
1. og gkMZos;j fMokbl dkSu&lh gS] ftls vke rkSj ij dEI;wVj dk ^czsu* dgrs gSa\
(A) RAM fpi (B) MkVk buiqV
(C) CPU (D) lsdsaMjh LVksjst mÙkj % (C)

2. fdlh izksxzke esa ^cx* (Bug) D;k gksrk gS\
(A) LVsVesaV (B) ,jj
(C) flXuspj (D) b vkSj c nksuksa mÙkj % (B)

3. fuEufyf[kr esa ls dkSu&lk dEI;wVjksa dks VsfyQksu ykbuksa dk iz;ksx djds MkVk varfjr djus dh vuqefr nsrk gS\
(A) dqathiVy (B) lhih;w
(C) eksMe (D) fizUVj mÙkj % (C)

4. igyk lfØ;kRed bysDVªkWfud vadh; dEI;wVj gS&
(A) ENIAC (B) EDVAC

(C) EDSAC (D) UNIVAC mÙkj % (A)

5. fuEufyf[kr esa ls dkSu&lk www dk lgh :i gS\
(A) window world wide (B) web working window

(C) world working web (D) world wide web mÙkj % (D)

6. lh- ih- ;w- dk D;k vFkZ gS\
(A) lsaVªy izkslsflax ;wfuV (B) daVªksy izksxzke ;wfuV
(C) lsaVªy izksxzke ;wfuV (D) daVªksy izksxzke ;wlst mÙkj % (A)

7. fuEufyf[kr mRiknksa esa ls dkSu lk mRikn ^isfUV;e* (Pentium) czk.M uke ls cspk tkrk gS\
(A) eksckby fpi (B) dEI;wV fpi
(C) dEI;wVj (D) ekbØksizkslslj mÙkj % (D)

8. www ds vkfo"dkjd rFkk laLFkkid gS&
(A) fVe cuZlZ yh (B) ,u- jlsy
(C) yh- ,u- fQ;ksax (D) fcy xsV~l mÙkj % (A)

9. fuEufyf[kr esa dkSu&lh lwpuk izkS|ksfxdh 'kCnkoyh ugha gS\
(A) lkbcj Lisl (B) viyksM
(C) izdk'k Hk.Mkj.k (D) eksMse mÙkj % (C)

10. igys bysDVªkWfud vadh; dEI;wVj esa D;k Fkk\
(A) VªkfUtLVj (B) okYo
(C) ØksM Le`fr (D) v¼Zpkyd Le`fr mÙkj % (B)

11. vuqie D;k gS\
(A) ,d 'kks/k laLFkku (B) ,d lqij dEI;wVj

daI;wVj
 iz'uksÙkjh100 iz'uksÙkjh



(C) uofufeZr iz{ksikL= (D) dEI;wVj lkW¶Vos;j mÙkj % (B)

12. Hkkjr esa fodflr ̂ ije* lqij dEI;wVj dk fodkl fdl laLFkk us fd;k gS\
(A) C-DAC (B) IIT] dkuiqj
(C) BARC (D) IIT, fnYyh mÙkj % (A)

13. dEI;wVj MkVk dh lcls NksVh bdkbZ gS&
(A) fcV (B) ckbV
(C) fjdkMZ (D) Qkby mÙkj % (B)

14. dkSu&lh HkkHkk ijek.kq vuqla/kku dsUnz }kjk fodflr lqij dEI;wVj ifj;kstuk gS\
(A) ije ine (B) ¶ykslkYoj ekdZ
(C) fpIl (D) vuqie mÙkj % (D)

15. ,d dEI;wVj dh Le`fr lkekU; rkSj ls fdyksckbV vFkok esxkckbV ds :i esa O;Dr dh tkrh gSA ,d ckbV cuk gksrk gS&
(A) vkB f}vk/kkjh vadksa dk (B) nks f}vk/kkjh vadksa dk
(C) vkB n'keyo vadksa dk (D) nks n'keyo vadksa dk mÙkj % (A)

16. ^LiSe* (Spam) fdl fo"k; ls lEcfU/kr 'kCn gS\
(A) dEI;wVj (B) dyk
(C) laxhr (D) [ksy mÙkj % (A)

17. MkVk ds izs"k.k dh xfr dks ekius ds fy, lkekU;r% iz;qDr ,dd (Unit) gS&
(A) esxk gV~tZ (B) laizrhd izfr lsd.M
(C) fcV izfr lsd.M (D) uSuks lsd.M mÙkj % (C)

18. bULVªD'kUl ds ml lewg dks D;k dgrs gSa] tks dEI;wVj dks crkrk gS fd D;k djuk gS\
(A) esUVj (B) bULVªDVj
(C) dEikbyj (D) izksxzke mÙkj % (D)

19. fuEufyf[kr esa ls dkSu Hkkjr dh lcls cM+h lkW¶Vos;j dEiuh gS\
(A) bUQksfll (B) Vh- lh- ,l-
(C) foizks (D) ,plh,y Vsd mÙkj % (B)

20. tc dksbZ dEI;wVj dksbZ Øekns'k ykxw djrk gS] rks og Øekns'k dgk¡ ij vVd tkrk gS\
(A) jSe (RAM) (B) jkse (ROM)

(C) gkMZ fMLd (D) ¶ykWih fMLd mÙkj % (A)

21. dEI;wVj dh LFkk;h Le`fr dks D;k dgrs gSa\
(A) RAM (B) ROM

(C) CPU (D) CD-ROM mÙkj % (B)
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22. fuEu esa ls dkSu fuxZe midj.k ugha gS\
(A) badtsV eqnzd (B) IykWVj
(C) izdkf'kr y{k.k vfHkKkrk (D) Lihdj mÙkj % (C)

23. igyh dEI;wVj Hkk"kk dkSu&lh fodflr dh xbZ Fkh\
(A) dkscksy (Cobal) (B) csfld (Basic)

(C) QksjVªkWu (Fortran) (D) ikLdy (Pascal) mÙkj % (C)

24. dEI;wVj ds fy, vkbZlh fpi vkerkSj ij cuk, tkrs gSa&
(A) Øksfe;e ds (B) flfydkWu ds
(C) lhlk ds (D) dkWij ds mÙkj % (B)

25. fuEu esa ls dkSu&lk CRT dk fgLlk ugha gS\
(A) QkWLQj iziV~V (B) Nk;k vkPNn
(C) bysDVªkWu xu (D) xSl IykTek mÙkj % (D)

26. ystj fizUVj esa fuEufyf[kr esa ls dkSu&lk ,d ystj izdkj iz;qDr gksrk gSA
(A) Mkb ystj (B) xSl ystj
(C) v¼Zpkyd ystj (D) mÙkst};h ystj mÙkj % (C)

27. igyk dEI;wVj fdlus cuk;k Fkk\
(A) fcy xsVkl (B) fcy fDyUVu
(C) pkYlZ cScst (D) ekdksZuh mÙkj % (C)

28. vk/kqfud dEI;wVjksa dk y?kq :idj.k laHko gks ladk gS] fuEu ds iz;ksx ls&
(A) VªkfUtLVj (B) lekdfyr ifjiFk fpi
(C) uSuks inkFkZ (D) vfr lapkyd mÙkj % (B)

29. fdlh vk¡dM+k lap; esa fjdkWMks± dk o`{kkdkj lap; D;k dgykrk gS\
(A) tkyØe ekWMy (B) Js.khc¼ ekWMy
(C) lEcU/kkRed ekWMy (D) cgqvk;keh ekWMy mÙkj % (B)

30. fuEu esa ls dkSu dEI;wVj vk¡dM+ksa dh =qfV;k¡ iznf'kZr djrk gS\
(A) fpi (B) ckbV
(C) cx (D) fcV mÙkj % (C)

31. fuEu esa ls dkSu&lh ,d ;a= lkexzh ugha gS\
(A) fizUVj (B) dh cksMZ
(C) ekÅl (D) izpkyu ra= mÙkj % (D)

32. tc dksbZ dEI;wVjksa dks ,d NksVs ls {ks= esa fcuk VsyhQksu ds rkjksa ds ijLij tksM+ fn;k tkrk gS] rks mls D;k dgrs gSa\
(A) lqnwj lapkj usVodZ (B) LFkkuh; {ks= usVodZ
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(C) foLr`r {ks= usVodZ (D) ewY; ;kstd usVodZ mÙkj % (B)

33. vkbZ- lh- fpiksa dk fuekZ.k fd;k tkrk gS&
(A) Qkbcj ls (B) lsehd.MDVj ls
(C) IykfLVd ls (D) mijksDr esa ls dksbZ ugha mÙkj % (B)

34. vktdy lcls vf/kd iz;ksx gksus okyh fuos'k ;qfDr (Input device) gS&
(A) Vsªd ckWy (B) Ldsuj
(C) ekÅl (D) buesa ls dksbZ ugha mÙkj % (C)

35. in ,e- ch- (MB) iz;ksx fd;k tkrk gS&
(A) eSXusfVd fcV~l ds fy, (B) esxk ckbV~l ds fy,
(C) esxk fcV~l ds fy, (D) mDr esa ls dksbZ ugha mÙkj % (B)

36. ewy fuos'k&fuxZe iz.kkyh (Basic Input Output System) dEI;wVj esa fo|eku jgrh gS&
(A) gkMZ fMLd ij (B) ;kn`fPNd vfHkxe Le`fr esa
(C) dsoy ekÅl Le`fr esa (D) mDr esa dksbZ ugha mÙkj % (B)

37. bysDVªkWfud dEI;wVj dk vkfo"dkj fdlus fd;k\
(A) ekdksZuh (B) ,yu ,e- Vwfjax
(C) ,ysDtsaMj xzkge csy (D) buesa ls dksbZ ugha mÙkj % (D)

38. dEI;wVj dh Hkk"kk esa ,d esxkckbV esa fdrus ckbV gksrs gSa\
(A) 100]000 (B) 10]00]000

(C) 10]24]000 (D) 10]48]576 mÙkj % (D)

39. lqij dEI;wVj ds fy, 'kCn yEckbZ dk ijkl (Range) gksrk gS&
(A) 16 fcV rd (B) 32 fcV rd
(C) 64 fcV rd (D) 128 fcV rd mÙkj % (C)

40. dEI;wVj okbjl dsoy ,d izdkj dk lkW¶Vos;j gS] tks eq[;r;k u"V djrs gSa&
(A) vk¡dM+ksa dks (B) midj.kksa dks
(C) izksxzkeksa dks (D) gkMZos;j dks mÙkj % (C)

41. fuEufyf[kr esa ls ml ;a= dk uke crkb, tks dEI;wVj dks VsyhQksu ykbu ls tksM+rk gS\
(A) LdSuj (B) ekWMse
(C) lh- Mh- jkse (D) fizUVj mÙkj % (B)

42. dEI;wVj flLVe ds fdl Hkkx dks HkkSfrd :i ls Li'kZ fd;k tk ldrk gS\
(A) MkVk (B) vksaijsfVax flLVe
(C) gkMZos;j (D) lkW¶Vos;j mÙkj % (C)
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43. MkWV eSfVªDl fdldk ,d izdkj gS\
(A) Vsi (B) fMLd
(C) fizUVj (D) cl mÙkj % (C)

44. ekbØkslkW¶V dkiksZjs'ku dk lEcU/k fdl m|ksx ls gS\
(A) lk¶V fMªad (B) mPp xq.koÙkk ds lw{en'khZ
(C) dEI;wVj lkW¶Vos;j (D) enj cksMZ mÙkj % (C)

45. dkSu&lk ikVZ dEI;wVj dk czsu gS\
(A) CPU (B) ekWfuVj
(C) RAM (D) ROM mÙkj % (A)

46. fuEu esa ls dkSu&lk flLVe dEiksusaV dEI;wVj dk efLr"d gksrk gS\
(A) lfdZV cksMZ (B) lh-ih-;w-
(C) eseksjh (D) usVodZ dkMZ mÙkj % (B)

47. dEI;wVj fizUVj fdl izdkj dk fMokbl gS\
(A) buiqV (B) vkmViqV
(C) lkW¶Vos;j (D) LVksjst mÙkj % (B)

48. dEI;wVj esa fcYV ijekusaV eseksjh dks D;k dgrs gSa\
(A) RAM (B) ROM

(C) CPU (D) CD-ROM mÙkj % (B)

49. dEI;wVj esa mi;ksx vkus okyh vkbZ- lh- fpIl fdlls cuh gksrh gS\
(A) rkack (B) flfydkWu
(C) LVhy (D) IykfLVd mÙkj % (B)

50. fuEufyf[kr esa ls dkSu&lk gkMZos;j ugha gS\
(A) izkslslj fpi (B) fizUVj
(C) ekml (D) tkok mÙkj % (D)

51. yksdy ,fj;k usVodZ esa fuEu esa ls fdl en dk iz;ksx ugha fd;k tkrk gS\
(A) dEI;wVj (B) eksMe
(C) bUVjQsl dkMZ (D) dscy mÙkj % (B)

52. dEI;wVj ds MkVk lh- ih- ;w- ls ifjf/k ;a=ksa dks varj.k fdlds ek/;e ls izkIr fd;k tkrk gS\
(A) eksMe (B) dEI;wVj iksVZl
(C) bUVjQsl (D) cQj eseksjh mÙkj % (B)

53. ,d gh le; ij nksuksa fn'kkvksa esa MkVk Hkstus ds fy, dkSu&lh MkVk lapkj fof/k iz;qDr dh tkrh gS\
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(A) lqij MqIySDl (B) flEIySDl
(C) gkQ MqIySDl (D) Qqy MqIySDl mÙkj % (D)

54. vusd ?kjsyw] midj.kksa esa fufeZr NksVs vkSj lLrs dEI;wVj fdl izdkj ds gksrs gSa\
(A) esuÝse (B) feuh dEI;wVj
(C) ekbØks dEI;wVj (D) buesa ls dksbZ ugha mÙkj % (C)

55. ml ;qfDr dks D;k dgk tkrk gS] tks dEI;wVj vkmViqV dks VsyhQksu ykbuksa ij izsf"kr djus ds fy, :ikarfjr djrh gS\
(A) bUVjQsl (B) bUVjizsVj
(C) eksMe (D) I/O iksVZ mÙkj % (C)

56. fuEufyf[kr esa ls dkSu&lk lwpuk&izkS|ksfxdh dh 'kCnkoyh dk Hkkx gS\
(A) izksVksdkWy (B) ykWfxax
(C) vkphZ (D) mi;qZDr lHkh mÙkj % (D)

57. fuEufyf[kr esa ls dkSu&lk lpZ batu ugha gS\
(A) xwxy (B) ,YVk&foLVk
(C) lkbal Mk;jsDV (D) vkWjdqV mÙkj % (C)

58. lapkj usVodZ ftldk iz;ksx cM+h laLFkkvksa }kjk izknsf'kd] jk"Vªh; vkSj oSf'od {ks= esa fd;k tkrk gS\
(A) LAN (B) WAN

(C) MAN (D) VAN mÙkj % (B)

59. dEI;wVj fuEufyf[kr esa ls dkSu&lk dk;Z ugha djrk gS\
(A) bEI;wfVax (B) izkslsflax
(C) daVªksfyax (D) vaMjLVSafMax mÙkj % (D)

60. fuEufyf[kr esa ls dkSu&lk gkMZos;j dk mnkgj.k ugha gS\
(A) ekml (B) fizUVj
(C) ekWuhVj (D) vkWijsfVax flLVe mÙkj % (D)

61. fuEufyf[kr esa ls dkSu&lk baVjusV laca/kh in ugha gS\
(A) czkmtj (B) fyad
(C) fizUVj (D) lpZ batu mÙkj % (C)

62. fuEufyf[kr esa ls dkSu&lk LVksjst ek/;e ugha gS\
(A) gkMZ fMLd (B) ¶yS'k Mªkbo
(C) DVD (D) dh&cksMZ mÙkj % (D)

63. dEI;wVjksa ds lanHkZ esa lkW¶Vos;j dk D;k vFkZ gS\
(A) ¶ykWih fMLd (B) dEI;wVj izksxzkEl
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(C) dEI;wVj ljfdVªh (D) g~;weu cszu mÙkj % (B)

64. ,d fucy fdrus fcVksa ds cjkcj gksrk gS\
(A) 16 (B) 32

(C) 4 (D) 8 mÙkj % (C)

65. fuEu esa ls lcls rst] lcls cM+k vkSj lcls egaxk dEI;wVj dkSu&lk gS\
(A) uksVcqd (B) ilZuy dEI;wVj
(C) ySiVkWi (D) lqij dEI;wVj mÙkj % (D)

66. igys ls vkWu dEI;wVj dks jhLVkVZ djus dks D;k dgrs gSa\
(A) ykWfxax vkWQ (B) dksYM cqfVax
(C) 'kV Mkmu (D) okeZ cfVax mÙkj % (D)

67. fuEu esa dkSu&lk flLVe ;wfuV dk Hkkx gS\
(A) ekWuhVj (B) CPU

(C) CD-ROM (D) ¶ykWih fMLd mÙkj % (B)

68. fuEu esa ls dkSu&lk gkMZos;j gS] lkW¶Vos;j ugha\
(A) ,Dlsy (B) fizUVj Mªkboj
(C) vkijsfVax flLVe (D) daVªksy ;wfuV mÙkj % (D)

69. fuEu esa ls dkSu&lk bZ&esy ls lacaf/kr 'kCn ugha gS\
(A) ikoj Iokb.V (B) buckWDl
(C) lsaMj (D) fjlhoj mÙkj % (A)

70. baVjusV ij loZj ls lwpuk izkIr djus ds dEI;wVj ds izkslsl dk vFkZ fuEu esa ls dkSu&lk gS\
(A) xSnfjax (B) viyksfMax
(C) buiqfVax (D) MkmuyksfMax mÙkj % (D)

71. dEI;wVj ij vkjksfir T;knkrj =qfV;k¡ fdl dkj.k gksrh gSa\
(A) Øekns'k =qfV (B) gkMZos;j dh foQyrk
(C) ehfM;k esa nks"k (D) MsVk izfof"V esa =qfV mÙkj % (D)

72. dEI;wVj dk lcls egRoiw.kZ Hkkx gS&
(A) lh- ih- ;w- (B) dh&cksMZ
(C) fMLd (D) fizUVj mÙkj % (A)

73. 1024 ckbV cjkcj gS&
(A) 1 TB (B) 1 GB

(C) 1 MB (D) 1 KB mÙkj % (D)
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74. lkjs dEI;wVjksa esa ykxw gksrh gS&
(A) csfld Hkk"kk (B) dkscksy Hkk"kk
(C) e'khuh Hkk"kk (D) QksjVªku Hkk"kk mÙkj % (C)

75. nl yk[k ckbV~l yxHkx gksrh gS&
(A) xhxk ckbV~l (B) fdyksckbV~l
(C) esxkckbV~l (D) VsjkckbV~l mÙkj % (C)

76. Hkkjr esa lqij dEI;wVj ^ije* dk fuekZ.k gqvk&
(A) psUubZ esa (B) caxykSj esa
(C) fnYyh esa (D) iq.ks esa mÙkj % (D)

77. dEI;wVj esa fo.Mks ,d izdkj gS&
(A) lkW¶Vos;j dk (B) gkMZos;j dk
(C) nksuksa dk (D) fdlh dk ugha mÙkj % (A)

78. fuEufyf[kr esa ls leLr laxzg.k midj.k gS] flok;&
(A) gkMZ fMLd Mªkbo ds (B) ¶ykWi fMLd Mªkbo ds
(C) lh- Mh- Mªkbo ds (D) fizUVj ds mÙkj % (D)

79. izFke ih<+h ds dEI;wVj iz;ksx djrs Fks&
(A) oSD;we V~;wc (B) eSXusfVd dksj
(C) flfydkWu fpi (D) VªkaftLVj mÙkj % (A)

80. CDs dk vkdkj dSlk gksrk gS&
(A) oxkZdkj (B) vk;rkdkj
(C) xksy (D) "kVdks.kh; mÙkj % (C)

81. lkW¶Vos;j (Software) ds fy, ,d vU; 'kCn gS&
(A) buiqV (B) vkmViqV
(C) izksxzke (D) flLVe mÙkj % (C)

82. DTP dk iwjk :i gS&
(A) Daily Text Printing (B) Desk Top Publishing

(C) Desk Top Printing (D) Daily Text Publishing mÙkj % (B)

83. MkWl (DOS) dk iw.kZ :i D;k gS\
(A) Mk;jsDV vkWijsfVax flLVe (B) Mqvy vkWijsfVax flLVe
(C) fMLd vkWijsfVax flLVe (D) Mk;yvi vkWijsfVax flLVe mÙkj % (C)

84. ts- Mh- ch- lh- (JDBC) bldk lwpd gS&



(A) tkok MkVkcsl daMfDVfoVh (B) tkok Msoysij dusfDVfoVh
(C) tkok MkVkcsl dusfDVfoVh (D) tkok Msoyfiax dusfDVfoVh mÙkj % (C)

85. LAN fdldk y?kq :i gS&
(A) yksdy ,fj;k usVodZ (B) ykWtZ ,fj;k usVodZ
(C) ykWtZ ,fj;k uksM~l (D) yksdy ,fj;k uksM~l mÙkj % (A)

86. dEI;wVj laf{kIrk{kj KB dk lkekU;r;k iw.kZ :i gS&
(A) Key Block (B) Kernel Boot

(C) Kilo Byte (D) Kit Bit mÙkj % (C)

87. bZ&esy dk foLr`r :i gS&
(A) bysfDVªdy esy (B) bysDVªkWfud esy
(C) bykfLVd esy (D) mi;qZDr esa ls dksbZ ugha mÙkj % (B)

88. dEI;wVj eseksjh esa jgrk gS MkVk&
(A) jftLVlZ (B) fcV~l
(C) ckbV~l (D) izksxzke mÙkj % (D)

89. igyk xzkfQdy ;wtj bUVjQsl fdl dEiuh us cuk;k Fkk\
(A) ekbØkslkW¶V (B) ,Vh ,.M Vh
(C) vkbZch,e (D) thjkWDl mÙkj % (D)

90. ekbØkslkW¶V oMZ mnkgj.k gS&
(A) ,d vkWijs'ku flLVe dk (B) ,d buiqV fMokbl dk
(C) ,d izkslsflax fMokbl dk (D) ,Iyhds'ku lkW¶Vos;j dk mÙkj % (D)

91. izksykWx (Prolog) Hkk"kk fodflr gqbZ&
(A) 1972 esa (B) 1970 esa
(C) 1975 esa (D) 1973 esa mÙkj % (A)

92. CykWx (Blog) 'kCn dks 'kCnksa dk la;kstu gS&
(A) osc&ykWx (Web-Log) (B) oso&ykWx (Wave-Log)

(C) osc&CykWx (Web-Blog) (D) csM&ykWd (Bed-Lock) mÙkj % (C)

93. ;g dEI;wVj dk og Hkkx gS ftls dksbZ Nw ugha ldrk&
(A) gkMZos;j (B) fizUVj
(C) ekml (D) lkW¶Vos;j mÙkj % (D)

94. fuEufyf[kr esa ls fdls ^dEI;wVj dk firkeg* dgk tkrk gS\
(A) gjeu gksysfjFk (B) pkYlZ cscst



(C) csYl ikLdy (D) tkslsQ tSD;wMZ mÙkj % (B)

95. bUVhxzsVsM lfdZV fpi (I.C.) ij fdldh ijr gksrh gS\
(A) flfydkWu (B) fufdy
(C) vk;ju (D) dkWij mÙkj % (A)

96. vk/kqfud fMftVy dEI;wVj esa fdl i¼fr dk mi;ksx fd;k tkrk gS\
(A) f}vk/kkjh vad i¼fr (B) n'keyo vad i¼fr
(C) vuq:i x.kuk i¼fr (D) buesa dksbZ ugha mÙkj % (A)

97. fdl dEI;wVj Hkk"kk dk iz;ksx okf.kfT;d dk;ks± esa fd;k tkrk gS\
(A) FORTRAN (B) BASIC

(C) COBOL (D) PASCAL mÙkj % (C)

98. FORTRAN, ALGOL, PASCAL vkfn Hkk"kkvksa dks fl[kkus ds fy, fdl Hkk"kk dks ^uhoa dk iRFkj* dgk tkrk gS\
(A) C++ (B) BASIC

(C) COBOL (D) buesa dksbZ ugha mÙkj % (B)

99. Hkkjr esa jsyos ds varxZr loZizFke dEI;wVjhÏr vkj{k.k O;oLFkk dgk¡ yxk;h xbZ\
(A) ubZ fnYyh (B) dksydkrk
(C) eqEcbZ (D) psUubZ mÙkj % (A)

100. dkSu&lk lkW¶Vos;j 'kCn lalk/ku esa iz;ksx fd;k tkrk gS\
(A) istesdj (B) oMZ LVkj
(C) ,e- ,l- oMZ (D) ;s lHkh mÙkj % (D)



Q-01

1- .ptx

2- .ppx

3- .px

4- .pptx 



Q-02

1- B1 to XFD1048576

2- D1 to XFD1048578

3- A1 to XFD1048576

4- C1 to XFD1048577



Q-03

1- Click on Review > enter password > Click on ok

2- Click on Review > upprotect worksheet 

3- Click on Review > unprotect worksheet > enter password > Click on ok

4- Click on File > enter password > unprotect worksheet > Click on ok



Q-04

1- बिहाइंड कािबन कॉपी 
2- ब्लैक कािबन कॉपी 
3- ब्लैंक कािबन कॉपी 
4- ब्लाइंड कािबन कॉपी 



Q-05

1- Open Worksheet>Home>Select a cell and right click>Number>Select date> OK

2- Open Worksheet>Home>Select a cell and right click> Select date>Type>OK 

3- Open Worksheet> Select a cell and right click>Number>Select date>Type>OK

4- Open Worksheet> Select a cell and right click>Number>Select date>Type>OK



Q-06

1- File > options > Protect Work book > Restrict Access 

2- Home Tab > Info > Protect Work book > Restrict Access 

3- View > Info > Protect Work book > Restrict Access

4- File Tab> Info > Protect Work book > Restrict Access



Q-07

1- CTRL + F9 

2- CTRL + ALT + F9

3- SHIFT + F9

4- ALT + F8



Q-08

1- 8 

2- 20

3- 15

4- 4



Q-09

1- List of records

2- List of active windows

3- List of labels

4- List of Data source



Q-10

1- Double click on current cell>Insert>select on entire column>OK

2- Single click on current cell>Insert>select on entire column>OK 

3- Right click on current cell> select on entire column>OK

4- Right click on current cell>Insert>select on entire column>OK



Q-11

1- Automatically

2- User has to store deleted file in the recycle bin manually

3- For fixed duration

4- Not automatically



Q-12

1- Small Computer System Integrate

2- None of the above 

3- Same Computer System Interface

4- Small Computer System Interface



Q-13

1- View tab > Window group > Hide 

2- View tab > Workbook views group > Hide

3- Review tab > Window group > Hide

4- वकब िुक हाईड नह ं होता है वकब शीट हाईड होता है 



Q-14

1- पॉइंटर Pointer 

2- कर्बर cursor 

3- आई-िीम I-beam 

4- र्भी all 



Q-15

1- Shift + F10

2- Shift + F11

3- Alt + F12

4- Alt+F9



Q-16

1- CTRL + F9

2- Win + D

3- CTRL + Alt + D

4- SHIFT + F9



Q-17

1- 1959

2- 1958

3- 1957

4- 1956



Q-18

1- Workbook structure

2- Inspect document

3- Protect current sheet

4- Encrypt with password



Q-19

1- Shift + F11

2- Shift + F8 

3- Shift + F10 

4- Shift + F9



Q-20

1- Shift + Tab 

2- Ctrl + Shift

3- Ctrl + Tab 

4- Alt + Shift



Q-21

1- इंकजेट प्रटंर 

2- लेजर प्रटंर 

3- थमबल प्रटंर 

4- इम्पैक्ट प्रटंर 



Q-22

1- <<>>

2- <> 

3- ‘ ’

4- “ ”



Q-23

1- fb

2- if

3- fx

4- fc



Q-24

1- Print Layout

2- Web Layout

3- Split Layout 

4- Multi Layout 



Q-25

1- .xl 

2- .doc

3- .pdf 

4- .mdb



Q-26

1- 3

2- 4

3- 2

4- 5



Q-27

1- रैप टेक््ट 
2- मजब ्टाइल
3- कंडीशनल फॉमेटटगं
4- फाइंड एंड रेप्लर् 



Q-28

1- Alt+C

2- Shift+C

3- Ctrl+C

4- Alt+Ctrl+C



Q-29

1- 216

2- 28

3- 2128

4- 232



Q-30

1- .xls File

2- .zip File

3- .docx File

4- .exe File



Q-31

1- 9

2- 12

3- 7

4- 4



Q-32

1- Insert > Illustration

2- Insert > Paragraph 

3- Insert > Paragraph 

4- Home > Paragraph 



Q-33

1- डडजाइन मेन्यू --> वेररयन्टल गु्रप 
2- होम मेन्यू --> पैराग्राफ गु्रप 
3- डडजाइन मेन्यू -->डडजाइन  गु्रप 
4- डडजाइन मेन्यू ---> क्टमाइज गु्रप 



Q-34

1- "=TRUE"

2- "=FLOOR.MATH()"

3- "=FALSE" 

4- "=DATE"



Q-35

1- ALT+Left Arrow

2- Ctrl+Alt+Left Arrow

3- Ctrl + (Left arrow)

4- Ctrl+Shift+ Left Arrow



























MS PowerPoint 
Objective Questions 

1. Which of these is not the view of PowerPoint? 
A) Slide Show view 
B) Slide Sorter view 
C) Normal view 
D) Outline view 
Correct Answer : D 

2. What is Extension of PowerPoint Presentation? 
A) .POT 
B) .PPT 
C) .PTP 
D) .PPE 
Correct Answer : B 

3. What is the shortcut key to create new files in PowerPoint 
presentation. 
A) Ctrl + N 
B) Ctrl + S 
C) Ctrl + M 
D) Shift + N 
Correct Answer : A 

4. To open Power Point from Run Dialog Box, type 
________ 
A) PowerPoint 
B) Pwrpoint 
C) Powerpnt 
D) Powerpint 
Correct Answer : C 

5. Which program is used to create a presentation 
A) Excel 
B) PowerPoint 
C) Access 



D) Outlook 
Correct Answer : B 

6. What is the shortcut key to insert a new slide into the 
current presentation. 
A) Ctrl + O 
B) Ctrl + M 
C) Ctrl + N 
D) Ctrl + F 
Correct Answer : B 

7. Which menu does have action button option ? 
A) Tools 
B) Format 
C) Window 
D) Slide Show 
Correct Answer : D 

8. Which option is used to create Speaker Notes in the 
Power Point slide. 
A) Slide Note 
B) Short Notes 
C) Sound Note 
D) Notes View 
Correct Answer : D 

9. Which option is used to change shadow, text color and the 
color of the box in Power Point 
A) Color schemes 
B) Drawing tools 
C) Text tools 
D) Background color 
Correct Answer : A 

10. How you can stop the slide show. 
A) Pressing Delete button. 
B) Pressing Esc button. 
C) Pressing Right arrow. 



D) Pressing Left arrow. 
Correct Answer : B 

11. _______ task pane shows the design that is currently 
being used in the presentation. 
A) slide show 
B) slide style 
C) slide design 
D) slide format 
Correct Answer : C 

12. How to insert a table in a slide. 
A) Table menu & Insert table 
B) Click on the insert table in the content pane of the blank 
slide. 
C) A and B Both 
D) The table can not be inserted into a slide. 
Correct Answer : B 

13. What is the use of the “Hide slide” option? 
A) During the presentation, to hide the selected slide. 
B) During editing, to hide the selected slide. 
C) To hide the selected slide during printing. 
D) To hide the selected slide during deleting. 
Correct Answer : A 

14. Handout Master is defined by _________ 
A) Slide formatting 
B) Slide transaction 
C) Layout of handout 
D) Layout of slide 
Correct Answer : C 

15. Which of these slides is used as a background. 
A) Gradient 
B) Texture 
C) Picture 
D) All of these 
Correct Answer : D 



16. Ctrl + E command is used in the power point – 
A)To make Text in the left 
B) To make Text in the Right 
C) To make Text in the Center 
D) All of these 
Correct Answer : C 

17. Ellipse Motion is a Predefined …………. 
A) Design Template 
B) Color Scheme 
C) Animation Scheme 
D) None of these 
Correct Answer : C 

18. How many slides can be printed on the same page by 
using the handout. 
A) 1 
B) 6 
C) 9 
D) All of these 
Correct Answer : D 

19. Which feature of Power Point will you use to apply the 
motion effect to different slides? 
A) slide transition 
B) slide Design 
C) Animation object 
D) Animation Scheme 
Correct Answer : A 

20. Which option is used to set a custom timing for a slide in 
Presentation. 
A) Slider timings 
B) slide transition 
C) Rehearsal 
D) Slide Show Setup 
Correct Answer : B 



21. If you want to see only text in the slide, which of the tabs 
will you use. 
A) Task pane 
B) Thumbnails 
C) Outline 
D) Tool bar 
Correct Answer : C 

22. If you want to change the order of slides, which view 
option will you use. 
A) Normal View 
B) slide sorter view 
C) Notes page view 
D) Slide show view 
Correct Answer : B 

23. Which menu contains an option like Animation scheme, 
custom animation, slide transition. 
A) insert menu 
B) tools menu 
C) View menu 
D) slide show menu 
Correct Answer : D 

24. Which option is right for inserting a hyperlink in a slide. 
A) Choose Insert & Hyperlink 
B) Press Ctrl + K 
C) Hyperlink can not be inserted into the slide. 
D) A and B Both 
Correct Answer : D 

25. The slide sorter in the power point is in the ________ 
menu. 
A) Insert 
B) View 
C) File 
D) Edit 
Correct Answer : B 



26. What happens to “apply design templates”? 
A) Changes the contents of the slide 
B) Adds the functionality of the slide. 
C) Change the look of the slide without any changes in the 
content of the slide. 
D) None of these 
Correct Answer : C 

27. The Pre-defined style that can be used for presentation 
in Power Point is called- 
A) Auto style 
B) Wizard 
C) Templates 
D) Pre Formatting 
Correct Answer : C 

28. In a presentation, the animation scheme can be applied 
in which slide. 
A) All slides 
B) Selected slide 
C) Current slide 
D) All of these 
Correct Answer : D 

29. Which of these keys will you press to check spelling. 
A) F3 
B) F5 
C) F7 
D) F9 
Correct Answer : C 

30. How many types of layouts are in the power point 
A) 4 
B) 5 
C) 6 
D)None of these 
Correct Answer : A 



31. What is the command to recolor a picture in a slide? 
A) Insert – Picture – Recolor 
B) Tools – Picture – Recolor 
C) Format – Picture – Recolor 
D) Edit – Picture – Recolor 
Correct Answer : A 

32. Which of the following option can have in a slide? 
A) Title, Text, graphs 
B) Drawn Object Shapes 
C) Clipart, Drawn art, Visual 
D) Any of these 
Correct Answer : D 

33. What is animation? 
A) To make a picture 
B) Accelerate static images 
C) Print out 
D) Changing the pictures in the graph 
Correct Answer : B 

34. What is the Shortcut Key to Slide Show ? 
A) F4 
B) F5 
C) F6 
D) F7 
Correct Answer : B 

35. Which orientation is set in the default page setup in the 
power point. 
A) Landscape 
B) Portrait 
C) Vertical 
D) None of these 
Correct Answer : A 

36. Which feature would you use to apply motion effect for 
slide Exit and Enter? 
A) Animation Scheme 



B) Slide Design 
C) Animation Objects 
D) Slide Transition 
Correct Answer : D 

37. Which file formats can add to power point shows? 
A) WAV 
B) JPG 
C) MPEG 
D) All of these 
Correct Answer : D 

38. Which tab does not have on the left panel when you open 
the presentation? 
A) Notes 
B) Outline 
C) Slides 
D) All are available 
Correct Answer : A 

39. Which section does not exist in slide layout 
A) Animations 
B) Lists 
C) Titles 
D) Charts 
Correct Answer : A 

 

40. Which Power Point feature would you use to apply the 
motion effect for different objects on the slide? 
A) Animation Scheme 
B) Animation Objects 
C) Slide Design 
D) Slide Transition 
Correct Answer : A 

41. Which of the following is the action button in the power 
point 
A) Home 



B) Help 
C) End 
D) All of these 
Correct Answer : D 

42. Which option is used to rehearse the presentation in the 
power point 
A) Setup time 
B) Timing 
C) Rehearse Timing 
D) All of these 
Correct Answer : C 

43. Shortcut key to open pre-made Presentation 
A) CTRL + A 
B) CTRL + O 
C) CTRL + N 
D) CTRL + L 
Correct Answer : B 

44. Which of these options is used to make a similar type of 
formatting in every slide in PowerPoint. 
A) Slide Transition 
B) Slide Design 
C) Slide Master 
D) All of these 
Correct Answer : C 

45. How to Stop the Slide Show in PowerPoint 
A) Press the right arrow 
B) Press Escape 
C) Press Ctrl + A 
D) Press Ctrl + S 
Correct Answer : B 

46. The page to create Presentation in Power Point is called 
_____. 
A) Sheet 
B) Paper 



C) Slide 
D) Document 
Correct Answer : C 

47. How the chart is inserted in PowerPoint ? 
A) Edit -> Chart 
B) Insert -> Pictures -> Chart 
C) Insert -> Chart 
D) View -> Chart 
Correct Answer : C 

48. Which option is used to replace the font in all the slides 
in PowerPoint 
A) Tools -> Fonts 
B) Edit -> Fonts 
C) Format -> Replace Fonts 
D) Tools -> Replace Fonts 
Correct Answer : C 

49. From which of these views can we see all the slides 
together ? 
A) Through slide sorter view 
B) Through slide view 
C) Through normal view 
D) through slide show 
Correct Answer : A 

50. Which toolbar has a slide design option in MS Power 
point ? 
A) Standard Toolbar 
B) Formatting Toolbar 
C) Drawing Toolbar 
D) None of these 
Correct Answer : B 

 



ऍम एस वड भाग – 1 (िहंदी म )
1. माइोसॉट वड या है।
a) ऑपरेिटंग िसटम (Operating System)
b) वड ोसेिसंग ोग ाम (Word Processing Program)
c) माइोसॉट िवडोज (Microsoft Windows)
d) इनमे से कोई नही (None Of Above)

2. Ms Word की िवशेषताऍ या है।
a) पेिलंग चैिकंग (Spelling Checking )
b) ग ािफस (Graphics)
c) दोनो (Both)
d) इनमे से कोई नही (None Of Above)

3. एम एस वड को रन कमांड के ारा खोलने के िलए या टाईप करते है।
a) िवनिज़प (Winzip)
b) िवनवड (Winword)
c) एम ्एस डॉस (MS DOS)
d) एम ्एस वड (MS Word)

4. Ms Word को Open करने पर िकतनी Screen Windows पर िदखाई देती है।
a) एक
b) दो
c) तीन
d) कोई नही

5. Ms Word मे बनाई गई फाईल को िकस नाम से जाना जाता है।
a) ोग ाम (Program)
b) टेट (Text)
c) ग ाफ (Graph)
d) डायमू ट (Document)

6. पेज सेटअप कमाड की सहायता से िकनको बदला जा सकता ह ।
a) मािजन, पेपर साइज, कलर
b) पेपर ोत, ले आउट
c) A और B दोन
d) फाइल का नाम
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7. काय े को मापन के िलए िकस बार का उपयोग िकया जाता ह ।
a) लर बार
b) मेय ूबार
c) टाक बार
d) टाईटल बार

8. एमएस वड 2007 म  फाईल को खोलने, सेव करने एवं बंद करने से सबंिधत कमाड —————–
म  होती ह ।
a) होम
b) ऑिफस बटन
c) यू
d) इसट

9. िकस कमाड ारा डॉयुम ट को िंट करने से पवू देख सकते ह ।
a) िट
b) वेब पेज ियू
c) िंट ियू
d) स ड टू

10. िसलेटेड लाइन को बोड करने की शॉटकट कंुजी ह ।
a) Alt + B
b) Ctrl + O
c) Alt + O
d) Ctrl + B

11. िसलेटेड लाइन को अंडरलाइन करने की शॉटकट कंुजी ह ।
a) Ctrl + Shift + U
b) Ctrl + A
c) Alt + E
d) Ctrl + U

12. िसलेटेड लाइन को डबल अंडरलाइन करने की शॉटकट कंुजी ह ।
a) Ctrl + Shift + U
b) Ctrl + D
c) Ctrl + Shift + D
d) Ctrl + U

13. एक िर स ह  जो डॉयमेूट के एक भाग की सचूना को दसूरे भाग म  िदखाता ह ।
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a) हाइपरिलंक
b) ॉस-िर स
c) डायमू ट
d) िलंकेज

14. िसलेटेड लाइन का लेट एलाइनमट करने की शाटकट कंुजी ह ।
a) Ctrl + L
b) Ctrl + D
c) Shift + L
d) Tab

15. पैराग ाफ या लाईन को सटर अलाईन करने के िलए िकस कंुजी का योग िकया जाता ह ।
a) Ctrl + Shift + U
b) Ctrl + E
c) Ctrl + Shift + D
d) Ctrl + U

Answer Sheet
1. माइोसॉट वड या है।
Answer – b) वड ोसेिसंग ोग ाम (Word Processing Program)

2. Ms Word की िवशेषताऍ या  है।
Answer – c) दोनो (Both)

3. एम एस वड को रन कमांड के ारा खोलने के िलए या टाईप करते है।
Answer – a) िवनिज़प  Winzip

4. Ms Word को Open करने पर िकतनी Screen Windows पर िदखाई देती है।
Answer – b) दो

5. Ms Word मे बनाई गई फाईल को िकस नाम से जाना जाता है।
Answer – d) डायमू ट

6. पेज सेटअप कमाड की सहायता से िकनको बदला जा सकता ह ।
Answer – (c) A और B दोन

7. काय े को मापन के िलए िकस बार का उपयोग िकया जाता ह ।
Answer – (c) टाक बार
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8. एमएस वड 2007 म  फाईल को खोलने, सेव करने एवं बंद करने से सबंिधत कमाड —————–
म  होती ह ।
Answer – (b) ऑिफस बटन

9. िकस कमाड ारा डॉयुम ट को िंट करने से पवू देख सकते ह ।
Answer – (c) िंट ियू

10. िसलेटेड लाइन को बोड करने की शॉटकट कंुजी ह ।
Answer – d) Ctrl + B

11. िसलेटेड लाइन को अंडरलाइन करने की शॉटकट कंुजी ह ।
Answer – d) Ctrl + U

12. िसलेटेड लाइन को डबल अंडरलाइन करने की शॉटकट कंुजी ह ।
Answer – c) Ctrl + Shift + U

13. एक िर स ह  जो डॉयमेूट के एक भाग की सचूना को दसूरे भाग म  िदखाता ह ।
Answer – b) ॉस-िर स

14. िसलेटेड लाइन का लेट एलाइनमट करने की शाटकट कंुजी ह ।
Answer – a) Ctrl + L

15. पैराग ाफ या लाईन को सटर अलाईन करने के िलए िकस कंुजी का योग िकया जाता ह ।
Answer – b) Ctrl + E
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ऍम एस वड भाग – 2 (िहंदी म )
1. MS Word 2010 का पहला मेय ूकौन सा है।
a) टूस (Tools)
b) फाइल (File)
c) ओपन (Open)
d) य ू(View)

2. Ms Word मे सबसे नीचे जो ीन दिशत होती है उसे या कहा जाता है।
a) टेटस बार (Status Bar)
b) टाइटल बार (Title Bar)
c) मेय ूबार (Menu Bar)
d) एंड बार (End Bar)

3. Ms Word मे सबसे ऊपर िदखाई देने वाली बार को या कहा जाता है।
a) टूल बार (Tool Bar)
b) टाइटल बार (Title Bar)
c) टेडड टूल बार (Standard Tool Bar)
d) टाक बार (Task Bar)

4. फुटनोट और एंडनोट का उपयोग …………….. के िलए िकया जाता है।
a) िर स
b) सचूना
c) िलट
d) वांइंट

5. ……………….. ग ािफक आपकी सचूना और िवचार का दृय ेजट शन है।
a) वड आट (Word art)
b) िलप आट (Clip art)
c) ऑटोशेप (Auto-shape)
d) माटआट (Smart art)

6. िसलेटेड लाइन का राईट एलाइनमट करने की शॉटकट कंुजी ह ।
a) Ctrl+ R
b) Shift + J
c) Ctrl+ J
d) Shift + I
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7. िसलेटेड लाइन को जटीफाई एलाइनमट करने की शॉटकट या ह ।
a) Shift + R
b) Shift + I
c) Ctrl+ I
d) Ctrl+ J

8. गो टु कमाड की सहायता से डॉयमूट म  ——————– को िदए गए थान पर भेजा जा सकता
ह ।
a) कसर
b) पेज नबर
c) टेसट
d) कैरेटर

9. ——————– एक िवषय सचूी ह  जो डॉयमू ट म  अपने संबंिधत रेेस पेज के साथ उपिथत
होता ह ।
a) इंडेस
b) टेबल
c) िलपबोड
d) टेबल ऑफ कॉट ट

10. अितम कमाड के भाव को नट करने की कौन सी कमाड होती ह ।
a) िरडु (Redu)
b) कट (Cut)
c) अडु (Undo)
d) िलयर (Clear)

11. िकस कमाड की सहायता से परेू डॉयमेूट को िसलेट िकया जाता ह ।
a) िसलेट (Select)
b) िसलेट पेज (Select Page)
c) िसलेट ऑल (Select All)
d) िसलेट पेसल (Select Special)

12. िकस कमाड की सहायता से िकसी भी टैसट या ग ािफस को थाई प से हटाया जा सकता ह ।
a) िडलीट (Delete)
b) िडलीट ऑल (Delete All)
c) िलयर (Clear)
d) िलयर ऑल (Clear All)
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13. अपने टैट को इंडेट देने के िलए आप —————— टैब पर ‘’पैराग ाफ ग ुप’’ म  ‘’िडीज इंडट’’
और ‘’इंीज इंडट’’ का उपयोग कर सकते ह ।
a) इसट (Insert)
b) होम (Home)
c) पेज ले आउट (Page Layout)
d) डेटा (Data)

14. फॉट डायलॉग बास दिशत करने के िलए िकस कंुजी का योग िकया जाता ह ।
a) Ctrl + D
b)Ctrl + P
c) Ctrl + Shift + G
d) Ctrl + H

15. डायुम ट बनाने के िलए —————– िविभन कार के िवकप दान करते ह ।
a) माइोसॉट एसेल
b) माइोसॉट पावर वॉइंट
c) माइोसॉट वड
d) माइोसॉट एसेस

Answer Sheet
1. MS Word 2010 का पहला मेय ूकौन सा है।
Answer – b) फाइल (File)

2. Ms Word मे सबसे नीचे जो ीन दिशत होती है उसे या कहा जाता है।
Answer – a) टेटस बार (Status Bar)

3. Ms Word मे सबसे ऊपर िदखाई देने वाली बार को या कहा जाता है।
Answer – b) टाइटल बार (Title Bar)

4. फुटनोट और एंडनोट का उपयोग …………….. के िलए िकया जाता है।
Answer – a) िर स

5. ……………….. ग ािफक आपकी सचूना और िवचार का दृय ेजट शन है।
Answer – d) माटआट (Smart Art)

6. िसलेटेड लाइन का राईट एलाइनमट करने की शॉटकट कंुजी ह ।
Answer – a) Ctrl+ R
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7. िसलेटेड लाइन को जटीफाई एलाइनमट करने की शॉटकट या ह ।
Answer – d) Ctrl + J

8. गो टु कमाड की सहायता से डॉयमूट म  ——————– को िदए गए थान पर भेजा जा सकता
ह ।
Answer – a) कसर

9. ——————– एक िवषय सचूी ह  जो डॉयमू ट म  अपने संबंिधत रेेस पेज के साथ उपिथत
होता ह ।
Answer – d) टेबल ऑफ कॉट ट

10. अितम कमाड के भाव को नट करने की कौन सी कमाड होती ह ।
Answer – c) अडु (Undo)

11. िकस कमाड की सहायता से परेू डॉयमेूट को िसलेट िकया जाता ह ।
Answer – c) िसलेट ऑल (Select All)

12. िकस कमाड की सहायता से िकसी भी टैसट या ग ािफस को थाई प से हटाया जा सकता ह ।
Answer – a) िडलीट (Delete)

13. अपने टैट को इंडेट देने के िलए आप —————— टैब पर ‘’पैराग ाफ ग ुप’’ म  ‘’िडीज इंडट’’
और ‘’इंीज इंडट’’ का उपयोग कर सकते ह ।
Answer – b) होम (Home)

14. फॉट डायलॉग बास दिशत करने के िलए िकस कंुजी का योग िकया जाता ह ।
Answer – (a) Ctrl + D

15. डायुम ट बनाने के िलए —————– िविभन कार के िवकप दान करते ह ।
Answer – (c) माइोसॉट वड
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ऍम एस वड भाग – 3 (िहंदी म )
1. एम एस वड 2007 मे टेट सलेट करने पर ……………… वत : दिशत होता है।
a) टाकबार (Taskbar)
b) िमनीबार (Minibar)
c) मीनी टूलबार (Mini Toolbar)
d) मेयबूार (Menubar)

2. एम एस वड मे बनी हुई फाइल का एसट शन होता है।
a) वड (Word)
b) डॉस (DOX)
c) आर टी एफ (RTF)
d) बीएमपी (BMP)

3. लाईन के आरभ मे जाने के िलए िकस कंुजी का उपयोग िकया जाता है।
a) Ctrl + Home
b) Home
c) Up Arrow
d) Page Up

4. टी ओ सी का उपयोग करके आप या बना सकते है।
a) हेिडंग टाईस
b) कटम टाईस
c) आउटलाइन लेवस
d) उपरोत सभी

5. वड 2010 के फाइल मेय ूके या काय कर सकते ह ।
a) नई फाईल बनाना
b) पुरानी फाईल खोलना
c) फाईल सेव करना
d) उपरोत सभी

6. ———————– के जिरए आप वतमान डॉयमू ट की िकसी लोकेशन को दसूरे डॉयमू ट या
वेबसाइट से जोड़ते ह ।
a) िलंक
b) हाइपरिलंक
c) हाइपोिलंक
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d) िलंकेज

7. सबिट करने की शॉटकट कंुजी ——————— होती ह ।
a) Shift + S
b) Ctrl + =
c) Ctrl + Shift + $
d) Ctrl+ –

8. सुपरिट करने की शॉटकट कंुजी —————— होती ह ।
a) Shift + Ctrl + एज
b) Ctrl + Shift +  +
c) Ctrl + $
d) Ctrl + –

9. डबल लाइन पेिसंग की शॉटकट कंुजी ——————— होती ह ।
a) Ctrl + 1
b) Ctrl + 2
c) Shift + 1
d) Shift + 2

10. िकस कमाड ारा अय सॉटवेयर से लाए गए ऑजेट म  पिरवतन कर सकते ह ।
a) च ज ऑजेट
b) ऑजेट
c) कवट ऑजेट
d) इनम  से कोई नहीं

11. िकसी भी टेसट व ग ािफस को कट और कॉपी करने से पहले वह िकस िथित म  होना चािहए।
a) िसलेटेड (Selected)
b) इपोट (Import)
c) पेट (Paste)
d) इनम  से कोई नही ं(None of Above)

12. ———————— समानाथक शादो ं की शदकोष है िजसका उपयोग समानाथक शदो ं को
खोजने के िलए कर सकते ह ।
a) ट ांसलेट (Translate)
b) पेिलंग (Spelling )
c) िथसोस (Thesaurus)
d) िरसच (Research)
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13. िकस कमाड की सहायता से िकसी भी टैट, फुटनोट, एंडनोट या माक  को सच िकया जा सकता
ह ।
a) सच (Search)
b) फाइंड (Find)
c) गो टू (Go To )
d) सच ऑल (Search All)

14. वेब पेज िडजाइन करते समय ——————- िट भाषा का योग िकया जाता ह ।
a) एचटीएमएल (Hyper Text Markup Language)
b) एचएलएमएल (Hyper Link Markup Language)
c) एचटीडयएूल (Hyper Text Web Language)
d) इनम  से कुछ भी नही ं(None of Above)

15. ———————— एक िवषय सचूी ह  जो डॉयमू ट म  अपने संबंिधत रेेस पेज के साथ
उपिथत होता ह ।
a) इंडेस (Index)
b) टेबल (Table)
c) टेबल ऑफ कॉट ट (Table Of Content)
d) िलपबोड (Clipboard)

Answer Sheet
1. एम एस वड 2007 मे टेट सलेट करने पर ……………… वत : दिशत होता है।
Answer – c) मीनीटूलबार  (Minibar)

2. एम एस वड मे बनी हुई फाइल का एसट शन होता है।
Answer – b) डॉस (DOX)

3. लाईन के आरभ मे जाने के िलए िकस कंुजी का उपयोग िकया जाता है।
Answer – b) Home

4. टी ओ सी का उपयोग करके आप या बना सकते है।
Answer – d) उपरोत सभी

5. वड 2010 के फाइल मेय ूके या काय कर सकते ह ।
Answer – d) उपरोत सभी

6. ———————– के जिरए आप वतमान डॉयमू ट की िकसी लोकेशन को दसूरे डॉयमू ट या
वेबसाइट से जोड़ते ह ।
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Answer – b) हाइपरिलंक

7. सबिट करने की शॉटकट कंुजी ——————— होती ह ।
Answer – b) Ctrl+ =

8. सुपरिट करने की शॉटकट कंुजी —————— होती ह ।
Answer – b) Ctrl + Shift +  +

9. डबल लाइन पेिसंग की शॉटकट कंुजी ——————— होती ह ।
Answer – b) Ctrl+ 2

10. िकस कमाड ारा अय सॉटवेयर से लाए गए ऑजेट म  पिरवतन कर सकते ह ।
Answer – b) ऑजेट

11. िकसी भी टेसट व ग ािफस को कट और कॉपी करने से पहले वह िकस िथित म  होना चािहए।
Answer – a) िसलेटेड

12. ———————— समानाथक शादो ं की शदकोष है िजसका उपयोग समानाथक शदो ं को
खोजने के िलए कर सकते ह ।
Answer – c) िथसोस

13. िकस कमाड की सहायता से िकसी भी टैट, फुटनोट, एंडनोट या माक  को सच िकया जा सकता
ह ।
Answer – c) गो टू

14. वेब पेज िडजाइन करते समय ——————- िट भाषा का योग िकया जाता ह ।
Answer – a) एचटीएमएल (Hyper Text Markup Language)

15. ———————— एक िवषय सचूी ह  जो डॉयमू ट म  अपने संबंिधत रेेस पेज के साथ
उपिथत होता ह ।
Answer – c) टेबल ऑफ कॉट ट (Table Of Content)
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ऍम एस वड भाग – 4 (िहंदी म )
1. िरलेस कमाड की सहायता से डॉयमू ट म  दी गई कौन-कौन सी चीजो ंको बदला जा सकता ह ।
a) टेट फॉरमेट ग ािफक
b) फुटनॉट एडनॉट
c) ग ाफ ऍनोटेशन
d) उपरोत सभी

2. कट व कॉपी करने पर िसलेटेड टेट कहा ँचला जाता ह ।
a) िरसाईल िबन (Recycle Bin)
b) माई कयटूर (My Computer)
c) िलपबोड (Clipboard)
d) डेकटॉप (Desktop)

3. िकस य ूम  हैडर, फुटर, बैकग ाउडं आिद ीन पर दिशत होती ह ।
a) ड ाट (Draft)
b) वेब लेआउट (Web Layout)
c) आउट लाइन (Outline)
d) िंट लेआउट (Print Layout)

4. िकस य ूम  डॉयमू ट साधारण प म  फॉरमेिटंग के िबना नजर आता ह ।
a) नॉरमल (Normal)
b) वेब लेआउट (Web Layout)
c) आउट लाईन (Outline)
d) डेक टॉप (Desktop)

5. डॉयमू ट को वत : ही सही करने के िलए हम ——————- का उपयोग करते ह ।
a) ऑटो करेट फीचर (Auto Correct Feature)
b) ऑटो कपलीट फीचर (Auto Complete Feature)
c) िबिडंग लॉस  (Building Blocks )
d) फोमिटंग (Formatting)

6. कौन-कौन सी कमाड्स के िलए एक ही डायलॉग बॉस होता ह ।
a) फांईड, गो टु (Find, Go To)
b) गो टु, िरपलेस, फाईडं (Go To, Replace, Find)
c) फाईडं, िलयर, गो टु (Find, Clear, Go To )
d) िलयर, गो टु, िरपलेस (Clear, Go To, Replace)
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7. िनन म  से कौन सा िरबन टैब, वड 2007 म  नही ंहोता ह ।
a) होम (Home)
b) टूस (Tools)
c) पेज लेआउट (Page Layout)
d) इसट (Insert)

8. सेव एज कमाड ारा हम अपने डॉयमू ट फाइल को िकस फॉरमेट म  सेव कर सकते ह ।
a) एचटीएमएल (HTML)
b) एसएमएल (XML)
c) वेब पेज (Web Page)
d) उपरोत सभी (All Of Above)

9. िंट कमाड के पेज रज म  कौन सा ऑशन होता ह ।
a) ऑल
b) करंट पेज
c) पेजस
d) उपरोत सभी

10. िकस कमाड से डॉयमू ट को ई-मेल ारा िकसी को भी भेज सकते ह ।
a) िट (Print)
b) सेड टू (Send to)
c) गो टू (Go To)
d) A तथा B

11. पहले से सेव िकए गए डॉयमू ट को िकसी अय नाम से सेव करने के िलए ———————-
कमाड का उपयोग िकया जाता ह ।
a) होम  (Home)
b) टूस (Tools)
c) पेज लेआउट (Page Layout)
d) इसट (Insert)

12. हैडर व फुटर ऑशन िकस कमाड की सहायता से बदले जा सकते ह ।
a) पेज सेटअप (Page Setup)
b) हैडर और फुटर (Header and Footer)
c) य ू(New)
d) A और B

13. वड म  नया डॉयुमट िकस टेपलेट पर आधािरत होता ह ।
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a) जनल (General)
b) नॉरमल (Normal)
c) ट पलेट (template)
d) टैडड (Standard)

14. वड की फाइल म  या-या हो सकता ह ।
a) टेट (Text)
b) ग ािफस (Graphs)
c) टेबल (Table)
d) उपरोत सभी (All Of Above)

15. िसलेटेड लाइन को इटैिलक करने की शॉटकट कंुजी ह ।
a) Alt + F
b) Ctrl + E
c) Alt+ I
d) Ctrl + I

Answer Sheet
1. िरलेस कमाड की सहायता से डॉयमू ट म  दी गई कौन-कौन सी चीजो ंको बदला जा सकता ह ।
Answer – d) उपरोत सभी

2. कट व कॉपी करने पर िसलेटेड टेट कहा ँचला जाता ह ।
Answer – c) िलपबोड (Clipboard)

3. िकस य ूम  हैडर, फुटर, बैकग ाउडं आिद ीन पर दिशत होती ह ।
Answer – d) िंट लेआउट (Print Layout)

4. िकस य ूम  डॉयमू ट साधारण प म  फॉरमेिटंग के िबना नजर आता ह ।
Answer – c) आउट लाईन (Out Line)

5. डॉयमू ट को वत : ही सही करने के िलए हम ——————- का उपयोग करते ह ।
Answer – a) ऑटो करेट फीचर (Auto Correct Feature)

6. कौन-कौन सी कमाड्स के िलए एक ही डायलॉग बॉस होता ह ।
Answer – b) गो टु, िरपलेस, फाईडं Go To, Replace, Find

7. िनन म  से कौन सा िरबन टैब, वड 2007 म  नही ंहोता ह ।
Answer – b) Tools
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8. सेव एज कमाड ारा हम अपने डॉयमू ट फाइल को िकस फॉरमेट म  सेव कर सकते ह ।
Answer – d) उपरोत सभी (All Of Above)

9. िंट कमाड के पेज रज म  कौन सा ऑशन होता ह ।
Answer – d) उपरोत सभी (All Of Above)

10. िकस कमाड से डॉयमू ट को ई-मेल ारा िकसी को भी भेज सकते ह ।
Answer – c) गो टू Go To

11. पहले से सेव िकए गए डॉयमू ट को िकसी अय नाम से सेव करने के िलए ———————-
कमाड का उपयोग िकया जाता ह ।
Answer – b) टूस (Tools)

12. हैडर व फुटर ऑशन िकस कमाड की सहायता से बदले जा सकते ह ।
Answer – b) हैडर और फुटर (Header and Footer)

13. वड म  नया डॉयुमट िकस टेपलेट पर आधािरत होता ह ।
Answer – b) नॉरमल (Normal)

14. वड की फाइल म  या-या हो सकता ह ।
Answer – d) उपरोत सभी  (All Of Above)

15. िसलेटेड लाइन को इटैिलक करने की शॉटकट कंुजी ह ।
Answer – d) Ctrl + I
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ऍम एस वड भाग – 5 (िहंदी म )
1. डॉयमूट म  माउस ारा एक लाइन को िसलेट करने के िलए िकस ऑशन का उपयोग िकया जाता
ह ।
a) तीन बार िलक करके
b) दो बार िलक करके
c) चार बार िलक करके
d) ोल बटन ारा

2. िकस कमाड की सहायता से हम अपने डॉयमू ट म  पवू पिरभािषत टेट डाल सकते ह ।
a) ऑटो करेट (Auto Correct)
b) ऑटो टेट(Auto Text)
c) A और B (Both)
d) इनम  से कोई नही ं(None of Above)

3. िवशेष िचह को इसट  करने के िलए कौनसी कमाड होती ह ।
a) इसट (Insert)
b) िसंबल (Symbol)
c) पेशल करेटर (Special character)
d) इनम  से कोई नही ं(None of Above)

4. वड म  नई फाईल बनाने की शॉटकट कंुजी —————– होती ह ।
a) Ctrl + N
b) Ctrl + W
c) Ctrl + E
d) Ctrl + M

5. फाइल को खोलने की शाटकट कंुजी —————- होती ह ।
a) Ctrl + E
b) Ctrl + W
c) Ctrl + O
d) Ctrl + M

6. िकस बटन ारा हैिडंग, सबहैिडंग व बॉडी टैट को छुपाया जा सकता ह ।
a) ामोट
b) एसप ड
c) कॉलेस
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d) िडमोट

7. फैस, इवाइस या यवसाियक प जैसे कायो के िलए —————- एक पहले से िडजाइन िकया
हुआ डॉयमेूट होता ह ।
a) टेपलेट (Template)
b) फाइल (File)
c) फॉम (Form)
d) डेटाबेस (Database)

8. पेज पर उपिथत िकसी शद के बारे म  उसी पेज के नीचे िलखा गया छोटा िववरण या कहलाता ह ।
a) हेडर (Header)
b) फुटर (Footer)
c) एंडनोट (End-note)
d) फुटनोट (Foot-note)

9. बायी ंतरफ से िकसी अकेले करेटर को िमटाने के िलए आप —————— कंुजी (key) ेस कर
सकते ह ।
a) िडलीट (Delete)
b) बैकपेस (Backspace)
c) एटर (Enter)
d) पेसबार (Backspace)

10. िकस ऑशन के ारा सभी टूल बॉस, ोल बार, टाईटल बार आिद ीन से हट जाते ह ।
a) फुल ीन  (Full Screen)
b) जमू (Zoom)
c) हाईड (Hide)
d) शो (Show)

11. िपचर कमाड ारा िपचर को कहां से इसट  कर सकते ह ।
a) ॉम फाईल
b) ऑटो शेप
c) चाट
d) उपरोत सभी

12. टेसट बॉस कमाड ारा टेट बॉस की फॉरमेिटंग िकस कार कर सकते ह ।
a) टेसट बॉस व टेसट का रंग बदल सकते ह
b) टेसट बॉस म  शेिडंग, आकार, टाइल व फॉट ह
c) A और B
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d) ग ािफस डाल सकते ह

13. यजू पेपर कॉलस के िलए सामाय एलीकेशन ह ।
a) यजू रीिडंग(News Reading)
b) यजू लेटर (News Letter)
c) यजू (News)
d) यजू एिडटर (News Editor)

14. टूलबार कमाड की सहायता से या िकया जाता ह ।
a) िविभन टूलबार को ीन पर ऑन/ऑफ कर सकते ह
b) नई टूलबार बना व हटा सकते ह
c) टूलबार का नाम बदल सकते ह
d) उपरोत सभी

15. लर कमाड का या काय होता ह ।
a) लर बार को िदखाना या छुपाना
b) लर बार का नाम बदलना
c) टेट फॉरमेिटग
d) इनम  से कोई नहीं

Answer Sheet
1. डॉयमूट म  माउस ारा एक लाइन को िसलेट करने के िलए िकस ऑशन का उपयोग िकया जाता
ह ।
Answer – a) तीन बार िलक करके

2. िकस कमाड की सहायता से हम अपने डॉयमू ट म  पवू पिरभािषत टेट डाल सकते ह ।
Answer – b) ऑटो टेट (Auto Text)

3. िवशेष िचह को इसट  करने के िलए कौनसी कमाड होती ह ।
Answer – b) िसंबल (Symbol)

4. वड म  नई फाईल बनाने की शॉटकट कंुजी —————– होती ह ।
Answer – a) Ctrl + N

5. फाइल को खोलने की शाटकट कंुजी —————- होती ह ।
Answer – c) Ctrl + O

6. िकस बटन ारा हेिडंग, सबहेिडंग व बॉडी टेट को छुपाया जा सकता ह ।
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Answer – c) कॉलेस

7. फेस, इवाइस या यवसाियक प जैसे कायो के िलए —————- एक पहले से िडजाइन िकया
हुआ डॉयमेूट होता ह ।
Answer – a) टेपलेट (Templates)

8. पेज पर उपिथत िकसी शद के बारे म  उसी पेज के नीचे िलखा गया छोटा िववरण या कहलाता ह ।
Answer – d) फुटनोट (Foot-note)

9. बायी ंतरफ से िकसी अकेले करेटर को िमटाने के िलए आप —————— पेस ेस कर सकते ह ।
Answer – b) बेकपेस (Backspace)

10. िकस कमाड ारा सभी टूल बॉस, ोल बार, टाईटल बार आिद ीन से हट जाते ह ।
Answer – a) फुल ीन (Full Screen)

11. िपचर कमाड ारा िपचर को कहॉ-ंकहॉ ंसे इसट  कर सकते ह ।
Answer – a) फॉम फाईल

12. टेसट बॉस कमाड ारा टेट बॉस की फॉरमेिटंग िकस कार कर सकते ह ।
Answer – c) A और B

13. यजू पेपर कॉलस के िलए सामाय एलीकेशन ह ।
Answer – b) यजू लेटर (News Letter)

14. टूलबार कमाड की सहायता से या िकया जाता ह ।
Answer – d) उपरोत सभी

15. लर कमाड का या काय होता ह ।
Answer – b) लर बार को िदखाना या छुपाना
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ऍम एस वड भाग – 6 (िहंदी म )
1. डॉयमेूट म  िचिहत की हुई िनिचत लोकेशन पर पहंुचने के िलए िकस ऑशन का उपयोग होता
ह ।
a) इंडेस (Index)
b) हाइपरिलंक (Hyperlink)
c) बुकमाक  (Bookmark)
d) टेबल (Table)

2. वड िवंडो को बद करने की शाटकट कंुजी —————— होती ह ।
a) Ctrl + F4
b) Alt + F4
c) Ctrl + F3
d) Alt + C

3. फॉट कमाड ारा िकसकी फॉरमेिटंग की जा सकती ह ।
a) करेटर (Character)
b) पेरेग ाफ (Paragraph)
c) पेज (Page)
d) उपरोत सभी (All of Above)

4. पैराग ाफ व लाइनो ंकी मय जगह को यविथत करने के िलए िकस िकस कमाड का योग िकया
जाता ह ।
a) लाईन (Line)
b) पेरेग ाफ (Paragraph)
c) लाईन और पैराग ाफ पेिसंग  (Line and Paragraph Spacing)
d) उपरोत सभी (All of Above)

5. Find कमांड की शाटकट कंुजी —————— होती ह ।
a) Ctrl + K
b) Ctrl + F
c) Ctrl + D
d) Ctrl + U

6. िकस कमाड ारा कसर की वतमान िथित पर पेज को ब ेक िकया जाता ह ।
a) इसट (Insert)
b) पेज ब ेक (Page Break)

ANKAJ INFOTECH

https://computerobjectivequestions.com/ms-office/%e0%a4%8d%e0%a4%ae-%e0%a4%8f%e0%a4%b8-%e0%a4%b5%e0%a4%b0%e0%a5%8d%e0%a4%a1-%e0%a4%ad%e0%a4%be%e0%a4%97-6-%e0%a4%b9%e0%a4%bf%e0%a4%82%e0%a4%a6%e0%a5%80-%e0%a4%ae%e0%a5%87%e0%a4%82/


c) सेशन ब ेक (Section  Break)
d) उपरोत सभी (All of Above)

7. पेज नबर कमाड ारा पेज नबर म  या पिरवतन िकया जा सकता ह ।
a) पेज नबर की पॉिजशन
b) पेज नबर को अलाइनम ट
c) पेज नबर की फॉरमेिटंग
d) उपरोत सभी

8. जब आप होम टैब पर, फॉरमेट पटर आइकन पर िलक करते ह  तो आपका माउस वॉइंटर
—————- के आकार का हो जाता ह ।
a) प टब श (Paint Brush)
b) आईबीम (IBM)
c) एरो (Arrow)
d) उपरोत सभी (All of Above)

9. िवडोज म  हेप के िलए —————– शॉटकट कंुजी होती ह ।
a) F1
b) F2
c) F3
d) F4

10. वड म  पेिलंग की जांच हेतु —————- शॉटकट कंुजी होती ह ।
a) F2
b) F7
c) F8
d) F4

11. िरलेस कमांड की शाटकट कंुजी —————- होती ह ।
a) Ctrl + K
b) Ctrl + H
c) Ctrl + U
d) Ctrl + N

12. गोटू कमांड की शाटकट कंुजी ————— होती ह ।
a) Ctrl + K
b) Ctrl + G
c) Ctrl + U
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d) Ctrl + N

13. कौन सा बटन या काय करता ह  इसके बारे म  िवतृत वणन —————— दान करता ह ।
a) सुपरटूलसीप
b) सबटूलसीप
c) इफ
d) की-िटप

14. डेट टाईम कमाड ारा डेट व टाईम को कहॉ ंइसट  िकया जा सकता ह ।
a) पेज के ऊपर
b) पेज के नीचे
c) कसर की वतमान िथित पर
d) उपरोत सभी

15. —————— एलीकेशन आपको पसनल लेटर, फॉम लेटर, बॉशर, फैस और यवसाियक
मैयअूल जैसे िविभन कार के िलिखत डायमूट तैयार करने म  मदद करता ह ।
a) वड ोसेसर
b) वड पैड
c) नोट पैड
d) इनम  से कोई नहीं

Answer Sheet
1. डॉयमेूट म  िचिहत की हुई िनिचत लोकेशन पर पहंुचने के िलए इसका उपयोग होता ह ।
Answer – c) बुकमाक  (Bookmark)

2. वड िवंडो को बद करने की शाटकट कंुजी —————— होती ह ।
Answer – b) Alt + F4

3. फॉट कमाड ारा िकसकी फॉरमेिटंग की जा सकती ह ।
Answer – a) करेटर  Character)

4. पैराग ाफ व लाइनो ंकी मय जगह को यविथत करने के िलए िकस िकस कमाड का योग िकया
जाता ह ।
Answer – c) लाईन और पेरेग ाफ पेिसंग   (Line and Paragraph Spacing)

5. फाड कमांड की शाटकट कंुजी —————— होती ह ।
Answer – b) Ctrl + F

ANKAJ INFOTECH



6. िकस कमाड ारा कसर की वतमान िथित पर पेज को ब ेक िकया जाता ह ।
Answer – b) पेज ब ेक  (Page Break)

7. पेज नबर कमाड ारा पेज नबर म  या पिरवतन िकया जा सकता ह ।
Answer – d) उपरोत सभी (All of Above)

8. जब आप होम टैब पर, फॉरमेट पटर आइकन पर िलक करते ह  तो आपका माउस वॉइंटर
—————- के आकार का हो जाता ह ।
Answer – a) प टब श  (Paint Brush)b

9. िवडोज म  हेप के िलए —————– शॉटकट कंुजी होती ह ।
Answer – a) F1

10. वड म  पेिलंग की जांच हेतु —————- शॉटकट कंुजी होती ह ।
Answer – b) F7

11. िरलेस कमांड की शाटकट कंुजी —————- होती ह ।
Answer – b) Ctrl + H

12. गोटू कमांड की शाटकट कंुजी ————— होती ह ।
Answer – b) Ctrl + G

13. कौन सा बटन या काय करता ह  इसके बारे म  िवतृत वणन —————— दान करता ह ।
Answer – a) सुपरटूलसीप

14. डेट टाईम कमाड ारा डेट व टाईम को कहॉ ंइसट  िकया जा सकता ह ।
Answer – c) कसर की वतमान िथित पर

15. —————— एलीकेशन आपको पसनल लेटर, फॉम लेटर, बॉशर, फैस और यवसाियक
मैयअूल जैसे िविभन कार के िलिखत डायमूट तैयार करने म  मदद करता ह ।
Answer – a) वड ोसेसर
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ऍम एस वड भाग – 7 (िहंदी म )
1. MS Word 2010 का पहला मेय ूकौन सा है।
a) टूस
b) फाइल
c) ओपन
d) यू

2. Ms Word मे सबसे नीचे जो ीन दिशत होती है उसे या कहा जाता है।
a) टेटस बार (Status Bar)
b) टाइटल बार (Tittle Bar)
c) मेय ूबार (Menu Bar)
d) एंड बार (End Bar)

3. Ms Word मे सबसे ऊपर िदखाई देने वाली बार को या कहा जाता है।
a) टूल बार (Tool Bar)
b) टाइटल बार (Tittle Bar)
c) टेडड टूल बार (Standard Tool Bar)
d) टाक बार (Task Bar)

4. फुटनोट और एंडनोट का उपयोग …………….. के िलए िकया जाता है।
a) िर स (Reference)
b) सचूना (Information)
c) िलट (List)
d) वांइंट (Point)

5. ……………….. ग ािफक आपकी सचूना और िवचार का दृय ेजट शन है।
a) वडआट (Word Art)
b) िलपआट (Clip Art)
c) ऑटोशेप (Auto Shape)
d) माटआट (Smart Art)

6. िसलेटेड लाइन का राईट एलाइनमट करने की शॉटकट कंुजी ह ।
a) Shift + R
b) Shift + I
c) Ctrl + J
d) Ctrl + I
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7. िसलेटेड लाइन को जटीफाई एलाइनमट करने की शॉटकट या ह ।
a) Shift + R
b) Shift + I
c) Ctrl + J
d) Ctrl + I

8. गो टु कमाड की सहायता से डॉयमूट म  ——————– को िदए गए थान पर भेजा जा सकता
ह ।
a) कसर (cursor)
b) पेज नबर (Page Number)
c) टेसट (Text)
d) कैरेटर (Character)

9. ——————– एक िवषय सचूी ह  जो डॉयमू ट म  अपने संबंिधत रेेस पेज के साथ उपिथत
होता ह ।
a) इंडेस (Index)
b) टेबल (Table)
c) िलपबोड (Clipboard)
d) टेबल ऑफ कॉट ट (Table of Content)

10. अंितम कमाड के भाव को नट करने की कौन सी कमाड होती ह ।
a) िरडु (Undo)
b) कट (Cut)
c) अडु (Undo)
d) िलयर Clear)

11. िकस कमाड की सहायता से परेू डॉयमेूट को िसलेट िकया जाता ह ।
a) िसलेट (Select)
b) िसलेट पेज Select Page)
c) िसलेट ऑल (Select All)
d) िसलेट पेिलंग (Select Spelling)

12. िकस कमाड की सहायता से िकसी भी टैसट या ग ािफस को थाई प से हटाया जा सकता ह ।
a) िडलीट (Delete)
b) िडलीट ऑल (Delete All)
c) िलयर (Clear)
d) िलयर ऑल (Clear All)

ANKAJ INFOTECH



13. अपने टैट को इंडेट देने के िलए आप —————— टैब पर ‘’पैराग ाफ ग ुप’’ म  ‘’िडीज इंडट’’
और ‘’इंीज इंडट’’ का उपयोग कर सकते ह ।
a) इसट (Insert)
b) होम (Home)
c) पेज ले आउट (Page Layout)
d) डेटा (Data)

14. फॉट डायलॉग बास दिशत करने के िलए िकस कंुजी का योग िकया जाता ह ।
a) Ctrl + D
b) Ctrl + P
c) Ctrl + Shift+ G
d) Ctrl + H

15. डायुम ट बनाने के िलए —————– िविभन कार के िवकप दान करते ह ।
a) माइोसॉट एसेल (Microsoft Excel)
b) माइोसॉट पावर वॉइंट (Microsoft Powerpoint)
c) माइोसॉट वड  (Microsoft Word)
d) माइोसॉट एसेस  (Microsoft Access)

Answer Sheet
1. MS Word 2010 का पहला मेय ूकौन सा है।
Answer – b) फाइल (File)

2. Ms Word मे सबसे नीचे जो ीन दिशत होती है उसे या कहा जाता है।
Answer – a) टेटस बार (Status Bar)

3. Ms Word मे सबसे ऊपर िदखाई देने वाली बार को या कहा जाता है।
Answer – b) टाइटल बार (Tittle Bar)

4. फुटनोट और एंडनोट का उपयोग …………….. के िलए िकया जाता है।
Answer – a) िर स (Reference)

5. ……………….. ग ािफक आपकी सचूना और िवचार का दृय ेजट शन है।
Answer – d) माटआट (Smart Art)

6. िसलेटेड लाइन का राईट एलाइनमट करने की शॉटकट कंुजी ह ।
Answer – c) Ctrl + J
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7. िसलेटेड लाइन को जटीफाई एलाइनमट करने की शॉटकट या ह ।
Answer – d) Ctrl + I

8. गो टु कमाड की सहायता से डॉयमूट म  ——————– को िदए गए थान पर भेजा जा सकता
ह ।
Answer – a) कसर (Cursor)

9. ——————– एक िवषय सचूी ह  जो डॉयमू ट म  अपने संबंिधत रेेस पेज के साथ उपिथत
होता ह ।
Answer – d) टेबल ऑफ कॉट ट (Table of Content)

10. अंितम कमाड के भाव को नट करने की कौन सी कमाड होती ह ।
Answer – c) अडु (Undo)

11. िकस कमाड की सहायता से परेू डॉयमेूट को िसलेट िकया जाता ह ।
Answer – c) िसलेट ऑल (Select All)

12. िकस कमाड की सहायता से िकसी भी टैसट या ग ािफस को थाई प से हटाया जा सकता ह ।
Answer – a) िडलीट (Delete)

13. अपने टैट को इंडेट देने के िलए आप —————— टैब पर ‘’पैराग ाफ ग ुप’’ म  ‘’िडीज इंडट’’
और ‘’इंीज इंडट’’ का उपयोग कर सकते ह ।
Answer – b) होम (Home)

14. फॉट डायलॉग बास दिशत करने के िलए िकस कंुजी का योग िकया जाता ह ।
Answer – (a) Ctrl + D

15. डायुम ट बनाने के िलए —————– िविभन कार के िवकप दान करते ह ।
Answer – (c) माइोसॉट वड  (Microsoft Word)
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ऍम एस वड भाग – 8 (िहंदी म )
1. एम एस वड 2007 मे टेट सलेट करने पर ……………… वत : दिशत होता है।
a) टाक बार (Task Bar)
b) िमनी बार (Mini Bar)
c) मीनीटूल बार (MiniTool Bar)
d) मेय ूबार (Menu Bar)

2. एम एस वड मे बनी हुई फाइल का एसट शन होता है।
a) वड (Word)
b) डॉकएस (Docx)
c) आरटीएफ (RTF)
d) बीएमपी (BMP)

3. लाईन के आरभ मे जाने के िलए िकस कंुजी का उपयोग िकया जाता है।
a) Ctrl + Home
b) Home
c) Up Arrow
d) Page Up

4. टी ओ सी का उपयोग करके आप या बना सकते है।
a) हेिडंग टाईस
b) कटम टाईस
c) आउटलाइन लेवस
d) उपरोत सभी

5. वड 2010 के फाइल मेय ूके या काय कर सकते ह ।
a) नई फाईल बनाना
b) पुरानी फाईल खोलना
c) फाईल सेव करना
d) उपरोत सभी

6. ———————– के जिरए आप वतमान डॉयमू ट की िकसी लोकेशन को दसूरे डॉयमू ट या
वेबसाइट से जोड़ते ह ।
a) िलंक (Link)
b) हाइपरिलंक (Hyperlink)
c) हाइपोिलंक (Hypolink)
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d) िलंकेज (Linkej)

7. सबिट करने की शॉटकट कंुजी ——————— होती ह ।
a) Shift + S
b) Ctrl + =
c) Ctrl+ Shift + $
d) Ctrl+ –

8. सुपरिट करने की शॉटकट कंुजी —————— होती ह ।
a) Shift + Ctrl+ S
b) Ctrl+ Shift + =
c) Ctrl+ $
d) Ctrl+ –

9. डबल लाइन पेिसंग की शॉटकट कंुजी ——————— होती ह ।
a) Ctrl+ 1
b) Ctrl+ 2
c) Shift + 1
d) Shift + 2

10. िकस कमाड ारा अय सॉटवेयर से लाए गए ऑजेट म  पिरवतन कर सकते ह ।
a) च ज ऑजेट (Change Object)
b) ऑजेट (Object)
c) कवट ऑजेट (Convert Object)
d) इनम  से कोई नही ं(None of Above)

11. िकसी भी टेसट व ग ािफस को कट और कॉपी करने से पहले वह िकस िथित म  होना चािहए।
a) िसलेटेड (Selected)
b) इपोट (Import)
c) पेट (Paste)
d) इनम  से कोई नही ं(None of Above)

12. ———————— समानाथक शादो ं की शदकोष है िजसका उपयोग समानाथक शदो ं को
खोजने के िलए कर सकते ह ।
a) ट ांसलेट (Translate)
b) पेिलंग (Spelling)
c) िथसोस (Thesaurus)
d) िरसच (Research)
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13. िकस कमाड की सहायता से िकसी भी टैट, फुटनोट, एंडनोट या माक  को सच िकया जा सकता
ह ।
a) सच (Search)
b) फाइंड (Find)
c) गो टू (Go To)
d) सच ऑल (Search All)

14. वेब पेज िडजाइन करते समय ——————- िट भाषा का योग िकया जाता ह ।
a) एचटीएमएल (Hyper Text Markup Language)
b) एचएलएमएल (Hyper Link Markup Language)
c) एचटीडयएूल (Hyper Text Web Language)
d) इनम  से कुछ भी नही ं(None of Above)

15. ———————— एक िवषय सचूी ह  जो डॉयमू ट म  अपने संबंिधत रेेस पेज के साथ
उपिथत होता ह ।
a) इंडेस (index)
b) टेबल (Table)
c) टेबल ऑफ कॉट ट (Table of Content)
d) िलपबोड (Clipboard)

Answer Sheet
1. एम एस वड 2007 मे टेट सलेट करने पर ……………… वत : दिशत होता है।
Answer – c) मीनीटूलबार (MiniTool Bar)

2. एम एस वड मे बनी हुई फाइल का एसट शन होता है।
Answer – b) डॉकएस (Docx)

3. लाईन के आरभ मे जाने के िलए िकस कंुजी का उपयोग िकया जाता है।
Answer – b) Home

4. टी ओ सी का उपयोग करके आप या बना सकते है।
Answer – d) उपरोत सभी

5. वड 2010 के फाइल मेय ूके या काय कर सकते ह ।
Answer – d) उपरोत सभी

6. ———————– के जिरए आप वतमान डॉयमू ट की िकसी लोकेशन को दसूरे डॉयमू ट या
वेबसाइट से जोड़ते ह ।
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Answer – b) हाइपरिलंक (Hyperlink)

7. सबिट करने की शॉटकट कंुजी ——————— होती ह ।
Answer – b) Ctrl+ =

8. सुपरिट करने की शॉटकट कंुजी —————— होती ह ।
Answer – b) Ctrl+ Shift + =

9. डबल लाइन पेिसंग की शॉटकट कंुजी ——————— होती ह ।
Answer – b) Ctrl+ 2

10. िकस कमाड ारा अय सॉटवेयर से लाए गए ऑजेट म  पिरवतन कर सकते ह ।
Answer – b) ऑजेट (Object)

11. िकसी भी टेसट व ग ािफस को कट और कॉपी करने से पहले वह िकस िथित म  होना चािहए।
Answer – a) िसलेटेड (Selected)

12. ———————— समानाथक शादो ं की शदकोष है िजसका उपयोग समानाथक शदो ं को
खोजने के िलए कर सकते ह ।
Answer – c) िथसोस (Thesaurus)

13. िकस कमाड की सहायता से िकसी भी टैट, फुटनोट, एंडनोट या माक  को सच िकया जा सकता
ह ।
Answer – c) गो टू (Go To)

14. वेब पेज िडजाइन करते समय ——————- िट भाषा का योग िकया जाता ह ।
Answer – a) एचटीएमएल (Hyper Text Markup Language)

15. ———————— एक िवषय सचूी ह  जो डॉयमू ट म  अपने संबंिधत रेेस पेज के साथ
उपिथत होता ह ।
Answer – c) टेबल ऑफ कॉट ट (Table of Content)

ANKAJ INFOTECH



ऍम एस वड भाग – 9 (िहंदी म )
1. िरलेस कमाड की सहायता से डॉयमू ट म  दी गई कौन-कौन सी चीजो ंको बदला जा सकता ह ।
a) टेट फॉरमेट ग ािफक (Text Format Graphic)
b) फुटनोट एंडनोट (Footnote EndNote)
c) ग ाफ ऍनोटेशन (Graph Enotation)
d) उपरोत सभी (All of Above)

2. कट व कॉपी करने पर िसलेटेड टेट कहा ँचला जाता ह ।
a) िरसाईल िबन (Recycle Bin)
b) माई कयटूर (My Computer)
c) िलपबोड (Clipboard)
d) डेकटॉप (Desktop)

3. िकस य ूम  हैडर, फुटर, बैकग ाउडं आिद ीन पर दिशत होती ह ।
a) ड ाट (Draft)
b) वेब लेआउट (Web Layout)
c) आउट लाइन (Out line)
d) िंट लेआउट (Print Layout)

4. िकस य ूम  डॉयमू ट साधारण प म  फॉरमेिटंग के िबना नजर आता ह ।
a) नॉरमल (Normal)
b) वेब लेआउट (Web Layout)
c) आउट लाईन (Outline)
d) डेक टॉप (Desktop)

5. डॉयमू ट को वत : ही सही करने के िलए हम ——————- का उपयोग करते ह ।
a) ऑटो करेट फीचर (Auto Correct Feature)
b) ऑटो कपलीट फीचर (Auto Complete Feature)
c) िबिडंग लॉस (Building Blocks)
d) फोमिटंग (Formatting)

6. कौन-कौन सी कमाड्स के िलए एक ही डायलॉग बॉस होता ह ।
a) फांईड, गो टु  (Find, Go To)
b) गो टु, िरपलेस, फाईडं (Go To, Replace, Find)
c) फाईडं, िलयर, गो टु (Find, Clear, Go T0)
d) िलयर, गो टु, िरपलेस (Clear, Go T0, Replace)
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7. िनन म  से कौन सा िरबन टैब, वड 2007 म  नही ंहोता ह ।
a) होम (Home)
b) टूस (Tools)
c) पेज लेआउट (Page Layout)
d) इसट (Insert)

8. सेव एज कमाड ारा हम अपने डॉयमू ट फाइल को िकस फॉरमेट म  सेव कर सकते ह ।
a) एचटीएमएल (HTML)
b) एसएमएल (XML)
c) वेब पेज (Web Page)
d) उपरोत सभी (All of Above)

9. िंट कमाड के पेज रज म  कौन सा ऑशन होता ह ।
a) ऑल (All)
b) करंट पेज (Current Page)
c) पेज (Pages)
d) उपरोत सभी (All Above)

10. िकस कमाड से डॉयमू ट को ई-मेल ारा िकसी को भी भेज सकते ह ।
a) िट (Print)
b) सेड टू (Send To)
c) गो टू (Go To)
d) A तथा B

11. पहले से सेव िकए गए डॉयमू ट को िकसी अय नाम से सेव करने के िलए ———————-
कमाड का उपयोग िकया जाता ह ।
a) होम (Home)
b) फाइल  (File)
c) पेज लेआउट (Page Layout)
d) इसट (Insert)

12. हैडर व फुटर ऑशन िकस कमाड की सहायता से बदले जा सकते ह ।
a) पेज सेटअप (Page Setup)
b) हैडर और फुटर (Header and Footer)
c) य ू(New)
d) A और B

13. वड म  नया डॉयुमट िकस टेपलेट पर आधािरत होता ह ।
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a) जनल (General)
b) नामल (Normal)
c) ट पलेट (Template)
d) टैडड (Standard)

14. वड की फाइल म  या-या हो सकता ह ।
a) टेट (Text)
b) ग ािफस (Graphic)
c) टेबल (Table)
d) उपरोत सभी (All of Above)

15. िसलेटेड लाइन को इटैिलक करने की शॉटकट कंुजी ह ।
a) Alt + F
b) Ctrl + I
c) Alt + I
d) Ctrl + L

Answer Sheet
1. िरलेस कमाड की सहायता से डॉयमू ट म  दी गई कौन-कौन सी चीजो ंको बदला जा सकता ह ।
Answer – d) उपरोत सभी (All of Above)

2. कट व कॉपी करने पर िसलेटेड टेट कहा ँचला जाता ह ।
Answer – c) िलपबोड (Clipboard)

3. िकस य ूम  हैडर, फुटर, बैकग ाउडं आिद ीन पर दिशत होती ह ।
Answer – d) िंट लेआउट (Print Layout)

4. िकस य ूम  डॉयमू ट साधारण प म  फॉरमेिटंग के िबना नजर आता ह ।
Answer – c) आउट लाईन (Outline)

5. डॉयमू ट को वत : ही सही करने के िलए हम ——————- का उपयोग करते ह ।
Answer – a) ऑटो करेट फीचर (Auto Correct Feature)

6. कौन-कौन सी कमाड्स के िलए एक ही डायलॉग बॉस होता ह ।
Answer – b) गो टु, िरपलेस, फाईडं (Go To, Replace, Find)

7. िनन म  से कौन सा िरबन टैब, वड 2007 म  नही ंहोता ह ।
Answer – b) टूस (Tools)
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8. सेव एज कमाड ारा हम अपने डॉयमू ट फाइल को िकस फॉमट म  सेव कर सकते ह ।
Answer – d) उपरोत सभी (All of Above)

9. िंट कमाड के पेज रज म  कौन सा ऑशन होता ह ।
Answer – d) उपरोत सभी (All of Above)

10. िकस कमाड से डॉयमू ट को ई-मेल ारा िकसी को भी भेज सकते ह ।
Answer – c) गो टू (Go To)

11. पहले से सेव िकए गए डॉयमू ट को िकसी अय नाम से सेव करने के िलए ———————-
कमाड का उपयोग िकया जाता ह ।
Answer – b) फाइल  (File)

12. हैडर व फुटर ऑशन िकस कमाड की सहायता से बदले जा सकते ह ।
Answer – b) हैडर और फुटर (Header and Footer)

13. वड म  नया डॉयुमट िकस टेपलेट पर आधािरत होता ह ।
Answer – b) नामल (Normal)

14. वड की फाइल म  या-या हो सकता ह ।
Answer – d) उपरोत सभी (All of Above)

15. िसलेटेड लाइन को इटैिलक करने की शॉटकट कंुजी ह ।
Answer – a) Alt  + I
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ऍम एस वड भाग – 10 (िहंदी म )
1. िरलेस कमांड की शाटकट की —————– होती ह ।
a) Ctrl + K
b) Ctrl + H
c) Ctrl + U
d) Ctrl + N

2. गोटू कमांड की शाटकट की —————- होती ह ।
a) Ctrl + K
b) Ctrl + G
c) Ctrl + U
d) Ctrl + N

3. फुटनोट्स व एटनोट्स का उपयोग —————— के िलए िकया जाता ह ।
a) िर स (Reference)
b) सचूना (Information)
c) वॉइंट (Point)
d) िलट (List)

4. िकस कमाड की सहायता से कॉलम की संयाओं को घटाया व बढ़ाया जा सकता ह ।
a) कॉलम (Column)
b) पैराग ाफ (Paragraph)
c) लाईन (Line)
d) उपरोत सभी (All of Above)

5. फाइल को सेव करने की शाटकट की ——————– होती ह ।
a) Ctrl + E
b) Ctrl + S
c) Ctrl + O
d) F12

6. िकस कमाड की सहायता से पेराग ाफ के पहले अर को िलखे शदो ंकी अपेा बड़ा बनाया जाता
ह ।
a) िर स (Reference)
b) ड ॉप केप (Drop Cap)
c) बैक पेस (Back Space)
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d) इनम  से कोई नही ं(None of Above)

7. हायर आकी म  आइटम के तर म  बदलाव के िलए आप इसका उपयोग कर इडट को बढ़ा सकते ह ।
a) टैब (Tab)
b) बैकपेस (Back Space)
c) िडलीट (Delete)
d) पेसबार (Space-bar)

8. फाइल को सेव ऐज करने की शाटकट की ——————— होती ह ।
a) Ctrl + E
b) Ctrl + Shift + F12
c) Ctrl + F12
d) F12

9. चच कैश कमाड के ऑशन कौन-कौन से ह ।
a) सेटेस केस (Sentence Case)
b) अपर, लॉवर केस (Upper, Lower Case)
c) टॉगल केस, टाईटल केस (Toggle Case)
d) उपरोत सभी (All of Above)

10. िनन म  से कौनसा भाव टेट को नही ंदे सकते ह ।
a) िहडन (Hidden)
b) सुपरिट (Super-Script)
c) सबिट (Sub-Script)
d) इनम  से कोई नही ं(None of Above)

11. िकस कमाड की सहायता से हम वयं की टेट टाईल बना सकते ह ।
a) टाईल (Style)
b) फॉरमेट (Format)
c) ऑवर टाईल (Over Style)
d) य ूटाईल (New Style)

12. माइोसॉट वड ारा दान िकए गए िकसी मािणक टेपलेट्स का उपयोग आप
——————– जैसे डॉयमू ट के िलए करते ह ।
a) ब ाशर (Brosher)
b) िरयमू (Resume)
c) िरपोट (Report)
d) उपरोत सभी (All of Above)

ANKAJ INFOTECH



13. फाइल को िट करने की शाटकट की —————– होती ह ।
a) Ctrl + I
b) Ctrl + S
c) Ctrl + R
d) Ctrl + P

14. कौन सी कमाड डॉयमेूट म  िलखे शदो ंकी पेिलंग जाचँ करने के काम आती ह ।
a) पेिलंग और ग ामर (Spelling and Grammar)
b) पेल चेक (Spall Check)
c) ल वेज (Language)
d) इनम  से कोई नही ं(None of Above)

15. परेू डॉयमेूट को एक साथ िसलेट करने की शाटकट की —————– होती ह ।
a) Ctrl + S
b) Ctrl + A
c) Ctrl + B
d) Ctrl + C

Answer Sheet
1. िरलेस कमांड की शाटकट की —————– होती ह ।
Answer – b) Ctrl + H

2. गोटू कमांड की शाटकट की —————- होती ह ।
Answer – b) Ctrl + G

3. फुटनोट्स व एटनोट्स का उपयोग —————— के िलए िकया जाता ह ।
Answer – a) िर स (Reference)

4. िकस कमाड की सहायता से कॉलम की संयाओं को घटाया व बढ़ाया जा सकता ह ।
Answer – a) कॉलम (Column)

5. फाइल को सेव करने की शाटकट की ——————– होती ह ।
Answer – b) Ctrl + S

6. िकस कमाड की सहायता से पेराग ाफ के पहले अर को िलखे शदो ंकी अपेा बड़ा बनाया जाता
ह ।
Answer – b) ड ॉप केप (Drop Cap)
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7. हायर आकी म  आइटम के तर म  बदलाव के िलए आप इसका उपयोग कर इडट को बढ़ा सकते ह ।
Answer – a) टैब (Tab)

8. फाइल को सेव ऐज करने की शाटकट की ——————— होती ह ।
Answer – d) F12

9. चच कैश कमाड के ऑशन कौन-कौन से ह ।
Answer – d) उपरोत सभी (All of Above)

10. िनन म  से कौनसा भाव टेट को नही ंदे सकते ह ।
Answer – a) िहडन (Hidden)

11. िकस कमाड की सहायता से हम वयं की टेट टाईल बना सकते ह ।
Answer – d) य ूटाईल (New Style)

12. माइोसॉट वड ारा दान िकए गए िकसी मािणक टेपलेट्स का उपयोग आप
——————– जैसे डॉयमू ट के िलए करते ह ।
Answer – d) उपरोत सभी (All of Above)

13. फाइल को िट करने की शाटकट की —————– होती ह ।
Answer – d) Ctrl + P

14. कौन सी कमाड डॉयमेूट म  िलखे शदो ंकी पेिलंग जाचँ करने के काम आती ह ।
Answer – a) पेिलंग और ग ामर (Spelling and Grammar)

15. परेू डॉयमेूट को एक साथ िसलेट करने की शाटकट की —————– होती ह ।
Answer – b) Ctrl + A
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ऍम एस वड भाग – 11 (िहंदी म )
1. एिडट मेन ूका ऑशन ह ।
a) कट (Cut)
b) कॉपी (Copy)
c) पेट (Paste)
d) उपयुत सभी (All of Above)

2. टेट चयिनत को कट करने का शॉटकट ह ।
a) Ctrl + C
b) Ctrl + V
c) Ctrl + X
d) उपयुत म  से कोई नहीं

3. िकसी टेट का वह टुकड़ा जो सबसे ऊपर िंट होता ह , वह ह ।
a) फुटर (Footer)
b) हैडर (Header)
c) सेटर (Center)
d) उपरोत सभी (All of Above)

4. कट ोल मेन ू िथत होता ह ।
a) टाइटल बार (Tittle Bar)
b) टेटस बार (Status Bar)
c) मेन ू बार (Menu Bar)
d) उपयुत कोई नही ं(None of Above)

5. वड के शु होने पर ऑिफस अिसट ट पर एक िटप आता ह  िजसे कहते ह ।
a) िटप (Tip)
b) िटप ऑप िद डे (Tip up the day)
c) डायलॉग बॉस (Dailog box)
d) कोई नही ं(None of Above)

6. िनन म  से वड ोसेसर ह ।
a) वड टार (Word Star)
b) एम एस वड (Ms Word)
c) वड परफेट (Word Parfact)
d) उपयुत सभी (All of  Above)
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7. िकसी टेट के अरो ंका प बदलने को कहा जाता ह ।
a) टाइिपंग (Typing)
b) ओपिनंग (Opening)
c) फॉमिटंग (Formatting)
d) एिडिटंग (Editing)

8. वड ोसेसर फोम िटंग के अतगत करता ह ।
a) पेज ल थ डेिफनेशन (Page Length Defination)
b) विटकल अलाइनमेट (Varietal Alignment)
c) जिटिफकेशन (Justification)
d) उपयुत सभी (All of Above)

9. िकसी शद को गहरा करने के िलए योग करते ह ।
a) जिटिफकेशन (Justification)
b) एबोिलंड्ग (Emboldening)
c) विटकल अलाइनमेट (Varietal Alignment)
d) उपयुत सभी (All of Above)

10. पैराग ाफ म  दायी ंतरफ एक अर पहले जाने के िलए ‘की’ काम म  लेते ह ।
a) अप एरो (Up Arrow)
b) राईट एरो (Right Arrow)
c) डाउन एरो (Down Arrow)
d) लेट एरो (Left Arrow)

11. वड म  गो टू ऑशन का योग िकया जाता ह , िकसी।
a) लाइन पर जाने हेतु
b) बुकमाक  पर जाने के िलए
c) पेज पर जाने के िलए
d) उपयुत सभी

12. िनन म  से एम एस वड का ऑशन नही ंह ।
a) फंशन  मेन ू(Function Menu)
b) हैडर और फुटर (Header and Footer)
c) ऑटो फोरमेट मेन ू(Auto Format Menu)
d) उपयुत कोई नही ं(None of Above)

13. िकसी डॉयमेूट म  से िकसी टेट को एक थान से हटाकर दसूरी जगह कॉपी िकया जा सकता ह ।
a) कट ारा
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b) कॉपी ारा
c) ‘कट’ व ‘पेट’ ारा
d) ‘कॉपी’ व ‘पेट’ ारा

14. वड म  गो टू ऑशन होता ह ।
a) फाईल मेन ूम
b) इसट मेन ूम
c) एिडट मेन ूम
d) उपयुत सभी म

15. की-बोड की सहायता से एक लाइन ऊपर िसलेट करना हो तो ‘की’ काम म  ली जाती ह ।
a) Ctrl Key
b) Shift Key
c) Shift + Up Arrow
d) Ctrl + End Key

Answer Sheet
1. एिडट मेन ू का ऑशन ह ।
Answer – d) उपयुत सभी  (All of Above)

2. टेट चयिनत को कट करने का शॉटकट ह ।
Answer – c) Ctrl + X

3. िकसी टेट का वह टुकड़ा जो सबसे ऊपर िंट होता ह , वह ह ।
Answer – b) हैडर (Header)

4. कट ोल मेन ू िथत होता ह ।
Answer – a) टाइटल बार (Tittle Bar)

5. वड के शु होने पर ऑिफस अिसट ट पर एक िटप आता ह  िजसे कहते ह ।
Answer – b) िटप ऑप िद डे

6. िनन म  से वड ोसेसर ह ।
Answer – d) उपयुत सभी (All of Above)

7. िकसी टेट के अरो ंका प बदलने को कहा जाता ह ।
Answer – c) फॉमिटंग (Formatting)

8. वड ोसेसर फोम िटंग के अतगत करता ह ।
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Answer – d) उपयुत सभी (All of Above)

9. िकसी शद को गहरा करने के िलए योग करते ह ।
Answer – b) एबोिलंड्ग  (Emboldening)

10. पैराग ाफ  म  दायी ंतरफ एक अर पहले जाने के िलए ‘की’ काम म  लेते ह ।
Answer – b) राईट एरो (Right Arrow)

11. वड म  गो टू ऑशन का योग िकया जाता ह , िकसी।
Answer – d) उपयुत सभी (All of Above)

12. िनन म  से एमएस वड का ऑशन नही ंह ।
Answer – d) उपयुत कोई नही ं(None of Above)

13. िकसी डॉयमेूट म  से िकसी टेट को एक थान से हटाकर दसूरी जगह कॉपी िकया जा सकता ह ।
Answer – a) कट ारा

14. वड म  गो टू ऑशन होता ह ।
Answer – c) एिडट मेन ूम

15. की-बोड की सहायता से एक लाइन ऊपर िसलेट करना हो तो ‘की’ काम म  ली जाती ह ।
Answer – c) Shift + Up Arrow

ANKAJ INFOTECH



ऍम एस वड भाग – 12 (िहंदी म )
1. वड म  टेबल बनाने की कमाड कौन सी ह ।
a) ड ॉ-टेबल
b) मेक-टेबल
c) इसट-टेबल
d) इनम  से कोई नहीं

2. िडलीट कंुजी ारा या-या हटा सकते ह ।
a) टेबल
b) कॉलम र
c) सेल
d) उपरोत सभी

3. कई सेलो ंका सेल बनाने के िलए िकस कमाड का उपयोग करते ह ।
a) मज सेल
b) िपिलट टेबल
c) िपिलट सेल
d) A और C दोन

4. एक सेल को कई सेलो ंम  िवभािजत करने के िलए िकस कमाड का उपयोग िकया जाता ह ।
a) मज सेल
b) िपिलट टेबल
c) िपिलट सेल
d) A और C दोन

5. वड म  कवट  कमाड का योग िकस िलए िकया जाता ह ।
a) टेबल को टेस म  बदलने के िलए
b) टेबल को टेबल म  बदलने के िलए
c) टेस को टेस म  बदलने के िलए
d) उपरोत सभी बदलने के िलए

6. रीडू कमाड की शाटकट कंुजी —————- होती ह ।
a) Ctrl + Z
b) Ctrl + U
c) Ctrl + Y
d) Alt + Y
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7. िसलेट टेट को हटाकर िलपबोड म  भेजने के िलए शाटकट की होती ह ।
a) Ctrl + U
b) Ctrl + X
c) Alt + X
d) Alt + C

8. डेटा सचूी को वणानुसार व अंको के आधार पर कमाड से यविथत करते ह ।
a) सोट
b) फॉमूला
c) गाईड लाईन
d) A और C दोन

9. सेल के चारो ंतरफ उपिथत लाइन को या कहते ह ।
a) आउट लाईन
b) गाईड लाईन
c) सेल लाईन
d) बोडर

10. फॉरमेट पटर कमाड की शाटकट कंुजी —————– होती ह ।
a) Ctrl + Shift + S
b) Ctrl + Shift + F
c) Ctrl + >
d) Ctrl + Shift + C

11. िकस कमाड ारा नई लाइन टेबल म  जोड़ी जा सकती ह ।
a) इसट लाईन
b) इसट रो
c) एंड लाईन
d) एंड रो

12. कट कमाड की शाटकट कंुजी —————– होती ह ।
a) Ctrl + X
b) Ctrl + U
c) Ctrl + C
d) Alt + X

13. कॉपी कमाड की शाटकट कंुजी —————- होती ह ।
a) Ctrl + X
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b) Ctrl + U
c) Ctrl + C
d) Alt + X

14. ——————- के अलावा सभी िरबन टैब, वड 2007 म  दिशत होते ह ।
a) होम
b) इसट
c) पेज लेआउट
d) टूस

15. वड म  एक फाइल —————— कहलाती ह ।
a) टेमलेट
b) फॉम
c) डॉयमेूट
d) डेटाबेस

Answer Sheet
1. वड म  टेबल बनाने की कमाड कौन सी ह ।
Answer – c) इसट-टेबल

2. िडलीट कंुजी ारा या-या हटा सकते ह ।
Answer – d) उपरोत सभी

3. कई सेलो ंका सेल बनाने के िलए िकस कमाड का उपयोग करते ह ।
Answer – b) िपिलट टेबल

4. एक सेल को कई सेलो ंम  िवभािजत करने के िलए िकस कमाड का उपयोग िकया जाता ह ।
Answer – c) िपिलट सेल

5. वड म  कवट  कमाड का योग िकस िलए िकया जाता ह ।
Answer – a) टेबल को टेस म

6. रीडू कमाड की शाटकट कंुजी —————- होती ह ।
Answer – c) Ctrl + Y

7. िसलेट टेट को हटाकर िलपबोड म  भेजने के िलए शाटकट की होती ह ।
Answer – b) Ctrl + X

8. डेटा सचूी को वणानुसार व अंको के आधार पर कमाड से यविथत करते ह ।
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Answer – a) सोट

9. सेल के चारो ंतरफ उपिथत लाइन को या कहते ह ।
Answer – d) बोडर

10. फॉरमेट पटर कमाड की शाटकट कंुजी —————– होती ह ।
Answer – d) Ctrl + Shift + C

11. िकस कमाड ारा नई लाइन टेबल म  जोड़ी जा सकती ह ।
Answer – b) इसट रो

12. कट कमाड की शाटकट कंुजी —————– होती ह ।
Answer – a) Ctrl + X

13. कॉपी कमाड की शाटकट कंुजी —————- होती ह ।
Answer – c) Ctrl + C

14. ——————- के अलावा सभी िरबन टैब, वड 2007 म  दिशत होते ह ।
Answer – d) टूस

15. वड म  एक फाइल —————— कहलाती ह ।
Answer – d) डेटाबेस
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ऍम एस वड भाग – 13 (िहंदी म )
1. डॉयमेूट को बद करने के िलए िकस कमाड का योग िकया जाता ह ।
a) लोज
b) एिजट
c) यू
d) सेव

2. अपने टेट म  इंडेट देने के िलए आप —————— टैब म  िडीज इंडेट और इंीज इंडट का
उपयोग कर सकते ह ।
a) इंसट
b) होम
c) डेटा
d) पेज लेआउट

3. वड 2007 म  टेट िसलेट करने पर —————- वत : दिशत होता ह ।
a) टाक बार
b) मेन टूलबार
c) मेयबूार
d) िमनी टूलबार

4. वड म  एक ऐसी िया िजसम  कई कमाडो ंको टोर करके उनका उपयोग एक साथ कर सकते ह ।
a) मेल मज
b) मैो
c) हाईपरिलंक
d) उपरोत सभी

5. वड म  डॉयमेूट को सेव करते समय ‘’सेव’’ और ‘’सेव एज’’ म  या अतर ह ।
a) ‘’सेव’’ ऑशन डॉयमेूट को उसी थान पर सेव करेगा
b) ‘’सेव एज’’ ऑशन हम  नाम और थान बदलने की अनुमित देता ह
c) ‘’सेव एज’’ ऑशन ारा हम एक और डॉयमेूट बना सकते ह
d) उपरोत सभी

6. वड म  शदो ंके नीचे हरे रंग की तरंिगत रेखा —————- को दशाता ह ।
a) शद की पेिलंग म  अशुदि्ध का होना
b) शद या लाईन म  याकरण की अशुदि्ध का होना
c) शद का एड ेस का गलत होना
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d) उपरोत सभी

7. टीओसी का उपयोग करके आप बना सकते ह ।
a) हेिडंग टाइस
b) कटम टाइस
c) आउटलाइन लेवस
d) उपरोत सभी

8. —————- म  फाइल को खोलने व सेव करने एवं बंद करने के िलए कमांड होता ह ।
a) होम
b) फाइल मेन ूम
c) यू
d) इसट

9. डॉयमू ट्स को िडजाइन करने के िलए ————— िविभन कार के िवकप दान करते ह ।
a) माइोसॉट एसेल
b) माइोसॉट पॉवर पॉइंट
c) माइोसॉट वड
d) माइोसॉट एसेस

10. वड म  एक फाइल —————- कहलाती ह ।
a) टेपलेट
b) फॉम
c) डेटाबेस
d) डॉयमू ट

11. डॉयमूट को वत : सही करने के िलए, हम ————— उपयोग करते ह ।
a) ऑटो करेट
b) ऑटो कलीट
c) फॉमिटंग
d) िबिडंग लॉस

12. यजू पेपर कॉलस के िलये सामाय एलीकेशन ह ।
a) यजू रीिडंग
b) यजू लैटर
c) यजू
d) यजू एिडटर
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13. डॉयमूट म  िचिहत की हुई िनिचत लोकेशन पर पहुचँने के िलए इसका उपयोग होता ह ।
a) इंडेस
b) हाइपरिलंक
c) बुकमाक
d) टेबल

14. हायराकी म  आइटम के तर म  बदलाव के िलए आप इसका उपयोग कर इडेट को बढ़ा सकते ह ।
a) टैब
b) बैकपेस
c) िडलीट
d) पेसबार

15. फुटनोट्स व एंडनोट्स का उपयोग —————- के िलए िकया जाता ह ।
a) रेफरेस
b) सचूना
c) पॉइट्स
d) िलट

Answer Sheet
1. डॉयमेूट को बद करने के िलए िकस कमाड का योग िकया जाता ह ।
Answer – a) लोज

2. अपने टेट म  इंडेट देने के िलए आप —————— टैब म  िडीज इंडेट और इंीज इंडट का
उपयोग कर सकते ह ।
Answer – b) होम

3. वड 2007 म  टेट िसलेट करने पर —————- वत : दिशत होता ह ।
Answer – a) टाक बार

4. वड म  एक ऐसी िया िजसम  कई कमाडो ंको टोर करके उनका उपयोग एक साथ कर सकते ह ।
Answer – d) उपरोत सभी

5. वड म  डॉयमेूट को सेव करने समय ‘’सेव’’ और ‘’सेव एज’’ म  या अतर ह ।
Answer – d) उपरोत सभी

6. वड म  शदो ंके नीचे हरे रंग की तरंिगत रेखा —————- को दशाता ह ।
Answer – b) शद या लाईन म  याकरण की अशुदि्ध का होना
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7. टीओसी का उपयोग करके आप बना सकते ह ।
Answer – d) उपरोत सभी

8. —————- म  फाइल को खोलने व सेव करने एवं बंद करने के िलए कमांड होता ह ।
Answer – b) फाइल मेन ूम

9. डॉयमू ट्स को िडजाइन करने के िलए ————— िविभन कार के िवकप दान करते ह ।
Answer – c) माइोसॉट वड

10. वड म  एक फाइल —————- कहलाती ह ।
Answer – a) टेपलेट

11. डॉयमूट को वत : सही करने के िलए, हम ————— उपयोग करते ह ।
Answer – a) ऑटो करेट

12. यजू पेपर कॉलस के िलये सामाय एलीकेशन ह ।
Answer – b) यजू लैटर

13. डॉयमूट म  िचिहत की हुई िनिचत लोकेशन पर पहुचँने के िलए इसका उपयोग होता ह ।
Answer – c) बुकमाक

14. हायराकी म  आइटम के तर म  बदलाव के िलए आप इसका उपयोग कर इडेट को बढ़ा सकते ह ।
Answer – a) टैब

15. फुटनोट्स व एंडनोट्स का उपयोग —————- के िलए िकया जाता ह ।
Answer – a) रेफरेस
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ऍम एस वड भाग – 14 (िहंदी म )
1. —————– एक िर स ह  जो डॉयमूट के एक भाग की सचूना को दसूरे भाग म  िदखाता ह ।
a) हाईपरिलंक (Hyperlink)
b) ॉस-िर स (Cross Reference)
c) डॉयमू ट (Document)
d) िलंकेज (Linked)

2. अपने टेट को इंडेट देने के िलए आप ‘’—————‘’ टैब पर पैराग ाफ ग ुप म  डीीज इंडेट
और इीज इंडेट का उपयोग कर सकते ह ।
a) इसट (Insert)
b) होम (Home)
c) पेज लेआउट (Page Layout)
d) डेटा (Data)

3. —————- समनाथक शदो ंकी शदकोष ह  िजसका उपयोग समनाथक शदो ंको खोजने के िलए
कर सकते ह ।
a) ट ांसलेट (Translate)
b) पेिलंग (Spelling)
c) िथसॉरस (Thesaurus)
d) िरसच (Research)

4. एक िवषय सचूी ह  जो डॉयमूट म  अपने सबिधत रेफरस पेज के साथ उपिथत होता ह ।
a) इंडेस (Index)
b) टेबल (Table)
c) िलप आट (Clip Art)
d) टेबल ऑफ़ कंट ट्स (Table and Contant)

5. —————- के जिरए आप वतमान डॉयमूट को िकसी लोकेशन को दसूरे डॉयमूट या वेबसाइट
से जोड़ते ह ।
a) िलंक (Link)
b) हाइपरिलंक (Hyperlink)
c) हाइपोिलंक (Hypo-link)
d) िलंकेज (Linked)

6. फैस, अविनत या यावसाियक लेटर जैसे आम काया के िलए —————- एक पहले िडजाइन
िकया हुआ डॉयमूट ह ।
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a) टेपलेट (Template)
b) फाइल (File)
c) फॉम (Form)
d) डेटाबेस (Database)

7. आउटपुट के प म  टेट दशन होता ह ।
a) कागज पर िट करके
b) मॉनीटर पर िदखाकर
c) अय िडवाइस पर सुरित रख के
d) उपयुत सभी

8. वड म  िकसी टेट को िडलीट कर सकते ह ।
a) िडलीट ‘की’ ारा
b) बैकपेस ‘की’ ारा
c) िडलीट व बैकपेस ‘की’ ारा
d) इनम  से कोई नहीं

9. ड ॉप केप ऑशन होता ह , एमएस वड के-
a) टूल बार मेनु म
b) फ़ॉमट मेनु म
c) एिडट मेनु म
d) य ूमेनु म

10. शदो को गहरा एवं अंडरलाइन करने का ऑशन पाया जाता ह ।
a) टैडड टूल बार म
b) फॉमिटंग टूल बार म
c) टाइटल बार म
d) टाक बार म

11. टेट को पेट करने की शाटकट कंुजी —————- होती ह ।
a) Ctrl + P
b) Ctrl + V
c) Alt + V
d) Alt + P

12. बांयी तरफ से िकसी अकेले केरेटर को िमटाने के िलए आप —————– पेस ेस कर सकते ह ।
a) िडलीट (Delete)
b) बैकपेस (Backspace)
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c) इंटर (Enter)
d) पेसबार (Space-bar)

13. जब आप होम टैब पर, फॉमट पटर आइकन पर िलक करते ह  तो आपका माउस पॉइंटर
————– के आकार का हो जाता ह ।
a) प ट ब श (Paint Brush)
b) बीम (Beem)
c) एरो (Arrow)
d) चतुकोण एरो

14. कोई बटन या काम करता ह  इसके बारे म  —————- िवतृत वणन दान करता ह ।
a) सुपर टूल िटप (Super Tool Tip)
b) सब टूल िटप (Sub Tool Tip)
c) इफो (Info)
d) की-िटप (Key-Tip)

15. —————– एलीकेशन आपको पसनल लेटर, फॉम लेटर, ब ोशर, फेस और यावसाियक
मेयअूल जैसे िविभन कार के िलिखत डॉयमूट तैयार करने म  मदद करता ह ।
a) वड ोसेसर (Word Processor)
b) वडपैड (Wordpad)
c) नोटपैड (Notepad)
d) इनम  से कोई नही ं(None of Above)

Answer Sheet
1. —————– एक िर स ह  जो डॉयमूट के एक भाग की सचूना को दसूरे भाग म  िदखाता ह ।
Answer – b) ॉस-िर स (Cross Reference)

2. अपने टेट को इंडेट देने के िलए आप ‘’—————‘’ टैब पर पैराग ाफ ग ुप म  डीीज इंडेट
और इीज इंडेट का उपयोग कर सकते ह ।
Answer – b) होम (Home)

3. —————- समनाथक शदो ंकी शदकोष ह  िजसका उपयोग समनाथक शदो ंको खोजने के िलए
कर सकते ह ।
Answer – c) िथसॉरस (Thesaurus)

4. एक िवषय सचूी ह  जो डॉयमूट म  अपने सबिधत रेफरस पेज के साथ उपिथत होता ह ।
Answer – d) टेबल ऑफ़ कंट ट्स

ANKAJ INFOTECH



5. —————- के जिरए आप वतमान डॉयमूट को िकसी लोकेशन को दसूरे डॉयमूट या वेबसाइट
से जोड़ते ह ।
Answer – b) हाइपरिलंक (Hyperlink)

6. फैस, अविनत या यावसाियक लेटर जैसे आम काया के िलए —————- एक पहले िडजाइन
िकया हुआ डॉयमूट ह ।
Answer – a) टेपलेट (Template)

7. आउटपुट के प म  टेट दशन होता ह ।
Answer – d) उपयुत सभी (All of Above)

8. वड म  िकसी टेट को िडलीट कर सकते ह ।
Answer – c) िडलीट व बैकपेस ‘की’ ारा

9. ड ॉप केप ऑशन होता ह , एमएस वड के।
Answer – b) फ़ॉमट मेनु म

10. शदो को गहरा एवं अंडरलाइन करने का ऑशन पाया जाता ह ।
Answer – b) फॉमिटंग टूल बार म

11. टेट को पेट करने की शाटकट कंुजी —————- होती ह ।
Answer – b) Ctrl + V

12. बांयी तरफ से िकसी अकेले केरेटर को िमटाने के िलए आप —————– पेस ेस कर सकते ह ।
Answer – b) बैकपेस (Backspace)

13. जब आप होम टैब पर, फॉमट पटर आइकन पर िलक करते ह  तो आपका माउस पॉइंटर
————– के आकार का हो जाता ह ।
Answer – a) प ट ब श (Paint Brush)

14. कोई बटन या काम करता ह  इसके बारे म  —————- िवतृत वणन दान करता ह ।
Answer – a) सुपर टूल िटप (Super Tool Tip)

15. —————– एलीकेशन आपको पसनल लेटर, फॉम लेटर, ब ोशर, फेस और यावसाियक
मेयअूल जैसे िविभन कार के िलिखत डॉयमूट तैयार करने म  मदद करता ह ।
Answer – a) वड ोसेसर (Word Processor)
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ऍम एस वड भाग – 15 (िहंदी म )
1. इनम  से कौनसा एमएस ऑिफस का वैध संकरण नही ंह ।
a) एमएस ऑिफस 97 (MS Office 97)
b) एमएस ऑिफस 2003 (MS Office 2003)
c) एमएस ऑिफस 2005 (MS Office 2005)
d) एमएस ऑिफस 2007 (MS Office 2007)

2. एमएस वड म  िडफॉट य ूहोता ह ।
a) िंट लेआउट य ू(Print Layout View)
b) हेडलाइन य ू(Headline View)
c) वेब लेआउट य ू(Web Layout View)
d) आउटलाइन य ू(Outline View)

3. िननिलिखत म  से कौनसा फॉट का टाइल नही ंह ।
a) बोड (Bold)
b) इटैिलक (Italic)
c) रेगुलर (Regular)
d) सुपरिट (Superscript)

4. एमएस वड म  शदो ंके नीचे लाल रंग की तरंिगत रेखा को ————— दशाता ह ।
a) वतनी म  अशुदि्ध
b) याकरण की अशुदि्ध
c) एड ेस लॉक
d) उपरोत म  से कोई नहीं

5. ‘अन डू’ ऑपरेशन िकन कीज के ारा संपािदत होता ह ।
a) Ctrl + X
b) Ctrl + C
c) Ctrl + Z
d) Ctrl + V

6. िननिलिखत म  से कौनसा एक एलीकेशन सॉटवेयर ह ।
a) डॉस (DOS)
b) िवंडोस (Windows)
c) एमएस वड (MS Word)
d) िलनस (Linux)
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7. डॉयमूट म  िचिहत की हुई िनिचत लोकेशन पर पहुचँने के िलए इसका उपयोग होता ह ।
a) इंडेस (Index)
b) हाइपरिलंक (Hyperlink)
c) बुकमाक  (Bookmark)
d) टेबल (Table)

8. ‘एक ऐसी िया िजसम  एक साथ बहुत से ातकताओं को संदेश भेजा जाता ह ’ कहलाती ह ।
a) मेल मज (Mail Marge)
b) मैो मज  (Macro Marge)
c) मेगा मज (Mega Marge)
d) माइो मज (Micro Marge)

9. माइोसॉट वड ारा दान िकये गए िकसी मािणक टेपलेट्स का उपयोग कर आप ————–
जैसे डॉयमूट के िलए कर सकते ह ।
a) ब ाशर (Brasher)
b) िरयमू (Resume)
c) िरपोट (Report)
d) ेज टेशन (Presentation)

10. डॉयमूट को वत : सही करने के िलए हम ————— का उपयोग करते ह ।
a) ऑटो करेट िफचर (Auto Correct Feature)
b) ऑटो कपलीट िफचर (Auto Complete Feature)
c) फॉमिटंग (Formatting)
d) िबिडंग लॉस (Building Blocks)

11. बायी तरफ के िकसी अकेले केरेटर को िमटाने के िलए आप ————— ेस कर सकते ह ।
a) िडलीट (Delete)
b) बैकपेस (Backspace)
c) एंटर (Enter)
d) पेस बार (Space-bar)

12. इसका उपयोग करके हम टेट म  मवू कर सकते ह ।
a) माउस (Mouse)
b) सीपीय ू(CPU)
c) की-बोड (Keyboard)
d) A और B दोन (Both A or B)

13. —————– और —————– लोकिय वड ोसेसर ह ।
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a) नोटपैड (Notepad)
b) माइोसॉट वड (Microsoft Word)
c) वडपैड (Wordpad)
d) B और C दोन

14. दतावेजो ंको सेव करते समय ‘’सेव’’ और ‘’सेव ऐज’’ म  अंतर ह ।
a) कोई भी अंतर नही ंह
b) ‘’सेव’’ उस दतावेज को संग िहत करेगा जो पहले से ही िकसी थान म  संग िहत ह
c) ‘’सेव ऐज’’ हमे नाम बदलने की अनुमित देता ह
d) B और C दोन

15. इनम  से कौनसा फॉट टाइल एमएस वड म  नही ंह ।
a) सबिट (Superscript)
b) बोड (Bold)
c) रेगुलर (Regular)
d) इटेिलस (Italic)

Answer Sheet
1. इनम  से कौनसा एमएस ऑिफस का वैध संकरण नही ंह ।
Answer – c) एमएस ऑिफस 2005 (MS Office 2005)

2. एमएस वड म  िडफॉट य ूहोता ह ।
Answer – a) िंट लेआउट य ू(Print Layout View)

3. िननिलिखत म  से कौनसा फॉट का टाइल नही ंह ।
Answer – d) सुपरिट (Superscript)

4. एमएस वड म  शदो ंके नीचे लाल रंग की तरंिगत रेखा को ————— दशाता ह ।
Answer – a) वतनी म  अशुदि्ध

5. ‘अन डू’ ऑपरेशन िकन कीज के ारा संपािदत होता ह ।
Answer – c) Ctrl + Z

6. िननिलिखत म  से कौनसा एक एलीकेशन सॉटवेयर ह ।
Answer – c) एमएस वड (Ms Word)

7. डॉयमूट म  िचिहत की हुई िनिचत लोकेशन पर पहुचँने के िलए इसका उपयोग होता ह ।
Answer – c) बुकमाक  (Bookmark)

ANKAJ INFOTECH



8. ‘एक ऐसी िया िजसम  एक साथ बहुत से ातकताओं को संदेश भेजा जाता ह ’ कहलाती ह ।
Answer – a) मेल मज (Mail Marge)

9. माइोसॉट वड ारा दान िकये गए िकसी मािणक टेपलेट्स का उपयोग कर आप ————–
जैसे डॉयमूट के िलए कर सकते ह ।
Answer – a) ब ाशर (Brasher)

10. डॉयमूट को वत : सही करने के िलए हम ————— का उपयोग करते ह ।
Answer – a) ऑटो करेट िफचर (Auto Correct Feature)

11. बायी तरफ के िकसी अकेले केरेटर को िमटाने के िलए आप ————— ेस कर सकते ह ।
Answer – b) बैकपेस (Backspace)

12. इसका उपयोग करके हम टेट म  मवू कर सकते ह ।
Answer – d) A और B दोन

13. —————– और —————– लोकिय वड ोसेसर ह ।
Answer – d) B और C दोन

14. दतावेजो ंको सेव करते समय ‘’सेव’’ और ‘’सेव ऐज’’ म  अंतर ह ।
Answer – b) ‘’सेव’’ उस दतावेज को संग िहत करेगा जो पहले से ही िकसी थान म  संग िहत ह

15. इनम  से कौनसा फॉट टाइल एमएस वड म  नही ंह ।
Answer – a) सबिट (Superscript)
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ऍम एस वड भाग – 16 (िहंदी म )
1. —————- डेटा आवयकताओं का अनुमान करते हुए हाडिडक के िनपादन म  सुधार करता ह ।
a) िडक कैिचंग
b) िडक डीेम ट
c) िडक राईिटंग
d) इनम  से कुछ भी नहीं

2. इनम  से कौन सी संगहण युित अिधकतम आंकड़ो को संग िहत रखती ह ।
a) लॉपी िडक
b) डीवीडी
c) सीडी रोम
d) सीडी आर डयू

3. इनम  से कौनसा एक वड ोसेिसंग सॉटवेयर ह ।
a) एमएस वड
b) फोटो शॉप
c) वड आट
d) कैलकुलेटर

4. MS Word म  अंितम पिरवतन को िकस कमांड के ारा िनंयित िकया जा सकता ह ।
a) रीडू
b) अडू
c) उपरोत दोन
d) इनम  से कोई नहीं

5. इनम  से  —————- फॉट का एक टाइप नही ंह ।
a) एिरयल
b) टाइस य ूरॉमन
c) इटैिलक
d) एिरयल लैक

6. यिद िकसी टेट म  ग ामेिटकल एरर हो तो उस टेट के नीचे कैसी कलर लाइन िदखती ह ।
a) रैड
b) लू
c) ग ीन
d) उपरोत म  से कोई नहीं
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7. MS-Word 2007 हेडर व फुटर को इसट  करने का ऑशन िकस मेन ूम  िमलता ह ।
a) एिडट
b) यू
c) इसट
d) फॉरमेट

8. एमएस वड म  िकतने कार के एलाईमेट होते ह ।
a) एक
b) दो
c) तीन
d) चार

9. —————— एलीकेशन आपको पसनल लेटर, फाम लेटर ब ोशर, फैस और यावसाियक
मेयुअल जैसे िविभन कार के िलिखत डॉयमूट तैयार करने म  मदद करता ह ।
a) वड ोसेसर
b) वड पेड
c) नोट पेड
d) कोई नहीं

10. डॉयमूट को वत : सही करने के िलए हम ————— का उपयोग करते ह ।
a) ऑटो करेट फीचर
b) ऑटो कमलीट फीचर
c) फोमिटंग
d) िबिडंग लॉस

11. सबिट का उदाहरण ह ।

a) X2

b) X2

c) X2
d) इनम  से कोई नहीं

12. हाइपरिलंक इसट  करने की —————— शॉटकट-की ह ।
a) Alt + K
b) Ctrl + K
c) Ctrl + H
d) Ctrl + M

13. एमएस वड 2010 म  कौन से टेब पर िलक करने पर ओपन कमांड आती ह ।
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a) फाइल टेब
b) ऑिफस बटन
c) एिडट टेब
d) य ूटेब

14. बायी तरफ के िकसी अकेले केरेटर को िमटाने के िलए कौन-सी की (key) ेस करते ह ।
a) बैकपेस
b) िडलीट
c) एटर
d) इनम  से कोई नहीं

15. डॉयमूट म  िकसी िनिचत लोकेशन पर पहुचँने के िलए कौन से ऑशन का यजू िकया जाता ह ।
a) बुकमाक
b) हाइपरिलंक
c) चेट
d) इनम  से कोई नहीं

Answer Sheet
1. —————- डेटा आवयकताओं का अनुमान करते हुए हाडिडक के िनपादन म  सुधार करता ह ।
Answer – b) िडक डीेम ट

2. इनम  से कौन सी संगहण युित अिधकतम आंकड़ो को संग िहत रखती ह ।
Answer – b) डीवीडी

3. इनम  से कौनसा एक वड ोसेिसंग सॉटवेयर ह ।
Answer – a) एमएस वड

4. अंितम पिरवतन को िकस के ारा िनंयित िकया जा सकता ह ।
Answer – b) अडू

5. इनम  से कौन सा फॉट टाइप नही ंह ।
Answer – c) इटैिलक

6. यिद िकसी टेट म  ग ामेिटकल एरर हो तो उस टेट के नीचे कैसी कलर लाइन िदखती ह ।
Answer – c) ग ीन

7. हेडर व फुटर को इसट  करने की कमांड िकस टेब म  िमलती ह ।
Answer – c) इसट
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8. एमएस वड म  िकतने कार के एलाईमेट होते ह ।
Answer – d) चार

9. —————— एलीकेशन आपको पसनल लेटर, फाम लेटर ब ोशर, फैस और यावसाियक
मेयुअल जैसे िविभन कार के िलिखत डॉयमूट तैयार करने म  मदद करता ह ।
Answer – a) वड ोसेसर

10. डॉयमूट को वत : सही करने के िलए हम ————— का उपयोग करते ह ।
Answer – a) ऑटो करेट फीचर

11. सबिट का उदाहरण ह ।
Answer – b) X2

12. हाइपरिलंक इसट  करने की —————— शॉटकट-की ह ।
Answer – b) Ctrl + K

13. एमएस वड 2010 म  कौन से टेब पर िलक करने पर ओपन कमांड आती ह ।
Answer – a) फाइल टेब

14. बायी तरफ के िकसी अकेले केरेटर को िमटाने के िलए कौनसी कीज की ेस करते ह ।
Answer – a) बैकपेस

15. डॉयमूट म  िकसी िनिचत लोकेशन पर पहुचँने के िलए कौन से ऑशन का यजू िकया जाता ह ।
Answer – a) बुकमाक
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ऍम एस वड भाग – 17 (िहंदी म )
1. एमएस वड म  फाइल या कहलाती ह ।
a) डॉयमू ट
b) शीट
c) लाईड
d) इनम  से कोई नहीं

2. ————- एक िवषय सचूी ह  जो डॉयमूट म  अपने से संबंिधत िरफरेस पेज के साथ उपिथत
होती ह ।
a) टेबल ऑफ कंट ट
b) टे क च ज
c) इंडेस
d) इनम  से कोई नहीं

3. बॉयी ंतरफ के िकसी अकेले केरेटर को िमटाने के िलए आप ————— ेस कर सकते ह ।
a) िडलीट
b) बैकपेस
c) एंटर
d) पेस बार

4. वड रेप का या अथ ह ।
a) शद के बीच पेस रखना
b) शद को दाय  मािजन से सीधा करता
c) टेट का वत : अगली लाइन म  पहँुचना
d) उपरोत म  से कोई नहीं

5. कट, कॉपी, तथा पेट की मश : शॉटकट की या ह ।
a) Ctrl + X, Ctrl + C, Ctrl + V
b) Ctrl + X, Ctrl + L, Ctrl + C
c) Ctrl + X, Alt + C, Ctrl + C
d) Alt + X, Alt + C, Alt + V

6. जब कोई यजूर —————– पर माउस ले जाता ह  तो वह हड के आकार का हो सकता ह ।
a) हाइपरिलंक
b) बुकमाक
c) ड ॉपकेप
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d) इनम  से कोई नहीं

7. एक फाइल िजसम  पवूिनधािरत सेिटंग का उपयोग जनरल डॉयमेूट को बनाने म  िकया जाता ह ,
————– कहलाती ह ।
a) पेटन
b) मॉडयलू
c) टेपलेट
d) ल ूिंट

8. इंसशन वॉइंट को डॉयमेूट के टािटग म  लाने के िलये कौन सी कीज का योग िकया जाता ह ।
a) Ctrl + P
b) Ctrl + Home
c) Ctrl + M
d) Ctrl + V

9. पेिलंग चेक करने की शॉटकट की ह ।
a) F7
b) F8
c) F9
d) F1

10. एमएस वड म  वाटरमाक  ऑशन िकस टेब म  होता ह ।
a) होम टेब
b) इंसट टेब
c) पेज लेआउट टेब
d) िरय ूटेब

11. िकसी पैराग ाफ की लाइनो ंके बीच के पेस को बढ़ाने के िलए िकस कमाड का योग िकया जाता
ह ।
a) इंडेट
b) अलाइनम ट
c) लाइनपेस
d) उपरोत म  से कोई नहीं

12. य ूमेय ूम  िलट ऑशन का या काय ह ।
a) नयी िवडो खोलना
b) सभी िवडो को अरेज करना
c) िवडो बंद करना
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d) एक िवड को दो भाग म  बाँटना

13. नया डॉयमूट तैयार करने के िलए ————— शाटकट-की ह ।
a) Ctrl + C
b) Ctrl + N
c) Ctrl + X
d) Ctrl + B

14. ऐड नोट को पेज म  जोड़ा जाता ह ।
a) सेटर के अंत म
b) पैराग ाफ के अंत म
c) डॉयमू ट के अंत म
d) पेज के अंत म

15. एमएस ऑिफस मे िमिनमम तथा मेसीमम जमू साइज िकतनी ह ।
a) 10 से 100
b) 20 से 250
c) 10 से 500
d) 10 से 1000

Answer Sheet
1. एमएस वड म  फाइल या कहलाती ह ।
Answer – a) डॉयमू ट

2. ————- एक िवषय सचूी ह  जो डॉयमूट म  अपने से संबंिध िरफरेस पेज के साथ उपिथत होती
ह ।
Answer – a) टेबल ऑफ कंट ट

3. बॉयी ंतरफ के िकसी अकेले केरेटर को िमटाने के िलए आप ————— ेस कर सकते ह ।
Answer – b) बैकपेस

4. वड रेप का या अथ ह ।
Answer – c) टेट का वत : अगली लाइन म  पहँुचना

5. कट, कॉपी, तथा पेट की मश : शॉट  कट की या ह ।
Answer – a) Ctrl + X, Ctrl + C, Ctrl + V

6. जब कोई यजूर —————– पर माउस ले जाता ह  तो वह हड के आकार का हो सकता ह ।
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Answer – a) हाइपरिलंक

7. एक फाइल िजसम  पवूिनधािरत सेिटंग का उपयोग जनरल डॉयमेूट को बनाने म  िकया जाता ह ,
————– कहलाती ह ।
Answer – b) मॉडयलू

8. इंसशन वॉइंट को डॉयमेूट के टािटग म  लाने के िलये कौन सी कीज का योग िकया जाता ह ।
Answer – b) Ctrl + Home

9. पेिलंग चेक करने की शॉट  कट की ह ।
Answer – a) F7

10. एमएस वड म  वाटरमाक  ऑफशन िकस टेब म  होता ह ।
Answer – c) पेज लेआउट टेब

11. िकसी पैराग ाफ की लाइनो ंके बीच के पेस को बढ़ाने के िलए िकस कमाड का योग िकया जाता
ह ।
Answer – c) लाइनपेस

12. य ूमेय ूम  पलीट ऑशन का या काय ह ।
Answer – d) एक िवड को दो भाग म  बाँटना

13. नया डॉयमूट तैयार करने के िलए शाटकट की ह ।
Answer – b) Ctrl + N

14. ऐड नोट को पेज म  जोड़ा जाता ह ।
Answer – b) पैराग ाफ के अंत म

15. एमएस ऑिफस मे िमिनमम तथा मेसीमम जमू साइज िकतनी ह ।
Answer – c) 10 से 500
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ऍम एस वड भाग – 18 (िहंदी म )
1. डॉयमूट को िडजाइन करने के िलए ————— िविभन कार के िवकप दान करते ह ।
a) माइोसॉट एसेल
b) माइोसॉट पावर वॉइंट
c) माइोसॉट वड
d) माइोसॉट एसेस

2. एमएस वड 2010 म  िकसी भी डॉयमूट का अिधकतम आकार िकतना हो सकता ह ।
a) 16 GB
b) 32 GB
c) 64 GB
d) 128 GB

3. एक बार टेब दबाने पर कसर आगे आता ह ।
a) 0.3’
b) 0.5’
c) 0.8’
d) 1.0’

4. एमएस वड 2010 म  िडफॉट य ूहोता ह ।
a) िट लेआउट
b) नॉरमल
c) वेब लेआउट
d) आउटलाइन

5. एमएस वड म  ट ांसलेट ऑशन िकस टेब म  उपलध होता ह ।
a) यू
b) िरयू
c) इंसट
d) िरफरेस

6. एमएस वड 2010 म  पैराग ाफ ग ुप होम टेब के अलावा िकस टेब म  उपिथत रहता ह ।
a) इंसट
b) मेलीगं
c) पेज लेआउट
d) यू
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7. िनन म  से कौनसा य ूएमएस वड 2010 म  नही ंहोता ह ।
a) िंट लेआउट
b) वेब पेज लेआउट
c) लाइड सॉटर
d) उपरोत म  से कोई नहीं

8. कई िमक कमांड के थान पर एक ही शाटकट की को िनधािरत करना कहलाता ह ।
a) मेो
b) मेल मज
c) ऑटो टेट
d) उपरोत म  से कोई नहीं

9. पैराग ाफ का िडफॉट अलाइनमट होता ह ।
a) लेट
b) सेटर
c) राइट
d) जिटफाई

10. हेडर दतावेज म  कहा ँ होता ह ।
a) टॉप
b) बॉटम
c) लेट
d) राइट

11. िकसका सबंध टेट की फॉरम िटंग से नही ंह ।
a) लाइन पेिसंग
b) टेट पेिसंग
c) मािजन च ज
d) सिचंग

12. कौनसा अलाइनमट मॉड दतावेज को दोनो ंऔर से अलाइन कर देता ह ।
a) अलाइन लेट
b) सेटर
c) अलाइन राईट
d) जिटफाई

13. कंट ोल + होम की के यजू से कसर लाइन के ————– पहुचँ जाता ह ।
a) मय म
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b) ऊपर
c) आरभ म
d) अंत म

14. टेट के सामने गोला, टार आिद िचह बने होते ह , उह  —————– कहते ह ।
a) बुलट्स
b) नबर
c) िडजाइन
d) लेआउट

15. एमएस वड 2010 म  फॉट साइज को ————– म  मापा जाता ह ।
a) स टीमीटर
b) बाईट्स
c) वॉइंट्स
d) इंच

Answer Sheet
1. डॉयमूट को िडजाइन करने के िलए ————— िविभन कार के िवकप दान करते ह ।
Answer – c) माइोसॉट वड

2. एमएस वड 2010 म  िकसी भी डॉयमूट का अिधकतम आकार िकतना हो सकता ह ।
Answer – b) 32 GB

3. एक बार टेब दबाने पर कसर आगे आता ह ।
Answer – b) 0.5’

4. एमएस वड 2010 म  िडफॉट य ूहोता ह ।
Answer – a) िट लेआउट

5. एमएस वड म  ट ांसलेट ऑफशन िकस टेब म  उपलध होता ह ।
Answer – b) िरयू

6. एमएस वड 2010 म  पैराग ाफ ग ुप होम टेब के अलावा िकस टेब म  उपिथत रहता ह ।
Answer – c) पेज लेआउट

7. िनन म  से कौनसा य ूएमएस वड 2010 म  नही ंहोता ह ।
Answer – c) लाइड सॉटर
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8. कई िमक कमांड के थान पर एक ही शाटकट की को िनधािरत करना कहलाता ह ।
Answer – a) मेो

9. पैराग ाफ का िडफॉट अलाइन होता ह ।
Answer – a) लेट

10. हेडर दतावेज म  कहा ँ होता ह ।
Answer – a) टॉप

11. िकसका सबंध टेट की फॉरम िटंग से नही ंह ।
Answer – d) सिचंग

12. कौनसा अलाइनमट मॉड दतावेज को दोनो ंऔर से अलाइन कर देता ह ।
Answer – d) जिटफाई

13. कंट ोल + होम की के यजू से कसर लाइन के ————– पहुचँ जाता ह ।
Answer – c) आरभ म

14. टेट के सामने गोला, टार आिद िचह बने होते ह , उह  —————– कहते ह ।
Answer – a) बुलट्स

15. एमएस वड 2010 म  फॉट साइज को ————– म  मापा जाता ह ।
Answer – c) वॉइंट्स
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ऍम एस वड भाग – 19 (िहंदी म )
1. Ctrl + P का इतेमाल होता ह ।
a) वड फाइल को बंद करने के िलये
b) कयटूर को बंद करने के िलये
c) दतावेज को छापने के िलये
d) दवावेज को कॉपी पेट करने के िलये

2. टेबल बनाते समय (एमएस वड म ) माउस वॉइंटर ————— के जैसा िदखाई देता ह ।
a) प िसल
b) पहले जैसा ही रहता ह
c) सीधी रेखा
d) वगाकार

3. टीओसी का उपयोग करके आप बना सकते ह ।
a) हेिडंग टाइस
b) कटम टाइस
c) आउटलाइन लेबस
d) उपरोत सभी

4. एक फाईल िजसम  पवूिनधािरत सेिटंस का योग समाय ेजटेश/डॉयमूट बनाने म  िकया जाता ह
———– कहलाता ह ।
a) पैटन
b) मॉडल
c) टेपलेट
d) ल ूिंट

5. ————— म  फाइल को खोलने, सेव करने एवं बंद करने  म  िकया जाता ह ।
a) होम
b) फाइल मेनू
c) यू
d) इंसट

6. िदए गए सारे िरबन टैब, वड 2010 म  दिशत होते ह , िसवाय।
a) होम
b) इसट
c) टूस
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d) पेज लेआउट

7. डॉयमूट के अंत तक पहुचँने के िलए —————- कीज दबाई जाए :-
a) Down Arrow
b) End Keys
c) Ctrl + Down Arrow
d) Ctrl + End Keys

8. वड म  एक फाईल ————— कहलाती ह ।
a) टैपलेट
b) फॉम
c) डेटाबेस
d) डॉयमू ट

9. कौन सी कीज का योग करने से ‘फाइड व िरलेस’ का िवकप खुलता ह ।
a) Ctrl + F
b) Ctrl + X
c) Ctrl + R
d) Ctrl + H

10. कोई बटन या काम करता ह  इसके बारे म  —————- िवतृत वणन दान करता ह ।
a) सुपरटूलिटप
b) सबटूलिटप
c) इफो
d) की-िटप

11. अपने टेट म  इंडट देने के िलए आप ‘—————-‘ टैब पर पैराग ाफ ग ुप म  िडीज इंडट और
इंीज इंडट का उपयोग कर सकते ह ।
a) इंजट
b) होम
c) पेज लेआउट
d) डेटा

12. डॉयमूट को िडजाइन करने के िलए ————– िविभन कार के िवकप दान करते ह ।
a) माइोसॉट एसेल
b) माइोसॉट पावर वॉइंट
c) माइोसॉट वड
d) माइोसॉट एसेस
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13. फुटनोट और एंडनोट का उपयोग —————- के िलए िकया जाता ह ।
a) िर स
b) सचूना
c) वॉइंट
d) िलट

14. माइोसॉट वड ारा दान िकये गए िकसी मािणक टेपलेट्स का उपयोग आप —————-
जैसे डॉयमूट के िलए करते ह ।
a) ब ाशर (Brasher)
b) िरयमू
c) िरपोट
d) ये सभी

15. इसका उपयोग करके हम टेट म  मवू कर सकते ह ।
a) माउस
b) सीपीयू
c) की-बोड
d) A और C दोन

Answer Sheet
1. Ctrl + P का इतेमाल होता ह ।
Answer – b) कयटूर को बंद करने के िलये

2. टेबल बनाते समय (एमएस वड म ) माउस वॉइंटर ————— के जैसा िदखाई देता ह ।
Answer – a) प िसल

3. टीओसी का उपयोग करके आप बना सकते ह ।
Answer – d) उपरोत सभी

4. एक फाईल िजसम  पवूिनधािरत सेिटंस का योग समाय ेजटेश/डॉयमूट बनाने म  िकया जाता ह
———– कहलाता ह ।
Answer – c) टेपलेट

5. ————— म  फाइल को खोलने, सेव करने एवं बंद करने  म  िकया जाता ह ।
Answer – b) फाइल मेनू

6. िदए गए सारे िरबन टैब, वड 2010 म  दिशत होते ह , िसवाय।
Answer – c) टूस
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7. डॉयमूट के अंत तक पहुचँने के िलए —————- कीज दबाई जाए :-
Answer – d) Ctrl + End Keys

8. वड म  एक फाईल ————— कहलाती ह ।
Answer – d) डॉयमू ट

9. कौन सी कीज का योग करने से ‘फाइड व िरलेस’ का िवकप खुलता ह ।
Answer – d) Ctrl + H

10. कोई बटन या काम करता ह  इसके बारे म  —————- िवतृत वणन दान करता ह ।
Answer – a) सुपरटूलिटप

11. अपने टेट म  इंडट देने के िलए आप ‘—————-‘ टैब पर पैराग ाफ ग ुप म  िडीज इंडट और
इंीज इंडट का उपयोग कर सकते ह ।
Answer – b) होम

12. डॉयमूट को िडजाइन करने के िलए ————– िविभन कार के िवकप दान करते ह ।
Answer – c) माइोसॉट वड

13. फुटनोट और एंडनोट का उपयोग —————- के िलए िकया जाता ह ।
Answer – a) िर स

14. माइोसॉट वड ारा दान िकये गए िकसी मािणक टेपलेट्स का उपयोग आप —————-
जैसे डॉयमूट के िलए करते ह ।
Answer – d) ये सभी

15. इसका उपयोग करके हम टेट म  मवू कर सकते ह ।
Answer – d) A और C दोन
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ऍम एस वड भाग – 20 (िहंदी म )
1. एमएस वड म  फाइल या कहलाती ह ।
a) डॉयमू ट
b) शीट
c) लाईड
d) इनम  से कोई नहीं

2. ————- एक िवषय सचूी ह  जो डॉयमूट म  अपने से संबंिधत िरफरेस पेज के साथ उपिथत
होती ह ।
a) टेबल ऑफ कंट ट
b) टे क च ज
c) इंडेस
d) इनम  से कोई नहीं

3. बॉयी ंतरफ के िकसी अकेले केरेटर को िमटाने के िलए आप ————— ेस कर सकते ह ।
a) िडलीट
b) बैकपेस
c) एंटर
d) पेस बार

4. वड रेप का या अथ ह ।
a) शद के बीच पेस रखना
b) शद को दाय  मािजन से सीधा करता
c) टेट का वत : अगली लाइन म  पहँुचना
d) उपरोत म  से कोई नहीं

5. कट, कॉपी, तथा पेट की मश : शॉट  कट की या ह ।
a) Ctrl + X, Ctrl + C, Ctrl + V
b) Ctrl + X, Ctrl + L, Ctrl + C
c) Ctrl + X, Alt + C, Ctrl + C
d) Alt + X, Alt + C, Alt + V

6. जब कोई यजूर —————– पर माउस ले जाता ह  तो वह हड के आकार का हो सकता ह ।
a) हाइपरिलंक
b) बुकमाक
c) ड ॉपकेप
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d) इनम  से कोई नहीं

7. एक फाइल िजसम  पवूिनधािरत सेिटंग का उपयोग जनरल डॉयमेूट को बनाने म  िकया जाता ह ,
————– कहलाती ह ।
a) पेटन
b) मॉडयलू
c) टेपलेट
d) ल ूिंट

8. इंसशन वॉइंट को डॉयमेूट के टािटग म  लाने के िलये कौन सी कीज का योग िकया जाता ह ।
a) Ctrl + P
b) Ctrl + Home
c) Ctrl + M
d) Ctrl + V

9. पेिलंग चेक करने की शॉट  कट की ह ।
a) F7
b) F8
c) F9
d) F1

10. एमएस वड म  वाटरमाक  ऑफशन िकस टेब म  होता ह ।
a) होम टेब
b) इंसट टेब
c) पेज लेआउट टेब
d) िरय ूटेब

11. िकसी पैराग ाफ की लाइनो ंके बीच के पेस को बढ़ाने के िलए िकस कमाड का योग िकया जाता
ह ।
a) इंडेट
b) अलाइनम ट
c) लाइनपेस
d) उपरोत म  से कोई नहीं

12. य ूमेय ूम  पलीट ऑशन का या काय ह ।
a) नयी िवडो खोलना
b) सभी िवडो को अरेज करना
c) िवडो बंद करना
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d) एक िवड को दो भाग म  बाँटना

13. नया डॉयमूट तैयार करने/खोलने के िलए शाटकट की ह ।
a) Ctrl + C
b) Ctrl + N
c) Ctrl + X
d) Ctrl + B

14. ऐडनोट को पेज म  जोड़ा जाता ह ।
a) सेटर के अंत म
b) पैराग ाफ के अंत म
c) डॉयमू ट के अंत म
d) पेज के अंत म

15. एमएस ऑिफस मे िमिनमम तथा मेसीमम जमू साइज िकतनी ह ।
a) 10 से 100
b) 20 से 250
c) 10 से 500
d) 10 से 1000

Answer Sheet
1. एमएस वड म  फाइल या कहलाती ह ।
Answer – a) डॉयमू ट

2. ————- एक िवषय सचूी ह  जो डॉयमूट म  अपने से संबंिधत िरफरेस पेज के साथ उपिथत
होती ह ।
Answer – a) टेबल ऑफ कंट ट

3. बॉयी ंतरफ के िकसी अकेले केरेटर को िमटाने के िलए आप ————— ेस कर सकते ह ।
Answer – b) बैकपेस

4. वड रेप का या अथ ह ।
Answer – c) टेट का वत : अगली लाइन म  पहँुचना

5. कट, कॉपी, तथा पेट की मश : शॉट  कट की या ह ।
Answer – a) Ctrl + X, Ctrl + C, Ctrl + V

6. जब कोई यजूर —————– पर माउस ले जाता ह  तो वह हड के आकार का हो सकता ह ।
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Answer – a) हाइपरिलंक

7. एक फाइल िजसम  पवूिनधािरत सेिटंग का उपयोग जनरल डॉयमेूट को बनाने म  िकया जाता ह ,
————– कहलाती ह ।
Answer – b) मॉडयलू

8. इंसशन वॉइंट को डॉयमेूट के टािटग म  लाने के िलये कौन सी कीज का योग िकया जाता ह ।
Answer – b) Ctrl + Home

9. पेिलंग चेक करने की शॉट  कट की ह ।
Answer – a) F7

10. एमएस वड म  वाटरमाक  ऑफशन िकस टेब म  होता ह ।
Answer – c) पेज लेआउट टेब

11. िकसी पैराग ाफ की लाइनो ंके बीच के पेस को बढ़ाने के िलए िकस कमाड का योग िकया जाता
ह ।
Answer – c) लाइनपेस

12. य ूमेय ूम  पलीट ऑशन का या काय ह ।
Answer – d) एक िवड को दो भाग म  बाँटना

13. नया डॉयमूट तैयार करने/खोलने के िलए शाटकट की ह ।
Answer – b) Ctrl + N

14. ऐड नोट को पेज म  जोड़ा जाता ह ।
Answer – b) पैराग ाफ के अंत म

15. एमएस ऑिफस मे िमिनमम तथा मेसीमम जमू साइज िकतनी ह ।
Answer – c) 10 से 500
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ऍम एस वड भाग – 21 (िहंदी म )
1. डॉयमूट को िडजाइन करने के िलए ————— िविभन कार के िवकप दान करते ह ।
a) माइोसॉट एसेल
b) माइोसॉट पावर वॉइंट
c) माइोसॉट वड
d) माइोसॉट एसेस

2. एमएस वड 2010 म  िकसी भी डॉयमूट का अिधकतम आकार िकतना हो सकता ह ।
a) 16 GB
b) 32 GB
c) 64 GB
d) 128 GB

3. एक बार टेब दबाने पर कसर आगे आता ह ।
a) 0.3’
b) 0.5’
c) 0.8’
d) 1.0’

4. एमएस वड 2010 म  िडफॉट य ूहोता ह ।
a) िट लेआउट
b) नामल
c) वेब लेआउट
d) आउटलाइन

5. एमएस वड म  ट ांसलेट ऑशन िकस टेब म  उपलध होता ह ।
a) यू
b) िरयू
c) इंसट
d) िरफरेस

6. एमएस वड 2010 म  पैराग ाफ ग ुप हॉम टेब के अलावा िकस टेब म  उपिथत रहता ह ।
a) इंसट
b) मेिलंग
c) पेज लेआउट
d) यू
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7. िनन म  से कौनसा य ूएमएस वड 2010 म  नही ंहोता ह ।
a) िंट लेआउट
b) वेब पेज लेआउट
c) लाइड सॉटर
d) उपरोत म  से कोई नहीं

8. कई िमक कमांड के थान पर एक ही शाटकट की को िनधािरत करना कहलाता ह ।
a) मेो
b) मेल मज
c) ऑटो टेट
d) उपरोत म  से कोई नहीं

9. पैराग ाफ का िडफॉट हॉिरजेटल होता ह ।
a) लेट
b) सेटर
c) राइट
d) जिटफाई

10. हेडर े दतावेज की िकस मािजन म  होता ह ।
a) टॉप
b) बॉटम
c) लेट
d) राइट

11. िकसका सबंध टेट की फॉरम िटंग से नही ंह ।
a) लाइन पेिसंग
b) टेट पेिसंग
c) मािजन च ज
d) सिचंग

12. कौनसा अलाइनमट मॉड दतावेज को दोनो ंऔर से अलाइन कर देता ह ।
a) अलाइन लेट
b) सेटर
c) अलाइन राईट
d) जिटफाई

13. कंट ोल + होम की के यजू से कसर लाइन के ————– पहुचँ जाता ह ।
a) मय म

ANKAJ INFOTECH



b) ऊपर
c) आरभ म
d) अंत म

14. टेट के सामने गोल, टार आिद िचह बने होते ह , उह  —————– कहते ह ।
a) बुलट्स
b) नबर
c) िडजाइन
d) लेआउट

15. एमएस वड 2010 म  फॉट साइज को ————– म  मापा जाता ह ।
a) स टीमीटर
b) बाईट्स
c) वॉइंट्स
d) इंच

Answer Sheet
1. डॉयमूट को िडजाइन करने के िलए ————— िविभन कार के िवकप दान करते ह ।
Answer – c) माइोसॉट वड

2. एमएस वड 2010 म  िकसी भी डॉयमूट का अिधकतम आकार िकतना हो सकता ह ।
Answer – b) 32 GB

3. एक बार टेब दबाने पर कसर आगे आता ह ।
Answer – b) 0.5’

4. एमएस वड 2010 म  िडफॉट य ूहोता ह ।
Answer – a) िट लेआउट

5. एमएस वड म  ट ांसलेट ऑशन िकस टेब म  उपलध होता ह ।
Answer – b) िरयू

6. एमएस वड 2010 म  पैराग ाफ ग ुप हॉम टेब के अलावा िकस टेब म  उपिथत रहता ह ।
Answer – c) पेज लेआउट

7. िनन म  से कौनसा य ूएमएस वड 2010 म  नही ंहोता ह ।
Answer – c) लाइड सॉटर
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8. कई िमक कमांड के थान पर एक ही शाटकट की को िनधािरत करना कहलाता ह ।
Answer – a) मेो

9. पैराग ाफ का िडफॉट हॉिरजेटल होता ह ।
Answer – a) लेट

10. हेडर े दतावेज की िकस मािजन म  होता ह ।
Answer – a) टॉप

11. िकसका सबंध टेट की फॉरम िटंग से नही ंह ।
Answer – d) सिचंग

12. कौनसा अलाइनमट मॉड दतावेज को दोनो ंऔर से अलाइन कर देता ह ।
Answer – d) जिटफाई

13. कट ॉल + होम की के यजू से कसर लाइन के ————– पहुचँ जाता ह ।
Answer – c) आरभ म

14. टेट के सामने गोल, टार आिद िचह बने होते ह , उह  —————– कहते ह ।
Answer – a) बुलट्स

15. एमएस वड 2010 म  फॉट साइज को ————– म  मापा जाता ह ।
Answer – c) वॉइंट्स
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ऍम एस वड भाग – 23 (िहंदी म )
1. एक ऐसी िकया िजसम  एक साथ बहुत से ातकताओं को संदेश भेजा जाता ह  कहलाती ह ।
a) मेल मज
b) मैो मज
c) मेगा मज
d) माइो मज

2. माइोसॉट वड ारा दान िकए गए िकसी मािणक टेपलेट्स का उपयोग आप —————-
जैसे डायमूट के िलए कर करते ह ।
a) ब ाशर
b) िरयमू
c) िरपोट
d) ये सभी

3. इसका उपयोग करके हम टैट म  मवू कर सकते ह ।
a) माउस
b) सीपीयू
c) की-बोड
d) A और C दोन

4. एमएस वड 2010 म  जब टेट का चयन िकया जाता ह  तो वत : या िदखाई देता ह ।
a) टाकबार
b) मेन टूलबार
c) िमनी टूलबार
d) टेट्सबार

5. फैस अविनत या यावसाियक लेटर जैसे आम कायो के िलए ————— एक पहले से िडजाइन
िकया हुआ डॉयमूट ह ।
a) टेलेट
b) फाइल
c) फाम
d) डेटाबेस

6. —————- एक िवषय सचूी ह  जो डॉयमूट म  अपने संबिधत रेेस पेज के साथ उपिथत होता
ह ।
a) इंडेस
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b) टेबल आफॅ कंट ट
c) िलपबोड
d) टेबल

7. टेट को आसानी से पढ़ने के िलए —————– का उपयोग कर सचूना को हॉिरजॉटल रो और
विटकल कॉलम म  यविथत िकया जाता ह ।
a) सेल
b) शीट
c) बॉस
d) टेबल

8. डॉयमूट को िडजायन करने के िलए ————- िविभन कार के िवकप दान करते ह ।
a) माइोसॉट एसेल
b) माइोसॉट पावर वॉइंट
c) माइोसॉट वड
d) माइोसॉट एसेस

9. एमएस वड म  टेट ,डेटा या नंबर को िकस ऑशन के ारा आरोही या अवरोही म म  यविथत
िकया जाता ह ।
a) शॉट
b) पेज
c) फोटो
d) बुकमाक

10. एमएस वड म  िकस ऑशन के ारा डायमूट को ऑटोमेिटक प से फॉमट कर सकते ह ।
a) टाइल ऑशन
b) पैराग ाफ
c) बुलट एड नबिरंग
d) इनम  से कोई नहीं

11. जो टेट हर पेज के बॉटम म  िंट होता होता ह ।
a) हेडर
b) फुटर
c) बुकमाक
d) उपरोत सभी

12. िकसी डॉयमूट म  िपचर के िकसी भाग को काटने के िलए िवकप होता ह ।
a) ॉप
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b) ऑजेट
c) A और B दोन
d) रोटेड

13. एमएस वड 2010 म  फाइल को सेव एज करने की फंशन की कौनसी होती ह ।
a) F9
b) F12
c) F11
d) F10

14. माइोसॉट वड 2010 म  िकस नाम का िरबन टेब दिशत नही ंहोता ह ।
a) टूस
b) िमनी टूलबार
c) िरबन
d) टाईटल बार

15. ————– के जिरए आप वतमान डॉयमूट की िकसी लोकेशन को दसूरे डॉयमूट या वेबसाइट
को जोड़ते ह ।
a) िलंक
b) हाइपरिलंक
c) हाइपोिलंक
d) िलंकेज

Answer Sheet
1. एक ऐसी िकया िजसम  एक साथ बहुत से ातकताओं को संदेश भेजा जाता ह  कहलाती ह ।
Answer :- a) मेल मज

2. माइोसॉट वड ारा दान िकए गए िकसी मािणक टेपलेट्स का उपयोग आप —————-
जैसे डायमूट के िलए कर करते ह ।
Answer :- d) ये सभी

3. इसका उपयोग करके हम टैट म  मवू कर सकते ह ।
Answer :- d) A और C दोन

4. एमएस वड 2010 म  जब टेट का चयन िकया जाता ह  तो वत : या िदखाई देता ह ।
Answer :- c) िमनी टूलबार

5. फैस अविनत या यावसाियक लेटर जैसे आम कायो के िलए ————— एक पहले से िडजाइन

ANKAJ INFOTECH



िकया हुआ डॉयमूट ह ।
Answer :- a) टेलेट

6. —————- एक िवषय सचूी ह  जो डॉयमूट म  अपने संबिधत रेेस पेज के साथ उपिथत होता
ह ।
Answer :- b) टेबल आफॅ कंट ट

7. आसानी से पढ़ने के िलए —————– का उपयोग कर सचूना को हॉिरजॉटल रो और विटकल
कॉलम म  यविथत िकया जाता ह ।
Answer :- d) टेबल

8. डॉयमूट को िडजायन करने के िलए ————- िविभन कार के िवकप दान करते ह ।
Answer :- c) माइोसॉट वड

9. एमएस वड म  टेट डेटा या नंबर को िकस ऑशन के ारा आरोही या अवरोही म म  जमाना
कहलाता ह ।
Answer :- a) शॉट

10. एमएस वड म  िकस ऑशन के ारा डायमूट को ऑटोमेिटक प से फॉमट कर सकते ह ।
Answer :- b) पैराग ाफ

11. जो टेट हर पेज के बॉटम म  िंट होता होता ह ।
Answer :- b) फुटर

12. िकसी डॉयमूट म  िपचर के िकसी भाग को काटने के िलए िवकप होता ह ।
Answer :- a) ॉप

13. एमएस वड 2010 म  फाइल को सेव एज करने की फंशन की कौनसी होती ह ।
Answer :- b) F12

14. माइोसॉट वड 2010 म  िकस नाम का िरबन टेब दिशत नही ंहोता ह ।
Answer :- a) टूस

15. ————– के जिरए आप वतमान डॉयमूट की िकसी लोकेशन को दसूरे डॉयमूट या वेबसाइट
को जोड़ते ह ।
Answer – b) हाइपरिलंक

ANKAJ INFOTECH



ऍम एस वड भाग – 22 (िहंदी म )
1. एमएस वड 2010 म  टेट का िडफॉट टेट कलर या होता ह ।
a) वाइट
b) लैक
c) ग ीन
d) रेड

2. एमएस वड 2010 म  फाइल लाइन पर नबर दिशत करने के िलए िकस कमाड का उपयोग करते
ह ।
a) बुलेट्स
b) नंबिरंग
c) लाइन नबर
d) मटी लेवल िलट

3. एमएस वड 2010 म  पैराग ाफ का फट  लेटर केिपटल एवं बड़ा दिशत करने के िलए िनन म  से
िकसऑशन का उपयोग िकया जाता ह ।
a) ड ॉप केप
b) वड आट
c) िलप आट
d) पेट पेशल

4. एमएस वड 2010 म  इफो ऑशन का योग िकस िलए िकया जाता ह ।
a) ीयू
b) पासवड
c) िट
d) उपरोत म  से कोई नहीं

5. डॉयमूट म  िबटमेप फाइल को इंसट  करने के िलए िकस ऑशन का योग िकया जाता ह ।
a) ऑजेट
b) ओपन
c) A और B दोन
d) उपरोत म  से कोई नहीं

6. एमएस वड 2010 म  िपचर इंसट  करने पर कौन-सा टैब िडसले होता ह ।
a) िडजाइन
b) लेआउट
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c) फॉरमेट
d) इनम  से कोई नहीं

7. ॉप का योग िकया जाता ह ।
a) िपचर के िकसी भाग को काटने के िलए
b) िपचर के िकसी भाग को छोटा करने के िलए
c) िपचर को रोटेट करने के िलए
d) िपचर को िडलीट करने के िलए

8. एमएस वड 2010 म  डॉयमूट म  एक से यादा िपचर को िसलेट करने के िलए िकस शॉटकट-की
को ेस करते ह ।
a) Alt
b) Ctrl
c) Ctrl + A
d) उपरोत म  से कोई नहीं

9. एमएस वड 2010 म  टेट को टेबल म  कवट  करने के िलए िकस ऑशन का योग होता ह ।
a) इंसट टेबल
b) कवट टेट टू टेबल
c) कवट टेबल टू टेट
d) इनम  से कोई नहीं

10. िनन म  से असंगत चुिनए।
a) टाइस य ूरोमन
b) बोड
c) एिरयल
d) इनम  से कोई नहीं

11. जिटफाई ॉपटी को की-बोड ारा एिटव करने के िलये —————-कीज का योग िकया
जाता ह ।
a) Ctrl + J
b) Ctrl + L
c) Ctrl + E
d) Ctrl + R

12. डॉयमूट म  अगले पेज पर जाने के िलए िकस कीज को दबाया जाता ह ।
a) पेज अप
b) वड
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c) फाेेडर
d) डाउन ऐरो

13. जरी फाइलो ं को गलती से या जानबझूकर िडलीट होने से बचाने के िलए ————– करना
अछा राता ह ।
a) िहडन
b) सेयोर
c) रीड ऑनली
d) िडलीट

14. डॉयमूट की मािजन को पिरवितत िकया जा सकता ह ।
a) लर बार के ारा
b) पेज सेटअप डायलॉग बॉस के ारा
c) A और B दोन के ारा
d) उपरोत म  से कोई नहीं

15. हायराकी म  आइटम के तर म  बदलाव के िलए आप इसका उपयोग कर इंडट को बढ़ा सकते ह ।
a) टैब
b) बैकपेस
c) िडलीट
d) पेसबार

Answer Sheet
1. एमएस वड 2010 म  टेट का िडफॉट टेट कलर या होता ह ।
Answer – b) लैक

2. एमएस वड 2010 म  फाइल लाइन पर नबर दिशत करने के िलए िकस कमाड का उपयोग करते
ह ।
Answer – c) लाइन नबर

3. एमएस वड 2010 म  पैराग ाफ का ट लेटर केिपटल एवं बड़ा दिशत करने के िलए िनन म  से
िकस का उपयोग िकया जाता ह ।
Answer – a) ड ॉप केप

4. एमएस वड 2010 म  इफो ऑफशन का योग िकस िलए िकया जाता ह ।
Answer – b) पासवड

5. डॉयमूट म  िबटमेप फाइल को इंसट  करने के िलए िकस ऑफशन का योग िकया जाता ह ।
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Answer – a) ऑजेट

6. एमएस वड 2010 म  िपचर इंसट  करने पर कौनसा टैब िडसले होता ह ।
Answer – c) फॉरमेट

7. ॉप का योग िकया जाता ह ।
Answer – a) िपचर के िकसी भाग को काटने के िलए

8. एमएस वड 2010 म  डॉयमूट म  एक से यादा िपचर को िसलेट करने के िलए िकस शॉटकट की
को ेस करते ह ।
Answer – b) Ctrl

9. एमएस वड 2010 म  टेट को टेबल म  कवट  करने के िलए िकस ऑशन का योग होता ह ।
Answer – b) कवट टेट टू टेबल

10. िनन म  से असंगत चुिनए।
Answer – b) बोड

11. जिटफाई ॉपटी को की-बोड ारा एिटव करने के िलये —————-कीज का योग िकया
जाता ह ।
Answer – a) Ctrl + J

12. डॉयमूट म  अगले पेज पर जाने के िलए िकस कीज को दबाया जाता ह ।
Answer – a) पेज अप

13. जरी फाइलो ं को गलती से या जानबझूकर िडलीट होने से बचाने के िलए ————– करन
अछा राता ह ।
Answer – a) िहडन

14. डॉयमूट की मािजन को पिरवितत िकया जा सकता ह ।
Answer – c) A और B दोन के ारा

15. हायराकी म  आइटम के तर म  बदलाव के िलए आप इसका उपयोग कर इंडट को बढ़ा सकते ह ।
Answer – a) टैब
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ऍम एस वड भाग – 24 (िहंदी म )
1. िकसी वाय म  येक शद अर को केपीटल म  पिरवितत होना कहलाता ह ।
a) सेटेस केस
b) अपर केस
c) टोगल केस
d) केपीटलाइजड इच वड

2. टॉक का उपयोग करके आप बना सकते ह ।
a) हेिडंग लाइस
b) कटम लाइस
c) आउटलाइन लेबस
d) उपरोत सभी

3. एक फाईल िजसम  पवूिनधािरत सैिटंस का योग सामाय ेजेट शन (तुतीकरण) / डॉयमूट के
बनाने म  िकया जाता ह , कहलाता ह ।
a) पैटन
b) मॉडल
c) टेलेट
d) ल ूिंट

4. िदए गए सारे िरबन टैब, वड 2010 म  दिशत होते ह , िसवाय –
a) होम
b) इंसट
c) टूस
d) पेज लेआउट

5. —————– फाईल का कार इंिगत करता ह  िक ये फाइल वड 2010 डॉयमूट ह ।
a) .msw
b) .wor
c) .wrd
d) .docx

6. कौन सी कीज का योग करने से ‘फाइड व िरलेस’ का िवकप खुलता ह ।
a) Ctrl + F
b) Ctrl + X
c) Ctrl + R
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d) Ctrl + H

7. कोई बटन या काम करता ह  इसके बारे म  —————- िवतृत वणन दान करता ह ।
a) सुपरटूलिटप
b) सबटूलिटप
c) इफो
d) की-िटप

8. —————- के जिरये आप वतमान डॉयमूट िक िकसी लोकेशन को दसूरे डॉयमूट या वेबसाइड
को जोड़त  ह ।
a) िलंक
b) हाइपरिलंक
c) हाइपोिलंक
d) िलंकेज

9. जब आप होम टैब पर फॉरमेट पटर ऑयकन पर िलक करते ह  तो आप देखते ह  िक आपका माउस
वॉइंटर —————— के आकार म  बदल गया ह ।
a) प ट ब श
b) चतुकोणीय ऐरो
c) ऐरो
d) I बीम

10. इनम  से कौन सी कीज वतनी और याकरण की जांच को संिय करता ह ।
a) F5
b) F7
c) F2
d) F8

11. िननिलिखत म  से कौन सा फॉट का टाइल नही ंह ।
a) बोड
b) इटैिलक
c) रेगुलर
d) सुपरिट

12. िननिलिखत म  से कौन सी कीज वतमान म  चल रही एलीकेशनो ं के मय चयन करने के िलए
दबायी जाती ह ।
a) F1
b) Alt + F4
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c) Tab
d) Alt + Tab

13. अन डू ऑपरेशन िकन कीज के ारा सपािदत होता ह -
a) Ctrl + X
b) Ctrl + C
c) Ctrl + Z
d) Ctrl + V

14. िननिलिखत म  से कौन-सा एक एलीकेशन सॉटवेयर ह ।
a) डॉस
b) िवंडोज
c) एमएस वड
d) िलनस

15. —————- समानाथक शदो ंकी शदकोश ह  िजसका उपयोग समानाथक शदो ंको खोजने के
िलए कर सकते ह ।
a) अनुवाद
b) िथसॉरस
c) पेिलंग
d) िरसच

Answer Sheet
1. िकसी वाय म  येक शद अर को केपीटल म  पिरवितत होना कहलाता ह ।
Answer :- d) केपीटलाइजड इच वड

2. टॉक का उपयोग करके आप बना सकते ह ।
Answer :- d) उपरोत सभी

3. एक फाईल िजसम  पवूिनधािरत सैिटंस का योग सामाय ेजेट शन (तुतीकरण) / डॉयमूट के
बनाने म  िकया जाता ह , कहलाता ह ।
Answer :- c) टेलेट

4. िदए गए सारे िरबन टैब, वड 2010 म  दिशत होते ह , िसवाय –
Answer :- c) टूस

5. —————– फाईल का कार इंिगत करता ह  िक ये फाइल वड 2010 डॉयमूट ह ।
Answer :- d) .docx
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6. कौन सी कीज का योग करने से ‘फाइड व िरलेस’ का िवकप खुलता ह ।
Answer :- d) Ctrl + H

7. कोई बटन या काम करता ह  इसके बारे म  —————- िवतृत वणन दान करता ह ।
Answer :- a) सुपरटूलिटप

8. —————- के जिरये आप वतमान डॉयमूट िक िकसी लोकेशन को दसूरे डॉयमूट या वेबसाइड
को जोड़त  ह ।
Answer :- b) हाइपरिलंक

9. जब आप होम टैब पर फॉरमेट पटर ऑयकन पर िलक करते ह  तो आप देखते ह  िक आपका माउस
वॉइंटर —————— के आकार म  बदल गया ह ।
Answer :- a) प ट ब श

10. इनम  से कौन सी कीज वतनी और याकरण की जांच को संिय करता ह ।
Answer :- b) F7

11. िननिलिखत म  से कौन सा फॉट का टाइल नही ंह ।
Answer :- d) सुपरिट

12. िननिलिखत म  से कौन सी कीज वतमान म  चल रही एलीकेशनो ं के मय चयन करने के िलए
दबायी जाती ह ।
Answer :- d) Alt + Tab

13. अन डू ऑपरेशन िकन कीज के ारा सपािदत होता ह -
Answer :- c) Ctrl + Z

14. िननिलिखत म  से कौन-सा एक एलीकेशन सॉटवेयर ह ।
Answer :- c) एमएस वड

15. —————- समानाथक शदो ंकी शदकोश ह  िजसका उपयोग समानाथक शदो ंको खोजने के
िलए कर सकते ह ।
Answer :- b) िथसॉरस
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ऍम एस वड भाग – 25 (िहंदी म )
1. एक वड ोसेसर का उपयोग संभािवत सबसे अिधक होगा-
a) Keep an account of money spent
b) Do a computer search in media center
c) Maintain an inventory
d) Type a biography

2. Gutter Margin या ह ।
a) Margin that is added to the left margin when printing
b) Margin that is added to right margin when printing
c) Margin that is added to the binding side of page when printing
d) Margin that is added to the outside of the page when printing

3. सामायत : योग म  आने वाली कमाडस और टूस को िवक एिसस करने के िलये िकसका
योग करते ह ।
a) Status Bar
b) Tool Bar
c) Menu Bar
d) Title Bar

4. Home कंुजी ह ।
a) Moves the cursor beginning of the document
b) Moves the cursor beginning of the paragraph
c) Moves the cursor beginning of the screen
d) Moves the cursor beginning of the line

5. “Ctrl + Right Arrow” ——————- के िलये योग होता ह ।
a) Moves the cursor one word right
b) Moves the cursor end of the line
c) Moves the cursor end of the document
d) Moves the cursor one Paragraph down

6. End कंुजी ह ।
a) Moves the cursor end of the line
b) Moves the cursor end of the document
c) Moves the cursor end of the paragraph
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d) Moves the cursor end of the screen

7. “Ctrl + Page Down” ———————- के िलए योग होता ह ।
a) Moves the cursor one paragraph down
b) Moves the cursor one page down
c) Moves the cursor one line down
d) Moves the cursor one screen down

8. “Ctrl + Down Arrow” ——————- के िलये योग होता ह ।
a) Moves the cursor one paragraph down
b) Moves the cursor one line down
c) Moves he cursor one page down
d) Moves the cursor one screen down

9. Page Up कंुजी –
a) Moves the cursor one line up
b) Moves the cursor one screen up
c) Moves the cursor one page up
d) Moves the cursor one paragraph up

10. “Ctrl + Left Arrow” —————— के िलए योग होता ह ।
a) Moves the cursor beginning of the line
b) Moves the cursor one word left
c) Moves the cursor one paragraph up
d) Moves the cursor one paragraph down

11. Page Down कंुजी –
a) Moves the cursor one line down
b) Moves the cursor one page down
c) Moves the cursor one screen down
d) Moves the cursor one paragraph down

12. “Ctrl + Page Up” ———————- के िलए योग होता ह ।
a) Moves the cursor one page up
b) Moves the cursor one screen up
c) Moves the cursor one paragraph up
d) Moves the cursor one line up

13. “Ctrl + Up Arrow” ——————– के िलए योग होता ह ।
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a) Moves the cursor one page up
b) Moves the cursor one line up
c) Moves the cursor one screen up
d) Moves the cursor one paragraph up

14. “Ctrl + Home” ——————- के िलए योग होता ह ।
a) Moves the cursor to the beginning of document
b) Moves the cursor to the beginning of line
c) Moves the cursor to the beginning of paragraph
d) All of the above

15. “Ctrl + End” —————— के िलए योग होता ह ।
a) Moves the cursor to the end of line
b) Moves the cursor to the end of document
c) Moves the cursor to the end of paragraph
d) None of the above

Answer Sheet
1. एक वड ोसेसर का उपयोग संभािवत सबसे अिधक होगा-
Answer – d) Type a biography

2. Gutter Margin या ह ।
Answer – c) Margin that is added to the binding side of page when printing

3. सामायत : योग म  आने वाली कमाडस और टूस को िवक एिसस करने के िलये िकसका
योग करते ह ।
Answer – b) Tool Bar

4. Home कंुजी ह ।
Answer – d) Moves the cursor beginning of the line

5. “Ctrl + Right Arrow” ——————- के िलये योग होता ह ।
Answer – a) Moves the cursor one word right

6. End कंुजी ह ।
Answer – a) Moves the cursor end of the line

7. “Ctrl + Page Down” ———————- के िलए योग होता ह ।
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Answer – b) Moves the cursor one page down

8. “Ctrl + Down Arrow” ——————- के िलये योग होता ह ।
Answer – a) Moves the cursor one paragraph down

9. Page Up कंुजी –
Answer – b) Moves the cursor one screen up

10. “Ctrl + Left Arrow” —————— के िलए योग होता ह ।
Answer – b) Moves the cursor one word left

11. Page Down कंुजी –
Answer – c) Moves the cursor one screen down

12. “Ctrl + Page Up” ———————- के िलए योग होता ह ।
Answer – a) Moves the cursor one page up

13. “Ctrl + Up Arrow” ——————– के िलए योग होता ह ।
Answer – d) Moves the cursor one paragraph up

14. “Ctrl + Home” ——————- के िलए योग होता ह ।
Answer – a) Moves the cursor to the beginning of document

15. “Ctrl + End” —————— के िलए योग होता ह ।
Answer – b) Moves the cursor to the end of document

ANKAJ INFOTECH



ऍम एस वड भाग – 26 (िहंदी म )
1. िननिलिखत म  से कौन Word Processing Software ह ।
a) Word perfect
b) Easy Word
c) MS Word
d) All of above

2. कौन सी फाइल MS Word को ारभ करती ह ।
a) Winword.exe
b) Easy Word
c) MSword.exe
d) Word 2003.exe

3. Ctrl + N के िलये योग होता ह ।
a) Save Document
b) Open Document
c) Create new document
d) Close document

4. िननिलिखत म  से कौन section Break Option नही ंह ।
a) Next Page
b) Previous Page
c) Odd Page
d) Even Page

5. िननिलिखत म  से कौन MS Office का माय संकरण नही ंह ।
a) Office XP
b) Office Vista
c) Office 2007
d) None of above

6. िडफॉट प म  Header और Footer िकस Page पर Print होते ह ।
a) On first page
b) On alternate page
c) On every page
d) None of the above
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7. MS Word Screen पर Horizontal Split Bar कहां होता ह ।
a) On the left of horizontal scroll bar
b) On the right of horizontal scroll Bar
c) On the top of vertical scroll bar
d) On the bottom of vertical scroll bar

8. Ctrl + G ——————- के िलये योग होता ह ।
a) Open paragraph dialog box activating go to tab
b) Open page setup dialog box activating go to tab
c) Open find and replace dialog box with activating go to tab
d) Open go to dialog box

9. Ctrl + F —————— के िलये योग होता ह ।
a) Open find and replace dialog box with activating tab
b) Open page setup dialog box with activating layout tab
c) Open font dialog box with activating insert hyper link tab
d) Open file save as dialog box

10. Ctrl + H —————— के िलये योग होता ह ।
a) Open Find and replace dialog box with activating tab
b) Open format dialog box activating insert hyper link tab
c) Open insert dialog box activating insert hyper link tab
d) Open insert hyper link dialog box

11. Ctrl + P —————- के िलये योग होता ह ।
a) Open paragraph dialog box
b) Open page format dialog box
c) Open save dialog box
d) Open print dialog box

12. Ctrl + T ——————- के िलये योग होता ह ।
a) Hanging Indent
b) Left Indent
c) Open Tabs Dialog Box
d) Terminate all opened dialog box

13. Portrait और Landscape are ह ।
a) Page Orientation
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b) Paper Size
c) Page Layout
d) All of above

14. यह Verify करने के िलए िक पेज पर Note text की िथित सही ह , —————— View पर
जाते ह  या Print Preview म  Document को दिशत करते ह ।
a) Normal
b) Print layout
c) Page layout
d) Page edit

15. िननिलिखत म  से कौन-सा दतावेज के Page Orientation के सदभ म  सय ह ।
a) Page Orientation can be change at any time
b) Page Orientation Of document deter-mines by Printer
c) Page Orientation must be set before start typing
d) Page Orientation of a document cannot be changed

Answer Sheet
1. िननिलिखत म  से कौन Word Processing Software ह ।
Answer – d) All of above

2. कौन सी फाइल MS Word को ारभ करती ह ।
Answer – a) Winword.exe

3. Ctrl + N के िलये योग होता ह ।
Answer – c) Create new document

4. िननिलिखत म  से कौन section Break Option नही ंह ।
Answer – b) Previous Page

5. िननिलिखत म  से कौन MS Office का माय संकरण नही ंह ।
Answer – b) Office Vista

6. िडफॉट प म  Header और Footer िकस Page पर Print होते ह ।
Answer – c) On every page

7. MS Word Screen पर Horizontal Split Bar कहां होता ह ।
Answer – c) On the top of vertical scroll bar
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8. Ctrl + G ——————- के िलये योग होता ह ।
Answer – a) Open paragraph dialog box activating go to tab

9. Ctrl + F —————— के िलये योग होता ह ।
Answer – a) Open find and replace dialog box with activating tab

10. Ctrl + H —————— के िलये योग होता ह ।
Answer – a) Open Find and replace dialog box with activating tab

11. Ctrl + P —————- के िलये योग होता ह ।
Answer – d) Open print dialog box

12. Ctrl + T ——————- के िलये योग होता ह ।
Answer – a) Hanging Indent

13. Portrait और Landscape are ह ।
Answer – a) Page Orientation

14. यह Verify करने के िलए िक पेज पर Note text की िथित सही ह , —————— View पर
जाते ह  या Print Preview म  Document को दिशत करते ह ।
Answer – b) Print layout

15. िननिलिखत म  से कौन-सा दतावेज के Page Orientation के सदभ म  सय ह ।
Answer – a) Page Orientation can be change at any time

ANKAJ INFOTECH



ऍम एस वड भाग – 27 (िहंदी म )
1. Portrait तथा Landscape Mode के बीच म  Switching ——————– को सिमिलत
करती ह ।
a) Header and footer toolbar
b) Print layout view
c) Page setup dialog box
d) None of the above

2. आप कहा ँपर Vertical alignment को बदल सकते ह ।
a) Formatting toolbar
b) Paragraph dialog box
c) Page setup dialog box
d) Standard toolbar

3. दतावेज को Wide format म  बनाने के िलए —————– को बदलते ह ।
a) Page Orientation
b) Page Margins
c) Paper Style
d) Paper Source

4. यिद आपको Text के Block को Move करने की आवयकता ह  तो आप कौन-सा Operation
Perform कर गे।
a) Copy and Paste
b) Cut and Paste
c) Paste and Delete
d) Paste and Cut

5. Tools Menu म  Word Count कमाड, Current document म  words की संया तथा
—————– की संया को दिशत करती ह ।
a) Lines
b) Characters
c) Paragraphs
d) All of the above

6. Ctrl + V —————– के िलए योग होता ह ।
a) Paste texts in the beginning of document
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b) Paste images in the beginning of document
c) Paste Tables At the middle of document
d) None of the above

7. िननिलिखत म  से कौन-सी toolbar fonts तथा उसके sizes को बदलना allow करती ह ।
a) Standard
b) Formatting
c) Print Preview
d) None of these

8. Headers तथा Footers को देखने के िलए आप —————- पर जाते ह ।
a) Normal view
b) Print layout view
c) Print preview mode
d) Both b & c

9. Ctrl + C —————– के िलए योग होता ह ।
a) Copy the selected text
b) Cut the selected text
c) Print the selected text
d) Paste the selected text

10. Ctrl + Q —————— के िलए योग होता ह ।
a) Removes Paragraph Formatting (Line Space and paragraph space)
b) Close word application without saving document
c) Print whole document without confirmation
d) Does nothing

11. Ctrl + R —————– के िलए योग होता।
a) Re-Open the last closed document
b) Re-Print the last printed page
c) Re-Apply the last paragraph formatting
d) Right align the selected paragraph

12. िननिलिखत म  से कौन सा Font Style नही ंह ।
a) Bold
b) Italics
c) Regular
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d) Superscript

13. आप save command को कहा ँसे access कर सकते ह ।
a) Home tab
b) Insert tab
c) Review tab
d) None of above

14. आप tab stop markers को Rules से कैसे हटा सकते ह ।
a) Double click the tab marker and choose clear all
b) Drag the tab stop marker out of the ruler
c) Right click the tab stop marker and choose remove
d) All of above

15. Ctrl + M —————- के िलए योग होता ह ।
a) New document
b) Close document
c) Right indent
d) Left indent

Answer Sheet
1. Portrait तथा Landscape Mode के बीच म  Switching ——————– को सिमिलत
करती ह ।
Answer – c) Page setup dialog box

2. आप कहा ँपर Vertical alignment को बदल सकते ह ।
Answer – c) Page setup dialog box

3. दतावेज को Wide format म  बनाने के िलए —————– को बदलते ह ।
Answer – a) Page Orientation

4. यिद आपको Text के Block को Move करने की आवयकता ह  तो आप कौन-सा Operation
Perform कर गे।
Answer – b) Cut and Paste

5. Tools Menu म  Word Count कमाड, Current document म  words की संया तथा
—————– की संया को दिशत करती ह ।
Answer – d) All of the above
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6. Ctrl + V —————– के िलए योग होता ह ।
Answer – d) None of the above

7. िननिलिखत म  से कौन-सी toolbar fonts तथा उसके sizes को बदलना allow करती ह ।
Answer – b) Formatting

8. Headers तथा Footers को देखने के िलए आप —————- पर जाते ह ।
Answer – d) Both b & c

9. Ctrl + C —————– के िलए योग होता ह ।
Answer – a) Copy the selected text

10. Ctrl + Q —————— के िलए योग होता ह ।
Answer – a) Removes Paragraph Formatting (Line Space and paragraph space)

11. Ctrl + R —————– के िलए योग होता।
Answer – d) Right align the selected paragraph

12. िननिलिखत म  से कौन सा Font Style नही ंह ।
Answer – d) Superscript

13. आप save command को कहा ँसे access कर सकते ह ।
Answer – d) None of above

14. आप tab stop markers को Rules से कैसे हटा सकते ह ।
Answer – b) Drag the tab stop marker out of the ruler

15. Ctrl + M —————- के िलए योग होता ह ।
Answer – d) Left indent
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ऍम एस वड भाग – 28 (िहंदी म )
1. िननिलिखत म  से जो MS Word Screen के Ruler पर available नही ंहोता।
a) Top Stop Box
b) Left indent
c) Right Indent
d) Center Indent

2. Word म  Paragraphs के िलए default alignment —————- ह ।
a) Left-aligned, or flush margins at the left edge and uneven edges at the right
edge
b) Centered, or equidistant from both the left edge and the right edge
c) Right-aligned, or flush margins at the right edge and uneven edge at the left
edge
d) Justified, or flush margins at both the left and right edges

3. MS-Word म  Ctrl + S —————— के िलए होता ह ।
a) Scenarios
b) Size
c) Save
d) Spelling Check

4. Ctrl + W —————— के िलए योग होता ह ।
a) Save and print the document
b) Save and close word application
c) Save and close document
d) Without save, Close Document

5. F12 कंुजी —————- को खोलती ह ।
a) Save as dialog box
b) Open dialog box
c) Save dialog box
d) Close dialog box

6. Ctrl + I ————— के िलए योग होता ह ।
a) Italic
b) Left indent
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c) Save document
d) Close document

7. Ctrl + S —————– के िलए योग होता ह ।
a) Save Document with different name
b) Save document with same name
c) Save document and close word application
d) Save document and print whole pages

8. Ctrl + J —————— के िलए योग होता ह ।
a) Align justify
b) Insert Hyperlink
c) Search
d) Print

9. दतावेज का वह Portion कौन सा ह  िजसम  आप certain page formatting िवकप को
Set करते ह ।
a) Page
b) Document
c) Section
d) Page Setup

10. यिद आपको वड को Double underline करने की आवयकता ह , आप इसे कैसे कर गे।
a) Go to format menu and then font option open underline style and choose
double underline
b) From Format menu choose font option and then from font tab open underline
style and select double underline
c) Select the text then choose format >> font and on font tab, open underline
style and choose double underline
d) Click double underline tool on formatting toolbar

11. आप िबकुल वही Formatting कैसे apply कर गे जैसे आपने दसूरे text म  की ह ।
a) Copy the text and paste in new location then type the new text again
b) Copy the text and click on paste special tool on new place
c) Select the text then click on format painter and select the new text
d) All of above

12. जब आपको टेट का कोई पोशन चुनना हो तो टेट के ारभ म  िलक कर  िफर ोल करके
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नीच  आकर टेट के अंत म  िलक कर  तथा —————— बटन को दबाय  रख  इससे बीच का
सपणू टेट िसलेट हो जाएगा।
a) Ctrl
b) Alt
c) Shift
d) Tab

13. Manual line break के िलए Shortcut कंुजी या ह ।
a) Ctrl + Enter
b) Alt + Enter
c) Shift + Enter
d) Space + Enter

14. MS Word म  नये Paragraph को ारभ करने के िलए कौन-सी Key को Press करते ह ।
a) Down cursor key
b) Enter Key
c) Shift + Enter
d) Ctrl + Enter

15. Field के Codes को दिशत करने के िलए Shortcut कंुजी या ह ।
a) Alt + F9
b) Ctrl + F9
c) Shift + F9
d) Space + F9

Answer Sheet
1. िननिलिखत म  से जो MS Word Screen के Ruler पर available नही ंहोता।
Answer – d) Center Indent

2. Word म  Paragraphs के िलए default alignment —————- ह ।
Answer – a) Left-aligned, or flush margins at the left edge and uneven edges at
the right edge

3. MS-Word म  Ctrl + S —————— के िलए होता ह ।
Answer – c) Save

4. Ctrl + W —————— के िलए योग होता ह ।
Answer – c) Save and close document
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5. F12 कंुजी —————- को खोलती ह ।
Answer – a) Save as dialog box

6. Ctrl + I ————— के िलए योग होता ह ।
Answer – a) Italic

7. Ctrl + S —————– के िलए योग होता ह ।
Answer – b) Save document with same name

8. Ctrl + J —————— के िलए योग होता ह ।
Answer – a) Align justify

9. दतावेज का वह Portion कौन सा ह  िजसम  आप certain page formatting िवकप को
Set करते ह ।
Answer – c) Section

10. यिद आपको वड को Double underline करने की आवयकता ह , आप इसे कैसे कर गे।
Answer – c) Select the text then choose format >> font and on font tab, open
underline style and choose double underline

11. आप िबकुल वही Formatting कैसे apply कर गे जैसे आपने दसूरे text म  की ह ।
Answer – c) Select the text then click on format painter and select the new text

12. जब आपको टेट का कोई पोशन चुनना हो तो टेट के ारभ म  िलक कर  िफर ोल करके
नीच  आकर टेट के अंत म  िलक कर  तथा —————— बटन को दबाय  रख  इससे बीच का
सपणू टेट िसलेट हो जाएगा।
Answer – c) Shift

13. Manual line break के िलए Shortcut कंुजी या ह ।
Answer – c) Shift + Enter

14. MS Word म  नये Paragraph को ारभ करने के िलए कौन-सी Key को Press करते ह ।
Answer – b) Enter Key

15. Field के Codes को दिशत करने के िलए Shortcut कंुजी या ह ।
Answer – a) Alt + F9
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ऍम एस वड भाग – 29 (िहंदी म )
1. माउस के योग िबना, केवल Keyboard के योग से िकसी Tool को िरबन पर से चुनने के िलये
——————— कंुजी को Press करके आप Key tips को दिशत कर सकते ह ।
a) Alt
b) Ctrl
c) Shift + Enter
d) Alt + Enter

2. एक लाइन ब ेक बनाने के िलए –
a) Shift + Enter
b) Ctrl + Enter
c) Shift + Tab
d) Ctrl + Tab

3. Optional Field instruction को रखने वाली word की field —————— कहलाती ह ।
a) Subdocument
b) Symbol
c) Signal
d) Switch

4. Business Letter के आवयक घटको ंकी सचूी म  —————- होते ह ।
a) Data Line and inside address
b) Message
c) Signature block
d) All of the above

5. वड वेब ऑथिरंग टूल रखता ह  जो आपको वेब पेज पर ——————– शािमल करने के िलए
अनुमित देते ह ।
a) Bullets
b) Hyperlinks
c) Sounds
d) All of the above

6. Horizontal Scrollbar के बाई तरफ या उपिथत होता ह ।
a) Tab step button
b) View buttons
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c) Split buttons
d) Indicators

7. िननिलिखत म  से कौन-सा आप Margins बदलने के िलए योग करते ह ।
a) Formatting toolbar
b) Page setup dialog box
c) Standard toolbar
d) Paragraph dialog box

8. MS Word से Word document को email करने का तरीका –
a) Office button >> send to >> mail recipient
b) Save the file as an email attachment
c) Start outlook and attach the file while open in word
d) This is an impossible operation

9.  MS  Word  का ीन एलीमेट जो सामायत : टाइटल बार के नीचे आता ह  तथा वगीकृत
िवकप दान करता ह ।
a) Menu Bar
b) Tool Bar
c) Status Bar
d) All of the above

10. Word 2007 म  zoom —————— म  होता ह ।
a) View Tab
b) Home tab
c) Status bar
d) a & c both

11. —————– एक छोटी horizontal line है जो एक दतावेज के िनकष को दशाती ह ।
a) Insertion point
b) End mark
c) Status indicator
d) Scroll box

12. छोटे वग, िजह  —————— कहा जाता ह , िकसी ग ािफक के चारो ं और चयन आयत पर
ग ािफक के आयामो ं को बदलने के िलए इतेमाल िकया जा सकता ह ।
a) Scroll boxes
b) Sizing handles
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c) Status indicators
d) Move handles

13. यिद आप Ctrl + Shift + F8 Press करते ह  तब या होता ह ।
a) It activates extended selection
b) It activates the rectangular selection
c) It selects the paragraph on which the insertion line is
d) None of these

14. Copyright Symbol बनाने के िलए Shortcut कंुजी या ह ।
a) Ctrl + Shift + C
b) Ctrl + C
c) Alt + C
d) Alt + Ctrl + C

15. Keystrokes Ctrl + I —————— के िलए योग होता ह ।
a) Increase font size
b) Inserts a line break
c) Applies italic format to selected text
d) Indicate the text should be bold

Answer Sheet
1. माउस के योग िबना, केवल Keyboard के योग से िकसी Tool को िरबन पर से चुनने के िलये
——————— कंुजी को Press करके आप Key tips को दिशत कर सकते ह ।
Answer – a) Alt

2. एक लाइन ब ेक बनाने के िलए –
Answer – a) Shift + Enter

3. Optional Field instruction को रखने वाली word की field —————— कहलाती ह ।
Answer – d) Switch

4. Business Letter के आवयक घटको ंकी सचूी म  —————- होते ह ।
Answer – d) All of the above

5. वड वेब ऑथिरंग टूल रखता ह  जो आपको वेब पेज पर ——————– शािमल करने के िलए
अनुमित देते ह ।
Answer – d) All of the above
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6. Horizontal Scrollbar के बाई तरफ या उपिथत होता ह ।
Answer – b) View buttons

7. िननिलिखत म  से कौन-सा आप Margins बदलने के िलए योग करते ह ।
Answer – b) Page setup dialog box

8. MS Word से Word document को email करने का तरीका –
Answer – a) Office button >> send to >> mail recipient

9.  MS  Word  का ीन एलीमेट जो सामायत : टाइटल बार के नीचे आता ह  तथा वगीकृत
िवकप दान करता ह ।
Answer – a) Menu Bar

10. Word 2007 म  zoom —————— म  होता ह ।
Answer – d) a & c both

11. —————– एक छोटी horizontal line है जो एक दतावेज के िनकष को दशाती ह ।
Answer – b) End mark

12. छोटे वग, िजह  —————— कहा जाता ह , िकसी ग ािफक के चारो ं और चयन आयत पर
ग ािफक के आयामो ं को बदलने के िलए इतेमाल िकया जा सकता ह ।
Answer – b) Sizing handles

13. यिद आप Ctrl + Shift + F8 Press करते ह  तब या होता ह ।
Answer – b) It activates the rectangular selection

14. Copyright Symbol बनाने के िलए Shortcut कंुजी या ह ।
Answer – d) Alt + Ctrl + C

15. Keystrokes Ctrl + I —————— के िलए योग होता ह ।
Answer – c) Applies italic format to selected text
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ऍम एस वड भाग – 30 (िहंदी म )
1. िननिलिखत म  से कौन सी Function कंुजी पैलर को Activate करती ह ।
a) F3
b) F6
c) F7
d) F11

2. िननिलिखत म  से कौन सी Shortcut कंुजी Spelling check करने के िलए योग होती ह ।
a) F3
b) F11
c) F5
d) F7

3. नया दतावेज बनाने की Shortcut की ह ।
a) Ctrl + F
b) Ctrl + N
c) Ctrl + O
d) All of above

4. —————– एक दतावेज को खोलने का Shortcut ह ।
a) Ctrl + N
b) Ctrl + S
c) Ctrl + O
d) All of above

5. ——————— एक दतावेज को बद करने का Shortcut ह ।
a) Alt + F4
b) Ctrl + C
c) Ctrl + W
d) Ctrl + Q

6. दतावेज को Save करने के िलए कंुजीयो ंका सही समहू या ह ।
a) Ctrl + S
b) Ctrl + F
c) Alt + F + A
d) Alt + S
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7. आिद को बंद करने का Shortcut —————– ह ।
a) Ctrl + W
b) Ctrl + Q
c) Alt + F4
d) Alt + Q

8. एक दतावेज पर Text को खोजने के िलए कंुजीयो ंका सही समहू या ह ।
a) Alt + F
b) Ctrl + T
c) Ctrl + F
d) Ctrl + H

9. दतावेज म  Text को Replace करने का Shortcut या ह ।
a) Ctrl + R
b) Alt + R
c) Ctrl + H
d) All of above

10. िकसी पेज पर जाने के िलए Shortcut के प म  योग होने वाले कंुजीयो ंका समहू या ह ।
a) Alt + G
b) Ctrl + G
c) Ctrl + F
d) All of above

11. िजस shortcut के ारा Browser a document/ Brower Panel दिशत होगा।
a) Ctrl + B
b) Alt + B
c) Alt + Ctrl + Home
d) Alt + Home

12. ———————- िकसी Action का undo करने का shortcut ह ।
a) Ctrl + A
b) Ctrl + Z
c) Ctrl + Esc
d) Ctrl + U

13. ——————— िकसी action को redo करने का shortcut ह ।
a) Ctrl + R
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b) Ctrl + U
c) Ctrl + Y
d) Ctrl + Delete

14. Font को बदलने की Shortcut की ह ।
a) Ctrl + F
b) Alt + Ctrl + F
c) Shift + Alt + F
d) Ctrl + Shift + F

15. िकस Shortcut की के ारा हम Font की Size काेे बदल सकते ह ।
a) Ctrl + Shift + C
b) Ctrl + H
c) Ctrl + Shift + P
d) Ctrl + Alt + C

Answer Sheet
1. िननिलिखत म  से कौन सी Function कंुजी पैलर को Activate करती ह ।
Answer – c) F7

2. िननिलिखत म  से कौन सी Shortcut कंुजी Spelling check करने के िलए योग होती ह ।
Answer – d) F7

3. नया दतावेज बनाने की Shortcut की ह ।
Answer – b) Ctrl + N

4. —————– एक दतावेज को खोलने का Shortcut ह ।
Answer – c) Ctrl + O

5. ——————— एक दतावेज को बद करने का Shortcut ह ।
Answer – c) Ctrl + W

6. दतावेज को Save करने के िलए कंुजीयो ंका सही समहू या ह ।
Answer – a) Ctrl + S

7. आिद को बंद करने का Shortcut —————– ह ।
Answer – c) Alt + F4

8. एक दतावेज पर Text को खोजने के िलए कंुजीयो ंका सही समहू या ह ।
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Answer – c) Ctrl + F

9. दतावेज म  Text को Replace करने का Shortcut या ह ।
Answer – c) Ctrl + H

10. िकसी पेज पर जाने के िलए Shortcut के प म  योग होने वाले कंुजीयो ंका समहू या ह ।
Answer – b) Ctrl + G

11. िजस shortcut के ारा Browser a document/ Brower Panel दिशत होगा।
Answer – c) Alt + Ctrl + Home

12. ———————- िकसी Action का undo करने का shortcut ह ।
Answer – b) Ctrl + Z

13. ——————— िकसी action को redo करने का shortcut ह ।
Answer – c) Ctrl + Y

14. Font को बदलने की Shortcut की ह ।
Answer – d) Ctrl + Shift + F

15. िकस Shortcut की के ारा हम Font की Size काेे बदल सकते ह ।
Answer – c) Ctrl + Shift + P
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ऍम एस एसेल भाग – 1 (िहंदी म )
1. MS Excel को िकस नाम से जाना जाता है।
a) Word Processing Program
b) Presentation
c) Spread Sheet Program
d) इनमे से कोई नहीं

2. िकसी वक शीट के थम सेल का सेल एडेस होगा।
a) A 16384
b) IBI
c) A1
d) B1

3. िकसी वक शीट का अंितम सेल एडेस होता ह ।
a) N 65536
b) A 256
c) N 256
d) AI 636

4. िनन म  से कौन-सी ग ािफकल फाइल नही ंह ।
a) .GIF
b) .BMP
c) .JPG
d) .TXT

5. एसेल म  वक शीट के समहू को या कहा जाता है।
(a) एसेल शीट (Excel Sheet)
(b) वक शीट (Worksheet)
(c) एसेल वक शीट (Excel Worksheet)
(d) वक बुक (Work Book)

6. ग ािफक कायो को करने के िलए आवयक ह ।
a) माइो कयटूर (Micro Computer)
b) िमनी कयटूर (Mini Computer)
c) सुपर कयटूर (Super Computer)
d) मेनेम कयटूर (Mainframe Computer)
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7. एम एस एसेल म , फॉमूला हमेशा —————- से ारभ होता ह ।
a) =
b) मटीपल
c) –
d) /

8. िनन म  से ेडशीट का कार ह ।
a) लोटस 1-2-3
b) एमएस एसेल
c) सॉट केक
d) उपयुत सभी

9. एसेल म  सेल का ाप बदलने का काय होता ह ।
a) फोमट मेयु से
b) डाटा मेयु से
c) टूल मेयु से
d) इनट मेयु से

10. माइोसाट एसेल ह ।
a) ेडशीट ( Spreadsheet)
b) साधारण पेपर (Normal Paper)
c) वक शीट (Worksheet)
d) इनम  से कोई नही ं(None of Above)

11. एसेल म  डाटा को िनिचत म म  शाट  िकया जाता ह ।
a) डाटा मेयु से (Data Menu)
b) टूल मेयु से (Tool Menu)
c) एिडट मेयु से (Edit Menu)
d) फाइल मेयु से (File Menu)

12. िकसी पंित तथा कॉलम के ितछेदन को कहते ह ।
a) वक शीट (Worksheet)
b) सेल एड ेस (Cell Address)
c) सेल (Cell)
d) इनम  से कोई नही ं(None of Above)

13. एसेल एलीकेशन िवंडो म  सबसे ऊपर होता ह ।
a) टाइटल बार (Tittle Bar)
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b) मेयु बार (Menu Bar)
c) फॉमिटंग बार (Formatting Bar)
d) कोई नही ं(None of Above)

14. वक शीट की एक सेल म  अिधकतम िकतने कैरेटर  रख सकते ह ।
a) 254
b) 255
c) 256
d) 257

15. शीघ ता से फॉम िटंग करने के िलए उपयोग िकया जाता ह ।
a) फॉमिटंग टूल बार (Formatting Toolbar)
b) ऑट फॉमिटंग कमाड (Auto Formatting Command)
c) फॉमट मेय ू(Format Menu)
d) इनम  से कोई नही ं(None of Above)

Answer Sheet
1. MS Excel को िकस नाम से जाना जाता है।
Answer – c) Spread Sheet Program

2.िकसी वक शीट के थम सेल का  सेल एडेस होगा।
Answer – c) A1

3. िकसी वक शीट का अंितम सेल एडेस ह ।
Answer – a) N 65536

4. िनन म  से कौन-सी ग ािफकल फाइल नही ंह ।
Answer – d) .TXT

5. एसेल म  कई सारी वक शीट को या कहा जाता है।
Answer – d) वक बुक (Work Book)

6. ग ािफक कायो को करने के िलए आवयक ह ।
Answer – b) िमनी कयटूर (Mini Computer)

7. एम एस एसेल म , फॉमूला हमेशा —————- से ारभ होता ह ।
Answer – a) =

8. िनन म  से ेडशीट का कार ह ।
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Answer – d) उपयुत सभी

9. एसेल म  सेल का ाप बदलने का काय होता ह ।
Answer – a) फोमट मेयु से (Format Menu)

10. माइोसाट एसेल ह ।
Answer – a) ेडशीट (Spreadsheet)

11. एसेल म  डाटा को िनिचत म म  शाट  िकया जाता ह ।
Answer – c) एिडट मेयु से (Edit Menu)

12. िकसी पंित तथा कॉलम के ितछेदन को कहते ह ।
Answer – c) सेल (Cell)

13. एसेल एलीकेशन िवंडो म  सबसे ऊपर होता ह ।
Answer – a) टाइटल बार (Tittle Bar)

14. वक शीट की एक सेल म  अिधकतम केरैटर हो सकते ह ।
Answer – c) 256

15. शीघ ता से फॉम िटंग करने के िलए उपयोग िकया जाता ह ।
Answer – a) फॉमिटंग टूल बार (Formatting Toolbar)
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ऍम एस एसेल भाग – 2 (िहंदी म )
1. एम एस एसेल की वक बुक या फाइल का िवतार होता ह ।
a) .DOC
b) .XLX
c) .XLC
d) .XLSX

2. िकसी सेल म  िकये गये काय म  संशोधन करना कहलाता ह ।
a) एिडिटंग
b) रेज
c) िफिसंग
d) इनम  से कोई नहीं

3. वक शीट म  थम सेल का पता A1 ह ।
a) सही
b) गलत

4. एम एस एसेल एलीकेशन िवंडो की िनचली पट्िटका कहलाती ह ।
a) फॉमिटंग टूल बार
b) फॉमूला बार
c) टेट्स बार
d) टाईटल बार

5. एसेल 2003 म  रो की संया —————- होती ह ।
a) 65535
b) 65536
c) 65534
d) 65533

6. एम एस एसेल म  फॉमूला िजस िचह म  शु होता ह  वह ह ।
a) $
b) =
c) &
d) #

7. टेबल म  केवल रो (पंितया)ँ होती ह ।
a) सही
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b) गलत

8. एक एसेल वक शीट म  256 पंितया ँ(रो) एवं 65536 कॉलम होते ह ।
a) सही
b) गलत

9. हम एम एस एसेल म  ग ाफ बना सकते ह ।
a) सही
b) गलत

10. की ‘’टेब’’ ारा सारणी बनाई जाती ह ।
a) सही
b) गलत

11. ेड शीट को कभी-कभी वक शीट भी कहते ह ।
a) सही
b) गलत

12. रो व कॉलम के ितछेदन को सेल कहते ह ।
a) सही
b) गलत

13. िकसी वक शीट के थम कॉलम की थम सेल का एडेस होगा।
a) A256
b) 1B1
c) A1
d) कोई नहीं

14. एसेल की एक शीट म  256 कॉलम व 65536 रा होती ह ।
a) सही
b) गलत

15. ेडशीट म  कॉलम एवं रो के जोड़ने को कहते ह ।
a) िवंडो
b)  सेल
c) पाइट
d) इनम  से कोई नहीं
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Answer Sheet
1. एम एस एसेल की वक बुक या फाइल का िवतार होता ह ।
Answer – d) .XLSX

2. िकसी सेल म  िकये गये काय म  संशोधन करना कहलाता ह ।
Answer – b) रेज

3. वक शीट म  थम सेल का पता A1 ह ।
Answer – a) सही

4. एम एस एसेल एलीकेशन िवंडो की िनचली पट्िटका कहलाती ह ।
Answer – c) टेट्स बार

5. एसेल 2003 म  रो की संया होती ह ।
Answer – b) 65536

6. एम एस एसेल म  फॉमूला िजस िचह म  शु होता ह  वह ह ।
Answer – b) =

7. टेबल म  केवल रो (पंितया)ँ होती ह ।
Answer – b) गलत

8. एक एसेल वक शीट म  256 पंितया ँ(रो) एवं 65536 कॉलम होते ह ।
Answer – b) गलत

9. हम एम एस एसेल म  गफ बना सकते ह ।
Answer – a) सही

10. की ‘’टेब’’ ारा सारणी बनाई जाती ह ।
Answer – a) सही

11. ेडशीट को कभी-कभी वक शीट भी कहते ह ।
Answer – a) सही

12. रो व कॉलम के ितछेदन को सेल कहते ह ।
Answer – b) सही

13. िकसी वक शीट के थम कॉलम की थम सेल का एडेस होगा।
Answer – c) A1
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14. एसेल की एक शीट म  256 कॉलम व 65536 रो होती ह ।
Answer – a) सही

15. ेडशीट म  कॉलम एवं रो के जोड़ने को कहते ह ।
Answer – b) सेल
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ऍम एस एसेल भाग – 3 (िहंदी म )
1. माइोसॉट एसेल म  सबसे अिधक उपयोगी कौन ह ।
a) माइोसॉट एसेल 2010
b) माइोसॉट एसेल 2007
c) माइोसॉट एसेल 2003
d) माइोसॉट एसेल 2000

2. ड ॉ-टेबल िवकप म  हम कॉलम व रो की संया देते ह  टेबल बनाने के िलये
a) सही
b) गलत

3. एमएस एसेस एक ेडशीट ोग ाम ह ।
a) सही
b) गलत

4. लाइड शो एसेल म  योग होते ह ।
a) सही
b) गलत

5. माइोसॉट एसेल म  िकतनी रो होती ह ।
a) 75536
b) 65536
c) 56563
d) इनम  से कोई नहीं

6. िकसी Function के अदर लगे हुए फंशन को कहते है |
a) Nested Function
b) Round Function
c) Sum Function
d) Text Function

7. बांयी तरफ से अकेले अर को िमटाने के िलये आप पेस ेस कर सकते ह ।
a) िडलीट (Delete)
b) बैकपेस (Backspace)
c) एटर (Enter)
d) पेसबार(Space-bar)
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8. रॉ और कॉलम का कटाव ————- कहलाता ह ।
a) टेबल (Table)
b) सेल (Cell)
c) डेटा (Data)
d) शीट (Sheet)

9. एसेल की टाइटल बार म  कौन-कौन से बटन होते ह ।
a) Maximize
b) Minimize
c) Open
d) A और B दोन

10. एसेल म  कौनसी मता नही ंह ।
a) फंशन (Function)
b) कॉपी और मवू (Copy and Move)
c) ग ाफ (Graph)
d) इनम  से कोई नही ं(None of Above)

11. एसेल की येक फाइल म  िकतनी शीट हो सकती ह ।
a) 10
b) 16
c) 256
d) इनम  से कोई नहीं

12. एसेल 2010 म  एक अितिरत मेय ूकौन सा होता ह ।
a) टूस (tools)
b) फाईल (File)
c) डेटा (Data)
d) इनम  से कोई नही ं(None of Above)

13. सेल वाइंटर को अगली शीट पर ले जाने के िलए कौन सी शाटकट की होती ह ।
a) Right Arrow
b) Alt + Page Down
c) Ctrl + Page Down
d) Ctrl + Home

14. ————– डेटा का दृिटगत िरेजटेशन ह  और सचूना को समझने के िलए आसान और आकिषत
तरीके से ितपािदत करता ह ।
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a) चाट (Chart)
b) टेबल (Table)
c) िपचर (Picture)
d) ग ािफस (Graphic)

15. फॉमूले म , शु से अंत के सेल एडेस के ारा एडजसट रज िनिदट होती ह , और इसे —————
ारा पृथक करते ह ।
a) सेिमकॉलन (;)
b) कोमा (,)
c) फुलटॉप ()
d) कॉलन (:)

Answer Sheet
1. माइोसॉट एसेल म  सबसे अिधक उपयोगी कौन ह ।
Answer – a) माइोसॉट एसेल 2010

2. ड ॉ-टेबल िवकप म  हम कॉलम व रो की संया देते ह  टेबल बनाने के िलये।
Answer – a) सही

3. एमएस एसेस एक ेड ोग ाम ह ।
Answer – b) गलत

4. लाइड शो एसेल म  योग होते ह ।
Answer – b) गलत

5. माइोसॉट एसेल म  िकतनी रो होती ह ।
Answer – b) 65536

6. एसेल के पहले सेल का एडेस या होगा।
Answer – a) Nested Function

7. बांयी तरफ से अकेले अर को िमटाने के िलये आप पेस ेस कर सकते ह ।
Answer – b) बैकपेस (Backspace)

8. रॉ और कॉलम का कटाव ————- कहलाता ह ।
Answer – b) सेल (Cell)

9. एसेल की टाइटल बार म  कौन-कौन से बटन होते ह ।
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Answer – d) A और B दोन

10. एसेल म  कौनसी मता नही ंह ।
Answer – d) इनम  से कोई नहीं

11. एसेल की येक फाइल म  िकतनी शीट हो सकती ह ।
Answer – c) 256

12. एसेल 2010 म  एक अितिरत मेय ूकौन सा होता ह ।
Answer – b) फाईल (File)

13. सेल पॉइटर को अगली शीट पर ले जाने के िलए कौन सी शाटकट की होती ह ।
Answer – c) Ctrl + Page Down

14. ————– डेटा का दृिटगत िरेजटेशन ह  और सचूना को समझने के िलए आसान और आकिषत
तरीके से ितपािदत करता ह ।
Answer – a) चाट (Chart)

15. फॉमूले म , शु से अंत के सेल एडेस के ारा एडजसट रज िनिदट होती ह , और इसे —————
ारा पृथक करते ह ।
Answer – d) कॉलन (:)
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ऍम एस एसेल भाग – 4 (िहंदी म )
1. —————- वतं िडजाइन ह  िजसका उपयोग डायमेूट के िविभन भागो ंम  िकया जा सकता
ह ।
a) ग ािफस (Graphics)
b) टाइल (Style)
c) िपचर (Picture)
d) थीम ( Theme)

2. वेयु एंट ी िकन से िमलकर बनती ह ।
a) 0-9
b) $ , –
c) दशमलव अंक
d) उपरोत सभी

3. नई वक शीट बनाने की शाटकट की —————- होती ह ।
a) Shift + Alt + F1
b) Shift + Alt + F2
c) Shift + Alt + F3
d) Shift + Alt + F4

4. फॉमूला एंटरीज के दो कार कौन से ह ।
a) िरलेिटव, एबसोयुट
b) िमसेड, एबसोयुट
c) िमसेड, िरलेिटव
d) इनम  से कोई नहीं

5. एसेल को रन िवडो के ारा चलाने के िलए या कोड टाईप करते ह ।
a) एसेल (Excel)
b) िवन एसेल (Win Excel)
c) एमएस एसेल (ms Excel)
d) एमएस वड (ms word)

6. एसेल 2007 वक  बुक का एसटेशन या होता ह ।
a) .XL
b) .LX
c) .DOC
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d) .XLSX

7. एमएस एसेल 2007 म , टेपलेटे फाइल का एसटेशन ————– ह ।
a) .DOCX
b) .YLTX
c) .XLTX
d) .ZLTX

8. एसेल वक बुक म  बाईिडफॉट िकतनी शीट होती ह ।
a) 2
b) 5
c) 3
d) इनम  से कोई नहीं

9. डेटा और सचूनाओं को समझने म  आसान व आकषक तरीके मे िवजुअल प से िरेजट करता ह ।
a) चाट (Chart)
b) टेबल (Table)
c) िपचर (Picture)
d) ग ािफक (Graphic)

10. फॉमूला बार म  ————- ारा अलग िकये गये सेल एडेस के जिरये नॉन एजेसट रज का वणन
करता ह ।
a) सेिमकॉलन (;)
b) कोमा (,)
c) फुलटॉप ()
d) कॉलन (:)

11. सेव एज वक  पेस से सेव की गई फाईल का एसटेशन होता ह ।
a) .XLS
b) .XLW
c) .SWL
d) इनम  से कोई नहीं

12. एसेल शीट को वेब पेज के प म  सेव करने की कमाड ————– होती ह ।
a) वेब पेज
b) सेव एज वेब पेज
c) वेब पेज ियू
d) इनम  से कोई नहीं
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13. एसेल से बाहर िनकलने की कमाड होती ह ।
a) ऐिजट (Exit)
b) लोज (Close)
c) ऐिजट ऑल (Exit All)
d) लोज ऑल(Exit All)

14. िनन म  से कौन सा टैब एसेल 2007 म  नही ंहोता।
a) टूल (Tools)
b) फॉमूला (Formula)
c) िरय ू(Review)
d) पेज लेआउट (Page Layout)

15. कौन सी कमाड चुनी हुई सेल रज को िंट े म  पिरभािषत करती ह ।
a) िट एिरया
b) सेट िंट एिरया
c) िलयर िंट एिरया
d) उपरोत सभी

Answer Sheet
1. —————- वतं िडजाइन ह  िजसका उपयोग डायमेूट के िविभन भागो ंम  िकया जा सकता
ह ।
Answer – b) टाइल (Style)

2. वेयु एंट ी िकन से िमलकर बनती ह ।
Answer – d) उपरोत सभी

3. नई वक शीट बनाने की शाटकट की —————- होती ह ।
Answer – a) Shift + Alt + F1

4. फॉमूला ऐटरीज के दो कार कौन से ह ।
Answer – a) िरलेिटव, एबसोयुट

5. एसेल को रन िवडो के ारा चलाने के िलए या कोड टाईप करते ह ।
Answer – a) एसेल (Excel)

6. एसेल 2007 वक  बुक का एसटेशन या होता ह ।
Answer – d) .XLSX
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7. एमएस एसेल 2007 म , टेपलेटे फाइल का एसटेशन ————– ह ।
Answer – c) .XLTX

8. एसेल वक बुक म  बाईिडफॉट िकतनी शीट होती ह ।
Answer – c) 3

9. डेटा और सचूनाओं को समझने म  आसान व आकषक तरीके मे िवजुअल प से िरेजट करता ह ।
Answer – a) चाट (Chart)

10. फॉमूला बार म  ————- ारा अलग िकये गये सेल एडेस के जिरये नॉन एजेसट रज का वणन
करता ह ।
Answer – b) कोमा (,)

11. सेव एज वक  पेस से सेव की गई फाईल का एसटेशन होता ह ।
Answer – b) .XLW

12. एसेल शीट को वेब पेज के प म  सेव करने की कमाड ————– होती ह ।
Answer – b) सेव एज वेब पेज

13. एसेल से बाहर िनकलने की कमाड होती ह ।
Answer – a) ऐिजट (Exit)

14. िनन म  से कौन सा टैब एसेल 2007 म  नही ंहोता।
Answer – a) टूल (Tool)

15. कौन सी कमाड चुनी हुई सेल रज को िंट े म  पिरभािषत करती ह ।
Answer – b) सेट िंट एिरया
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ऍम एस एसेल भाग – 5 (िहंदी म )
1. एम एस ऐसेल मे पहले से बनी वक बुक को ओपन की शाटकट की या होती ह ।
a) Open
b) Ctrl + O
c) Ctrl + N
d) Alt + O

2. सेल को सीय सेल म  पिरवतन करने की शाटकट की —————- होती ह ।
a) F1
b) F2
c) F3
d) F4

3. यिद आप अपनी वक शीट म  सीधे एिडिटंग नही ंकरना चाहते ह  तो डेटा को एिडट और एंटर करने के
िलए आप ————— का उपयोग भी कर सकते ह ।
a) फॉमूला बार (Formula Bar)
b) टाइटलबार (Tittle Bar)
c) मेयबूार (Menu Bar)
d) पेसबार (Space Bar)

4. िलपबोड के अदर िकतने आइटम कॉपी करके रख सकते ह ।
a) 10
b) 24
c) 15
d) 40

5. एसेल म  बनी हुई फाइल का िडफॉट नाम या होता ह ।
a) वक बुक (Work Book)
b) डॉयुमेट (Document)
c) शीट (Sheet)
d) अनटाईटल (Untitled)

6. पेट कमाड की शाटकट की होती ह ।
a) Ctrl + P
b) Ctrl + F
c) Ctrl + V
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d) इनम  से कोई नहीं

7. पेट पेसल कमाड की सहायता से पेट की जाने वाली सचूनाओं को पेट पर पवू से उपिथत
सचूनाओं के साथ िकन िवकप से जोड़ा जा सकता ह ।
a) एड सबटे ट
b) मटीपलाई
c) डीवाईड
d) उपरोत सभी

8. फाइल को ओपन, सेव, लोज एवं िंट करने की कमाड इसम  होती ह ।
a) य ूटैब
b) ऑिफस बटन
c) इंसट टैब
d) िरय ूटैब

9. िकस कमाड की सहायता से िकसी भी सेल म  उसकी चौड़ाई से यादा टाईप िकए गए टेट को
उसकी चौड़ाई के अंदर यविथत कर सकते ह ।
a) फाइल (File)
b) जिटफाई (Justify)
c) िफल (Fill)
d) सीरीज (series)

10. एम एस एसेल म  बनी हुई फाइल के येक पेज को कहते ह ।
a) बुक (Book)
b) डॉयुम ट (Document)
c) शीट (Sheet)
d) इनम  से कोई नही ं(None of Above)

11. एसेल िवडो को कौनसा े मान एवं सू को इंटर करता ह ।
a) टाइटल बार (Tittle bar)
b) मेेेेनु बार (Menu bar)
c) फॉमूला बार (Formula bar)
d) टेडड टूलबार (Standard toolbar)

12. इस टैब म  ुिफंग टूस होती ह ।
a) िरय ू(Review)
b) डेटा (Data)
c) य ू(View)
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d) इसंट (Insert)

13. िफल कमाड ारा िकन-िकन िदशाओं म  चुनी हुई संयाओं को िकसी ेणी से भरा जा सकता ह ।
a) अप डाउन
b) लेट राईट
c) A और B दोन
d) इनम  से कोई नहीं

14. िलयर कमाड ारा िकस-िकस को हटाया जा सकता ह ।
a) ऑल फॉरमेटस (All Format)
b) कट्ेट कम ट्स (Content Comment)
c) A और B दोन (Both)
d) इनमे से कोई नही (None of Above)

15. यह कमाड सेल पाईटर को वक शीट के िकसी भी सेल पर ले जाती ह ।
a) गोटू (Go To)
b) स ड टु (Send To)
c) ई-मेल (E-mail)
d) इनम  से कोई नही ं(None of Above)

Answer Sheet
1. एम एस ऐसेल मे पहले से बनी वक बुक को ओपन की शाटकट की या होती ह ।
Answer – b) Ctrl + O

2. सेल को सीय सैल म  पिरवतन करने की शाटकट की —————- होती ह ।
Answer – b) F2

3. यिद आप अपनी वक शीट म  सीधे एिडिटंग नही ंकरना चाहते ह  तो डेटा को एिडट और एंटर करने के
िलए आप ————— का उपयोग भी कर सकते ह ।
Answer – a) फॉमूला बार (Formula bar)

4. िलपबोड के अदर िकतने आइटम कॉपी करके रख सकते ह ।
Answer – b) 24

5. एसेल म  बनी हुई फाइल का िडफॉट नाम या होता ह ।
Answer – a) वक बुक (Work Book)

6. पेट कमाड की शाटकट की होती ह ।
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Answer – c) Ctrl + V

7. पेट पेसल कमाड की सहायता से पेट की जाने वाली सचूनाओं को पेट पर पवू से उपिथत
सचूनाओं के साथ िकन िवकप से जोड़ा जा सकता ह ।
Answer – d) उपरोत सभी

8. फाइल को ओपन, सेव, लोज एवं िंट करने की कमाड इसम  होती ह ।
Answer – b) ऑिफस बटन

9. िकस कमाड की सहायता से िकसी भी सेल म  उसकी चौड़ाई से यादा टाईप िकए गए टैट को
उसकी चौड़ाई के अंदर यविथत कर सकते ह ।
Answer – b) जिटफाई (Justify)

10. एमएस एसेल म  बनी हुई फाइल के येक पेज को कहते ह ।
Answer – c) शीट (Sheet)

11. एसेल िवडो को कौनसा े मान एवं सू को इंटर करता ह ।
Answer – c) फॉमूला बार (Formula Bar)

12. इस टैब म  ुिफंग टूस होती ह ।
Answer – a) िरय ू(Review)

13. फील कमाड ारा िकन-िकन िदशाओं म  चुनी हुई संयाओं को िकसी ेणी से भरा जा सकता ह ।
Answer – c) A और B दोन

14. िलयर कमाड ारा िकस-िकस को हटाया जा सकता ह ।
Answer – d) A और B दोन

15. यह कमाड सेल पाईटर को वक शीट के िकसी भी सेल पर ले जाती ह ।
Answer – a) गोटू (Go To)
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ऍम एस एसेल भाग – 6 (िहंदी म )
1. वह य ूिजसम  हम बाईिडफॉट काय करते ह ।
a) नामल (Normal)
b) वक  (Work)
c) एिटव (Active)
d) इनम  से कोई नही ं(None of Above)

2. एसेल सीट म  से येक सेल अपने एडेस से रेफर िकया जाता ह  जो ——————- ह ।
a) सेल का रो लेबल
b) सेल का कॉलम लेबल
c) सेल का रो औरे कॉलम लेबल
d) सेल का कॉलम लेबल और वक शीट टैब नाम

3. ——————— ऐसा िनयम ह  जो वैय ूके पवूानुमान म  मदद करता ह ।
a) फाइंड (Find)
b) िरलेस (Replace)
c) गोल सीक (Goal seek)
d) गोटू (Go-to)

4. ——————– पवू िलिखत फॉमूले होते ह , जो वत : गणना का काय करते ह ।
a) फंशन (Function)
b) इवेशन (Equation)
c) टेपलेट्स (Template)
d) िरएशन (Reaction)

5. कौनसी कमाड देने पर टेबल पेजो ंम  िवभािजत हो जाएगी और उनका दशन पेज वाईज होगा।
a) पेज ब ेक िय ू(Page-Brake Preview)
b) पेज ब ेक (Page-Brake)
c) कट (Cut)
d) इनम  से कोई नही ं(None of Above)

6. फॉमूला बार कमाड का काय ह ।
a) फॉमूला बार को ऑन/ऑफ करना
b) नया फॉमूला बनाना
c) फॉमूला बार को बदलना
d) उपरोत सभी
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7. एम एस एसेल 2007 का उपयोग िविभन कार के ——————- म  िकया जाता ह  जो सामाय
से लेकर जिटल कायो तक उपयोगी होते ह ।
a) गणना (Calculation)
b) मैनपुूलेशन (Manupulation)
c) ेज टेशन (Presentation)
d) एसेशन (Expression)

8. हायरकी म  आइटम के तर म  बदलाव के िलये आप इसका उपयोग करके इंडेट बढ़ा सकते ह ।
a) टैब (Tab)
b) बैकपेस (Backspace)
c) िडलीट (Delete)
d) पेसबार (Space-bar)

9. ीन पर जो िलिकंग िसंबल होता ह ।
a) माउस (Mouse)
b) ह ड (Hand)
c) लाईट (Light)
d) कसर (Curser)

10. —————— कमाड को देने पर ीन पर वक शीट के अलावा सभी बार अदृय हो जाते ह ।
a) टूल बार (Toolbar)
b) फुल ीन (Full Screen)
c) A और B दोन
d) इनम  से कोई नही ं(None of Above)

11. िकस कमाड की सहायता से वक शीट के कई य ूबनाए जा सकते ह ।
a) कटम य ू(Custom View)
b) मेक य ू(Make View)
c) जमू (Zoom)
d) इनम  से कोई नही (None of Above)

12. वक शीट पर होिरजोटल और वटीकंल लाईन  होती ह  उह  —————— कहते ह ।
a) सेस (Sales)
b) शीट्स (Sheets)
c) लोक लाइस (Block Line)
d) िग ड लाइस (Grid Line)

13. ीन को अिधकतम िकतनी संया तक जमू िकया जा सकता ह ।
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a) 10
b) 200
c) 300
d) 400

14. एक वक बुक म  वक शीट का िडफॉट नाम —————– होता ह ।
a) वक शीट (Worksheet)
b) शीट (Sheet)
c) पेपर (Paper)
d) इनम  से कोई नही (None of Above)

15. वक बुक म  एक नई शीट को जोड़ने वाली कमाड कौनसी ह ।
a) शीट (Sheet)
b) य ूशीट (New Sheet)
c) वक  शीट (Worksheet)
d) इसट शीट (Insert Sheet)

Answer Sheet
1. वह य ूिजसम  हम बाईिडफॉट काय करते ह ।
Answer – a) नामल (Normal)

2. एसेल सीट म  से येक सेल अपने एडेस से रेफर िकया जाता ह  जो ——————- ह ।
Answer – c) सेल का रो और कॉलम लेबल

3. ——————— ऐसा िनयम ह  जो वैय ूके पवूानुमान म  मदद करता ह ।
Answer – c) गोल सीक (Goalseek)

4. ——————– पवू िलिखत फॉमूले होते ह , जो वत : गणना का काय करते ह ।
Answer – a) फंशन (Function)

5. कौनसी कमाड देने पर टेबल पेजो ंम  िवभािजत हो जाएगी और उनका दशन पेज वाईज होगा।
Answer – a) पेज ब ेक िय ू(Page Brake Preview)

6. फॉमूला बार कमाड का काय ह ।
Answer – a) फॉमूला बार को ऑन/ऑफ करना

7. एमएस एसेल 2007 का उपयोग िविभन कार के ——————- म  िकया जाता ह  जो सामाय
से लेकर जिटल कायो तक उपयोगी होते ह ।
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Answer – a) गणना (Calculation)

8. हायराकी म  आइटम के तर म  बदलाव के िलये आप इसका उपयोग करके इंडेट बढ़ा सकते ह ।
Answer – a) टैब (Tab)

9. ीन पर जो िलिकंग िसंबल होता ह ।
Answer – d) कसर (Curser)

10. —————— कमाड को देने पर ीन पर वक शीट के अलावा सभी बार अदृय हो जाते ह ।
Answer – b) फुल ीन (Full Screen)

11. िकस कमाड की सहायता से वक शीट के कई य ूबनाए जा सकते ह ।
Answer – c) जमू (Zoom)

12. वक शीट पर होिरजोटल और वटीकंल लाईन  होती ह  उह  —————— कहते ह ।
Answer – d) िग ड लाइस (Grid-line)

13. ीन को अिधकतम िकतनी संया तक जमू िकया जा सकता ह ।
Answer – d) 400

14. एक वक बुक म  वक शीट का िडफॉट नाम —————– होता ह ।
Answer – b) शीट (Sheet)

15. वक बुक म  एक नई शीट को जोड़ने वाली कमाड कौनसी ह ।
Answer – d) इसट शीट (Insert Sheet)
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ऍम एस एसेल भाग – 7 (िहंदी म )
1. पेज के ऊपरी मािजन म  िथत टेट को —————— कहते ह ।
a) फुटर (Footer)
b) कॉलम  (Column)
c) हैडर  (Header)
d) पैराग ाफ (Paragraph)

2. सेल िनिचत करने के िलए या संबंिधत सेल के वत : रे स को रोकने के िलए कॉलम और रो की
संया के पहले —————— टाईप करते ह ।
a) हैश (#)
b) डॉलर ($)
c) ितशत (%)
d) टार (*)

3. माइोसॉट एसेल 2007 म  बनी फाइल को ——————- कहते ह ।
a) वक बुक (Workbook)
b) वक शीट (Worksheet)
c) शीट (Sheet)
d) नोटबुक (Notebook)

4. एसेल म  जहां वॉइटर उपिथत ह  वह सेल कहलाता ह ।
a) A1
b) करंट सेल (Current Cell)
c) एिटव सेल (Active Cell)
d) िडएिटव सेल (Dative Cell)

5. कौन सी कमाड वक शीट म  नई लाईन जोड़ने के काम आती ह ।
a) य ूरो (New Row)
b) इसट रो (Insert Row)
c) सेल (Cell)
d) इनम  से कोई नही ं(None of Above)

6. सेल कमाड ारा नया सेल कहा-ँकहा ँजोड़ सकते ह ।
a) िशट सेल राईट (Shift Cell Right)
b) िशट सेल अप (Shift Cell Up)
c) िशट सेल लेट (Shift Cell Left)
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d) उपरोत सभी (All of Above)

7. चाट  बनाने के िलए िकस मेय ूका उपयोग िकया जाता ह ।
a) फाईल (File)
b) य ू(New)
c) इसट (Insert)
d) चाट (Chart)

8. सेल एडेस E21 दिशत करता ह ।
a) 21 वी कॉलम, ई रो
b) ई रो, 12 वा कॉलम
c) ई कॉलम, 21 रो
d) इनम  से कोई नहीं

9. यह कमाड वक शीट म  िकसी भी थान से िपचर लाने के काम आती ह ।
a) िपचर (Picture)
b) इंिडकेटर (Indicator)
c) िलप आट (Clip Art)
d) उपरोत सभी (All of Above)

10. िकसी सेल एट ी के िलए िदया गया कमट िन पर या िदखाता ह ।
a) कम ट (Comment)
b) ईडीक टर  (Indicator)
c) िपचर (Picture)
d) कुछ नही ं(None)

11. िकसी अय फाइल से िलंक थािपत करने के िलए िकस कमाड का योग िकया जाता ह ।
a) िपचर (Picture)
b) कमेट (Comment)
c) फाइल (File)
d) हाइपरिलंक (Hyperlink)

12. सेल की फॉरमेिटंग के िलए कौन-कौनसी कमाड होती ह ।
a) नंबर फॉट (Number Font)
b) ऐिलनम ट बॉडर (Alignment Border)
c) पैटन ोट ट (Pattern Protect)
d) उपरोत सभी (All of Above)
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13. रो को िछपाने के िलए कौन-कौनसी कमाड होती ह ।
a) हाईड (Hide)
b) हाईड रो (Hide Row)
c) रो (Row)
d) इनम  से कोई नही ं(None of Above)

14. कॉलम की चौड़ाई िकतने नबरो ंतक हो सकती ह ।
a) 0-255
b) 1-256
c) 10-250
d) 0-65536

15. ——————- ऑशन के साथ रो ंया कॉलम, दोनो ंको ीज कर सकते ह , अथात वक शीट रहते
हुए आप हमेशा  उस रो या कॉलम म  सचूना को देख सकते ह ।
a) िपलट (Split)
b) अर ज (Arrange)
c) िफटर (Filter)
d) ीज पेस (Freeze Panes)

Answer Sheet
1. पेज के ऊपरी मािजन म  िथत टेट को —————— कहते ह ।
Answer – c) हैडर (Header)

2. सेल िनिचत करने के िलए या संबंिधत सेल के वत : रे स को रोकने के िलए कॉलम और रो की
संया के पहले —————— टाईप करते ह ।
Answer – b) डॉलर ($)

3. माइोसॉट एसेल 2007 म  बनी फाइल को ——————- कहते ह ।
Answer – a) वक बुक (Workbook)

4. एसेल म  जहां वॉइटर उपिथत ह  वह सेल कहलाता ह ।
Answer – c) एिटव सेल (Active Cell)

5. कौन सी कमाड वक शीट म  नई लाईन जोड़ने के काम आती ह ।
Answer – b) इसट रो (Insert Row)

6. सेल कमाड ारा नया सेल कहा-ँकहा ँजोड़ सकते ह ।
Answer – a) िशट सेल राईट (Shift Cell Right)
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7. चाट  बनाने के िलए िकस मेय ूका उपयोग िकया जाता ह ।
Answer – c) इसट (Insert)

8. सेल एडेस ई 21 दिशत करता ह ।
Answer – c) ई कॉलम, 21 रो

9. यह कमाड वक शीट म  िकसी भी थान से िपचर लाने के काम आती ह ।
Answer – a) िपचर (Picture)

10. िकसी सेल एट ी के िलए िदया गया कमट िन पर या िदखाता ह ।
Answer – b) ईडीक टर (Indicator)

11. िकसी अय फाइल से िलंक थािपत करने के िलए िकस कमाड का योग िकया जाता ह ।
Answer – d) हाइपरिलंक (Hyperlink)

12. सेल की फॉरमेिटंग के िलए कौन-कौनसी कमाड होती ह ।
Answer – d) उपरोत सभी (All of Above)

13. रो को िछपाने के िलए कौन-कौनसी कमाड होती ह ।
Answer – a) हाईड (Hide)

14. कॉलम की चौड़ाई िकतने नबरो ंतक हो सकती ह ।
Answer – a) 0-255

15. ——————- ऑशन के साथ रो ंया कॉलम, दोनो ंको ीज कर सकते ह , अथात वक शीट रहते
हुए आप हमेशा  उस रो या कॉलम म  सचूना को देख सकते ह ।
Answer – d) ीज पेस (Freeze Panes)
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ऍम एस एसेल भाग – 8 (िहंदी म )
1. िकसी भी रो की अिधकतम ऊँचाई िकतनी होती ह ।
a) 409
b) 500
c) 255
d) इनम  से कोई नहीं

2. िसलेट सेल रज म  रंग भरने के िलए िनन म  से िकस ऑशन का योग िकया जाता है।
a) पैटन (Pattern)
b) बॉडर (Border)
c) बैकग ाउंड (Background)
d) िफल कलर (Fill Color)

3. दी गई शतो के अनुसार वक शीट तथा उसके सेल की फॉरमेिटंग िकस कमाड से की जाती ह ।
a) कंडीशनल  फॉरमेिटंग (Conditional Formatting)
b) फॉमट (Format)
c) िसलेटेड फॉरमेिटंग (Selected Formatting)
d) इनम  से कोई नही ं(None of Above)

4. िकस कमाड ारा िकसी भी िपचर या ग ािफक को चुनकर उसे वक शीट बैकग ाउडं बना सकते ह ।
a) सेल (Cell)
b) रो (Row)
c) कॉलम (Colum)
d) बैकग ाउंड (Background)

5. डॉयमेूट को वत : सही करने के िलए, हम —————— का उपयोग करते ह ।
a) ऑटो करेट फीचर (Auto Correct Feature)
b) ऑटो कंलीट फीचर (Auto Complete Feature)
c) िबिडंग लॉस (Building Blocks)
d) फोरमिटंग (Formatting)

6. कंडीशनल फॉरमेिटंग म  अिधकतम िकतनी शत  ंदे सकते ह ।
a) 2
b) 3
c) 5
d) इनम  से कोई नहीं
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7. वक बुक को शेयर करने पर टाइटल बार म  वक बुक के नाम के साथ या िलखा होता ह ।
a) शेयड (Shared)
b) ोटेड (Protect)
c) शेयर (Share)
d) इनम  से कोई नही ं(None of Above)

8. पेिलंग कमाड म  शद को डायरेट ी म  जोड़ने के िलए िकस बटन का उपयोग िकया जाता ह ।
a) एड वड टू (Add Word-to)
b) एड (Add)
c) सम (Sum)
d) इसट (Insert)

9. दो वक बुक को आपस म  िमलाने के िलए िकस कमाड का उपयोग िकया जाता ह ।
a) मज (Merge)
b) मज बुक (Merge Book)
c) मज वक बुक (Merge Workbook)
d) उपरोत सभी (All of Above)

10. ोटेड कमाड िनन म  से कौन-कौन से िवकप देती ह ।
a) ोटेड शीट (Protect Sheet)
b) ोटेड वक शीट (Protect Worksheet)
c) ोटेड और शेयर वक बुक (Protect and Share Workbook)
d) उपरोत सभी (All of Above)

11. यह कमाड िकसी एक सेल की वेय ूको उस वेय ू से बदलने के काम आती ह  िजससे िदए गए
फॉमूला से पवू िनधािरत पिरणाम आए।ँ
a) गोल सीक (Gol Sheek)
b) च ज वेय ू(Change Value)
c) उपरोत दोन (Both)
d) इनम  से कोई नही ं(None of Above)

12. ये बटन ‘टाईटल बार’ म  मौजदू रहते ह  िसवाय, ………….
a) िमनीमाइज (Minimize)
b) टाट (Start)
c) लोज (Close)
d) मैसीमाइज (Maximize)

13. िकसी फॉमूला म  युत िविभन सेल एडेस की वेय ूको बदल-बदल कर िविभन पिरणाम ात
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करने के काम आने वाली कमाड कौनसी ह
a) गोल सीक (Gol Sheek)
b)िसनेिरयो मेनेजर (Scenario Manager)
c) ऑिडिटंग (Auditing)
d) इनम  से कोई नही ं(None of Above)

14. िकस ऑशन की सहायता से वक बुक को ऑटोमेिटक सेव करने के आदेश दे सकते ह ।
a) सेव (Save)
b) सेव एज (Save-As)
c) सेव एज वेब पेज (Save-as Web-page)
d) ऑटो सेव (Auto Save)

15. िकस कमाड की सहायता से टूलबार के बटन, मेय ूकी कमाड तथा िविभन कमांडो ंकी शाटकट
कंुजी िनधािरत कर सकते ह ।
a) ऑशन (Option)
b) कटोमाईज (Customize)
c) टूल बार (Toolbar)
d) इनम  से कोई नही ं(None of Above)

Answer Sheet
1. िकसी भी रो की अिधकतम ऊँचाई िकतनी होती ह ।
Answer – a) 409

2. िसलेट सेल रज म  रंग भरने के िलए िनन म  से िकस ऑशन का योग िकया जाता है।
Answer – d) िफल कलर (Fill Color)

3. दी गई शतो के अनुसार वक शीट तथा उसके सेल की फॉरमेिटंग िकस कमाड से की जाती ह ।
Answer – a) कडीशनल फॉरमेिटंग (Conditional Formatting)

4. िकस कमाड ारा िकसी भी िपचर या ग ािफक को चुनकर उसे वक शीट बैकग ाउडं बना सकते ह ।
Answer – d) बैकग ाउंड (Background)

5. डॉयमेूट को वत : सही करने के िलए, हम —————— का उपयोग करते ह ।
Answer – a) ऑटो करेट फीचर (Auto Correct Feature)

6. कंडीशनल फॉरमेिटंग म  अिधकतम िकतनी शत  ंदे सकते ह ।
Answer – b) 3
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7. वक बुक को शेयर करने पर टाइटल बार म  वक बुक के नाम के साथ या िलखा होता ह ।
Answer – a) शेयड (Shared)

8. पेिलंग कमाड म  शद को डायरेट ी म  जोड़ने के िलए िकस बटन का उपयोग िकया जाता ह ।
Answer – d) इसट (Insert)

9. दो वक बुक को आपस म  िमलाने के िलए िकस कमाड का उपयोग िकया जाता ह ।
Answer – c) मज वक बुक (Merge Workbook)

10. ोटेड कमाड िनन म  से कौन-कौन से िवकप देती ह ।
Answer – d) उपरोत सभी (All of Above)

11. यह कमाड िकसी एक सेल की वेय ूको उस वेय ू से बदलने के काम आती ह  िजससे िदए गए
फॉमूला से पवू िनधािरत पिरणाम आए।ँ
Answer – a) गोल सीक (Gol Sheek)

12. ये बटन ‘टाईटल बार’ म  मौजदू रहते ह  िसवाय,………….
Answer – b) टाट (Start)

13. िकसी फॉमूला म  युत िविभन सेल एडेस की वेय ूको बदल-बदल कर िविभन पिरणाम ात
करने के काम आने वाली कमाड कौनसी ह ।
Answer – b) केनरीयो मैनेजर (Scaneriyo Manager)

14. िकस ऑशन की सहायता से वक बुक को ऑटोमेिटक सेव करने के आदेश दे सकते ह ।
Answer – d) ऑटो सेव (Auto Save)

15. िकस कमाड की सहायता से टूलबार के बटन, मेय ूकी कमाड तथा िविभन कमांडो ंकी शाटकट
कंुजी िनधािरत कर सकते ह ।
Answer – b) कटोमाईज (Customize)
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ऍम एस एसेल भाग – 9 (िहंदी म )
1. कौनसी कमाड चुनी हुई सेल रेज की उही ंएट ीज को दिशत करती ह , जो िकसी दी गई शत को
परूा करती ह ।
a) शॉट (Sort)
b) िफटर (Filter)
c) A और B दोन (Both)
d) इनम  से कोई नही ं(None of Above)

2. शॉट  कमाड म  दो कार के कौन से ओिरएटेशन िदए जा सकते ह ।
a) शॉट मालेट टू लाजट (Sort Smallest to Largest)
b) शॉट लारजेट टू मालेट (Sort Largest to Smallest)
c) A और B दोन (Both)
d) ल डकेप ोटरेट (Landscape Poritrait)

3. िनन म  से कौन सी कमाड िकसी भी सेल म  इनपुट िकए गए डेटा मान को िनयंित करती ह ।
a) वेिलडेशन (Validation)
b) फॉम (Form)
c) सब टोटल (Sub Total)
d) सेिटंग (Setting)

4. एक ऐसी टेबल िजसम  साधारण टेबल के डेटा को इस कार दशाया जाता ह  िक उनसे िविभन कार
के िवलेषण िकए जा सक , को या कहते ह ।
a) टेबल (Table)
b) पेशल टेबल (Spacial Table)
c) िपवोट टेबल (Pivot Table)
d) चाट (Chart)

5. टेट को टेबल के प म  पिरवितत करने की कमाड कौनसी ह ।
a) टेट टू टेबल (Text to Table)
b) टेट टू कॉलम (Text to Column)
c) कवट (Convert)
d) इनम  से कोई नही ं(None of Above)

6. शॉट  कमाड के ारा िकन दो कार से डेटा को शॉट  कर सकते ह ।
a) अस िडंग (Ascending)
b) डेस िडंग (Descending)

ANKAJ INFOTECH

https://computerobjectivequestions.com/ms-office/ms-excel-part-9-in-hindi/


c) उपरोत दोन (Both)
d) टॉप बटन (Top Button)

7. िकस कमाड की सहायता ारा इनपुट व फॉमूला से पिरणामो ंकी टेबल बनाई जाती ह ।
a) िपवोट टेबल (Pivot Table)
b) टेबल (Table)
c) चाट (Chart)
d) इनम  से कोई नही ं(None of Above)

8. ——————- सॉटवेयर डेटा टोर करने के िलए उपयोगी होता ह ।
a) एम एस वड (MS Word)
b) एम एस एसेल (MS Excel)
c) एम एस पावर वाइंट (MS Power-point)
d) इनम  से कोई नही ं(None of Above)

9. य ूिवंडो कमाड वक बुक को िकस िवडो म  दिशत करती ह ।
a) नई (New)
b) पुरानी (Old)
c) वही (Current)
d) इनम  से कोई नही ं(None of Above)

10. िलट कमाड िकस शीट को िवभािजत करती ह ।
a) करंट (Current)
b) एिटव (Active)
c) य ूिवंडो (New Window)
d) ऑल िवंडो (All Window)

11. वतमान िवडो को िछपाने के िलए िकस कमाड का योग िकया जाता ह ।
a) हाईड (Hide)
b) िहडन (Hidden)
c) सेव (Save)
d) लॉक (Lock)

12. एमएस एसेल ोग ाम म  खानो ंकी चौड़ाई और पंित की लंबाई मापी जाती ह ।
a) इंच (Inch)
b) िपसेल (Pixel)
c) स टीमीटर (CM)
d) परस टेज (%)
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13. ————— एक ऐसी फाइल ह  जो सड टू यजू प म  एलीकेशन ारा दान िकया जाता ह ।
a) शीट (Sheet)
b) टेपलेट (Template)
c) बुक (Book)
d) िरपोट (Report)

14. डेटा और सचूनाओं को समझने म  आसान व आकषक तरीके म  िवजुअल प से िरेजट करता ह ।
a) चाट (Chart)
b) टेबल (Table)
c) िपचर (Picture)
d) ग ािफक (Graphic)

15. माइोसॉट एसेल 2010 म  एक अकेली फाइल या डॉयमूट —————- कहलाती ह ।
a) वक बुक (Workbook)
b) वक शीट (Worksheet)
c) शीट (Sheet)
d) नोटबुक (Notebook)

Answer Sheet
1. कौनसी कमाड चुनी हुई सेल रेज की उही ंएट ीज को दिशत करती ह , जो िकसी दी गई शत को
परूा करती ह ।
Answer – b) िफटर (Filter)

2. शॉट  कमाड म  दो कार के कौन से ओिरएटेशन िदए जा सकते ह ।
Answer – c) A और B दोन (Both)

3. िनन म  से कौन सी कमाड िकसी भी सेल म  इनपुट िकए गए डेटा मान को िनयंित करती ह ।
Answer – a) वेिलडेशन (Validation)

4. एक ऐसी टेबल िजसम  साधारण टेबल के डेटा को इस कार दशाया जाता ह  िक उनसे िविभन कार
के िवलेषण िकए जा सक , को या कहते ह ।
Answer – c) िपवोट टेबल (Pivot Table)

5. टेट को टेबल के प म  पिरवितत करने की कमाड कौनसी ह ।
Answer – a) टेट टू टेबल (Text to Table)

6. शॉट  कमाड के ारा िकन दो कार से डेटा को शॉट  कर सकते ह ।
Answer – c) उपरोत दोन (Both)
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7. िकस कमाड की सहायता ारा इनपुट व फॉमूला से पिरणामो ंकी टेबल बनाई जाती ह ।
Answer – b) टेबल (Table)

8. ——————- सॉटवेयर डेटा टोर करने के िलए उपयोगी होता ह ।
Answer – b) एम एस एसेल (MS Excel)

9. य ूिवंडो कमाड वक बुक को िकसी िवडोज म  दिशत करती ह ।
Answer – a) नई (New)

10. िलट कमाड िकस शीट को िवभािजत करती ह ।
Answer – b) एिटव (Active)

11. वतमान िवडो को िछपाने के िलए िकस कमाड का योग िकया जाता ह ।
Answer – a) हाईड (Hide)

12. एमएस एसेल ोग ाम म  खानो ंकी चौड़ाई और पंित की लंबाई मापी जाती ह ।
Answer – a) इंच (Inch)

13. ————— एक ऐसी फाइल ह  जो सड टू यजू प म  एलीकेशन ारा दान िकया जाता ह ।
Answer – b) टेपलेट (Template)

14. डेटा और सचूनाओं को समझने म  आसान व आकषक तरीके म  िवजुअल प से िरेजट करता ह ।
Answer – a) चाट (Chart)

15. माइोसॉट एसेल 2010 म  एक अकेली फाइल या डॉयमूट —————- कहलाती ह ।
Answer – a) वक बुक (Workbook)
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ऍम एस एसेल भाग – 10 (िहंदी म )
1. अगर आप अपनी वक शीट म  सीधे एिडिटंग नही करना चाहते ह  तो डेटा को एिडट और इंटर करने
के िलये आप ——————- का उपयोग भी कर सकते ह ।
a) फॉमूला बार (Formula Bar)
b) टाईटल बार (Title Bar)
c) मेन ूबार (Menu Bar)
d) पेस बार (Space Bar)

2. िकसी एम एस एसेल सू म  संलन िवतार के ारभ व अंत के सैल एडेस को —————- के
ारा पृथक िकया जाता ह ।
a) सेमी कॉलन (;)
b) कोमा  (,)
c) फुलटोप (.)
d) कॉलन (:)

3. ऐसा िनयम ह  जो वैय ूके पवूानुमान म  मदद करता ह ।
a) फाइंड (Find)
b) िरलेस (Replace)
c) गोल सीक (Goal Seek)
d) इनम  से कोई नही ं(None of Above)

4. इस टैब म  िूफंग टूस होती ह  जैसे-
a) िरय ू(Review)
b) डाटा (Data)
c) य ू(View)
d) इनसट (Insert)

5. ——————- ऐसा िनयम ह  जो वैय ूके पवूानुमान म  मदद करता ह ।
a) फाइंड (Find)
b) िरलेस (Replace)
c) गोल सीक (Goal Seek)
d) गो टू (Go-t0)

6. सेल िनिचत करने के िलए यानी संबंिधत सेल के वत : िर स को रोकने के िलए कॉलम और रो की
संया के पहले ————- टाइप करते ह ।
a) #
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b) $
c) :
d) ,

7. एक पृथक शीट के सेल से आंकड़ो ंको ात करना —————– कहलाता ह ।
a) एसेिसंग (Accessing)
b) रेफर िसंग (Refreshing)
c) अपडेिटंग (Updating)
d) फंशिनंग (Funtioning)

8. एसेल वक शीट के चयिनत अंश को आप कैसे िंट कर ग ।
a) फॉट का साइज बदलकर
b) टेटस बार मे जमू िनदश का योग करके
c) पेज ब ेक िनदश का योग करके
d) िजस अंश को िंट करना ह  उसे िसलेट कर िंट डायलॉग बॉस मे िसलेशन िवकप चुनकर

9. एम एस एसेल 2010 म , सेल म  कमेट्स िलखने को कहते ह ।
a) सेल िटप (Cell Trip)
b) सेल रेट (Cell Rate)
c) कॉलम (Column)
d) इनम  से कोई नही ं(None of Above)

10. —————- ऑशन के साथ रॉ या कॉलम या दोनो ंको ीज कर सकते ह , अथात् वक शीट म
कही ंभी रहते हुए आप हमेशा उस रो या कॉलम म  सचूना को देख सकते ह ।
a) ीज पेस (Freeze-Panes)
b) ीज शीट (Freeze-Sheet)
c) पैराग ाफ (Paragraph)
d) उपरोत म  से कोई नही ं(None of Above)

11. िलट िवंडोज ऑशन एसेल के िकस टैब म  िथत होती ह ।
a) य ू(View)
b) होम (Home)
c) पेज लेआउट (Page Layout)
d) उपरोत सभी (All of Above)

12. एसेल म  शीट का िडफॉट य ूहोता ह ।
a) फुल ीन (Full Screen)
b) नामल Normal)
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c) वेब आउट लाइन (Web Outline)
d) इनम  से कोई नही ं(None of Above)

13. एम एस एसेल या ह ।
a) िवंडोज पर आधािरत ोसेसर पैकेज
b) िवंडोज पर आधािरत ेडशीट पैकेज
c) डॉस पर आधािरत ेडशीट पैकेज
d) डॉस पर आधािरत ोसेसर पैकेज

14. एम एस एसेल 2010 म  िकसी भी नई फाइल का िडफॉट नाम या होता ह ।
a) बुक-1 (Book-1)
b) बुक-2 (Book-2)
c) बुक-3 (Book-3)
d) बुक-4 (Book-4)

15. एम एस एसेल म  बनाई गई फाइलो ंको कहा जाता ह ।
a) वक  शीट (Work-sheet)
b) वक  जॉब (Work-job)
c) वक  बुक (Work-Book)
d) उपरोत सभी (All of Above)

Answer Sheet
1. अगर आप अपनी वक शीट म  सीधे एिडिटंग नही करना चाहते ह  तो डेटा को एिडट और इंटर करने
के िलये आप ——————- का उपयोग भी कर सकते ह ।
Answer – a) फॉमूला बार (Formula Bar)

2. िकसी एमएस एसेल सू म  संलन िवतार के ारभ व अंत के सैल एडेस को —————- के
ारा पृथक िकया जाता ह ।
Answer – d) कॉलन (:)

3. ऐसा िनयम ह  जो वैय ूके पवूानुमान म  मदद करता ह ।
Answer – c) गोल सीक (Gol Sheek)

4. इस टैब म  िूफंग टूस होती ह  जैसे-
Answer – a) िरय ू(Review)

5. ——————- ऐसा िनयम ह  जो वैय ूके पवूानुमान म  मदद करता ह ।
Answer – c) गोल सीक (Goal Seek)

ANKAJ INFOTECH



6. सैल िनिचत करने के िलए यानी संबंिधत सेल के वत : िर स को रोकने के िलए कॉलम और रो की
संया के पहले ————- टाइप करते ह ।
Answer – b) $

7. एक पृथक शीट के सेल से आंकड़ो ंको ात करना —————– कहलाता ह ।
Answer – b) रेफर िसंग (Refreshing)

8. एसेल वक शीट के चयिनत अंश को आप कैसे िंट कर ग ।
Answer – d) िजस अंश को िंट करना ह  उसे िसलेट कर िंट डायलॉग बॉस मे िसलेशन िवकप
चुनकर

9. एम एस एसेल 2010 म , सेल म  कमेट्स िलखने को कहते ह ।
Answer – a) सेल िटप (Cell-Trip)

10. —————- ऑशन के साथ रॉ या कॉलम या दोनो ंको िज कर सकते ह , अथात् वक शीट म
कही ंभी रहते हुए आप हमेशा उस रो या कॉलम म  सचूना को देख सकते ह ।
Answer – a) ीज पेस (Freeze-Panes)

11. िलट िवंडोज ऑशन एसेल के िकस टैब म  िथत होती ह ।
Answer – a) य ू(View)

12. एसेल म  शीट का िडफॉट य ूहोता ह ।
Answer – b) नामल (Normal)

13. एम एस एसेल या ह ।
Answer – b) िवंडोज पर आधािरत ेडशीट पैकेज

14. एम एस एसेल 2010 म  िसकी भी नई फाइल का िडफॉट नाम या होता ह ।
Answer – a) बुक-1 (Book-1)

15. एम एस एसेल म  बनाई गई फाइलो ंको कहा जाता ह ।
Answer – c) वक -बुक (Work-Book)
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ऍम एस एसेल भाग – 11 (िहंदी म )
1. पवूिलिखत फॉमूले होते ह , जो वत : गणना का काय करते ह ।
a) फंशन (Function)
b) इवेशन (Equation)
c) टेलेट्स (Template)
d) िरएशन (Reaction)

2. एमएस एसेल 2007 का उपयोग िविभन कार के —————— म  िकया जाता ह  जो सामाय
से लेकर जिटल कायो तक उपयोगी होते ह ।
a) गणना (Calculation)
b) म नपुलेशन (Manipulation)
c) ेज टेशन (Presentation)
d) एसेशन (Expreesion)

3. हायरकी म  आइटम के तर म  बदलाव के िलए इसका उपयोग करके इंडट बढ़ा सकते ह ।
a) टैब (Tab)
b) बैकपेस (Backspace)
c) िडलीट (Delete)
d) पेसबार (SpaceBar)

4. बायी ंतरफ से अकेले अर को िमटाने के िलए आप  ेस कर सकते ह ।
a) िडलीट (Delete)
b) बैकपेस (Backspace)
c) इंटर (Enter)
d) पेसबार (SpaceBar)

5. —————– एक ऐसी फाइल ह , जो ‘’रेडी टू यजू’’ प म  एलीकेशन ारा दान करता ह ।
a) शीट (Sheet)
b) टेपलेट्स (Template)
c) बुक (Book)
d) िरपोट (Report)

6. ——————- डेटा का द िटगत िरेजटेशन ह  और सचूना को समझने के िलए आसान और
आकिषत तरीके से ितपािदत करता ह ।
a) चाट (Chart)
b) टेबल (Table)
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c) िपचर (Picture)
d) ग ािफक (Graphic)

7. —————— वतं िडजाइन ह , िजसका उपयोग डॉयमूट के िविभन भागो म  िकया जा सकता
ह ।
a) ग ािफस (Graphics)
b) टाइस (Style)
c) िपचस (Picture)
d) थीस (Thames)

8. फाइल को ओपन, सेव, लोज, एवं िंट करने की कमांड इसम  होती ह ।
a) य ूटैब (View Tab)
b) ऑिफस बटन (Office Button)
c) इसट टैब (Insert Tab)
d) िरय ूटैब (Review Tab)

9. ——————- ऑशन के साथ रो या कोलम या दोनो ंको ीज कर सकते ह  अथात् वक शीट रहते
हुए आप हमेशा उस रो या कालम म  सचूना को देख सकते हो।
a) िलट (Split)
b) अर ज (Arrange)
c) िफटर (Filter)
d) िज पेस (Freeze-Pan)

10. माइोसॉट एसेल 2007 म  एक अकेली फाइल या डॉयमेूट ——————– कहलाती ह ।
a) वक  बुक (Work-Book)
b) वक  शीट (Work-Sheet)
c) शीट (Sheet)
d) नोट बुक (Note-Book)

11. सेल िनिचत करने के िलए यािन संबंिधत सेल के वत : रे स को रोकने के िलए, कॉलम और रो
की संया के पहले ——————- टाईप करते ह ।
a) हैश (#)
b) डॉलर ($)
c) ितशत (:)
d) टार (‘)

12. पेज के ऊपरी मािजन म  िथत टैट को —————— कहते ह ।
a) फुटर (Footer)
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b) कोलम (Column)
c) हेडर (Header)
d) पैराग ाफ (Paragraph)

13. िलिटंग या ीिजंग पेन के ारा आप वक शीट के दो ेो ंको देख सकते ह  तथा इनके ारा आप
लॉक कर सकते ह ।
a) शीट (Sheet)
b) पेज (Page)
c) रो या कॉलम (Row / Column)
d) इनम  से कोई नही ं(None of Above)

14. ेडशीट ोग ाम म  दो से अिधक सेलो ंके िसलेशन को कहा जाता ह ।
a) टेबल (Table)
b) बुक (Book)
c) फाईल (File)
d) शीट (Sheet)

15. सेल एडेस कहां िदखाई देता ह ।
a) नेम बॉस (Name Box)
b) फॉमूलाबार (Formula Bar)
c) टाकबार (Task-Bar)
d) इनम  से कोई नही ं(None of Above)

Answer Sheet
1. पवूिलिखत फॉमूले होते ह , जो वत : गणना का काय करते ह ।
Answer – a) फंशन (Function)

2. एमएस एसेल 2007 का उपयोग िविभन कार के —————— म  िकया जाता ह  जो सामाय
से लेकर जिटल काया तक उपयोगी होते ह ।
Answer – a) गणना (Calculation)

3. हायरआकी म  आइटम के तर म  बदलाव के िलए इसका उपयोग करके इंडट बढ़ा सकते ह ।
Answer – a) टैब (Tab)

4. बायी ंतरफ से अकेले अर को िमटाने के िलए आप  ेस कर सकते ह ।
Answer – b) बैकपेस (Backspace)

5. —————– एक ऐसी फाइल ह , जो ‘’रेडी टू यजू’’ प म  एलीकेशन ारा दान करता ह ।
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Answer – b) टेपलेट्स (Template)

6. ——————- डेटा का द िटगत िरेजटेशन ह  और सचूना को समझने के िलए आसान और
आकिषत तरीके से ितपािदत करता ह ।
Answer – a) चाट (Chart)

7. —————— वतं िडजाइन ह , िजसका उपयोग डॉयमूट के िविभन भागो म  िकया जा सकता
ह ।
Answer – b) टाइस (Style)

8. फाइल को ओपन, सेव, लोज, एवं िंट करने की कमांड इसम  होती ह ।
Answer – b) ऑिफस बटन (Office Button)

9. ——————- ऑशन के साथ रो या कोलम या दोनो ंको ीज कर सकते ह  अथात् वक शीट रहते
हुए आप हमेशा उस रो या कालम म  सचूना को देख सकते हो। 
Answer – d) ीज पेस (Freeze-Pans)

10. माइोसॉट एसेल 2007 म  एक अकेली फाइल या डॉयमेूट ——————– कहलाती ह ।
Answer – a) वक  बुक (Work-Book)

 11. सेल िनिचत करने के िलए यािन संबंिधत सेल के वत : रे स को रोकने के िलए, कॉलम और रो
की संया के पहले ——————- टाईप करते ह ।
Answer – b) डॉलर ($)

12. पेज के ऊपरी मािजन म  िथत टैट को —————— कहते ह ।
Answer – c) हेडर (Header)

13. िलिटंग या ीिजंग पेन के ारा आप वक शीट के दो ेो ंको देख सकते ह  तथा इनके ारा आप
लॉक कर सकते ह ।
Answer – c) रो या कॉलम (Row / Column)

14. ेडशीट ोग ाम म  दो से अिधक सेलो ंके िसलेशन को कहा जाता ह ।
Answer – a) टेबल (Table)

15. सेल एडेस कहां िदखाई देता ह ।
Answer – a) नेम बॉस (Name-Box)
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ऍम एस एसेल भाग – 12 (िहंदी म )
1. एमएस एसेल 2007 म , टेपलेट फाइल का एसट सन —————- ह ।
a) डीओसीएस (DOCX)
b) वायरल टी एस  (ViralTX)
c) एसेएल टी एस (Excel TX)
d) जेडएल टी एस (ZLTX)

2. —————– अकाउटेंट के बही खाते के समान ह , जो रो और कॉलम  म  रखा गया ह ।
a) टेबल (Table)
b) एमएस एसेस 2007 (MS Access 2007)
c) फॉमट (Format)
d) शीट (Sheet)

3. एमएस एसेल 2007 का उपयोग िविभन कार के ————– म  िकया जाता ह , जो सामाय से
लेकर जिटल काय तक उपयोग होते ह ।
a) एसेशन (Expressing)
b) गणना (Calculation)
c) मेनुपुलेशन (Manipulate)
d) ेज टेशन (Presentation)

4. फॉमूले मे शू से अंत तक के सैल एडेस के ारा एडजसट रज िनिदट होती ह  और इसे ————–
ारा पृथक करते ह ।
a) सेमीकॉलन (;)
b) कोमा (,)
c) फुलटॉप (.)
d) कॉलन (:)

5. डेटा और सचूनाओं को समझने म  आसान व आकषक तरीके म  िवजुअल प से िरजट करता ह ।
a) चाट (Chart)
b) टेबल (Table)
c) शीट (Sheet)
d) कॉलम (:)

6. अगर आप अपनी वक शीट म  सीधे एिडिटंग नही ंकरना चाहता ह  तो डेटा को एिडट और एंटर करने
के िलए आप —————— का उपयोग भी कर सकते ह ।
a) फॉमूला बार (Formula Bar)
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b) टाइटल बार (Title Bar)
c) मेनु बार (Menu Bar)
d) पेस बार (Space Bar)

7. इस टैब म  ुिफंग टूस होती ह  जैसे-
a) िरय ू(Review)
b) डाटा (Data)
c) य ू(View)
d) इसट (Insert)

8. यिद आप चौड़े फॉमट म  िंट लेना चाहते ह  तो िकस तरह पेज ओिरएंटेशन या अिभिवयास का
योग कर गे।
a) ल डकेप (Landscape)
b) पोट ट (portrait)
c) ैितज (Horizontal)
d) उवाकार (Vertical)

9. —————– पवूिलिखत फॉमूले होते ह  जो वत : गणना का काय करते ह ।
a) फंशन (Function)
b) इवेशन (Equation)
c) टेपलेट्स (Template)
d) िरएशन (Reaction)

10. एमएस एसेल 2010 का उपयोग िविभन कार —————- म  िकया जाता ह  जो सामाय प
से लेकर जिटल कायो तक उपयोगी होते ह ।
a) गणना (Calculation)
b) मैनुपुलेशन (Manipulation)
c) ेज टेशन (Presentation)
d) एसेशन (Expression)

11. पेज के ऊपरी मािजन म  िथत टेट को —————- कहते ह ।
a) फुटर (Footer)
b) कॉलम (Column)
c) हेडर (Header)
d) पैराग ाफ (Paragraph)

12. दतावेज को सेव करते समय सेव और सेव एज म  अंतर ह ।
a) कोई भी अंतर नही ंहै

ANKAJ INFOTECH



b) सेव उस दतावेजो  को संग िहत करेगा जो पहले से ही संग िहत ह
c) सेव एज हम  नाम और थान बदलने की अनुमित देता ह
d) A और C दोन

13. वक शीट म  रहते हुए आप हमेशा उस रो या कॉलम म  सचूना को देख सकते ह ।
a) िलट (Split)
b) अर ज (Orange)
c) िफलटर (Filter)
d) ीज पेस (Freeze Pan)

14. फॉमूला म  ————— ारा अलग िकए गए सैल एडेस के जिरए नॉन एसचज रज का वणन
होता ह ।
a) सेमीकालन (;)
b) कोमा (,)
c) फुलटोप (.)
d) कोलन (:)

15. एक टेट फीड म  आप —————- कैरेटर को एंटर कर सकते ह ।
a) 125
b) 375
c) 235
d) 255

Answer Sheet
1. एमएस एसेल 2007 म , टैपलेट फाइल का एसट सन —————- ह ।
Answer – c) एसेएल टी एस (Excel TX)

2. —————– अकाउटेंट के बही खाते के समान ह , जो रो और कोलम म  रखा गया ह ।
Answer – b) शीट (Sheet)

3. एमएस एसेल 2007 का उपयोग िविभन कार के ————– म  िकया जाता ह , जो सामाय से
लेकर जिटल काय तक उपयोग होते ह ।
Answer – b) गणना (Calculation)

4. फॉमूले मे शू से अंत तक के सैल एडेस के ारा एडजसट रज िनिदट होती ह  और इसे ————–
ारा पृथक करते ह ।
Answer – d) कॉलन (:)
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5. डेटा और सचूनाओं को समझने म  आसान व आकषक तरीके म  िवजुअल प से िरजट करता ह ।
Answer – a) चाट (Chart)

6. अगर आप अपनी वक शीट म  सीधे एिडिटंग नही ंकरना चाहता ह  तो डेटा को एिडट और एंटर करने
के िलए आप —————— का उपयोग भी कर सकते ह ।
Answer – a) फॉमूला बार (Formula Bar)

7. इस टैब म  ुिफंग टूस होती ह  जैसे-
Answer – a) िरय ू(Review)

8. यिद आप चौड़े फॉमटम  िंट लेना चाहते ह  तो िकस तरह पेज ओिरएंटेशन या अिभिवयास का
योग कर गे।
Answer – a) ल डकेप (Landscape)

9. —————– पवूिलिखत फॉमूले होते ह  जो वत : गणना का काय करते ह ।
Answer – a) फंशन (Function)

10. एमएस एसेल 2010 का उपयोग िविभन कार —————- म  िकया जाता ह  जो सामाय प
से लेकर जिटल कायो तक उपयोगी होते ह ।
Answer – a) गणना (Calculation)

11. पेज के ऊपरी मािजन म  िथत टेट को —————- कहते ह ।
Answer – c) हेडर (Header)

12. दतावेज को सेव करते समय सेव और सेव एज म  अंतर ह ।
Answer – d) A और C दोन (Both)

13. ऑेशन के साथ आप रो या कॉलम दोनो ंको ीज कर सकते ह  अथात् वक शीट म  रहते हुए आप
हमेशा उस रो या कॉलम म  सचूना को देख सकते ह ।
Answer – d) ीज पेस (FreezePan)

14. फॉमूला म  ————— ारा अलग िकए गए सैल एडेस के जिरए नॉन एसचज रज का वणन
होता ह ।
Answer – b) कोमा (,)

15. एक टेट फीड म  आप —————- कैरेटर को एंटर कर सकते ह ।
Answer – d) 255
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ऍम एस एसेल भाग – 13 (िहंदी म )
1. आसानी से पढ़ने के िलए —————- का उपयोग कर सचूना को हॉिरजेटल रो और विटकल
कॉलम म  यविथत िकया जाता ह ।
a) सेल (Cell)
b) शीट (Sheet)
c) बॉस (Box)
d) टेबल (Table)

2. ‘आटोमेिटक िरलेिटव सेल रेफरेस’ को रोकने के िलए िकस िवशेष केरेटर का योग कॉलम व रो
नबर के पवू म  होते ह ।
a) हेश (#)
b) डॉलर ($)
c) मटीपलाई (Multiply)
d) इनम  से कोई नही ं(None of Above)

3. िननिलिखत म  से कौन-सा फॉमूला (सू) सही प म  िविटत ह ।
a) =SUM (A1A10)
b) =SUM (:A10A10)
c) =SUM (A1:A10)
d) उपरोत सभी (All of Above)

4. एक पृथक शीट के सेल से आंकड़ो को ात करना ————— कहलाता ह ।
a) एसेिसंग (Accessing)
b) रेफेर िसंग (Refreshing)
c) अपडेिटंग (Updating)
d) फंशिनंग (Functioning)

5. एमएस एसेल म  िकसी फंशन को डालने के िलए संित कंुजी योग म  लाई जाती ह ।
a) Shift + F3
b) Shift + F4
c) Shift + F5
d) Shift + F7

6. एमएस एसेल म  ‘ईफऐरर’ ह ।
a) लॉिजकल फंशन (Logical Function)
b) सम फंशन (Sum Function)
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c) A और B दोन (Both)
d) उपरोत म  से कोई नही ं(None of Above)

7. एमएस एसेल म  टेट के संयोजन के िलए —————- युत िकया जाता ह ।
a) एपॉट ॉपी (‘)
b) एसलेम सन ()
c) हैश (#)
d) एस ड (&)

8. सेल एकमा िकसकी िविशटता ह ।
a) यिूनस (Unix)
b) डॉस (DOS)
c) िसटम सॉटवेयर (System Software)
d) एलीकेशन सॉटवेयर (Application Software)

9. यिद फोमट संया िकसी सेल म  सटीक (िफट) नही ंबैठता ह  तो ————— दिशत होता ह ।
a) हैशहैशहैशहैशहैश (#####)
b) हैश डीआईवी/ओ (#DIV/O)
c) हैश डीआईवी  (#DIV)
d) उपरोत म  से कोई नही ं(None of Above)

10. िविशट तंभो को िचिहत करने की िया तािक वे पंितया व तभ को दृय पटल पर देखा जा
सक  ———— ।
a) ीिजंग (Freezing)
b) लॉिकंग (Locking)
c) सेलेिटंग (Selecting)
d) िफिसंग (Fixeing)

11. एमएस एसेल िविभन कार की ————– के िलए युत होता ह  जो सरल से जिटल कार
का होता ह ।
a) गणना (Calculation)
b) तुतीकरण (Presentation)
c) इमेज केशन (Image Compression)
d) इमेज एिडिटंग (Image Editing)

12. एमएस एसेल म  ‘एबीसी’ काय युत होता ह ।
a) िकसी संया का िनप मान हेतु
b) िकसी संया का अपतू मान हेतु
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c) िकसी संया का विधत मान हेतु
d) ‘एबीसी’ एक फंशन नही ंह

13. एमएस एकसेल ोग ाम म  खानो ंकी चौड़ाई और पंित की लबाई मापी जाती ह ।
a) इंच (Inch)
b) िपसेल (Pixel)
c) स टीमीटर (CM)
d) परस टेज (%)

14. एमएस एसेल 2010 म  बाय िडफॉट िकतनी शीट होती ह ।
a) 1
b) 3
c) 4
d) उपरोत म  से कोई नहीं

15. एमएस एसेल म  बनने वाली शीट को िनन म  से या कहा जाता ह ।
a) डायमेूट शीट (Document Sheet)
b) ेड  शीट (Spreed Sheet)
c) फाइल शीट (File Sheet)
d) फॉडर शीट (Folder Sheet)

Answer Sheet
1. आसानी से पढ़ने के िलए —————- का उपयोग कर सचूना को हॉिरजेटल रो और विटकल
कॉलम म  यविथत िकया जाता ह ।
Answer – d) टेबल (Table)

2. ‘आटोमेिटक िरलेिटव सेल रेफरेस’ को रोकने के िलए िकस िवशेष केरेटर का योग कॉलम व रो
नबर के पवू म  होते ह ।
Answer – b) डॉलर ($)

3. िननिलिखत म  से कौन-सा फॉमूला (सू) सही प म  िविटत ह ।
Answer – c) =SUM(A1:A10)

4. एक पृथक शीट के सेल से आंकड़ो को ात करना ————— कहलाता ह ।
Answer – b) रेफेर िसंग (Refreshing)

5. एमएस एसेल म  िकसी फंशन को डालने के िलए संित कंुजी योग म  लाई जाती ह ।
Answer – a) Shift + F3
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6. एमएस एसेल म  ‘ईफऐरर’ ह ।
Answer – a) लॉिजकल फंशन (Logical Function)

7. एमएस एसेल म  टेट के संयोजन के िलए —————- युत िकया जाता ह ।
Answer – d) एस ड (&)

8. सैल एकमा िकसकी िविशटता ह ।
Answer – a) यिूनस (Unix)

9. यिद फोमट संया िकसी सेल म  सटीक (िफट) नही ंबैठता ह  तो ————— दिशत होता ह ।
Answer – a) हैशहैशहैशहैशहैश (#####)

10. िविशट तंभो को िचिहत करने की िया तािक वे पंितया व तभ को दृय पटल पर देखा जा
सक  —————- ।
Answer – a) ीिजंग (Freezing)

11. एमएस एसेल िविभन कार की ————– के िलए युत होता ह  जो सरल से जिटल कार
का होता ह ।
Answer – a) गणना (Calculation)

12. एमएस एसेल म  ‘एबीसी’ काय युत होता ह ।
Answer – a) िकसी संया का िनप मान हेतु

13. एमएस एकसेल ोग ाम म  खानो ंकी चौड़ाई और पंित की लबाई मापी जाती ह ।
Answer – a) इंच (Inch)

14. एमएस एसेल 2010 म  बाय िडफॉट िकतनी शीट होती ह ।
Answer – b) 3

15. एमएस एसेल म  बनने वाली शीट को िनन म  से या कहा जाता ह ।
Answer – b) ेडशीट (Spreed-sheet)
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ऍम एस एसेल भाग – 14 (िहंदी म )
1. एमएस एसेल 2010 म  िकही ं भी 5 िवयाथी की िरकॉड का औसत ात करने के िलए कौनसा
फॉमूला योग होता ह ।
a) मेस (MAX)
b) िमन (MIN)
c) एवरेज (AVERAGE)
d) सम  (SUM)

2. हम अपनी वक शीट म  हाइपरिलंक िनन म  से िकस शाटकट की को दबा कर जोड़ सकते ह ।
a) Alt + K
b) Ctrl + H
c) Ctrl + K
d) Ctrl + M

3. इनम  से कौन से फंशन के ारा करट डाटा इंसट  कराई जा सकती ह ।
a) डाटा (DATA)
b) टूडे (TODAY)
c) नाउ (NOW)
d) िटम (TRIM)

4. एमएस एसेल 2010 की एक वक शीट म  िकतने रो और कॉलम होते ह ।
a) 10,48,576 और 16,384
b) 65,535 और 256
c) A और B दोन
d) इनम  से कोई नहीं

5. एमएस एसेल 2010 म  कौन से टैब ारा चाट  इंसट  करवाया जाता ह ।
a) फाइल (File)
b) इंसट (Insert)
c) य ू(New)
d) डाटा (Data)

6. एमएस एसेल म  िपवोट टेबल यजू म  ली जाती ह ।
a) डाटा को संित बनाने के िलये
b) डाटा को शाट करने के िलये
c) डाटा को देखने के िलये
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d) उपरोत सभी

7. एमएस एसेल म  डाटा शॉिटग का ऑशन िकस टेब म  उपलध होता ह ।
a) होम (Home)
b) फॉमूला (Formula)
c) य ू(View)
d) इंसट (Insert)

8. बाय िडफॉट सेल म  एटर नबिरक वेय ूका अलाइनमेट या होता ह ।
a) लेट अलाइन (Left Align)
b) राईट अलाइन (Right Align)
c) सेटर अलाइन (Center Align)
d) अनअलाइन (An Align)

9. एमएस एसेल 2010 िकस पेकेज म  होता ह ।
a) एमएस ऑिफस (MS Office)
b) कोरेल ड ा (CorelDraw)
c) पेज मेकर (Pagemaker)
d) टैली (Tally)

10. एमएस एसेल 2010 म  िकसी भी वक शीट का नाम मैसीमम िकतने केरेटर म  हो सकता ह ।
a) 28
b) 29
c) 30
d) 31

11. िनन म  से एसयटू एडेस कौनसा होता ह ।
a) P21
b) $P21
c) $P$ 21
d) उपरोत म  से कोई नहीं

12. िनन म  से कौनसा रेलेिटव एडेस होता ह ।
a) P21
b) $P 21
c) $P$ 21
d) उपरोत म  से कोई नहीं
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13. एसेल म  शीट का िडफॉट य ूहोता ह ।
a) वक  (Work)
b) ऑटो (Auto)
c) नामल  (Normal)
d) रोमन (Roman)

14. —————— परेडफाइन फॉमूला होते ह  जो वत : गणना का काय करते ह ।
a) फंशन (Function)
b) वडरेप (Word-wrap)
c) ऑटो सम (Auto Sum)
d) लॉिजल (Logical)

15. एमएस एसेल म  जो की संशोधन के काम आती ह  , वह ह ।
a) F1
b) F2
c) F3
d) F4

Answer Sheet
1. एमएस एसेल 2010 म  िकही ं भी 5 िवयाथी की िरकॉड का औसत ात करने के िलए कौनसा
फॉमूला योग होता ह ।
Answer – c) एवरेज (AVERAGE)

2. हम अपनी वक शीट म  हाइपरिलंक िनन म  से िकस शाटकट की को दबा कर जोड़ सकते ह ।
Answer – c) Ctrl + K

3. इनम  से कौन से फंशन के ारा करट डाटा इंसट  कराई जा सकती ह ।
Answer – b) टूडे (TODAY)

4. एमएस एसेल 2010 की एक वक शीट म  िकतने रो और कॉलम होते ह ।
Answer – a) 10,48,576 और 16,384

5. एमएस एसेल 2010 म  कौन से टैब ारा चाट  इंसट  करवाया जाता ह ।
Answer – b) इंसट (Insert)

6. एमएस एसेल म  िपवोट टेबल यजू म  ली जाती ह ।
Answer – a) डाटा को संित बनाने के िलये
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7. एमएस एसेल म  डाटा शॉिटग का ऑशन िकस टेब म  उपलध होता ह ।
Answer – a) होम (Home)

8. बाय िडफॉट सेल म  एटर नबिरक वेय ूका अलाइनमेट या होता ह ।
Answer – b) राईट अलाइन (Right Align)

9. एमएस एसेल 2010 िकस पेकेज म  होता ह ।
Answer – a) एमएस ऑिफस (MS Office)

10. एमएस एसेल 2010 म  िकसी भी वक शीट का नाम मैसीमम िकतने केरेटर म  हो सकता ह ।
Answer – d) 31

11. िनन म  से एसयटू एडेस कौनसा होता ह ।
Answer – b) $ पी 21

12. िनन म  से कौनसा रेलेिटव एडेस होता ह ।
Answer – c) $ पी $ 21

13. एसेल म  शीट का िडफॉट य ूहोता ह ।
Answer – c)  नामल (Normal)

14. —————— परेडफाइन फॉमूला होते ह  जो वत : गणना का काय करते ह ।
Answer – a) फंशन (Function)

15. एमएस एसेल म  जो की संशोधन के काम आती ह  , वह ह ।
Answer – b) F2
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ऍम एस एसेल भाग – 15 (िहंदी म )
1. िनन म  कौनसी एसेल की टम नही ंह ।
a) रो (Row)
b) कॉलम (Column)
c) डॉयमेूट (Document)
d) इनम  से कोई नही ं(None of Above)

2. पहले वाली वक शीट पर जाने के िलये हम ————— का योग करते ह ।
a) Alt + Page Up
b) Ctrl + Page Up
c) Ctrl + Page Down
d) Shift + Tab

3. डेटा और सचूनाओं को समझने म  आसान व आकषक तरीके म  िवजुअल प से िर जेट करता ह ।
a) चाट (Chart)
b) टेबल (Table)
c) सेिमकॉलन (;)
d) कॉलन (:)

4. अगर आप अपनी वक शीट म  सीधे एिडिटंग नही ंकरना चाहते ह  तो डेटा को एिडट और एंटर करने
के िलए आप ————– का उपयोग भी कर सकते ह ।
a) फॉमूलाबार (Formula Bar)
b) टाइटलबार (Title Bar)
c) मेयबूार (Menu Bar)
d) पेसबार (Space Bar)

5. इस टेब म  ुिफंग टूस होती ह  जैसे-
a) िरय ू(Review)
b) डाटा (Data)
c) य ू(View)
d) इंसट (Insert)

6. यिद आप चौड़े ॉमट म  िंट लेना चाहते ह  तो िकस तरह पेज ओिरएंटेशन या अिभिवयास का
योग करेग ।
a) ल डकेप (Landscape)
b) पोट ट (portrait)
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c) ैितज (Horizontal)
d) उवाधर (Vertical)

7. पेज के ऊपरी मािजन म  िथत टेट को ————– कहते ह ।
a) फुटर (Footer)
b) कॉलम (Column)
c) हेडर (Header)
d) पैराग ाफ (Paragraph)

8. आसानी से पढ़ने के िलए ————— का उपयोग कर सचूना को हॉिरजॉटल रो और वािटकल
कॉलम मे यविथत िकया जाता ह ।
a) सेल (Cell)
b) शीट (Sheet)
c) बॉस (Box)
d) टेबल (Table)

9. ————— ऐसा िनयम ह  जो वैय ू के पवूनुमान म  मदद करता ह ।
a) फाइंड (Find)
b) िरलेस (Replace)
c) गोल सीक (Gol Seek)
d) गोटू (Go To)

10. िकसी एमएस एसेल सू म  संलन िवतार के ारभ व अंत के सेल एडेस को —————- के
ारा पृथक िकया जाता ह ।
a) सेमीकॉलन (;)
b) कोमा (,)
c) फुलटाप (.)
d) कॉलन (:)

11. सेल िनिचत करने के िलए यािन संबंिधत सेल के वत : रे स को रोकने के िलए कॉलम और रो
की संया के पहले ————- टाइप करते ह ।
a) हेश (#)
b) डालर ($)
c) ितशत (%)
d) टार (*)

12. एक दतावेज की सभी सामग ी को चयिनत करने के िलए हम योग करते ह ।
a) Ctrl + A
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b) Ctrl + Z
c) Ctrl + C
d) Ctrl + U

13. िलट, अरज, िफटर ————— पवूिलिखत फॉमूले होते ह  जो वत : गणना करने का काय
करते ह ।
a) फंशन (Function)
b) इवेशन (Equation)
c) टेमलेट्स (Template)
d) िरएशन (Reaction)

14. एक पृथक शीट के सेल से आंकड़ो ंको ात करना ————— कहलाता ह ।
a) एसेिसंग (Accessing)
b) रेफेर िसंग (Refreshing)
c) अपडेिटंग (Updating)
d) फंशिनंग (Functioning)

15. एमएस एसेल 2010 म , टेमलेट फाइल का एसट शन ————— ह ।
a) .िडओिसएस (.DOCX)
b) .वाएएलटीएस (.YALTX)
c) .एसएलटीएस (.XLTX)
d) .जेडएलटीएस (.ZLTX)

Answer Sheet
1. िनन म  कौनसी एसेल की टम नही ंह ।
c) डॉयमेूट (Document)

2. पहले वाली वक शीट पर जाने के िलये हम ————— का योग करते ह ।
b) Ctrl + Page Up

3. डेटा और सचूनाओं को समझने म  आसान व आकषक तरीके म  िवजुअल प से िर जेट करता ह ।
a) चाट (Chart)

4. अगर आप अपनी वक शीट म  सीधे एिडिटंग नही ंकरना चाहते ह  तो डेटा को एिडट ओर एंटर करने
के िलए आप ————– का उपयोग भी कर सकते ह ।
a) फॉमूला बार (Formula Bar)

5. इस टेब म  ुिफंग टूस होती ह  जैसे-
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a) िरय ू(Review)

6. यिद आप चौड़े ॉमट म  िंट लेना चाहते ह  तो िकस तरह पेज ओिरएंटेशन या अिभिवयास का
योग करेग ।
a) ल डकेप (Landscape)

7. पेज के ऊपरी मािजन म  िथत टेट को ————– कहते ह ।
c) हेडर (Header)

8. आसानी से पढ़ने के िलए ————— का उपयोग कर सचूना को हॉिरजॉटल रो और वािटकल
कॉलम मे यविथत िकया जाता ह ।
d) टेबल (Table)

9. ————— ऐसा िनयम ह  जो वैय ूके पवूनुमान म  मदद करता ह ।
c) गोल सीक (Gol Sheek)

10. िकसी एमएस एसेल सू म  संलन िवतार के ारभ व अंत के सेल एडेस को —————- के
ारा पृथक िकया जाता ह ।
d) कॉलन (:)

11. सेल िनिचत करने के िलए यािन संबंिधत सेल के वत : रे स को रोकने के िलए कॉलम और रो
की संया के पहले ————- टाइप करते ह ।
b) डालर ($)

12. एक दतावेज के सभी सामग ी को चयिनत करने के िलए हम योग करते ह ।
a) Ctrl + A

13. िलट, अरज, िफटर ————— पवूिलिखत फॉमूले होते ह  जो वत : गणना करने का काय
करते ह ।
a) फंशन (Function)

14. एक पृथक शीट के सेल से आंकड़ो ंको ात करना ————— कहलाता ह ।
b) रेफेर िसंग (Refreshing)

15. एमएस एसेल 2010 म , टेमलेट फाइल का एसट शन ————— ह ।
c) .एसएलटीएस (.XLTX)
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ऍम एस एसेल भाग – 16 (िहंदी म )
1. —————- एक ऐसी फाइल ह  जो रेिड टू यजू प म  एिलकेशन ारा दान िकया जाता ह ।
a) शीट
b) टेमलेट्स
c) बुक
d) िरपोट

2. माइोसॉट एसेल 2010 म , एक अकेली फाइल  ————— कहलाती  ह ।
a) वक बुक
b) वक शीट
c) शीट
d) नोटबुक

3. ऑशन के साथ आप रो या कॉलम या दोनो ंको ीज कर सकते ह , अथात वक शीट म  रहते हुए आप
हमेशा उस रो या कॉलम म  सचूना को देख सकते ह ।
a) िलट
b) अर ज
c) िफटर
d) ीज पेस

4. फॉमूला म  ————— ारा अलग िकए गए सेल एडेस के जिरए नॉन एजेस अ रज का वणन का
होता ह ।
a) सेमीकालन
b) कोमा
c) फुलटोप
d) कोलन

5. ————— ऑटोमेिटक िरलेिटव सेल रेफरेस को रोकने के िलए िकस िवशेष केरेटर का योग
कॉलम व रो नबर के पवू म  होता ह ।
a) हैश
b) डॉलर
c) ितशत
d) टार

6. ————— टैब म  पेल चेक जैसे िूफंग टूल होते ह ।
a) िरयू
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b) डेटा
c) यू
d) इंसट

7. —————- डेटा का दृिटगत िरजेट शन है और सचूना को समझने के िलए आसान और
आकिषत तरीके से ितपािदत करता ह ।
a) चाट
b) टेबल
c) िपचर
d) ग ािफस

8. ‘—————-‘ अकाउटं के बहीखाते के समान ह , जो रो और कॉलम म  रखा गया ह ।
a) टेबल
b) एमएस एसेल 2007
c) फॉरमेट
d) शीट

9. एसेल म  औसत एक ————— ह ।
a) कंमाड
b) फंशन
c) फॉमूला
d) ोसेसर

10. एमएस एसेल म  डाटा िकसम  रखा जाता ह ।
a) रो
b) कॉलम
c) टेबल
d) नन ऑफ एबाऊ

11. एक सेल की रज —————- के ारा दिशत करते ह ।
a) (A6, A8)
b) (A6 : A8)
c) (A6 – A8)
d) (A6 + A8)

12. इलेट ॉिनक ेड शीट या ह ।
a) ऑपरेिटंग िसटम
b) एलीकेशन ोग ाम
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c) यिूटिलटी ोग ाम
d) उपरोत सभी

13. एमएस एसेल 2010 म  िकस टेब म  ुफीगं ग ुप होता ह ।
a) िरयू
b) इंसट
c) होम
d) डाटा

14. एमएस एसेल ोग ाम म  खानो ंकी चौड़ंाई और पंित की लबाई मापी जाती ह ।
a) इंच
b) िपसेल
c) स टीमीटर
d) परस टेज

15. शेषफल िनकलने के िलए कौनसा फंशन उपयोग िकया जाता ह ।
a) इंट
b) मोड
c) टम
d) लोग

Answer Sheet
1. —————- एक ऐसी फाइल ह  जो रेिड टू यजू प म  एिलकेशन ारा दान िकया जाता ह ।
Answer – b) टेमलेट्स

2. माइोसॉट एसेल 2010 म , एक अकेली फाइल ————— कहलाती ह ।
Answer – a) वक बुक

3. ऑशन के साथ आप रो या कॉलम या दोनो ंको ीज कर सकते ह , अथात वक शीट म  रहते हुए आप
हमेशा उस रॉ या कॉलम म  सचूना को देख सकते ह ।
Answer – d) ीज पेस

4. फॉमूला म  ————— ारा अलग िकए गए सेल एडेस के जिरए नॉन एजेस अ रज का वणन का
होता ह ।
Answer – b) कोमा

5. ————— ऑटोमेिटक िरलेिटव सेल रेफरेस को रोकने के िलए िकस िवशेष केरेटर का योग
कॉलम व रोल नबर के पवू म  होता ह ।
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Answer – b) डॉलर

6. ————— टैब म  पेल चेक जैसे िूफंग टूल होते ह ।
Answer – a) िरयू

7. —————- डेटा का दृिटगत िरजेट शन है और सचूना को समझने के िलए आसान और
आकिषत तरीके से ितपािदत करता ह ।
Answer – a) चाट

8. ‘—————-‘ अकाउटं के बहीखाते के समान ह , जो रो और कॉलम म  रखा गया ह ।
Answer – b) एमएस एसेल 2007

9. एसेल म  औसत एक ————— ह ।
Answer – b) फंशन

10. एमएस एसेल म  डाटा िकसम  रखा जाता ह ।
Answer – c) टेबल

11. एक सेल की रज —————- के ारा दिशत करते ह ।
Answer – b) (ए6 : ए8)

12. इलेट ॉिनक ेड शीट या ह ।
Answer – b) एलीकेशन ोग ाम

13. एमएस एसेल 2010 म  िकस टेब म  ुफीगं ग ुप होता ह ।
Answer – a) िरयू

14. एमएस एसेल ोग ाम म  खानो ंकी चौड़ंाई और पंित की लबाई मापी जाती ह ।
Answer – a) इंच

15. शेषफल िनकलने के िलए कौनसा फंशन उपयोग िकया जाता ह ।
Answer – b) मोड
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ऍम एस एसेल भाग – 17 (िहंदी म )
1. िननिलिखत म  से आप िकस Format को Auto Format Dialog Box म  Apply करने या न
करने को Decide कर सकते ह ।
a) Number Format
b) Border Format
c) Font Format
d) All of above

2. आप Cells म  लाग ूिकया गया Border कैसे हटा सकते ह ।
a) Chose None on Border Tab of format cells
b) Open the list on border tool in formatting toolbar then chose first tool (no
border)
c) Both of above
d) None of above

3. आप Excel म  Cells की range के िलये Shading color कहां Set करते ह ।
a) Chose required color from patterns tab of format cells dialog box
b) Chose required color on fill color tool in formatting toolbar
c) Choose required color on fill color tool in drawing toolbar
d) All of the above

4. आप excel म  page border कहा ँसे Set करते ह ।
a) From border tab in format cells dialog box
b) From border tool in formatting toolbar
c) From line style tool in drawing toolbar
d) You can not page border in excel

5. यिद 0 से 100 तक सभी संया लाल रंग म  दिशत करनी हो तो –
a) Use=if() function to format the required numbers red
b) Apply conditional formatting command on format menu
c) Select the calls that contain number between 0 and 100 then click red color on
text color tool
d) All of above

6. जब  Conditional  formatting  लाग ू करते ह  तब आप —————- के  against
conditions  को  check  कर सकते ह ।
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a) Cell value
b) Formula
c) Both of above
d) None of above

7. िननिलिखत म  से जो Conditional formatting के संदभ म  सय नही ंह ।
a) You can add more then one condition to check
b) You can set condition to look for bold and apply italics on them
c) You an apply font, border and pattern formats apply that meets the specified
conditions
d) You can delete any condition from condition formatting dialog box if it is not
required

8. िननिलिखत म  से जो अमाय वाय ह ।
a) Sheet tabs can be colored
b) Some picture can be applied as a background of a sheet
c) You can set the column width automatically fit the amount of text
d) The width of a row can be specified manually or fit automatically

9. आप formula palette को —————- के िलये योग कर सकते ह ।
a) Format cells containing numbers
b) Create and edit formula containing functions
c) Enter assumption data
d) Copy a range of cells

10. जब एक range select हो, आप पहली cell को activate कैसे कर सकते ह ।
a) Press the alt key
b) Press tab
c) Press enter
d) None of above

11. िकस tool को आप कुछ cells को join करने के िलये तथा joined की गई cells के बीच म
content को रखने के िलये योग करते ह ।
a) From format cells dialog box click on merge cells check box
b) From format cells dialog box select the centered alignment
c) From format cells dialog box choose merge and center check box
d) Click on merge and center tool on formatting toolbar
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12. Excel Screen पर Tab Scroll Buttons होते ह ।
a) Toward the bottom right corner
b) Toward the bottom left corner
c) Toward the top right corner
d) Toward the top left corner

13. Formula bar के बॉईं तरफ का Name box –
a) Shows the name of workbook currently working on
b) Shows the name of worksheet currently working on
c) Shows the name of cell of range currently working on
d) None of above

14. येक excel file एक workbook होती ह  जो अलग-अलग sheets रखती ह । िननिलिखत
म  से कौन Workbook म  Sheet नही ंहो सकती ह ।
a) Work sheet
b) Chart sheet
c) Module sheet
d) Data sheet

15. िननिलिखत म  से कौन सा cell के content को edit करने का सही तरीका नही ंह ।
a) Press the alt key
b) Press the F2 key
c) Click the formula bar
d) Double click the cell

Answer Sheet
1. िननिलिखत म  से आप िकस Format को Auto Format Dialog Box म  Apply करने या न
करने को Decide कर सकते ह ।
Answer – d) All of above

2. आप Cells म  लाग ूिकया गया Border कैसे हटा सकते ह ।
Answer – c) Both of above

3. आप Excel म  Cells की range के िलये Shading color कहां set करते ह ।
Answer – d) All of the above

4. आप excel म  page border कहा ँसे Set करते ह ।
Answer – d) You can not page border in excel
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5. यिद 0 से 100 तक सभी संया लाल रंग म  दिशत करनी हो तो –
Answer – b) Apply conditional formatting command on format menu

6. जब  Conditional  formatting  लाग ू करते ह  तब आप —————- के  against
conditions  को  check  कर सकते ह ।
Answer – c) Both of above

7. िननिलिखत म  से जो Conditional formatting के संदभ म  सय नही ंह ।
Answer – b) You can set condition to look for bold and apply italics on them

8. िननिलिखत म  से जो अमाय वाय ह ।
Answer – d) The width of a row can be specified manually or fit automatically

9. आप formula palette को —————- के िलये योग कर सकते ह ।
Answer – b) Create and edit formula containing functions

10. जब एक range select हो, आप पहली cell को activate कैसे कर सकते ह ।
Answer – d) None of above

11. िकस tool को आप कुछ cells को join करने के िलये तथा joined की गई cells के बीच म
content को रखने के िलये योग करते ह ।
Answer – d) Click on merge and center tool on formatting toolbar

12. Excel Screen पर Tab Scroll Buttons होते ह ।
Answer – b) Toward the bottom left corner

13. Formula bar के बॉईं तरफ का Name box –
Answer – c) Shows the name of cell of range currently working on

14. येक excel file एक workbook होती ह  जो अलग-अलग sheets रखती ह । िननिलिखत
म  से कौन Workbook म  Sheet नही ंहो सकती ह ।
Answer – d) Data sheet

15. िननिलिखत म  से कौन सा cell के content को edit करने का सही तरीका नही ंह ।
Answer – a) Press the alt key
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ऍम एस एसेल भाग – 18 (िहंदी म )
1.  Excel  म  आप  data  source  के साथ मुय दतावेज को जोड़ सकते ह ।  Mail  Merge
Operation  म  word  —————–  होता ह ।
a) Server
b) Source
c) Client
d) None

2. यिद excel की auto calculate mode िडसऐबल ह  तो आप formula cells की values
को update कैसे कर सकते ह ।
a) F8
b) F9
c) F10
d) F11

3. Excel म  automatic या manual कैलकुलेशन मोड को कहां से बदला जा सकता ह ।
a) Double click cal indicator on status bar
b) Go to tools >> Options >> calculation and mark the corresponding radio
button
c) Both of above
d) None of above

4. Excel Worksheet म  ग ीड लाइन को hide या show कैसे करते ह ।
a) Go to tools >> Options >> View tab and mark or remove the check named
gridline
b) Click gridline tool on forms toolbar
c) Both of above
d) None of above

5. िननिलिखत Excel Screen घटक म  से कौन turn on या off नही ंहो सकता ह ।
a) Formula Bar
b) Status Bar
c) Tool Bar
d) None of above

6. Excel म  कुछ cells को चयिनत करने पर ctrl + X press करने पर या होगा।
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a) The cell content of selected cells disappear from cell and stored in clipboard
b) The cells selected are marked for cutting
c) The selected cells are deleted and the cells are shifted left
d) The selected cells are deleted and cells are shifted up

7. िननिलिखत िवकप म  से कौन paste special dialog box म  उपलध नही ंहोता ह ।
a) Add
b) Subtract
c) Divide
d) SQRT

8. Data के Column को row म  बदलने के िलये आप कौन सी Command को choose कर गे।
a) Cut and paste
b) Edit >> Paste special >> Transpose
c) Both of above
d) None of above

9. यह वीकाय ह  िक एक बड़े Text को adjacent cell म  रहने द  यिद –
a) Data will be entered in the adjacent cells
b) No data will be entered in the adjacent cells
c) There is no suitable abbreviation for the text
d) There is on time to format the text

10. कौन सा cell pointer दशाता ह  िक आप selection बना सकते ह ।
a) Doctor’s symbol (Big Plus)
b) Small thin plus icon
c) Mouse pointer with anchor at the tip
d) None of above

11. कौन सा cell pointer दशाता ह  िक आप series को fill कर सकते ह ।
a) Doctor’s symbol (Big Plus)
b) Small thin plus icon
c) Mouse pointer with anchor at the tip
d) None of above

12. आप ————— के ारा column की चौड़ाई को auto fit कर सकते ह ।
a) Double clicking on the column name on column header
b) Double click on the cell pointer in worksheet
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c) Double clicking on column right border on column header
d) Double clicking on the column left border of column header

13. Long Text एक सेल के साथ म  एक से अिधक line म  टूट सकता ह  आप ऐसा —————
के ारा कर सकते ह ।
a) Wrap text in format >> cells
b) Justify in edit >> cells
c) Text wrapping in format >> cells, layout tab
d) All of above

14. MS Excel, Fill Series डायलॉग बॉस म  step के िलये ————– िडफॉट वैय ूदान
करता ह ।
a) 0
b) 1
c) 5
d) 10

15. कौन सा cell pointer दशाता ह  िक आप दसूरे cell के content को move कर सकते ह ।
a) Doctor’s symbol (Big Plus)
b) Small thin plus icon
c) Mouse pointer with anchor at the tip
d) None of above

Answer Sheet
1.  Excel  म  आप  data  source  के साथ मुय दतावेज को जोड़ सकते ह ।  Mail  Merge
Operation  म  word  —————–  होता ह ।
Answer – c) Client

2. यिद excel की auto calculate mode िडसऐबल ह  तो आप formula cells की values
को update कैसे कर सकते ह ।
Answer – b) F9

3. Excel म  automatic या manual कैलकुलेशन मोड को कहां से बदला जा सकता ह ।
Answer – b) Go to tools >> Options >> calculation and mark the corresponding
radio button

4. Excel Worksheet म  ग ीड लाइन को hide या show कैसे करते ह ।
Answer – c) Both of above
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5. िननिलिखत Excel Screen घटक म  से कौन turn on या off नही ंहो सकता ह ।
Answer – d) None of above

6. Excel म  कुछ cells को चयिनत करने पर ctrl + X press करने पर या होगा।
Answer – b) The cells selected are marked for cutting

7. िननिलिखत िवकप म  से कौन paste special dialog box म  उपलध नही ंहोता ह ।
Answer – d) SQRT

8. Data के Column को row म  बदलने के िलये आप कौन सी Command को choose कर गे।
Answer – b) Edit >> Paste special >> Transpose

9. यह वीकाय ह  िक एक बड़े Text को adjacent cell म  रहने द  यिद –
Answer – b) No data will be entered in the adjacent cells

10. कौन सा cell pointer दशाता ह  िक आप selection बना सकते ह ।
Answer – a) Doctor’s symbol (Big Plus)

11. कौन सा cell pointer दशाता ह  िक आप series को fill कर सकते ह ।
Answer – b) Small thin plus icon

12. आप ————— के ारा column की चौड़ाई को auto fit कर सकते ह ।
Answer – c) Double clicking on column right border on column header

13. Long Text एक सेल के साथ म  एक से अिधक line म  टूट सकता ह  आप ऐसा —————
के ारा कर सकते ह ।
Answer – a) Wrap text in format >> cells

14. MS Excel, Fill Series डायलॉग बॉस म  step के िलये ————– िडफॉट वैय ूदान
करता ह ।
Answer – b) 1

15. कौन सा cell pointer दशाता ह  िक आप दसूरे cell के content को move कर सकते ह ।
Answer – c) Mouse pointer with anchor at the tip
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ऍम एस एसेल भाग – 19 (िहंदी म )
1. जब data की एक row, column म  बदलनी होती ह ।
a) Copy the cells in row, select the same number of cells in row and paste
b) Copy the cels in column then choose edit >> paste special, then click transport
and ok
c) Copy the cells then go to format >> cells then on alignment tab click transpose
check box and click ok
d) Select the cells then place the cell pointer on new cell and choose edit >>
paste special, mark transpose check box and click ok.

2. Excel म  Ctrl + D Shortcut कंुजी —————– करेगी।
a) Open the font dialog box
b) Apply double underline for the active cell
c) Fill down in the above
d) None of above

3. Excel म  Ctrl + R Short Cut कंुजी ————– के िलये योग होती ह ।
a) Right align the content of cell
b) Remove the cell contents of selected cells
c) Fill the selection with active cells to the right
d) None of above

4. Command Edit >> Fill Across Worksheet सिय ह  केवल जब –
a) One sheet is selected
b) When many sheets are selected
c) When no sheet is selected
d) None of above

5. िननिलिखत Series type म  से कौन fill series डायलॉग बॉस के िलये माय नही ंह ।
a) Linear
b) Growth
c) Auto fill
d) Time

6. िननलिलिखत म  से िकसे आप  Paste  special  command का योग करके  Selectively
paste कर सकते ह ।
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a) Validation
b) Formats
c) Formulas
d) All of above

7. जब आप नये सेल म  कुछ पेट करते ह  तो उस दौरान  Paste  Special  कुछ ऑपरेशन एलाउ
करता ह  िनन म  से कौन-सा ऑपरेशन Valid ह ।
a) Square
b) Percentage
c) Goal seek
d) Divide

8. Edit >> Delete आदेश –
a) Deletes the content of a cell
b) Deletes formats of cell
c) Delete the comment of cell
d) Deletes selected cells

9. चयनीत  cells  के  content को हटाने के िलये आप को ————— आदेश को  issue करना
चािहए।
a) Edit >> Delete
b) Edit >> Clear >> All
c) Edit >> Clear >> Contents
d) Data >> Delete

10. कीबोड की Delete कंुजी Excel म  िकस आदेश के िलये िनयुत ह ।
a) Edit >> Clear >> Contents
b) Edit >> Clear >> All
c) Edit >> Delete
d) All of the above

11. यिद आप िकसी रज म  योग हुई फाम िटंग को डीलीट करना चाहते ह  तो –
a) From edit menu choose clear and then formats
b) From edit menu chose delete
c) Click on remove formatting tool on standard toolbar
d) Double click the format painter and then press esc key in keyboard

12. एसेल िडफॉट प से आपको 3 वक शीट्स देता ह  यिद आप उनम  से केवल दो का योग करना
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चाहते ह  तो आप उनम  से केवल दो का योग करना चाहते ह  तो आप तीसरी वक शीट को कैसे िडलीट
कर गे।
a) Right click on sheet tab of third sheet and choose delete from context menu
b) Click on sheet 3 and from edit from edit menu choose delete
c) Both of above
d) None of above

13. एक cell म  enter होने वाली value हमेशा —————— होती ह ।
a) Left aligned
b) Right aligned
c) Centered
d) Not aligned at all

14. िननिलिखत  Statement  म  से कौन माय ह  जब  Excel  म  िकसी  data  बदला या खोजा
जाता ह ।
a) You can find and replace within the sheet or workbook
b) Excel does not have option to match case for find
c) Both are valid
d) None are valid

15. िननिलिखत म  से कौन Excel म  Find और replace के बारे म  सय नही ंह ।
a) You can search for bold and replace with italics
b) You can decide whether to look for the whole word or not
c) You can search in formula too
d) You can search by rows or columns or sheets

Answer Sheet
1. जब data की एक row, column म  बदलनी होती ह ।
Answer – d) Select the cells then place the cell pointer on new cell and choose
edit >> paste special, mark transpose check box and click ok.

2. Excel म  Ctrl + D Shortcut कंुजी —————– करेगी।
Answer – c) Fill down in the above

3. Excel म  Ctrl + R Short Cut कंुजी ————– के िलये योग होती ह ।
Answer – c) Fill the selection with active cells to the right

4. Command Edit >> Fill Across Worksheet सिय ह  केवल जब –
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Answer – b) When many sheets are selected

5. िननिलिखत Series type म  से कौन fill series डायलॉग बॉस के िलये माय नही ंह ।
Answer – d) Time

6. िननलिलिखत म  से िकसे आप  Paste  special  command का योग करके  Selectively
paste कर सकते ह ।
Answer – d) All of above

7. जब आप नये सेल म  कुछ पेट करते ह  तो उस दौरान  Paste  Special  कुछ ऑपरेशन एलाउ
करता ह  िनन म  से कौन-सा ऑपरेशन Valid ह ।
Answer – d) Divide

8. Edit >> Delete आदेश –
Answer – d) Deletes selected cells

9. चयनीत  cells  के  content को हटाने के िलये आप को ————— आदेश को  issue करना
चािहए।
Answer – c) Edit >> Clear >> Contents

10. कीबोड की Delete कंुजी Excel म  िकस आदेश के िलये िनयुत ह ।
Answer – a) Edit >> Clear >> Contents

11. यिद आप िकसी रज म  योग हुई फाम िटंग को डीलीट करना चाहते ह  तो –
Answer – a) From edit menu choose clear and then formats

12. एसेल िडफॉट प से आपको 3 वक शीट्स देता ह  यिद आप उनम  से केवल दो का योग करना
चाहते ह  तो आप उनम  से केवल दो का योग करना चाहते ह  तो आप तीसरी वक शीट को कैसे िडलीट
कर गे।
Answer – a) Right click on sheet tab of third sheet and choose delete from context
menu

13. एक cell म  enter होने वाली value हमेशा —————— होती ह ।
Answer – a) Left aligned

14. िननिलिखत  Statement  म  से कौन माय ह  जब  Excel  म  िकसी  data  बदला या खोजा
जाता ह ।
Answer – a) You can find and replace within the sheet or workbook

15. िननिलिखत म  से कौन Excel म  Find और replace के बारे म  सय नही ंह ।
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Answer – d) You can search by rows or columns or sheets
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ऍम एस एसेल भाग – 20 (िहंदी म )
1. आप एक sheet को एक workbook से नई book म  —————- के ारा move कर सकते
ह ।
a) From edit menu choose move or copy sheet, mark the create a copy and click
ok
b) From edit menu choose move or copy then choose (move to end) and click ok
c) From edit menu choose move or copy then select (new book) from to book list
and click ok
d) None of above

2. sheet म  एक data को दसूरे के साथ बदलने के िलये shortcut कंुजी या ह ।
a) Ctrl + R
b) Ctrl + Shift + R
c) Ctrl + H
d) Ctrl + F

3. Cells म  Comments रखना —————- कहलाता ह ।
a) Smart Tip
b) Cell Tip
c) Web Tip
d) Soft Tip

4. Cells म  Comments को ————— के ारा जोड़ा जा सकता ह ।
a) Edit -> Comments
b) Insert -> Comment
c) File -> Comments
d) View -> Comments

5. कौन सा menu िवकप window को दो म  तोड़ने के िलये योग होता ह ।
a) Format -> Window
b) View -> Window -> Split
c) Window -> Split
d) View -> Split

6. अलग sheet म  located cell से data ात करना ————— कहलाता ह ।
a) Accessing
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b) Referencing
c) Updating
d) Functioning
Referencing

7. िननिलिखत म  से कौन Excel म  एक माय data type नही ंह ।
a) Number
b) Character
c) Label
d) Data/Time

8. worksheet का कौन सा तव accidental modification से सुरित हो सकता ह ।
a) Contents
b) Objects
c) Scenarios
d) All of the above

9. एक Numeric value को label value की तरह माना जायेगा यिद —————- उससे पहले
आती ह ।
a) Apostrophe (‘)
b) Exclamation (!)
c) Hash (#)
d) Tilde (~)

10. Text को जोड़ना —————- का योग करके हो सकता ह ।
a) Apostrophe (‘)
b) Exclamation (!)
c) Hash (#)
d) Ampersand (&)

11. Excel Window म  कौन सा area, value और formulas को entry की अनुमित देता ह ।
a) Title Bar
b) Menu Bar
c) Formula Bar
d) Standard Tool Bar

12. िसगल फोरमलेू म  मिटपल कैलकुलेशन —————– का योग करके की जा सकती ह ।
a) Standard Formulas
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b) Array Formula
c) Complex Formulas
d) Smart Formula

13. एक Excel Workbook —————- का समहू ह ।
a) Workbooks
b) Worksheets
c) Charts
d) Worksheets and Charts

14. Workspace से आप या समझते ह ।
a) Group Of Column
b) Group of Worksheets
c) Group of Rows
d) Group of Workbooks

15. MS-EXCEL —————- पर आधािरत ह ।
a) Windows
b) Dos
c) Unix
d) OS/2

Answer Sheet
1. आप एक sheet को एक workbook से नई book म  —————- के ारा move कर सकते
ह ।
Answer – c) From edit menu choose move or copy then select (new book) from to
book list and click ok

2. sheet म  एक data को दसूरे के साथ बदलने के िलये shortcut कंुजी या ह ।
Answer – c) Ctrl + H

3. Cells म  Comments रखना —————- कहलाता ह ।
Answer – b) Cell Tip

4. Cells म  Comments को ————— के ारा जोड़ा जा सकता ह ।
Answer – b) Insert -> Comment

5. कौन सा menu िवकप window को दो म  तोड़ने के िलये योग होता ह ।
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Answer – c) Window -> Split

6. अलग sheet म  located cell से data ात करना ————— कहलाता ह ।
Answer – b) Referencing

7. िननिलिखत म  से कौन Excel म  एक माय data type नही ंह ।
Answer – b) Character

8. worksheet का कौन सा तव accidental modification से सुरित हो सकता ह ।
Answer – d) All of the above

9. एक Numeric value को label value की तरह माना जायेगा यिद —————- उससे पहले
आती ह ।
Answer – a) Apostrophe (‘)

10. Text को जोड़ना —————- का योग करके हो सकता ह ।
Answer – d) Ampersand (&)

11. Excel Window म  कौन सा area, value और formulas को entry की अनुमित देता ह ।
Answer – c) Formula Bar

12. िसगल फोरमलेू म  मिटपल कैलकुलेशन —————– का योग करके की जा सकती ह ।
Answer – b) Array Formula

13. एक Excel Workbook —————- का समहू ह ।
Answer – d) Worksheets and Charts

14. Workspace से आप या समझते ह ।
Answer – d) Group of Workbooks

15. MS-EXCEL —————- पर आधािरत ह ।
Answer – a) Windows
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ऍम एस एसेल भाग – 21 (िहंदी म )
1. Excel म  आप data के बड़े भाग का sum एक tool button को चयिनत करके कर सकते ह
——————- कहलाता ह ।
a) Auto Fill
b) Auto Correct
c) Auto Sum
d) Auto Format

2. MS-Excel म  एक परेू Column को चयिनत करने के िलए press करते ह ।
a) Ctrl + C
b) Ctrl + Arrow Key
c) Ctrl + S
d) None Of The Above

3. Excel म  संया को दसूरी संया से भाग देने पर शेषफल को  Return करने के िलए हम िकस
फंशन का योग करते ह ।
a) ROUND ()
b) FACT ()
c) MOD ()
d) DIV ()

4. Consolidate Dialog Box म  कौन-सा फंशन उपलध नही ंहोता ह ।
a) PMT
b) AVERAGE
c) MAX
d) SUM

5. “Edit, Clear” आदेश िकस का फंशन नही ंह ।
a) Delete Content
b) Delete Notes
c) Delete Cells
d) Delete Formats

6. Microsoft Excel एक पावरफुल ————– ह ।
a) Word processing package
b) Spreadsheet package
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c) Communication S/W Package
d) DBMS package

7. आप डेटा को आरोही या अवरोही म म  दोबारा यविथत कैसे करते ह ।
a) Data, Sort
b) Data, Form
c) Data, Table
d) Data, Subtotals

8. Excel म  कौन-सा Chart बन सकता ह ।
a) Area
b) Line
c) Pie
d) All of the above

9. यिद िकसी सेल म  ‘5436.8’ को “#,##0.00” के प म  Format करते ह  तो आउटपुट या होगा।
a) 5430
b) 5,436.80
c) 5436.8
d) 6.8

10. MS Excel म  वतमान की िदनांक तथा समय को आप कैसे दिशत करते ह ।
a) = Data ()
b) = Today ()
c) = Now ()
d) = Time ()

11. MS Excel म  आप केवल वतमान की िदनांक को कैसे दिशत करते ह ।
a) Data ()
b) Today ()
c) Now ()
d) Time ()

12. आप एक Cell म  Text को कैसे Wrap करते ह ।
a) Format, Cells, Font
b) Format, Cells, Protection
c) Format, Cells, Number
d) Format, Cells, Alignment
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13. COUNTA () या करता ह ।
a) Counts cells having alphabets
b) Counts empty cells
c) Counts cells having number
d) Counts non-empty cells

14. सपणू Column को हाइलाइट करने के िलए Shortcut कंुजी या ह ।
a) Ctrl + C
b) Ctrl + Enter
c) Ctrl + Page Up
d) Ctrl + Space Bar

15. सू म , कौन-सा तीक िनिचत तंभो ंया पितयो ंको िनिदट करता ह ।
a) $
b) *
c) %
d) &

Answer Sheet
1. Excel म  आप data के बड़े भाग का sum एक tool button को चयिनत करके कर सकते ह
——————- कहलाता ह ।
Answer – c) Auto Sum

2. MS-Excel म  एक परेू Column को चयिनत करने के िलए press करते ह ।
Answer – d) None Of The Above

3. Excel म  संया को दसूरी संया से भाग देने पर शेषफल को  Return करने के िलए हम िकस
फंशन का योग करते ह ।
Answer – c) MOD ()

4. Consolidate Dialog Box म  कौन-सा फंशन उपलध नही ंहोता ह ।
Answer – a) PMT

5. “Edit, Clear” आदेश िकस का फंशन नही ंह ।
Answer – c) Delete Cells

6. Microsoft Excel एक पावरफुल ————– ह ।
Answer – b) Spreadsheet package
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7. आप डेटा को आरोही या अवरोही म म  दोबारा यविथत कैसे करते ह ।
Answer – a) Data, Sort

8. Excel म  कौन-सा Chart बन सकता ह ।
Answer – d) All of the above

9. यिद िकसी सेल म  ‘5436.8’ को “#,##0.00” के प म  Format करते ह  तो आउटपुट या होगा।
Answer – b) 5,436.80

10. MS Excel म  वतमान की िदनांक तथा समय को आप कैसे दिशत करते ह ।
Answer – c) = Now ()

11. MS Excel म  आप केवल वतमान की िदनांक को कैसे दिशत करते ह ।
Answer – b) Today ()

12. आप एक Cell म  Text को कैसे Wrap करते ह ।
Answer – d) Format, Cells, Alignment

13. COUNTA () या करता ह ।
Answer – d) Counts non-empty cells

14. सपणू Column को हाइलाइट करने के िलए Shortcut कंुजी या ह ।
Answer – d) Ctrl + Space Bar

15. सू म , कौन-सा तीक िनिचत तंभो ंया पितयो ंको िनिदट करता ह ।
Answer – a) $
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ऍम एस एसेल भाग – 22 (िहंदी म )
1. Excel म  —————– वतमान cell address को दिशत करता ह ।
a) Formula Bar
b) Status Bar
c) Name Box
d) Title Bar

2. Sheet1 से Sheet3 पर Cell A10 को संब करने का सही तरीका या ह ।
a) Sheet3!A10
b) Sheet1!A10
c) Sheet3.A10
d) A10

3. Excel म  Macros बनाने के िलए कौन-सी भाषा का योग होता ह ।
a) Visual Basic
b) C
c) Visual C++
d) Java

4. िननिलिखत म  कौन MS-Excel की term नही ंह ।
a) Cells
b) Rows
c) Columns
d) Document

5. एक workbook िकतनी worksheets रख सकती ह ।
a) 3
b) 8
c) 255
d) None of above

6. एक Bar िच बनाने के िलए आप िकसका चयन कर गे।
a) Edit, Chart
b) Insert, Chart
c) Tools, Chart
d) Format, Chart
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7. एक worksheet को letterhead का योग करके िंट करने के िलए आपको कौन-सी setting
बदलनी होगी।
a) Paper
b) Margin
c) Layout
d) Orientation

8. उस चाट  को आप या कह गे िजसम  यह दिशत होता ह  िक कोई डाटा दसूरे डाटा से कैसे सबध
रखता ह ।
a) XY Chart
b) Line Chart
c) Pie Chart
d) Column Chart

9.  Spelling  डायलॉग बॉस को —————— मैय ू से  Spelling  चुनकर शािमल िकया जा
सकता ह ।
a) Insert
b) File
c) Tools
d) View

10. Spelling को जाचँने के िलए आप िकस कंुजी को press करते ह ।
a) F3
b) F5
c) F7
d) F9

11. बाद म  ले करने हेतु कीटोस के म व माउस एशस को िरकाड करने के िलए आप योग
कर गे।
a) Media Player
b) Sound Recorder
c) Calculator
d) Macro Recorder

12. हम काय पुितका को —————- के ारा save तथा product कर सकते ह ।
a) Write reservation password
b) Protection password
c) Read – only recommended
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d) Any of the above

13. EXCEL Worksheet म  थम Cell को लेबल िकया जाता ह ।
a) AA
b) A1
c) Aa
d) A0

14. जब डॉलर िचह ($) Cell address म  आता ह  तो या होता ह ।
a) An absolute cell address is created
b) Cell address will charge when it is copied to another cell
c) The sheet tab is changed
d) The status bar does not display the cell address

15. येक काय पुितका के िनचले भाग पर िदखाई देने वाले टैस को या कहा जाता ह ।
a) Reference tabs
b) Position tabs
c) Location tabs
d) Sheet tabs

Answer Sheet
1. Excel म  —————– वतमान cell address को दिशत करता ह ।
Answer – c) Name Box

2. Sheet1 से Sheet3 पर Cell A10 को संब करने का सही तरीका या ह ।
Answer – a) Sheet3!A10

3. Excel म  Macros बनाने के िलए कौन-सी भाषा का योग होता ह ।
Answer – a) Visual Basic

4. िननिलिखत म  कौन MS-Excel की term नही ंह ।
Answer – d) Document

5. एक workbook िकतनी worksheets रख सकती ह ।
Answer – d) None of above

6. एक Bar िच बनाने के िलए आप िकसका चयन कर गे।
Answer – b) Insert, Chart
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7. एक worksheet को letterhead का योग करके िंट करने के िलए आपको कौन-सी setting
बदलनी होगी।
Answer – b) Margin

8. उस चाट  को आप या कह गे िजसम  यह दिशत होता ह  िक कोई डाटा दसूरे डाटा से कैसे सबध
रखता ह ।
Answer – c) Pie Chart

9.  Spelling  डायलॉग बॉस को —————— मैय ू से  Spelling  चुनकर शािमल िकया जा
सकता ह ।
Answer – c) Tools

10. Spelling को जाचँने के िलए आप िकस कंुजी को press करते ह ।
Answer – c) F7

11. बाद म  ले करने हेतु कीटोस के म व माउस एशस को िरकाड करने के िलए आप योग
कर गे।
Answer – d) Macro Recorder

12. हम काय पुितका को —————- के ारा save तथा product कर सकते ह ।
Answer – d) Any of the above

13. EXCEL Worksheet म  थम Cell को लेबल िकया जाता ह ।
Answer – b) A1

14. जब डॉलर िचह ($) Cell address म  आता ह  तो या होता ह ।
Answer – a) An absolute cell address is created

15. येक काय पुितका के िनचले भाग पर िदखाई देने वाले टैस को या कहा जाता ह ।
Answer – d) Sheet tabs
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ऍम एस एसेल भाग – 23 (िहंदी म )
1. िकसी सिय क या ेणी के िनचले-दाय  कोने म  छोटे, काले वग ारा या तुत िकया जाता ह ।
a) Copy Handle
b) Fill Handle
c) Insert Handle
d) Border

2. Excel म  डेटा ंृखला को िकस प म  पिरभािषत िकया गया ह ।
a) A type of chart
b) A cell reference
c) A collection of related data
d) A division of result

3. Excel म  Formatting Toolbar पर Fill Color बटन का या योग ह ।
a) To insert a background
b) To add borders
c) To select a distribution of figures
d) To add shading or color to a cell range

4. Excel के Help मैय ूम , िननिलिखत म  से कौन-सी tabs पाई जाती ह ।
a) Contents tab
b) Answer Wizard tab
c) Index tab
d) None of the above

5. Labeled Columns तथा rows के साथ —————– एक िगड ह ।
a) Dialog box
b) Worksheet
c) Clipboard
d) Toolbar

6. एिटव cell –
a) Is defined by a bold border around the cell
b) Receives the data the user enters
c) It is the formula bar
d) Only a and b
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7. कौन-सा फंशन मूयवास, वापसी की दर, भिवय मूयो ंतथा ऋण भुगतान माा की गणना करने
के िलए उपयोग िकया जाता ह ।
a) Logical
b) Math & Trigonometry
c) Statistical
d) Financial

8. B7:B9 दशाता ह ।
a) Cells B7 and cell B9 only
b) Cells B7 through B9
c) Cell B8 only
d) None of the above

9. Cancel तथा Enter बटन —————- पर कट होते ह ।
a) Title Bar
b) Formula Bar
c) Menu Bar
d) Sheet Tabs

10.  Row  Data  को  Column  म  या  Column  Data  को  Row  म  कौन-सा फंशन दिशत
करता ह ।
a) Hyperlink
b) Index
c) Transpose
d) Rows

11. जब आप एक Excel File को Word Document म  खोलते ह , डाटा ————– होता ह ।
a) Hyperlinked
b) Placed in a word table
c) Linked
d) Embedded

12. —————– फंशन को छोड़कर सभी फंशनस ्म  उर सय अथवा असय के प म  आता
ह ।
a) IF
b) AND
c) OR
d) NOT
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13. Macros ————— मैय ूसे Run तथा Executed होते ह ।
a) Insert
b) Format
c) Tools
d) Data

14. आप —————- मैय ू से  Consolidate  चयन करके  Consolidate  Dialog  Box  को
खोल सकते ह ।
a) Insert
b) Format
c) Tools
d) Data

15. यके Excel File एक वक बुक कहलाती ह  योिंक –
a) It can contain and data
b) It can be modified
c) It can contain many sheets including worksheets and chart sheets
d) You have to work hard to create it

Answer Sheet
1. िकसी सिय क या ेणी के िनचले-दाय  कोने म  छोटे, काले वग ारा या तुत िकया जाता ह ।
Answer – b) Fill Handle

2. Excel म  डेटा ंृखला को िकस प म  पिरभािषत िकया गया ह ।
Answer – c) A collection of related data

3. Excel म  Formatting Toolbar पर Fill Color बटन का या योग ह ।
Answer – d) To add shading or color to a cell range

4. Excel के Help मैय ूम , िननिलिखत म  से कौन-सी tabs पाई जाती ह ।
Answer – d) None of the above

5. Labeled Columns तथा rows के साथ —————– एक िगड ह ।
Answer – b) Worksheet

6. एिटव cell –
Answer – d) Only a and b
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7. कौन-सा फंशन मूयवास, वापसी की दर, भिवय मूयो ंतथा ऋण भुगतान माा की गणना करने
के िलए उपयोग िकया जाता ह ।
Answer – d) Financial

8. B7:B9 दशाता ह ।
Answer – b) Cells B7 through B9

9. Cancel तथा Enter बटन —————- पर कट होते ह ।
Answer – b) Formula Bar

10.  Row  Data  को  Column  म  या  Column  Data  को  Row  म  कौन-सा फंशन दिशत
करता ह ।
Answer – c) Transpose

11. जब आप एक Excel File को Word Document म  खोलते ह , डाटा ————– होता ह ।
Answer – b) Placed in a word table

12. —————– फंशन को छोड़कर सभी फंशनस ्म  उर सय अथवा असय के प म  आता
ह ।
Answer – a) IF

13. Macros ———- मैय ूसे Run तथा Executed होते ह ।
Answer – c) Tools

14. आप —————- मैय ू से  Consolidate  चयन करके  Consolidate  Dialog  Box  को
खोल सकते ह ।
Answer – d) Data

15. यके Excel File एक वक बुक कहलाती ह  योिंक –
Answer – c) It can contain many sheets including worksheets and chart sheets
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ऍम एस एसेल भाग – 24 (िहंदी म )
1. Excel, चाट  के कौन से कार का िनमाण कर सकता ह ।
a) Line graphs and pic charts only
b) Only line graphs
c) Bar charts, line graphs and pie charts
d) Bar charts and line graphs only

2. एक spreadsheet म  data कैसे यविथत होता ह ।
a) Lines and spaces
b) Layers and planes
c) Rows and columns
d) Height and width

3. VLOOKUP फंशन या करता ह ।
a) Looks up text that contain ‘v’
b) Checks whether text is the same in one cell as in the next
c) Finds related records
d) All of above

4. िगडलाइनस –
a) May be turned off for display but turned on for printing
b) May be turned on or off for printing
c) May be turned off for display and printing
d) All of above

5. आप केवल एक एबडेड चाट  को —————- ारा िंट कर सकते ह ।
a) Moving the chart to a chart sheet before you print
b) Formatting the chart before you print
c) Selecting the chart before you print
d) a and c

6. िननिलिखत म  से कौन एक सू पिरकलन म  वरीयता का एक सही म ह ।
a) Multiplication and division, exponential positive and negative value.
b)  Multiplication  and  division,  positive  and  negative  values,  addition  and
subtraction
c) Addition and subtraction, positive and negative values, exponentiation
d) None of above
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7. एक फंशन के अदर दसूरा फंशन —————- फंशन कहलाता ह ।
a) Nested
b) Round
c) Sum
d) Text

8. यिद आप एक िभन े को अगली बार िंट करना चाहते ह  तब आप िकसी वक शीट के चयिनत
भाग को कैसे िंट करते ह ।
a) On the file menu, point to print area, and then click set print are(a)
b) On the file menu, click print, and then click selection under print what
c) On the view menu, click custom views, then click add
d) All of above

9. आप excel म  िकसी sum को यरूोस म  कैसे बदल गे।
a) On the insert menu, click symbol and from the currency symbol subset, select
the euro sign.
b) On the tools menu, click add-ins, and select the euro currency tools check box
c) Apply a selection background color
d) All of above

10. आपके मािसक िगरवी भुगतान का पिरकलन कौन-सा फंशन करता ह ।
a) PMT (Payments)
b) NPER (Number of Periods)
c) PV (Present Value)
d) All of above

11. िननिलिखत method म  से कौन एक cell म  data को enter करने के िलए योग नही ंहोता
ह ।
a) Pressing an arrow key
b) Pressing the tab key
c) Pressing the Esc key
d) Clicking the enter button to the formula bar

12. िननिलिखत म  से कौन चयिनत cells म  text को इटैिलक set नही ंकरता।
a) Pressing ctrl + I on the keyboard
b) Using the tools – wizard – web form menu item
c) Using the format – cells – font menu item
d) None of the above
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13. िननिलिखत Method म  से कौन cell के content को edit करने के िलए योग नही ंहोता।
a) Pressing the alt key
b) Clicking the formula bar
c) Pressing F2
d) Double clicking the cell

14. आप cell को —————- के ारा सिय कर सकते ह ।
a) Pressing the tab key
b) Clicking the cell
c) Pressing an arrow key
d) All of above

15. िननिलिखत setup िवकप म  से कौन page setup dialog box म  set नही ंहोता ह ।
a) Printer selection
b) Vertical or horizontal placement
c) Orientation
d) Row and column titles

Answer Sheet
1. Excel, चाट  के कौन से कार का िनमाण कर सकता ह ।
Answer – c) Bar charts, line graphs and pie charts

2. एक spreadsheet म  data कैसे यविथत होता ह ।
Answer – c) Rows and columns

3. VLOOKUP फंशन या करता ह ।
Answer – c) Finds related records

4. िगडलाइनस –
Answer – d) All of above

5. आप केवल एक एबडेड चाट  को —————- ारा िंट कर सकते ह ।
Answer – d) a and c

6. िननिलिखत म  से कौन एक सू पिरकलन म  वरीयता का एक सही म ह ।
Answer – d) None of above

7. एक फंशन के अदर दसूरा फंशन —————- फंशन कहलाता ह ।
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Answer – a) Nested

8. यिद आप एक िभन े को अगली बार िंट करना चाहते ह  तब आप िकसी वक शीट के चयिनत
भाग को कैसे िंट करते ह ।
Answer – b) On the file menu, click print, and then click selection under print
what

9. आप excel म  िकसी sum को यरूोस म  कैसे बदल गे।
Answer – a) On the insert menu, click symbol and from the currency symbol
subset, select the euro sign.

10. आपके मािसक िगरवी भुगतान का पिरकलन कौन-सा फंशन करता ह ।
Answer – a) PMT (Payments)

11. िननिलिखत method म  से कौन एक cell म  data को enter करने के िलए योग नही ंहोता
ह ।
Answer – c) Pressing the Esc key

12. िननिलिखत म  से कौन चयिनत cells म  text को इटैिलक set नही ंकरता।
Answer – b) Using the tools – wizard – web form menu item

13. िननिलिखत Method म  से कौन cell के content को edit करने के िलए योग नही ंहोता।
Answer – a) Pressing the alt key

14. आप cell को —————- के ारा सिय कर सकते ह ।
Answer – d) All of above

15. िननिलिखत setup िवकप म  से कौन page setup dialog box म  set नही ंहोता ह ।
Answer – a) Printer selection
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ऍम एस एसेल भाग – 25 (िहंदी म )
1. वक  बुक के साथ save िकये गए values के एक िविशट सेट को कौन संदिभत करता ह ।
a) Range
b) Scenario
c) Trent Line
d) What – if analysis

2. यिद आपको insert function डायलॉग बॉस की आवयकता ह  आप कैसे ात कर गे।
a) Right click a cell and then click insert
b) Click the insert menu and then click function
c) Type = in a cell
d) All of the above

3. िननिलिखत म  से कौन एक िसंगल कॉलम म  सभी सेस का चयन करने का वणन करता ह ।
a) Right click on column and select pick from list
b) Use data – text to column menu item
c) Left click on the gray column title button
d) Pressing ctrl + A on the keyboard

4. Format data series डायॅलोग बॉस म  file effects का योग करते समय आप या नहीं
कर सकते ह ।
a) Rotate text on the chart
b) Select a force ground color
c) Select a pattern
d) Select a background color

5. िननिलिखत म  से िकसे छोड़कर पेपर ेडशीट म  सभी इलेट ॉिनक ेडशीट के समान ही गुण
होते ह ।
a) Rows and columns
b) Heading
c) Speed
d) None

6. िनन म  से या वक शीट बनाने का मलू चरण नही ंह ।
a) Save the workbook
b) Modify the worksheet
c) Enter text and data
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d) Copy the worksheet

7. Columns D तथा E के बीच म  तीन Columns इसट  करने के िलए आप ————— कर गे।
a) Select Columns D
b) Select Columns E
c) Select Columns E, F and G
d) Select Columns D, E, And F

8. एक electronic spreadsheet म  होते ह ।
a) Rows
b) Columns
c) Cells
d) All of the above

9. जब ms word व excel का एकीकरण करते ह , word आमतौर पर ह ।
a) Sever
b) Source
c) Client
d) None

10. Charts tips करता ह ।
a) Show the formatting of a data label
b) Show the name of a data series
c) Show the value of data point
d) b and c

11. नेम बॉस-
a) Shows the location of the previously active cell
b) Appears the left of the formula bar
c) Appears below the status bar
d) Appears below the menu bar

12. आप Column को fit करने के िलए column की चौड़ाई को कैसे बदलते ह ।
a) Single-check the boundary to the left to the columns heading
b) Double click the boundary to the right of the column heading
c) Press alt and single click anywhere in the column
d) All of above

13. जब आप बड़ी worksheets के साथ काय करते ह , आपको आवयकता हो सकती ह ।
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a) Size the worksheet to fit on the specific number of pages
b) Add and remove page breaks
c) Specify only certain print areas
d) All of above

14. Hyperlink नही ंहो सकती ह ।
a) Special shapes like stars and banners
b) Drawing objects like rectangles ovals
c) Pictures
d) All can be hyperlinks

15. आप horizontal तथा vertical scroll bars का योग —————– के िलए करते ह ।
a) Split a worksheet in to panes
b) View different rows and columns
c) Edit the contents program
d) View different worksheets

Answer Sheet
1. वक  बुक के साथ save िकये गए values के एक िविशट सेट को कौन संदिभत करता ह ।
Answer – b) Scenario

2. यिद आपको insert function डायलॉग बॉस की आवयकता ह  आप कैसे ात कर गे।
Answer – b) Click the insert menu and then click function

3. िननिलिखत म  से कौन एक िसंगल कॉलम म  सभी सेस का चयन करने का वणन करता ह ।
Answer – c) Left click on the gray column title button

4. Format data series डायॅलोग बॉस म  file effects का योग करते समय आप या नहीं
कर सकते ह ।
Answer – a) Rotate text on the chart

5. िननिलिखत म  से िकसे छोड़कर पेपर ेडशीट म  सभी इलेट ॉिनक ेडशीट के समान ही गुण
होते ह ।
Answer – c) Speed

6. िनन म  से या वक शीट बनाने का मलू चरण नही ंह ।
Answer – d) Copy the worksheet
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7. Columns D तथा E के बीच म  तीन Columns इसट  करने के िलए आप ————— कर गे।
Answer – b) Select Columns E

8. एक electronic spreadsheet म  होते ह ।
Answer – d) All of the above

9. जब ms word व excel का एकीकरण करते ह , word आमतौर पर ह ।
Answer – c) Client

10. Charts tips करता ह ।
Answer – d) b and c

11. नेम बॉस-
Answer – b) Appears the left of the formula bar

12. आप Column को fit करने के िलए column की चौड़ाई को कैसे बदलते ह ।
Answer – b) Double click the boundary to the right of the column heading

13. जब आप बड़ी worksheets के साथ काय करते ह , आपको आवयकता हो सकती ह ।
Answer – d) All of above

14. Hyperlink नही ंहो सकती ह ।
Answer – d) All can be hyperlinks

15. आप horizontal तथा vertical scroll bars का योग —————– के िलए करते ह ।
Answer – b) View different rows and columns
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ऍम एस एसेल भाग – 26 (िहंदी म )
1. वह कयटूर ोग ाम कौन सा ह  जो डाटा को रॉ व कॉलम म  रखता ह ।
a) Spreadsheet program
b) Database program
c) Word processor program
d) Desktop publisher program

2. आप ——————- टूलबार पर Insert Picture From File बटन पर िलक करके िपचर
add कर सकते ह ।
a) Standard
b) Formatting
c) Drawing
d) Inert

3. Mathematical Functions का एक उदाहरण ह ।
a) AVG
b) MAX
c) COS
d) All of the above

4. जब Vertical page break करते ह ।
a) The active cell must be A1
b) The active cell can be anywhere in the worksheet
c) The entire row must be selected
d) The active cell must be in column A

5. पहले से चयिनत रज म  से पवू सेल को चुनने के िलये –
a) The Alt key
b) The tab key
c) The enter key
d) None of above

6. जब formula bar सिय होता ह , आप देख सकते ह ।
a) The edit formula button
b) The cancel button
c) The enter button
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d) All of the above

7. Worksheet म  आप चयन कर सकते ह ।
a) The entire worksheet
b) Rows
c) Columns
d) a, b, and c

8. जब आप एक Worksheet का िंट Preview करते ह ।
a) The entire worksheet is displayed
b) The selected range is displayed
c) The active portion of the worksheet is dis-played
d) a, b, and c

9. आप non continuous काय पको ंको ——————– के साथ समहूीकृत कर सकते ह ।
a) The group button on the standard toolbar
b) The shift key and the mouse
c) The ctrl key and mouse
d) The alt+enter key

10. वेट का अथ ह ।
a) The print density of characters
b) The height of the printed characters
c) Upright or slanted shape
d) The design and appearance of characters

11. जब आप Excel Work book म  मेनटेन िकये गये डाटा को word म  िलंक करते ह ।
a) The word document cannot be edited
b) The word document contains a reference to the original source application
c) The word document must contain a hyperlink
d) The word document contains a copy of the actual data

12. जब आप िकसी सेल के सबसे ऊपर के दांये कोने पर रेडॉस का िचह देखते ह  तो इसका या अथ
होता ह ।
a) There is an error in the cell
b) There is a comment associated with the cell
c) The font color the text in the cell is red
d) A formula cannot be entered into the cell
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13. रॉ व कॉलम के शीषक को एक थान पर होड करने के िलए, तािक वे ॉल न हो जब आप िकसी
वक बुक को ोल करते ह , िलक कर ग।
a) Unfreeze panes command on the window menu
b) Freeze panes command on the window menu
c) Hold titles command on the edit menu
d) Split Command on the window menu

14. िनन म  से कौन सा िकसी चयिनत सेल से दसूरी अलग सेल म  फॉरमेट कॉपी करने का सबसे तीव
तरीका ह ।
a) Use Ctrl to select all three cells, then click the paste button on the standard
toolbar
b) Copy the selected cell, then select the other two cells, click style on the format
menu, then click modify
c) Click format painter on the formatting toolbar twice than click in each cell you
want to copy the formatting to
d) All of above

15. वड डॉयमेूट म  इबेिडड एसेल वक शीट म  डाटा एिडट करने के िलये –
a) Use the excel menu bar and toolbar inside the word application
b) Edit the hyperlink
c) Edit the data in a excel source application
d) Use the word menu bar and toolbar

Answer Sheet
1. वह कयटूर ोग ाम कौन सा ह  जो डाटा को रॉ व कॉलम म  रखता ह ।
Answer – a) Spreadsheet program

2. आप ——————- टूलबार पर Insert Picture From File बटन पर िलक करके िपचर
add कर सकते ह ।
Answer – d) Inert

3. Mathematical Functions का एक उदाहरण ह ।
Answer – c) COS

4. जब Vertical page break करते ह ।
Answer – c) The entire row must be selected

5. पहले से चयिनत रज म  से पवू सेल को चुनने के िलये –
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Answer – d) None of above

6. जब formula bar सिय होता ह , आप देख सकते ह ।
Answer – d) All of the above

7. Worksheet म  आप चयन कर सकते ह ।
Answer – d) a, b, and c

8. जब आप एक Worksheet का िंट Preview करते ह ।
Answer – d) a, b, and c

9. आप non continuous काय पको ंको ——————– के साथ समहूीकृत कर सकते ह ।
Answer – c) The ctrl key and mouse

10. वेट का अथ ह ।
Answer – a) The print density of characters

11. जब आप Excel Work book म  मेनटेन िकये गये डाटा को word म  िलंक करते ह ।
Answer –  b)  The word document contains a reference to the original  source
application

12. जब आप िकसी सेल के सबसे ऊपर के दांये कोने पर रेडॉस का िचह देखते ह  तो इसका या अथ
होता ह ।
Answer – b) There is a comment associated with the cell

13. रॉ व कॉलम के शीषक को एक थान पर होड करने के िलए, तािक वे ॉल न हो जब आप िकसी
वक बुक को ोल करते ह , िलक कर ग।
Answer – b) Freeze panes command on the window menu

14. िनन म  से कौन सा िकसी चयिनत सेल से दसूरी अलग सेल म  फॉरमेट कॉपी करने का सबसे तीव
तरीका ह ।
Answer – c) Click format painter on the formatting toolbar twice than click in each
cell you want to copy the formatting to

15. वड डॉयमेूट म  इबेिडड एसेल वक शीट म  डाटा एिडट करने के िलये –
Answer – a) Use the excel menu bar and toolbar inside the word application
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ऍम एस एसेल भाग – 27 (िहंदी म )
1. Text पर िकसके ारा Operations Performed होते ह ।
a) String Functions
b) Data Functions
c) Logical Functions
d) Financial Functions

2. आप ——————- मैय ू से  Scenarios  का चयन करके  scenario  manager  डायलॉग
बॉस को खोल सकते ह ।
a) View
b) Insert
c) Format
d) Tools

3. आप ——————- मैय ूसे sort का चयन करके sort dialog box को खोल सकते ह ।
a) View
b) Format
c) Tools
d) Data

4. पेज ब ेक िय ूम  काय करते हुए, आप कर सकते ह ।
a) View exactly where each page break occurs
b) Add or remove page breaks
c) Change the print area
d) All of the above

5. Data Map मददगार है –
a) When you have too much data to chart
b) To show a geographic distribution of data
c) To compare data points
d) To show changes in data over time

6. Rounding ुिट आ सकती ह ।
a) When you use multiplication, division or exponentiation in a formula
b) When you use addition and subtraction in a formula
c) Because Excel uses hidden decimal places In computation
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d) When you show the results of formulas with different decimal places than the
calculated result

7. आप Data तथा Formulas को Copy कर सकते ह ।
a) With the copy, paste and cut commands on the edit menu
b) With commands on a shortcut
c) With buttons on the standard toolbar
d) All of the above

8. MS Excel का ——————– को automate करने के िलए योग होता ह ।
a) Financial statements, Business forecasting
b) Transaction registers, inventory control
c) Account receivable, account payble
d) Any of the above

9. NOT, AND, OR तथा XOR ह ।
a) Logical Operators
b) Arithmetic Operators
c) Relational Operators
d) None of the above

10. िरपोट  म , आपको भोपाल म  मािसक वषा को दशान के िलये —————- का योग करना
सवोम ह ।
a) Calendar
b) Photograph of rainfall
c) Chart Showing rainfall Amounts
d) Database of rainfall

11. आप एसपेिरमेटल इफोरमेशन को िरकाड तथा िकसी समयाविध म  िवकास की दर को दशाने
वाला चाट  बनाया चाहते ह  तो इसके िलए उपयोग करने की सबसे उम Application होगी।
a) Word processing
b) Spreadsheet
c) Database
d) Graphics

12. आप िकसी पुरानी सेव हुई वक शीट को एिडट कर रहे ह  यिद आप  edit  की गई  worksheet
Original sheet को नट िकए िबना सुरित करना चाहते ह , तो आपको कौन सी  Command
योग करनी चािहए।
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a) New
b) Save as
c) Edit
d) Save

13. यिद आप िकसी वक शीट म  टाइटल के बाद खाली लाइन छोड़ना चाहते ह , तो सबसे अछा
तरीका या ह ।
a) Re-Format the spreadsheet
b) Insert a row
c) Increase the column width
d) Use the spacebar

14. यिद आप देशो ंके नाम को उनकी जनसंया के घटते म के आधार पर लगाना चाहते ह  तो आपको
—————- म  Population field पर छटनी करने की आवयकता ह ।
a) Ascending order
b) Descending order
c) Alphabetical order
d) Random order

15. ेडशीट म  गणना करने के िलए आप िकसका योग करते ह ।
a) Table
b) Formula
c) Field
d) Variable

Answer Sheet
1. Text पर िकसके ारा Operations Performed होते ह ।
Answer – a) String Functions

2. आप ——————- मैय ू से  Scenarios  का चयन करके  scenario  manager  डॉयलोग
बॉस को खोल सकते ह ।
Answer – d) Tools

3. आप ——————- मैय ूसे sort का चयन करके sort dialog box को खोल सकते ह ।
Answer – d) Data

4. पेज ब ेक िय ूम  काय करते हुए, आप कर सकते ह ।
Answer – d) All of the above
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5. Data Map मददगार है –
Answer – d) To show changes in data over time

6. Rounding ुिट आ सकती ह ।
Answer – a) When you use multiplication, division or exponentiation in a formula

7. आप Data तथा Formulas को Copy कर सकते ह ।
Answer – d) All of the above

8. MS Excel का ——————– को automate करने के िलए योग होता ह ।
Answer – d) Any of the above

9. NOT, AND, OR तथा XOR ह ।
Answer – b) Arithmetic Operators

10. िरपोट  म , आपको भोपाल म  मािसक वषा को दशान के िलये —————- का योग करना
सवोम ह ।
Answer – c) Chart Showing rainfall Amounts

11. आप एसपेिरमेटल इफोरमेशन को िरकाड तथा िकसी समयाविध म  िवकास की दर को दशाने
वाला चाट  बनाया चाहते ह  तो इसके िलए उपयोग करने की सबसे उम Application होगी।
Answer – b) Spreadsheet

12. आप िकसी पुरानी सेव हुई वक शीट को एिडट कर रहे ह  यिद आप  edit  की गई  worksheet
Original sheet को नट िकए िबना सुरित करना चाहते ह , तो आपको कौन सी  Command
योग करनी चािहए।
Answer – b) Save as

13. यिद आप िकसी वक शीट म  टाइटल के बाद खाली लाइन छोड़ना चाहते ह , तो सबसे अछा
तरीका या ह ।
Answer – b) Insert a row

14. यिद आप देशो ंके नाम को उनकी जनसंया के घटते म के आधार पर लगाना चाहते ह  तो आपको
—————- म  Population field पर छटनी करने की आवयकता ह ।
Answer – b) Descending order

15. ेडशीट म  गणना करने के िलए आप िकसका योग करते ह ।
Answer – b) Formula
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ऍम एस एसेल भाग – 28 (िहंदी म )
1. चाट  पर िथत बॉस जो येक िरकाड का नाम रखता ह  ——————– कहलाता ह ।
a) Cell
b) Title
c) Axis
d) Legend

2. यिद आप सभी सफेद िबिलयो ं को एक साथ िकसी डेटाबेस म  रखना चाहते ह  तो आपको
—————— के ारा घटनी करने की आवयकता ह ।
a) Color, then gender
b) Pet type, then color
c) Pet type, then gender
d) Color, then pet name

3. यिद आप Sheet से कोई िरकॉड गलती से िमटा देते ह  तो इसे पुन : ात करने के िलये कौन-सी
Command योग कर सकते ह ।
a) Insert
b) Copy
c) Undo
d) Replace

4. जहा ँRow तथा Column िमलते ह , आप इसे या कहते ह ।
a) A cell
b) A block
c) A box
d) None of the above

5. जो एक cell address का उदाहरण ह ।
a) 1125
b) 911
c) 41A
d) A21

6. कौन सा एक Formula का उदाहरण ह ।
a) =A1 + A2
b) = add(A1:A2)
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c) =SUM (A1:A2)
d) A1 + A2

7. कौन सा एक फंशन का उदाहरण ह ।
a) =add (A1:A2)
b) =A1 + A2
c) =SUM (A1:A2)
d) A1+A2

8. Multiplying का िचह या ह ।
a) >
b) /
c) !
d) *

9. भाग देने के िलए िचह या ह ।
a) /
b) %
c) &
d) #

10. फॉमट सेल डायलॉग बॉस म  िनन म  से कौन अडरलाइन का िवकप नही ंह ।
a) Double
b) Single Accounting
c) Double Accounting
d) Single Engineering

11. Excel म  Formulas —————— के साथ शु होता ह ।
a) %
b) =
c) +
d) –

12. Worksheet के िलए िडफॉट हैडर ह  –
a) Username
b) Date and Time
c) Sheet tab Name
d) None
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13. िननिलिखत म  से कौन Spelling Dialog box का िवकप नही ंह ।
a) Ignore
b) Ignore all
c) Edit
d) Change

14. Statistical फंशन –
a) Accept a single number, perform a mathematical transformation on it, and
return a single number.
b) Provide summary statistics on a list of item
c) Both a & b
d) None of the above

15. G2 से M12 तक का सेल रेफरस होगा।
a) G2.M12
b) G2;M12
c) G2:M12
d) G2-M12

Answer Sheet
1. चाट  पर िथत बॉस जो येक िरकाड का नाम रखता ह  ——————– कहलाता ह ।
Answer – d) Legend

2. यिद आप सभी सफेद िबिलयो ं को एक साथ िकसी डेटाबेस म  रखना चाहते ह  तो आपको
—————— के ारा घटनी करने की आवयकता ह ।
Answer – b) Pet type, then color

3. यिद आप Sheet से कोई िरकॉड गलती से िमटा देते ह  तो इसे पुन : ात करने के िलये कौन-सी
Command योग कर सकते ह ।
Answer – c) Undo

4. जहा ँRow तथा Column िमलते ह , आप इसे या कहते ह ।
Answer – a) A cell

5. जो एक cell address का उदाहरण ह ।
Answer – d) A21

6. कौन सा एक Formula का उदाहरण ह ।
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Answer – c) =SUM (A1:A2)

7. कौन सा एक फंशन का उदाहरण ह ।
Answer – c) =SUM (A1:A2)

8. Multiplying का िचह या ह ।
Answer – d) *

9. भाग देने के िलए िचह या ह ।
Answer – a) /

10. फॉमट सेल डायलॉग बॉस म  िनन म  से कौन अडरलाइन का िवकप नही ंह ।
Answer – d) Single Engineering

11. Excel म  Formulas —————— के साथ शु होता ह ।
Answer – b) =

12. Worksheet के िलए िडफॉट हैडर ह  –
Answer – d) None

13. िननिलिखत म  से कौन Spelling Dialog box का िवकप नही ंह ।
Answer – c) Edit

14. Statistical फंशन –
Answer – c) Both a & b

15. G2 से M12 तक का सेल रेफरस होगा।
Answer – c) G2:M12
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ऍम एस एसेल भाग – 29 (िहंदी म )
1. चयिनत Cell range से चाट  बनाने की शाटकट कंुजी या ह ।
a) F2
b) F4
c) F8
d) F11

2. एक Value Spreadsheet को बताती ह ।
a) How to calculate the cell’s value
b) How to display the value
c) Both a & b
d) None of the above

3. Excel की Auto Complete िवशेषता या ह ।
a) It automatically completes abbreviated words
b) It completes text entries that match an existing entry in the same column
c) It completes text and numeric entries that match an existing entry in the same
column
d) It column text entries that match an existing entry in the same worksheet

4. िननिलिखत म  से कौन सही ह ।
a) =AVERAGE(4,5,6,7)
b) =AVERAGE(A1,B1,C1)
c) =AVERAGE(A1:A9, B1:B9)
d) =All of the above

5. िननिलिखत फंशन म  से कौन 8 की Value return करेगा।
a) ROUNDUP(8.4999,0)
b) ROUNDDOWN(8.4999,0)
c) ROUND(8.4999,0)
d) Only b and c

6. आप MS Excel के शु होते ही वत : चिलत मैो को कैसे रोक गे।
a) Hold down the shift key during startup
b) Hold down the ctrl key during startup
c) Hold down the ESC key during startup
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d) Hold down the ALT key during startup

7. आप परेू मैो को पुन : िरकाड िकये िबना िरकॉड िकए मैो से अवांिछत िया को कैसे हटाय गे।
a) By using the find and edit action option
b) By clicking on the refresh button in the macro toolbar
c) By edit the macro in the visual basic editor
d) Macro cannot be edited

8. आप डेट की िवटी को अवोइड करने के िलये िफरेशन से पहले या एंटर करते ह ।
a) //
b) FR
c) Zero
d) Zero Space

9. िनन म  से कौन सा फशन सीरीज के अिधकतम अंक को ात करने के िलये योग म  लाया जाता
ह ।
a) MAX(B1:B3)
b) MAXIMUM(B1:B3)
c) HIGH (B1:B3)
d) HIGHEST (B1:B3)

10. NOW () फंशन या return करता ह ।
a) It return the current date and time
b) It return the serial number of the current date
c) It returns the serial number of the current time
d) None of the above

11. यिद formula = “$55.003 + 5 को cell म  enter करते ह , या value दिशत होगी।
a) $60
b) 60
c) $55.003 + 5
d) $60.00

12. एक cell म  वतमान िदनांक insert करने की shortcut कंुजी या ह ।
a) Ctrl + D
b) Ctrl + T
c) Ctrl + ;
d) Ctrl + /
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13. Excel म  SUM फंशन के सदभ म  िननिलिखत Syntax म  से कौन सय ह ।
a) =SUM (A1, B1)
b) =SUM (A1:B9)
c) =SUM (A1:A9, B1:B9)
d) All of the above

14. चयिनत सपणू Column को िछपाने की Shortcut कंुजी या ह ।
a) Ctrl + “
b) Ctrl + 0
c) Ctrl + H
d) Ctrl + C

15. Excel एक ोग ाम ह ।
a) Word Processing
b) Presentation
c) Database
d) None of these

Answer Sheet
1. चयिनत Cell range से चाट  बनाने की शाटकट कंुजी या ह ।
Answer – d) F11

2. एक Value Spreadsheet को बताती ह ।
Answer – a) How to calculate the cell’s value

3. Excel की Auto Complete िवशेषता या ह ।
Answer – b) It completes text entries that match an existing entry in the same
column

4. िननिलिखत म  से कौन सही ह ।
Answer – d) =All of the above

5. िननिलिखत फंशन म  से कौन 8 की Value return करेगा।
Answer – d) Only b and c

6. आप MS Excel के शु होते ही वत : चिलत मैो को कैसे रोक गे।
Answer – a) Hold down the shift key during startup
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7. आप परेू मैो को पुन : िरकाड िकये िबना िरकॉड िकए मैो से अवांिछत िया को कैसे हटाय गे।
Answer – c) By edit the macro in the visual basic editor

8. आप डेट की िवटी को अवोइड करने के िलये िफरेशन से पहले या एंटर करते ह ।
Answer – d) Zero Space

9. िनन म  से कौन सा फशन सीरीज के अिधकतम अंक को ात करने के िलये योग म  लाया जाता
ह ।
Answer – a) MAX(B1:B3)

10. NOW () फंशन या return करता ह ।
Answer – a) It return the current date and time

11. यिद formula = “$55.003 + 5 को cell म  enter करते ह , या value दिशत होगी।
Answer – c) $55.003 + 5

12. एक cell म  वतमान िदनांक insert करने की shortcut कंुजी या ह ।
Answer – c) Ctrl + ;

13. Excel म  SUM फंशन के सदभ म  िननिलिखत Syntax म  से कौन सय ह ।
Answer – d) All of the above

14. चयिनत सपणू Column को िछपाने की Shortcut कंुजी या ह ।
Answer – b) Ctrl + 0

15. Excel एक ोग ाम ह ।
Answer – c) Database

ANKAJ INFOTECH



ऍम एस एसेल भाग – 30 (िहंदी म )
1. एसेल की फाईल को कहा जाता ह ।
a) Workbook
b) Work Copy
c) Both a and b
d) None of these

2. एक वक बुक म  िडफॉट प से िकतनी शीट होती ह ।
a) 1
b) 2
c) 3
d) 4

3. एसेल का योग होता ह ।
a) Make Data
b) Make chart for the data
c) Organize the data
d) All of these

4. एसेल का उपयोग िकन ेो ंम  होता ह ।
a) Accounting
b) Data Analysis
c) Both a & b
d) None of these

5. माइोसॉट एसेल 2003 का फाईल एसट शन ह ।
a) .ELX
b) .XLS
c) .XLL
d) .XLA

6. वक शीट म  डाटा इनम  संगिठत होता ह ।
a) Row
b) Column
c) Both a & b
d) None
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7. रॉ और कॉलम के इटरसेशन को कहते ह ।
a) Cell
b) Group
c) Both a and b
d) None

8. एसेल 2003 म  िकतने कॉलम होते ह ।
a) 256
b) 260
c) 255
d) 280

9. िनन म  से सैल िरफरेस का कार ह ।
a) Relative Cell Reference
b) Absolute cell Reference
c) Both a & b
d) None of these

10. िनन म  Absolute cell िरफरेस ह ।
a) A1
b) A$1
c) 2A
d) 4#F

11. एसोयटू सैल म  िसबल योग होता ह ।
a) =
b) #
c) $
d) @

12. Freeze Panes ऑशन आता ह ।
a) Edit
b) Format
c) Tools
d) Window

13. Page Setup के मािजन बार म  Left और Right हेतु िडफॉट मािजन होता ह ।
a) .75 & 75 inch
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b) 1 & 1 inch
c) 2 & 2 inch
d) .5 & 5 inch

14. Page Setup म  मािजन बार म  टॉप और बॉटम हेतु िडफॉट मािजन होता ह ।
a) 1 & 1 inch
b) .8 & .8 inch
c) .75 & .75 inch
d) 2.0 & 2.0 inch

15. Taskpane की शॉटकट कमाड ह ।
a) Ctrl + F1
b) Alt + F1
c) Shift + F1
d) F1

Answer Sheet
1. एसेल की फाईल को कहा जाता ह ।
Answer – a) Workbook

2. एक वक बुक म  िडफॉट प से िकतनी फाइल होती ह ।
Answer – c) 3

3. एसेल का योग होता ह ।
Answer – d) All of these

4. एसेल का उपयोग िकन ेो ंम  होता ह ।
Answer – c) Both a & b

5. माइोसॉट एसेल 2003 का फाईल एसट शन ह ।
Answer – b) .XLS

6. वक शीट म  डाटा इनम  संगिठत होता ह ।
Answer – c) Both a & b

7. रॉ और कॉलम के इटरसेशन को कहते ह ।
Answer – c) Both a and b

8. एसेल 2003 म  िकतने कॉलम होते ह ।
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Answer – a) 256

9. िनन म  से सैल िरफरेस का कार ह ।
Answer – c) Both a & b

10. िनन म  Absolute cell िरफरेस ह ।
Answer – b) A$1

11. एसोयटू सैल म  िसबल योग होता ह ।
Answer – c) $

12. Freeze Panes ऑशन आता ह ।
Answer – d) Window

13. Page Setup के मािजन बार म  Left और Right हेतु िडफॉट मािजन होता ह ।
Answer – a) .75 & 75 inch

14. Page Setup म  मािजन बार म  टॉप और बॉटम हेतु िडफॉट मािजन होता ह ।
Answer – a) 1 & 1 inch

15. Taskpane की शॉटकट कमाड ह ।
Answer – a) Ctrl + F1
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ऍम एस पॉवर वॉइंट भाग – 1 (िहंदी म )
1. इनम  से कौनसा powerpoint का view नही ंहै |
a) Slide Show view
b) Slide view
c) Presentation view
d) Outline view

2. Slide Transition या है |
a) Overhead
b) letters
c) एक िवशेष भाव जो slide show म  slide को introdused करने के िलए use िकया जाता है
d) slide को delete करने का तरीका |

3. िविभन slides म  motion effect लाग ूकरने के िलए आप पॉवर पॉइंट का कौनसा फीचर use
कर गे |
a) slide transition
b) slide Design
c) Animation object
d) Animation Scheme

4.  presentation  म  िकसी  slide  के िलए  custom  timing  सेट करने के िलए आप इस
option  का  use  कर सकते है |
a) Slider timings
b) Slider timer
c) Rehearsal
d) Slide Show Setup

5. आप कैसे िकसी Presentation म  chart को रख सकते है |
a) Edit – Chart
b) Insert – Picture – Chart
c) Insert – Chart
d) View – Chart

6. Current Presentation म  नयी slide insert करने की शॉटकट key है |
a) Ctrl + O
b) Ctrl + M
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c) Ctrl + N
d) Ctrl + F

7. Powerpoint Presentation म  िडफ़ॉट Extention होता है |
a) .PPO
b) .PPT
c) .PPP
d) .PPE

8. इनम  से कौनसा view पॉवर पॉइंट म  slide के िलए Speaker Notes बनाने म  िकया जाता है |
a) Slide Note
b) Short Notes
c) Sound Note
d) Notes View

9. िनन म  से कौनसा Power point म  Shadow, title text और boxes का कलर बदलने की
सुिबधा दान करता है |
a) Color schemes
b) Drawing tools
c) Text tools
d) Background color

10. आप slide show को कैसे रोक सकते है |
a) Delete बटन को दबाकर |
b) Esc बटन को दबाकर |
c) Right arrow को दबाकर |
d) Left arrow को दबाकर |

11. …………….. task pane उस Design को show करती है जो वतमान म  presentation
म  use हो रही होती है |
a) slide show
b) slide style
c) slide design
d) slide format

12. िकसी slide म  table को कैसे insert करते है |
a) table menu – insert table
b) blank slide के content pane म  insert slide पर click करते है |
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c) अ. और ब. दोन |
d) table को slide म  insert नही ंिकया जा सकता |

13. ‘Hide slide’ option का या use है |
a) Presentation के दौरान select की गयी slide को hide करने के िलए |
b) Editing के दौरान select की गयी slide को hide करने के िलए |
c) Printing के दौरान select की गयी slide को hide करने के िलए |
d) Deleting के दौरान select की गयी slide को hide करने के िलए |

14. Hendout Master ारा define िकया जाता है |
a) slide formating
b) slide transaction
c) layout of hendout
d) layout of slide

15. इनमे से कौनसा slide के background की तरह use िकया जा सकता है |
a) Gradient
b) Taxture
c) Picture
d) ये सभी

Answer Sheet
1. इनम  से कौनसा powerpoint का view नही ंहै |
Answer – (d) Outline view

2. Slide Transition या है |
Answer  –  (c)  एक िवशेष भाव जो  slide  show म  slide  को  introdused  करने के िलए  use
िकया जाता है

3. िविभन slides म  motion effect लाग ूकरने के िलए आप पॉवर पॉइंट का कौनसा फीचर use
कर गे |
Answer – (d) Animation Scheme

4.  presentation  म  िकसी  slide  के िलए  custom  timing  सेट करने के िलए आप इस
option  का  use  कर सकते है |
Answer – (c) Rehearsal

5. आप कैसे िकसी Presentation म  chart को रख सकते है |
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Answer – (b) Insert – Picture – Chart

6. Current Presentation म  नयी slide insert करने की शॉटकट key है |
Answer – (b) Ctrl + M

7. Powerpoint Presentation म  िडफ़ॉट Extention होता है |
Answer – (b) .PPT

8. इनम  से कौनसा view पॉवर पॉइंट म  slide के िलए Speaker Notes बनाने म  िकया जाता है |
Answer – (d) Notes View

9. िनन म  से कौनसा Power point म  Shadow, title text और boxes का कलर बदलने की
सुिबधा दान करता है |
Answer – (a) Color schemes

10. आप slide show को कैसे रोक सकते है |
Answer – (b) Esc बटन को दबाकर |

11. …………….. task pane उस Design को show करती है जो वतमान म  presentation
म  use हो रही होती है |
Answer – (c) slide design

12. िकसी slide म  table को कैसे insert करते है |
Answer – (c) अ. और ब. दोन |

13. ‘Hide slide’ option का या use है |
Answer – (a) Presentation के दौरान select की गयी slide को hide करने के िलए

14. Hendout Master ारा define िकया जाता है |
Answer – (c) layout of hendout

15. इनमे से कौनसा slide के background की तरह use िकया जा सकता है |
Answer – (d) ये सभी
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ऍम एस पॉवर वॉइंट भाग – 2 (िहंदी म )
1. पॉवरपॉइंट म  Ctrl + E कमांड का use होता है |
a) Text को left म  करने के िलए
b) Text को Right म  करने के िलए
c) Text को Center म  करने के िलए
d) ये सभी

2. Ellipse Motion एक predefined………… है |
a) Design Template
b) Color Scheme
c) Animation Scheme
d) इनमे से की नहीं

3. Hendout का use करके िकतनी slides को एक ही पेज पर िंट िकया जा सकता है |
a) 1
b) 6
c) 9
d) ये सभी

4. यिद आप slide के केबल Text देखना चाहते है तो आप इनमे से कौनसा tab use कर गे |
a) Task pane
b) Thumbnails
c) Outline
d) Tool bar

5. यिद आप slides का म बदलना चाहते है तो आप िकस इनमे से कौनसा view use कर गे |
a) Normal View
b) slide sorter view
c) Notes page view
d) Slide show view

6. इनम  से कौनसा  menu  आपको  Animation  scheme,  custom  animation,  slide
transition  जैसी सुिबधा दान करता है |
a) insert menu
b) tools menu
c) format menu
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d) slide show menu

7. िकसी slide म  Hyperlink insert करने के िलए कौनसा िवकप सही है |
a) Choos insert – Hyperlink
b) Press Ctrl + K
c) Hyperlink को slide म  insert नही ंिकया जा सकता
d) अ. और ब. दोन

8. पॉवरपॉइंट म  slide sorter ………….. menu म  होता है |
a) Insert
b) View
c) File
d) Edit

9. “apply design templates” से या होता है |
a) slide का content change करता है
b) slide की functionality को जोड़ता है
c) slide के content म  िबना कोई पिरवतन िकये slide का look change करता है
d) इनम  से कोई नहीं

10. Readymade style म  बनी फाइल िजसे पॉवरपॉइंट म  presentation के िलए use िकया
जा सकता है, कहलाती है |
a) Autostyle
b) Wizard
c) Templates
d) Pre Formatting

11. िकसी  presentation म  ,  Animation scheme को  …………. slide म  लाग ूिकया जा
सकता है |
a) All slides
b) Selected slide
c) Current slide
d) ये सभी

12. इनम  से कौनसी key आप spelling check करने के िलए press करोगे |
a) F3
b) F5
c) F7
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d) F9

13. पॉवरपॉइंट म  ………………. text और Graphics के िलए Container की तरह use होता
है |
a) slide master
b) Table
c) Placeholder
d) Text Box

14. slide म  िकसी picture को Recolor करने की command है |
a) Insert – Picture – Recolor
b) Tools – Picture – Recolor
c) Format – Picture – Recolor
d) Edit – Picture – Recolor

15. िकसी slide म  िनन म  से कौन-2 से option हो सकते है |
a) Title, Text, graphs
b) Drawn, Object, Shapes
c) Clipart, Drawn art, Visual
d) इनम  से कोई भी

Answer Sheet
1. पॉवरपॉइंट म  Ctrl + E कमांड का use होता है |
Answer – (c) Text को Center म  करने के िलए

2. Ellipse Motion एक predefined………… है |
Answer – (c) Animation Scheme

3. Hendout का use करके िकतनी slides को एक ही पेज पर िंट िकया जा सकता है |
Answer – (d) ये सभी

4. यिद आप slide के केबल Text देखना चाहते है तो आप इनमे से कौनसा tab use कर गे |
Answer – (c) Outline

5. यिद आप slides का म बदलना चाहते है तो आप िकस इनमे से कौनसा view use कर गे |
Answer – (b) slide sorter view

6. इनम  से कौनसा  menu  आपको  Animation  scheme,  custom  animation,  slide
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transition  जैसी सुिबधा दान करता है |
Answer – (d) slide show menu

7. िकसी slide म  Hyperlink insert करने के िलए कौनसा िवकप सही है |
Answer – (d) अ. और ब. दोन

8. पॉवरपॉइंट म  slide sorter ………….. menu म  होता है |
Answer – (b) View

9. “apply design templates” से या होता है |
Answer – (c) slide के content म  िबना कोई पिरवतन िकये slide का look change करता है |

10. Readymade style म  बनी फाइल िजसे पॉवरपॉइंट म  presentation के िलए use िकया
जा सकता है, कहलाती है |
Answer – (c) Templates

11. िकसी  presentation म  ,  Animation scheme को  …………. slide म  लाग ूिकया जा
सकता है |
Answer – (d) ये सभी |

12. इनम  से कौनसी key आप spelling check करने के िलए press करोगे |
Answer – (c) F7

13. पॉवरपॉइंट म  ………………. text और Graphics के िलए Container की तरह use होता
है |
Answer – (d) Text Box

14. slide म  िकसी picture को Recolor करने की command है |
Answer – (c) Format – Picture – Recolor

15. िकसी slide म  िनन म  से कौन-2 से option हो सकते है |
Answer – (d) इनम  से कोई भी
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ऍम एस पॉवर वॉइंट भाग – 3 (िहंदी म )
1. एम एस पॉवर वॉइट का योग िकया जाता ह ।
a) ेजेटेशन हेतु
b) डाटाबेस हेतु
c) ोग ािमंग हेतु
d) एकाउंिटंग हेतु

2. ——————– उपयोग के िलए तैयार िपचर दान करता ह ।
a) वड आट  (Word Art)
b) िलप आट (Clip Art)
c) माट आट (Smart Art)
d) ऑटोशेप (Auto-shape)

3. लाइड शो को कैसे चलाना ह , इसको कंट ोल करने वाले टूस —————  टेब म  होते ह ।
a) िडजायन (Design)
b) लाइड शो (Slide Show)
c) य ू(View)
d) िरय ू(Review)

4. लाईड म  एिनमेशन का उपयोग करने के िलए टेब का उपयोग िकया जाता ह ।
a) एिनमेशन (Animation)
b) िडजाईन (Design)
c) होम (Home)
d) उपरोत सभी (All of Above)

5. एम एस पावर वॉइंट का उपयोग ह ।
a) प लेखन म
b) डाटा मैनेजम ट म
c) िवलेषण कायो  ंम
d) तुितकरण के कायो  ंम

6. जब पॉइंटर  —————– पर कसर पोजीशन िकया जाता ह , तब इसका आकार हाथ जैसा होता
ह ।
a) हाईपरिलंक (Hyperlink)
b) ीन िटप (Screen Tip)
c) पेिलंग एरर (Spelling Error)
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d) फाम िटंग एरर (Formatting Error)

7. पॉवर पॉइट म  बनाई तुित को ीन पर दिशत करने के िलए —————– कमाड योग
की जाती ह ।
a) य ूशो (View Show)
b) लाईड य ू(Slide View)
c) कटम शो (Custom View)
d) लाईड शो (Slide Show)

8. येक लाईड का टाईम सेट करने के िलए —————- कमाड योग की जाती ह ।
a) टाईम गेट (Time Get)
b) िरहेरस टाईिमंग (Rehears Timing)
c) टाईम (Time)
d) A और B

9. ेजेटेशन/लाइड्स िनन के ारा तैयार हो सकता ह ।
a) ऐसल (Excel)
b) पॉवर वॉइंट (Power Point)
c) ऐसेस (Access)
d) वड (Word)

10. ——————– सामाय उेय जैसे फोटो एबम, या िवज शो के िलए एक पवू विणत
ेजेटेशन ह ।
a) टेपलेट (Template)
b) टेबल (Table)
c) लाइड (Slide)
d) चाट (Chart)

11. यिद आपके ेजेटेशन म  अनेक लाईड हो, तो ——————– का उपयोग करके आप आसानी
से अपनी सारी लाइड को देख सकते ह  और उसके थानो ंम  पिरवतन कर सकते ह ।
a) नामल य ू(Normal View)
b) लाइड सॉटर य ू(Slide Sorter View)
c) लाइड शो य ू(Slide Show View)
d) नोट्स पेज (Notes Page)

12. सेट कमाड का काय ह ।
a) दशन का कार
b) लाइड्स की सयां
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c) लाइड्स का तरीका
d) उपरोत सभी

13. पावर वॉइंट तुितकरण का एक सशत मायम ह ।
a) सही (True)
b) गलत (False)

14. िकस टैब की सहायता से हम लाईड को ीन पर दिशत करने का भाव दे सकते ह ।
a) एनीमेशन (Animation)
b) ट ांिजसन (Transaction)
c) लाईड शो (Slide Show)
d) उपरोत म  कोई नही ं(None of Above)

15. हम हमारी जटेशन म  वीिडयो ंनही ंडाल सकते ह ।
a) सही (True)
b) गलत (False)

Answer Sheet
1. एम एस पॉवर वॉइट का योग िकया जाता ह ।
Answer – a) ेजेटेशन हेतु

2. ——————– उपयोग के िलए तैयार िपचर दान करता ह ।
Answer – b) िलप आट (Clip Art)

3. लाइड शो को कैसे चलाना ह , इसको कंट ोल करने वाले टूस ————— टैब म  होते ह ।
Answer – b) लाइड शो (Slide Show)

4. लाईड म  एिनमेशन का उपयोग करने के िलए टेब का उपयोग िकया जाता ह ।
a) एिनमेशन

5. एम एस पावर वॉइंट का उपयोग ह ।
Answer – d) तुितकरण के कायो  ंम

6. जब पॉइंटर  —————– पर कसर पोजीशन िकया जाता ह , तब इसका आकार हाथ जैसा होता
ह ।
Answer – a) हाईपरिलंक (Hyperlink)

7. पॉवर पॉइट म  बनाई तुित को ीन पर दिशत करने के िलए —————– कमाड योग
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की जाती ह ।
Answer – b) लाईड य ू(Slide View)

8. येक लाईड का टाईम सेट करने के िलए —————- कमाड योग की जाती ह ।
Answer – b) िरहेरस टाईिमंग (Rehears Timing)

9. ेजेटेशन/लाइड्स िनन के ारा तैयार हो सकता ह ।
Answer – b) पॉवर वॉइंट (Power Point)

10. ——————– सामाय उेय जैसे फोटो एबम, या िवज शो के िलए एक पवू विणत
ेजेटेशन ह ।
Answer – a) टेपलेट (Template)

11. यिद आपके ेजेटेशन म  अनेक लाईड हो, तो ——————– का उपयोग करके आप आसानी
से अपनी सारी लाइड को देख सकते ह  और उसके थानो ंम  पिरवतन कर सकते ह ।
Answer – b) लाइड सॉटर य ू(Slide Sorter View)

12. सेट कमाड का काय ह ।
Answer – d) उपरोत सभी (All of Above)

13. पावर वॉइंट तुितकरण का एक सशत मायम ह ।
Answer – a) सही (True)

14. िकस टैब की सहायता से हम लाईड को ीन पर दिशत करने का भाव दे सकते ह ।
Answer – b) ट ांिजसन (Transaction)

15. हम हमारी जटेशन म  वीिडयो ंनही ंडाल सकते ह ।
Answer – b) गलत  (False)
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ऍम एस पॉवर वॉइंट भाग – 4 (िहंदी म )
1. एनीमेशन टैब म  कौन-कौन से भाव होते ह ।
a) फेड (Fade)
b) बॉस  (Box)
c) लाई इन (Fly in)
d) उपरोत सभी (All of Above)

2. िकस मता ारा पॉवर वॉइंट म  बनाई गई लाइडो ंको वेत, तथा रंगीन पारदिशताओं के प म
िट करा सकते ह ।
a) ओवरहेड ट ांसपेर सी (Overhead Transparency)
b) कलर (Color)
c) लेक ओर वाइट (Black and White)
d) उपरोत सभी (All of Above)

3. पॉवर वॉइंट को रन करने के िलए रन िवडो म  या टाईप िकया जाता ह ।
a) Powerpnt
b) Power
c) ppt
d) Power Point

4. पॉवर वॉइंट की जेट शन म  लाईड पर िलखे गये —————— टेट का िट िलया जा
सकता ह ।
a) पेपर िंट आउट (Paper print Out)
b) ह ड आउट (Handout)
c) आउट लाईन (Out Line)
d) वेब जेट शन (Web Presentation)

5. िनन म  से कौनसा य ूपॉवर वॉइंट म  नही ंहोता ह ।
a) लाइड सोटर (Slide Sorter)
b) िरडीगं (Reading)
c) नामल (Normal)
d) डायमू ट (Document)

6. कौन सा डायलॉग बॉस पॉवर वॉइंट लोड करते समय ीन पर दिशत होता ह ।
a) लोड  (Load)
b) पावर वाट (Power Point)
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c) टाट (Start)
d) टाक पेन (TaskPan)

7. वतमान और कुल लाइडो ंकी संया कहॉ ंदिशत होती ह ।
a) काउंट बार (Count Bar)
b) टेटस बार (Status Bar)
c) करंट बार (Current Bar)
d) उपरोत सभी (All of Above)

8. लाइड शो की शॉटकट की  —————— होती ह ।
a) F5
b) F3
c) F7
d) F1

9. ——————– ग ािफकल सचूना और िवचारो ंका दृय होता ह ।
a) वड आट
b) िलप आट
c) माट आट
d) ऑटोशेप

10. ऑजेट को डुलीकेट बनाने की शॉटकट की ह ।
a) Ctrl + C
b) Ctrl + P
c) Ctrl + D
d) Ctrl + M

11. पीकर नोट कहां उपिथत होते ह ।
a) लाईड के नीचे
b) लाईड के ऊपर
c) परेू पेज म
d) इनम  से कोई नहीं

12. पॉवर वॉइंट म  नया जेटेशन सदैव िकस पर आधािरत होता ह ।
a) य ूेजेटेशन (New Presentation)
b) ल क ेजेटेशन (Blank Presentation)
c) ऑटो कट ट िवजाड (Auto Shape Wizard)
d) इनम  से कोई नही ं(None of Above)
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13. ——————— वातिवक लाइड शो ेजेटेशन की तरह सपणू कयटूर पर नजर आता ह ।
a) लाइड सोटर (Slide Sorter)
b) लाइड शो य ू(Slide Show View)
c) नोट्स पेज य ू(Notes Page View)
d) नामल य ू(Normal View)

14. कौन सी कंुिजयो ंके संयोजन से पावर पॉइंट तुतीकरण म  नया लाइड जोड़ा जा सकता ह ।
a) Ctrl + X
b) Ctrl + N
c) Ctrl + M
d) Ctrl + Z

15. लाइड शो को कैसे चलाना ह , इसको कंट ोल करने वाले टूल —————– टैब म  होते ह ।
a) िडजायन
b) लाइड शो
c) िरयू
d) यू

Answer Sheet
1. एनीमेशन टैब म  कौन-कौन से भाव होते ह ।
Answer – d) उपरोत सभी  (All of Above)

2. िकस मता ारा पॉवर वॉइंट म  बनाई गई लाइडो ंको वेत, तथा रंगीन पारदिशताओं के प म
िट करा सकते ह ।
Answer – a) ओवरहेड ट ांसपेर सी (Overhead Transparency)

3. पॉवर वॉइंट को रन करने के िलए रन िवडो म  या टाईप िकया जाता ह ।
Answer – a) Powerpnt

4. पॉवर वॉइंट की जेट शन म  लाईड पर िलखे गये —————— टेट को िट िलया जा
सकता ह ।
Answer – c) आउट लाईन (Out Line)

5. िनन म  से कौनसा य ूपॉवर वॉइंट म  नही ंहोता ह ।
Answer – d) डायमू ट (Document)

6. कौन सा डायलॉग बॉस पॉवर वॉइंट लोड करते समय ीन पर दिशत होता ह ।
Answer – d) टाक पेन (Task-Pan)
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7. वतमान और कुल लाइडो ंकी संया कहॉ ंदिशत होती ह ।
Answer – b) टेटस बार (Status bar)

8. लाइड शो की शॉटकट की  —————— होती ह ।
Answer – a) F5

9. ——————– ग ािफकल सचूना और िवचारो ंका दृय होता ह ।
Answer – b) िलप आट (Clip Art)

10. ऑजेट को डुलीकेट बनाने की शॉटकट की ह ।
Answer – c) Ctrl + D

11. पीकर नोट कहां उपिथत होते ह ।
Answer – a) लाईड के नीचे

12. पॉवर वॉइंट म  नया जेटेशन सदैव िकस पर आधािरत होता ह ।
Answer – b) ल क ेजेटेशन (Blank Presentation)

13. ——————— वातिवक लाइड शो ेजेटेशन की तरह सपणू कयटूर पर नजर आता ह ।
Answer – a) लाइड सोटर (Slide Sorter)

14. कौन सी कंुिजयो ंके संयोजन से पावर वॉइंट तुतीकरण म  नया लाइड जोड़ा जा सकता ह ।
Answer – c) Ctrl + M

15. लाइड शो को कैसे चलाना ह , इसको कंट ोल करने वाले टूल —————– टैब म  होते ह ।
Answer – b) लाइड शो (Slide Show)
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ऍम एस पॉवर वॉइंट भाग – 5 (िहंदी म )
1. माइोसॉट पॉवर पॉइट 2007 म  फाईल —————— एसट शन के साथ टोर होती ह ।
a) .PHD
b) .BMP
c) .DOCX
d) .PPTX

2. एक —————— आइकन दिशत करता ह  िजसम  सामाय प से उपयोग होने वाले कमाड
(जैसे सेव, अंडू और िरडू) होते ह ।
a) होम बटन (Home Button)
b) िरबन (Ribbon)
c) िवक एसेस टूलबार (Quick Access Toolbar)
d) ऑिफस बटन (Office Button)

3. कौनसी कमाड पॉवर पॉइट ेजेटेशन तथा उससे संबंिधत िविभन फाइलो ंको एक साथ िकसी
लॉपी तथा हाडिडक पर कॉपी करने के काम आती ह ।
a) स ड टू (Send-To)
b) पैकेज फॉर सीडी (Package for CD)
c) ओिरएंटेशन (Orientation)
d) इनम  से कोई नही ं(None of Above)

4. ेजेटेशन ग ािफस म  —————- का उपयोग, ेजेटेशन म  हडआउट या नोट्स पेज के ऊपर
या लाइड, हड आउट या नोट्स पेज के नीचे की ओर सचूनाए,ँ जैसे लाइड, संया, समय और तारीख,
कपनी का लोगो या ेजेटेशन टाइटल को रखने के िलए करते ह ।
a) हाइपरिलंक (Hyperlink)
b) हेडस-फुटस (Headers-Footers)
c) चाट्स (Charts)
d) टेबल (Table)

5. िनन म  से कौन सी कमाड पॉवर पॉइट म  नही ंहोती ह ।
a) सेव (Save)
b) सेव वक पेज (Save Workpage)
c) सेव एज (Save-AS)
d) सेव एज वेब पेज (Save-As Webpage)

6. पेज सेटअप कमाड से िकन-िकन को बदला जाता ह ।
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a) पेपर साईज (Paper Size)
b) पेपर हाईट (Paper Height)
c) ऑिरएटेशन (Orientation)
d) उपरोत सभी (All of Above)

7. पॉवर पॉइट म  बनी हुई फाइल का िडफॉट नाम या होता ह ।
a) बुक (Book)
b) डॉयमू ट (Document)
c) ेजेटेशन (Presentation)
d) अनटाईटल (Untitle)

8. िकस य ूम  लाइड की छोटी तवीर  नजर आती ह ।
a) लाइड सॉटर (Slide Sorter)
b) नॉमल (Normal)
c) लाइड शो (Slide Show)
d) आउटलाइन (Outline)

9. लाईड म  एिनमेशन का उपयोग करने के िलए —————— टैब का उपयोग िकया जाता ह ।
a) एिनमेशन (Animation)
b) िडजाईन (Design)
c) होम (Home)
d) उपरोत सभी (All Of Above)

10. पॉवर पॉइट म  बनी हुई फाइल को िकस नाम से जाना जाता ह ।
a) ेजेटेशन (Presentation)
b) डायमू ट (Document)
c) वक शीट (Worksheet)
d) उपरोत सभी  (All Of Above)

11. लाईडो को रन करने के िलए ——————- कमाड का उपयोग िकया जाता ह ।
a) रन (Run)
b) लाईड शो (Slide Show)
c) शो (Show)
d) रन लाईड (Run Slide)

12. ——————- टैब म  बेिसक फॉरमेिटंग टूस होते ह ।
a) िडजाईन (Design)
b) य ू(View)
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c) होम (Home)
d) इसट (Insert)

13. िलपबोड के कटेट को िवशेष फॉरमेट म  पेट करने के िलए —————— कमाड का उपयोग
िकया जाता ह ।
a) पेट (Paste)
b) पेट एज हाईपरिलंक (Paste-As Hyperlink)
c) पेशल (Hyperlink)
d) पेट पेशल (Paste Spacial)

14. िकस कमाड की सहायता से चुने हुए ऑजेट की दसूरी ितिलिप तैयार की जा सकती ह ।
a) कॉपी (Copy)
b) मवू (Move)
c) कट (Cut)
d) डुलीकेट (Duplicate)

15. —————– मुय एिडिटंग य ूह ।
a) लाइड सॉटर (Slide Sorter)
b) लाइड शो (Slide Show)
c) नोट्स पेज (Notes Page)
d) नामल (Normal)

Answer Sheet
1. माइोसॉट पॉवर पॉइट 2007 म  फाईल —————— एसट शन के साथ टोर होती ह ।
Answer – d) .PPTX

2. एक —————— आइकन दिशत करता ह  िजसम  सामाय प से उपयोग होने वाले कमाड
(जैसे सेव, अंडू और िरडू) होते ह ।
Answer – c) िवक एसेस टूलबार (Quick Access Toolbar)

3. कौनसी कमाड पॉवर पॉइट ेजेटेशन तथा उससे संबंिधत िविभन फाइलो ंको एक साथ िकसी
लॉपी तथा हाडिडक पर कॉपी करने के काम आती ह ।
Answer – b) पैकेज फॉर सीडी (Package for CD)

4. ेजेटेशन ग ािफस म  —————- का उपयोग, ेजेटेशन म  हडआउट या नोट्स पेज के ऊपर
या लाइड, हड आउट या नोट्स पेज के नीचे की ओर सचूनाए,ँ जैसे लाइड, संया समय और तारीख,
कपनी का लोगो या ेजेटेशन टाइटल को रखने के िलए करते ह ।
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Answer – b) हेडस-फुटस (Headers-Footers)

5. िनन म  से कौन सी कमाड पॉवर पॉइट म  नही ंहोती ह ।
Answer – b) सेव वक  पेज  (Save Workpage)

6. पेज सेटप कमाड से िकन-िकन को बदला जाता ह ।
Answer – d) उपरोत सभी (All Of Above)

7. पॉवर पॉइट म  बनी हुई फाइल का िडफॉट नाम या होता ह ।
Answer – c) ेजेटेशन (Presentation)

8. िकस य ूम  लाइड की छोटी तवीर  नजर आती ह ।
Answer – a) लाइड सॉटर (Slide Sorter)

9. लाईड म  एिनमेशन का उपयोग करने के िलए टैब का उपयोग िकया जाता ह ।
Answer – a) एिनमेशन (Animation)

10. पॉवर पॉइट म  बनी हुई फाइल को िकस नाम से जाना जाता ह ।
Answer – a) ेजेटेशन (Presentation)

11. लाईडो को रन करने के िलए ——————- कमाड का उपयोग िकया जाता ह ।
Answer – b) लाईड शो (Slide Show)

12. ——————- टैब म  बेिसक फॉरमेिटंग टूस होते ह ।
Answer – c) होम  (Home)

13. िलपबोड के कटेट को िवशेष फॉरमेट म  पेट करने के िलए —————— कमाड का उपयोग
िकया जाता ह ।
Answer – d) पेट पेशल (Paste Spacial)

14. िकस कमाड की सहायता से चुने हुए ऑजेट की दसूरी ितिलिप तैयार की जा सकती ह ।
Answer – d) डुलीकेट (Duplicate)

15. —————– मुय एिडिटंग य ूह ।
Answer – d) नामल (Normal)
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ऍम एस पॉवर वॉइंट भाग – 6 (िहंदी म )
1. िननिलिखत म  से कौन-सा फॉट का टाईल नही ंह ।
a) बोड (Bold)
b) सुपर िट (Super Script)
c) इटैिलक (Italic)
d) रेगलूर (Regular)

2. िडलीट कमाड ारा िकस कार की लाईड को हटाया जा सकता ह ।
a) सभी लाईड (All Slide)
b) करंट लाईड (Current Slide)
c) ििवयस लाईड (Previous Slide)
d) इनम  से कोई नही ं(None of Above)

3. ीन के बॉटम पर िथत —————– पर दिशत बटनो ंपर िलक करके ेजेटेशन य ूको बदल
सकते ह ।
a) टाइटल बार (Title Bar)
b) मेय ूबार (Menu Bar)
c) टेटस बार (Status Bar)
d) टूल बार (Tool Bar)

4. यह कमाड िकसी अय सॉटवेयर से लाए गए ऑजेट म  कुछ पिरवतन करने के काम आती ह ।
a) ऑजेट (Object)
b) च ज (Change)
c) कवट (Convert)
d) िलंक (Link)

5. करंट लाईड का नोट पेज िकस कमाड से दिशत होता ह ।
a) नोट्स पेज (Notes Page)
b) य ूपेज (New Page)
c) नोट य ू(Note New)
d) इनम  से कोई नही ं(None of Above)

6. पॉवर वॉइंट ेज टेशन िननिलिखत एलीकेशन ोग ास का िहसा ह ।
a) िलप ऑिफस (Lip Office)
b) टार ऑिफस (Star Office)
c) ओपेन ऑिफस (Open Office)
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d) एमएस ऑिफस (MS Office)

7. िकस य ूम  लाईड की एडेिटंग टाईिपंग तथा फॉरमेिटंग की जा सकती ह ।
a) माटर (Master)
b) नामल (Normal)
c) लाईड सोटर (Slide Sorter)
d) उपरोत सभी (All of Above)

8. गाईडस कमाड का काय ह ।
a) होरीजेटल गाइड को िदखाना
b) विटकल गाइड को िदखाना
c) गाइड्स को िछपाना
d) उपरोत सभी

9. —————– सामाय उेय जैसे फोटो एबम या िवज शो के िलए एक पवू विणत ेजेटेशन
ह ।
a) चाट (Chart)
b) टेबल (Table)
c) लाइड (Slide)
d) टेपलेट (Template)

10. जब आप अपने माउस को साइिजंग हडल के ऊपर मवू कराते ह  तो ं वॉइंटर —————– की
तरह होता ह ।
a) लस िचह
b) दो हेडेड ऐरो
c) चार िसर वाला ऐरो
d) राउंड ऐरो

11. लर लाईड िकस ओर दिशत होती ह ।
a) ऊपर (Top)
b) नीचे  (Bottom)
c) ऊपर और बाएं (Top and Left)
d) ऊपर और दाएं (Top and Right)

12. वतमान ेजेटेशन म  नई लाईड इसट  करने के िलए िकस कमाड का उपयोग िकया जाता ह ।
a) इसट (Insert)
b) य ूलाईड  (New Slide)
c) य ू(New)
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d) इनम  से कोई नही ं(None of Above)

13. लाईड ाम कमाड ारा ेजेटेशन म  या इसट  िकया जा सकता ह ।
a) फाईल (File)
b) टेट (Text)
c) ग ाफ (Graph)
d) इनम  से कोई नही ं(None of Above)

14. िकसी दसूरी एिलकेशन म  बनी फाईल को वतमान ेजेटेशन म  इसट  करने की कमाड कौन सी
होती ह ।
a) लाईड (Slide)
b) इसट (Insert)
c) लाईड ाम आउट लाईन (Slide Form Out Line)
d) इनम  से कोई नही ं(None of Above)

15. लाइड म  टेबल जोड़ने की कमाड —————– ह ।
a) टेबल (Table)
b) य ूटेबल (New Table)
c) इसट टेबल (Insert Table)
d) उपरोत सभी (All of Above)

Answer Sheet
1. िननिलिखत म  से कौन-सा फॉट का टाईल नही ंह ।
Answer – d) रेगलूर (Regular)

2. िडलीट कमाड ारा िकस कार की लाईड को हटाया जा सकता ह ।
Answer – b) करंट लाईड (Current Slide)

3. ीन के बॉटम पर िथत —————– पर दिशत बटनो ंपर िलक करके ेजेटेशन य ूको बदल
सकते ह ।
Answer – c) टेटस बार (Status Bar)

4. यह कमाड िकसी अय सॉटवेयर से लाए गए ऑजेट म  कुछ पिरवतन करने के काम आती ह ।
Answer – a) ऑजेट (Object)

5. करंट लाईड का नोट पेज िकस कमाड से दिशत होता ह ।
Answer – a) नोट्स पेज (Notes Page)

ANKAJ INFOTECH



6. पॉवर वॉइंट ेज टेशन िननिलिखत एलीकेशन ोग ास का िहसा ह ।
Answer – d) एमएस ऑिफस

7. िकस य ूम  लाईड की एडेिटंग टाईिपंग तथा फॉरमेिटंग की जा सकती ह ।
Answer – b) नामल (Normal)

8. गाईडस कमाड का काय ह ।
Answer – d) उपरोत सभी (All of Above)

9. —————– सामाय उेय जैसे फोटो एबम या िवज शो के िलए एक पवू विणत ेजेटेशन
ह ।
Answer – d) टेपलेट (Template)

10. जब आप अपने माउस को साइिजंग हडल के ऊपर मवू कराते ह  तो ं वॉइंटर —————– की
तरह होता ह ।
Answer – b) दो हेडेड ऐरो

11. लर लाईड िकस ओर दिशत होती ह ।
Answer – c) ऊपर और बाएं (Top and Left)

12. वतमान ेजेटेशन म  नई लाईड इसट  करने के िलए िकस कमाड का उपयोग िकया जाता ह ।
Answer – a) इसट (Insert)

13. लाईड ाम कमाड ारा ेजेटेशन म  या इसट  िकया जा सकता ह ।
Answer – a) फाईल (File)

14. िकसी दसूरी एिलकेशन म  बनी फाईल को वतमान ेजेटेशन म  इसट  करने की कमाड कौन सी
होती ह ।
Answer – c) लाईड ाम आउट लाईन (Slide Form Out Line)

15. लाइड म  टेबल जोड़ने की कमाड —————– ह ।
Answer – a) टेबल (Table)
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ऍम एस पॉवर वॉइंट भाग – 7 (िहंदी म )
1. —————– कमाड म  फाइल को खोलने, सेव करने, िट करने और बंद करने की कमाड होती
ह ।
a) ऑिफस बटन (Office Button)
b) य ूटैब (View Tab)
c) िरय ूटैब (Review Tab)
d) इनम  से कोई नही ं(None of Above)

2. चुने हुए टेट के कैरेटर फॉरमेट को बदलने के िलए —————– कमाड योग की जाती ह ।
a) फॉरमेट (Format)
b) फॉट (Font)
c) पेिलंग (Spelling)
d) च ज केश (Change Case)

3. िनन म  से एलाइमट िकस कार के होते ह ।
a) लेट, राईट (Left, Right)
b) स टर, जटीफाई (Center, Justify)
c) टॉप, बॉटम (Top, Bottom)
d) A और B दोन

4. ——————- समानाथक शदो ंकी शदकोश ह  िजसका उपयोग समानाथी शदो ंको खोजने के
िलए कर सकते ह ।
a) अनुवाद (Synonyms)
b) पेिलंग (Spelling)
c) िरसच (Research)
d) िथंसरस (Thesaurus)

5. लाइड म  ले आउट बदलने की कमाड कौन होती ह ।
a) लेआउट (Layout)
b) बैकग ाउंड (Background)
c) लाईड लेआउट (Slide Layout)
d) उपरोत सभी (All of Above)

6. यह कमाड चुने गए िच की आउट लाइन की टाइल व रंग तथा उसम  भरे गए रंग को बदलती ह ।
a) कलर (Color)
b) लाईन (Line)
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c) कलर और लाईन (Color and Line)
d) बैकग ाउंड (Background)

7. पॉवर वॉइंट िकस ोग ाम का एक िहसा ह ।
a) िलप ऑिफस (Lip Office)
b) टार ऑिफस (Star Office)
c) ओपन ऑिफस (Open Office)
d) एम.एस. ऑिफस (MS Office)

8. —————– का उपयोग कयटूर पर लाइड शो बनाने के िलए िकया जाता ह ।
a) ेजेटेशन ग ािफस (Presentation Graphics)
b) एनालेिटक ोग ास (Analytic Program)
c) लाइड मेकर टूस (Slide Maker Tools)
d) सुपर लाइड पैकेज (Super Slide Package)

9. —————– एक िवशेष लाइड ह , जो ेजेटेशन की सभी लाइडो ंके िलए टाईटल और टेट
के फॉरमेट व वप को िनयंित करती ह ।
a) लाइड (Slide)
b) मेनु (Menu)
c) माटर (Master)
d) उपरोत सभी (All of Above)

10. लाइनो ंके बीच की जगह को यविथत करने के िलए िनन म  से िकस कमाड का योग िकया
जाता ह ।
a) लाईन (Line)
b) पैराग ाफ (Paragraph)
c) लाईन पेिसंग (Line Spacing)
d) इनम  से कोई नही ं(None of Above)

11. पॉवर वॉइंट म  लाईड की िडजायन ——————- टैब ारा तैयार की  जाती ह ।
a) फाइल (File)
b) होम (Home)
c) एिनमेशन (Animation)
d) िडजाईन(Design)

12. एक फॉट को दसूरे फॉट से बदलने के िलए  —————— कमाड योग की जाती ह ।
a) फॉट (Font)
b) िरलेस फॉट (Replace Font)
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c) A और B दोन
d) इनमे से कोई नही ं(None of Above)

13. लाईड के शदो ंकी पेिलंग जॉचने के िलए —————— योग िकया जाता ह ।
a) ग ामर (Grammar)
b) पेिलंग (Spelling)
c) चेक (Check)
d) इनम  से कोई नही ं(None of Above)

14. कौनसी कमाड पॉवर वॉइंट म  बनाई गई तुित का आकार उपिथत िवडो के आकार के
अनुसार यविथत करती ह ।
a) िफट टू िवंडो (Fit to Window)
b) िफट टू फाईल (Fit to File)
c) िफट टू पेज (Fit to File)
d) िफट टू पॉवर वाट (Fit to Power Point)

15. कौनसी कमाड लाईड म  िलखे टेट को वत : ठीक करता ह ।
a) ऑटो फॉरमेट (Auto Format)
b) ऑटो करेट (Auto Correct)
c) करेट (Correct)
d) च ज केश (Change Case)

Answer Sheet
1. —————– कमाड म  फाइल को खोलने, सेव करने, िट करने और बंद करने की कमाड होती
ह ।
Answer – a) ऑिफस बटन (Office Button)

2. चुने हुए टेट के कैरेटर फॉरमेट को बदलने के िलए —————– कमाड योग की जाती ह ।
Answer – b) फॉट (Font)

3. िनन म  से एलाइमट िकस कार के होते ह ।
Answer – d) A और B दोन

4. ——————- समानाथक शदो ंकी शदकोश ह  िजसका उपयोग समानाथक शदो ंको खोजने के
िलए कर सकते ह ।
Answer – d) िथंसरस (Thesaurus)

5. लाइड का ले आउट बदलने की कमाड कौन होती ह ।
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Answer – a) लेआउट (Layout)

6. यह कमाड चुने गए िच की आउटलाइनकी टाइल व रंग तथा उसम  भरे गए रंग को बदलती ह ।
Answer – c) कलर और लाईन (Color Line)

7. पॉवर वॉइंट िकस ोग ाम का एक िहसा ह ।
Answer – d) एम.एस. ऑिफस (MS Office)

8. —————– का उपयोग कयटूर पर लाइड शो बनाने के िलए िकया जाता ह ।
Answer – a) ेजेटेशन ग ािफस (Presentation)

9. —————– एक िवशेष लाइड ह , जो ेजेटेशन की सभी लाइडो ंके िलए टाईटल और टैट
के फॉरमेट व वप को िनयंित करती ह ।
Answer – c) माटर (Master)

10. लाइनो ंके बीच की जगह को यविथत करने के िलए िनन म  से िकस कमाड का योग िकया
जाता ह ।
Answer – c) लाईन पेिसंग (Line Spacing)

11. पॉवर वॉइंट म  लाईड की िडजायन ——————- टैब ारा तैयार िक जाती ह ।
Answer – d) िडजाईन (Design)

12. एक फॉट को दसूरे फॉट से बदलने के िलए कमाड योग की जाती ह ।
Answer – c) A और B दोन

13. लाईड के शदो ंकी पेिलंग जॉचने के िलए —————— योग िकया जाता ह ।
Answer – b) पेिलंग (Spelling)

14. कौनसी कमाड पॉवर वॉइंट म  बनाई गई तुित का आकार उपिथत िवडो के आकार के
अनुसार यविथत करती ह ।
Answer – c) िफट टू पेज (Fit to Page)

15. कौनसी कमाड लाईड म  िलखे टेट को वत : ठीक करता ह ।
Answer – b) ऑटो करेट (Auto Correct)
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ऍम एस पॉवर वॉइंट भाग – 8 (िहंदी म )
1. पॉवर वॉइंट म  येक पेज —————- कहलाता ह ।
a) वक शीट (Worksheet)
b) टेट पेज (Text Page)
c) लाइड (Slide)
d) तुित (Presentation)

2. यिद आपके ेज टेशन म  अनेक लाइड हो तो ——————- का उपयोग करके आप आसानी से
आपनी सारी लाइड को देख सकते है और उनके थानो ंम  पिरवतन कर सकते ह ।
a) नामल य ू(Normal View)
b) लाइड सॉटर य ू(Slide Sorter View)
c) लाइड शो य ू(Slide Show View)
d) नोट्स पेज य ू(Notes Page View)

3. —————– सामाय उेय जैसे फोटो एबम या िवज शो के िलए एक पवूविणत ेज टेशन ह ।
a) चाट (Chart)
b) टेबल (Table)
c) लाइड (Slide)
d) टैपलेट (Template)

4. ——————– िकसी फाइल के िववरण ह  जो उसे पहचानने म  मदद करता ह ।
a) डेकटॉप ोपटी ज (Desktop Properties)
b) िवंडोज ोपटी ज (Windows Properties)
c) ोपटी ज (Properties)
d) डायमू ट ोपटी ज (Document Properties)

5. मुय एिडिटंग य ूह ।
a) लाइड सॉटर य ू(Slide Sorter View)
b) नामल (Normal View)
c) लाइड शो य ूSlide Show View)
d) नोट्स पेज य ू (Notes Page View)

6. ——————- टैब म  बेिसक फारमेिटंग टूस होती ह ।
a) िडजाइन (Design)
b) य ू(View)
c) इसट (Insert)
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d) होम (Home)

7. पॉवर वॉइंट के तुतीकरण म  ितप लाइड को जोड़ने के की शॉटकट-की होती ह ।
a) Ctrl + X
b) Ctrl + N
c) Ctrl + M
d) Ctrl + Z

8. ‘’िलप’’ एक िसंगल मीिडया फाइल हो सकती ह  िजससे आट , साउडं, एनीमेशन या मवूीज शािमल
होती ह ।
a) सही (True)
b) गलत (False)

9. िसलेट िकये गये आयत के बगल म  और िकनारे की और ‘’साइिजंग हडल’’ का उपयोग लेसहोडर
के आकार को संतुिलत करने के िलए िकया जाता ह ।
a) सही (True)
b) गलत (False)

10. पहले सेव की गई फाइल को खोलने के िलए, िरबन पर िलक करके ‘’ओपन’’ िसलेट करते ह ।
a) सही (True)
b) गलत (False)

11. पॉवर वॉइंट ेज टेशन म  वनी का समावेश कर सकते ह ।
a) सही (True)
b) गलत (False)

12. एिडट के दौरान आउटलाइन टैब आपकी लाइडो ंको थंबनेल के आकार की तवीरो के प म
िदखाता ह ।
a) सही (True)
b) गलत (False)

13. पॉवर वॉइंट म  इसट  टैब म  लाइड िडजाइन के िलए टूस होती ह ।
a) सही (True)
b) गलत (False)

14. फाइल को खोलने, सेव करने, िंट करने और बंद करने के िनदशो ंको दिशत करने वाला ऑिफस
बटन ह ।
a) सही (True)
b) गलत (False)
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15. ‘’आउटलाइन’’ टैब आपको लाइड टेट, तवीरो ं टेिबल, चाट  और िफमो ंजैसे एिलमटस की
यवथा को दिशत करता ह ।
a) सही (True)
b) गलत (False)

Answer Sheet
1. पॉवर वॉइंट म  येक पेज —————- कहलाता ह ।
Answer – c) लाइड (Slide)

2. यिद आपके ेज टेशन म  अनेक लाइड हो तो ——————- का उपयोग करके आप आसानी से
आपनी सारी लाइड को देख सकते है और उनके थानो ंम  पिरवतन कर सकते ह ।
Answer – b) लाइड सॉटर य ू(Slide Sorter View)

3. —————– सामाय उेय जैसे फोटो एबम या िवज शो के िलए एक पवूविणत ेज टेशन ह ।
Answer – d) टैपलेट (Template)

4. ——————– िकसी फाइल के िववरण ह  जो उसे पहचानने म  मदद करता ह ।
Answer – d) डायमू ट ोपटी ज (Document Properties)

5. मुय एिडिटंग य ूह ।
Answer – b) नामल य ू(Normal View)

6. ——————- टैब म  बेिसक फारमेिटंग टूस होती ह ।
Answer – d) होम (Home)

7. पॉवर वॉइंट के तुतीकरण म  ितप लाइड को जोड़ने के की शॉटकट की होती ह ।
Answer – c) Ctrl + M

8. ‘’िलप’’ एक िसंगल मीिडया फाइल हो सकती ह  िजससे आट , साउडं, एनीमेशन या मवूीज शािमल
होती ह ।
Answer – a) सही (True)

9. िसलेट िकये गये आयत के बगल म  और िकनारे की और ‘’साइिजंग हडल’’ का उपयोग लेसहोडर
के आकार को संतुिलत करने के िलए िकया जाता ह ।
Answer – a) सही (True)

10. पहले सेव की गई फाइल को खोलने के िलए, िरबन पर िलक करके ‘’ओपन’’ िसलेट करते ह ।
Answer – b) गलत (False)
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11. पॉवर वॉइंट ेज टेशन म  वनी का समावेश कर सकते ह ।
Answer – a) सही (True)

12. एिडट के दौरान आउटलाइन टैब आपकी लाइडो ंको थंबनेल के आकार की तवीरो के प म
िदखाता ह ।
Answer – b) गलत (False)

13. पॉवर वॉइंट म  इसट  टैब म  लाइड िडजाइन के िलए टूस होती ह ।
Answer – b) गलत (False)

14. फाइल को खोलने, सेव करने, िंट करने और बंद करने के िनदशो ंको दिशत करने वाला ऑिफस
बटन ह ।
Answer – a) सही (True)

15. ‘’आउटलाइन’’ टैब आपको लाइड टेट, तवीरो ं टेिबल, चाट  और िफमो ंजैसे एिलमटस की
यवथा को दिशत करता ह ।
Answer – a) सही (True)

ANKAJ INFOTECH



ऍम एस पॉवर वॉइंट भाग – 9 (िहंदी म )
1. पॉवर वॉइंट म  कौनसी फाइल का ाप नही जोड़ा जाता ह ।
a) जेपीईजी (JPEG)
b) एच टी एम एल (HTML)
c) जी आई एफ (GIF)
d) डय ूएवी (WAV)

2. लाइड तुित म  िवशेष भाव डालने को ————– कहते ह ।
a) इफेट्स (Effect)
b) कटम एनीमेशन (Custom Animation)
c) ट ांजेशन (Transaction)
d) ेज ट एनीमेशन (Present Animation)

3. माइोसॉट पॉवर वॉइंट 2010 ोग ाम म  आपकी फाइल ————— एसट शन म  संग िहत
होता ह ।
a) .पीएसडी (.PSD)
b) .आरटीएफ (.RTF_
c) .पीपीटीएस (.PPTX)
d) .डॉकएस (.DOCX)

4. —————– टाइटल बार म  एक आइकॉन दिशत करता ह  िजसम  सामाय प से उपयोग होने
वाले कमांड जैसे सेव, अंडू और रीडू रहते ह ।
a) होम बटन (Home Button)
b) िरबन (Ribbon)
c) िवक एसेस टूलबार (Quick Access Toolbar)
d) ऑिफस बटन (Office Button)

5. ग ािफस जटेशन ोग ास म  येक ेजटेशन —————— म  िवभािजत होता ह ।
a) चाट्स (Chart)
b) लाइड्स (Slides)
c) टेबल (Table)
d) िपचर (Picture)

6. ——————– सामाय उेय जैसे-फोटो एलबम या िवज शो के िलए एक पवू विणत ेज टेशन
ह ।
a) चाट (Chart)
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b) टेबल (Table)
c) लाइड (Slide)
d) टेपलेट (Template)

7. ——————— वातिवक लाइड शो ेज टेशन की तरह संपणू कयटूर ीन पर नजर आता
ह ।
a) लाइड सॉटर य ू(Slide Sorter View)
b)  नामल य ू(Normal View)
c) लाइड शो य ू (Slide Show View)
d) नोट्स पेज (Notes Page)

8. िननिलिखत म  से िकसी पैकेज को लाइड तुित के िलए युत िकया जाता ह ।
a) एम एस वड (Ms Word)
b) एम एस एसेल (Ms Excel)
c) एम एस पावर वांईट (Ms PowerPoint)
d) एम एस एसेस (Ms Access)

9. ——————– वतमान डॉयमूट के एक थान से अय डॉयमेूट या वेबसाइट के बीच होने
वाला संपक  ह ।
a) हाइिलंक (Highlink)
b) हाइपोिलंक (Highpolink)
c) िलक ज (Linkage)
d) हाइपरिलंक (Hyperlink)

10. िरय ूिकसी जटेशन को देखने का एक तरीका होता ह ।
a) सही (True)
b) गलत (False)

11. ेज टेशन को वेब पेज के प म  िय ूकरने के िलए बटन िरबन म  वेब पेज िय ूकमांड को जोड़ने
की आवयकता होती ह ।
a) सही (True)
b) गलत (False)

12. ीन पर िवंडो म  अपने लाइड की िय ूको देखने के िलए िवक एसेस टूलबार पर िलक करके
िंट िय ूको िसलेट करते ह ।
a) सही (True)
b) गलत (False)
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13. लाइड लेआउट एक लाइड पर टेट तवीरो ंटेबल चाट  और िफम जैसे एिलमट्स की यवथा
को दिशत करता ह ।
a) सही (True)
b) गलत (False)

14. एिडट के दौरान आउटलाइन टैब आपकी लाइडो ंको थंबनेल के आकार की तवीरो ं के प म
िदखाता ह ।
a) सही (True)
b) गलत (False)

15. पावर वॉइंट म  इसट  टैब म  लाइड िडजाइन के िलए टूस होती ह ।
a) सही (True)
b) गलत (False)

Answer Sheet
1. पॉवर वॉइंट म  कौनसी फाइल ाप नही जोड़ा जाता ह ।
Answer – b) एच टी एम एल (HTML)

2. लाइड तुित म  िवशेष भाव डालने को ————– कहते ह ।
Answer – b) कटम एनीमेशन (Custom Animation)

3. माइोसॉट पॉवर वॉइंट 2010 ोग ाम म  आपकी फाइल ————— एसट शन म  संग िहत
होता ह ।
Answer – c) .पीपीटीएस (.PPTX)

4. —————– टाइटल बार म  एक आइकॉन दिशत करता ह  िजसम  सामाय प से उपयोग होने
वाले कमांड जैसे सेव, अंडू और रीडू रहते ह ।
Answer – c) िवक एसेस टूलबार (Quick Access Toolbar)

5. ग ािफस जटेशन ोग ास म  येक ेजटेशन —————— म  िवभािजत होता ह ।
Answer – b) लाइड्स (Slides)

6. ——————– सामाय उेय जैसे-फोटो एलबम या िवज शो के िलए एक पवू विणत ेज टेशन
ह ।
Answer – d) टेपलेट (Template)

7. ——————— वातिवक लाइड शो ेज टेशन की तरह संपणू कयटूर ीन पर नजर आता
ह ।
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Answer – a) लाइड सॉटर य ू(Slide Sorter View)

8. िननिलिखत म  से िकसी पैकेज को लाइड तुित के िलए युत िकया जाता ह ।
Answer – c) एम एस पावर वांईट (Ms PowerPoint)

9. ——————– वतमान डॉयमूट के एक थान से अय डॉयमेूट या वेबसाइट के बीच होने
वाला संपक  ह ।
Answer – d) हाइपरिलंक (Hyperlink)

10. िरय ूिकसी जटेशन को देखने का एक तरीका होता ह ।
Answer – b) गलत (False)

11. ेज टेशन को वेब पेज के प म  िय ूकरने के िलए बटन िरबन म  वेब पेज िय ूकमांड को जोड़ने
की आवयकता होती ह ।
Answer – b) गलत (False)

12. ीन पर िवंडो म  अपने लाइड की िय ूको देखने के िलए िवक एसेस टूलबार पर िलक करके
िंट िय ूको िसलेट करते ह ।
Answer – b) गलत (False)

13. लाइड लेआउट एक लाइड पर टेट तवीरो ंटेबल चाट  और िफम जैसे एिलमट्स की यवथा
को दिशत करता ह ।
Answer – a) सही (True)

14. एिडट के दौरान आउटलाइन टैब आपकी लाइडो ंको थंबनेल के आकार की तवीरो ं के प म
िदखाता ह ।
Answer – b) गलत (False)

15. पावर वॉइंट म  इसट  टैब म  लाइड िडजाइन के िलए टूस होती ह ।
Answer – b) गलत (False)
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ऍम एस पॉवर वॉइंट भाग – 10 (िहंदी म )
1. एमएस पावर वॉइंट म  रेडी टू यजू का तापय ——————- होता ह ।
a) िलप आट (Clip Art)
b) वड आट (Word Art)
c) माट आट (Smart Art)
d) माट िलप (Smart Clip)

2. पावर वॉइंट जटेशन िननिलिखत एलीकेशन ोग ाम का एक िहसा ह ।
a) िलप ऑिफस (Lip Office)
b) टार ऑिफस (Star Office)
c) ओपन ऑिफस (Open Office)
d) एमएस ऑिफस (MS Office)

3. —————– ग ािफक आपकी सचूना और िवचार का दृय जटेशन ह ।
a) वड आट (Word Art)
b) िलप आट (Clip Art)
c) लस िचह (+)
d) इनम  से कोई नहीं

4. —————— का उपयोग कयटूर पर लाइड शो बनाने के िलए िकया जाता ह ।
a) ेज टेशन ग ािफस (Presentation Graphics)
b) एनािलिटकल डेवलपम ट ोग ाम
c) सुपर लाइड पैकेज
d) लाइड मेकर टूस

5. पॉवर वॉइंट ेज टेशन का उपयोग करना बहुत आसान एवं िकसी भी िवषय वतु का ेज टेशन देने के
िलए िकया जाता ह ।
a) सही
b) गलत

6. पॉवर वॉइंट म  िबड इफेट लाइड के कंट ट का एनीमेशन होता ह ।
a) सही
b) गलत

7. केल टू िफट पेपर लाइड को आउटर ेम के साथ िंट करने के िलए इस बॉस को चैक करता ह ।
a) सही
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b) गलत

8. िकनारे पर िथत साइिजंग हडल का उपयोग केवल ऊँचाई और चौड़ाई को संतुिलत करने के िलए
िकया जाता ह ।
a) सही
b) गलत

9. एनीमेशन आपकी लाइड के िलए िवशेष दृय या साउडं इफेट दान करता ह ।
a) सही
b) गलत

10. फाइल को खोलने, सेव करने, िंट करने और बंद करने के िनदशो ंको दिशत करने वाला फाइल
मेन ूकहलाता ह ।
a) सही
b) गलत

11. वड आट  ग ािफक का उपयोग करके मैसेज को भावशाली और आसान ढगं से शीघ तापवूक संचार
कर सकते ह ।
a) सही
b) गलत

12. डॉयमूट म  िकसी टेट को येक बार नए टेट से िरलेस करने के िलए िरलेस ऑल िलक
करते ह ।
a) सही
b) गलत

13. एसडीवी िकये गये आयत के बगल म  और िकनारे और साइिजंग हडल का उपयोग लेसहोडर के
आकार को संतुिलत करने के िलए िकया जाता ह ।
a) सही
b) गलत

14. पावर वॉइंट ेज टेशन म  हम विन िलप का समावेश कर सकते ह ।
a) सही
b) गलत

15. जब आप पावरवॉइंट को टाट  करते ह  तो आप ेजटेशन 1, के नाम से नामल य ूम  एक लक
ेजटेशन देखेते ह ।
a) सही
b) गलत
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Answer Sheet
1. एमएस पावरवॉइंट म  रेडी टू यजू का तापय ——————- होता ह ।
Answer – b) वड आट (Word Art)

2. पावर वॉइंट जटेशन िननिलिखत एलीकेशन ोग ाम का एक िहसा ह ।
Answer – d) एमएस ऑिफस (MS Office)

3. —————– ग ािफक आपकी सचूना और िवचार का दृय जटेशन ह ।
Answer – b) िलप आट (Clip Art)

4. —————— का उपयोग कयटूर पर लाइड शो बनाने के िलए िकया जाता ह ।
Answer – a) ेज टेशन ग ािफस (Presentation Graphics)

5. पॉवर वॉइंट ेज टेशन का उपयोग करना बहुत आसान एवं िकसी भी िवषय वतु का ेज टेशन देने के
िलए िकया जाता ह ।
Answer – a) सही

6. पॉवर वॉइंट म  िबड इफेट लाइड के कंट ट का एनीमेशन होता ह ।
Answer – a) सही

7. केल टू िफट पेपर लाइड को आउटर ेम के साथ िंट करने के िलए इस बॉस को चैक करता ह ।
Answer – a) सही

8. िकनारे पर िथत साइिजंग हेडल का उपयोग केवल ऊँचाई और चौड़ाई को संतुिलत करने के िलए
िकया जाता ह ।
Answer – a) सही

9. एनीमेशन आपकी लाइड के िलए िवशेष दृय या साउडं इफेट दान करता ह ।
Answer – a) सही

10. फाइल को खोलने सेव करने िंट करने और बंद करने के िनदशो ंको दिशत करने वाला फाइल मेनू
कहलाता ह ।
Answer – a) सही

11. वड आट  ग ािफक का उपयोग करके मैसेज काेे भावशाली और आसान ढगं से शीघ तापवूक संचार
कर सकते ह ।
Answer – b) गलत

12. डॉयमूट म  िकसी टेट को येक बार नए टेट से िरलेस करने के िलए िरलेस ऑल िलक

ANKAJ INFOTECH



करते ह ।
Answer – a) सही

13. एसडीवी िकये गये आयत के बगल म  और िकनारे और साइिजंग हेडल का उपयोग लेसहोडर के
आकार को संतुिलत करने के िलए िकया जाता ह ।
Answer – a) सही

14. पावर वॉइंट ेज टेशन म  हम विन िलप का समावेश कर सकते ह ।
Answer – a) सही

15. जब आप पावरवॉइंट को टाट  करते ह  तो आप ेजटेशन 1, के नाम से नामल य ूम  एक लक
ेजटेशन देखेते ह ।
Answer – a) सही
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ऍम एस पॉवर वॉइंट भाग – 11 (िहंदी म )
1. िकसी मौजदूा पॉवर वॉइंट तुतीकरण को खोजने हेतु संित कंुजी योग म  लाई जाती ह ।
a) Ctrl + O
b) Ctrl + P
c) Ctrl + R
d) Shift + Ctrl + N

2. वतमान लाइड को लाइड शो के प म  योग करने हेतु संित कंुजी योग म  लाई जाती ह ।
a) Shift + F5
b) Ctrl + Shift + F5
c) Ctrl + F5
d) उपरोत म  से कोई नहीं

3. पावर वॉइंट तुतीकरण म  युत िकया जा सकता ह  ————— ।
a) हाइपरिलंक (Hyperlink)
b) माट आट (Smart Art)
c) िलप आट (Clip Art)
d) उपरोत सभी (All of Above)

4. विन व संगीत को सुनने हेतु पीकर होता ह ।
a) पदायुत
b) अदायुत
c) A और B दोन
d) उपरोत म  से कोई नहीं

5. पावर वॉइंट को हम ऐसे देख सकते ह ।
a) रंगीन (Color)
b) ग ेकेल (Grayscale)
c) शु वे्त एवं याम रंग  म
d) उपरोत सभी (All of Above)

6. पावर वॉइंट दशन म  कौनसा फाइल ाप नही ंजोड़ा जा सकता ह ।
a) .jpeg
b) .html
c) .gif
d) .wav
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7. कौन सी कंुजीयो के संयोजन से पावर वॉइंट तुतीकरण म  नया लाइड जोड़ा जा सकता ह ।
a) Ctrl + X
b) Ctrl + N
c) Ctrl + M
d) Ctrl + Z

8. एमएस पावर वॉइंट म  रेडी टू यजू का तापय ——————- होता ह ।
a) िलपआट (Clip Art)
b) वडआट (Word Art)
c) माटआट (Smart Art)
d) माटिलप  (Smart Clip)

9. िनन म  से कौनसा ेजेटेशन सॉटवेयर ह ।
a) पावरवॉइंट (PowerPoint)
b) एमएस एसेल (MS Excel)
c) प ट ब स (Paint Brush)
d) एमएस वड (MS Word)

10. एमएस पावर वॉइंट 2010 म  येक लाईड की छोटी ईमेज िनन प म  िदखाई जाती ह ।
a) नॉमल य ू(Normal View)
b) आउट लाइन य ू(Outline View)
c) लाइड सॉटर य ू(Slide Sorter View)
d) लाइड शो य ू(Slide Show View)

11. एमएस पावर वॉइंट 2010 म  लाईड शो देखने के िलए कौनसी शोटकट की यजू होती ह ।
a) F2
b) F5
c) F7
d) F9

12. िनन म  से लाईड शो िकसम  होता ह ।
a) एमएस वड (MS Word)
b) एमएस एसेल (MS Excel)
c) एमएस पावर वॉइंट (MS PowerPoint)
d) एमएस एसेस (MS Access)

13. िकसी माटर लाईड का एलाईमट ह ।
a) बैकग ाउड (Background)
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b) लोगो (Logo)
c) फॉट (Font)
d) उपरोत सभी (All of Above)

14. एमएस पावर वॉइंट 2010 म  टेट पर िनन म  से कौन सा एिनमेशन लाग ूिकया जा सकता ह ।
a) डीससोयू
b) लाइंग (Flying)
c) लेजर टेट (Laser Text)
d) उपरोत सभी (All of Above)

15. िनन म  से कौन सा य ूपावर वॉइंट म  नही ंहोता ह ।
a) नामल य ू(Normal View)
b) लाईड शो य ू(Slide Show View)
c) िट लेआउट य ू(Print Layout View)
d) लाईड शॉटर य ू(Slide Sorter View)

Answer Sheet
1. िकसी मौजदू पॉवर वॉइंट तुतीकरण को खोजने हेतु संित कंुजी योग म  लाई जाती ह ।
Answer – a) Ctrl + O

2. वतमान लाइड को लाइड शो के प म  योग करने हेतु संित कंुजी योग म  लाई जाती ह ।
Answer – a) Shift + F5

3. पावर वॉइंट तुतीकरण म  युत िकया जा सकता ह  ————— ।
Answer – d) उपरोत सभी (All of Above)

4. विन व संगीत को सुनने हेतु पीकर होता ह ।
Answer – a) पदा युत

5. पावर वॉइंट को हम ऐसे देख सकते ह ।
Answer – d) उपरोत सभी (All of Above)

6. पावर वॉइंट दशन म  कौनसा फाइल ाप नही ंजोड़ा जा सकता ह ।
Answer – b) .html

7. कौन सी कंुजीयो के संयोजन से पावर वॉइंट तुतीकरण म  नया लाइड जोड़ा जा सकता ह ।
Answer – c) Ctrl + M

8. एमएस पावर वॉइंट म  रेडी टू यजू का तापय ——————- होता ह ।
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Answer – a) िलप आट (Clip Art)

9. िनन म  से कौनसा ेजेटेशन सॉटवेयर ह ।
Answer – a) पावर वॉइंट (PowerPoint)

10. एमएस पावर वॉइंट 2010 म  येक लाईड की छोटी ईमेज िनन  म  िदखाई जाती ह ।
Answer – c) लाइड सॉटर य ू(Slide Sorter View)

11. एमएस पावर वॉइंट 2010 म  लाईड शो देखने के िलए कौनसी शोटकट की यजू होती ह ।
Answer – b) F5

12. िनन म  से लाईड शो िकसम  होता ह ।
Answer – c) एमएस पावर वॉइंट (MS PowerPoint)

13. िकसी माटर लाईड का Alignment (एलाईमट) ह ।
Answer – d) उपरोत सभी (All of Above)

14. एमएस पावर वॉइंट 2010 म  टेट पर िनन म  से कौन सा एिनमेशन लाग ूिकया जा सकता ह ।
Answer – d) उपरोत सभी (All of Above)

15. िनन म  से कौन सा य ूपावर वॉइंट म  नही ंहोता ह ।
Answer – c) िट लेआउट य ू(Print Layout View)
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ऍम एस पॉवर वॉइंट भाग – 12 (िहंदी म )
1. एमएस पावर वॉइंट म  बने जेटेशन को बाई िडफाट या नाम होता है।
a) SHW-1
b) Slide-1
c) Presentation-1
d) उपरोत म  से कोई नही ं(None of Above)

2. एमएस पावर वॉइंट 2010 का योग िकस काय म  िकया जाता ह ।
a) ेजेटेशन (Presentation)
b) डाटाबेस (Database)
c) एकाउट (Account)
d) ोग ािमंग (Programming)

3. एमएस पावर वॉइंट म  पहली लाईड पर जाने के िलये कौनसी शॉटकट का योग िकया जाता ह ।
a) Ctrl + End
b) Ctrl + Home
c) Shift + Home
d) Shift + End

4. लाईड लेआउट कमाड िकस टैब के अतगत आता ह ।
a) Insert Tab
b) Format Tab
c) Tool Tab
d) View Tab

5. िकसी शेप या िपचर को रोटेट करने के िलये िकस एिनमेशन का यजू िकया जाता ह ।
a) पेन  (Spane)
b) कलर लस (Color Plus)
c) जमू (Zoom)
d) इनम  से कोई नही ं(None of Above)

6. एमएस पावर वॉइंट म  अिधकतम जमू िकतने ितशत हो सकता ह ।
a) 100
b) 200
c) 400
d) 500
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7. ेजेटेशन लाईड के टेट की मेसीमम साईज होती ह ।
a) 72
b) 82
c) 96
d) 90

8. ेजेटेशन लाईड म  साउड का कौनसा कार नही ंहोता ह ।
a) कैमरा (Camera)
b) साइज़ (Size)
c) लॉक (Clock)
d) िरय ू(Review)

9. कौन सी कीज दबाने पर लाइड समात हो जाता ह ।
a) केप की (Esc Key)
b) िशट की (Shift Key)
c) एट + एम (Alt + M)
d) कट ोल + एफ4 (Ctrl + F4)

10. ——————- टेब म  बेिसक फॉरमेिटंग टूस होते ह ।
a) होम (Home)
b) इसट (Insert)
c) य ू(View)
d) पेज लेआउट (Page Layout)

11. ीन के बॉटम पर िथत ————— टैब पर दिशत बटन पर िलक करके ेजेटेशन य ू को
बदल सकते ह ।
a) टाइटल बार (Title Bar)
b) मेय ूबार (Menu Bar)
c) टूल बार (Tool Bar)
d) टेटस बार (Status Bar)

12. एमएस पावर वॉइंट ह ।
a) जीयुआई (GUI)
b) सीयुआई (CUI)
c) एयुआई (AUI)
d) आरबीआई (RBI)

13. िकसी भी लाइड म  िपचर िडले (Display) करने का ऑशन िकस टेब म  होता ह ।

ANKAJ INFOTECH



a) इंसट टेब (Insert Tab)
b) होम टेब (Home Tab)
c) एिनमेशन टेब (Animation Tab)
d) िडजाईन टेब (Design Tab)

14. कौन से टेब ारा पावर वॉइंट म  साउड इंसट  करवा सकते ह ।
a) इंसट टेब (Insert Tab)
b) होम टेब (Home Tab)
c) एिनमेशन टेब (Animation Tab)
d) िडजाईन टेब (Design Tab)

15. िनन म  से कटम एिनमेशन टेब िकस म  होता ह ।
a) माटर लाइड (Master Slide)
b) डीजाइन ट पलेट (Design Template)
c) इनट ांस (Intrans)
d) ट ांिजशन (Transition)

Answer Sheet
1. एमएस पावर वॉइंट म  बने जेटेशन को बाई िडफाट या नाम होता है।
Answer – c) ेजेटेशन 1 (Presentation-1)

2. एमएस पावर वॉइंट 2010 का योग िकस काय म  िकया जाता ह ।
Answer – a) ेजेटेशन (Presentation)

3. एमएस पावर वॉइंट म  पहली लाईड पर जाने के िलये कौनसी शॉटकट का योग िकया जाता ह ।
Answer – b) Ctrl + Home

4. लाईड लेआउट कमाड िकस टैब के अतगत आता ह ।
Answer – a) Insert Tab

5. िकसी शेप या िपचर को रोटेट करने के िलये िकस एिनमेशन का यजू िकया जाता ह ।
Answer – a) पेन (Spane)

6. एमएस पावर वॉइंट म  अिधकतम जमू िकतने ितशत हो सकता ह ।
Answer – c) 400

7. ेजेटेशन लाईड के टेट की मेसीमम साईज होती ह ।
Answer – c) 96
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8. ेजेटेशन लाईड म  साउड का कौनसा कार नही ंहोता ह ।
Answer – d) िरय ू(Review)

9. कौन सी कीज दबाने पर लाइड समात हो जाता ह ।
Answer – a) केप की (Esc Key)

10. ——————- टेब म  बेिसक फॉरमेिटंग टूस होते ह ।
Answer – a) होम (Home)

11. ीन के बॉटम पर िथत ————— टैब पर दिशत बटन पर िलक करके ेजेटेशन ये को
बदल सकते ह ।
Answer – d) टेटस बार (Status Bar)

12. एमएस पावर वॉइंट ह ।
Answer – a) जीयुआई (GUI)

13. िकसी भी लाइड म  िपचर िडले (Display) करने का ऑशन िकस टेब म  होता ह ।
Answer – a) इंसट टेब (Insert Tab)

14. कौन से टेब ारा पावर वॉइंट म  साउड इंसट  करवा सकते ह ।
Answer – c) एिनमेशन टेब (Animation Tab)

15. िनन म  से कटम एिनमेशन टेब िकस म  होता ह ।
Answer – d) ट ांिजशन (Transition)
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ऍम एस पॉवर वॉइंट भाग – 13 (िहंदी म )
1. ————– वातिवक लाइड शो ेज टेशन की तरह सपणू कयटूर ीन पर नजर आता ह ।
a) लाइड सॉटर य ू(Slide Sorter View)
b) नामल य ू (Normal View)
c) लाइड शो य ू(Slide Show View)
d) नोट्स पेज (Notes Page)

2. अपने ेज टेशन को सेव करने के िलए-
a) आप ऑिफस बटन पर िलक कर सेव िसलेट करते ह
b) आप की-बोड शाटकट कट ोल (Ctrl) + एस (S) का उपयोग करते ह
c) A और B दोन
d) इनम  से कोई नहीं

3. िननिलिखत म  से िकस पैकेज को लाइड तुित के िलए युत िकया जाता ह ।
a) एमएस वड (MS Word)
b) एमएस एसेल (MS Excel)
c) एमएस पॉवर वॉइंट (MS PowerPoint)
d) एमएस एसेस (MS Access)

4. ————– वतमान डॉयमूट के एक थान से अय डॉयमूट या वेबसाइट के बीच होने वाला
संपक  ह ।
a) हाइिलंक (Hylink)
b) हाइपोिलंक (Hypolink)
c) िलक ज (Linked)
d) हाइपरिलंक (Hyperlink)

5. ीन के बॉटम पर िथत ————— टैब पर दिशत बटन पर िलक करके ेजेट शन य ू को
बदल सकते ह ।
a) टाइटल बार (Title Bar)
b) मेनु बार (Menu Bar)
c) टूल बार (Tool Bar)
d) टेट्स बार (Status Bar)

6. लाइड शो को कैसे चलाना ह , इसको कट ोल करने वाले टूस ——————- टैब म  होते ह ।
a) िडजाइन (Design)
b) लाइड शो (Slide Show)
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c) य ू(View)
d) िरय ू(Review)

7. पावर वॉइट के तुतीकरण म  ितप (डुलीकेट) लाइड को जोड़ने िलए कौन-कौन सी कीज
को िमलाकर योग करते ह ।
a) Ctrl + X
b) Ctrl + N
c) Ctrl + D
d) Ctrl + Z

8. एक फाईल िजसम  पवूिनधािरत सेिटंस का योग सामाय ेजटेशन (तुतीकरण) डॉयमेूट के
बनाने म  िकया जाता ह  —————— कहलाता ह ।
a) पैटन (Pattern)
b) मॉडल (Model)
c) टेपलेट (Template)
d) ल ूिंट (Blue Print)

9. ‘एमएस पावर वॉइंट’ म  ‘रेडी-टू-यजू’ का तापय —————— होता है।
a) िलप आट (Clip Art)
b) वड आट (Word Art)
c) माट आट (Smart Art)
d) माट िलप (Smart Clip)

10. ‘एमएस पावर वॉइंट 2010’ की फाइल का िडफॉट एसट शन या होता ह ।
a) .पीपीटी (.PPT)
b) .पीपीटीएस (.PPTX)
c) .पीपीएस (.PPX)
d) .पीपीएसएस (.PPSX)

11. लाइड तुित म  िवशेष भाव डालने को —————- कहते ह ।
a) इफेट्स (Effect)
b) कटम एनीमेशन (Custom Animation)
c) ट ांजीशन (Transition)
d) ेज ट एनीमेशन (Present Animation)

12. िननिलिखत म  से िकस पैकेज को लाइड तुित के िलए युत िकया जाता ह ।
a) एमएस वड (MS Word)
b) एमएस एसेल (MS Excel)
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c) एमएस पावर वॉइंट (MS PowerPoint)
d) एमएस एसेस (MS Access)

13. माइोसॉट पावर वॉइंट 2010 ोग ाम म  आपको फाइल —————– एसट शन म  संग िहत
होती ह ।
a) .पीएसडी (.PSD)
b) .आरटीएफ (.RTF)
c) .पीपीटीएस (.PPTX)
d) .डीऑसीएस (.DOXIX)

14. —————– एक िवशेष लाइड ह , जो ेज टेशन की सभी लाइडो ंके िलए टाइटल और टेट
के फॉमट एवं वप को िनयंित करती ह ।
a) होम लाइड (Home Slide)
b) माटर लाइड (Master Slide)
c) A और B दोन (Both)
d) इनम  को कोई नही ं(None of Above)

15. पावर वॉइंट तुतीकरण म  हाइपरिलंक को डालने के िलए संित कंुजी योग म  लाई जाती ह ।
a) Ctrl + K
b) Ctrl + J
c) Ctrl + M
d) Shift + Ctrl + Z

Answer Sheet
1. ————– वातिवक लाइड शो ेज टेशन की तरह सपणू कयटूर ीन पर नजर आता ह ।
Answer – c) लाइड शो य ू(Slide Show View)

2. अपने ेज टेशन को सेव करने के िलए-
Answer – c) A और B दोन (Both)

3. िननिलिखत म  से िकस पैकेज को लाइड तुित के िलए युत िकया जाता ह ।
Answer – c) एमएस पॉवर वॉइंट (MS PowerPoint)

4. ————– वतमान डॉयमूट के एक थान से अय डॉयमूट या वेबसाइट के बीच होने वाला
संपक  ह ।
Answer – d) हाइपरिलंक (Hyperlink)

5. ीन के बॉटम पर िथत ————— टैब पर दिशत बटन पर िलक करके ेजेट शन य ू को
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बदल सकते ह ।
Answer – d) टेट्स बार (Status Bar)

6. लाइड शो को कैसे चलाना ह , इसको कट ोल करने वाले टूस ——————- टैब म  होते ह ।
Answer – b) लाइड शो (Slide Show)

7. पावर वॉइट के तुतीकरण म  ितप (डुलीकेट) लाइड को जोड़ने िलए कौन-कौन सी कीज
को िमलाकर योग करते ह ।
Answer – c) Ctrl + D

8. एक फाईल िजसम  पवूिनधािरत सेिटंस का योग सामाय ेजटेशन (तुतीकरण) डॉयमेूट के
बनाने म  िकया जाता ह  —————— कहलाता ह ।
Answer – c) टेपलेट (Template)

9. ‘एमएस पावर वॉइंट’ म  ‘रेडी-टू-यजू’ का तापय —————— होता है।
Answer – b) वड आट (Word Art)

10. ‘एमएस पावर वॉइंट 2010’ की फाइल का िडफॉट एसट शन या होता ह ।
Answer – b) .पीपीटीएस (.PPTX)

11. लाइड तुित म  िवशेष भाव डालने को —————- कहते ह ।
Answer – b) कटम एनीमेशन (Custom Animation)

12. िननिलिखत म  से िकस पैकेज को लाइड तुित के िलए युत िकया जाता ह ।
Answer – c) एमएस पावर वॉइंट (MS PowerPoint)

13. माइोसॉट पावर वॉइंट 2010 ोग ाम म  आपको फाइल —————– एसट शन म  संग िहत
होती ह ।
Answer – c) .पीपीटीएस (.PPTX)

14. —————– एक िवशेष लाइड ह , जो ेज टेशन की सभी लाइडो ंके िलए टाईिटल और टेट
के फॉमट एवं वप को िनयंित करती ह ।
Answer – b) माटर लाइड (Master Slide)

15. पावर वॉइंट तुतीकरण म  हाइपरिलं क को डालने के िलए संित कंुजी योग म  लाई जाती
ह ।
Answer – a) Ctrl + K
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ऍम एस पॉवर वॉइंट भाग – 14 (िहंदी म )
1. PowerPoint दशन म  कौन-सा फाइल फॉरमेट जोड़ा जा सकता ह ।
a) .jpg
b) .giv
c) .wav
d) All of the above

2. Microsoft PowerPoint म  दो कार की Sound Effects Files िजह  Presentation
म  जोड़ा जा सकता ह ।
a) .wav files and .mid files
b) .wav files and .giv files
c) .wav files and .jpg files
d) .jpg files and .gif files

3. text तथा number को रखने वाला सबसे अछा उपिथत Material ह ।
a) A table slider
b) A bullet slide
c) A title slider
d) All of the above

4. Motion path या ह ।
a) A type of animation entrance effect
b) A method of advancing slides
c) A method of moving items on a slide
d) All of the above

5. slide-title master pair या ह ।
a) The title area text area of a specific slide
b) A slide master and title master merged in to a slide
c) A slide master and title master for a specific design template
d) All of above

6. यिद आप Presentation म  सभी Slide को एक जैसा िदखाना चाहते ह , िननिलिखत म  से िकसे
योग कर गे।
a) The Slide Layout Option
b) Add a slide option
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c) Outline view
d) A presentation design template

7. चलिच के संदभ म , Trigger या ह ।
a) An action button that advances to the next slide
b) An item in the slide that performs an action when clicked
c) The name of a motion part
d) All of the above

8. यिद आप एक पॉवर पॉइंट ेजेटेशन बनाकर िकसी को भेजना चाहते हो तो आपको अपनी ईमेल म
चुनना पड़ेगा।
a) Inclusion
b) Attachment
c) Replay
d) Forward

9. एक चाट  को म म  संशोिधत करने के िलए आप कर सकते ह ।
a) Triple click the chart object
b) Click and drag the chart object
c) Double click the chart object
d) Click the chart object

10. PowerPoint को बद करने के िलए-
a) Click the application minimize button
b) Click the document close button
c) Press Alt + F4
d) Double click the document control menu icon

11. कटम एनीमेशन टाक पेन का योग करके मोशन पाथ इफेट को देखने के िलये आप या करेग ।
a) Click the play button
b) Click the show effect button
c) Double click the motion part
d) All of above

12. —————– को छोड़कर िननिलिखत सभी के ारा आप नई presentation बना सकते ह ।
a) Clicking the new button on the standard toolbar
b) Clicking file, new
c) Clicking file open
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d) Pressing Ctrl + N

13. आप एक Slide म  एक MS-Organization Chart को —————— के ारा जोड़ सकते
ह ।
a) Clicking the object command on the edit menu
b) Clicking the insert new slide button the standard toolbar, than double click the
organization chart button on the formatting toolbar
c) Clicking the ms-organization chart button on the standard toolbar
d) All of the above

14. एक Slide presentation के दौरान एक के बाद एक Hyperlink को Select करने के िलए
आप या Press कर गे।
a) Tab
b) Ctrl + K
c) Ctrl + H
d) All of the above

15. एक  Presentation  म  Slide  को  Introduce  करने के िलए योग होने वाला  special
effects  कहलाता ह ।
a) Effects
b) Custom animation
c) Transitions
d) Present animations

Answer Sheet
1. PowerPoint दशन म  कौन-सा फाइल फॉरमेट जोड़ा जा सकता ह ।
Answer – d) All of the above

2. Microsoft PowerPoint म  दो कार की Sound Effects Files िजह  Presentation
म  जोड़ा जा सकता ह ।
Answer – a) .wav files and .mid files

3. text तथा number को रखने वाला सबसे अछा उपिथत Material ह ।
Answer – a) A table slider

4. Motion path या ह ।
Answer – c) A method of moving items on a slide
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5. slide-title master pair या ह ।
Answer – c) A slide master and title master for a specific design template

6. यिद आप Presentation म  सभी Slide को एक जैसा िदखाना चाहते ह , िननिलिखत म  से िकसे
योग कर गे।
Answer – d) A presentation design template

7. चलिच के संदभ म , Trigger या ह ।
Answer – b) An item in the slide that performs an action when clicked

8. यिद आप एक पॉवर पॉइंट ेजेटेशन बनाकर िकसी को भेजना चाहते हो तो आपको अपनी ईमेल म
चुनना पड़ेगा।
Answer – b) Attachment

9. एक चाट  को म म  संशोिधत करने के िलए आप कर सकते ह ।
Answer – c) Double click the chart object

10. PowerPoint को बद करने के िलए-
Answer – c) Press Alt + F4

11. कटम एनीमेशन टाक पेन का योग करके मोशन पाथ इफेट को देखने के िलये आप या करेग ।
Answer – a) Click the play button

12. —————– को छोड़कर िननिलिखत सभी के ारा आप नई presentation बना सकते ह ।
Answer – c) Clicking file open

13. आप एक Slide म  एक MS-Organization Chart को —————— के ारा जोड़ सकते
ह ।
Answer – a) Clicking the object command on the edit menu

14. एक Slide presentation के दौरान एक के बाद एक Hyperlink को Select करने के िलए
आप या Press कर गे।
Answer – a) Tab

15. एक  Presentation  म  Slide  को  Introduce  करने के िलए योग होने वाला  special
effects  कहलाता ह ।
Answer – c) Transitions
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ऍम एस पॉवर वॉइंट भाग – 15 (िहंदी म )
1. आप  Embedded Organization चाट  ऑजैट को —————— के ारा संशोिधत कर
सकते ह ।
a) Clicking edit object
b) Double clicking the organization chart object
c) Right clicking the chart object, than clicking edit MS-Organization chart object
d) a and b both

2. माउस की लेट की को दबाकर उसे लाइड पर घुमाने को या कहते ह ।
a) Highlighting
b) Dragging
c) Selecting
d) Moving

3. Ctrl + G —————- के िलये योग होता ह ।
a) Grids and Guides
b) Group Object
c) Both a and b
d) None

4. आप सभी  Slides  म  back ground िच जोड़ने के ारा  uniform appearance कैसे
बनाते ह ।
a) Create a template
b) Edit the slide master
c) Use the autocorrect wizard
d) All of the above

5. आप  Speaker  note  page  कैसे बनाते ह  जो  slider,  संबिधत  Notes,  तथा आपकी
Company  के  Logo  को येक पेज पर िदखाता ह ।
a) Edit the notes master and add your company log
b) Edit the slide master and insert your company logo and notes pane
c) Edit the handout master to include your company logo and one slide per page
with additional note space
d) All of the above

6.  Custom  animation  task  pane  पर कौन-सा िवकप आपको  Custom  या  preset
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motion  part  को लाग ू करने की अनुमित देता ह ।
a) Add effect
b) Emphasis
c) Animate Now
d) All of the above

7. िलप आट  म  फेस की िदशा बदलने के िलये िकस टम का योग करते ह ।
a) Group
b) Flip
c) Rotate
d) All of the above

8. Slide जो एक Topic को Introduce करने तथा presentation के िलए tone set करने के
िलए योग होती ह  —————– कहलाती ह ।
a) Table Slider
b) Graph Slider
c) Bullet Slider
d) Title slider

9. िननिलिखत फीचस म  से िकसे आप Notes text box म  िलखते समय योग करते ह ।
a) Slider Show
b) Insert
c) Slider Master
d) Zoom

10. कौन-सा िवकप आपको Line, Curve, Freeform या Scribble tools का चयन करने की
अनुमित देता ह ।
a) Create effect
b) Insert motion path
c) Draw custom path
d) All of the above

11. िननिलिखत म  से िकसका योग होना चािहए जब आप एक उपिथत Presentation म  नई
Slide जोड़ना चाहते ह ।
a) File, Add a new slide
b) Insert, new slide
c) File Open
d) File, New
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12. Organization Chart Object का आकार –
a) Is determined by the presentation design and not be changed
b) Is determined by the presentation design but can be changed in PowerPoint
c) Is dependent on the amount of text within the Organization chart
d) b and c

13. िननिलिखत म  से कौन PowerPoint म  Slide की िडफॉट पेज सैटअप ओिरयनटेशन ह ।
a) Vertical
b) Landscape
c) Portrait
d) None of the above

14. पावर पॉइट फोटो एबम के लाइड शो को लगातार चलाने के िलये-
a) Use Random Slide transitions
b) Launch an online broadcast
c) Loop continuously
d) All of the above

15. Handout Master के ारा या पता चलता ह ।
a) Slide Formatting
b) Layout of audience handout notes
c) Handout content formatting for Microsoft word export
d) All of above

Answer Sheet
1. आप  Embedded Organization चाट  ऑजैट को —————— के ारा संशोिधत कर
सकते ह ।
Answer – d) a and b both

2. माउस की लेट की को दबाकर उसे लाइड पर घुमाने को या कहते ह ।
Answer – b) Dragging

3. Ctrl + G —————- के िलये योग होता ह ।
Answer – a) Grids and Guides

4. आप सभी  Slides  म  back ground िच जोड़ने के ारा  uniform appearance कैसे
बनाते ह ।
Answer – b) Edit the slide master

ANKAJ INFOTECH



5. आप  Speaker  note  page  कैसे बनाते ह  जो  slider,  संबिधत  Notes,  तथा आपकी
Company  के  Logo  को येक पेज पर िदखाता ह ।
Answer – a) Edit the notes master and add your company log

6.  Custom  animation  task  pane  पर कौन-सा िवकप आपको  Custom  या  preset
motion  part  को लाग ू करने की अनुमित देता ह ।
Answer – a) Add effect

7. िलप आट  म  फेस की िदशा बदलने के िलये िकस टम का योग करते ह ।
Answer – c) Rotate

8. Slide जो एक Topic को Introduce करने तथा presentation के िलए tone set करने के
िलए योग होती ह  —————– कहलाती ह ।
Answer – d) Title slider

9. िननिलिखत फीचस म  से िकसे आप Notes text box म  िलखते समय योग करते ह ।
Answer – d) Zoom

10. कौन-सा िवकप आपको Line, Curve, Freeform या Scribble tools का चयन करने की
अनुमित देता ह ।
Answer – c) Draw custom path

11. िननिलिखत म  से िकसका योग होना चािहए जब आप एक उपिथत Presentation म  नई
Slide जोड़ना चाहते ह ।
Answer – b) Insert, new slide

12. Organization Chart Object का आकार –
Answer – d) b and c

13. िननिलिखत म  से कौन PowerPoint म  Slide की िडफॉट पेज सैटअप ओिरयनटेशन ह ।
Answer – b) Landscape

14. पावर पॉइट फोटो एबम के लाइड शो को लगातार चलाने के िलये-
Answer – d) All of the above

15. Handout Master के ारा या पता चलता ह ।
Answer – b) Layout of audience handout notes
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ऍम एस पॉवर वॉइंट भाग – 16 (िहंदी म )
1. िननिलिखत म  से कौनसा टूल आपको  Standard Placeholders का योग िकये िबना एक
slide म  text जोड़ने के लायक बनाता ह ।
a) Text tool box
b) Line tool
c) Drawing tool
d) Auto shapes tool

2. Notes Master View म , आप एक ेजेटेशन के सभी नोट्स के टेट के फॉट के साइज को
कैसे पांतरित करते ह ।
a) Modify the slide design
b) Modify the notes master layout
c) Modify the text within the body placeholder
d) All of the above

3. वचािलत प से, येक लाइड पर आप लोगो ं को एक ही िथित म  चाहते ह । इसे
—————— पर  Insert  कर ।
a) Handout Master
b) Notes Master
c) Slide Master
d) All of the above

4. िननिलिखत म  से कौनसा views योग के िलए सबसे अछा ह  जब एक Presentation म
सभी slides के िलए transition effects सेट करते ह ।
a) Slide Sorter view
b) Notes pages view
c) Slide view
d) Outline view

5. Slide पर ऑजेट जो text को रखता ह  —————- कहलाता ह ।
a) Placeholders
b) Object Holder
c) Auto Layout
d) Text Holders

6. िनन म  से कौन िंिटंग पेज पर लघु लाइड के साथ ििटंग आउट फीचर का एक साधन दान
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करती ह ।
a) Slide With Animation
b) Outline view
c) Notes page
d) Audience handout

7. कौनसी Command आपको आपकी Presentation म  first slide पर लाता ह ।
a) Next Slide Button
b) Page Up
c) Ctrl/Home
d) Ctrl + End

8.  —————  Outlook  के साथ म  एक  Online  सचइंजन ह  जो आपको  topic  पर
Information  दान करता ह ।
a) Bing
b) Google
c) Outlook Help
d) Yahoo!

9. माटर य ूम  िडलीट हुए फुटर लेस होडर को आप पुन : थािपत कैसे कर सकते ह ।
a) Create a new slide master
b) Re-apply the footer placeholder
c) Re-Apply the slide layout
d) All of the above

10. िननिलिखत म  से िकसे आप एक Presentation म  Slide पर समय को जोड़ने के िलए योग
कर सकते ह ।
a) Slide show menu
b) Rehearse timings button
c) Slide transition button
d) All of the above

11. एक Organization चाट  के सभी बॉस का चयन करने के िलए-
a) Clicking and edit select all
b) Right click the chart background and then click select all
c) Press and hold the shift key and click each box
d) All of above
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12. —————– के ारा आप Side show के दौरान शाटकट मैय ूको Show कर सकते ह ।
a) Clicking the shortcut button on the formatting toolbar
b) Right clicking the current side
c) Clicking an icon on the current slide
d) a and b

13. आप आउटलुक म  ————– बदलकर आइटमस ्को कटमाइज कर सकते ह ।
a) Look
b) Appearance
c) Interface
d) View

14. एक organization chart के बॉस के साथ म  Text को संशोिधत करने के िलए आप-
a) Select the box and text, then make changes
b) Select the box, than make the changes
c) Highlight the text, then make the changes
d) a and b both

15. िननिलिखत म  से कौन आपको  Presentation म  एक से अिधक  Slide का चयन करने की
अनुमित देता ह ।
a) Alt + Click each slide
b) Shift + drag each slide
c) Shift + click each slide
d) Ctrl + click each slide

Answer Sheet
1. िननिलिखत म  से कौनसा टूल आपको  Standard Placeholders का योग िकये िबना एक
slide म  text जोड़ने के लायक बनाता ह ।
Answer – a) Text tool box

2. Notes Master View म , आप एक ेजेटेशन के सभी नोट्स के टैट के फॉट के साइज को
कैसे पांतरित करते ह ।
Answer – c) Modify the text within the body placeholder

3. वचािलत प से, येक लाइड पर आप लोगो ं को एक ही िथित म  चाहते ह । इसे
—————— पर  Insert  कर ।
Answer – c) Slide Master
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4. िननिलिखत म  से कौनसा views योग के िलए सबसे अछा ह  जब एक Presentation म
सभी slides के िलए transition effects सैट करते ह ।
Answer – a) Slide Sorter view

5. Slide पर ऑजैट जो text को रखता ह  —————- कहलाता ह ।
Answer – a) Placeholders

6. िनन म  से कौन िंिटंग पेज पर लघु लाइड के साथ ििटंग आउट फीचर का एक साधन दान
करती ह ।
Answer – d) Audience handout

7. कौनसी Command आपको आपकी Presentation म  first slide पर लाता ह ।
Answer – c) Ctrl/Home

8.  —————  Outlook  के साथ म  एक  Online  सचइंजन ह  जो आपको  topic  पर
Information  दान करता ह ।
Answer – c) Outlook Help

9. माटर य ूम  िडलीट हुए फुटर लेस होडर को आप पुन : थािपत कैसे कर सकते ह ।
Answer – b) Re-apply the footer placeholder

10. िननिलिखत म  से िकसे आप एक Presentation म  Slide पर समय को जोड़ने के िलए योग
कर सकते ह ।
Answer – b) Rehearse timings button

11. एक Organization चाट  के सभी बॉस का चयन करने के िलए-
Answer – c) Press and hold the shift key and click each box

12. —————– के ारा आप Side show के दौरान शाटकट मैय ूको Show कर सकते ह ।
Answer – b) Right clicking the current side

13. आप आउटलुक म  ————– बदलकर आइटमस ्को कटमाइज कर सकते ह ।
Answer – d) View

14. एक organization chart के बॉस के साथ म  Text को संशोिधत करने के िलए आप-
Answer – a) Select the box and text, then make changes

15. िननिलिखत म  से कौन आपको  Presentation म  एक से अिधक  Slide का चयन करने की
अनुमित देता ह ।
Answer – c) Shift + click each slide
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ऍम एस पॉवर वॉइंट भाग – 17 (िहंदी म )
1. view जो Slides को presentation म  slides की miniature representation के प
म  दिशत करता ह  —————– कहलाता ह । 
a) Slide show
b) Slide sorter view
c) Notes page view
d) Outline view
2. PowerPoint view जो केवल text (title तथा bullets) को दिशत करता ह । 
a) Slide Show
b) Slide Sorter view
c) Notes page view
d) Outline view
3. िकसी शो म  MS Power Point की एक लाइड को दसूरे म  बदलने को —————- कहते ह । 
a) Animation
b) Slide transition
c) Custom animation
d) Preset animation
4. िननिलिखत  Presentation elements म  से िकसे आप  Slide master का योग करके
संशोिधत कर सकते ह । 
a) Slide comments
b) Slide transitions
c) Speaker note font and color
d) All of the above
5. िननिलिखत म  से कौन आपकी presentation की printed ितिलिप दान करता ह । 
a) Outline
b) Sparker notes
c) Audience handouts
d) All of the above
6.  presentation को उपलध होने वाले  Slide  Show िवकप म  —————– को छोड़कर
िननिलिखत सभी होते ह । 
a) Transitions command
b) Speaker notes command
c) Meeting reminder command
d) Navigation command
7. ेजटेशन िडजाइस म  लाइड की फॉम िटंग व लेआउट को रेगुलेट करने को सामायत : कहते ह । 
a) Design plates
b) Templates
c) Placeholders
d) Blueprints
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8. अकेली लाइड या सपणू ेजटेशन को िंट करने के िलए िनन म  से िकसका योग होता ह । 
a) Help
b) The Print Button
c) Print
d) Recent
9. अपने handout म  हैडर या फुटर जोड़ने के िलए, आप योग कर सकते ह । 
a) The title master
b) The slide master
c) The handout master
d) All of the above
10. िनन म  से या Slide Show View म  लाइड को एडवास नही ंकरता। 
a) Esc key
b) The spacebar
c) The enter key
d) The mouse button
11. lines, curve, freeform तथा scribble या ह । 
a) Emphasis effects that can be applied to animations
b) Types of custom motion paths
c) Predefined entrance and exit effects
d) All of the above
12. Presentation पर comments िरकॉड कर सकते ह  िजसने उह  िलखा था और जब वे जोड़े
गये थे। PowerPoint 2003 म  automatic way या ह । 
a) Use online collaboration
b) Use comments
c) Use the notes page
d) All of the above
13. Microsoft PowerPoint म  एक Screen पर सभी slides को एक म म  देखने के िलए
योग करते ह । 
a) View, slide sorter
b) View, slide
c) View, master
d) View, slide show
14. आपकी PowerPoint 2002 Presentation के िलए चलिच खोजने का सबसे अछा थान
या ह । 
a) Microsoft online
b) Word clipart
c) PowerPoint tools and ins
d) All of the above
15. Slides पर पिरण के िलए Varied animation को लाग ूकरन  का आसान राता या ह । 
a) Apply effects in the custom animation text pane
b) Apply an animation scheme
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c) Customize bullets with animated clipart
d) All of above

Answer Sheet
1. view जो Slides को presentation म  slides की miniature representation के प
म  दिशत करता ह  —————– कहलाता ह । 
Answer – b) Slide sorter view
2. PowerPoint view जो केवल text (title तथा bullets) को दिशत करता ह । 
Answer – d) Outline view
3. िकसी शो म  MS Power Point की एक लाइड को दसूरे म  बदलने को —————- कहते ह । 
Answer – b) Slide transition
4. िननिलिखत  Presentation elements म  से िकसे आप  Slide master का योग करके
संशोिधत कर सकते ह । 
Answer – b) Slide transitions
5. िननिलिखत म  से कौन आपकी presentation की printed ितिलिप दान करता ह । 
Answer – c) Audience handouts
6.  presentation को उपलध होने वाले  Slide  Show िवकप म  —————– को छोड़कर
िननिलिखत सभी होते ह । 
Answer – a) Transitions command
7. ेजटेशन िडजाइस म  लाइड की फॉम िटंग व लेआउट को रेगुलेट करने को सामायत : कहते ह । 
Answer – b) Templates
8. अकेली लाइड या सपणू ेजटेशन को िंट करने के िलए िनन म  से िकसका योग होता ह । 
Answer – c) Print
9. अपने handout म  हैडर या फुटर जोड़ने के िलए, आप योग कर सकते ह । 
Answer – c) The handout master
10. िनन म  से या Slide Show View म  लाइड को एडवास नही ंकरता। 
Answer – a) Esc key
11. lines, curve, freeform तथा scribble या ह । 
Answer – b) Types of custom motion paths
12. Presentation पर comments िरकॉड कर सकते ह  िजसने उह  िलखा था और जब वे जोड़े
गये थे। PowerPoint 2003 म  automatic way या ह । 
Answer – b) Use comments
13. Microsoft PowerPoint म  एक Screen पर सभी slides को एक म म  देखने के िलए
योग करते ह । 
Answer – a) View, slide sorter
14. आपकी PowerPoint 2002 Presentation के िलए चलिच खोजने का सबसे अछा थान
या ह । 
Answer – b) Word clipart
15. Slides पर पिरण के िलए Varied animation को लाग ूकरन  का आसान राता या ह । 
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Answer – b) Apply an animation scheme
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ऍम एस पॉवर वॉइंट भाग – 18 (िहंदी म )
1. Cell या होती ह ।
a) The intersection of a column and a row
b) An input box
c) A rectangular marker
d) All of the above

2. िननिलिखत म  से कौन सबसे अछी Serifs की याया करता ह ।
a) Serifs on characters help to differentiate between similar looking letter
b) Serifs fonts are best for viewing test at a distance
c) Serifs are fine cross stokes that appear at the bottom and top of a letter
d) Serifs font are very simple in appearance

3. जब आप केद  के समानातर रखते हुए िकसी आजेट को रीसाइज करना चाहते ह  तो माउस के
साथ िननिलिखत म  से िकसका योग होना चािहये।
a) The space bar
b) The alt key
c) The ctrl key
d) The shift key

4. जब आप एक Perfect Shape बनाना चाहते ह  तो िननिलिखत म  से िकसका योग माउस के
साथ करना चािहए।
a) The spacebar
b) The alt key
c) The ctrl key
d) The shift key

5. एक वग बनाते समय यिद आप माउस िलक को Shift से पहले छोड़ देते ह  तो या होता ह ।
a) The square will not be a perfect square
b) The square will not be at the center of the slide
c) The square will be smaller
d) The square will be larger

6. चाट  के िकस पाट  म  डाटाशीट म  एटर होने वाली वैय ूिदखाई देती ह ।
a) The little area
b) The legend
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c) The y-axis
d) The x-axis

7. एक चाट  को संशोिधत करने के संबंध म , आप कर सकते ह ।
a) Triple click the chart object
b) Click and drag the chart object
c) Double click the chart object
d) Click the chart objects

8. जब एक िच चयिनत होता ह , यह िननिलिखत म  से िकसे दिशत करता ह ।
a) Two corner handles
b) Six middle handles
c) Eight sizing handles
d) Six boxes

9. Microsoft PowerPoint म  अिधकतम Zoom करने का ितशत ——————- ह ।
a) 100%
b) 200%
c) 400%
d) 500%

10. PowerPoint 2000 —————– Views रखता ह ।
a) 3
b) 4
c) 5
d) 6

11. एनीमेशन इफेट अनुमित दान करता ह ।
a) Add clip art images to your slides
b) Create a custom transition to the next slide
c) Show bullet items as they are discussed
d) None of above

12. िनन म  से कौन-सा Feature येक Slide को िबना Manually आगे बढ़ाए Slide Show
म  Slide देखने की अनुमित देता ह ।
a) Adding build effects
b) Setting slide times
c) Adding transitions
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d) All of these

13. Presentation म  Animation Schemes —————- पर लाग ूहो सकती ह ।
a) All slides
b) Select slides
c) Current slide
d) All of the above

14. िननिलिखत फीचर म  से कौन आपको एक से अिधक Slide का Slide sorter view म  चयन
करने की अनुमित देता ह ।
a) Alt + Click each slide
b) Shift + drag each slide
c) Shift + Click each slide
d) Ctrl + click each slide

15. एक बात जो common tasks button आपको करने की अनुमित देता ह ।
a) Apply a design template to a slide
b) Insert a new slide
c) Choose a new layout for a slide
d) All of above

Answer Sheet
1. Cell या होती ह ।
Answer – a) The intersection of a column and a row

2. िननिलिखत म  से कौन सबसे अछी Serifs की याया करता ह ।
Answer – c) Serifs are fine cross stokes that appear at the bottom and top of a
letter

3. जब आप केद  के समानातर रखते हुए िकसी आजेट को रीसाइज करना चाहते ह  तो माउस के
साथ िननिलिखत म  से िकसका योग होना चािहये।
Answer – c) The ctrl key

4. जब आप एक Perfect Shape बनाना चाहते ह  तो िननिलिखत म  से िकसका योग माउस के
साथ करना चािहए।
Answer – d) The shift key

5. एक वग बनाते समय यिद आप माउस िलक को Shift से पहले छोड़ देते ह  तो या होता ह ।
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Answer – a) The square will not be a perfect square

6. चाट  के िकस पाट  म  डाटाशीट म  एटर होने वाली वैय ूिदखाई देती ह ।
Answer – c) The y-axis

7. एक चाट  को संशोिधत करने के संबंध म , आप कर सकते ह ।
Answer – c) Double click the chart object

8. जब एक िच चयिनत होता ह , यह िननिलिखत म  से िकसे दिशत करता ह ।
Answer – c) Eight sizing handles

9. Microsoft PowerPoint म  अिधकतम Zoom करने का ितशत ——————- ह ।
Answer – c) 400%

10. PowerPoint 2000 —————– Views रखता ह ।
Answer – a) 3

11. एनीमेशन इफेट अनुमित दान करता ह ।
Answer – c) Show bullet items as they are discussed

12. िनन म  से कौन-सा Feature येक Slide को िबना Manually आगे बढ़ाए Slide Show
म  Slide देखने की अनुमित देता ह ।
Answer – b) Setting slide times

13. Presentation म  Animation Schemes —————- पर लाग ूहो सकती ह ।
Answer – d) All of the above

14. िननिलिखत फीचर म  से कौन आपको एक से अिधक Slide का Slide sorter view म  चयन
करने की अनुमित देता ह ।
Answer – c) Shift + Click each slide

15. एक बात जो common tasks button आपको करने की अनुमित देता ह ।
Answer – d) All of above
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ऍम एस पॉवर वॉइंट भाग – 19 (िहंदी म )
1. एक अछा िडजाइन —————– ारा िनधािरत होता ह ।
a) Credibility
b) Readability
c) First Impression
d) All of the above

2. यिद आप ेजेटेशन की िकसी एक लाइड को दसूरी लाइड से अलग िडजाइन टेपलेट देना
चाहते ह  तो आप या कर गे।
a) Select the slides thumbnails in that section, and apply a different color scheme.
b) Select the slide thumbnails in tin that section and apply a different design
template.
c) Select one of the slide in the section you want to change, customize the fonts
and colors, and use the format painter tool to apply those styles to the other slides
in the section
d) All of the above

3. Line Spacing दशाता ह ।
a) The space between the lines of text
b) The height of the line
c) The length of the line
d) a and c

4. िननिलिखत म  से कौन गलत  Spelling को दशाने के िलए  Spelling तथा  grammar का
feature योग करता ह ।
a) The incorrect word appears in all capital letters
b) The incorrect word has a wavy red line under it
c) The incorrect word appears italicized
d) The incorrect word appears bold

5. िननिलिखत सभी के िलए Placeholders रखता ह ।
a) Slide number
b) Title
c) Footer
d) Header
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6. लाइड के बैकग ाउडं म  िदखने वाली शेप म  ट ां सी के अंश कैसे सेट करते ह ।
a) Use #D style 4 button on the drawing toolbar
b) Use the set transparent color button on the picture toolbar
c) Use the transparency slider in the format auto shapes dialog box
d) All of above

7. कौन-सा pane, outlook म  चयिनत item के content को दिशत करता ह ।
a) People pane
b) Folder pane
c) Navigation pane
d) Reading pane

8. Microsoft clip gallery आपको …………….. करने अनुमित देता ह ।
a) Add word art image to a slide
b) Spell check your presentation
c) Add clip art images to a slide or slide
d) Add slide to a presentation

9. जब अनेक चयिनत आजेट्स को डीलीट करना हो तो कौन सी कमांड सभी ऑजेट का चयन
करती ह ।
a) Alt + a
b) Ctrl + a
c) Edit, select all
d) Both b & c

10. Table के Column की चौड़ाई को समायोिजत करने के िलए, आप –
a) Click table menu. Column width, then make adjustments
b) Drag the vertical gridline between two columns
c) Drag the column markers on the table rule bar
d) Both b & c

11. Table म  एक नई पंित जोड़ने के िलए आप कर गे।
a) Click the insert rows command on the insert menu
b) Press the enter key
c) Click the insert rows button on the standard toolbar
d) None of the above

12. —————- का उपयोग करके एक िलप आट  छिव को लाइड के िवशेष थान पर ले जाने के
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बाद आप तुरंत िरवस कर सकते ह ।
a) Click the not be move object command on the edit menu
b) Click on the undo button
c) Click on redo button
d) All of the above

13. आप एक Embedded table object को —————– के ारा संशोिधत कर सकते ह ।
a) Clicking the edit sub command of the document object command on the edit
menu
b) Double clicking the table object
c) Right clicking the table object, then clicking edit document on the edit menu
d) All of above

14. Outlook इटरफेस िविभन —————– का बना होता ह ।
a) Tabs
b) Groupings
c) Windows
d) Panes

15. Mail, Calendar, People और Task के बीच म  कौन सा पैन िविचंग करता ह ।
a) People pane
b) Folder pane
c) Navigation pane
d) Reading pane

Answer Sheet
1. एक अछा िडजाइन —————– ारा िनधािरत होता ह ।
Answer – d) All of the above

2. यिद आप ेजेटेशन की िकसी एक लाइड को दसूरी लाइड से अलग िडजाइन टेपलेट देना
चाहते ह  तो आप या कर गे।
Answer – b) Select the slide thumbnails in tin that section and apply a different
design template.

3. Line Spacing दशाता ह ।
Answer – a) The space between the lines of text

4. िननिलिखत म  से कौन गलत  Spelling को दशाने के िलए  Spelling तथा  grammar का
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feature योग करता ह ।
Answer – b) The incorrect word has a wavy red line under it

5. िननिलिखत सभी के िलए Placeholders रखता ह ।
Answer – b) Title

6. लाइड के बैकग ाउडं म  िदखने वाली शेप म  ट ां सी के अंश कैसे सेट करते ह ।
Answer – c) Use the transparency slider in the format auto shapes dialog box

7. कौन-सा pane, outlook म  चयिनत item के content को दिशत करता ह ।
Answer – d) Reading pane

8. Microsoft clip gallery आपको …………….. करने अनुमित देता ह ।
Answer – c) Add clip art images to a slide or slide

9. जब अनेक चयिनत आजेट्स को डीलीट करना हो तो कौन सी कमांड सभी ऑजेट का चयन
करती ह ।
Answer – d) Both b & c

10. Table के Column की चौड़ाई को समायोिजत करने के िलए, आप –
Answer – d) Both b & c

11. Table म  एक नई पंित जोड़ने के िलए आप कर गे।
Answer – d) None of the above

12. —————- का उपयोग करके एक िलप आट  छिव को लाइड के िवशेष थान पर ले जाने के
बाद आप तुरंत िरवस कर सकते ह ।
Answer – b) Click on the undo button

13. आप एक Embedded table object को —————– के ारा संशोिधत कर सकते ह ।
Answer – d) All of above

14. Outlook इटरफेस िविभन —————– का बना होता ह ।
Answer – d) Panes

15. Mail, Calendar, People और Task के बीच म  कौन सा पैन िविचंग करता ह ।
Answer – c) Navigation pane
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ऍम एस पॉवर वॉइंट भाग – 20 (िहंदी म )
1. कौन-सा pane, outlook म  मुय working area ह ।
a) People pane
b) Folder pane
c) Navigation Pane
d) Reading pane

2. Chart की value को Input करने वाले form का नाम या ह ।
a) Datasheet
b) Microsoft Excel
c) Microsoft graph
d) Auto form

3. एक Object को खम करने के िलए आपको िननिलिखत म  से िकसे पहले परूा करना चािहए।
a) Double click the image
b) Select the object
c) Resize the image
d) Move the image to a new location

4. िलप आट  आजेट के अलग-अलग भाग करके उसे पावरपॉइंट आजेट बनाने को या कहते ह ।
a) Embedding
b) Regrouping
c) Ungrouping
d) Grouping

5. िनन म  से या योग िकया जाना चािहए जब आप एक मौजदूा ेजेटेशन म  एक Slide जोड़ना
चाहते ह ।
a) File, add a new slide
b) Insert, new slide
c) File, open
d) File, new

6. ऑटोशेप टूल दान करता ह ।
a) Fancy text to place on your slide
b) Commonly found shapes
c) Any shape you want to add on a slide
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d) Clip art that is related to your presentation

7. िकसी संगठन म  राटपित, उपराटपित, मैनेजर और सुपरवाईजर है तो उपराटपित संगठन के कौन
से चरण पर माना जाएगा।
a) Fourth level
b) Third level
c) Second level
d) First level

8. िनन म  से कौन  Special effects म  शािमल ह  िजसे  drawing object पर लाग ू िकया जा
सकता ह ।
a) Gradient fills
b) Line color and style
c) Rotating
d) All of the above

9. माउस की बांयी की को दबाकर उसे लाइड के चारो ंऔर घुमाने को या कहते ह ।
a) Highlighting
b) Dragging
c) Selecting
d) Both b and c

10. एक table object का आकार-
a) Is dependent on the amount of text within the table
b) Is determined by the presentation design but can be changed
c) Is determined by the presentation design and can not be changed
d) Both a and c

11. एक  axis  पर डोलर को दिशत करने के िलए िननिलिखत  Format  िवकप म  से िकसका
योग होता ह ।
a) Normal
b) Percentage
c) Currency
d) Comma

12. पप िटव को मेटेन करके आजेट को रीसाइज करने के िलये आपको —————- की
आवयकता होगी।
a) Press and hold the shift key while drag-gene a corner sizing handle
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b) Press and hold the alt + ctrl keys while dragging a mobile handle
c) Drag a Corner Sizing handle
d) Both a and c

13. िननिलिखत म  से कौनसा rules तथा guides क  संदभ म  सही ह ।
a) Rulers and guides can be turned on or off
b) Rules and guides print on the slide
c) Rules and guides help to place objects on the slide
d) Both a and c

14. िनन म  कौन सा िवकप आजेट के रंग को िडफाट रंग म  बदल देता ह ।
a) Template
b) Automatic
c) Patterns
d) Fill colors

15. आउटलुक का कौन सा फंशन यह टैक करता ह  िक काय करने म  िकतना समय िलया गया।
a) Tasks
b) Journal
c) Notes
d) Calendar

Answer Sheet
1. कौन सा pane, outlook म  मुय working area ह ।
Answer – b) Folder pane

2. Chart की value को Input करने वाले form का नाम या ह ।
Answer – a) Datasheet

3. एक Object को खम करने के िलए आपको िननिलिखत म  से िकसे पहले परूा करना चािहए।
Answer – b) Select the object

4. िलप आट  आजेट के अलग-अलग भाग करके उसे पावर पॉइंट आजेट बनाने को या कहते
ह ।
Answer – c) Ungrouping

5. िनन म  से या योग िकया जाना चािहए जब आप एक मौजदूा ेजेटेशन म  एक Slide जोड़ना
चाहते ह ।
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Answer – b) Insert, new slide

6. ऑटो शेप टूल दान करता ह ।
Answer – b) Commonly found shapes

7. िकसी संगठन म  राटपित, उपराटपित, मैनेजर और सुपरवाईजर है तो उपराटपित संगठन के कौन
से चरण पर माना जाएगा।
Answer – c) Second level

8. िनन म  से कौन  Special effects म  शािमल ह  िजसे  drawing object पर लाग ू िकया जा
सकता ह ।
Answer – d) All of the above

9. माउस की बांयी की को दबाकर उसे लाइड के चारो ंऔर घुमाने को या कहते ह ।
Answer – d) Both b and c

10. एक table object का आकार-
Answer – b) Is determined by the presentation design but can be changed

11. एक  axis  पर डोलर को दिशत करने के िलए िननिलिखत  Format  िवकप म  से िकसका
योग होता ह ।
Answer – c) Currency

12. पप िटव को मेटेन करके आजेट को रीसाइज करने के िलये आपको —————- की
आवयकता होगी।
Answer – a) Press and hold the shift key while drag-gene a corner sizing handle

13. िननिलिखत म  से कौनसा rules तथा guides क  संदभ म  सही ह ।
Answer – d) Both a and c

14. िनन म  कौन सा िवकप आजेट के रंग को िडफाट रंग म  बदल देता ह ।
Answer – b) Automatic

15. आउटलुक का कौन सा फंशन यह टैक करता ह  िक काय करने म  िकतना समय िलया गया।
Answer – b) Journal
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ऍम एस एसेस भाग – 1 (िहंदी म )
1. MS access या है
a) RDBMS
b) OODBMS
c) ORDBMS
d) Network Database Model

2. फीड को यिूनक बनाने के िलए िकस Key का उपयोग िकया जाता है
a) ाइमरी की
b) फॉरेन की
c) इनडेस की
d) कमपोिजट की

3. टेिबल को िनन म  से िकस कार से बनाया जा सकता है
a) िडजाइन य ूके ारा
b) डाटा शीट य ूके ारा
c) िवजाड के ारा
d) परोत सभी

4. एक डेटावेस टेिबल म  जानकारी की ेणी को या कहा जाता है
a) टपल
b) िरकाड
c) फीड
d) उपरोत सभी

5. MS access म  बनाए गए डेटाबेस का एसट शन नेम या होता है
a) .mdb
b) .mad
c) .doc
d) इनमे से कोई नही

6. िनन म  से कौन सा डेटावेस आजेट नही है
a) टेिबल
b) वेरी
c) िरलेशनिशप
d) िरपोट
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7. D.B.M.S या है
a) डेटाबेस मेनेजम ट िसटम
b) डेटाबेस मेनेजर िसटम
c) डेटा मेनेज िसटम
d) इनमे से कोई नही

8. िरकाड होता है
a) रो
b) कॉलम
c) रो तथा कॉलम का समहू
d) इनमे से कोई नही

9. िरलेशन मॉडल संबंिधत होता है
a) डाटा ट्चर तथा डाटा इंटिग टी
b) डाटा मेनीपुलेशन
c) a तथा b दोनो
d) इनमे से कोई नही

10. िनन म  से कौन नेटवक  डेटाबेस का उदाहरण है
a) Oracle
b) Ingress
c) IDMS
d) इनमे से कोई नही

11. हायरेिरकल डाटा मॉडल होता है
a) Partially ordered
b) Totally ordered
c) not ordered
d) इनमे से कोई नही

12. डेटाबेस के ओवरऑल िडजाइन को कहते है
a) डेटाबेस ीन
b) डेटाबेस ट्चर
c) डेटाबेस यू
d) इनमे से कोई नही

13. Boyce-codd Normal Form होता है
a) 1NF
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b) 2NF
c) 3NF
d) 4NF

14. नॉमलाइजेशन का थम फॉम है
a) First Normal Form
b) Second Normal Form
c) Fifth Normal Form
d) इनमे से कोई नही

15. Functional Dependency होती है
a) First Normal Form
b) Second Normal Form
c) Third Normal Form
d) Fourth Normal Form

Answer Sheet
1. MS access या है
Answer – (a) RDBMS

2. फीड को यिूनक बनाने के िलए िकस Key का उपयोग िकया जाता है
Answer – (a) ाइमरी की

3. टेिबल को िनन म  से िकस कार से बनाया जा सकता है
Answer – (d) परोत सभी

4. एक डेटावेस टेिबल म  जानकारी की ेणी को या कहा जाता है
Answer – (d) उपरोत सभी

5. MS access म  बनाए गए डेटाबेस का एसट शन नेम या होता है
Answer – (a) .mdb

6. िनन म  से कौन सा डेटावेस आजेट नही है
Answer – (c) िरलेशनिशप

7. D.B.M.S या है
Answer – (a) डेटाबेस मेनेजम ट िसटम

8. िरकाड होता है
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Answer – (a) रो

9. िरलेशन मॉडल संबंिधत होता है
Answer – (b) डाटा मेनीपुलेशन

10. िनन म  से कौन नेटवक  डेटाबेस का उदाहरण है
Answer – (c) IDMS

11. हायरेिरकल डाटा मॉडल होता है
Answer – (b) Totally ordered

12. डेटाबेस के ओवरऑल िडजाइन को कहते है
Answer – (b) डेटाबेस ट्चर

13. Boyce-codd Normal Form होता है
Answer – (c) 3NF

14. नॉमलाइजेशन का थम फॉम है
Answer – (a) First Normal Form

15. Functional Dependency होती है
Answer – (d) Fourth Normal Form
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ऍम एस एसेस भाग – 2 (िहंदी म )
1. डेटा आइटमो की सभी संभािवत वैय ूके सेट को कहते है
a) Domain
b) Tuple
c) Attribute
d) इनमे से कोई नही

2. फाइल सभी Related का कलेशन होती है
a) Database
b) Records
c) Fields
d) File

3. एक टेिबल के एक काॅलम मे एक फीड को कहते है
a) Database
b) Attribute
c) Tuple
d) Data

4. इनमे से कौन DBMS पैकेज नही है
a) Database
b) Records
c) Fields
d) File

5. Text Data Type मे अिधकतम िकतने character का data store कर सकते है
a) 50
b) 255
c) 256
d) 56

6. Text Type Data Type योग होता है
a) Text को टोर करने के िलए
b) Number को टोर करने के िलए
c) a तथा b दोनो के िलए
d) इनमे से कोई नही

ANKAJ INFOTECH

https://computerobjectivequestions.com/ms-office/ms-access-part-2-in-hindi/


7. Filter म  आॅशन होते है
a) Filter by form
b) Filter by selection
c) Filter excluding selection
d) उपरोत सभी

8. Table म  Paste option होते है
a) Structure only
b) Structure and data
c) Append data to existing
d) उपरोत सभी

9. MSACCESS म  Table िकतने कार से Create की जा सकती है
a) 3
b) 2
c) 4
d) 1

10. Table मे Particular िकसी field मे से िकसी record को ढूढने के िलए िकस option का
use िकया जाता है
a) Find and replace
b) search record
c) Go to
d) इनमे से कोई नही

11. MS Acces मे िकतने कार के Data type होते है
a) 10
b) 5
c) 8
d) 7

12. MEMO Data Type का use यो ंिकया जाता है
a) Long discription के िलए
b) currency value store करने के िलए
c) Numerical value store करने के िलए
d) इनमे से कोई नही

13. Table म  िकसी फीड का नाम अिधकतम िकतने Character का हो सकता है
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a) 64
b) 32
c) 52
d) 11

14. MS ACCESS मे table मे लाॅजीकल वेय ूको टोर करने के िलए िकस डेटा टाइप का नेम
िकया जाता है
a) True/False
b) Yes/No
c) On/Off
d) इनमे से कोई नही

15. आवाज,िच, वड, एसेल आिद के आजेट डालने या आजेट िलंक करने के िलए िनन मे से
कौन सा डेटा टाइप योग िकया जाता है
a) Hyerlink
b) OLE
c) Text
d) Number

Answer Sheet
1. डेटा आइटमो की सभी संभािवत वैय ूके सेट को कहते है
Answer – (c) Attribute

2. फाइल सभी Related का कलेशन होती है
Answer – (b) Records

3. एक टेिबल के एक काॅलम मे एक फीड को कहते है
Answer – (d) Data

4. इनमे से कौन DBMS पैकेज नही है
Answer – (d) File

5. Text Data Type मे अिधकतम िकतने character का data store कर सकते है
Answer – (b) 255

6. Text Type Data Type योग होता है
Answer – (c) a तथा b दोनो के िलए
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7. Filter म  आॅशन होते है
Answer – (d) उपरोत सभी

8. Table म  Paste option होते है
Answer – (d) उपरोत सभी

9. MSACCESS म  Table िकतने कार से Create की जा सकती है
Answer – (a) 3

10. Table मे Particular िकसी field मे से िकसी record को ढूढने के िलए िकस option का
use िकया जाता है
Answer – (a) Find and replace

11. MS Acces मे िकतने कार के Data type होते है
Answer – (a) 10

12. MEMO Data Type का use यो ंिकया जाता है
Answer – (a) Long discription के िलए

13. Table म  िकसी फीड का नाम अिधकतम िकतने Character का हो सकता है
Answer – (a) 64

14. MS ACCESS मे table मे लाॅजीकल वेय ूको टोर करने के िलए िकस डेटा टाइप का नेम
िकया जाता है
Answer – (b) Yes/No

15. आवाज,िच, वड, एसेल आिद के आजेट डालने या आजेट िलंक करने के िलए िनन मे से
कौन सा डेटा टाइप योग िकया जाता है
Answer – (b) OLE
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ऍम एस एसेस भाग – 3 (िहंदी म )
1. Relationship संभव होती है
a) एक टेिबल के अंदर Field मे
b) दो table के मय
c) एक से अिधक table के बीच मे
d) इनमे से कोई नही

2. Referential Integrity होती है
a) Table
b) Database
c) Query
d) उपरोत सभी

3. Queries create होती है
a) Filter से
b) Table से
c) A तथा B दोन
d) इनमे से कोई नही

4. AND OR operation specify होते है
a) Field म
b) Criteriya म
c) sort म
d) इनमे से कोई नही

5. Relationship म  opreation होते है
a) Define relationship
b) Save relationship
c) Delete relationship
d) उपरोत सभी

6. Append Query का use यो िकया जाता है
a) एक टेिबल का डेटा दसूरी टेिबल मे कॉपी करने के िलए
b) Query को िडलीट करने के िलए
c) Query Save करने के िलए
d) Query Update करने के िलए
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7. Find duplicate record query का use यो िकया जाता है
a) Duplicate Record को Delete करने के िलए
b) Duplicate Record को ढूढने के िलए
c) Duplicate Record को Update करने के िलए
d) Query को create करने के िलए

8. Table या Query म  से Unmatched Record को देखने िकस query का use िकया जाता
है
a) append query
b) find duplicate query
c) find unmatched Query
d) update query

9. Cross tab query का use यो िकया जाता है
a) Data analysis करने के िलए
b) Record Update करने के िलए
c) Record delete करने के िलए
d) duplicate record search करने के िलए

10. ायः सबसे यादा िकस Query का योग िकया जाता है
a) select query
b) action query
c) crosstab query
d) sql query

11. िननिलिखत म  फॅाम के कार है
a) Datasheet
b) Justify
c) Tabular
d) उपरोत सभी

12. िननिलिखत म  से कौन सी फॅाम ॉपटी है
a) Format
b) Event
c) Data
d) उपरोत सभी

13. List box control का योग होता है
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a) Single selection के िलये
b) Multiple list के िलए
c) Editing के िलए
d) इनमे से कोई नही

14. Combo box िडजाइन होता है
a) Table म
b) Query म
c) Form म
d) उपरोत सभी

15. Sub form होता है
a) Current form के साथ दसूरा form
b) अलग से एक और form
c) Table form
d) इनमे से कोई नही

Answer Sheet
1. Relationship संभव होती है
Answer – (c) एक से अिधक table के बीच मे

2. Referential Integrity होती है
Answer – (c) Query

3. Queries create होती है
Answer – (b) Table से

4. AND OR operation specify होते है
Answer – (b) Criteriya म

5. Relationship म  opreation होते है
Answer – (d) उपरोत सभी

6. Append Query का use यो िकया जाता है
Answer – (a) एक टेिबल का डेटा दसूरी टेिबल मे कॉपी करने के िलए

7. Find duplicate record query का use यो िकया जाता है
Answer – (b) Duplicate Record को ढूढने के िलए
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8. Table या Query म  से Unmatched Record को देखने िकस query का use िकया जाता
है
Answer – (c) find unmatched Query

9. Cross tab query का use यो िकया जाता है
Answer – (a) Data analysis करने के िलए

10. ायः सबसे यादा िकस Query का योग िकया जाता है
Answer – (a) select query

11. िननिलिखत म  फॅाम के कार है
Answer – (d) उपरोत सभी

12. िननिलिखत म  से कौन सी फॅाम ॉपटी है
Answer – (d) उपरोत सभी

13. List box control का योग होता है
Answer – (b) Multiple list के िलए

14. Combo box िडजाइन होता है
Answer – (c) Form म

15. Sub form होता है
Answer – (a) Current form के साथ दसूरा form
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ऍम एस एसेस भाग – 4 (िहंदी म )
1. एम एस एसेस म  िकतने कार के फॉस होते है
a) 2
b) 4
c) 5
d) 6

2. Combo box का use यो ंिकया जाता है
a) Multiple value म  से selection के िलए
b) Data entry करने क िलए
c) Dropdown list म  से value को select करता है
d) ingle selection के िलए

3. Check box का use यो ंिकया जाता है
a) multiple selection के िलए
b) single selection के िलए
c) text add के िलए
d) इनमे से कोई नही

4. फॉम मे हेडर फुटर िकस मेन ूके ारा इसट  िकया जा सकता है
a) insert menu
b) view menu
c) tool menu
d) format menu

5. Text box का use िकस िकए िकया जाता है
a) user से जानकारी लेने के िलए
b) single selection के िलए
c) Current form के साथ दसूरा form जोड़ने के िकए
d) इनमे से कोई नही

6. Group Header के on या off म  turns होते है
a) Group Header
b) Group footer
c) Group interval
d) Group on
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7. येक value म  prefix character होते है
a) Text
b) Date /Time
c) Auto Number
d) Number

8. Reports के types होते है
a) Columnar
b) Tabular
c) a तथा b दोनो
d) इनमे से कोई नही

9. Report जो एक ही टेबल की सचूनाओ को िदखाती है…..
a) multi table report
b) single table report
c) malling lable
d) इनमे से कोई नही

10. Report बनाने के टेस है
a) ले आउट बनाना
b) िरपोट बनाना
c) िरपोट िंट करना
d) उपरोत सभी

11. report का उपयोग यो िकया जाता है
a) परीणाम दशाने के िलए
b) डाटा इनपुट करने के िलए
c) Data को यविथत करने के िलए
d) उपरोत सभी

12. एक सामाय िरपोट  मे कौन .कौन से भाग होते है
a) Report Header
b) Report Footer
c) Detail
d) उपरोत सभी

13. एक िरपोट  मे केशन कहा show होता है
a) Report window title bar म
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b) Task bar म
c) Report header म
d) Report footer म

Answer Sheet
1. एम एस एसेस म  िकतने कार के फॉस होते है
Answer – (b) 4

2. Combo box का use यो ंिकया जाता है
Answer – (c) Dropdown list म  से value को select करता है

3. Check box का use यो ंिकया जाता है
Answer – (a) multiple selection के िलए

4. फॉम मे हेडर फुटर िकस मेन ूके ारा इसट  िकया जा सकता है
Answer – (b) view menu

5. Text box का use िकस िकए िकया जाता है
Answer – (a) user से जानकारी लेने के िलए

6. Group Header के on या off म  turns होते है
Answer – (a) Group Header

7. येक value म  prefix character होते है
Answer – (a) Text

8. Reports के types होते है
Answer – (c) a तथा b दोनो

9. Report जो एक ही टेबल की सचूनाओ को िदखाती है…..
Answer – (b) single table report

10. Report बनाने के टेस है
Answer – (d) उपरोत सभी

11. report का उपयोग यो िकया जाता है
Answer – (a) परीणाम दशाने के िलए

12. एक सामाय िरपोट  मे कौन .कौन से भाग होते है
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Answer – (d) उपरोत सभी

13. एक िरपोट  मे केशन कहा show होता है
Answer – (a) Report window title bar म
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ऍम एस एसेस भाग – 5 (िहंदी म )
1. ——————- म  से कौन एक डाटाबेस ऑजेट नही ंह ।
a) Tables
b) Queries
c) Relationships
d) Report

2. One-to-Many Relationships म  ‘One’ Side म  िथत Table को —————– कहते
ह  और ‘Many’ Side म  िथत को ———————– कहते ह ।
a) Child, Parent
b) Parent Child
c) Brother, Sister
d) Father, Son

3. एक डाटाबेस की Designing म  तीसरी Stage होती ह   जब हम अपने Tables को और अिधक
नजदीकी से िवलेिषत करते ह  और एक —————— को Tables के बीच Create करते ह ।
a) Relationship
b) Join
c) Query
d) None of These

4. Access File का Command Center जो िक तब दिशत होता ह  जब आप MS Access
डेटाबेस फाइल को Create या Open करते ह ।
a) Database Window
b) Query Window
c) Design View Window
d) Switchboard

5. एक डाटाबेस भाषा जो संपणू डाटाबेस टचर और Schema की पिरभाषा से संबंिधत ह ।
a) DCL
b) DML
c) DDL
d) All Of Above

6. िनन म  से कौन माइोसॉट एसेस के डाटाबेस का आजेट नही ंह ।
a) Table
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b) Form
c) Worksheet
d) Modules

7. टूल बॉस का —————– बटन िरलेिटड टेबल का डाटा िडले करता ह ।
a) Sub From Sub Report
b) Relationship
c) Select Object
d) More Controls

8. एेशन िबडर एक एिसस टूल ह  जो एटर होने वाले एसेशन के िलए एेशन
————- कट ोल करता ह ।
a) Table
b) Box
c) Cell
d) Palette

9. वह डाटाबेस ल वेज जो डेटाबेस म  िकसी डेटा को एिसस या मेटेन करने म  मदद करती ह ।
a) DCL
b) DML
c) DDL
d) None Of Above

10. Referential Integrity का अथ ह ।
a) Do not enter a value in the foreign key field of a child table if that value does
not exist in the primary key of the parent table.
b) Do not enter a value in the primary key
c) Both a & b
d) None of above

11. Shift + F10 का योग या ह ।
a) Show Context Menu
b) Open the Zoom Box
c) Check Spelling
d) None of above

12. एक सच वैय ूएक इजैट वैय ूया ————— हो सकती ह ।
a) Logical Operator
b) Relationship
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c) Wild card character
d) Comparison operator

13. यह एक साइन या िसबल ह  जो वैयजू ारा िरजट दान करता ह ।
a) Operator
b) Query
c) Expression
d) None of the above

14. Open तथा Open Exclusively म  या अतर ह ।
a)  Open  statement  opens  access  database  files  and  open  exclusively  opens
database files of other program like oracle
b) Open exclusive locks whole database so that no one can access it whereas open
locks only the record that is being accessed
c) Both Open and open exclusively are same
d) Open exclusive command does not exist in ms access

15. Alt+F8 ——————- के िलए योग होती ह ।
a) Toggle the field list pane
b) Close the dialog box
c) Both a & b
d) None

Answer Sheet
1. ——————- म  से कौन एक डाटाबेस ऑजेट नही ंह ।
Answer – c) Relationships

2. One-to-Many Relationships म  ‘One’ Side म  िथत Table को —————– कहते
ह  और ‘Many’ Side म  िथत को ———————– कहते ह ।
Answer – b) Parent Child

3. एक डाटाबेस की Designing म  तीसरी Stage होती ह   जब हम अपने Tables को और अिधक
नजदीकी से िवलेिषत करते ह  और एक —————— को Tables के बीच Create करते ह ।
Answer – a) Relationship

4. Access File का Command Center जो िक तब दिशत होता ह  जब आप MS Access
डेटाबेस फाइल को Create या Open करते ह ।
Answer – a) Database Window
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5. एक डाटाबेस भाषा जो संपणू डाटाबेस टचर और Schema की पिरभाषा से संबंिधत ह ।
Answer – c) DDL

6. िनन म  से कौन माइोसॉट एसेस  के डाटाबेस का आजेट नही ंह ।
Answer – c) Worksheet

7. टूल बॉस का —————– बटन िरलेिटड टेबल का डाटा िडले करता ह ।
Answer – a) Sub From Sub Report

8. एेशन िबडर एक एिसस टूल ह  जो एटर होने वाले एसेशन के िलए एेशन
————- कट ोल करता ह ।
Answer – b) Box

9. वह डाटाबेस ल वेज जो डेटाबेस म  िकसी डेटा को एिसस या मेटेन करने म  मदद करती ह ।
Answer – b) DML

10. Referential Integrity का अथ ह ।
Answer – a) Do not enter a value in the foreign key field of a child table if that
value does not exist in the primary key of the parent table.

11. Shift + F10 का योग या ह ।
Answer – a) Show Context Menu

12. एक सच वैय ूएक इजैट वैय ूया ————— हो सकती ह ।
Answer – c) Wild card character

13. यह एक साइन या िसबल ह  जो वैयजू ारा िरजट दान करता ह ।
Answer – a) Operator

14. Open तथा Open Exclusively म  या अतर ह ।
Answer – b) Open exclusive locks whole database so that no one can access it
whereas open locks only the record that is being accessed

15. Alt+F8 ——————- के िलए योग होती ह ।
Answer – a) Toggle the field list pane
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ऍम एस एसेस भाग – 6 (िहंदी म )
1. Microsoft Access ह ।
a) RDBMS
b) OODBMS
c) ORDBMS
d) Network database Model

2. DCL —————की तरह ियाए ँकरने के िलए कमाड दान करता ह ।
a) Change The Structure Of Tables
b) Insert, update or delete records and data values
c) Authorizing access and other control over database
d) None of above

3. िनन म  से कौन सा डाटाबेस नही ंह ।
a) Data presented in tables in ms word document
b) Data entered in excel spreadsheet
c) A presentation created in power-point
d) A telephone diary

4. डेटाबेस को सवोम वािणत िकया जा सकता ह ।
a) Organized collection of data
b) Useful presentation of data
c) Graphical representation of data
d) All of above

5. िनन म  से कौन-सी टम डेटाबेस से सबसे कम सबिधत ह ।
a) Attributes
b) Tuples
c) Relationship
d) Columns

6. ——————- म  से या MS Access म  एक डेटाबेस आजेट नही ंह ।
a) Tables
b) Query
c) Report
d) Relationship
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7. डाटाबेस मैनेजमेट िसटम —————- के साथ गुण ह ।
a) The facility to easy editing, spelling check, auto pagination, lay out and printing
re ports
b) The ability to store large amount of data to facilitate easy update, sort and
retrieval
c) The ability to calculate efficiently with the help of built-in function and analyze
d) All of above

8. ————– म  से या डेटाबेस का उदाहरण ह ।
a) Address book of all the suppliers of a company
b) Salary sheet of all the employees of a company
c) Records of daily sales transactions of a company
d) All of above

9. िनन मे से कौन सही म म  ह ।
a) Characters, Fields, records, tables, files, database
b) Characters, Fields, records, tables, database, files
c) Database, tables, files, records, field, Characters
d) Files, database, tables, records, fields, characters

10. िननिलिखत म  से िकसे Primary की वड कहा जाता ह ।
a) Foreign Key
b) Native key
c) Composite Key
d) Primary key

11. यिद हम  Fees टेबल म  Student फीड बनाएं तथा  Student टेबल के  Student-id का
इसम  योग कर  तो वह Student फीड, fees टेबल म  या ह ।
a) Foreign Key
b) Native key
c) Composite Key
d) Primary key

12. एक Composite कंुजी ह ।
a) Required When a tables does not have any unique field in it
b) The primary key with auto number as the field type
c) Made up of two or more field to uniquely identity records
d) Is a foreign key that uniquely identifies records
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13. िकसी टेबल म  ाइमरी की की िवशेषता होती ह ।
a) No null
b) No duplicate
c) Both of above
d) None of above

14. तािक क सबिधत डाटा के संगिठत समहू को कहा जाता ह ।
a) Data
b) Meta data
c) Database
d) Information

15. डेटाबेस म  लॉिकंग लेवल को —————- भी कहते ह ।
a) Granularity
b) S lock
c) X lock
d) Dead lock

Answer Sheet
1. Microsoft Access ह ।
Answer – a) RDBMS

2. DCL —————की तरह ियाए ँकरने के िलए कमाड दान करता ह ।
Answer – c) Authorizing access and other control over database

3. िनन म  से कौन सा डाटाबेस नही ंह ।
Answer – c) A presentation created in power-point

4. डेटाबेस को सवोम वािणत िकया जा सकता ह ।
Answer – a) Organized collection of data

5. िनन म  से कौन-सी टम डेटाबेस से सबसे कम सबिधत ह ।
Answer – d) Columns

6. ——————- म  से या MS Access म  एक डेटाबेस आजेट नही ंह ।
Answer – d) Relationship

7. डाटाबेस मैनेजमेट िसटम —————- के साथ गुण ह ।
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Answer – b) The ability to store large amount of data to facilitate easy update, sort
and retrieval

8. ————– म  से या डेटाबेस का उदाहरण ह ।
Answer – d) All of above

9. िनन मे से कौन सही म म  ह ।
Answer – a) Characters, Fields, records, tables, files, database

10. िननिलिखत म  से िकसे Primary की वड कहा जाता ह ।
Answer – d) Primary key

11. यिद हम  Fees टेबल म  Student फीड बनाएं तथा  Student टेबल के  Student-id का
इसम  योग कर  तो वह Student फीड, fees टेबल म  या ह ।
Answer – a) Foreign Key

12. एक Composite कंुजी ह ।
Answer – c) Made up of two or more field to uniquely identity records

13. िकसी टेबल म  ाइमरी की की िवशेषता होती ह ।
Answer – c) Both of above

14. तािक क सबिधत डाटा के संगिठत समहू को कहा जाता ह ।
Answer – c) Database

15. डेटाबेस म  लॉिकंग लेवल को —————- भी कहते ह ।
Answer – a) Granularity
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ऍम एस एसेस भाग – 7 (िहंदी म )
1. िनन म  से कौन डेटाबेस एलीकेशन नही ंह ।
a) Dbase
b) Flash
c) Foxpro
d) Access

2. HSAM से तापय ह ।
a) Hierarchic sequential access method
b) Hierarchic standard access method
c) Hierarchic sequential and method
d) Hierarchic standard and method

3. िनन म  कौन-सा तािक क डेटाबेस टचर नही ंह ।
a) Chain
b) Network
c) Tree
d) Relational

4. उस ाइमरी की फीड को या कहते ह  जो दसूरी टेबल म  समिलत होती ह ।
a) Foreign Key
b) Parent Key
c) Child Key
d) Index

5. SQL का फुल-फॉम या ह ।
a) Sophisticated question list
b) Structured question list
c) Structured query list
d) Small query length

6. डेटाबेस िवजाड का उपयोग करके बनाए गए िकसी अनुयोग म , मुय मेन ू————— के प म
तुत िकया गया ह ।
a) Form, called a switchboard
b) Report, called a menu
c) Tables, called a switchboard
d) Query, called a menu
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7. िकसी टेबल की ाइमरी की तथा इडेस को अलग-अलग देखने के िलये िकस पर िलक करते ह ।
a) Indexes button
b) Primary key button
c) View datasheet button
d) View design button

8. ाइमरी की ह ।
a) Uniquely identifies each record
b) Cannot be repeated
c) Auto number is example of primary key
d) All of above

9. िनन म  से कौन DBMS का कार ह ।
a) Flat file system
b) Hierarchical DBMS
c) Relational DBMS
d) All of the above

10. िरलेिटड टेबल के समहू को —————– कहते ह ।
a) Row
b) Record
c) Database
d) File

11. मैकरोज को —————- से एक कट ॉलड मैनर म  पुन : ात कर सकते ह ।
a) Events
b) Modules
c) Arguments
d) Errors

12. VB Editor म  ोजेट पेन म  िकसी ऑजेट पर डबल िलक करने से या होता ह ।
a) The associated code is displayed in the code pane
b) The associated code is displayed in o new window
c) The object is delete from the project pane
d) The object/s’ property sheet opens

13. ——————– एक बडा ऑजेट है जो एक एशन या एक एशन के समहू को पणू करता ह ।
a) Event
b) Property
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c) Procedure
d) Macro

14. िडफॉट प से ोजेट पैन के मॉडूल फोडर म  नये मॉडूल का या नाम होता ह ।
a) Bas 1
b) Module
c) New module
d) Module 1

15. एक माडूल म , एक चेतावनी वेरी िचह दिशत करने के िलए इतेमाल िकया जाने वाला VB
नाम ह ।
a) Vb critical
b) Vb information
c) Vb Exclamation
d) Vb Question

Answer Sheet
1. िनन म  से कौन डेटाबेस एलीकेशन नही ंह ।
Answer – b) Flash

2. HSAM से तापय ह ।
Answer – a) Hierarchic sequential access method

3. िनन म  कौन-सा तािक क डेटाबेस टचर नही ंह ।
Answer – a) Chain

4. उस ाइमरी की फीड को या कहते ह  जो दसूरी टेबल म  समिलत होती ह ।
Answer – a) Foreign Key

5. SQL का फुल-फॉम या ह ।
Answer – c) Structured query list

6. डेटाबेस िवजाड का उपयोग करके बनाए गए िकसी अनुयोग म , मुय मेन ू————— के प म
तुत िकया गया ह ।
Answer – a) Form, called a switchboard

7. िकसी टेबल की ाइमरी की तथा इडेस को अलग-अलग देखने के िलये िकस पर िलक करते ह ।
Answer – a) Indexes button
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8. ाइमरी की ह ।
Answer – d) All of above

9. िनन म  से कौन DBMS का कार ह ।
Answer – d) All of the above

10. िरलेिटड टेबल के समहू को —————– कहते ह ।
Answer – c) Database

11. मैकरोज को —————- से एक कट ॉलड मैनर म  पुन : ात कर सकते ह ।
Answer – a) Events

12. VB Editor म  ोजेट पेन म  िकसी ऑजेट पर डबल िलक करने से या होता ह ।
Answer – a) The associated code is displayed in the code pane

13. ——————– एक बडा ऑजेट है जो एक एशन या एक एशन के समहू को पणू करता ह ।
Answer – d) Macro

14. िडफॉट प से ोजेट पैन के मॉडूल फोडर म  नये मॉडूल का या नाम होता ह ।
Answer – d) Module 1

15. एक माडूल म , एक चेतावनी वेरी िचह दिशत करने के िलए इतेमाल िकया जाने वाला VB
नाम ह ।
Answer – d) Vb Question
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ऍम एस एसेस भाग – 8 (िहंदी म )
1. िकसी मॉडूल म  ————— एक कमांड तथा ोपटीज की ेणी ह  जो एक िविशट टाक के
िलये योग िकये जाते ह ।
a) Event
b) Property
c) Procedure
d) Macro

2. —————- एक बड़ा ऑजेट ह  जो कट ोल से वत होकर रन हो सकते ह ।
a) Event
b) Property
c) Procedure
d) Macro

3. िननिलिखत म  से कौन वेब दतावेज के िलए Standard फाइल फॉरमेट ह ।
a) HTML
b) XML
c) XSD
d) XSL

4. िननिलिखत म  से कौन Extendible Markup Language के िलए फाइल Extension ह ।
a) EML
b) HTML
c) XML
d) XSD

5. —————- फाइल का एक िडएडवाटेज यह ह  िक हम फाइल म  िकसी फीड को आसानी से
नही ंबता सकते िक यह नबर टेट, डेट या करेसी ह ।
a) Standardized
b) Fixed
c) Delimited
d) Text

6. —————– फंशन सपणू िटंग को अपरकेस म  बदल देता ह ।
a) All Cap
b) U Case
c) Up Case
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d) Upper

7. Date/Tine वैय ूसे कौन-सा फंशन महीने का नाम एटे ट करता ह ।
a) Month
b) Month Name
c) Month Label
d) Month Value

8. िननिलिखत फंशनो ंम  से कौन एक संयामक फीड म  सभी मानो के िलए उपयोग िकया जाता
ह ।
a) NUM
b) Count
c) SUM
d) Total

9. टेबल की फीड िलट म  ाइमरी की —————— होती ह ।
a) Bold
b) Italicized
c) Underlined
d) With key icon

10. इनपुट माक िवजाड म  िनन म  से या करने की मता नही ंहोती ह ।
a) Force all uppercase
b) Define placeholder
c) Store symbols with data
d) Use present masks

11. डेटाबेस ोपटी म  समिलत नही ंहोता ह ।
a) Title
b) Author
c) Company
d) Size

12. —————— एक डायनेिमक गिणतीय गणना ह  जो एक िविशट फीड के िलए िसंगल वैयू
को दशाती ह ।
a) Format row
b) Criteria row
c) Aggregate function
d) Format layout
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13. इसरशन पॉइट —————– की भॉित िदखाई देता ह ।
a) H-pointer
b) I-pointer
c) H-beam
d) I-beam

14. सवािधक लोकिय औघोिगक DBMS ह ।
a) Microsoft SQL Server
b) Microsoft Access
c) My SQL
d) Oracle

15. डेटा टे िकंग जरतो ं को बढ़ाने के प म  डाटाबेस की िवकिसत करने की मता इसकी अपनी
————– ह ।
a) Scalability
b) Expandability
c) Maintainability
d) Platform-independence

Answer Sheet
1. िकसी मॉडूल म  ————— एक कमांड तथा ोपटीज की ेणी ह  जो एक िविशट टाक के
िलये योग िकये जाते ह ।
Answer – c) Procedure

2. —————- एक बड़ा ऑजेट ह  जो कट ोल से वत होकर रन हो सकते ह ।
Answer – d) Macro

3. िननिलिखत म  से कौन वेब दतावेज के िलए Standard फाइल फॉरमेट ह ।
Answer – a) HTML

4. िननिलिखत म  से कौन Extendible Markup Language के िलए फाइल Extension ह ।
Answer – c) XML

5. —————- फाइल का एक िडएडवाटेज यह ह  िक हम फाइल म  िकसी फीड को आसानी से
नही ंबता सकते िक यह नबर टेट, डेट या करेसी ह ।
Answer – d) Text

6. —————– फंशन सपणू िटंग को अपरकेस म  बदल देता ह ।
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Answer – b) U Case

7. Date/Tine वैय ूसे कौन-सा फंशन महीने का नाम एटे ट करता ह ।
Answer – b) Month Name

8. िननिलिखत फंशनो ंम  से कौन एक संयामक फीड म  सभी मानो के िलए उपयोग िकया जाता
ह ।
Answer – b) Count

9. टेबल की फीड िलट म  ाइमरी की —————— होती ह ।
Answer – d) With key icon

10. इनपुट माक िवजाड म  िनन म  से या करने की मता नही ंहोती ह ।
Answer – a) Force all uppercase

11. डेटाबेस ोपटी म  समिलत नही ंहोता ह ।
Answer – d) Size

12. —————— एक डायनेिमक गिणतीय गणना ह  जो एक िविशट फीड के िलए िसंगल वैयू
को दशाती ह ।
Answer – c) Aggregate function

13. इसरशन पॉइट —————– की भॉित िदखाई देता ह ।
Answer – d) I-beam

14. सवािधक लोकिय औघोिगक DBMS ह ।
Answer – d) Oracle

15. डेटा टे िकंग जरतो ं को बढ़ाने के प म  डाटाबेस की िवकिसत करने की मता इसकी अपनी
————– ह ।
Answer – a) Scalability
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ऍम एस एसेस भाग – 9 (िहंदी म )
1. सवािधक ओपन सॉस DBMS ह ।
a) Microsoft SQL Server
b) Microsoft Access
c) My SQL
d) Oracle

2. ———– एक ऐसा DBMS ह  जो िविभन ऑपरेिटंग िसटम पर चल सकता ह ।
a) Scalable
b) Robust
c) Platform Independent
d) Distributed

3. सचइंजन —————– का योग ऑटोमैिटकली इडेस साइट्स के िलये करता ह ।
a) Crawler
b) Query
c) Enterprise
d) Site builder

4. —————- पसनल डाटाबेस के िलए िलयर लीडर ह ।
a) Microsoft Access
b) Microsoft Foxpro
c) Borland dBase
d) My SQL

5. —————- सॉटवेयर टूल ह  जो डेटा को टोर या एसेस करता ह ।
a) Table
b) DBMS
c) Query
d) Report

6. इस डेटाबेस म  केवल एक टेबल होती ह ।
a) Relational
b) Large
c) Flat-file
d) DBMS

ANKAJ INFOTECH

https://computerobjectivequestions.com/ms-office/ms-access-part-9-in-hindi/


7. डेटाबेस म  िपचर टोर करने के िलये ————— फीड की आवयकता होती ह ।
a) BLOB
b) Text
c) Image
d) Logical

8. यह डाटाबेस िडजाइन की वह टेज है जहा ँडाटाबेस ोजेट की सभी जरी फीडस ्एक होकर
एक िलट के प म  िदखाई देता ह ।
a) Data definition
b) Data refinement
c) Establishing relationship
d) None of the above

9. िनन म  से कौन डेटाबेस मॉडल नही ंह ।
a) Network database model
b) Relational database model
c) Object oriented database model
d) None

10. इस कार का डेटाबेस अनेक टेबलस ्रखता ह  जो सभी टेबल से संयुत आउटपुट produce करने
के िलए कनेट होती ह ।
a) Bound
b) Linked
c) Relational
d) Joined

11. वह डेटाबेस एसेस का आधार िजसके अनुसार िकसे और या डेटाबेस म  से एसेस करना ह ।
a) User ID
b) Password
c) Status
d) None Of Above

12. डेटाबेस म  सबिधत िरकॉड के समहू को या कहते ह ।
a) Table
b) Database
c) File
d) None Of above

13. िनन म  से कौन सा डेटा पदानुम का आरोही म ह ।
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a) Bit – byte – field – record – file – database
b) Bit – byte – record – field – file – database
c) Byte – bit – field – record – file – database
d) Bit – byte – field – record – database – file

14. एसेस म , यह ऑपरेसन बैकअप फाइल को संगहक मायम से कयटूर पर कॉपी करता ह ।
a) Recreate
b) Restore
c) Copy
d) Structure

15. यिद आप इनपुट माक िवजाड डायलॉग बॉस म  गलत िवटी कर देते ह  तो यह आपको सुझाव
देता ह  िक आपके ारा की गयी िवटी गलत ह ।
a) Text error
b) Validation error
c) Literal error
d) Entry error

Answer Sheet
1. सवािधक ओपन सॉस DBMS ह ।
Answer – c) My SQL

2. ———– एक ऐसा DBMS ह  जो िविभन ऑपरेिटंग िसटम पर चल सकता ह ।
Answer – c) Platform Independent

3. सचइंजन —————– का योग ऑटोमैिटकली इडेस साइट्स के िलये करता ह ।
Answer – a) Crawler

4. —————- पसनल डाटाबेस के िलए िलयर लीडर ह ।
Answer – a) Microsoft Access

5. —————- सॉटवेयर टूल ह  जो डेटा को टोर या एसेस करता ह ।
Answer – b) DBMS

6. इस डेटाबेस म  केवल एक टेबल होती ह ।
Answer – c) Flat-file

7. डेटाबेस म  िपचर टोर करने के िलये ————— फीड की आवयकता होती ह ।
Answer – a) BLOB
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8. यह डाटाबेस िडजाइन की वह टेज है जहा ँडाटाबेस ोजेट की सभी जरी फीडस ्एक होकर
एक िलट के प म  िदखाई देता ह ।
Answer – a) Data definition

9. िनन म  से कौन डेटाबेस मॉडल नही ंह ।
Answer – d) None

10. इस कार का डेटाबेस अनेक टेबलस ्रखता ह  जो सभी टेबल से संयुत आउटपुट produce करने
के िलए कनेट होती ह ।
Answer – c) Relational

11. वह डेटाबेस एसेस का आधार िजसके अनुसार िकसे और या डेटाबेस म  से एसेस करना ह ।
Answer – a) User ID

12. डेटाबेस म  सबिधत िरकॉड के समहू को या कहते ह ।
Answer – c) File

13. िनन म  से कौन सा डेटा पदानुम का आरोही म ह ।
Answer – a) Bit – byte – field – record – file – database

14. एसेस म , यह ऑपरेसन बैकअप फाइल को संगहक मायम से कयटूर पर कॉपी करता ह ।
Answer – b) Restore

15. यिद आप इनपुट माक िवजाड डायलॉग बॉस म  गलत िवटी कर देते ह  तो यह आपको सुझाव
देता ह  िक आपके ारा की गयी िवटी गलत ह ।
Answer – b) Validation error
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ऍम एस एसेस भाग – 10 (िहंदी म )
1. Database पर पासवड लगाने के िलये, माइोसॉट एसेस ओपन िवंडो म  से ————— को
चुने।
a) Open read only
b) Open write only
c) Open explicit
d) Open exclusive

2. Input Mask Wizard एटर करने के िलये।
a) Click on the three dots to the right of the caption entry field
b) Click on the three dotes to the right of the format entry field
c) Click on the input mask toolbar
d) Click on the three dots to the right or the input mask entry field

3. एसेस म  डेटाबेस कब सेव होता ह ।
a) At the beginning of the database
b) The first time you save data
c) When closing the application
d) During auto save

4. access 2003 data base का फाइल एसटेशन ह ।
a) Exe
b) Doc
c) Exe
d) Mdb

5. िरलेनल डाटाबेस कीमा म  येक टपल फीडस ्म  बटी होती ह  िजह  ——————- कहते ह ।
a) Relation
b) Queries
c) Record
d) Domains

6. Macro Design Window म  िनन म  से कौन से कॉलम नही ंहोते ह ।
a) Arguments
b) Comments
c) Conditions
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d) Actions

7. Data access pages के code को edit करने के िलए िकस ोग ाम का योग करते ह ।
a) Microsoft Script Editor
b) Microsoft Code Editor
c) Microsoft data access pages editor
d) None of above

8. डेटाबेस से डेटा को िकसी िनिचत एलीकेशन म  देखने के िलए एलीकेशन —————— का
योग करती ह ।
a) Module
b) Relational Model
c) Schema
d) Sub – schema

9. एक ऑरगेनाइजेशन म , डेटा ोसेिसंग फंशन के िलए िजमेदार एसीयिूटव ह ।
a) Pm
b) Dbms
c) Dp
d) Dpm

10. सबिधत थाई डाटा को रखने वाली फाइल ह ।
a) Random file
b) Transaction file
c) Master file
d) Sequential File

11. डाटाबेस म  टोर डाटा का सपणू िच —————- कहलाता ह ।
a) Record
b) Scheme
c) System flowchart
d) DBMS

12. िविभन फाइलो के डेटा को िलंक करने के िलए  DBMS  के ारा योग होने वाले डाटाबेस
टे चर को िकस-सी टम वािणत नही ं कर सकती ह ।
a) Relational
b) Structural
c) Network
d) All of the above
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13. डेटाबेस फोरमेस को ऑटीमाइज करने के िलये या िकया जाता ह ।
a) Set the record set type to snapshot
b) Use the compact and repair database tool
c) Create a replica of the database
d) All of the above

14. access help के अनुसार, डाटाबेस बनाने का अछा तरीका कौन सा ह ।
a) Start from data access pages and work backward
b) Sketch the deign of your database using a pencil and paper
c) Use the table analyzer to reverse-engineer your flat source data
d) None of above

15. यिद डेटाबेस म  डेटा का पाट  दो थानो ंपर संग िहत हो जाता ह  तो ।
a) Storage space is wasted
b) Changing the data is one spot will cause data inconsistency
c) If can be more easily accessed
d) Both a & b

Answer Sheet
1. Database पर पासवड लगाने के िलये, माइोसॉट एसेस ओपन िवंडो म  से ————— को
चुने।
Answer – d) Open exclusive

2. Input Mask Wizard एटर करने के िलये।
Answer – d) Click on the three dots to the right or the input mask entry field

3. एसेस म  डेटाबेस कब सेव होता ह ।
Answer – a) At the beginning of the database

4. access 2003 data base का फाइल एसटेशन ह ।
Answer – d) Mdb

5. िरलेनल डाटाबेस कीमा म  येक टपल फीडस ्म  बटी होती ह  िजह  ——————- कहते ह ।
Answer – d) Domains

6. Macro Design Window म  िनन म  से कौन से कॉलम नही ंहोते ह ।
Answer – c) Conditions
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7. Data access pages के code को edit करने के िलए िकस ोग ाम का योग करते ह ।
Answer – a) Microsoft Script Editor

8. डेटाबेस से डेटा को िकसी िनिचत एलीकेशन म  देखने के िलए एलीकेशन —————— का
योग करती ह ।
Answer – d) Sub – schema

9. एक ऑरगेनाइजेशन म , डेटा ोसेिसंग फंशन के िलए िजमेदार एसीयिूटव ह ।
Answer – b) Dbms

10. सबिधत थाई डाटा को रखने वाली फाइल ह ।
Answer – c) Master file

11. डाटाबेस म  टोर डाटा का सपणू िच —————- कहलाता ह ।
Answer – b) Scheme

12. िविभन फाइलो के डेटा को िलंक करने के िलए  DBMS  के ारा योग होने वाले डाटाबेस
टे चर को िकस-सी टम वािणत नही ं कर सकती ह ।
Answer – b) Structural

13. डेटाबेस फोरमेस को ऑटीमाइज करने के िलये या िकया जाता ह ।
Answer – b) Use the compact and repair database tool

14. access help के अनुसार, डाटाबेस बनाने का अछा तरीका कौन सा ह ।
Answer – b) Sketch the deign of your database using a pencil and paper

15. यिद डेटाबेस म  डेटा का पाट  दो थानो ंपर संग िहत हो जाता ह  तो ।
Answer – d) Both a & b
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ऍम एस एसेस भाग – 10 (िहंदी म )
1. Database पर पासवड लगाने के िलये, माइोसॉट एसेस ओपन िवंडो म  से ————— को
चुने।
a) Open read only
b) Open write only
c) Open explicit
d) Open exclusive

2. Input Mask Wizard एटर करने के िलये।
a) Click on the three dots to the right of the caption entry field
b) Click on the three dotes to the right of the format entry field
c) Click on the input mask toolbar
d) Click on the three dots to the right or the input mask entry field

3. एसेस म  डेटाबेस कब सेव होता ह ।
a) At the beginning of the database
b) The first time you save data
c) When closing the application
d) During auto save

4. access 2003 data base का फाइल एसटेशन ह ।
a) Exe
b) Doc
c) Exe
d) Mdb

5. िरलेनल डाटाबेस कीमा म  येक टपल फीडस ्म  बटी होती ह  िजह  ——————- कहते ह ।
a) Relation
b) Queries
c) Record
d) Domains

6. Macro Design Window म  िनन म  से कौन से कॉलम नही ंहोते ह ।
a) Arguments
b) Comments
c) Conditions
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d) Actions

7. Data access pages के code को edit करने के िलए िकस ोग ाम का योग करते ह ।
a) Microsoft Script Editor
b) Microsoft Code Editor
c) Microsoft data access pages editor
d) None of above

8. डेटाबेस से डेटा को िकसी िनिचत एलीकेशन म  देखने के िलए एलीकेशन —————— का
योग करती ह ।
a) Module
b) Relational Model
c) Schema
d) Sub – schema

9. एक ऑरगेनाइजेशन म , डेटा ोसेिसंग फंशन के िलए िजमेदार एसीयिूटव ह ।
a) Pm
b) Dbms
c) Dp
d) Dpm

10. सबिधत थाई डाटा को रखने वाली फाइल ह ।
a) Random file
b) Transaction file
c) Master file
d) Sequential File

11. डाटाबेस म  टोर डाटा का सपणू िच —————- कहलाता ह ।
a) Record
b) Scheme
c) System flowchart
d) DBMS

12. िविभन फाइलो के डेटा को िलंक करने के िलए  DBMS  के ारा योग होने वाले डाटाबेस
टे चर को िकस-सी टम वािणत नही ं कर सकती ह ।
a) Relational
b) Structural
c) Network
d) All of the above
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13. डेटाबेस फोरमेस को ऑटीमाइज करने के िलये या िकया जाता ह ।
a) Set the record set type to snapshot
b) Use the compact and repair database tool
c) Create a replica of the database
d) All of the above

14. access help के अनुसार, डाटाबेस बनाने का अछा तरीका कौन सा ह ।
a) Start from data access pages and work backward
b) Sketch the deign of your database using a pencil and paper
c) Use the table analyzer to reverse-engineer your flat source data
d) None of above

15. यिद डेटाबेस म  डेटा का पाट  दो थानो ंपर संग िहत हो जाता ह  तो ।
a) Storage space is wasted
b) Changing the data is one spot will cause data inconsistency
c) If can be more easily accessed
d) Both a & b

Answer Sheet
1. Database पर पासवड लगाने के िलये, माइोसॉट एसेस ओपन िवंडो म  से ————— को
चुने।
Answer – d) Open exclusive

2. Input Mask Wizard एटर करने के िलये।
Answer – d) Click on the three dots to the right or the input mask entry field

3. एसेस म  डेटाबेस कब सेव होता ह ।
Answer – a) At the beginning of the database

4. access 2003 data base का फाइल एसटेशन ह ।
Answer – d) Mdb

5. िरलेनल डाटाबेस कीमा म  येक टपल फीडस ्म  बटी होती ह  िजह  ——————- कहते ह ।
Answer – d) Domains

6. Macro Design Window म  िनन म  से कौन से कॉलम नही ंहोते ह ।
Answer – c) Conditions
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7. Data access pages के code को edit करने के िलए िकस ोग ाम का योग करते ह ।
Answer – a) Microsoft Script Editor

8. डेटाबेस से डेटा को िकसी िनिचत एलीकेशन म  देखने के िलए एलीकेशन —————— का
योग करती ह ।
Answer – d) Sub – schema

9. एक ऑरगेनाइजेशन म , डेटा ोसेिसंग फंशन के िलए िजमेदार एसीयिूटव ह ।
Answer – b) Dbms

10. सबिधत थाई डाटा को रखने वाली फाइल ह ।
Answer – c) Master file

11. डाटाबेस म  टोर डाटा का सपणू िच —————- कहलाता ह ।
Answer – b) Scheme

12. िविभन फाइलो के डेटा को िलंक करने के िलए  DBMS  के ारा योग होने वाले डाटाबेस
टे चर को िकस-सी टम वािणत नही ं कर सकती ह ।
Answer – b) Structural

13. डेटाबेस फोरमेस को ऑटीमाइज करने के िलये या िकया जाता ह ।
Answer – b) Use the compact and repair database tool

14. access help के अनुसार, डाटाबेस बनाने का अछा तरीका कौन सा ह ।
Answer – b) Sketch the deign of your database using a pencil and paper

15. यिद डेटाबेस म  डेटा का पाट  दो थानो ंपर संग िहत हो जाता ह  तो ।
Answer – d) Both a & b
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ऍम एस एसेस भाग – 11 (िहंदी म )
1. RDBMS पैकेज एक बार म  एक से अिधक फाइल म  डाटा को मैनेज कर सकता ह । यह फाइस
को िकस कार संयोिजत करता ह ।
a) Tables
b) Relations
c) Tuple
d) Both a & b

2. DBMS का उपयोग करने के िलए यह समझने के िलए महवपणू ह ।
a) The physical schema
b) All sub schemas that the system support
c) One sub schema
d) Both a & b

3. एक िलट लाटनेम, फट नेम, एडरेस और िपन कोड रखती ह  यिद िलट म  सभी लोगो ं के
लाटनेम व िपन कोड समान ह  तो कौन-सी की उपयोगी ह ।
a) The pin code
b) The last name
c) A compound key consisting of the first name and the last name
d) All of the above

4. एिसस बेिसक के साथ योग करने के िलए कौन सा एिडटर उपलध ह ।
a) The visual basic 1.0 editor
b) Notepad
c) The QuickBasic editor
d) All of above

5. कौन सा कथन असय ह ।
a) A relationship establishes the association between common fields in two tables.
b) An auto number field can be related to a field of either type auto number of
type text.
c) Joins specify that each pair of rows that satisfy the join conditions will be
combined in the result to from a single row.
d) Access will automatically create a join only if the field names in both tables are
the same.

6. MS Access जेट वेरी इंजन का योग करता है जो —————- योग करता ह ।
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a) MS SQL Server
b) Full Fledged SQL
c) Dialect of SQL
d) None of above

7. िनन म  से कौन अंितम िकये गये एशन को िरवस नही ंकरता।
a) Choose edit, undo command
b) Click undo button
c) Press ctrl+x
d) Press esc

8. MS Access म  lookup field िलट बॉस या कॉबो ंबॉस के कटेट को िरेश करने के
िलये –
a) F4 or ALT+DOWN ARROW
b) DOWN ARROW
c) PAGE DOWN
d) F9

9. MS Access म , िथत database को खोलने के िलये-
a) Ctrl + N
b) Ctrl + O
c) Alt + F4
d) None of these

10. MS – Access म  कॉबो बॉस को खोलने के िलये –
a) F4 or Alt + Down Arrow
b) Down Arrow
c) Page Down
d) F9

11. करट या िसलेिटड ऑजेट को िंट करने के िलये हम िकस कंुजी का योग करते ह ।
a) Ctrl + P
b) P or Ctrl + P
c) S
d) C or Esc

12. MS Access म , ALT+F11 का योग —————- के िलए करते ह ।
a) Display the control menu
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b) Display the shortcut menu
c) Close the active window
d) None of these

13. फॉट बदलने के िलए िकस Shortcut का योग करते ह ।
a) Ctrl + F
b) Alt + Ctrl + F
c) Shift + Alt + F
d) Ctrl + shift + F

14. सवािधक योग िकये जाने वाले कमांडस ् व टूल की  quick  access  के िलये या योग हो
सकता ह ।
a) Status bar
b) Tool bar
c) Menu bar
d) Title bar

15. िनन म  से या DBMS का लाभ नही ंह ।
a) Independence of data
b) Redundancy data
c) Sharing of data
d) Centralized management

Answer Sheet
1. RDBMS पैकेज एक बार म  एक से अिधक फाइल म  डाटा को मैनेज कर सकता ह । यह फाइस
को िकस कार संयोिजत करता ह ।
Answer – d) Both a & b

2. DBMS का उपयोग करने के िलए यह समझने के िलए महवपणू ह ।
Answer – c) One sub schema

3. एक िलट लाटनेम, फट नेम, एडरेस और िपन कोड रखती ह  यिद िलट म  सभी लोगो ं के
लाटनेम व िपन कोड समान ह  तो कौन-सी की उपयोगी ह ।
Answer – c) A compound key consisting of the first name and the last name

4. एिसस बेिसक के साथ योग करने के िलए कौन सा एिडटर उपलध ह ।
Answer – b) Notepad
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5. कौन सा कथन असय ह ।
Answer – b) An auto number field can be related to a field of either type auto
number of type text.

6. MS Access जेट वेरी इंजन का योग करता है जो —————- योग करता ह ।
Answer – c) Dialect of SQL

7. िनन म  से कौन अंितम िकये गये एशन को िरवस नही ंकरता।
Answer – c) Press ctrl+x

8. MS Access म  lookup field िलट बॉस या कॉबो ंबॉस के कटेट को िरेश करने के
िलये –
Answer – d) F9

9. MS Access म , िथत database को खोलने के िलये-
Answer – b) Ctrl + O

10. MS – Access म  कॉबो बॉस को खोलने के िलये –
Answer – a) F4 or Alt + Down Arrow

11. करट या िसलेिटड ऑजेट को िंट करने के िलये हम िकस कंुजी का योग करते ह ।
Answer – a) Ctrl + P

12. MS Access म , ALT+F11 का योग —————- के िलए करते ह ।
Answer – d) None of these

13. फॉट बदलने के िलए िकस Shortcut का योग करते ह ।
Answer – d) Ctrl + shift + F

14. सवािधक योग िकये जाने वाले कमांडस ् व टूल की  quick  access  के िलये या योग हो
सकता ह ।
Answer – b) Tool bar

15. िनन म  से या DBMS का लाभ नही ंह ।
Answer – b) Redundancy data
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ऍम एस एसेस भाग – 12 (िहंदी म )
1. “सही सचूना िनमाण” का या अथ ह ।
a) Data redundancy
b) Data consistency
c) Data recovery
d) None of these

2. DBA से तापय ह ।
a) Database administration
b) Database administrator
c) Database application
d) None of these

3. DBMS का मलू उेय या ह ।
a) Data non-redundancy
b) Data consistency
c) Data recovery
d) All of the above

4. RDBMS िनभर ह ।
a) Relationships
b) Hierarchic
c) Tree structure
d) None of these

5. HDBMS से तापय ह ।
a) Home database management system
b) Hierarchical database management system
c) High database management system
d) None of above

6. HDBMS रखता ह ।
a) Tree structure
b) Graph structure
c) Node structure
d) None of these
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7. NDBMS रखता ह ।
a) Tree structure
b) Graph structure
c) Node structure
d) None of these

8. codd,s िनयम ह ।
a) 10
b) 11
c) 12
d) 13

9. codd का थम िनयम ह ।
a) Representation of information
b) Guaranteed access
c) Systematic treatment of null value
d) Dynamic on-line catalogue based on relationship model

10. डेटाबेस िडजाइन का थम चरण ह ।
a) Gathering and analyzing the require – ments
b) Conceptual design
c) Implementation design
d) Physical design

11. डेटाबेस िडजाइन का दसूरा चरण ह ।
a) Gathering and analyzing the require – ments
b) Conceptual design
c) Implementation design
d) Physical design

12. डेटाबेस िडजाइन का तीसरा चरण ह ।
a) Gathering and analyzing the require – ments
b) Conceptual design
c) Implementation design
d) Physical design

13. डेटाबेस िडजाइन का अंितम चरण ह ।
a) Gathering and analyzing the require – ments
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b) Conceptual design
c) Implementation design
d) Physical design

14. हम डेसाबेस को ——————— चरणो ंम  िडजाईन करते ह ।
a) 1
b) 2
c) 3
d) 4

15. E-R का अथ ह ।
a) Every – Relationship
b) Entity – Relationship
c) Both (a) & (b)
d) None of the above

Answer Sheet
1. “सही सचूना िनमाण” का या अथ ह ।
Answer – d) None of these

2. DBA से तापय ह ।
Answer – b) Database administrator

3. DBMS का मलू उेय या ह ।
Answer – d) All of the above

4. RDBMS िनभर ह ।
Answer – a) Relationships

5. HDBMS से तापय ह ।
Answer – b) Hierarchical database management system

6. HDBMS रखता ह ।
Answer – a) Tree structure

7. NDBMS रखता ह ।
Answer – b) Graph structure

8. codd,s िनयम ह ।
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Answer – c) 12

9. codd का थम िनयम ह ।
Answer – a) Representation of information

10. डेटाबेस िडजाइन का थम चरण ह ।
Answer – a) Gathering and analyzing the require – ments

11. डेटाबेस िडजाइन का दसूरा चरण ह ।
Answer – b) Conceptual design

12. डेटाबेस िडजाइन का तीसरा चरण ह ।
Answer – c) Implementation design

13. डेटाबेस िडजाइन का अंितम चरण ह ।
Answer – d) Physical design

14. हम डेसाबेस को ——————— चरणो ंम  िडजाईन करते ह ।
Answer – d) 4

15. E-R का अथ ह ।
Answer – b) Entity – Relationship
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ऍम एस एसेस भाग – 13 (िहंदी म )
1. एिटटी एक ————- ह ।
a) Field
b) Attribute
c) Object
d) Tuple

2. एिटटी सेट एक —————— ह ।
a) Set of field
b) Set of attribute
c) Set of object
d) Set of tuple

3. E-R मॉडल —————– ह ।
a) Physical model
b) Conceptual model
c) Both of the above
d) none of these

4. DLL से तापय ह ।
a) Data link libraries
b) Data library link
c) Dynamic link library
d) Dynamic library link

5. DAP डेटाबेस से —————— पेज बनाने के िलए योग होता ह ।
a) XML
b) FTP
c) RDBMS
d) HTML

6. DAP से तापय ह ।
a) Data access page
b) Dynamic access page
c) Default access page
d) None of the above
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7. ——————- का योग आवयक सचूना के प म  एक ोफेनल ेजटेशन तैयार करने के
िलए िकया जाता ह ।
a) Field
b) Attributed
c) Records
d) Tuple

8. डेटाबेस म  िकये जाने वाले काय को वत : चलाने के िलये ——————- का योग करते ह ।
a) Field
b) Attributed
c) Macros
d) Tuple

9. MS Access 2002 म  —————— का योग िकसी संबंिधत ियाओं के समहू को वत :
चलाने के िलए िकया जाता ह ।
a) Modules
b) Attribute
c) Form
d) Tuple

10. MS Access 2002 के िलये —————–MBs RAM यनूतम ाथिमक आवयकता ह ।
a) 128
b) 64
c) 256
d) 512

11. MS Access ————— का भाग ह ।
a) MS DOS
b) Windows
c) MS Office
d) None of the above

12. MS Access —————– ह ।
a) Application software
b) System software
c) Utility software
d) Operating system

ANKAJ INFOTECH



13. सबिधत सचूनाओं या डाटा के समहू को ——————- कहते ह ।
a) Database
b) Application
c) Both of the above
d) None of these

14. िनन म  से कौन MS Access की माय IDE ह ।
a) Menu bar
b) Status bar
c) Design bar
d) All of the above

15. IDE का पणू नाम या ह ।
a) Integrated development environment
b) Integrated data environment
c) Integrate development environment
d) None of these

Answer Sheet
1. एिटटी एक ————- ह ।
Answer – c) Object

2. एिटटी सेट एक —————— ह ।
Answer – c) Set of object

3. E-R मॉडल —————– ह ।
Answer – b) Conceptual model

4. DLL से तापय ह ।
Answer – c) Dynamic link library

5. DAP डेटाबेस से —————— पेज बनाने के िलए योग होता ह ।
Answer – d) HTML

6. DAP से तापय ह ।
Answer – a) Data access page

7. ——————- का योग आवयक सचूना के प म  एक ोफेनल ेजटेशन तैयार करने के
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िलए िकया जाता ह ।
Answer – c) Records

8. डेटाबेस म  िकये जाने वाले काय को वत : चलाने के िलये ——————- का योग करते ह ।
Answer – c) Macros

9. MS Access 2002 म  —————— का योग िकसी संबंिधत ियाओं के समहू को वत :
चलाने के िलए िकया जाता ह ।
Answer – a) Modules

10. MS Access 2002 के िलये —————–MBs RAM यनूतम ाथिमक आवयकता ह ।
Answer – b) 64

11. MS Access ————— का भाग ह ।
Answer – c) MS Office

12. MS Access —————– ह ।
Answer – a) Application software

13. सबिधत सचूनाओं या डाटा के समहू को ——————- कहते ह ।
Answer – a) Database

14. िनन म  से कौन MS Access की माय IDE ह ।
Answer – d) All of the above

15. IDE का पणू नाम या ह ।
Answer – a) Integrated development environment
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ऍम एस एसेस भाग – 14 (िहंदी म )
1. िनन म  कौन-सी की माय ह ।
a) Primary key
b) Candidate key
c) Composite key
d) All of the above

2. —————— एटीयटूस ्का सेट ह ।
a) Primary key
b) Candidate key
c) Composite key
d) Super key

3. ER model म  आयत दशाता ह ।
a) Entity set
b) Attribute
c) Relation between entity sets
d) Relation between entity sets and attributes

4. ER Model म  अडाकार दशाता ह ।
a) Entity set
b) Attribute
c) Relation between entity sets
d) Relation between entity sets and attributes

5. ER Model म  डायमड दशाता ह ।
a) Entity set
b) Attribute
c) Relation between entity sets
d) Relation between entity sets and attributes

6. ER Model म  रेखा दशाती ह ।
a) Entity set
b) Attribute
c) Relation between entity sets
d) Relation between entity sets and attributes
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7. MS Access Window को बद करने के िलये-
a) Use alt+F4
b) Click close (x) button
c) Click file then exit
d) All of the above

8. DCL से तापय ह ।
a) Data control language
b) Data control location
c) Both of the above
d) None of the above

9. DML से तापय ह ।
a) Data manipulation language
b) Data main location
c) Both of the above
d) None of the above

10. DFD से तापय ह ।
a) Data flow diagram
b) Data filter disk
c) Both of the above
d) None of the above

11. कौन DBMS का मुय घटक ह ।
a) Data
b) Hardware
c) Software
d) All of the above

12. DBMS के —————— मुय घटक ह ।
a) 1
b) 2
c) 3
d) 4

13. DBMS आिक टेचर के —————– मुय घटक ह ।
a) 1
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b) 2
c) 3
d) 4

14. िनन म  से कौन DBMS आिक टेचर का भाग ह ।
a) External level
b) Conceptual level
c) Internal level
d) All of the above

15. OODBMS या ह ।
a) Object oriented data base management system
b) Object organized data base management system
c) Organization oriented data base management system
d) None of these

Answer Sheet
1. िनन म  कौन-सी की माय ह ।
Answer – d) All of the above

2. —————— एटीयटूस ्का सेट ह ।
Answer – b) Candidate key

3. ER model म  आयत दशाता ह ।
Answer – a) Entity set

4. ER Model म  अडाकार दशाता ह ।
Answer – b) Attribute

5. ER Model म  डायमड दशाता ह ।
Answer – c) Relation between entity sets

6. ER Model म  रेखा दशाती ह ।
Answer – d) Relation between entity sets and attributes

7. MS Access Window को बद करने के िलये-
Answer – d) All of the above

8. DCL से तापय ह ।
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Answer – a) Data control language

9. DML से तापय ह ।
Answer – a) Data manipulation language

10. DFD से तापय ह ।
Answer – a) Data flow diagram

11. कौन DBMS का मुय घटक ह ।
Answer – d) All of the above

12. DBMS के —————— मुय घटक ह ।
Answer – d) 4

13. DBMS आिक टेचर के —————– मुय घटक ह ।
Answer – c) 3

14. िनन म  से कौन DBMS आिक टेचर का भाग ह ।
Answer – d) All of the above

15. OODBMS या ह ।
Answer – a) Object oriented data base management system
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ऍम एस एसेस भाग – 15 (िहंदी म )
1. DDBMS या ह ।
a) Digital data base management system
b) Dynamic data base management system
c) Derived data base management system
d) Distributed data base management system

2. ER मॉडल का मुय घटक कौन ह ।
a) Entity
b) Attributes
c) Relationships
d) All of the above

3. ER मॉडल का योग होता ह ।
a) RDBMS
b) NDBMS
c) HDBMS
d) All of the above

4. ोग ािमंग टेटमेट के सैट को कहते ह ।
a) Entity
b) Attributes
c) Relationships
d) Macro

5. MS Access की एटेशन ह ।
a) .mba
b) .mca
c) .Mdb
d) .mca

6. MAOL से तापय ह ।
a) Microsoft Access object library
b) Microsoft Access object literals
c) Microsoft Access oriented library
d) Microsoft Access object oriented library
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7. MS Access, MS MQL से ——————– ह ।
a) Slower
b) Expensive
c) Cheaper
d) All of the above

8. MS Access ह ।
a) Database Application Program
b) System Software
c) Both (a) & (b)
d) None of the above

9. MS Access को इस कपनी ने बनाया था।
a) Microsoft
b) IBM
c) Accenture
d) None of the above

10. डाटाबेस ह ।
a) Group of information
b) Only information
c) Both (a) & (b)
d) None of the above

11. डाटाबेस टोर होता ह ।
a) Computer
b) DBMS
c) SQL
d) None of the above

12. DBMS का परूा नाम ह ।
a) Daily basis management system
b) Database management system
c) Daily basis management software
d) None of the above

13. डाटाबेस का उेय ह ।
a) Storing
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b) Gathering
c) Both (a) & (b)
d) None of above

14. िनन म  से ाइमरी ऑजेट ह ।
a) Field
b) ROW
c) Column
d) Table

15. टेबल म  डाटा टोर होता ह ।
a) Sequence
b) Tabular
c) Ascending
d) None Of the Above

Answer Sheet
1. DDBMS या ह ।
Answer – d) Distributed data base management system

2. ER मॉडल का मुय घटक कौन ह ।
Answer – d) All of the above

3. ER मॉडल का योग होता ह ।
Answer – d) All of the above

4. ोग ािमंग टेटमेट के सैट को कहते ह ।
Answer – d) Macro

5. MS Access की एटेशन ह ।
Answer – c) .Mdb

6. MAOL से तापय ह ।
Answer – a) Microsoft Access object library

7. MS Access, MS MQL से ——————– ह ।
Answer – c) Cheaper

8. MS Access ह ।
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Answer – a) Database Application Program

9. MS Access को इस कपनी ने बनाया था।
Answer – a) Microsoft

10. डाटाबेस ह ।
Answer – a) Group of information

11. डाटाबेस टोर होता ह ।
Answer – b) DBMS

12. DBMS का परूा नाम ह ।
Answer – b) Database management system

13. डाटाबेस का उेय ह ।
Answer – c) Both (a) & (b)

14. िनन म  से ाइमरी ऑजेट ह ।
Answer – d) Table

15. टेबल म  डाटा टोर होता ह ।
Answer – b) Tabular
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dEI;wVj % ifjp; ,oa fodkl Øe 

^dEI;wVj*  

 कम्प्यूटर शब्द की उत्ऩत्त्ि अॊगे्रजी के 
‘Compute*  शब्द से मानी जािी है 
त्जसका अर्थ है गणना करना। कम्प्यूटर 
त्जसे हहन्दी में ‘अभिकभऱत्र अर्वा सगॊणक 
कहा जािा है को सामान्यिया एक ऐसे यॊत्र 
के रूऩ में जाना जािा है। जो अत्यन्ि 
िीव्रगति से गणनाएॉ करने में सऺम है।  
tks blds vFkZ dks vkSj Hkh vf/kd O;kid cuk nsrs gS & 

 

 

C&Calcutation&¼x.kuk½  Common  

O&Operative & ¼fØ;k'khy½ Oriented   

M&Mechanics & ¼;kfU=dh½  Machine  

P&Processing & ¼izfØ;k½ Particularly   

U&Useful  & ¼mi;ksxh½ United   

T&Thesaurus & ¼'kCdks"k½  Technical 

E&Extensive & ¼foLr`r½  Educational 

R&Research  & ¼vuqla/kku 'kks/k½ Research  

  

vr% ^dEI;wVj* dk rkRi;Z ,d ,sls ;U= ls gS] ftldk 

mi;ksx x.kuk izfØ;k] ;kfU=dh] vuqla/kku] 'kks/k vkfn 

dk;kZsa eas fd;k tkrk gSA  

 

dEI;wVj dk laf{kIr fodkl Øe %& 

dEI;wVj dk fodkl Øe 3000 o"kZa iqjkuk gSA phu us 

lcls igys x.kuk ;a= vcsdl dk vfo"dkj fd;k FkkA 

;g ,d ;kaf=d fMokbl gSA 17oha 'krkCnh esa Qzkal ds 

xf.krK Cyst ikLdy us ,d ;kaf=d vadh; x.kuk ;a=- 

lu~ 1645 eas fodflr fd;k gSA bl e'khu dks ,fMax 

e'khu dgrs gSA D;ksafd ;g e'khu dsoy tksM ;k ?kVk 

ldrh FkhA   

tsdkM~Zl ywe (Jacquard Loom):-lu~ 1801 esa 

Qzkalhlh cqudj tkslsQ us diM+s cquus ds ,sls ywe  dk 

vkfo"dkj fd;k tks diM+ksa esa Lor% gh fMtkbu ;k iSVuZ 

nsrk FkkA 

pkYlZ cScst dk fMQjsal baftu:- pkYlZ cScst us lu~ 

1822 esa ,d e'khu dk fuekZ.k fd;k ftldk O;; 

fczfV'k ljdkj ogu fd;kA ml e'khu dk uke 

fMQjsUl baftu j[kk x;kA bl e'khu eas fx;j vkSj 

'kk¶V yxs FksA vkSj ;g Hkki ls pyrh FkhA  
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gksysfjFk lsall VscqysVj (Hollerith Census 

Taulator) 

lu~ 1890 esa dEI;wVj ds bfrgkl eas ,d vkSj egRoiw.kZ 

?kVuk gqbZ og Fkh vesfjdk dh tux.kuk dk dk;ZA lu~ 

1890 ls iwoZ tux.kuk dk dk;Z ikjEifjd rjhdksa ls 

fd;k tkrk FkkA 

1. Aiken and Mark 1 ¼vkbdsu vkSj ekdZ &1½:-

lu~  1940 eas Electromechanical Computing 

vius f'k[kj ij igq¡p pqdh FkhA vkbZ ch ,e ds pkj 

शीषथ bathfu;jkas o gkWoMZ vkbZdsu ls lu~ 1944 eas ,d 

e'khu dks fodflr fd;k vkSj bldk vkf/kdkfjd uke 

Automatic Sequence Controlled 

Calculator j[kkA 

2. ABC:-vkbdsu vkSj ch ,e ds ekdZ&1 dh rduhdh 

ubZ bysDVªkWfuDl rduhdh vkus ls iqjkuh gks x;h FkhA 

ubZ bySDVªkWfuDl rduhdh esa dksbZ ;kaf=d iqtkZ 

lapkfyr djus dh vko';drk ugha FkhA tcfd ekdZ&1 

,d fo|rq e'khu FkhA  

 

3. The ENIAC (1993-46):-bl dEI;wVj dk iwjk 

uke Electronic Numerical Integrator and 

Calculator gSA bldk fodkl vkehZ ds fy;s fd;k 

x;k FkkA 

 

4. The EDVAC (1946-52):- bl dk iwjk uke 

Electronic Discrete Variable Automatic 

Computer FkkA ;g igyk fMftVy dEI;wVj FkkA  

 

5. The EDSAC (1947-49):- bl dk iwjk uke 

Electronic Delay Variable Automatic 

Calculator FkkA ;g igyk dEI;wVj Fkk ftl ij 

izksxzke dks ju fd;k x;k FkkA   

 

6.The UNIVAC-I (1951):- bl dk iwjk uke 

Universal  Automatic Computer FkkA ;g 

igyk fMftVy dEI;wVj FkkA vkSj ;g O;kikj esa iz;ksx 

gksus okyk izFke dEI;wVj FkkA IBM us 701 

Commercial Computer rS;kj djk FkkA  

 

 

 

¼dEI;wVj dh ih<+h;k¡½ 

 izFke ih<+h (1945-1955)%& dEI;wVj dh izFke ih<+h 

dh 'kq:vkr 1945 ls ekuh tkrh gSA bl tujs'ku esa 

Vacuum Tube Technology dk iz;ksx fd;k 

x;k FkkA blesa e'khu Hkk"kk dk iz;ksx fd;k x;k FkkA  
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bleas eseksjh ds rkSj ij pqEcdh; Vsi ,oa iapdkMZ dk 

iz;ksx fd;k tkrk FkkA  

 

f}rh; ih<+h (1955-1964) %& f}rh; ih<+h dh 

'kq:vkr 1956 ls 1964 rd ekuh tkrh gSA bl ih<+h esa 

Transistor dk iz;ksx fd;k x;k FkkA ftldk 

fodkl Willom Shockly ने 1947 esa fd;k FkkA 

blesa vlsEcyh Hkk"kk dk iz;ksx fd;k x;k FkkA  blesa 

eseksjh ds rkSj ij pqEcdh; Vsi dk iz;ksx fd;k tkus 

yxk FkkA   

 

िीसरी ऩीढ़ी (1964-1975) :- dEI;wVj dh rhljh 

ih<+h dh 'kq:vkr 1964 ls ekuh tkrh gSA bl tujs'ku 

esa vkbZ lh dk iz;ksx fd;k tkus yxk FkkA IC dk iwjk 

uke Integrated Circuit gSA IC dk fodkl 1958 

esa Jack Kilby us fd;k FkkA blesa IC 

Technology (SSI) dk iz;ksx fd;k x;k FkkA SSI 

dk iwjk uke Small Scale Integration gSA bleas 

gkbZ ysfoy Hkk"kk dk iz;ksx izksxzkfeZx ds fy;s fd;k 

tkrk FkkA blesa eseksjh ds rkSj ij pqEcdh; fMLd dk 

iz;ksx fd;k tkus yxk FkkA   

 

pkSFkh ih<+h:- dEI;wVj dh pkSFkh ih<+h dh 'kq:vkr 1975 

ls 1989 rd ekuh tkrh gSA bl tujs'ku esa vkbZ lh 

dh vk/kqfud rduhdh dk iz;ksx fd;k tkus yxk FkkA 

IC dh ;g rduhdh VLSI Fkh bldk iwjk uke 

Very Large-Scale Integration gSaA blesa gkbZ 

ysfoy Hkk"kk dk iz;ksx izksxzkfeaax fd fy;s fd;k tkrk 

FkkA   

 

प ांचव ां ih<+h :- dEI;wVj dh ऩाॊचवीॊ ih<+h dh 

'kq:vkr 1989 ls ekuh tkrh gSA bl tujs'ku esa vkbZ 

lh dh vk/kqfud rduhdh dk iz;ksx fd;k tkus yxk 

FkkA IC dh ;g rduhdh ULSI Fkh bldk iwjk uke 

Ultra Large Scale Integration gSaA 
blesa gkbZ ysfoy Hkk"kk dk iz;ksx izksxzkfeaax fd fy;s 

fd;k tkrk tks vf/kd ljy gSA bu Hkk"kkvksa esa GUI 

Interface dk iz;ksx fd;k tkrk gSA    

 

vxyh ih<+h ds dEI;wVj  

1. uSuks dEI;wVj &uSuks Lrj ¼10
&9m½ ij fufeZr 

uSuks V~;wc~l ds iz;ksx ls vR;Ur NksVs o 

fo'kky {kerk okys dEI;wVj ds fodkl dk 

iz;kl fd;k tk jgk gSA  

2. DokaVe dEI;wVj &;g izdk'k ds DokaVe 

fl)kUr ij vk/kkfjr gS ftlesa vkadM+ksa dk 

laxzg.k vkSj lalk/ku DokaVe d.k dgrs gSA ;s 

d.k ;qXe esa jgrs gSa vkSj bUgsa ^D;w fcV~l* 

dgrs gSA  

,Iyhds'ku ij dEI;wVj vk/kkj ds प्रक र  

-,Iyhds'ku ds vk/kkj ij dEI;wVj rhu izdkj ds gksrs 

gSA  

1. Analog Computer: tks HkkSfrd ek=kvksa dks 

ukius dk dk;Z djrs gSA ,ukykWx dEI;wVj dk 

iz;ksx foKku ,oa Engineering  ds {kS+= esa fd;k 

tkrk gSA D;ksfd bu {kS=ksa eas ifjeki dk iz;ksx 

vf/kd gksrk gSA   

2. Digital Computer: ;g dEI;wVj vadks dh 

x.kuk djrs gSA vf/kdka'kr% dEI;wVj fMftVy 

dEI;wVj fMfyVy dEI;wVj gh gksrs gSA  
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3. Hybrid Computer: os dEI;wVj tks ,ukykWu 

,oa fMftVy dEI;wVj nksuksa dk dk;Z djrs gSA 

mnkgj.k Petrol Pump  ;g pertrol  vkfn dks 

ukirk gS vkSj mlds ewY; dh x.kuk Hkh djrk gSA  

mˆs'; ds vk/kkj ij dEI;wVj nks izdkj ds gksrs gSA  

1. General Purpose Computer: ftlls 

lekU; dk;Z fd;s tkrs gSAbudk iz;ksx ?kjksa ,oa 

nqdkuksa fd;k tkrk gSA  

2. Special Purpose Computer: ;g dEI;wVj 

fo'ks"k dk;Z ds fy;s rS;kj fd;s tkrs gSA budk 

iz;ksx fuEu {ks=ksa esa fd;k tkrk gSA tSls ekSle 

foKku] d`f"k foKu] ;q)] ,oa varfj{k vkfn foKku 

esa bldk iz;ksx gksrk gSA  

vkdkj ,oa dk;Z djus ds vk/kkj ij dEI;wVj fuEuizdkj 

ds gksrs gSA  

1. Micro  Computer:- ;g dEI;wVj vkdkj esa 

NksVs gksrs gSA bu dEI;wVj dk fodkl 1970 ds 

n'kd esa gqvk FkkA bu dEI;wVj eas ekbdzks izkslslj 

dk iz;ksx fd;k tkrk FkkA bu dEI;wVlZ dks PC Hkh 

dgk tkrk gSA   

 PC dks fuEu Hkkxksa esa ck¡Vk x;k gSA   

a. Desktop Computer  

b. Laptop Computer  

c. Palmtop Computer  

d. Notebook Computer  

e. Tablet Computer  

 Desktop Computer:- Desktop 

Computer os dEI;wVj gksrs gSA ftudks Vsfcy 

ij j[kdj pyk;k tkrk gSA  

 

 

 Laptop Computer:- Laptop 

Computer os gksrs gSA ftudks xksnh eas j[kdj 

pyk;k tkrk gSA ;g lkbZt esa cgqr NksVs gksrs gSA 

bu dEI;wVjlZ dks ,d LFkku ls nwljs LFkku ij 

vklkuh ls ys tk ldrs gSA buesa ikoj ds fy;s 

cSVjh dk iz;ksx gksrk gSA  

 

 

 

 Palmtop Computer:- ;g dEI;wVj 

Laptop Computer ls NksVs gksrs gSA ftudks 

gFksyh eas j[kdj pyk;k tkrk gSA budh dk;Z 

djus dh {kerk ysiVkWi ls FkksMh de gksrh gSA 
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 Notebook Computer:- Notebook 

computer Laptop Computer ds समान  

gh gksrs हैं  

 

 

 Tablet Computer:- ;g dEI;wVj cgqr gh 

NksVs dEI;wVj gksrs gSA ;g eksckbZy ls FkksMs cMs 

gksrs gSA ;g VpLdhu gksrs gSA 

    

 

 

 

2. Workstation Computer:- Workstation 

Computer dk iz;ksx NksVs O;kikj esa loZj ds 

:i eas fd;k tkrk gSA budh dk;Z djus dh {kerk 

ekbZdzks dEI;wVj dh vis{kk vf/kd gksrh gSA  

3. Mini Computer:- ;g oks dEI;wVj tks cM+h 

cM+h dEiuh;ksa ,oa ljdkjh vkWfQl eas loZj dEI;wVj 

ds dk;Z ds fy;s iz;ksx fd;s tkrs gSA  

PDP-8 First Mini Computer ftldk 

fodkl 1965 eas f;dk x;k FkkA A DEC 

Companyus cuk;k FkkA DECdk iwjk uke 

Digital Equipment Corporation gSA  

4. Mainframe Computer:- ;g oks dEI;wVj tks 

cMh cMh dEiuh;ksa ,oa ljdkjh vkWfQl eas loZj 

dEI;wjV ds dk;Z ds fy;s iz;ksx fd;s tkrs gSA bu 

dEI;wVjl esa ekbZdzks dEI;wVj dk iz;ksx Client ds 

rkSj ij fd;k tkrk gSA    

 dqNMainframe Computer fuEu gSA   

 IBM 4381, ICL 39, CDC Cyber etc.  

5.  Super Computer:-lqij dEI;wVj fo'ks"k izdkj 

ds dEI;wVj gksrs gSA budk fuekZ.k fo'ks"k dk;Z ds 

fy;s fd;k tkrk gSA ;g nqfu;k ds lcls rst vkSj 

cMs dEI;wVj gksrs gSA   

 Hkkjr dk igyk lqij dEI;wVj ije gSA  

 lqij dEI;wVj  ds dk;Z%& 

1. varfj{k ;k=k ds fy;s  

2. ekSle foKku dh tkudkjh Kkr ds fy;s   

3. ;q) ds fy;s   

 

कां प्यटूर सिस्टम के घटक  

1. Input 

2. Process 

3. Output  

4. Memory 

buiqV&;qfDr;k¡ (Input Devices):-  
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ekuoh; funs'kksZa dks dEI;wVj ds le>us ;ksX; ladsrksa eas 

ifjofrZr djus ds fy, ftu ;qfDr;kas dk iz;ksx fd;k 

tkrk gS mUgas ^buiqV ;qfDr;k¡ dgrs gSA tSls &dh 

&cksMZ] ekÅl vkfnA   

lh-ih-;w- &(C.P.U.) :- lh-ih-;w- dk dk;Z fn;s x;s 

MkVk dks izkslsl djds mlls vkmViqV :i eas 

lwpuk,sa@ifj.kke iznf'kZr djuk gksrk gSA  

CPU dks eq[;r;k rhu Hkkxksa eas ckaVk x;k gSA  

1. dUVªksy ;wfuV  

2. vFkZ eSfVd ykWftd ;wfVu  

3. eSeksjh  

¼1½ dUVªksy ;wfuV: dUVªksy ;wfuV dEI;wVj dh vkUrfjd 

fØ;kvkas dks lapkfyr djds] mUgas fu;fU=r djrh gSA 

rRi'pkr bu fØ;kvksa dk ,-,y-;w- rFkk eSeksjh eas 

vknku&iznku djrh gSA  

¼2½ vFkZ eSfVd ykWftd ;wfuV 

 tSlk fd uke ls gh Li"V gS] fd ;g ;wfuV lkHkh 

izdkj ds vFkZ eSfVd vkSj ykWftdy fØ;k;sa djrh gSA

 ,-,y-;w- dUVªksy ;wfuV ls MkVk rFkk funsZ'kkas dks 

izkIr djds mUgsa fØ;kfUor djrk gSA rRi'pkr~ MkVk 

rFkk funsZ'kkas dks lwpuk ds :i esa eSeksjh esa Hkst nsrk gSA  

¼3½ eSeksjh (Memory)  

eSeksjh eq[;r% nks izdkj dh gksrh gSA  

 1- eq[; eSeksjh(Main Memory): bl eSeksjh dks 

Main MemoryHkh dgk tkrk gSA ;g nks izdkj dh 

gksrh gSA  

   A. RAM  

   B. ROM   

2- lgk;d eSeksjh (Auxiliary Memory):  lgk;d 

eSeksjh mlesa ckgj pqEcdh; ek/;eksa tSls&gkMZ fMLd] 

¶ykWih fMLd] pqEcdh; Vsi vkfn ds :i esa gksrh gSA  

lhih;w dh xfr dks izHkkfor djus okys dkjd& 

1. 'kCn ijkl ¼Word Lenght½  

2. dEI;wVj ?kM+h  ¼System Clock½ 

3. lekUkkUrj x.kuk ¼Parallel 

Processing½  

4. dS'k eseksjh ¼Cache Memory½ &blds 

}kjk eseksjh ;wfuV rFkk dEI;wVj dh xfr ls 

chp leUo; LFkkfir fd;k tkrk gSA blls 

dEI;wVj dh xfr esa o`f) gksrh gSA 

 

मेमोरी  

मेमोरी:- ;g Computer dh LVksjst ;wfuV gSA ;g 

dEI;wVj dk egRoiw.kZ fgLlk gksrh gSA blesa ge MkVk 

izksxzke vkfn dks LVksj djds j[k ldrs gSA bldks ukius 

dh lkbZt ds vk/kkj ij dbZ ;wfuV gSA tSls ckbZV] 

fdykckbZV] esxkckbZV] xhxkckbZV ,oa VsjkcbZV blesa 

lcls NksVh ;wfuV ckbZV ,oa lcls cMh ;wfuV VsjkckbZV 

gksrh gSA   

;g nks izdkj dh gksrh gSA   

1.Primary Memory 

2. Secondary Memory   
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प्राइमरी मेमोरी  

प्राइमरी मेमोरी:- bl eSeksjh dks Main 

MemoryHkh dgk tkrk gSA ;g nks izdkj dh gksrh 

gSA  

   A. RAM  

   B. ROM   

RAM (Randam Access Memory)  

bldk iwjk uke Randam Access Memory gSA 

bldh fuEu fo'ks"krk,¡ gksrh gSA   

 bldks dEI;wVj dh izeq[k eSeksjh dgk tkrk gSA  

 ;g vLFkkbZ eSeksjh gksrh gSA vFkkZr~ bleas LVksj 

MkVk dEi;wVj can gksus ij fMfyV gks tkrk 

gSA ftldk iqu% izkIr ugha fd;k tk ldrk 

gSA  

 ;g Volatile Memory dgykrh gSA  

 ;g ,d Semiconditor or Filp Flop 

ls feydj cuh Memory gksrh gSA  
 ;g fuEu izdkj dh gksrh gSA tSls SRAM, 

DRAM SD RAM etc.  

SRAM:-bldk iwjk uke Staic Randam 

Access Memory gSA ;g Flip Flop ls feydj 

cuh gksrh gSA blfy;s ;g de Refresh gksrh gSA  

DRAM:- bldk iwjk uke Dyanamic 

Random Access Memory gSA ;g eSeksjh 

tYnh tYnh fjQzs'k gksrh gSA Refresh dk eryc 

Electronic Charge or Dischange ls gksrk 

gSA ;g ,d सेकॊ ड esa gtkjksa ckj ररफे्रश gksrh gSA 

vr%  bldh गति धीमी gksrh gSA ;g vU; jse dh 

vis{kk lLrh gksrh gSA  

 

SD RAM:-bldk iwjk uke Synchoronous 

Dyanamic Randam Access Memory gSA  

 

NV RAM:- bldk iwjk uke Non Volatile 

Randam Access Memory gSA bl jse dk 

iz;ksx usVodZ fMokbl esa gkMZfMLd ds :i esa fd;k 

tkrk gSA ;g ,d eagxh eSeksjh gksrh gSA   

 

ROM (Read Only Memory) 

ROM dk iwjk uke Read Only Memory gSA 

;g dEI;wVj dh Primary Memory gksrh gSA ;g 
LFkkbZ eSeksjh gksrh gSA bleas dEI;wVj dks LVkVZ djus 

okys izkFkfed izksxzke ,oa सेहटॊग gksrh gSA ;g rhu 

izdkj dh gksrh gSA  

1. PROM   2. EPROM   

3. EEPROM  

1. PROM:- bldk iwjk uke Programble 

Read Only Memory gSA bl fpi esa ,d 

ckj izksxzke LVksj fd;k tk ldrk FkkA ;fn izksxzke esa 

=qfV (Error) gksus ij mlesa dksbZ lq/kkj ugha fd;k 

tk ldrk FkkA   

2. EPROM:- bldk iwjk uke Erasable 

Programmable Read Only Memory 

gSA bl fpi eas LVksj izksxzke eas lq/kkj fd;k tk 

ldrk FkkA fpi esa lq/kkj djus ds fy;s fpi dks 

cksMZ ls fudky dj ijkcSxuh (ultraviolet 

Ray) ds lkeus j[kk tkrk FkkA  

3. EEPROM:- bldk iwjk uke Electronic 

Erasable Programmable Read Only 
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Memory gSA bl fpi us EPROM dh leL;k 

dks nwj fd;k gSA bl fpi esa LVksj izksxzke ,oa MkVk 

eas lq/kkj djus ds fy;s fo|qr dk iz;ksx fd;k x;k 

FkkA vktdy ds enjcksMZ esa blh jkse dk iz;ksx 

fd;k tk jgk gSA  

िेकें डरी स्टोरेज डडव इि  

Secondary Storage Device dks Auxiliary 

Storage Device Hkh dgk tkrk gSA ;g dEI;wVj 

dk Hkkx ugha gksrkh gSA bldh Storage {kerk vf/kd 

gksrh gSA ,oa MkVk dks ,sDlsl djus fd xfr 

Primary Memory ls /kheh gksrh gSA  

MkVk dks ,sDlsl djus ds vk/kkj ij ;g rhu izdkj dh 

gksrh gSA   

1. Sequential Access Storage 

Device:- bl fØ;k esa Storage Data 

dks mlh Øe esa ,sDlsal fd;k tkrk gS ftl 

Øe esa LVksj fd;k tkrk gSA pqEcdh; Vsin 

blh dk mnkgj.k gSA  

2. Index Sequential Access 

Method:-  blesa MkVk dks sequential 

Access method ls gh MkVk dks ,sDlsl 

fd;k tkrk gSA ysfdu bleas MkVk dks LVksj 

djrs le; ,d baMsDl rS;kj dj fy;k tkrk 

gSA  

3. Direct Access Method:- blesa MkVk 

dks fdlh Hkh Øe esa ,sDlsl fd;k tk ldrk 

gSA ,oa fdlh Hkh Øe esa MkVk dks LVksj fd;k 

tk ldrk gSA bldh ,sDlsl xfr flfj;y 

,sDlsl dh rqyuk esa vf/kd gksrh gSA  

स्टोरेज डडव इि के प्रक र:  

1. Magnetic Tape:- Magnetic Tape 

,d LFkkbZ f}Ÿkh;d LVksjst fMokbt gSA bleas 

,d IykfLVd ds Vsi ij pqEcdh; inkFkZ 

(Magnetic oxide) dk ysiu jgrk gSA  

2. dkVsZat Vsi (Cartridge Tape):- bl Vsi 

dh pkSMkbZ pqEcdh; Vsi ls de gksrh gSA 1970 

ds n'kd ds var eas ?kjsyw dEI;wVjksa esa dkWEisDV 

dSlsV dk iz;ksx fd;k tkrk FkkA 

3. pqEcdh; fMLd (Magnetic Disk)  

vktdy MkVk dks LVksj djus ds fy;s dEI;wVjksa esa 

pqEcdh; fMLd dk iz;ksx fd;k tk jgk gSA pqEcdh; 

fMLd nks izdkj dh gksrh gSA   

1. Floppy Disk  

2. Hard Disk  

हाडथ डडस्क:- हाडथ डडस्क dk fodkl dEI;wVj eas 

MkVk dks LVksj djus ds fy;s fd;k x;k Fkk vkt dy 

bldk iz;ksx dEI;wVj ls vkxs c<dj dbZ {ks=ksa esa gks 

jgk gSA  

fMLd dh IysV esa Track and Sector gksrs gSA 

lsDVj eas MkVk LVksj gksrk gSA ,d lsDVj eas 512 ckbV 

MkVk LVksj gksrk gSA 

MkVk dks LVskj ,oa i<+us ds fy;s rhu rjg ds le; 

yxrs gSA tks fuEu gSA   

1. Seek Time:- fMLd eas MkVk dks jh<+ ;k 

jkbZV djus okys Track rd igqap esa yxk 

le; lhd Vkbe dgyrk gSA  
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2. Letancy time:- Track  esa MkVk ds 

Sector rd igqap esa yxk le; ysVsalh VkbZe 

dgykrk gSA  

3. Transfer Rate:- Sector esa MkVk dks 

fy[kus ,oa i<us esa tks le; yxrk gSA mls 

Transfer Rate dgk tkrk gSA   

फ्ऱॉऩी डडस्क:- फ्ऱॉऩी डडस्क dks fMDdsV ;k 

dsoy फ्ऱॉऩी Hkh dgk tkrk gSA bldk iz;ksx ekbdzks 

dEI;wVj esa gksrk gSA ;gka vkdkj ,oa lkbZt ds vk/kkj 

ij nks izdkj dh gksrh gSA   

1. Mini Floppy:- ;g vkdkj eas 5¼ bap 

dh gksrh है, laxzg.k {kerk 1.2 MB gksrh gSA 

budh Drive Hkh vkdkj esa blh ds vkdkj 

dh gksrh gSA   

2. Micro Floppy:- ;g vkdkj esa 3½ bap 

dh gksrh gSA budh laxzg.k {kerk 1.4 MB 

gksrh gSA                       

ऑत््टकऱ डडस्क: ओत््टकऱ डडस्क os fMLd 

gksrh gSA ftlesa MkVk dks jhM vkSj LVksj djus ds fy;s 

ykbZVk dk iz;ksx fd;k tkrk gSA vkWifVdy fMLd 

dgykrh gSA bl fMLV eas ,d jklk;fud inkFkZ dk ysi 

jgrk gSA 1 lhMh 2 MhohMh   

 

मेमोरी यूनिट   

 

 

 

इिपुट और आउटपुट डडव इि  

buiqV&;qfDr;k¡ (Input Devices):-  

ekuoh; funs'kksZa dks dEI;wVj ds le>us ;ksX; ladsrksa eas 

ifjofrZr djus ds fy, ftu ;qfDr;kas dk iz;ksx fd;k 

tkrk gS mUgas ^buiqV ;qfDr;k¡ dgrs gSA tSls &dh 

&cksMZ] ekÅl vkfnA   

buiqV fMokbl nks izdkj dh gksrh gSA  

1.Online  

2.Offline  

Online input device:- is fMokbl tks dEI;wVj 

ls connect  gksdj MkVk dks buiqV djus dk dk;Z 

djrh gSA  

vkuykbZu buiqV fMokbl dgykrh gSA tSls  

I. Keyboard  
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II. Mouse  

III. Scanner  

IV. Joy Strick 

V. Track ball  

VI. Digiting tablet  

VII. MICR 

VIII. OCR  

IX. OMR 

X. BCR 

XI. Light pen  

XII. Touch screen  

XIII. Voice Recognition  

 

Key board ¼dh cksMZ½ 

;g ,d lcls T;knk iz;ksx dh tkus okyh vkuykbZu 

buiqV fMokbl gSA A blls text, number, 

symbol vkfn dks dEI;wVj ds vanj buiqV fd;k 

tkrk gSA ,d LVWMZ dhcksMZ esa 101 dh gksrh gS  

dhcksMZ dh dks pkj Hkkxksa esa ckWVk x;k gSA   

1. Function key 2. Alfa - numeric 

keypad 3. Numeric key pad 4. Special 

key  

1. Function key:-  ;g dh dhcksMZ eas lcls Åij 

gksrh gSA budh la[;k ckjg (F1-F12) gksrh gSA  

1. F1 dEI;wVj ij dke djrs le; gesa enn 

dh vko';drk gksrh gSA  

2. F2 dEI;wVj ij bl dqath dh lgk;rk ls 

fdlh Hkh QksYMj ,oa Qkby dk uke cny 

ldrs gSA  

3. F3 dEI;wVj ij bl dqath dh lgk;rk ls 

fdlh Hkh QksYMj Qkby fp= vkfn dks [kkstus 

ds fy, dke esa fy;k tkrk gSA  

4. F4 dEI;wVj ij bl dqath dh lgk;rk 

baVjusV ,DlIyksj eas ,Mªl ckj [kqy tk,xhA 

vkSj Alt  ds lkFk F4 nckus ls pkyw izksxzke 

can gks tk,xkA   

5. F5 dEI;wVj dks bl dqath dh lgk;rk ls 

rktk (Refresh) dj ldrs gS vkSj osc ist 

dksa nqckjk yksM dj ldrs gSA  

6. F6 oMZ esa dke djrs le; bl dqath dks nks 

ckj nckus ls esuw ckj lfØ; gks tkrh gSA  

7. F7 oMZ esa dke djrs le; orZuh vkSj 

O;kdj.k ls lEcfU/k xyrh dks lq/kkjus ds fy, 

bl dqath dh lgk;rk yh tkrh gSA 

8. F8 dEI;wVj eas foaMks yksM djrs le; bl 

dqath dks nckdj cwV izfØ;k pkyw dh tk 

ldrh gSA  

9. F9 oMZ eas bl daqth dh lg;rk ls lysDlu 

dks gVk;k tkrkj gS vkSj ;g cwV izfØ;k pkyw 

djus ds dke esa Hkh yh tkrh gSA  

10. F10 dEI;wVj ij bl dqath dh lgk;rk 

izksxzke dh esuw ckj dks lafØ; djus ds dke esa 

yh tkrh gSA vkSj Shift ds lkFk F10 nckus 

ls MsLdVkWi ij Right Click dk dk;Z 

djrk gSA  

11. F11 baVjusV ,DlIyksj eas dke djrs le; 

bl dqath dh lgk;rk ls baVjusV ,DlIyksj 

dks Qqy LØhu ij ns[kk tk ldrk gSA  

12. F12 oMZ eas dk;Z djrs le; bl daqth dh 

lgk;rk ls Save as foaMks [kqy tkrh gSA 

vkSj QkbZy dks lso dj ldrs gSA 
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Alfa-Numeric keypad:-;g dh dhcksMZ ds 

e/; dk fgLlk gksrk gS ;g dh lcls egRoiw.kZ dh 

gksrh gSA blls A TO Z, a TO z, 0 TO 9 ~ 

! @ # $ % ^ & * ( )  

Numeric key:-;g dh cksMZ eas nk;s rjQ gksrh 

gSA blesa dqy 17 dh gksrh gSA  

Special Key:- budh la[;k dh cksMZ eas de 

gksrh gS buls dEI;wVj ds special dk;Z tkrs gSA 

tSls screen printing, scroll lock, 

insert, power button, home, End, 

Insert etc.  

Mouse ¼ekml½  

;g GUI interface eas lcls T;knk iz;ksx gksus 

okyh pointer input device gSA bldk fodkl 

1980 ds n'kd ds ckn fd;k x;k FkkA bldk vkdkj 

ekml ds leku gksus ds dkj.k bls ekml dgk tkrk 

gSA blesa dqy rhu cVu gksrs gsA Left and Right 

Button vkSj chp eas ,d Scroll button gksrk gSA  

ekml rhu izdkj ds gksrs gSA   

1. Mechanical Mouse  

2. Optical Mouse 

3. Wireless Mouse  

Mechanical Mouse¼;kaf=dh ekml½%& bu ekml 

dk iz;ksx 1990 ds n'kd esa fd;k tkrk gSA blesa ,d 

jcj dh xsan gksrh Fkh tks ekml ds [kksy ls FkksMh ckgj 

fudyh jgrh FkhA  

 

 

Optical Mouse ¼izdk'kh; ekml½%&optical 

mouse ,d u;s izdkj ds ekml gS vktdy bu 

ekml dk iz;ksx lcls T;knk gks jgk gSA  

 

 

Cordless Mouse :- ;g vkt ds vk/kqfud ;qx ds 

ekml gSA ;g ekml QzhDosUlh ds vk/kkj ij dk;Z djrs 

gSA blesa nks izeq[k dEiksusUVl transmitter and 

receiver gksrs gSA ;g electromagnetic 

signal ds :i esa ekml dh xfr rFkk fDyd djus 

dh lwpuk Computer dks Hksth tkrh gS fjlhoj 

dEI;wVj eas tksM+k tkrk gSA rFkk blesa blds Driver 

dks dEI;wVj eas install djuk iMrk gSA vkt ds 

dEI;wVjvksa eas ;g bu fcYV Hkh gksrk gSA   
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ge ekml ds lkFk dbZ izdkj dh fØ;k,a djrs gSa& 

ikWbfVax(Pointing):- tc ge ekml dks b/kj&m/kj 

f[kldk dj ekml ikWbaVj dks vius MsLdVkWi dh fdlh 

vkbdkWu ij ykrs gSa] rks bls ikWbaV djuk dgk tkrk gSA 

fDyfdax (Clicking):- tc ge ekml ikWbaVj dks 

fdlh vkbdkWu ;k izksxzke ij ykdj ekml ds ck,a cVu 

dks ,d ckj nckdj NksM+ nsrs gSa] rks ml fØ;k dks 

fDyd djuk dgk tkrk gS]  

Mcy fDyfdax (Double Clicking ):- tc ge 

ekml ds cka, cVu ls tYnh&tYnh nks ckj fDyd 

djrs gS] rks ml fØ;k dks Mcy fDyd djuk dgk 

tkrk gSA  

jkbV&fDyfdax (Right Clicking):- tc ge ekml 

ikWbaVj dks fdlh vkbdkWu ;k izksxzke ij ykdj ekml 

ds nk,a cVu dks fDyd djrs gS] rks bl fØ;k dks 

jkbV&fDyd djuk dgk tkrk gSA  

MªSfaxax  (Dragging):- tc ge ikWbaVj dks fdlh 

vk;dkWu ij ykdj ekml ds cka, cVu dks nckdj 

idM+ ysrs gS vkSj ekml cVu dks nck, j[kdj gh 

ekml ikWbaVj dks b/kj&m/kj ljdkrs gS] rks bl fØ;k 

dks [khapuk ;k MSªx djuk dgk tkrk gSA  

Scanner ¼LdSuj½  

LdSuj ,d vkWuykbZu buiqV fMokbl gSA blls ge 

lwpuk ,oa MkVk dks dEI;wVj ds vUnj lh/ks buiqV dj 

ldrs gSA blls fdlh Hkh fdrkc QksVks ,oa vU; MkVk 

dks i<dj mls dEI;wVj eas QksVks ds :i eas lso djrk 

gSA blls ge gkMZdkWih dks soft dkWih eas ifjofrZr dj 

nsrk gSA  

MICR Scanner:-  MICR  dk iz;ksx cSafdax eas 

vf/kd fd;k tkrk gSA cSad eas vf/kd la[;k esa pSd 

tkapus esa budk iz;ksx gksrk gSA  

 MICR Technology esa pSd ij fo'ks"k pqEcdh; 

L;kgh }kjk dSjsDVj Nkis tkrs gSA  

Optical Scanner:-blesa izdk'kh; fof/k ls izdk'k 

dSjsDVlZ ij Mkyk tkrk gSA blds mnkgj.k OCR, 

OMR and OBR   

 

 

OMR:- bldk iwjk uke Optical Mark 

Reader gSA ;g ,d ,slh fMokbl gS tks OMR 
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Sheet  ij isfUly ;k isu ds fpUg dh mifLFkfr vkSj 

vuqmifLFkfr dks tk dh mifLFkfr vkSj vuqmifLFkfr dks 

tk¡prh gSA vktdy bldk iz;ksx Competitive 

examination dh answer book dks Check 

fd;k tkrk gSA blds iz;ksx ls de le; eas lgh 

ifj.kke vk tkrs gSA  

 

 

OCR:-bldk iwjk uke Optical Character 

Recognition gSA  

OCR ds QzkWUV dEI;wVj esa LVksj jgrs gSA ftUgsa 

vkslhvkj LVS.MMZ dgrs gSA blesa letter, Number 

and special symbol gksrs gSA  

Joystick:-bldk iz;ksx dEI;wVj eas xsEl [ksyus ds 

fy;s fd;k tkrk gSA                              

 

 

Trackball:- ;g ,d pointer device  gSA ;g 

ekml ds leku dk;Z djrh gSA blesa ,d mHkjh gqbZ 

xsan gksrh gSA bldh lgk;rk ls xsEl Hkh [ksys tkrs gSA 

;g de txg ?ksjrk gSA blesa dsoy xsan dks ?kqekuk 

iMrk gS] iwjh trackball device dks ughaA   

 

 

Light Pen:- ykbZV isu dk iz;ksx dEI;wVj Ldzhu ij 

dksbZ fp= ;k dk vkd̀fr dk fuekZ.k djus ds fy;s fd;k 

tkrk gSA ;g Hkh ,d ikabVj fMokbl  

vktdy bldk iz;ksx CAD  ds dk;ksZa esa vf/kd gks 

jgk gSA  

 

Touch Screen:- Touch Screen dk iz;ksx 

vktdy cSafdax] jsYos] ,;jiksVZ ,oa ykbczsjh esa dSVykWu 

Qkby dks <w<us esa fd;k tk jgk gSA 

 

Digitizing tablet or Graphic table:-   

Digitizing tablet  ,d drawing lrg gksrh 

gSA blds lkFk ,d isu ;k ekml gksrk gSA bl Vsfcy 

ij irys rkjksa dk tky gksrk gSA ftl ij isu pykrs 
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gh ladsr dEI;wVj eas pys tkrs gSA                      

 

 

Voice recognition:-bldh lgk;rk ls ge MkVk 

dks dEI;wVj esa cksydj buiqV djk ldrs gSA  

Bar Code Reader (BCR):-BCR dk iz;ksx 

O;klkf;d {kS= eas fd;k tkrk gSA blls mRikn 

(product) ds iSdsV ds Åij Nis gq;s ckj dksM dh 

i<us ds fy;s fd;k tkrk gSA  

Offline input device:- os fMtkbl tks dEI;wVj 

ls plug fd;s fcuk MkVk dks collect djds dEI;wVj 

esa buiqV djrh gSA vkWQ ykbZu buiqV fMokbl 

dgykrh gSA gSA dSejk ,d vkWQ ykbZu buiqV fMokbl 

gSA   

Digital Camera:-  ;g ,d vkWQ ykbZu buiqV 

fMokbl gSS bldk iz;ksx QksVks [khpus ,oa LVksj djus ds 

fy;s fd;k tkrk gSA  

Output Devices : 

Monitor  

Monitor ,d vkmViqV fMokbl gSA bldks fotqvy 

fMLIys ;wfuV Hkh dgk tkrk gSA  

CRT (Cathode Ray Tube) Monitor 

Flat Panel Monitor:-;g ubZ rduhdh ds 

ekWuhVj gSA blesa LCD (Liquid Crystal 

Display) Technology dk iz;ksx gksrk gSA   

vkt dh ubZ rduhdh LED gSA ftldk iwjk uke 

Light emitting diode gSA  

Characteristics of a Monitor ¼ekWuhVj ds 

eq[; y{k.k½%& 

1. Resolution ¼jstksyw'ku½%&Display 

device dk egRoiw.kZ xq.k jstksyw'ku ;k 

Ldzhu ds fp= dh Li"Vrk gksrk gSA 

ekWuhVj esa fp= dk fuekZ.k NksVs NksVs 

fcUnqvksa ls feydj gksrk gSA ftls fiDlsy 

dgk tkrk gS tc og fcUnq pedrs gSA  

2. Refresh Rate:- ekWuhVj ls fjQzs'k jsV 

dks gVZt eas ukik tkrk gSA  

3. Dot Pitch:- MkWV fip ,d izdkj dh 

ekiu rduhdh gSA dyj ekWuhVj dh MkWV 

fip 0.15 MM ls .30 MM rd gksrh 

gSA   

4. Interlacing or non 

Interlacing:- ;g ,d ,slh fMLIys 

rduhdh gSA tks dh ekWuhVj ls jstksyw'ku 

dh xq.koŸkk esa vkSj vf/kd of̀) djrh gSA 

5. Bit Mapping:- ftleas VSDl vkSj 

xzkfQDl nksuksa dks iznf'kZr fd;k tk 

ldrk gS og fcV eSafix dgykrh gSA 

blls vkWijsVj fdlh Hkh vkd`fr dks Ldzhu 

ij cuk;k tk ldrk gSA  

 

Printer  

Printer ,d vkWu ykbZu vkmViqV fMokbl gSA blls 

vkmViqV dks dkxt ij Nki dj izLrqr fd;k tkrk gSA 
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dkxt ij fy;s x;s vkmViqV dks hard copy dgk 

tkrk gSA  

Printering Technology ds vk/kkj ij fizaVlZ nks 

izdkj ds gksrs gSA 

 

;g os fizVaj gksrs gSA tks fizfVax djrs le; vkokt 

djrs gSA blfy;s budks impact printer dgrs gSA  

Impact Printer nks izdkj ds gksrs gSA 

1. Draft Quality Printening:- 

blesa lkekU; NikbZ gksrh gSA  

2. Near Letter Quality 

Princterning:- bl fizfVax eas ,d 

v{kj dks nks ckj Nkik tkrk gSA bldh 

fizafVax xfr /kheh gksrh gSA   

Solid Printer  

Daisy Wheel printer:- ;g ,d Bksl eqnzk & 

v{kj ¼ Solid Font Printer½ impact printer 

gSA blds fizfVax gSM esa ,d pØ (Wheel) gksrk gSA 

ftlds izR;sd rkus ij ,d v{kj mHkjk jgrk gSA  

Printing ds vk/kkj ij Line Printer rhu izdkj 

ds gksrs gSA 

Line Printer:-ykbZu fizaVj gksrs tks ,d ckj eas ,d 

ykbZu dks fizaV djrs gSA ;g bEiSDV fizaVj gksrs gSA ;g 

rhu izdkj ds gksrs gSA  

1. Chain Printer:- bl fizaVj esa ,d pSu gksrh 

gSA ftls fizafVx pSu dgrs gS      

2. Band Printer:- bl fizaVj eas ,d csaM gksrk gSA 

ftls fizafVal cSM dgrs gSA  

3. Drum Printer:- bl fizaVj eas ,d Mªe gksrk 

gSA bl ij Bksl v{kj fpids jgrs gSA  

Non Impact Printer 

Non Impact Printer os fizaVj gksrs gSA tks fizfaVax 

djrs le; vkokt ugha djrs gSA Non Impact 

Printer nks izdkj ds gksrs gSA   

1. Ink Jet Printer  

2. Laser Printer   

Ink Jet Printer:-Ink jet Printer ,d non 

impact printergSA jaxhu badtSV fiazVj eas L;kgh ds 

pkj uksty gksrs gSA uhye] yky] ihyk] dkyk blfy;s 

bldks CYMK fizaVj Hkh dgk tkrk gSA   

blds bldh fiazfVax DokfyVh izk;% 300 DPI (Dot 

Per Inch) gksrh gSA  

Laser Printer:-  ;g ukWu bEiSDV ist fizaVj gksrs 

gSA bldk iz;ksx dEI;wVj esa 1970 ds n'kd ls fd;k 

tk jgk gSA  

budh fizafVax DokfyVh 300 to 600 Dpi rd gksrh gS 

tks loZJs"B gksrh gSA bldh xfr dks ppm esa ukik 

tkrk gSA vktdy budh dher de gks xbZ gSA   

Plotter 

ANKAJ INFOTECH



16 

www.bankersadda.com|           www.careerpower.in|          www.sscadda.com 
 

;g ,d vkmViqV fMokbl gS blls fp= ,oa xzkQ dks 

fiazV fd;k tkrk gSA ;g 3 D printing Hkh dj 

ldrs gSA blds }kjk cSuj iksLVj vkfn dks fizaV fd;k 

tkrk gSA   

;g nks izdkj ds gksrs gSA   

1. Drum pen plotter 

2. Fletbed plotter   

Sound Card & Speaker  

Sound Card ,dExtenstion board gksrk gS 

ftldk iz;ksx lkmUM dks Edit djus ,oa output 

djus es gksrk gSA  

 

Software 

Need of Sofware:- Computer Hardware 

and Software ls feydj curk gSA dEI;wVj esa 

gkMZos;j dk iz;ksx djus ds fy;s dEI;wVj eas mlds 

dk;Z dks ifjHkkf"kr djuk iM+rk gSA rkfd og vius 

dk;Z dks vPNh rjg ls dj ldsA blds dk;Z dks 

Software ds ek/;e ls ifjHkkf"kr fd;k tkrk gSA 

vFkkZr~ dEI;wVj dk iz;ksx djus ds Software dh 

vko';drk gksrh gSA dEI;wVj eas fdlh dk;Z dks djus 

ds fy;s ,d software dh vko';drk gksrh gSA  

dEI;wVj esa hardware and Software ,d nwljs 

ds iwjd gksrs gSA  

Software:- Computer dksbZ Hkh dk;Z vius vki 

ugha djrk gS mlls dk;Z djuk ds fy;s mls igys 

ifjHkkf"kr djuk iMrk gSA ftlds fy;s Computer 

Language dk iz;ksx fd;k tkrk gSA  

Software nks izdkj ds gksrs gSA 

 System Software 

 Application Software  

System Software:- ;g ,d ;k ,d ls vf/kd 

izksxzke dk lewg gksrk gSA bl software ds }kjk 

dEI;wVj mlds gkMZos;j dks fu;af=ar fd;k tkrk gSA  

buds }kjk fuEufyf[kr dk;Z fd;s tkrs gSA   

1. ;g ;wtj ,oa gkMZos;j ds chp interface 

dk fuek.kZ djrs gSA  

2. ;g Application Software dks 

execute djus ds fy;s IysVQkeZ miyC/k 

djrs gSA  

3. u;s gkMZos;j dk iz;ksx djus ds fy;s lg;ksx 

iznku djrs gSA  

4. ;g dEI;wVj dks esUVsUl dk dk;Z fd;k tkrk 

gSA  

5. ;g dEI;wVj dks fu;af=r djrs gSA   

dqN egRoiw.kZ System Software fuEufyf[kr gSA  

Operating System:- izR;sd Computer esa 

vkWijsfVax dh vko';drk gksrh gSA fcuk blds dEI;wVj 

dks iz;ksx ugha fd;k tk ldrk gSA ;g ;wtj ,oa 

dEI;wVj ds chp bUVjQsl dk fuekZ.k fd;k tkrk gSA  

Hkk"kk vuqoknd (Language Translators):-  
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 ;s ,sls izksxzke gSA tks fofHkUu izksxzkfeax Hkk"kkvkas eas 

fy[ks x;s izksxzkekas dk vuqokn dEI;wVj dh e'khuh Hkk"kk 

eas djrsa gSA ;g vuqokn djuk blfy, vko';d gksrk 

gSA fd dEI;wVj dsoy viuh e'khuh Hkk"kk esa fy[ks gq, 

izksxzke dk ikyu dj ldrk gSA  

Hkk"kk vuqokndksa dks eq[;r% rhu Jsf.k;kas esa ck¡Vk tkrk 

gSA  

1. vlsEcyj  

2. dEikbyj  

3. bUVjiszVj  

budk laf{kIr fooj.k fuEuor gSA  

1. vlsEcyj %&;g ,d ,slk izksxzke gksrk gSA tks 

vlsEcyh Hkk"kk eas fy[ks x;s fdlh izksxzke dks 

i<rk gSA vkSj mldk vuqokn e'khuh Hkk"kk esa 

dj nsrk gSA vlsEcyh Hkk"kk ds izksxzke dks lkslZ 

vkWCtsDV izksxzke dgk tkrk gSA bldk e'khuh 

Hkk"kk esa vuqokn djus ds ckn tks izksxzke izkIr 

gksrk gSA mls vkWCtsDV izksxzke dgk tkrk gSA  

2. dEikbyj%&;g ,d ,slk izksxzke gksrk gSA tks 

fdlh izksxzkej }kjk mPp&Lrjh; izksxzkfeaxHkk"kk 

esa fy[ks x;s lkslZ izksxzke dk e'khuh Hkk"kk esa 

vuqokn djrk gSA  

3. bUVjizsVj%&;g Hkh fdlh izksxzkej }kjk 

mPp&Lrjh; izksxzkfeax Hkk"kk eas fy[ks x;s lkslZ 

izksxzke dk vuqokn e'khuh Hkk"kk eas djrk gSA 

ewyr% dEikbyj vkSj bUVjizsVj dk dk;Z 

leku gksrk gSA vUrj dsoy ;g gS fd 

dEikbyj tgk¡ vkWCtsDV izksxzke cukrh gSA ogh 

bUVjizsVj dqN ugha cukrk gSA 

;wfVfyVh lkW¶Vos;j%& 

 ;wfVfyVh lkW¶Vos;j dqN ,sls izksxzkeksa dks dgk 

tkrk gSA ftudh vko';drk ges ckj&ckj iMrh 

gSA ;wfVfyVh izksaxzke] dbZ ,sls dk;Z djrk gSA tks 

dEI;wVj dk mi;ksx djrs le; geas djkus iMrs 

gSA  

 ;wfVfyVh lkW¶Vos;j ds dqN izeq[k mnkgj.k 

fuEuor gSa & 

 Qkby lkWfVZx izksxzke (File Sorting 

Programs):- ;s ,sls izksxzke gksrs gSA tks 

fdlh MkVk Qkby ds fjdkWMksZ dks gekjs fdlh 

bfPNr Øe eas yxk ldrs gSA  

 MkVk lsysD'ku izksxzke:- ;s ,sls izksxzke gksrs gSA 

tks fdlh MkVk Qkby esa ls gekjh :fp ds 

fjdkWMZ vyx djus esa lgk;d gksrs gSA  

 fMLd eSustesUV izksxzke %&;s ,sls izksxzke gksrs gS 

tks fdlh gkMZ fMLd ij Qkbyksa dks bl izdkj 

O;ofLFkr djrs gSA  

 fMLd QkWjeSfVax ¼Disk Formatting½ 

&blds }kjk fofHkUu eSeksjh fMLd ;Fkk ¶ykWih] 

gkMZ fMLd vkfn dks dEI;wVj esa iz;ksx ls 

igys vkWijsfVax flLVe ds vuqdwy cukus dk 

dk;Z fd;k tkrk gSA  

 

 fMLd Dyhu vi ¼Word Clean Up½ 

&blls fMLd dh v'kqf);kas ,oa vokafNr 

izksxzkeksa dks gVk;k tkrk gSA  

 ,aVhok;jl ;wfVfyVh ¼Antivirus Utility½ 

&blesa dbZ izdkj ds ok;jl izksVsD'ku 

lkW¶Vos;j ¼Virus Protection 
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Software½ dk bLrseky dk dEI;wVj dh 

gkMZfMLd rFkk mlds izksxzkeksa dh j{kk dh 

tkrh gSA  

Application Software:-;g os izksxzke gksrs 

gSA ftudk iz;ksx ;wtj vius Daily routineds 

dk;Z djrk gSA  

mnkgj.k%&Word processing software 

Database Software, Graphics software 

 bl izdkj vU; dbZ izdkj ds izksxzke ;wfVfyVh 

lkW¶Vos;j ds Hkkx gks ldrs gSA   

 lkekU; mˆs';kas ds lkW¶Vos;j %& 

 izksxzkekas dk og lewg] ftUgsa ;wtj viuh 

vko';drkuqlkj vius lkekU; mˆs';kas dh iwfrZ ds 

fy, mi;ksx esa ykrs gSA  

 lkekU; mˆs'; ds lkW¶Vos;j fuEufyf[kr {ks=ksa esa 

mi;ksx eas yk, tkrs gSA  

1. dEI;wVj vk/kkfjr fMtkbfuax  

2. lwpuk lapkj  

3. MkVkcsl eSustesaV flLVe  

4. xzkfQDl ds iz;ksx  

5. 'kCn lalk/ku  

6. 'kSf{kd iz;ksx  

7. O;kikfjd iz;ksx  

 lkekU; mˆs'; ds lkW¶Vos;j ds mnkgj.k%& 

LiSzM'khV (Spread Sheet) MkVk csl eSustesaV 

flLVe] xzkfQDl lkW¶Vos;j] 'kCn lalk/ku] dksjyMªks] 

isUV] ikoj ikWbUV bR;kfnA  

 

Operating System 

Operating System:- Operating System 

is a System Software ;g ,d daVªksy izksxzke 

gksrk gSA bldk laf{kIr uke OS gSA  

dqN egRoiw.kZ vkWijsfVax flLVe %& 

1- ,e-,l- MkWl MS - DOS (Disc Operating 

System) :  O;kid :i ls ilZuy dEI;wVj esa 

LFkkfir ekbØkslkW¶V dk izFke vkWijsfVax flLVe 

FkkA ;g (Non graphical), CUI 

(command view interface)dekaM ykbu 

vkijsfVax flLVe gSA  

2- ,e-,l- fo.Mkst (Microsoft Windows)% ;g 

ekbØkslkW¶V }kjk fodflr o xzkfQdy ;wtj 

baVjQsl (GUI- graphical user 

interface)vkWijsfVax flLVe gSA  

eg. windows 95, windows 98, windows XP, 

windows vista, windows 7, windows 8 

3- ;wfuDl(UNIX);g lu~ 1969 esa AT & T 

deZpkfj;ksa (employees) }kjk csy iz;ksx'kkyk esa 

fodflr vkijsfVax flLVe gSA  
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Developer - Ken thompson, Dennis Ritcnic, 

Douglos Mcllroy 

4- ykbuDl (LINUX)lu~ 1991 esa bldk izFke 

laLdj.k yk;k x;k FkkA ;g ;wfuDl ds rjg 

dEI;wVj vkijsfVax flLVe gSA tks ykbuDl djuy 

(Linux kernal) ij vk/kkfjr gSA   

 

Microsoft windows ¼ekbØkslkW¶V foaMkst½ 

Microsoft windows , personal computer  ds 

fy, Microsoft }kjk fodflr vkWijsfVax flLVe 

gSA ekbØkslkW¶V ds laLFkkid fcy xsV~l rFkk ikWy 

,ysu gSA ;g GUI, Graphical user 

interface, Multi progaming virtual 

memorydh lqfo/kk nsrk gSA  

Microsoft Windows dk izFke laLdj.k 1-0 20 

uoEcj 1985 dks vk;k] ftls baVjQsl eSustj ds 

uke ls tkuk tkrk gSA  

eg,   windows 95 – 1995, windows 98 -

(1998) ,windows ME - (2000), windows 

XP - (2004), windows vista - (2007), 

windows 7, windows 8, windows 8.1, 

windows 10 

,e-,l- foaMkst laca/kh 'kCnkoyh%& 

MS windows related points%  

 

1- xzkfQDl ;wtj baVjQsl (GUI- 

graphical user interface) GUI ;wtj 

dks bysDVªksfuDl baLVªqesaVl ls laokn djuk 

miyC/k djrk gSA  

2- vkbdu(icon)% vkbdu NksVk lk xzkfQd 

QksVks gSA tks fdlh Hkh izksxzke ds fØ;kUo;u 

dk izfrfuf/kRo djrk gSA  

3- baVjQsl (Interface) % ;g nks dEI;wVj 

ds chp lapkj LFkkfir djus dh lqfo/kk ;k 

rduhd gSA nks usVodksaZ ;k VfeZuy vkSj 

usVodZ ds chp lapkj LFkkfir djus dh lqfo/kk 

dks usVodZ baVjQsl dgrs gSA  

4 fo.Mkst MsLdVkWi (Windows 

Desktop): dEI;wVj ds fLop dks vkWu djus 

ds fy, dqN le; i'pkr~ vkidh dEI;wVj 

LØhu fp= ds leku fn[kkbZ nsrk gSA bls 

windows desktop dgrs gSA 

;g xzkfQdy LØhu gS vkSj bl LØhu ij 

vkidks dqN xzkfQdy flEcy fn[kkbZ nsrs gSa 

ftUgsa ge vkbdkWu (icons) dgrs gSaA ;s 

vkbdkWu izksxzkeksa dks [kksy ldrs gSA 

1- LVkVZ (Start) - Task bar  ij ck;ha vksj 

foaMkst dk LVkVZ cVu gksrk gSA ;g foaMkst 

izksxzkeksa dk LVkVZ djus esa lgk;rk djrk gSA 

2- VkWLd ckj (Task bar) % foaMkst esa MsLdVkWi esa 

lcls uhps fn[kus okyk ckj VkLd ckj dgykrk 

gSA  

3- Start menu ¼LVkVZ esU;w½ %&VkLdckj ds LVkVZ 

cVu ij fDyd djus ij ,d esU;w [kqyrk gS ftls 

LVkVZ esU;w dgrs gSaA bl esU;w esa dbZ vkWI'ku vkrs 

gS & 

1- izksxzke(program) : computer esa baLVkYM 

(Installed) izksxzkeksa dh lwph gSA  

2- QsofjV (Favorite) :  Book marked oscist dh 

lwphA  

3- MkD;wesaV(Dacuments)% lcls orZeku mi;ksx 

fd;s x;s nLrkostksadh lwphA  

4- lsfVaXl (Settings)% flLVe vuqiz;ksx tSls & 

daVªksy iSuy] fizaVj] VkLdckj rFkk usVodZ dusD'ku 
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bR;kfn dh lwphA daVªksy iSuy ds }kjk fdlh Hkh 

gkMZos;j ;k lkW¶Vos;j dh lsfVaXl dks Hkh ifjorZu 

dj ldrs gSA  

5- lpZ(Search)% fo'ks"k Qkby ;k QksYMlZ dks <wa<us 

ds fy,A 

6- gSYi(Help)% izksxzke laca/kh dksbZ Hkh lgk;rk izkIr 

djus ds fy,A  

7- ju (Run)% fdlh izksxzke dks ju djus ds fy, ;k 

fdlh Qkby] QksYMj ;k nLrkost dks [kksyus ds 

fy,A  

8- ykWx vkWQ (Log off)% ikloMZ izksVsDVsM ,d 

mi;ksxdrkZ dks ykWx vkWQ djus rFkk nwljs 

mi;ksxdrkZ dks ykWx vkWu djus dh vuqefr nsrk 

gSA  

9- VuZ vkWQ ;k ckj Mkmu % flLVe can dj nsrk gSA  

 

Title Bar% dksbZ Hkh izksxzke ;k vuqiz;ksx foaMks ds 

vUnj ju djrk gSA  

esU;w ckj (Menu Bar)% foaMkst vkijsfVax flLVe 

esa gj foaMks dk viuk esU;w gksrk gS A VkbVy ckj 

ds rqjar uhps esU;w ckj gksrk gSA  

1- Qkby (File)% bl esU;w ds vUrxZr U;w] vksiu] lso] 

Dykst] rFkk fizaV bR;kfn fodYi gksrk gSA  

2- ,fMV(Edit)%  bl esU;w ds vUrxZr vuMw (undo), 

dV (cut), dkWih (copy), isLV (paste) rFkk 

fDy;j (clear)  

3- (view)% bl esU;w ds vUrxZr ukeZy (normal), 

fizaV ysvkmV (print layout)] gsMj&QqVj 

(header-footer) bR;kfnA    

4- gsYi(Help)%  bl esU;w ds varxZr lgk;d tkudkjh 

;k mi;ksxh V~;wVksfj;y (Tutorial) gksrs gSaA   

foaMkstExplorer % foaMkst ,DlIyksjj ds }kjk vki 

vius dEI;wVj flLVe dh fofHkUu Mªkboksa vkSj 

QksYMjksa esa ekStwn fofHkUu Qkbyksa vkSj izksxzkeksa dks 

ns[k ldrs gSa vkSj mudk mfpr izca/ku dj ldrs 

gSaA  

 

foaMkst ds vUrxZr mi;ksxh izksxzke (Useful 

Program inside windows) %& 

1- uksViSM(Notepad)% lk/kkj.k VsDLV ,fMVj Click 

> start >  program > Accessories > 

Notepad 

2- oMZ iSM (Wordpad) % nwljk oMZ izkslsl gSA    

Click > start  > program > Accessories > 

wordpad  

3- isaV(paint)% fp= dk iz;ksx ;k cukukA Click > 

start  > program > Accessories > paint  

4- dSysdqysVj(Calculator) :x.kuk ds fy,A  

Click>  start >  program > Accessories 

>calculator 

5- Qksu Mk;yj (Phone Dialer)% dEI;wVj dks Qksu 

dh rjg iz;ksx djukA eksMse dks baLVky ds lkFk 

VsyhQsku ykbu ds lkFk tksM+ukA  Click > start 

>  program > Accessories > com             

6Clip board ¼fDyi cksMZ½ % blds }kjk fdlh lwpuk 

dks ,d txg ls nwljh txg dkWih ;k ewo dj 

ldrs gSa rFkk isLV djus ij dV ds ckn VsDLV dks 

fDyicksMZ esa j[kk tkrk gS rc isLV dh izfØ;k 

gksrh gSA 
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izksxzkfex Hkk"kk,W 

Programming Language 

dEI;wVj ,d bysDVªkWfud e'khu gS tks ;wtj }kjk iznku 

dh lkekU; Hkk"kk dks ugh le> ldrk gSA blds fy, 

fofHkUu izdkj dh izksxzkfexa Hkk"kk dk t:jr gksrh gSA 

gj izksxzkfeax Hkk"kk dh viuh O;kdj.k gksrh gSA 

izksxzkfeax Hkk"kk ds izdkj %& 

1- Low level language ¼fuEu Lrjh; Hkk"kk,a½ 

,slh Hkk"kk,W ftudk iz;ksx dEI;wVj esa fy;s fdlh dk;Z 

dks dj ldrs gSA ;s Hkk"kk,W dEI;wVj }kjk le>h tkus 

okyh Hkk"kk,W gksrh gSA  

(a) e'khu Hkk"kk %& 

;g ,d ,slh Hkk"kk gksrh gSA tks fdlh Hkh dEI;wVj }kjk 

fl/ks le>h tk ldrh gSA bl Hkk"kk dks iz;ksx djuk 

fdlh ;wtj ds fy, cgqr dfBu gksrk gSA  

(b) vlsEcrh Hkk"kk,W ¼Assemly language½  

vlsEcrh Hkk"kk,W iwjh rjg e'khuh Hkk"kkvksa ij vk/kkfjr 

gksrh gSA ijUrq blesa ckbujh la[;k *vks* Vksj *,* ds 

LFkku ij dqN 'kCnksa dk iz;ksx fd;k tkrk gSA ftUgsa 

MNEMONICSdgk tkrk gSA 

2. mPp Lrjh; Hkk"kk,W ¼high level language½  

izksxzkfeax Hkk"kk,W dEI;wVj dh vkUrfjd dk;Ziz.kkyh ij 

vk/kkfjr ugha gksrh gSSSSSS SS SS S SS SS S SS SS S SA budk iz;ksx ;wtj }kjk fdlh 

izksxzke dks cukdj dk;Z dks djus ds fy, fd;k tkrk 

gSA  

bu Hkk"kkvksa esa fofHkUu izdkj ds vaxzsth 'kCn vkSj 

xf.kfr; QaD'kuksa dk iz;ksx gksrk gSA mPPk Lrjh; Hkk"kk 

esa fy[ks izksxzke dEI;wVj ugha le> ldrk gSA blfy, 

gesa ,d language traalator dh t:jr gksrh gSA 

tSls dEikbyj ,d ckj esa gh iwjs izksxzke dk vuqokn 

e'khu Hkk"kk esa dj nsrk gSA tcfd baVj fizaVj ykbZu 

by ykbu djrk gSA  

izeq[k mPp Lrjh; Hkk"kk,W %& 

1- QksjVªku bldk iwjk uke Formula Pranslation 
gSA bldk iz;ksx tfVy x.kukvksa dks djus ds fy, 

fd;k tkrk gSA blfy, bls oSKkfud vkSj bUthfu;jksa 

}kjk iz;ksx esa fy[kk tkrk gSA  

bl Hkk"kk dk fodkl lu~ 1957 esa vkbZ-ch-,e- vesfjdk 

esa tkWu cSld }kjk fd;k x;k FkkA 

2- ALGOL ¼vYxksy½ 

bldk iwjk uke Algorithmic language gSA bldk 

vkfo"dkj eq[;r% tfVy chtxf.kr x.kukvksa gsrq fd;k 

tkrk gSA bl Hkk"kk dk iz;ksx bUthfu;fjax vkSj 

oSKkfudksa }kjk fd;k tkrk gSA  

bl Hkk"kk dk fodkl lu~ 1958 bUVjus'kuy dEiuh us 

fd;k FkkA  

3- dksCkkWy ¼COBOL½  

bldk iwjk uke common Business oneted 

language gSA bldk iz;ksx commrcial 

Application saizksxze fy[kus ds fy;s iz;ksx esa fy;k 

tkr gSA  
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4- yksxks ¼LOGO½& 

bldk iwjk uke logic oriented language gSA 

bl Hkk"kk dk iz;ksx cPpksa ds fy, iz;ksx fd;k x;k gSA  

5- ikLdy ¼PASSAL½&bldk fodkl lu~ 1975 esa izks 

fudykWl fodZ us fd;k FkkA bl izksxzkfeax Hkk"kk dkuke 

,sysl ikLdy ds uke ij j[kk x;k gSA bldk iz;ksx 

fofHkUu izdkj ds dk;kZsa ds fy;s fd;k tkrk gSA  

6- csfld ¼BASSIC½&bldk iwjk uke Beignners 

all Purpose symbolic Instnsction code gSA 
bldk iz;ksx gj izdkj ds dEI;wVj ds fy, gksrk gSA  

bldk fodkl lu~ 1964 esa MkVZ ekMy dkWyst vesfjdk 

ds ikel dqVZt rFkk MkW tkWu dsesuh us fd;k FkkA  

7- izksykWx ¼PROLOG½&& bldk iwjk uke 

Programming Logic gSA bl Hkk"kk dk fodkl 

1973 bZ- eas Ýkal eas d`f=e cqf) lEcfU/kr dk;ksaZ dks 

djus ds fy, fd;k x;k FkkA  

8- lh ¼C) & ;g izksxzkfea dh lcls vk/kqfud Hkk"kk gSA 

ftldk fodkl A&T LAB esa Msful] fVph us lu~ 

1972 esa fd;k FkkA bl Hkk"kk dk iz;ksx djds tfVy ls 

tfVy izksxzke dk ljy Hkk"kk esa fy[kus ds fy, fd;k 

tkrk gSA  

9- C++ bldk fodkl 1980 esa ckUuZ LVªkLVªk; }kjk 

vesfjdk dh csay ycksjsVjh esa gqvk Fkk ;g ,d object 

orientieal Programmig language gSA ftldk 

iz;ksx ;wtj bUVjQsl ij vk/kkfjr izksxzke dks fy[kus ds 

fy, fd;k tkrk gSaA 

 

COMPUTER NETWORK 

dEI;wVj usVodZ dh ifjHkk"kk 

dEI;wVj usVodZ nks ;k nks ls vf/kd dEI;wVj ds chp 

,d ,slk ,MtsLVesaV ¼lkeatL;½ gksrk gS ftlds }kjk os 

vkil esa MkVk o bUQkesZlu dk vknku iznku djrs gSA   

Hkkjr dk jk"Vªh; lwpuk usVodZ & 

1. NICNET - Hkkjr ds jk"Vªh; lwpuk foKku 

dsUnz ¼National Informatics 

Centre½ us mixzg ij vk/kkfjr ^fudusV* 

uked jk"VªO;kih dEI;wVj lapkj usVodZ 

LFkkfir fd;k gSA  

2. ERNET -f'k{kk ,oa vuqla/kku usVodZ 

¼Educational & Research 

Network½ dk laf{kIr :i gh ,jusV gSA 

;g ns'k dh eq[; f'k{k.k laLFkkvkas rFkk 

vuqla/kku dsUnzksa dks tksM+rk gSA  

3. INFLIBNET- ;g fo'ofo|ky; vuqnku 

vk;ksx ¼UGC½ }kjk 'kq: fd;k x;k 

fo'ofo|ky;kas vkSj dkWystksa ds fy, bUQkWesZ'ku 

vkSj ykbczsjh usVodZ gSA  

4. BITSNET -;g Hkkjr ljdkj ds 

ck;ksVsDuksykWth foHkkx }kjk fufeZr 

ckW;ksVsDuksykWth bUQkWesZ'ku flLVe usVodZ gSA  

5. RABMNET¼fjeksV ,fj;k fctusl eslst 

usVodZ½ & ;g C-DOT }kjk 'kq: fd;k x;k 

usVodZ gSA  

lfoZl ds vk/kkj ij usVodZ ds izdkj  

lfoZl ds vk/kkj ij usVodZ nks izdkj ds gksrs gS& 

1. ih;j Vw ih;j  

2. loZj lsfVªd   

ih;j Vw ih;j &ih;j Vw ih;j usVodZ ,d ,slk usVodZ 

gksrk gS ftlesa fuf'pr :i ls u rks dksbZ dEI;wVj loZj 

gksrk gS vkSj u gh dksbZ dEI;wVj DykbaV ysfdu 

vko';drk ds vuqlkj dksbZ Hkh dEI;wVj loZj Hkh cu 

ldrk gS vkSj dksbZ Hkh dEI;wVjDykbaVA bls le>us ds 
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fy, gesa loZj DykbaV vkSj ih;j dks Hkh le>uk iM+sxk 

& 

loZj(SERVER) -loZj ml dEI;wVj dks dgk tkrk 

gS tks usVodZ esa vU; dEI;wVj dks dkbZ MkVk bUQkesZlu 

;k lfoZl iznku djrk gSA  

DykbaV ¼CLIENT½&DykbaV og dEI;wVj gksrk gS u 

rks loZj gksrk gS vkSj u DykbaV ij t:jr ds le; 

;g loZj dh rjg Hkh dk;Z dj ldrk gS vkSj DykbaV 

dh rjg HkhA   

 

usVodZ lfoZl ds izdkj (TYPES OF 

NETWORK SERVICES)  

usVodZ esa dEI;wVj ds fofHkUu fjlkslZsl tSls gkMZ&fMLd] 

lhMh&Mªkbo] fizaVj vkfn dks 'ks;j djus ds fy, usVodZ 

lfoZl gh ftEesnkj gksrh gSA  

usVodZ esa iz;ksx gksus okyh izeq[k lfoZlsl fuEu gSa & 

1. Qkby lfoZl  

2. fizaV lfoZl  

3. eSslst lfoZl  

4. MkVkcsl lfoZl ,Iyhds'ku lfoZl  

 

usVodZ lfoZl (NETWORK SERVICE)  

usVodZ ds dEI;wVj lfoZl ysrs Hkh gS vkSj lfoZl nsrs Hkh 

gSA bl vk/kkj ij usVodZ eas mifLFkr dEI;wVj dks nks 

Hkkxksa eas ckaVk tkrk gS& 

1. lfoZl izksokbMj  

2. lfoZl fjdq,LVj  

lfoZl izksokbMj&lfoZl izksokbMj os dEI;wVj gksrs gS tks 

usVodZ eas mifLFkr dEI;wVj dks viuh fofHkUu lfoZlsl 

iznku djrs gSA bl ge loZj Hkh dgrs gSA  

lfoZl fjdq,LVj &lfoZl fjdq,LVj os dEI;wVj gksrs gSA 

tks usVodZ esa mifLFkfr fdlh vkSj dEI;wVj ls fofHkUu 

izdkj dh lfoZlsl ysrs gSA bls ge DykbaV Hkh dgrs gSA  

izksVksdkWy(PROTOCOL)  

izksVksdkWy ,sls fu;eksa dk lewg gksrk gSA ftlds }kjk 

;g fu/kkZfjr gksrk gS fd fdl izdkj ,d fMokbl ;k 

dEI;wVj dk MkVk o bUQkesZ'ku nqljs fMokbl ;k 

dEI;wVj eas VªkalfeV gksA  

dqN izksVksdkWy fuEufyf[kr gSA   

1. ,Q Vh ih ¼Qkby VªkalQj izksVksdkWy½  

2. ,l ,e Vh ih ¼flEiy esy VªkalQj izksVksdkWy½   

3. ,p Vh Vh ih ¼gkbij VsDLV VªkalQj 

izksVksdkWy½   

4. Vh lh ih ¼Vªkalfe'ku d.Vªksy izksVksdkWy½   

5. vkbZ ih ¼bUVjusV izksVksdkWy½  

vkfnA 

 

 

dEI;wVj usVodZ ds izdkj ¼TYPES OF 

COMPUTER NETWORK½  

dEI;wVj usVodZ dks ge nwjh ds vk/kkj ij ge eq[; 

rhu izdkjksa esa ck¡V ldrs gSa& 

1. ySu  

2. eSu  

3. oSu  

ySu ¼yksdu ,fj;k usVodZ½ & ySu ,d ,slk usVodZ 

gksrk gS tks de nwjh esa QSyk gqvk gksrk gS tSls fdlh 

?kj eas j[ks nks dEI;wVj ds chp dk usVodZ] fdlh 

vkWfQl ds dqN dEI;wVj dk usVodZ ;k fdlh fcfYMax 

esa QSyk gqvk usVodZA  

 

eSu¼esVªks iksyhfVu ,fj;k usVodZ½& eSu ,d ,slk usVodZ 

gksrk gS tks nks ;k nks ls 'kgjksa ds chp QSyk gqvk gks 

ldrk gSA  
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oSu ¼okbM ,fj;k usVodZ½ & oSu usVodZ ,slk usVodZ 

gksrk gS ftldh dksbZ lhek fuf'pr ugha gksrh gSA ;g 

nks ;k nks ls vf/kd ns'kksa ds chp QSyk gqvk gks ldrk 

gSA bldk lcls cM+k mnkgj.k bUVjusV gS bl izdkj ds 

usVodZ dk iz;ksx cM+h daiuh ds }kjk fd;k tkrk gSA  

lapkj dh fof/k;k¡ ¼Methods of 

Communication½ & 

¼i½  flEIysDl fof/k¼Simplex Method½&blesa 

MkVk o lwpukvksa dks dsoy ,d gh fn'kk 

vFkkZr~ izs"kd ls izkIrdŸkkZ dh vkSj lapkfjr 

fd;k tkrk gS] ij blesa lwpuk o MkVk dk 

izkIr gksuk lqfuf'pr ugha gksrk gSA tSls&jsfM;kas 

;k Vh-oh- dk izlkj.kA  

¼ii½  v)ZMÌysDl fof/k 

¼Half Duplex Method½ &blesa lwpukvkas 

dks nksukas fn'kkvksa eas lapkfjr fd;k tk ldrk 

gS vFkkZr~ izs"kd ls izkIrdrkZ dh vksj vkSj 

izkIrdŸkkZ ls izs"kd dh vksj ysfdu blls ,d 

ckj eas ,d gh fn'kk es lwpuk,¡ lapkfjr dh 

tk ldrh gSA tSls&VsyhQksu ij okrkZykiA 

¼iii½ iw.kZ MqIysDl fof/k 

¼Full Duplex Method)&blesa lwpuk rFkk 

MkVk dks ,d lkFk nksukas fn'kkvkas esa laizsf"kr 

fd;k tk ldrk gS vkSj izkIr fd;k tk ldrk 

gSA bleas lwpuk rRdky izkIr gksrh gSA  

usVodZ VksiksykWth ¼Network Topology½&;g 

usVodZ ds fofHkUu uksV ;k VfeZuYl dks vkil eas tksM+us 

dk rjhdk gS tks usVodZ dh HkkSfrd lajpuk cukrk gS] 

;g fuEu izdkj dk gks ldrk gS &*  

i. LVkj VksiksykWth& bl usVodZ esa ,d dsUnzh; 

uksM gksrk gS tks baVsyhtasl ls ;qDr gksrk gSA 

ckdh uksM~l blls tqM+k gksrk gSA bl dsUnzh; 

uksM dks gc dgk tkrk gSA dksbZ ,d dscy esa 

dksbZ leL;k vkus ij uksM foQy gksrk gS ijUrq 

gc esa dksbZ leL;k vkus ij lkjk usVodZ foQy 

gks tkrk gSA  

 

ii. cl VksiksykWth ¼LANesa iz;qDr gksrk gS½ &bl 

usVodZ ds lHkh uksM ,d gh dscy ls tqM+s gksrs 

gSA  

iii. fjax VksiksykWth& bl usVodZ esa lHkh usM~l esa 

baVsyhtsal gksrk gSA bldk Lo:i fjax ¼xksys½ ds 

lkeku gksus ds dkj.k bls fjax usVodZ ds uke 

ls tkuk tkrk gSA  

iv. Vªh VksiksykWth ¼esl usVodZ½& ;g usVodZ mPp 

VªsfQd fLFkfr eas ekxZ dks /;ku eas j[kdj 

mi;ksx fd;k tkrk gSA  

 

OSI ekWMy 
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blsISO- International Organization for 

Standardization us vyx&vyx gkMZos;j vkSj 

lkW¶Vos;j okys flLVeksad dks vkil esa lEc) djus ds 

fy, cuk;k gSA viuh  

ys;j la[;k 7 ;k ,Iyhds'ku ys;j ¼Layer 7 

Application Layer½ &;g ys;jj vfUre 

mi;ksxdrkZ ds lcls fudV gksrh gS bldk vFkZ ;g 

gqvk fd ;g ys;j vkSj ;wtj nksukas lkW¶Vos;j ,Iyhds'ku 

ds ek/;e ls lh/ks lEidZ djrs gSa vkSj ys;j lkW¶Vos;j 

ls laokn dj Qkby gLrkUrj.k] Qkby 'ks;fjax vkfn 

lsok,¡ nsrh gS]  

 

 ys;j la[;k 6 ;k izstsaVs'ku ys;j ¼Layer 6 

or Presentation Layar½ &bls flaVsDl 

ys;j Hkh dgrs gSA ;g vkWijsfVax flLVe dk 

,d fgLlk gksrh gS] tks vkus vkSj tkus okys 

MsVk dh izLrqfr ,d QkeZsV ls nwljs eas cnyrh 

gSA  

 ys;j la[;k 5 ;k ls'ku ys;j ¼Layer 5 or 

Session Layer½&,Iyhds'kukas ds nksukas 

fljksa ij ckrphr vny&cny vkSj laokn 

vkfn dh lsfVax] leUo;] vkSj mls lekIr 

djus dk dke bl ys;j esa gksrk gSA  

 ys;j la[;k 4 ;k VªkaliksVZ ys;j ¼Layer 4 

or Transport Layer½ &;g ys;j ;wtj 

izfØ;kvkas eslSt iSdsVksa dks bdB~Bk vkSj vyx 

djus ,jj fjdojh vkSj ¶yks dUVªksy ds chp 

MsVk ds fo'oluh; vkSj Li"V gLrkUrj.k dk 

dke djrh gS  

 ys;j la[;k 3 ;k usVodZ ys;j ¼Layer 3 

or Network Layer½ &,d ;k vf/kd 

usVoDlZ ds ek/;e ls ,d LFkku ls nwljs 

LFkku rd MsVk dh fofHkUu yEckbZ dh J̀a[kyk 

Hkstus ds fy, izfØ;kxr vkSj dk;Zdkjh 

okrkoj.k miyC/k djus dk dke bl ys;j ds 

ftEes gS]  

 ys;j la[;k 2 ;k MsVk fyad ys;j ¼Layer 2 

or Data Link Layer½ &usVodZ ys;j ls 

feys vkxzgksa dk mŸkj nsrh gSA ;g ys;j mUgas 

fQftdy ys;j ds ikl Hkstrh gSA  

 ys;j la[;k 1 ;k fQftdy ys;j ¼Layer 1 

or Physical Layer½ &;g ,d ,slh 

gkMZos;j ys;j gS tks midj.kksa vkSj lEizs"k.k ds 

chp dusD'ku dh eSdsfudy vkSj 

bysDVªks&eSXusfVd fo'ks"krkvkas dks crkrh gS] 

fo'ks"kdj ;g ,d midj.k vkSj fQftdy 

ek/;e ds chp lEcU/k dks n'kkZrh gS]  

 

bUVjusV dk TPC/IP 

bUVjusV eas nwjlapkj izksVksdkWy dh iz.kkyh 

viuk;h tkrh gSA TCP/IP dk iz;ksx 
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bUVjusV ,oa lHkh bUVªkusV ,oa ,DLVªkusV }kjk 

fd;k tkrk gSaA vusd dEifu;k¡ ,oa laxBu 

vius DykbUV@loZj usVodZ dks TCP/IP esa 

ifjofrZr dj jgsa gSaA  

TCP/IP ds ikap Lrj ftUgas vkd̀fr esa 

fn[kk;k x;k gS] fuEukafdr gSa %  

 ,Iyhds'ku vFkok izfØ;k Lrj  

 gksLV&Vw&gksLV ifjogu Lrj  

 bUVjusV izksVksdkWy  

 usVodZ bUVjQsl 

 HkkSfrd Lrj   

 

 

 

इन्टरनेट   

bUVjusV gtkjkas yk[kksa Lora= usVodksaZ dk ,slk la;qDr 

usVodZ gS ftlesa izR;sd usVodZ ,d ,sls ek/;e ls tqM+k 

gksrk gS] ftldh lgk;rk ls ;g vU; usVodZ ls 

lwpukvkas dk vknku iznku djrk gSA  

ubZ fnYyh fLFkr us'kuy buQksjes'ku lsUVj ¼NIC½ 

Hkkjr esa bUVjusV dusD'ku iz;ksx djus okyk izFke 

laLFkku FkkA Hkkjr ljdkj ds miØe VSNL fons'k 

lapkj fuxe fyfeVsM us 15 vxLr 1995 esa O;olkf;d 

:i ls izFke bUVjusV lsok iznku dhA  

izksVksdkWy& bUVjusV ij lwpukvksa ,oa vkadM+ksa ds 

vknku&iznku dk ,d flLVe gS ftls izksVksdkWy dgk 

tkrk gSA orZeku esa ¼TCP=Transmission 

Contral Protocol½ ,oa ¼IP= Internet 

Protocol½ izpfyr izksVksdksy gSA  
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Mksesx usse bUVjusV ls tqM+s izR;sd dEI;wVj dk ,d 

Mksesu use gksrk gS tsls www.yahoo.com ;g 

okLro esa dEI;wVj dk ,Mªsl gksrk gSA ftlds ek/;e ls 

ml dEI;wVj ls tqMk tk ldrk gSA bls DNS ;kfu 

¼Domain Name System dgrs gSA ;g nks Hkkxksa 

eas foHkDr gksrk gS] bu nksuks Hkkxksa esa foHkDr gksrk gS] 

bu nksuks Hkkxksas dks vyx&vyx djus ds fy, fcUnq ¼ ½ 

dk iz;ksx fd;k tkrk gSA  

IP Address eq[;r rhu izdkj ds gksrs gSA ftUgsa 

Class A, Class B rFkk Class C esa ckaVk tkrk 

gSA IP Address la[;kvksa eas gksrk gSA ftls ISP 

loZj bls IP Address esa ifjofrZr dj nsrk gSA IP 

Address  esa 0 ls 255 rd dh dksbZ Hkh la[;k gks 

ldrh gSA tSls&196-6-201-10 vkfnA   

Hkkjr esa izeq[k ISP (Internet Service 

Providers)   

1. VSNL- fons'k lapkj fuxe fyfeVsM  

2. BSNL-Hkkjr lapkj fuxe fyfeVsM  

3. Satyam Online 

4. DATA INFOSYS  

DNS ,d izdkj ds cMs dEI;wjVlZ dks dgk tk ldrk 

gSA ftudk dk;Z bUVjusV ds IP Address dh 

tkudkjh j[kuk gSA bls eq[;r;k 8 Hkkxksa esa ckaVk tkrk 

gSA   

1. .com ;k O;olkf;d laxBuksa ds fy, fjtoZ 

gSA   

2. .edu 'kS{kf.kd laLFkkukas ds fy,   

3. .mil vefjdh luh; laLFkkvkas ds fy,  

4. .gov xouZesUV ds fy,  

5. .org vksjxsukbts'ku ds fy,   

6. .net usVodZ laLFkkvkas ds fy,   

7. .int vUrjkZ"Vªh; laxBukas ds fy,  

8. .in, uk ;s izR;sd ns'k ds fy, vyx vyx 

gksrk gSA .in bfUM;k .uk fczVsu ds fy, 

vkfnA  

gkse ist&osclkbV dk eq[; i`"B tks fd osclkbV 

open djrs oDr loZizFke [kqyrk gS rFkk bl ij 

lwpuk dh gSfMax fy[kh gksrh gSA rFkk mlls vU; ist 

gkbijfyad ds ek/;e ls tqMs+ jgrs gS] gkse ist dgykrk 

gSA  

HTML- gkbij VsDLV ekdZvi ysXosat bldh enn ls 

osc istksa dks fMtkbu fd;k tkrk gSA vktdy JAVA 

Hkk"kk dk iz;ksx Hkh osclkbV MoyiesaV ds fy, gksrk gSA  

 

E-mail (Electronic Mail)  

besy dEI;wVj ds }kjk Hksth tk ldus okyh bysDVªksfud 

Mkd lsok dk laf{kIr :i gSA loZizFke bZ&esy lsok 

www.hotmail.com us 'kq: dhA bls ,d Hkkjrh; 

lchj HkkfV;k us fodflr fd;k Fkk ftls ckn eas 

ekbØkslks¶V us [kjhn fy;kA   

E-mail Address - izR;sd bUVjusV lkbV tks fd 

bZ&esy lqfo/kk iznku djrh gS] izR;sd ;wtj dks ,d 

,Mªsl nsrh gSA ftlesa ;wtj dk uke rFkk lkbV dk uke 

gksrk gS bZesy ,Mªsl dgykrk gSA tSls 

dubeyharmsa@hotmail.com ;gka 

dubeydharma ;wtj use gS rFkk 

hotmail.com  lkbV dk uke bu nksuks dks 

vyx&vyx djus ds fy, @ ¼,V n jsV½ fpUg dk 

mi;ksx gksrk gSA  

Mail Box- izR;sd lkbV tks bZ&esy ,Mªsl nsrh gS 

og viuh osc lkbV eas dqN kb ;k mb dk Lisl bl 

;wtj ds fy, fjtoZ djrh gS bls esy cksDl dgrs gSA 
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rFkk ;gh ls og fdlh vU; dks Mkd compose 

djds Hkstrk gSA fuEu dqN osc lkbV besa Ýh bZ&esy 

iznku djrh gSA  

1. www.hotmail.com 

2. www. yahoo.com  

3. www.rediffmail.com  

4. www.sify.com  

5. www.webduniya.com  ¼fgUnh esa 

miyC/k½ vkfnA  

 

 

bUVjusV dh lsok;sa %& 

 lkekU;r% bUVjusV iz;ksDrk dsoy oYMZ&okbM&osc 

dks gh bUVjusV dk ,d ek= lalk/ku le>rk gSA  

bUVjusV lfQZax vkt bUVjusV ds egRo ds dkj.k cgqr 

vf/kd la[;k eas bUVjusV osc lkbVks dk fuekZ.k gks pqdk 

gSA  

search batu & vla[; i`"Bksa dh lkexzh esa ls 

vkidh eupkgh lkexzh ;k fo"k; oLrq okyk ì"B <wa<dj 

lkeus ys vkus tSls dk;Z dks iyHkj esa esa dj nsus dk 

dk;Z bUVjusV ds lpZ bUtu }kjk fd;k tkrk gSA   

 

LikbMj &LikbMj ,sls izksxzke gS ftUgsa MsVkcsl esa lwph 

c) osc ist dh ns[kjs[k ds fy, fufeZr fd;k x;k gSA  

URL (Uniform Resource Locator) dks gh 

LVksj fd;k tkrk gSA cfYd mudh vkòfŸk  vkfn dks Hkh 

LVksj dj fy;k tkrk gS vkSj blh ds vk/kkj ij batu 

bu 'kCnksa dks egRo iznku djds ifj.kke lwph eas mUgas 

ofj;rk ls LFkku iznku djrk gSA   

izeq[k lpZ batu&www.msn.com, 

www.google.com, www.yahoo.com, 

www.google.com, www.directhit.com, 

www.indianwebsitees.com, 

www.rediff.com, www.123india.com  

czkmlj&,sls lks¶Vos;j tks osc lkbV dks <w<us esa dke 

vkrs gS czkmlj dgykrs gSA izeq[k czkmlj gS 

ekbØkslks¶V bUVjusV ,DlIyksjj] usVLdsi usohxsVj 

vkfnA   

World Wide Web (www) vkt tc O;fDr 

baVjusV ljfQaax dh ckr djrk gS rks bldk vFkZ og 

gksrk gS fd og Xyksc ¼oYMZ½ Hkj esa fLFkr eYVhehMh;k 

gkbij fyax MsVk csl ls Hkjh gqbZ lkbV~l dks pSd 

djusxk rks bu lkbV~l dks lEiw.kZ tky dks tgka fd 

vkt dy izfrfeuV ,d ubZ osc lkbV mHkj dj vk 

tkrh gSA www dgk tkrk gSA  

Internet Explorer- ;g ,d xzkfQd] osc czkmlj 

gSA ;g ,d lks¶Vos;j gS tks geas bUVjusV iz;ksx djus 

dk IysV QkeZ miyC/k djokrk gS ;g gesa bUVjusV ls 

lEidZ LFkkfir djus eas enn djrk  

Qkby VªkalQj izksVksdkWy %& 

 Qkby VªkalQj izksVksdkWy dk mi;ksx ,d dEI;wVj 

usV odZ ls fdlh nwljs dEI;wVj usVodZ esa Qkbyksa dks 

VªkalQj ¼Hkstus½ djus ds fy, fd;k tkrk gSA  

xksQj %& 

 xksQj dk vkfo"dkj vesfjdk ds fefulksVk uked 

fo'ofo|ky; esa gqvk FkkA ;g ,d ;wtj Ýs.Myh bUVj 

Qsl gSA ftlds ek/;e ls ;wtj bUVjusV ij izksxzke 

rFkk lwpukvksa dk vknku&iznku dj ldrk gSA  

VsyusV %& 
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 MkVk ds gLrkUrj.k ds fy, VsyusV dk iz;ksx fd 

tkrk gSA bl izksVksdkWy ds }kjk ;wtj dks fjeksV 

dEI;wVj ls tksM+k tkrk gSA 

;wtusV %& 

 fofHkUu izdkj dh lwpukvkas dks ,d= djus ds fy 

buVjusV ds usVodZ ;wtusV dk iz;ksx fd;k tkrk gSA 

bl usVodZ ds ek/;e ls dksbZ Hkh ;wtj fofHkUu lewgksa 

ls vius fy, vko';d lwpuk,as ,d= dj ldrk gSA  

 

oSjksfudk %& 

 oSjksfudk izksVksdkWy] xksQj ds ek/;e ls dk;Z 

djrk gSA ;wtj xksQj rFkk osjksfudk dk ,d lkFk 

iz;ksx djds fdlh Hkh MkVk csl rd vklkuh ls igqapk 

tk ldrk gSA  

vkphZ %& 

 Qkby VªklaQj izksVksdkWy ¼F.T.P½ esa LVksj Qkbyksa 

dks [kkstus ds fy, vkphZ dk iz;ksx fd;k tkrk gSA  

bUVjusV ls lEcfU/kr 'kCnkoyh %& 

izksVksdkWy ¼Protocol½%& ;g ,d ,slh ekud vkSj 

vkSipkfjd izfØ;k gSA ftlds ek/;e ls dEI;wVjkas rFkk 

latkyksa ¼usVodksZ½ esa vadh; lapkj fd;k tkrk gSA  

czkmtj ¼Browser½%& ;g ,d ,slk lkW¶Vos;j gSA 

ftldh lgk;rk ls ;wtj lwpukvksa dks izkIr djus ds 

fy, bUVjusV esa izos'k djrk gSA  

oscloZj %&;g izksxzke] osc czkmtj ds }kjk lalk/kukas dks 

izkIr djus ds fy, ;wtj }kjk fn;s x;s vuqjks/k dks iwjk 

djrk gSA osc loZj }kjk osc czkmtj esa mifLFkr fdlh 

izksxzke dk fØ;kfUor fd;k tk ldrk gSA  

usVodZ%&fofHkUu dEI;wVjkas dks ,d lkFk tksMdj cuk;s 

x;s latky dks usVodZ dgrs gSA blds }kjk ,d lkFk 

dbZ txgksa ij lwpukvkas dk vknku&iznku djuk lEHko 

gSA   

vkWu ykbu%&tc ;wtj bUVjusV ij tkudkfj;k rFkk 

lsokvksa dk v/;;u djrk gSA rc dgk tkrk gS fd og 

;wtj vkWu ykbu gSA  

gkWe ist %&;g fdlh Hkh lkbV dk izkjfEHkd iznf'kZr 

gksus okyk ist gksrk gSA ftlesa lwpuk,as gkbijfyad }kjk 

tqMh jgrh gSA  

vkWQ ykbu%&tc ;wtj bUVjusV esa mifLFkr lwpukvkas 

dks vius&vius dEI;wVj eas laxzfgr djds bUVjusV ls 

lEidZ dkV nsrk gSA rRi'pkr Hkh og lwpukvkas dk 

v/;;u djrk jgrk gSA  

gkbZij VsDLV ekdZvi ysaXost %&bldk laf{kIr :i 

HTML gSA ftldk iz;ksx osc&ist cukus ds fy, 

fd;k tkrk izkjEHk esa osc&fMtkbfuax HTML ds }kjk 

gh dh tkrh FkhA HTML ,d izdkj ds ,udksfMax 

Ldhe dh rjg dk;Z djrk gSA ftldk iz;ksx nLrkost 

rS;kj djus ds fy, fd;k tkrk gSA  

gkbZij VsDLV VªkalQj izksVksdkWy %&bldk laf{kIr :i 

HTTP gSA bldk iz;ksx HTML esa laxzfgr 

nLrkostksa rFkk nwljs osc lalk/kukas dks LFkkukUrfjr djus 

ds fy, fd;k tkrk gSA  
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Vh-lh-ih-@vkb-ih- ¼TCP/IP½ %&bldk iwjk uke 

¼Transmission Control Protocol/Internet 

Protocol½ gSA bldk iz;ksx lwpukvkas ds 

vknku&iznku djus ds fy, fd;k tkrk gSA ;s ,sls 

izksVksdkWy gS] ftuds ek/;e ls vla[; dEI;wVjksa ds e/; 

lEidZ LFkkfir gksrk gSA  

;wfuQkeZ fjlkslZ yksdsVj %&bldk laf{kIr :i URL 

gSA bldk iz;ksx osc ij fdlh fo'ks"k lwpuk dks 

lapkfyr djus ds fy, fd;k tkrk gSA URL eas ,d 

fo'ks"k izdkj dk ,sMªsl dksM iz;ksx eas yk;k tkrk gSA 

ftls Mksesu ,sMªsl dksM dgrs gS tSls 

http:www.gmail.com/mial bleas Gmail 

bldk ,Mªsl dksM dgykrk gSA  

osc ist%&gkse ist ij cus gkbijfyad dks fDyd djus 

ij tks ist gekjs le{k izLrqr gksrk gSA mls osc ist 

dgrs gSA osc ist esa Hkh lwpukvkas dh gkbZykbV djusd 

ds fy, gkbijfyad dk iz;ksx fd;k tkrk gSA  

osc lkbV %&osc istksa ds lewg dks osc lkbV dgk tkrk 

gSA ftleas fp=ksa] /ofu] VSDLV bR;kfn dk lekos'k gksrk 

gSA blesa fdlh Hkh egRoiw.kZ rF; dh tkudkjh izkIr 

djus ds fy, dsoy rF; dk gh uke fy[kk tkrk gSA 

vkSj ;wtj ds le{k mls rF; ls lEcfU/kr tkudkjh;ka 

izLrqr gks tkrh gSA   

gkbijfyad %&osc ist eas mifLFkr og fo'ks"k 'kCn ;k 

fp=] ftl ij fDyd djus ij ml 'kCn ;k fp= 

lEcfU/kr lwpuk,as ,d vyx osc ist ij vk tkrh gSA 

mls osc ist dk gkbijfyad dgk tkrk gSA vFkkZr ,d 

osc ist ij fdlh vU; osc ist dks lekfgr djuk] 

gkbijfyad dgykrk gSA  

MkmuyksM %&bUVjusV ;k fdlh vU; dEI;wVj ls izkIr 

lwpukvksa dks vius dEI;wVj eas laxzfgr djus dh fØ;k 

dks MkmuyksM dgrs gSA bUVjusV ds ek/;e ls gj jkst 

djksMks esxk ckbV dh lwpuk,sa MkmuyksM dh tkrh gSA  

vi&yksM%&vius dEI;wVj ls fdlh Hkh vU; dEI;wVj eas 

lwpukvksa dks Hkstuk] vi&yksM djuk dgykrk gSA 

mnkgj.k ds fy,&tc vki vius fe= ;k fj'rsnkj dks 

dksbZ lwpuk Hkstus ds fy, bZ&esy djrs gSA ;k fdlh 

dEiuh eas ck;ksMkVk Hkstrs gSA rks mls vi&yksM djuk 

dgrs gSA  

loZj(Server½ %&og dEI;wVj tks bUVjusV dk 

bLrseky djus okykas dk vFkkZr~ ;wtj dks lwpuk,as iznku 

djus dh {kerk j[krk gSA loZj dgykrk gSA   

lfQZx¼Surfing½%& bUVjusV ds usVodksaZ esa egRoiw.kZ 

lwpukvkas dks [kkstuk fofHkUu lkbVksa ij Hkze.k djuk 

lfQZx dgykrk gSA  

 

usVodZ baVjQsl dkMZ &;g ,d gkMZos;j fMokbl gS tks 

dEI;wVj dks usVodZ ls tksM+dj MkVk dk vknku&iznku 

laHko cukrk gSA  

ok;jysl yksdy ywi ¼WLL½ &;g ,d LFkkuh; csrkj 

rduhd gS ftlesa /ofu ds lkFk baVjusV rFkk rhoz xfr 

ls MkVk dk vknku&iznku laHko gksrk gSA  

okbZ&QkbZ ¼Wifi-Wireless Fidelity½ &;g 

fofHkUu bysDVªkWfud lapkj midj.kksa ds chp fcuk rkj 

ds laidZ LFkkfir djus dh O;oLFkk gS ftlls MkVk dk 

vknku &iznku laHko gks ldsA blds }kjk eksckby ;k 

dEI;wVj dks usVodZ ds lhek dk Hkhrj baVjusV ls tksM+k 

tk ldrk gSA  

ANKAJ INFOTECH



31 

www.bankersadda.com|           www.careerpower.in|          www.sscadda.com 
 

okbZ eSDl  ¼Wi Max -World 

Interoperability for Microwave Access½ 

&;g yach nwjh rd ekbØksoso fyad ds tfj, MkVk dk 

lapj.k laHko cukrk gSA ;g czkWMcSUM eas baVjusV rFkk 

vU; lqfo/kk,¡ iznku djrk gSA ;g 3-3 ls 3-4 GHz ds 

chp dk;Z djrk gSA 

IP Address &usVodZ eas loZj vkSj mlls tqM+s izR;sd 

uksM dks ,d igpku dksM fn;k tkrk gS tks baVjusV 

izksVksokdWky ¼IP½ ,Mªsl dgykrk gSA \ 

Dynamic IP Address- gekjs Network }kjk 

gekjs fdlh Device dks Provide fd;k x;k ;s IP 

Address Number rHkh rd gekjs fMokbl dks 

Refer djrk gS] tc rd ge usV ls dusDV jgrs gSA 

tSls gh ge usV ls Disconnect gksrs gS] gesa Allot 

fd;k x;k IP Number fdlh vU; fMokbl dks 

Provide fd;k tk ldrk gSA   

xsVos ¼Gateway½ &baVjusV ls dbZ usVodZ vkil esa 

tqM+s gksrs gSA xsVos ml dEI;wVj dks dgrs gS] tks nks 

fHkUu &fHkUu usVodksZa ls tqMs+ dEI;wVj ls tqM+k jgrk gSA 

fMftVy lClØkbcj ykbu ¼DSL-Digital 

Subscriber line½ &blds varxZr dEI;wVj dks 

VsyhQksu ds lkekU; rkacs ds rkj }kjk VsyhQksu 

,Dlpast ls tksM+ fn;k tkrk gS vkSj blds lkFk Mh-lh-

,y- ekWMse tksM+us ls dEI;wVj ij pkSchlksa ?kaVs baVjusV 

lqfo/kk gkfly dh tk ldrh gSA  

ISD ¼Integrated Services Digital 

Network½ &;g vadh; latky dh ,dhd`r lsok gS 

ftleas ,d gh jkLrs ls /ofu] n`'; vkSj vadh; ;k 

fyfic) lwpoukvksa dks lEizsf"kr djus dh {kerk gksrh 

gSA bleas MkVk] ohfM;ksa vkSj /ofu dk ,d lkFk izlkj.k 

laHko gSA ISDN ds varxZr fMftVy lwpuk dks 

lkekU; VsyhQksu usVodZ ij 128 dschih,l dh j¶rkj 

ls izsf"kr fd;k tk ldrk gSA  

HTML ¼Hyper Text Markup Language½ 

&bldk iz;ksx osc ist cukus esa fd;k tkrk gS bldh 

lgk;rk ls osc czkmtj nLrkost dks n'kkZrk gSA   

HTML¼Hyper Text Markup Language½ 

Web Pages dh ewy Hkk"kk gSA Internet ij vkt 

ftruh Hkh Websites gS] os lHkh Web Sites 

HTML Pages dk Collection ek= gS] ftuesa 

HTML Elements dk iz;ksx fd;k tkrk gSA 

HTML ds bu Elements dks gh Markup Hkh 

dgrs gS] D;ksafd ;s Elements Web Page ds 

fofHkUu izdkj ds Contents dks fofHkUu rjhdksa ls 

Web Browser eas Render gksus ds fy, Mark 

djrs gS vkSj Web Browser dks bl ckr dk 

Indication djrs gSa] fd Web Browser eas fdl 

Content dks fdl txg ij vkSj fdl rjg ls 

Render djrk gSA  

;s ,d Markup Language gS tks fd iwjh rjg ls 

Content ;k Text ds Organizaiton ls lacaf/kr 

gSA  

¶yse ¼Flame½ &baVjusV ij izsf"kr ;k fyf[kr 

vi'kCnA   

ANKAJ INFOTECH



32 

www.bankersadda.com|           www.careerpower.in|          www.sscadda.com 
 

ØSdj ¼Cracker½ &galh &etkd ;k euksjatu ds fy, 

baVjusV ij tqM+s fofHkUu dEI;wVjkas ls NsM+NkM+ djus 

okysA   

CykWx ¼Blog½ &;g  Web log dk laf{kIr :i gSA 

;g baVjusV ij ,d izdkj dh osclkbV gS ftl ij 

le; &le; ij VsDLV] fp= ;k /ofu }kjk vius 

vuqHko o fopkj Mkys tkrs gSA CykWx lkoZtfud Hkh gks 

ldrs gS o O;fDrxr HkhA 1999 eas vkf/kdkfjd :i ls 

CykWx dh 'kq:vkr ihVj egksZYt us dhA 

ikWi vi ¼Pop up½ &;g baVjusV ds iz;ksx ds le; 

Lo;a [kqyus okyk foUMksa gS ftlesa fdlh fo"k; fo'ks"k ij 

lwpuk jgrh gSA  

 

bZ&dkWelZ rFkk bZ&cSfdax  

(E- Commerce and E-Banking)  

Electronic Commerce vFkkZr ,sls lHkh 

okf.kT;d dk;Z tks fd bysDVªksfud flLVe vFkkZr~ 

dEI;wVj ds }kjk iw.k fd;s tkrs gSA ge bls ,sls Hkh dg 

ldrs gS fd bUVjusV ds ek/;e ls O;kikj djuk gh 

bZ&dkWelZ dgykrk gSA  

Types of E- Commerce 

o bysDVªkWfud dkWelZ ds rhu ewy izdkj gS& 

i. fctusl Vw dUT;wej ¼B2C½ & NksVs 

dkWiksZjs'ku rFkk  vkjafHkd O;kikfj;ksa ds }kjk 

bldk mi;ksx fd;k tkrk gSA 

ii. dUT;wej Vw dUT;wej ¼C2C½ & oLrq,¡ 

cspus ds fy, fofHkUu O;fDr;kas dks 'kkfey 

djrk gSA ;g vDlj DyklhQkbM foKkiukas 

;k fdlh uhykeh ds ,d bysDVªkWfud :i eas 

utj vkrk gsA  

iii. fctusl Vw fctusl ¼B2B½& O;kikj eas nks 

O;kikfj;kas dk vkil esa mRiknu vkSj lsokvksa 

dh fcØh gksrh gSA ;g fo'ks"k :i ls 

mRiknd forjd ds chp laca/k gSA  
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E-Banking ¼bZ&cSfdax½ 

Electronic Banking Internet Banking 

,Virtual Banking ds uke ls Hkh tkuk tkrk gSaA 

blsOnline Banking Hkh dgka tkrk  

Electronic Payment System:   

baVjusV ij fd;k x;k Hkqxrku Electronic 

Payment dgykrk gS rFkk bl fof/k dks 

Electronic Payment System dgk tkrk gSA  

Hkqxrku fuEu ek/;eksa ls fd;k tkrk gSA  

1. ØsfMV dkMZ  

2. fMthVy eqnzk  

3. LekVZ dkMZ vkfn A  

ØsfMV dkMZ ,oa LekVZ dkMZ &baVjusV ij vkWuykbu 

lksfiax djus ds fy, IykfLVd euh vFkkZr ØsfMV dkMZ 

,oa LekVZ dkMksZa dk iz;ksx fd;k tkrk gSA bUgsa 

vyx&vyx cSad rFkk dEifu;ka b';w djrh gS rFkk iSls 

ml dkMZ Holder ls olwys tkrs gSA   

Important terms related to E-Banking: 

NEFT- National Electronic Fund 

Transfer  

;g jk"Vªh; Lrj ij ,d Account ls nqljs Account 

es Fund Transfer djus ds fy, fd;k tkrk gSaA 

 

RTGS ( Real time Gross settlement) 

;g Fund ds okfLrod vk/kkfjr vkMZj ds vk/kkj ij 

Transfer gksrk gSaA  Application ds mlh le; 

Process fd;k tkrk gSa tc Transaction dh tkrh 

gSaA;g tYnh ;k Fast Fund Transfer ds fy, 

mi;ksx es fy;k tkrk gSaA 

Mobile Banking:- 
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vktdy izR;sd cSad }kjk viuh Smart Phone 

Application lqfo/kk nh x;h gSa ftlesa Application 

dh lgk;rk ls Mobile Phonels ysu nsu fd;k tk 

ldrk gSaA 

Online Banking Password:- 

izR;sd Bank }kjk Password  fn;k tkrk gSa ftls 

Web ID  ds lkFk fy[kus ds fy, dke es fy;k tkrk 

gSaA 

Transaction Password 

;g Password add fd;s x;s account esa Balance 

Transfer ds fy;s mi;ksx es fy;k tkrk gSa rFkk mUgha 

account esa Balance Transfer dj ldrsa gSa tks 

vkids Bank ds lkFk Add fd;s x;s gSaA 

One time password (OTP) 

;gOnline Banking esa Found Transfer  djus gsrq 

mi;ksx esa fy;k tkrk gSaA blesa User us Reguler 

Mobile Number ij ,d Number vkrk gSa tks ml 

ysu nsu dks iwjk djus ds fy, Mkyuk gksrk gSaA 

 

ekbØkslkW¶V vkWfQl  

ifjp;  

 ekbØkslkW¶V vkWfQl ijLij lEcfU/kr MsLdVkWi 

vuqiz;ksxksa vkSj lsokvkas lewg gSA ftls lkewfgd :i ls 

vkWfQl lwV dgk tkrk gSA ekbØkslkW¶V vkWfQl 

loZizFke lu~ 1989 eas ekbØkslkW¶V dkWiksZjs'ku }kjk eSd 

OSds fy;s 'kq: fd;k x;kA mlds i'pkr~ lu~ 1990 

eas foaMkst ds fy;s loZizFke laLdj.k yk;k x;kA 

ekbØkslkW¶V vkWfQl 4-0 lu~ 1994 eas vk;k ftlesa oMZ 

6-0 ,Dly 5-0 ikWoj ikbUV 4-0 esy vkSj ,Dlsl FkkA   

 mlds ckn ds laLdj.k Øe'k% ekbØkslkW¶V 

vkWfQl 4-3 ekbØkslkW¶V vkWfQl 95] ekbØkslkW¶V 

vkWfQl 97] ekbØkslkW¶V vkWfQl 2000] ekbØkslkW¶V 

vkWfQl xp] ekbØkslkW¶V vkWfQl 2003] ekbØkslkW¶V 

vkWfQl 2007 rFkk ekbØkslkW¶V vkWfQl 2010gSA 

ekbØkslkW¶V vkWfQl ds vUrxZr eq[;r% pkj izksxzke vkrs 

gS & 

1. ekbØkslkW¶V oMZ  

2. ekbØkslkW¶V ,Dlsy  

3. ekbØkslkW¶V ikWoj iakbV rFkk  

4. ekbØkslkW¶V ,Dlsl   

 

ekbØkslkW¶V oMZ 

 ekbØkslkW¶V oMZ ekbØkslkW¶V dkisZjs'ku }kjk 

fodflr oMZ izkslslj gSA bldk eq[k dk;Z nLrkost 

ds lapkfyr djuk gSA ;g ,d oMZ izkslsflax iSdst 

gSA 

Different types of menus available in Ms-

Word 

Quick Access Tab 

(i) New (ctrl + N) – New Document 

Create djus ds fy, 

(ii) Open (ctrl + O) – cuh gqbZ File dks 

Open djus ds fy, 
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(iii) Save (ctrl + S) – cuh gqbZ File dks 

Save djus ds fy, 

(iv) Print Preview - Print Preview  

ns[kus ds fy,A 

(v) Undo (ctrl + z) – fd;k dke 

ifjoZru gVukA 

(vi) Redo (ctrl + y) – ifjoZru okil 

ykus ds fd,A 

1- Home Tab 

Cut : Ctrl + x ¼VsDVj dks gVkuk½ 

Copy : Ctrl + c ¼dkWih djuk½ 

Paste : Ctrl + v ¼isLV djuk½ 

2- Font Block  

(i) Font Face -Text Deign ;k Font 

Deign dks Change  (Ctrl + D) djus 

ds fy,A 

(ii) Font Size -Font Size ds fy,A 

(ctrl + Shit + p)  

 By Default Min=8 and Max=72 

(iii) Bold-(ctrl + b) eksVs vkdkj esa 

(iv) Italic-(ctrl + I) frj{ks vkdkj esaa 

(v) Underline -(ctrl + u) Under ykbZu 

djus ds fy, 

(vi) Grow Font-(ctrl + {) Tex dk 

vkdkj cMkus ds fy, 

(vii) Shrink  Font- (ctrl + }) Tex 

dk vkdkj de djus ds fy, 

(viii) Super Script- Text dks NksVk cukrk 

gSa bldk mi;ksx Formula esa fd;k 

tkrk gSaA x
2
+y

2
 

(Ctrl + Shit+ +) 

(ix) Subscript – Math question ds fy, 

(Ctrl+Shit+ =) 

(x) Strike Through- Text dks e/; ls 

dkVus ds fy,  

(xi) Change case - Selected Text 

ds Case dks Changee  djuk 

(xii) Sentence Case - Only first 

letter capital 

(xiii) Upper Case -(Capital Letter) 

(xiv) Lower Case -(Small Letter) 

(xv) Capitalize -each word 

(xvi) Toggle Case - First small 

remaining capital  

(xvii) Font color -Change color of 

selected Case 

 

3- Paragraph block: 

(i) Number / Bullets 

(ii) Alignments- 

(i) Align Left (Ctrl + L) -

 Left margin 

(ii) Align Right (Ctrl + R) -

 Right margin 

(iii) Align Center (Ctrl + E) -

Left and Right ds fcp esa 

(iv) Justify (Ctrl + J) -Left 

Right Equal space 

(iii) Line Spacing - nks ykbuks ds chp 

nwjh cMkus ds fy, 
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Ctrl + 1 - Single Line Space 

Ctrl + 2 - Double Line Space 

Ctrl + 5 - 1.5 Line Space 

(iv) Shading -  Select Text ds 

fiNs ds dyj dks Change djuk 

4- Style Block: 

p;fur Text dh Style dks Change djus gsrqA 

fufeZr dj ldrs gSaA (Alt + Ctrl + Shift + S) 

Editing - Text es Change djus ds fy,A 

(i) Find - (Ctrl + F) tks Text dks 

<q<rk gSaA 

(ii) Replace - (Ctrl + H) ,d Word dks 

nqljs Word ls Replace djukA 

(iii) Go to - (Ctrl + G) ,d page ls 

nqljs page ij tkukA 

 

2-  Insert Tab: 

(i) Page Block 

- Cover page – igys ls fufeZr 

Cover page document insert 

fd;k tkrk gSaA 

- Blank Page - [kkyh page 

insert djukA 

- Page Break - Current 

position ls nwljs page es tkuk 

(Ctrl + enter) 

(ii) Table Block - Ms-Word esa 

Table cukus dh lqfo/kk iznku djrk gSaA 

(iii) Illustration Block 

- Picture – Input Picture 

- Clip Art – Predefine image 

dks use djukA 

- Shapes – Auto Shape ,d 

Drawing gksrh gSa tks Word esa 

igys ls cuh gksrh gSa vkSj vko’;Drk 

ds vuqlkj Insert dh tk ldrh gSaA 

- Chart – vkadMks ds vuqlkj Chart 

insert fd;k tkrk gSaA Line chart, 

Ple Chart, bar Chart, Colum 

Chart etc. 

(iv) Header & Footer Block 

- Header ist ds  Top Margin ij 

vkSj Footer Page ds Bottom esa 

gksrk gSaA 

- Header & Footer esa margin dh 

by default value 0.5gksrh gSaA 

(v) Link Block 

- Hyper link (Ctrl + K) Hyper 

line insert djukA 

 

Drop cap - Drop cap dk iz;ksx Paragraph 

ds first character esa species effectMkyus ds fy, 

fd;k tkrk gSaA 

 

3- Page Layout Tab 

(i) Themes - Themes lEiq.kZ 

document dh design Change ds 

fy, 
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(ii) Page setup block   

Margin 

(a) Top Margin - by default 1 

bap gksrk gSaA 

(b) Bottom Margin - by 

default 1 bap gksrk gSaA 

(c) Left Margin - by default 

1.25 bap gksrk gSaA 

(d) Right Margin - by default 

1.25 bap gksrk gSaA 

(e) Gutter or Gutter Pointer 

Gutter margin dhDefault Value 0gksrh 

gSaA 

Gutter margin dh Position Top o  

leftgksrh gSaA 

(iii) Orientation: Orientation nks izdkj 

dh gksrh gSaA Potrait, .Mlandscape 

By default layout Potrait gksrk 

gSaA 

(iv) Size : tc document cukrs gSaa 

rks word processor ,d Size ysrk gSaA 

lkekUr;% page dk vkdkj 8x11 esa 

lettergksrk gSaA 

 

Page Back Ground Block 

Water mark – izR;sd page ds e/; 

background ds :Ik es lsV dj ldrs 

gSaA 

Page Color – Background es 

Color Mkyuk 

Page Border – Document ds 

page es border Mkyuk 

 

Paragraph Block: 

 Indent - ;g paragraph dks left/right 

side es move djrs gSaA blds }kjk lEiw.kZ 

paragraph dh margin Changee dh tk ldrh gSaA 

 Spacing - ;g paragraph ds after ;k 

before space nsus ds fy, bldks 

paragraph spacing djrs gSaA 

 

4- References Tab  

 Foot note: document ds izR;sd 

page ds loot esa fn[kus okyk text foot 

note dgykrk gSaA (Ctrl+Alt+D) 

 End Note:iwjs document ds var esa 

fn[kus okyk VsDlV end note dgykrk 

gSaA (Alt+Ctrl+D) 

5- Mailing Tab 

 Mail Merge Word dh izkFkfed dh 

fo’ks"krkvksa esa ls ykHknk;d vkSaj ikojQqy 

function gSaA 

 mail merge dks Lo;a ds QkeZ] ysVlZ] 

uke o irs lfgr print dj ldrs gSaA 

6- Review Tab: 

(i) Spelling and Grammar  - F7 

documentesa Spelling & Grammar 

dh xyfr;ka dks lq/kkjus ds fy,A 

Deferent types of line: 
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Red Color -Spelling Mistake 

Green Color -Grammar Mistake 

Blue Color-Formatting Mistake 

(ii) Thesaurus-Thesaurus 'kCndks’k gSa 

tks gekjs text ls feyrs tqyrs 'kCn iznku 

djrk gSaA (Shift+F7) 

7- View Tab :   

(i) Document View : 

(a) Web layout-Web Page dh rjg 

[kqyukA 

(b) Print layout-Document print gksus 

ds ckn fn[kus okykA 

(c) Outline View- Document dks 

outline ds :i esa fn[kkrk gSa 

(d) Reading layout View -

 Document dks Full screen ij 

read djukA 

(e) Normal View –Cut, copy and 

page ;k editing ds fy,A 

(ii) Zoom – Word es ,d Document 

dsZOOM size de ls de10% vkSaj 

vf/kdre 500% rd gks ldrh gSaA 

(iii) Macros – Macros ds }kjk ,d ;k 

,d ls vf/kd dek.Ml dk ,d dek.Ml 

esa lxzg dj ldrs gSaA 

&%egRoiw.kZ rF;%& 

 

(i) Word Wrap : Text dk Lor% 

vxyh ykbZu esa iagqpukA 

(ii) Ms Word 2010 esa tc fdlh Text dks 

select fd;k tkrk gSa rks Lor% gSaMini 

tool baresa fn[kkbZ nsrk gSaA 

(iii) Template : ,d file ftlesa igys ls 

define setting dk mi;ksx final 

Document dks cukus ds fy, fd;k 

tkrk gSaA  

(iv) ,d ckj TAB Cursor nckus ls 0-

5inches cMrk gSaA 

(v) Translate option Hkk"kk ifjoZru ds 

dke vkrk gSa tksReview tabesa gksrk gSaA 

(vi) MS-Word dks 'kq: djus ds fy, 

winword.exe 

 

ekbØkslkW¶V ,Dlsy 

ekbØkslkW¶V ,Dlsy ,d bySDVªkWfud LizsM'khV gS] tks 

lkaf[;d x.kuk djus rFkk pkVZ cukus esa lgk;rk djrk 

gSAbysDVªkWfud LizsM'khV dEI;wVj eseksjh eas rkfdZd odZ 

'khV gSA tks dkWye  rFkk jkW (Row)esa caVk gS] ;g 

;wfVfyVh lkW¶Vos;j iSdst gSA 

Formula Operators: 

(i) Arithmetic Operator  budk mi;ksx 

xf.kfr; fØ;kvksa ds fy, fd;k tkrk gSaA 

(+, -, x, /, % ) 

(ii) Comparison Operator  budk iz;ksx 

nks ekuks dks vkil esa rqyuk ds fy, 

fd;k tkrk gSaA 
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(iii) Text Operator (&) ¼,Eijls.M½ dk 

iz;ksx VsDlV dks tksMus ess fd;k tkrk 

gSaA 

(iv) Reference Operator (:) Cell esa 

Range Define djus ds fy,A 

 

,Dlsy ds QDa'ku  

 ,Dlsy eas miyC/k QDa'ku ,slh 'kfDr'kkyh 

lqfo/kk,as gSA ftudh lgk;rk ls vki tfVy x.kuk,sa] 

lkaf[;dh; x.kuk,sa foRrh; x.kuk,sa vkSj ikB~; ij cgqr 

ls dk;Z djh ldrs gSA QDa'kuksa dk iz;ksx QkWeZwyk ds 

:i esa ;k nwljs QDa'kukas rFkk vkWijsVjkas ds lkFk tfVy 

QkWewZys cukus esa fd;k tkrk gSA  

 

Math Function  

 =sum (n1,n2.........)  

Sum functionfn, x, uacj o reference 

dh total djrk gSA  

 Exam =sum (4,5,2) =11   

 =product (n1,n2,n3.......)  

Product function fn, x, uacj vkSj 

jsQjsUl dk xq.kuQy ykSVkrk gSA 

= product (5,4,2) (5*4*2=40) - 40  

 = man *n1,n2,n3..)   

 Min functionfn, x, uacj vkSj jsQjsUl dh 

lcls NksVh osY;w dks ykSVkrk gSA  

 min (4,5,6,2)=2 

  = max function fn, x, uacj vkSj jsQjsUl 

dh lcls cM+h osY;w dks ykSVkrk gSA  

Number or ref  

 =count()   

 count functionfn, x, jsQjsUl dh 

numerical cell dh la[;k ykSVkrk gSA  

 =average (n1,n2,n3....) average 

function return average of given num  

 average functionfn, x, jsQjsUl dh 

vkSlr ykSVkrk gSA   

 =average (4,5,6)=5  

 = =mod (number, divisor) 

 =mod (10,3)=1 

 mod function 'ks"k dks ykSVkrk gSA  

 =power (5,3)  

 125(5*5*5*) 

 power function ?kkr fudkyrk gSA  

Text function  

 =upper("string")  

 upper function nh xbZ okD; ds lHkh 

dSjsDVj dks capital eas cnyrk gSA  

 =upper ("lion")  

 =lower ("String")  

 lower function nh xbZ okD; ds lHkh 

dSjsDVj dks small character eas cnyrk gSA  

 Len function len function okD; ds 

character dh la[;k dks ykSVkrk gSA  

 =len ("lion")4  

 Date and time  

Date formate depand oonin o.s  

(o.s default format is mm/dd/yyyy)  
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 today function orZeku fnukad dks ykSVkrk 

gSA  

 now function orZeku le; ,oa fnukad dks 

ykSVkrk gSA  

 year (date) function fn, x, fnukad eas ls 

o"kZa dks ykSVkrk gSA  

 month (date) function fn, x, fnukad 

eas ls efgus dks ykSVkrk gSA  

 day (date)  function fn, x, fnukad esa ls 

fnu dks ykSVkrk gSA  

 hour (time) function fn, x, fnukad esa 

ls ?kaVs dks ykSVkrk gSA  

 second (time) function fn, x, fnukad 

eas ls lSd.M dks ykSVkrk gSA   

 minut (time) function fn, x, fnukad esa 

ls feuV dks ykSVkrk gSA 

 

 

&%egRoiw.kZ rF;%& 

1. Ms Excel esa Data dks Sort ¼lf{kIr½ cukus 

ds fy,Pivot Tabledke es fy tkrh gSaA 

2. By Default Cell esaEntre numeric 

Value dkAlignment Right aligngksrk gSaA 

3. Ms-Excel esa fdlh Hkh Work Sheet dk 

uke Maximum 31 Charactersdk gks ldrk gSaA 

4. Ms-Excel esa la’kks/ku ds fy, F2 

Function key use djrs gSaA 

5. igyh okyh Work Sheet  ij tkus ds 

fy,Ctrl + Page up key use djrs gSaA 

6. Ms-Excel esa#### Cell dh lkexzh cgqr 

cMh gksus ds dkj.k iznZ’ku ij fn[kkbZ nsrk gSaA 

7. ,d Text Field esa255 Character 

typefd;s tk ldrs gSaA 

8. Ms-Excel 2010 esa fdlh Column 

dhDefault pkSMkbZ 8.43 Pointsgksrh gSaA 

9. Automatic cell referencedks jksdus ds 

fy, $ ds sing dk use fd;k tkrk gSaA 

10. Ms- Excel esa fdlh Function dks Insert 

djus ds fy,Shift + F3 key dk use gksrk gSaA 

11. V Look up Function related record 

irk yxkus ds fy, dke vkrk gSaA 

12. Address in Excel: 

(a) Absoluteaddress - $ P21 (With cell 

reference) 

(b) Relative address - P21 

(Without cell reference)  

13. Formula Bar - bldk mi;ksx Formula 

o Function dks fy[kus ds fy, gksrk gSaA 
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14. Sorting - Excel es nks rjg dh 

sorting gksrh gSA 

(a) Ascending ¼NksVs ls cMs½ 

(b) Descending ¼cMs ls NksVs½ 

15. Filter -table esa mifLFkr Data esa ls user 

dh need ds vuqlkj dks display djukA blds iw.kZ 

MkVk dks display djus ds ctk; filter fd;k tkrk 

gSaA 

16. Pivot table  - Special type dh table 

gksrh gSa ftldh lgk;rk ls chart ;k graph cuk;s 

tk ldrs gSaA 

17. Validation - ,d ,slk process ftlds 

ek/;e ls related data gh cell esa store fd;k tkrk 

gSaA 

18. Chart  - Table ds data dks 

graphically display djus ds fy, chart dk 

mi;ksx fy;k tkrk gSaA 

Chart cukus ds fy,  axiso gridline dks define 

djuk gksrk gSaA 

 

 

Ms-Power Point 

Ms-Power Point ,dPresentation 

SoftwaregSaA bldk iz;ksxPresentation and 

Slide Showds fy, fd;k tkrk gSaA  blesa cuh File 

dk File extension  .pptxgksrk gSaA Presentation 

ds izR;sd page dksSlidedgk tkrk gSaA 

1. Home 

(a)  (Slide) 

(i) New slide (ctrl + m)- ubZ 

Slide dks Add djukA 

(ii) Reset -Slide dks Set djukA 

(formatting rFkk color) 

(iii) Slide layout- Layout cnyukA 

By default lands capegksrk gSaA 

(iv) Delete   -

 Select slide dks delete djukA 

(b) (Drawing ) 

(i) Arrange- Slide esa insert fd;s x;s 

object dh position esa Changee 

(ii) Shape Fill - Salute dh xbZ 

Shape, Color , Picture File fd;s 

tkrk gSaA 

(iii) Shape Outline- Shape dh 

Outline Color dks Fill fd;k tkrk gSaA 

(iv) Shape Select- 3-D Rotation 

2. Insert 

Different Images and media file 

dks attach fd;k tkrk gSaA 

3. Animation 

Slide esa Audio rFkk Effects Set dj 

ldrs gSaA 

4. Transition 

geAnimation esa Slide ij Transition Hkh Set 

dj ldrs gSa ftlesa Transition Sound rFkk 

Speed mouse click ;k time ds vuqlkj set 

dj ldrs gSaA 

5. Slide Show 

blesaSlidedksShowdjus lEcU/khSetting gksrh 

gSaAF5key use gksrh gSaA 
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Current  Slidels Slide Show LVkVZ djus ds 

fy,Shift + F5gksrh gSaA 

 

 

oDrk ds uksV (Speaker’s Notes): 

;s ,slh lqpuk,a gSa tks oDrk tks oDrk dks 

izLrqrhdkj.k ds le; dqN ckrsa ;kn 

fnykus ds fy, nh tkrh gSaA 

Hand Outs: 

;s dqN ,slsPage gksrs gSa tks Jksrkvksa esa ckVs tkrs 

gSaA bu ij izLrqrhdj.k dh lHkh ;k pquh 

xbZ LykbZM Mkyh tkrh gSaA 

Master Slide: 

;g ,d ,slh Slide gksrh gSa ftlesa ,slh lwpuk,a 

;k lkexzh Mkyh tkrh gSa tks izLrqrhdj.k 

dh izR;sd LykbZM esa 'kkfey dh tkrh gSaA 

Views in power point 

(i) Slide Sorter View- bl O;q 

esaPresentstionds lHkhSlide dks ,d 

lkFk ns[k tk ldrk gSa rkfd 

Presentation dh Complete name 

rFkk Øe dh tkap dh tk ldsA 

(ii) Slide Show View - Slide 

dks Full screen ij display djukA 

    

    &%egRoiw.kZ rF;%& 

(1) Ms-power point esa ready to use 

dkclip artls gksrk gSaA 

(2) Ms-power point esa First Slide ij 

tkus dsCtrl + Home key dk use 

fd;k tkrk gSaA 

(3) Power point pykus ds 

fy,Powerpnt.exe 

(4) bldh Windows dh Zoom Size 10% 

to 400%gksrk gSaA 

(5) bldkdefault Zoom Size 69%gksrk 

gSaA 

 

Ms-Access 

MS-Access ,d RBDMS (Relational 

Database Management System)gS ftlesa 

fjys'kuy ekbØkslkW¶V tsV MkVkcsl baftu ds lkFk 

GUI (Graphical User Interface) vkSj 

lkW¶Vos;j fodkl Vwy dk la;kstu (Combination) 

gSA  

&RDBMS ds pkj cqfu;knh rRo gS& 

1. Tables - ;g fo'ks"k fo"k; ds MkVk dk laxzg.k gS 

ftlds fuEu rRo gksrs gSa & 

¼i½  Columns¼dkWyEl½&gj dkWyEl ,d QhYM 

dks izLrqr djrk gSA ,d QhYM (Field) dk 

vFkZ gS&fuf'pr Js.kh ;k dksfV ds MkVk LVksjA  

¼ii½  Rows ¼jkst½&,d jks esa vkus okyh fdlh 

dSVsxjh (Category) dh lHkh ensa MkVkcsl 

dk ,d fjdkWMZ cukrh gSaA  

¼iii½ Domin  ¼Mksesu½&fdlh Hkh QhYM esa tks 

vf/kdre vkSj U;wure eku (Values) gksrs 

gS mls ml QhYM dk Mksesu dgrs gSA  
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¼iv½ Primary Key¼izkFkfed dqath ½&;g ,d 

[kkl rjg dh QhYM gksrh gS] tks gj fjdkWMZl 

dks ,d vyx igpku nsrh gSA  

¼v½ Relationship ¼laca/k½ dk vFkZ& ,d ;k 

,d ls vf/kd MkVkcslkas dks vkil esa tksM+ukA  

¼iii½ Domain  ¼Mksesu½&fdlh Hkh QhYM esa tks 

vf/kdre vkSj U;wure eku (Values) gksrs 

gS mls ml QhYM dk Mksesu dgrs gSA  

2. Dosjht ¼Quries½ &;g MkVkcsl ls fdlh fo'ks"k 

MkVk dks O;ofLFkr rjhds ls ns[kus ds fy, gksrh gSA 

blds }kjk dh cpr gksrh gSA ,Dlsl dh Query 

nh xbZ daMh'ku (Condition) ds vk/kkj ij MkVk 

dks <w¡<+rh gS vkSj mls Ldzhu ij fn[kkrh gSA  

3. QkWElZ ¼Forms½ &;g MkVkcsl esa LVksj gq, MkVk 

dks ljy QkWesZV (Format) eas fn[kkrk gSA 

Forms ds }kjk fjdkWMZ dks ns[kk tk ldrk gS] 

enter fd;k tk ldrk gSa ;k mleas Qsjcny dh 

tk ldrh gSA Forms LØhu ij ,d le; esa ,d 

gh fjdkWMZ fn[kkrk gSA  

4. fjiksVZl (Reports)& ;g MkVk dks bl izdkj 

fMtkbu djus esa enn djrk gS fd ;g vklku cu 

tk, vkSj bldk fooj.k tYnh ls le>k tk ldsA  

कां प्यटूर िे िम्बांधित ऱघ ुरूप  

A-C 

 AA - anti-aliasing  

 AABB - Axis aligned bounding box 

 AAC - Advanced Audio Coding  

 ACID - Atomiticy Consistency Isolation 

Durability 

 ACPI -Advanced Configuration and 

Power Interface 

 APCI - Application-Layer Protocol 

Control Information 

 ADC - Apple Display Connector ADO - 

ActiveX Data Object 

 ADSL - Asymmetric Digital Subscriber 

Line, variant of DSL 

 AI - artificial intelligence AIM - AOL 

Instant Messenger 

 AMD - Advanced Micro Devices  

 AMI - American Megatrends ... (BIOS 

manufacturer) 

 AMR - Audio Modem Riser 

 ANSI - American National Standards 

Institute 

 AOL - America Online 

 API - Application Programming Interface  

 ASCII  - American Standard Code for 

Information Interchange 

 ASP - Application Service Provider 

 AVI - Audio Video Interleaved 

 BASIC - Beginner's All-purpose 

Symbolic Instruction Code, acronym was 

added later, originally it was simply 

Basic 

 BBS - Bulletin Board System 

 BIND - Berkeley Internet Name Daemon 

 BIOS < - Basic Input Output System 
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 BJT - Bipolar Junction Transistor 

 CAD - Computer Aided Design 

 CD-R - CD-Recordable 

 CD-RW - CD-Rewritable 

 CF - Compact Flash 

 CFG - Context-free grammar - control 

flow graph 

 CG - Computer Graphics? 

 CGA - Color Graphics Array 

 CGI - Common Gateway Interface 

 CLI - Command Line Interface 

 CM - Configuration Management 

 COM - Component Object Model 

 CPU - Central Processing Unit 

 CRC - Cyclic Redundancy Check 

 CRT - Cathode Ray Tube 

 CS - Computer Science 

 CSE - Computer Science Engineering 

 CSS - Cascading Style Sheets 

 CT - Computerized Tomography 

 CVS - Concurrent Versioning System 

 

D-F 

 DB - database 

 DBA - database administrator 

 DBMS - Database Management System 

 DHTML - Dynamic HTML 

 DLL - Dynamic Load Library 

 DMA - Direct Memory Addressing 

 DN - Distinguished Name 

 DND - drag and drop 

 DNS - Domain Name Server 

 DOM - Document Object Model 

 DOS - Disk Operating System 

 DRAM –Dyanamic RAM 

 EEPROM –Electrically Erasable PROM 

 EOF - End of File 

 EOL - End of Life 

 EPROM - 

 ERP - Enterprise Resource Planning 

 FAT - File Allocation Table 

 FAQ  - Frequently Asked Questions 

 FET - Field Effects Transistor 

 FIFO - First In First Out 

 FPGA - Field Programmable Gate Array 

 FS - file system 

 FTP - File Transfer Protocol 

 

G-I 

 GB - Gigabyte 

 GIF - Graphics Interchange Format 

 GPL - GNU Public License 

 GRUB - GRand Unified Boot-loader 

 GUI - Graphical User Interface 

 HAL - Hardware Abstraction Layer 

 HCI - Human Computer Interaction 

ANKAJ INFOTECH



45 

www.bankersadda.com|           www.careerpower.in|          www.sscadda.com 
 

 HDD - Hard Disk Drive 

 HF - High Frequency 

 HTML - Hypertext Markup Language 

 HTTP - Hypertext Transport Protocol 

 Hz - Hertz 

 IBM - International Business Machines 

 IC - Integrated Circuit 

 IDL - Interface Definition Layer 

 IM - Instant Messaging 

 IP  - Internet Protocol 

 IRC - Internet Relay Chat 

 IRQ - Interrupt Request 

 IS - Information Systems 

 ISA - Industry Standard Architechture 

 ISO - International Organization for 

Standardization 

 ISP - Internet Service Provider 

 IT - Information Technology 

 

J-M 

 JDK - Java Developer's Kit 

 JPEG - Joint Photographic Experts Group 

 JS - Javascript 

 JSP - Java Server Page 

 KB - Kilobyte 

 KDE - K Desktop Environment 

 kHz - Kilohertz 

 LAN - Local Area Network 

 LDAP - Lightweight Directory Access 

Protocol 

 LED - Light Emitting Diode 

 LF - Low Frequency 

 LIFO - Last In First Out 

 LOC - Lines of Code 

 LUG - Linux User's Group 

 MAN  - Metropolitan Area Network 

 MB - Megabyte 

 MCSE - Microsoft Certified System 

Engineer 

 MHz - Megahertz 

 MMU > - Memory Management Unit 

 MOSFET - Metal-oxide semiconductor 

FET 

 MPEG  - Motion Pictures (Coding) 

Experts Group 

 MPL - Mozilla Public License 

 MS - Microsoft 

 MS-DOS - Microsoft DOS 

 MSDN - Microsoft Developer's Network 

 MUD - Multi-user dungeon 

 

N-R 

 NDS - Novell Directory Services 

 NFS - Network filesystem 

 NP - Non-polynomial 

 NPL - Netscape Public License 

 NPU - Numeric processing unit? 
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 NMI - Non-Maskable Interrupt 

 NNTP - Network News Transfer Protocol 

 NTFS - NT file system 

 OLED - Organic Light Emitting Diode 

 OO - Object Oriented 

 OO - Open Office 

 OOo - openoffice.org 

 OOP - Object Oriented Programming 

 OS - Operating System 

 OSI - Open Source Initiative 

 OSI - Open Systems Interconnect 

 OSS - Open Source Software 

 OSDN - Open Source Developer's 

Network 

 PAN - Personal Area Network 

 PCB - Printed Circuit Board 

 PCMCIA - Personal Computer Memory 

Card International Association 

 PCM - Pulse Coded Modulation 

 PDA - Personal digital assistant  

 PERL - Practical Extraction and 

Reporting Language 

 PGA - Programmable Gate Arrays 

 PGP - Pretty Good Privacy 

 PINE - PINE Is Not Elm 

 PNG - Portable Network Graphics 

 POP  - Point of Presence 

 POP3 - Post Office Protocol v3 

 PVR - Personal Video Recorder 

 PXE - Pre Excecution Environment 

 QoS - Quality of Service? 

 RAID - Redundant Array of Inexpensive 

Disks 

 RAM - Random Access Memory 

 RC - Release Candidate 

 RDBMS - Relational Database 

Management System 

 RDF - Resource Description Framework 

 RF - Radio Frequency 

 RFI - Radio Frequency Interference 

 RFID - Radio Frequency Identification 

 RGB - Red, Green, Blue 

 RIP - Routing Information Protocol  

 RLE - run-length encoding 

 ROM - Read Only Memory 

 RSA - Rivest Shamir Adelman 

 

S-V 

 SCP - Secure Copy 

 SAN - Storage Area Network 

 SDK - Software Developer's Kit 

 SEAL - Semantics-directed Environment 

Adaptation Language 

 SEI - Software Engineering Institute 

 SIMM - Single Inline Memory Module 

 SMP - Symmetric Multi-Processing 

 SMTP - Simple Mail Transfer Protocol 

 SP - Service Pack 
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 SQL - Structured Query Language 

 SSH - Secure Shell 

 SSI - Server Side Include 

 SSL - Secure Socket Layer 

 SVG - Scalable Vector Graphics 

 TB - Terabyte 

 TCP - Transmission Control Protocol 

 TCP/IP - Transmission Cntrol 

Protocol/Internet Protocol 

 TSP - Traveling Salesman Problem 

 TTL - transistor to transistor logic 

 TTL - time to live 

 UHF - Ultra High Frequency 

 UML - Unified Markup Language 

 UPS - Uninterruptible Power Supply 

 URI - Uniform Resource Identifier? 

 URL - Uniform Resource Locator? 

 USB - Universal Serial Bus 

 VRML - Virtual Reality Markup 

Language 

 VB - Visual Basic 

 VBA - Visual Basic for Applications 

 VBS - Visual Basic Script 

 VGA - Variable Graphics Array 

W-Z 

 WAN - Wide Area Network 

 WAP - wireless application protocol 

 WEP - Wired equivalent protocol? 

 WPA (wireless protocol) 

 WWW - World Wide Web  

 XHTML - eXtensible Hypertext Markup 

Language 

 

कुछमहत्वपूर्णशब्दोक पूर्णि म 

1.) GOOGLE - Global Organization Of 

Oriented Group Language Of Earth. 

2.) YAHOO - Yet another Hierarchical 

Officious Oracle. 

3.) WINDOW - Wide Interactive Network 

Development for Office work Solution. 

4.) COMPUTER - Common Oriented 

Machine Particularly United and used under 

Technical and Educational Research. 

5.) VIRUS - Vital Information Resources 

Under Siege. 

6.) UMTS - Universal Mobile 

Telecommunications System. 

7.) AMOLED - Active-matrix organic light-

emitting diode. 

8.) OLED - Organic light-emitting diode. 

9.) IMEI - International Mobile Equipment 

Identity. 

10.) ESN - Electronic Serial Number. 

11.) UPS - Uninterruptiblepower supply. 

12. HDMI - High-DefinitionMultimedia 

Interface. 

13.) VPN - Virtual private network. 

14.) APN - Access Point Name. 

15.) SIM - Subscriber Identity Module. 

16.) LED - Light emitting diode. 

17.) DLNA - Digital Living Networks 
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Alliance. 

18.) RAM - Random access memory. 

19.) ROM - Read only memory. 

20.) VGA - Video Graphics Array. 

21.) QVGA - Quarter Video Graphics Array. 

22.) WVGA - Wide video graphics array. 

23.) WXGA - Widescreen Extended 

Graphics Array. 

24.) USB - Universal serial Bus. 

25.) WLAN - Wireless Local Area Network. 

26.) PPI - Pixels Per Inch. 

27.) LCD - Liquid Crystal Display. 

28.) HSDPA - High speed down-link packet 

access. 

29.) HSUPA - High-Speed Uplink Packet 

Access. 

30.) HSPA - High Speed Packet Access. 

31.) GPRS - General Packet Radio Service. 

32.) EDGE - Enhanced Data Rates for Globa 

Evolution. 

33.) NFC - Near field communication. 

34.) OTG - On-the-go. 

35.) S-LCD - Super Liquid Crystal Display. 

36.) O.S. - Operating system. 

37.) SNS - Social network service. 

38.) H.S - HOTSPOT. 

39.) P.O.I - Point of interest. 

40.) GPS - Global Positioning System. 

41.) DVD - Digital Video Disk. 

42.) DTP - Desk top publishing. 

43.) DNSE - Digital natural sound engine. 

44.) OVI - Ohio Video Intranet. 

45.) CDMA - Code Division Multiple 

Access. 

46.) WCDMA - Wide-band Code Division 

Multiple Access. 

47.) GSM - Global System for Mobile 

Communications. 

48.) WI-FI - Wireless Fidelity. 

49.) DIVX - Digital internet video access. 

50.) APK - Authenticated public key. 

51.) J2ME - Java 2 micro edition. 

52.) SIS - Installation source. 

53.) DELL - Digital electronic link library. 

54.) ACER - Acquisition Collaboration 

ExperimentationReflection. 

55.) RSS - Really simple syndication. 

56.) TFT - Thin film transistor. 

57.) AMR- Adaptive Multi-Rate. 

58.) MPEG - moving pictures experts group. 

59.) IVRS - Interactive Voice Response 

System. 

60.) HP - Hewlett Packard 
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Computer GK Practice Set – 1
इस ैिटस पेपर म  कंयटूर फंडाम टल, डेटाबेस और इटरनेट से सबंिधत कुल 15 वतुिनठ न
उर िमल गे, जो आपको  SSC,  ब िकंग, पटवारी, पुिलस, रेलवे और  DCA,  PGDCA की परीा की
तैयारी के िलए बहुत काम आय गे|
In  this  practice  set  you  will  find  15  objective  question  related  to  Computer
Fundamentals and Database which will help you in prepration of SSC, Banking,
Patwari, Police, Railway and DCA, PGDCA.

1. इस कार की मेमोरी को सामाय Temporary या अथाई टोरेज कहते है
a) ROM
b) लैश मेमोरी
c) वचुअल मेमोरी
d) RAM
Answer- (d) RAM

2. ीन को होड करने वाला equipment कौन सा है
a) िविडयो
b) डेकटॉप
c) माडेम
d) मॉनीटर
Answer- (b) डेकटॉप

3. ……… फॉम करने के िलए पसनल कयटूर को एक साथ कनेट िकया जा सकता है
a) सवर
b) सुपर कंयटूर
c) नेटवक
d) इटराइज
Answer- (c) नेटवक

4. ……… म  पेिसिफक िनयम और शद होते ह  जो algorithm के लॉिजकल टैप यत करते
ह ।
a) ोग ामीगं
b) सेटेस
c) ोग ािमंग
d) लोजोक चाट
Answer- (a) ोग ामीगं
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5. ……… एक इलेट ॉिनक िडवाइस है जो डाटा को सचूना म  पिरवितत कर उसे ोसेस करता है ।
a) ोसेसर
b) कयटूर
c) केस
d) टायलस
Answer- (b) कयटूर

6. िकसी शद को हाईलाइट करने के िलए आप या करेग  आप कसर को शद के आगे रखते ह  और
िफर –
a) बटन डाउन होड करते हुए माउस ड ैग करते ह
b) माउस एक बार िलक रोल करते ह
c) माउस को इद – िगद रोल करते ह
d) माउस को रोल करके िलक करते ह
Answer- (a) बटन डाउन होड करते हुए माउस ड ैग करते ह

7. टेलीफोन िसटम ारा ट ासिमशन करने के िलए और पुन : वापसी हेतु िडजीटल कयटूर िसनल
को एनलॉग म  पिरवितत करने वाला िडवाईस
a) मॉडेम
b) मॉनीटर
c) िडिजटल कैमरा
d) कैनर
e. Answer- (a) मॉडेम

8. िबना केबल युत िकए नेटवक  को कनेट करने वाले िडवाइस को कहते ह ।
a) िडिट यटेूड
b) सेट ालाइड
c) ओपन सोस
d) वायरलेस
Answer – (d) वायरलेस

9. ेडशीट म  सेल को िननानुसार पिरभािषत िकया जाता है ।
a) रॉ और कालॅम का इंटरसेशन
b) टेबल और टुलेट का इंटरसेशन
c) फाइल और डाटाबेस का इंटर सेशन
d) फीड और िरकॉड का इंटर सेशन
Answer – (a) रॉ और कालॅम का इंटरसेशन
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10. कयटूर संेप म  KB का परूा प सामायत िननानुसार होता ह  ।
a) Key Block
b) Kemrel Boot
c) Kilo Byte
d) Kit Bit
Answer – (c) Kilo Byte

11. सॉटवेयर का ाथिमक योजन डाटा को ______म  पिरवितत करना ह  ।
a) वेब साइट
b) सचूना
c) ोग ाम
d) ओजेट्स
Answer – (b) सचूना

12. लॉपी िडक म  डाटा नामक िरंगस पर िरकाड िकया जाता है ।
a) सेटस
b) िरंस
c) टै स
d) राउंडस
Answer – (c) टै स

13. कपयटूर का वह भाग है िजसे छुआ जा सकता है
a) हाडवेयर
b) डाटा
c) सॉटवेयर
d) इनपुट
Answer – (a) हाडवेयर

14. लॉपी िडक का उपयोग िकस िलए होता है
a) कयटूर ीन को इरेज करने
b) िंटर को कायरत करने
c) कयटूर को अनलॉक करने
d) सचूना टोर करने
Answer – (d) सचूना टोर करने

15. CPU का परूा प या है ।
a) Compute Processing Unit
b) Central Processing Unit
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c) Computer Protection Unit
d) Central Processing Upload
Answer –(b) Central Processing Unit
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Computer GK Practice Set – 2
इस ैिटस पेपर म  कंयटूर फंडाम टल, डेटाबेस और इटरनेट से सबंिधत कुल 15 वतुिनठ न
उर िमल गे, जो आपको
SSC, ब िकंग, पटवारी, पुिलस, रेलवे और  DCA, PGDCA की परीा की तैयारी के िलए बहुत काम
आय गे|
In  this  practice  set  you  will  find  15  objective  question  related  to  Computer
Fundamentals and Database which will help you in prepration of SSC, Banking,
Patwari, Police, Railway and DCA, PGDCA.

1. योता जो ात करना चाहता है उसे कयटूर ारा एसीयटू िकए जाने वाले इटशस म
ट ासलेट करने की िया ………. को कहते ह  ।
a) ोग ािमंग
b) िडबिगंग
c) मोडेिलंग
d) िसटम टेिटंग
Answer – (a) ोग ािमंग

2. इनपुट िडवाइस का एक उदाहरण है।
a) की बोड
b) मॉनीटर
c) माउस
d) (a) एवं (c) दोनो
Answer – (d), (a) एवं (c) दोनो

3. वेब साइट एड ेस एक यनूीक नाम होता है जो वेब पर एक पेिसिफक को आइडिटफाय करता है ।
a) वेब ब ाउजर
b) वेब साइट
c) PDA
d) िलकं
Answer – (b) वेब साइट

4. ……. म  ऐसी कमांड्स होती है िजहे िसलेट िकया जा सकता है ।
a) पॉइटर
b) मेनू
c) आइकन
d) वटन
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Answer – (b) मेनू

5. वड ोसेिसंग ोग ाम ारा िकस कार की फाइल िएट की जाती है।
a) एिडिटंग
b) िएिटंग
c) मॉिडफाइगं
d) एडजिटंग
Answer – (d) एडजिटंग

6. िकसी िवमान डॉयुम ट म  पिरवितत करने को कहते ह ।
a) डाटाबेस फाइल
b) टोरेज फाइल
c) वक शीट फाइल
d) डॉयुम ट फाइल
Answer – (a) डाटाबेस फाइल

7. आपके कयटूर का एवरीिथंग कंपोनेट या तो ……. होता है ।
a) सॉटवेयर होता है या CPU/RAM
b) एिलकेशन साटवेयर होता है या िसटम सॉटवेयर
c) इनपुट िडवाइस होता है या आउटपुट िडवाइस
d) हाडवेयर होता है या सॉटवेयर
Answer – (d) हाडवेयर होता है या सॉटवेयर

8. ……… ऐसे शद है िजह  ोग ािमंग लैवेज ने अपने योग हेतु अलग रखा है।
a) कंट ोल वडस
b) कंट ोल टचस
c) िरजड वड्स
d) िरजवड कीज
Answer – (c) िरजड वड्स

9. टेप ड ाइव डाटा को …… एसेस ऑफर करता है ।
a) टाइमली
b) पोरेिडक
c) रैडम
d) िसवेिशयल
Answer – (d) िसवेिशयल

10. RAM का परूा प या है ।
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a) Random Access Memory
b) Registered Application Module
c) Real time Access Memory
d) Remote Access Machine
Answer – (a) Random Access Memory

11. ििडफाइड मीिनंग वाला कैरेटर का एक समहू।
a) फाइल
b) डेटाबेस
c) फीड
d) कीबोड
Answer – (b) डेटाबेस

12. प िलखने जैसे काय करने के िलए युत सॉटवेयर के कार को कहते है।
a) GUI सॉटवेयर
b) यिूटिलटी सॉटवेयर
c) एिलकेशन सॉटवेयर
d) यजूर नीड्स सॉटवेयर
Answer – (c) एिलकेशन सॉटवेयर

13. .bss, .doc और .html िकसके उदाहरण ह ।
a) डाटाबेस।
b) डोमेन
c) एसटेशन
d) ोटोकॉल
Answer – (c) एसटेशन

14. ………. एक यनूीक नाम होता है जो आप सचूना की िकसी फाइल को देते है ।
a) फोडर
b) िडवाइस
c) फाइलनेम
d) फाइलनेम एसट शन
Answer – (c) फाइलनेम

15. कंपाइलर हाई-लेवेल ोग ाम को मशीन ल वेज म  ट ासलेट करता है िजसे कहते है ।
a) सोस कोड
b) ओजेट कोड
c) कंपाइड कोड
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d) बीटा कोड
Answer – (b) ओजेट कोड
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Computer GK Practice Set – 3
इस ैिटस पेपर म  कंयटूर फंडाम टल, डेटाबेस और इटरनेट से सबंिधत कुल 15 वतुिनठ न
उर िमल गे, जो आपको
SSC, ब िकंग, पटवारी, पुिलस, रेलवे और  DCA, PGDCA की परीा की तैयारी के िलए बहुत काम
आय गे|

In  this  practice  set  you  will  find  15  objective  question  related  to  Computer
Fundamentals and Database which will help you in preparation of SSC, Banking,
Patwari, Police, Railway and DCA, PGDCA.

1. िकस ोग ाम को कंयटूर से िनकालने के िलए उसे  ………… करना आवयक है।
a) िडलीिटंग
b) िरमिूवंग
c) अनइटािलंग
d) िडसेिलंग
Answer – (c) अनइटािलंग

2. ………….. म  बटन और मेन ूहोते है जो सामाय युत कमांडो को एसेस उपलध कराते ह ।
a) टूल बार
b) मेन ूबार
c) िवंड
d) फाइंड
Answer – (b) मेन ूबार

3. कयटूर बंद हो जाने पर ………… का कंटेट्स िडलीट हो जाता है ।
a) इनपुट
b) आउटपुट
c) मेमोरी
d) टोरेज
Answer – (c) मेमोरी

4. इसटशस के सीिरज िजनक कयटूर एक या अिधक पिटयलूर टाक परफॉम करने के िलए
कहती है कहलाती है ।
a) वॉड्स िएवेशन
b) डाटावेश
c) ेडशीड
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d) ोग ाम
Answer – (d) ोग ाम

5. नबर पैड से डायरेशन ऐरो म  काम लेने के िलए ……….. कंुजी दबानी पड़ती है ।
a) नम लॉक
b) कैस लॉक
c) ऐरो लॉक
d) िशट
Answer – (a) नम लॉक

6. िकसी भी कयटूर िसटम म  सबसे छोटा यिूनट िजससे आठ……….. िमलकर एक बाइट बनता है ।
a) िबट
b) बाइनरी
c) ऑटल
d) िगगाबाइट
Answer – (a) िबट

7. िकसी ओजेट की ोटी ज म  एसेस के िलए यजू की जाने वाली माउस टेकनीक िननिलिखत ह  ।
a) डैिगंग
b) ड ॉिपंग
c) राइट-िलिकंग
d) िशट िलिकंग
Answer – (c) राइट-िलिकंग

8. कयटूर से हाडकॉपी उपलध कराता है
a) ई मेल
b) फैस
c) सॉटवेयर
d) िंटर
Answer – (d) िंटर

9. िटिपकल नेटवक  म  सबसे महवपणू या पावफुल कयटूर
a) डेक टॉप
b) नेटवक  लाइट
c) नेटवक  सवर
d) नेटवक  टेशन
Answer – (c) नेटवक  सवर
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10. PC का परूा नाम है ।
a) Personal Computer
b) Process Control
c) Production Computer
d) Painful Creation

11. िकसी फाइल को एक फोडर से दसूरे फोडर म  ले जाने के िलए आदेश का कौन – सा जोड़ा िदया
जाता है।
a) कॉफी – पेट
b) कट – पेट
c) िडलीट – पेट
d) िडलीट – मवू
Answer – (a) कट – पेट

12. िनन म  से या एसेल का िबट – इन फंशन नही ंह
a) TOTAL
b) SUM
c) AVERAGE
d) MAX
Answer – (a) TOTAL

13. फॉस (Forms) के संबंध म  कौन – सा कथन असय है ।
(a) फास की सहायता से टोर हुए डाटा को सरल फॉमट म  िदखता है
(b) फास की सहायता से िरमाड्स देखे जा सकते है िवट कर सकते ह  या कुछ िरकाडस म  फेरबदल
कर सकते ह
(c) A तथा B दोन
(d)इनम  से कोई नहीं
Answer – (c) A तथा B दोन

14. DBMS (Database Management System) का काम ह ।
I. डाटाबेस बनाना
II. डाटाबेस म  बदलाव करना
III. डाटाबेस म  िरकाड िवट करना
IV. डाटाबेस से िरकाड िडलीट करना
V. कुछ िरकाड चुनना
(a) (i),(II),(III),एव(IV
(b) केवल(ii), (iii)एव (iv)
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(c) केवल(i),(iii)एव (iv)
(d) (i),(ii),(iii),(iv)एव (v)
Answer – (d) (i),(ii),(iii),(iv)एव (v)

15. असय कथन को िचिहत कर ।
a) वेरीज (Queries) डाटाबेस से िकसी िवशेष डाटा को यविथत तरीके से देखने म  सहायता करती
है
b) एक या एक से अिधक डाटाबेस को आपस म  जोड़ने को िरलेशनिशप (Relationship) कहते ह
c) ाइमरी की एक खास तरह की फीड होती है जो हर िरकाड को अलग पहचान देती है
d) िवशेष िवषय के डाटा संग हरण को फॉस कहते ह
Answer – (d) िवशेष िवषय के डाटा संग हरण को फॉस कहते ह
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Computer GK Practice Set – 4
इस ैिटस पेपर म  कंयटूर फंडाम टल, डेटाबेस और इटरनेट से सबंिधत कुल 15 वतुिनठ न
उर िमल गे, जो आपको
SSC, ब िकंग, पटवारी, पुिलस, रेलवे और  DCA, PGDCA की परीा की तैयारी के िलए बहुत काम
आय गे|

In  this  practice  set  you  will  find  15  objective  question  related  to  Computer
Fundamentals and Database which will help you in preparation of SSC, Banking,
Patwari, Police, Railway and DCA, PGDCA.

1. HTML भाषा के ोग ाम को Run करने के िलए ……….. साटवेयर का योग होता है ।
a) Notepad
b) WordPad
c) a और b दोन
d) Internet Explorer
Answer – d) Internet Explorer

2. MS – Word की िवडो को दो या अिधक भाग म  बॉटने की िविध को कहते ह  ।
a) Freeze Window
b) Page Break
c) Split Window
d) Page End
Answer –c) Split Window

3. HUB एक …………….. िडवाइस ह ।
a) डब
b) एिटव
c) सुचा
d) जागक
Answer –(a) डब

4. डॉयुम ट म  Font Size को बढ़ाने के िलए िननिलिखत म  स  कौन – सी Key योग िकया जाता ह
a) Ctrl + Shift + >
b) Ctrl + Shift + <
c) Ctrl + Shift + :
d) Ctrl + Shift +;
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Answer – a) Ctrl + Shift + >

5. सचूनाओं को पंित व तभ के प म  यविथत करने को …………… कहा जाता ह  ।
a) कॉलम
b) रो
c) टेबल
d) केस
Answer – c) टेबल

6. Text को Double underline करने के िलए ……………… का योग करते ह ।
a) Crtl +Shift + D
b) Ctrl + D
c) Shift + D
d) Alt + D
Answer –a) Crtl +Shift + D

7. लाइड शो य ूम  िपछली लाइड पर जाने के िलए कौन – सी बटन दबाया जाता ह ।
a) एटर कंुजी
b) पेज अप कंुजी
c) पेस बार
d) N कंुजी
Answer –(b) पेज अप कंुजी

8. इनम  से िकस ॉल बार का योग िवंडो म  नीचे की और िछपी हुई सामग ी को देखने म  िकया जाता
ह ।
a) ैितज
b) ऊवाधर
c) ये दोन
d) इनम  से कोई नहीं
Answer –b) ऊवाधर

9. नॉमलाइजेशन ह ।
a)  िरलेशनल डाटाबेस की िडजािइनग करते समय ऑकड़ो के जिटल समहूो से माइल टेबल डेटा
टचर उपन करने की िया
b) डाटाबेस म  िविभन एिटटीज के बीच सबध को दशाने के िलए डेटाबेस के डॉयुम टेशन करने
वाली मेथॉडोलॉजी है
c) यह डेटा मैनेजम ट की वह िवधी है जो डेटा और उन पर ियाशील िविधय (ासीजस) का संग हण
करती ह
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d) एलीकेशन ोग ाम या यजूर के समुख कट होने वाला ऑकड़ का िनपण ह
Answer  –a)  िरलेशनल डाटाबेस की िडजािइनग करते समय ऑकड़ो के जिटल समहूो से माइल
टेबल डेटा टचर उपन करने की िया

10. िकस य ूम  आप िकसी तुतीकरण की लाइड को म म  लगा सकते ह ।
a) नॉमल यू
b) लाइड सॉटर यू
c) दोन
d) ये सभी
Answer –b) लाइड सॉटर यू

11. लाइड शो समात करने के िलए कौन – सा बटन दबाया जाता ह ।
a) एस कंुजी
b) – (ऋण) कंुजी
c) कंट ोल + ब ेक
d) ये सभी
Answer –d) ये सभी

12. कसर वाले िचह को हटाने के िलए की बोड की िकस कंुजी को दबाते ह  ।
a) बैकपेस
b) ऑट
c) िडलीट
d) एटर की
Answer –c) िडलीट

13. हाड िडक म  िविभन ोग ाम की ड ाइव (Derives की भौितकीय ुिटय की जॉचं करने एवं उह
ठीक ढंग से करने के िलए िवडोज म  एक ोग ाम उपलध है िजसे…………. कहते ह ।
a) कैन िडक (Scan Disk)
b) चेक िडक (Check Disk)
c) िडक डायरेटी (Disk Directory)
d) हेप मेयु (Help Menu)
Answer –(a) कैन िडक (Scan Disk)

14. ड म िंटर …………. कार के िंटर कर एक उदाहरण ह ।
a) लाइन
b) कैरेट
c) सीिरयल
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d) लेजर
Answer –(a) लाइन

15. OSI Model की ……………… Layers होती ह
a) 7
b) 9
c) 11
d) 13
Answer –a) 7
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Computer GK Practice Set – 5
इस ैिटस पेपर म  कंयटूर फंडाम टल, डेटाबेस और इटरनेट से सबंिधत कुल 15 वतुिनठ न
उर िमल गे, जो आपको  SSC,  ब िकंग, पटवारी, पुिलस, रेलवे और  DCA,  PGDCA की परीा की
तैयारी के िलए बहुत काम आय गे|

In  this  practice  set  you  will  find  15  objective  question  related  to  Computer
Fundamentals and Database which will help you in preparation of SSC, Banking,
Patwari, Police, Railway and DCA, PGDCA.

1.  MS-Word Picture Insert के िलए कौन सी सुिवधा उपलध ह ।
a)  Clip art
b) Picture
c) From File
d) उपरोत सभी
Answer –(a)    Clip art
2.  ……………एक ऐसा सॉटवेयर है िजसके ारा वीिडय व ऑिडय को चलाया जाता ह ।
a) MPEG Player
b) Plotters
c) Menu Bar
d) Win Zip
Answer –(a) MPEG Player
3.  Front-Page म  बनने वाले डॉयमू ट की HTML Coding को देखने के िलए िननिलिखत म  से
या योग िकया जाता ह ।
a) Reveal Tag
b) Empty Tag
c) Container Tag
d) Break Tag
Answer –(a)  Reveal Tag
4.  कयटूर म  बस (BUS) से अिभाय ह ।
a) डाटा लाइन का ग ुप
b) केवल कुछ लाइन
c) एड ेस बस
d) डाटा बस
Answer –(d) डाटा बस

5.  िननिलिखत म  से कौन सा कथन Disk Copy के संबंध मे सय ह ।
a) Copy और Disk Copy एक समान ह
b) Disk Copy कमांड का योग DOS म  होता ह
c) Disk Copy हाड िडक पर योग िकया जा सकता है
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d) Disk Copy लॉपी और हाड के साथ योग िकया जा सकता ह
Answer –(b) Disk Copy कमांड का योग DOS म  होता ह
6. Virus का िवतािरत प होगा
a) Very Important Resource Under Search
b) Virtual Information Resource Under Size
c) Verify Interchange Result Unit Source
d) Very Important Record Use Searched
Answer –(b) Virtual Information Resource Under Size
7. िननिलिखत म  कौन सा उच तरीय भाषा कोबोल  (COBOL)  एवं फोरट ान  (FORTRAN)  का
सिमण ह ।
a) पाकल
b) बेिसक
c) एलगोल
d) पी एल / 1
Answer –(d) पी एल / 1
8. सवािधक ोग ािमंग किठन ह
a) मशीन म  (Machine)
b) असेबली (Assembly) म
c) उच तरीय भाषा म
d) ये सभी
Answer –(a) मशीन म  (Machine)
9. इनम  से कौन सा बटन टॉगंल बटन नही ंहै।
a) Bold
b) Italic
c) Underline
d) इनम  से कोई नहीं
Answer –(d) इनम  से कोई नहीं
10. बेिसक (Basic) सवािधक उपयुत ह  ।
a) टाइम शेयिरंग (Micro Sharing) िसटम के िलए
b) माइो कयटूर (Micro Computer) म  योग हेतु
c) A एवं B दोन
d) इनम  से कोई नहीं
Answer –(c)  A एवं B दोन
11.  ………………. कयटूर को यह कहता ह  िक अपने कंपोनेट्स का कैसे उपयोग िकया जाए।
a) मॉनीटर
b) िंटर
c) नेटवक
d) ऑपरेिटंग
Answer –(d) ऑपरेिटंग
12.  कयटूर सीधे सपक  करता है।
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a) हाड ड ाइव
b) िडक ड ाइव
c) मॉडेम
d) USB पोट
Answer –(a) हाड ड ाइव
13. िननिलिखत म  स  कौन सा 1 िमिलयन बाइट िरेज ट करता है ।
a) िगगाबाइट
b) िकलोबाइट
c) टेराबाइट
d) मेगाबाइट
Answer –(d) मेगाबाइट
14. डाटा टोर करने और गणना करने के िलए कयटूर ………. नबर िसटम का उपयोग करते ह ।
a) बाइनरी
b) ओटल
c) डेिसमल
d) हेसाडेिसमल
Answer –(a) बाइनरी
15. कयटूर ारा ……………. को सचूना म  ोसेस िकया जाता ह ।
a) डाटा
b) नबर
c) ोसेस
d) िरपोट
Answer –(a) डाटा
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Computer GK Practice Set – 6
इस ैिटस पेपर म  कंयटूर फंडाम टल, डेटाबेस और इटरनेट से सबंिधत कुल 15 वतुिनठ न
उर िमल गे, जो आपको
SSC, ब िकंग, पटवारी, पुिलस, रेलवे और  DCA, PGDCA की परीा की तैयारी के िलए बहुत काम
आय गे|
In  this  practice  set  you  will  find  15  objective  question  related  to  Computer
Fundamentals and Database which will help you in preparation of SSC, Banking,
Patwari, Police, Railway and DCA, PGDCA.

1. एंटीवायरस साटवेयर ……… का उदाहरण है
(a) िबजनेस सॉटवेयर
(b) ऑपरेिटंग िसटम
(c) िसयोिरटी यिूटिलटी
(d) ऑिफस सइूट
Answer – (c) िसयोिरटी यिूटिलटी

2. कौन – सा ोग ाम  कयटूर के िविभन भाग का िनयण करता है और योता को कयटूर के
साथ इंटरेट करने देता है।
(a) यिूटिलटी सॉवेयर
(b) ऑपरेिटंग िसटम
(c) वड ोसेिसंग सॉवेयर
(d) डाटाबेस ोग ाम
Answer – (b) ऑपरेिटंग िसटम

3. अनसॉिलिसटेउ ई-मेल को या कहते ह  ।
(a) यजूगुप
(b) यजूनेट
(c) बैकबोन
(d) पैम
Answer – (d) पैम

4. बैकअप या होता ह
(a) अपने नेटवक  को अिधक कपोनेट जोड़ना
(b) मलू ोत से िकसी िभन डेिटनेशन पर कॉपी करके डाटा का संरण करना
(c) नये डाटा से पुराना डाटा िफटर करना
(d) टेप पर डाटा को एसेस करना
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Answer – (b) मलू ोत से िकसी िभन डेिटनेशन पर कॉपी करके डाटा का संरण करना

5. …………. टोपोलोजी मे नेटवक  कपोनेट एक ही केबल से कनेट िकए जाते ह ।
(a) टार
(b) िरंग
(c) बस
(d) मेश
Answer – (c) बस

6. माइोसॉट ऑिफस एसेल डायुम ट म  से रेपर िकया जाता है जो ……… ह ।
(a) सेल का कॉलम लेबल
(b) सेल का कॉलम लेबल और वक शीट टैब नाम
(c) सेल का रो लेबल
(d) सेल का रो और कॉलम लेबल
Answer – (d) सेल का रो और कॉलम लेबल

7. सेकेडरी टोरेज मीिडया से हाड िडक म  सॉटवेयर ोग ाम को कॉपी करने की िया को या
कहते ह ।
(a) कोनिफगरेशन
(b) डाउनलोड
(c) टोरेज
(d) इनटालेशन
Answer – (d) इनटालेशन

8. बड़े पैमाने पर भौगोिलक प से अलग अलग फैले हैए ऑिफस LANs एक कॉपो रेट …………. के
उपयोग से कनेट िकये जा सकते है-
(a) CAN
(b) LAN
(c) DAN
(d) WAN
Answer – (b) LAN

9. डायल –अप इंटरनेट एसेस का एक लाभ िननिलिखत ह ।
(a) यह ब ॉडबैड टेनोलॉजी का उपयोग करता ह
(b) यह िवघमान टेलीफोन सेवा का उपयोग करता है
(c) यह सुरा के िलए राउटर का उपयोग करता है
(d) मॉडेम पीड बहुत तेज होती ह
Answer – (b) यह िवघमान टेलीफोन सेवा का उपयोग करता है
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10. …………… का योग करते हुए वेब पेज का कोड िलखा जाता ह ।
(a) िफथ जनरेशन ज वेज
(b) िवनिजप
(c) पल
(d) हाइपरटेट माक अप ल वेज
Answer – (d) हाइपरटेट माक अप ल वेज

11. सचूना शेयर करने के िलए एक दसूरे से कनेटेड दो या अिधक कयटूर से ………. बनता है।
(a) नेटवक
(b) राउटर
(c) सवर
(d) टिमनल
Answer – (a) नेटवक

12. िननिलिखत म  से कौन – सा सय ह ।
(a) बाइनरी नबर म  बाइट एक िसंगल िडिजट होता ह
(b) िबट िडिजटल नबस के एक समहू को िरेजेट करता ह
(c) आठ – िडिजट के बाइनरी नबर को बाइट कहते ह
(d) आठ – िडिजट के बाइनरी नबर को िबट कहते ह
Answer – (c) आठ – िडिजट के बाइनरी नबर को बाइट कहते ह

13. एसेस देने से पहले कयटूर यजूर नाम और पासवडो  को मैच करने के िलए सुिवधाजनक होते ह ।
(a) वेबसाइड
(b) नेटवक
(c) बैकअप फाइल
(d) इनम  से कोई नहीं
Answer – (d) इनम  से कोई नहीं

14. ऐसे कयटूर जो पोट बल होते ह  और याा करने वाले योताओं के िलए सुिवधाजनक होते ह ।
(a) सुपर कयुटर
(b) लैपटॉप
(c) िमनीकयटूर
(d) फाइल सवस
Answer – (b) लैपटॉप

15. जब वाइंटर ……… पर पोिजशन िकया जाता है तब इसका आकार हाथ जैसा हो जाता है।
(a) Grammar Error
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(b) Hyperlink
(c) Screen Tip
(d) Spieling Error
Answer – (b) Hyperlink
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Computer GK Practice Set – 9
इस ैिटस पेपर म  कंयटूर फंडाम टल, डेटाबेस और इटरनेट से सबंिधत कुल 15 वतुिनठ न
उर िमल गे, जो आपको
SSC, ब िकंग, पटवारी, पुिलस, रेलवे और  DCA, PGDCA की परीा की तैयारी के िलए बहुत काम
आय गे|
In  this  practice  set  you  will  find  15  objective  question  related  to  Computer
Fundamentals and Database which will help you in preparation of SSC, Banking,
Patwari, Police, Railway and DCA, PGDCA.

1. कयटूर के वे िविभन भौितक अंग, िजह  पश या देख सकते ह , कहलाते ह ।
a) हाडवेयर
b) सॉवेयर
c) यं
d) इकाई
Answer –(a) हाडवेयर

2. Computer का वह पाट िजसको हम केवल देख सकते ह  और उस पर काय कर सकते ह , कहलाता
है।
a) आगम उपकरण
b) सीपीयू
c) िनगम
d) सॉवेयर
Answer –(d) सॉवेयर

3. कयटूर हाडवेयर का सबसे महवपणू भाग है।
a) आगम
b) केद ीय संसाधन इकाई (CPU)
c) िनगम
d) सॉवेयर
Answer –(b) केद ीय संसाधन इकाई (CPU)

4. िनन म  से िकसे कयटूर का िदमाग (Brain) भी कहते ह ।
a) सीपीय ूको
b) आगम इकाई को
c) डाटा को
d) िवंस टे ड को
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Answer –(a) सीपीय ूको

5. डाटा ोसेिसंग के चरण ह ।
a) िरकॉड करना
b) वगी करण करना
c) मबता
d) ये सभी
Answer –(d) ये सभी

6. सवथम पंचकाड का योग िकसने िकया।
a) लेज पाकल
b) हावड एकेन
c) जॉन मॉकले
d) जोसेफ मेरी
Answer –(d) जोसेफ मेरी

7. इलेट ॉिनक एनालॉग कयटूर का उपयोग कब शु हुआ।
a) 1930 से
b) 1950 से
c) 1956 से
d) 1958 से
Answer –(b) 1950 से

8. संगणक (Calculator) मशीन का आिवकार िकसने िकया।
a) जे िबहाग  ने
b) लेज पाकल ने
c) जैकाड ने
d) होवड एकन ने
Answer –(b) लेज पाकल ने

9. हाडिब ड कयटूर िमण ह ।
a) एवेकस + कलकुलेटर का
b) पंचकाड + लेपटॉप
c) एनालॉग + िडिजटल कयटूर
d) केलकुलेटर + पंचकाड का
Answer –(c) एनालॉग + िडिजटल कयटूर

10. 1980 म  िकस कपनी ने घरेल ूउपयोग हेतु कयटूर का िनमाण िकया।
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a) IBM ने
b) सयम ने
c) िवो ने
d) उपयुत सभी ने
Answer –(a) IBM ने

11. माइो कयटूर ………. के प है।
a) डेकटॉप कयटूर
b) लैपटॉप
c) नेटवक  कयटूर
d) उपयुत सभी
Answer –(d) उपयुत सभी

12. बाइनरी िवकप म  िकतने िवकप होते ह ।
a) एक
b) दो
c) तीन
d) चार
Answer –(b) दो

13. िमनी कयटूर की िडक टोरेज मता होती ह ।
a) 5
b) 20
c) 3
d) 100
Answer –(b) 20

14. हाडवेयर म  शािमल ह ।
a) आगम उपकरण
b) सीपीयू
c) िनगम उपकरण
d) ये सभी
Answer –(d) ये सभी

15. मुय मेमोरी (Main Memory) भाग ह ।
a) इनपुट यिूनट की
b) आउटपुट यिूनट की
c) सीपीय ूकी
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d) मदरबोड की
Answer –(c) सीपीय ूकी
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Computer GK Practice Set – 8
इस ैिटस पेपर म  कंयटूर फंडाम टल, डेटाबेस और इटरनेट से सबंिधत कुल 15 वतुिनठ न
उर िमल गे, जो आपको
SSC, ब िकंग, पटवारी, पुिलस, रेलवे और  DCA, PGDCA की परीा की तैयारी के िलए बहुत काम
आय गे|
In  this  practice  set  you  will  find  15  objective  question  related  to  Computer
Fundamentals and Database which will help you in preparation of SSC, Banking,
Patwari, Police, Railway and DCA, PGDCA.

1. माइोसॉट ऑिफस …………….।
(a) शेयरवेयर ह
(b) पिलक – डोमेन सॉटवेयर
(c) ओपन – सोस सॉटवेयर है
(d) एक ऐिलकेशन सुईट ह
Answer – (d) एक ऐिलकेशन सुईट  ह

2. LAN (लोकल एिरया नेटवक ) से जुड़े कयटूर
(a) तेज चल सकते ह
(b) ऑनलाइन जा सकते ह
(c) इनफॉमशन और/या पेिरफरल उपकरण शेयर कर सकते ह
(d) ई-मेल भेज सकते ह
Answer – (c) इनफॉमशन और/या पेिरफरल उपकरण शेयर कर सकते ह

3. आपके कयुटर म  िननिलिखत म  से कौन – सी मेमोरी दशाता ह
(a) RAM
(b) DSL
(c) USB
(d) LAN
Answer – (a) RAM

4. मदर बोड के कपोनेट्स के बीच इफॉमशन ……… के मायम से टे वल करता है।
(a) लैश मेमोरी
(b) CMOS
(c) बेज
(d) बसेज
Answer – (d) बसेज
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5. एक मेगाबाइट लगभग ………. के समान होता है।
(a) 1000 िबट्स
(b) 1000 बाइट्स
(c) 1 िमिलयन बाइट्स
(d) 1 िमिलयन बाइट्स
Answer – (c) 1 िमिलयन बाइट्स

6. जब आप PC पर िकसी डायमेूट पर काय करते ह  तब डायुमेट पर काय करते ह  तब डायमेूट
अथायी प से कही ंटोर िकया जाता ह ।
(a) RAM
(b) ROM
(c) CPU
(d) लैश मेमोरी
Answer – (a) RAM

7. ेडशीट म  डाटा कैसे ओग नाइज होता है
(a) लाइस एड पेसेज
(b) लेयस एड लेस
(c) हाइट एड िवड्थ
(d) रोस एड कॉलस
Answer – (d) रोस एड कॉलस

8. ऐसे ऐिलकेशन के िलए मैनेिटक टेप ैिटकल नही ंहै िजनम  डाटा शीघ  रीकॉल िकया जाना है
योिकं टेप…………..।
(a) र डम एसेस मीिडयम
(b) िसवेिशयल एसेस मीिडयम
(c) रीड – ओली मीिडयम
(d) ेजाइल और easily डैमेड
Answer – (b) िसवेिशयल एसेस मीिडयम

9. कयटूर ीन पर िलक करने वाले तीक को …………… कहते है।
(a) माउस
(b) लोग
(c) ह ड
(d) पाम
Answer – (d) पाम

10. किटंग और पेिटंग के साथ काटी गई मद अथायी प से ………… मे टोर की जाती है।
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(a) ROM
(b) हाड ड ाइव
(c) िडकेट
(d) िलपबोड
Answer – (d) िलपबोड

11. मॉनीटर और हाड ड ाइव जैसे अिधक पॉवर हंग ी कपोनेट को आइडल रखने पर होता ह ।
(a) हाइबरनेशन
(b) पॉवर डाउन
(c) टैडबाइ मोड
(d) शटडाउन ोिसजर
Answer – (c) टैडबाइ मोड

12. हाड िडक ड ाइव को ………….. टोरेज माना जाता है।
(a) लैश
(b) नॉनवोलाटाइल
(c) टेपरेरी
(d) नॉनपरमानेट
Answer – (b) नॉनवोलाटाइल

13. शाटकट्स और अय िवशेष कायो  के िलए ………. की और …………. की अय कीज के साथ
कांिबनेशन मे योग िकया जाता है।
(a) कंट ोल आट
(b) फंशन टोगल
(c) िडलीट, इनसट
(d) कैस लॉक नम लॉक
Answer – (a) कंट ोल ,आट

14. ……….. और ………… सवािधक सामाय इनपुट िडवाइस ह ।
(a) माइोफोन िटर
(b) कैनर मानीटर
(c) िडिजटल कैमरा, पीकस
(d) की – बोड , माउस
Answer – (d) की–बोड , माउस

15. नये नाम सिहत या नये लाकेशन पर िकसी िवमान फाइल को सेव करने के िलए आपक ……..
कमांड का योग करना चािहए।
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(a) सेव
(b) सेव एड िरलेस
(c) सेव एज
(d) य ूफाइल
Answer – (c) सेव एज
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Computer GK Practice Set – 7
इस ैिटस पेपर म  कंयटूर फंडाम टल, डेटाबेस और इटरनेट से सबंिधत कुल 15 वतुिनठ न
उर िमल गे, जो आपको
SSC, ब िकंग, पटवारी, पुिलस, रेलवे और  DCA, PGDCA की परीा की तैयारी के िलए बहुत काम
आय गे|
In  this  practice  set  you  will  find  15  objective  question  related  to  Computer
Fundamentals and Database which will help you in preparation of SSC, Banking,
Patwari, Police, Railway and DCA, PGDCA.

1. यजूर यह कैसे िनधािरत कर सकता है िक कयटूर पर कौन से ोग ाम उपलध है।
(a) हाड िडक की ॉपटी ज चेक करके
(b) बिूटग ोसेस के दौरान इनटाड ोग ाम देखकर
(c) इंटाड ोग ाम की िलट देखकर
(d) िडक पर सेव की गई िवमान फाइल  चेक करके
Answer – (c) इंटाड ोग ाम की िलट देखकर

2. कयटूर के कपोनेट ठीक से ऑपरेट हो रहे ह  और कनेटेड है यह सुिनिचत करने के िलए कौन
सी ोसेस चेक करता है।
(a) बिूटग
(b) ोसिसंग
(c) सेिवंग
(d) एिडिटंग
Answer – (a) बिूटग

3. ………….. का उपयोग करते हुए पहले कयटूर ोग ाम िकए गए थे।
(a) एसेबली ल वेज
(b) मशीन ल वेज
(c) सोस कोड
(d) ओजेट कोड
Answer – (a) एसेबली ल वेज

4. छोटे एिलकेशन ोग ाम जो वेब पेज पर चलते है और यह सुिनिचत करते ह  िक फाम ठीक से परूा
हो गया है या एिनमेशन ोवाइड करते है उहे ……….. कहते है।
(a) लैश
(b) पाइडस
(c) कूकीज
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(d) एलेट्स
Answer – (a) लैश

5. िरलेशनल डाटाबेस म  यह डाटा टचर ह  जो एक िसंगल टॉिपक सबधी इनफामशन को रो और
कॉलमो म  ऑगनाइज करता है।
(a) लॉकं
(b) िरकाड
(c) टूफल
(d) टेबल
Answer – (d) टेबल

6. बाइनरी चॉइस म  िकतने िवकप होते ह
(a) कोई नहीं
(b) एक
(c) दो
(d) यह कयटूर म  मेमोरी की माा पर िनभर करता ह
Answer – (c) दो

7. कयटू म  जाने वाले डाटा को ……… कहते है।
(a) आउटपुट
(b) एगोिरम
(c) इनपुट
(d) कैलयलेूशस
Answer – (c) इनपुट

8. एक बाइट से िकतने मूय िनिपत िकए जा सकते ह ।
(a) 4
(b) 16
(c) 64
(d) 256
Answer – (b) 16

9. इनपुट का आउटपुट म  पातरण ………. ारा िकया जाता है।
(a) पेिरफेरस
(b) मेमोरी
(c) टोरेज
(d) CPU
Answer – (d) CPU
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10. िडवाइस ड ाइस या होते ह ।
(a) एसटनल टोरेज िडवाइस के िलए टाइनी पावर कोड
(b) िवशेष जो यह जानते है िक िडवाइस का परफॉमस कैसे अिधकतम िकया जाए
(c) छोटे िवशेष – योजन ोग ाम
(d) ऑपरेिटंग िसटम का अंतरम भाग
Answer – (c) छोटे िवशेष – योजन ोग ाम

11. ोग ोम का समहू जो आपकी कयटूर िसटम के चलने को कंट ोल करता है और सचूना ोसेस
करता ह  उसे …….. कहते है।
(a) ऑपरेिटंग िसटम
(b) कयटूर
(c) ऑिफस
(d) कपाइलर
Answer – (a) ऑपरेिटंग िसटम

12. िननिलिखत म  से कौन सा एक छोटा िसंगल – साइट नेटवक  ह ।
(a) LAN
(b) DSL
(c) RAM
(d) USB
Answer – (a) LAN

13. अनुदेश का सेट जो कयटूर को या करना यह बताता है उसे ……….. कहते है।
(a) म टर
(b) इटटर
(c) कपाइलर
(d) ोग ाम
Answer – (d) ोग ाम

14. आपक ऐसे िकसी से ई मेल ात होता है िजसे आप नही ंजानत  है आपको या करना चािहए।
(a) इसे सीधा पुिलस को भेजना चािहए
(b) िबना खोले इसे िमटा देना चािहए
(c) खोजकर आप उह  नही ंजानते ह  बताते हुए उसका उर देना चािहए
(d) उर देकर उनकी वैयितक जानकारी मांगनी चािहए
Answer – (b) िबना खोले इसे िमटा देना चािहए

15. ऑपरेिटंग िसटम ारा सीधे ह डल नही ंिकए जाने वाले अिधकांश काय िननिलिखत म  से कौन
सा ह डल कर सकता ह
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(a) विटकल – माक ट एिलकेशस
(b) यिूटिलटीज
(c) एगोिरस
(d) इंटेग े टेड सॉटवेयर
Answer – (d) इंटेग े टेड सॉटवेयर
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Computer GK Practice Set – 10
इस ैिटस पेपर म  कंयटूर फंडाम टल, डेटाबेस और इटरनेट से सबंिधत कुल 15 वतुिनठ न
उर िमल गे, जो आपको
SSC, ब िकंग, पटवारी, पुिलस, रेलवे और  DCA, PGDCA की परीा की तैयारी के िलए बहुत काम
आय गे|
In  this  practice  set  you  will  find  15  objective  question  related  to  Computer
Fundamentals and Database which will help you in preparation of SSC, Banking,
Patwari, Police, Railway and DCA, PGDCA.

1. एसेल के एक िसंगल सेल िकतने कैरेटर टाइप िकये जा सकते ह ।
a) 256
b) 1024
c) 3200
d) 65536
Answer –(d) 65536

2. Rom (Read Only Memory) िकस कृित की मेमोरी ह ।
a) थायी कृित की
b) अथायी कृित की
c) अंशत : थायी कृित
d) उपयुत सभी
Answer –(a) थायी कृित की

3. मुय आगम उपकरण ह ।
a) की–बोड
b) माउस
c) पंचकाड
d) ये सभी
Answer –(d) ये सभी

4. येक ALU एक समय म  िकतने िबट डाटा को िडकोड करती ह ।
a) 33 िबट
b) 32 िबट
c) 50 िबट
d) 100 िबट
Answer –(b) 32 िबट
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5. कैनर को कहा जाता ह ।
a) कयटूर की ऑख
b) कयटूर की नीवं
c) कयटूर की भाषा
d) कयटूर का ोग ाम
Answer –(a) कयटूर की ऑख

6. बार कोिडंग म  िकतने अर होते ह ।
a) 10
b) 20
c) 30
d) 40
Answer –(a) 10

7. िनन म  से कौन-कौन–सी कयटूर की ाथिमक मेमोरी ह ।
a) रैम
b) रोम
c) ोम
d) ये सभी
Answer –(d) ये सभी

8. कयटूर के बद होने, पर इसस  िलखी सचूनाऍ खम हो जाती ह , वह मेमोरी ह ।
a) रैम
b) रोम
c) ोम
d) इोम
Answer –(a) रैम

9. हाड िडक ह ।
a) रेम
b) सरोम
c) मैनेिटक िडक
d) कैनर
Answer –(c) मैनेिटक िडक

10. मैनेिटक िडक िनन म  से कौन–सी मेमोरी ह ।
a) रेडम एसेस मेमोरी
b) ैनर
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c) ग ोम
d) उपरोत म  से कोई नहीं
Answer –(d) उपरोत म  से कोई नहीं

11. 3.5 आकार वाली लॉपी (Floppy) की भडारण मता ह ।
a) 1.44 MB
b) 1.44 GB
c) 1.06 MB
d) 100 GB
Answer –(a) 1.44 MB

12. पसनल कयटूर के इनपुट उपकरण है
a) पीकर
b) माइोफोन
c) टच पैड
d) ये सभी
Answer –(d) ये सभी

13. पसनल कयटूर के आउटपुट उपकरण ह ।
a) पीकर
b) मॉनीटर
c) िंटर
d) ये सभी
Answer –(d) ये सभी

14. नेटविक ग सुिवधा के प ह ।
a) ई – मेल सुिवधा
b) WWW (वेब) सुिवधा
c) अपलोड एवं डाउनलोड सुिवधा
d) उपयुत सभी
Answer –(d) उपयुत सभी

15. बस नेटवक  के अतगत
a) नेटवक  की िविभन नोड्स एवं उपकरण एक सीधी रेखा म  जुड़े रहते ह
b) कायम समात होते है
c) िंटर नही ंहोते
d) उपयुत सभी
Answer –(a) नेटवक  की िविभन नोड्स एवं उपकरण एक सीधी रेखा म  जुड़े रहते ह

ANKAJ INFOTECH



Computer GK Practice Set – 11
इस ैिटस पेपर म  कंयटूर फंडाम टल, डेटाबेस और इटरनेट से सबंिधत कुल 15 वतुिनठ न
उर िमल गे, जो आपको
SSC, ब िकंग, पटवारी, पुिलस, रेलवे और  DCA, PGDCA की परीा की तैयारी के िलए बहुत काम
आय गे|
In  this  practice  set  you  will  find  15  objective  question  related  to  Computer
Fundamentals and Database which will help you in preparation of SSC, Banking,
Patwari, Police, Railway and DCA, PGDCA.

1. नेटवक  टॉपोलॉजी के प ह
a) बस नेटवक
b) िरंग नेटवक
c) टी नेटवक
d) ये सभी
Answer –(d) ये सभी

2. थानीय तर का नेटवक  कहलाता ह ।
a) LAN
b) WAN
c) MAN
d) HOST
Answer –(a) LAN

3. LAN टॉपोलॉजी के प ह ।
a) बस
b) टार
c) िरंग
d) ये सभी
Answer –(d) ये सभी

4. टेलीफोन लाइन के िलए उपयुत नेटवक  ह ।
a) LAN
b) MAN
c) WAN
d) HOST
Answer –(c) WAN
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5. वड वाइड वेब ह ।
a) www
b) sww
c) mww
d) LAN
Answer –(a) www

6. इटरनेट पर उपलध सुिवधा ह ।
a) इटरनेट फोन
b) यजू ग ुप
c) ई – मेल
d) ये सभी
Answer –(d) ये सभी

7. िनन म  से कौन–सा सच इंजन ह ।
a) www.yahoo.com
b) LAN
c) RAM
d) PROM
Answer –(a) www.yahoo.com

8. सॉटवेयर पैकेज ह ।
a) लैन
b) िसटम सॉटवेयर
c) वैन
d) रैम
Answer –(b) िसटम सॉटवेयर

9. एलीकेशन सॉटवेयर ह ।
a) ब ाउजर
b) ेडशीट
c) ग ािफस
d) उपयुत सभी
Answer –(d) उपयुत सभी

10. ऑपरेिटंग िसटम के कार ह ।
a) MS – DOS
b) LINUX
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c) UNIX
d) ये सभी
Answer –(d) ये सभी

11. िननिलिखत म  से कौन सा कथन सय ह ।
a) वचुअल मैमोरी हाड ड ाइव पर पेस है जहॉ ंऑपरेिटंग िसटम मैमोरी – बाउंड होने पर डाटा टोर
आंरभ करती ह
b) RAM म  डाटा एसेस करना वचुअल मैमोरी से डाटा एसेस करने मे धीमा होता ह
c)  वचुअल मैमोरी म  डाटा युत करते समय, ऑपरेिटंग िसटम  RAM फाइल नाम फाइल िबड
करती ह
d) यिद कोई कयटूर मैमोरी – बाउंड है तो अिधक जोड़ने RAM से समया हल नही ंहोगी।
Answer –(a) वचुअल मैमोरी हाड ड ाइव पर पेस है जहॉ ंऑपरेिटंग िसटम मैमोरी – बाउंड होने पर
डाटा टोर आंरभ करती ह

12. पद िबट …………….. एक लघु प ह ।
a) मेगाबाइट
b) बाइनरी ल वेज
c) बाइनरी िडिजट का
d) बाइनरी नबर
Answer –(c) बाइनरी िडिजट का

13. नीचे िदए गए सभी पद ेडशीट सॉटवेयर संब है, िसवाय-
a) वक शीट
b) सेल
c) फामूला
d) वायरस िडटेशन
Answer –(d) वायरस िडटेशन

14. ……………. ऐसी िडवाइस ह  िजनका योग टेलीकयिूनकेशन लाइन पर डाटा ट ासिमट करने
के िलए िकया जाता ह ।
a) ड ाइस
b) ड ाइव बेज
c) मॉडेम
d) लैटफाम
Answer –(c) मॉडेम

15. …………. लगभग एक िविलयन बाइट्स होते ह ।
a) िकलोबाइट
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b) िबट
c) िगगाबाइट
d) मेगाबाइट
Answer –(c) िगगाबाइट
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Computer GK Practice Set – 12
इस ैिटस पेपर म  कंयटूर फंडाम टल, डेटाबेस और इटरनेट से सबंिधत कुल 15 वतुिनठ न
उर िमल गे, जो आपको
SSC, ब िकंग, पटवारी, पुिलस, रेलवे और  DCA, PGDCA की परीा की तैयारी के िलए बहुत काम
आय गे|
In  this  practice  set  you  will  find  15  objective  question  related  to  Computer
Fundamentals and Database which will help you in preparation of SSC, Banking,
Patwari, Police, Railway and DCA, PGDCA.

1. िवंडो……….. है और िवड 95, िवंडो 98 ……….. है।
a) ग ािफकल यजूर इंटरफेस, ऑपरेिटंग िसटम
b) ग ािफस यजूफुल,एजेयिूटंग िसटम
c) ग ाफ यजूर इंटरवल, एसपट िसटम
d) ग ािफकल यजू इंटरफेस, एसेल िसटम
Answer – (a) ग ािफकल यजूर इंटरफेस, ऑपरेिटंग िसटम

2. MS – Word से नया पैराग ाफ शु करने के िलए कौन सी शाटकट की है।
a) डाउन कसर
b) एंटर
c) िशट + एंटर
d) कंट ोल + एंटर
Answer – (b) एंटर

3. पावर वाईट म  लाइड शो करने के िलए कौन सी Key का योग करते है।
a) 1
b) F2
c) F5
d) F10
Answer – (c) F5

4. िननिलिखत म  से कौन – सा टूलबार फाट व साइज बदलने की अनुमित देता ह ।
a) ट डड
b) फॉमिटंग
c) िंट ियू
d) उपरोत सभी
Answer – (b) फॉमिटंग
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5. माइोसॉट पावर वाइंट म  अिधकतम िकतना जमू हो सकता ह ।
a) 100%
b) 200%
c) 400%
d) 500%
Answer – (c) 400%

6. MS – EXCLE का extension या होता है।
a) .EXL
b) .XLS
c) .XLE
d) .EXCEL
Answer – (b) .XLS

7. Text को Bold करने के िलए िननिलिखत म  कौन सी योग की जाती ह ।
a) Ctrl +B
b) Ctrl + A
c) Shift + B
d) Alt +P
Answer – (a) Ctrl +B

8. ई – गवनस की ेठ याया िननिलिखत म  से कौन – सी ह ।
a) सरकार की कायणाली म  सुधार लाना
b) सरकारी कमचािरय को कयिूटंग की बुिनयादी िशा देना
c) इंटरनेट पर चैिटंग संबंधी साइबर काननू बनाना
d) इंटरनेट के मायम से सावजिनक सेवाऍ देना
Answer – (c) इंटरनेट पर चैिटंग संबंधी साइबर काननू बनाना

9. कौन सा ोग ाम कयटूर के िविभन भाग का िनयंण करता ह  और योता को कयटूर के साथ
इंटरऐट करने देता ह ।
a) यजूगुप
b) यजूनेट
c) बैकबोन
d) लोिमंग
Answer – (b) यजूनेट

10. MS – WORD म  िननिलिखत म  कौन सी का योग नही ंहोता ह ।
a) Table
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b) Hyperlink
c) Frame
d) Image
Answer – (d) Image

11. DOS म  फाइल बनाने के िलए िननिलिखत म  कौन सी कमाड का योग िकया जाता ह ।
a) Copy con
b) Create
c) Make
d) Do
Answer – (a) Copy con

12. Digital Control िननिलिखत म  से कौन Layer का Function ह ।
a) ट ांसपोट
b) सैशन
c) जेटेशन
d) एलीकेशन
Answer – (b) सैशन

13. िबजली बंद करने के बाद जो टोरेज डाटा को संभाल लेती है, उसे ………. कहते ह ।
a) वोलेटाइल टोरेज
b) नॉन – वोलेटाइल टोरेज
c) सीवेिशयल टोरेज
d) डाइरेट टोरेज
Answer – (b) नॉन – वोलेटाइल टोरेज

14. …………..मैनुअल बताता ह  िक िकसी सॉवेयर ोग ाम का योग कैसे िकया जाए।
a) डायुम टेशन
b) ोग ामिमंग
c) यजूर
d) टेिनकल
Answer – (c) यजूर

15. बडी माा म  बताता है िक िकसी सॉवेयर ोग ाम का योग कैसे िकया जाए।
a) लॉपी िडक
b) कॉपेट िडक रीड – ओनली मेमोरी
c) हाड िडक
d) एसट िडड िडक री – ओनली मेमोरी
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Answer – (c) हाड िडक
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Computer GK Practice Set – 13
इस ैिटस पेपर म  कंयटूर फंडाम टल, डेटाबेस और इटरनेट से सबंिधत कुल 15 वतुिनठ न
उर िमल गे, जो आपको
SSC, ब िकंग, पटवारी, पुिलस, रेलवे और  DCA, PGDCA की परीा की तैयारी के िलए बहुत काम
आय गे|
In  this  practice  set  you  will  find  15  objective  question  related  to  Computer
Fundamentals and Database which will help you in preparation of SSC, Banking,
Patwari, Police, Railway and DCA, PGDCA.

1. ई – मेल अटैचम ट या होती ह ।
a) ातकता ारा भेजी गई रसीद।
b) ई-मेल संदेश के साथ एक – दसूरे ोग ाम से भेजा गया एक अलग डायुम ट
c) दुभावनापणू पैरासाइट जो आपके संदेशो से फीड ऑफ होता ह  और कटेट को नट करता ह ।
d) या ातकताओं की सचूी
Answer – (b) ई-मेल संदेश के साथ एक – दसूरे ोग ाम से भेजा गया एक अलग डायुम ट

2. हाड िडक ड ाइव को
a) लैश
b) नॉनवोलेटाइल
c) टेपरेरी
d) नॉन परमानेट
Answer – (b) नॉनवोलेटाइल

3. …………….. हाडवेयर और सॉवेयर का कॉबीनेशन है िजससे कयिूटंग िडवाइस के बीच
सचूना की शेयिरंग सुिवधाजनक हो जाती ह ।
a) नेटवक
b) पेिरफेरल
c) एसप शन बाड
d) िडिजटल िडवाइस
Answer – (a) नेटवक

4. ई-मेल भेजते समय  ……….. लाइन संदेश के कटेट को दशाती है।
a) to
b) subject
c) contents
d) CC
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Answer – (b) subject

5. िनन म  से कनेिटिवटी का उदाहरण कौन सा ह ।
a) इंटरनेट
b) लॉपी िडक
c) पावर काड
d) डाटा
Answer – (a) इंटरनेट

6. िनन म  से कौन सा इनपुट िडवाइस नही ंहै।
a) की-बोड
b) माउस
c) िंटर
d) कैनर
Answer – (c) िंटर

7. इस कंुजी को दबा कर सचूना कयटूर म  डाली जाती ह ।
a) कैस लॉक
b) टैब
c) एंटर
d) केप
Answer – (c) एंटर

8. डायुम ट म  िपचर या टेट जोड़ने या डालने के िलए ……….. का योग िकया जाता है।
a) TV
b) इसट
c) पुश इन
d) रवीज इन
Answer – (b) इसट

9. िकसी फाइल म  िकसी एक मद का पता लगाने के िलए ……….. का योग िकया जाता है।
a) फाइल एलोकेशन टेबल
b) डायरेटरी
c) सीवेिशयल एसेस
d) डाइरेट एसेस
Answer – (a) फाइल एलोकेशन टेबल

10. नोटबुक से डेकटॉप मॉडल का काम लेने के िलए नोटबुक
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a) बे
b) डॉिकंग टेशन
c) पोट
d) नेटवक
Answer – (d) नेटवक

11. टैब कंुजी (की) का योग के िकसिलए होता ह ।
a) कसर को ीन पर चलाने के िलए
b) पैरग ाप इंड ट करने के िलए
c) कसर को ीन पर नीचे ले जाने के िलए
d) केवल (A) और (B)
Answer – (d) केवल (a) और (b)

12. कटमर लॉयटी को
a) कैरेटर
b) फीड
c) डाटाबेस
d) िरकॉड
Answer – (c) डाटाबेस

13. िबजली बंद कर िदए जाने के बाद जो टोरेजअपना डाटा रखती ह  उसे
a) वोलैटालइ टोरेज
b) नॉन – वोलैटाइल
c) सीवैिशयल टोरेज
d) डाइरेट टोरेज
Answer – (b) नॉन – वोलैटाइल

14. िननिलिखत म  से कनेिटिवटी का उदाहरण कौन सा ह ।
a) इंटरनेट
b) लॉपी िडक
c) पॉवर काड
d) डाटा
Answer – (a) इंटरनेट

15. जब भी कोई कमांड या सचूना एंटर की जाती ह  तो कौन सी कंुजी दबाई जाती ह ।
a) केप
b) िरटन/एंटर
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c) िडलीट
d) होम
Answer – (b) िरटन/एंटर
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Computer GK Practice Set – 15
इस ैिटस पेपर म  कंयटूर फंडाम टल, डेटाबेस और इटरनेट से सबंिधत कुल 15 वतुिनठ न
उर िमल गे, जो आपको
SSC, ब िकंग, पटवारी, पुिलस, रेलवे और  DCA, PGDCA की परीा की तैयारी के िलए बहुत काम
आय गे|
In  this  practice  set  you  will  find  15  objective  question  related  to  Computer
Fundamentals and Database which will help you in preparation of SSC, Banking,
Patwari, Police, Railway and DCA, PGDCA.

1. िननिलिखत म  से िकस समहू म  केवल आउटपुट िडवाइस ह ।
a) कैनर, िंटर, मॉिनटर
b) कीबोड, िंटर, मॉिनटर
c) माउस, िंटर, मॉिनटर
d) लॉट्टर, िंटर, मॉिनटर
Answer –(d) लॉट्टर,  िंटर, मॉिनटर

2. …………. म  ऐसे कमांड होते ह  िजह  िसलेट िकया जा सकता ह ।
a) पॉइंटर
b) मेनू
c) आइकन
d) बटन
Answer –(d) मेनू

3. IT का परूा प या ह ।
a) Information Technology
b) Integrated Technology
c) Intelligent Technology
d) Interesting Technology
Answer –(a) Information Technology

4. ई-मेल भेजना िननिलिखत के समान ह ।
a) िकसी घटना का िच बनाना
b) कहानी सुनाना
c) प िलखना
d) िच का सृजन
Answer –(c) प िलखना
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5. ………… यिूनट के प म  सॉट ड और डेटा िरलेटेड इनफामशन का कलेशन ह ।
a) िडक
b) डाटा
c) फाइल
d) लॉपी
Answer –(d) डाटा

6. एरर को …….. भी कहते ह ।
a) बग
b) िडबग
c) कसर
d) आइकन
Answer –(a) बग

7. की – बोड िकस कार का साधन ह ।
a) लैक
b) इनपुट
c) आउटपुट
d) वड ोसेिसंग
Answer –(d) इनपुट

8. अिरथमेिटक ऑपरेशस-
a) म  एक डाटा दसूरे से एक िनधािरत करने के िलए मैच िकया जाता है िक पहली मद दसूरी मद से बड़ी
समान या छोटी ह
b) म  डाटा मद को ट डड, ििडफाइड ाइटेिरयो के अनेसार आरोही म म  सॉट करता ह
c) म  ऑपरेटस के साथ AND, OR जैसी NOT जैसी कंिडशस यजू करते ह
d) म  जोड़ना, घटाना, गुणा करना और िवभािजत करना शािमल ह ।
Answer –(d) म  जोड़ना, घटाना, गुणा करना और िवभािजत करना शािमल ह ।

9. कयटूर का कौन – सा भाग इनफॉमशन टोर करने म  मदद करता ह ।
a) िडक ड ाइव
b) की-बोड
c) मॉनीटर
d) िंटर
Answer –(a) िडक ड ाइव

10. इंटरनेट पर सवर से सचूना पाने के िलए कयटूर के ोसेस को ………. कहते ह ।
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a) पुिलंग
b) पुिशंग
c) डाउलोिडंग
d) ट ांसफिरंग
Answer –(c) डाउलोिडंग

11.ीन का आयाताकार े जो ोग ाम, डाटा और या इफॉमशन दिशत करता ह , वह
िननिलिखत ह  ।
a) टाइटल बार
b) बटन
c) डायलाग बॉस
d) िवंडो
Answer –(d) िवंडो

12. ………. कमांड के अमल की िया ह ।
a) फेिचंग
b) टोिरंग
c) एक्सजेयिूटंग
d) िडकोिडंग
Answer –(c) एक्सजेयिूटंग

13. िननिलिखत म  से कौन सा सबसे तेज, सबसे बड़ा और सबसे अिधक महंगा कयटूर ह ।
a) पसनल कयटूर
b) सुपर कयटूर
c) लैपटॉप
d) नोटबुक
Answer –(d) सुपर कयटूर

14. िनन म  से कौन सा िसटम यिूनट का भाग ह ।
a) CPU
b) मॉनीटर
c) CD – ROM
d) लॉपी िडक
Answer –(a) CPU

15. अनुदेश की ंृखला जो कयटूर को या करना और कैसे करना बताती है उसे …………. कहते
ह ।
a) ोग ाम
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b) कंमाड
c) यजूर िरपॉस
d) ोसेसर
Answer –(a) ोग ाम
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Computer GK Practice Set – 14
इस ैिटस पेपर म  कंयटूर फंडाम टल, डेटाबेस और इटरनेट से सबंिधत कुल 15 वतुिनठ न
उर िमल गे, जो आपको
SSC, ब िकंग, पटवारी, पुिलस, रेलवे और  DCA, PGDCA की परीा की तैयारी के िलए बहुत काम
आय गे|
In  this  practice  set  you  will  find  15  objective  question  related  to  Computer
Fundamentals and Database which will help you in preparation of SSC, Banking,
Patwari, Police, Railway and DCA, PGDCA.

1. PC पर टाइिपंग करते समय दो शद के बीच जगह छोड़ने के िलए ………….. नामक की दबानी
पडती है।
a) बैक पेश
b) िशट
c) कंट ोल
d) पेश बार
Answer – (d) पेश बार

2. CD – RW पर
a) सचूना को रीड़ राइट और रीराइट िकया जा सकता ह
b) केवल सचूना को रीड िकया जा सकता ह
c) केवल सचूना को राइट िकया जा सकता ह
d) सचूना को रीड एवं राइट िकया जा सकता ह
Answer – (a) सचूना को रीड़ राइट और रीराइट िकया जा सकता ह

3. वचुअल मेमोरी या होती ह ।
a) हाड िडक की मेमोरी िजसे CPU एसट डड RAM की तरह योग करता ह ।
b) RAM म  होती ह
c) तभी आवयक होती ह  यिद आपके कयटूर म  कोई RAM न हो
d) लॉपी िडक के िलए बैकअप िडवाइस
Answer – (a) हाड िडक की मेमोरी िजसे CPU एसट डड RAM की तरह योग करता ह ।

4. कयटूर डाटा टोर करने और गणनाऍ करने के िलए ……………. नंबर िसटम का योग करते
है।
a) दशमलव
b) हेसाडेिसमल
c) ओटल बाइनरी
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d) बाइनरी
Answer – (d) बाइनरी

5. ………… कंुजी (की) टाट करने को शु करती ह ।
a) इकेप
b) िशट
c) िवंडोज
d) शॉटकट
Answer – (c) िवंडोज

6. टेट की पंित के आरभ म  जाने के िलए ………… की  का योग करते है।
a) होम
b) इंड
c) पेजअप
d) एंटर
Answer – (a) होम

7. ई-मेल भेजते समय …………. की लाईन संदेश की िवषय वतु के बारे मे बता  देती है।
a) टू
b) सजेट
c) कटेट्स
d) CC
Answer – (b) सजेट

8. वड म  टेट की फामिटंग करते समय िकस गु िपंग म  काम िकया जाता ह
a) टेबस, पाराग ास इडेसेज
b) पाराग ास, इडेसेज और पाराग ास
c) कैरेटस, सेशज और पाराग ास
d) उपरोत म  से कोई नहीं
Answer – (d) उपरोत म  से कोई नहीं

9. िननिलिखत म  से टोरेज का सबसे बड़ा यिूनट कौन – सा ह ।
a) GB
b) KB
c) MB
d) TB
Answer – (d) TB
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10. कयटूर को …………. बताता ह  िक इसके कपोन ट्स का योग कैसे िकया जाए।
a) नेटवक
b) ऑपरेिटंग िसटम
c) एिलकेशन ोग ाम
d) यिूटिलटी
Answer – (c) एिलकेशन ोग ाम

11. िनन म  से कौन सा एक वेब ब ाउजर ह ।
a) प ट
b) पावर वांइट
c) फायर फॉस
d) वड
Answer – (c) फायर फॉस

12. आमतौर पर युत अिधकांश कयटूर/लैपटॉप म  ………… नामक कमांड की नही होता है।
a) टनओवर
b) िशट
c) आट
d) इनसट
Answer – (a) टनओवर

13. कयटूर संबंधी गितिविधय म  युत USB का परूा प या ह ।
a) Universal Security Block
b) Ultra Serial Block
c) United Service Block
d) Universal Serial Bus
Answer – (d) Universal Serial Bus

14. वड म  िकसी डायमू ट म  िकसी खास शद या वायांश को सबसे जदी और सरल तरीके से ढंूढ़ना
हो तो …………… कमांड का योग करना चािहये।
a) िरलेस
b) फाइंड
c) लुकअप
d) सच
Answer – (b) फाइंड

15. िनन म  कौन कयटूर ोग ािमंग भाषा नही ंहै।
a) C
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b) C + +
c) जावा
d) माइोसोट
Answer – (d) माइोसोट
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Computer GK Practice Set – 16
इस ैिटस पेपर म  कंयटूर फंडाम टल, डेटाबेस और इटरनेट से सबंिधत कुल 15 वतुिनठ न
उर िमल गे, जो आपको
SSC, ब िकंग, पटवारी, पुिलस, रेलवे और  DCA, PGDCA की परीा की तैयारी के िलए बहुत काम
आय गे|
In  this  practice  set  you  will  find  15  objective  question  related  to  Computer
Fundamentals and Database which will help you in preparation of SSC, Banking,
Patwari, Police, Railway and DCA, PGDCA.

1. कयटूर का कौन सा भाग िकया गया काम दिशत करता ह ।
a) RAM
b) िंटर
c) मॉनीटर
d) ROM
Answer –(c) मॉनीटर

2. कयटूर के मैमोरी म  एटर िकया कोई डाटा या अनुदेश को ……….. माना जाता ह ।
a) टोरेज
b) आउटपुट
c) इनपुट
d) इनफॉमशन
Answer –(c) इनपुट

3. माइोसॉट वड ………. का एक उदाहरण ह ।
a) ऑपरेिटंग िसटम
b) ोसेिसंग िडवाइस
c) एिलकेशन सोटवेयर
d) इनपुट िडवाइस
Answer –(c) एिलकेशन साॅटवेयर

4. ोसेिसंग…………….।
a) म  कयटूर िसटम म  डाटा का इनपुिटंग होता ह
b) म  इनपुट का आउपुट म  ट ांसफािमग होता ह
c) म  उपयोगी तरीके से आउटपुट का दशन होता ह
d) म  संगत उर उपलध कराए जाते ह
Answer –(d) म  इनपुट का आउपुट म  ट ांसफािमग होता ह
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5. िनन म  से िकसका योग थम पीढ़ी के कयटूर म  नही ंिकया गया था।
a) वैयमू टूस
b) काड्स
c) मैनेिटक कोर
d) ये सभी
Answer –(d) ये सभी

6.िट के िलए कौन सा मेन ूिसलेट िकया जाता ह ।
a) एिडट
b) पेशल
c) फाइल
d) टूस
Answer –(c) फाइल

7. योता दतावेज को जो नाम देता ह  उसे कहते है।
a) फाइल नेम
b) ोग ाम
c) िरकाड
d) डाटा
Answer –(a) फाइल नेम

8.िकसी सॉटवेयर म  कोई पंित तभ या बटन, या िचह को लॉक िलक करने पर, ये बटन या
िचह ोग ाम के िवशेष यह  Windows डेकटॉप पर दिशत छिव है। आप कोई ऐसा ितमान पर
िच चुन सकते ह , िजसे एक िबटमैप फाइल के प संग िहत िकया जा सके और उसे ीन
की………..के प म  दिशत कर सकते ह ।
a) ीन िरजॉयशून
b) िपसेल
c) पृठभिूम
d) A तथा B दोन
Answer –(c) पृठभिूम

9. दो कार के आउटपुट िडवाइस कौन से ह ।
a) मॉनीटर और िटर
b) टोरेज िडसस (लापी, CD)
c) की – बोड और माउस
d) िवड 2000, िवंडोज NT
Answer –(a) मॉनीटर और िटर
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10. ऑजेट की ोपटी ज म  एसेस करने के िलए यजू की जाने वाली माउस तकनीक ……………
ह ।
a) ड ैिगंग
b) ड ॉिपंग
c) राइट-िलिकंग
d) िशट-िलिकंग
Answer –(c) राइट-िलिकंग

11. एक ोग ाम है िजससे कयटूर का उपयोग करना आसान हो जाता ह ।
a) ऑपरेिटंग िसटम
b) ऐिलकेशन
c) यिूटिलटी
d) नेटवक
Answer –(a) ऑपरेिटंग िसटम

12. फोन लाइन और मॉडेम का उपयोग करते हुए इंटरनेट के कनेशस को ………….. कनेशन
कहते ह ।
a) िडिजटल
b) डायल-अप
c) ब ॉडब ड
d) िडश
Answer –(d) डायल-अप

13. मेनेम या सुपर कयुटर म  एसेस के िलए यजूस असर ………. का उपयोग करते ह ।
a) टिमनल
b) नोड
c) डेकटॉप
d) ह डहेड
Answer –(a) टिमनल

14. ोग ाम म  ुिट िजससे गलत या अनुपयुत पिरणाम उपन होते ह , उसे ……………..कहते ह ।
a) बग
b) बाइट
c) एिट यटू
d) यिूनट ोलम
Answer –(a) बग
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15.एक मेन ूजो उपयोगकता ारा मेन ूिलक िकए जाने पर उससे नीचे आता है उपयोगकता ारा िफर
से माउस िलक िकए जाने या िकसी मेन ूआइटम का चयन करने तक िबना िकसी अगली िया के
खुला रहता ह ।
a) ड ॉप-डाउन मेनू
b) डेकटॉप
c) चेक बॉस
d) कट बॉस
Answer –(a) ड ॉप-डाउन मेनू
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Computer GK Practice Set – 17
इस ैिटस पेपर म  कंयटूर फंडाम टल, डेटाबेस और इटरनेट से सबंिधत कुल 15 वतुिनठ न
उर िमल गे, जो आपको
SSC, ब िकंग, पटवारी, पुिलस, रेलवे और  DCA, PGDCA की परीा की तैयारी के िलए बहुत काम
आय गे|
In  this  practice  set  you  will  find  15  objective  question  related  to  Computer
Fundamentals and Database which will help you in preparation of SSC, Banking,
Patwari, Police, Railway and DCA, PGDCA.

1. यिद आप िकसी ई-मेल संदेश म  इस बसे म  िकसी ातकता के नाम को जोडते है तो संदेश की एक
………….. उस ातकता को भेजी जाती ह  और ातकता का नाम संदेश के अय ातकताओं को
िदखाई देता ह ।
a) ितिलिप
b) मलू
c) डाउनलोड
d) a तथा b दोन
Answer –(a) ितिलिप

2. डॉयुम ट को सुरित करने के िलए िननिलिखत म  कौन सी कमाड दी जाती ह ।
a) Ctrl + P
b) Ctrl + Q
c) Ctrl + R
d) Ctrl + S
Answer –(d) Ctrl + S

3. वड ोसेड डायमू ट चेक करते समय,यजूर, ीन और ीटेड फाम दोन मे पेज पर िदखते वड्स
च ज करता है उसे – कहते ह ।
a) एिडिटंग टेट
b) इनसिटग टेबस और इंडेसेस
c) फामिटंग टेट
d) िूफंग डायमू ट्स
Answer –(d) िूफंग डायमू ट्स

4. ………CPU के िलए सामाय गिणत परफाम करता ह ।
a) ALU
b) DIMM
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c) BUS
d) Register
Answer –(a) ALU

5. िरयजेूबल ऑिटकल टोरेज का िटिपकली एोिनम…………होगा।
a) CD
b) RW
c) DVD
d) ROM
Answer –(d) RW

6. कयटूर ारा ………… इनफामशन म  ोसेस िकए जाते ह ।
a) नंबर
b) ोसेसर
c) इनपुट
d) डाटा
Answer –(d) डाटा

7. पसनल कयटूर ………….. बनाने के िलए साथ कनेट िकए जा सकते ह ।
a) सवर,
b) सुपर कयटूर
c) इटराइज
d) नेटवक
Answer –(d) नेटवक

8. वेब पेज का एक वड, िजसे िलक करने पर दसूरा डायमू ट खुलता ह  उसे कहते ह ।
a) एंकर
b) हाइपरिलंक
c) रेफरेस
d) URL
Answer –(d) हाइपरिलंक

9. सॉटवेयर के ………… म  कमांडो और ऑशन की सिूचयॉ होती है।
a) टाइटल बार
b) मेन ूबार
c) फायूला बार
d) टूल बार
Answer –(d) मेन ूबार
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10.िकसी डायमू ट को एिडट करने के िलए,उसे बनाने के बाद पढ़ना और िफर……….।
a) गलितय को ठीक करना होता है
b) इसे िटं करना होता ह
c) इसे सेव करना होता है
d) इसे िडलीट करना होता ह
Answer –(a) गलितय को ठीक करना होता है

11. इसम  कौन िस ऑपरेिटंग िसटम नही ंहै।
a) िवंडोज िवटा
b) मैक OS
c) िलनस
d) वचुअल बॉस
Answer –(d) मैक OS

12. इंटरनेट से या िकया जा सकता ह ।
a) इलेट ािनक मेल भेजा जा सकता ह
b) वेब पेज देखे जा सकते है
c) िवव भर म  सवर से कनेट िकया जा सकता है
d) उपरोत सभी
Answer –(d) उपरोत सभी

13. िबिलंग अकाउंट का टै क रखने के िलए िकस कार के सॉटवेयर के योग िकए जाने की सबसे
यादा संभावना ह ।
a) वड ोसिसंग
b) इलेट ािनक पिलिशंग
c) ैडशीट
d) वेब ऑथिरंग
Answer –(c) ैडशीट

14. कट या कॉपी के बाद टेट और ग ािफस…………..नामक एिरया म  टोर िकए जाते ह ।
a) पेटबोड
b) कापी बोड
c) िलप बोड
d) किटंग बोड
Answer –(c) िलप बोड

15. की-बोड के ऊपर F1 से F12 तक उपलध कीज (Keys) को ………..Keys के नाम से जाना जाता
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है।
a) Numeric
b) Friendly
c) Function
d) Free
Answer –(c) Function
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Computer GK Practice Set – 18
इस ैिटस पेपर म  कंयटूर फंडाम टल, डेटाबेस और इटरनेट से सबंिधत कुल 15 वतुिनठ न
उर िमल गे, जो आपको  SSC,  ब िकंग, पटवारी, पुिलस, रेलवे और  DCA,  PGDCA की परीा की
तैयारी के िलए बहुत काम आय गे|
In  this  practice  set  you  will  find  15  objective  question  related  to  Computer
Fundamentals and Database which will help you in preparation of SSC, Banking,
Patwari, Police, Railway and DCA, PGDCA.

1. यिद आप एक शद टाइप करते ह  जो वड िडशनरी म  नही ं है तो उस शद के नीचे एक ………
अंडरलाइन िदखती ह ।
a) लाल
b) हरी
c) नीली
d) काली
Answer –(a) लाल

2. िवक एसेस-टूलबार के ऊपर जो……….बटन होता ह , आपके िरसेट कमांड या एशन आपक
कैसल करने देता ह ।
a) सच
b) कट
c) डायमू ट
d) अनडु
Answer –(d) अनडु

3. एसेल म  सेट ऑफ कैरेटस िजससे एक अर, एक हाइफन या पेस होता है उसे……….माना
जाता ह ।
a) फामूला
b) टेट
c) नाम
d) टाइटल
Answer –(b) टेट

4. ………..सॉटवेयर योताओं को डाटा की पंितय और कालम पर पिरकलन करने देता ह ।
a) वड ोसेिसंग
b) ेजेटेशन ग ािफस
c) डाटाबेस मेनेजमेट िसटम
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d) इलेट ॉिनक ेडशीट
Answer –(d) इलेट ॉिनक ेडशीट

5. एक …………. लगभग एक िबिलयन मेमोरी लोकेशस िरेजेट करता ह ।
a) िकलोबाइट
b) मेगाबाइट
c) िगगाबाइट
d) टेराबाइट
Answer –(c) िगगाबाइट

6. …………… सेस, दो या अिधक चुने हुए सेस को कंबाइन कर एक िसंगल सेल िएट करता ह ।
a) फामिटंग
b) मिजंग
c) एबेिडंग
d) िलिटंग
Answer –(b) मिजंग

7. ऑपरेिटंग िसटम सवािधक चिलत ……….. सॉटवेयर ह ।
a) कयिूनकेशन
b) एिलकेशन
c) िसटम
d) वड-ोसेिसंग
Answer –(c) िसटम

8. जब आप माउस के बाय  बटन को जदी जदी दो बार दबाते और छोड़ते है तब आप……….करते
ह ।
a) ाइमरी-िलिकंग
b) पॉइिटंग
c) डबल – िलिकंग
d) सेकंडरी – िलिकंग
Answer –(c) डबल – िलिकंग

9. वक शीट पर हॉिरजाॉटल और वटी कल लाइन होती ह  उह …….कहते ह ।
a) सेस
b) शीट्स
c) लाक लाइस
d) िग डलाइस
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Answer –(d) िग डलाइस

10. िकसी डायमू ट मे से एक गलत कैरेटर िडलीट करने हेतु इनसशन वाइंट के दॉये इरेज करने के
िलए……….।
a) लेट माउस ेस कीिजए
b) राइट माउस की डबल िलक कीिजए
c) बैक पेस की ेस कीिजए
d) िडलीट की ेम कीिजए
Answer –(d) िडलीट की ेस कीिजए

11. लाइड ले आउट चुनने के िलए ……….का उपयोग कीिजए।
a) िवक टाइस गैलरी
b) फामट गैलरी
c) लेआउट गैलरी
d) लेआउट लेशन
Answer –(c) लेआउट गैलरी

12. सेड डायमू ट को………….कहा जाता ह ।
a) फाइल
b) वड
c) फोडर
d) ोजेट
Answer –(a) फाइल

13. …………एक साथ कनेटेड कयटूस और िडवाइसेस का एक कलेशन ह ।
a) ोटोकॉल
b) मेमोरी काड
c) नेटवक
d) सेटल ोसिसंग यिूनट
Answer –(c) नेटवक

14. सबटोटस कमांड के साथ युत मोट कॉमन सबटोटल…….फंशन है, िजसे येक बार कंट ोल
फीड के बदलने पर एसेल का एक योग िडले करता ह ।
a) ADD
b) SUM
c) TOTAL
d) LIST
Answer –(b) SUM
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15. ……….. टेट या कंटेट पर एलाइट एक िवशेष दृयय इफेट होता है।
a) एिनमेशन
b) लैश
c) वाइप
d) िडजोव
Answer –(a) एिनमेशन
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Computer GK Practice Set – 19
इस ैिटस पेपर म  कंयटूर फंडाम टल, डेटाबेस और इटरनेट से सबंिधत कुल 15 वतुिनठ न
उर िमल गे, जो आपको
SSC, ब िकंग, पटवारी, पुिलस, रेलवे और  DCA, PGDCA की परीा की तैयारी के िलए बहुत काम
आय गे|
In  this  practice  set  you  will  find  15  objective  question  related  to  Computer
Fundamentals and Database which will help you in preparation of SSC, Banking,
Patwari, Police, Railway and DCA, PGDCA.

1. ………… िजसे वेब भी कहते ह , म  िबिलयन डायमू ट होते ह ।
a) वडवाइड वेब
b) HTTP
c) वेब पोटल
d) डोमेन
Answer –(a) वडवाइड वेब

2. मेन ूम  ……….. का िलट होता ह ।
a) कमांड्स
b) डाटा
c) ऑजेट्स
d) िरपोट्स
Answer –(a) कमांड्स

3. टेकट और फोडर नेम जैसी अंडरलाइड टेट को ………… कहत  है।
a) आइकन
b) हाइपरिलंक
c) मेनू
d) इनम  से कोई नहीं
Answer –(b) हाइपरिलंक

4. ………. कयटूर चाल ूकरते समय ऑपरेिटंग िसटम की लोिडंग को कहते ह ।
a) बिूटंग
b) लैिशंग
c) टै िकंग
d) टेिपंग
Answer –(a) बिूटंग
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5. …………. एक टेट है िजसे आप पेज के बाटम म  िंट करते है।
a) हेडर
b) एंडनोट
c) फुटनोट
d) फूटर
Answer –(c) फुटनोट

6. अय लोग को वक शीट को ोटेटेड से अनोटेटेड म  पिरवतन करने से रोकने के िलए
आपक……….िएट करना चािहए।
a) एसेस कोड
b) पासवड
c) की
d) िसेट माक
Answer –(b) पासवड

7. वड म  …………… फीचर पेिलंग , टाइिपंग, कैिपटलाइजेशन या ग ामर की गलितय को
आटोमैिटकली सुधार देता है।
a) ऑटोिफस
b) ऑटोपेल
c) ऑटोमाक
d) ऑटोकरेट
Answer –(d) ऑटोकरेट

8. ………. सेस के कालम, पंित या रेट युलर गुप म  दो या अिधक एजेट सेस की एक ृखला
होती है।
a) एिरया
b) र ज
c) सेशन
d) िलट
Answer –(b) र ज

9. ………….. को आप ऑजेट्स म  एसेस कर ोग ाम टाट कर सकते ह ।
a) िडफाट मेनू
b) XP मेनू
c) टाट मेनू
d) टॉप मेनू
Answer –(a) िडफाट मेनू
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10. ……….. बार-बार युत कमांड को ईजी एसेस उपलध कराता ह ।
a) कमांड टूलबार
b) िवक एसेस टूलबार
c) टेडड टूलबार
d) शॉटकट टूलबार
Answer –(b) िवक एसेस टूलबार

11. आप जो टाक कर रहे ह  उसके आधार पर …………….. अलग अलग शेप धारण करता है।
a) एिटव टैब
b) इनसशन पाइंट
c) माउस पॉइटर
d) िरबन
Answer –(c) माउस वांइंटर

12. एसेल, सेल म  टेसट को बााायिडफाट …………….. रखता ह ।
a) लेट – एलाइड
b) राइट – एलाइट
c) सेटड – एलाइट
d) जिटफाइड
Answer –(a) लेट – एलाइड

13. शाटकट कीज के उपयोग से पैरेग ाफ को सेटर करने के िलए …………… ेस कीिजए।
a) Ctrl + C
b) Ctrl + E
c) Ctrl + L
d) Ctrl + R
Answer –(b) Ctrl + E

14. कोई डायमू ट िंट करने के िलए ………….. ेस कीिजए िफर ENTER ेस कीिजए।
a) Shift + P
b) Ctrl + P
c) Alt + P
d) Esc + P
Answer –(b) Ctrl + P

15. ……………… टाइड कैरेटस एक एिपयरेस है।
a) साइज
b) फामट
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c) पाइंट
d) कलर
Answer –(b) फामट
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Computer Practice GK Set – 20
इस ैिटस पेपर म  कंयटूर फंडाम टल, डेटाबेस और इटरनेट से सबंिधत कुल 15 वतुिनठ न
उर िमल गे, जो आपको  SSC,  ब िकंग, पटवारी, पुिलस, रेलवे और  DCA,  PGDCA की परीा की
तैयारी के िलए बहुत काम आय गे|
In  this  practice  set  you  will  find  15  objective  question  related  to  Computer
Fundamentals and Database which will help you in preparation of SSC, Banking,
Patwari, Police, Railway and DCA, PGDCA.

1. िजस िडक म  फाइस टोर िकए होते ह  उस पर …………. एक नेड लोकेशन होता है।
a) फोडर
b) फाइल फोडर
c) फाइल
d) पोट

2. सारणी म  एक परूी पंित चुनने के िलए……….. ।
a) पंित के बाय  िलक िकिजए
b) सेल के एड ेस को िलक कीिजए
c) TAB की दबाए
d) टेबल मलू ह डस कीिजए

3. ……………… िजसे कयटूर का ब ेन भी कहते ह , डाटा ोसेिसंग करता है।
a) मदरबोड
b) मेमोरी
c) RAM
d) सेटल ोसेिसंग यिूनट (CPU)

4. ……………… ऐसे तीक होता  ह  जो िकसी भी कैरेटर या कैरेटस के कांिबनेशन को िरजेट
करता है।
a) लेइंग काड्स
b) वाइड – काड्स
c) ाइवेट कीज
d) पिलक कीज

5. आठ 0 और की 1 की िटंग को …………… को कहते ह ।
a) मेगाबाइट
b) िकलोबाइट
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c) िगगाबाइट
d) बाइट

6. मेन ूपर येक ……………… एक िविशट काय करता ह ।
a) लांइट
b) सवर
c) नोड
d) कमांड

7. ……………… डायुमेट को वड ीन पर छोटे आकार म  िडले करता ह ।
a) लेआउट
b) िंट ियू
c) रेय ूयू
d) नामल यू

8. …………….. का अथ है एक सही तय को एक से अिधक जगह टोर करना।
a) ोपटी ज
b) सॉिटग
c) िरडडेसी
d) होिडंग

9. ेजेटेशन को …………….. भी कहते ह ।
a) ियू
b) गैलरी
c) लाइड सोटर
d) लाइड शो

10. लाइड शो य ूम  जब आप एक लाइड को राइट – िलक करते ह  तब िदखने वाला …………
मेन ूएक शाटकट मेन ूह ।
a) पॉप – अवे
b) पॉप – डाउन
c) पॉप – अप
d) िडफाट

11. एक से अिधक ोसेसर उपलध होने के कारण इनपुट आउटपुट एवं ोसेिसंग तीनो ंकायो के मय
समवय रहता है यह िवशेषता है।
a) मटी ोसेिसंग की
b) मटी टािकंग की
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c) उपयुत दोन
d) इनम  से कोई नहीं

12. माट  काड सामायत : िकस कार का काड होता है।
a) पेशल परपज काड है
b) माइोोसेसर काड है
c) ोसेसिसंग यिूनट म  डाटा टोिरंग के िलए मेमोरी होती है
d) सॉटवेयर ह डिलंग के िलए ोसेिसंग यिूनट है

13. कयटूर एवं सॉटवेयर े म  िननिलिखत म  से कौन – सा संगठन सवािधक लोकिय है
a) रॉटमैन
b) हेली
c) माइोसॉट
d) डीएलए पाइपर
Answer –(c) माइोसॉट

14. प / दतावेज को तैयार / टाइप करने के िलए कयटूर पैकेज िननिलिखत म  से कौन–सा ह 
a) वड
b) एसेल
c) पावर वांइट
d) िवंडोज

15. कयटूर म  पॉवर सलाई िसटम म  युत एसएमपीएस का अथ या होता ह 
a) िवज मोड पावर सलाई
b) सिवस मोड पावर सलाई
c) योर मॉडयलू पॉवर सलाई
d) िसयोर मॉडयलू पॉवर सलाई

Answer Sheet
1. िजस िडक म  फाइस टोर िकए होते ह  उस पर …………. एक नेड लोकेशन होता है।
Answer –(a) फोडर

2. सारणी म  एक परूी पंित चुनने के िलए……….. ।
Answer –(b) सेल के एड ेस को िलक कीिजए

3. ……………… िजसे कयटूर का ब ेन भी कहते ह , डाटा ोसेिसंग करता है।
Answer –(d) सेटल ोसेिसंग यिूनट (CPU)
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4. ……………… ऐसे तीक होता  ह  जो िकसी भी कैरेटर या कैरेटस के कांिबनेशन को िरजेट
करता है।
Answer –(b) वाइड–काड्स

5. आठ 0 और की 1 की िटंग को …………… को कहते ह ।
Answer –(d) बाइट

6. मेन ूपर येक ……………… एक िविशट काय करता ह ।
Answer –(d) कमांड

7. ……………… डायुमेट को वड ीन पर छोटे आकार म  िडले करता ह ।
Answer –(b) िंट ियू

8. …………….. का अथ है एक सही तय को एक से अिधक जगह टोर करना।
Answer –(c) िरडडेसी

9. ेजेटेशन को …………….. भी कहते ह ।
Answer –(d) लाइड शो

10. लाइड शो य ूम  जब आप एक लाइड को राइट – िलक करते ह  तब िदखने वाला …………
मेन ूएक शाटकट मेन ूह ।
Answer –(c) पॉप – अप

11. एक से अिधक ोसेसर उपलध होने के कारण इनपुट आउटपुट एवं ोसेिसंग तीनो ंकायो के मय
समवय रहता है यह िवशेषता है।
Answer –(a) मटी ोसेिसंग की

12. माट  काड सामायत : िकस कार का काड होता है।
Answer –(b) माइोोसेसर काड है

13. कयटूर एवं सॉटवेयर े म  िननिलिखत म  से कौन – सा संगठन सवािधक लोकिय है
Answer –(c) माइोसॉट

14. प / दतावेज को तैयार / टाइप करने के िलए कयटूर पैकेज िननिलिखत म  से कौन–सा ह 
Answer –(a) वड

15. कयटूर म  पॉवर सलाई िसटम म  युत एसएमपीएस का अथ या होता ह 
Answer –(a) िवज मोड पावर सलाई
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Computer Practice Questions Set –
22
1. िवंडोज 95 , िवंडोज 98 , और िवंडोज NT ……………. के नाम से जाने जाते ह ।
a) ोसेसस
b) डोमेन नेम
c) मोडेस
d) ऑपरेिटंग िसटम

2. कयटूर पर जानकारी …………….. के प म  टोर की जाती ह ।
a) एनालॉग डाटा
b) िडिजटल डाटा
c) की बोड
d) वाट्स डाटा

3. बजट बनाने के िलए कैलकूलेटर की तरह काम करने वाले ोग ाम को ……… कहते ह ।
a) कैलयलेूटर
b) कोरलािटक
c) कीबोड
d) ेडशीट

4. िकसी ोत से जानकारी लेकर और उसे अपने कयटूर मे लाने को ………. कहते ह ।
a) अपलोड
b) डाउनलोड
c) टासफर
d) िड – िलंक

5. ेडशीट म  येक बॉस को ………… कहते ह ।
a) सेल
b) खाली थान
c) िरकॉड
d) फीड

6. अपनी िरपोट  का पहला पैराग ाफ इंडेट करने के िलए आपको इसकी ……………का उपयोग करना
चािहए।
a) पेस बार
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b) िरटन की
c) टैब की
d) िशट की

7. ………… ऐसी िविशट मद  ह  िजनका िकसी िदए गए सुदभ म  कुछ खास अथ नही ंहोता ह ।
a) फीड्स
b) डाटा
c) वेरीज
d) ोपटी ज

8. वक  शीट कमाड (Work Shet Command) का योग होता है।
a) सारी वक शीट को यविथत करने हेतु
b) रेज को दिशत करने हेतु
c) वक शीट को बदलने (Change) हेतु
d) इनम  से कोई नहीं

9. ………………. टेलीयिूनकेशन िडवाइस का एक उदाहरण है।
a) कीबोड
b) माउस
c) िंटर
d) मोडेम

10. सॉटवेयर पैकेज की सबसे अछी पिरभाषा कौन – सी है
a) आपके कयटूर के िलए अितिरत मेमोरी जैसा कोई एड ऑन
b) वड ोसेिसंग जैसे िकसी खास काय के िलए युत कयटूर ोग ाम का एक सेट
c) कयटूर मे िलए आप खरीद सकते ह  ऐसा संरण
d) वािणियक सॉटवेयर के साथ ऐसा बॉस, मैनुआल और लाइसेस करार

11. ………….. आप वड डॉयमेूट के साथ एसेल वक शीट डाटा िलंक नही कर सकते ह ।
a) राइट ड ैग मेथड से
b) हाइपर िलंक से
c) कॉफी और पेट पेशल कमांडो से
d) कॉफी और ट डड कमांडो पर पेट बटनो से

12. ………….. बटन का उपयोग कर आप माइोसॉट वड टाट  कर सकते ह ।
a) यू
b) टाट
c) ोग ाम
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d) कंट ोल पैनल

13. …………… िंट/फाइल लाइन का योग होता ह ।
a) िंटर को एक लाइन पीछे हटाने के िलए
b) िंटर को एक लाइन आगे बढ़ाने के िलए
c) िंटर को दो लाइन आगे बढ़ाने के िलए
d) िंटर को दो लाइन पीछे हटाने के िलए

14. अपने िलखे िकसी िरपोट  म  से एक पैराग ाफ िनकालने के िलए आप िननिलिखत म  से या कर
सकते ह ।
a) िडलीट और एिडट
b) हाइलाइट और िडलीट
c) कट एड पेट
d) अनडु

15. डेकटॉप पर तारीख और समय ………….. पर होते ह ।
a) टाकबार
b) माइक कयटूर
c) िरसाइकल िबन
d) केवल (b) और (c)

Answer Sheet
1. िवंडोज 95 , िवंडोज 98 , और िवंडोज NT ……………. के नाम से जाने जाते ह ।
Answer –(d) ऑपरेिटंग िसटम

2. कयटूर पर जानकारी …………….. के प म  टोर की जाती ह ।
Answer –(b) िडिजटल डाटा

3. बजट बनाने के िलए कैलकूलेटर की तरह काम करने वाले ोग ाम को ……… कहते ह ।
Answer –(d) ेडशीट

4. िकसी ोत से जानकारी लेकर और उसे अपने कयटूर मे लाने को ………. कहते ह ।
Answer –(b) डाउनलोड

5. ेडशीट म  येक बॉस को ………… कहते ह ।
Answer –(a) सेल

6. अपनी िरपोट  का पहला पैराग ाफ इंडेट करने के िलए आपको इसकी ……………का उपयोग करना
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चािहए।
Answer –(c) टैब की

7. ………… ऐसी िविशट मद  ह  िजनका िकसी िदए गए सुदभ म  कुछ खास अथ नही ंहोता ह ।
Answer –(c) वेरीज

8. वक  शीट कमाड (Work Shet Command) का योग होता है।
Answer –(a) सारी वक शीट को यविथत करने हेतु

9. ………………. टेलीयिूनकेशन िडवाइस का एक उदाहरण है।
Answer –(d) मोडेम

10. सॉटवेयर पैकेज की सबसे अछी पिरभाषा कौन – सी है
Answer –(b) वड ोसेिसंग जैसे िकसी खास काय के िलए युत कयटूर ोग ाम का एक सेट

11. ………….. आप वड डॉयमेूट के साथ एसेल वक शीट डाटा िलंक नही कर सकते ह ।
Answer –(a) राइट ड ैग मेथड से

12. ………….. बटन का उपयोग कर आप माइोसॉट वड टाट  कर सकते ह ।
Answer –(b) टाट

13. …………… िंट/फाइल लाइन का योग होता ह ।
Answer –(b) िंटर को एक लाइन आगे बढ़ाने के िलए

14. अपने िलखे िकसी िरपोट  म  से एक पैराग ाफ िनकालने के िलए आप िननिलिखत म  से या कर
सकते ह ।
Answer –(c) कट एड पेट

15. डेकटॉप पर तारीख और समय ………….. पर होते ह ।
Answer –(a) टाकबार
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Computer Practice Questions Set –
23
1. िकसी डायरेटरी के भीतरी जो डायरेटरी होती है, उसे ………….. कहते ह ।
a) िमनी डायरेटरी
b) जिूनयर डायरेटरी
c) पोट डायरेटरी
d) सब डायरेटरी

2. टेट को ……….. बनाने के िलए आप , िकस पर िलक करते ह ।
a) इटािलस
b) अंडरलाइन
c) इटािलस और अंडरलाइन
d) बोड

3. मेमोरी की संगह मता यत की जाती ह ।
a) सेकड्स म
b) मेगाबाइट म
c) हाट्ज म
d) िकलोमीटर म

4. एसेल म  िकस िवकप के योग से चाट  िएट िकए जाते ह ।
a) चाट िवजाड
b) िपवट टेबल
c) पाइ चाट
d) बार चाट

5. माइोकयटूर हॉडवेयर मे िफिजकल इिवपमट की तीन बेिसक कैटेगरी होती ह ।
a) की बोड, मॉनीटर, हाडवेयर
b) िसटम यिूनट, इनपुट/आउटपुट, मेमोरी
c) िसटम यिूनट, इनपुट/आउटपुट, स केडरी मेमोरी
d) िसटम यिूनट, ाइमरी टोरेज, स केडरी मेमोरी

6. िननिलिखत म  से कौन – सी सॉटवेयर ऐिलकेशन की एक आम िवशेषता नही ंह ।
a) मेनजू
b) िवंडोज
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c) हेप
d) सच

7. जब उपयोगकता िसटम के साथ कैरेटर के ारा सचूना देता है, तो इस ऑपरेिटंग िसटम को
कहते ह ।
a) कैरेटर यजूर इंटरफेस
b) ग ािफकल यजूर इंटरफेस
c) डाटा संचार
d) सुगम संचार

8. दतावेज िएट करने के िलए फाइल मेन ूपर आप ……….. कमांड का योग करते ह ।
a) ओपन
b) लोज
c) यू
d) सेव

9. इफामशन और कंमाड कैचर करने के िलए िकस इिवपमट का योग िकया जाता ह ।
a) आउटपुट िडवाइस
b) इनपुट िडवाइस
c) टोरेज िडवाइस
d) टेलीयिूनकेशस

10. डाटाबेस की सॉिटग (Sorting) से तापय ह ।
a) िरकॉड्स (Records) से
b) िरकॉड्स का िकसी भी म म  संग ह
c) ‘A’ तथा ‘B’ दोन
d) इनम  से कोई नहीं

11. िकसी नेटवक  से कयटूर को संलन करने पर कौन सा एडेस िदया जाता ह ।
a) िसटम एड ेस
b) SYSID
c) ोसेस आई डी
d) आईपी एड ेस

12. डासरेट X है एक –
a) कयटूर पाटस
b) सॉटवेयर
c) यजूर इंटरफेस
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d) केबल (Cable)

13. कयटूर ारा ारिभक ियाऍ कायािवत की जाती ह ।
a) गिणतीय िया ारा
b) लॉजीकल िया ारा
c) टोरेज तथा सबंिधत िया ारा
d) उपयुत a, b व c ारा

14. सवथम पंच काड्स केआिवकारक थे
a) पास
b) पाकल (Blaise Pascal)
c) जैयआूड (Jacquard)
d) हमन होलेिरथ (Herman Hollerith)

15. PC की वड – लेथ िकतनी होती ह 
a) 4 िबट्स
b) 8 िबट्स
c) 16 िबट्स
d) 64 िबट्स

Answer Sheet
1. िकसी डायरेटरी के भीतरी जो डायरेटरी होती है, उसे ………….. कहते ह ।
Answer –(d) सब डायरेटरी

2. टेट को ……….. बनाने के िलए आप , िकस पर िलक करते ह ।
Answer –(d) बोड

3. मेमोरी की संगह मता यत की जाती ह ।
Answer –(b) मेगाबाइट म

4. एसेल म  िकस िवकप के योग से चाट  िएट िकए जाते ह ।
Answer –(a) चाट िवजाड

5. माइोकयटूर हॉडवेयर मे िफिजकल इिवपमट की तीन बेिसक कैटेगरी होती ह ।
Answer –(b) िसटम यिूनट , इनपुट/आउटपुट , मेमोरी

6. िननिलिखत म  से कौन – सी सॉटवेयर ऐिलकेशन की एक आम िवशेषता नही ंह ।
Answer –(b) िवंडोज
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7. जब उपयोगकता िसटम के साथ कैरेटर के ारा सचूना देता है, तो इस ऑपरेिटंग िसटम को
कहते ह ।
Answer –(a) कैरेटर यजूर इंटरफेस

8. दतावेज िएट करने के िलए फाइल मेन ूपर आप ……….. कमांड का योग करते ह ।
Answer –(c) यू

9. इफामशन और कंमाड कैचर करने के िलए िकस इिवपमट का योग िकया जाता ह ।
Answer –(b) इनपुट िडवाइस

10. डाटाबेस की सॉिटग (Sorting) से तापय ह ।
Answer –(a) िरकॉड्स (Records) से

11. िकसी नेटवक  से कयटूर को संलन करने पर कौन सा एडेस िदया जाता ह ।
Answer –(a) िसटम एड ेस

12. डासरेट X है एक –
Answer –(b) सॉटवेयर

13. कयटूर ारा ारिभक ियाऍ कायािवत की जाती ह ।
Answer –(d) उपयुत a, b व c ारा

14. सवथम पंच काड्स केआिवकारक थे
Answer –(d) हमन होलेिरथ (Herman Hollerith)

15. PC की वड – लेथ िकतनी होती ह 
Answer –(c) 16 िबट्स
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Computer Practice Questions Set –
24
1. आउटलुक एसेस एक ……………. ह ।
a) ई – मेल लाइंट
b) शेडूलर
c) एड ेस बुक
d) उपरोत सभी

2. MS वड म  नया पृठ आरभ करने के िलए कौन – सी ‘की’ दबाई जानी चािहए।
a) डाउन कसर की
b) Enter की
c) Shift + Enter
d) Ctrl + Enter

3. िकस कार का सॉटवेयर लेखाकर के वक शीट जैसा होता ह ।
a) वड ोसिसंग
b) डाटाबेस
c) ेडशीट
d) ग ािफस

4. िववभर म  बहुत से कयटूरो ंको जोड़ने वाला नेटवक  िननिलिखत ह ।
a) इंट ानेट
b) इंटरनेट
c) ARP नेट
d) नेटवक

5. िवंडोज म  बायिडफाट जब िडलीट हो जाती ह , उह  ………… म  भेजा जाता ह ।
a) डट िबन
b) िरसाईिकल िबन
c) ARP नेट
d) िरसाईिकल वेट िबन

6. इंटरनेट ऑपरेिटंग िसटम िननिलिखत म  से कौन – सी ह 
a) MS िवंडोज
b) मैक
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c) MS – DOS
d) िवंडोज NT

7. टिमनल जो िकसी इफामशन को ोसेज नही ंकर सकता है, उसे ………. कहते ह ।
a) डायरेट एसेस टिमनल
b) इंटेिलज ट टिमनल
c) माट टिमनल
d) डब टिमनल

8. की – बोड पर 0–9 लेवल वाली कीज को ……………. कहते ह ।
a) फंशन कीज
b) यमेूिरक कीज
c) टाइपराइटर कीज
d) पेशन कीज

9. अिधकतम लोकिय इंटरनेट गितिविध िननिलिखत ह ।
a) डाउनलोिडंग यिूजक
b) चलिच का टै लर देखना
c) िकताब की खरीददारी
d) ई – मेिलंग

10. ेडशीट म  सेल की पिरभाषा िननानुसार की जाती है…………. ।
a) टेबल और टपलेट का इंटरसेशन
b) फाइल और डाटाबेस का इंटरसेशन
c) रो और कॉलम का इंटरसेशन
d) फीड और िरकॉड का इंटरसेशन

11. GUI का परूा प या ह 
a) Cinutella Universal Interface
b) Graphical User Interface
c) Graphic Uninstall / Install
d) Generally Utility Interface

12. ……………….. एक िडजाइन टूल है सोयशून अगािरथम म  ग ािफकली लॉिजक दशाता है।
a) लोचाट
b) हायराकरी चाट
c) टचर चाट
d) कंटेट डायग ाम
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13. फाइल िजसम  आपके डॉयुम ट और आपके ारा कटमाइड टूलबार और मेनु जैसी सभी चीजो
के िलए पैराग ाफ और कैरेटर टाइस की पिरभाषाऍं होती ह  उसे कहते ह ।
a) गाइड
b) पैटन
c) बेस डायमेूट
d) टेलेट

14. जनरल – परपस एिलकेशन और पेशल – परपस ऐिलकेशस को एडेस करने के िलए िवशेषत :
िडजाइन िकए गए ोग ामो ंको ……..कहते ह ।
a) ऑपरेिटंग िसटम
b) िसटम सॉटवेयर
c) एिलकेशन सॉटवेयर
d) मैनेजमेट इनफामशन िसटम

15. िवंडोज ऑपरेिटंग िसटम म  डाटा को टोर करने की सबसे छोटी इकाई या है
a) फाइल
b) फोडर
c) सब – फोडर
d) लॉक

Answer Sheet
1. आउटलुक एसेस एक ……………. ह ।
Answer – (a) ई– मेल लाइंट

2. MS वड म  नया पृठ आरभ करने के िलए कौन – सी ‘की’ दबाई जानी चािहए।
Answer – (d) Ctrl + Enter

3. िकस कार का सॉटवेयर लेखाकर के वक शीट जैसा होता ह ।
Answer – (c) ेडशीट

4. िववभर म  बहुत से कयटूरो ंको जोड़ने वाला नेटवक  िननिलिखत ह ।
Answer – (b) इंटरनेट

5. िवंडोज म  बायिडफाट जब िडलीट हो जाती ह , उह  ………… म  भेजा जाता ह ।
Answer – (b) िरसाईिकल िबन

6. इंटरनेट ऑपरेिटंग िसटम िननिलिखत म  से कौन – सी ह 
Answer – (d) िवंडोज NT
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7. टिमनल जो िकसी इफामशन को ोसेज नही ंकर सकता है, उसे ………. कहते ह ।
Answer – (d) डब टिमनल

8. की – बोड पर 0–9 लेवल वाली कीज को ……………. कहते ह ।
Answer – (b) यमेूिरक कीज

9. अिधकतम लोकिय इंटरनेट गितिविध िननिलिखत ह ।
Answer – (d) ई – मेिलंग

10. ेडशीट म  सेल की पिरभाषा िननानुसार की जाती है…………. ।
Answer – (c) रो और कॉलम का इंटरसेशन

11. GUI का परूा प या ह 
Answer – (b) Graphical User Interface

12. ……………….. एक िडजाइन टूल है सोयशून अगािरथम म  ग ािफकली लॉिजक दशाता है।
Answer – (a) लोचाट

13. फाइल िजसम  आपके डॉयुम ट और आपके ारा कटमाइड टूलबार और मेनु जैसी सभी चीजो
के िलए पैराग ाफ और कैरेटर टाइस की पिरभाषाऍं होती ह  उसे कहते ह ।
Answer – (d) टेलेट

14. जनरल – परपस एिलकेशन और पेशल – परपस ऐिलकेशस को एडेस करने के िलए िवशेषत :
िडजाइन िकए गए ोग ामो ंको ……..कहते ह ।
Answer – (a) ऑपरेिटंग िसटम

15. िवंडोज ऑपरेिटंग िसटम म  डाटा को टोर करने की सबसे छोटी इकाई या है
Answer – (a) फाइल
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Computer Practice Questions Set –
26
1. ऐिटव सेल के कंटेट ……………. म  िडले होते ह ।
a) टूलबार
b) मेनबूार
c) नेम बॉस
d) फामूला

2. दतावेज म  अगले पृठ पर जाने के िलए कंुजी को दबाया जाता ह ।
a) Page Up
b) Page Down
c) Up Arrow
d) इनम  से कोई नहीं

3. सेिवंग िननिलिखत म  से िया है …………. ।
a) मेमोरी से टोरेज मीिडयम म  डॉयमेूट कॉपी करने की
b) िकसी डॉयुम ट की वतमान िवषय वतु म  पिरवितत करने की
c) िकसी डॉयुम ट का िदखाया जा समग  प म  पिरवतन करने की
d) की बोड के योग के टेट एटर कर डॉयमू ट डेवलप करने की

4. िननिलिखत म  से कौन – सी इनपुट िडवाइस ह ।
a) काड रीडर, िंटर, मैगनेिटक िडक
b) काड रीडर, मैगनेिटक टेप, मैगनेिटक िडक टिमनल
c) काड रीडर, मैगनेिटक िडक, मैगनेिटक टेप, टिमनल, िंटर
d) उपरोत म  से कोई नहीं

5. ……………. नामक मुिद त इनफामशन, वातुिवक प म  िवमान होता है और िडले िडवाइस
पर तुत आउटपुट से अिधक परमानट प का आउटपुट होता ह ।
a) सॉट कॉपी
b) काबन कॉपी
c) हॉड कॉपी
d) डेक कॉपी

6. एसेल अपने डॉयमेूट फाइलो ंके प म  टोर करता है िजह  …………. कहते ह ।
a) वक शीट्स
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b) वक बुस
c) नोटबुस
d) एसेल शीट्स

7. सामायत : हाडवेयर कंपोनेट्स के अिधक शितशाली या नये पिरकृत वजन म  चच करने को
……………….. कहते ह ।
a) एसपैशन
b) लग एड ले
c) अपग ेिडंग
d) अपसाइिजंग

8. दो या अिधक सेस को एक िसंगल सेल म  कंबाइन करने को …………… कहते ह ।
a) मिजग
b) जोइिनंग
c) शेयिरंग
d) िलिटंग

9. पावर वाइंट म  िननिलिखत मे से कौन – सा य ूहोता है।
a) डायमू ट यू
b) लाइड सोटर यू
c) लाइडच चर यू
d) ले साइड यू

10. एसेल वक बुक म  एक वक शीट से दसूरे म  मवू करने के िलए …………… िलक कीिजए।
a) एिटव सेल
b) ॉल बार
c) शीट टैब
d) टैब बटन

11. िननिलिखत म  से कौन– सा िडवाइस पी. सी. और टेलीफोन लाइन के मय लगाई जाती ह 
a) एसएमपीएस
b) मॉडेम
c) मॉनीटर
d) िंटर

12. कयटूर सॉटवेयर म  सिमिलत होते ह ।
a) एिलकेशन ोग ाम
b) ऑपरेिटंग िसटम ोग ाम
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c) पैकेज ोग ाम
d) उपयुत A, B, व C

13. कयटूर िवान का जनक कहा जाता ह ।
a) पाकल
b) चास बैबेज
c) वॉन यमैून
d) कोबोल

14. MHz इकाई का योग िननिलिखत म  से िकसकी गित मापने हेतु िकया जाता ह 
a) ोसेसर
b) िडक ड ाइव
c) िंटर
d) माउस

15. िकस िडवाइस का योग ग ािफकल यजूर वातावरण म  टैडड वांइिटंग िडवाइस के प म  िकया
जाता ह 
a) की – बोड
b) माउस
c) वॉय िटक
d) टे कबॉल

Answer Sheet
1. ऐिटव सेल के कंटेट ……………. म  िडले होते ह ।
Answer – (d) फामूला

2. दतावेज म  अगले पृठ पर जाने के िलए कंुजी को दबाया जाता ह ।
Answer – (d) इनम  से कोई नहीं

3. सेिवंग िननिलिखत म  से िया है …………. ।
Answer – (a) मेमोरी से टोरेज मीिडयम म  डॉयमेूट कॉपी करने की

4. िननिलिखत म  से कौन – सी इनपुट िडवाइस ह ।
Answer – (d) उपरोत म  से कोई नहीं

5. ……………. नामक मुिद त इनफामशन, वातुिवक प म  िवमान होता है और िडले िडवाइस
पर तुत आउटपुट से अिधक परमानट प का आउटपुट होता ह ।
Answer – (c) हॉड कॉपी
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6. एसेल अपने डॉयमेूट फाइलो ंके प म  टोर करता है िजह  …………. कहते ह ।
Answer – (a) वक शीट्स

7. सामायत : हाडवेयर कंपोनेट्स के अिधक शितशाली या नये पिरकृत वजन म  चच करने को
……………….. कहते ह ।
Answer – (c) अपग ेिडंग

8. दो या अिधक सेस को एक िसंगल सेल म  कंबाइन करने को …………… कहते ह ।
Answer – (a) मिजग

9. पावर वाइंट म  िननिलिखत मे से कौन – सा य ूहोता है।
Answer – (b) लाइड सोटर यू

10. एसेल वक बुक म  एक वक शीट से दसूरे म  मवू करने के िलए …………… िलक कीिजए।
Answer – (c) शीट टैब

11. िननिलिखत म  से कौन– सा िडवाइस पी. सी. और टेलीफोन लाइन के मय लगाई जाती ह 
Answer – (b) मॉडेम

12. कयटूर सॉटवेयर म  सिमिलत होते ह ।
Answer – (d) उपयुत A, B, व C

13. कयटूर िवान का जनक कहा जाता ह ।
Answer – (b) चास बैबेज

14. MHz इकाई का योग िननिलिखत म  से िकसकी गित मापने हेतु िकया जाता ह 
Answer – (a) ोसेसर

15. िकस िडवाइस का योग ग ािफकल यजूर वातावरण म  टैडड वांइिटंग िडवाइस के प म  िकया
जाता ह 
Answer – (c) वॉय िटक
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Computer Practice Questions Set –
25
1. िकसी िरकॉड की िविशट फीड जो येक िरकॉड को यनूीकली आइडेिटफाइड करता है, उसे
………….. कहते ह ।
a) की फीड
b) ाइमरी फीड
c) माटर फीड
d) ऑडर फीड

2. …………. इनपुट िडवाइस का एक उदाहरण ह ।
a) की बोड
b) मॉनीटर
c) िंटर
d) सेटल ोसिसंग यिूनट

3. CPU म  …………….. होता ह ।
a) एक काड रीडर और एक ििटंग िडवाइस
b) एक एनािलिटकल जन और एक कंट ोल
c) एक कंट ोल यिूनट और एक एिरथमैिटक लॉिजक यिूनट
d) एक एिरथमैिटक लॉिजक यिूनट और एक काड रीडर

4. ……………. न हो तो कयटूर ‘बटू’ नही ंकर सकता ह ।
a) कंपाइलर
b) लोडर
c) ऑपरेिटंग िसटम
d) एस लर

5. जब आप िकसी पेज से कोई टेट िकसी अय पेज पर ले जाना चाहते ह  तो उसकी ेठ पित ह ।
a) ड ेग एड ड ॉप
b) कट एड पेट
c) िडलीट एड िरटाइप
d) फाइड एड िरलेस

6. एक समय म  एक से अिधक एिलकेशन रन करने के िलए OS की मता को …………… कहते ह ।
a) मटीटािकंग
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b) आजेट ओिरएटेड ोग ािमंग
c) मटी – यजूर कयिूटंग
d) टाईम – शेयिरंग

7. ………… नॉन यमैूिरक डाटा का एक उदाहरण ह ।
a) एलॉई एड ेस
b) एजािमनेशन कोर
c) ब क शेष
d) उपरोत सभी

8. कयटूर िसटम म  एसेल पाने के िलए युत कोडब एट ीज को ………….. कहते ह  ।
a) एंट ी कोड
b) पासवड
c) सेयुिरटी
d) कोडवड्स

9. रीड ऑनली मैमोरी (ROM) को कौन सी िवशेषता उसे उपयोगी बनाती ह ।
a) ROM सचूना आसानी से उतन की जा सकती है
b) ROM म  डाटा नॉनवोलाटाइल होता है अथात ्िबना इलेिटकल पावर के भी यह रहता है
c) ROM बहुत अिधक माा म  कम खची ला डाटा टोरेज उपलध कराता है
d) ROM िचस अलग अलग ब ड के कयटूर मे आसानी से वैप िकए जा सकते है

10. हाई – लेवल ल वेज म  िलखे गए अनुदेशो ंकी ंृखला या ोग ाम को कयटूर पर रन िकए जा
सकने वाले अनुदेशो ंम  कनवट  करने के िलए युत िया का नाम या है
a) एस बिलंग
b) कपइिलंग
c) ट ांसनेिटंग
d) अपलोिडंग

11. …………….. रॉ फैट्स िरेजेट करती है जबकी ……….. अथपणू बना हुआ डाटा है।
a) इनफामशन, िरपोिटग
b) डाटा, इनफामशन
c) इनुफामशन, िबट्स
d) िरकाड्स बाइट्स

12. िननिलिखत म  से कौन सा पेिरफरल िडवाइस योता को इफॉमशन िडले करता ह ।
a) मॉनीटर
b) कीबोड
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c) सेक डरी टोरेज िडवाइसेज
d) सेक डरी टोरेज मीिडया

13. जब आप कोई रॉ या कॉलम मवू करते ह , मूड सेस टेट ………..।
a) सेल के साथ मवू होता है
b) जहॉ ंथा वही ंरहता है िकतु सारे फामिटंग मवू होता ह
c) सेस के साथ मवू होता है िकंतु सारे फामिटंग का लॉस हो जाता है
d) सेस के साथ मवू होता है और कुछ फॉमिटंग च च हो जाता ह

14. कयटूर नेटवक  म  िकस कार के िरसोस को शेयड होने की अयािधक संभावना ह 
a) िंटस
b) पीकस
c) लॉपी िडक ड ाइस
d) की बोड्स

15. ीन की िकसी मद को िकसी नए थान पर ले जाने के िलए माउस के योग के वणन हेतु युत
पद कौन– सा ह 
a) िलक
b) डबल – िलक
c) ड ेग एड ड ॉप
d) वांइट

Answer Sheet
1. िकसी िरकॉड की िविशट फीड जो येक िरकॉड को यनूीकली आइडेिटफाइड करता है, उसे
………….. कहते ह ।
Answer – (a) की फीड

2. …………. इनपुट िडवाइस का एक उदाहरण ह ।
Answer – (a) की बोड

3. CPU म  …………….. होता ह ।
Answer – (c) एक कंट ोल यिूनट और एक एिरथमैिटक लॉिजक यिूनट

4. ……………. न हो तो कयटूर ‘बटू’ नही ंकर सकता ह ।
Answer – (c) ऑपरेिटंग िसटम

5. जब आप िकसी पेज से कोई टेट िकसी अय पेज पर ले जाना चाहते ह  तो उसकी ेठ पित ह ।
Answer – (b) कट एड पेट
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6. एक समय म  एक से अिधक एिलकेशन रन करने के िलए OS की मता को …………… कहते ह ।
Answer – (a) मटीटािकंग

7. ………… नॉन यमैूिरक डाटा का एक उदाहरण ह ।
Answer – (a) एलॉई एड ेस

8. कयटूर िसटम म  एसेल पाने के िलए युत कोडब एट ीज को ………….. कहते ह  ।
Answer – (b) पासवड

9. रीड ऑनली मैमोरी (ROM) को कौन सी िवशेषता उसे उपयोगी बनाती ह ।
Answer – (d) ROM िचस अलग अलग ब ड के कयटूर मे आसानी से वैप िकए जा सकते है

10. हाई – लेवल ल वेज म  िलखे गए अनुदेशो ंकी ंृखला या ोग ाम को कयटूर पर रन िकए जा
सकने वाले अनुदेशो ंम  कनवट  करने के िलए युत िया का नाम या है
Answer – (b) कपइिलंग

11. …………….. रॉ फैट्स िरेजेट करती है जबकी ……….. अथपणू बना हुआ डाटा है।
Answer – (b) डाटा, इनफामशन

12. िननिलिखत म  से कौन सा पेिरफरल िडवाइस योता को इफॉमशन िडले करता ह ।
Answer – (a) मॉनीटर

13. जब आप कोई रॉ या कॉलम मवू करते ह , मूड सेस टेट ………..।
Answer – (a) सेल के साथ मवू होता है

14. कयटूर नेटवक  म  िकस कार के िरसोस को शेयड होने की अयािधक संभावना ह 
Answer – (a) िंटस

15. ीन की िकसी मद को िकसी नए थान पर ले जाने के िलए माउस के योग के वणन हेतु युत
पद कौन– सा ह 
Answer – (c) ड ेग एड ड ॉप
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Computer Practice Questions Set –
27
1. Ctrl + V कंुजी सेलेट करने पर या होता ह 
a) आपके डायमू ट म  जहॉ ंकसर है वहॉ ंबड़ा V टाइप हो जाता है
b) िसलेट की गई आइटम िलपबोड से पेट हो जाती है
c) िसलेट की गई आइटम िलबोड म  पेट हो जाती है
d) िसलेट िकए गए ड ाइंग आजेट पेज पर िवतिरत हो जाते ह

2. िकसी सेल म  मौजदूा तारीख एंटर करने के िलए िकसे चयन िकया जाता ह 
a) Ctrl +; (सेमी कोलन)
b) Ctrl + : (कोलन)
c) Ctrl + F10
d) Ctrl + F11

3. िनन म  से कौन–सा िरलेशनल डाटाबेस को विणत करता ह 
a) यह इंटेजस के बीच िरलेशनिशप उपलध कराता है
b) इसम  िरलेटेड डाटा के पृथक टेबल होते है
c) यह इसकी वेरीज से संबिधत डाटा को िरट ीव करता है
d) यह लोट्स के बीच िरलेशनिशप उपलध कराता है

4. िजस ह गआउट म  नोट्स के िलए लाइन  बनी होती ह , उसे लाइडो ंकैसे िंट की जाती ह ।
a) िंट डायलॉग बॉस म  ह ◌ंगआउट िसलेट कर  और ित पृठ 3 लाइड  सेट कर
b) िंट डायलॉग बॉस मे ह ◌ंगआउट और ित पेज लाइड की संया िसलेट कर  िफर इलडू
कम ट पेिजस ऑशन िसलेट कर
c) िंट डायलॉग बॉस म  ह ◌ंगआउट के बजाए नोट्स पेिजस िसलेट कर
d) ऐसा नही ंिकया जा सकता

5. मान लीिजए आपके पास डाटा के कॉलम ह  जो एक िंटेड पेज से यादा ह  येक पेज पर कॉलम
हेिडंग पेज से यादा ह  येक पेज पर कॉलम हेिडंग आप ऑटोमैिटकली कैसे िंट करेगे
a) फाइल मीन ूपर पेज सेटअप िलक कर , शीट टैब िलक कर  और उस रो को एंटर कर  िजसम  िंट
टाइस म  ये कॉलम हेिडंग ह
b) फाइल मेन ूपर पेज सेटअप िलक कर  पेज टैब िलक कर , ऑशन बटन िलक कर  िफर अपने
चवॉइस एंटर कर
c) िंट डायलॉग बॉस मे ह ड आउट्स के बजाए नोट्स पेिजस िसलेट कर
d) ऐसा नही ंिकया जा सकता
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6. असिसट ट या है
a) एक एिलकेशन िजससे आप नोट्स ने सकते है और उसे एक फाइल मे सेव कर सकते ह
b) सहायता और सुझाव देने वाला एक एिनमेिटड करैटर
c) टैडड टूलबार पर एक बटन जो िंट कमांड को एजीयटू करता है
d) उपरोत सभी

7. िनन म  से कौन – सा कॉमन डाटा एिलमटो ंको छोटे से बड़े के म मे लगाता ह ।
a) कैरेटर, फाइल, िरकाड, फीड, डाटाबेस
b) कैरेटर, िरकॉड, फीड, फाइल, डाटाबेस
c) कैरेटर, फीट, िरकॉड फाइल, डाटाबेस
d) िबट, बाइट, कैरेटर, िरकॉड, फीड फाइल, डाटाबेस

8. िवषम की पहचान कीिजए।
a) इंटरेटर
b) ऑपरेिटंग िसटम
c) कपाइलर
d) एसैबलर

9. एक ही वक शीट मे िसलेट िकए गए सेल से दो अय सेलो ंम  फॉम िटंग को जदी से कॉपी करने का
तरीका कौन सा है
a) तीन सेल को िसलेट करने के िलए  Ctrl  क योग कर  िफर ट डड टूल बार पर पेट बटन को
िलक कर ।
b) िसलेट िकए गए सेल को कॉपी कर ,िफर अय दो सेल को िसलेट कर , फामट मीन ूपर टाइल
िलक कर  िफर मोडीफाई िलक कर
c)  फॉमिटंग टूलबार पर फामट प टर बटन इमेज को दो बार िलक कर  जहॉ ं फॉमिटंग कॉपी करना
चाहते ह
d) तीन सेल को िसलेट करने के िलए Alt का योग कर  िफर ट डड टूल बार पर पेट बटन इमेज
बटन पर िलक कर

10. ई मेल िकए गए वड डायमूट को हमेशा रीिडंग लेआट मे खोले जाने से कैसे रोका जाता है
a) टूल मीन ू> ऑशन > अलौ टािटग इन रीिडंग लेआउट को अनचेक कर
b) य ूमीन ूसे > रीिडंग लेआउट > जनरल टैक > अलौ टािटग इन रीिडंग लेआउट
c) फारमेट मीन ूसे > ऑटो फारमैट > एिडट टैब > यजू िवद ई मेड अटैचम ट्स को अनचेक कर
d) उपरोत सभी

11. चाट  बनाने के िलए आप या करते ह ।
a) पाई िवजाड
b) एसेल िवजाड
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c) डाटा िवजाड
d) चाट िवजाड

12. िनन म  से कौन – सा छोटा, िसंगल – साइट नेटवक  ह 
a) LAN
a) DSL
a) RAM
a) USB

13. वड म  ब ेक कैसे िकया जा सकता ह 
a) उिचत थान पर कसर को रखकर कंुजी को ेस कर के
b) उिचत थान पर कसर को रखकर कंट ोल + एंटर को ेस करके
c) इसट/सेशन ब ेक का योग करके
d) डायुम ट का फॉट बदल कर

14. एिटव सेल के कटेट्स या िदखाते ह 
a) नेमबॉस
b) रो – हेिडंग
c) फामूलाबार
d) टाकपैन

15. सेव की गई फाइल को ढूढ़ंने और लोड करने के िलए।
a) लोज कमांड को िसलेट कर
b) य ूकमांड को िसलेट कर
c) सेव कमांड को िसलेट कर
d) ओपन कमांड को िसलेट कर

Answer Sheet
1. Ctrl + V कंुजी सेलेट करने पर या होता ह 
Answer – b) िसलेट की गई आइटम िलपबोड से पेट हो जाती है

2. िकसी सेल म  मौजदूा तारीख एंटर करने के िलए िकसे चयन िकया जाता ह 
Answer – a) Ctrl +; (सेमी कोलन)

3. िनन म  से कौन–सा िरलेशनल डाटाबेस को विणत करता ह 
Answer – b) इसम  िरलेटेड डाटा के पृथक टेबल होते है

4. िजस ह गआउट म  नोट्स के िलए लाइन  बनी होती ह , उसे लाइडो ंकैसे िंट की जाती ह ।

ANKAJ INFOTECH



Answer – a) िंट डायलॉग बॉस म  ह ◌ंगआउट िसलेट कर  और ित पृठ 3 लाइड  सेट कर

5. मान लीिजए आपके पास डाटा के कॉलम ह  जो एक िंटेड पेज से यादा ह  येक पेज पर कॉलम
हेिडंग पेज से यादा ह  येक पेज पर कॉलम हेिडंग आप ऑटोमैिटकली कैसे िंट करेगे
Answer – a) फाइल मीन ूपर पेज सेटअप िलक कर , शीट टैब िलक कर  और उस रो को एंटर कर
िजसम  िंट टाइस म  ये कॉलम हेिडंग ह

6. असिसट ट या है
Answer – b) सहायता और सुझाव देने वाला एक एिनमेिटड करैटर

7. िनन म  से कौन – सा कॉमन डाटा एिलमटो ंको छोटे से बड़े के म मे लगाता ह ।
Answer – d) िबट, बाइट, कैरेटर, िरकॉड, फीड फाइल, डाटाबेस

8. िवषम की पहचान कीिजए।
Answer – b) ऑपरेिटंग िसटम

9. एक ही वक शीट मे िसलेट िकए गए सेल से दो अय सेलो ंम  फॉम िटंग को जदी से कॉपी करने का
तरीका कौन सा है
Answer – c) फॉमिटंग टूलबार पर फामट प टर बटन इमेज को दो बार िलक कर  जहॉ ंफॉमिटंग कॉपी
करना चाहते ह

10. ई मेल िकए गए वड डायमूट को हमेशा रीिडंग लेआट मे खोले जाने से कैसे रोका जाता है
Answer – b) य ूमीन ूसे > रीिडंग लेआउट > जनरल टैक > अलौ टािटग इन रीिडंग लेआउट

11. चाट  बनाने के िलए आप या करते ह ।
Answer – d) चाट िवजाड

12. िनन म  से कौन – सा छोटा, िसंगल – साइट नेटवक  ह 
Answer – a) LAN

13. वड म  ब ेक कैसे िकया जा सकता ह 
Answer – b) उिचत थान पर कसर को रखकर कंट ोल + एंटर को ेस करके

14. एिटव सेल के कटेट्स या िदखाते ह 
Answer – c) फामूलाबार

15. सेव की गई फाइल को ढूढ़ंने और लोड करने के िलए।
Answer – d) ओपन कमांड को िसलेट कर
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Computer Practice Questions Set –
28
1. वड के उस फंशन को………….. कहते ह  जो टेट को टाइप करते ही करेट कर देता ह ।
a) ऑटो समराइज
b) ऑटो इसट
c) ऑटो करेट
d) टै क च च

2. डायमूट मे बॉटम म  जाने के िलए ……………… ेस कर ।
a) इसट कंुजी
b) होम कंुजी
c) कंट ोल कंुजी
d) एंड कंुजी

3. येक लाइड पर तारीख और लाइड नबर िदखाने का सबसे अछा तरीका कौन सा ह 
a) टूस चुन  हेडर एंड फुॅटर लाइड टैब िलप कर  इिछत ऑशन चुन  एलाई टू ऑल िलक कर
b) इसट चुने, हेडर एंड फुॅटर लाइड टैब िलक कर  , ऑशन चुन , एलाई टू ऑल िलक कर
c) य ूचुन , हेडर एंड फुॅटर लाइड टैब िलक कर , इिदत ऑशन चुन , एलाई टू ऑल िलक कर
d) फाइल चुन , हेडर एंड फुॅटर , लाइड टैब िलक कर , इिदत ऑशन चुन , एलाई टू ऑल िलक
कर

4. नंबरो के सेट म  सबसे बड  वैयु की गणना कौन फंशन करता है
a) एवरेज (average)
b) काउंट (count )
c) िमन (min)
d) मैस (max)

5. पेशल टाक के िलए अय कंुिजयो ंके साथ िकन कंुिजयो ंका योग करता है
a) इनसट, िडलीट
b) कंट ोल, िशट
c) लेट एरो, राइट एरो
d) पेज अप, पेज डाउन

6. िकसी भी वड डायमूट की बैकग ाउडं…………।
a) हमेशा सफेद रंग की होती है
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b) ऑशन मीन ूम  ीसेट िकए गए रंग म  होती है
c) सारे डायमू ट के िलए हमेशा एक ही होती है
d) आपकी पसंद के िकसी भी रंग की हो सकती है

7. टेबल म  रो को …………… भी कहते ह ।
a) िरकाड
b) फीड
c) डाटा टाइप
d) डाटा

8. वैय ूम  डॉलर का साइन और कौमा िकस टाइल बटन से आता ह ।
a) कौमा
b) परस ट
c) डॉलर
d) कर सी

9. शेयड ड ाइव म  बायिडफाट डायुमट को कैसे सेव िकया जाता ह 
a) िवंडोज एसलोरर खोल , शेयड ड ाइव पर िजस फाइल को सेव करना चाहते ह , वहॉ ंनेिवगेट कर
उह  िसलेट कर  एिडट मीन ूसे फोडर म  जाऍं शेयड ड ाइव म  नेिवगेट कर  मवू
b) यह ऑटोमैिटकली नही ंहो सकता इसिलए ऐसा करे – फाइल सेव ऐज ………. और शेयड ड ाइव
को िसलेट कर
c) टूस मीन ूसे ऑशस फाइल लोकेशन टैब डायुम ट को िसलेट कर  िफर मोडीफाई बटन को ेस
कर  मोडीफाई लोकेशन डायलॉग बॉस से शेयड ड ालव िसलेट कर
d) कोई भी फाइल पहले डेकटॉप म  सेव की जाती है बाद म  इसे अपेित ड ाइव म  ले जाया जाता ह

10. कयटूर का सबसे छोटा टोरेज यिूनट ह ।
a) िबट
b) बाइट
c) िनबल
d) िपसल

11. उस ोग ाम को या कहते ह  िजससे िलिखत डॉयुमट िएट करने और वापस जाने और यथा
आवयकतानुसार करेशन करने म  सहायता िमलती ह 
a) ीडशीट
b) पसनल राइडर
c) वड िंटर
d) वड ोसैसर
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12. आउटपुट देखने के िलए आप …………… का उपयोग करते ह ।
a) मॉनीटर
b) की – बोड
c) माउस
d) कैनर

13. ऐिलकेशन को छोडे िबना ोग ाम से एिजट करना या कहलाता ह 
a) फाइल
b) एिडट
c) कॉपी
d) लोज

14. इस कार के हाडवेयर म  ऐसें िडवाइस होते है जो डाटा को ऐसे प म  ट ासनलेट कर सकते ह
िजसे कयटूर ोसेसर कर सकता ह ।
a) एिलकेशन
b) इनपुट
c) िसटम
d) ये सभी

15. िकसी िवशेष टाक को करने के िलए एक अय की के साथ कौन – सी की युत की जाती ह ।
a) फंशन
b) एरो
c) ेस बार
d) कंट ोल

Answer Sheet
1. वड के उस फंशन को………….. कहते ह  जो टेट को टाइप करते ही करेट कर देता ह ।
Answer – c) ऑटो करेट

2. डायमूट मे बॉटम म  जाने के िलए ……………… ेस कर ।
Answer – d) एंड कंुजी

3. येक लाइड पर तारीख और लाइड नबर िदखाने का सबसे अछा तरीका कौन सा ह 
Answer – c) य ूचुन , हेडर एंड फुॅटर लाइड टैब िलक कर , इिदत ऑशन चुन , एलाई टू ऑल
िलक कर

4. नंबरो के सेट म  सबसे बड  वैयु की गणना कौन फंशन करता है
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Answer – d) मैस (max)

5. पेशल टाक के िलए अय कंुिजयो ंके साथ िकन कंुिजयो ंका योग करता है
Answer – b) कंट ोल, िशट

6. िकसी भी वड डायमूट की बैकग ाउडं…………।
Answer – a) हमेशा सफेद रंग की होती है

7. टेबल म  रो को …………… भी कहते ह ।
Answer – a) िरकाड

8. वैय ूम  डॉलर का साइन और कौमा िकस टाइल बटन से आता ह ।
Answer – d) कर सी

9. शेयड ड ाइव म  बायिडफाट डायुमट को कैसे सेव िकया जाता ह 
Answer  –  b)  यह ऑटोमैिटकली नही ंहो सकता इसिलए ऐसा करे–फाइल सेव ऐज ………. और
शेयड ड ाइव को िसलेट कर

10. कयटूर का सबसे छोटा टोरेज यिूनट ह ।
Answer – a) िबट

11. उस ोग ाम को या कहते ह  िजससे िलिखत डॉयुमट िएट करने और वापस जाने और यथा
आवयकतानुसार करेशन करने म  सहायता िमलती ह 
Answer – d) वड ोसैसर

12. आउटपुट देखने के िलए आप …………… का उपयोग करते ह ।
Answer – a) मॉनीटर

13. ऐिलकेशन को छोडे िबना ोग ाम से एिजट करना या कहलाता ह 
Answer – d) लोज

14. इस कार के हाडवेयर म  ऐसें िडवाइस होते है जो डाटा को ऐसे प म  ट ासनलेट कर सकते ह
िजसे कयटूर ोसेसर कर सकता ह ।
Answer – b) इनपुट

15. िकसी िवशेष टाक को करने के िलए एक अय की के साथ कौन – सी की युत की जाती ह ।
Answer – d) कंट ोल
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Computer Practice Questions Set –
29
1. िननिलिखत म  से कौन – सा टेट, ड ाइंस को और फोटो के इमेजो ंको िडिजटल प म  ट ासलेट
करेगा।
a) िडिजटाइजर
b) मोडेम
c) कैनर
d) की – बोड

2. वड ोसैिसंग ोग ामो ंमे अरो ंकी अलग – अलग शैिलयो ंको या कहते ह 
a) फॉट
b) कैिलग ाफी
c) राइिटंग
d) मैनुिट

3. एसेबलर का योग ………………. म  िलखे गए ोग ाम को ट ांसलेट करने के िलए िकया जाता
ह ।
a) लो लेवल ल वेज
b) मशीन ल वेज
c) हाई लेवल ल वेज
d) एसेबली ल वेज

4. कयटूर पर इनफामशन ……………… के प म  टोर िकया जाता ह ।
a) एनलॉग
b) िडिजटल डाटा
c) मोडेम डाटा
d) वाट्स डाटा

5. डायमूट िएट करने के िलए आप फाइल मेन ूपर ……………… कमांड यजू करेग ।
a) यू
b) ओपन
c) डायुम ट
d) टाइप

6. िलंिकंग पाइंट जो टेट म  आपकी पोिजशन दशाता ह  उसे ……… कहते ह ।
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a) िलंकर
b) कसर
c) कॉजर
d) वाइटर

7. जब ोसेसर ोग ामो ंऔर डाटा को यजू कर रहा होता है तब उह  कहॉ ंरखा जाता ह ।
a) मेन मेमोरी
b) सेकंडरी मेमोरी
c) िडक मेमोरी
d) ोग ाम मेमोरी

8. परेू डायमूट को िसलेट करने के िलए िननिलिखत म  से िकसका योग िकया जा सकता है
a) Ctrl + A
b) Alt + F5
c) Shift + A
d) िनधािरत नही ंिकया जा सकता

9. िजन हाडवेयर इंिवपमट से कयटूर बना होता है उनके नाम बताइए।
a) मॉनीटर , स टल ोसेिसंग यिूनट (CPU), कीबोड, माउस, सोटवेयर और नेटवक
b) मॉनीटर , स टल ोसेिसंग यिूनट (CPU), की बोड, माउस, ोग ाम और नेटवक
c) मॉनीटर , स टल ोसिसंग यिूनट (CPU), कीबोड
d) मॉनीटर , स टल ोसेिसंग यिूनट (CPU), कीबोड, माउस, एिलकेशन और नेटवक

10. ोग ाम को चलाने और चीजो ं को पिरवितत करने के िलए ीन के टॉप पर  FILE  –  EDIT-
FONT – TOOLS जैसी कमाड या होती है
a) मीन ूबार
b) टूल बार
c) यजूर  डली
d) वड ोसैसर

11. िसलेट या हाईलाइट करने के िलए अकसर ………….. का योग िकया जाता है।
a) आइकन
b) कीबोड
c) माउस
d) लॉपी िडक

12. टोरेज यिूनट या ोवाइड करते ह 
a) डाटा टाइप करने के िलए जगह
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b) इनफामशन और इटशस जब मेमोरी म  यजू न हो रह  हो तब उह  टोर करने के िलए लेस
c) इनफामशन िंट करने के िलए लेस
d) उपरोत सभी

13. िकस कार की मेमोरी ोसेसर के सबसे करीब से कनेटेड ह 
a) मेन मेमोरी
b) स कडरी मेमोरी
c) िडक मेमोरी
d) टेप मेमोरी

14. कौन – सा िडवाइस आपके कयटूर को दसूरे से टेलीफोन पर बात करने और इंटरनेट एसेस करने
देता है
a) RAM
b) CD – ROM ड ाईव
c) मोडेम
d) हाड ड ाइव

15. आपके कयटूर म  बनी परमानेट मेमोरी को या कहते ह ।
a) RAM
b) ROM
c) CPU
d) CD – ROM

Answer Sheet
1. िननिलिखत म  से कौन – सा टेट, ड ाइंस को और फोटो के इमेजो ंको िडिजटल प म  ट ासलेट
करेगा।
Answer – c) कैनर

2. वड ोसैिसंग ोग ामो ंमे अरो ंकी अलग – अलग शैिलयो ंको या कहते ह 
Answer – a) फॉट

3. एसेबलर का योग ………………. म  िलखे गए ोग ाम को ट ांसलेट करने के िलए िकया जाता
ह ।
Answer – d) एसेबली ल वेज

4. कयटूर पर इनफामशन ……………… के प म  टोर िकया जाता ह ।
Answer – d) वाट्स डाटा
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5. डायमूट िएट करने के िलए आप फाइल मेन ूपर ……………… कमांड यजू करेग ।
Answer – a) यू

6. िलंिकंग पाइंट जो टेट म  आपकी पोिजशन दशाता ह  उसे ……… कहते ह ।
Answer – b) कसर

7. जब ोसेसर ोग ामो ंऔर डाटा को यजू कर रहा होता है तब उह  कहॉ ंरखा जाता ह ।
Answer – a) मेन मेमोरी

8. परेू डायमूट को िसलेट करने के िलए िननिलिखत म  से िकसका योग िकया जा सकता है
Answer – d) िनधािरत नही ंिकया जा सकता

9. िजन हाडवेयर इंिवपमट से कयटूर बना होता है उनके नाम बताइए।
Answer – c) मॉनीटर , स टल ोसिसंग यिूनट (CPU), कीबोड

10. ोग ाम को चलाने और चीजो ं को पिरवितत करने के िलए ीन के टॉप पर  FILE  –  EDIT-
FONT – TOOLS जैसी कमाड या होती है
Answer – a) मीन ूबार

11. िसलेट या हाईलाइट करने के िलए अकसर ………….. का योग िकया जाता है।
Answer – c) माउस

12. टोरेज यिूनट या ोवाइड करते ह 
Answer – b) इनफामशन और इटशस जब मेमोरी म  यजू न हो रह  हो तब उह  टोर करने के
िलए लेस

13. िकस कार की मेमोरी ोसेसर के सबसे करीब से कनेटेड ह 
Answer – a) मेन मेमोरी

14. कौन – सा िडवाइस आपके कयटूर को दसूरे से टेलीफोन पर बात करने और इंटरनेट एसेस करने
देता है
Answer – c) मोडेम

15. आपके कयटूर म  बनी परमानेट मेमोरी को या कहते ह ।
Answer – b) ROM
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Computer Practice Questions Set –
30
1. टेट हाइलाइट कर के Edit मेय ूसे Copy िलक करने पर या होगा
a) टेट डायमू ट से कॉपी हो के िलपबोड पर रखा जाएगा
b) टेट टायमू ट से िनकल कर के िलपबोड
c) िलप बोड से टेट डॉयुम ट म  कसर िलंग कर रहा है वहॉ ंरखा जाएगा
d) केवल (B) और (C)

2. इस कमांड का योग टेट या ग ािफस को हटाने के िलए िकया जाता है उसके बाद सचूना को
िलबोड पर टोर िकया जाता है, तािक उसे पेट िकया जा सके।
a) चॉप
b) कट
c) िलप
d) काट अवे

3. जो एकदम अभी कट या कॉपी िकया गया हो उसे इनसट  वाइंट पर िलपबोड कटेट की कॉपी को
इसट  करने को ………….. कहते ह ।
a) पेट
b) िटक इन
c) िफट इन
d) पुश इन

4. यह िलंिकंग इंडीकेटर होता है, जो वह बताता ह  िक आपका अगला एशन कहॉ ंहोगा
a) CPU
b) कसर
c) टूल बार
d) बटू

5. की – बोड पर पाये जाने वाले कोई अर, संया या तीक या कहलाता ह  िजसे आप कयटूर म
टाइप कर सकती ह  ।
a) आउटपुट
b) करैटर
c) टाइप
d) िंट
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6. उस िडवाइस को या कहते ह  जो िडक म  रखी सचूना को पढ़ती ह  और कयटूर की मेमोरी म
ट ांसफर करती ह ।
a) मॉिनटर
b) ीन
c) की – बोड
d) िडक ड ाइव

7. एसेल म  फाइल खोलने और बंद करने के िलए िकस बार का योग िकया जा सकता ह 
a) फामिटंग
b) टेडड
c) टाइटल
d) फामिटग या टाइटल

8. यजूर और ओपरेिटंग िसटम के बीच के इंटरसेशन के तरीके को िननिलिखत म  से कौन कंट ोल
करता ह ।
a) यजूर इंटरफेस
b) ल गवेज ट ांसलेटर
c) लैटफाम
d) ीन सेवर

9. इंटरनेट पर युत कयटूर ल वेज …………. ह ।
a) बेिसक
b) कोबोल
c) जावा
d) पाकल

10. टेट को……………… बनाने के िलए B पर िलक करते ह ।
a) इटािलस
b) अंडरलाइड
c) इटािलस और अंडरलाइन
d) बोड

11. वह कौन – सा कंुजी है जो कयटूर की मेमोरी की सचूना और ीन से करेटस को िमटा देती ह ।
a) एिडट
b) िडिलट की
c) डमी आउट
d) टट की
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12. िविनमाण के समय िरकाड िकया गया िडक का कंटेट िजसे यजूर चच या इरेज नही ंकर सकता है,
िननिलिखत होता ह ।
a) केवल मेमोरी
b) केवल राइड
c) केवल रीड
d) केवल रन

13. येक अर के िलए िशट कंुजी का योग िकए िबना सभी अरो ंको कैिपटल करने के िलए
कंुजी का योग िकया जाता ह ।
a) िशटर
b) अपर केस
c) कैस लॉक की
d) आइकन

14. आप अपनी पसनल फाइल/फोडर ……………….. म  रख सकते ह ।
a) माइ फोडर
b) माइ डायुम ट्स
c) माई फाइस
d) माई टेट

15. ……….. एक सटल कयटूर है जो बहुत से PC वक टेशस और अय कयटूरो ंके िलए डाटा
और ोग ामो ंके कलेशन होड करता ह ।
a) सुपर कयटूर
b) िमनी कयटूर
c) लैपटॉप
d) सवर

Answer Sheet
1. टेट हाइलाइट कर के Edit मेय ूसे Copy िलक करने पर या होगा
Answer – a) टेट डायमू ट से कॉपी हो के िलपबोड पर रखा जाएगा

2. इस कमांड का योग टेट या ग ािफस को हटाने के िलए िकया जाता है उसके बाद सचूना को
िलबोड पर टोर िकया जाता है, तािक उसे पेट िकया जा सके।
Answer – b) कट

3. जो एकदम अभी कट या कॉपी िकया गया हो उसे इनसट  वाइंट पर िलपबोड कटेट की कॉपी को
इसट  करने को ………….. कहते ह ।
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Answer – a) पेट

4. यह िलंिकंग इंडीकेटर होता है, जो वह बताता ह  िक आपका अगला एशन कहॉ ंहोगा
Answer – b) कसर

5. की – बोड पर पाये जाने वाले कोई अर, संया या तीक या कहलाता ह  िजसे आप कयटूर म
टाइप कर सकती ह  ।
Answer – b) करैटर

6. उस िडवाइस को या कहते ह  जो िडक म  रखी सचूना को पढ़ती ह  और कयटूर की मेमोरी म
ट ांसफर करती ह ।
Answer – d) िडक ड ाइव

7. एसेल म  फाइल खोलने और बंद करने के िलए िकस बार का योग िकया जा सकता ह 
Answer – b) टेडड

8. यजूर और ओपरेिटंग िसटम के बीच के इंटरसेशन के तरीके को िननिलिखत म  से कौन कंट ोल
करता ह ।
Answer – a) यजूर इंटरफेस

9. इंटरनेट पर युत कयटूर ल वेज …………. ह ।
Answer – c) जावा

10. टेट को……………… बनाने के िलए B पर िलक करते ह ।
Answer – d) बोड

11. वह कौन – सा कंुजी है जो कयटूर की मेमोरी की सचूना और ीन से करेटस को िमटा देती ह ।
Answer – b) िडिलट की

12. िविनमाण के समय िरकाड िकया गया िडक का कंटेट िजसे यजूर चच या इरेज नही ंकर सकता है,
िननिलिखत होता ह ।
Answer – c) केवल रीड

13. येक अर के िलए िशट कंुजी का योग िकए िबना सभी अरो ंको कैिपटल करने के िलए
कंुजी का योग िकया जाता ह ।
Answer – c) कैस लॉक की

14. आप अपनी पसनल फाइल/फोडर ……………….. म  रख सकते ह ।
Answer – b) माइ डायुम ट्स

ANKAJ INFOTECH



15. ……….. एक सटल कयटूर है जो बहुत से PC वक टेशस और अय कयटूरो ंके िलए डाटा
और ोग ामो ंके कलेशन होड करता ह ।
Answer – d) सवर
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Q.1 एम.एस.-वड� म�, CTRL + K दबाने पर ______ होगा।
Ans 1. चय�नत पाठ �डल�ट करे

2. इ�सट� हाइपर�लकं डायलॉग बॉ�स खोल�

3. एक नय ू�वडंो खोल�

4. परैा�ाफ को इंड�ट कर�

Question Type : MCQ
Question ID : 618278497

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.2 वेबपेज �लखने के �लए �न�न�ल�खत म� से �कसका उपयोग �कया जा सकता है?

Ans 1. एफ.ट�.पी

2. एच.ट�.एम.एल

3. एस.एम.ट�.पी

4. एच.ट�.ट�.पी

Question Type : MCQ
Question ID : 618278538

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.3 �लाइड शो म� �पछल� �लाइड पर जाने के �लए, ______ का उपयोग कर�।
Ans 1. F1

2. डाउन ऐरो (DOWN ARROW)

3. P

4. N

Participant ID 19334796
Participant Name SHAILESH KUMAR
Test Center Name iON Digital Zone iDZ Jalalpur
Test Date 10/12/2019
Test Time 3:00 PM - 4:00 PM
Subject Data Entry Operator
Marks Obtained 29.00000

Section : MCQ for Data Entry Operator
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Question Type : MCQ
Question ID : 618278535

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.4 �या WINDOWS 7 अपने आप �कसी नए हाड�वेयर का पता लगा सकता है?

Ans 1. हा,ं जब �डवाइस �ाइवर पहले से लोड हो

2. हा ंकेवल जब �डवाइस �ाइवर स��य हो

3. नह�ं

4. हाँ

Question Type : MCQ
Question ID : 618278494

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.5 सी.पी.य.ू �दश�न सधुार के �लए हम ______ के �प म� �ात एक छोट� �मता वाल� परंत ुबहुत तज़े मेमोर� का
उपयोग करत ेह�।

Ans 1. �लशै

2. रोम (ROM)

3. एच.डी.डी. (HDD)

4. कैश

Question Type : MCQ
Question ID : 618278482

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.6 मान ल� �क हमारे पास A2 और B2 से�स म� �मशः ABC और DEF ह�। इसे �न�न�ल�खत स�ू म� दज� �कए
जाने पर सेल C2 म� �द�श�त म�ूय �न�न�ल�खत म� से �या होगा?

= CONCATENATE (A2, LEFT (B2, 2))
Ans 1. ABDE

2. ABCDE

3. FECB

4. DEFABC

Question Type : MCQ
Question ID : 618278525

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.7 In MS-WORD, what does CTRL + O do?
Ans 1. Toggles 6pt space above the paragraph.

2. Facilitates to open a new word document

3. Toggles the Grammar Spelling option.
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4. Switches from all small to all capital mode.

Question Type : MCQ
Question ID : 618278500

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.8 मे�लगं लेब�स �न�न�ल�खत म� से ______ का �ह�सा ह�।
Ans 1. डटेा सोस�

2. मेन डॉ�यमू�ट

3. लेबल फ़ाइल

4. डटेाबेस लेब�स

Question Type : MCQ
Question ID : 618278508

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.9 In MS-Excel, using Alt+H+O+R one can ______.
Ans 1. Rename the worksheet

2. Delete the worksheet

3. Insert a new worksheet

4. Hide the worksheet

Question Type : MCQ
Question ID : 618278511

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.10 एम.एस.-ए�सेल �वडंो म�, काय� �े� को ______ के �प म� जाना जाता है।
Ans 1. वक� शीट

2. �ल�कशीट

3. ��डशीट

4. माक� शीट

Question Type : MCQ
Question ID : 618278510

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.11 A control panel in Windows consists of a set of _______ that allows system settings.
Ans 1. applets

2. libraries

3. hardware devices

4. translators

ANKAJ INFOTECH



1/27/2020 https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S42D109/157630845161164…

https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S42D109/1576308451611640/19334796… 4/16

Question Type : MCQ
Question ID : 618278492

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.12 �थम वेब �ाउज़र के �वकास के वष� को इं�गत कर�।
Ans 1. 1989

2. 1988

3. 1992

4. 1990

Question Type : MCQ
Question ID : 618278540

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.13 एम.एस.-ए�सेल 2016 म�, वक� बकु साझा करत ेसमय, आप प�रवत�न इ�तहास नह� ंरखना चाहत ेह�। आप इसे
कहां से स�म कर सकत ेह�?

Ans 1. ओपन वक�  बकु डायलॉग बॉ�स म� एडवां�ड टैब

2. �ोटे�ट वक� बकु डायलॉग बॉ�स म� एडवां�ड टैब

3. शयेर वक�  बकु डायलॉग बॉ�स म� ए�ड�टगं टैब

4. शयेर वक� बकु डायलॉग बॉ�स म� एडवां�ड टैब

Question Type : MCQ
Question ID : 618278523

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.14 In MS-Excel 2016, INSERT smart art option provides different types of pyramids. Total
how many pyramid types are available?

Ans 1. 1

2. 4

3. 3

4. 2

Question Type : MCQ
Question ID : 618278529

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.15 In MS-Excel 2016, a worksheet or workbook may be protected using various available
options. Which of the following options is INCORRECT in this regard?

Ans 1. Protect Worksheet

2. Protect and Share Worksheet

3. Protect Workbook
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4. Protect and Share Workbook

Question Type : MCQ
Question ID : 618278517

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.16 मान ल�िजए �क एम.एस.-ए�सेल 2016 सेल म�, आपके पास 2.1753456 सं�या है। य�द आप ड�े�ज ड�ेसमल
(होम टैब के तहत) बटन को 5 बार दबात ेह� और उसे �फर से दबात ेह� तो 5वी ंबार क� दबाने के बाद और अ�ंतम
क� दबाने के बाद �या �द�श�त होगा?

Ans 1. 2.18, 2.2

2. 2.17, 2.18

3. 2.19, 2.22

4. 2.20, 1.89

Question Type : MCQ
Question ID : 618278519

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.17 एम.एस.-पॉवरपॉइंट म�, �कसी �लाइड को ______ �वारा डुि�लकेट �कया जा सकता है।
Ans 1. CTRL+E

2. CTRL+I

3. CTRL+M

4. CTRL+D

Question Type : MCQ
Question ID : 618278531

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.18 मेरे पास एम.एस.-पॉवरपॉइंट म� कई �लाइड ह� और इनम� से कुछ म� टे��ट श�द "INDIA" उपल�ध है। अब
य�द म� �लाइड सॉट�र �य ूम� CTRL + F दबाता हंू और INDIA को खोजता हंू तो वे �लाइ�स कौन सी ह� िज�ह�
चनुा जाएगा?

Ans 1. INDIA श�द वाल� सभी �लाइ�स

2. INDIA श�द वाल� केवल अ�ंतम �लाइड

3. INDIA श�द वाल� केवल पहल� �लाइड

4. INDIA श�द वाल� केवल पहल� और आ�खर� �लाइ�स

Question Type : MCQ
Question ID : 618278533

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.19 The easiest way to move to the last item of a folder being displayed is to press ______.
Ans 1. SHIFT + END
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2. ALT + END

3. END

4. CTRL + Down Arrow

Question Type : MCQ
Question ID : 618278493

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.20 ए�सेल म�, मान ल� �क आपके पास A2 और B2 दो सेल म� लगातार ABC और DE ह�। सेल C2 का चयन कर�
और स�ू = concatenate (A2, B2) दज� कर�। अब, कं�ोल + सी का उपयोग करके C2 के स�ू क� कॉपी कर�
और इसे D2 म� कं�ोल + वी का उपयोग करके पे�ट करे। सेल D2 क� साम�ी �या होगी?

Ans 1. DEABCDE

2. ABCDE

3. DEDEABC

4. DEABC

Question Type : MCQ
Question ID : 618278526

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.21 In MS-WORD, CTRL+ P opens up ______.
Ans 1. Preference setting

2. Alignment dialogue box

3. Align paragraph dialogue box

4. Print dialogue box

Question Type : MCQ
Question ID : 618278499

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.22 In MS-WORD, what is the use of CTRL+SHIFT+ F12?
Ans 1. Copy a document

2. Save a document

3. Print a document

4. Delete a document

Question Type : MCQ
Question ID : 618278502

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.23

Ans
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1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 618278539

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.24 In MS-WORD, ALT + X is used to ______.
Ans 1. Show the Unicode encoding of the selected character

2. Move to another WORD window

3. Delete the file

4. Save the file

Question Type : MCQ
Question ID : 618278498

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.25 ______ को माउस �वारा �नयं��त �कया जाता है जो ���न पर �वशषे ि�थ�तय� म� अपना आकार बदलता है।
Ans 1. आइकॉन

2. पॉइंटर

3. मे�यू

4. फ़ाइल

Question Type : MCQ
Question ID : 618278491

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.26 Pressing ALT + M in MS-Excel leads to the ______.
Ans 1. Formula Tab

2. Home Tab

3. Table Tab

4. Chart Tab

Question Type : MCQ
Question ID : 618278512

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.27 मेल मज� म�, कौन सा शॉट�कट डॉ�यमू�ट मज� को,संचालन करता है?

Ans 1. ALT + SHIFT + M
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2. CTRL + SHIFT + M

3. CTRL + SHIFT + N

4. ALT + SHIFT + N

Question Type : MCQ
Question ID : 618278509

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.28 In MS-WORD, CTRL+F opens ______.
Ans 1. A file

2. A dialogue box to find something in the document

3. A dialogue box to set a new font

4. A format specification box to save the file

Question Type : MCQ
Question ID : 618278501

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.29 Excel has a number of functions of different types. From the given options find out the
INCORRECT function type.

Ans 1. Text functions

2. Economical functions

3. Statistical functions

4. Mathematical functions

Question Type : MCQ
Question ID : 618278527

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.30 एम.एस.- वड� म� तीन बार ि�लक �कस के �लए �कया जाता है?

Ans 1. टे��ट लाइन या परैा�ाफ को र� करता है

2. टे��ट लाइन या परैा�ाफ का चयन करता है

3. टे��ट लाइन या परैा�ाफ को हटाता है

4. टे��ट लाइन या परैा�ाफ को कापी करता है

Question Type : MCQ
Question ID : 618278504

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.31 Four options are given out of which three are alike and one is different. Select the odd
one.

Ans 1. 3-D movie
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2. 3-D animation

3. 3-D image

4. 3-D printer

Question Type : MCQ
Question ID : 618278484

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.32 Pressing ALT + A in MS-Excel leads to the ______.
Ans 1. Data Tab

2. Review Tab

3. View Tab

4. Formulas Tab

Question Type : MCQ
Question ID : 618278513

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.33 A/An __________ CANNOT be the mail merge data source.
Ans 1. executable file

2. WORD file

3. text file

4. Excel file

Question Type : MCQ
Question ID : 618278507

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.34 एम.एस.-पॉवरपॉइंट 2016 म� प�रवत�न �लाइड ले आउट आरंभ करने के �लए मानक �प �न�न म� से ______
म� है।

Ans 1. �य ू��लाइड मा�टर � "ले आउट चनु�"

2. �र�य ू� �लाइड मा�टर � �डजाइन � "ले आउट चनु�"

3. TOOLS� �लाइड मा�टर � "ले आउट चनु�"

4. एनीमेशन � �य ू�� "ले आउट चनु�"

Question Type : MCQ
Question ID : 618278534

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.35 Which of the following is NOT a valid internet connection type?
Ans 1. DSL

2. FASTNET
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3. WI-FI

4. DIALUP

Question Type : MCQ
Question ID : 618278537

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.36 Four options are given out of which three are alike and one is different. Select the odd
one.

Ans 1. Joystick

2. Monitor

3. Light pen

4. Mouse

Question Type : MCQ
Question ID : 618278483

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.37 एम.एस.-ए�सेल म� एक सेल के �लए म�ुा [0] शलै� का उपयोग करने और 12 टाइप करने पर हम� ______
�मलता है।

Ans 1. 12.00 के बाद �डफ़ॉ�ट म�ुा �तीक

2. 12 के बाद �डफ़ॉ�ट म�ुा �तीक

3. 12.0 के बाद �डफ़ॉ�ट म�ुा �तीक

4. 12 के बाद कोई म�ुा �तीक नह�ं

Question Type : MCQ
Question ID : 618278522

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.38

Ans
1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 618278521
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Status : Answered
Chosen Option : 3

Marks : 0.00

Q.39 Spell check can be initiated in MS-WORD by using ______.
Ans 1. F3

2. F5

3. F7

4. F1

Question Type : MCQ
Question ID : 618278503

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.40 A merged document can be printed by using ______.
Ans 1. SHIFT + ALT + P

2. ALT + SHIFT + M

3. SHIFT + CTRL + P

4. CTRL + SHIFT + M

Question Type : MCQ
Question ID : 618278506

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.41 HDD एक _____ �डवाइस है।
Ans 1. इनपटु (input)

2. मेमोर� (Memory)

3. आउटपटु (output)

4. �ोसेसर (processor)

Question Type : MCQ
Question ID : 618278481

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.42 WINDOWS XP क� श�ुआत �कस वष� म� हुई थी?
Ans 1. 2005

2. 2003

3. 2001

4. 2002

Question Type : MCQ
Question ID : 618278490

Status : Answered
Chosen Option : 3
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Marks : 1.00

Q.43 एम.एस.-ए�सेल म�, य�द हम �कसी संक�ण� कॉलम म� टे��ट टाइप करत ेह� तो टे��ट को समायोिजत करने के
�लए कॉलम अपने आप बढ़ जाता है। कॉलम क� चौड़ाई को बढ़ाए �बना, लंबे टे���स को इसम� कैसे
समायोिजत �कया जा सकता है?

Ans 1. टे��ट को रैप करके

2. मज� एंड स�टर �वारा

3. अ�त�र�त �पेस इ�सट� करके

4. अ�त�र�त �पेस �डल�ट करके

Question Type : MCQ
Question ID : 618278520

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.44 How can the cell border may be set in MS-Excel 2016 so that we get a cross sign (two
diagonal lines; from bottom left to upper right and upper left to bottom right) over the
text contained therein?

Ans 1. FORMAT� FORMAT CELL�BORDER� "select the appropriate first diagonal" �
"appropriate 2nd diagonal"

2. DATA� CELL�BORDER� "select the appropriate first diagonal" � "appropriate 2nd
diagonal"

3. TOOLS� FONT�BORDER� "select the appropriate first diagonal" � "appropriate
2nd diagonal"

4. TOOLS� CELL�BORDER� "select the appropriate first diagonal" � "appropriate
2nd diagonal"

Question Type : MCQ
Question ID : 618278518

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.45 In MS-Excel 2016, under REVIEW tab you may protect a worksheet and get many other
options. Some of the options are given here. Find out the INCORRECT option.

Ans 1. Share workbook

2. Spelling

3. Macros

4. Smart lookup

Question Type : MCQ
Question ID : 618278524

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.46 There are 3 documents involved in a mail merge; they are:
Ans 1. Address data, header data, body data

2. Address labels, body, header

3. Document1, document2, document3
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4. Data source, main document, merged document

Question Type : MCQ
Question ID : 618278505

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.47 Assemblers are ______.
Ans 1. Linkers of the object programs generated by the compilers

2. Loaders of the executable code

3. Translators of the low level program code to machine code

4. Preprocessors that assemble the basic items for further use by the compilers

Question Type : MCQ
Question ID : 618278489

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.48 एम.एस.-पॉवरपॉइंट म�, �कसी �लाइड को ______ के �वारा हटाया जा सकता है।
Ans 1. CTRL+X

2. CTRL+M

3. CTRL+D

4. CTRL+I

Question Type : MCQ
Question ID : 618278532

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.49 ALT+O+C+W may be used in MS-Excel to ______.
Ans 1. Adjust the row width

2. Adjust the row height

3. Adjust the column width

4. Adjust the column height

Question Type : MCQ
Question ID : 618278515

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.50 एमएस - वड� ���न पर �टैटस बार कहां ह�?
Ans 1. टॉप

2. राइट 

3. बॉटम

4. ले�ट
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Question Type : MCQ
Question ID : 618278496

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.51 The oldest web browser among the following is ______.
Ans 1. NETSCAPE

2. CHROME

3. FIREFOX

4. SAFARI

Question Type : MCQ
Question ID : 618278536

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.52 What is a shareware?
Ans 1. A software for sharing the memory with other users

2. A software to be developed in a shared basis

3. A software that is often distributed to evaluate its performance free of cost

4. A software that shares the hardware

Question Type : MCQ
Question ID : 618278487

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.53 ऑपरे�टगं �स�टम �न�न�ल�खत म� से कौन सा काय� नह�ं करता है?

Ans 1. �ोसेस मनेैजम�ट

2. मेमोर�  मनेैजम�ट

3. सॉ�टवेयर मनेैजम�ट

4. फाइल मनेैजम�ट

Question Type : MCQ
Question ID : 618278486

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.54 एम.एस.-ए�सेल शीट म�, मान ल� �क हम� यह दशा�ने क� आव�यकता है �क काटू�न च�र� बोल रहा है (�द�श�त
टे��ट के �प म�) । इस उ�े�य के �लए उपय�ुत ऑटो आकार का �कार �न�न�ल�खत म� से �या होगा?

Ans 1. रे�ट�ग�स

2. �लोचाट�

3. कॉलआउ�स

4. �टास� एंड बनैस�
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Question Type : MCQ
Question ID : 618278530

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.55 For a high speed data transfer between Memory to Memory and I/O devices, a
computer uses _______.

Ans 1. cache memory

2. DMA controller

3. tertiary memory

4. secondary memory

Question Type : MCQ
Question ID : 618278485

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.56 एम.एस.-ए�सेल 2016 म�, _______ मे�य ूके बाद _______ �वक�प के मा�यम से �कसी वक� बकु को
संर��त और आरंभ �कया जा सकता है।

Ans 1. फाइल, �ोटे�ट शीट

2. डटेा, �ोटे�ट शीट

3. होम, �ोटे�ट शीट

4. �र�य,ू �ोटे�ट शीट

Question Type : MCQ
Question ID : 618278516

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.57

Ans 1. समान ढलान के साथ 4 लाइ�स (रेखाएं)

2. 2 व�ट�कल लाइ�स (ऊ�वा�धर रेखाएँ)

3. 4 हॉ�रज�टल लाइ�स (�ै�तज रेखाएँ)

4. 2 �लांट लाइ�स (�तरछ� रेखाएं) जो एक-दसूरे को बीच म� काटती ह�

Question Type : MCQ
Question ID : 618278528

Status : Answered
Chosen Option : 4

Marks : 1.00
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Q.58 ALT+O+R+E may be used in MS-Excel to ______.
Ans 1. Adjust the row width

2. Adjust the column height

3. Adjust the column width

4. Adjust the row height

Question Type : MCQ
Question ID : 618278514

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.59 Check the C program segment and find out how many times the body of the while loop
would be executed?
int a, b; a = 2; b = 5;
while (a & b) 
printf (“hello\n”);

Ans 1. 1

2. 0

3. Cannot be determined

4. Infinite

Question Type : MCQ
Question ID : 618278488

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.60 Which of the following is a non-WYSIWIG type software.
Ans 1. PAGEMILL

2. MS-WORD

3. Latex

4. FRONTPAGE

Question Type : MCQ
Question ID : 618278495

Status : Answered
Chosen Option : 2

Marks : 0.00
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Q.1 एम.एस.-वड� म� CTRL + D ______ को खोलता है।
Ans 1. �पे�लगं एंड �ामर चे�कंग बॉ�स

2. फॉ�ट �ेफर�स �वडंोज़

3. ��टं मे�यू

4. फाइल �ोटे�शन मे�यू

Question Type : MCQ
Question ID : 618278438

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.2 एम.एस.-ए�सेल 2016 म� वक� शीट क� �ोटेि�टंग के �लए आप पहले ______ पर ि�लक करत ेहै और �फर
अ�य उपय�ुत ��याओ ंका पालन करत ेह�।

Ans 1. �र�य ूटैब

2. लेआउट टैब

3. टेब�स टैब

4. डॉ�यमू�ट टैब

Question Type : MCQ
Question ID : 618278463

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.3 आप कं�े�ड �कए जाने वाले फ़ाइल / फ़ो�डर के चयन के बाद कं�ेस करने के �लए नीचे के �कस चरण का
अनपुालन कर सकत ेह�?

Ans 1. राइट ि�लक > इंपोट� > कं�े�ड

2. राइट ि�लक > ले�ट ि�लक > कं�े�ड

3. राइट ि�लक > स�ड टू > कं�े�ड (िज़�पड) फो�डर

Participant ID 19339231
Participant Name SUDARSHAN KUMAR
Test Center Name iON Digital Zone iDZ 1 Patliputra
Test Date 10/12/2019
Test Time 12:00 PM - 1:00 PM
Subject Data Entry Operator
Marks Obtained 27.00000

Section : MCQ for Data Entry Operator
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4. राइट ि�लक > ए�सपोट� > कं�े�ड

Question Type : MCQ
Question ID : 618278433

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.4 एम.एस.-ए�सेल म� CTRL + SPACE कंुजी संयोजन का उपयोग ______ के �लए �कया जाता है।
Ans 1. �कसी कॉलम को �सले�ट करने

2. �कसी रो को �सले�ट करने

3. �कसी सेल को �छपाने

4. �कसी कॉलम को �छपाने

Question Type : MCQ
Question ID : 618278453

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.5 The shortcut CTRL + Y in MS-WORD is used to ______.
Ans 1. Create a bullet list

2. Redo the last action

3. Undo a bullet

4. Undo the last action

Question Type : MCQ
Question ID : 618278439

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.6 एम.एस.-वड� म� मेल-मज़� डॉ�यमू�ट को �यि�तगत बना लेने का ______ फ��ड एक तर�का है।
Ans 1. मज�

2. पस�नल

3. य�ूनट

4. �ुप

Question Type : MCQ
Question ID : 618278445

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.7 एक �लकं �कये हुए �लाइड तक मवू करने के �लए आप एम.एस.-पॉवरपॉइंट 2016 म� �कस तरह से हाइपर�लकं
जोड़�गे? मान ल� �क आप नॉम�ल �य ूमोड म� ह�।

Ans 1. �लाइड शो टैब पर ि�लक कर� और हाइपर�लकं आ�द को चजू कर�

2. इ�सट� टैब पर ि�लक कर� और हाइपर�लकं आ�द को चजू कर�

3. टू�स टैब पर ि�लक कर� और हाइपर�लकं आ�द को चजू कर�
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4. फॉम�ट टैब पर ि�लक कर� और हाइपर�लकं आ�द को चजू कर�

Question Type : MCQ
Question ID : 618278475

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.8 �कसी डायलअप कने�शन क� �पीड आम तौर पर ______ होती है।
Ans 1. 100 Kbps

2. 56 Kbps

3. 112 Kbps

4. 168 Kbps

Question Type : MCQ
Question ID : 618278477

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.9 उस एम.एस.-ए�सेल वज़�न म� वक� बकु �ोटे�शन �वक�प के तहत �ोटेि�टंग �वडंो का अथ� �या है िजसम� यह
मौजदू है?

Ans 1. वक� बकु खोलने पर �वडंोज समान आकार और समान ि�थ�त म� होती ह�

2. �वडंोज �छपी ह�गी

3. �वडंोज को �गै नह�ं �कया जा सकता है

4. �वडंोज �छपी नह�ं ह�गी

Question Type : MCQ
Question ID : 618278456

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.10 एम.एस.-वड� 2016 के एक टेबल म� �नयत कॉल�स क� अ�धकतम सं�या ______ होती है ।
Ans 1. 63

2. 16

3. 32

4. 8

Question Type : MCQ
Question ID : 618278444

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.11 वक� बकु के �ोटे�शन के तहत एम.एस.-ए�सेल म� हम ���चर को �ोटे�ट कर सकत ेह� िजसका आशय शी�स
पर कुछ �नषधे� (�ो�ह�ब�नस) से है। इस संबंध म� �न�न�ल�खत �वक�प� म� कौन सह� �नषधे (�ो�हबीश�स)
है?

Ans 1. म�ूड, �य ूकोड, सेले�ट आल शी�स
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2. म�ूड, इ�सट�ड, �डल�टेड

3. मवू, हाईड, �य ूकोड

4. मवू, इ�सट�ड, �ोटे�ट शीट

Question Type : MCQ
Question ID : 618278457

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.12 �कसी �ा��पक C �ो�ाम म� दो बात� ह�:

i) a=5; b= + + a 
ii) a =5; b = a + + 

दोन� असाइनम�ट �नद�श� के �न�पादन के बाद “a” और “b” के मान �या ह�?
Ans 1. i) 6, 6; ii) 7, 7

2. i) 6, 6; ii) 6, 5

3. i) 6, 6; ii) 6, 6

4. i) 5, 5; ii) 6, 6

Question Type : MCQ
Question ID : 618278428

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.13 जब एम.एस.-ए�सेल 2016 म� आप HOME > FORMAT > ORGANIZE SHEET > TAB COLOR को
�सले�ट करत ेह� और जो कलस� का म�ै��स �दखाई देता है उनमे से एक कलर पर ि�लक करत ेह� तो �या होता
है?

Ans 1. वक� शीट के फॉर�ाउंड (अ�भ�ूम) का रंग �सले�टेड (चय�नत) रंग म� बदल जाता है

2. संपणू� वक� शीट के बकै�ाउंड (प�ृठभ�ूम) का रंग �सले�टेड (चय�नत) रंग म� बदल जाता है

3. �रबन के फॉर�ाउंड (अ�भ�ूम) का रंग �सले�टेड (चय�नत) रंग म� बदल जाता है

4. �नचले �ह�से म� वक� शीट टैब के बकै�ाउंड (प�ृठभ�ूम) का रंग �सले�टेड (चय�नत) रंग म� बदल जाता
है

Question Type : MCQ
Question ID : 618278462

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.14 �कसी इंटरनेट आई.पी.वी.4 ए�से म� ______ ऑ�टे�स �योग �कये जात ेह� ।
Ans 1. 16

2. 4

3. 8

4. 6

Question Type : MCQ
Question ID : 618278478

Status : AnsweredANKAJ INFOTECH
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Chosen Option : 2
Marks : 1.00

Q.15 �न�न�ल�खत म� से �कस ए��ेसगं मोड म� आपर�ड शी�ता से ऑप-कोड (op-code) का अनसुरण करता है?

Ans 1. इ�ड�े�ड

2. बे�ड

3. डाइरे�ट

4. इमी�डएट

Question Type : MCQ
Question ID : 618278422

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.16 एम.एस.-वड� म� ALT + SHIFT + N इस कंुजी संयोजन का उपयोग ______ के �लए �कया जाता है।
Ans 1. डॉ�यमू�ट म� मेल-मज़� प�रणाम� को इक�ा करने

2. नए �ल�क डॉ�यमू�ट को ��एट करने

3. डटेा सोस� को ��एट करने

4. मेन डटेा सोस� को ��एट करने

Question Type : MCQ
Question ID : 618278449

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.17 आप �वडंोज 10 म� �कसी नई �डवाइस को इ��टाल करने के �लए �कस �कार क� पहल करत ेह�?
Ans 1. �टाट� > �डवाइसेस

2. �टाट� > से�ट�ंस > �डवाइसेस > �लटूूथ एंड अदर �डवाइसेस

3. �टाट� > �डवाइसेस > �सले�ट > �लटूूथ एंड अदर �डवाइसेस

4. �टाट� > से�ट�ंस > �लटूूथ एंड अदर �डवाइसेस

Question Type : MCQ
Question ID : 618278434

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.18 _______ एक ऐसी छोट� ले�कन बहुत तजे मेमोर� है िजसे CPU और म�ुय मेमोर� के बीच रखा जाता है।
Ans 1. CACHE (कैश)

2. USB

3. ROM

4. BUS (बस)

Question Type : MCQ
Question ID : 618278421

Status : Answered
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Chosen Option : 1
Marks : 1.00

Q.19 एम.एस.-वड� म� �सले�टेड (चय�नत) टे��ट को ______ अन�ुम का पालन करके कह�ं और कॉपी �कया जा
सकता है।

Ans 1. CTRL + A; CTRL + P

2. CTRL + C; CTRL + P

3. CTRL + C; CTRL + V

4. CTRL + A; CTRL + V

Question Type : MCQ
Question ID : 618278442

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.20 सं���त �प WWW ______ के �लए �य�ुत होता है।
Ans 1. वेब व�ड� वाइड

2. वाई-फाई वाइड वेब

3. वेब वाइड वाई-फाई

4. व�ड� वाइड वेब

Question Type : MCQ
Question ID : 618278476

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.21 एम.एस.- वड� म� CTRL + E का उपयोग ______ के �लए �कया जाता है।
Ans 1. टे��ट लाइन या परैा�ाफ को अतं म� ले जाने (मवू)

2. टे��ट लाइन या परैा�ाफ को दा� ओर ले जाने (मवू)

3. टे��ट लाइन या परैा�ाफ को बीच म� संरेखण (एलाइन) करने

4. टे��ट लाइन या परैा�ाफ �मटाने (इरेस)

Question Type : MCQ
Question ID : 618278435

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.22 एम.एस.-ए�सेल म�, सेल फॉम��टगं ऑ�शन के तहत, आप बहुत सारे �वक�प देख सकत ेह� | �न�न�ल�खत म�
से कौनसा उनमे से एक �वक�प नह�ं है |

Ans 1. हाइड

2. आटो�फट

3. अनहाइड

4. टाइडी

Question Type : MCQ
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Question ID : 618278461
Status : Answered

Chosen Option : 1
Marks : 0.00

Q.23 एम.एस.-ए�सेल 2016 म� �माट�आट� टैब म� �परा�मड और म�ै��स नाम वाले दो �वक�प उपल�ध ह�। उनम� से
��येक म� �कतने सब-ऑ�शन (उप�वक�प) मौजदू ह�?

Ans 1. 5

2. 3

3. 6

4. 4

Question Type : MCQ
Question ID : 618278470

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.24 एम.एस.-ए�सेल 2016 �वडंो के बाएँ बॉटम पर ‘+’ पर ि�लक करने के बजाय ______ के �वारा एक वक� शीट
को जोड़ा जा सकता है।

Ans 1. होम > इ�सट� शीट > एंटर

2. होम > इ�सट� > इनसट� शीट

3. होम > इ�सट� वक� शीट > एंटर

4. इ�सट� > एल�म�ट > एंटर

Question Type : MCQ
Question ID : 618278450

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.25 �कसी ��पी 6 फेज वाले कंपाइलर का फेज 3 ______ है।
Ans 1. कूट इ�टमीकरण (कोड ऑि�टमाइज़ेशन)

2. मा�य संकेतजनन (इंटरमी�डएट कोड जनरेशन)

3. वा�य रचना �व�लेषण (�सनटे�स एना�ल�सस)

4. माने-सबंधी �व�लेषण (�सम��टक एना�ल�सस)

Question Type : MCQ
Question ID : 618278429

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.26 नीचे क� �कस �डवाइस का �यादातर उपयोग यज़ूस� क� फ़ाइ�स को कॉपी या मवू करने के �लए �कया जाता है?

Ans 1. ROM

2. ��टंर

3. पेन �ाइव

4. �लॉटर
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Question Type : MCQ
Question ID : 618278423

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.27 एक �लकंर ______ के �लए िज�मेदार होता है।
Ans 1. हेडर फाइ�स को �लकं करने

2. ऑ�जे�ट फाइल� को �लकं करने

3. सोस� फाइल� को �लकं करने

4. �न�पादन एि�ज�यशून के �लए �ड�क से मेमोर� तक लोड करने

Question Type : MCQ
Question ID : 618278426

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.28 एम.एस.-ए�सेल म� CTRL + PAGEUP इस कंुजी संयोजन का उपयोग ______ के �लए �कया जाता है।
Ans 1. दा�हनी बाज ूवाल� अगल� वक� शीट पर जाने के �लए

2. बाये बाज ूवाल� �पछल� वक� शीट पर जाने के �लए

3. एक शीट ऊपर जाने

4. एक शीट नीचे जाने

Question Type : MCQ
Question ID : 618278451

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.29 मान ल� �क ए�सेल शीट म� आपके पास एक टेबल है और E कॉलम म� आपके पास पणूा�क मान (E2 से श�ु) ह�।
य�द नया कंडीशनल फॉम��टगं �ल =$E2>10 लागू �कया जाता है, तो �या होता है?

Ans 1. E कॉलम म� डटेा मान 10 से अ�धक होने पर टेबल क� रोज हाइलाइट हो जाएँगी

2. E कॉलम म� डटेा मान 10 से अ�धक होने पर टेबल क� रोज �छप जाएँगी

3. 10 से अ�धक मान वाले सभी सेल हाइलाइट ह�गे

4. 10 से अ�धक मान वाले कॉलम हाइलाइट हो जाएँगे

Question Type : MCQ
Question ID : 618278460

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.30 एम.एस.-वड� 2016 म�, �रि���टेड ए�सेस का �वक�प ______ के नीचे आता है।
Ans 1. मेन मे�यू

2. फाइल मे�यू

3. ए�डट मे�यू

4. टूल मे�यू
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Question Type : MCQ
Question ID : 618278437

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.31 एम.एस.-वड� म� ALT + CTRL + S यह कंुजी संयोजन ______ को ओपन करता है (खोलता है)।
Ans 1. ��टं लेआउट �यू

2. ��टं ���य ू�यू

3. आउटलाइन �यू

4. टैगल ि��लट ���न

Question Type : MCQ
Question ID : 618278441

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.32 In MS Word, the key combination ALT + SHIFT + K is used to ______.
Ans 1. Print the data source

2. Preview a mail merge

3. Print the labels only

4. Delete mail merge document

Question Type : MCQ
Question ID : 618278448

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.33 य�द आप एम.एस.-ए�सेल 2016 म� �कसी वक� शीट क� �ोटेि�टंग के �लए जात ेह� तो कौनसे ऑ�शन (इनबै�ड
या �डसबै�ड) मौजदू होत ेह�?

Ans 1. रोज़, �वडंो

2. ���चर, रोज़, कॉल�स

3. ���चर, �वडंो

4. रोज़, कॉल�स

Question Type : MCQ
Question ID : 618278464

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.34 USB 4.0 या हाई-�पीड वाला USB ______ क� उ�चतम अतंरण दर को सपोट� करता है।
Ans 1. 400 Mbps

2. 20 Gbps

3. 450 Mbps

4. 40 Gbps
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Question Type : MCQ
Question ID : 618278425

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.35 �वडंोज़ म� �स�टम से�टगं का बदलाव ______ के मा�यम से �कया जाता है।
Ans 1. होम पनैल

2. �स�टम पनैल

3. ओ.एस.(OS) पनैल

4. कं�ोल पनैल

Question Type : MCQ
Question ID : 618278432

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.36 एम.एस.-पॉवरपॉइंट म� कर�ट �लाइड को डुि�लकेट करने के �लए ______ को दबाएँ।
Ans 1. ALT + D

2. CTRL + D

3. F1 + D

4. SHIFT + D

Question Type : MCQ
Question ID : 618278472

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.37 �न�न�ल�खत म� कौन सा कोई �स�टम सॉ�टवेयर नह�ं है?

Ans 1. POST

2. DB2

3. �डवाइस �ाइवर

4. फम�वेयर

Question Type : MCQ
Question ID : 618278427

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.38 एम.एस.-वड� 2016 म� बलेुटेड �ल�ट ______ के नीचे आती है।
Ans 1. टेबल > परैा�ाफ

2. डॉ�यमू�ट > परैा�ाफ

3. होम > परैा�ाफ

4. लेआउट > परैा�ाफ
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Question Type : MCQ
Question ID : 618278440

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.39 एम.एस.-वड� ���न म� आप ज़मू कं�ोलर को कहाँ पात ेह�?
Ans 1. टॉप राइट

2. बॉटम ले�ट

3. बॉटम राइट

4. टॉप ले�ट

Question Type : MCQ
Question ID : 618278436

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.40 कं�यटूर HDD पर एक �व�श�ट नाम वाल� जगह ______ है जो �कसी यज़ूर क� हटाई गई (�डल�ट क� गई)
फ़ाइ�स और फ़ो�डस� को रखता है।

Ans 1. �वडंोज़

2. �शै/र�सायकल �बन

3. मे�यू

4. ड�ेकटॉप

Question Type : MCQ
Question ID : 618278430

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.41 एम.एस.-वड� म� वत�नी और �याकरण जाँच करने के �लए _______ को दबाया जाना चा�हए।
Ans 1. F8

2. F7

3. F6

4. F5

Question Type : MCQ
Question ID : 618278443

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.42 ए�सेल म�, सेल A1 और A2 म� �मशः नंबर 4 और 6 ह�। �न�न�ल�खत फॉमू�ले का �या प�रणाम होगा?

=AVERAGE(A1,A2)
Ans 1. 24

2. 5

3. 2
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4. 10

Question Type : MCQ
Question ID : 618278465

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.43 Resizing rows and columns in MS-EXCEL 2016 can be done through ______.
Ans 1. LAYOUT

2. HOME

3. FORMAT

4. INSERT

Question Type : MCQ
Question ID : 618278454

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.44 मेल-मज� म� कौन-से 2 डॉ�यमू�ट आव�यक होत ेह�?
Ans 1. शयेड� डॉ�यमू�ट और �फ��ड डॉ�यमू�ट

2. मेन डॉ�यमू�ट और डटेा सोस�

3. ए�से और टे��लेट

4. �ॉम डॉ�यमू�ट और टू डॉ�यमू�ट

Question Type : MCQ
Question ID : 618278446

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.45 �न�न�ल�खत म� से कौन सा �वक�प बाक� से अलग है?

Ans 1. डॉट म�ै��स ��टंर

2. �म ��टंर

3. 3D ��टंर

4. लाइन ��टंर

Question Type : MCQ
Question ID : 618278424

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.46 एम.एस.-ए�सेल म� फॉम��टगं सेल ऑ�शन �कसी टे��ट को पवू�प�रभा�षत कोण पर घमूत े�दखने क� अनमु�त
देता है। �ड�ी म� इसक� �वीकृत सीमा �या है?

Ans 1. 0 से 90

2. −45 से 45

3. −90 से 0
ANKAJ INFOTECH



1/27/2020 https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S41D101/157630845450161…

https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S41D101/15763084545016105/193392… 13/16

4. −90 से 90

Question Type : MCQ
Question ID : 618278459

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.47 एम.एस.-ए�सेल 2016 म� �न�न�ल�खत म� से कौनसा एक वधै चाट� का �कार है?

Ans 1. हॉ�रजन

2. �कैटर

3. इ�ल�स

4. ि�वच

Question Type : MCQ
Question ID : 618278468

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.48 एम.एस.-वड� म� कंुजी संयोजन ALT + SHIFT + E का उपयोग ______ के �लए �कया जाता है।
Ans 1. ��टं �कए जाने वाले डॉ�यमू�ट के संपादन (ए�डट)

2. मेल-मज� डटेा सोस� के संपादन (ए�डट)

3. फॉ�ट डायलॉग बॉ�स खोलने के �लए

4. �कसी मेल-मज� �ल�ट को �डल�ट करने

Question Type : MCQ
Question ID : 618278447

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.49 एम.एस.-ए�सेल म� MOD फ़ं�शन का ��तफल �या होता है?

Ans 1. फ़ं�शन को द� गई दो सं�याओ ंके �वभाजन के बाद शषे

2. फ़ं�शन के �लए दो ऑपरै�ड का मॉडरेट म�ूय

3. फं�शन को दो ऑपरै�ड का मॉडन� व�ैयू

4. फ़ं�शन के �लए दो ऑपरै�ड का औसत म�ूय

Question Type : MCQ
Question ID : 618278467

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.50 एम.एस.-ए�सेल 2016 म� �माट�आट� टैब के नीचे �न�न�ल�खत म� से कौनसा एक ऑ�शन नह�ं होता है?

Ans 1. हाइराक�

2. �ल�ट

3. ऑ�डयो

ANKAJ INFOTECH



1/27/2020 https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S41D101/157630845450161…

https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S41D101/15763084545016105/193392… 14/16

4. �प�चर

Question Type : MCQ
Question ID : 618278469

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.51 इस ए�से के ए�से �लास का पता लगाएं।

231.231.231.231
Ans 1. �लास B

2. �लास D

3. �लास C

4. �लास A

Question Type : MCQ
Question ID : 618278479

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.52 एम.एस.-पॉवरपॉइंट म� �लाइड साट�र �य ू______ है।
Ans 1. �लाइ�स के बीच पवू��नधा��रत �डले वाल� �लाइ�स को �ड��ले करने के �लए �य�ुत �कया जाता

2. नॉम�ल �य ूका एक ए�सप�डडे फॉम�

3. �ज�टेशन के �कसी ओवराल �य ूके �लए थंबनेल फॉ�स� म� �लाइ�स को �ड��ले करने के �लए �य�ुत
�कया जाता ह

4. �लाइ�स को छाँटने म� उपयोग �कया जाता

Question Type : MCQ
Question ID : 618278473

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.53 से�स म� समान फामू�ला कॉपी करने के �लए: से�स को �सले�ट करना चा�हए और एक सामा�य तर�के से
फॉमू�ला �लखना चा�हए (जसैा �क आप इसे पहले सेल के �लए कर�गे) और �फर सभी से�स के �लए समान
फॉमू�ला हा�सल करने के �लए ______ को �ेस करना चा�हए।

Ans 1. ALT + ENTER

2. CTRL + ENTER

3. ENTER

4. F7

Question Type : MCQ
Question ID : 618278466

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.54 �ड��ले हो रह� �लाइ�स के च�ज के बीच मोशन इफे�ट ए�लाई करने म� उपय�ुत फ�चर को च�ुनए।
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Ans 1. �लाइड साट�र फ�चर

2. �लाइड �ड��ले फ�चर

3. �लाइड �डजाइन फ�चर

4. �लाइड �ांिजशन फ�चर

Question Type : MCQ
Question ID : 618278474

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.55 एम.एस.-ए�सेल म� �कसी पंि�त (row) क� अ�धकतम ऊँचाई लगभग ______ के बराबर बनाई जा सकती है।
Ans 1. 15 cm

2. 5 cm

3. 20 cm

4. 10 cm

Question Type : MCQ
Question ID : 618278455

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.56 एम.एस.-ए�सेल म� SHIFT + SPACE कंुजी संयोजन का उपयोग ______ के �लए �कया जाता है।
Ans 1. �कसी रो को �सले�ट करने

2. �कसी कॉलम को �सले�ट करने

3. परू� वक� शीट को �सले�ट करने

4. �कसी सेल को �सले�ट करने

Question Type : MCQ
Question ID : 618278452

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.57 एम.एस.-पॉवरपॉइंट म� एक नई �लाइड इ�सट� करने के �लए कोई _______ कंुजी संयोजन का उपयोग कर
सकत ेहै ।

Ans 1. CTRL + C

2. CTRL + V

3. CTRL + M

4. CTRL + B

Question Type : MCQ
Question ID : 618278471

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.58 फाइल, ए�डट, �य ूजसेै �वक�प, ______ पर �कसी �वडंो म� उपल�ध होत ेह�।
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Ans 1. �टेटस बार

2. मे�य ूबार

3. टाइटल बार

4. �रबन

Question Type : MCQ
Question ID : 618278431

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.59 पहला वेब �ाउज़र कहाँ �वक�सत (डवेलप) �कया गया?
Ans 1. सन�, (ि�व�ज़रल�ड)

2. केि��ज, (यनूाइटेड �कंगडम)

3. मसैाचसेु�स इि��ट�यटू ऑफ टै�नोलॉजी, (य ूएस ए)

4. गा�टजेंन, (जम�नी)

Question Type : MCQ
Question ID : 618278480

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.60 कुछ एम.एस.-ए�सेल वज़�न कुछ सामा�य टे��ट ओ�रएंटेशन ऑ�शन ��ततु करत ेह�। �न�न�ल�खत म� कौन
इस संबंध म� अमा�य है?

Ans 1. रोटेट टे��ट हॉ�रजे�टल

2. टे��ट हॉ�रजे�टल

3. टे��ट व�ट�कल

4. टे��ट बॉटम

Question Type : MCQ
Question ID : 618278458

Status : Answered
Chosen Option : 4

Marks : 1.00
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Q.1 एक वक� शीट सेल म� ��तशत को 3 दशमलव अकं� के साथ �द�श�त करने के �लए फॉम�ट �कया जाता है। य�द
उस सेल म� इनपटु मान 123.4567 है तो �द�श�त मान �कतना होगा?

Ans 1. 0.12346

2. 1234.5667

3. 123.4567

4. 0.12344

Question Type : MCQ
Question ID : 618278399

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.2 MS-Word म� __________ दबाकर �पे�लगं और �ामर (�याकरण) जाँच श�ु क� जा सकती है।
Ans 1. F9

2. F3

3. F7

4. F5

Question Type : MCQ
Question ID : 618278383

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.3 MS-Excel 2016 म� एक �ोटे�टेड वक� शीट पर �न�न�ल�खत म� से कौन सा ऑपरेशन �कया जा सकता है?

Ans 1. एक रो इ�सट� करना

2. से�स फॉम��टगं

3. एक कॉलम इ�सट� करना

4. वक� शीट �डल�ट करना

Participant ID 19346939
Participant Name PREM KUMAR YADAV
Test Center Name iON Digital Zone iDZ 2 Patliputra
Test Date 10/12/2019
Test Time 9:00 AM - 10:00 AM
Subject Data Entry Operator
Marks Obtained 16.00000

Section : MCQ for Data Entry Operator
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Question Type : MCQ
Question ID : 618278397

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.4 मेन डॉ�यमू�ट म� डटेा को मिज�ग करने के �लए हम ______ का उपयोग करत ेह�।
Ans 1. डटेा सोस�

2. ए�से सोस�

3. टेबल सोस�

4. �ल�ट सोस�

Question Type : MCQ
Question ID : 618278389

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.5 MS-Excel 2016 म� उपल�ध अ�धकतम रो (पंि�तय� ) क� सं�या �कतनी होती है?

Ans 1. 2,25,786

2. 8,96,425

3. 50,27,490

4. 10,48,576

Question Type : MCQ
Question ID : 618278393

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.6 MS-Excel 2016 म� �र�य ूमे�य ूके अतंग�त �ैक च�जेस म� �सफ�  ______ �वक�प होत ेह�।
Ans 1. 2

2. 3

3. 5

4. 4

Question Type : MCQ
Question ID : 618278404

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.7 �न�न�ल�खत म� से �वषम क� पहचान कर�।
Ans 1. C++

2. Bootstrap (बटू��ैप)

3. JAVA (जावा)

4. Python (पाइथन)
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Question Type : MCQ
Question ID : 618278368

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.8 DLL (डी.एल.एल.) का पणू� �प �या है?

Ans 1. डाइना�मक �लकं लाइ�ेर�

2. डटेाबेस �लकं लाइ�ेर�

3. डाइरे�ट लेयर �लकं

4. डटेाबेस लेयर लाइ�ेर�

Question Type : MCQ
Question ID : 618278374

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.9 �न�न�ल�खत म� से �वषम का चयन कर�।
Ans 1. इंक जेट

2. लेज़र

3. डॉट-म�ै��स

4. टच���न

Question Type : MCQ
Question ID : 618278364

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.10 �न�न�ल�खत �वक�प� म� से �वषम का चयन कर�।
Ans 1. ए�रयल

2. इटै�लक

3. बो�ड

4. अडंरलाइन

Question Type : MCQ
Question ID : 618278380

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.11 MS-Word म� गटर मािज�न श�द ______ इं�गत करता है।
Ans 1. बाइं�डगं साइड म� मािज�न जोड़ना

2. टे��ट का ले�ट और राइट मािज�न एडज�ट करने के �लए मािज�न जोड़ना

3. टे��ट को राइट एडज�ट करने के �लए मािज�न जोड़ना

4. टे��ट को ले�ट एडज�ट करने के �लए मािज�न जोड़ना
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Question Type : MCQ
Question ID : 618278378

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.12 �न�न�ल�खत म� से कौन सा MS-PowerPoint 2016 म� अमा�य (इनव�ैलड) �य ू�वक�प है?

Ans 1. �लाइड सॉट�र

2. र��डगं �यू

3. पेज

4. नॉम�ल

Question Type : MCQ
Question ID : 618278413

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.13 इं���शन (�नद�श) �डकोडर ______ का एक �ह�सा है।
Ans 1. HDD

2. CPU

3. कैश

4. कं�ोलर

Question Type : MCQ
Question ID : 618278361

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.14 ��येक �लाइड को अलग-अलग समय पर ��ततु करने के �लए ______ का उपयोग करत ेह�।
Ans 1. �ज�टेशन टाइ�मगं बटन

2. �लाइड मा�टर

3. �रहस� टाइ�मगं ऑ�शन

4. �लाइड �ांजीशन बटन

Question Type : MCQ
Question ID : 618278412

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.15 MS-Excel 2016 क�टम सेटअप को छोड़कर मािज�न सेट-अप (पेज लेआउट मे�य ूके अतंग�त) के �लए तीन
�वक�प �दान करता है। उनक� पहचान कर�।

Ans 1. ले�ट, राइट, स�टर (बाएं, दाएं, क� �)

2. हाई, लो और मी�डयम (उ�च, �न�न और म�यम)

3. ले�ट, राइट, और �मडल (बाएं, दाएं और म�य)

4. नॉम�ल, वाइड और नरैो (सामा�य, चौड़ा और संकरा)
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Question Type : MCQ
Question ID : 618278394

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.16 नया समय और �दनांक �नधा��रत करने के �लए आप ______ का उपयोग कर सकत ेह�।
Ans 1. फ़ाइल मे�यू

2. इ�सट� मे�यू

3. कं�ोल पनैल

4. टू�स मे�यू

Question Type : MCQ
Question ID : 618278372

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.17 �ॉ�सी सव�र �न�न�ल�खत म� से कौन सी सेवा �दान नह�ं करता है?

Ans 1. डटेा कै�शगं

2. नेटवक�  कने�शन शये�रगं

3. TCP/IP

4. फ़ायरवॉल और नेटवक�  डटेा �फ़�ट�रगं

Question Type : MCQ
Question ID : 618278418

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.18 MS-Word 2016 ���न लेआउट के ऊपर� बाएं कोने म� मे�य ूबटन है िजसे ______ कहा जाता है।
Ans 1. होम

2. टू�स

3. फ़ाइल

4. मे�यू

Question Type : MCQ
Question ID : 618278376

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.19 MS-Excel म� फै�ट फ़ं�शन _______ �ेणी का है।
Ans 1. इनफॉम�शन (सचूना)

2. लॉिजकल (ता�क� क)

3. मथै एंड ���नॉमे�� (ग�णत और ��कोण�मतीय)

4. डटेाबेस
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Question Type : MCQ
Question ID : 618278407

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.20 MS-Word डॉ�यमू�ट म� एक टेबल इ�सट� करने के �लए _______ मे�य ूपर ि�लक करना चा�हए।
Ans 1. होम

2. टू�स

3. इ�सट�

4. पेज लेआउट

Question Type : MCQ
Question ID : 618278384

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.21 MS-Excel 2016 वक� शीट क� संरचना क� सरु�ा के �लए, _____टैब पर ि�लक करने के बाद �ोटे�ट �वक�प
का चयन करना चा�हए।

Ans 1. डटेा

2. �र�यू

3. टेब�स

4. होम

Question Type : MCQ
Question ID : 618278396

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.22 MS-Excel म� आपके �वारा खोले और काम �कए गए मौजदूा वक� शीट म� �कए गए प�रवत�न� को सेव करने के
�लए �न�न�ल�खत म� से कौन सा �वक�प सह� नह�ं है?

Ans 1. ALT + S

2. फ़ाइल/ऑ�फस मे�य ूके अतंग�त सेव का �वक�प

3. सेव आइकन (�लॉपी �ड�क का �तीक) पर ि�लक कर�

4. CTRL + S

Question Type : MCQ
Question ID : 618278391

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.23 MS-Word डॉ�यमू�ट म� संपणू� टे��ट और इमजै के चयन के �लए ______ का उपयोग करना चा�हए।
Ans 1. CTRL + E

2. SHIFT + A

3. CTRL + A

4. F1
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Question Type : MCQ
Question ID : 618278382

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.24 MS-Word 2016 म� फ़ाइल को पासवड� से सरु��त करने के �लए ________ पर ि�लक करना चा�हए।
Ans 1. �य ूमे�यू

2. होम मे�यू

3. टू�स मे�यू

4. फ़ाइल मे�यू

Question Type : MCQ
Question ID : 618278379

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.25 MS-Excel 2016 म� �ोटे�ट/अन�ोटे�ट �वक�प ______ मे�य ूके अतंग�त उपल�ध होता है।
Ans 1. �र�यू

2. ए�डट

3. होम

4. डटेा

Question Type : MCQ
Question ID : 618278403

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.26 MS-Excel 2016 के �माट� आट� के अतंग�त �परा�मड एक �वक�प होता है। �कतने �कार के �परा�म�स
उपल�ध होत ेह�?

Ans 1. 3

2. 2

3. 4

4. 1

Question Type : MCQ
Question ID : 618278409

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.27 MS-Excel म� कंजे�य�ूटव रो के कई स�ू� को दसूर� जगह म�ट�पल रो म� कॉपी करने के �लए ______ ।
Ans 1. वां�छत रो का चयन कर� और CTRL + F के बाद CTRL + P दबाएं

2. वां�छत रो का चयन कर� और CTRL + V के बाद CTRL + C दबाएं

3. वां�छत रो का चयन कर� और CTRL + A के बाद CTRL + V दबाएं
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4. वां�छत रो का चयन कर� और CTRL + C के बाद CTRL + V दबाएं

Question Type : MCQ
Question ID : 618278406

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.28 Windows XP होम वज�न (सं�करण) के �लए �न�न�ल�खत म� से कौन सी स�ुवधा उपल�ध नह�ं होती है?

Ans 1. ऑटोम�ैटक सॉ�टवेयर इं�टालेशन एंड म�टेने�स

2. वायरलेस कने�शन

3. फा�ट �टाट� अप

4. हे�प स�टर

Question Type : MCQ
Question ID : 618278370

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.29 MS-PowerPoint म� �लाइड शो �य ूम� अगल� �लाइड पर जाने के �लए ________ का उपयोग करत ेह�।
Ans 1. राइट एरो क�

2. F1

3. P

4. N

Question Type : MCQ
Question ID : 618278415

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.30 हाड�वेयर �डवाइस को ______ के मा�यम से जोड़ा जा सकता है।
Ans 1. मेन मे�यू

2. फ़ाइल मे�यू

3. �डवाइस मे�यू

4. कं�ोल पनैल

Question Type : MCQ
Question ID : 618278371

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.31 �कसी ��त�ुत म� सभी �लाइ�स के �लए एक ह� ि�थ�त म� अपने आप �द�श�त होने वाले ऑग�नाइजेशन
(संगठन) का लोगो �ा�त करने के �लए लोगो को ______ म� डालना चा�हए।

Ans 1. नो�स मा�टर

2. ह�डआउट मा�टर

3. चाट� मा�टर
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4. �लाइड मा�टर

Question Type : MCQ
Question ID : 618278411

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.32 MS-Word म� राइट मािज�न को अनदेखा करत ेहुए जब आप एक लंबे श�द को लगातार टाइप करत ेरहत ेह� तो
�या होता है?

Ans 1. जो श�द �फट नह�ं होता है वह अपने आप अगल� पंि�त म� चला जाता है

2. नए वण� का इनपटु �लॉ�ड (अव��) होता है

3. एक वा�न�ग (चेतावनी) उ�प�न होती है

4. लाइन और बड़ी हो जाती है

Question Type : MCQ
Question ID : 618278377

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.33 ______ MS-PowerPoint म� �डफ़ॉ�ट पेज ओ�रएंटेशन है।
Ans 1. ल�ड�केप

2. राइट-�ल�टेड

3. पो��ट

4. ले�ट-�ल�टेड

Question Type : MCQ
Question ID : 618278414

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.34 MS-Excel वक� शीट सेल म� फ़ॉ�ट आकार �ॉप-डाउन सचूी से �कस अ�धकतम फ़ॉ�ट साइज का चयन �कया
जा सकता है?

Ans 1. 72

2. 36

3. 204

4. 172

Question Type : MCQ
Question ID : 618278401

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.35 टे��ट के �लए �न�न�ल�खत म� से कौन सा सेल फॉम��टगं �वक�प MS-Excel म� उपल�ध नह�ं है?

Ans 1. इटै�लक

2. बो�ड
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3. �लांटेड-इटै�लक

4. बो�ड-इटै�लक

Question Type : MCQ
Question ID : 618278402

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.36 मेमोर� �डवाइसेस को जोड़ने के �लए आमतौर पर �न�न�ल�खत म� से �कस बस (BUS) का उपयोग �कया जाता
है?

Ans 1. RTI

2. CBI

3. PCI

4. RPI

Question Type : MCQ
Question ID : 618278362

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.37 MS-Word म� चय�नत टे��ट म� सभी फॉम��टगं को साफ करने के �लए _______ का उपयोग करना चा�हए।
Ans 1. CTRL + SPACEBAR (�पेस बार)

2. SHIFT + F3

3. SHIFT + F5

4. CTRL + V

Question Type : MCQ
Question ID : 618278381

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.38 कन�ल ________ है।
Ans 1. एक I/O कं�ोलर (�नयं�क)

2. CPU

3. ऑपरे�टगं �स�टम का म�य भाग

4. हाड�वेयर के अदंर का नरम �ह�सा

Question Type : MCQ
Question ID : 618278367

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.39 USB 2.0 _______ के उ�चतम अतंरण दर को सपोट� करता है।
Ans 1. 400 Mbit/s

2. 480 Mbit/s
ANKAJ INFOTECH



1/27/2020 https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S40D74/1576308483033357…

https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S40D74/15763084830333578/1934693… 11/16

3. 380 Mbit/s

4. 450 Mbit/s

Question Type : MCQ
Question ID : 618278365

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.40 सेल साइज के अतंग�त एक रो का फॉम��टगं करत ेसमय “रो हाइट” के अलावा MS-Excel 2016 म�
�न�न�ल�खत म� से कौन सा �वक�प भी उपल�ध होता है?

Ans 1. बोथ साइड एडज�ट

2. राइट एडज�ट

3. ऑटो�फट रो हाइट

4. ले�ट एडज�ट

Question Type : MCQ
Question ID : 618278400

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.41 फ़ाइल ऑग�नाइजेशन _______ से संबं�धत है।
Ans 1. फ़���स क� �फिजकल ���चर (भौ�तक संरचना)

2. �रका��स क� लॉिजकल ���चर (ता�क� क संरचना)

3. फ़���स क� लॉिजकल ���चर (ता�क� क संरचना)

4. �रका��स क� �फिजकल ���चर (भौ�तक संरचना)

Question Type : MCQ
Question ID : 618278373

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.42 WWW �ाउिज़ंग के �लए _______ �ोटोकॉल का उपयोग �कया जाता है।
Ans 1. snmp

2. http

3. ftp

4. smtp

Question Type : MCQ
Question ID : 618278417

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.43 MS-Excel 2016 म� होम मे�य ूके अतंग�त नंबर समहू म� अनपुल�ध �वक�प कौन सा है?

Ans 1. परस�ट �टाइल

2. �ड��ज डसेीमल
ANKAJ INFOTECH
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3. डसेीमल पॉइंट �टाइल

4. कॉमा �टाइल

Question Type : MCQ
Question ID : 618278398

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.44 मेल मज� म� सेले�ट �टा�ट�ग डॉ�यमू�ट म� तीन ऑ�शन होत ेह�। इनक� पहचान कर�।
Ans 1. यजू कर�ट डॉ�यमू�ट, �टाट� �ॉम टे�पलेट, �टाट� �ॉम एन इि�ज़ि�टंग डॉ�यमू�ट (कर�ट डॉ�यमू�ट

�योग कर�, टे�पलेट से श�ु कर�, मौजदू डॉ�यमू�ट से श�ु कर�)

2. यजू ओ�ड डॉ�यमू�ट, �टाट� यिूजंग ए लटैर, यजू कर�ट डॉ�यमू�ट

3. मे�लगं लेबल, डायरे���ज, यजू �ल��स

4. लेटस�, फाइ�स, टे�पले�स

Question Type : MCQ
Question ID : 618278386

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.45 �न�न�ल�खत म� से कौन MS-Excel 2016 म� �माट� आट� के अतंग�त एक व�ैलड (वधै) साइकल �वक�प नह�ं
है?

Ans 1. टे��ट साइकल

2. म�ट�-डायरे�शनल साइकल

3. �ेक साइकल

4. �गयर

Question Type : MCQ
Question ID : 618278410

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.46 य�द हम �न�न�ल�खत सचूी का चयन करत ेह�: 
0 0
1 1
2 4
3 9
और एक �मथू लाइन (सरल रेखा) �कैटर चाट� बनात ेह� तो �फर Excel (ए�सेल) शीट म� व� का आकार �या
होगा?

Ans 1. एक द�घ�व�ृत

2. एक परवलय

3. एक सीधी रेखा

4. एक व�ृत

Question Type : MCQ
Question ID : 618278408

Status : Answered
Chosen Option : 1ANKAJ INFOTECH
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Marks : 0.00

Q.47 एक क�पाइलर आमतौर पर _______ फेजेज का उपयोग सोस� फ़ाइल को मशीन कोड म� बदलने के �लए
करता है।

Ans 1. 4

2. 3

3. 2

4. 6

Question Type : MCQ
Question ID : 618278369

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.48 �न�न�ल�खत �वक�प� म� से �वषम क� पहचान कर�।
Ans 1. FTP

2. SAP

3. HTTP

4. SMTP

Question Type : MCQ
Question ID : 618278420

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.49 �न�न�ल�खत म� से कौन सा �डवाइस (उपकरण) गे�मगं परपज (उ�े�य) के �लए अ�धकतर उपयोग �कया जाता
है?

Ans 1. टच ���न

2. क�बोड�

3. जॉयि�टक

4. माउस

Question Type : MCQ
Question ID : 618278363

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.50 टेल�फोन लाइन का उपयोग करके इंटरनेट कने�शन के �लए आपको _____ क� आव�यकता होती है।
Ans 1. USB केबल

2. मोडम

3. ��टंर

4. UPS

Question Type : MCQ
Question ID : 618278416

Status : AnsweredANKAJ INFOTECH
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Chosen Option : 4
Marks : 0.00

Q.51 MS-Excel वक� शीट म� सेल के बाहर एक टे��ट ओवर�लो इ�य ूको ________ �वक�प के साथ �बं�धत
�कया जा सकता है।

Ans 1. टे��ट वा�प�ग

2. टे��ट राइट एडज�टम�ट

3. टे��ट एलाइनम�ट

4. टे��ट रै�पगं

Question Type : MCQ
Question ID : 618278392

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.52 MS-Excel म� फॉमू�लाज के अतंग�त कौन सा लॉिजकल ऑपरेशन (ता�क� क ��या) उपल�ध नह�ं है?

Ans 1. ELSE

2. OR

3. NOT

4. AND

Question Type : MCQ
Question ID : 618278405

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.53 एक लोडर ______ के �लए िज�मेदार होता है।
Ans 1. ऑ�जे�ट फ़ाइ�स क� �ल�ंकंग

2. हेडर फ़ाइ�स क� लो�डगं

3. सोस� (�ोत) फ़ाइ�स क� ए�ड�टगं (संपादन)

4. ए�जी�यशून (�न�पादन) के �लए �ड�क से मेमोर� तक �ो�ाम कोड क� लो�डगं

Question Type : MCQ
Question ID : 618278366

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.54 मेन मेल-मज� डो�यमू��स �या ह�?
Ans 1. डाइरे�टर�, लेटर, एनवेलप, लेब�स, ई-मे�स

2. टेब�स, �ल��स, लेटस�, परैा�ा�स

3. फॉम�, लेटर, डॉ�यमू�ट, �ल�ट

4. मे�लगं लेब�स, फाइ�स, �ड�शनर�एस, लेटस�

Question Type : MCQ
Question ID : 618278385
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Status : Answered
Chosen Option : 2

Marks : 0.00

Q.55 MS-Excel म� �डफ़ॉ�ट मान से �तंभ क� चौड़ाई को 2.0 cm करने के �लए _______।
Ans 1. कॉलम हे�डगं पर माउस को राइट ि�लक कर� और �फर वां�छत मान डालने के �लए कॉलम �व�थ

�वक�प का चयन कर�

2. सेल पर माउस को ले�ट ि�लक कर� और �गै कर�

3. सेल पर माउस को राइट ि�लक कर� और �गै कर�

4. कॉलम पर माउस को राइट ि�लक कर� और �गै कर�

Question Type : MCQ
Question ID : 618278395

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.56 मेल मज� के संबंध म� �न�न�ल�खत म� से कौन सा एक लेबल म� �डफ़ॉ�ट फ़��ड नह�ं है?

Ans 1. �सट�

2. �पन

3. ला�ट नेम

4. ईमेल ए�से

Question Type : MCQ
Question ID : 618278388

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.57 MS-Word श�ु करने के �लए �न�न�ल�खत म� से कौन सी वधै �व�ध है?

Ans 1. ड�ेकटॉप पर MS-Word आइकॉन पर �सगंल ि�लक करना

2. MS-Word आइकॉन का चयन करे और �डल�ट क� दबाएं

3. MS-Word आइकॉन पर राइट ि�लक कर� और बकै �पेस क� दबाएं

4. ड�ेकटॉप पर MS-Word आइकॉन पर डबल ि�लक कर�

Question Type : MCQ
Question ID : 618278375

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.58 202.121.75.96 यह एक _______ आई.पी. ए�से है।
Ans 1. �लास B

2. �लास C

3. �लास D

4. �लास A

Question Type : MCQ
ANKAJ INFOTECH



1/27/2020 https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S40D74/1576308483033357…

https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S40D74/15763084830333578/1934693… 16/16

Question ID : 618278419
Status : Answered

Chosen Option : 2
Marks : 1.00

Q.59 �न�न�ल�खत म� से कौन मेल मज� म� एक अमा�य डटेा �ोत है?

Ans 1. अदर डटेाबेस फ़ाइ�स

2. ए�सेल ��ेडशीट

3. ए�सेस डटेाबेस

4. पावर पॉइंट

Question Type : MCQ
Question ID : 618278387

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.60 MS-Excel ���न पर वक� शीट का नाम कहाँ �द�श�त होत ेह�?
Ans 1. टॉप राइट (ऊपर दाएं)

2. बॉटम ले�ट (नीचे बाएं)

3. बॉटम राइट (नीचे दाएं)

4. टॉप ले�ट (ऊपर बाएं)

Question Type : MCQ
Question ID : 618278390

Status : Answered
Chosen Option : 1

Marks : 0.00
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Q.1 आप MS-Word 2016 म� मेल मज� का उपयोग करके लेबल ��टं करना चाहत ेह�। अतं म�, जब लेबल जसैा आप
चाहत ेह� वसैा �दखता तो है , Mailings → _________ → Print Documents पर जाएँ।

Ans 1. �य ूलेब�स

2. अपडटे लेब�स

3. चेक �रका��स

4. �फ�नश एंड मज�

Question Type : MCQ
Question ID : 618278688

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.2 �कसी वक� शीट म� चय�नत �तंभ को �छपाने के �लए, MS-Excel म� �कस शॉट�कट कंुजी का �योग �कया जाता
है?

Ans 1. Alt + H

2. Ctrl + H

3. Shift + H

4. Ctrl + 0 (zero)

Question Type : MCQ
Question ID : 618278692

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.3 एक MS-Excel वक� शीट म�, �तंभ L �दखाई नह�ं देता है। आप इस �तंभ को �कस �कार देखने यो�य बना
सकत ेह�?

Ans 1. �तंभ M का चयन कर� और Insert > Column > Left का �योग कर�।

2. �तंभ M चनु�, �तंभ M लेबल क� दा� सीमा पर कस�र को रख� और माउस को खींच� (�गै कर�)।

Participant ID 19329720
Participant Name SUJEET KUMAR
Test Center Name iON Digital Zone iDZ 2 Patliputra
Test Date 16/12/2019
Test Time 3:00 PM - 4:00 PM
Subject Data Entry Operator
Marks Obtained 24.00000

Section : MCQ for Data Entry Operator
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3. �तंभ K चनु�, �तंभ K लेबल क� दा� सीमा पर कस�र को रख� और माउस को खींच� (�गै कर�)।

4. �तंभ K और M चनु�, �तंभ M लेबल क� दा� सीमा पर कस�र को रख� और माउस को खींच� (�गै कर�)।

Question Type : MCQ
Question ID : 618278695

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.4 MS-Excel 2016 म� �न�न म� से कौन सा कमांड बटन फ़ॉम��टगं टूलबार का भाग नह�ं है?

Ans
1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 618278698

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.5 MS-Word 2016 म� ��टं कमांड का उपयोग करके म�ुण हेत ुप�ृठ� का चयन करने के �लए �न�न�ल�खत म� से
कौन एक मा�य �वक�प नह�ं है?

Ans 1. पेज र�ज

2. कर�ट पेज

3. ऑल

4. ने��ट पेज

Question Type : MCQ
Question ID : 618278679

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.6 Windows XP म�, आपक� ���न के नीचे-बाएँ कोने म� �ारंभ (Start) बटन आपको MS-Word स�हत आपके
�नजी कं�यटूर (PC) के सभी �ो�ाम� तक पहँुच �दान करता है। MS-Word श�ु करने के �लए, Start → All
Programs → _________ → MS-Word चनु�।

Ans 1. ऍि�लकेश�स

2. टा�कस

3. MS-Office

4. फ़ो�डस�

Question Type : MCQANKAJ INFOTECH
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Question ID : 618278675
Status : Answered

Chosen Option : 3
Marks : 0.00

Q.7 एक ��ेडशीट म� __________ जोड़ने के बाद, आप योजक रेखाओ ं(कने�टर लाइंस) को जोड़कर, शलै� को
बदलकर, एक दप�ण छ�व को जोड़कर, रंग बदलकर, और कई अ�य �भाव जसेै �क छाया, चमक और 3-डी को
लागू कर इसे बदल सकत ेह�।

Ans 1. �माट�आट�

2. �च� (�प�चर)

3. आइकॉन

4. आकृ�त (शपे)

Question Type : MCQ
Question ID : 618278709

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.8 MS-Excel म� संपणू� वक� शीट को कॉपी करने के �लए:

Ans 1. a) कॉपी �कए जाने वाले वक� शीट के शीट टैब को चनु�
b) Choose Workbook > Worksheet > Copy

2. a) कॉपी �कए जाने वाले वक� शीट के शीट टैब पर दाएँ -ि�लक कर�
b) कॉपी चनु�।

3. a) कॉपी �कए जाने वाले वक� शीट के शीट टैब को चनु�
b) Choose File > Worksheet > Copy

4. a) कॉपी �कए जाने वाले वक� शीट के शीट टैब पर दाएँ-ि�लक कर�
b) मवू या कॉपी चनु�।

Question Type : MCQ
Question ID : 618278690

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.9 Windows 10 म� फ़ाइल� को खोलने के �लए �डफ़ॉ�ट �ो�ाम म� प�रवत�न हेत ुपहला चरण �न�न�ल�खत म� से
�या होगा?

Ans 1. Left-click on filename > Properties > Opens With

2. Left-click on filename > Open with > Choose another app

3. Right-click on filename > Create Shortcut > Opens With

4. Right-click on filename > Properties > Opens With

Question Type : MCQ
Question ID : 618278672

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.10
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Ans 1. (i) – (c), (ii) – (a), (iii) – (b), (iv) – (d)

2. (i) – (a), (ii) – (b), (iii) – (c), (iv) – (d)

3. (i) – (c), (ii) – (b), (iii) – (a), (iv) – (d)

4. (i) – (b), (ii) – (a), (iii) – (c), (iv) – (d)

Question Type : MCQ
Question ID : 618278713

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.11 अन�ुयोग (ए�ल�केशन) सॉ�टवेयर के संबंध म� �न�न�ल�खत म� से कौन सा कथन सह� है?

Ans 1. यह उपयोगकता�ओ ंके �व�श�ट काय� के �लए बनाया गया है।

2. यह �णाल� (�स�टम) के बंद होने पर ह� चलता है।

3. कं�यटूर इसके �बना काम नह�ं कर सकता।

4. यह हमेशा �स�टम के चाल ू�कए जाने पर काय� करना श�ु करता है।

Question Type : MCQ
Question ID : 618278666

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.12 MS-PowerPoint म�, �वचार कर� �क आपके पास 10 �लाइड ह� और आपने �लाइड 5 का चयन �कया है।
“ctrl” + “end” ि�लक करने पर आप _________ पर पहँुच जाएँगे।

Ans 1. �लाइड 5 क� अ�ंतम पंि�त

2. �लाइड 6

3. �लाइड 1

4. �लाइड 10

Question Type : MCQ
Question ID : 618278715

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.13 �न�न�ल�खत म� से कौन एक आउटपटु उपकरण (�डवाइस) नह�ं है?

Ans 1. माइ�ोफ़ोन
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2. मॉ�नटर

3. �लॉटर

4. �पीकर

Question Type : MCQ
Question ID : 618278663

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.14 MS-Word का उपयोग कर तयैार क� गई �रपोट� म� टे��ट क� कुछ �भ�न �े�णयां होने क� संभावना होती है जो
थोड़ी अलग �दखाई देनी चा�हए, इनम� शा�मल ह� : 

म�ुय टे��ट (��येक अन�ुछेद म� श�द)
हे�डगं और सबहे�डगं 
अ�याय का शीष�क
अव��-बंद उ�रण (�लॉक-ऑफ़ को�स)
एव ंअ�य।

इन '�े�णय�' को _________ कहा जाता है।
Ans 1. गुण (�ॉपट�ज)

2. शलै� (�टाइल)

3. �व�प (फ़ॉम�ट)

4. फ़ॉम�ट प�टर

Question Type : MCQ
Question ID : 618278683

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.15

Ans 1. �ॉ �य ूबलेुट

2. �डफाइन �य ूबलेुट

3. इंसट� बलेुट

4. च�ज बलेुट

Question Type : MCQ
Question ID : 618278681

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.16 स��ल �ोसे�सगं य�ूनट (CPU) के बारे म� �न�न�ल�खत म� से कौन सा कथन सह� नह�ं है?

Ans 1. मेमोर� म� डाटा और �नद�श दोन� पकड़ ेहोती ह�।

2. रिज�टर CPU के भीतर डाटा के �वाह को �नयं��त करत ेह�।

3. अकंग�णतीय तक�  इकाई (ALU) CPU का एक मह�वपणू� �ह�सा है।
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4. इनपटु बस के मा�यम से CPU म� आता है।

Question Type : MCQ
Question ID : 618278662

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.17 �न�न�ल�खत म� से कौन सी MS-Excel स�ुवधा एक साथ फॉ�ट आकार, रंग �व�पण, सेल बॉड�र, छाया�भाव
(श�ेडगं) इ�या�द �योग करने म� मदद करती है?

Ans 1. सेल �टाइ�स

2. ता�लका के �प म� फ़ॉम�ट कर�

3. सशत� �व�पण (कंडीशनल फ़ॉम��टगं)

4. से�स फ़ॉम�ट कर�

Question Type : MCQ
Question ID : 618278702

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.18 TCP/IP �ोटोकॉल म� TCP के �लए गलत कथन क� पहचान कर�।
Ans 1. �ोत पर संदेश को पकेैट� के एक सम�ुचय म� �पांत�रत करता है

2. नेटवक�  पर पकेैट� का �ेषण �बं�धत करता है

3. स�ुनि�चत करता है �क �ेषक से �ा�तकता� तक भेजे गए संदेश ठ�क से पहँुचाए गए ह� या नह�ं

4. �व�वसनीय प�रवहन सेवा �दान करता है

Question Type : MCQ
Question ID : 618278718

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.19 MS-Word द�तावेज़ म� फ़ुटनोट जोड़ने के �लए, आपको _________ म� उपय�ुत �वक�प �मलेगा।
Ans 1. इ�सट� मेनू

2. रेफर�स मेनू

3. �र�य ूमेनू

4. लेआउट मेनू

Question Type : MCQ
Question ID : 618278676

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.20 मेल मज� म�, मज� द�तावेज़ _________ और डाटा �ोत का एक संयोजन होता है।
Ans 1. मज� �े�

2. म�ुय द�तावेज़
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3. मज� द�तावेज़

4. डाटा �ोत

Question Type : MCQ
Question ID : 618278689

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.21 जब आप अपने द�तावेज़ बनाने के �लए �योग �कए जाने वाले सं�करण क� तलुना म� MS-Word के नए
सं�करण का उपयोग करत ेह�, तो आपको आमतौर पर शीष�क प�ी (टाइटल बार) म� _________ मोड �दखता
है। 

Ans 1. पवू�वत� (�ी�वयस)

2. पवू� (अ�ल�यर)

3. परुाना सं�करण (ओ�ड वज�न)

4. संगतता (क�पटै�बलट�)

Question Type : MCQ
Question ID : 618278677

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.22 मानक टूलबार या इंसट� टैब पर इंसट� टेबल बटन MS-Word द�तावेज़ म� ता�लका जोड़ने के सबसे तज़े तर�क�
म� से एक है। य�द आप बटन पर ि�लक करत ेह�, तो बटन के नीचे एक बॉ�स �व�ता�रत होता है, िजसम� छोटे
बॉ�स होत ेह�। अपने माउस को उतने से�स तक ले जाएँ, िज�ह� आप द�तावेज़ म� सि�म�लत करना चाहत ेह�।
�यान द� �क जब आप माउस को इनके ऊपर ले जात ेह� तो सेल _________ बदल जाता है। 

Ans 1. �व�प

2. आकार

3. आकृ�त

4. रंग

Question Type : MCQ
Question ID : 618278684

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.23 MS-PowerPoint म� गलत पवू��नधा��रत टे��ट �दशा क� पहचान कर�।
Ans 1. �टै�ड (Stacked)

2. ह��ड (Heaped)

3. �ै�तज (Horizontal)

4. घमुाएँ (Rotate)

Question Type : MCQ
Question ID : 618278711

Status : Answered
Chosen Option : 2

Marks : 1.00
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Q.24 �न�न�ल�खत म� से �कसे सॉ�टवेयर माना जाता है?

Ans 1. अकंग�णतीय तक�  इकाई

2. हाड� �ड�क �नयं�क

3. ऑपरे�टगं �स�टम

4. र�ड ऑनल� ममैोर� (ROM)

Question Type : MCQ
Question ID : 618278661

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.25 अ�य उपयोगकता�ओ ंको गलती से या जानबझूकर �कसी वक� शीट म� डाटा को बदलने, �थानांत�रत करने या
हटाने से रोकने के �लए, आप अपने MS-Excel वक� शीट पर उन से�स को लॉक कर सकत ेह� जो उ�ह� गलती से
संशो�धत करने से बचाएँगे। इस संदभ� म�, �न�न�ल�खत म� से ग�त�व�धय� का कौन सा �म अपनाया जाना
चा�हए?

Ans 1. सरु��त करने के �लए से�स के परास (र�ज) का चयन कर� और इसके बाद Worksheet > Range >

Lock का चयन करे

2. पहले उन से�स के लॉक खोल� िज�ह� दसूरे लोग संपा�दत कर सकत ेह� और �फर पासवड� के साथ या
उसके �बना वक� शीट को सरु��त कर सकत ेह�।

3. सरु��त करने के �लए से�स के परास (र�ज) का चयन कर� और इसके बाद Worksheet > Range >

Protect का चयन कर�

4. पहले वक� शीट को पासवड� के साथ या उसके �बना सरु��त कर� और �फर उन से�स के लॉक खोल�
िज�ह� दसूरे लोग संपा�दत कर सकत ेह�।

Question Type : MCQ
Question ID : 618278693

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.26 ______________ एक लोक��य ऑ�जे�ट-ओ�रएंटेड �ो�ा�मगं भाषा है।
Ans 1. COBOL

2. FORTRAN

3. C++

4. BASIC

Question Type : MCQ
Question ID : 618278668

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.27 POP सव�र के संबंध म� गलत कथन का चयन कर�।
Ans 1. यह पोट� 110 पर कने�ट होता है

2. उपयोगकता� ई-मेल संदेश� को सीधे ई-मेल सव�र पर हेरफेर करता है

3. यह �लाइंट के �लए दरू�थ सव�र पर ई-मेल सं��हत करता है

4. ई-मेल संदेश POP3 सव�र से �लाइंट कं�यटूर पर डाउनलोड �कए जात ेह�
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Question Type : MCQ
Question ID : 618278720

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.28

Ans 1. (a, iv), (b, i), (c, ii), (d, iii)

2. (a, iii), (b, i), (c, ii), (d, iv)

3. (a, iii), (b, iv), (c, i), (d, ii)

4. (a, iv), (b, ii), (c, i), (d, iii)

Question Type : MCQ
Question ID : 618278665

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.29 MS-PowerPoint म�, ‘Slide Size’ ______ मेन ूम� पाया जाता है।
Ans 1. �र�यु

2. एनीमेशन

3. �ांजीशन

4. �लाइड �डज़ाइन

Question Type : MCQ
Question ID : 618278712

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.30

Ans 1. (a, iv), (b, iii), (c, ii), (d, i)

2. (a, ii), (b, i), (c, iv), (d, ii)

3. (a, iii), (b, i), (c, iv), (d, ii)

4. (a, i), (b, iii), (c, iv), (d, ii)

Question Type : MCQ
Question ID : 618278710

Status : Answered
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Chosen Option : 1
Marks : 0.00

Q.31

Ans 1. 8

2. 24

3. 12

4. 18

Question Type : MCQ
Question ID : 618278706

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.32 मेल मज� सचूी के साथ द�तावेज क� �डजाइन संयोिजत करने क� ���या है, ता�क सचूी म� ��येक ��वि�ट के
�लए द�तावेज क� कई ��तया ँबनाई जा सक� ,इसे कहत ेह�:

Ans 1. डाटा ता�लका (टेबल)

2. डाटा �ोत

3. डाटा फॉम�

4. डाटा सचूी

Question Type : MCQ
Question ID : 618278686

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.33 जब �कसी �नि�चत समय तक कोई उपयोगकता� ग�त�व�ध नह�ं होती है तो �नजी कं�यटूर पर एक ए�नमेटेड
छ�व �दखती है िजसे _________ कहा जाता है। ���नसेवर का म�ुय उ�े�य बन�-इन (समान छ�व के पनुः
�कैन �कए जाने के घंट� बाद कैथोड रे �यबू के भीतर फ़ो�फ़र म� छ�व को बन� करना)।

Ans 1. ड�ेकटॉप

2. प�ृठभ�ूम (बकै�ाउंड)

3. ए�स�लोरर

4. ���नसेवर

Question Type : MCQ
Question ID : 618278671

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.34 �न�न�ल�खत म� से कौन सी तकनीक एक-दसूरे के नजद�क ि�थत दो या दो से अ�धक �डवाइओ ंके बीच सचूना
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को �थानांत�रत करने के �लए उपयोगी है?

Ans 1. �लटूूथ

2. वाई-फ़ाई

3. 4G

4. RFID

Question Type : MCQ
Question ID : 618278664

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.35 __________ चाट� समान �प से �व�ध�त अ� पर समय के साथ सतत डाटा �दखा सकत ेह�, इस�लए वे
मह�न�, �तमा�हय� या �व�तीय वष� जसेै समान अतंराल पर डाटा के �झान �दखाने के �लए उपय�ुत ह�।

Ans 1. बार

2. X-Y

3. �तंभ (कॉलम)

4. रेखा (लाइन)

Question Type : MCQ
Question ID : 618278708

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.36 '�ोटे�ट वक� बकु' का फं�शन �या है?

Ans 1. यह वक� बकु को कॉपीराइट से बचाता है।

2. यह वक� बकु को हटाए जाने से बचाता है। 

3. यह वक� शी�स को जोड़ने, हटाने या �थानांत�रत करने से रोकता है। 

4. यह एक वक� बकु को समाि�त से बचाता है।

Question Type : MCQ
Question ID : 618278703

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.37 आप MS-Excel वक� शीट क� एक �वशषे पंि�त म� सभी से�स के फ़ॉ�ट रंग को बदलकर ह�का नीला करना
चाहत ेह�। उपय�ुत पंि�त का चयन करने के बाद, इस काय� को करने के �लए आप �न�न�ल�खत म� से कौन सी
स�ुवधा (फ़�चर) का उपयोग नह�ं कर�गे?

Ans 1. ‘Font Color’ का �योग

2. ‘Cell Styles’ का �योग

3. ‘Fill Color’ का �योग

4. Format > Format Cells > Font का �योग

Question Type : MCQ
Question ID : 618278701

Status : Answered
Chosen Option : 4ANKAJ INFOTECH
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Marks : 0.00

Q.38 यह �नयं��त करने के �लए �क उपयोगकता� आपक� वक� बकु क� संरचना के अदंर वक� शी�स के साथ �कस तरह
से काय� कर�, इसके �लए, �न�न म� से �कसका उपयोग करना चा�हए?

Ans 1. फ़ाइल �तर क� सरु�ा

2. फ़ाइल �तर और वक� बकु �तर सरु�ा का एक संयोजन

3. वक� बकु �तर क� सरु�ा

4. वक� शीट �तर क� सरु�ा

Question Type : MCQ
Question ID : 618278704

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.39 �न�न�ल�खत म� से कौन अन�ुयोग (ए�ल�केशन) सॉ�टवेयर का उदाहरण नह�ं है?

Ans 1. Oracle

2. Ubuntu

3. MS-Office

4. SAP

Question Type : MCQ
Question ID : 618278667

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.40 उस संयोजन क� पहचान कर� जो �ॉडब�ड का उपयोग नह�ं करता है।
Ans 1. केबल

2. उप�ह

3. DSL

4. डायल-अप

Question Type : MCQ
Question ID : 618278716

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.41 _________ �ो�ामर �वारा मशीन को बेहद �न�न-�तर�य भाषा पर �नद�श देने क� स�ुवधा देता है और
पठनीय वा�य�व�यास (�सटैं�स) का �योग करता है।

Ans 1. अस�बलर

2. इंटर��टर

3. कंपाइलर

4. �ोसेसर

Question Type : MCQ
Question ID : 618278669
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Status : Answered
Chosen Option : 1

Marks : 1.00

Q.42 MS-Excel म� __________ फ़ं�शन ब�ुनयाद� अकंग�णतीय, �नयमब� योग, घातांक और लघगुणक स�हत
कई सामा�य ग�णतीय गणनाएँ करत ेह�।

Ans 1. टे��ट

2. ग�णत

3. ता�क� क

4. सांि�यक�य

Question Type : MCQ
Question ID : 618278707

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.43 MS-PowerPoint म� गलत पवू��नधा��रत �लाइड लेआउट क� पहचान कर�।
Ans 1. कै�शन के साथ �च�

2. तीन साम�ी

3. तलुना

4. कै�शन वाल� साम�ी

Question Type : MCQ
Question ID : 618278714

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.44 _________ एक खोज स�ुवधा भी सि�म�लत करता है जो उपयोगकता�ओ ंको हाड� �ाइव पर फ़ाइल� के �थान
अ�नि�चत होने पर उ�ह� आसानी से खोजने और �थान जानने क� स�ुवधा देता है।

Ans 1. सच� बॉ�स

2. इंटरनेट ए�स�लोरर

3. टा�क बार

4. फ़ाइल ए�स�लोरर

Question Type : MCQ
Question ID : 618278673

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.45 �बंधन के �लए �मैा�सक प�रचालन �रपोट� पर काय� करत ेहुए, आशा के पास कुछ �ब�� जानकार� के साथ एक
अ�छ� ��ेडशीट है, िजसे वह उस MS-Word द�तावेज़ म� डालना चाहती है िजसे वह �लख रह� है। वह चाहती है
�क MS-Excel फ़ाइल अ�य�तत होने पर MS-Word द�तावेज़ अपने आप अ�य�तत हो जाए। आशा को
�न�न�ल�खत म� से कौन सा �वक�प को चनुना चा�हए?

Ans 1. ���नशॉट

2. �प�चस�
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3. कॉपी और पे�ट

4. ऑ�जे�ट

Question Type : MCQ
Question ID : 618278678

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.46 शीट और लॉक �कए गए से�स क� साम��य� को सरु��त रखने के �लए �न�न म� से कार�वाईय� का कौन सा
�म अपनाया जाना चा�हए?

Ans 1. Tools > Protection > Protect Sheet

2. File > Protect Sheet

3. Tools > Protect Sheet

4. File > Protect Workbook > Protect Current Sheet

Question Type : MCQ
Question ID : 618278696

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.47 वक� शीट के पंि�त 8 म� सभी से�स क� साम�ी को इटै�लक बनाने के �लए आप �या कर�गे?

Ans 1. पंि�त 8 का चयन कर� और Ctrl+T कमांड का �योग कर�।

2. पंि�त 8 का चयन कर�, और फ़ॉम��टगं टूलबार पर ‘I’ बटन का �योग कर�।

3. पंि�त 8 का चयन कर� और Paste > Italics कमांड का �योग कर�।

4. पंि�त 8 का चयन कर� और Format Painter > Italics कमांड का �योग कर�।

Question Type : MCQ
Question ID : 618278700

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.48 Windows-आधा�रत कं�यटूर पर ��टंर के इं�टॉलेशन के संबंध म� �न�न�ल�खत म� से कौन सा कथन सह�
नह�ं है?

Ans 1. यो�य �डवाइस �ाइवर� को �नमा�ता क� वेबसाइट पर खोजा और पाया जा सकता है और उ�ह�
डाउनलोड करके इं�टॉल �कया जा सकता है।

2. ��टंर� के सामा�य मॉडल के �डवाइस �ाइवर पहले से ह� ऑपरे�टगं �स�टम के भाग होत ेह�।

3. एक कं�यटूर ��टंर तब तक काय� नह�ं करता है, जब तक �क आप अ�त�व��ट �ाइवर और सॉ�टवेयर
इं�टॉल नह�ं करत ेह�। 

4. इं�टॉलेशन ���या के दौरान डाटा केबल का उपयोग करके ��टंर को कं�यटूर से कने�ट करना
आव�यक है।

Question Type : MCQ
Question ID : 618278674

Status : Answered
Chosen Option : 2

Marks : 1.00
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Q.49 केबल पर इंटरनेट पहँुच �दान करने के �लए DOCSIS नामक मानक का उपयोग �कया जाता है। DOCSIS
का पणू� �प �या है?

Ans 1. �डल�वर ओवर केबल स�व�स इंटरनेट �पे�स�फ़केशन (Deliver Over Cable Service Internet
Specification)

2. �डल�वर ओवर केबल इंटरफ़ेस �पे�स�फ़केशन (Deliver Over Cable Interface Specification )

3. डाटा ओवर केबल स�व�स इंटरफ़ेस �पे�स�फ़केशन
(Data Over Cable Service Interface Specification)

4. डाटा ओवर केबल स�व�स इंटरनेट �पे�स�फ़केशन
(Data Over Cable Service Internet Specification)

Question Type : MCQ
Question ID : 618278717

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.50 _________ Windows XP ड�ेकटॉप पर ऐसी लघ ुछ�वया ँह� जो कं�यटूर पर मौजदू �ो�ाम� को दशा�ती ह�।
Ans 1. पॉइंटर

2. आइकॉन

3. बटन

4. �प�सेल

Question Type : MCQ
Question ID : 618278670

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.51 MS-Word म� मेल मज� ऑपरेशन के संबंध म�, �न�न�ल�खत म� से कौन सा कथन गलत है?

Ans 1. एक ��ेडशीट डाटा �ोत नह�ं हो सकता है।

2. मज� फ़��ड �व�श�ट होना चा�हए।

3. मेल मज� का उपयोग लेबल बनाने के �लए �कया जा सकता है।

4. मेल मज� का उपयोग �व�श�ट �प से �न�म�त म�ु�त प� भेजने के �लए �कया जा सकता है।

Question Type : MCQ
Question ID : 618278685

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.52 सेल A1 म� एक सं�या 105 �लखी है, इसक� प�ृठभ�ूम सफेद है और फ़ॉ�ट का रंग काला है। जब इसक� साम�ी
67 म� बदल जाती है, तो प�ृठभ�ूम गुलाबी और फ़ॉ�ट लाल हो जाता है। जब सेल A1 म� सं�या 206 दज� �कया
जाता है, तो प�ृठभ�ूम ह�क� हर� हो जाती है और फ़ॉ�ट गहरे हरे रंग का हो जाता है। इसका �या कारण हो
सकता है?

Ans 1. यह वक� शीट म� अतंः�था�पत (ए�बेडडे) एक �वशषे Visual Basic �ो�ाम के कारण होता है।

2. यह सेल पर �योग हुए 'सशत� �व�पण (कंडीशनल फ़ॉम��टगं)' के कारण होता है।

3. यह सेल पर �योग हुए अलग-अलग 'सेल �टाइ�स' के कारण होता है।

4. यह सेल पर �योग हुए 'टॉप/बॉटम ��स' के कारण होता है।
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Question Type : MCQ
Question ID : 618278699

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.53 MS-Excel म� वक� शीट के नामकरण के �लए �न�न�ल�खत म� से कौन एक मा�य फ़ाइल नाम नह�ं है?

Ans 1. Account:1

2. Account-1

3. Account1

4. Account’1

Question Type : MCQ
Question ID : 618278691

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.54 MS-Word 2016 म�, वत�नी और �याकरण (Spelling and Grammar) जांच �वक�प _________ मेन ूम�
�मलत ेह�।

Ans 1. �र�यु

2. टू�स

3. ए�डट

4. �वडंो

Question Type : MCQ
Question ID : 618278682

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.55 ��येक श�द को बड़ ेअ�र (कै�पटल) म� रखने के �लए, आपको 'च�ज केस’ का �वक�प कहाँ �मलेगा?
Ans 1. इ�सट� टैब

2. लेआउट टैब

3. होम टैब

4. �डज़ाइन टैब

Question Type : MCQ
Question ID : 618278680

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.56 MS-Excel 2016 म�, सेल D5 म� केवल एक ��वि�ट ‘ABCEFGHIJK’ है। इस सेल म�, आपने कस�र को �तंभ
शीष�क के दा� ओर सीमा पर ि�थत �कया है, इससे कस�र का आकार + �दखने लगता है। �फर आप माउस पर
डबल ि�लक करत ेह�। इसका �या प�रणाम होगा?

Ans 1. कोई �भाव नह�ं पड़गेा

2. �तंभ म� सबसे बड़ ेमान को �फट करने के �लए �तंभ क� चौड़ाई प�रव�त�त क� जाती है

3. �तंभ म� सबसे छोटे मान को �फट करने के �लए �तंभ क� चौड़ाई प�रव�त�त क� जाती है
ANKAJ INFOTECH
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4. �तंभ क� चौड़ाई उतनी ह� रहती है, ले�कन चय�नत �तंभ के से�स म� साम�ी को �लपटे हुए (वड� रैप)

श�द �मलत ेह�

Question Type : MCQ
Question ID : 618278694

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.57 वग� B नेटवक�  म�, पहला �बट 1 पर और दसूरा �बट 0 पर सेट है। वग� B नेटवक�  का परास (र�ज) �या होगा?
Ans 1. 255.0.0.0 से 255.255.0.0

2. 128.0.0.0 से 191.255.0.0

3. 128.1.0.0 से 191.255.0.0

4. 255.1.0.0 से 255.255.0.0

Question Type : MCQ
Question ID : 618278719

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.58 मेल मज� हेत ुMS-Excel डाटा �ोत फ़ाइल बनाने के �लए, क�टम जानकार� के ��येक फ़��ड के �लए िजसे
आप मज� �कए गए द�तावेज़ म� शा�मल करना चाहत ेह�, एक _______ बनाता है।

Ans 1. पंि�त (रो)

2. ता�लका (टेबल)

3. �तंभ (कॉलम)

4. काय�प�क (वक� शीट)

Question Type : MCQ
Question ID : 618278687

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.59 आपने ‘Protect Structure’ �वक�प के साथ MS-Excel वक� बकु को सरु��त �कया है। इसका �या अथ� है?

Ans 1. पंि�तय� और �तंभ� को जोड़ा या हटाया नह�ं जा सकता

2. वक� बकु म� वक� शी�स के से�स के �ा�प को �बना असरु��त (अन�ोटे�ट) �कए प�रव�त�त नह�ं �कया
जा सकता है

3. शीट को �थानांत�रत, सि�म�लत, हटाया, �छपाया, सामने लाया या नाम प�रव�त�त नह�ं �कया जा
सकता है

4. काय�पिु�तका को �बना पासवड� के नह�ं खोला जा सकता है

Question Type : MCQ
Question ID : 618278697

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.60
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Ans 1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 618278705

Status : Answered
Chosen Option : 4

Marks : 1.00
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Q.1 MS-Excel 2016 म� एक सेल म�, कैर�टस� क� अ�धकतम �कतनी सं�या को धा�रत रखा जा सकता है?

Ans 1. 4096

2. 2048

3. 32767

4. 1024

Question Type : MCQ
Question ID : 618278575

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.2 iOS, UNIX, LINUX एव ंWINDOWS जसेै सॉ�टवेयर, ______ के �कार होत ेहै।
Ans 1. एि�लकेशन �ो�ाम

2. �डवाइस �ाइवस�

3. भाषा �ोसेसर

4. प�रचालन तं� (ऑपरे�टगं �स�टम)

Question Type : MCQ
Question ID : 618278546

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.3 MS-Excel म�, वक� शीट अथवा वक� बकु को सरु��त रखने का म�ुय उ�े�य ______ होता है।
Ans 1. साव�ज�नक �प से लोग� से �छपाए रखना

2. उसम� प�रवत�न न होने देना - अनजाने म� अथवा दभुा�वनापणू�

3. केवल साझदेार� (शये�रगं)

4. चोर�−�वरोधी (एंट�-थे�ट)

Participant ID 19367976
Participant Name NEERAJ KUMAR
Test Center Name iON Digital Zone iDZ 2 Patliputra
Test Date 16/12/2019
Test Time 12:00 PM - 1:00 PM
Subject Data Entry Operator
Marks Obtained 19.00000

Section : MCQ for Data Entry Operator
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Question Type : MCQ
Question ID : 618278583

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.4 MS-Powerpoint 2016 म�, एक ��त�ुत क� �व�यमान �परेखा को बदलने हेत ुVIEWS टैब म� जाकर,
_______ �ुप म� _______ मा�टर का चयन कर�।

Ans 1. नो�स, मा�टर �यज़ू

2. ह�डआउट, �ेज�टेशन �यज़ू

3. �लाइड, �ेज�टेशन �यज़ू

4. �लाइड, मा�टर �यसू

Question Type : MCQ
Question ID : 618278594

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.5 �ोसेसर, जो घड़ी के ��येक च� पर एक से अ�धक �नद�श �न�पा�दत कर सकता है, उसे ____________
कहत ेह�।

Ans 1. RISC

2. सपूरकं�यटूर

3. CISC

4. सपूर�केलार �ोसेसर

Question Type : MCQ
Question ID : 618278542

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.6 IP ए�से 244.120.255.251 का ए�से �लास �या है?

Ans 1. �लास D

2. �लास C

3. �लास A

4. �लास E

Question Type : MCQ
Question ID : 618278599

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.7 MS-Wordड 2016 म�, आप कैसे संकेत दे सकत ेह� �क टे��ट के एक �ह�से को �कसी अ�य भाषा म� �लखा
गया है, ता�क जांच हेत ुतदन�ुपी श�दकोष का �योग �कया जाएगा?

Ans 1. INSERT मेन ूक� सहायता से चय�नत टे��ट को �चि�नत �कया जा सकता है।

2. REVIEW मेन ूक� सहायता से चय�नत टे��ट को �चि�नत �कया जा सकता है।

3. VIEW मेन ूक� सहायता से चय�नत टे��ट को �चि�नत �कया जा सकता है।
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4. ऐसा नह�ं �कया जा सकता है

Question Type : MCQ
Question ID : 618278560

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.8 �न�न�ल�खत म� से �कन �कार के फाइल� का �योग मेल मज� म� लेबल लाने हेत ुनह�ं �कया जाता है?

Ans 1. टे��ट फाइल

2. बाइनर� फाइल

3. ए�सेल ��ेडशीट

4. आउटलकु संपक�  सचूी

Question Type : MCQ
Question ID : 618278566

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.9 MS- Excel 2016 म�, _________ टैब के तहत सेल के समहू म� इ�सट� �वक�प पर ि�लक करने पर, एक
वक� शीट (पहले से ह� चय�नत) के सामने दसूरे वक� शीट को ��व�ट �कया जा सकता है।

Ans 1. डाटा (DATA)

2. होम (HOME)

3. �य ू(VIEW)

4. इ�सट� (INSERT)

Question Type : MCQ
Question ID : 618278571

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.10 MS-Excel 2016 म�, वक� बकु सरु�ा स�ुवधा म� ‘इसके �लए वक� बकु को सरु��त कर�’ म� दो �वक�प उपल�ध
ह�। सह� �वक�प� का चयन कर�।

Ans 1. संरचना और शीट

2. टेबल और शीट

3. शीट और वक� बकु

4. �वडंोज़ और संरचना

Question Type : MCQ
Question ID : 618278577

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.11 एक �ट�पकल ‘C’ �ो�ाम के हैडर फाइल को ____________ �वारा शा�मल �कया जाता है।
Ans 1. �ी�ोसेसर

2. लोडर
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3. असे�बलर

4. क�पाइलर

Question Type : MCQ
Question ID : 618278549

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.12 MS-Excel म� कॉलम क� चौड़ाई को 0 य�ूनट चय�नत �कए जाने पर �या होगा?
Ans 1. यह मान अमा�य होगा।

2. कॉलम �डल�ट हो जाएगा।

3. कॉलम हेडर म�, कॉलम, डबल लाइन के �प म� �द�श�त होगा।

4. कॉलम हेडर म� कॉलम, एक एकल लाइन के �प म� �द�श�त होगा।

Question Type : MCQ
Question ID : 618278580

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.13 �वडंोज़ �स�टेम म� ‘अ�डू ���या’ �दश�न करने के �लए ____________ दबाएं।
Ans 1. CTRL+U

2. CTRL+C

3. CTRL+V

4. CTRL+Z

Question Type : MCQ
Question ID : 618278550

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.14 �वडंोज़ �स�टम म�, एक फो�डर म�, �बना �कसी �म के एक फाइल का चयन �कया जाता है। फो�डर म� दशा�ए
गए पहले आइटम को आसानी से �थानांत�रत करने के �लए _________ कंुजी दबानी होती है।

Ans 1. PAGE DOWN

2. ESC

3. HOME

4. PAGE UP

Question Type : MCQ
Question ID : 618278552

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.15 DLL का परूा नाम ____________ हैः
Ans 1. डाइने�मक �लकं लाइ�ेर�

2. डवेलपम�ट ऑफ ल��नयर लाइ�ेर�
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3. डील�टेड �ल�ंकंग लाइ�ेर�

4. डाइरे��ल� �ल�ंड लाइ�ेर�

Question Type : MCQ
Question ID : 618278554

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.16 मेल मज� ���या म�, एक द�तावेज़ को मज� करने हेत ुक�बोड� शाट�कट �या है?

Ans 1. ALT+SHIFT+K

2. ALT+SHIFT+E

3. ALT+SHIFT+N

4. ALT+SHIFT+F

Question Type : MCQ
Question ID : 618278569

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.17 मेल मज� म�, �मखु द�तावेज़, एक टे��ट फाइल हो सकता है तथा लेबल, ��ेडशीट से आ सकत ेह�। हालां�क,
अ�भवादन (स�ैयटेूशन) भाग को इसके अनकूुल बनाने हेतःु

Ans 1. मज� क� पनुराविृ�त तकनीक का �योग कर�

2. मज� के अदंर मज� का �योग कर�

3. मज� फ��ड नामक स�ुवधा का �योग कर�

4. अलग स�ैयटेूशन टे��ट का �योग कर�

Question Type : MCQ
Question ID : 618278567

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.18 MS-Word म�, ____________ को दबात ेहुए, बड़-ेअ�र� से छोटे अ�र� तथा इसक� �वपर�त ि�थ�त म�
टॉगल �कया जा सकता हैः

Ans 1. ESC+F3

2. CTRL+F3

3. ALT+F3

4. SHIFT+F3

Question Type : MCQ
Question ID : 618278556

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.19 �न�न�ल�खत �वक�प� म� से �वषम �वक�प का चयन कर� −
Ans 1. वड� �ोसेसर
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2. ��ेडशीट

3. MS-DOS

4. डाटाबेस �बंधन �णाल�

Question Type : MCQ
Question ID : 618278547

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.20 MS-Excel 2016 क� वक� शीट म� श�ेस और �माट� आट� को इ�सट� मेन ूके ज़�रए ��व�ट �कया जा सकता है।
उसी मेन ूका �योग करत ेहुए �न�न�ल�खत म� से �कन �वक�प� को जोड़ा नह�ं जा सकता है?

Ans 1. �स�ब�स

2. �प�चस�

3. हाइपर�लकं

4. म�ैोस

Question Type : MCQ
Question ID : 618278590

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.21 MS-Excel 2016 म�, ‘�ोटे�ट वक� बकु’ क� श�ुआत कैसे क� जा सकती है?

Ans 1. VIEW > �ोटे�ट वक� बकु

2. HOME > �ोटे�ट वक� बकु

3. DATA > �ोटे�ट वक� बकु

4. REVIEW > �ोटे�ट वक� बकु

Question Type : MCQ
Question ID : 618278576

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.22 MS-Word 2016 म�, मे�लगं लेबल क� संरचना, MAILINGS टैब के ज़�रए श�ु क� जाती है तथा CREATE
अनभुाग के तहत कई उपल�ध �वक�प� का अनसुरण �कया जाता है। CREATE अनभुाग म� �कतने �व�भ�न
�वक�प उपल�ध ह�?

Ans 1. 3

2. 1

3. 2

4. 4

Question Type : MCQ
Question ID : 618278568

Status : Answered
Chosen Option : 4

Marks : 0.00
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Q.23 एक MS-Excel वक� शीट क� एक ह� पंि�त म�, �मवार लगातार कॉलम म� टे��ट ‘AB’, ‘CD’ और ‘EF’ को
सहेजा गया है। य�द आप तीन सेल का चयन करत ेहुए, ‘मज� और स�टर’ बटन पर ि�लक करत ेह� तो
�न�न�ल�खत म� से कौन सा मान �वक�प �द�श�त होगाः

Ans 1. AB

2. AF

3. CD

4. ABCDEF

Question Type : MCQ
Question ID : 618278578

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.24 MS-Excel 2016 म�, वक� शीट क� सरु�ा का चयन करने पर, एक डायलॉग बॉ�स उभर कर आता है िजसम�
यह �लखा होता है �क,' इस वक� शीट के सभी �योगकता� को �न�न�ल�खत क� अनमु�त द� जाती है' और उसके
बाद वां�छत �वक�प� के चयन हेत ुचेक बॉ�स क� सचूी �द�श�त होती है। �न�न�ल�खत म� से कौन सा �वक�प,
उनम� शा�मल नह�ं होता है?

Ans 1. ऑटो�फ�टर का �योग कर�

2. अ�सॉट� (अ��मत कर�)

3. कॉलम ��व�ट कर�

4. हाइपर�लकं ��व�ट कर�

Question Type : MCQ
Question ID : 618278584

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.25 मलू TCP/IP मॉडल म� �कतने लेयस� होत ेह�?
Ans 1. 6

2. 8

3. 4

4. 7

Question Type : MCQ
Question ID : 618278598

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.26 कं�यटूर म� __________ सवा��धक सामा�य डाटा इनपटु �डवाइस होता है।
Ans 1. लाइट पेन

2. �पीकर

3. क�बोड�

4. जॉयि�टक

Question Type : MCQ
Question ID : 618278543ANKAJ INFOTECH
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Status : Answered
Chosen Option : 3

Marks : 1.00

Q.27 �ड�क के ��येक �ैक को खंड� (Segments) म� �वभािजत �कया जाता है िजसे __________ कहत ेह�।
Ans 1. श�द (words)

2. �ब�स

3. बाइ�स

4. से�टर

Question Type : MCQ
Question ID : 618278545

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.28 MS-Word ���न म� �य ूबटन कहाँ ि�थत होता है?

Ans 1. नीचे दा� ओर

2. नीचे बा� ओर

3. ऊपर दा� ओर

4. ऊपर बा� ओर

Question Type : MCQ
Question ID : 618278555

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.29 �वडंोज़ �स�टम म� एक खलु� �वडंो से दसूरे म� �थानांत�रत करने के �लए ____________ दबाएं।
Ans 1. ALT+TAB

2. SHIFT+F1

3. CTRL+TAB

4. SHIFT+TAB

Question Type : MCQ
Question ID : 618278551

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.30 MS-Word 2016 म�, वत�नी और �याकरण क� जांच, ‘Spelling & Grammar’ �वक�प का चयन करत ेहुए,
_______ टैब क� ��ूफंग समहू से �कया जा सकता है।

Ans 1. रेफरे�सेस (REFERENCES)

2. होम (HOME)

3. �र�य ू(REVIEW)

4. �य ू(VIEW)

Question Type : MCQ
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Question ID : 618278562
Status : Answered

Chosen Option : 1
Marks : 0.00

Q.31 MS-Powerpoint म�, नॉम�ल �य ूसे आउटलाइन �य ूतथा इसक� �वपर�त ि�थ�त म� ि�वच करने के �लए
_______ दबाएं।

Ans 1. CTRL+SHIFT+TAB

2. SHIFT+F5+TAB

3. Fn+CTRL+TAB

4. CTRL+ALT+TAB

Question Type : MCQ
Question ID : 618278595

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.32 �थम इंटरनेट का पवू�वत� �या था?
Ans 1. NSFNET

2. UNIVNET

3. INSNET

4. ARPANET

Question Type : MCQ
Question ID : 618278596

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.33 MS-Excel वक� शीट म�, ____________ को दबात ेहुए, एक मोट� सेल बॉड�र सि�म�लत क� जा सकती है।
Ans 1. F5+H+B+T

2. SHIFT+H+B+T

3. ALT+H+B+T

4. CTRL+H+B+T

Question Type : MCQ
Question ID : 618278573

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.34 MS-Excel म� सभी �े�णय� के फं�शन, 4 �व�भ�न �कार क� डाटा �कार के एक सामा�य समहू को साझा
करत ेह�; वे ह�:

Ans 1. नंबर, टे��ट, �दनांक और ब�ूलयन

2. �लोट, नंबर, टे��ट और �दनांक

3. �रयल, टे��ट, �दनांक और ब�ूलयन

4. टे��ट, �दनांक, नंबर और इंट�जर
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Question Type : MCQ
Question ID : 618278587

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.35 �न�न�ल�खत म� से कौन सा �वक�प, MS-Powerpoint म� �लाइड �न�म�त/��व�ट करने हेत ुकाय� नह�ं
करेगा?

Ans 1. CTRL +M

2. F1

3. इ�सट� का चयन कर� तथा �य ू�लाइडड़ पर ि�लक कर�

4. F4

Question Type : MCQ
Question ID : 618278591

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.36 �न�न�ल�खत म� से कौन सा �वक�प, MS-EXCEL 2016 म� सेल के संपा�दत करने के ��ता�वत तर�क� म� से
एक नह�ं है?

Ans 1. डबल ि�लक

2. �सगंल ि�लक

3. फ़ॉमू�ला बार के ज़�रए

4. F2

Question Type : MCQ
Question ID : 618278572

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.37 य�द आप MS-Excel शीट टैब पर डबल ि�लक करत ेह�, तो आप �न�न काय� कर पाएँगे:

Ans 1. वक� शीट को �छपाना

2. वक� शीट को नया नाम देना

3. �य ूवक� शीट ��व�ट करना

4. वक� शीट को �डल�ट करना

Question Type : MCQ
Question ID : 618278570

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.38 MS-Word म�, फाइल मेन ूसे चयन �कए गए '�ोटे�ट डॉ�यमु��ट' टैब के अधीन �न�न�ल�खत म� से �कन
�वक�प� को शा�मल नह�ं �कया जाता है?

Ans 1. ए�सेस को ��तबं�धत करना

2. पासवड� से �ड���ट करना

3. पासवड� से एि���ट करना
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4. अ�ंतम (फाइनल) के �प म� �चि�नत करना

Question Type : MCQ
Question ID : 618278559

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.39 MS-Excel 2016 म�, आकृ�तय� (श�ेस) क� ��वि�ट, _________ मेन ूके ज़�रए क� जाती है।
Ans 1. इ�सट�

2. फॉम�ट

3. होम

4. �यू

Question Type : MCQ
Question ID : 618278589

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.40 MS-Word म� ���न शॉट कैसे �लया जा सकता है?

Ans 1. F1+PRINT SCRN

2. ALT+P

3. CTRL+PRINT SCRN

4. CTRL+P

Question Type : MCQ
Question ID : 618278557

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.41 _______ �ोटोकॉल के �योग के ज़�रए ईमेल को एक नोड से दसूरे नोड म� �ांसफर �कया जाता है।
Ans 1. FTP

2. STP

3. SMTP

4. UDP

Question Type : MCQ
Question ID : 618278600

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.42 MS-Word 2016 द�तावेज़ म� ��डलाइन के �दश�न हेत ु�न�न�ल�खत का �योग �कया जाना चा�हएः
Ans 1. DESIGN टैब के संरे�खत अनभुाग (एलाइन से�शन) का �योग कर� और शो ��ड के चयन हेत ु��ड

से�टगं �वक�प पर जाएं

2. LAYOUT टैब के संरे�खत अनभुाग (एलाइन से�शन) का �योग कर� और शो ��ड के चयन हेत ु��ड
से�टगंग �वक�प पर जाएं
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3. LAYOUT टैब के पेज सेटअप अनभुाग का �योग कर� और शो ��ड के चयन हेत ु��ड से�टगं �वक�प
पर जाएं

4. INSERT टैब के संरे�खत अनभुाग (एलाइन से�शन) का �योग कर� और शो ��ड के चयन हेत ु��ड
से�टगं �वक�प पर जाएं

Question Type : MCQ
Question ID : 618278564

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.43 दो फो�डर खलेु हुए ह�। �वडंोज़ �स�टम म� �कसी फाइल को एक फो�डर से दसूरे फो�डर म� �थानांत�रत करने
का सबसे आसान उपाय �या होता है?

Ans 1. फाइल को �रसाइकल �बन म� �थानांत�रत करना और �फर उसे वां�छत फो�डर म� अतं�रत करना

2. फाइल को कॉपी करके, वां�छत फो�डर म� पे�ट करना

3. फाइल को एक फो�डर से खींच कर वां�छत फो�डर म� लाना

4. फाइल को संकु�चत करना और �फर वां�छत फो�डर म� उसे �व�ता�रत (अन-क��ेस) करना

Question Type : MCQ
Question ID : 618278553

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.44 �न�न�ल�खत ‘C’ �ो�ाम खंड़ पर �वचार कर� –

while (−5) {;};

वाइल (While) लपू क� बॉडी (empty) �कतनी बार �न�पा�दत क� जाएगी?
Ans 1. पांच

2. अनंत

3. �नधा��रत नह�ं �कया जा सकता है

4. श�ूय

Question Type : MCQ
Question ID : 618278548

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.45 MS-Excel वक� शीट म� �न�न�ल�खत डाटा पर �यान द� िजसम� बायां कॉलम, पंि�तय� क� सं�या को स�ूचत
करता है।

1 सेब केला संतरा

2 8 40 12

य�द इस डाटा का �योग करत ेहुए एक पाई चाट� बनाया जाता है, तो पाई चाट� म� ‘केला’ अनभुाग �वारा �य�ुत
कुल �े� का ��तशत �या होगा?

Ans 1. 0.2839

2. 0.2
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3. 0.1333

4. 0.6667

Question Type : MCQ
Question ID : 618278588

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.46 DSL का परूा नाम �या है?

Ans 1. �डिजटल सव�सेज़ �लकं

2. �डिजटल स�व�सेज़ �ल�मटेड

3. �डिजटल स�स�ाइबर लाइन

4. �डिजटल स�स�ाइबर लेयर

Question Type : MCQ
Question ID : 618278597

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.47 म�ट�पल �ड�क �लटैर के एक समान लंबवत ि�थ�त के कॉस���क �ै�स को ता�क� क �प से __________
माना जाता है।

Ans 1. सपुर �ैक

2. से�टर

3. �स�लडंर

4. वे�टर

Question Type : MCQ
Question ID : 618278544

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.48 MS-Excel के �न�न�ल�खत फ़ॉमू�ला का प�रणाम �या होगा?

=SIGN(−300)
Ans 1. 1

2. 300

3. −1

4. −300

Question Type : MCQ
Question ID : 618278585

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.49 MS-Excel म�, एक सेल िजसम� 1234 सं�या ��वि�ट क� गई है, को व�ैा�नक नोटेशन म� उ�त सं�या को
�द�श�त करने हेत ुचयन �कया गया है। �न�न�ल�खत म� से कौन सा मान �वक�प �द�श�त होगा?
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Ans 1. 0.1234E+04

2. 1234

3. 12.34E+02

4. 1.23E+03

Question Type : MCQ
Question ID : 618278579

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.50 MS-Excel 2016 म� कॉलम क� अ�धकतम अनमुत चौड़ाई �कतनी होती है?

Ans 1. 255 कैर�टस�

2. 128 कैर�टस�

3. 2048 कैर�टस�

4. 1023 कैर�टस�

Question Type : MCQ
Question ID : 618278574

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.51 मान ल� �क, सेल E10 एवं F10 म� �मशः मान 8 और 4 ��व�ट ह�। सेल G10 म� फामू�ला =E10−F10 �लखे
जाने पर उस सेल म� 4 नंबर �द�श�त होगा। G10 म� CTRL+C ि�लक करने पर तथा H10 म� CTRL+V
ि�लक करने पर, (अथा�त ्फामू�ला को कॉपी करने पर) �या �द�श�त होगा?

Ans 1. −4

2. 8

3. 4

4. 0

Question Type : MCQ
Question ID : 618278586

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.52 मेमोर� से �नद�श �ा�त करने के बाद, उसे डीकोड करके, आगे क� काय�वाह� हेत ु_____________ म� डाला
जाता है।

Ans 1. �टैक पाइंटर

2. मेमोर� ए�से रिज�टर

3. �ो�ाम काउंटर

4. �नद�श रिज�टर

Question Type : MCQ
Question ID : 618278541

Status : Answered
Chosen Option : 2

Marks : 0.00
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Q.53 MS-Powerpoint म�, �लाइडस� �े�, ‘�लाइड सॉट�र’ �य ूम� �लाइ�स का �दश�न कैसे करत ेह�?
Ans 1. कोई �नि�चत �म नह�ं

2. �लाइडड़ क� �वषयव�त ुके आधार पर ऑड�र को सॉट� �कया जाता है

3. रो-मेजर ऑड�र म� थंबनेल फाम�

4. कॉलम-मेजर ऑड�र म� थंबनेल फाम�

Question Type : MCQ
Question ID : 618278593

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.54 MS-Powerpoint �लाइडड म� टे��ट के फॉ�ट को ____________ टे��ट का चयन एवं दबात ेहुए कम
�कया जा सकता हैः

Ans 1. ALT+ <

2. CTRL+SHIFT+ <

3. CTRL+SHIFT+D

4. ALT+SHIFT+ <

Question Type : MCQ
Question ID : 618278592

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.55 MS-Word 2016 के एक स��य द�तावेज़ म� ���न शॉट को कैसे जोड़ा जा सकता है?

Ans 1. फाइल > ���नशॉट > “इस �बदं ुपर �वडंोज़ म� खलु� हुई थंबने�स से चयन कर�”

2. �डज़ाइन > ���नशॉट > “इस �बदं ुपर �वडंोज़ म� खलु� हुई थंबने�स से चयन कर�”

3. इ�सट� > ���नशॉट > “इस �बदं ुपर �वडंोज़ म� खलु� हुई थंबने�स से चयन कर�”

4. �य ू> ���नशॉट > “इस �बदं ुपर �वडंोज़ म� खलु� हुई थंबने�स से चयन कर�”

Question Type : MCQ
Question ID : 618278558

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.56 MS-Word म�, होम म�, �रबन से बलेुट को इ�सट� �कया जा सकता है। क�बोड� से इसी कार�वाई को कैसे �कया
जा सकता है?

Ans 1. CTRL+SHIFT+N

2. CTRL+SHIFT+L

3. ALT+CTRL+B

4. ऐसा नह�ं �कया जा सकता है

Question Type : MCQ
Question ID : 618278561

Status : Answered
Chosen Option : 4
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Marks : 0.00

Q.57 MS-Excel के एक वक� शीट म�, नीचे क� ओर (ऊपर से नीच क� ओर उ�मखुीकरण) सेल क� �वषयव�त ु�लखने
का एक संभव उपाय, फॉम�ट के तहत �टाइल �वक�प के ज़�रए एवं एलाइनम�ट डायलॉग बॉ�स से टे��ट के
उ�मखुीकरण का चयन ____________ के �प म� हो सकता हैः

Ans 1. 0°

2. 180°

3. 90°

4. −90

Question Type : MCQ
Question ID : 618278582

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.58 हालां�क, सामा�य बॉडी भाग हेत ुकई �कार के द�तावेज़� का �योग �कया जा सकता है और पत ेके लेबल हेतु
भी कई द�तावेज़� का �योग �कया जा सकता है, मेल मज� म� �योग �कए जाने वाले दो �मखु फाइल� के
तकनीक� नाम_________ होत ेह�।

Ans 1. ए�वलप फाइल और लेटर फाइल

2. टे��ट और डाटा

3. पता और लेबल

4. �मखु द�तावेज़ और डाटा �ोत

Question Type : MCQ
Question ID : 618278565

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.59 MS-Word म� फं�शन कंुजी F7 _______ का काय� करती है।
Ans 1. MS-वड� से बाहर �नकलने

2. फामु�ला क� ��वि�ट

3. संपादन हेत ुएक नई �र�त �वडंो खोलने

4. वत�नी और �याकरण क� जांच क� श�ुआत

Question Type : MCQ
Question ID : 618278563

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.60

Ans
1. 

2. 
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3. 

4. 

Question Type : MCQ
Question ID : 618278581

Status : Answered
Chosen Option : 2

Marks : 0.00
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Q.1 एक मेल मज� डटेा �ोत ______ नह�ं हो सकता है।
Ans 1. ऐ�सेस डटेाबेस

2. टे��ट फाइल

3. HLL �ो�ाम

4. ए�सेल ��ेडशीट

Question Type : MCQ
Question ID : 618278625

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.2 जब हम Microsoft Word म� क�बोड� शॉट�कट ‘Ctrl + Delete’ दबात ेह� तो वत�मान कस�र ि�थ�त से
______ को �मटाया जाता है।

Ans 1. श�द के दाएँ भाग

2. अन�ुछेद के दाएँ भाग

3. श�द के बाएँ भाग

4. अन�ुछेद के बाएँ भाग

Question Type : MCQ
Question ID : 618278618

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.3 1. Microsoft Excel 2016 काय�पिु�तका (वक� बकु) साझा करने और प�रवत�न �ै�कंग क� सरु�ा (�ोटे�ट
च�ज �े�कंग) करने के �लए, �न�न�ल�खत चरण� का अनसुरण करना चा�हए:
प�रवत�न समहू (च�जेस �ुप) म� समी�ा (�र�य)ू टैब पर, 'वक� बकु को सरु��त और साझा कर�' बटन पर ि�लक
कर�।
डायलॉग �वडंो पर जो ______ चेकबॉ�स का चयन करता है।

Ans 1. �ैक प�रवत�न के साथ साझा करना

Participant ID 19326977
Participant Name RAJURANJAN KUMAR
Test Center Name iON Digital Zone iDZ Jalalpur
Test Date 16/12/2019
Test Time 9:00 AM - 10:00 AM
Subject Data Entry Operator
Marks Obtained 24.00000

Section : MCQ for Data Entry Operator
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2. �कसी के साथ साझा करना

3. �डल�ट के साथ साझा करना

4. दसूर� के साथ साझा करना

Question Type : MCQ
Question ID : 618278637

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.4 Microsoft Excel 2016 म�, 'फ़ॉम�ट सेल' �वक�प के उपयोग से सेल; को सरु��त �कया जा सकता है। दशा�ए
जाने वाले फ़ॉम�ट सेल डायलॉग �वडंो पर, 'लॉक सेल' �वक�प को ______ टैब के तहत पाया जा सकता है।

Ans 1. �विज�ब�लट�

2. ऑग�नाइज़ शीट

3. �ोटे�शन

4. हाइड/अनहाइड

Question Type : MCQ
Question ID : 618278639

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.5 Microsoft Excel 2016 वक� शीट क� शीट टैब पर दाएँ-ि�लक करके �न�न�ल�खत म� से कौन सा काय� नह�ं
�कया सकता है?

Ans 1. वक� शीट का नाम बदलना

2. वक� शीट �छपाना

3. वक� शीट को हटाना

4. वक� शीट को घमुाना

Question Type : MCQ
Question ID : 618278631

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.6 Microsoft Office 2007 से, ______ ने �व�पण (फॉम��टगं) टूलबार को ��त�था�पत कर �दया है।
Ans 1. �ॉ

2. �रबन

3. फॉम�ट �ल�ट

4. सेल�ा�ट3

Question Type : MCQ
Question ID : 618278638

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.7 IPv4 पत ेक� पहचान कर�, जो मा�य नह�ं है।
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Ans 1. 123.255.155.256

2. 128.128.255.200

3. 150.150.150.150

4. 200.100.240.100

Question Type : MCQ
Question ID : 618278656

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.8 जब आप Microsoft Excel 2016 फ़ाइल को सरु��त करत ेह�, तो आप यह स�ुनि�चत नह�ं कर सकत ेह� �क
______।

Ans 1. सेल म� दज� एक स�ू नह�ं बदला जाएगा

2. फ़ाइल �कसी अन�धकृत �यि�त �वारा ए�सेस नह� ंक� जाएगी

3. काय�पिु�तकाएँ (वक� शीट) हटाई नह�ं जाएँगी

4. �यि�तगत शीट संर��त ह�

Question Type : MCQ
Question ID : 618278644

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.9 इंटरनेट सेवा �दाता को ______ के �प म� भी जाना जाता है।
Ans 1. ISP

2. TCP/IP

3. ISPP

4. IPP

Question Type : MCQ
Question ID : 618278657

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.10 जब आप फ़ाइल मेन ूसे 'डॉ�यमू�ट �ोटे�ट' का चयन करत ेह�, तो �न�न�ल�खत म� से कौन सा �वक�प
Microsoft Word 2016 म� उपल�ध नह� ंहोता है?

Ans 1. समापक (फाइनल) के �प म� �चि�नत कर�

2. हटाना ��तबं�धत कर�

3. ए�सेस ��तबं�धत कर�

4. संपादन ��तबं�धत कर�

Question Type : MCQ
Question ID : 618278619

Status : Answered
Chosen Option : 1

Marks : 0.00

ANKAJ INFOTECH
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Q.11 �न�न�ल�खत म� से कौन सा क�बोड� शॉट�कट मेल मज� डटेा �ोत को संपा�दत करने के �लए उपयोगी होगा?
Ans 1. Alt + Shift + E

2. Alt + Shift + F6

3. Ctrl + Shift + E

4. Alt + Shift + Home

Question Type : MCQ
Question ID : 618278629

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.12 एक पणू� योजक (एडर) को ______ का उपयोग करके लागू �कया जा सकता है।
Ans 1. दो अध� योजक और एक NAND गेट

2. दो अध� योजक और एक OR गेट

3. दो अध� योजक और एक XOR गेट

4. दो अध� योजक और एक AND गेट

Question Type : MCQ
Question ID : 618278602

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.13 आपने Microsoft Excel 2016 म� एक कॉलम चनुा है। अब आप चय�नत कॉलम को �छपाने के �लए �या
करत ेह�?

Ans 1. यह नह�ं �कया जा सकता है

2. दाएँ-ि�लक कर� और '�छपाएँ (हाइड)' �वक�प चनु�।

3. Ctrl + ( दबाएँ

4. F11 दबाएँ

Question Type : MCQ
Question ID : 618278634

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.14 ZIF कं�यटूर मदरबोड� पर एक �कार का CPU सॉकेट है जो �ोसेसर के सरल ��त�थापन या उ�नयन के �लए
अनमु�त देता है। इस ‘ZIF’ का पणू� �प �या है?

Ans 1. ज़ीरो इ�सश�न फ़ोस�

2. ज़ोडीऐक इ�टर�ट फं�शन

3. ज़ीरो इि��लमे�टेशन फं�शन

4. ज़ेबरा इ�सश�न फै�स�लट�

Question Type : MCQ
Question ID : 618278614

Status : Answered
Chosen Option : 2

Marks : 0.00ANKAJ INFOTECH
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Q.15 Microsoft Word 2016 म�, Word �वडंो के शीष� पर �व�पण (फॉम��टगं) और अ�य स�ुवधाएँ �वत�रत क�
जाती ह�। ऊपर से नीचे क� ओर, �यव�थापन इस �कार है:

Ans 1. �व�पण (फॉम��टगं) टूलबार, शीष�क (टाइटल) बार, मेन ूबार

2. मेन ूबार, शीष�क बार, �व�पण (फॉम��टगं) टूलबार

3. शीष�क (टाइटल) बार, मेन ूबार, �व�पण (फॉम��टगं) टूलबार

4. शीष�क (टाइटल) बार, �व�पण (फॉम��टगं) टूलबार, मेन ूबार

Question Type : MCQ
Question ID : 618278620

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.16 �न�न�ल�खत म� से कौन सा क�बोड� शॉट�कट मेल मज� म� मज� फ़��ड सि�म�लत करने के �लए उपय�ुत होगा ?
Ans 1. P + Alt + Shift

2. Shift + Alt + I

3. Ctrl + Shift + F

4. Alt + Shift + F

Question Type : MCQ
Question ID : 618278627

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.17 �न�न�ल�खत म� से कौन से द�तावेज मेल मज� म� ससुंगत ह�?
Ans 1. डटेा टे��ट, मेन टे��ट और �ो�ाम टे��ट

2. टे��ट, डटेा और �ो�ाम

3. मेन डा�यमेू�ट, डटेा सोस� और मज� डा�यमेू�ट

4. डटेाबेस, टेबल और मेन डा�यमेू�ट

Question Type : MCQ
Question ID : 618278626

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.18 �न�न�ल�खत म� से �कस फो�डर म� वह द�तावेज है िजसे फै�स �कया जाना है, जो �वडंोज़ �वारा �डफॉ�ट �प
से सं��हत �टोर है?

Ans 1. डाउनलोड

2. होम

3. �प�चस�

4. �कै�ड डा�यमेू�ट

Question Type : MCQ
Question ID : 618278612

Status : Answered
ANKAJ INFOTECH
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Chosen Option : 4
Marks : 1.00

Q.19

Ans
1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 618278641

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.20 आप �न�न�ल�खत म� से �कस क�बोड� शॉट�कट का उपयोग Microsoft Word फ़ाइल क� संपणू� साम�ी का
चयन करने के �लए कर�गे?

Ans 1. F7 + A

2. Alt + A

3. Shift + F7

4. Ctrl + A

Question Type : MCQ
Question ID : 618278610

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.21 Microsoft Excel फ़ं�शन को �व�भ�न वग� म� वग�कृत �कया जा सकता है। हालाँ�क, वे कुछ मानक डटेा
�कार� को तक�  के �प म� दशा�त ेह�। �न�न�ल�खत म� से कौन सा मा�य तक�  (आ�यु�म�ट) डटेा �कार नह�ं है?

Ans 1. तार�ख (Date)

2. �बट �े� (Bit field)

3. ब�ूलयन (Boolean)

4. सं�या (Number)

Question Type : MCQ
Question ID : 618278647

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.22 एक सी�रयल ��टंर के �लए एक समय पर �कतने �ब�स �ांसफर �कए जात ेह�?
Ans 1. 1 bit

2. 1 byte

ANKAJ INFOTECH
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3. 1 double word

4. 1 word

Question Type : MCQ
Question ID : 618278604

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.23 सामा�यतः �न�न�ल�खत म� से �कसका उपयोग डायना�मक वेबसाइट बनाने के �लए नह�ं �कया जाता है?

Ans 1. PHP

2. JSP

3. HTML

4. ASP.NET

Question Type : MCQ
Question ID : 618278660

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.24 Microsoft Excel 2016 म�, वक� शीट के अदंर एक सेल म� 1234567 समा�व�ट होता है। इस सेल का चयन
करत ेहुए, आप होम टैब के अतंग�त नंबर �ुप म� जात ेह�। �ेणी सचूी म�, आप 'नंबर' चनु� और '1000 सेपरेटर का
उपयोग कर� (,)' चेकबॉ�स चनु�। इन चरण� को करने के प�रणाम�व�प से�न�न म� से कौन सा �वक�प �द�श�त
होगा?

Ans 1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 618278642

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.25 Microsoft Word 2016 म�, वत�नी और �याकरण को 'वत�नी और �याकरण' �वक�प का चयन करके समी�ा
टैब के ______ समहू से जाँच सकत ेह�।

Ans 1. ��ूफंग

2. भाषा (ल��वेज)

3. �माण पठन (�फ़ू �रडींग)

4. �ट�प�णया ँ(कम��स )

Question Type : MCQ
Question ID : 618278623

Status : Answered
Chosen Option : 4

Marks : 0.00

ANKAJ INFOTECH
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Q.26 य�द आप Microsoft Excel 2016 म� शीट टैब पर डबल ि�लक करत ेह�, तो ______ म� स�म ह�गे।
Ans 1. वक� शीट का नाम बदलने

2. वक� शीट हटाने

3. वक� शीट को �छपाने

4. नई वक� शीट सि�म�लत करने

Question Type : MCQ
Question ID : 618278630

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.27 Microsoft Word द�तावेज़ म� �कसी श�द पर दो बार लगातार �कए गए ि�लक एक ______ का चयन करते
ह�।

Ans 1. प�ृठ (पेज़)

2. अनभुाग (से�शन)

3. श�द (वड�)

4. अन�ुछेद (परैा�ाफ़)

Question Type : MCQ
Question ID : 618278621

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.28 बाइनर� नंबर 10101001010101 के अ�टक के बराबर क� सं�या �ात क�िजए।
Ans 1. 13542

2. 65425

3. 25125

4. 52252

Question Type : MCQ
Question ID : 618278601

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.29 Windows XP क� �ड�क-�ल�न अप स�व�स म� जाने के �लए आप �न�न�ल�खत म� से �कस चरण का उपयोग
कर�गे?

Ans 1. Control Panel > System & Security > Administrative Tools

2. Control Panel > Administrative Tools

3. Downloads > Systems & Security > Administrative Tools

4. Home > System & Security > Administrative Tools

Question Type : MCQ
Question ID : 618278613

Status : Answered
Chosen Option : 1

Marks : 1.00
ANKAJ INFOTECH
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Q.30 Microsoft Excel 2016 म�, �कसी को होम टैब के तहत सेल समहू के भीतर फॉम�ट बटन �मलेगा। इस बटन
को दबाने पर �न�न�ल�खत म� से कौन सा �वक�प उपल�ध नह�ं है?

Ans 1. फॉम�ट सेल

2. कि�डशनल फॉम��टगं

3. लॉक सेल

4. हाइड और अनहाइड

Question Type : MCQ
Question ID : 618278640

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.31 �न�न�ल�खत चरण� का पालन करके Microsoft Word म� चलायमान (म�ूवगं) टे��ट सरलता से परूा �कया
जा सकता है:
1.चलायमान टे��ट का चयन कर�।
2.क�बोड� शॉट�कट ______ दबाकर टे��ट को काट�।
3.अपने कस�र को इि�छत �थान पर ले जाएँ।
4.काटे गए टे��ट को �चपकाने के �लए क�बोड� शॉट�कट ______ दबाएँ।

Ans 1. Ctrl + C, Ctrl + M

2. Ctrl + X, Ctrl + V

3. Ctrl + S, Ctrl + M

4. Ctrl + C, Ctrl + X

Question Type : MCQ
Question ID : 618278622

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.32 एक Microsoft Excel सेल िजसम� मान ABC चय�नत है। अब, य�द आप इस मान का उपयोग करके एक
सामा�य पाई चाट� सि�म�लत करत ेह�, तो �न�न�ल�खत म� से कौन सा चाट� �द�श�त �कया जाएगा?

Ans 1. 3-D �भाव वाला एक च�
तीन वग� �े� वाला च� जो �ा�त चाट� म� A, B, और C के बराबर है

2. एक �नि�चत आकार का एक सामा�य च�

3. एक पाई चाट� केवल टे��ट इनपटु के साथ तयैार नह�ं �कया जा सकता है

4. पाई चाट� म� तीन �े� के वग� के बराबर अथा�त,् A, B, और C के साथ एक च�

Question Type : MCQ
Question ID : 618278648

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.33

ANKAJ INFOTECH
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Ans 1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 618278645

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.34 Microsoft PowerPoint म� वत�मान �लाइड से �लाइड शो श�ु करने के �लए आप �न�न�ल�खत म� से कौन
सा क�बोड� शॉट�कट दबाएँगे?

Ans 1. F5

2. Ctrl + F5

3. Alt + F5

4. Shift + F5

Question Type : MCQ
Question ID : 618278655

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.35 एक �ो�ाम या समहू जो कं�यटूर के सभी संसाधन� (�रसोस�) का �बंधन करता है, वह ______ होता है।
Ans 1. �चालन तं� (ऑपरे�टगं �स�टम)

2. �डवाइस �ाइवर

3. संकलनकता� (क�पाइलर)

4. मेमोर� क��ोलर

Question Type : MCQ
Question ID : 618278606

Status : Answered
Chosen Option : 4

Marks : 0.00ANKAJ INFOTECH
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Q.36 आप Microsoft PowerPoint �लाइड के पेज ओ�रएंटेशन को इस तरह से बदल सकत ेह�।
Ans 1. छोटे से लंबे तक (शॉट� टू लॉ�ग) और इसके �वपर�त करके

2. इसके �वपर�त �तरछा घमुाके

3. वग� से व�ृतीय और इसके �वपर�त करके

4. ल�ड�केप के �लए पो��ट और इसके �वपर�त करके

Question Type : MCQ
Question ID : 618278654

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.37 Microsoft Power Point 2016 म� �य ूटैब कई ��त�ुत ��य �दान करता है। �न�न�ल�खत टैब म� से कौन
सा एक मा�य �वक�प नह�ं है?

Ans 1. नॉम�ल

2. इनलाइन

3. �लाइड सॉट�र

4. आऊट लाइन

Question Type : MCQ
Question ID : 618278653

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.38 Microsoft Word 2016 द�तावेज़ म� ता�लका बनाने के �लए ______ टैब पर ि�लक करके इसक� श�ुआत
कर�।

Ans 1. इ�सट�

2. फाइल

3. �डज़ाइन

4. �र�यू

Question Type : MCQ
Question ID : 618278624

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.39 Microsoft Excel म� एक सेल से दसूरे सेल म� फॉमू�ला कॉपी करने के �लए, सव��थम सेल को चनुना होगा
और ______ को दबाना होगा, �फर डिे�टनेशन सेल म� जाकर ______ को दबाना होगा।

Ans 1. Alt + F, Alt + P

2. Ctrl + C, Ctrl + V

3. Ctrl + F, Ctrl + P

4. F5, F10

Question Type : MCQ
Question ID : 618278646

ANKAJ INFOTECH
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Status : Answered
Chosen Option : 2

Marks : 1.00

Q.40 एक मानक छह-चरण संकलन ���या म�, इंटरमी�डएट कोड क� �न�म��त कब क� जाती है?

Ans 1. चरण 3 म�

2. चरण 2 म�

3. चरण 5 म�

4. चरण 4 म�

Question Type : MCQ
Question ID : 618278609

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.41 Microsoft Excel 2016 म� वक� शीट क� सरु�ा के �लए �र�य ूटैब के अतंग�त �न�न�ल�खत म� से कौन सा
�वक�प मौजदू नह�ं है?

Ans 1. काय�पिु�तका साझा कर� (Share Workbook)

2. शीट को सरु��त रख� (Protect Sheet)

3. सेल को सरु��त रख� (Protect Cells)

4. काय�पिु�तका को सरु��त रख� (Protect Workbook)

Question Type : MCQ
Question ID : 618278643

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.42 �न�न�ल�खत म� से �कसे एक नेटवक�  पर �रमोट कं�यटूर म� लॉग इन करने के �लए �य�ुत �कया जा सकता है?

Ans 1. FASTNET

2. TELNET

3. STEADYNET

4. USENET

Question Type : MCQ
Question ID : 618278658

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.43 Microsoft Word एक ______ है।
Ans 1. य�ून�स एडीटर

2. क�पाइलर

3. ऑपरे�टगं �स�टम

4. ए�ल�केशन �ो�ाम

Question Type : MCQ
Question ID : 618278607ANKAJ INFOTECH
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Status : Answered
Chosen Option : 4

Marks : 1.00

Q.44 Microsoft PowerPoint �लाइड म� फ़ॉ�ट का आकार टे��ट का चयन करके और क�बोड� शॉट�कट ______
दबाकर बढ़ाया जा सकता है।

Ans 1. Ctrl + Shift + >

2. Alt + >

3. Alt + Shift + >

4. Ctrl + Shift + I

Question Type : MCQ
Question ID : 618278652

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.45 Microsoft Excel 2016 म�, जब आप टैब के �च� समहू के तहत 'इ�सट� ए �माट�आट� �ा�फ़क' का चयन
करत ेह�, तो आपको �दखाई देने वाले डायलॉग बॉ�स म� चार अलग-अलग �कार के मे��सेस �मलत ेह�।
�न�न�ल�खत म� से कौन एक मा�य म�ै��स �कार नह�ं है?

Ans 1. Basic

2. Titled

3. Cycle

4. Tiled

Question Type : MCQ
Question ID : 618278650

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.46 Microsoft Excel 2016 म�, जब आप इ�सट� टैब के इल��ेशन �ुप के तहत 'इ�सट� ए �माट�आट� �ा�फ़क' का
चयन करत ेह� तब �न�न�ल�खत म� से कौन सी �े�णया ँउपल�ध नह�ं होती ह�?

Ans 1. �च� (�प�चर)

2. अन�ुम (हाइराक�)

3. वी�डयो

4. सचूी (�ल�ट)

Question Type : MCQ
Question ID : 618278649

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.47 �न�न�ल�खत म� से कौन Microsoft Word फ़ाइल� का फ़ाइल ए�सट�शन नह�ं है?

Ans 1. .text

2. .rtf

3. .doc
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4. .docx

Question Type : MCQ
Question ID : 618278615

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.48 वत�मान Microsoft PowerPoint �लाइड को बाएँ फलक म� �लाइड का चयन करके और क�बोड� शॉट�कट
______ दबाकर हटाया जा सकता है।

Ans 1. Ctrl + X

2. Ctrl + K

3. Ctrl + D

4. Ctrl + C

Question Type : MCQ
Question ID : 618278651

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.49 �न�न�ल�खत म� से बड़ ेआरेखण और �ा�फ�स ��टं करने के �लए कौन सबसे उपय�ुत है?

Ans 1. �कैनर

2. वी डी य ू(VDU)

3. �लॉटर

4. डॉट-म�ै��स ��टंर

Question Type : MCQ
Question ID : 618278605

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.50 म�ट�का�ट के �लए IPv4 पत ेक� कौन सी �ेणी का उपयोग �कया जा सकता है?

Ans 1. A

2. D

3. C

4. B

Question Type : MCQ
Question ID : 618278659

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.51 Microsoft Excel म�, जब कोई वक� शीट पहले से खलु� होती है, तो शॉट�कट कंुजी 'F7' को दबाकर
�न�न�ल�खत म� से �कस क� पणू�ता क� जाती है?

Ans 1. वत�नी जाँच चलाई जाती है

2. ए�सेल फाइल बंद हो जाती है
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3. काय�पिु�तका (वक� बकु) बंद हो जाती है

4. वक� शीट बंद हो जाती है

Question Type : MCQ
Question ID : 618278632

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.52 Microsoft Excel 2016 म� वक� शीट म� पंि�त क� चौड़ाई को बदलने के �लए �या �कया जा सकता है?

Ans 1. Row चौड़ाई का ऐसा कोई अथ� नह�ं है, इस�लए इसे Microsoft Excel म� ��ततु नह�ं �कया गया है

2. Alt + F9 दबाएँ

3. Shift + F9 दबाएँ

4. Ctrl + F9 दबाएँ

Question Type : MCQ
Question ID : 618278635

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.53 �न�न�ल�खत 'C' �ो�ाम सेगम�ट क� जाँच कर�। �कतनी बार लपू के म�ुय भाग को काया�ि�वत �कया जाएगा?

int a, b; a = 2; b = 5;
While (a && b)
printf (“hello\n”);

Ans 1. 0

2. 1

3. अनंत

4. �नधा��रत नह�ं �कया जा सकता है

Question Type : MCQ
Question ID : 618278608

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.54 �न�न म� से �वषम च�ुनए।
Ans 1. आलेखक (Plotter)

2. वी डी य ू(VDU)

3. सरल कलम (Light pen)

4. म�ुक (Printer)

Question Type : MCQ
Question ID : 618278603

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.55 Microsoft Excel म�, आप ______ को सरु��त नह�ं रख सकत।े
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1. एक काय�पिु�तका (वक� बकु)

2. दसूर� के �वलोपन अ�धकार क� फ़ाइल

3. एक सेल

4. एक वक� शीट

Question Type : MCQ
Question ID : 618278636

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.56 �न�न�ल�खत म� से कौन सा क�बोड� शॉट�कट Microsoft Excel 2016 म� चय�नत पंि�त को �छपाने के �लए
उपयोग �कया जाता है ?

Ans 1. Alt + Shift + 9

2. Ctrl + F5

3. Ctrl + 9

4. Alt + 1

Question Type : MCQ
Question ID : 618278633

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.57 Microsoft Word 2016 �वडंो म� �वषय-व�त ुसंरेखण के (टे��ट अलाइ�म�ट) �वक�प आपको कहाँ �मलते
ह�?

Ans 1. र�बन

2. �टेटस बार

3. मेन ूबार

4. टायटल बार

Question Type : MCQ
Question ID : 618278616

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.58 �न�न म� से कौन सा �वक�प �वडंोज के �लए एक �ायलवेयर फ़ाइल आका�इवेर य�ूट�लट� टूल है?

Ans 1. ZIP

2. DOCX

3. PDF

4. WinRAR

Question Type : MCQ
Question ID : 618278617

Status : Answered
Chosen Option : 4

Marks : 1.00
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Q.59 �वडंोज म� एक ओपन �ो�ाम को बंद करने के �लए �कस क�बोड� शॉट�कट का उपयोग होगा?
Ans 1. Esc

2. Shift + Esc

3. Alt + ESC

4. Alt + F4

Question Type : MCQ
Question ID : 618278611

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.60 एक मे�लगं लेबल का �नमा�ण मे�लगं टैब के उपयोग से आरंभ �कया जाता है, इसके बाद बनाएँ समहू (��एट
�ुप) से ______ �वक�प का चयन करत ेह�।

Ans 1. बनाएँ (��एट)

2. �लफ़ाफ़े (ए�वल�स)

3. प� (लेटर)

4. लेब�स

Question Type : MCQ
Question ID : 618278628

Status : Answered
Chosen Option : 2

Marks : 1.00
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Q.1 एमएस वड� (MS Word) म� डाटा �ोत बनाए जाने तक आप म�ुय डॉ�यमू�ट म� ________ नह�ं जोड़ सकते
ह�।

Ans 1. से�स

2. फ़��ड

3. डाटा

4. टेब�स

Question Type : MCQ
Question ID : 618278807

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.2 कं�यटूर के मलू संगठन म� __________ शा�मल नह� ंहोता है।
Ans 1. मॉ�नटर

2. वेबकैम

3. CPU

4. क�बोड�

Question Type : MCQ
Question ID : 618278782

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.3 MS Excel 2010 म�, �कसी वक� शीट म� नई पंि�त या �तंभ (row or column) डालने के �लए, ________
टैब पर ि�लक कर� और �फर पंि�त या �तंभ (Rows or Columns) पर ि�लक कर�।

Ans 1. �यू

2. होम

3. इ�सट�

Participant ID 19428744
Participant Name RANI KUMARI
Test Center Name iON Digital Zone iDZ Jalalpur
Test Date 17/12/2019
Test Time 3:00 PM - 4:00 PM
Subject Data Entry Operator
Marks Obtained 29.00000

Section : MCQ for Data Entry Operator
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4. डाटा

Question Type : MCQ
Question ID : 618278820

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.4 ________ �य ूम� �कसी �ेज़ेटेशन क� �लाइड� को उनके सं�या�मक अन�ुम म� �द�श�त �कया जाता है।
Ans 1. आउटलाइन

2. ह�डआउट

3. नो�स

4. मा�टर

Question Type : MCQ
Question ID : 618278835

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.5 MS Excel म� सेल क� साम�ी (कंटे��स) को ए�डट करने के �लए _______ कंुजी का उपयोग �कया जाता है।
Ans 1. F2

2. Ctrl + Enter

3. F4

4. Shift + Enter

Question Type : MCQ
Question ID : 618278813

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.6 MS Windows screen के _______ �नचले कोने पर '�टाट�' बटन मौज़दू होता है।
Ans 1. नीचे क� तरफ़

2. दा� ओर

3. ऊपर क� तरफ़

4. बा� ओर

Question Type : MCQ
Question ID : 618278791

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.7 _________ डाटाबेस, लेब�स को ��टं करने के �लए उपयोगी है।
Ans 1. कै�कुलेटर

2. ��ेडशीट

3. नोटपडै
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4. एम एस प�ट

Question Type : MCQ
Question ID : 618278808

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.8 �न�न�ल�खत फ़ॉ�यू�ला का आउटपटु �या है?

= ABS(-5)
Ans 1. 5

2. 10

3. -5

4. 25

Question Type : MCQ
Question ID : 618278821

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.9 _______ सेव एज (Save As) के �लए शॉट�-कट कंुजी है।
Ans 1. F12

2. F2

3. Alt + S

4. Ctrl + A

Question Type : MCQ
Question ID : 618278833

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.10 MS Excel म� नई ख़ाल� वक� बकु बनाने के �लए �कस शॉट�कट कंुजी का उपयोग �कया जाता है?

Ans 1. Ctrl + Y

2. Ctrl + V

3. Ctrl + N

4. Ctrl + X

Question Type : MCQ
Question ID : 618278811

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.11 डाटा �ोत को ________ से जोड़ने के �लए, डाटा �ोत को मेल मज़� के �लए MS Word म� खोला जाना
चा�हए।

Ans 1. अ�ंतम डॉ�यमू�ट

2. फाइल �ोत
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3. डाटा को डॉ�यमू�ट के साथ मज़� कर�

4. म�ुय डॉ�यमू�ट

Question Type : MCQ
Question ID : 618278805

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.12 MS Word म� मेल मज़� डॉ�यमू�ट के ��येक सं�करण के �लए समान रहने वाल� जानकार� को __________
कहा जाता है।

Ans 1. डाटा को डॉ�यमू�ट के साथ मज़� कर�

2. अ�ंतम डॉ�यमू�ट

3. म�ुय डॉ�यमू�ट

4. डाटा �ोत

Question Type : MCQ
Question ID : 618278806

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.13 दो से अ�धक सेल� को मज़� नह�ं �कया जा सकता।
Ans 1. �नधा��रत नह�ं �कया जा सकता

2. अस�य

3. स�य

4. शायद

Question Type : MCQ
Question ID : 618278814

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.14 MS PowerPoint म�, PPT फ़ाइल का �डफ़ॉ�ट फ़ाइल नाम ________ होता है।
Ans 1. Document1

2. Book1

3. Presentation1

4. Untitled1

Question Type : MCQ
Question ID : 618278831

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.15

ANKAJ INFOTECH



1/27/2020 https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S63D224/157664724065016…

https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S63D224/15766472406501604/1942874… 5/16

Ans 1. �माट�आट� लेआउट गैलर� का �व�तार होगा।

2. चय�नत आरेख, वक� शीट म� डाला जाएगा।

3. ए�सेल फाइल बंद हो जाएगी।

4. �रबन �छप जाएगा।

Question Type : MCQ
Question ID : 618278830

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.16 MS Excel म� वक� बकु को सहेजने के �लए �कस शॉट�कट कंुजी संयोजन का उपयोग �कया जाता है?

Ans 1. Ctrl + S

2. Ctrl + X

3. Ctrl + C

4. Ctrl + Z

Question Type : MCQ
Question ID : 618278812

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.17 Excel म� सं�याओ ंको �य�त करने के �लए �डफ़ॉ�ट फ़ॉम�ट �या है?

Ans 1. उपयोगकता� �वारा पा�रभा�षत (User-defined)

2. जनरल

3. पस�ट

4. -1234

Question Type : MCQ
Question ID : 618278819

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.18 वक� शीट म� डटेा के �ा�फक �न�पण को प�रभा�षत करने के �लए �कस श�द का उपयोग �कया जाता है?

Ans 1. से�स

2. चाट�

3. टेबल

4. टे��ट
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Question Type : MCQ
Question ID : 618278828

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.19 �वडंोज़ ए�स�लोरर ________ के सम�प होता है।
Ans 1. माय डॉ�यमू��स

2. र�साइकल �बन

3. माय क��यटूर

4. फ़ो�डर

Question Type : MCQ
Question ID : 618278790

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.20 इंटरनेट से जड़ु ेहोने और उस पर काय� करने क� अव�था को ________ कहा जाता है।
Ans 1. ऑनलाइन

2. गेटवे

3. ऑफ़लाइन

4. नेट�केप

Question Type : MCQ
Question ID : 618278836

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.21 �कसी भी वेबसाइट को खोलने पर आपको �दखाई देने वाला पहला पेज़ �या कहलाता है?

Ans 1. होमपेज़

2. ला�ट पेज़

3. वेबसाइट

4. अ�से

Question Type : MCQ
Question ID : 618278838

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.22 रैम (RAM) क� �वशषेता म� _________ है।
Ans 1. �थाई

2. वोलाटाइल

3. वोलाटाइल के साथ-साथ नॉन-वोलाटाइल भी

4. नॉन-वोलाटाइल
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Question Type : MCQ
Question ID : 618278783

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.23 _______ यजूर और व�ड� वाइड वेब (WWW) के बीच एक इंटरफ़ेस के �प म� काय� करता है।
Ans 1. वेबपेज़

2. वेब �ाउज़र

3. होमपेज़

4. वेबसाइट

Question Type : MCQ
Question ID : 618278840

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.24 ROW Height को संशो�धत करने के �लए, होम टैब पर 'सेल' �ुप म� _______ �ॉप-डाउन �वक�प पर ि�लक
कर�।

Ans 1. �डल�ट

2. इ�सट�

3. �फ़ल

4. फ़ॉम�ट

Question Type : MCQ
Question ID : 618278815

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.25 पंि�तय� और �तंभ� (rows and columns) म� �यवि�थत डटेा के शी� �नमा�ण, म�ूयांकन एवं �व�लेषण के
�लए इनम� से �कसका उपयोग �कया जाता है?

Ans 1. ��ेडशीट पकेैज़

2. वड� �ोसे�सगं पकेैज़

3. ए�ल�केशन पकेैज़

4. आउटलाइन �ोसेसर

Question Type : MCQ
Question ID : 618278810

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.26 MS Word 2016 म�, ________ आपको फ़ॉ�ट नेम, फ़ॉ�ट साइज़ और फ़ॉ�ट �टाइल बदलने क� अनमु�त
देता है।

Ans 1. टा�क बार

2. �टेटस बार

3. �रबन
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4. ��ॉल बार

Question Type : MCQ
Question ID : 618278801

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.27 MS Word 2010 म�, फ़ाइल मेन ूके हाल के (recent) द�तावेज़� के साथ �दखाई देने वाल� अ�धकतम फाइल�
_________ ह�।

Ans 1. 3

2. 1

3. 25

4. 6

Question Type : MCQ
Question ID : 618278796

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.28 �न�न�ल�खत स�ू का आउ�पटु �या होगा?

=NOT(0)
Ans 1. 0

2. 1

3. False

4. True

Question Type : MCQ
Question ID : 618278817

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.29 जब आप �कसी वक� शीट को सरु��त करने के �लए �र�य ूटैब और �फर �ोटे�ट शीट �वक�प पर ि�लक करत ेह�,
तो एक डायलॉग बॉ�स खलुता है, जहाँ आप एक _________ सेट कर सकत ेह�।

Ans 1. �पन

2. पासवड�

3. कोड

4. यज़ूरनेम

Question Type : MCQ
Question ID : 618278816

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.30 ऑपरे�टगं �स�टम म�, ______ को बॉटम लेयर माना जाता है।
Ans 1. हाड�वेयर
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2. यज़ूर इंटरफ़ेस

3. GUI

4. सॉ�टवेयर

Question Type : MCQ
Question ID : 618278789

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.31 __________ �य ूका �योग आपक� �लाइड के लेआउट को एक ��टेंड ह�डआउट के �लए सेट करने के �लए
�कया जाता है।

Ans 1. मा�टर

2. ह�डआउट

3. नो�स

4. आउटलाइन

Question Type : MCQ
Question ID : 618278834

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.32 MS Word म�, �डफ़ॉ�ट और �ट�डड� पेज़ फ़ॉम�ट ________ होता है।
Ans 1. लॉगं बॉडं

2. टै�लॉइड

3. लेटर

4. ल�गल

Question Type : MCQ
Question ID : 618278804

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.33 मेल मज़� फ़�चर डाटाबेस जानकार� के फ़��ड या �े�णय� को �टै�टक टे��ट के साथ मज़� करके __________
उ�प�न करता है।

Ans 1. अ�ंतम डॉ�यमू�ट

2. डाटा �ोत

3. म�ुय डॉ�यमू�ट

4. मज़� डॉ�यमू�ट

Question Type : MCQ
Question ID : 618278809

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.34 य�द आप मा�स� के एक सेट से 50 से अ�धक वाले मा�स� के औसत क� गणना करना चाहत ेह�, तो आप
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�न�न�ल�खत म� से �कस स�ू का उपयोग कर�गे?

Ans 1. AVERAGEIF

2. AVGIF

3. AVERAGE

4. AVERAGE50

Question Type : MCQ
Question ID : 618278826

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.35 इनम� से कौन सा MS Excel म� फ़ॉ�यू�ला के पहले आता है?

Ans 1. *

2. =

3. #

4. &

Question Type : MCQ
Question ID : 618278825

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.36 �न�न�ल�खत म� से कौन सा एक सामा�य �योजन हेत ु�न�म�त अन�ुयोग (ए�ल�केशन) सॉ�टवेयर
(Application Software) नह�ं है?

Ans 1. वड� �ोसे�सगं

2. DBMS

3. �ेज�टेशन सॉ�टवेयर

4. जावा

Question Type : MCQ
Question ID : 618278786

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.37 ______ एरो कंुजी का उपयोग एक वण� बा� ओर ले जाने के �लए �कया जाता है।
Ans 1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 618278798

Status : Answered
Chosen Option : 2

Marks : 1.00
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Q.38 MS Excel म� _______ फ़ं�शन का उपयोग सं�या�मक डटेा वाल� सेल� को �गनने के �लए �कया जाता है।
Ans 1. टोटल (TOTAL)

2. सम (SUM)

3. काउंट (COUNT)

4. ऐड (ADD)

Question Type : MCQ
Question ID : 618278827

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.39 MS PowerPoint म� टे��ट �लेसहो�डर ________ होता है।
Ans 1. एक आयताकार ठोस रेखा (rectangular solid line)

2. एक ड�ैड रेखा (dashed line)

3. एक �बदं�दार रेखा (dotted line)

4. गुलाबी रंग का (Pink Coloured)

Question Type : MCQ
Question ID : 618278832

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.40 जब हम �कसी फ़ाइल को �डल�ट करत ेह�, तो फ़ाइल _________ नामक अ�थाई मेमोर� म� चल� जाती है।
Ans 1. माय �ीफ़केस

2. माय क��यटूर

3. इंटरनेट ए�स�लोरर

4. र�साइकल �बन

Question Type : MCQ
Question ID : 618278792

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.41 MS Word म�, �पेल चेक (Spell Check) �वक�प �न�न�ल�खत म� से �क़सम� ��ुट क� खोज करेगा?
Ans 1. Is a beautiful sunny day.

2. It isa beautiful, sunny day.

3. It in a beautiful, sunny day.

4. It is a beautiful sunny.

Question Type : MCQ
Question ID : 618278802

Status : Answered
Chosen Option : 2

Marks : 1.00
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Q.42 कं�यटूर को �दए जाने वाले असंग�ठत अप�र�कृत त�य� और आकँड़� को साम�ूहक �प से �या कहा जाता है?

Ans 1. आउटपटु

2. इ�फम�शन

3. रोम (ROM)

4. डाटा

Question Type : MCQ
Question ID : 618278781

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.43 सेल म� डाटा के �लए �ै�तज एव ंऊ�वा�धर संरेखण सेट करने के �लए �कस फ़ॉम�ट सेल मेन ूका उपयोग �कया
जाता है?

Ans 1. अलाइनम�ट

2. नंबर

3. बकै�ाउंड

4. फॉ�ट

Question Type : MCQ
Question ID : 618278818

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.44 MS Excel म� कौन सा टैब, आपको वक� शीट म� �माट� आट� ऑ�जे�ट जोड़ने क� अनमु�त देता है?

Ans 1. होम

2. इ�सट�

3. फ़ॉ�यू�ला

4. र��यू

Question Type : MCQ
Question ID : 618278829

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.45 वड� डॉ�यमू��स को _________ का उपयोग करके सहेजा जा सकता है।
Ans 1. File → Close

2. Ctrl + S

3. File → Open

4. Ctrl + M

Question Type : MCQ
Question ID : 618278795

Status : Answered
Chosen Option : 2

Marks : 1.00
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Q.46 वह फ़ाइल, जो MS Word डॉ�यमू�ट म� खलु� थी, उसे FILE टैब म� मौज़दू _______ �वक�प का उपयोग
करके बंद �कया जा सकता है।

Ans 1. सेव (save)

2. ओपन (open)

3. �लोज (close)

4. ए�डट (edit)

Question Type : MCQ
Question ID : 618278797

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.47 ______ म� बॉल क� ग�त के संसचून के �लए लेज़र तकनीक का उपयोग �कया जाता है।
Ans 1. रोलर बॉल माउस

2. वायरलेस क�बोड�

3. टच���न

4. ऑि�टकल माउस

Question Type : MCQ
Question ID : 618278785

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.48 इनम� से कौन सा यआूरएल (URL) का भाग नह�ं है?

Ans 1. पोट� नंबर

2. �ोटोकॉल

3. डोमेन अ�से

4. IP  अ�से

Question Type : MCQ
Question ID : 618278839

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.49 MS Word 2010 म�, वह कमान (कमांड) जो टे��ट को हटाती है (कट करती है) ________ म� मौज़दू होती
है।

Ans 1. ए�डट मेनू

2. होम मेनू

3. फ़ाइल मेनू

4. �य ूमेनू

Question Type : MCQ
Question ID : 618278793

Status : Answered
Chosen Option : 2
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Marks : 1.00

Q.50 होम मेन ूम� सेल �ुप म� मौज़दू इ�सट� �ॉप-डाउन �ल�ट (Insert drop-down list) के अतंग�त �कतने �वक�प
मौज़दू होत ेह�?

Ans 1. 5

2. 3

3. 6

4. 4

Question Type : MCQ
Question ID : 618278823

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.51 _______ अनवुादक (translators) तीन �कार के होत ेह�।
Ans 1. कंपाइलर (Compiler)

2. अस�बलर (Assembler)

3. �डब�गर (Debugger)

4. ल��वेज़ (Language)

Question Type : MCQ
Question ID : 618278788

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.52 �न�न�ल�खत म� से कौन सा ऑपरे�टगं �स�टम का काय� नह�ं है?

Ans 1. फ़ाइल �बंधन (मनेैजम�ट)

2. डाटाबेस �बंधन (मनेैजम�ट)

3. �ोसेसर �बंधन (मनेैजम�ट)

4. मेमोर� �बंधन (मनेैजम�ट)

Question Type : MCQ
Question ID : 618278787

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.53 MS Word सभी संभा�वत ��ुटय� को लहरदार ________ के �नशान �वारा �चि�नत करता है।
Ans 1. अडंरलाइन

2. बो�ड

3. चेक

4. ��ाइक

Question Type : MCQ
Question ID : 618278803

Status : Answered
Chosen Option : 1ANKAJ INFOTECH
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Marks : 1.00

Q.54 �न�न�ल�खत फ़ॉ�यू�ला का आउटपटु �या है?

=sum(1,2,3)
Ans 1. 5

2. 7

3. 6

4. 10

Question Type : MCQ
Question ID : 618278824

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.55 लाइट पेन का �या उपयोग है?

Ans 1. पेन �ाइव का �र�लेसम�ट

2. �ा�फ़�स और �डज़ाइ�नगं म�

3. गेम खेलने म�

4. कं�यटूर का उपयोग �कए �बना नोटपडै पर �लखने म�

Question Type : MCQ
Question ID : 618278784

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.56 MS Word 2010 म� �कसी श�द पर _______ उस परेू श�द को सेले�ट �कया जा सकता है।
Ans 1. ALT+ ि�लक करके

2. �सगंल ि�लक करके

3. डबल ि�लक करके

4. ��पल ि�लक करके

Question Type : MCQ
Question ID : 618278800

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.57 MS Excel 2016 म�, सेल �टाइल के अतंग�त �कतने नंबर फ़ॉम�ट मौज़दू होत ेह�?
Ans 1. दो

2. आठ

3. चार

4. पाँच

Question Type : MCQ
Question ID : 618278822

Status : Answered
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Chosen Option : 1
Marks : 0.00

Q.58 ऑनलाइन �ा�त करने के �लए इनम� से कौनसे एक मलू हाड�वेयर आव�यकता नह�ं है?

Ans 1. ��टंर

2. टेल�फ़ोन लाइन

3. मॉडमे

4. कं�यटूर

Question Type : MCQ
Question ID : 618278837

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.59 ________ हाड�वेयर क� �मता को बढ़ाता है और कं�यटूर को इनपटु, �ोसे�सगं और आउटपटु जसेै काय� करने
के �लए �नद�श देता है।

Ans 1. GUI

2. ��ेडशीट

3. हाड�वेयर

4. सॉ�टवेयर

Question Type : MCQ
Question ID : 618278794

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.60 MS Word डॉ�यमू�ट को _________ �वक�प का चयन करके और ओके (OK) पर ि�लक करके ��टं �कया
जा सकता है।

Ans 1. File → Print

2. File → Close

3. File → Save

4. File → Open

Question Type : MCQ
Question ID : 618278799

Status : Answered
Chosen Option : 1

Marks : 1.00
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Q.1 MS Excel म� एक �तंभ (column) म� मौज़दू डटेा को पंि�त (row) म� बदलने के �लए आप �कस कमान
(कमांड) का चयन कर�गे?

Ans 1. Paste Special >> Transpose

2. Paste Special

3. Format Painter

4. Cut and Paste

Question Type : MCQ
Question ID : 618278881

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.2 MS Excel म�, आप कुछ सेल� को जोड़ने और साम�ी को जड़ुने के प�चात �ा�त सेल के म�य म� रखने के �लए
______ टूल का उपयोग कर सकत ेह�।

Ans 1. मज़� सेल चेकबॉ�स (Merge cells checkbox)

2. कंबाइन अडँ स�टर (Combine and Centre)

3. स�टड� अलाइनम�ट (Centred alignment)

4. मज़� अडँ स�टर (Merge and Centre)

Question Type : MCQ
Question ID : 618278878

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.3 फ़ॉ�यू�ला काउंट नंबस� (Count Numbers) का �या काय� है?

Ans 1. यह �कसी सं�या म� अकं� क� सं�या को दशा�ता है।

2. यह चय�नत सीमा के भीतर मौजदू सं�याओ ंक� �गनती को दशा�ता है।

3. यह �कसी टे��ट के समत�ुय सं�या को दशा�ता है।

Participant ID 19355429
Participant Name RAKESH KUMAR
Test Center Name iON Digital Zone iDZ Jalalpur
Test Date 17/12/2019
Test Time 12:00 PM - 1:00 PM
Subject Data Entry Operator
Marks Obtained 16.00000

Section : MCQ for Data Entry Operator
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4. यह चय�नत सीमा के अदंर मौज़दू सेल� क� �गनती को दशा�ता है।

Question Type : MCQ
Question ID : 618278883

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.4 MS Excel म� एक नई वक� शीट इ�सट� करने के �लए ______ कंुजी का उपयोग �कया जाता है।
Ans 1. Shift + F11

2. Ctrl + F11

3. Shift + F12

4. Ctrl + F12

Question Type : MCQ
Question ID : 618278871

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.5 इनम� से कौन सी वेब �वारा �दान क� जाने वाल� सेवा नह�ं है?

Ans 1. समाचार समहू

2. ईमेल

3. च�ैटगं

4. एफट�पी (FTP)

Question Type : MCQ
Question ID : 618278896

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.6 In MS Word 2016 Mail Merge, a data source document in Word has ______.
Ans 1. fields and records

2. only names

3. only columns

4. only rows

Question Type : MCQ
Question ID : 618278867

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.7 ______ अ�थायी �प से चय�नत चीज़� को सं��हत करता है, िज�ह� कॉपी या कट �कया जाता है।
Ans 1. डशैबोड�

2. �लकैबोड�

3. �हाइटबोड�

4. ि�लपबोड�
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Question Type : MCQ
Question ID : 618278860

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.8 ______ का उपयोग �ेज़�टेशन को बड़ी ���न या �ोज़े�टर पर �दखाने के �लए �कया जाता है।
Ans 1. �ड��ले �लाइड

2. मा�टर �लाइड

3. �य ू�लाइड

4. �लाइड शो

Question Type : MCQ
Question ID : 618278893

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.9 MS Word 2010 म� मेल मज़� म� ______ का उपयोग �कया जाता है।
Ans 1. �ाथ�मक द�तावेज़

2. �ारं�भक द�तावेज़

3. ��वतीयक द�तावेज़

4. म�ुय द�तावेज़

Question Type : MCQ
Question ID : 618278865

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.10 हम ______ के �वारा वक� बकु को सं�ह�त और सरु��त नह�ं कर सकत ेह�।
Ans 1. सरु�ा पासवड�

2. Read-only अनशुं�सत करने

3. �रज़व�शन पासवड� �लखने

4. सरु��त कर� और हटाएँ

Question Type : MCQ
Question ID : 618278877

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.11 MS Word 2016 म�, मेल मज़� �वज़ाड� का अ�ंतम चरण (चरण 6) कौन सा है?

Ans 1. सहेज� और ��टं कर�

2. अपना वण� �लखो

3. अपने वण� का पवूा�वलोकन कर�

4. मज� को पणू� कर�
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Question Type : MCQ
Question ID : 618278869

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.12 अस�बल� ल��वेज़, �कस जनरेशन क� भाषा है?

Ans 1. 3 GL

2. 4 GL

3. 2 GL

4. 1 GL

Question Type : MCQ
Question ID : 618278848

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.13 ______ बॉ�स आपके कं�यटूर पर चीज़� को खोजने के सबसे स�ुवधाजनक तर�क� म� से एक है।
Ans 1. �ट�फ़न

2. टूल

3. क�पास

4. सच�

Question Type : MCQ
Question ID : 618278852

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.14 ______ कंुजी, �कसी भी फ़ाइल(ल�) या फ़ो�डर को �डल�ट करती है।
Ans 1. Delete

2. Enter

3. Shift

4. Alt

Question Type : MCQ
Question ID : 618278853

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.15

Ans 1. 

2. 

3. 

4. 
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Question Type : MCQ
Question ID : 618278886

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.16 MS Excel म� डटेा को व�ृत के �प म� �द�श�त करने वाले चाट� का नाम बताऍ �।
Ans 1. �े�फल (ए�रया) चाट�

2. �कैटर चाट�

3. पाई चाट�

4. बार चाट�

Question Type : MCQ
Question ID : 618278888

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.17 MS Excel 2016 शीट म�, एक कॉलम म� बहुत सी डुि�लकेट ��वि�टया ँह�। आपको डुि�लकेट हटाने का �वक�प
कहाँ �मलेगा?

Ans 1. डटेा

2. इ�सट�

3. होम

4. पेज़ लेआउट

Question Type : MCQ
Question ID : 618278874

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.18 DBMS का पणू� �प �या है?

Ans 1. Database Management System (डटेाबेस मनेैजम�ट �स�टम)

2. Database Media System (डटेाबेस मी�डया �स�टम)

3. Digitalbase Management System (�डिजटलबेस मनेैजम�ट �स�टम)

4. Databasic Management System (डटेाबे�सक मनेैजम�ट �स�टम)

Question Type : MCQ
Question ID : 618278847

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.19 ______ ��य, एक एकल �लाइड, �ेज़�टेशन क� आउटलाइन और �पीकर नो�स �े� को �द�श�त करता है।
Ans 1. आउटलाइन

2. नॉम�ल

3. नो�स

4. ह�डआउट
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Question Type : MCQ
Question ID : 618278895

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.20 ि�लपबोड� से �लए गए पाठ (टे��ट) को संपा�दत (ए�डट) �कए जा रहे डॉ�यमू�ट म� �चपकाने करने के �लए,
______ कंुजी दबाएँ।

Ans 1. Ctrl + X

2. Ctrl + Z

3. Ctrl + A

4. Ctrl + V

Question Type : MCQ
Question ID : 618278855

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.21 MS Word 2016 म�, �पे�लगं और �ामर डायलॉग बॉ�स ______ बटन दबाकर �द�श�त �कया जा सकता है।
Ans 1. F7

2. F5

3. F4

4. F6

Question Type : MCQ
Question ID : 618278862

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.22 �न�न�ल�खत म� से कौनसे फ़ॉ�यू�ले का उपयोग दो या अ�धक टे��ट को जोड़ने के �लए �कया जा सकता है?

Ans 1. मज़�

2. जॉइन

3. का�कैटनेट

4. ऐड

Question Type : MCQ
Question ID : 618278885

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.23 MS Word म� �ॉप कै�स ______ पर लागू नह�ं होत ेह�।
Ans 1. वण�

2. सीमाओं

3. श�द�

4. अ�र�
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Question Type : MCQ
Question ID : 618278858

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.24 �डफ़ॉ�ट �प से, MS Word 2016, आपके पाठ (टे��ट) को ______ के �प म� फ़ॉम�ट करता है।
Ans 1. 12-पॉइंट ए�रयल

2. 13-पॉइंट मंगल

3. 11-पॉइंट कैल�बर�

4. 11-पॉइंट टाइ�स �य ूरोमन

Question Type : MCQ
Question ID : 618278857

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.25 �न�न�ल�खत म� से �कसक� डटेा सं�हण �मता उ�चतम होती है?

Ans 1. CD

2. �लॉपी �ड�क

3. �ल-ूरे �ड�क

4. �ा�फ़क काड�

Question Type : MCQ
Question ID : 618278844

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.26 ______ MS Windows ���न के �न�नतम भाग पर मौजदू प�ी होती है, िजसम� खलेु �ो�ाम �दखाई देत ेह�।
Ans 1. ड�ेकटॉप

2. �टेटस बार

3. टा�क बार

4. �वडंोज़

Question Type : MCQ
Question ID : 618278850

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.27

Ans 1. 

2. 

3. 

4. 
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Question Type : MCQ
Question ID : 618278880

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.28 इनम� से कौन सा उपकरण दो या अ�धक असम�प नेटवक� को जोड़ने के �लए �योग मे लाया जाता है?

Ans 1. आतं�रक मॉडमे

2. कं�यटूर

3. गेटवे

4. बा� मॉडमे

Question Type : MCQ
Question ID : 618278898

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.29 आप वक� शीट को उपयोगकता�ओ/ंपाठक� के �लए अ�धक �ासं�गक बनाने के �लए इसे ______ कर सकत ेह�।
Ans 1. फ़ॉम�ट (Format)

2. �डल�ट (Delete)

3. र�नेम (Rename)

4. ए�डट (Edit)

Question Type : MCQ
Question ID : 618278870

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.30 MS Word 2003 म�, मेल मज़� मज़�र हे�पर बॉ�स म� ______ नह�ं होता है।
Ans 1. डटेा को द�तावेज़ के साथ मज़� करने के �लए कमान (कमांड)

2. अ�ंतम द�तावेज़

3. म�ुय द�तावेज़

4. डटेा �ोत

Question Type : MCQ
Question ID : 618278866

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.31 �कसी एक कं�यटूर पर एक ______ �था�पत �कया जा सकता है।
Ans 1. होम पेज़

2. वेबसाइट

3. वेबपेज

4. वेब �ाउज़र
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Question Type : MCQ
Question ID : 618278900

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.32 MS Word म� टे��ट को ______ बटन दबाकर अडंरलाइन �कया जा सकता है।
Ans 1. Ctrl + C

2. Ctrl + B

3. Ctrl + U

4. Ctrl + I

Question Type : MCQ
Question ID : 618278859

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.33 �न�न�ल�खत म� से कौन सा ए�सेल म� सरु�ा के संबंध म� वधै नह�ं है?

Ans 1. वक� �पेस सरु��त कर�।

2. शीट सरु��त कर�।

3. वक� बकु को सरु��त कर� और साझा कर�।

4. वक� बकु सरु��त कर�।

Question Type : MCQ
Question ID : 618278876

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.34 आप Excel म� वक� शीट का बकै�ाउंड कलर �कस �कार बदलत ेह�?
Ans 1. आप इ�सट� टैब का उपयोग करके �कसी वक� बकु म� केवल एक वक� शीट का बकै�ाउंड बदल सकत ेह�।

2. आपको बकै�ाउंड से�ट�ंस के अतंग�त ऑ�श�स डायलॉग बॉ�स म� बकै�ाउंड कलर से�टगं को
बदलना होगा।

3. आप वक� शीट का बकै�ाउंड कलर नह� ंबदल सकत ेह�।

4. परू� वक� शीट का चयन कर�। फ़ॉ�ट �ुप म�, होम टैब के अतंग�त, �फ़ल कलर गैलर� से रंग चनु�।

Question Type : MCQ
Question ID : 618278889

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.35 ______ �वडंोज़ का सं�करण नह�ं है।
Ans 1. �वडंोज़ एनट� (Windows NT)

2. �वडंोज़ एमई (Windows ME)

3. �वडंोज़ 21 (Windows 21)

4. �वडंोज़ ए�सपी (Windows XP)
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Question Type : MCQ
Question ID : 618278854

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.36 MS Word 2016 मेल मज़� म�, �न�न�ल�खत म� से �ा�तकता� �कार का वधै चयन कौन सा है?

Ans 1. वेबसाइट से चयन

2. टे��ट फ़ाइल से �नकालकर

3. आउटलकु कांटै�ट से चयन

4. पॉवरपॉइंट का उपयोग करके

Question Type : MCQ
Question ID : 618278868

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.37 डॉट म�ै��स ��टंर एक �कार का ______ है।
Ans 1. नॉन-इ�प�ैट ��टंर

2. इ�प�ैट ��टंर

3. मनैअुल ��टंर

4. म�ै��स ��टंर

Question Type : MCQ
Question ID : 618278843

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.38

Ans
1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 618278890

Status : Answered
Chosen Option : 3ANKAJ INFOTECH
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Marks : 0.00

Q.39 MS Excel 2016 म�, �पवट टेबल _____ मेन ूके अतंग�त मौज़दू होती है।
Ans 1. �यू

2. र��यू

3. होम

4. इ�सट�

Question Type : MCQ
Question ID : 618278872

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.40 ‘Del’ कंुजी कस�र के ______ से वण� को हटाती है।
Ans 1. दा� ओर

2. शीष� से

3. बा� ओर

4. क� � से

Question Type : MCQ
Question ID : 618278856

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.41 ______ कॉलम म� केवल �न�द��ट मानदंड के अनसुार डटेा �द�श�त करता है।
Ans 1. सॉ�ट�ग

2. �पवट

3. �फ़�ट�रगं

4. फ़ॉ�यू�ला

Question Type : MCQ
Question ID : 618278879

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.42 ______, �कसी �ेज़�टेशन म� बाद म� कुछ रखने के �लए �नधा��रत �े� है।
Ans 1. �लकैबॉ�स

2. ऑ�ज़े�ट हो�डर

3. टे��टबॉ�स

4. �लेसहो�डर

Question Type : MCQ
Question ID : 618278892

Status : Answered
Chosen Option : 3
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Marks : 0.00

Q.43 MS Excel म� फ़ामु�ल� के अदंर फं�श�स का उपयोग �कया जाता है।
Ans 1. स�य

2. अस�य

3. शायद

4. �नधा��रत नह�ं कर सकते

Question Type : MCQ
Question ID : 618278887

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.44 वह घटक जो सभी ग�णतीय (मथैमे�टकल) गणनाओ ंएव ंकं�यटूर के ता�क� क संचालन (लॉिजकल ऑपरेश�स)
के �नयं�ण के �लए िज�मेदार है, उसे ______ कहा जाता है।

Ans 1. MU

2. CU

3. ALU

4. ROM

Question Type : MCQ
Question ID : 618278842

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.45 ______, MS PowerPoint �ेज़�टेशन के म�ुय �बि�डगं �लॉक ह�।
Ans 1. टे��ट

2. �लाइड

3. �प�चस�

4. वी�डयो

Question Type : MCQ
Question ID : 618278894

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.46 ए�सेल वक� बकु के होम टैब के अतंग�त से�स �ुप म� मौजदू ______ बटन का उपयोग पंि�तय� और �तंभ�
(rows and columns) क� चौड़ाई और ऊंचाई को समायोिजत करने के �लए भी �कया जा सकता है।

Ans 1. नंबर (Number)

2. फ़ाइल (File)

3. फ़ॉम�ट (Format)

4. �टाइल (Styles)

Question Type : MCQ
Question ID : 618278875
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Status : Answered
Chosen Option : 3

Marks : 1.00

Q.47 ______, �ो�ाम को लाइन-बाय-लाइन का अनवुा�दत करता है।
Ans 1. ऑपरे�टगं �स�टम

2. अस�बलर

3. इंटर�ेटर

4. कंपाइलर

Question Type : MCQ
Question ID : 618278849

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.48 लेज़र ��टंर म� ______ का उपयोग �कया जाता है।
Ans 1. फोटोकॉपी तकनीक (Photocopy technology)

2. ��े �याह� (Spray ink)

3. ऊ�मा-संवेद� कागज़ (Heat sensitive paper)

4. डाई �याह� (Dye ink)

Question Type : MCQ
Question ID : 618278845

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.49 आपको सरु��त सेल� (protected cells) को अनलॉक करने के �लए पासवड� डालने क� आव�यकता होती है।
Ans 1. शायद

2. स�य

3. अस�य

4. �नधा��रत नह�ं �कया जा सकता

Question Type : MCQ
Question ID : 618278884

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.50 कौन सा सॉ�टवेयर सामा�यतः �यि�तय� या संगठन� क� ज�रत� क� प�ूत � करने के �लए �डज़ाइन �कया जाता
है?

Ans 1. सामा�य उ�े�य (General purpose)

2. अन�ुयोग (Application)

3. �व�नधा��रत (Customised)

4. �व�श�ट उ�े�य (Specific purpose)

Question Type : MCQ
ANKAJ INFOTECH
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Question ID : 618278846
Status : Answered

Chosen Option : 2
Marks : 1.00

Q.51 आप वक� शीट म� अवां�छत पंि�तय� और �तंभ� को ______ कर सकत ेह�।
Ans 1. ए�डट (Edit)

2. र�नेम (Rename)

3. �डल�ट (Delete)

4. सेव (Save)

Question Type : MCQ
Question ID : 618278873

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.52 �न�न�ल�खत म� से कौन सा पाई चाट� का सह� �कार है?

Ans 1. 3-D पाई

2. �पवट चाट�

3. 2-D पाई

4. डोनट

Question Type : MCQ
Question ID : 618278882

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.53 MS PowerPoint म�, PPT फ़ाइल को ______ ए�सट�शन के साथ सहेजा जाता है।
Ans 1. OPT

2. PPT

3. ODT

4. ODP

Question Type : MCQ
Question ID : 618278891

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.54 इनम� से कौन सा इंटरनेट कने�शन का �कार नह�ं है?

Ans 1. डायल-अप ए�सेस

2. �ॉडब�ड

3. आईएसपी (ISP)

4. ल�ज़ ्लाइन

Question Type : MCQ
Question ID : 618278897ANKAJ INFOTECH
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Status : Answered
Chosen Option : 1

Marks : 0.00

Q.55

Ans 1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 618278899

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.56 ______ �वडंोज़ ड�ेकटॉप के सबसे मह�वपणू� आइकन� म� से एक है, िजसम� ने�वगेशन पेन, �य ूपेन और
�डटे�स पेन शा�मल होत ेह�।

Ans 1. माय क��यटूर

2. फ़ो�डर

3. र�साइकल �बन

4. माय डॉ�यमू��स

Question Type : MCQ
Question ID : 618278851

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.57 MS Word म�, य�द �कसी टे��ट म� हरे रंग क� लहरदार रेखा �दखाई देती है, तो यह ______ को इं�गत करता
है।

Ans 1. कोई ��ुट न होने

2. एक �याकर�णक ��ुट

3. एका�धक ��ुटय�

4. एक वत�नी ��ुट

Question Type : MCQ
Question ID : 618278863

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.58

Ans 1. 

2. 

3. 
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4. 

Question Type : MCQ
Question ID : 618278864

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.59 �न�न�ल�खत म� से कौन सा सीपीय ू(CPU) का भाग नह�ं है?

Ans 1. CU

2. VDU

3. ALU

4. MU

Question Type : MCQ
Question ID : 618278841

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.60 य�द आप स�ू O2 म� अकं 2 को �दखाए गए अनसुार �द�श�त करना चाहत ेह�, तो आप �कस �वक�प का उपयोग
कर�गे?

Ans 1. वड� आट�

2. सबि���ट

3. �सबं�स

4. फ़ॉ�ट आकार घटाएँ

Question Type : MCQ
Question ID : 618278861

Status : Answered
Chosen Option : 2

Marks : 1.00
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Q.1 एक नया ख़ाल� MS PowerPoint 2016 �ेज�टेशन, �डफ़ॉ�ट �प से ______ �लाइड/�लाइड� के साथ खलुता
है।

Ans 1. 2

2. 1

3. 4

4. 3

Question Type : MCQ
Question ID : 618278772

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.2 इनम� से कौन सा �च�न, एक ईमेल पत ेके दो भाग� को अलग करता है?

Ans 1. $

2. *

3. &

4. @

Question Type : MCQ
Question ID : 618278778

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.3 Windows XP म�, ॲ�शन स�टर एक _______ होता है।
Ans 1. अ�धसचूना (Notification)

2. संदेश (Message)

3. चेतावनी (Warning)

4. अन�ुमारक (Reminder)

Participant ID 19313571
Participant Name PANKAJ PRIYANSHU
Test Center Name iON Digital Zone iDZ 2 Patliputra
Test Date 17/12/2019
Test Time 9:00 AM - 10:00 AM
Subject Data Entry Operator
Marks Obtained 32.00000

Section : MCQ for Data Entry Operator
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Question Type : MCQ
Question ID : 618278730

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.4 सोस� �ो�ाम �या है?

Ans 1. मशीनी भाषा म� �लखा गया एक �ो�ाम

2. एच एल एल (HLL) म� �लखे गए �ो�ाम का मशीनी भाषा म� �पांतरण

3. मशीनी भाषा म� �पांत�रत �कया जाने वाला �ो�ाम

4. �ो�ाम

Question Type : MCQ
Question ID : 618278728

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.5 आप अपने कं�यटूर म� सहेजी गई कोई त�वीर ए�सेल वक� शीट म� कैसे डाल सकत ेह�?
Ans 1. इ�सट� टैब पर ि�लक करके, �च� का चयन कर� और चयन और इ�सट� करने के �लए अपने PC पर

फोटो को खोजे।

2. आप ए�सेल वक� शीट म� फ़ोटो नह�ं डाल सकत।े

3. इ�सट� टैब पर ि�लक करके और फोटो गैलर� �ुप से फोटो का चयन करके।

4. इमेजेस कॉटें�चअुल टैब पर ि�लक करके और अपने PC पर इ�सट� क� जाने वाल� फोटो का चयन
कर�।

Question Type : MCQ
Question ID : 618278769

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.6 MS Word म�, ___________ �वक�प, आपको परैा�ाफ को बाएँ या दाएँ मािज�न से हा�शया छोड़ने (indent)
क� अनमु�त �दान करता है।

Ans 1. फॉम��टगं

2. इंड�ेटेशन

3. एलाइनम�ट

4. �पे�सगं

Question Type : MCQ
Question ID : 618278741

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.7 __________ आपके �वारा सं�ह क� गई साम�ी के सं�ह (collections) होत ेह�, िज�ह� आसानी से
ड�ेकटॉप सच� फ़ं�शन के मा�यम से ॲ�सेस �कया जा सकता है।

Ans 1. फाइल�
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2. �टोरेज़

3. लाइ�ेर�ज

4. कले�श�स

Question Type : MCQ
Question ID : 618278732

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.8 उपयोगकता� को मॉ�नटर पर �ा�त होने वाले अ�ंतम आउटपटु को �या कहा जाता है?

Ans 1. हाड�कॉपी

2. सॉ�टकॉपी

3. मशीन ल��वेज़ कॉपी

4. सॉ�टवेयर

Question Type : MCQ
Question ID : 618278721

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.9 आपके �वारा उपयोग �कए जाने वाले पासवड� पर लंबाई, वण� या सं�याओ ंके संबंध म� कोई ��तबंध नह�ं है,
ले�कन पासवड� _______ होत ेह�।

Ans 1. �वशषे वण�

2. हमेशा छोटे अ�र� म�

3. केस-स�स�टव

4. हमेशा बड़ ेअ�र� म�

Question Type : MCQ
Question ID : 618278763

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.10 इनम� से कौन सा य�ूट�लट� �ो�ाम का �ह�सा नह�ं है?

Ans 1. वायरस �कै�नगं सॉ�टवेयर

2. �ड�क �ड�ैगम�टर

3. ब�ूटगं

4. बकैअप सॉ�टवेयर

Question Type : MCQ
Question ID : 618278727

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.11 __________ क�टम मेल बनाने के �लए �य�ुत MS Word का एक शि�तशाल� �वशषेता है।
Ans
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1. वत�नी और �याकरण

2. MS Word

3. मेल मज़�

4. भाषा

Question Type : MCQ
Question ID : 618278745

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.12 आप MS Excel 2016 वक� शीट म� �वचा�लत प�ृठ सं�या (ऑटोमे�टक पेज नंबर) �कस �कार दज़� करत ेह�,
ता�क वक� शीट को ��टं करत ेसमय आसानी से कोलेट �कया जा सके?

Ans 1. फ़ॉ�यू�ला मेन ूके अतंग�त नेम मनेैजर का उपयोग करके

2. इ�सट� मेन ूके अतंग�त टाइमलाइन फ़ं�शन का उपयोग करके

3. पेज लेआउट टैब म�, पेज सेटअप डायलॉग बॉ�स के तहत, ��येक प�ृठ के हेडर या फ़ुटर �े� म�
�वचा�लत प�ृठ सं�या (ऑटोम�ैटक पेज नंबर) दज़� करने के �लए हेडर या फ़ुटर टूल का उपयोग करके

4. �य ूमेन ूके अतंग�त हे�डगं फ़ं�शन का उपयोग करके

Question Type : MCQ
Question ID : 618278762

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.13 MS Excel 2016 म�, इनम� से कौन सा वधै डाटा �कार नह�ं है?

Ans 1. डटे (�दनांक)

2. इमेज

3. टे��ट

4. सं�या (नंबर)

Question Type : MCQ
Question ID : 618278765

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.14 By default, the text entries in MS Excel 2016 are _________ aligned.
Ans 1. right

2. up

3. down

4. bottom left

Question Type : MCQ
Question ID : 618278760

Status : Answered
Chosen Option : 1

Marks : 0.00
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Q.15 MS Word म� केवल पहल� पंि�त को छोड़कर, इसके नीचे क� ��येक पंि�त को �थानांतरतन करने को �या
कहा जाता है?

Ans 1. दाएँ

2. पहल� पंि�त

3. बाएँ

4. ह��गगं इंड�ट

Question Type : MCQ
Question ID : 618278738

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.16 MS Word म�, पा�य (text) के �कसी भी गुण को बदलने के �लए, इसे पहले _________ चा�हए।
Ans 1. चयन �कया जाना

2. सहेजा जाना

3. बदला जाना

4. �डल�ट �कया जाना

Question Type : MCQ
Question ID : 618278740

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.17 एक �कूल के कं�यटूर �लब 'बाइ�स अडँ �नब�स' के सद�य, एक ��ेडशीट का उपयोग करके अपने वा�ष�क
अतंर-�कूल संगो�ठ� म� सभी ��तभा�गय� के �लए भागीदार� �माण प� तयैार करना और म�ु�त करना चाहते
ह�, िजसम� आयोजन� और �कूल� के साथ भाग लेने वाले छा�� का �ववरण दज़� �कया गया हो।
इनम� से कौन सी ऑ�फ़स तकनीक वां�छत प�रणाम �ा�त करने के �लए सबसे उपय�ुत है?

Ans 1. मेल मज़�

2. रे��स

3. बकुमाक�

4. इ�सट� �स�नेचर

Question Type : MCQ
Question ID : 618278746

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.18 सबसे �नचल� �लाइड से पहल� �लाइड पर जाने के �लए, क�बोड� पर ________ दबाएँ।
Ans 1. End

2. Up arrow

3. Home

4. PageUp या PgUp

Question Type : MCQ
Question ID : 618278773
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Status : Answered
Chosen Option : 2

Marks : 0.00

Q.19 ________ एक सॉ�टवेयर पकेैज़ है, जो चाट�, �ाफ, �लाइड, ह�डआउट आ�द का उपयोग करके �ेज�टेशन �दान
करता है।

Ans 1. MS Word

2. MS PowerPoint

3. MS Access

4. MS Paint

Question Type : MCQ
Question ID : 618278771

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.20 MS Word म�, मेल मज� का उपयोग करत ेसमय, ________ डटेा �ोत म� �यि�तगत व�तओु ं(individual
items) क� पहचान करता है।

Ans 1. कॉपी अ�से

2. इ�सट� मज़� फ़��ड

3. इ�सट� अ�से

4. हाइलाइट मज़� फ़��ड

Question Type : MCQ
Question ID : 618278749

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.21 MS Excel म�, आपको दो तर�क�, अथा�त फ़ॉम��टगं ________ या फ़ॉम�ट से�स डायलॉग बॉ�स, म� से �कसी
एक का उपयोग करके सेल� को फ़ॉम�ट करने क� अनमु�त देता है।

Ans 1. टूल बार

2. प�ट बॉ�स

3. क�पास बॉ�स

4. टूल बॉ�स

Question Type : MCQ
Question ID : 618278758

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.22 _______ का अ�भ�ाय असंग�ठत डटेा को उपयोगकता� के �नद�श� के अनसुार साथ�क जानकार� म� प�रव�त�त
करना है।

Ans 1. अस�ब�लगं

2. �ोसे�सगं

3. कंपाइ�लगं
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4. डीब�गगं

Question Type : MCQ
Question ID : 618278722

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.23 When you open a new blank workbook, the cells, columns and rows are set to a
_______ size.

Ans 1. random

2. default

3. big

4. small

Question Type : MCQ
Question ID : 618278761

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.24 Using Mail Merge you can also create a/an:
Ans 1. envelope

2. video

3. audio

4. presentation slide

Question Type : MCQ
Question ID : 618278748

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.25 �न�न�ल�खत म� से कौन सा उपकरण अपने आउटपटु को एक �वशषे ऊ�मा-संवेद� कागज़ पर म�ु�त करता है?

Ans 1. थम�ल ��टंर

2. 3-D ��टंर

3. लेज़र ��टंर

4. इंकजेट ��टंर

Question Type : MCQ
Question ID : 618278725

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.26 MS Word म�, ‘Ctrl + C’, __________ के समान होता है।
Ans 1. Edit → Delete

2. Edit → Cut

3. Edit → Paste

4. Edit → Copy
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Question Type : MCQ
Question ID : 618278736

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.27 �न�न�ल�खत म� से कौन-सा वे�टर पर आधा�रत �ा�फ़कल ���ंटगं उपकरण है?

Ans 1. लाइट पेन

2. �कैनर

3. �लॉटर

4. ��टंर

Question Type : MCQ
Question ID : 618278724

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.28 The _______ feature, which is similar to using an actual pair of scissors, allows you to
remove selected text from the document and temporarily place it in on the Office
Clipboard.

Ans 1. Cut

2. Move

3. Copy

4. Paste

Question Type : MCQ
Question ID : 618278743

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.29 _________ एक �न�द��ट �वशषेताओ ंके एक सेट के साथ एक �लाइड है, िजसे अ�य �लाइड बनाने के �लए
आरं�भक �बदं ुके �प म� उपयोग �कया जाता है।

Ans 1. आउटलाइन

2. नो�स

3. �लाइड मा�टर

4. नॉम�ल

Question Type : MCQ
Question ID : 618278774

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.30 Which of the following is NOT a type of chart in MS Excel 2016?
Ans 1. Custom chart

2. Pie chart

3. Bar chart
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4. Scatter chart

Question Type : MCQ
Question ID : 618278768

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.31 �न�न�ल�खत म� से कौन सी इंटरनेट से जड़ुने के �लए एक मलूभतू आव�यकता है?

Ans 1. अ�से �ोटोकॉल

2. फ़ाइल �ांसफ़र �ोटोकॉल

3. �ांसफ़र �ोटोकॉल

4. IP �ोटोकॉल

Question Type : MCQ
Question ID : 618278776

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.32 MS Windows क� ब�ूटगं के बाद आने वाल� म�ुय एव ंपहल� ���न को �या कहा जाता है?

Ans 1. माय डॉ�यमू��स

2. ड�ेकटॉप

3. माय क��यटूर

4. डाउनलोड

Question Type : MCQ
Question ID : 618278731

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.33 MS Excel म�, ��ज़ �कए गए पेन को हटाने के �लए, �वडंो मेन ूपर ि�लक कर� और �फर ______ पर ि�लक
कर�।

Ans 1. हाइड

2. ि��लट

3. �य ू�वडंो

4. ��ज़ पेन

Question Type : MCQ
Question ID : 618278752

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.34 Notepad creates and saves text in ________ format only.
Ans 1. txt

2. doc

3. rtf
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4. pdf

Question Type : MCQ
Question ID : 618278733

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.35 A/An ______ computer may work as a server offering information resources, services,
and applications to users on the network.

Ans 1. Gateway

2. Mac address

3. host

4. IP address

Question Type : MCQ
Question ID : 618278779

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.36 जब आप �कसी वक� शीट या वक� बकु को सरु��त करत ेह�, तो ________ ।
Ans 1. केवल एक सेल लॉक होगी

2. केवल पंि�तया ँलॉक ह�गी

3. सभी सेल लॉक हो जाएँगी

4. केवल कॉलम लॉक ह�गे

Question Type : MCQ
Question ID : 618278764

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.37 म� एक Excel ऐ�लकेशन के �नचले �ह�से म� ि�थत होता हँू। म� मौजदूा वक� बकु म� शी�स क� सचूी �द�श�त
(�ड��ले) करता हँू । म� कौन हँू?

Ans 1. वक� शीट

2. फ़ॉ�यू�ला टैब

3. वक� बकु

4. शीट टैब

Question Type : MCQ
Question ID : 618278750

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.38 ________ हाइपर�लकं बनाने के �लए �य�ुत शॉट�कट कंुजी है।
Ans 1. Ctrl + J

2. Ctrl + H
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3. Ctrl + V

4. Ctrl + K

Question Type : MCQ
Question ID : 618278747

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.39 �कसी वक� शीट को सरु��त करने के �लए, �र�य ूटैब पर जाएँ और �फर च�ज़ेस �ुप म� ________ पर ि�लक
कर�।

Ans 1. �ोटे�ट शीट

2. शयेर वक� बकु

3. शयेर शीट

4. �ोटे�ट वक� बकु

Question Type : MCQ
Question ID : 618278757

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.40 Which of the following refers to a set of instructions that directs the computer to
process information?

Ans 1. Hardware

2. Software

3. Assembler

4. Debugger

Question Type : MCQ
Question ID : 618278726

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.41 �न�न�ल�खत म� से कौन सा �टोरेज़ �डवाइस नह�ं है?

Ans 1. डी वी डी

2. �लशै �ाइव

3. सीडी-रोम

4. �लॉटर

Question Type : MCQ
Question ID : 618278723

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.42 MS Word म�, �कसी टेबल म� �डल�ट सेल डायलॉग बॉ�स इनम� से कौन सा काय� नह�ं कर सकता है?

Ans 1. परेू प�ृठ को �डल�ट कर�
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2. सेल बाएँ �श�ट कर�

3. सभी पंि�तय� और �तंभ� को �डल�ट कर�

4. सेल ऊपर �श�ट कर�

Question Type : MCQ
Question ID : 618278744

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.43 MS Excel म�, कॉलम क� चौड़ाई उपांत�रत (मोडीफ़ाई) करने के �लए, होम टैब पर 'सेल' �ुप म� _______
नामक �ॉप-डाउन �वक�प पर ि�लक कर�।

Ans 1. फ़ॉम�ट

2. �डल�ट

3. �फ़ल

4. इ�सट�

Question Type : MCQ
Question ID : 618278754

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.44 MS Excel म�, आप दो से अ�धक सेल� को मज़� कर सकत ेह�।
Ans 1. कथन अस�य है।

2. कथन स�य या अस�य हो सकता है।

3. उ�तर �नधा��रत नह�ं �कया जा सकता।

4. कथन स�य है।

Question Type : MCQ
Question ID : 618278755

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.45 हम _________ �य ूम� �लाइ�स को हटा सकत ेह�।
Ans 1. �लाइड शो

2. �लाइड सॉट�र

3. फ़ुल

4. �य ू�लाइड

Question Type : MCQ
Question ID : 618278775

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.46 _________ is a good way to review the formatting.
Ans 1. Preview
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2. Save

3. Print Preview

4. Print

Question Type : MCQ
Question ID : 618278739

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.47 एक ��ेडशीट म�, एक स�ू म� $ �च�न शा�मल है, उदाहरण के �लए =A1*$B$1। शीट क� समी�ा करत ेसमय,
रो�हत को लगता है �क $ �च�न गलती से जोड़ा गया है इस�लए वह स�ू से सभी $ �च�न हटा देता है। �फर वह
�गै करके परू� र�ज म� फॉमू�ला लागू कर देता है। इसका �या �भाव होगा?

Ans 1. कोई �भाव नह�ं होगा, �य��क $ �च�न का स�ू पर कोई �भाव नह�ं पड़ता है।

2. $ �च�न सेल म� संदभ� (references) को �नरपे� संदभ� (Absolute References) के �प म�
�चि�नत करता है। इ�ह� हटाने पर स�ू गलत मान� क� गणना करेगा।

3. $ �च�न को हटाना सह� है, �य��क Excel स�ू म� $ को नह�ं पहचानता है।

4. $ �च�न हटाने से म�ुा बदल जाएगी।

Question Type : MCQ
Question ID : 618278766

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.48 MS Excel म�, ________ बॉ�स, स��य सेल या चय�नत र�ज का नाम �द�श�त करता है, और इसका उपयोग
सेल� क� एक र�ज का नाम देने के �लए �कया जा सकता है।

Ans 1. फ़�ट

2. टूल

3. नेम

4. �टाइल

Question Type : MCQ
Question ID : 618278751

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.49 MS Excel म�, ऑटो�फ़ल ��वि�टया ँ(AutoFill entries), डाटा �फ़ल ह�डल क� मदद से क� जाती ह�।
Ans 1. कथन स�य या अस�य हो सकता है।

2. कथन अस�य है।

3. उ�तर �नधा��रत नह�ं �कया जा सकता।

4. कथन स�य है।

Question Type : MCQ
Question ID : 618278753

Status : Answered
Chosen Option : 4

Marks : 1.00
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Q.50 अपनी ए�सेल वक� शीट को पासवड� से सरु��त करना, दसूर� को आपके डटेा के साथ छेड़छाड़ करने से रोक
सकता है।

Ans 1. उ�तर �नधा��रत नह�ं �कया जा सकता।

2. कथन अस�य है।

3. कथन स�य या अस�य हो सकता है।

4. कथन स�य है।

Question Type : MCQ
Question ID : 618278756

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.51 In MS Excel 2016, the Format option is available under which group of the Home tab?
Ans 1. Font

2. Data Tools

3. Cells

4. Clipboard

Question Type : MCQ
Question ID : 618278759

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.52 ________ is a wireline transmission technology that transmits data faster over
traditional copper telephone lines already installed to homes and businesses.

Ans 1. Satellite

2. Wireless

3. Cable modem

4. DSL

Question Type : MCQ
Question ID : 618278777

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.53 MS Word एक ___________ सॉ�टवेयर पकेैज है।
Ans 1. वड� �ोसे�सगं

2. प�ट

3. वड�

4. वक� बकु

Question Type : MCQ
Question ID : 618278735

Status : Answered
Chosen Option : 1

Marks : 1.00
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Q.54 �न�न�ल�खत म� से कौन सा MS Excel म� �य�ुत फ़ं�शन नह� ंहै?

Ans 1. MIN

2. SUM

3. ALT

4. MAX

Question Type : MCQ
Question ID : 618278767

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.55 ________ का उपयोग अस�बल� भाषा म� �लखे गए �ो�ाम को मशीनी भाषा म� बदलने के �लए �कया जाता है।
Ans 1. कंपाइलर

2. �ांसलेटर

3. इ�ट��टर

4. अस�बलर

Question Type : MCQ
Question ID : 618278729

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.56 MS Word म� एक अतं�न��हत श�दकोश (dictionary) होता है, िजसका उपयोग _________ फ़ं�शन का
उपयोग करत ेसमय �कया जाता है।

Ans 1. वड� काउंट

2. �ांसलेट

3. �पे�लगं अडँ �ामर

4. �थसॉरस

Question Type : MCQ
Question ID : 618278737

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.57 In MS Word, the Cut, Copy and Paste buttons are located on the ________ of the Home
tab.

Ans 1. Standard toolbar

2. Paragraph group

3. Insert tab

4. Clipboard

Question Type : MCQ
Question ID : 618278742

Status : Answered
Chosen Option : 1

Marks : 0.00
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Q.58 MS Excel म� SmartArt �या होता है?

Ans 1. यह एक ए�सेल वक� शीट म� �कैन क� गई �ाइंग, �ा�फ�स और चाट� डालने का एक तर�का है।

2. यह स�ूचय�, पदान�ु�मत संरचनाओ,ं ���याओ,ं च�� और अ�य चीज� का पवू��नधा��रत �च�मय
एव ं��य ��त�न�ध�व है।

3. यह एक �कार का ग�णतीय आरेख है, िजसका उपयोग ए�सेल म� �वशषे गणनाओ ंके �लए �कया
जाता है।

4. यह एक �वशषे फ़ॉम��टगं है, जो आप Excel म� छ�वय� और त�वीर� पर लागू कर सकत ेह�, जो
आपको खींचने और रंग भरने क� अनमु�त देता है।

Question Type : MCQ
Question ID : 618278770

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.59 Which of the following is NOT a function of an operating system?
Ans 1. Device management

2. Database management

3. User management

4. Service management

Question Type : MCQ
Question ID : 618278734

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.60 _______ �वारा �दान क� जाने वाल� �वशषेताओ ंऔर स�ुवधाओ ंम� डाउनलोड, बकुमाक�  और पासवड� �बंधन
शा�मल है।

Ans 1. वेब �ाउज़र

2. होम पेज़

3. वेबसाइट

4. वेबपेज़

Question Type : MCQ
Question ID : 618278780

Status : Answered
Chosen Option : 1

Marks : 1.00
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Q.1 �ाई (TRAI) �वारा ��ततु �ॉ�ब�ड क� प�रभाषाः ‘�कसी भी तरह क� तकनीक का उपयोग करने वाला डटेा
कने�शन जो इंटरनेट ए�सेस स�हत इंटरैि�टव स�व�सेस का समथ�न करने म� स�म है और �यनूतम ______
का समथ�न करता है’।

Ans 1. 1 Gbps

2. 256 Mbps

3. 512 Mbps

4. 512 kbps

Question Type : MCQ
Question ID : 6182781076

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.2 चय�नत डटेा से बार चाट� बनाने के �लए शाट�-कट कंुजी �या है?

Ans 1. Ctrl + B

2. F9

3. F11

4. Alt + B

Question Type : MCQ
Question ID : 6182781064

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.3 एक ए�सेल वक� शीट म� �माट� आट� �ा�फ�स को जोड़ने के �लएः

1. ___(1)___ टैब से, ___(2)___ को ’इल��ेश�स समहू’ से चय�नत कर�।
2. ‘�माट�आट� �ा�फक’ का चयन कर� नामक डायलॉग बॉ�स म�, आपको िजस �कार एव ंलेआउट क� इ�छा हो,
उस पर ि�लक कर�।

Participant ID 19426591
Participant Name NIKEE KUMARI
Test Center Name iON Digital Zone iDZ Jalalpur
Test Date 18/12/2019
Test Time 3:00 PM - 4:00 PM
Subject Data Entry Operator
Marks Obtained 16.00000

Section : MCQ for Data Entry Operator
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3. आप �ि�टगत �प से िजस अवधारणा को जसेै �क �ल�ट, �ोसेस अथवा �रलेशन�शप को व�ण�त करना चाहते
ह�, उसे �माट�आट� के ___(3)___ से चय�नत कर�।

Ans 1. (1) इ�सट� (2) �माट� आट� (3) कैटगर�

2. (1) �माट� आट� (2) इ�सट� (3) कैटगर�

3. (1) इ�सट� (2) �माट� आट� (3) शपे

4. (1)�माट� आट� (2) इ�सट� (3) शपे

Question Type : MCQ
Question ID : 6182781070

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.4 MS Word श�ु करने पर, वह:

Ans 1. �वय ंह� एक �र�त डॉ�यमु�ट को खोलता है

2. यह पछूता है �क �कस फाइल को खोला जाए

3. MS Word को �पछल� बार बंद करत ेसमय िजस द�तावेज़ का �योग �कया गया था, उसे खोलता है

4. एक वड� टे��लेट को खोलता है

Question Type : MCQ
Question ID : 6182781035

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.5 MS Word 2016 द�तावेज़ म� वॉटरमाक�  को जोड़ने के �लए, आप मेन ूके �कस �वक�प का चयन कर�गे?

Ans 1. लेआउट

2. होम

3. �ॉ

4. �डज़ाइन

Question Type : MCQ
Question ID : 6182781036

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.6 �वषय-व�त ुके आकार से �तंभ� एवं पंि�तय� (कॉल�स व रो) के आकार को समायोिजत करने हेत ुमाइ�ोसॉ�ट
ए�सेल क� ______ �वशषेता से समय क� अ�य�धक बचत होती है।

Ans 1. ऑटोफॉम�ट से�स

2. ऑटो�फट

3. ��कं टे��ट टू �फ़ट

4. रैप टे��ट

Question Type : MCQ
Question ID : 6182781054

Status : Answered
Chosen Option : 2
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Marks : 1.00

Q.7 �न�न�ल�खत म� से कौन सा �वक�प, �स�टम सॉ�टवेयर का उदाहरण नह�ं है?

Ans 1. �डवाइस �ाइवर

2. क�पाइलर

3. वेब �ाउज़र

4. ऑपरे�टगं �स�टम

Question Type : MCQ
Question ID : 6182781026

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.8 तीर (एरो) जसैी एक छोट� सी व�त,ु जो माउस को चलाने पर �वडंोज़ XP ���न पर ग�तशील �दखाई देती है,
को ______ कहत ेह�।

Ans 1. �प�सेल

2. पॉइ�टर

3. टूलबार

4. आइकॉन

Question Type : MCQ
Question ID : 6182781030

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.9 मान ल� �क आपने एक MS Word डॉ�यमु�ट एवं एक MS Excel 2016 शीट को खोल रखा है। आप संदभ� हेत,ु
डॉ�यमु�ट म� शीट के ���न शॉट को जोड़ना चाहत ेह�। �न�न�ल�खत म� से �कस �वक�प �वारा यह काया��मकता
क� जा सकती है?

Ans 1. इ�सट� मेन ु> इल��ेशन �ुप > �प�चस� > उपल�ध �वडंोज़ से चयन कर�

2. रेफर�स मेन ु> इल��ेशन �ुप > ���नशॉट > उपल�ध �वडंोज़ से चयन कर�

3. MS Word म� कोई डीफॉ�ट कार�वाई नह�ं होती है, हम� क�बोड़� क� ��टं ���न बटन का �योग करने
के बाद उसे डॉ�यमु�ट म� �चपकाना (पे�ट) होगा।

4. इ�सट� मेन ु> इल��ेशन �ुप > ���नशॉट > उपल�ध �वडंोज़ से चयन कर�

Question Type : MCQ
Question ID : 6182781046

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.10 �न�न�ल�खत म� से कं�यटूर क� कौन सी भाषा �वषय उ�मखु (ऑ�जे�ट ओ�रएंटेड) भाषा का उदाहरण नह�ं है?

Ans 1. फोट�रान

2. �बी

3. C++

4. जावा
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Question Type : MCQ
Question ID : 6182781028

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.11 �वडंोज़ 10 म�, इमेल, िज़�पगं तथा फाइल क� ���ंटगं और साथ ह� उ�ह� �ड�क म� बन� करने तथा �थानीय
नेटवक�  म� साझा करने के �लए फाइल ए���लोरर के �कस �वक�प का �योग �कया जाता है?

Ans 1. होम टैब

2. मनेैज टैब

3. शयेर टैब

4. �य ूटैब

Question Type : MCQ
Question ID : 6182781032

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.12 मेल मज� �ोसेस म� तीन द�तावेज़ शा�मल होत ेह�: ______, डाटा �ोत एवं मज� �कया हुआ द�तावेज़।
Ans 1. इमेल

2. म�ुय द�तावेज़ (मेन द�तावेज़)

3. आउटलकु संपक�  सचूी (आउटलकु कॉ�टे�ट �ल�ट)

4. ��ेडशीट

Question Type : MCQ
Question ID : 6182781045

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.13 एक ��ेडडशीट म�, �कसी कंपनी के 100 उ�पाद� हेत ु�पय� म� वा�ष�क �ब�� ��ततु है। ��येक उ�पाद हेत ुएक
अलग पंि�त मौजदू है। आपको �ब�� कॉलम म� केवल उन धनरा�शय� को हरे रंग म� �व�श�ट �प से �दखाना
होता िजनक� मा�ा �1,00,000/- से अ�धक है। आप माइ�ोसॉ�ट ए�सेल क� �कस �वशषेता का �योग कर�गे?

Ans 1. आव�यक से�स को �व�श�ट �प से �दखाने हेत ु�वजअुल बे�सक म� �ो�ाम �लख�।

2. �रकॉ��स को �ब�� के घटत े�म म� �यवि�थत (सॉट�) कर� और �फर उन उ�पाद� के फॉ�ट रंग को हरे
रंग म� बदल� िजनक� �ब�� �1,00,000/- से अ�धक हो।

3. जहा ँ�ब�� �1,00,000/- से अ�धक हुई हो वहाँ एक-एक करके, ��येक सेल क� फॉ�ट रंग को बदल�।

4. कंडीशनल फॉरमे�टगं का �योग कर� तथा आव�यक �नयम एवं वां�छत फॉ�ट को लागू कर�।

Question Type : MCQ
Question ID : 6182781059

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.14 काया�लय म� �योग हेत ुलपैटॉप का RAM, संभवतः ______ होता है।
Ans 1. 256 KB

2. 8 GB
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3. 512 GB

4. 512 MB

Question Type : MCQ
Question ID : 6182781021

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.15 �न�न�ल�खत म� से उस �वक�प का चयन कर� िजसम� MS Word म� एक ता�लका �च��त करने हेत ु�न�द��ट
�कए जाने वाले सह� चरण� का �ववरण ��ततु �कया जाता है।

Ans 1. Layout > Table > Draw Table

2. Insert > Draw Table > Table

3. Design > Table > Draw Table

4. Insert > Table > Draw Table

Question Type : MCQ
Question ID : 6182781044

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.16 वड� डॉ�यमु�ट म� ए�सेल फाइल को ए�बेड करने हेतःु

क) वड� डॉ�यमु�ट खोल� तथा ______ मेन ूका चयन कर�।
ख) टे��ट �ुप म�, ______ हेत ु�ॉपडाउन एरो पर ि�लक कर�।
ग) उसके बाद अनवुत� कार�वाइय� (सब�स�व�ट �टे�स) का अनसुरण कर�।

Ans 1. टे��ट �ुप, ऑ�जे�ट

2. इ�सट�, इ�सट� ए�सेल

3. इ�सट�, ऑ�जे�ट

4. टे��ट �ुप, इ�सट� ए�सेल

Question Type : MCQ
Question ID : 6182781038

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.17 वक� शीट को सरु��त रखने हेत ुआप ______ मेन ूसे �ोटे�शन एवं �ोटे�ट शीट का चयन कर सकत ेह�।
Ans 1. �र�यू

2. फॉम�ट

3. डटेा

4. ए�डट

Question Type : MCQ
Question ID : 6182781056

Status : Answered
Chosen Option : 3

Marks : 0.00
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Q.18 MS Word 2016 म� पंि�त के बीच क� �पे�सगं हेत ु�कतने �वक�प उपल�ध होत ेह�?
Ans 1. 6

2. 4

3. 3

4. 5

Question Type : MCQ
Question ID : 6182781043

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.19 ERP (इ�टर�ाइस �रसोस� �ला�नगं) सॉ�टवेयर को �न�न�ल�खत �प से वग�कृत �कया जा सकता है:

Ans 1. एि�लकेशन सॉ�टवेयर

2. �स�ट�स सॉ�टवेयर

3. सव�र सॉ�टवेयर

4. यटू��लट� सॉ�टवेयर

Question Type : MCQ
Question ID : 6182781027

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.20 ए�सेल म� बहृत ्(लाज�) डटेा समहू ��ततु �कए जाने पर, �व�यमान सचूना को �मवार एवं उसका सारांश
��ततु करने म� ______ सहायक होत ेह�।

Ans 1. मथै फं�श�स

2. लॉिजकल फं�श�स

3. लकुअप फं�श�स

4. �टै�टि�टकल फं�श�स

Question Type : MCQ
Question ID : 6182781067

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.21 ______ फाइल� का ऐसा समहू है जो एक या एका�धक हाड�वेयर �डवाइस� को कं�यटूर ऑपरे�टगं �स�टम के
साथ संचार (क�य�ुनकेट) करने यो�य बनाता है।

Ans 1. �डवाइस �ाइवर

2. �डवाइस इ��टालर

3. �डवाइस फाइल

4. इं�टॉलेशन �ाइवर

Question Type : MCQ
Question ID : 6182781034

Status : Answered
Chosen Option : 3

Marks : 0.00ANKAJ INFOTECH
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Q.22

Ans 1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 6182781066

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.23 ��टं डायलॉग बॉ�स को खोलने का शॉट�कट ______ होता है।
Ans 1. Ctrl + P

2. Ctrl + D

3. Ctrl + O

4. Ctrl + V

Question Type : MCQ
Question ID : 6182781039

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.24 पावरपॉइंट म�, पठन ��य (र��डगं �य)ू म� �पछले �लाइड को देखने हेत,ु ______ शॉट�कट कंुजी का �योग �कया
जाता है।

Ans 1. P

2. N

3. J

4. H

Question Type : MCQ
Question ID : 6182781075

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.25 MS Word 2016 म�, �न�न�ल�खत म� से कौन सा �वक�प, एक चय�नत टे��ट को कॉपी करने हेत ुशॉट�-कट

ANKAJ INFOTECH
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कंुजी है?

Ans 1. Ctrl + Insert

2. Alt + C

3. Ctrl + V

4. Ctrl + W

Question Type : MCQ
Question ID : 6182781048

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.26 ए�सेल फाइल पर पासवड� के एि���शन को कैसे हटाया जा सकता है?

Ans 1. ‘सरु��त (�ोटे�टेड) �य’ू म� वक� बकु को खोल� तथा �बना पासवड� के उसे पनुः सहेज� (सेव कर�)

2. वक� बकु को ‘केवल पठन हेत ु(र�ड ओनल�)’ खोल� तथा �बना पासवड� के उसे पनुः सहेज� (�रसेव कर�)

3. वक� बकु को एक नए द�तावेज़ के �प म� पनुः सहेज� तथा उसक� एक ��त बनाएं

4. वक� बकु को खोलने के �लए पासवड� ��व�ट कर� और �फर प�म�श�स म� �न�म�त पासवड� को �डल�ट कर
द� → पासवड� बा�स से एि���ट कर�

Question Type : MCQ
Question ID : 6182781057

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.27 वत�मान �लाइड क� ��त बनाने हेत ु______ शॉट�-कट कंुजी का �योग �कया जाता है।
Ans 1. F5

2. Alt + D

3. Ctrl + D

4. F1

Question Type : MCQ
Question ID : 6182781073

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.28 RJ-45 केबल का परूा नाम �या है?

Ans 1. रेफर�स जकै-45

2. रिज�टड� जकै-45

3. रेगुलर जकै-45

4. र�ऑड�र जकै-45

Question Type : MCQ
Question ID : 6182781077

Status : Answered
Chosen Option : 2

Marks : 1.00

ANKAJ INFOTECH
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Q.29

Ans

1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 6182781058

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.30 लपू बकै IP पता ______ से श�ु होता है।
Ans 1. 191

2. 255

3. 0

4. 127

Question Type : MCQ
Question ID : 6182781079

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.31 MS Word द�तावेज़ म�, िजस �वषट को काटा जाता है अथवा उसक� ��त बनाई जाती है, उसे ______ म�
सरु��त रखा जाता है।

Ans 1. ि�लपबोड�

2. फॉम�ल प�टर

3. डॉ�यमु�ट

4. साइडबोड�

Question Type : MCQ
Question ID : 6182781042

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.32 पावरपॉइंट म� �लाइड लेआउट क� प�रभाषा के अनकूुलन हेत ु______ का �योग �कया जाता है।
Ans

ANKAJ INFOTECH
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1. ह�डआउट मा�टर

2. नॉम�ल मा�टर

3. �लाइड मा�टर

4. नो�स मा�टर

Question Type : MCQ
Question ID : 6182781074

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.33 MS Excel 2016 म� एक नई वक� शीट को शी�ता से डालने हेत ु______ कर�।
Ans 1. Click Insert > my Add-ins

2. Click File > Insert > Sheet

3. Click Insert > Worksheet

4. मौजदूा शीट के पास बा� ओर नीचे �लस �च�ह पर ि�लक कर�

Question Type : MCQ
Question ID : 6182781050

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.34 आपने कॉलम D एव ंE का चयन �कया है और �फर इ�सट� > कॉलम का चयन �कया है। इससे �या होगा?
Ans 1. कॉलम E के बाद दो कॉलम को ��व�ट �कया जाएगा

2. कॉलम F के बाद दो कॉलम को ��व�ट �कया जाएगा

3. कॉलम C के बाद एक कॉलम को ��व�ट �कया जाएगा

4. कॉलम C के बाद दो कॉलम को ��व�ट �कया जाएगा

Question Type : MCQ
Question ID : 6182781061

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.35 ए�सेल म� ‘�ोटे�ट वक� बकु’ �वक�प, ______ मेन ूशीष�क के अतंग�त उपल�ध है।
Ans 1. �यू

2. �र�यू

3. पेज लेआउट

4. डटेा

Question Type : MCQ
Question ID : 6182781063

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.36 MS Excel वक� शीट 2016 म� वक� शीट को �न�न�ल�खत म� से �या नाम �दया जा सकता है?

Ans ANKAJ INFOTECH
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1. शीट1

2. बजटः1

3. �ह���

4. शीट[1]

Question Type : MCQ
Question ID : 6182781051

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.37 �न�न�ल�खत म� से �कस तकनीक म�, म�ु�त अ�र� को पढ़ने के �लए चुंबक�य �याह� (मिै�नटाइजबल इंक) का
�योग �कया जाता है?

Ans 1. ऑि�टकल �च�न क� पहचान (Optical Mark Recognition)

2. म�ैने�टक इंक अ�र क� पहचान (Magnetic Ink Character Recognition)

3. पोट�बल द�तावेज़ (Portable Document Format)

4. ऑि�टकल अ�र क� पहचान (Optical Character Recognition)

Question Type : MCQ
Question ID : 6182781024

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.38 �न�न�ल�खत म� से कौन सा �वक�प, एक इनपटु �डवाइस नह�ं है?

Ans 1. बारकोड र�डर

2. माउस

3. �लॉटर

4. �कैनर

Question Type : MCQ
Question ID : 6182781023

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.39 मेल मज� के �लए डाटा �ोत के �प म� ए�सेल ��ेडशीट तयैार करने के �लए स�ुनि�चत कर� �क ��तशत, म�ुाएं
तथा पो�टल कोड वाल� डटेा ��वि�टय� को ��ेडशीट म� सह� तरह से ______ �कया जाता है, ता�क वड� �वारा
सह� तरह से उन मान� को पढ़ा जा सके।

Ans 1. संरे�खत (अलाइ�ड)

2. इ�ड�ट

3. फॉम�ट

4. टैब

Question Type : MCQ
Question ID : 6182781047

Status : Answered
Chosen Option : 1

Marks : 1.00
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Q.40 �न�न�ल�खत म� से कौन सा �वक�प, एक टे��ट वेब �ाउज़र है?

Ans 1. �ल�ंस

2. गेज़ेल

3. वेब

4. ओपेरा

Question Type : MCQ
Question ID : 6182781078

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.41 माइ�ोसॉ�ट Excel म� �व आकार (ऑटो शपे) के संदभ� म� �न�न�ल�खत म� से कौन सा कथन गलत है?

Ans 1. आकार म� ��य� �प से �वषय-व�त ुको ��व�ट नह�ं �कया जा सकता है

2. ह�डल को ि�लक करत ेएव ंखींचत ेहुए आकृ�त के आकार को बदला जा सकता है

3. बॉ�स, व�ृत एवं तीर (एरो) जसेै आकार को, ��ेडशीट म� जोड़ा जा सकता है

4. आकार के रंग को ‘शपे �फल’ �वक�प का �योग करत ेहुए बदला जा सकता है

Question Type : MCQ
Question ID : 6182781069

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.42 MS Word डॉ�यमु�ट क� श�ुआत पर वापस लौटने के �लए �कस शॉट�-कट कंुजी का �योग �कया जाता है?

Ans 1. Ctrl + Home

2. Ctrl + Up arrow

3. Alt + PgUp

4. Ctrl + H

Question Type : MCQ
Question ID : 6182781053

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.43 MS PowerPoint 2016 म�, वत�मान �लाइड से �लाइड शो श�ु करने का कंुजी संयोजन (क� कॉि�बनेशन)
______ होता है।

Ans 1. F12

2. Alt + S

3. SHIFT + F5

4. F5

Question Type : MCQ
Question ID : 6182781071

Status : Answered
Chosen Option : 4

Marks : 0.00
ANKAJ INFOTECH
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Q.44 वक� शीट क� कॉलम B म� सभी सेल क� �वषय-व�त ुको बो�ड करने हेत ुआप ______ ।
Ans 1. कॉलम B का चयन कर� तथा Ctrl + D कमांड का �योग कर�गे

2. कॉलम B का चयन कर� तथा पे�ट > बो�ड कमांड का �योग कर�गे

3. कॉलम B का चयन कर� तथा फाम�ट प�टर > बो�ड कमांड का �योग कर�गे

4. कॉलम B का चयन कर� तथा फॉम��टगं टूलबार पर ‘B’ बटन का �योग कर�गे

Question Type : MCQ
Question ID : 6182781060

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.45 एक गोलाकार �ाफ जो सम� कुल म� अशंदान �दान करने वाले �व�भ�न वग� के पर�पर अशंदान को दशा�ता है,
को ______ कहत ेह�।

Ans 1. ए�रया चाट�

2. सक� ल चाट�

3. पाइ चाट�

4. बबल चाट�

Question Type : MCQ
Question ID : 6182781068

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.46 MS Word के एक द�तावेज़ म� दो परैा�ाफ के बीच क� जगह को ______ कहत ेह�।
Ans 1. परैा�ाफ के बीच क� जगह

2. इ�ड�ट

3. लाइन के बीच क� जगह

4. पंि�त के बीच क� जगह

Question Type : MCQ
Question ID : 6182781041

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.47 �न�न�ल�खत म� से कौन सा �वक�प, सामा�यतः CPU का भाग नह�ं होता है।
Ans 1. कं�ोल य�ूनट

2. ए�रथमे�टक लॉिजक य�ूनट

3. पेन �ाइव

4. रिज�टर

Question Type : MCQ
Question ID : 6182781022

Status : Answered
Chosen Option : 3

ANKAJ INFOTECH
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Marks : 1.00

Q.48 फाइल का �कार ______ �वारा दशा�या जा सकता है।
Ans 1. फाइल आइड��टफायर

2. फाइल ए��ट�शन

3. फाइल टैग

4. फाइल नेम

Question Type : MCQ
Question ID : 6182781033

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.49 �न�न�ल�खत म� से कौन सा �वक�प, वक� शीट म� कॉलम जोड़ने का सह� उपाय है?

Ans 1. िजस कॉलम के पास एक और कॉलम जोड़ना हो उसक� बा� ओर कॉलम का चयन कर�। कं�ोल +=

दबाएं।

2. िजस कॉलम के पास एक और कॉलम जोड़ना हो उसक� बा� ओर कॉलम का चयन कर�। दाएँ ि�लक
कर� > इ�सट�

3. िजस कॉलम के पास एक और कॉलम जोड़ना हो उसक� दा� ओर कॉलम का चयन कर�। दाएँ ि�लक
कर� > इ�सट�

4. िजस कॉलम के पास एक और कॉलम जोड़ना हो उसक� बा� ओर कॉलम का चयन कर�। इ�सट� कंुजी
दबाएं।

Question Type : MCQ
Question ID : 6182781052

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.50 एक वेब �ाउज़र म�, ‘�ू�स-ऐ�पल’ क� खोज क� जाती है। यह ______ �द�श�त करेगा।
Ans 1. ऐ�पल से सभी स�त ेफल

2. ऐ�पल के �सवाय सभी फल

3. सभी �कार के फल िजसके नाम के साथ ऐ�पल जड़ुा हुआ हो, उदाहरण, पाइने�पल

4. फल� म� केवल ऐ�पल

Question Type : MCQ
Question ID : 6182781080

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.51 ______ �नद�श� को मशीन कोड म� �पांत�रत करता है।
Ans 1. डीबगर

2. एसे�बलर

3. �ोसेसर

4. क�पाइलर

ANKAJ INFOTECH
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Question Type : MCQ
Question ID : 6182781029

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.52 MS Excel 2016 शीट म� Alt + M दबाने से �या होता है?

Ans 1. यह ग�णत के फ़ं�शन को खोलता है

2. यह एक मा�टर शीट �न�म�त करता है

3. यह FORMULA मेन ूको स��य करता है

4. यह कई वक� शीट खोलता है

Question Type : MCQ
Question ID : 6182781062

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.53 �न�न�ल�खत म� से कौन सा कथन गलत है?

Ans 1. USB पोट�, सी�रयल अथवा परैलल पोट� से काफ� तज़े होत ेह�।

2. लपैटॉप चाज� करने के �लए USB-C पोट� का �योग नह�ं �कया जा सकता है।

3. समानांतर (परैलल) पोट�, एक ह� समय म� 8 �बट क� डटेा संचा�रत (�ांस�मट) करत ेह�।

4. सी�रयल पोट� एक समय पर 1 �बट डटेा संचा�रत (�ांस�मट) करत ेह�।

Question Type : MCQ
Question ID : 6182781025

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.54

Ans 1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 6182781065

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.55 मेल मज� डॉ�यमु�ट म� डटेा �ोत (सोस�) से �लकं �कए गए फ��ड नाम को �या कहा जाता है?

Ans 1. सोस� फ��ड

2. मज� डटेा फ��ड

3. मज� फ��ड

4. डटेा फ��ड
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Question Type : MCQ
Question ID : 6182781049

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.56 MS Excel 2016 क� वक� बकु म� आप �रबन को �दखाना/�छपाना चाहत ेह�। आप �कस शॉट�-कट कंुजी का
�योग कर�गे?

Ans 1. Ctrl + F1

2. Ctrl + SH

3. Ctrl + F3

4. Ctrl + R

Question Type : MCQ
Question ID : 6182781055

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.57 कं�यटूर क� हाड� �ड�क से डील�ट क� जाने वाल� �कसी भी फाइल को ______ नामक एक अलग फो�डर म� डाल
�दया जाता है।

Ans 1. जंक फो�डर

2. र�साइ�कल �बन

3. �ैश �बन

4. �पमै फो�डर

Question Type : MCQ
Question ID : 6182781031

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.58 परैा�ाफ → �पे�सगं ऑ�शन से ______ �कया जा सकता है।
Ans 1. परैा�ाफ के बाद �पेस जोड़ना

2. परैा�ाफ हेत,ु पहले या बाद म� अथवा दोन� बार �पेस जोड़ना

3. परैा�ाफ से पहले �पेस जोड़ना

4. लाइन क� �पे�सगं (के बीच क� जगह) के अनसुार पहले या बाद म� �पेस जोड़ना

Question Type : MCQ
Question ID : 6182781040

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.59 एक खलु� हुए वड� द�तावेज़ को अ�य �कसी नाम से सहेजने (सेव) हेत ुसवा��धक उपय�ुत �वक�प ______ है।
Ans 1. File > Close > Rename

2. File > Save As

3. File > Move
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4. File > Save

Question Type : MCQ
Question ID : 6182781037

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.60 पावरपॉइंट म� ______ के �लए �वशषे श�ुआती शत� को �नधा��रत करने हेत ु��गर �वक�प का �योग �कया
जाता है।

Ans 1. �लाइड सॉट�र

2. ए�नमेशन

3. �लाइडड शो

4. �ां�सशन

Question Type : MCQ
Question ID : 6182781072

Status : Answered
Chosen Option : 2

Marks : 1.00
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Q.1 वक� शीट म� एक पंि�त (रॉ) जोड़ने के �लए, �न�न�ल�खत म� से कौन सा तर�का सह� नह�ं है?

Ans 1. �रबन पर �दए गए होम टैब पर ि�लक कर�। �फर, से�स �ुप म�, इ�सट� �ल�ट म�, इ�सट� शीट
कॉल�स पर ि�लक कर�।

2. उस पंि�त को चनु�, िजसके ऊपर दसूर� पंि�त जोड़ी जानी है। माऊस का उपयोग करके दाएँ ि�लक
कर�। इ�सट� चनु�।

3. उस पंि�त (रॉ) को चनु�, िजसके ऊपर दसूर� पंि�त जोड़ी जानी है। शॉट� कट कंुजी Control + का
उपयोग कर�।

4. उस पंि�त को चनु�, िजसके ऊपर दसूर� पंि�त जोड़ी जानी है। माऊस का उपयोग करके दाएँ ि�लक
कर�। Row > Add चनु�।

Question Type : MCQ
Question ID : 618278992

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.2 एक ए�सेल ��डैशीट म� आपने पांच अलग–अलग कॉल�स म� डटेा दज� है, पर यह पता चलने पर �क आप
तीसरे कॉलम म� द� हुई सार� जानकार� नह�ं पढ़ पा रहे ह�। केवल इसी कॉलम के आकार को अपने आप बदलने
के �लए आपको �या करना चा�हए?

Ans 1. तीसरे सेल क� दा�हनी सीमा पर ि�लक कर� और इसे एक सेट �प�सल आकार म� खींचे।

2. सारे कॉलम को चनु� और �रबन पर �दए हुए “सेल” समहू के “फ़ॉम�ट” बटन का उपयोग कर�।

3. तीसरे कॉलम चनु� और फॉम�ट कॉलम के �वक�प का उपयोग कर�।

4. कॉलम नाम क� दा�हनी सीमा पर डबल ि�लक कर�।

Question Type : MCQ
Question ID : 618278995

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.3 �वडंोज़ 10 वाले लपैटॉप म� ��टंर इं� टाल करने/सेट करने के संबंध म� �न� न म� से कौन सा कथन गलत है?

Participant ID 19367600
Participant Name SAURAV KUMAR
Test Center Name iON Digital Zone iDZ Jalalpur
Test Date 18/12/2019
Test Time 12:00 PM - 1:00 PM
Subject Data Entry Operator
Marks Obtained 14.00000

Section : MCQ for Data Entry Operator
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Ans 1. आप एक � लाउड ��टंर सेट अप कर सकत ेह�

2. आप एक वॉयरलेस ��टंर सेट अप कर सकत ेह�

3. आप एक नेटवक�  ��टंर सेट अप कर सकत ेह�

4. आप एक लोकल ��टंर सेट अप कर सकत ेह�

Question Type : MCQ
Question ID : 618278974

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.4 माइ�ोसॉ�ट ए�सेल वक� शीट म�, �न�न�ल�खत म� से कौन सा कथन ‘Cell Styles’ स�ुवधा के बारे म� सह�
नह�ं है?

Ans 1. परेू ए�सेल ��ेडशीट म� एक समान �प के �लए आप समान डॉ�यमु�ट थीम को लागू करने हेत ुइसका
उपयोग कर सकत ेह�।

2. बहुत से से�स को फाम��टग करने के �लए, तज़ेी से इसका उपयोग �कया जा सकता है।

3. इसका उपयोग करके, हम हर बार समान और एकदम सह� फाम��टगं लागू कर सकत ेह�।

4. �व�वध सेल को तरंुत और अपने आप फॉम�ट कर सकता है।

Question Type : MCQ
Question ID : 6182781002

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.5 ए�सेल म� एक ऑटो शपे डालने के �लए, ______ पर ि�लक कर�, ______ पर ि�लक कर�, एक शपे को चनु�
और �फर उस शपे को बनाने के �लए पॉइंटर को खींचे।

Ans 1. इ�सट�, श�ेस

2. �ॉ, �प�चस�

3. �ॉ, श�ेस

4. इ�सट�, �प�चस�

Question Type : MCQ
Question ID : 6182781009

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.6 एक म�ड़� डॉ�यमु�ट बनाने के �लए मिज�ग, एक म�ुय डॉ�यमु�ट को डटेा सोस� के साथ सि�म�लत करता है।
मज� करने से पहले, मे�लगं टैब पर ______ �ुप आपको लेटस� देखने क� अनमु�त देता है। जब आप स�ुनि�चत
ह� �क म�ुय डॉ�यमु�ट और डटेा सोस� सह� ह�, तब मज� परूा कर� (�फ�नश मज�) कमांड का उपयोग कर�।

Ans 1. प�रणाम देख� (चेक �रज़�टस)

2. प�रणाम क� समी�ा कर� (�र�य ू�रज़�टस)

3. प�रणाम देख� (�य ू�रज़�टस)

4. पवूा�वलोकन प�रणाम (�ी�य ू�रज़�टस)

Question Type : MCQ
Question ID : 618278989

Status : AnsweredANKAJ INFOTECH
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Chosen Option : 3
Marks : 0.00

Q.7 �वडंोज़ ए� वॉयन�म�ट म� MS-वड� श�ु करने के �लए:

___(1)___ बटन पर ि�लक कर�। ___(2)___ का चयन कर�। ___(3)___ को चय�नत कर� और �फर MS-वड�
�वक� प पर ि�लक कर�।

Ans 1. (1) Programs (2) Start (3) MS Office

2. (1) MS Office (2) Start (3) Program

3. (1) Programs (2) MS Office (3) Start

4. (1) Start (2) Programs (3) MS Office

Question Type : MCQ
Question ID : 618278975

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.8 �न� न म� से कौन सा कथन �स� टम सॉ�टवेयर से संबं�धत है?

Ans 1. इसे �व�श� ट काय� करने के �लए बनाया गया है।

2. इसे �लखने के �लए उ� च � तर क� भाषाओ ंका उपयोग �कया जाता है।

3. यह यज़ूर एवं हाड�वेयर के म� य एक इंटरफेस के �प म� काय� करता है।

4. इसके �बना क� � यटूर �स� टम चल सकता है।

Question Type : MCQ
Question ID : 618278966

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.9 वड� म� एक नई, �र� त ए� सेल � �ेडशीट अतं:� था�पत (ए�बेड) करने के �लए, आप इ� सश�न पॉइंट वहां रख�,
जहां वड� डॉ� यमु�ट म� � �ेडशीट अतं:� था�पत करना चाहत ेह�। �रबन पर ______ टैब पर ि�लक कर�।

Ans 1. लेआउट (Layout)

2. �डज़ाइन (Design)

3. रेफर�सेज़ (References)

4. इ� सट� (Insert)

Question Type : MCQ
Question ID : 618278978

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.10

Ans 1. 

2. 

3. 
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4. 

Question Type : MCQ
Question ID : 6182781005

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.11 इंटरनेट से कने�ट करने के �लए ADSL का उपयोग करने के �लए �न�न�ल�खत म� से सह� कथन को पहचान�।
Ans 1. अपलोड क� ग�त, डाउनलोड क� ग�त से �यादा होती है

2. अपलोड क� ग�त और डाउनलोड क� ग�त कभी-कभी एक समान होती है

3. अपलोड क� ग�त और डाउनलोड क� ग�त हमेशा एक समान होती है

4. अपलोड क� ग�त, डाउनलोड क� ग�त से कम होती है

Question Type : MCQ
Question ID : 6182781017

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.12 साउंड, आइकॉन, फॉ� ट, कलर एवं � ��न सेवर के सं�ह को ______ के नाम से जाना जाता है।
Ans 1. अ�पयर�स

2. से�टगं

3. बकै�ाउंड

4. थीम

Question Type : MCQ
Question ID : 618278971

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.13 क� पाइलर सोस� कोड को ______ म� �पांत�रत करता है।
Ans 1. ऑ� जे� ट कोड

2. इंटर�ेटर कोड

3. लो ल�� वेज कोड

4. � �� चड� कोड

Question Type : MCQ
Question ID : 618278969

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.14 �न� न म� से कौन एक इनपटु �डवाइस नह�ं है?

Ans 1. �डिजटल कैमरा

2. माइ�ोफोन

3. माउस
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4. मॉ�नटर

Question Type : MCQ
Question ID : 618278963

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.15 वड� डॉ� यमु�ट के नवीनतम सं� करण म� डॉ� यमु�ट फाइल के �लए फाइल ए� � ट�शन ______ होता है।
Ans 1. .dotx

2. .docx

3. .doc

4. .docb

Question Type : MCQ
Question ID : 618278977

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.16 वह चाट� ए�लम�ट जो डटेा मान और �े�णय� को चाट� के नीचे �द�श�त करता है, उसे �या कहत ेह�?
Ans 1. डटेा लेजं�स

2. डटेा ल�ैलस

3. डटेा टेबल

4. डटेा पॉइं�स

Question Type : MCQ
Question ID : 6182781008

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.17 �न�न�ल�खत म� से, पावरपॉइंट म�, �लाइड लेआउट के गलत पवू��नधा��रत लेआउट क� पहचान कर�।
Ans 1. टाइटल एंड कंटे�ट लेआउट

2. �ी कंटे�ट लेआउट

3. टू कंटे�ट लेआउट

4. टाइटल �लाइड

Question Type : MCQ
Question ID : 6182781014

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.18 माइ�ोसॉ�ट वड� का उपयोग करत ेसमय, टे� � ट के � लॉक� म� ��-सेट फॉम��टगं डिे�नशन अ� लाइ करने के
�लए ______ का उपयोग �कया जाता है। उदाहरण के �लए, आप 'हे�डगं 1' कहलाने वाले ______ को �न�द�� ट
कर सकत ेह� जो �व�श� ट फॉ� ट, बो� डफेस, �सगंल � पेस वाल� तथा क� टड� म� फ� ट�-लेवल हे�ड�ं स को फॉम�ट कर
देता है। आपक� सभी फ� ट�-लेवल हे�ड�ं स म� �ीफ या अ� य डॉ� यमु�ट म� अ� लाइ क� गई वह हे�डगं 1 ______,
आपको आपके डॉ� यमु�ट म� एकसमान फॉम��टगं के �लए, मि�टपल फॉम�ट से�ट�ंस अ� लाइ करने के �लए वन-
� टेप वे (one-step way) क� स�ुवधा �दान करती है।
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Ans 1. �ॉपट� / �ॉपट�ज़

2. � टाइल / � टाइ� स

3. फॉम�ट / फॉम��स

4. कैटेगर� / कैटेगर�ज़

Question Type : MCQ
Question ID : 618278983

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.19 ए�सेल म�, जब हम एक सेल म� द� हुई जानकार� के कुछ �ह�से को �नकालना चाहत ेह� या हम �व�वध सेल म� द�
हुई जानकार� को �मलाने क� को�शश करत ेह�, तो ______ उपयोगी होत ेह�।

Ans 1. टे��ट फं�श�स

2. लॉिजकल फं�श�स

3. लकुअप फं�श�स

4. मथै फं�श�स

Question Type : MCQ
Question ID : 6182781007

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.20 वड� म� मेल मज� के �लए नया डटेा सोस� बनाने के �लए, मे�ल�ंस > ______ > नई सचूी बनाएं, के �वक�प का
उपयोग कर�।

Ans 1. डटेाबेस का चयन कर� (�सले�ट डटेाबेस)

2. संपक�  का चयन कर� (�सले�ट का�टै��स)

3. सचूी का चयन कर� (�सले�ट �ल�ट)

4. �ा�तकता� का चयन कर� (�सले�ट �र�सपीअ�टस)

Question Type : MCQ
Question ID : 618278987

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.21

Ans 1. 

2. 

3. 

4. 

Question Type : MCQANKAJ INFOTECH
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Question ID : 6182781006
Status : Answered

Chosen Option : 3
Marks : 0.00

Q.22 �न� न म� से कौन सी तकनीक �कसी छ�वय� (eg: jpg, tiff, bmp, …) को �ोसेस कर सकती है और इसम�
��टं �कए गए टे� � ट को ए� � �ै� ट कर सकती है तथा इसे टे� � ट फाइल/MS Word फाइल म� �पांत�रत कर
सकती है, िजससे इसे संपा�दत �कया जा सके?

Ans 1. पोट�बल डॉ� यमु�ट फॉम�ट

2. ऑि�टकल माक�  �रकॉि�नशन

3. ऑि�टकल कैरे� टर �रकॉि�नशन

4. म�ै ने�टक इंक कैरे� टर �रकॉि�नशन

Question Type : MCQ
Question ID : 618278964

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.23 पावरपॉइंट म�, �लाइडस म� �लाइड सं�या डालने के �लए, ______ का उपयोग कर�।
Ans 1. हेडर एंड फूटर

2. �स�ब�स

3. �ैि�ज़शन

4. ए�नमेशन

Question Type : MCQ
Question ID : 6182781011

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.24 �वडंोज़ 10 म� फाइल ए� � � लोरर के संबंध म� �न� न म� से कौन सा कथन गलत है?

Ans 1. आप � य ूटैब क� सहायता से अपनी कोई भी फाइल या फो� डर अ� य लोग� के साथ साझा कर सकते
ह�।

2. यह आपको फाइल� सीधे वन�ाइव (OneDrive) ऑनलाइन � लाउड � टोरेज म� सहेजने क� स�ुवधा
देता है।

3. आप अ� सर देखी गई फाइल� तक ि�वक ए� सेस फ�चर के �वारा पहंुच सकत ेह�।

4. �योगकता� को वन�ाइव (OneDrive) से लोकल फाइल �स� टम के �वारा फाइल� �सकं करने क�
स�ुवधा �मलती है।

Question Type : MCQ
Question ID : 618278973

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.25 एक वक� बकु पर �योग हुए “वक� बकु �ोटे�शन” को हम कैसे हटा सकत ेह�?
Ans 1. �ोटे�शन को हटाने के �लए, फ़ाइल को खोल�, पासवड� डाल� और �फर उस वक� बकु को �फर से सेव

कर�।
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2. �रबन पर �दए हुए �र�य ूटैब पर ि�लक कर� और �फर च�जेस �ुप म� �ोटे�ट वक� बकु पर ि�लक कर�।

3. वक� बकु को चय�नत करके दाएँ ि�लक कर� और मेन ू�ल�ट म� से ‘�रमवू �ोटे�शन’ को चनु�।

4. �ोटे�शन हटाने वाल� सेल का चयन कर�, �रबन पर �दए हुए होम टैब पर ि�लक कर� और फॉम�ट मेनू
म� ‘लॉक से�स’ को चनु�।

Question Type : MCQ
Question ID : 618278997

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.26 MS Word म� शॉट�कट कंुजी Ctrl + I का उपयोग ______ के �लए �कया जाता है।
Ans 1. लाइन �ेक सि�म�लत करने

2. इंड�ट बढ़ाने

3. फॉ� ट साइज़ म� बढ़ाने

4. चय�नत टे� � ट को इटै�लक करने

Question Type : MCQ
Question ID : 618278981

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.27 वड� म� मेल मज� के �लए, य�द आप ए�सेल म� डटेा सोस� का इ� तमेाल करत ेह�, जो �क ए�सेल म� एक �ल� ट के
�प म� संद�भ�त होता है, इसे कुछ �व�नद�श� को परूा करना चा�हए। इस संदभ� म� �न� न म� से कौन सा गलत है?

Ans 1. फ�� ड के नाम/कॉलम के लेबल �ल� ट क� पहल� पंि�त म� होने चा�हए तथा फ�� ड के नाम �व�श� ट
होने चा�हए।

2. �ल� ट म� एक �र� त पंि�त होनी चा�हए।

3. फ�� ड के नाम तथा पहले �रकॉड� के म� य �र� त पंि�त नह�ं होनी चा�हए।

4. य�द वक� शीट पर अ�त�र� त सचूना है, तो अ� य डटेा से �ल� ट को अलग रखने के �लए कम से कम
एक �र� त पंि�त या � तंभ होना चा�हए।

Question Type : MCQ
Question ID : 618278986

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.28 �न� न म� से � या �ो�ा�मगं ल��वेज का गणधुम� नह�ं है?

Ans 1. प�रश�ु �कए जाने क� आव� यकता

2. अ�भ� यंिजत (ए��े�सव) �कए जाने क� आव� यकता

3. सं��� त �कए जाने क� आव� यकता

4. असंर�चत �कए जाने क� आव� यकता

Question Type : MCQ
Question ID : 618278968

Status : Answered
Chosen Option : 4

Marks : 1.00
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Q.29 �माट�आट� �ा�फक के लेआउट को बदलने के �लए, �टाइल को बदलने के �लए, या आपके �माट�आट� �ा�फक म�
उपयोग �कए हुए रंग� को बदलने के �लए, आप    ______ टैब का उपयोग कर�गे।

Ans 1. फॉम�ट

2. अर�ज

3. श�ेस

4. �डज़ाइन

Question Type : MCQ
Question ID : 6182781010

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.30

Ans 1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 6182781000

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.31 इंटरनेट के मा�यम से, �कसी अ�य कं�यटूर से फ़ाइल� �ा�त करने के �लए, �न�न�ल�खत म� से �कसका उपयोग
करना होगा?

Ans 1. FTP

2. DUNET

3. USENET

4. TELNET

Question Type : MCQ
Question ID : 6182781018

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.32 एक �ेणी म� 0 से 100 के बीच क� सार� सं�याओ ंको, लाल रंग म� �द�श�त करने के �लए:

Ans 1. कं�डशनल फाम��टग का उपयोग कर�

2. आव�यक सं�याओ ंको लाल फॉम�ट करने के �लए = if() फं�शन का उपयोग कर�।

3. इस काय� को करने के �लए �वज़अुल बे�सक म� �ो�ाम �लख�।
ANKAJ INFOTECH



1/27/2020 https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S65D261/157682219819030…

https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S65D261/15768221981903054/193676… 10/17

4. 0 से 100 तक सं�याओ ंवाल� से�स को चय�नत कर�, �फर टे��ट कलर टूल पर लाल रंग पर ि�लक
कर�।

Question Type : MCQ
Question ID : 618278999

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.33 MS Word के 'पेज सेटअप ' डायलॉग बॉ� स म� 'पेज ए��� य�ूस ' म�, �न� न म� से कौन सा मा�य �वक� प नह�ं
है?

Ans 1. ओ�रएंटेशन

2. मािज�� स

3. � केल

4. पेपर साइज़

Question Type : MCQ
Question ID : 618278979

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.34 �न� न म� से �कस पोट� का उपयोग चािज�ग व डटेा �ांसफर दोन� के �लए �कया जा सकता है?

Ans 1. सी�रयल

2. परैलल

3. यएूसबी (USB)

4. यएूसबी-सी (USB-C)

Question Type : MCQ
Question ID : 618278965

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.35 माइ�ोसॉ�ट ए�सेल म�, �न�न म� से कौन सा एक नाम वक� शीट के �लए अमा�य है?

Ans 1. �ह���

2. अ�वूड-1

3. बजट

4. अकाउंट123

Question Type : MCQ
Question ID : 618278991

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.36 माइ�ोसॉ�ट ए�सेल म�, �ोटे�शन के संदभ� म�, �न�न�ल�खत म� से कौन सा �वक�प अमा�य है?

Ans 1. सेल अनलॉक कर�

2. वक� बकु सरु��त कर� (वक� बकु �ोटे�ट कर�)
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3. ता�लका सरु��त कर� (टेबल �ोटे�ट कर�)

4. शीट सरु��त कर� (�ोटे�ट शीट)

Question Type : MCQ
Question ID : 618278996

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.37

Ans

1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 618278998

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.38 पावरपॉइंट म�, अगर आपके पास 10 �लाइ�स ह� और आपने 5वी ं�लाइड को चनुा है, तो + पर ि�लक करने पर
आप कौन सी �लाइड पर पहँुच जाएंगे?

Ans 1. �लाइड नंबर 1

2. 5वीं �लाइड क� पहल� लाइन पर

3. �लाइड नंबर 10

4. �लाइड नंबर 6

Question Type : MCQ
Question ID : 6182781015

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.39 MS Word डॉ� यमु�ट म� लाइन � पे�सगं ___(a)___ → ___(b)___ का उपयोग करके बदल� जा सकती है।
Ans 1. (a) �डज़ाइन (b) लाइन � पे�सगं

2. (a) लेआउट (b) मािज�� स

3. (a)   �डज़ाइन (b) परैा�ाफ � पे�सगं
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4. (a) लेआउट (b) एलाइन

Question Type : MCQ
Question ID : 618278980

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.40 जब आप ए�सेल वक� बकु खोलत ेह�, तब ए�सेल आपके �लए अपने आप ______ चनुता है। डॉ�यमु�ट �वडं� के
�नचले भाग म� शीट टैब पर वक� शीट का नाम �दखाई देता है।

Ans 1. नेम1

2. वक� शीट1

3. शीट A

4. शीट1

Question Type : MCQ
Question ID : 618278990

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.41 सीपीय ू(CPU) का पणू� �प �या है?

Ans 1. स��ल �ोसे�सगं य�ूनट

2. कमांड �ोसे�सगं य�ूनट

3. कं�ोल �ो�ाम य�ूनट

4. कोर �ोसे�सगं य�ूनट

Question Type : MCQ
Question ID : 618278961

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.42 ए�सेल म� “�ोटे�ट शीट” का �वक�प �न�न म� से �कस मेन ूहे�डगं म� उपल�ध होता है?

Ans 1. �यू

2. पेज लेआउट

3. डटेा

4. �र�यू

Question Type : MCQ
Question ID : 6182781003

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.43 इ� सट� टेबल डायलॉग बॉ� स से ता�लका बनाने के �लए:

1. मे�य ूबार म� टेबल पर ि�लक कर�, इ�सट� चय�नत कर� और �फर टेबल... एक डायलॉग बॉ� स खलेुगा।
2. पंि�तय� व � तंभ� क� इि�छत सं� या दज� कर�।
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3. य�द आप चाहत ेह� �क टेबल के सेल उनम� मौजदू टे� � ट को �फट करने के �लए � वत: �व� ता�रत हो जाएं, तो
______ को चनु�।

Ans 1. वड� रैप

2. ऑटोफॉम�ट

3. टे� � ट रैप

4. ऑटो-�फट �बहै�वयर

Question Type : MCQ
Question ID : 618278984

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.44 बड़ी सं�या म� रॉ और कॉलम वाले डटेा वाले वक� शीट म�, जब आप वक� शीट के दसूरे �ह�स� को ��ॉल करत ेह�,
तब वक� शीट क� पहल� रॉ म� �दए हुए कॉलम हे�डगं को ��यमान रखने के �लए �न�न�ल�खत चरण �कए जाते
ह�:

Ans 1. View > Freeze Panes > Freeze Row

2. View > Freeze Row > Page Layout

3. View > Freeze Panes > Freeze First Row

4. View > Page Layout > Freeze Row

Question Type : MCQ
Question ID : 618278993

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.45 कोई यह कैसे उि�ल�खत कर सकता है �क जब वक� शीट �ोटे�टेड हो, तो वक� शीट के उपयोगकता� फाम��टगं को
बदल कर उसे लागू कर सकत ेह�?

Ans 1. होम टैब के अदंर �टाइ�स �ुप म� Cell Styles Gallery से �ी-सेट फाम��टगं को �सले�ट करके।

2. Formats > Cells > Protection को अ�चि�नत (अन�टक) करके

3. ‘�ोटे�ट वक� बकु’ डायलॉग बॉ�स म� केवल ���चर  और �वडंोज़ के �वक�प को चनुकर

4. ‘�ोटे�ट वक� बकु’ डायलॉग बॉ�स म�, फॉम�ट से�स, फॉम�ट  कॉलम और फॉम�ट रॉ के बॉ�स म� �टक
करके

Question Type : MCQ
Question ID : 6182781004

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.46 पावरपॉइंट म�, ‘फ़ॉम�ट बकै�ाउंड’ का उपयोग ______ के समय �कया जाता है।
Ans 1. ए�नमेशन

2. �ैि�ज़शन

3. �लाइड �डज़ाइन

4. �लाइड इ�सट�

Question Type : MCQ
ANKAJ INFOTECH



1/27/2020 https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S65D261/157682219819030…

https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S65D261/15768221981903054/193676… 14/17

Question ID : 6182781012
Status : Answered

Chosen Option : 3
Marks : 1.00

Q.47 माइ�ोसॉ�ट ए�सेल म�, पंि�त (रॉ) क� ऊँचाई बदलने के संदभ� म�, �न�न�ल�खत म� से कौन सा कथन गलत
है?

Ans 1. �डफ़ॉ�ट �प से, एक नई वक� बकु म� सारे रॉ क� ऊँचाई एक समान होती है।

2. ओटो�फट स�ुवधा, रॉ म� �दए हुए सबसे बड़ ेमान को समायोिजत करने के �लए उस रॉ को अपने आप
बढ़ा देती है।

3. ए�सेल म� रॉ हाइट को समायोिजत करने के �लए, रॉ बोड�र को खींचना, सबसे सामा�य तर�का है।

4. एक समय पर केवल एक ह� रॉ क� ऊँचाई बदल� जा सकती है।

Question Type : MCQ
Question ID : 618278994

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.48 मेल मज� �ोसेस म� तीन डॉ� यमु�ट शा�मल होत ेह�: मेन डॉ� यमु�ट, डटेा सोस� तथा ______।
Ans 1. मज� �कया जाने वाला लेटर

2. मज� �कया गया डॉ� यमु�ट

3. � �ेडशीट

4. आउटलकु कॉ� टै� ट �ल� ट

Question Type : MCQ
Question ID : 618278985

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.49 �न�न�ल�खत म� से, SMTP सव�र के बारे म� गलत कथन का चयन कर�।
Ans 1. यह �ा�तकता� इमेल �लाइंट ए�सै क� जाँच करता है

2. यह पोट� 25 पर जड़ुता है

3. यह �लाइंट के �लए �रमोट सव�र पर इमेल �टोर करता है

4. यह �लाइंट से आउटगोइंग इमेल को �वीकार करता है

Question Type : MCQ
Question ID : 6182781020

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.50 �लास B नेटवक�  म�, पहले ______ �ब�स ए�से का नेटवक�  �ह�सा होत ेह�।
Ans 1. 16

2. 2

3. 8

4. 24
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Question Type : MCQ
Question ID : 6182781019

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.51 पहँुच (ए�सेस) क� ग�त के बढ़त े�म म� �न�न�ल�खत को �यवि�थत कर�:

(1) डायल-अप (2) डीएसएल (3) केबल
Ans 1. (1) (2) (3)

2. (2) (3) (1)

3. (2) (1) (3)

4. (1) (3) (2)

Question Type : MCQ
Question ID : 6182781016

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.52 �वडंोज़ ए� सपी (Windows XP) ड�े कटॉप पर पाया जाने वाला छोटा �च� वह �तीक होता है जो �ो�ाम,
ए� ल�केशन या फाइल को दशा�ता है। इनम� से �� येक क� � यटूर के भीतर मौजदू �कसी आइटम, फाइल या
�ो�ाम के शॉट�कट होत ेह�। ये ______ कहलात ेह�।

Ans 1. पॉइंटर

2. टूलबार

3. आइकॉन

4. �प�सेल

Question Type : MCQ
Question ID : 618278970

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.53 आपने रॉ 7 और 8 को चय�नत �कया है और �फर आप Insert → Row को चनुत ेह�। इससे �या होगा?
Ans 1. रॉ 7 के बाद दो रॉ जड़ु जाएंगे

2. रॉ 8 के बाद दो रॉ जड़ु जाएंगे

3. रॉ 6 के बाद दो रॉ जड़ु जाएंगे

4. रॉ 9 के बाद दो रॉ जड़ु जाएंगे

Question Type : MCQ
Question ID : 6182781001

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.54 ______ आपके क� � यटूर म� फाइल सं��हत करने का एक �थान होता है। यह डॉस, य�ून� स, �वडंोज़ (DOS,
UNIX, Windows) इ� या�द के जसेै ऑपरे�टगं �स� टम म� फाइल �स� टम के वग�कृत संरचना म� पाया जाता
है।

Ans 1. डाइरे� टर�
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2. कैटलॉग

3. रिज� टर

4. �डि���टर

Question Type : MCQ
Question ID : 618278972

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.55 मेल मज� का उपयोग करके लबैल ��टं करने के �लए:

क) “Mailings” म� जाएं > ______ > “Labels”.
ख) “Label Options” डायलॉग बॉ�स म�, “Label products” �ल�ट म� अपना लबैल स�लायर चनु�।
ग) “Product number” �ल�ट म� जाकर, उस �ॉड�ट नंबर को चनु� जो आपके लबैल के पकेैज पर �दया हुआ
है।
घ) “OK” को चनु�। अब आपका डॉ�यमु�ट ,लबैल के आउटलाइन वाला एक टेबल �दखाएगा। य�द आपको
आउटलाइन नह�ं �दख रह� है, तो “Table Layout” म� जाएं और “View Gridlines” चनु�।
ड) फाइल म� जाएं उसके बाद आपके डॉ�यमु�ट को सेव कर�।

Ans 1. ��टं कर�

2. ��एट

3. मेल मज�

4. मेल मज� श�ु कर�

Question Type : MCQ
Question ID : 618278988

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.56 �लाइड सॉट�र �य ूका म�ुय उदे�य �या है?

Ans 1. �लाइडस को पनु�य�वि�थत करना

2. �लाइडस क� �गनती करना

3. �लाइडस का �दश�न करना

4. �लाइडस म� सधुार करना

Question Type : MCQ
Question ID : 6182781013

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.57 �व� व म� कह�ं पर हाड�वेयर के � ल� टर �वारा संचा�लत और इंटरनेट पर आपके ट�म�नल पर �वत�रत क� � य�ूटगं
स�व�स ______ कहलाती है।

Ans 1. � लाउड क� � य�ूटगं

2. � लाइंट-सव�र क� � य�ूटगं

3. डटेाबेस स�व�स

4. �रमोट क� � य�ूटगं
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Question Type : MCQ
Question ID : 618278967

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.58 माइ�ो�ोसेसर म� लाख� छोटे-छोटे ______ होत ेह�।
Ans 1. इंड� टर एवं रिज� टर

2. �स�लकॉन �च� स

3. �ांिज� टर

4. कैप�सटर

Question Type : MCQ
Question ID : 618278962

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.59 MS Word का उपयोग करत ेसमय, आप डॉ� यमु�ट म� फुटनोट सि�म�लत करने के �लए �कस मे� य ूका
उपयोग कर�गे?

Ans 1. इ� सट� (Insert)

2. रेफर�सेज़ (References)

3. फॉम�ट (Format)

4. �र� य ू(Review)

Question Type : MCQ
Question ID : 618278976

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.60 य�द MS Word म� चयन �कए गए टे� � ट को कॉपी करना हो, तो �कस बटन पर ि�लक �कया जाना चा�हए?

Ans 1. डु� ल�केट (Duplicate)

2. मवू (Move)

3. कट (Cut)

4. कॉपी (Copy)

Question Type : MCQ
Question ID : 618278982

Status : Answered
Chosen Option : 3

Marks : 0.00
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Q.1 MS Excel 2016 म� ______ अ�ंतम ��या को दोहराने के �लए शॉट�-कट कंुजी है।
Ans 1. Ctrl + R

2. F8

3. F4

4. Ctrl + Z

Question Type : MCQ
Question ID : 618278931

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.2 डटेा नेटव�क� ग के संबंध म�, �नयम� और कंवे�शन का एक औपचा�रक सेट जो यह �नयं��त करता है �क
कं�यटूर �कस तरह से एक नेटवक�  मा�यम पर सचूनाओ ंका आदान-�दान करत ेह�, ______ के �प म� जाना
जाता है।

Ans 1. गेटवे

2. एफ़ट�पी (FTP)

3. �ोटोकॉल

4. ट�सीपी/आईपी (TCP/IP)

Question Type : MCQ
Question ID : 618278956

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.3 �न�न�ल�खत म� से कौन कं�यटूर �स�टम के संबंध म� भाषा अनवुादक का एक मा�य �कार नह�ं है?

Ans 1. डीबगर

2. क�पाइलर

3. दभुा�षया (इंटर�ेटर)

Participant ID 19417421
Participant Name PANKAJ KUMAR SAH
Test Center Name iON Digital Zone iDZ 2 Patliputra
Test Date 18/12/2019
Test Time 9:00 AM - 10:00 AM
Subject Data Entry Operator
Marks Obtained 27.00000

Section : MCQ for Data Entry Operator
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4. असे�बलर

Question Type : MCQ
Question ID : 618278908

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.4 MS Excel म� सेल क� साम�ी (कंट�ट) को संपा�दत करने के �लए �कस कंुजी का उपयोग �कया जाता है?

Ans 1. F4

2. Ctrl + Enter

3. F2

4. Shift + Enter

Question Type : MCQ
Question ID : 618278933

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.5 �लर बार �डफ़ॉ�ट �प से �द�श�त होता है और ______ के नीचे �दखाई देता है।
Ans 1. �वडंो बार

2. टूलबार

3. �टेटस बार

4. टाइटल बार

Question Type : MCQ
Question ID : 618278916

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.6 वक� शीट या वक� बकु क� सरु�ा के �लए �र�य ूटैब पर जाएं और �फर �ोटे�ट शीट पर ि�लक कर� या च�ज �ुप म�
�ोटे�ट वक� बकु पर ि�लक कर�।

Ans 1. हो सकता है

2. �नधा��रत नह�ं कर सकते

3. स�य

4. अस�य

Question Type : MCQ
Question ID : 618278937

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.7 GUI ______ के बीच एक इंटरफ़ेस के �प म� काय� करता है।
Ans 1. �योगकता� (यजूर) और हाड�वेयर

2. हाड�वेयर और सॉ�टवेयर

3. सॉ�टवेयर और �योगकता� (यजूर)
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4. �यि�त और मॉ�नटर

Question Type : MCQ
Question ID : 618278906

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.8 Excel म� �तंभ� (कॉलम) को ______ के �प म� लेबल �कया जाता है।
Ans 1. A, B, C, आ�द

2. $A$1, $A$2, आ�द

3. 1, 2, 3, आ�द

4. A1, A2, आ�द

Question Type : MCQ
Question ID : 618278930

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.9 While dragging the text, the mouse pointer changes to a box with a small ______ arrow
over it, indicating you are dragging text.

Ans 1. Black

2. Grey

3. White

4. Blue

Question Type : MCQ
Question ID : 618278924

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.10 MS Power Point �ेज�टेशन क� संरचना को ______ म� �दखाया जा सकता है।
Ans 1. �लाइड �यू

2. आउटलाइन �यू

3. नाम�ल �यू

4. �टे�टक �यू

Question Type : MCQ
Question ID : 618278951

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.11 MS Word 2016 म� �वडंो को �वभािजत करने के �लए शॉट�-कट कंुजी �या है?

Ans 1. Ctrl + W

2. Alt + Ctrl + S

3. Alt + S
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4. Ctrl + S

Question Type : MCQ
Question ID : 618278923

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.12 ______ �लकं �कए गए द�तावेज़� या प�ृठ� का एक सं�ह है, जो लाख� कं�यटूर� पर सं��हत (�टोर) होता है
और परेू इंटरनेट पर फैला हुआ है।

Ans 1. FTP

2. WWW

3. ISP

4. TCP/IP

Question Type : MCQ
Question ID : 618278958

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.13 ______ केवल तब होता है, जब हम डटेाबेस फ़���स को एक टे��ट डॉ�यमू�ट के �प म� लेटर म� मज� करत ेह�।
Ans 1. एमएस वड� (MS Word)

2. �पे�लगं और �ामर

3. भाषा

4. मेल मज�

Question Type : MCQ
Question ID : 618278929

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.14 �कसी वक� शीट पर लगे बॉड�र को आप कैसे हटा सकत ेह�?
Ans 1. बॉड�स� को हटाया नह�ं जा सकता ।

2. उन सभी सेल� का चयन कर� िजनसे आप बॉड�र �नकालना चाहत ेह� और �फर बॉड�र मेन ूसचूी म� 'नो
बॉड�र' पर ि�लक कर� ।

3. उन सभी सेल� का चयन कर� िजनसे आप बॉड�र को हटाना चाहत ेह� और �फर बॉड�स� मेन ूसचूी म�
‘�रमवू बॉड�र’ पर ि�लक कर� ।

4. उन सभी सेल� का चयन कर� िज�ह� आप बॉड�र से हटाना चाहत ेह� और अपने क�बोड� पर ‘Ctrl +

Delete’ दबाएं ।

Question Type : MCQ
Question ID : 618278942

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.15 MS Word के शीष� पर ि�थत बार को ______ बार कहा जाता है।
Ans

ANKAJ INFOTECH



1/27/2020 https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S64D247/157682222281985…

https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S64D247/15768222228198580/1941742… 5/16

1. टाइटल

2. �वडंो

3. �टेटस

4. टूल

Question Type : MCQ
Question ID : 618278915

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.16 MS Excel म� �कस �कार के डटेा का उपयोग नह�ं �कया जा सकता है?

Ans 1. टे��ट

2. �दनांक और समय

3. फं�शन

4. फॉमू�ला

Question Type : MCQ
Question ID : 618278945

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.17 ______ चाट� �वशषे �प से �टॉक और शयेर� से संबं�धत डटेा मान� के आलेखन (�ला�टगं) के �लए बनाया गया
है।

Ans 1. पाई

2. �टॉक

3. बार

4. �े� (ए�रया)

Question Type : MCQ
Question ID : 618278948

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.18 MS-Excel 2016 म� Home Menu के तहत आप ��वि�टय� क� एक �ृंखला को �मब� (सॉट�) कर सकत ेह�।
क�टम सॉट� के अलावा सॉट� और �फ़�टर �वक�प के अतंग�त �कतने �कार के सॉट� उपल�ध ह�?

Ans 1. 5

2. 2

3. 4

4. 3

Question Type : MCQ
Question ID : 618278934

Status : Answered
Chosen Option : 3

Marks : 0.00
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Q.19 इनम� से कौन सा इंटरनेट कने�शन वायरलेस कने�शन नह�ं है?

Ans 1. वाईम�ैस

2. ल��ड लाइन

3. वाई-फाई

4. उप�ह (सटैलाइट)

Question Type : MCQ
Question ID : 618278957

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.20 ______ टे��ट क� �गै-एंड-�ॉप �व�ध आपको अपने माउस का उपयोग करके चय�नत टे��ट को �थानांत�रत
करने क� अनमु�त देती है।

Ans 1. से�वगं

2. ए�ड�टगं

3. म�ूवगं

4. �डल�ट�ंग

Question Type : MCQ
Question ID : 618278922

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.21 वड�पडै फाइल� का फाइल ए�सट�शन ______ होता ह।
Ans 1. Doc

2. Rtf

3. Pdf

4. Txt

Question Type : MCQ
Question ID : 618278913

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.22 �कसी MS Excel 2016 वक� शीट म� आप चाहत ेह� �क कोई �योगकता� �ॉपडाउन सचूी से केवल हा ंया ना म�
इनपटु डालने म� स�म हो। आप इसके �लए �कस फं�शन का उपयोग कर�गे?

Ans 1. कंसो�लडटे

2. डटेा वे�लडशेन

3. मनेैज डटेा मॉडल

4. �लशै �फल

Question Type : MCQ
Question ID : 618278943

Status : Answered
Chosen Option : 2

Marks : 1.00ANKAJ INFOTECH
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Q.23 MS PowerPoint ______ का एक उदाहरण है।
Ans 1. �ेज�टेशन सॉ�टवेयर

2. म�ट�मी�डया सॉ�टवेयर

3. ऑ�डयो सॉ�टवेयर

4. डटेाबेस सॉ�टवेयर

Question Type : MCQ
Question ID : 618278907

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.24 टा�कबार म� एक �ो�ाम को शा�मल �कया जाता है। य�द आप टा�कबार से �ो�ाम श�ु करना चाहत ेह�, तो
आपको इसके आइकॉन पर ______ करने क� आव�यकता है।

Ans 1. डबल ि�लक

2. राइट ि�लक

3. ��पल ि�लक

4. �सगंल ि�लक

Question Type : MCQ
Question ID : 618278910

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.25 कौन सा भाषा �ोसेसर उ�च �तर पर �लखे गए �ो�ाम को मशीन भाषा �ो�ाम म� पंि�त-दर-पंि�त (लाइन-
बाय-लाइन) �पांत�रत करता है?

Ans 1. असे�बलर

2. क�पाइलर

3. ऑपरे�टगं �स�टम

4. दभुा�षया (इंटर�ेटर)

Question Type : MCQ
Question ID : 618278909

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.26 ______ इंड�ट, हर परैा�ाफ क� पहल� लाइन को इंड�ट करता है।
Ans 1. बायाँ (ले�ट)

2. ह��गगं

3. पहल� पंि�त (फ�ट� लाइन)

4. दाया ँ(राईट)

Question Type : MCQ
Question ID : 618278917

Status : Answered
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Chosen Option : 1
Marks : 0.00

Q.27 MS Excel 2016 वक� शीट म� आप वेबसाइट पर एक हाइपर�लकं जोड़ना चाहत ेह�। कौन सा मेन ूआपको
हाइपर�लकं जोड़ने का �वक�प देगा?

Ans 1. फॉमू�ला

2. �यू

3. होम

4. इ�सट�

Question Type : MCQ
Question ID : 618278938

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.28 ______ म� फ़ाइल� का समहू या अ�य फ़ो�डर होत ेह�।
Ans 1. आइकॉन

2. फ़ाइल

3. फ़ो�डर

4. डटेा

Question Type : MCQ
Question ID : 618278912

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.29 अ�ंतम ______ घटक जो कट या कॉपी �कए गए थे उ�ह� वड� के ि�लपबोड� म� रखा जाता है।
Ans 1. बदले गए (ऑ�टड�)

2. हटाए गए (�डल�टेड)

3. सहेजे गए (से�ड)

4. चय�नत (�सले�टेड)

Question Type : MCQ
Question ID : 618278920

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.30 आपको MS Word 2016 डॉ�यमू�ट म� एक उ�रण (साइटेशन) शा�मल करने क� आव�यकता है। आपको यह
�वक�प कहां �मलेगा?

Ans 1. �रफरे�स मेनू

2. �र�य ूमेनू

3. �डजाइन मेनू

4. इ�सट� मेनू

Question Type : MCQ
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Question ID : 618278928
Status : Answered

Chosen Option : 1
Marks : 1.00

Q.31 MS Excel 2016 म� सेल A2 म� स�ू '=B2+C3' है। इस स�ू को सेल C2 म� कॉपी करने पर स�ू ______ बन
जाता है।

Ans 1. E2+F3

2. F2+G3

3. C2+D3

4. D2+E3

Question Type : MCQ
Question ID : 618278946

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.32 In MS Word 2016, ribbon is divided into ______ sections.
Ans 1. One

2. Four

3. Three

4. Two

Question Type : MCQ
Question ID : 618278918

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.33 MS Word म� पेज नंबर को हेडर या फुटर म� ______ �वारा शा�मल �कया जा सकता है।
Ans 1. फ��ड

2. मािज�न

3. से�शन

4. कॉलम

Question Type : MCQ
Question ID : 618278921

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.34 ______ को ROM म� सं��हत �कया जाता है।
Ans 1. SRAM

2. BIOS

3. DRAM

4. PROM

Question Type : MCQ
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Question ID : 618278901
Status : Answered

Chosen Option : 4
Marks : 0.00

Q.35 �न�न�ल�खत म� से कौन एक आउटपटु �डवाइस है?

Ans 1. वीडीय ू(VDU)

2. जॉयि�टक

3. माउस

4. सीपीय ू(CPU)

Question Type : MCQ
Question ID : 618278904

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.36 MS Excel 2016 क� वक� शीट म� 'बोक' क� कई ��वि�टया ँह�। यह 'बकु' होना चा�हए था। ऐसे सभी उदाहरण�
को ढँूढने और बदलने के �लए आप �कस कमांड का उपयोग कर�गे?

Ans 1. Ctrl + G

2. Ctrl + R

3. Ctrl + H

4. Ctrl + A

Question Type : MCQ
Question ID : 618278936

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.37 MS Word 2016 म� ��टं �ी�य ूके �लए शॉट�-कट कंुजी �या है?

Ans 1. Ctrl + W

2. Ctrl + F2

3. Alt + Ctrl + S

4. Alt + P

Question Type : MCQ
Question ID : 618278925

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.38 आपके पास MS Excel 2016 म� कई वक� बकु खलु� ह�। Ctrl + W और Ctrl + F4 दबाने पर �या अतंर है?

Ans 1. Ctrl + F4 केवल वत�मान वक� बकु को बंद करता है, जब�क Ctrl + W संपणू� Excel को बंद कर देता
है

2. Ctrl + W एक वॉटरमाक�  जोड़ता है, जब�क Ctrl + F4 फ़ाइल का नाम बदल देता है

3. Ctrl + W वत�मान वक� बकु को बंद करता है, जब�क Ctrl + F4 एक नई वक� बकु खोलता है

4. कोई फक�  नह�ं
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Question Type : MCQ
Question ID : 618278932

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.39 MS PowerPoint 2016 म� �लाइड शो के दौरान कमांड Ctrl + P का उपयोग करने से �या होता है?

Ans 1. अगल� �लाइड चलाय�

2. �लाइड शो को रोकना

3. ��टं आउट लेना

4. �लाइड शो के दौरान पेन टूल के साथ एनोटेट करना

Question Type : MCQ
Question ID : 618278954

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.40 ल�ना को MS Excel वक� शीट म� 1 से 40 तक क� सं�या दज� करनी है। अपना काम ज�द� और आसानी से परूा
करने के �लए उसे MS Excel क� �कस �वशषेता का उपयोग करना चा�हए?

Ans 1. �टाइ�स

2. फॉरमेट प�टर

3. फ़ॉ�ट

4. ऑटो �फल

Question Type : MCQ
Question ID : 618278939

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.41 ______ एक डटेाबेस है िजसम� नाम और पता �रकॉड� होता है िजसम� से एक मे�लगं सचूी MS Word मेल मज�
म� �ा�त क� जा सकती है।

Ans 1. फाइनल डॉ�यमू�ट

2. मेन डॉ�यमू�ट

3. डॉ�यमू�ट के साथ डटेा मज�

4. डटेा सोस�

Question Type : MCQ
Question ID : 618278927

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.42 MS Excel आपको ______ कंट�ट को बा�, क� �, दा� संरे�खत करने और जि�टफाई करने म� स�म बनाता है।
Ans 1. सेल

2. पंि�त (रो)

3. �तंभ (कॉलम)
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4. वक� शीट

Question Type : MCQ
Question ID : 618278940

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.43 MS Excel म� �न�न�ल�खत म� से कौन एक मा�य फं�शन नह�ं है?

Ans 1. MAX

2. SUM

3. MIN

4. AVG

Question Type : MCQ
Question ID : 618278947

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.44 �लाइड सॉट�र �य ूम� सभी �लाइड ______ शा�मल होत ेह�।
Ans 1. डटेा

2. आइकॉन

3. पेजेस

4. थंबनेल

Question Type : MCQ
Question ID : 618278953

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.45 �न�न�ल�खत म� से �कस वग� के �डवाइस को माइ�ोकं�यटूर म� शा�मल नह�ं �कया गया है?

Ans 1. सपुरकं�यटूर

2. लपैटॉप कं�यटूर

3. ह�डहे�ड �डवाइस

4. टेबलेट पी.सी.

Question Type : MCQ
Question ID : 618278902

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.46 �लाइड �े� को ______ �े� कहा जाता है।
Ans 1. �ेज�टेशन

2. �ाइंग

3. फॉरमेट
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4. वक�

Question Type : MCQ
Question ID : 618278952

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.47 आप MS Excel 2016 म� अपनी वक� शीट म� एक प�ृठभ�ूम ( बकै�ाउंड) �च� जोड़ना चाहत ेह�। आपको इसका
�वक�प कहां �मलेगा?

Ans 1. पेज लेआउट मेनू

2. डटेा मेनू

3. डवेलपर मेनू

4. �य ूमेनू

Question Type : MCQ
Question ID : 618278949

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.48 GUI का �व�ता�रत �प ______ है।
Ans 1. �ाफ यजूर इंटरफेस

2. �ा�फकल यज़ूर इंटरफ़ेस

3. �ा�फकल यजूर इंटरे�शन

4. �ा�फकल य�ूनवस�ल इंटरफ़ेस

Question Type : MCQ
Question ID : 618278911

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.49 आप �कसी वक� शीट क� पंि�त या कॉलम का आकार बदल नह�ं सकत।े
Ans 1. अस�य

2. �नधा��रत नह�ं कर सकते

3. स�य

4. हो सकता है

Question Type : MCQ
Question ID : 618278935

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.50 एक काया��मक कं�यटूर �स�टम बनाने के �लए हाड�वेयर के सभी �ह�स� को इक�ा करने के बाद काय� श�ु करने
के �लए आपको �कस सॉ�टवेयर को इं�टॉल करने क� आव�यकता है?

Ans 1. वड� �ोसे�सगं सॉ�टवेयर

2. हाड�वेयर �ाइवर
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3. ऑपरे�टगं �स�टम

4. एंट�वायरस सॉ�टवेयर

Question Type : MCQ
Question ID : 618278914

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.51 डॉट म�ै��स ��टंर क� ग�त को ______ म� मापा जाता है।
Ans 1. सी.पी.एस. (Cps)

2. �ब�स

3. बाइ�स

4. डी.पी.आई. (Dpi)

Question Type : MCQ
Question ID : 618278905

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.52 Excel भलेू हुए पासवड� को पनु�ा��त करने का कोई तर�का �दान नह�ं करता है।
Ans 1. �नधा��रत नह�ं कर सकते

2. अस�य

3. स�य

4. हो सकता है

Question Type : MCQ
Question ID : 618278944

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.53 ______ एक 32-�बट सं�या�मक पता है िजसका उपयोग इंटरनेट पर कं�यटूर दशा�ने के �लए �कया जाता है।
Ans 1. रे�सड��शयल ए�से

2. वचु�अल ए�से

3. आईपी ए�से (IP ए�से)

4. ए�से

Question Type : MCQ
Question ID : 618278959

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.54 �कस कमांड के अतंग�त आपको �माट�आट� कमांड �मलेगा?
Ans 1. �डज़ाइन

2. इल��ेशन
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3. परैा�ाफ

4. टे��ट

Question Type : MCQ
Question ID : 618278950

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.55 ______ एक सॉ�टवेयर �ो�ाम है जो �योगकता�ओ ं(यजूस�) को व�ड� वाइड वेब तक पहंुचने और ने�वगेट करने
क� अनमु�त देता है।

Ans 1. �ाउज़र

2. मेन पेज

3. वेबसाइट

4. वेबपेज

Question Type : MCQ
Question ID : 618278960

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.56 MS PowerPoint 2016 म� त�वीर शा�मल करने के �लए शॉट�-कट कंुजी �या है?

Ans 1. Ctrl + Alt + P

2. Ctrl + P

3. Alt + N + P

4. Shift + P

Question Type : MCQ
Question ID : 618278955

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.57 MS Word 2016 म� डॉ�यमू�ट को बंद करने के �लए शॉट�-कट कंुजी �या है?

Ans 1. Ctrl + W

2. Alt + W

3. Ctrl + M

4. Ctrl + C

Question Type : MCQ
Question ID : 618278919

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.58 MS Word 2016 म� आप श�द� क� एक सीमा (र�ज) को रेखां�कत करना चाहत ेह�, ले�कन श�द� के बीच म�
जगह को नह�ं। इसके �लए शॉट�-कट कंुजी �या है?

Ans 1. Ctrl + W
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2. Ctrl + Shift + W

3. Alt + P

4. Ctrl + U

Question Type : MCQ
Question ID : 618278926

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.59 संपणू� पंि�त (रो) को हाइलाइट करने के �लए हम ______ का उपयोग करत ेह� और आव�यक या �दए गए
मानदंड� के आधार पर एक स�ू दज� करत ेह�।

Ans 1. टे��ट

2. र�ज

3. सशत� �व�पण (कंडीशनल फॉम��टगं)

4. स�ू (फॉमू�ला)

Question Type : MCQ
Question ID : 618278941

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.60 क�बोड� म� ______ शा�मल नह�ं होता है।
Ans 1. �यमेू�रक क�ज़

2. माउस

3. कं�ोल क�ज़

4. फ़ं�शन क�ज़

Question Type : MCQ
Question ID : 618278903

Status : Answered
Chosen Option : 2

Marks : 1.00
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Q.1 MS-वड� म�, जब आप टे��ट के �कसी चय�नत भाग को काटत ेह� तो टे��ट, द�तावेज़ से हटा �दया जाता है
और अ�थायी भंडारण �े� पर रखा जाता है, इसे �न�न�ल�खत म� से �या कहत ेह�?

Ans 1. पलू

2. ि�लपबोड�

3. लेआउट

4. परैा�ाफ

Question Type : MCQ
Question ID : 6182781223

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.2 MS-ए�सल 2016 म� मौजदूा वक� शीट से पहले नई वक� शीट इंसट� करने के �लए सह� �म कौनसा �वक�प
��ततु करता है?

Ans 1. होम टैब → से�स �ुप → इंसट� → इंसट� शीट

2. होम टैब → इंसट� → से�स �ुप → इंसट� शीट

3. होम टैब → से�स �ुप → इंसट� शीट → इंसट�

4. होम टैब → इंसट� → इंसट� शीट → से�स �ुप

Question Type : MCQ
Question ID : 6182781230

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.3 MS-ए�सल 2016 म� फाम�ट सेल पॉपअप क� नंबर टैब म� �न�न�ल�खत म� से कौनसी एक मा�य �ेणी नह�ं है?

Ans 1. कर�सी

2. ड�ेसमल

3. नंबर

Participant ID 19456646
Participant Name ANAND KUMAR
Test Center Name iON Digital Zone iDZ 2 Patliputra
Test Date 19/12/2019
Test Time 3:00 PM - 4:00 PM
Subject Data Entry Operator
Marks Obtained 22.00000

Section : MCQ for Data Entry Operator
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4. �ै�शन

Question Type : MCQ
Question ID : 6182781239

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.4 ऍि�लकेशन सॉ�टवेयर के संदभ� म� �न�न�ल�खत म� से कौनसा कथन गलत है?

Ans 1. कोई भी अन�ुयोग सॉ�टवेयर, अ�य अन�ुयोग सॉ�टवेयर से �वतं� �प से चल सकता है।

2. ऍि�लकेशन सॉ�टवेयर को कं�यटूर पर तभी इ��टॉल �कया जा सकता है जब ऑपरे�टगं �स�टम
कं�यटूर पर इ��टॉल क� गई हो।

3. ऍि�लकेशन सॉ�टवेयर को उपयोगकता� क� आव�यकताओ ंके अनसुार इ��टॉल �कया जाता है।

4. ऍि�लकेशन सॉ�टवेयर का उपयोग म�ुय �प से कं�यटूर हाड�वेयर को चलाने के �लए �कया जाता है।

Question Type : MCQ
Question ID : 6182781207

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.5 MS-Excel 2016 म�, फ़ं�शन को सि�म�लत करने के �लए आप �न�न�ल�खत म� से �कस शॉट� कट कंुजी का
उपयोग कर�गे?

Ans 1. Ctrl + F

2. Ctrl + I

3. Shift + F3

4. F3

Question Type : MCQ
Question ID : 6182781236

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.6 �न�न�ल�खत म� से कौनसा वेब �ाउज़र का उदाहरण नह�ं है?

Ans 1. गूगल �ोम

2. ओपेरा

3. �बगं

4. मोिज़ला फ़ायरफ़ॉ�स

Question Type : MCQ
Question ID : 6182781260

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.7 �वडंोज़ XP म� �न�न�ल�खत म� से कौनसा "�टाट�" मेन ूआइटम इ��टॉल �कए गए �ो�ाम� क� सचूी �द�श�त
करता है जो उपयोगकता� श�ु या उपयोग कर सकता है?

Ans 1. माय �यिूज़क
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2. हे�प एंड सपोट�

3. माय डॉ�यमेु��स

4. ऑल �ो�ाम

Question Type : MCQ
Question ID : 6182781211

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.8 MS -ए�सेल 2016 म�, होम टैब क� श�ैलय� के समहू म� �न�न�ल�खत म� से कौनसा �वक�प ज�द� से सेल� क�
एक �ेणी को फाम�ट करता है और इसे पवू� �नधा��रत ता�लका शलै� चनु कर ता�लका म� प�रव�त�त करता है?

Ans 1. नई सेल �टाइल

2. फॉम�ट अस टेबल

3. मज� �टाइ�स

4. कंडीशनल फोम�ि�तंग

Question Type : MCQ
Question ID : 6182781242

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.9 �न�न�ल�खत म� से कौनसा एक आउटपटु उपकरण है?

Ans 1. माइ�ोफ़ोन

2. बारकॉड र�डर

3. �पीकर

4. OMR

Question Type : MCQ
Question ID : 6182781203

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.10 MS-ए�सल 2016 म� �कसी स�ू क� कॉपी करत ेसमय, स�ू के केवल मान को पे�ट करने के �लए �न�न�ल�खत
म� से कौन से पे�ट �वशषे �वक�प का उपयोग �कया जाता है?

Ans 1. फोम��स

2. व�ैयजू

3. फ़ॉमू�लास

4. कम��स

Question Type : MCQ
Question ID : 6182781246

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.11 �न�न�ल�खत म� से कौनसा इनपटु उपकरण अपनी ज�ैवक �वशषेताओ ंके माप न �वारा �यि�तय� क� पहचान
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करने के �लए उपयोग म� �लया जाता है?

Ans 1. माउस

2. �फंगर ���ट �कैनर

3. बारकॉड �कैनर

4. लाइट गन

Question Type : MCQ
Question ID : 6182781204

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.12 MS-ए�सल 2016 म�, होम टैब के तहत सेल� के समहू म� �न�न�ल�खत म� से �कसका उपयोग, पंि�तय� और
कॉलम� क� चौड़ाई और ऊंचाइय� को समायोिजत करने के �लए �कया जा सकता है?

Ans 1. �डल�ट

2. फाइंड एंड �सले�ट

3. फॉम�ट

4. इ�सट�

Question Type : MCQ
Question ID : 6182781234

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.13 MS- पावर �वाइंट 2016 म� �न�न�ल�खत म� से कौनसा वधै �लाइड लेआउट नह�ं है?

Ans 1. चार कंट�ट

2. कंट�ट �वथ कै�शन

3. टाइटल ओनल�

4. दो कंट�ट

Question Type : MCQ
Question ID : 6182781254

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.14 एक MS-ए�सेल शीट म�, A1 और B1 म� �मशः 10 और 100 ह�। फ़ं�शन =A1*B1 का प�रणाम �या होगा?
Ans 1. 10

2. 90

3. 110

4. 1000

Question Type : MCQ
Question ID : 6182781240

Status : Answered
Chosen Option : 1

Marks : 0.00
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Q.15 MS-ए�सल म� एक नई वक� शीट इंसट� करने का शॉट�कट-क� संयोजन �न�न�ल�खत म� से कौनसा है?

Ans 1. Shift + F11

2. Shift + F10

3. Shift + F8

4. Shift + F9

Question Type : MCQ
Question ID : 6182781233

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.16 MS-ए�सल 2016 के �न�न�ल�खत काय� म� से कौन से �दए गए मापदंड �वारा �न�द��ट सेल� को जोड़ा जाता
है?

Ans 1. SUMIFG

2. SUMIF

3. SUMIFM

4. SUM

Question Type : MCQ
Question ID : 6182781245

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.17 �न�न�ल�खत म� से कौनसा �स�टम सॉ�टवेयर का एक उदाहरण है?

Ans 1. डाटाबेस

2. ��ेडशीट

3. वड� �ोसेसर

4. ऑपरे�टगं �स�टम

Question Type : MCQ
Question ID : 6182781206

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.18 �न�न�ल�खत म� से कौन उस ल��वेज �ोसेसर को संद�भ�त करता है जो उ�च-�तर�य ल��वेज म� �लखे गए संपणू�
�ोत �ो�ाम को एक बार म� ह� परूा पढ़ता लेता है और इसे मशीनी भाषा म� एक समक� काय��म म� अनवुा�दत
करता है?

Ans 1. असे�बलर

2. इ�ट��टर

3. �ड�पचैर

4. क�पाइलर

Question Type : MCQ
Question ID : 6182781209

Status : Answered
Chosen Option : 1ANKAJ INFOTECH
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Marks : 0.00

Q.19 �न�न�ल�खत म� से कौनसा दरूसंचार सॉ�टवेयर, उपल�ध दरूसंचार स�ुवधा का उपयोग करता है और दरू�थ
कं�यटूर पर आपको उपयोगकता� बनने क� अनमु�त देता है?

Ans 1. ई-मेल

2. HTTP

3. FTP

4. टेलनेट

Question Type : MCQ
Question ID : 6182781258

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.20 �वडंोज़ XP ऑपरे�टगं �स�टम म� नए सॉ�टवेयर को इ��टॉल करने के �लए कं�ोल पनैल क� �ो�ा�स
य�ूट�लट� को ‘�ो�ाम को जोड़� या हटाएं’ म� �कस �वक�प का उपयोग �कया जाता है?

Ans 1. �वडंोज़ अपडटे (Windows Update)

2. नए �ो�ाम जोड़� (Add New Programs)

3. �ो�ाम बदल� या हटाएं (Change or Remove Programs)

4. हाड�वेयर जोड़� (Add Hardware)

Question Type : MCQ
Question ID : 6182781214

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.21 MS-ए�सल 2016 म� �न�न�ल�खत म� से कौनसी ‘आकार’ क� मा�य �ेणी नह�ं है?

Ans 1. �लोचा��स

2. रे�ट�ग�स

3. कॉल इंस (Call-ins)

4. लाइ�स

Question Type : MCQ
Question ID : 6182781249

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.22 य�द टेबल के सेल� को �वचा�लत �प से उनके अदंर टे��ट को �फट करने के �लए �व�ता�रत �कया जाए तो
MS वड� 2016 म�, इंसट� टेबल �वडंो के तहत �न�न�ल�खत म� से �कस �वक�प का उपयोग �कया जाता है?

Ans 1. ऑटो �फट टु क�टे�ट

2. ऑटो फाम�ट

3. संपादन

4. श�ैलय� को बदल�

Question Type : MCQ
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Question ID : 6182781224
Status : Answered

Chosen Option : 2
Marks : 0.00

Q.23 MS-वड� म� फ़ॉ�ट डायलॉग बॉ�स खोलने के �लए �न�न�ल�खत म� से कौन से शॉट�कट कंुजी संयोजन का
उपयोग �कया जाता है?

Ans 1. Ctrl + U

2. Ctrl + B

3. Ctrl + Shift + O

4. Ctrl + Shift + F

Question Type : MCQ
Question ID : 6182781220

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.24 अस�बल� ल��वेज, कं�यटूर ल��वेज क� �न�न�ल�खत पी�ढ़य� म� से �कस पीढ़� क� है?

Ans 1. चौथी

2. दसूर�

3. तीसर�

4. �थम

Question Type : MCQ
Question ID : 6182781208

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.25 MS-ए�सेल 2016 म�, �न�न�ल�खत म� से �कस �वक�प का उपयोग शीट म� डाटा म� कौनसी जानकार� बदल�
जा सकती है यह �न�द��ट करके अवां�छत प�रवत�न को रोकने के �लए �कया जाता है?

Ans 1. ��ज प�ैस (Freeze panes)

2. फॉम�ट से�स

3. ि�प�ट से�स

4. ऐड इनंस (Add-ins)

Question Type : MCQ
Question ID : 6182781243

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.26 �वडंोज़ XP ऑपरे�टगं �स�टम म� �न�न�ल�खत म� से कौन कं�यटूर पर सभी फाइल�, फो�डर� और �टोरेज
�ाइव (�फ��ड और �रमवेूबल दोन�) क� पदान�ु�मत सचूी �द�श�त करता है?

Ans 1. डॉ�यमु�ट और से�ट�ंस

2. �व�डोज़ ए�स�लोरर

3. सच� क�प�ैनयन
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4. शयेड� डॉ�यमु��स

Question Type : MCQ
Question ID : 6182781213

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.27 ��टंर के संबंध म� �न�न�ल�खत म� से कौनसा कथन गलत है?

Ans 1. लेज़र ��टंर एक गैर- �भावी ��टंर है।

2. LED ��टंर गैर- �भावी वाला ��टंर होत ेह�।

3. इंकजेट ��टंर, कागज� पर छ�वय� को म�ु�त करने के �लए लेज़र तकनीक का उपयोग करता है।

4. डॉट-म�ै��स ��टंर म�, छ�व क� गुणव�ता, ��त इंच डॉट क� सं�या से �नधा��रत होती है।

Question Type : MCQ
Question ID : 6182781205

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.28 �कसी �थानीय टेल�फोन नेटवक�  के तार� पर �डिजटल डाटा �सार �दान करने क� तकनीक को �न�न�ल�खत म�
से �कस �प म� संद�भ�त �कया जाता है?

Ans 1. डायल - अप कने�शन

2. ल�ज़ कने�शन

3. �डिजटल सब��ाइबर लाइन

4. VSAT

Question Type : MCQ
Question ID : 6182781257

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.29 आप MS वड� 2016 द�तावेज़ म� सभी परैा�ाफ माक�  ढंूढना चाहत ेह�। आपक� सच� कंुजी �न�न�ल�खत म� से
कौनसी होगी?

Ans 1. Ctrl + P

2. परैा�ाफ

3. परैा

4. ^p

Question Type : MCQ
Question ID : 6182781217

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.30 MS-ए�सल 2016 म�, वण� क� सं�या के संदभ� म�, कॉलम क� चौड़ाई का कद �मशः �यनूतम और अ�धकतम,
�कतना होता ह�?

Ans 1. 0 और 15
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2. 0 और 409

3. 0 और 843

4. 0 और 255

Question Type : MCQ
Question ID : 6182781235

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.31 MS-वड� 2016 म�, ि�वक ए�सेस टूलबार _____ बार म� ि�थत होता है।
Ans 1. ��ॉल

2. टाइटल

3. �टेटस

4. टा�क

Question Type : MCQ
Question ID : 6182781216

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.32 MS-ए�सल 2016 म�, य�द कॉलम के सेल क� साम�ी को �द�श�त करने के �लए पया��त चौड़ाई नह�ं है तो सेल
म� �न�न�ल�खत म� से कौनसा संकेत �दखाई देता है?

Ans 1. #######

2. @@@@

3. !!!!!!!!!!

4. %%%%

Question Type : MCQ
Question ID : 6182781241

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.33 MS-वड� म� संभा�वत �याकरण संबंधी ��ुटया ं________ रंग क� लहरदार रेखा से �चि�नत होती ह�।
Ans 1. पीला

2. लाल

3. नीला

4. हरा

Question Type : MCQ
Question ID : 6182781222

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.34 MS-वड� 2016 म�, �न�न�ल�खत म� से �कस टैब के तहत �ैक च�ैज �वक�प उपल�ध होता है?

Ans 1. र��यू
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2. पेज लेआउट

3. �यू

4. �डज़ाइन

Question Type : MCQ
Question ID : 6182781219

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.35 MS-वड� 2016 म� टे��ट के फ़ॉ�ट और कद बदलने का कमांड होम टैब के �कस समहू के भाग के �प म� �दखाई
देता ह�?

Ans 1. परैा�ाफ

2. श�ैलयाँ

3. फ़ॉ�ट

4. ि�लपबोड�

Question Type : MCQ
Question ID : 6182781221

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.36 MS-Excel 2016 म�, थीम ______ मेन ूके अतंग�त उपल�ध ह�।
Ans 1. पेज लेआउट

2. �यू

3. होम

4. इ�सट�

Question Type : MCQ
Question ID : 6182781248

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.37 परू� द�ुनया म� कं�यटूर के नेटवक�  को _____ कहा जाता है।
Ans 1. इंटरनेट

2. LAN

3. सव�र

4. इं�ानेट

Question Type : MCQ
Question ID : 6182781256

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.38 �वडंोज़ XP म�, फाइल� के समहू को _______ म� रखा जाता है।
Ans ANKAJ INFOTECH
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1. फाइल

2. डाटाबेस फाइल

3. फो�डर

4. वड� डॉ�यमु�ट

Question Type : MCQ
Question ID : 6182781212

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.39 MS-ए�सल 2016 म� �माट� आट� स�ुवधा �न�न�ल�खत म� से कौनसी टैब म� पाया जाता है?

Ans 1. �यू

2. पेज लेआउट

3. इंसट�

4. होम

Question Type : MCQ
Question ID : 6182781250

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.40 MS-वड� 2016 म� डाटा �ोत से नाम, पत ेऔर अ�य डाटा को मज� करने के �लए मे�लगं मेन ूके कौनसा �वक�प
उपयोग �कया जाता है?

Ans 1. ए�डट रे�स�पएंट �ल�ट

2. इ�सट� मज� फ��ड

3. हाईलाइट मज� फ��ड

4. �सले�ट रे�स�पएं�स

Question Type : MCQ
Question ID : 6182781229

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.41 MS-पावर �वाइंट 2016 क� कौनसी टैब के तहत नई �लाइड �वक�प पाया जाता है?

Ans 1. एनीमेशन

2. होम

3. इंसट�

4. �डज़ाइन

Question Type : MCQ
Question ID : 6182781252

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.42
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मेल मज� का उपयोग करके MS-ए�सल 2016 म� मे�लगं लेबल बनाने के संबंध म� �न�न�ल�खत म� से कौनसा
गलत है?

Ans 1. ��ेडशीट म� प�रवत�न या प�रवध�न को वड� म� मेल मज� द�तावेज़ से जड़ु ेहोने से पहले परूा हो जाना
चा�हए।

2. �वलय �कए जाने वाल� सभी डाटा ��ेडशीट क� अ�ंतम शीट म� मौजदू होने चा�हए

3. ��ेडशीट म� कॉलम का नाम, लेबल म� इंसट� �कए जाने वाले फ़��ड नाम� से मेल खाना चा�हए

4. ��ेडशीट म� पो�टल कोड डाटा को सह� ढंग से फाम�ट �कया गया हो ता�क वड�, व�ैय ूको ठ�क से पढ़
सके

Question Type : MCQ
Question ID : 6182781228

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.43 MS-वड� 2016 म� मेल मज� म� �न�न�ल�खत म� से कौनसा �वक�प डाटा �ोत के �प म� उपयोग नह�ं �कया जा
सकता है?

Ans 1. ए�सेल ��ेडशीट

2. ODBC DSN

3. डाटाबेस तक पहँुच�

4. कोई HTTP �थान

Question Type : MCQ
Question ID : 6182781227

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.44 MS-ए�सल 2016 म�, फ़ं�शन 'COUNTA' �न�न�ल�खत म� से �कसका एक �कार का है?

Ans 1. ता�क� क

2. ��कोण�म�त

3. सांि�यक�य

4. पणूा�कन

Question Type : MCQ
Question ID : 6182781247

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.45 �वडंोज़ XP म�, जब भी कोई �ो�ाम चलाया जाता है या �वडंो खोल� जाती है, तब �ो�ाम को दशा�ता हुआ एक
आइकन �न�न�ल�खत म� से �कस पर �दखाई देता है?

Ans 1. �टाट� बटन

2. �टेटस बार

3. टा�क बार

4. ड�ेकटॉप

Question Type : MCQ
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Question ID : 6182781210
Status : Answered

Chosen Option : 4
Marks : 0.00

Q.46 MS-वड� 2016 के �क�से म�, मेल मज� �न�न�ल�खत म� से �कस �कार के द�तावेज़ म� डाटा �ोत से आया�तत
नाम और पत ेह�?

Ans 1. फो�डर

2. लेटर

3. ए�वलप या लेबल

4. ईमेल

Question Type : MCQ
Question ID : 6182781226

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.47 MS-वड� म� कोई नया द�तावेज़ बनाने के �लए �न�न�ल�खत म� से कौन से शॉट�कट कंुजी संयोजन� का उपयोग
�कया जाता है?

Ans 1. Ctrl + M

2. Ctrl + O

3. Ctrl + P

4. Ctrl + N

Question Type : MCQ
Question ID : 6182781218

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.48 MS-ए�सल 2016 म� चय�नत सेल क� प�ृठभ�ूम को रंगीन करने के �लए �न�न�ल�खत म� से कौन से बटन का
उपयोग �कया जाता है?

Ans 1. बो�ड

2. �फल कलर

3. �टाइ�स

4. फॉ�ट कलर

Question Type : MCQ
Question ID : 6182781238

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.49 MS-पावर �वाइंट 2016 म� एक नई �लाइड इंसट� करने के �लए �न�न�ल�खत म� से कौन से शॉट�कट कंुजी
संयोजन का उपयोग �कया जाता है?

Ans 1. Ctrl + N

2. Ctrl + O

3. Ctrl + P
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4. Ctrl + M

Question Type : MCQ
Question ID : 6182781251

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.50 MS-पॉवर पॉइंट 2016 म�, �कसी ��त�ुत के दौरान �लाइड के बीच म�ूवगं के संदभ� म� �न�न�ल�खत म� से
कौनसा गलत है?

Ans 1. ��त�ुत के दौरान अगल� �लाइड पर जाने के �लए माउस के बाएं बटन पर एक बार ि�लक कर�।

2. ��त�ुत के दौरान अगल� �लाइड पर जाने के �लए क� बोड� पर पेज डाउन या एंटर कंुजी को दबाएं।

3. ��त�ुत के दौरान �पछल� �लाइड पर लौटने के �लए पेज अप कंुजी दबाएं।

4. ��त�ुत के दौरान �पछल� �लाइड पर लौटने के �लए ए�केप कंुजी को दबाएं।

Question Type : MCQ
Question ID : 6182781255

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.51 MS-ए�सेल 2016 के संबंध म� �न�न�ल�खत म� से कौन सा सच है / ह�?

(i) केवल एक �डफ़ॉ�ट वक� शीट खोला जाता है
(ii) �डफ़ॉ�ट सेल फॉम�ट जनरल (General) है

Ans 1. i) सह� (ii) गलत

2. i) गलत (ii) सह�

3. (i) सह� (ii) सह�

4. i) गलत (ii) गलत

Question Type : MCQ
Question ID : 6182781237

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.52 MS-वड� 2016 म� मेल मज� म� �न�न�ल�खत म� से कौनसा द�तावेज़ का �कार नह�ं है?

Ans 1. फो�डर

2. लेटर

3. ए�वलप

4. ईमेल

Question Type : MCQ
Question ID : 6182781225

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.53 MS -ए�सेल 2016 म� सेल पर दाएं-ि�लक करके �दखाई देने वाले पॉपअप म� �न�न�ल�खत म� से कौनसा
�वक�प नह�ं है?
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Ans 1. संपणू� रौ

2. �श�ट सेल अप

3. �श�ट सेल राइट

4. संपणू� कॉलम

Question Type : MCQ
Question ID : 6182781232

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.54 MS- पावर �वाइंट 2016 म� �न�न�ल�खत म� से कौनसा �य ू�लाइड को आसानी से पनु�य�वि�थत करने के �लए
उपयोग �कया जाता है?

Ans 1. �लाइड शो

2. �लाइड साट�र

3. नॉम�ल

4. �लाइड मा�टर

Question Type : MCQ
Question ID : 6182781253

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.55 MS-ए�सल 2016 म� संर��त वक� शीट को संपा�दत करने के �लए �न�न�ल�खत म� से कौन से �वक�प का
उपयोग �कया जाता है?

Ans 1. लॉक से�स

2. ए�डट से�स

3. उन�ोटे�ट से�स

4. हाईड एंड उनहाईड

Question Type : MCQ
Question ID : 6182781244

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.56

Ans 1. (i) सह� (ii) सह�

2. (i) गलत (ii) सह�

3. (i) सह� (ii) गलत

4. (i) गलत (ii) गलत

Question Type : MCQ
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Question ID : 6182781202
Status : Answered

Chosen Option : 1
Marks : 1.00

Q.57 �न�न�ल�खत उपकरण� म� से कौनसा उपकरण अध�चालक मेमर� पर आधा�रत है?

Ans 1. पेन �ाइव

2. CD-ROM

3. �लॉपी �ड�क

4. हाड� �ड�क

Question Type : MCQ
Question ID : 6182781201

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.58 माइ�ोसो�ट वड� ऍि�लकेशन को खोलने के �लए �न�न�ल�खत म� से �कस �वक�प का उपयोग �कया जाता है?

Ans 1. �वडंोज़ XP के रन डायलॉग बॉ�स म� Win.exe टाइप कर�।

2. �वडंोज़ XP के रन डायलॉग बॉ�स म� Word.exe टाइप कर�।

3. �वडंोज़ XP के रन डायलॉग बॉ�स म� Windows.exe टाइप कर�

4. �वडंोज़ XP के रन डॉयलॉग बॉ�स म� WinWord.exe टाइप कर�।

Question Type : MCQ
Question ID : 6182781215

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.59 MS-ए�सल 2016 म� वक� शीट के नामकरण के �लए वण� क� सं�या क� अ�धकतम सीमा �न�न�ल�खत म� से
�कतनी होती है?

Ans 1. 32

2. 23

3. 31

4. 13

Question Type : MCQ
Question ID : 6182781231

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.60 ई-मेल पत े‘john@hotmail.com’ का कौनसा �ह�सा इंटरनेट पर उस संगठन के �कार को इं�गत करता है
जो मेल सव�र क� होि�टंग कर रहा है?

Ans 1. @

2. .com

3. john

4. hotmail
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Question Type : MCQ
Question ID : 6182781259

Status : Answered
Chosen Option : 4

Marks : 0.00
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Q.1 �लाइंट-साइड अ�तर��याशीलता (इंटरि�ट�वट�) के �लए गलत ि��ि�टंग ल��वेज क� पहचान कर�।
Ans 1. �बी (Ruby)

2. जावा����ट (Javascript)

3. फो�ा�न (FORTRAN)

4. VB����ट (Vbscript)

Question Type : MCQ
Question ID : 6182781198

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.2 �न�न�ल�खत म� से कौन सा एक ऑि�टकल �टोरेज़ �डवाइस नह�ं है?

Ans 1. DVD

2. Compact Disk

3. Blue ray Disk

4. RAM

Question Type : MCQ
Question ID : 6182781144

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.3

Ans 1. 

Participant ID 19439537
Participant Name MANTOSH KUMAR
Test Center Name iON Digital Zone iDZ Jalalpur
Test Date 19/12/2019
Test Time 12:00 PM - 1:00 PM
Subject Data Entry Operator
Marks Obtained 25.00000

Section : MCQ for Data Entry Operator
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2. 

3. 

4. 

Question Type : MCQ
Question ID : 6182781186

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.4 ______ चाट� का उपयोग ऊ�वा�धर द�ड� का उपयोग करके �े�णय� के म�ूय� क� तलुना करने के �लए �कया
जाता है।

Ans 1. पाई

2. ए�रया

3. कॉलम

4. �कैटर

Question Type : MCQ
Question ID : 6182781188

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.5 Windows XP म� एक _____ है जो उपयोगकता�ओ ंको कोड �लखे �बना काय� करने क� स�ुवधा देता है।
Ans 1. �ा�फ़कल यज़ूर इंटरफ़ेस

2. माई कं�यटूर

3. फ़ाइल ए�स�लोरर

4. ड�ेकटॉप

Question Type : MCQ
Question ID : 6182781151

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.6 मेल मज़� हेत ुExcel डटेा �ोत फ़ाइल बनाने के �लए, स�ुनि�चत कर� �क संबं�धत डटेा ______ शा�मल हो।
Ans 1. वक� बकु के पहले प�क म�

2. “Data Source” नाम के वक� शीट म�

3. “Mail Merge Data” नाम के वक� शीट म�

4. वक� बकु के �कसी भी ना�मत प�क म�

Question Type : MCQ
Question ID : 6182781167

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.7 MS Excel 2016 म� चय�नत सेल म� आउटलाइन बॉड�र जोड़ने के �लए शॉट� कट कंुजी �या है?
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Ans 1. Ctrl + Shift + 7 (or Ctrl + &)

2. Ctrl + O

3. Alt + Shift + 7

4. Alt + O

Question Type : MCQ
Question ID : 6182781180

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.8 एक यज़ूर excel वक� शीट म� एक �तंभ सि�म�लत करने क� को�शश कर रहा है। वह ऐसा करने म� स�म नह�ं
है। संभा�वत कारण �या हो सकता है?

Ans 1. वक� शीट सरु��त है।

2. फ़ाइल वायरस से �भा�वत है।

3. वक� बकु साझा (shared) क� गई है।

4. वक� बकु संरचना (structure) सरु��त है।

Question Type : MCQ
Question ID : 6182781184

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.9

Ans
1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 6182781178

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.10
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Ans 1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 6182781194

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.11 MS PowerPoint 2016 म�, हाइपर�लकं सि�म�लत करने के �लए शॉट� कट कंुजी ______ है।
Ans 1. Ctrl + H

2. Alt + H

3. Ctrl + K

4. Alt + K

Question Type : MCQ
Question ID : 6182781196

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.12 �न�न�ल�खत म� से कौन सा CPU का एक भाग नह�ं है?

Ans 1. रिज�टस�

2. पेन �ाइव

3. कं�ोल य�ुनट

4. अ�र�म�टक/ लॉिजक य�ुनट

Question Type : MCQ
Question ID : 6182781141

Status : Answered
Chosen Option : 1

Marks : 0.00
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Q.13 मेल मज़� म� �न�न�ल�खत म� से कौन एक वधै डटेा �ोत नह�ं है?

Ans 1. आउटलकु कॉ�टै��स �ल�ट (Outlook Contacts List)

2. ए�सेल वक� शीट (Excel Worksheet)

3. नोटपडै फ़ाइल (Notepad file)

4. माइ�ोसॉ�ट ए�सेस टेबल (Microsoft Access Table)

Question Type : MCQ
Question ID : 6182781169

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.14 आमतौर पर कू�रयर कंप�नय� �वारा �न�न�ल�खत म� से �कस तकनीक का �योग �कया जाता है?

Ans 1. OCR

2. बारकोड (Barcode)

3. MICR

4. �डकोड (Decode)

Question Type : MCQ
Question ID : 6182781145

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.15 एक ______ एक नेटव�क� ग �डवाइस है जो कं�यटूर नेटवक�  के बीच डटेा पकेैट को आगे बढ़ाता है।
Ans 1. �चपसेट (Chipset)

2. यपूीएस (UPS)

3. राऊटर (router)

4. माउस (Mouse)

Question Type : MCQ
Question ID : 6182781197

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.16

Ans

1. 

2. 

3. 
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4. 

Question Type : MCQ
Question ID : 6182781177

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.17 Microsoft Excel म�, काय�प�क� के संदभ� म� �न�न�ल�खत म� से कौन सा कथन गलत है?

Ans 1. वक� बकु के अदंर वक� शी�स के �म को बदला नह�ं जा सकता है।

2. वक� बकु म� एक या अ�धक वक� शीट जोड़ ेजा सकत ेह�।

3. वक� बकु से एक या अ�धक वक� शी�स हटाए जा सकत ेह�।

4. �कसी वक� बकु का कोई वक� शीट �कसी अ�य वक� बकु म� कॉपी नह�ं �कया जा सकता है।

Question Type : MCQ
Question ID : 6182781173

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.18 Windows Explorer का �या काय� है?

Ans 1. फ़ाइल� और फ़ो�डर� को �यवि�थत करना ।

2. खलेु हुए �व�भ�न �वडंोज़ को �यवि�थत करना ।

3. से�टगं बदलना ।

4. नए �ो�ाम जोड़ना ।

Question Type : MCQ
Question ID : 6182781153

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.19 MS Word म� मेल मज़� ऑपरेशन के संबंध म�, �न�न�ल�खत म� से कौन सा कथन गलत है?

Ans 1. ��ेडशीट एक डटेा �ोत हो सकता है।

2. मेल मज़� का उपयोग लेबल बनाने के �लए �कया जा सकता है।

3. मज़� �कए गए �े� अन�य होने चा�हए।

4. मेल मज़� का अथ� केवल ईमेल द�तावेज़ को मज़� करना है।

Question Type : MCQ
Question ID : 6182781165

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.20 Microsoft Excel म� एक वक� शीट हटाने (�डल�ट करने) के �लए �या करना चा�हए?

Ans 1. File > Worksheet > Delete

ANKAJ INFOTECH



1/27/2020 https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S68D319/157682168718829…

https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S68D319/15768216871882904/1943953… 7/17

2. शीट टैब पर राइट-ि�लक कर� और Delete चनु�।

3. शीट टैब पर बायाँ-ि�लक कर� और Delete चनु�।

4. File > Sheet > Delete

Question Type : MCQ
Question ID : 6182781170

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.21 ______ अस�बल� कोड़ म� �लखे सोस� कोड़ को मशीन कोड़ म� प�रव�त�त करता है।
Ans 1. इंटर��टर

2. कंपाइलर

3. अस�बलर

4. �ोसेसर

Question Type : MCQ
Question ID : 6182781149

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.22 य�द एक ि�थ�त सह� है और दसूर� गलत है तो एक व�ैय ूवापस पाने के �लए MS Excel म� ______ �कार के
फ़ं�शन का उपयोग कर�।

Ans 1. लॉिज़कल

2. टे��ट

3. लकुअप

4. मथै

Question Type : MCQ
Question ID : 6182781187

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.23 MS PowerPoint म�, एक �लाइड म� ऐनीमेशन के अन�ुम को खींचने और बदलने के �लए ______ का
उपयोग कर�।

Ans 1. ऐनीमेशन पनै (Animation Pane)

2. ऐनीमेशन प�टर (Animation Painter)

3. ��गर (Trigger)

4. ऐनीमेशन इफ़े�ट (Animation Effect)

Question Type : MCQ
Question ID : 6182781192

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.24 A1:AA1 र�ज म� �कतने से�स �न�हत ह�?
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Ans 1. 11

2. 10

3. 52

4. 27

Question Type : MCQ
Question ID : 6182781185

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.25 MS PowerPoint म�, �व�न इफ़े�ट (sound effect) जोड़ने के �लए, ______ मेन ूका उपयोग कर�।
Ans 1. �लाइड शो

2. �यू

3. �ांिज़श�स

4. �डज़ाइन

Question Type : MCQ
Question ID : 6182781191

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.26 ______ सभी अ�र� को अपरकेस के �प म� �ा��पत करता है।
Ans 1. Ctrl + A

2. Alt + Shift + A

3. Ctrl + Shift + A

4. Ctrl + Shift + C

Question Type : MCQ
Question ID : 6182781168

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.27 एमएस वड� म� ______ �वक�प �र� य ू(Review) मेन ूके तहत उपल�ध है।
Ans 1. �य ूसाइड बाय साइड (View side by side)

2. �पे�लगं एंड �ामर (Spelling and Grammar)

3. ��ज़ प�ैस (Freeze panes)

4. ि��लट (Split)

Question Type : MCQ
Question ID : 6182781162

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.28 Microsoft Excel म�, वक� शीट म� चय�नत Row को �छपाने क� शॉट�कट कंुजी �या है?

Ans
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1. Shift + H

2. Alt + H

3. Ctrl + 9

4. Ctrl + H

Question Type : MCQ
Question ID : 6182781172

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.29 आप अपने MS Word डॉ�यमू�ट म� एक ए�सेल शीट को ए�बेड करना चाहत ेह�। आप �कस फं�शन का
इ�तमेाल कर�गे?

Ans 1. Design > Excel

2. Layout > Excel

3. Insert > Objects

4. File > Embed

Question Type : MCQ
Question ID : 6182781158

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.30 IP ऐ�से म�, वग� ______ ॲ�से का उपयोग बहु�सारण अन�ुयोग� (म�ट�काि�टंग ऍि�लकेश�स) के �लए
�कया जाता है।

Ans 1. D

2. A

3. B

4. C

Question Type : MCQ
Question ID : 6182781199

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.31 उस �ो�ा�मगं भाषा संरचना को �या कहत ेह� िजसम� एक �ो�ाम �टेटम�ट दसूरे का अनगुमन करता है?

Ans 1. लपू

2. �र�पट�शन

3. �सले�शन

4. �स�वे�शल

Question Type : MCQ
Question ID : 6182781148

Status : Answered
Chosen Option : 2

Marks : 0.00
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Q.32 Microsoft Excel म� वक� शीट के �लए �न�न�ल�खत म� से कौन सा नाम वधै नह�ं है?

Ans 1. Name.1

2. Name*1

3. Name-1

4. Name_1

Question Type : MCQ
Question ID : 6182781171

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.33 आप संपणू� MS Word द�तावेज़ म� बकै�ाउंड रंग लागू करना चाहत ेह�। आप �कस फं�शन का इ�तमेाल
कर�गे?

Ans 1. View > page color

2. Design > page color

3. Home > Fill color

4. File > Fill color

Question Type : MCQ
Question ID : 6182781164

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.34 Excel वक� बकु को पासवड� �वारा सरु��त करने के �लए, ता�क इसे कोई �बना पासवड� के खोल न सके, कमांड
का �म �या होगा?

Ans 1. File > Passwords

2. Tools > Protect > Passwords

3. Tools > Passwords

4. File > Protect Workbook > Encrypt with Password

Question Type : MCQ
Question ID : 6182781176

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.35 MS Word म� �न�न�ल�खत म� कौन से ��टं कमांड का उपयोग कर ���ंटगं के �लए प�ृठ� का चयन करने के
�लए वधै �वक�प नह�ं है?

Ans 1. Next Page

2. Page Range

3. Odd pages only

4. All pages in range

Question Type : MCQ
Question ID : 6182781159

Status : Answered
Chosen Option : 4
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Marks : 0.00

Q.36 मेल मज़� के �ा�तकता� आमतौर पर �कसी मौज़दूा सचूी म� नाम और डटेा �ल�ट से आत ेह�, जसेै Excel
��ेडशीट, या आपक� Outlook कॉ�टे��स �ल�ट। इस �ल�ट को �या कहा जाता है?

Ans 1. डटेा �ल�ट

2. डटेा टेबल

3. डटेा फ़ॉम�

4. डटेा सोस�

Question Type : MCQ
Question ID : 6182781166

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.37 Microsoft Excel म� "File > Password” कमांड के संदभ� म� �न�न�ल�खत म� से कौन सा �वक�प सह�
नह�ं है?

Ans 1. ए�सेस को ��तबं�धत करने म� मदद करता है

2. यह स�ुनि�चत करता है �क फ़ाइल को केवल खोला जा सकता है ले�कन संपा�दत नह�ं �कया गया है

3. वक� शीट क� संरचना (structure) सरु�ा म� मदद करता है

4. एक �डिजटल ह�ता�र जोड़ सकत ेह�

Question Type : MCQ
Question ID : 6182781183

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.38 सेल C2 म� सं�या 101 �लखी है और इसक� बकै�ाउंड सफ़ेद और फ़ॉ�ट का रंग काला है। जब सेल क� कंटे��स
बदल कर 99 हो जाती है तो बकै�ाउंड गुलाबी और फ़ॉ�ट लाल हो जाता है। इसका �या कारण होगा?

Ans 1. सेल म� “Conditional formatting“ लागू होने के कारण ऐसा होता है।

2. यह ऑटो�फल �वक�प के कारण है।

3. सेल म� �व�भ�न “Cell Styles लागू होने के कारण ऐसा होता है।

4. सेल म� “Special formatting“ लागू होने के कारण ऐसा होता है।

Question Type : MCQ
Question ID : 6182781179

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.39 आपके पास एक बड़ा द�तावेज़ है और दो प�ृठ� क� टे��ट क� तलुना करना चाहत ेह�। आप �कस फं�शन का
इ�तमेाल कर�गे?

Ans 1. Review > Compare

2. Review > Split

3. View > Split

4. File > Compare
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Question Type : MCQ
Question ID : 6182781163

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.40 MS PowerPoint 2016 म� नो�स पनै (Notes pane) को �दखाने / �छपाने के �लए शॉट� कट कंुजी �या है?

Ans 1. Ctrl + Shift + N

2. Ctrl + Shift + H

3. Alt + H

4. Ctrl + H

Question Type : MCQ
Question ID : 6182781195

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.41 �कसी फ़ाइल पर Delete और Shift + Delete के बीच �या अतंर है?

Ans 1. Delete कंुजी फ़ाइल� को र�सायकल �बन म� भेजती है, Shift + Delete फ़ाइल को �थायी �प से
Delete कर देता है।

2. दोन� का काय� समान है

3. Shift + Delete चय�नत फ़ाइल के बगल क� फ़ाइल� को हटा देता है।

4. Shift + Delete कंुजी फ़ाइल� को र�सायकल �बन म� भेजता है, Delete फ़ाइल को �थायी �प से हटा
देता है।

Question Type : MCQ
Question ID : 6182781152

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.42 �लाइड सॉट�र ��य म� �लाइड को �थानांत�रत करने के �लए सह� अन�ुम क� पहचान कर� 
(i) बटन �रल�ज़ कर�। 
(ii) �लाइड को पॉइंट कर�। 
(iii) �लाइड को नए लोकेशन तक खींच�। 
(iv) माउस बटन को हो�ड कर�

Ans 1. (i) (ii) (iii) (iv)

2. (ii) (i) (iii) (iv)

3. (ii) (iv) (iii) (i)

4. (ii) (iii) (iv) (i)

Question Type : MCQ
Question ID : 6182781193

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.43 आपके पास एक �मां�कत सचूी (Numbered list) है, और आप 1 के बजाय 5 से �मांकन श�ु करना चाहते
ह�। आप यह कैसे कर�गे?
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Ans 1. Right click > Insert Bullet Number

2. Right click > Set Numbering Value

3. Right click > Change Bullet Number

4. Right click > Restart Numbering

Question Type : MCQ
Question ID : 6182781161

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.44 �न�न�ल�खत म� कौन एक इनपटु उपकरण (�डवाइस) नह�ं है?

Ans 1. �कैनर

2. �लॉटर

3. माइ�ोफ़ोन

4. क�बोड�

Question Type : MCQ
Question ID : 6182781143

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.45 Windows XP म� ______ बकै�ाउंड म� चलने वाल� सेवाओ ंके अन�ुप आइकन �द�श�त करता है, जसेै �क
इंटरनेट कने�शन (Internet connection)।

Ans 1. My documents

2. My Computer

3. Toolbar

4. Notification Area

Question Type : MCQ
Question ID : 6182781150

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.46 आप MS Word 2016 का उपयोग कर रहे ह�। आपका �म� MS Word 2003 का उपयोग कर रहा है। आप
अपनी फ़ाइल को कैसे सेव कर�गे ता�क आपका �म� उस पर काम कर सके?

Ans 1. Save > Use old version

2. Save > Word 2003 document

3. Save As > Text file

4. Save As > Word 97-2003 document

Question Type : MCQ
Question ID : 6182781157

Status : Answered
Chosen Option : 2

Marks : 0.00
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Q.47 “Clear All” फॉम��टगं �वक�प �कस �रबन टैब म� उपल�ध होता है?

Ans 1. �डज़ाइन (Design)

2. �र� य ू(Review)

3. होम (Home)

4. लेआउट (Layout)

Question Type : MCQ
Question ID : 6182781160

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.48 एमएस ए�सेल 2016 म� एक सेल म� दशमलव �बदं ु(decimal point) के बाद अकं� क� सं�या को कम करने
के �लए शॉट� कट कंुजी �या है?

Ans 1. Alt + H + 9

2. Alt + R + D

3. Ctrl + Alt + R

4. Ctrl + R

Question Type : MCQ
Question ID : 6182781174

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.49 आप excel वक� शीट म� ______ का �योग कर लाइ�स, �लॉक ऐरोज़ और आयत� आ�द को जोड़ सकत ेह�।
Ans 1. श�ेस (Shapes)

2. �माट�आट� (SmartArt)

3. �प�चस� (Pictures)

4. आइकन (Icons)

Question Type : MCQ
Question ID : 6182781189

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.50 द�तर म� उपयोग के �लए एक सामा�य लपैटॉप म� �न�न�ल�खत स�ुवधाओ ंम� से �कसके होने क� संभावना सब
से कम है?

Ans 1. USB-C Port

2. Webcam

3. 256 GB RAM

4. 512 GB Hard Disk

Question Type : MCQ
Question ID : 6182781142

Status : Answered
Chosen Option : 1

Marks : 0.00
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Q.51 �न�न�ल�खत म� से कौन सा �स�टम सॉ�टवेयर का एक उदाहरण है?

Ans 1. MS-DOS

2. MS-Office

3. Facebook

4. Adobe Photoshop

Question Type : MCQ
Question ID : 6182781146

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.52 आपके पास एक ��टंर है, िजसे आप अपने Windows पर आधा�रत लपैटॉप के साथ उपयोग करना चाहत ेह�।
आपने USB पोट� का उपयोग करके ��टंर को कने�ट �कया है, ले�कन लपैटॉप इसका पता नह�ं लगा पा रहा है।
आपका पहला कदम �या होगा?

Ans 1. ��टंर का मॉडल देख�गे, इंटरनेट पर इस मॉडल का �डवाइस �ाइवर खोज�गे और अगर उपल�ध हो तो
उसे डाउनलोड कर�गे।

2. मोबाइल से ��टंर का उपयोग करने का �यास कर�गे।

3. �कसी ई-कॉमस� साइट का उपयोग करकेएक नया ��टंर खर�द�गे या �कसी कं�यटूर क� दकुान से
खर�द�गे।

4. ��टंर बदल�गे।

Question Type : MCQ
Question ID : 6182781154

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.53 Excel म� �न�न�ल�खत म� से कौन �माट�आट� (SmartArt) का एक वधै �कार है?

Ans 1. �लाइसर (Slicer)

2. चाट� (Chart)

3. �पवोट टेबल (Pivot Table)

4. �परा�मड़ (Pyramid)

Question Type : MCQ
Question ID : 6182781190

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.54 Microsoft Excel म� “ सेल �टाइ�स ” (Cell Styles) स�ुवधा ______ का एक तर�का है।
Ans 1. वक� शीट म� से�स के भीतर टे��ट लपेटने या लपेटे हुए टे��ट को सामा�य करने

2. एक वक� शीट म� से�स के भीतर पाठ संरे�खत कर�

3. वक� शीट म� चय�नत से�स के थीम को बदलने

4. �कसी वक� शीट म� चय�नत से�स को फ़ॉम�टेड करने

Question Type : MCQ
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Question ID : 6182781182
Status : Answered

Chosen Option : 4
Marks : 1.00

Q.55 �न�न�ल�खत म� से कौन ईमेल से संबं�धत �ोटोकॉल नह�ं है?

Ans 1. FTP

2. SMTP

3. IMAP

4. TCP/IP

Question Type : MCQ
Question ID : 6182781200

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.56 आप Excel वक� शीट क� एक �वशषे पंि�त (Row) म� सभी से�स क� बकै�ाउंड का रंग बदलकर ह�का नीला
करना चाहत ेह�। उपय�ुत Row का चयन करने के बाद, इस काय� को करने के �लए आप �न�न�ल�खत म� से
�कस स�ुवधा का उपयोग नह�ं कर�गे?

Ans 1. सेल �टाइ�स (Cell Styles)

2. �फल कलर (Fill Colour)

3. फॉ�ट कलर (Font Colour)

4. Format > Format Cells > Background Colour

Question Type : MCQ
Question ID : 6182781181

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.57 Windows XP म� Microsoft Word खोलने के �लए: 
“______” बटन पर ि�लक कर�। माउस पॉइंटर को "All Programs” पर ले जाएँ। “Microsoft Office”
फ़ो�डर आने तक ��ॉल कर� और इस पर ि�लक कर�। "Microsoft Word" का चयन कर�।

Ans 1. ऍि�लकेश�स (Applications)

2. �ब�गन (Begin)

3. �वडंोज (Windows)

4. �टाट� (Start)

Question Type : MCQ
Question ID : 6182781155

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.58 Paste Special > Values को ______ शॉट� कट कंुजी �वारा भी �न�पा�दत �कया जा सकता है।
Ans 1. Ctrl + Alt + V, �फर S दबाएं

2. Ctrl + Shift + V, �फर V दबाएं

3. Ctrl + Alt + V, �फर V दबाएं
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4. Ctrl + Alt + F, �फर V दबाएं

Question Type : MCQ
Question ID : 6182781175

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.59 आप MS Word 2016 म� �ैक च�ज़ मोड को चाल ूकरना चाहत ेह�। आपको यह �वक�प ______ म� �मलेगा ।
Ans 1. लेआउट मेनू

2. �र� य ूमेनू

3. रेफर�सेस मेनू

4. इंसट� मेनू

Question Type : MCQ
Question ID : 6182781156

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.60 �न�न�ल�खत म� से कौन सा कथन गलत है?

Ans 1. �स�टम सॉ�टवेयर ए�ल�केशन सॉ�टवेयर और कं�यटूर के हाड�वेयर के बीच एक इंटरफ़ेस का काय�
करता है।

2. ए�ल�केशन सॉ�टवेयर उपयोगकता� और �स�टम सॉ�टवेयर के बीच एक इंटरफ़ेस का काय� करता
है।

3. �स�टम सॉ�टवेयर को उपयोगकता�ओ ं(यज़ूर) के �व�श�ट काय� को करने के �लए बनाया गया है।

4. �स�टम सॉ�टवेयर को �स�टम संसाधन� (�रसोस�स) के �बंधन के �लए बनाया गया है। 

Question Type : MCQ
Question ID : 6182781147

Status : Answered
Chosen Option : 1

Marks : 0.00
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Q.1 पाँच MS-Word डॉ� यमु�ट एक �व�श� ट समय पर खलेु हुए ह�। य�द आप इन खलेु हुए डॉ� यमु��स पर बार�-बार�
से जाना चाहत ेह�, तो आप �कस टैब का उपयोग कर�गे?

Ans 1. File > Switch windows

2. Home > Switch windows

3. Tools > Switch windows

4. View > Switch windows

Question Type : MCQ
Question ID : 6182781097

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.2 MS-Word डॉ� यमु�ट म� 'टेबल ऑफ क�ट�ट' को जोड़ने के �लए, आप ______ मे� य ूका चयन कर�गे।
Ans 1. लेआउट

2. इं� सट�

3. रेफ़र�सेस

4. �र� यू

Question Type : MCQ
Question ID : 6182781096

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.3 241.1.2.234 � लास ______ का आइपी (IP) अ�से है।
Ans 1. B

2. A

3. D

4. E

Participant ID 19375535
Participant Name AJEET KUMAR
Test Center Name iON Digital Zone iDZ 2 Patliputra
Test Date 19/12/2019
Test Time 9:00 AM - 10:00 AM
Subject Data Entry Operator
Marks Obtained 13.00000

Section : MCQ for Data Entry Operator
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Question Type : MCQ
Question ID : 6182781138

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.4 MS-Word डॉ� यमु�ट म� ‘Insert’ → ‘Object’ �वक� प का इ� तमेाल करत ेहुए एक मौज़दूा वक� शीट से डटेा
को अतं:� था�पत करने (embedding) के संदभ� म� �न�न�ल�खत म� से कौन सा कथन स� य है?

Ans 1. केवल एक �र� त MS-Excel फ़ाइल इ� सट� क� जा सकती है।

2. MS-Word डॉ� यमु�ट म� क� गई ए�बेडडे MS-Excel ऑ�ज़े� ट को ए�डट नह�ं �कया जा सकता है।

3. मौज़दूा MS-Excel फ़ाइल इस तरह ए�बेडडे क� जा सकती है, वड� डॉ� यमु�ट म� केवल एक MS-

Excel का आइकॉन �दखेगा।

4. केवल डटेा वाल� एक MS-Excel फ़ाइल इ� सट� क� जा सकती है।

Question Type : MCQ
Question ID : 6182781098

Status : Marked For Review
Chosen Option : 3

Marks : 1.00

Q.5 MS-Excel म� वक� शीट क� ने�मगं के �लए �न�न�ल�खत म� से कौन सा वधै फ़ाइल नाम है?

Ans 1. Budget/1

2. Budget[1]

3. Budget-1

4. Budget.1

Question Type : MCQ
Question ID : 6182781111

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.6 MS-PowerPoint म� � लाइड सॉट�र � य ूके संदभ� म� �न�न�ल�खत म� से गलत कथन का चयन क�िजए।
Ans 1. �कसी � लाइड के क�टे�ट को प�रव�त�त करता है

2. इसे सेले� ट करने के �लए एक � लाइड पर  ि�लक करता है

3. एक � लाइड को �डल�ट करता है

4. � लाइ�स को थंबनेल �प�चस� के �प म� करता है

Question Type : MCQ
Question ID : 6182781133

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.7 बज़ट और �व� तीय ��तवेदन� के जसेै अकं�य डटेा को संग�ठत, �व� ले�षत व आले�खत करने वाले �ो�ाम
______ कहलात ेह�।

Ans 1. � �ेडशी�स

2. �ा�फ़� स
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3. वड� �ॉसेसस�

4. DBMS

Question Type : MCQ
Question ID : 6182781087

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.8 MS-Excel म�, ‘View’ मे� य ुके अतंग�त �न�न�ल�खत म� से कौन सा फ़�चर उपल� ध नह�ं होता है?

Ans 1. Split Columns

2. New Window

3. Freeze Panes

4. Arrange All

Question Type : MCQ
Question ID : 6182781113

Status : Marked For Review
Chosen Option : 3

Marks : 0.00

Q.9 मेल मज़� के �लए डटेा सोस� के �प म� MS-Excel � �ेडशीट तयैार करने के �लए, यह स�ुनि�चत कर� �क आपक�
� �ेडशीट म� ______ के नाम, उन फ�� ड के नाम� से समेु�लत ह� िज� ह� आप अपनी मेल मज़� म� इ� सट� करना
चाहत ेह�।

Ans 1. कॉलम

2. सेल

3. वक� शीट

4. रो

Question Type : MCQ
Question ID : 6182781107

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.10 �न�न�ल�खत म� से कौन सी टे� नोलॉज़ी का उपयोग ब�क� �वारा चेक क� ���या के �लए �कया जाता है?

Ans 1. OMR

2. MICR

3. QR

4. OCR

Question Type : MCQ
Question ID : 6182781083

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.11 � लास A नेटवक�  म�, पहले ______ �बट, अ�से के नेटवक�  पाट� होत ेह� और ______ शषे �बट अ�से के हो� ट
पाट� होत ेह�।

Ans ANKAJ INFOTECH



1/27/2020 https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S67D303/157682171263038…

https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S67D303/15768217126303830/1937553… 4/17

1. 16; 16

2. 24; 8

3. 4; 28

4. 8; 24

Question Type : MCQ
Question ID : 6182781139

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.12 MS-Excel म�, ‘Lock’ या ‘Unlock Cells’ फ़ं�शन के काय� करने के �लए, इनम� से �कस �वक� प को इनेबल
�कया जाना चा�हए?

Ans 1. ‘Protect Workbook’ फ़ं�शन को इनेबल करने क� आव� यकता है

2. ‘Smart Loop up’ फ़ं�शन को इनेबल करने क� आव� यकता है

3. वक� शीट को से� स के लॉक या अ� लॉक होने से पहले र��त �कया जाना चा�हए

4. ‘Lock’ या ‘Unlock Cells’ �वक� प� के अलावा �कसी अ� य फ़ं�शन को इनेबल करने क�
आव� यकता नह�ं है

Question Type : MCQ
Question ID : 6182781117

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.13 MS-Excel म� ______ आपको फ़ॉम�ट कोड़ वाल� फ़ॉम��टगं लागू करने पर �दखने वाल� सं� याओ ंके तर�के म�
प�रवत�न करने क� स�ुवधा देता है। यह उस ि�थ�त म� उपयोगी होता है जब आप सं� याओ ंको अ�धक पठनीय
फ़ॉम�ट म� दशा�ना चाहत ेह�, या आप सं� याओ ंको टे� � ट या �सबं� स के साथ संयोिजत करना चाहत ेह�।

Ans 1. टे� � ट फ़ं� शंस

2. लॉिज़कल फ़ं� शंस

3. मथै फ़ं� शंस

4. लकुअप फ़ं� शंस

Question Type : MCQ
Question ID : 6182781127

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.14 MS-Excel म� �ोटे� शन फ़�चस� के संदभ� म� �न�न�ल�खत म� से कौन सा अस� य है?

Ans 1. वक� शीट लेवल �ोटे� शन �स� यो�रट� फ़�चर के �प म� अ�भ�ेत नह�ं होता है। यह केवल �यो� ताओं
को वक� शीट म� लॉक क� हुई से� स म� प�रवत�न करने से रोकता है।

2. आप शीट �ोटे� शन के साथ यह �न�द�� ट कर सकत ेह� �क यज़ूर शीट म� वा� तव म� � या कर सकता
है, िजससे यह स�ुनि�चत होता है �क आपक� वक� शीट म� कोई भी मह� वपणू� डटेा �भा�वत नह�ं होता है।

3. आप पासवड� �न�द�� ट करके अपनी वक� बकु के � ��चर को लॉक नह� ंकर सकत ेह�।

4. MS-Excel म�, आप MS-Excel फ़ाइल को पासवड� �न�द�� ट करके लॉक कर सकत ेह� िजससे यज़ूर
इसे खोल या प�रव�त�त नह�ं कर सकत ेह�।

Question Type : MCQANKAJ INFOTECH
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Question ID : 6182781124
Status : Answered

Chosen Option : 1
Marks : 0.00

Q.15 MS-Word म� मेल मज़� के �लए, य�द आप MS-Excel म� डटेा सोस� का इ� तमेाल कर रहे ह�, तो इसम� कुछ
� पे�स�फ़केशन �मल सकत ेह�। इस संदभ� म�, �न�न�ल�खत म� से कौन सा कथन गलत है?

Ans 1. फ़�� ड के नाम/कॉलम के लेबल �ल� ट क� पहल� पंि�त म� होने चा�हए, और फ़�� ड के नाम �व�श� ट
(unique) होने चा�हए

2. �ल� ट म� कोई �र� त � तंभ या पंि�त नह�ं होने चा�हए

3. फ़�� ड के नाम� तथा �थम �रकॉड� के म� य म� �र� त पंि�त होनी चा�हए

4. य�द वक� शीट म� कोई अ�त�र� त सचूना है, तो कम से कम एक �र� त पंि�त या � तंभ होना चा�हए
जो �ल� ट को अ� य डटेा से पथृक कर सके

Question Type : MCQ
Question ID : 6182781106

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.16 ______ सोस� कोड़ को इंटरमी�डएट फॉम� म� �पांत�रत करता है और �फर उस इंटरमी�डएट कोड़ को मशीन
ल�� वेज़ म� �पांत�रत करता है।

Ans 1. असे� बलर

2. �ॉसेसर

3. क� पाइलर

4. इंटर�ेटर

Question Type : MCQ
Question ID : 6182781089

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.17 ______ एक आइकॅन होता है जो आपको उस आइटम (डॉ� यमु�ट, ॲि�लकेशन या �प�चर) तक �नद��शत
करता है जो क� � यटूर म� कह�ं और ि�थत होता है। यह यज़ूर के �लए उस आइटम तक ॲ� सेस अ�धक सगुम
(आमतौर पर ड�ेकटॉप पर) बनाता है और इसे आइकॅन के कोने म� एक तीर छोटे तीर �वारा पहचाना जाता है।

Ans 1. � टाट� बटन

2. GUI

3. �ो�ाम

4. शॉट�कट

Question Type : MCQ
Question ID : 6182781091

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.18 वड� �ॉसे�सगं डॉ� यमु�ट म� टै� स व � पेसेज़ के मा� यम से क� जाने वाल� टे� � ट क� एलाइ�नगं एक क�ठन काय�
हो सकता है। MS-Word के �वारा �कसी ______ डॉ� यमु�ट म� टे� � ट के � तंभ� तथा पंि�तय� को आसानी से
एलाइन करने के �लए इ� सट� करना होगा।

ANKAJ INFOTECH
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Ans 1. टेबल

2. टे� � ट बॉ� स

3. इ�ड��स

4. कॉल� स

Question Type : MCQ
Question ID : 6182781104

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.19 MS-Excel वक� शीट म� परेू � माट�आट� �ा�फ़क म� रंग� म� प�रवत�न करने के �लए:

� माट�आट� पर ि�लक कर�।
� माट�आट� टू� स के अतंग�त, ______ टैब पर, � माट� आट� �ुप म�,______ पर ि�लक कर�।

Ans 1. Design; SmartArt Styles; Change Colors

2. SmartArt Design; Format; Change Colors

3. Styles; Design; Change Colors

4. SmartArt Design; Styles; Change Colors

Question Type : MCQ
Question ID : 6182781130

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.20 MS-PowerPoint म�, आप � लाइड के साइज़ का �नधा�रण करने के �लए �वक� प कहाँ पा सकत ेह�?
Ans 1. � लाइड शो

2. �डज़ाइन

3. फ़ाइल

4. � यू

Question Type : MCQ
Question ID : 6182781134

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.21 �न�न�ल�खत का � या प�रणाम होगा?

Right-click on a filename > Send to > Desktop
Ans 1. ड�े कटॉप पर फ़ाइल खोल देगा

2. ड�े कटॉप पर फ़ाइल क� कॉपी बन जाएगी

3. ड�े कटॉप पर फ़ाइल का शॉट�कट आइकॉन बन जाएगा

4. फ़ाइल को ड�े कटॉप पर पहँुचा देगा

Question Type : MCQ
Question ID : 6182781093

Status : Answered
Chosen Option : 1ANKAJ INFOTECH
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Marks : 0.00

Q.22 �न�न�ल�खत म� से कौन सा ऐसा काय� है जो �मखु �प से सीपीय ू(CPU) का नह�ं है?

Ans 1. �ा�फ़कल �ॉसे�सगं करना

2. �ाइमर� � टोरेज़ या मेन मेमोर� के साथ �नकटता के साथ इंटरै� ट करना

3. ए�रथमे�टक व लॉिज़कल ऑपरेशन� को ��याि�वत करना

4. भंडा�रत (�टोड�) �ो�ाम �नद�श� को ��याि�वत करना

Question Type : MCQ
Question ID : 6182781082

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.23

Ans 1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 6182781136

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.24 मेल मज़� �ॉसेस म� तीन डॉ� यमु�ट शा�मल होत ेह�: मेन डॉ� यमु�ट, ______ तथा म�ड� डॉ� यमु�ट।
Ans 1. डटेा सोस�

2. लेटर

3. फ़ॉम�

4. ईमेल

Question Type : MCQ
Question ID : 6182781105

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.25 ॲि�लकेशन सॉ�टवेयर के संदभ� म� �न�न�ल�खत म� से कौन सा कथन स� य है?

Ans 1. य ह �व�श� ट उ�े� य वाला सॉ�टवेयर है िजसका उपयोग �व�श� ट काय� करने के �लए �कया जाता है

2. इसे �लखने के �लए केवल लो-लेवल ल�� वेज़ का इ� तमेाल �कया जाता है

3. यह इ� पटु और आउटपटु �डवाइस� के म� य इंटरफ़ेस के �प म� धीरे-धीरे काय� करता है

4. इसके �बना क� � यटूर �स� टम संचा�लत नह�ं हो सकता है

Question Type : MCQ
Question ID : 6182781086

Status : Answered

ANKAJ INFOTECH
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Chosen Option : 1
Marks : 1.00

Q.26 � लाइड शो के दौरान � ��न को काल� करने के �लए ______ दबाया जाता है।
Ans 1. Ctrl + B

2. B

3. F5

4. Alt + B

Question Type : MCQ
Question ID : 6182781135

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.27 य�द आप MS-Excel 2016 वक� शीट � ट�ड आउट पर �व�श� ट डटेा बनाना चाहत ेह�, तो ______, जसेै �क ॲरो,
� टार या बनैर (arrow, star or banner) का उपयोग करना एक अ� छा तर�का होगा।

Ans 1. आइकॉन

2. � माट�आट�

3. चाट�

4. शपे

Question Type : MCQ
Question ID : 6182781129

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.28

Ans

1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 6182781118

Status : Answered
Chosen Option : 2

Marks : 0.00

ANKAJ INFOTECH
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Q.29 आप अपने सम� त �ाहक� को एक मानक प� भेज रहे ह�। आप प� म� अपने �ाहक� के नाम व पत े�लखना
चाहत ेह�। MS-Word 2016 म� आप � या इ� सट� कर�गे?

Ans 1. मज़� फ�� �स

2. मेन डॉ� यमु�ट

3. डटेा सोस�

4. मज़� डॉ� यमु�ट

Question Type : MCQ
Question ID : 6182781109

Status : Marked For Review
Chosen Option : 2

Marks : 0.00

Q.30 MS-PowerPoint म�, ______ क� से�टगं के �लए ��गर �वक� प का उपयोग �कया जाता है।
Ans 1. इ� सट� अ चाट�

2. ॲ�नमेशन

3. � लाइड �डज़ाइन

4. �ांिज़शन

Question Type : MCQ
Question ID : 6182781132

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.31 MS-Word म�, एक परैा�ाफ़ के भीतर दो लाइन� के म� य क� दरू� ______ कहलाती है।
Ans 1. लाइन � पे�सगं

2. � पे�सगं

3. रो � पे�सगं

4. परैा�ाफ़ � पे�सगं

Question Type : MCQ
Question ID : 6182781101

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.32

Ans 1. 

2. 

ANKAJ INFOTECH
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3. 

4. 

Question Type : MCQ
Question ID : 6182781126

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.33 8 पेज़ेस वाले MS-Word 2016 डॉ� यमु�ट म�, आप केवल पेज़ 2, 3, 6 और 8 का ��टंआउट लेना चाहत ेह�।
आप �कस से�टगं का इ� तमेाल कर�गे?

Ans 1. ��टं सेले� शन

2. क� टम ��टं

3. ��टं करंट पेज

4. ��टं ऑल पेजेस

Question Type : MCQ
Question ID : 6182781099

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.34 क� � यटूर नेटवक�  काड� और नेटवक�  राउटर को कने� ट करने वाल� केबल को ______ कहा जाता है।
Ans 1. रेगुलर जकै-45

2. �रकॉड�र जकै-45

3. रेफ़र�स जकै-45

4. रिज� टड� जकै-45

Question Type : MCQ
Question ID : 6182781137

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.35 MS-Excel वक� शीट म� सं� याओ ंके वे पंि�त या � तंभ ______ कहलात ेह� जो चाट� म� � लॉटेड होत ेह�।
Ans 1. डटेा ल�ज��स

2. डटेा टेबल

3. डटेा लेब� स

4. डटेा �सर�ज़

Question Type : MCQ
Question ID : 6182781128

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.36 एक वक� शीट क� एक सेल क� फ़ॉम��टगं को उसी वक� शीट क� दसूर� सेल म� लागू करने के �लए, आप
�न�न�ल�खत म� से ______ का उपयोग कर�गे।

Ans 1. Data > Recent Sources
ANKAJ INFOTECH



1/27/2020 https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S67D303/157682171263038…

https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S67D303/15768217126303830/193755… 11/17

2. Format > Cells

3. Paste Special > Values

4. Paste Special > Format

Question Type : MCQ
Question ID : 6182781121

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.37 ‘Protect Workbook’ फ़ं�शन � या करता है?

Ans 1. यह वक� बकु को इस तरह से र��त करता है �क इस तक केवल वह� लोग पहँुच सकत ेह� िजनके पास
इसका पासवड� होगा।

2. यह वक� बकु को �ोटे� टेड फ़ो�डर म� र��त करता है।

3. यह वक� बकु को इ� सट�, �डल�ट या मवू �कए जाने से रोकता है।

4. यह वक� बकु को सरु��त सव�र पर ले जाता है।

Question Type : MCQ
Question ID : 6182781116

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.38 वॉयरलेस नेटवक�  का इ� तमेाल करत ेसमय, SSID इनम� से �कसे �न��पत करता है?

Ans 1. �डवाइस ID

2. डायल-अप ए� � ट�शन

3. �स� नल � ��थ ऑफ़ द नेटवक�

4. य�ूनक आइड��टफायर ऑफ़ अ वॉयरलेस नेटवक�

Question Type : MCQ
Question ID : 6182781140

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.39 MS-Word म� टे� � ट क� फॉम��टगं करत ेसमय �न�न�ल�खत म� से कौन सा वधै �वक� प नह� ंहै जो उपल� ध
होता है?

Ans 1. सपुरि� �� ट

2. ए� � पोन�ट

3. � �ाइक�ू

4. सि� � �� ट

Question Type : MCQ
Question ID : 6182781100

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.40 �न�न�ल�खत म� से �कसे/�क� ह� लो-लेवल ल��वेज के �प म� प�रभा�षत �कया जा सकता है?
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Ans 1. बे�सक, कोबॉल, फो�ा�न

2. �बी

3. C, C++

4. असे� बल�

Question Type : MCQ
Question ID : 6182781088

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.41 MS-Excel 2016 म� आप वक� शीट को �रनेम कैसे कर�गे?

Ans 1. Left-click on the sheet name > Rename

2. File menu > Rename

3. Right-click on the sheet name > Rename

4. Edit menu > Rename

Question Type : MCQ
Question ID : 6182781110

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.42 MS-Word म� �कसी टे� � ट का फ़ॉ�ट प�रव�त�त करने के �लए � या करना होगा?

a) प�रव�त�त �कए जाने वाले टे� � ट को सेले� ट कर�गे।
b) ‘Home’ टैब पर, ______ बॉ� स पर ‘drop-down arrow’ पर ि�लक कर�गे। उसके बाद वां�छत फ़ॉ�ट
का चयन कर�गे।

Ans 1. फ़ॉम�ट

2. साइज़

3. � टाइल

4. फ़ॉ�ट

Question Type : MCQ
Question ID : 6182781102

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.43 MS-Excel म� इनम� से �कस टूल का उपयोग एक सेल के फ़ॉम�ट को �कसी दसूर� या से� स क� र�ज़ म� कॉपी
करने के �लए �कया जाता है?

Ans 1. Split cells

2. Format painter

3. Paste as formula

4. Paste as a value

Question Type : MCQ
Question ID : 6182781119

Status : Answered
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Chosen Option : 1
Marks : 0.00

Q.44 काया�लय म� इ� तमेाल �कए जाने वाले लपैटॉप म� ______ क� डटेा � टोरेज़ �मता होती है।
Ans 1. 512 GB

2. 512 MB

3. 512 TB

4. 512 KB

Question Type : MCQ
Question ID : 6182781081

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.45 MS-PowerPoint म�, टे� � ट डाइरे� शन म� �डफ़ॉ� ट �प से �कतने �वक� प उपल� ध होत ेह�?
Ans 1. 6

2. 4

3. 10

4. 8

Question Type : MCQ
Question ID : 6182781131

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.46 MS-Word 2016 म� मेल मज� का इ� तमेाल करत ेहुए लेब� स को ��टं करने के �लए:

‘______’ > ‘Start Mail Merge’ > ‘Labels’ पर जाएँ।
Ans 1. इ� सट�

2. ��एट

3. मेल मज़�

4. म�ैल�ंज़

Question Type : MCQ
Question ID : 6182781108

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.47 ______ जड़ुी हुई हाड�वेयर �डवाइस तथा ऑपरे�टगं �स� टम के म� य आव� यक �प से �नबा�ध क� य�ुनकेशन
क� स�ुवधा देता है।

Ans 1. इं� टालेशन �ाइवर

2. �डवाइस फ़ाइल

3. �डवाइस �ाइवर

4. �डवाइस इं� टालर

Question Type : MCQ
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Question ID : 6182781094
Status : Answered

Chosen Option : 2
Marks : 0.00

Q.48 कॉलम B क� सम� त से� स के क�टे�ट को बो� ड व इटै�लक करने के �लए, आप � या कर�गे?

Ans 1. कॉलम B को सेले� ट कर�गे, तथा कमांड Paste > Bold > Italic का उपयोग कर�गे

2. कॉलम B को सेले� ट कर�गे, और होम (Home) मे� य ुके अतंग�त फ़ॉ�ट (Font) �ुप म� ‘B’ तथा ‘I’
का उपयोग कर�गे

3. कॉलम B को सेले� ट कर�गे, तथा कमांड Format Painter > Bold > Italics का उपयोग कर�गे

4. कॉलम B को सेले� ट कर�गे, तथा कमांड Ctrl + I का उपयोग कर�गे

Question Type : MCQ
Question ID : 6182781120

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.49 MS-Excel रैप टे� � ट फ़�चर, टे� � ट को समायोिजत करने के �लए, ______ को ॲडज� ट करता है।
Ans 1. शीट क� चौड़ाई (sheet width)

2. कॉलम क� चौड़ाई (column width)

3. सेल क� ऊँचाई तथा चौड़ाई (cell height and width)

4. रो क� ऊँचाई (row height)

Question Type : MCQ
Question ID : 6182781114

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.50 �वडंोज़ ए� सपी (Windows XP) म� ______ बटन होत ेह� जो आपको सामा� य टूल� तथा वत�मान म� चल रहे
�ो�ाम� तक � व�रत ॲ� सेस देत ेह�।

Ans 1. � टाट� बटन

2. टा� कबार

3. नो�ट�फ़केशन ए�रया

4. कं�ोल पनैल

Question Type : MCQ
Question ID : 6182781090

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.51 र�ज A1:D5 म� �कतनी सेल होती ह�?
Ans 1. 9

2. 20

3. 4

4. 5
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Question Type : MCQ
Question ID : 6182781125

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.52 MS-Word म� ��टं ��� य ूपाने के �लए, Ctrl + P के अ�त�र� त �कस शॉट�कट कंुजी का उपयोग �कया जा
सकता है?

Ans 1. Ctrl + F9

2. Ctrl + Shift + W

3. Alt + F2

4. Ctrl + F2

Question Type : MCQ
Question ID : 6182781103

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.53 I/O �डवाइस सीधे मदरबोड� से जड़ु ेइले��ॉ�नक मॉ�यलू से जड़ु ेहोत ेह� िज�ह� ______ कहा जाता है।
Ans 1. �डवाइस �ाइवर

2. �डवाइस कं�ोलर

3. I/O कं�ोल य�ूनट

4. बस

Question Type : MCQ
Question ID : 6182781085

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.54 MS-Excel म� ‘Cell Styles’ फ�चर के संदभ� म� �न�न�ल�खत म� से कौन सा कथन स� य नह�ं है?

Ans 1. जब आप एक समय पर एक सेल या से� स क� र�ज म� एक से अ�धक फ़ॉम�ट लागू करना चाहत ेह�, तो
� टाइल लागू करना सवा��धक आसान होता है

2. MS-Excel म� फ़ॉम��टगं के �लए अनेक �ब� ट-इन � टाइल होती ह� िज� ह� आप लागू या प�रव�त�त कर
सकत ेह�

3. � टाइल फ़ॉम��टगं कैरे� टरि�ट� स, जसेै फ़ॉ�ट का नाम, साइज़, कलर, एलाइनम�ट व � पे�सगं, का
एक सेट होता है

4. इससे पंि�त क� ऊँचाई या � तंभ क� चौड़ाई प�रव�त�त होती है

Question Type : MCQ
Question ID : 6182781122

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.55 �न�न�ल�खत म� से कौन सा एक आउटपटु �डवाइस नह�ं है?

Ans 1. � लॉटर

2. मॉ�नटर
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3. � कैनर

4. ��टंर

Question Type : MCQ
Question ID : 6182781084

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.56 �र� त � थान क� प�ूत � कर�:

Start → ______ → MS Office → MS Word.
Ans 1. Applications

2. Windows

3. Menu

4. All Programs

Question Type : MCQ
Question ID : 6182781095

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.57 आपने एक MS-Excel � �ेडशीट म� पाँच �व�भ� न � तंभ� म� डटेा एंटर �कया है, ले�कन आपने देखा �क आप
तीसरे � तंभ म� उपल� ध सचूना को पढ़ नह�ं पा रहे ह�? आप सभी पाँच � तंभ� क� एक जसैी �दखावट चाहत ेह�।
आपको � या करना चा�हए?

Ans 1. तीसरे सेल क� दा� बाउं�ी पर डबल ि�लक करना चा�हए

2. तीसरे सेल क� बा� बाउं�ी पर ि�लक करना चा�हए

3. तीसरे सेल क� बा� बाउं�ी पर डबल ि�लक करना चा�हए

4. तीसरे सेल क� दा� बाउं�ी पर ि�लक करना चा�हए

Question Type : MCQ
Question ID : 6182781115

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.58 एक वक� शीट से दसूर� वक� शीट म� जाने के �लए �न�न�ल�खत म� से कौन सा शॉट�कट कंुजी/कंुिजयाँ उपय�ु त है/
ह�?

Ans 1. Ctrl + Tab

2. Ctrl + Page Up

3. Ctrl + Page Down

4. Tab

Question Type : MCQ
Question ID : 6182781112

Status : Answered
Chosen Option : 2

Marks : 0.00
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MS-Excel वक� शीट म� सभी सेल �डफॉ� ट �प से ______ होती ह�, ले�कन उ� ह� ______ के �प म� फ़ॉम�ट
�कया जा सकता।

Ans 1. अनलॉ�ड, लॉ�ड

2. लॉ� ड, अनलॉ�ड

3. �ोटे� टेड, लॉ� ड

4. �ोटे� टेड, अन�ोटे� टेड

Question Type : MCQ
Question ID : 6182781123

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.60 �न�न�ल�खत म� से कौन सा �ो�ाम यज़ूर को �डल�ट फाइ� स तक ॲ� सेस �दान करता है?

Ans 1. �वडंोज़ ए� � � लोरर

2. �वडंोज़ मनेैज़र

3. �ाउज़र

4. इंटरनेट ए� � � लोरर

Question Type : MCQ
Question ID : 6182781092

Status : Answered
Chosen Option : 3

Marks : 0.00
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Q.1 �न�पादन-���या (ए�से�यशून �ोसेस) म�, C भाषा म� �ल�खत �कसी �ो�ाम का मशीनी भाषा म� अनवुाद
�न�न�ल�खत म� �कसके उपयोग से �कया जाता है?

Ans 1. कंपाइलर

2. �ड�पचैर

3. इंटर�ेटर

4. अस�बलर

Question Type : MCQ
Question ID : 6182781329

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.2 �न�न�ल�खत म� कौनसा कं�यटूर का काया��मक भाग (फं�शनल य�ूनट) नह�ं है?

Ans 1. मेमोर� य�ूनट

2. आउटपटु य�ूनट

3. इंटरनेट

4. इनपटु य�ूनट

Question Type : MCQ
Question ID : 6182781321

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.3 MS-Excel 2016 म� ऑटो श�ेस क� �न�न�ल�खत म� से �कस �ेणी से जोड़, घटाव, गुणा आ�द श�ेस का संबंध
है?

Ans 1. बे�सक श�ेस

2. रे�ट�ग�स

3. लाइ�स

Participant ID 19459302
Participant Name ALOK KUMAR
Test Center Name iON Digital Zone iDZ 1 Patliputra
Test Date 20/12/2019
Test Time 3:00 PM - 4:00 PM
Subject Data Entry Operator
Marks Obtained 17.00000

Section : MCQ for Data Entry Operator
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4. इ�वेशन श�ेस

Question Type : MCQ
Question ID : 6182781369

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.4 Windows XP ऑपरे�टगं �स�टम म� �न�न�ल�खत म� से कौनसा �वक�प कं�यटूर �स�टम को कॉि�फ़गर
करने और सॉ�टवेयर- हाड�वेयर इ��टॉल करने के �लए एक य�ूट�लट�-�ल�ट को �द�श�त करता है?

Ans 1. कं�ोल पनैल

2. ��टंर एंड फै�सेस

3. माय �प�चस�

4. माय �यिूज़क

Question Type : MCQ
Question ID : 6182781330

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.5 MS-Word 2016 म� मेल मज� म� डटेा सोस� चय�नत करने पर �न�न�ल�खत म� से कौन सा �वक�प मा�य नह�ं
है?

Ans 1. इंटरनेट से चय�नत कर�

2. मौजदूा सचूी का �योग कर�

3. आउटलकु संपक�  म� से चनु�

4. नई सचूी टाइप कर�

Question Type : MCQ
Question ID : 6182781347

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.6 MS-Word 2016 म� य�द आप डॉ�यमू�ट के �कसी श�द क� �याकर�णक-जाँच करना चाहत ेह�, तो इसके �लए
�पे�लगं एंड �ामर �वडंो म� �न�न�ल�खत म� से �कस �वक�प का उपयोग होता है?

Ans 1. Check grammar with spelling

2. Frequently confused words

3. Show readability statistics

4. Add to Dictionary

Question Type : MCQ
Question ID : 6182781343

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.7 MS-Word 2016 म� मेल मज� म� डॉ�यमू�ट का डाइरे�टर� �कार ______।
Ans 1. �कसी �ुप मे�लगं के �लए ए�से लेबल� को ��टं करेगा
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2. ई-मेल संदेश� को लोग� के �कसी समहू तक भेजेगा

3. पत� के एक कैटलॉग या ��टेंड �ल�ट वाले �कसी एक डा�यमू�ट को बनाएगा

4. �कसी �ुप मे�लगं के �लए ए��ेड एनवल�स को ��टं करेगा

Question Type : MCQ
Question ID : 6182781346

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.8 MS-Excel 2016 म� पॉइंट �केल पर आधा�रत वक� शीट म� कॉलम क� �यनूतम चौड़ाई �कतनी होती है?

Ans 1. 15

2. 0

3. 409

4. 255

Question Type : MCQ
Question ID : 6182781355

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.9 Windows XP ऑपरे�टगं �स�टम म� मौजदूा �योगकता� �वारा उपयोग क� जाने वाल� फाइल� जसेै नाम,
�कार, आकार आ�द के �ववरण-�दश�न के �लए �कस अन�ुम का पालन �कया जाता है?

Ans 1. Start → My Documents → Details → View

2. Start → Details → My Documents → View

3. Start → View → My Documents → Details

4. Start → My Documents → View → Details

Question Type : MCQ
Question ID : 6182781333

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.10 �न�न�ल�खत म� से �कस �ेणी का संबंध कं�यटूर के ऑपरे�टगं �स�टम और य�ूट�लट� �ो�ाम से है?

Ans 1. �स�टम सॉ�टवेयर

2. एि�लकेशन सॉ�टवेयर

3. एंट�वायरस सॉ�टवेयर

4. क�टमाइ�ड सॉ�टवेयर

Question Type : MCQ
Question ID : 6182781326

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.11 क�बोड� का संबंध �न�न�ल�खत म� से �कस �ेणी से है?

Ans 1. आउटपटु �डवाइस
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2. मेमोर� �डवाइस

3. ���ंटगं �डवाइस

4. इनपटु �डवाइस

Question Type : MCQ
Question ID : 6182781323

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.12 MS-Excel 2016 म� रोज़ और कॉल�स का आकार �फर से बदलने के संदभ� म� �न�न�ल�खत म� कौन सा
�वक�प मा�य नह�ं है?

Ans 1. ऑटो �फट रो हाइट

2. ऑटो �फट वक� शीट हाइट

3. कॉलम �व�थ

4. रो हाइट

Question Type : MCQ
Question ID : 6182781354

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.13 एक एमएस ए�सेल वक� शीट म�, सेल A1 से A6 म� �मशः 1, 2, 3, a, b, c ह�। सेल G1 म� स�ू =count(A1:
A6) होता है। आउटपटु �या होगा?

Ans 1. 6

2. 0

3. 2

4. 3

Question Type : MCQ
Question ID : 6182781357

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.14 MS-Word के �कस टैब म� कट, कॉपी और पे�ट जसेै �वक�प पाए जात ेह�?
Ans 1. पेज लेआउट

2. रेफर�सेज

3. इ�सट�

4. होम

Question Type : MCQ
Question ID : 6182781342

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.15 �न�न�ल�खत म� से �कसे MS PowerPoint म� �लाइड म� आइटम के �प म� नह�ं डाला जा सकता है?
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Ans 1. लेआउट

2. टेबल

3. �माट� आट� �ा�फक

4. चाट�

Question Type : MCQ
Question ID : 6182781372

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.16 MS-Excel 2016 म� �न�न�ल�खत म� से �कस �वक�प म� ‘लॉक से�स’ पाया जा सकता है?

Ans 1. �फल

2. फॉम�ट

3. ऑटो सम

4. इ�सट�

Question Type : MCQ
Question ID : 6182781363

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.17 �वडंोज़ ऑपरे�टगं �स�टम के सच� बॉ�स म� �न�न�ल�खत म� से �कसे टाइप करने पर, MS-Word एि�लकेशन
श�ु होगा?

Ans 1. Winword

2. Win.exe

3. Windows

4. Word.exe

Question Type : MCQ
Question ID : 6182781335

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.18 MS-PowerPoint 2016 म� �न�न�ल�खत म� से �कस टैब म�, ‘लेआउट’ �वक�प नह�ं पाया जाता है?

Ans 1. इ�सट�

2. �र�यू

3. �यू

4. होम

Question Type : MCQ
Question ID : 6182781374

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.19 �न�न�ल�खत म� कौन MS-Excel 2016 म� चाट� का कोई �कार नह�ं है?
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Ans 1. कॉलम

2. सोलर

3. लाइन

4. �कैटर

Question Type : MCQ
Question ID : 6182781368

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.20 �न�न�ल�खत म� से कौन सा �वक�प �स�टम और एि�लकेशन सॉ�टवेयर के संदभ� म� �न�नां�कत कथन� क�
स�यता का सव��तम वण�न करता है?

(i) �स�टम सॉ�टवेयर के पा�व� म� काम करने के कारण आम तौर पर यज़ूर उससे इ�टरै�ट नह�ं करता है।
(ii) कं�यटूर पर एि�लकेशन सॉ�टवेयर तब इं�टॉल �कया जाता है, जब ऑपरे�टगं �स�टम इं�टॉल �कया गया
हो।

Ans 1. (i) गलत (ii) गलत

2. (i) सह� (ii) गलत

3. (i) गलत (ii) सह�

4. (i) सह� (ii) सह�

Question Type : MCQ
Question ID : 6182781327

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.21 MS-PowerPoint 2016 म� डु�ल�केट �सले�टेड �लाइड फं�शन �लाइड �ुप म� ______ के अतंग�त आता है
।

Ans 1. New Slide

2. Layout

3. Section

4. Reset

Question Type : MCQ
Question ID : 6182781371

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.22 �न�न�ल�खत म� से कौन URL का पणू� �प है, िजसके मा�यम से इंटरनेट पर सचूना पाई जाती है?

Ans 1. य�ूनफॉम� �रसोस� लोकेटर

2. य�ूनवस�ल �रकॉड� लोकेटर

3. य�ूनफॉम� �रकॉड� लोडर

4. य�ूनफॉम� रेकॉड� लोकेटर

Question Type : MCQ
Question ID : 6182781378
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Status : Answered
Chosen Option : 2

Marks : 0.00

Q.23 MS-Excel 2016 म� फॉमू�ल� को कॉपी और पे�ट करत ेसमय �सफ�  फॉमू�ला कॉपी करने के �लए पे�ट �पेशल
वाले �न�न�ल�खत म� से �कस �वक�प का उपयोग �कया जाता है?

Ans 1. स�ू (फॉमू�लाज)

2. सभी (ऑल )

3. �ा�पण (फॉम��स)

4. मान (व�ैयजू)

Question Type : MCQ
Question ID : 6182781366

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.24 MS-Word 2016 म� �य ूटैब का �न�न�ल�खत म� से कौन-सा �वक�प मौजदूा डॉ�यमू�ट के �य ूसे य�ुत कोई
नई �वडंो खोलने के �लए �य�ुत �कया जाता है?

Ans 1. ि�प�लट

2. �य ू�वडंो

3. ज़मू

4. अर�ज ऑल

Question Type : MCQ
Question ID : 6182781338

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.25 जब माउस MS-Word म� �कसी द�तावेज़ के ि�लक करने यो�य बटन पर माउस को घमुाया जाता है, तो यह
______ बन जाता है।

Ans 1. पॉइं�टगं ऐरो

2. आई-बीम

3. इ�सश�न पॉइंटर

4. ए�ड ऑफ़ डॉ�यमू�ट माक� र

Question Type : MCQ
Question ID : 6182781337

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.26 MS-Excel 2016 म� वक� बकु क� सरु�ा के �लए �न�न म� से �कस �वक�प का उपयोग �कया जाता है?

Ans 1. Write-only recommended

2. Write Reservation password

3. Encrypt with password

4. Hide the worksheet
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Question Type : MCQ
Question ID : 6182781356

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.27 MS-Word 2016 म� मेल मज� का उपयोग करत ेहुए जब मे�लगं लेबल बनाए जा रहे ह�, तो डटेा सोस� के �प म�
�न�न�ल�खत म� �कस �कार क� फाइल को चय�नत नह�ं �कया जा सकता है?

Ans 1. ए�सेल फाइल

2. ए�सेस डटेाबेस

3. वड� फाइल

4. MP3

Question Type : MCQ
Question ID : 6182781348

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.28 MS-ए�सेल 2016 म� �नि�ल�खत म� से फं�शन लाइ�ेर� क� कौन सी �ेणी फं�शन ‘IFERROR’ से संबं�धत
है?

Ans 1. टे��ट

2. लॉिजकल

3. �व�त (फाइन��सयल)

4. �त�थ और समय (डटे एंड टाइम)

Question Type : MCQ
Question ID : 6182781365

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.29 MS-Excel 2016 म� �कसी एक रो क� सभी से�स को सेले�ट करने के �लए �न�न�ल�खत म� से �कसका
उपयोग �कया जाता है?

Ans 1. कॉलम हे�डगं पर ि�लक कर�

2. क�बोड� पर Ctrl + A को दबाएँ

3. रो हे�डगं पर ि�लक कर�

4. उस रो क� �कसी भी सेल म� एक बार ि�लक कर�

Question Type : MCQ
Question ID : 6182781352

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.30 �न�न�ल�खत म� कौन �ॉडब�ड इंटरनेट कने�शन का एक �कार नह�ं है?

Ans 1. DSL

2. डायल-अप
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3. फाइबर

4. सटैलाइट

Question Type : MCQ
Question ID : 6182781377

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.31 जो कुछ (इनपटु) पर बताए जात ेह�, उनसे उ�प�न छ�वय� को �न�न�ल�खत म� कौनसा इनपटु �डवाइस �हण
करता है और उन छ�वय� को �कसी कं�यटूर के �लए भेज देता है?

Ans 1. क�बोड�

2. वेबकैम

3. माउस

4. माइ�ोफोन

Question Type : MCQ
Question ID : 6182781324

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.32 �न�न�ल�खत म� कौन एक वेब �ाउज़र है?

Ans 1. Google Chrome

2. Ask.com

3. Yahoo

4. Bing

Question Type : MCQ
Question ID : 6182781380

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.33 MS-Word म� �न�न�ल�खत म� से �कसका संदभ� �ॉप-डाउन मेन ूके लेबल वाल� �कसी पतल�, �ै�तज प�ी जसेै
होम, इ�सट� आ�द से है?

Ans 1. मेन ूबार

2. टा�क बार

3. ऑ�शन बार

4. टाइटल बार

Question Type : MCQ
Question ID : 6182781336

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.34 इंटरनेट ए�से ‘http://www.oit.edu/libraries’ म� मौजदू श�द ‘http’ �न�न�ल�खत म� से �या दशा�ता है?

Ans 1. पेज का मलू (Origin of the page)
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2. वेबसाइट का �थान (Location of the Website)

3. इस आइटम को देखने के �लए �य�ुत �ोटोकॉल का �कार (The type of protocol used to view
this item)

4. हो�ट का नाम (Name of the host)

Question Type : MCQ
Question ID : 6182781379

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.35 MS-Excel 2016 का �न�न�ल�खत कौन-सा डटे एंड टाइम फं�शन �त�थ-समय के अनसुार फॉम�ट �कए गए
साम�यक डटे और समय को लौटा देता है?

Ans 1. MONTH

2. DATE

3. DAY

4. NOW

Question Type : MCQ
Question ID : 6182781367

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.36 MS-Word 2016 म� �कसी ता�लका म� कॉल�स क� �यनूतम और अ�धकतम सं�या �या होनी चा�हए?

Ans 1. 1 और 32767

2. 1 और 32768

3. 1 और 63

4. 1 और 64

Question Type : MCQ
Question ID : 6182781344

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.37 �न�न�ल�खत म� से कौन-सा ��टंर �याह� को फैलाने या �कसी इंक �रबन से टकराने के �लए ��टंर हे�स का
उपयोग करता है, ता�क सकैड़� से लेकर हजार� छोटे डॉ�स ��ततु ह� और टे��ट और छ�वयाँ छप�।

Ans 1. इंकजेट ��टंर

2. लेज़र ��टंर

3. डॉट म�ै��स ��टंर

4. LED ��टंर

Question Type : MCQ
Question ID : 6182781325

Status : Answered
Chosen Option : 3

Marks : 1.00
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�कसी वक� शीट टैब के नाम पर डबल ि�लक करके आप ______।
Ans 1. वक� शीट को मवू कर सकत ेह�

2. वक� शीट को �रनेम कर सकत ेह�

3. वक� शीट इ�सट� कर सकत ेह�

4. वक� शीट �डल�ट कर सकत ेह�

Question Type : MCQ
Question ID : 6182781350

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.39 �न�न�ल�खत म� से �कस मा�यम से �माट� फोन इंटरनेट से कने�ट �कए जा सकत ेह�?
Ans 1. डायल-अप कने�शन

2. एथरनेट केबल

3. Wi-fi (वाई-फाई)

4. DSL

Question Type : MCQ
Question ID : 6182781376

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.40 MS-Word 2016 म� �ुप मे�लगं के �लए मेल मज� म� �न�न�ल�खत म� से कौन सा द�तावेज ए�से �कए गए
एनवल�स को ��टं करता है?

Ans 1. डाइरे�टर�

2. इमेल

3. लेटस�

4. एनवेल�स

Question Type : MCQ
Question ID : 6182781345

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.41 �न�न�ल�खत म� कौन सा कथन �कसी कं�यटूर क� मेमोर� य�ूनट के संदभ� म� गलत है?

Ans 1. �न�पादन होने से पहले मेमोर� म� �ो�ाम� का सं�ह नह�ं �कया जाना चा�हए

2. �ाइमर� मेमोर� काफ� तजे होती है जो इले��ॉ�नक ग�त पर काय� करती है

3. मेमोर� य�ूनट �ो�ाम के साथ-साथ डटेा का सं�ह करती है

4. �ाइमर� मेमोर� क� अपे�ा सेक� डर� मेमोर� �ब�कुल स�ती (चीप) होती है

Question Type : MCQ
Question ID : 6182781322

Status : Answered
Chosen Option : 2

Marks : 0.00
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Q.42 MS-PowerPoint 2016 म� �ज�टेशन के अतं तक जाने के �लए �न�न�ल�खत �कस कंुजी का उपयोग �कया
जाता है?

Ans 1. End

2. Down arrow

3. Up arrow

4. Home

Question Type : MCQ
Question ID : 6182781375

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.43 MS-Excel 2016 म�, �भावशाल� बनाने क� �ि�ट से सेल सेल को लॉक करने के �लए, वक� शीट को ______
होना भी चा�हए।

Ans 1. �ोटे�टेड

2. �लो�ड

3. शयेड�

4. अपडटेेड

Question Type : MCQ
Question ID : 6182781364

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.44 MS-ए�सेल 2016 म� �कस �वक�प का उपयोग शीट के �कसी �ह�से को ��यमान रखने के �लए �कया जाता है,
जब�क शषे शीट उसी समय ��ॉल क� जाती है?

Ans 1. ��ज़ पे�स

2. �य ू�वडंो

3. अर�ज ऑल

4. हाइड

Question Type : MCQ
Question ID : 6182781353

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.45 MS-Excel 2016 म� �न�न�ल�खत म� से कौन �माट� आट� �ा�फक का �कार नह�ं है?

Ans 1. पदान�ुम (ह�रॉक�)

2. �ृंखला (चनै)

3. �ल�ट

4. सायकल

Question Type : MCQ
Question ID : 6182781370

Status : Answered
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Chosen Option : 4
Marks : 0.00

Q.46 MS-Excel 2016 म� �छपाएँ और �दखाएँ (हाइड एंड अनहाइड) �वक�प म� �न�न�ल�खत म� से कौन अमा�य
सा कथन है?

Ans 1. Hide workbook

2. Hide columns

3. Hide row

4. Hide sheet

Question Type : MCQ
Question ID : 6182781361

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.47 MS-Excel 2016 म� �न�न�ल�खत �कस टैब पर ‘��मत और �फ़�टर कर� (सॉट� एंड �फ�टर)’ पाया जाता है?

Ans 1. इ�सट�

2. होम

3. फॉमू�ला

4. पेज लेआउट

Question Type : MCQ
Question ID : 6182781360

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.48 �न�न�ल�खत म� से �कस �वक�प का उपयोग Windows XP ऑपरे�टगं �स�टम के सच� कंपे�नयन म� उन
फ़ाइल� को देखने म� �कया जाता है, जो �व�श�ट �त�थय� पर या उनके बीच बनाई या संशो�धत क� गई थी?ं

Ans 1. लकु इन (Look in)

2. इसे कब संशो�धत �कया गया (When was it modified)

3. अ�त अ�वत� �वक�प (More advanced options)

4. यह �कस आकार क� है (What size is it)

Question Type : MCQ
Question ID : 6182781332

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.49 MS-Word 2016 म� डॉ�यमू�ट के शीष� (टॉप) तक जाने (म�ूवगं) के �लए �न�न�ल�खत म� से �कस शॉट�कट
कंुजी का उपयोग �कया जाता है?

Ans 1. End

2. Home

3. Ctrl + End

4. Ctrl + Home

Question Type : MCQANKAJ INFOTECH
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Question ID : 6182781340
Status : Answered

Chosen Option : 3
Marks : 0.00

Q.50 �न�न�ल�खत �कस उ�े�य के �लए MS-PowerPoint म� �लाइड सॉट�र �य ूका उपयोग �कया जा सकता है?

Ans 1. �पीकर नो�स को संपा�दत करने के �लए

2. मा�टर �लाइ�स क� �डजाइन और लेआउट को बदलने के �लए

3. ��टेंड ह�डाउ�स क� �डजाइन और लेआउट को बदलने के �लए

4. आसानी से �लाइ�स पनुः �यवि�थत करने के �लए

Question Type : MCQ
Question ID : 6182781373

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.51 य�द आप x का वग� �लखना चाहत ेह�, तो वग� को �दखाने वाला नंबर 2 ______ बनाया जाना चा�हए।
Ans 1. Subscript

2. Superscript

3. Underlined

4. Strikethrough

Question Type : MCQ
Question ID : 6182781341

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.52 �न�न म� कौन सा �वक�प मेल मज� को परूा करेगा और उसका उपयोग ऐसे लेटर प� क� हर कॉपी के �लए
अलग डॉ�यमू�ट बनाने म� �कया जा सकता है, िजसे ��टंर तक सीधे या ई-मेल के मा�यम से भेजा जा सकता
है?

Ans 1. Create

2. Write & Insert Fields

3. Finish and Merge

4. Preview results

Question Type : MCQ
Question ID : 6182781349

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.53 MS-Excel 2016 म� �न�न�ल�खत म� से कौन-सा फॉम��टगं �वक�प �कसी सेल के अदंर क� सभी साम�ी को
एका�धक (म�ट�पल) लाइन� पर �द�श�त करके इसे ��यमान करता है?

Ans 1. Wrap text

2. Conditional formatting

3. Insert

4. Merge & Center
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Question Type : MCQ
Question ID : 6182781359

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.54 अलग-अलग पेपर के आकार वाले द�तावेज को ��टं करने के �लए, �न�न�ल�खत म� से MS-Word 2016 म�
��टं �वडंो के �कस �वक�प का चयन �कया जाता है?

Ans 1. �केल टु पेपर साइज़

2. पेज र�ज

3. कॉपीज़

4. ��टंर

Question Type : MCQ
Question ID : 6182781339

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.55 Ms-Excel 2016 म� सेल के अदंर डटेा क� ि�थ�त और संरेखण को बदलने के �लए फॉम�ट सेल �वडंो के �कस
टैब का उपयोग �कया जाता है?

Ans 1. बॉड�र

2. नंबर

3. अलाइनम�ट

4. फॉ�ट

Question Type : MCQ
Question ID : 6182781358

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.56 MS-Excel 2016 म� होम टैब के �टाइ�स �ुप के �न�न�ल�खत �कस म� से �वक�प का उपयोग वत�मान
वक� बकु म� खलु� एक दसूर� वक� बकु क� सेल �टाइ�स को कॉपी करने म� �कया जाता है?

Ans 1. मज� �टाइ�स

2. �य ूसेल �टाइल

3. अलाइनम�ट

4. फॉम�ट

Question Type : MCQ
Question ID : 6182781362

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.57 �न�न �तर�य कोडांतरण भाषा का संबंध �कस जनरेशन क� कं�यटूर भाषाओ ंसे है?

Ans 1. चौथी

2. दसूर�
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3. तीसर�

4. पहल�

Question Type : MCQ
Question ID : 6182781328

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.58 MS-Excel 2016 म� �कसी नई वक� शीट को इ�सट� करने के �लए �न�न म� से कौन-सा �वक�प अमा�य है?

Ans 1. होम टैब म� ि�लपबोड� �ुप का उपयोग करना

2. वक� शीट टै�स के अतं म� �कट होने वाले इ�सट� वक� शीट टैब पर ि�लक करना

3. शीट पर दाएँ ि�लक करने पर �दखने वाले पॉपअप मेन ूसे इ�सट� ऑ�शन को चय�नत करना

4. होम टैब म� से�स �ुप के इ�सट� �वक�प का उपयोग करना

Question Type : MCQ
Question ID : 6182781351

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.59 Windows XP ऑपरे�टगं �स�टम के कं�ोल पनैल म� �न�न म� से कौन-सी य�ूट�लट� कं�यटूर �स�टम पर
�ो�ाम� और घटक� को �यवि�थत करने म� सहायक है?

Ans 1. �श�य�ूस टा��स

2. साउं�स एंड ऑ�डयो स�व�स

3. इंटरनेट ऑ�श�स

4. �ो�ाम सि�म�लत कर� या हटाएँ (एड ऑर �रमवू �ो�ा�स)

Question Type : MCQ
Question ID : 6182781334

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.60 य�द पीसी �कसी नेटवक�  से कने�टेड हो, तो �न�न म� से कौन सा आइकॉन, Windows XP ऑपरे�टगं �स�टम
के ड�ेकटॉप पर नेटवक�  �रसोस�ज को ए�सेस �दान करता है?

Ans 1. माय कं�यटूर

2. माय नेटवक�  �लेसेज़

3. टा�क बार

4. �रसायकल �बन

Question Type : MCQ
Question ID : 6182781331

Status : Answered
Chosen Option : 2

Marks : 1.00
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Q.1 माइ�ोसॉ�ट पॉवरपॉइंट 2016 म�, �न�न�ल�खत म� से कौन सा �यजू, �ज�टेशन के ��येक �लाइड म� बाएं
फलक के �कनारे पर टे� � ट वाले छोटे वगा�कार बॉ�स के �प म� �द�श�त होता है?

Ans 1. ए�डट

2. �ांसलेट

3. �लाइ�स

4. आउटलाइन �यू

Question Type : MCQ
Question ID : 6182781432

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.2 �वडंोज़ XP के �टाट� मे�य ुम� ‘माइ �प�चस�’ �वक�प पर ि�लक करने पर �न�न�ल�खत म� से �कसक� सचूी
�द�श�त होती है?

Ans 1. ता�का�लक �योगकता� �वारा हाल ह� म� �य�ुत द�तावेज़

2. ता�का�लक �योगकता� �वारा �य�ुत �च� अथवा फोटो

3. ता�का�लक �योगकता� �वारा �य�ुत द�तावेज़

4. ता�का�लक �योगकता� �वारा बजाया गया संगीत अथवा गाने

Question Type : MCQ
Question ID : 6182781390

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.3 �न�न�ल�खत म� से � या   �ो�ाम के �न�पादन क� ���या म� म�ुय मेमर� से अनदेुश� को पनुः�ा�त करने क�
���या कोसंद�भ�त करता है?

Ans 1. �डकोड

2. फे�च

Participant ID 19415973
Participant Name NISHA KUMARI
Test Center Name iON Digital Zone iDZ 1 Patliputra
Test Date 20/12/2019
Test Time 12:00 PM - 1:00 PM
Subject Data Entry Operator
Marks Obtained 15.00000

Section : MCQ for Data Entry Operator
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3. राइट बकै

4. एि�ज�यटू

Question Type : MCQ
Question ID : 6182781382

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.4 माइ�ोसॉ�ट ए�सेल 2016 म� वक� बकु क� संरचना को सरु��त करने हेत ु�न�न�ल�खत म� से �कन चरण� का
�योग �कया जा सकता है?

Ans 1. Data → Protect Workbook

2. View → Protect Workbook

3. Page Layout → Protect Workbook

4. Review → Protect Workbook

Question Type : MCQ
Question ID : 6182781416

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.5 यह बताएं �क Microsoft Excel 2016 के संदभ� म� �न�न�ल�खत कथन स� य ह� या अस� य ह�। 
(i) कॉलम क� चौड़ाई को समायोिजत करने हेत ुकॉलम हेडर पर दा� ओर ि�लक कर� तथा कॉलम �व�थ
(Column Width) का चयन कर�। कॉलम क� चौड़ाई को बदलने के �लए पॉप अप �वडंो म� कोई सं� या टाइप
कर�।
(ii) पंि�त क� ऊंचाई को समायोिजत करने हेत,ु पंि�त के लेब�स के बीच के बॉड�र पर एरो को घमुाएं। उसके
बाद ��येक पंि�त को चौड़ी अथवा संकु�चत करने हेत ुबॉड�र पर ि�लक करके �गै कर�। 

Ans 1. (i) स� य (ii) अस� य

2. (i) अस� य (ii) स� य

3. (i) स� य (ii) स� य

4. (i) अस� य (ii) अस� य

Question Type : MCQ
Question ID : 6182781415

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.6 Microsoft Word 2016 म� क�-बोड� शॉट�कट ‘Ctrl + V’ का �योजन �या होता है?

Ans 1. सेले� ट �कए गए टे� � ट को हटाना

2. सेले� ट �कए गए टे� � ट को कॉपी करना

3. कॉपी अथवा कट �कए गए टे�� ट को पे�ट करना

4. सेले� ट �कए गए टे� � ट को �छपाना

Question Type : MCQ
Question ID : 6182781402

Status : Answered
Chosen Option : 3

Marks : 1.00
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Q.7 �न�न�ल�खत म� से कौन सा एक एि�लकेशन सॉ�टवेयर है?

Ans 1. भाषा अनवुादक

2. ऑपरे�टगं �स� टम

3. �डवाइस �ाइवस�

4. वड� �ॉसेसर

Question Type : MCQ
Question ID : 6182781387

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.8 माइ�ोसॉ�ट ए�सेल 2016 म�, य�द सेल B8 से F8 म� �मशः 1,2,3,4,5 मान उपि�थत ह�, तो
‘=COUNT(B8:F8)’ फामू�ला का प�रणाम �या होगा?

Ans 1. 4

2. #VALUE

3. #ERROR

4. 5

Question Type : MCQ
Question ID : 6182781427

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.9 �न�न�ल�खत म� से कौन सी वह तज़े मेमर� है जो �क म�ुय मेमर� एव ंCPU के बीच बफर के �प म� काय� करती
है?

Ans 1. ह�प

2. अ�यमुलेुटर

3. �टैक

4. कैश (Cache)

Question Type : MCQ
Question ID : 6182781381

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.10 Microsoft Excel 2016 म�, इ�सट� टैब के �कस समहू के अदंर ऑटो श�ेस एवं �माट�आट� �वक�प मौजदू होते
ह�?

Ans 1. �ल�ंस

2. चा��स

3. टेबल

4. इल��ेश�स

Question Type : MCQ
Question ID : 6182781429
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Status : Answered
Chosen Option : 4

Marks : 1.00

Q.11 MS ए�सेल 2016 वक� शीट म�, आप एक सेल म� दो लाइन� म� कुछ टे� � ट ��व�ट करना चाहत ेह�। आप,
�न�न�ल�खत म� से �कस कंुजी का �योग कर�गे?

Ans 1. Ctrl + Enter

2. Ctrl + Spacebar

3. Alt + Enter

4. Enter

Question Type : MCQ
Question ID : 6182781417

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.12 माइ�ोसॉ�ट ए�सेल 2016 म�, होम टैब के इ�सट� ऑ�शन म� इनम� से � या मौजदू नह�ं होता है?

Ans 1. इ�सट� कॉल�स

2. इ�सट� डाटा

3. इ�सट� रो

4. इ�सट� से�स

Question Type : MCQ
Question ID : 6182781410

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.13 माइ�ोसॉ�ट ए�सेल म� �न�न�ल�खत म� से कौन रोज़ एव ंकॉल�स का ��त�छेदन को संद�भ�त करता है?

Ans 1. वक� बकु

2. सेल

3. नेम बॉ�स

4. वक� शीट

Question Type : MCQ
Question ID : 6182781420

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.14 वड� �ॉसेसस� के संबंध म� �न�न�ल�खत म� से कौन सा कथन अस� य है?

Ans 1. वड� �ॉसेसस�, एक ह� समय म� अनेक द�तावेज़� पर काय� करने क� स�ुवधा देता है।

2. वे, �ब� ट-इन एव ंक�टम टे��ले�स का �योग करत ेहुए अ�त शी� �यावसा�यक द�तावेज़ सिृजत
कर सकत ेह�।

3. वड� �ॉसेसस�, टेबल ऑफ कंट��स, इंड�ेस एव ं�ॉस-रेफेर�सेस �न�म�त करने क� �मता जसैी �व�भ�न
�वशषेताओ ंका �योग करत ेहुए आसानी से बड़ ेद�तावेज़� के �बंधन म� सहायता �दान करता है।

4. वड� �ॉसेसस� के ज़�रए आसानी से ��त�ुतया ंबनाई जा सकती ह�।
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Question Type : MCQ
Question ID : 6182781395

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.15 �वडंोज़ XP म� �वडंोज़ ए���लोरर का �योग करत ेहुए फाइल� के �बंधन के दौरान अ�मागत फाइल अथवा
फो�डर को सेले� ट करने हेत ु�न�न�ल�खत म� से �कन कंुिजय� का उपयोग �कया जाता है?

Ans 1. Esc

2. Tab

3. Ctrl

4. Shift

Question Type : MCQ
Question ID : 6182781393

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.16 Microsoft Word 2016 डॉ�यमु�ट क� बा� ओर टे� � ट को संरे�खत करने हेत ुक�-बोड� के �न�न�ल�खत म� से
�कस शॉट�क�स का �योग �कया जाना चा�हए?

Ans 1. Alt+L

2. Ctrl + R

3. Ctrl+L

4. Ctrl + E

Question Type : MCQ
Question ID : 6182781401

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.17 माइ�ोसॉ�ट ए�सेल 2016 म� �न�न�ल�खत म� से कौन सा �वक�प फॉम�ट से�स डायलॉग बॉ�स का वधै टैब
नह�ं है?

Ans 1. �फल

2. बॉड�र

3. फॉ�ट

4. ि�लपबोड�

Question Type : MCQ
Question ID : 6182781419

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.18 �वडंोज़ XP म�, �टाट� मे� य ुपर ि�लक करके कं�ोल पनैल पर ि�लक करने से �स�टम ऑ�शन ��ततु होता है।
इस �वक�प पर डबल ि�लक करने पर, �स�टम �ॉपट�ज़ ��ततु होता है। �न�न�ल�खत म� से कौन सा टैब,
�स�टम �ॉपट�ज़ �वडंो म� �व�यमान नह�ं होता है?

Ans 1. सॉ�टवेयर
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2. हाड�वेयर

3. जनरल

4. एडवां�ड

Question Type : MCQ
Question ID : 6182781392

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.19 �न�न�ल�खत म� से �कस पर Microsoft Word म� Word Document का नाम �द�श�त होता है?

Ans 1. टाइटल बार

2. � �ॉलबार

3. मेनबुार

4. टूलबार

Question Type : MCQ
Question ID : 6182781397

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.20 माइ�ोसॉ�ट ए�सेल 2016 म� वक� शीट को सरु��त करने के �लए, होम टैब के तहत से�स �ुप के अदंर,
_________ बटन पर ि�लक करके, ‘�ोटे�ट शीट’ �वक�प का चयन �कया जाता है।

Ans 1. इ�सट�

2. �डल�ट

3. ए�डट

4. फॉम�ट

Question Type : MCQ
Question ID : 6182781423

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.21 सेव एज (Save as) डॉयलॉग बॉ�स लाने हेत ु_______ को दबाएं।
Ans 1. Ctrl + A

2. Shift + S

3. S + A

4. F12

Question Type : MCQ
Question ID : 6182781406

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.22 Microsoft Excel 2016 म�, �कसी वक� शीट के वत�मान डटेा �े� म�, �कसी सेल से रो के अतं म� जाने हेतु
�न�न�ल�खत म� से क�-बोड� के �कस शॉट�क�स का �योग �कया जाता है?
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Ans 1. Ctrl + up arrow

2. Ctrl+ right arrow

3. Ctrl + down arrow

4. Ctrl + left arrow

Question Type : MCQ
Question ID : 6182781413

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.23 माइ�ोसॉ�ट ए�सेल 2016 म�, से�स क� र�ज को शी� फॉम�ट कर उसे टेबल म� प�रव�त�त करने के �लए होम टैब
के तहत �टाइ�स �ुप के अदंर, _________ �वक�प का �योग �कया जाता है।

Ans 1. कंडीशनल फॉम��टगं

2. फॉम�ट

3. �ी�डफाइ�ड �टाइल

4. फॉम�ट एज टेबल

Question Type : MCQ
Question ID : 6182781422

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.24 �न�न�ल�खत म� से कौन सा श� द मेल मज� डॉ�यमु�ट म� ��व�ट क� जाने वाल� �व�श�ट सचूना क� सचूी का
संदभ� ��ततु करता है?

Ans 1. मज� फ��ड

2. मेल मज�

3. मेन डॉ�यमु�ट

4. डटेा सोस�

Question Type : MCQ
Question ID : 6182781405

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.25 �न�न�ल�खत म� से कौन सा अन�ुम �वडंोज़ XP ऑपरे�टगं �स�टम के �योग के संबंध म� अ�ययन करने हेतु
ऑनलाइन मदद �ा�त करने का सह� �म है?

Ans 1. Start → Help and Support

2. All Programs → Help and Support

3. My Documents → Help and Support

4. Start → All Programs → Help and Support

Question Type : MCQ
Question ID : 6182781391

Status : Answered
Chosen Option : 4

Marks : 0.00
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Q.26 माइ�ोसॉ�ट ए�सेल 2016 म� वक� शीट ��व�ट करने के संदभ� म� �न�न�ल�खत म� से कौन सा कथन अस� य है?

Ans 1. दो �व�यमान वक� शीट के बीच एक नई वक� शीट को जोड़ा नह�ं जा सकता है।

2. �व�यमान �थम वक� शीट से पहले एक नई वक� शीट को ��व�ट �कया जा सकता है।

3. अ�ंतम �व�यमान वक� शीट के बाद नई वक� शीट को जोड़ा जा सकता है।

4. वक� शीट ��व�ट करने हेत ुक�-बोड़� का शाट�कट ‘Shift + F11’ होता है।

Question Type : MCQ
Question ID : 6182781411

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.27 �न�न�ल�खत म� से � या सामा�यतः एक कं�यटूर अथवा कोई उपकरण है जो �क अ�य कं�यटूर एव ंउनके
�योगकता�ओ ंको सचूना तथा स�ुवधाएं �दान करने हेत ुकं�यटूर नेटवक�  से जड़ु जाता है?

Ans 1. डोमेन नेम

2. वेब �ाउज़र

3. नेटवक�  हो�ट

4. IP ए�से

Question Type : MCQ
Question ID : 6182781438

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.28 आप िजन लोग� को प� भेजना चाहत ेह�, उनक� सचूी का चयन करने हेत ुमे�लगं (मेल मज�) टैब के तहत
�न�न�ल�खत म� से �कस �वक�प का चयन �कया जाता है?

Ans 1. लेब�स

2. सेले�ट रेसी�पय��स

3. इ�सट� मज� फ��ड

4. ए�वल�स

Question Type : MCQ
Question ID : 6182781407

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.29 माइ�ोसॉ�ट ए�सेल 2016 के संदभ� म� यह बताएं �क �न�न�ल�खत कथन सह� ह� या गलत है। 
(i) जब फामू�ला को हटाया (कट और पे�ट) जाता है, फामू�ला के अदंर उपि�थत
सेल रेफरे�सेस बदलत ेनह�ं ह�, चाहे आप �कसी भी �कार के सेल रेफर�स का �योग कर�।
(ii) जब �कसी फामू�ला को कॉपी करके अ�य सेल म� पे�ट �कया जाता है, सापे��क से�स रेफरे�सेस भी बदल
जाएंगे।

Ans 1. (i) सह� (ii) सह�

2. (i) गलत (ii) सह�

3. (i) गलत (ii) गलत

4. (i) सह� (ii) गलत
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Question Type : MCQ
Question ID : 6182781426

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.30 �न�न�ल�खत म� से कौन सा पॉइं�टगं �डवाइस का उदाहरण है?

Ans 1. पेन �ाइव

2. माइ�ोफोन

3. माउस

4. बार कोड र�डर

Question Type : MCQ
Question ID : 6182781383

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.31 �न�न�ल�खत म� से कौन सी एक हाई लेवल ल�� वेज क� �वशषेता नह�ं है?

Ans 1. इसे मशीन कोड़ म� �लखा जाता है

2. इसम� सपु�रभा�षत �सटैं�स एवं �ट�डड़� होत ेह�।

3. इसके �लए कंपाइलर क� आव�यकता होती है

4. इसका आसानी से �योग �कया जा सकता है

Question Type : MCQ
Question ID : 6182781388

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.32 Microsoft Word 2016 क� आव�यकताओ ंके अनसुार, लेबल ऑ�श�स �वडंो के तहत क�टमाइ�ड लेबल
�न�म�त करने हेत ु�न�न�ल�खत म� से �कस �वक�प का चयन �कया जाता है?

Ans 1. �य ूलेबल

2. �डटे�स

3. लेबल इ�फॉम�शन

4. ��टंर इ�फॉम�शन

Question Type : MCQ
Question ID : 6182781408

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.33 माइ�ोसॉ�ट ए�सेल 2016 म� फामू�ला ��व�ट करने अथवा संपा�दत करने हेत ु�न�न�ल�खत म� से �कस
�वक�प का �योग �कया जाता है?

Ans 1. मेन ुबार

2. टा�कबार

3. टाइटल बार
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4. फॉमू�ला बार

Question Type : MCQ
Question ID : 6182781425

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.34 �न�न�ल�खत म� से � या एक सॉ�टवेयर �ो�ाम है जो �क �योगकता� को वेब पेज ढंूढ़ने, उस तक पहंुचने तथा
�द�श�त करने क� स�ुवधा �दान करता है?

Ans 1. सच� इंजन

2. WWW

3. वेब �ाउज़र

4. वेबसाइट

Question Type : MCQ
Question ID : 6182781440

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.35 माइ�ोसॉ�ट पॉवरपॉइंट 2016 म� �ज�टेशन के पहले �लाइड़ म� जाने के �लए, �न�न�ल�खत म� से �कस क�-बोड़�
शाट�कट का �योग �कया जाता है?

Ans 1. Tab + Home

2. Shift + Home

3. Home

4. Alt + Home

Question Type : MCQ
Question ID : 6182781435

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.36 माइ�ोसॉ�ट ए�सेल 2016 म� चा��स के संदभ� म� �न�न�ल�खत म� से कौन सा कथन गलत है?

Ans 1. समय के साथ �विृ�त �द�श�त करने हेत ुलाइन चा��स का �योग �कया जाता है।

2. पाई चा��स �वारा डटेा �द�श�त करने के �लए लाइन� क� �ेणी का �योग �कया जाता है।

3. �कैटर चा��स को बबल चाट� भी कहा जाता है

4. �व�भ�न वग� के मान� क� तलुना हेत ुकॉलम चा��स का �योग �कया जाता है।

Question Type : MCQ
Question ID : 6182781428

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.37 माइ�ोसॉ�ट ए�सेल 2016 म�, होम टैब पर से�स �ुप के तहत, �न�न�ल�खत म� से कौन सा �वक�प, ‘ऑटो
�फट रो हाइट’ म� शा�मल होता है?

Ans 1. �डल�ट
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2. फॉम�ट

3. फॉम�ट प�टर

4. इ�सट�

Question Type : MCQ
Question ID : 6182781414

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.38 Microsoft Word 2016 म� य�द आप परैा�ाफ माक�  एवं अ�य �छपे हुए फॉम��टगं �तीक� को �द�श�त करना
चाहत ेह�, तो आप _______ को दबा सकत ेह�।

Ans 1. Ctrl + +

2. Ctrl + *

3. Ctrl + &

4. Ctrl + $

Question Type : MCQ
Question ID : 6182781400

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.39 इ�सट� मे�य ुम� इल��ेशन �ुप के तहत �न�न�ल�खत म� से कौन सा �वक�प, श�े स का एक वधै �कार नह�ं
होता है?

Ans 1. रे�ट�गल

2. �लॉक एरोज़

3. पाइ चाट�

4. लाइ�स

Question Type : MCQ
Question ID : 6182781430

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.40 �न�न�ल�खत म� से � या असे�बल� भाषा म� �लखे गए �ो�ाम को मशीन कोड म� �पांत�रत करता है?

Ans 1. क�वट�र

2. इ�टर�ेटर

3. असे� बलर

4. क�पाइलर

Question Type : MCQ
Question ID : 6182781389

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.41 माइ�ोसॉ�ट ए�सेल 2016 म�, म�ुा �च�ह, होम मे�य ुम� _________ �ुप म� मौजदू होता है।
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Ans 1. से�स

2. ए�ड�टगं

3. नंबर

4. �टाइ�स

Question Type : MCQ
Question ID : 6182781418

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.42 �लॉटर, जो �क एक I/O उपकरण है, का �योग _________ हेत ु�कया जाता है।
Ans 1. कहे गए श�द� को मशीनी भाषा के �प म� �पांत�रत करने

2. कागज़� पर �ा�फकल आउटपटु �न�म�त करने

3. बार कोड़ को पढ़ना तथा उ�ह� कं�यटूर �वारा �ॉसेस �कए जाने के �लए इलेि��क प�स म� प�रव�त�त
करने

4. कं�यटूर क� ���न पर लाइन अथवा �च�  �ॉ करने

Question Type : MCQ
Question ID : 6182781385

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.43 �न�न�ल�खत म� से कौन सा �स�टम, �व�श�ट �याह� से म�ु�त �व�श�ट अ�र� को पढ़ सकता है?

Ans 1. म�ैने�टक इंक कैरे�टर �रकि�नशन

2. ऑि�टकल कैरे�टर र�डर

3. लाइट पेन

4. ऑि�टकल माक�  र��डगं

Question Type : MCQ
Question ID : 6182781384

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.44 माइ�ोसॉ�ट ए�सेल 2016 म�, होम टैब पर से�स �ुप म� �डल�ट ऑ�शन म� इनम� से � या मौजदू नह�ं होता है?

Ans 1. �डल�ट फॉमु�ला

2. �डल�ट शीट रो

3. �डल�ट शीट कॉल�स

4. �डल�ट से�स

Question Type : MCQ
Question ID : 6182781412

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.45
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Microsoft Word 2016 म� द�तावेज़ को ��टं करने के दौरान �न�न�ल�खत म� से कौन सी एक �डफॉ� ट पेज
र�ज होती है?

Ans 1. सेल�शन

2. पेज

3. आल

4. करंट

Question Type : MCQ
Question ID : 6182781399

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.46 Microsoft Word 2016 म� �कसी द�तावेज़ को आव�ध�त करके �दखाने के �लए �न�न�ल�खत म� से �कन
चरण� का �योग �कया जाता है?

Ans 1. Go to Tools → Select Option

2. Go to Format → Select Font

3. Go to Tools → Select Customize

4. Go to View → Select Zoom

Question Type : MCQ
Question ID : 6182781404

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.47 Microsoft Word 2016 म�, मेल मज� �वज़ाड़� का �न�न�ल�खत म� से कौन सा अ�ंतम चरण होता है?

Ans 1. �टा�ट�ग डॉ�यमु�ट

2. सेले�ट रेसी�पय��स

3. अर�ज यअुर लेब�स

4. कं�ल�ट �द मज�

Question Type : MCQ
Question ID : 6182781409

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.48 �न�न�ल�खत म� से कौन सा �वक�प, अभी तक उपल�ध सभी �कार के इंटरनेट कने�श�स म� सबसे धीमा है?

Ans 1. डायल-अप

2. केबल

3. सटैलाइट

4. DSL

Question Type : MCQ
Question ID : 6182781437

Status : Answered
Chosen Option : 3

Marks : 0.00
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Q.49 ___________, कं�यटूर नेटवक�  पर �लाइंट और सव�र के बीच कं�यटूर फाइ� स के �ांसफर हेत ु�य�ुत होने
वाला मानक नेटवक�  �ोटोकॉल होता है।

Ans 1. OTP

2. TELNET

3. FTP

4. ARP

Question Type : MCQ
Question ID : 6182781436

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.50 Microsoft Excel म�, �न�न�ल�खत म� से कौन सा �वक�प सापे� � तंभ एवं �नरपे� पंि�त का संदभ� ��ततु
करता है?

Ans 1. $A2

2. A$2

3. A2

4. $A$2

Question Type : MCQ
Question ID : 6182781421

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.51 माइ�ोसॉ�ट पॉवरपॉइंट 2016 म�, �न�न�ल�खत म� से कौन सा �वक�प �लाइड लेआउट का चयन करने हेतु
एक वधै चरण नह�ं है?

Ans 1. Home → Layout → Office Theme

2. Home → New Slide → Office Theme

3. Review → Layout → Office Theme

4. Right-click on the current slide → Layout → Office Theme

Question Type : MCQ
Question ID : 6182781434

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.52 Microsoft Word 2016 म�, �रबन म� _______ क� �ृंखला शा�मल होती है।
Ans 1. मािज�न

2. ��ॉल बार

3. टैब

4. �वडंोज़

Question Type : MCQ
Question ID : 6182781396

Status : Answered
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Chosen Option : 2
Marks : 0.00

Q.53 माइ�ोसॉ�ट ए�सेल 2016 म�, होम टैब के तहत से�स �ुप के अदंर फॉम�ट बटन पर ि�लक करके हम वक� शीट
को सरु��त करने हेत ु‘�ोटे�ट शीट’ �वक�प का चयन कर सकत ेह�। शीट, सरु��त हो जाने के बाद, यह
�वक�प _________ म� प�रव�त�त हो जाता है।

Ans 1. अन�ोटे�ट शीट

2. अपडटे शीट

3. इ�सट� शीट

4. डील�ट शीट

Question Type : MCQ
Question ID : 6182781424

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.54 MS Word 2016 डॉ�यमु�ट म�, अगले फ��ड पर जाने के �लए _______ को दबाया जाता है।
Ans 1. F9

2. F5

3. F11

4. F8

Question Type : MCQ
Question ID : 6182781403

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.55 माइ�ोसॉ�ट पॉवरपॉइंट 2016 म�, �न�न�ल�खत म� से कौन सा �वक�प, �य ूटैब के �ज�टेशन �यज़ू �ुप के
अदंर, एक वधै �य ूनह�ं है?

Ans 1. ह�डआउट सॉट�र

2. नॉम�ल

3. नो�स पेज

4. �लाइड सॉट�र

Question Type : MCQ
Question ID : 6182781433

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.56 माइ�ोसॉ�ट पॉवरपॉइंट 2016 म�, � �ैच से एक नई �ज�टेशन तयैार करने हेत ु�डफॉ� ट �प से �न�न�ल�खत म�
से �कस �वक�प का �योग �कया जाता है?

Ans 1. माई टे��ले�स

2. इ��टा�ड थी�स

3. �ल�क �ज�टेशन

4. इ��टा�ड टे��लेट
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Question Type : MCQ
Question ID : 6182781431

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.57 ‘http://www.nios.ac.in’ नामक इंटरनेट ए�से पर �यान द�। ‘nios’ नाम �न�न�ल�खत म� से �कसे संद�भ�त
करता है?

Ans 1. व�ड़� वाइड वेब

2. डोमेन का नाम

3. देश का कोड

4. सं�था का �कार

Question Type : MCQ
Question ID : 6182781439

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.58 कं�यटूर �स�टम क� काया��मकता को �नयं��त करने हेत ु�न�न�ल�खत म� से �कस �वक�प का �योग �कया
जाता है?

Ans 1. डटेाबेस

2. �स�टम सॉ�टवेयर

3. गे�मगं सॉ�टवेयर

4. ऐ�ल�केशन सॉ�टवेयर

Question Type : MCQ
Question ID : 6182781386

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.59 �वडंोज़ XP म�, नॉन-�लग एवं खेल संबंधी �डवाइस� को इं� टाल करने हेत ु‘एड़ हाड�वेयर �वज़ाड�’ का उपयोग
�कया जाता है, यह �न�न�ल�खत म� से �कस �वडंो म� �व�यमान होता है?

Ans 1. माई �प�चस�

2. कं�ोल पनैल

3. लाइ�ेर�

4. माई डॉ�यमु��स

Question Type : MCQ
Question ID : 6182781394

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.60 जब मे�य ुबार तथा टूलबार के समीप माउस को ले जाया जाता है, तो माउस पॉइंटर, _______ बन जाता है।
Ans 1. पॉइं�टगं एरो

2. I-बीम
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3. एंड-ऑफ-डॉ� यमु�ट माक� र

4. इ�सश�न पाइंट

Question Type : MCQ
Question ID : 6182781398

Status : Answered
Chosen Option : 1

Marks : 1.00
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Q.1 सेक� डर� मेमोर� के संदभ� म� �न�न म� से कौन सा कथन अस�य है?

Ans 1. सेक� डर� मेमोर� अि�थर होती ह�

2. CD-ROM सेक� डर� मेमोर� का एक उदाहरण है

3. सेक� डर� मेमोर� का उपयोग डटेा और �ो�ाम के �थायी भंडारण के �लए �कया जाता है

4. हाड� �ड�क, जो �क एक सेक� डर� मेमोर� �डवाइस है, एक म�ैने�टक �डवाइस होती है

Question Type : MCQ
Question ID : 6182781262

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.2 �वडंोज़ ए� सपी (Windows XP) म� ______ का उपयोग करके फ़ाइल �बंधन �कया जा सकता है।
Ans 1. ए�सेसर�ज

2. �व�डोज़ ए�स�लोरर

3. �स�टम से�ट�ंस

4. कं�ोल पनैल

Question Type : MCQ
Question ID : 6182781273

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.3 बताएं �क �वडंोज़ ए� सपी (Windows XP) के संदभ� म� �न�न�ल�खत कथन स�य ह� या अस�य ह�।

(i) टा�कबार के सच� बॉ�स म� 'winword' को �बना को�स (quotes) के टाइप करके माइ�ोसॉ�ट वड� चालू
�कया जा सकता है।
(ii) माइ�ोसॉ�ट वड� को �टाट� बटन पर ि�लक करके चाल ू�कया जा सकता है। इसके �लए �दखाई देने वाले
मेन ूम�, ऑल �ो�ा�स→माइ�ोसॉ�ट ऑ�फस→माइ�ोसॉ�ट ऑ�फस वड� को चनु�

Ans 1. (i) स�य (ii) स�य

Participant ID 19408859
Participant Name SUNIL KUMAR
Test Center Name iON Digital Zone iDZ 1 Patliputra
Test Date 20/12/2019
Test Time 9:00 AM - 10:00 AM
Subject Data Entry Operator
Marks Obtained 23.00000

Section : MCQ for Data Entry Operator
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2. (i) स�य (ii) अस�य

3. (i) अस�य (ii) स�य

4. (i) अस�य (ii) अस�य

Question Type : MCQ
Question ID : 6182781275

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.4 माइ�ोसॉ�ट पॉवर-पॉइंट (Microsoft PowerPoint) 2016 �लाइड शो मोड म� एक �लाइड से दसूर� �लाइड
पर जाने के �लए �न�न म� से कौन सी �व�ध अमा�य है?

Ans 1. बॉटम-ले�ट ने�वगेशन बटन� का उपयोग करना

2. राइट ि�लक करना और अगला या �पछला

3. ��ॉल बार का उपयोग करना

4. ��डलाइ�स का उपयोग करना

Question Type : MCQ
Question ID : 6182781315

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.5 TRIM फ़ं�शन को माइ�ोसॉ�ट ए� सेल (Microsoft Excel) 2016 म� फ़ं�शन लाइ�ेर� समहू के ______
�वक�प के अतंग�त �ॉपडाउन मेन ूम� पाया जा सकता है।

Ans 1. डटे & टाइम

2. टे��ट

3. लॉिजकल

4. फाइन��सयल

Question Type : MCQ
Question ID : 6182781307

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.6 �न�न�ल�खत कथन स� य ह� या अस�य ह�, बताइए

(i) हम चय�नत से�स को एक वक� शीट म� हाईड कर सकत ेह�।
(ii) जब हम कॉल�स या पंि�तय� को हाईड करत ेह�, तो संबं�धत कॉलम अ�र या पंि�त सं�याएं वक� शीट �ेम
से गायब हो जाती ह�

Ans 1. (i) स�य (ii) अस�य

2. (i) स�य (ii) स�य

3. (i) अस�य (ii) स�य

4. (i) अस�य (ii) अस�य

Question Type : MCQ
Question ID : 6182781300

Status : Answered
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Chosen Option : 2
Marks : 0.00

Q.7 आप होम टैब म� ह�। मे�लगं टैब को स��य करने के �लए आप ______ दबा सकत ेह�।
Ans 1. Ctrl + Shift + M

2. Ctrl + M

3. Shift + M

4. Alt + M

Question Type : MCQ
Question ID : 6182781286

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.8 माइ�ोसॉ�ट वड� (Microsoft Word) म� �न�न�ल�खत म� से कौन सा �वक�प यज़ूर को �कसी �भ�न फ़ो�डर
म� फ़ाइल क� ��त�ल�प बनाने क� स�ुवधा देता है या �कसी �भ�न नाम से ��त�ल�प बनाता है?

Ans 1. सेव एज (Save as)

2. �ीपेर (Prepare)

3. पि�लश (Publish)

4. सेव (Save)

Question Type : MCQ
Question ID : 6182781278

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.9 माइ�ोसॉ�ट वड� (Microsoft Word) 2016 म� अ�धकतम �कतने आइटम कट या कॉपी करके ि�लपबोड� पर
�लेस �कए जा सकत ेह�?

Ans 1. 24

2. 20

3. 10

4. 5

Question Type : MCQ
Question ID : 6182781283

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.10 माइ�ोसॉ�ट ए� सेल (Microsoft Excel) 2016 म� होम टैब के से�स �ुप म� �न�न�ल�खत म� से कौन सा
�वक�प मौजदू नह�ं होता है?

Ans 1. इ�सट�

2. �डल�ट

3. फॉम�ट

4. सॉट� & �फ़�टर

Question Type : MCQANKAJ INFOTECH
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Question ID : 6182781293
Status : Answered

Chosen Option : 2
Marks : 0.00

Q.11 �वडंोज़ ए� सपी (Windows XP) म� कं�ोल पनैल के अदंर आप �न�न म� से �कस आइकॉन पर ि�लक करके
एक नया यज़ूर बना सकत ेह� या �कसी मौजदूा यज़ूर क� से�ट�ंस को प�रव�त�त कर सकत ेह�?

Ans 1. नेटवक�  एंड इंटरनेट

2. हाड�वेयर एंड साउंड

3. �स�टम एंड �स�य�ूरट�

4. यजूर अकाउंट

Question Type : MCQ
Question ID : 6182781272

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.12 माइ�ोसॉ�ट वड� (Microsoft Word) 2016 म� ‘�पे�लगं & �ामर’ �वक�प ______ टैब के अतंग�त उपल�ध
होता है।

Ans 1. �र�यू

2. �रफरे�स

3. �डज़ाइन

4. �यू

Question Type : MCQ
Question ID : 6182781282

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.13 माइ�ोसॉ�ट ए� सेल (Microsoft Excel) 2016 म� पॉइंट �केल के आधार पर कॉलम का �डफ़ॉ�ट आकार
सं�या �या होती है?

Ans 1. 409

2. 8.43

3. 15

4. 255

Question Type : MCQ
Question ID : 6182781294

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.14 �न�न�ल�खत म� से कौन सा सीपीय ू(CPU) रिज�टर ए�सेस क� जाने वाल� लोकेशन का ए�से धा�रत करता
है?

Ans 1. इं���शन रिज�टर

2. �ो�ाम काउंटर

3. MAR
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4. MDR

Question Type : MCQ
Question ID : 6182781261

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.15 जब आप माइ�ोसॉ�ट वड� (Microsoft Word) 2016 ______ के �कसी परैा�ाफ पर ��पल-ि�लक करत ेह�।
Ans 1. एक परूा परैा�ाफ सेले� ट हो जाता है

2. संपणू� डॉ�यमू�ट सेले� ट हो जाता है

3. परैा�ाफ क� कुछ पंि�तया ँसेले� ट हो जाती ह�

4. एक परूा श�द सेले� ट हो जाता है

Question Type : MCQ
Question ID : 6182781280

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.16 आप माइ�ोसॉ�ट वड� (Microsoft Word) 2016 म� मेल मज� म� क� टमाइ� ़ड लेबल बनाने के �लए �न�न म�
से �कस अन�ुम का उपयोग कर�गे?

Ans 1. Mailings → Label options → Labels → New Label

2. Mailings → Labels → Label options → New Label

3. Labels → Label options → Mailings → New Label

4. Mailings → Labels → New Label → Label options

Question Type : MCQ
Question ID : 6182781288

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.17 य�द आप पवू�-प�रभा�षत �टाइ�स म� से चनुकर �कसी सेल को ज�द� से फॉरमेट करना चाहत ेह�, तो आपको
माइ�ोसॉ�ट ए� सेल (Microsoft Excel) 2016 म� ______ टैब म� �टाइ�स �ुप म� जाना होगा।

Ans 1. पेज लेआउट

2. इ�सट�

3. �यू

4. होम

Question Type : MCQ
Question ID : 6182781302

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.18 �न�न�ल�खत म� से कौन सा उपकरण �कसी इनपटु �ोत �वारा उ�प�न �व�न को �ा�त करता है और उस
�व�न को कं�यटूर म� भेजता है?

Ans 1. क�बोड�
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2. वेबकैम

3. माउस

4. माइ�ोफ़ोन

Question Type : MCQ
Question ID : 6182781265

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.19 �स�टम सॉ�टवेयर के संदभ� म� �न�न�ल�खत म� से कौन सा कथन सह� है?

Ans 1. सामा�य तौर पर यज़ूर �स�टम सॉ�टवेयर के साथ इंटरै�ट करता है।

2. �स�टम सॉ�टवेयर �वतं� �प से नह�ं चल सकता है।

3. �स�टम सॉ�टवेयर यज़ूर क� आव�यकताओ ंके अनसुार इं� टाल �कया जाता है।

4. �स�टम सॉ�टवेयर का उपयोग कं�यटूर हाड�वेयर के संचालन के �लए �कया जाता है।

Question Type : MCQ
Question ID : 6182781267

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.20 �न�न�ल�खत म� से कौन सा एक इनपटु �डवाइस है?

Ans 1. ��टंर

2. �पीकर

3. मॉ�नटर

4. बार कोड र�डर

Question Type : MCQ
Question ID : 6182781263

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.21 �न�न�ल�खत म� से कौन सी भाषा चौथी जनरेशन क� कं�यटूर भाषा है?

Ans 1. C++

2. पाइथन

3. C

4. Java

Question Type : MCQ
Question ID : 6182781268

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.22 एमएस-ए� सेल (MS-Excel) 2016 क� वक� शीट म� सेल A1 म� "tHe fILm waS greaT" �लखा है। सेल B1
म� स�ू “=Proper(A1)” लगा है। इसका आउटपटु �या होगा?

Ans 1. Thefilm was great
ANKAJ INFOTECH
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2. Great Film

3. THE FILM WASGREAT

4. The Film Was Great

Question Type : MCQ
Question ID : 6182781301

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.23 माइ�ोसॉ�ट पॉवर-पॉइंट (Microsoft PowerPoint) 2016 म�, होम टैब के �लाइड समहू म� option
लेआउट ’�वक�प का चयन करने पर �कतने �लाइड लेआउट बॉ�स �दखाई देत ेह�?

Ans 1. 13

2. 9

3. 12

4. 15

Question Type : MCQ
Question ID : 6182781314

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.24 माइ�ोसॉ�ट वड� (Microsoft Word) 2016 म� �कस टैब म� आपको ’पेज सेटअप’ �वक�प �मल�गे िजसम�
पेपर साइज़ और पेज ओ�रएंटेशन शा�मल ह�?

Ans 1. �डज़ाइन

2. लेआउट

3. पेज लेआउट

4. �यू

Question Type : MCQ
Question ID : 6182781284

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.25 माइ�ोसॉ�ट वड� (Microsoft Word) 2016 के मे�लगं टैब म� ���य ू�रज�ट �ुप के अतंग�त कौन सा �वक�प
डॉ�यमू�ट म� मज� फ़��ड को रे�स�पय�ट �ल�ट के वा�त�वक डटेा से बदल देता है ता�क हम देख सक�  �क यह कैसा
�दखता है?

Ans 1. ���य ू�रज��स

2. ऑटो चेक फॉर एर�स�

3. मचै फ़���स

4. �फ�नश

Question Type : MCQ
Question ID : 6182781289

Status : Answered
Chosen Option : 2

Marks : 0.00
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Q.26 �वडंोज़ ए� सपी (Windows XP) म� सॉ�टवेयर को बदलने या हटाने के �लए �न�न�ल�खत म� से �कस �म का
अनसुरण �कया जाता है?

Ans 1. �टाट� → कं�ोल पनैल → ऐड या �रमवू �ो�ा�स → च�ज या �रमवू �ो�ा�स

2. �टाट� → कं�ोल पनैल → ऐड या �रमवू �ो�ा�स → �वडंोज अपडटे

3. �टाट� → कं�ोल पनैल → ऐड या �रमवू �ो�ा�स → ऐड �य ू�ो�ा�स

4. �टाट� → कं�ोल पनैल → ऐड या �रमवू �ो�ा�स → �वडंोज कॉ�पोने�ट �वज़ाड�

Question Type : MCQ
Question ID : 6182781274

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.27 एमएस-ए� सेल (MS-Excel) 2016 म� ��ज़ प�ै स �ॉप-डाउन सचूी म� �कतने �डफ़ॉ�ट �वक�प होत ेह�?
Ans 1. 7

2. 9

3. 3

4. 5

Question Type : MCQ
Question ID : 6182781295

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.28 एमएस पॉवर-पॉइंट (MS PowerPoint) 2016 म�, ’लेआउट’ �वक�प होम टैब के ______ �ुप म� मौजदू होता
है।

Ans 1. परैा�ाफ

2. फ़ॉ�ट

3. ि�लपबोड�

4. �लाइ�स

Question Type : MCQ
Question ID : 6182781312

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.29 माइ�ोसॉ�ट वड� (Microsoft Word) 2016 म� टाइ�पगं वाले ए�रया क� चौड़ाई और ऊंचाई को दशा�ने के �लए
�न�न म� से � या �ै�तिजक और ऊ�वा�धर पमैाने �द�श�त करता है?

Ans 1. �लस�

2. फूटर

3. टूलबार

4. हेडर

Question Type : MCQ
Question ID : 6182781276

Status : Answered
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Chosen Option : 3
Marks : 0.00

Q.30 �न�न�ल�खत फामू�ला का आउटपटु �या होगा?

=trim(The Film Was Great)
Ans 1. The Film Was Great

2. TheFilmWasGreat

3. The

4. Film Was

Question Type : MCQ
Question ID : 6182781308

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.31 माइ�ोसॉ�ट वड� (Microsoft Word) 2016 म� एि�जि�टंग डा�यमू��स को खोलने के �लए आप
�न�न�ल�खत म� से कौन से क�-बोड� शॉट�क�स का उपयोग कर�गे?

Ans 1. Ctrl + S

2. Ctrl + N

3. Ctrl + P

4. Ctrl + O

Question Type : MCQ
Question ID : 6182781277

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.32 इंटरनेट ए�से के �न�न�ल�खत डोमेन नाम ए�सट�शंस म� से कौन सरकार� सं�थान� को दशा�ता है?

Ans 1. .com

2. .org

3. .net

4. .gov

Question Type : MCQ
Question ID : 6182781319

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.33

Ans 1. 

2. 

3. 

4. 
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Question Type : MCQ
Question ID : 6182781297

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.34 माइ�ोसॉ�ट ए� सेल (Microsoft Excel) 2016 म� सरु�ा के संदभ� म� �न�न�ल�खत म� से कौन सा एक
�वक�प अमा�य है?

Ans 1. �ोटे�ट वक� बकु

2. �ोटे�ट वक� �पेस

3. �ोटे�ट शीट

4. �ोटे�ट एंड शयेर वक� बकु

Question Type : MCQ
Question ID : 6182781296

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.35 �न�न�ल�खत म� से कौन सा �वक� प माइ�ोसॉ�ट वड� (Microsoft Word) 2016 म� मे�लगं (मेल मज�) टैब के
‘सेले�ट रेसी�पएंट’ �वक�प के अतंग�त नह�ं पाया जा सकता है?

Ans 1. चजू �ॉम आउटलकु कॉ�टे��स

2. यजू एन एि�जि�टंग �ल�ट

3. नाम�ल वड� डॉ�यमू�ट

4. टाइप ए �य ू�ल�ट

Question Type : MCQ
Question ID : 6182781287

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.36 �न�न�ल�खत म� से कौन सी इंटरनेट सेवा एक ह� समय म� एक �यि�त से दसूरे �यि�त या यहां तक �क कई
लोग� को संदेश, नो�स या प� भेजने क� एक पेपरलेस �व�ध है?

Ans 1. इमेल

2. मालवेयर

3. फ़ायरवॉल

4. एंट�वायरस

Question Type : MCQ
Question ID : 6182781320

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.37 �वडंोज़ ए� सपी (Windows XP) ऑपरे�टगं �स�टम म� �टाट� मेन ूके ‘ऑल �ो�ा�स’ पर ि�लक करने पर
______ क� सचूी �द�श�त होती है।

Ans 1. वत�मान यज़ूर �वारा हाल ह� म� इ�तमेाल �कए गए डॉ�यमू�ट

2. वत�मान यज़ूर �वारा उपयोग �कए गए डॉ�यमू�ट
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3. वत�मान यज़ूर �वारा इ� तमेाल �कए गए �च�/फोटो

4. यज़ूर �वारा चाल ूया इ� तमेाल, इं�टॉल �कया गया �ो�ाम

Question Type : MCQ
Question ID : 6182781270

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.38 �न�न�ल�खत म� से कौन सी एक फ़ाइल है िजसम� नाम और पत ेया कोई अ�य जानकार� शा�मल होती है और
जो माइ�ोसॉ�ट वड� (Microsoft Word) 2016 म� मेल मज� डॉ�यमू�ट के ��येक सं�करण म� �भ� न-�भ� न
होती है?

Ans 1. डटेा सोस�

2. मेन डॉ�यमू�ट

3. �ट�डड� लेटर

4. मज� डॉ�यमू�ट

Question Type : MCQ
Question ID : 6182781285

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.39 य�द आपके �स�टम म� कई ��टंर जोड़ ेगए ह� तो आप उस ��टंर को कैसे चनुत ेह� िजससे आपको ��टं आउट
लेने क� आव�यकता है?

Ans 1. Ctrl + P > ��टंर �ॉप-डाउन सचूी से ��टंर चनु�

2. Ctrl + P > मािज�न �ॉप-डाउन सचूी से ��टंर चनु�

3. Ctrl + P > पेज सेटअप �ॉप-डाउन सचूी से ��टंर चनु�

4. Ctrl + P > से�टगं �ॉप-डाउन सचूी से ��टंर चनु�

Question Type : MCQ
Question ID : 6182781279

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.40 एमएस पॉवर-पॉइंट (MS PowerPoint) 2016 म� मौजदू �लाइड शो �वक�प �या ह�?
Ans 1. From end; From current slide

2. From beginning; From next slide

3. From beginning; From current slide

4. From beginning; From previous slide

Question Type : MCQ
Question ID : 6182781311

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.41 �न�न�ल�खत म� से कौन सा �वक� प ए�ल�केशन सॉ�टवेयर का एक उदाहरण है?
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Ans 1. असे�बलर

2. क�पाइलर

3. डी-बगर

4. डटेाबेस

Question Type : MCQ
Question ID : 6182781266

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.42 एक एमएस-ए� सेल (MS-Excel) 2016 शीट म� A6 और B6 से�स म� �मशः "My" और "Life" �लखा है।
सेल C6 म� स�ू "=CONCATENATE(A6,B6)" लगा है। आउटपटु �या होगा?

Ans 1. my_life

2. ML

3. My Life

4. MyLife

Question Type : MCQ
Question ID : 6182781303

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.43 एमएस पॉवर-पॉइंट (MS PowerPoint) 2016 म� �लाइड सॉट�र �य ूके संदभ� म� �न�न�ल�खत म� से कौन सा
अस� य गलत है?

Ans 1. �लाइड को आसानी से �लाइड सॉट�र �य ूका उपयोग करके सॉट� और �मब� �कया जा सकता है

2. �लाइड सॉट�र �य ूका उपयोग �ांिजशन के जसेै �वशषे �भाव� को शा�मल करने के �लए भी �कया जा
सकता है

3. �लाइड सॉट�र �य ूतक पहंुचने के �लए आपको �र�य ू→ �लाइड सॉट�र का चयन करना होगा

4. �लाइड सॉट�र �य ूम� ��येक �लाइड क� एक छोट� इमेज �द�श�त क� जाती है

Question Type : MCQ
Question ID : 6182781313

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.44 माइ�ोसॉ�ट ए� सेल (Microsoft Excel) 2016 म� वक� शीट का नाम बदलने के �लए �न�न म� से कौन सी
�व�ध मा�य नह� ंहै?

Ans 1. मौजदूा वक� शीट नाम पर राइट-ि�लक कर�, �फर �ा�त संदभ� मेन ूसे '�रनेम' चनु�

2. उस वक� शीट टैब पर �सगंल-ि�लक कर� िजसका आप नाम बदलना चाहत ेह�

3. उस वक� शीट टैब पर डबल-ि�लक कर� िजसका आप नाम बदलना चाहत ेह�

4. उस वक� शीट का चयन कर� िजसका आप नाम बदलना चाहत ेह�, होम मेन ूम� फॉम�ट �ॉप-डाउन सचूी
से �रनेम शीट’ �वक�प चनु�

Question Type : MCQ
Question ID : 6182781291

Status : Answered
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Chosen Option : 1
Marks : 0.00

Q.45 माइ�ोसॉ�ट ए� सेल (Microsoft Excel) 2016 म� फॉरमेट से�स डायलाग बॉ�स को स��य करने के �लए
�न�न�ल�खत म� से �कस क�-बोड� शॉट�कट का उपयोग �कया जाता है?

Ans 1. Ctrl + 2

2. Ctrl + F

3. Ctrl + D

4. Ctrl + 1 (सं�या�मक एक)

Question Type : MCQ
Question ID : 6182781299

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.46 माइ�ोसॉ�ट वड� (Microsoft Word) 2016 म� बलेुट और नंब�रगं �वक�प होम टैब के ______ �ुप म�
उपल�ध होत ेह�।

Ans 1. फ़ॉ�ट

2. ि�लपबोड�

3. परैा�ाफ

4. �टाइ�स

Question Type : MCQ
Question ID : 6182781281

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.47 माइ�ोसॉ�ट ए� सेल (Microsoft Excel) 2016 म� एक नयी शीट को इ�सट� करने के �लए ‘इ�सट�’ �वक�प
होम टैब के भीतर ______ समहू म� पाई जा सकती है।

Ans 1. ए�ड�टगं

2. �टाइ�स

3. एलाइनम�ट

4. से�स

Question Type : MCQ
Question ID : 6182781290

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.48 माइ�ोसॉ�ट ए� सेल (Microsoft Excel) म�, A1 से C3 म� कॉपी �कए जा रहे फामू�ला के �लए य�द सेल
�रफरे�स $A$1 है, तो यह ______ बन जाता है।

Ans 1. $A$1

2. C$1

3. $A3

4. C3
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Question Type : MCQ
Question ID : 6182781306

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.49 �न�न�ल�खत कथन स� य ह� या अस�य ह�, बताइए

(i) असे��लस�, अस�बल� ल��वेज कोड को सीधे मशीन कोड म� बदल सकत ेह�
(ii) क�पाइलर एक उ�च-�तर�य भाषा �ोत कोड को पहले ऑ�जे�ट कोड म� �पांत�रत करता है और �फर
ऑ�जे�ट कोड को �न�पादन यो�य कोड (ए�से�यटेूबल कोड) म� �पांत�रत करता है।

Ans 1. (i) स�य (ii) अस�य

2. (i) स�य (ii) स�य

3. (i) अस�य (ii) अस�य

4. (i) अस�य (ii) स�य

Question Type : MCQ
Question ID : 6182781269

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.50 कं�यटूर �स�टम य�ूनट के अदंर �न�न�ल�खत म� से �कस इले��ॉ�नक मॉ�यलू से इनपटु/आउटपटु �डवाइस
सीधे जड़ु ेहोत ेह�?

Ans 1. यएूसबी (USB) पोट�

2. �डवाइस कं�ोलर

3. लनै (LAN) काड�

4. पीसीआई (PCI) बसेस

Question Type : MCQ
Question ID : 6182781264

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.51 �वडंोज़ ए� सपी (Windows XP) म� माइ�ोसॉ�ट प�ट चाल ूकरने के �लए आप �कस �म का अनसुरण कर�गे?

Ans 1. ऑल �ो�ाम → �टाट� → ए�सेसर�ज → प�ट

2. �टाट� → ए�सेसर�ज → ऑल �ो�ाम → प�ट

3. �टाट� → ऑल �ो�ाम → ए�सेसर�ज → प�ट

4. �टाट� → ऑल �ो�ाम → प�ट → ए�सेसर�ज

Question Type : MCQ
Question ID : 6182781271

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.52 माइ�ोसॉ�ट ए� सेल (Microsoft Excel) म� फामू�ला के संदभ� म� �न�न�ल�खत म� से कौन सा कथन अस� य
है?

Ans
ANKAJ INFOTECH



1/27/2020 https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S70D363/157684399890656…

https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S70D363/1576843998906569/1940885… 15/17

1. फॉमू�ला म� मथैमे�टकल ऑपरेटस� और लॉिजकल ऑपरेटस� हो सकत ेह�।

2. फॉमू�ला म� से�स के संदभ� हो सकत ेह� (ना�मत र�ज� और से�स स�हत)।

3. फॉमू�ला म� टे��ट या व�ैय ूहो सकत ेह�।

4. एक फॉमू�ला '#' �च�ह से श�ु होना चा�हए।

Question Type : MCQ
Question ID : 6182781305

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.53 �न�न�ल�खत म� से कौन सा �ाथ�मक उपकरण �वशषे �प से होम कं�यटूर को इंटरनेट से कने�ट करने क�
स�ुवधा देने के �लए आव�यक है?

Ans 1. मॉडम

2. मॉ�नटर

3. क�-बोड�

4. माउस

Question Type : MCQ
Question ID : 6182781316

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.54 माइ�ोसॉ�ट ए� सेल (Microsoft Excel) 2016 म� �न�न म� से �कस टैब म� ’श�ेस’ फ�चर �मल सकता है?

Ans 1. �यू

2. होम

3. इ�सट�

4. पेज लेआउट

Question Type : MCQ
Question ID : 6182781309

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.55 ______ एक �व�श�ट एि�लकेशन सॉ�टवेयर है िजसे इंटरनेट से कने�ट करने के �लए �डज़ाइन �कया गया है।
Ans 1. �ाउज़र

2. एमएस वड� (MS Word)

3. ए�ोबेट

4. पि�लशर

Question Type : MCQ
Question ID : 6182781317

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.56
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इंसट� पॉपअप �द�श�त करने के �लए आप �कस क�-बोड� शॉट�कट का उपयोग कर�गे, िजसके �वारा माइ�ोसॉ�ट
ए� सेल (Microsoft Excel) 2016 म� पंि�तय� और �तंभ� को जोड़ा जा सकता है?

Ans 1. Ctrl + Shift + @

2. Ctrl + Shift + !

3. Ctrl + Shift + ~

4. Ctrl + Shift + =

Question Type : MCQ
Question ID : 6182781292

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.57 माइ�ोसॉ�ट ए� सेल (Microsoft Excel) 2016 म� ______ म� फॉम��टगं टूल उपल�ध नह�ं होत ेह�।
Ans 1. होम टैब के भीतर

2. फॉरमेट सेल डायलाग बॉ�स म�

3. जब माउस र�ज या सेल पर राइट ि�लक �कया जाता है तब �दखनेवाले �मनी टूल बार म�

4. मे�लगं टैब के भीतर

Question Type : MCQ
Question ID : 6182781298

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.58 �न�न म� से कौन सा एक वधै �माट�आट� �ा�फ़क (SmartArt graphic) नह�ं है जो माइ�ोसॉ�ट ए� सेल
(Microsoft Excel) 2016 म� �माट�आट� डायलाग बॉ�स के भीतर �दखाई देता है?

Ans 1. साइ�कल

2. हायराक� (Hierarchy)

3. चाट�

4. �ल�ट

Question Type : MCQ
Question ID : 6182781310

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.59 माइ�ोसॉ�ट ए� सेल (Microsoft Excel) 2016 म� एक वक� शीट को असरु��त बनाने के �लए �न�न�ल�खत
म� से �कस �म का पालन �कया जाना चा�हए?

Ans 1. Review tab → Comments → Unprotect Sheet

2. Review tab → Changes → Unprotect Sheet

3. Review tab → Changes → Protect Sheet

4. View tab → Changes → Unprotect Sheet

Question Type : MCQ
Question ID : 6182781304

Status : Answered
Chosen Option : 2
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Marks : 1.00

Q.60 �न�न�ल�खत म� से कौन सा संचार �ोटोकॉल इंटरनेट पर नेटवक�  उपकरण� को इंटरकने�ट करने के �लए
इ� तमेाल �कया जाता है?

Ans 1. WWW

2. HTTP

3. TCP/IP

4. FTP

Question Type : MCQ
Question ID : 6182781318

Status : Answered
Chosen Option : 1

Marks : 0.00
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Q.1 ऑपरे�टगं �स�टम म� फाइल म�ैपगं �न�न म� से कौन करता है?

Ans 1. पेज टेबल

2. फ़ाइल �स�टम

3. फ़ाइल मेटाडटेा

4. वचु�अल मेमर�

Question Type : MCQ
Question ID : 6182781451

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.2 �न�न�ल�खत म� से कौन सा �ोसेसर का एक �कार नह�ं है?

Ans 1. jpg

2. Mediatek

3. Snapdragon

4. Pentium

Question Type : MCQ
Question ID : 6182781454

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.3 IPv4 के रेफर�स म� अ�से साइज़ �या है?

Ans 1. 128-�बट

2. 64-�बट

3. 32-�बट

4. 16-�बट

Participant ID 19332119
Participant Name AMIT RAJ
Test Center Name iON Digital Zone iDZ Sandalpur
Test Date 21/12/2019
Test Time 12:00 PM - 1:00 PM
Subject Data Entry Operator
Marks Obtained 19.00000

Section : MCQ for Data Entry Operator
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Question Type : MCQ
Question ID : 6182781499

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.4 OSS का पणू� �प है:

Ans 1. Open Sold Software

2. Other Synchronised Software

3. Open Source Software

4. Other System Service

Question Type : MCQ
Question ID : 6182781447

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.5 MS Excel म� ‘मज� एंड स�टर’ के �लए �न�न�ल�खत म� से �कस शॉट�कट कंुजी का उपयोग �कया जाता है?

Ans 1. Alt + M + C

2. Alt + H + M + C

3. Ctrl + M + C

4. Shift + M + C

Question Type : MCQ
Question ID : 6182781469

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.6 MS Excel म� �न�न�ल�खत म� से कौन सा ता�क� क स�ू (logical function) है?

Ans 1. AND

2. DAYS

3. CHAR

4. SUM

Question Type : MCQ
Question ID : 6182781477

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.7 �न�न�ल�खत म� से कौनसी ��ेडशीट का एक सह� रो ए�से है?

Ans 1. 25

2. C5

3. 3B

4. AA

Question Type : MCQ
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Question ID : 6182781470
Status : Answered

Chosen Option : 1
Marks : 0.00

Q.8 सेल ए�से AB12 म�, कॉलम नंबर �या है?

Ans 1. AB

2. 12

3. A1

4. A

Question Type : MCQ
Question ID : 6182781471

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.9 सभी वेब �ाउज़र �कस �कार क� फ़ाइल� को पढ़ सकत ेह�?
Ans 1. HTML

2. JAVA

3. PERL

4. C#

Question Type : MCQ
Question ID : 6182781500

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.10 माइ�ोसॉ�ट वड� म� टे��ट खोजने के �लए �न�न म� से �कस शॉट�कट कंुजी का उपयोग �कया जाता है?

Ans 1. Ctrl + F

2. F6

3. F4

4. F2

Question Type : MCQ
Question ID : 6182781459

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.11 एक डॉट म�ै��स ��टंर क� ग�त को �कसके संदभ� म� मापा जाता है?

Ans 1. कंट�ट ��त सेकंड

2. लाइन ��त सेकंड

3. लाइन ��त �मनट

4. कैरे�टर ��त सेकंड

Question Type : MCQ
Question ID : 6182781443

ANKAJ INFOTECH
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Status : Answered
Chosen Option : 1

Marks : 0.00

Q.12 कौन सा �ड��ले �ो�ाम �वडंो के शीष� पर होता है?

Ans 1. थंबनेल

2. मेन ूबार

3. टाइटल बार

4. डायलॉग बार

Question Type : MCQ
Question ID : 6182781450

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.13 MS Excel म� TRIM फॉमू�ला का उपयोग �या है?

Ans 1. श�द� के बीच एकल �र�त �थान को छोड़कर एक टे��ट ि��ंग से सभी �र�त �थान �नकाल देता है

2. सभी �र�त �थान को �नकाल देता है

3. एक वा�य के बाद अ�त�र�त �र�त �थान �नकाल देता है

4. पहले और आ�खर� श�द� को �नकाल देता है

Question Type : MCQ
Question ID : 6182781475

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.14 वेबसाइट स�फ� ग करत ेसमय �न�न�ल�खत म� से �कस एक क� आव�यकता नह�ं है?

Ans 1. ऑपरे�टगं �स�टम

2. मोिज़ला फ़ायरफ़ॉ�स

3. इंटरनेट स�व�स �ोवाइडर

4. �ाउज़र

Question Type : MCQ
Question ID : 6182781496

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.15 कं�यटूर �यव�थापन म�, ISP का पणू� �प �या है?

Ans 1. Internet Service Provider

2. Interchange Service Protocol

3. Interrupt Service Procedure

4. Interchange Standard Protocol

Question Type : MCQ
Question ID : 6182781441

Status : AnsweredANKAJ INFOTECH
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Chosen Option : 1
Marks : 1.00

Q.16 Google Chrome म�, य�द आप Ctrl + Shift + N दबात ेह�, तो आपको एक ______ �मलता है।
Ans 1. नया टैब

2. नई इ�कॉि�नटो �वडंो

3. नया �ाउज़र

4. अगला टैब

Question Type : MCQ
Question ID : 6182781497

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.17 टाइपफेस का उपयोग ______ दशा�ने के �लए �कया जाता है।
Ans 1. कैरे�टर क� सघनता (density of the character)

2. कैरे�टर का झुकाव (slant of the character)

3. कैरे�टर क� लंबाई (height of the character)

4. कैरे�टर का �डजाइन और �दखावट (design and appearance of the character)

Question Type : MCQ
Question ID : 6182781463

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.18 MS PowerPoint म�, एक नई �र�त �ेज�टेशन का �डफ़ॉ�ट लेआउट �या होता है?

Ans 1. टायटल �लाइड़ िजसम� टायटल और सबटायटल है

2. �कसी भी टायटल/सबटायटल के �बना �र�त �लाइड़

3. टायटल �लाइड़ और कंट�ट �लाइड़

4. क�प�ैरजन �लाइड़

Question Type : MCQ
Question ID : 6182781494

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.19 MS Excel म�, �न�न�ल�खत म� से �कस टैब म� �माट�आट� बटन/�वक�प होता है?

Ans 1. �र�यू

2. �यू

3. होम

4. इ�सट�

Question Type : MCQ
Question ID : 6182781489

Status : Answered
ANKAJ INFOTECH
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Chosen Option : 4
Marks : 1.00

Q.20 �हडन (hidden) फाइल� को �द�श�त करने के �लए आप �न�न म� से �कस कमांड का उपयोग कर�गे?

Ans 1. dir /hide

2. dir /ash

3. dir /ah

4. dir /ad

Question Type : MCQ
Question ID : 6182781453

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.21 �कसी भी वक� शीट म�, सेल को फॉम�ट करत ेसमय जब तक �क हम ______ नह�ं करत,े तब तक सेल के लॉक
होने का कोई �भाव नह�ं पड़ता है।

Ans 1. वक� शीट को मॉ�डफाय

2. वक� शीट को �डल�ट

3. वक� शीट को �र�यू

4. वक� शीट को �ोटे�ट

Question Type : MCQ
Question ID : 6182781479

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.22 �न�न�ल�खत म� से �कस ए��ेसगं मोड म� इन-डायरे�शन पॉइंटस� का उपयोग �कया जाता है?

Ans 1. एि�टव ए��ेसगं मोड

2. इंडाईरे�ट ए��ेसगं मोड

3. डायरे�ट ए��ेसगं मोड

4. परैलल ए��ेसगं मोड

Question Type : MCQ
Question ID : 6182781442

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.23 एक ______ �स�टम सॉ�टवेयर का उदाहरण नह�ं है।
Ans 1. �वडंोज XP (Windows XP)

2. वड� �ोसेसर (Word processor)

3. कं�यटूर भाषा अनवुादक (Computer Language Translator)

4. य�ून�स (Unix)

Question Type : MCQ
Question ID : 6182781446

Status : AnsweredANKAJ INFOTECH
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Chosen Option : 4
Marks : 0.00

Q.24 MS Word 2016 म� एक डॉ�यमू�ट �वडंो का पवू��नधा�रत नाम ______ होता है।
Ans 1. Document1

2. Word 1

3. File 1

4. WPD 1

Question Type : MCQ
Question ID : 6182781455

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.25 MS Excel 2016 म�, �न�न�ल�खत म� से कौन “बे�सक शपे” म� शा�मल नह�ं है?

Ans 1. Star

2. Cloud

3. Moon

4. Cross

Question Type : MCQ
Question ID : 6182781490

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.26 मेल मज� �वज़ाड� म� �कतने चरण शा�मल ह�?
Ans 1. 1

2. 2

3. 6

4. 4

Question Type : MCQ
Question ID : 6182781468

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.27 माइ�ोसॉ�ट वड� म� 'ल�ड�केप' पद �कससे संबं�धत है?

Ans 1. फॉ�ट �टाइल

2. पेज मािज�न

3. पेज ओ�रएंटेशन

4. पेपर साइज़

Question Type : MCQ
Question ID : 6182781456

Status : Answered
Chosen Option : 2

ANKAJ INFOTECH
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Marks : 0.00

Q.28 अ�भ�थापन ���या/उपयो�गता का �योग �न�न म� से �कसके �लए �कया जाता है?

Ans 1. टे��ट के चार� तरफ बाड�र लगाने के �लए

2. लाइन �पे�सगं को प�रव�त�त करने के �लए

3. पेज मािज�न से एक परैा�ाफ क� दरू� �नधा��रत करने के �लए

4. परैा�ाफ के रंग को बदलने के �लए

Question Type : MCQ
Question ID : 6182781457

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.29 MS Excel म�, �न�न�ल�खत म� से कौन सा टे��ट फ़ं�शन (TEXT function) है?

Ans 1. AND

2. NOT

3. CONCATENATE

4. BASE

Question Type : MCQ
Question ID : 6182781484

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.30 MS PowerPoint 2016 म�, नई �र�त �ेज�टेशन फ़ाइल बनाने के �लए �कस शॉट�कट कंुजी-संयोजन का
उपयोग �कया जाता है?

Ans 1. CTRL + H

2. CTRL + C

3. CTRL + N

4. CTRL + HOME

Question Type : MCQ
Question ID : 6182781492

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.31 एट�एम (Automated Teller Machine ) म� �कस �कार के ��टंर का �योग �कया जाता है?

Ans 1. थम�ल ��टंर

2. डॉट मॅ���स ��टंर

3. �लॉटर

4. लेजर ��टंर

Question Type : MCQ
Question ID : 6182781444

Status : Answered
Chosen Option : 4

ANKAJ INFOTECH
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Marks : 0.00

Q.32 मेल मज� हे�पर का उपयोग करके �कतने डटेा फ़��ड बनाए जा सकत ेह�?
Ans 1. 63

2. 61

3. 62

4. 64

Question Type : MCQ
Question ID : 6182781467

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.33 Which of the following key combinations is used for alignment to ‘justify’ in MS Word?
Ans 1. Ctrl + G

2. Ctrl + A

3. Ctrl + C

4. Ctrl + J

Question Type : MCQ
Question ID : 6182781460

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.34 MS Word 2016 म� �कसी �वशषे पेज पर जाने के �लए �कस शॉट� कट कंुजी का उपयोग �कया जाता है?

Ans 1. Alt + F6

2. Alt + G

3. F5

4. Shift + G

Question Type : MCQ
Question ID : 6182781458

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.35 MS Excel म�, A1 म� 3 और A2 म� 4 ह�। स�ू "=A1=A2" का आउटपटु �या होगा?
Ans 1. अस�य

2. स�य

3. 5

4. 1

Question Type : MCQ
Question ID : 6182781483

Status : Answered
Chosen Option : 2

Marks : 0.00

ANKAJ INFOTECH
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Q.36 �न�न�ल�खत म� से कौन सी कं�यटूर भाषा एक �बज़नेस ओ�रएंटेड भाषा है?

Ans 1. C++

2. C

3. DOS

4. COBOL

Question Type : MCQ
Question ID : 6182781448

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.37 What is the output of the following formula in MS Excel?

=DAYS("12 jan","1 jan")
Ans 1. 14

2. 13

3. 11

4. 12

Question Type : MCQ
Question ID : 6182781472

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.38 कंडीशनल फॉम�ट एक सेल र�ज के �व�प को �कस आधार पर बदलता है?

Ans 1. �ाइटे�रया और व�ैयसू

2. रंग

3. टेबल �टाइल

4. फ़ॉ�ट

Question Type : MCQ
Question ID : 6182781474

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.39 In MS Excel, the ______ function is used to sum the values in a range that meets
criteria you specify.

Ans 1. SUMIF

2. COUNTIF

3. SUM

4. PMT

Question Type : MCQ
Question ID : 6182781487

Status : Answered
Chosen Option : 2

Marks : 0.00
ANKAJ INFOTECH
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Q.40 वक� शीट म�, जब आप एक सेल से फॉमू�ला कॉपी करत ेह� और दसूर� सेल म� पे�ट करत ेह�, तब:

Ans 1. स�ू (फ़ॉमू�ला) बदल जाता ह�

2. �रले�टव सेल रेफरे�सेस अड़ज�ट होत ेह�

3. ए�सो�यटू सेल रेफरे�सेस अड़ज�ट होत ेह�

4. केवल म�ूय कॉपी होत ेह�

Question Type : MCQ
Question ID : 6182781486

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.41 MS Excel म�, एक सेल "=" से श�ु होता है। यह �या दशा�ता है?

Ans 1. छ�व

2. स�ू

3. चाट�

4. म�ैो

Question Type : MCQ
Question ID : 6182781485

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.42 �न�न�ल�खत म� से �कस कंुजी संयोजन का उपयोग �कसी वक� शीट के शीष� पर जाने के �लए �कया जाता है
(उदा, A1 सेल)?

Ans 1. CTRL + HOME

2. CTRL + ALT

3. ALT + HOME

4. SHIFT + HOME

Question Type : MCQ
Question ID : 6182781473

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.43 माइ�ोसॉ�ट वड� टेबल म�, कॉलम क� �यनूतम सं�या �या होती है?

Ans 1. 2

2. 3

3. 0

4. 1

Question Type : MCQ
Question ID : 6182781461

Status : Answered
Chosen Option : 3

Marks : 0.00
ANKAJ INFOTECH
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Q.44 MS Word म�, एक टेबल म� बॉड�र को �कस मेन ूसे संशो�धत (मॉ�डफाइड) �कया जा सकता है?

Ans 1. Table Tools > Design

2. Table Tools > Insert

3. Table Tools > Layout

4. Word Tools > Design

Question Type : MCQ
Question ID : 6182781464

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.45 URL "www.google.com" म�, "google.com" ______ है।
Ans 1. हो�ट

2. डोमेन नेम

3. वेब �ाउज़र

4. ISP

Question Type : MCQ
Question ID : 6182781498

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.46 MS PowerPoint 2016 म�, जब हम एक नई �र�त �ेज�टेशन बनात ेह�, तो �डफ़ॉ�ट �प से �कतनी �लाइड़
बन जाती ह�?

Ans 1. एक

2. श�ूय

3. तीन

4. दो

Question Type : MCQ
Question ID : 6182781491

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.47 MS Excel म� �न�न म� से कौन-सा, कॉलम क� चौड़ाई और रो क� ऊँचाई को मॉ�डफाय करने का तर�का भी है?

Ans 1. सॉट�

2. �फ़�टर

3. मािज��स

4. रैप टे��ट

Question Type : MCQ
Question ID : 6182781481

Status : Answered
Chosen Option : 4

Marks : 1.00
ANKAJ INFOTECH
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Q.48 Which of the below is a type of image scanner?
Ans 1. Parallel

2. Flat-bed

3. Indirect

4. Active

Question Type : MCQ
Question ID : 6182781445

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.49 मेलमज� के �लए, �न�न म� से कौन सा मा�य डॉ�यमू�ट का �कार नह�ं है?

Ans 1. एनवेल�स

2. मेमोस

3. लेटस�

4. डायरे�टर�

Question Type : MCQ
Question ID : 6182781465

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.50 MS Word म� ऑटोकरे�ट टूल का उ�े�य �या है?

Ans 1. डॉ�यमू�ट के बारे म� आकंड़ े�दान करना

2. समान और एक ह� अथ� वाले श�द� को �ड��ले करना

3. डॉ�यमू�ट के �याकरण को जाँचना

4. टाइप करत ेसमय गलत वत�नी वाले श�द� को जांचना और गलत वत�नी वाले श�द� को रेखां�कत
करना

Question Type : MCQ
Question ID : 6182781462

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.51 MS PowerPoint 2016 म�, Notes के संबंध म� �न�न�ल�खत म� से कौन सा सह� नह�ं है?

Ans 1. यह केवल �लाइड शो के दौरान �दखाई देता है।

2. यह �लाइड के नीचे �दखाई देता है।

3. यह टे��ट को बो�ड या इटै�लक बनाने क� अनमु�त देता है।

4. यह उपयोगकता�ओ ंको टे��ट �लखने क� अनमु�त देता है।

Question Type : MCQ
Question ID : 6182781493

Status : Answered
Chosen Option : 3

Marks : 0.00
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Q.52 Dir/ad कमांड का �योग �कस हेत ु�कया जाता है?

Ans 1. .exe फाइल को �ड��ले करने के �लए

2. �हडन (hidden) फ़ाइल� को �ड��ले करने के �लए

3. करंट पाथ म� केवल डाइरे�टर� को �ड��ले करने के �लए

4. डाइरे�टर� को देखने क� अनमु�त �ा�त करने के �लए

Question Type : MCQ
Question ID : 6182781452

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.53 �ेज�टेशन के दौरान एक �लाइड़ से दसूर� �लाइड़ म� जाने पर कौन सा ��य �भाव घ�टत होता है?

Ans 1. �लाइड़ �ांिज़शन

2. �ांसलेट

3. �लाइड़ साइज

4. फॉम�ट बकै�ाउंड

Question Type : MCQ
Question ID : 6182781495

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.54 MS Excel म�, रो और कॉलम को फॉम�ट करने के �लए टूलबार से, ______ टैब का उपयोग �कया जाता है।
Ans 1. होम

2. पेज़ लेआउट

3. �यू

4. �र�यू

Question Type : MCQ
Question ID : 6182781480

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.55 Which type of chart is used to show trends over time (years, months and days) or
categories?

Ans 1. Pie chart

2. Waterfall chart

3. Line chart

4. Hierarchy chart

Question Type : MCQ
Question ID : 6182781488

Status : Answered
Chosen Option : 1

Marks : 0.00
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Q.56 �न�न�ल�खत म� से कौन सा फं�शन MS Excel म� फॉम��टगं का �ह�सा नह�ं है?

Ans 1. रैप टे��ट

2. �यू

3. फॉम�ट प�टर

4. मज� एंड स�टर

Question Type : MCQ
Question ID : 6182781478

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.57 जो �ो�ाम �न�न-�तर�य भाषा से उ�च-�तर�य भाषा म� अनवुाद करता है, उसे �या कहा जाता है?

Ans 1. बटू��ैप कंपाइलर

2. कंपाइलर-कंपाइलर

3. �ॉस कंपाइलर

4. �डकंपाइलर

Question Type : MCQ
Question ID : 6182781449

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.58 Which of the following is a type of document in mail merge?
Ans 1. Data source

2. Message

3. Envelope

4. Labels

Question Type : MCQ
Question ID : 6182781466

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.59 MS Excel म�, AutoSum �ॉप डाउन सचूी के तहत �न�न�ल�खत म� से कौन सा वधै �वक�प नह�ं है?

Ans 1. Clipart

2. Sum

3. Max

4. Average

Question Type : MCQ
Question ID : 6182781476

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.60
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MS Excel म�, �न�न�ल�खत म� से कौन सा, �टाइ�स का एक �ह�सा भी है?

Ans 1. ि�लपबोड�

2. ऑटो सम

3. कंडीशनल फॉम��टगं

4. इ�सट� फं�शन

Question Type : MCQ
Question ID : 6182781482

Status : Answered
Chosen Option : 1

Marks : 0.00
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Q.1 MS Excel 2016 म� सेल म� एक �ट�पणी (Comment) जोड़ने के �लए शॉट� कट कंुजी �या है?

Ans 1. Shift + F2

2. Shift + C

3. Alt + C

4. Ctrl + C

Question Type : MCQ
Question ID : 6182781594

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.2 STDEV.P() एक ______ है।
Ans 1. ता�क� क फ़ं�शन (Logical function)

2. टे��ट फ़ं�शन (Text function)

3. सांि�यक�य फ़ं�शन (Statistical function)

4. व�ैा�नक फ़ं�शन (Scientific function)

Question Type : MCQ
Question ID : 6182781607

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.3 MS Word म�, टे��ट को कॉपी करने के �लए उपयोग क� जाने वाल� शॉट�कट कंुजी �या है?

Ans 1. CTRL + X

2. CTRL + C

3. CTRL + V

4. CTRL + Z

Participant ID 19426293
Participant Name SOHAN KUMAR
Test Center Name iON Digital Zone iDZ Jalalpur
Test Date 21/12/2019
Test Time 9:00 AM - 10:00 AM
Subject Data Entry Operator
Marks Obtained 20.00000

Section : MCQ for Data Entry Operator
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Question Type : MCQ
Question ID : 6182781582

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.4 MS Word 2016 मेल मज� म�, मे�लगं के �लए �ा�तकता� क� मौजदूा सचूी _____ म� मौजदू होती है।
Ans 1. Mailings → Select recipients → Use existing list

2. Mailings → Use existing list

3. Mailings → Start Mail Merge → Use existing list

4. Select recipients → Mailing → Use existing list

Question Type : MCQ
Question ID : 6182781588

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.5 MS Power point 2016 म�, �रकॉड� �लाइड शो _____ मेन ूके तहत उपल�ध है।
Ans 1. �लाइड शो

2. इ�सट�

3. �ां�सश�स

4. ऐ�नमेश�स

Question Type : MCQ
Question ID : 6182781612

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.6 MS Excel म�, वक� शीट का नाम कैसे बदलत ेह�?
Ans 1. Home → Rename → Rename the worksheet

2. Right click on Sheet tab → Rename

3. Left click on Sheet tab → Rename

4. Home → Design → Rename

Question Type : MCQ
Question ID : 6182781591

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.7 Excel 2016 म� �न�न�ल�खत म� से कौन सा कथन सह� है?

Ans 1. एक वक� बकु एक वक� शीट के समान है।

2. एक वक� बकु एक श�द द�तावेज़ भी है।

3. एक वक� बकु एक एकल फ़ाइल नह�ं है।

4. एक वक� बकु एक वक� शीट के समान नह�ं है।

Question Type : MCQ
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Question ID : 6182781599
Status : Answered

Chosen Option : 3
Marks : 0.00

Q.8 �लाइड सॉट�र �य ूइनम� से �या �द�श�त करता है?

Ans 1. �ै�तज �म म� आपके �ज�टेशन क� एक �लाइड, थंबनेल

2. �ै�तज �म म� आपके �ज�टेशन क� सभी �लाइड, थंबनेल

3. आपके �ज�टेशन क� कोई �लाइड नह�ं

4. केवल सम सं�याओ ंके �मांक वाल� �लाइड

Question Type : MCQ
Question ID : 6182781613

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.9 टे��ट को पे�ट करने के �लए उपयोग क� जाने वाल� शॉट�कट कंुजी �या है?

Ans 1. CTRL + Z

2. CTRL + V

3. CTRL + C

4. CTRL + X

Question Type : MCQ
Question ID : 6182781583

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.10 MS Excel म� होम मेन ूके तहत ए�ड�टगं �ुप म� ि�लयर �ॉपडाउन सचूी के तहत �न�न�ल�खत म� से कौन सा
वधै �वक�प नह�ं है?

Ans 1. ि�लयर डाटा

2. ि�लयर कंट��स

3. ि�लयर फोम��स

4. ि�लयर कम��स

Question Type : MCQ
Question ID : 6182781604

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.11 इनम� से कौन सा उपयोगकता�ओ ंको �च� और ए�नमेशन जसेै �च�मय त�व� (�ा�फकल ए�लम��स) के मा�यम
से �कसी उपकरण के साथ इंटरै�ट करने क� अनमु�त देता है?

Ans 1. �ा�फ़कल यजूर इंटरफेस

2. �ा�फ़कल यजूर इं���शन

3. जनरल यजूर इं���शन

4. �ाउंड यजूर इंटरफेस
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Question Type : MCQ
Question ID : 6182781565

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.12 MS Excel म� सेल बॉड�र लगाने का �वक�प कहा ँ�मलता है?

Ans 1. Review → Font group → Borders

2. Insert → Font group → Borders

3. Home → Design group → Borders

4. Home → Font group → Borders

Question Type : MCQ
Question ID : 6182781603

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.13 कंपाइलस� _______ �पांत�रत करता है।
Ans 1. हाई लेवल ल��वेज को मशीन कोड म�

2. अस�बल� लेवल ल��वेज को हाई लेवल ल��वेज म�

3. हाई लेवल ल��वेज को अस�बल� लेवल ल��वेज म�

4. मशीन कोड को हाई लेवल ल��वेज म�

Question Type : MCQ
Question ID : 6182781569

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.14 वह �य,ू िजसम� वड� डॉ�यमू�ट कं�यटूर क� ���न पर उस �कार �दखाई देता है, िजस �कार पेज चौड़ाई, टे��ट
ि�थ�त और फ़ॉम�ट म� डॉ�यमू�ट �ाउज़र म� �दखाई देगा, वह �या कहलाता है?

Ans 1. आउटलाइन �यू

2. ��टं लेआउट �यू

3. �ा�ट �यू

4. वेब लेआउट �यू

Question Type : MCQ
Question ID : 6182781581

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.15 आप 19-12-2019 को MS Excel वक� शीट म� फ़ं�शन "=TODAY()" डाल�। जब आप अगले �दन वक� शीट
खोल�गे, तो आउटपटु �या होगा?

Ans 1. 19-12-2019

2. 19-12-2020

3. 19-11-2019
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4. 20-12-2019

Question Type : MCQ
Question ID : 6182781596

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.16 _____ म� मेल मज� के �लए एनवेलप एक �डफ़ॉ�ट द�तावेज़ �कार नह�ं है?

Ans 1. MS Excel

2. MS Word

3. MS Access

4. MS PowerPoint

Question Type : MCQ
Question ID : 6182781586

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.17 आप Windows XP म� एक नया फ़ो�डर कैसे बनात ेह�?
Ans 1. Double click on empty area → New → Folder

2. Right click on empty area → Create → Folder

3. Left click on empty area → New → Folder

4. Right click on empty area → New → Folder

Question Type : MCQ
Question ID : 6182781573

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.18 एि�टव-ए�स (ActiveX) ______ �वारा श�ु क� गई एक तकनीक है।
Ans 1. माइ�ोसॉ�ट

2. आईबीएम (IBM)

3. इंटेल

4. सन माइ�ो�स�ट�स

Question Type : MCQ
Question ID : 6182781620

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.19 कं�यटूर के भौ�तक उपकरण� को �या कहा जाता है?

Ans 1. पकेैज

2. हाड�वेयर

3. सा�टवेयर
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4. �स�टम सॉ�टवेयर

Question Type : MCQ
Question ID : 6182781566

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.20 सॉ�टवेयर पकेैज �ो�ाम का वह समहू है जो _______ का समाधान करता है।
Ans 1. �व�श�ट सम�या या काय� (Specific problem or job)

2. हाड�वेयर क� सम�याएं (Hardware problems)

3. नेटव�क� ग कने�शन सम�याएं (Networking connection problems)

4. ऑपरे�टगं �स�टम क� सम�याएं (Operating system problems)

Question Type : MCQ
Question ID : 6182781567

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.21 लेआउ�स, �रबन म� _______ टैब के अदंर मौजदू होता है।
Ans 1. �डजाइन

2. इ�सट�

3. होम

4. ऐनीमेशन

Question Type : MCQ
Question ID : 6182781614

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.22 चय�नत अ�र को सबि���ट बनाने के �लए शॉट�कट कंुजी �या है?

Ans 1. Ctrl + =

2. Alt + S

3. Ctrl + Sb

4. Alt + =

Question Type : MCQ
Question ID : 6182781589

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.23 MS Word म� आउटलाइन �य ू�या है?

Ans 1. यह �य,ू द�तावेज़ क� संरचना को हे�डगं के ने�टेड �तर म� �द�श�त करता है

2. यह �य ूकेवल बॉडी टे��ट को �द�श�त करता है

3. यह �य,ू द�तावेज़ को हे�डगं और बॉडी टे��ट के �सगंल लेवल म� �द�श�त करता है
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4. कंट�ट को बलेुटेड पॉइं�स के �प म� �दखाया जाता है

Question Type : MCQ
Question ID : 6182781576

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.24 व�ड� वाइड वेब का आ�व�कार �कसने �कया था?
Ans 1. �टम बन�स� - ल�

2. अले�ज�डर �ाहम बेल

3. जोएल �टेनल� एंगेल

4. मा�ट�न कूपर

Question Type : MCQ
Question ID : 6182781616

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.25 मेल मज�र �वक�प MS Word द�तावेज़ के ____ टैब म� मौजदू होता है।
Ans 1. मे�ल�ंस

2. इ�सट�

3. �यू

4. होम

Question Type : MCQ
Question ID : 6182781587

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.26 वॉन �यमूनै कं�यटूर �स�टम म� इनम� से �कसका उपयोग होता है?

Ans 1. कोई �ो�ाम नह�ं (No Program)

2. उपयोगकता� से �ा�त �ो�ाम आउटपटु (Program output from the user)

3. सं�ह�त �ो�ाम �स�ांत (Stored Program Principle)

4. उपयोगकता� से �ा�त �ो�ाम इनपटु (Program input from the user)

Question Type : MCQ
Question ID : 6182781561

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.27 MS Power point 2016 म�, �न�न�ल�खत म� से कौन पे�ट �ॉपडाउन सचूी के तहत एक वधै �वक�प नह�ं है?

Ans 1. �प�चर (Picture)

2. क�प सोस� फॉम��टगं (Keep Source Formatting)

3. यज़ू �य ूफॉम��टगं (Use new formatting)
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4. यज़ू डिे�टनेशन थीम (Use destination theme)

Question Type : MCQ
Question ID : 6182781611

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.28 �न�न�ल�खत म� से �क़सम� कं�यटूर� के बीच नेटव�क� ग क� स�ुवधा मौजदू नह�ं है?

Ans 1. Windows 3.1

2. Windows 10

3. Windows XP

4. Windows 8

Question Type : MCQ
Question ID : 6182781572

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.29 �न�न�ल�खत म� से कौन सचूना �थायी �प से �टोर कर सकता है?

Ans 1. SRAM

2. DRAM

3. ROM

4. Cache memory

Question Type : MCQ
Question ID : 6182781562

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.30 MS Word म� इंड�ट के परैा�ाफ को बढ़ाने के �लए शॉट� कट कंुजी कौन सी है?

Ans 1. Ctrl + M

2. Shift + Alt + V

3. Alt + C

4. Shift + C

Question Type : MCQ
Question ID : 6182781577

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.31 �न�न�ल�खत म� से कौन सा पेज मािज�न का एक �कार है?

Ans 1. शीष� (Top)

2. म�य (Center)

3. �वकण� (Diagonal)

4. कोने (Corner)
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Question Type : MCQ
Question ID : 6182781580

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.32 आप Excel वक� शीट म� तीन कॉलम म� कुछ शीष�क बनाना चाहत ेह�। आप ऐसा कैसे कर सकत ेह�?
Ans 1. तीन �मागत से�स को सेले�ट करके �फर मज� से�स �वक�प चनु�

2. एक 1x3 टेबल इ�सट� कर�

3. उन से�स से ��डलाइंस हटाएं

4. सबसे दा� ओर के दो से�स �डल�ट कर�

Question Type : MCQ
Question ID : 6182781595

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.33 DSL का पणू� �प �या है?

Ans 1. �डिजटल �ट�डड� लाइन

2. �डिजटल �टै�टक लाइन

3. डटेा स�स�ाइबर लाइन

4. �डिजटल स�स�ाइबर लाइन

Question Type : MCQ
Question ID : 6182781617

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.34 MS Word म� टे��ट-�टाइ�लगं फ�चर को �या कहा जाता है?

Ans 1. वड�साइज़

2. वड�फ़ॉटं

3. वड�कलर

4. वड�आट�

Question Type : MCQ
Question ID : 6182781578

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.35 �न�न�ल�खत म� से कौन सा कं�यटूर बस नह� ंहै?

Ans 1. ए�से बस

2. डाटा बस

3. कं�ोल बस

4. टाइमर बस
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Question Type : MCQ
Question ID : 6182781574

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.36 �न�न�ल�खत म� से कौन सी पणू�तया ऑ�जे�ट ओ�रएंटेड कं�यटूर ल��वेज है?

Ans 1. MS-Office

2. CSS

3. C++

4. HTML

Question Type : MCQ
Question ID : 6182781568

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.37 आम तौर पर, ड�ेकटॉप पर आइकन जो �कसी फ़ाइल या फ़ो�डर म� र�डायरे�ट करता है, उसे ______ कहा
जाता है।

Ans 1. शाट� कट

2. फ़ो�डर

3. डायरे�टर�

4. फ़ाइल

Question Type : MCQ
Question ID : 6182781570

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.38 पाई चाट� केवल __________ �द�श�त कर सकता ह�।
Ans 1. डटेा क� दो �ृंखलाएं

2. डटेा क� एक �ृंखला

3. डटेा क� तीन �ृंखलाएं

4. डटेा क� एका�धक �ृंखलाएं

Question Type : MCQ
Question ID : 6182781608

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.39 �डफ़ॉ�ट �प से Excel Workbook 2016 म� �कतनी शीट होती ह�?
Ans 1. 4

2. 1

3. 2

4. 5
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Question Type : MCQ
Question ID : 6182781592

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.40 MS Excel 2016 म�, जब आप एक �वडंो को ि��लट करत ेह�, तो �वडंो �कतने पेन (pane) म� ि��लट होती है?

Ans 1. चार

2. दो या चार

3. दो

4. तीन

Question Type : MCQ
Question ID : 6182781593

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.41 डायलअप �व�ध का उपयोग ______ आपस म� जोड़ने के �लए �कया जाता है।
Ans 1. इनपटु एंड आउटपटु �डवाइस

2. लॉिजक स�क� �स

3. टू �रमोट क��यटूस�

4. कं�यटूर एंड ��टंर

Question Type : MCQ
Question ID : 6182781563

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.42 कॉलम B और C के बीच तीन कॉलम ��व�ट करने के �लए आप _____ को सेले�ट कर�ग�।
Ans 1. कॉलम C

2. कॉल�स C, D और E

3. कॉलम B

4. कॉल�स B, C और D

Question Type : MCQ
Question ID : 6182781590

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.43 MS Word डॉ�यमू�ट म� टेबल �कस �कार इ�सट� �कया जाता है?

Ans 1. Blank Page → Insert → Table

2. Insert → Home → Table

3. Insert → Table

4. Insert → Blank Page → Table
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Question Type : MCQ
Question ID : 6182781584

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.44 फॉम��टगं को बदले �बना एक सेल के फॉमू�ला को दसूरे सेल म� कैसे कॉपी कर�?
Ans 1. Right Click on cell which contains formula → select copy → Right Click on cell

where formula to be copied → select Paste value.

2. Right Click on cell which contains formula → select copy → Right Click on cell
where formula to be copied → select Paste formatting.

3. Right Click on cell which contains formula → select copy → Right Click on cell
where formula to be copied → select Paste Transpose.

4. Right Click on cell which contains formula → select copy → Right Click on cell
where formula to be copied → select Paste formula.

Question Type : MCQ
Question ID : 6182781606

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.45 MS PowerPoint 2016 म�, आप �ट�प�णय� (Comments) के फलक को ______ मेन ूसे �दखाई दे सकते
ह�।

Ans 1. होम

2. �यू

3. �डज़ाइन

4. �र�यु

Question Type : MCQ
Question ID : 6182781615

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.46 MS Excel 2016 म�, 'SmartArt', �रबन म� �कस टैब के अतंग�त मौजदू होता है?

Ans 1. फ़ॉ�यू�ला टैब

2. �य ूटैब

3. होम टैब

4. इ�सट� टैब

Question Type : MCQ
Question ID : 6182781609

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.47 आप से�स क� एक �ृंखला को जोड़ना और �फर इसे सेल ��वि�टय� क� सं�या से �वभािजत करना चाहत ेह�,
इस �कार उस �ृंखला के सभी मान� का औसत मान �ा�त होता है। इसके �लए �कस फ़ं�शन का उपयोग �कया
जाना चा�हए?

Ans 1. MIN
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2. COUNT

3. MAX

4. AVERAGE

Question Type : MCQ
Question ID : 6182781605

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.48 �डल�ट क� गई फ़ाइल, िजसे र�सायकल �बन म� सं�ह�त �कया गया हो, उसे ______ ।
Ans 1. र��टोर �कया जा सकता है

2. उपयोग नह�ं �कया जा सकता है

3. र��टोर नह�ं �कया जा सकता है

4. �डल�ट नह�ं �कया जा सकता है

Question Type : MCQ
Question ID : 6182781571

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.49 मौजदूा MS Word डॉ�यमू�ट को कैसे सहेजा जाता है?

Ans 1. View → Save

2. Insert → Save

3. Home → Save

4. File → Save

Question Type : MCQ
Question ID : 6182781579

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.50 �ाइंग, म�ु�त पा�य या अ�य छ�वय� को �डिजटल �प म� प�रव�त�त करने वाला �कैनर एक _________ होता
है।

Ans 1. चुंबक-संवेदनशील उपकरण (magnetic sensitive device)

2. �काश-संवेदनशील उपकरण (light sensitive device)

3. तापमान-संवेदनशील उपकरण (temperature sensitive device)

4. ताप-संवेदनशील उपकरण (heat sensitive device)

Question Type : MCQ
Question ID : 6182781564

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.51 इंटरनेट पर �कसी कं�यटूर क� पहचान इसके ______ �वारा क� जाती है।
Ans 1. सी�रयल नंबर
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2. IP ए�से

3. ई-मेल ए�से

4. जी-मेल ए�से

Question Type : MCQ
Question ID : 6182781619

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.52 Excel क� कौन सी स�ुवधा, �वचा�लत �प से �कसी अ�य सेल या र�ज के डटेा से से�स को भरती है या डटेा
�ृंखला को परूा करती है?

Ans 1. डाटा �फ़ल

2. र�ज �फ़ल

3. ऑटो �फ़ल

4. कं�ल�ट �फ़ल

Question Type : MCQ
Question ID : 6182781602

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.53 �कसी वक� शीट म� सेले�ट क� गई सेल को अ�धकतम _____ तक ज़मू �कया जा सकता है।
Ans 1. 4

2. 2

3. 3

4. 1

Question Type : MCQ
Question ID : 6182781601

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.54 TCP का पणू� �प �या है?

Ans 1. �ांस�मशन कं�ोल �ोटोकॉल

2. टे��ट कं�ोल �ोटोकॉल

3. �ाई�टेट कं�ोल �ोटोकॉल

4. टाइ�मगं कं�ोल �ोटोकॉल

Question Type : MCQ
Question ID : 6182781618

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.55 �न�न�ल�खत म� से कौन सा ए�सेल �वडंो के शीष� के पास ि�थत वह बार है, जहां आप सेल ��वि�टया ँदज� या
ए�डट कर सकत ेह�?
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Ans 1. फ़ॉ�यू�ला बार

2. सेल पॉइंटर

3. कॉलम माक� र

4. �फ़ल ह�डल

Question Type : MCQ
Question ID : 6182781598

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.56 ि��लट �वडंो को �वभािजत करने या हटाने के �लए शॉट� कट कंुजी �या है?

Ans 1. Ctrl + S

2. Alt + S

3. Shift + Ctrl + S

4. Alt + Ctrl + S

Question Type : MCQ
Question ID : 6182781575

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.57 MS Word 2016 म�, मेल मज� �टाट� करने के �लए एनवेलप कैसे बनाया जाता है?

Ans 1. Mailings → Start Mail Merge → Ok

2. Mailings → Start Mail Merge → Select size → Ok

3. Mailings → Start Mail Merge → Envelope → Select size → Ok

4. Start Mail Merge → Envelope → Select size → Ok

Question Type : MCQ
Question ID : 6182781585

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.58 स�ू "=TIME(2,23,34)" का आउटपटु �या होगा?
Ans 1. 14:23 AM

2. 0.599305555555556

3. 0.0993055555555555

4. 14:23 PM

Question Type : MCQ
Question ID : 6182781597

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.59 �न�न�ल�खत म� से कौन सा एक पंि�त (ROW) और �तंभ (COLUMN) का ��त�छेदन होता है?

Ans 1. tab
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2. bar chart

3. cell

4. range

Question Type : MCQ
Question ID : 6182781600

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.60 MS Excel 2016 म�, AutoShape, �रबन म� �कस टैब के अतंग�त मौजदू होता है?

Ans 1. �य ूटैब

2. होम टैब

3. फ़ॉ�यू�ला टैब

4. इ�सट� टैब

Question Type : MCQ
Question ID : 6182781610

Status : Answered
Chosen Option : 1

Marks : 0.00
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Q.1 �न�न�ल�खत म� से कौन सी इंटरनेट सेवा समान अपलोड और डाउनलोड ग�त �दान करता है?

Ans 1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 6182781797

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.2 वक� बकु और वक� शीट क� सरु�ा के संबंध म� �न�न�ल�खत म� से कौन सा कथन अस�य है?

Ans 1. वक� बकु संरचना सरु�ा भी उपल�ध है।

2. वक� शीट और वक� बकु दोन� के �लए सरु�ा उपल�ध है।

3. सरु�ा के �लए, पासवड� सरु�ा उपल�ध है।

4. आप वक� बकु क� सरु�ा नह�ं कर सकत,े केवल वक� शीट क� सरु�ा उपल�ध है।

Question Type : MCQ
Question ID : 6182781784

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.3 �कसी वक� शीट म�, �कसी �तंभ क� साम�ी को �कसी अन�ुम या �म म� �यवि�थत करने क� ���या को
______ के �प म� जाना जाता है।

Ans 1. अर�िज़ंग

2. सॉ�ट�ग

3. ऑटो �फ़ल

Participant ID 19446797
Participant Name MAMTA VERMA
Test Center Name iON Digital Zone iDZ 2 Patliputra
Test Date 22/12/2019
Test Time 3:00 PM - 4:00 PM
Subject Data Entry Operator
Marks Obtained 0.00000

Section : MCQ for Data Entry Operator
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4. �फ़�ट�रगं

Question Type : MCQ
Question ID : 6182781780

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.4 �डफ़ॉ�ट �स�टम �ाइव कौन सा है जहां �वडंोज �था�पत होत ेह�?
Ans 1. B

2. E

3. C

4. D

Question Type : MCQ
Question ID : 6182781754

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.5 Microsoft Word म�, �लर और टूलबार के नीचे के खलेु �े� को ______ के �प म� जाना जाता है।
Ans 1. खोज �े�

2. टाइ�पगं �े�

3. �डल�ट �े�

4. �बंधन �े�

Question Type : MCQ
Question ID : 6182781757

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.6 ______ फ़ं�शन, एक पंि�त म� मौजदू डटेा को �तंभ म� या �तंभ म� मौजदू डटेा को पंि�त म� �द�श�त करता है।
Ans 1. हाइपर�लकं

2. पंि�त

3. �ां�पोज़

4. इंड�ेस

Question Type : MCQ
Question ID : 6182781778

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.7 हाड� �ाइव से �डल�ट �कया गया डटेा कहाँ �थानांत�रत होता है?

Ans 1. र�साइकल �बन

2. डाउनलोड

3. माय डॉ�यमू�ट
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4. एड�मन

Question Type : MCQ
Question ID : 6182781750

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.8 ______ TCP/IP सपो�ट�ग वेब �ाउज़र� और सव�र ��त��याओ ंपर संचा�लत मानक अन�ुयोग �ोटोकॉल है।
Ans 1. हाइपरटे��ट �ांसफ़र �ोटोकॉल

2. VOIP

3. इंटरनेट �ोटोकॉल

4. टेलनेट

Question Type : MCQ
Question ID : 6182781800

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.9 वक� शीट के सं�ह को ______ के �प म� जाना जाता है।
Ans 1. वक�  बकु

2. वक�  �ुप

3. वक�  पेज

4. वक�  डायर�

Question Type : MCQ
Question ID : 6182781770

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.10 Microsoft Word म� द�तावेज़ के उपयोग क� अनमु�त को ��तबं�धत करने के �लए �कस टैब का उपयोग
�कया जाता है?

Ans 1. इ�सट�

2. र��यू

3. �यू

4. होम

Question Type : MCQ
Question ID : 6182781759

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.11 Microsoft Word म� �कतने ��ॉल बार होत ेह�?
Ans 1. 2

2. 4

3. 1
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4. 3

Question Type : MCQ
Question ID : 6182781758

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.12 �न�न�ल�खत म� से कौन सा एक सेल से दसूरे सेल म� फ़ॉ�यू�ला कॉपी करने के �लए �य�ुत एक �वक�प है?

Ans 1. Ctrl F + Ctrl R

2. Ctrl + C and Ctrl + N

3. Alt F + Alt C

4. माउस क� मदद से �गै करे

Question Type : MCQ
Question ID : 6182781786

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.13 अपने �ो�ाम से एक मौजदूा फ़ाइल खोलने के �लए शाट� कट क� �या है?

Ans 1. Ctrl + O

2. Ctrl + P

3. Ctrl + N

4. Ctrl + V

Question Type : MCQ
Question ID : 6182781753

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.14 �न�न�ल�खत म� से कौन सी ऑटो श�ेस (Auto Shapes) क� �ेणी नह� ंहै?

Ans 1. वड�आट�

2. बे�सक अलाउज़

3. लाइ�स

4. बे�सक श�ेस

Question Type : MCQ
Question ID : 6182781790

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.15 �कसी �ेज�टेशन म� �लाइ�स बनाने के �लए �कस मेन ूम� �वशषे �भाव� का उपयोग �कया जाता है?

Ans 1. इफ़े��स

2. मा�टर �लाइड

3. �ांजीश�स
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4. एनोटेशंस

Question Type : MCQ
Question ID : 6182781792

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.16 इंटरनेट कने�शन से�यलूर टावर� से आपके इंटरनेट �डवाइस पर �सा�रत �कया जाता है। इस�लए, य�द
______ कह�ं भी उपल�ध है, तो इसका अथ� है �क उस �व�श�ट से�यलूर �दाता का �स�नल मौजदू है।

Ans 1. DSL इंटरनेट

2. मोबाइल इंटरनेट

3. केबल इंटरनेट

4. सटेैलाइट इंटरनेट

Question Type : MCQ
Question ID : 6182781796

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.17 �न�न�ल�खत म� से �कसका उपयोग एक �श�थल यिु�मत म�ट��ोसेसर �णाल� (loosely coupled
multiprocessor system) म� �कया जाता है?

Ans 1. �ड����यटेूड मेमोर�

2. शयेड� मेमोर�

3. �सगंल मेमोर�

4. सी�व�स मेमोर�

Question Type : MCQ
Question ID : 6182781742

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.18 �वडंोज़ अपडटे कहाँ उपल�ध होत ेह�?
Ans 1. �डवाइस एंड ��टंस�

2. हे�प एंड सपोट�

3. �स�टम एंड �स�यो�रट�

4. �डफॉ�ट �ो�ा�स

Question Type : MCQ
Question ID : 6182781752

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.19 Microsoft Word म�, नॉम�ल �य ूम�, �कस �कार का �लर �दखाई दे सकता है?

Ans 1. �ै�तज़ (Horizontal)

2. �ै�तज और ऊ�वा�धर दोन� (Both horizontal and vertical)
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3. नीचे (Down)

4. ऊ�वा�धर (Vertical)

Question Type : MCQ
Question ID : 6182781756

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.20 �कसी वक� शीट म�, �कस मेन ूका उपयोग म�ैो को रन या एि�ज़�यटू करने के �लए �कया जाता है?

Ans 1. फ़ॉम�ट

2. डाटा

3. डवेलपर

4. इ�सट�

Question Type : MCQ
Question ID : 6182781773

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.21 ��ेडशीट म� पंि�त और �तंभ� का आकार बदलने के �लए �कस टैब का उपयोग �कया जाता है?

Ans 1. �यू

2. र��यू

3. इ�सट�

4. होम

Question Type : MCQ
Question ID : 6182781771

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.22 MS Word म� वत�मान �दनांक को सि�म�लत करने के �लए �न�न�ल�खत म� से �कस शॉट�कट कंुजी का
उपयोग �कया जाता है?

Ans 1. Shift + D

2. Ctrl + D

3. Alt + D

4. Alt + Shift + D

Question Type : MCQ
Question ID : 6182781761

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.23 MS Excel 2016 म� �कस मेन ूम� शयेर वक� बकु �वक�प है?

Ans 1. View

2. Data
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3. Formulas

4. Review

Question Type : MCQ
Question ID : 6182781783

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.24 ��ेडशीट म�, एक कॉलम को सेले�ट करने का सबसे आसान तर�का �या है?

Ans 1. कॉलम लेबल पर ि�लक कर�

2. कॉलम म� �कसी भी सेल पर डबल ि�लक कर�

3. कॉलम म� शीष� सेल से श�ु करके अ�ंतम सेल तक �गै कर�

4. कॉलम शीष�क पर ि�लक कर�

Question Type : MCQ
Question ID : 6182781772

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.25 पायथन भाषा �कस वष� म� जार� क� गई थी?
Ans 1. 1999 म�

2. 1975 म�

3. 1991 म�

4. 1890 म�

Question Type : MCQ
Question ID : 6182781748

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.26 �न�न�ल�खत म� से �कस द�तावेज़ म� मेल मज� �वक�प मौजदू होता है?

Ans 1. म�ुय द�तावेज़ (Main document)

2. पता द�तावेज़ (Address document)

3. �नयं�ण द�तावेज़ (Control document)

4. मा�टर लेटर (Master letter)

Question Type : MCQ
Question ID : 6182781767

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.27 पॉवरपॉइंट �ेज�टेशन म�, �लाइड शो मेन ूका कौन सा �वक�प ��येक �लाइड के �लए समय �नधा�रण से
संबं�धत है?

Ans 1. From beginning

2. Hide slide
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3. From current slide

4. Rehearse timing

Question Type : MCQ
Question ID : 6182781795

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.28 MS Word म� टेबल म� �तंभ �वराम (कॉलम �ेक) के �लए �न�न�ल�खत म� से �कन कंुिजय� का उपयोग �कया
जाता है?

Ans 1. Alt + Shift + Enter

2. Shift + Tab + Enter

3. Ctrl + Tab + Enter

4. Ctrl + Shift + Enter

Question Type : MCQ
Question ID : 6182781764

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.29 वक� शीट म�, पंि�तय� को इनम� से �कस �टाइल म� लेबल �कया जाता है?

Ans 1. A, B, C, etc

2. $A$1, $A$2, $A$3, etc

3. A1, A2, A3, etc

4. 1, 2, 3, 4, etc

Question Type : MCQ
Question ID : 6182781781

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.30 MS Excel म� वत�मान �दनांक और समय को �द�श�त करने के �लए �कस स�ू का उपयोग �कया जाता है?

Ans 1. "=now()"

2. "=datetime()"

3. "=enter()"

4. "=current()"

Question Type : MCQ
Question ID : 6182781787

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.31 �न�न�ल�खत म� से कौन सा आपके �स�टम म� इं�टाल �कए गए �ो�ाम� क� सचूी �द�श�त करता है?

Ans 1. माय �प�चस�

2. र�स�ट फ़ाइ�स
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3. ऑल �ो�ा�स

4. डॉ�यमू��स

Question Type : MCQ
Question ID : 6182781751

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.32 MS Excel 2016 वक� शीट म�, �कस �कार के पा�य संरेखण (text alignment) को �न�द��ट नह�ं �कया गया
है?

Ans 1. दाएँ संरे�खत (Align right)

2. क� � संरे�खत (Align centre)

3. �वकण�तः संरे�खत (Align diagonally)

4. बाएँ संरे�खत (Align left)

Question Type : MCQ
Question ID : 6182781774

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.33 मेल मज� म� �न�न�ल�खत म� से कौन सा द�तावेज़ नह�ं बदलता है?

Ans 1. �नयं�ण द�तावेज़ (Control document)

2. म�ुय द�तावेज़ (Main document)

3. पता द�तावेज़ (Address document)

4. मा�टर लेटर (Master letter)

Question Type : MCQ
Question ID : 6182781768

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.34 �न�न�ल�खत म� से �कस शॉट�कट कंुजी का उपयोग साम�ी को कॉपी करने के �लए �कया जाता है?

Ans 1. Ctrl + V

2. Ctrl + D

3. Ctrl + X

4. Ctrl + C

Question Type : MCQ
Question ID : 6182781760

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.35 अस�बलर म� �कतने पासेस होत ेह�?
Ans 1. 2

2. 6
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3. 4

4. 5

Question Type : MCQ
Question ID : 6182781749

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.36 �न�न�ल�खत म� से कौन सा एक सॉ�टवेयर नह�ं है?

Ans 1. ऑपरे�टगं �स�टम (Operating system)

2. आर�ण �णाल� (Reservation system)

3. वड� �ोसेसर (Word processor)

4. �ो�ा�मगं भाषा (Programming language)

Question Type : MCQ
Question ID : 6182781746

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.37 मेल मज� म� �न�न�ल�खत म� से कौन सा डटेा �ोत म� मौजदू स�ैपल डटेाबेस का पहला फ़��ड है?

Ans 1. फ�ट� नेम (First name)

2. आईडी (Id)

3. पो�टल कोड (Postal code)

4. शहर (City)

Question Type : MCQ
Question ID : 6182781769

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.38 डॉट म�ै��स ��टंर क� ग�त को ______ म� मापा जाता है।
Ans 1. Cps

2. Dpi

3. Ppm

4. Imp

Question Type : MCQ
Question ID : 6182781743

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.39 आप कॉलम क� चौड़ाई को साम�ी को �फ़ट करने के �लए बदलना चाहत ेह�। आप �न�न�ल�खत म� से कौन सा
�वक�प चनु�गे?

Ans 1. �तंभ शीष�क के दा� ओर क� सीमा पर डबल ि�लक कर�

2. �तंभ शीष�क के बा� ओर क� सीमा पर �सगंल-ि�लक कर�
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3. कॉलम म� कह�ं भी Alt दबाकर �सगंल ि�लक कर�

4. Alt + A दबाएँ और �फर पहले कॉलम क� सीमा पर ि�लक कर�

Question Type : MCQ
Question ID : 6182781775

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.40 वक� शीट म�, �न�न�ल�खत म� से कौन सी सेल �टाइल क� �ेणी नह�ं है?

Ans 1. कने�श�स

2. डटेा मॉड�स

3. सं�या �ा�प (Number format)

4. अ�छा, बरुा, तट�थ

Question Type : MCQ
Question ID : 6182781782

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.41 लेज़र जेट ��टंर म� इनम� से �कसका उपयोग नह�ं �कया जाता है?

Ans 1. एक फ़ोटो कंडि�टव �म

2. लेज़र बीम

3. ��टं हेड

4. टोनर का���ज

Question Type : MCQ
Question ID : 6182781745

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.42 पॉवरपॉइंट �ेज�टेशन म�, य�द आप एक नई �लाइड इ�सट� करना चाहत ेह�, तो �कस शॉट�कट का उपयोग �कया
जाएगा?

Ans 1. Ctrl + M

2. Ctrl + F

3. Ctrl + O

4. Ctrl + N

Question Type : MCQ
Question ID : 6182781791

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.43 एक �ो�ाम चलाने के दौरान �नद�श का अन�ुम ______ म� सं�ह�त होता है।
Ans 1. हाड� �ड�क
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2. एएलय ू(ALU)

3. रैम (RAM)

4. रिज�टर

Question Type : MCQ
Question ID : 6182781741

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.44 इंटरनेट ॲ��ेसगं म�, IP का परूा नाम �या है?

Ans 1. इनवस� �ोटोकॉल

2. आइड�ट��फ़केशन �ोटोकॉल

3. इंटरनेट पकेैज़

4. इंटरनेट �ोटोकॉल

Question Type : MCQ
Question ID : 6182781799

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.45 MS Word म� कस�र �बदं ुसे �पछले श�द को हटाने के �लए �न�न�ल�खत म� से �कस शॉट�कट कंुजी का उपयोग
�कया जाता है?

Ans 1. Ctrl + D

2. Ctrl + Backspace

3. Ctrl + Delete

4. Ctrl + B

Question Type : MCQ
Question ID : 6182781762

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.46 ______ म� �लाइड पर �दखाई देने वाल� सभी साम�ी के �लए फ़ॉम��टगं, पोज़ीश�नगं और �लेस हो�डर बॉ�स
शा�मल होत ेह�।

Ans 1. �ेज�ट ऑनलाइन

2. �लाइड शो

3. �ॉम द �बग�नगं

4. �लाइड लेआउट

Question Type : MCQ
Question ID : 6182781794

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.47 ए�सेल एि�लकेशन म�, �े�णय� के अनसुार म�ूय� क� तलुना करने के �लए �कस �कार के चाट� उपयोगी होते
ANKAJ INFOTECH
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ह�?
Ans 1. लाइन चाट�

2. बबल चाट�

3. कॉलम चाट�

4. �कैटर चाट�

Question Type : MCQ
Question ID : 6182781788

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.48 PowerPoint 2016 म�, "�फ़ट टू �वडंो" �कस मेन ूम� उपल�ध है?

Ans 1. फ़ाइल

2. �यू

3. �डज़ाइन

4. इ�सट�

Question Type : MCQ
Question ID : 6182781793

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.49 डज़ेी �ह�ल ��टंर का दसूरा नाम �या है?

Ans 1. गो�फ़ बॉल ��टंर

2. परेैलल ��टंर

3. 3D ��टंर

4. इंक जेट ��टंर

Question Type : MCQ
Question ID : 6182781744

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.50 SmartArt एमएस ए�सेल 2016 म� ___ मेन ूम� पाया जाता है?

Ans 1. र��यू

2. होम

3. फ़ॉ�यू�ला

4. इ�सट�

Question Type : MCQ
Question ID : 6182781789

Status : Not Answered
Chosen Option : --

Marks : 0.00
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Q.51 �कसी फ़ाइल को बंद करने के �लए �न�न�ल�खत म� से कौन सी शॉट� कट कंुजी का उपयोग �कया जाता है?

Ans 1. Ctrl + O

2. Ctrl + W

3. Ctrl + D

4. Ctrl + C

Question Type : MCQ
Question ID : 6182781755

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.52 MS Word 2016 म� मेल मज� �वज़ाड� म� �कतने चरण (�टेप) होत ेह�?
Ans 1. 6

2. 3

3. 4

4. 5

Question Type : MCQ
Question ID : 6182781765

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.53 MS Word म� �न�न�ल�खत म� से �कस शॉट�कट कंुजी का उपयोग च�ज �ै�कंग ऑन या ऑफ़ करने के �लए
�कया जाता है?

Ans 1. Ctrl + shift + C

2. Ctrl + shift + S

3. Ctrl + shift + E

4. Ctrl + shift + T

Question Type : MCQ
Question ID : 6182781763

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.54 एक ______ सॉ�टवेयर का एक �ह�सा है, जो कं�यटूर और इं�ानेट के अवां�छत यातायात को अव�� करता
है।

Ans 1. WWW

2. HTTP �ोटोकॉल

3. ि�वच

4. फ़ायरवाल

Question Type : MCQ
Question ID : 6182781798

Status : Not Answered
Chosen Option : --

Marks : 0.00
ANKAJ INFOTECH



1/28/2020 https://cdn3.digialm.com///per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S78D423/157701548612794…

https://cdn3.digialm.com///per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S78D423/15770154861279480/194467… 15/16

Q.55 एमएस ए�सेल 2016 म� होम टैब म� _____ समहू म� मज� एंड से�टर पाया जाता है।
Ans 1. Format

2. Alignment

3. Styles

4. Font

Question Type : MCQ
Question ID : 6182781777

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.56 �न�न�ल�खत म� से कौन सा मेल मज� �वज़ाड� का चरण नह�ं है?

Ans 1. Select recipient (�ा�तकता� चनु�)

2. Write your letter (अपना प� �लख�)

3. Select document type (द�तावेज़ �कार चनु�)

4. Select address (पता चनु�)

Question Type : MCQ
Question ID : 6182781766

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.57 �न�न�ल�खत म� से कौन सा कं�यटूर के आतं�रक संचालन को �नयं��त करता है?

Ans 1. ��त�ुत

2. ��ेडशीट

3. �स�टम सॉ�टवेयर

4. वड� �ोसेसर

Question Type : MCQ
Question ID : 6182781747

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.58 वक� शीट म�, �न�न�ल�खत म� से कौन सा सेल एं�� को परूा करने का तर�का नह�ं है?

Ans 1. फ़ॉ�यू�ला बार से एंटर बटन दबाकर

2. एंटर दबाकर

3. क�बोड� से �कसी भी तीर कंुजी (arrow key) दबाकर

4. �पेसबार दबाकर

Question Type : MCQ
Question ID : 6182781779

Status : Not Answered
Chosen Option : --

Marks : 0.00
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Q.59 ए�सेल �वडंो म�, कौन सा �े� मान और स�ू� (फ़ॉमू�लास) को दज� करने क� अनमु�त देता है?

Ans 1. फ़ॉ�यू�ला बार

2. मेन ूबार

3. टाइटल बार

4. �ट�डड� टूल बार

Question Type : MCQ
Question ID : 6182781785

Status : Not Answered
Chosen Option : --

Marks : 0.00

Q.60 ��ेडशीट म� सभी से�स का चयन करने के �लए शॉट� कट कंुजी �या है?

Ans 1. Ctrl + A

2. Space bar + A

3. Shift + A

4. Alt + A

Question Type : MCQ
Question ID : 6182781776

Status : Not Answered
Chosen Option : --

Marks : 0.00
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Q.1 आप �कसी एम एस वड� द�तावेज को �कस �कार सरु��त करत ेह�?
Ans 1. �र�य ूदेकर

2. ए�सेस देकर

3. परमीशन (अनमु�त) देकर

4. �रि���शन देकर

Question Type : MCQ
Question ID : 6182781699

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.2 माइ�ोसॉ�ट वड� 2016 म�, मेल मज� स�ुवधा �कस टैब म� मौजदू होती है?

Ans 1. लेटस� एंड मे�लगं

2. �डज़ाइन

3. होम

4. मे�ल�ंस

Question Type : MCQ
Question ID : 6182781705

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.3 MS PowerPoint 2016 म�, �डफ़ॉ�ट �प से, �लाइड लेआउट पनैल म� �कतने लेआउट उपल�ध होत ेह�?
Ans 1. 9

2. 12

3. 7

4. 4

Participant ID 19307213
Participant Name SUBHASH KUMAR
Test Center Name iON Digital Zone iDZ 2 Patliputra
Test Date 22/12/2019
Test Time 12:00 PM - 1:00 PM
Subject Data Entry Operator
Marks Obtained 7.00000

Section : MCQ for Data Entry Operator
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Question Type : MCQ
Question ID : 6182781734

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.4 MS Excel म� �न�न�ल�खत म� �कस टैब का �योग नए वक� शीट को इ�सट� करने के �लए �कया जाता है?

Ans 1. �यू

2. इ�सट�

3. लेआउट

4. होम

Question Type : MCQ
Question ID : 6182781710

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.5 C ल��वेज को �कस वष� �डज़ाइन �कया गया?
Ans 1. 1968 म�

2. 1970 म�

3. 1972 म�

4. 1978 म�

Question Type : MCQ
Question ID : 6182781688

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.6 एम एस वड� म�, �न�न�ल�खत म� से �कस शॉट�कट कंुजी का उपयोग ‘गो टू' फ़ं�शन के �लए �कया जाता है?

Ans 1. Ctrl+G

2. Ctrl+T

3. Ctrl+S

4. Ctrl+O

Question Type : MCQ
Question ID : 6182781703

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.7 �न�न�ल�खत म� से कौन-सा एक �स�टम मनेैजम�ट �ो�ाम है?

Ans 1. �लकंर

2. लोडर

3. �डवाइस �ाइवर

4. इमेज ऐ�डटर
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Question Type : MCQ
Question ID : 6182781687

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.8 �न�न�ल�खत म� से कौन-सा �वक�प �च�� क� सचूी �द�श�त करता है?

Ans 1. ऑल �ो�ा�स

2. �डवाइस �ाइवर

3. माय �प�चर

4. क��ोल पनैल

Question Type : MCQ
Question ID : 6182781691

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.9 �न�न�ल�खत म� से कौन-सा एक �कार का �माट�आट� �ा�फ़�स (SmartArt Graphics) नह�ं है?

Ans 1. �परा�मड

2. �ल�ट (सचूी)

3. ��वायर (वग�)

4. �ोसेस

Question Type : MCQ
Question ID : 6182781729

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.10 इंटरनेट पर, इले��ॉ�नक मेल स�व�स का उपयोग �कस �लए �कया जाता है?

Ans 1. इंटरनेट से जड़ु े�कसी दरू�थ कं�यटूर पर लॉग ऑन करने के �लए

2. इंटरनेट के मा�यम से इले��ॉ�नक संदेश� को भेजने के �लए

3. सॉ�टवेयर साझा करने के �लए इंटरनेट उपयोगकता�ओ ंके समहू �यवि�थत करने के �लए

4. परेू �व�व के लोग� को वा�त�वक समय म� स�मेलन (conference) करने क� अनमु�त देने के �लए

Question Type : MCQ
Question ID : 6182781740

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.11 हर एक सॉ�टवेयर फ़ाइल म� एक ________ फ़ाइल होती है।
Ans 1. .xls फाइल

2. .zip फाइल

3. .docx फाइल
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4. .exe फाइल

Question Type : MCQ
Question ID : 6182781694

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.12 इंटरनेट पर, वेब के हर प�ृठ का एक अ��वतीय पता होता है, िजसे य�ूनफ़ॉम� �रसोस� लोकेटर (URL) कहा जाता
है। URL यह इं�गत करता है �क इंटरनेट पर वेब पेज़ कहाँ सं�ह�त है। �न�न�ल�खत म� से कौन-सा आम तौर
पर URL का �ह�सा नह�ं है?

Ans 1. http

2. www

3. डोमेन नेम

4. IP पता (हे�स �ा�प म�)

Question Type : MCQ
Question ID : 6182781738

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.13 एक ��ेडशीट म� पाँच पंि�तयाँ ह�। पंि�त 3 को हटाने क� आव�यकता है। कस�र पंि�त 3 को इं�गत कर रहा है।
�न�न�ल�खत म� से कौन-सा �वक�प पंि�त को हटाने का एक तर�का है?

Ans 1. पंि�त म� �कसी भी सेल का चयन करने के �लए ि�लक कर� → Home → Delete → Delete
sheet rows

2. Edit → Delete row 3

3. Ctrl+A, और �फर �डल�ट

4. Edit → Column

Question Type : MCQ
Question ID : 6182781715

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.14 एमएस वड� म�, �न�न�ल�खत म� से कौन एक वधै �डफ़ॉ�ट पेपर आकार है?

Ans 1. P4

2. X2

3. A3

4. D5

Question Type : MCQ
Question ID : 6182781697

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.15 IPv6 ए��ेसगं अ�धकतम �कतने अ��वतीय पत� (य�ूनक ए�से) क� अनमु�त देती है?

Ans ANKAJ INFOTECH
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1. 216

2. 28

3. 2128

4. 232

Question Type : MCQ
Question ID : 6182781739

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.16 �लाइड क� डुि�लकेट बनाने के �लए शॉट� कट कंुजी �या है?

Ans 1. Ctrl + D

2. Ctrl + E

3. Ctrl + P

4. Ctrl + C

Question Type : MCQ
Question ID : 6182781732

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.17 वक� शीट को संशो�धत करने के संबंध म� �न�न�ल�खत म� से कौन सा कथन गलत है?

Ans 1. ‘Wrap text’ फ़ं�शन कॉलम क� चौड़ाई को बदल देता है।

2. वक� शीट म� हम ‘मज� एंड स�टर’ टैब से कॉलम मज� कर सकत ेह�।

3. ‘कंडीशनल फोम�ि�तंग’ टैब के साथ हम सेल का रंग बदल सकत ेह�।

4. ‘Wrap text’ फ़ं�शन पंि�त क� ऊँचाई को बदलता है।

Question Type : MCQ
Question ID : 6182781712

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.18 मेल मज� म�, डटेा �ोत म� डटेा को कैसे �नयोिजत �कया जाता है?

Ans 1. परैा�ाफ़

2. टेबल

3. चाट�

4. म�ै��स

Question Type : MCQ
Question ID : 6182781709

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00
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Q.19 �न�न�ल�खत म� से कौन-सा �वक�प �वडंो को अलग-अलग पनै म� �वभािजत करने क� सह� �व�ध है, िजनम� से
��येक अलग से ��ॉल करती है?

Ans 1. डटेा �लशै �फल

2. Format → Window

3. Insert → Slicer

4. View → Split

Question Type : MCQ
Question ID : 6182781718

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.20 ‘Home → Cells → Format → Visibility’ का उपयोग करके हम इनम� से कौन का काय� करने म� स�म
हो जात ेह�?

Ans 1. केवल पंि�तय� और कॉलम� को हाइड और अनहाइड करने म�

2. पंि�तय�, कॉलम� और शी�स को हाइड और अनहाइड करने म�

3. केवल कॉलम� और शी�स को हाइड और अनहाइड करने म�

4. केवल शी�स को हाइड और अनहाइड करने म�

Question Type : MCQ
Question ID : 6182781720

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.21 MS Excel 2016 म� �न�न�ल�खत म� से कौन-सा वक� बकु को सरु��त करने का एक तर�का है?

Ans 1. File → protect workbook → Encrypt with password

2. Home → Info → Manage Workbook

3. Home → Info → Inspect Workbook

4. Home → Publish → Manage Workbook

Question Type : MCQ
Question ID : 6182781716

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.22 य�द आप सभी �लाइड� को एक ���न पर देखना चाहत ेह�, तो �न�न�ल�खत म� से �कसका उपयोग कर�गे?

Ans 1. View → Slide Show

2. View → Slide

3. View → Slide Sorter

4. View → Master

Question Type : MCQ
Question ID : 6182781733

Status : Not Attempted and
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Marked For Review
Chosen Option : --

Marks : 0.00

Q.23 �न�न�ल�खत म� से कौन सा �वशषे �भाव� वाले टे��ट को बनाने के �लए एक �व�रत तर�का है?

Ans 1. वॉटरमाक�  (Watermark)

2. वड�आट� (WordArt)

3. बकुमाक�

4. �स�नेचर लाइन

Question Type : MCQ
Question ID : 6182781730

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.24 MS Excel म� �कस �कार का चाट� व�ृत के �प म� �दखता है?

Ans 1. Line chart

2. Bar chart

3. Column chart

4. Pie chart

Question Type : MCQ
Question ID : 6182781728

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.25 CAM is the abbreviation for:
Ans 1. Clear Area Memory

2. Clear Addressable Memory

3. Content Addressable Memory

4. Connect Address Memory

Question Type : MCQ
Question ID : 6182781681

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.26 एम एस वड� म�, �न�न�ल�खत म� से �कस शॉट�कट कंुजी का उपयोग ‘कॉपीराइट' फ़ं�शन के �लए �कया जाता
है?

Ans 1. Alt+C

2. Shift+C

3. Ctrl+C

4. Alt+Ctrl+C

Question Type : MCQ
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Question ID : 6182781701
Status : Answered

Chosen Option : 3
Marks : 0.00

Q.27 एमएस वड� 2016 का मेल मज� �वज़ाड� का उपयोग करके मेल मज� म� पहला कदम है:

Ans 1. Select Document Type

2. Select Version

3. Select Data

4. Select Rows

Question Type : MCQ
Question ID : 6182781708

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.28 आप उन से�स को हाईलाइट करना चाहत ेह� िजनके मान 100 से कम ह�। आप यह कैसे कर सकत ेह�?
Ans 1. रैप टे��ट

2. मज� �टाइल

3. कंडीशनल फ़ॉम��टगं

4. फाइंड एंड रे�लस

Question Type : MCQ
Question ID : 6182781722

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.29 _______ कंुजी �वडंोज़ XP म� खोज �वडंो लाएगी।
Ans 1. F3

2. F5

3. F7

4. F12

Question Type : MCQ
Question ID : 6182781692

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.30 एक वक� शीट म�, य�द आप कई कॉलम� को लेबल देना चाहत ेह�, तो ऐसा करने के �लए कौन-सा �वक�प
उपय�ुत है?

Ans 1. मेल मज�

2. मज� & स�टर

3. रैप टे��ट
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4. अनमज� से�स

Question Type : MCQ
Question ID : 6182781721

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.31 एम एस वड� म�, �न�न�ल�खत म� से �कस शॉट�कट कंुजी का उपयोग ‘ऑल कै�स' फ़ं�शन के �लए �कया जाता
है?

Ans 1. Ctrl+Shift+X

2. Ctrl+Shift+C

3. Ctrl+Shift+D

4. Ctrl+Shift+A

Question Type : MCQ
Question ID : 6182781702

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.32 पे�ट के �लए शॉट� कट क� �या है?

Ans 1. Shift + P

2. Ctrl + P

3. Alt + V

4. Ctrl + V

Question Type : MCQ
Question ID : 6182781706

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.33 ��टं करत ेसमय �न�न�ल�खत म� से कौन-सा �वक�प द�तावेज़ के �ती�ा समय को कम करता है?

Ans 1. ए�डशनल �ाइवर

2. ��टंर प�ूलगं

3. ��टंर शये�रगं

4. ��टंर पॉट�

Question Type : MCQ
Question ID : 6182781685

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.34 �न�न�ल�खत म� से कौन-सा एक सेल से दसूरे सेल म� फ़ॉमू�ला कॉपी करने का तर�का नह�ं है?

Ans 1. Home → Copy → Paste

2. Ctrl+C और �फर Ctrl+V
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3. माउस क� मदद से �गै करना |

4. Ctrl+M और �फर Ctrl+N

Question Type : MCQ
Question ID : 6182781726

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.35 लेजर जेट ��टंर क� ग�त �कसके �वारा मापी जाती है?

Ans 1. PPM

2. DPS

3. LMP

4. DPL

Question Type : MCQ
Question ID : 6182781683

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.36 �कसी फ़ो�डर क� लोकेशन (ि�थ�त) देखने के �लए �न�न�ल�खत म� से �कसका उपयोग �कया जाता है?

Ans 1. �डवाइस �ाइवर

2. ए�से बार

3. क��ोल पनैल

4. टा�कबार

Question Type : MCQ
Question ID : 6182781693

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.37 �दए गए ग�णत और ��कोण�मतीय फ़ं�शन� (math and trig functions) म� से, �कस फ़ं�शन के
प�रणाम�व�प �कसी सं�या का गुणनखंड (factorial) �ा�त होता है?

Ans 1. EXP

2. GSD

3. FACT

4. INT

Question Type : MCQ
Question ID : 6182781727

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.38 �न�न�ल�खत म� से �कसक� इंटरनेट क� ग�त सबसे तज़े है?

Ans 1. VSAT
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2. DSL

3. ऑि�टकल फाइबर

4. डायल-अप

Question Type : MCQ
Question ID : 6182781736

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.39 वक� शीट और वक� बकु सरु�ा के संबंध म� �न�न�ल�खत म� से कौन-सा कथन सह� है?

Ans 1. केवल वक� बकु के �लए सरु�ा उपल�ध है|

2. वक� शीट और वक� बकु दोन� के �लए सरु�ा उपल�ध है|

3. कोई सरु�ा उपल�ध नह�ं है|

4. केवल वक� शीट के �लए सरु�ा उपल�ध है|

Question Type : MCQ
Question ID : 6182781724

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.40 ��ेडशीट का कौन सा त�व डटेा �व�लेषण के �लए उपयोग �कया जाता है?

Ans 1. ऑटो श�ेस

2. �माट� आट�

3. वड� आट�

4. �पवट टेबल

Question Type : MCQ
Question ID : 6182781711

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.41 क�बोड� क� �न�न�ल�खत म� से �कस कंुजी का उपयोग �लाइड शो देखने के �लए �कया जाता है?

Ans 1. F1

2. F2

3. F5

4. F10

Question Type : MCQ
Question ID : 6182781735

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.42 रैम �कतने म�ुय �कार के होत ेह�?
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Ans 1. 3

2. 4

3. 2

4. 5

Question Type : MCQ
Question ID : 6182781682

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.43 एम एस वड� म�, �न�न�ल�खत म� से �कस शॉट�कट कंुजी का उपयोग 'कट क�टे�ट' फ़ं�शन के �लए �कया जाता
है?

Ans 1. Ctrl+V

2. Ctrl+X

3. Ctrl+C

4. Ctrl+D

Question Type : MCQ
Question ID : 6182781700

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.44 �कसी �ेज़�टेशन म� नई �लाइड बनाने के �लए �कन शॉट�कट कंुिजय� का �योग �कया जाता है?

Ans 1. Ctrl+N

2. Alt+M

3. Alt+N

4. Ctrl+M

Question Type : MCQ
Question ID : 6182781731

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.45 एम एस वड� म�, �न�न�ल�खत म� से कौन-सा �ै�तज और ऊ�वा�धर �के�स �द�श�त करता है, जो आपके
टाइ�पगं ए�रया क� चौड़ाई और ऊँचाई को दशा�ता है?

Ans 1. मेन ूबार

2. शाट�कट मेनज़ु

3. �लर

4. टूलबार

Question Type : MCQ
Question ID : 6182781696

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00
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Q.46 �न�न�ल�खत म� से �कस शॉट�कट कंुजी का उपयोग ���ंटगं के �लए �कया जाता है?

Ans 1. Ctrl+R

2. Ctrl+A

3. Ctrl+P

4. Ctrl+T

Question Type : MCQ
Question ID : 6182781695

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.47 मे�लगं म� कौन-सा फ़ॉम�ट डटेा �ोत सहेजा जाता है?

Ans 1. .xl

2. .doc

3. .pdf

4. .mdb

Question Type : MCQ
Question ID : 6182781707

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.48 एमएस वड� के �न�न�ल�खत म� से �कस �य ुम� आप अलग पेज नह�ं देख सकत ेह�?
Ans 1. Print Layout

2. Web Layout

3. Split Layout

4. Multi Layout

Question Type : MCQ
Question ID : 6182781698

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.49 फ़ॉमू�ला मेन ूम� 'इ�सट� फ़ं�शन' के �लए �कस �तीक का उपयोग �कया जाता है?

Ans 1. fb

2. if

3. fx

4. fc

Question Type : MCQ
Question ID : 6182781725

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00
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Q.50 य�द �व�श�ट साम�ी �ा�प वाल� वक� शीट बनाई गई है और आप उसी साम�ी �ा�प (जसेै फ़ॉ�ट आकार, फ़ॉ�ट
रंग आ�द) वाला एक और वक� शीट चाहत ेह�, तो कम से कम �यास से यह कैसे �कया जा सकता है?

Ans 1. रैप टे��ट का उपयोग करके

2. मज� एंड से�टर �टाइ�स का उपयोग करके

3. सशत� फ़ॉम��टगं का उपयोग करके

4. फ़ॉम�ट प�टर टूल का उपयोग करके

Question Type : MCQ
Question ID : 6182781713

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.51 ‘Protect Workbook’ मेन ूसे कौन सा �वक�प वक� बकु क� संरचना म� अवां�छत प�रवत�न (जसेै �क शीट
जोड़ना) को रोकने के �लए उपयोग �कया जाता है?

Ans 1. �ोटे�ट वक� बकु ���चर

2. �ोटे�ट कर�ट शीट

3. ऐड �डिज़टल �स�नेचर

4. इि���ट �वद पासवड�

Question Type : MCQ
Question ID : 6182781717

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.52 �न�न�ल�खत म� से कौन-सा म�यवत� ऑ�जे�ट कोड उ�प�न नह�ं करता है?

Ans 1. ए�ज़ी�यटेूबल कोड

2. अस�बलर

3. इ�टर�ेटर

4. क�पाइलर

Question Type : MCQ
Question ID : 6182781689

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.53 600 डॉट ��त इंच के �रज़ॉ�यशून वाला �कैनर छ�वय� को �कतने म� �वभािजत कर सकता है?

Ans 1. 100 × 60

2. 600 × 600

3. 60 × 10

4. 600

Question Type : MCQ
Question ID : 6182781684
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Status : Answered
Chosen Option : 3

Marks : 0.00

Q.54 �न�न�ल�खत म� से कौन-सा �वक�प पंि�त और कॉलम के आयाम बदलने का एक तर�का नह�ं है?

Ans 1. ि�ल�कंग और ��ैगगं

2. ऑटो�फ़�टगं

3. Home → Format

4. AutoSum

Question Type : MCQ
Question ID : 6182781714

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.55 MS Excel म� इ�सट� फं�शन के �लए शॉट� कट क� �या है?

Ans 1. Shift + F5

2. Shift + F6

3. Shift + F4

4. Shift + F3

Question Type : MCQ
Question ID : 6182781723

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.56 �न�न�ल�खत म� से �कस शॉट�कट कंुजी का उपयोग ‘गो टू द इंड ऑफ द रो' फ़ं�शन के �लए �कया जाता है?

Ans 1. Alt+End

2. Ctrl+End

3. Ctrl+Tab

4. Shift+End

Question Type : MCQ
Question ID : 6182781704

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.57 �न�न�ल�खत म� से �कस इंटरनेट तकनीक म� इंटरनेट से जड़ुने के �लए टेल�फोन लाइन� या केबल� का उपयोग
नह�ं �कया जाता है?

Ans 1. DSL

2. वाई-फ़ाई

3. डायल-अप

4. केबल
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Question Type : MCQ
Question ID : 6182781737

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.58 वक� शीट म�, से�स को �व�श�ट �प से �कससे पहचाना जाता है?

Ans 1. कॉलम लेटस� और पंि�त सं�या

2. सेल कलर

3. कॉलम सं�या और पंि�त लेटस�

4. सेल GPS �वा�ड �ने�स

Question Type : MCQ
Question ID : 6182781719

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.59 टा�क बार म�, �स�टम �े कहा ँि�थत है?

Ans 1. कह� ंभी

2. दाएँ

3. बाएँ

4. बीच म�

Question Type : MCQ
Question ID : 6182781690

Status : Not Attempted and
Marked For Review

Chosen Option : --
Marks : 0.00

Q.60 �न�न�ल�खत म� से कौन-सा �स�टम सॉ�टवेयर का एक उदाहरण है?

Ans 1. कं�यटूर गेम

2. इंटरनेट �ाऊज़र

3. ��ेडशीट

4. य�ूट�ल�टज़

Question Type : MCQ
Question ID : 6182781686

Status : Answered
Chosen Option : 2

Marks : 0.00

ANKAJ INFOTECH



1/27/2020 https://cdn3.digialm.com///per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S76D406/157701486345964…

https://cdn3.digialm.com///per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S76D406/15770148634596477/1938251… 1/16

Q.1 य�द आप MS Excel म� एक टे��टबॉ�स सि�म�लत करना चाहत ेह�, तो आप इसे ______ म� पाएंगे।
Ans 1. Add-ins

2. Symbols

3. Charts

4. Shapes

Question Type : MCQ
Question ID : 6182781669

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.2 �न�न�ल�खत म� से कौन-सा �वक�प पंि�त क� ऊँचाई को समायोिजत करता है, ता�क हर एक मान पंि�त या
कॉलम म� परू� तरह से �फट हो जाए?

Ans 1. Column Height

2. AutoFit Row Height

3. AutoFit to Window

4. Rename Sheet

Question Type : MCQ
Question ID : 6182781654

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.3 इंटरनेट पर, मे�लगं �ल�ट सेवा का उपयोग �कसके �लए �कया जाता है?

Ans 1. इंटरनेट से जड़ु े�कसी दरू�थ (�रमोट) कं�यटूर पर लॉग ऑन करने के �लए

2. परेू �व�व के लोग� को वा�त�वक समय म� संचार करने क� अनमु�त देने के �लए

3. इंटरनेट के मा�यम से इले��ॉ�नक संदेश� को भेजने के �लए

4. इंटरनेट �यो�ताओ ंके संगठन समहू� को ई-मेल के मा�यम से सामा�य जानकार� साझा करने के

Participant ID 19382513
Participant Name KUMARI SALONI
Test Center Name iON Digital Zone iDZ 1 Patliputra
Test Date 22/12/2019
Test Time 9:00 AM - 10:00 AM
Subject Data Entry Operator
Marks Obtained 23.00000

Section : MCQ for Data Entry Operator

ANKAJ INFOTECH



1/27/2020 https://cdn3.digialm.com///per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S76D406/157701486345964…

https://cdn3.digialm.com///per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S76D406/15770148634596477/1938251… 2/16

�लए

Question Type : MCQ
Question ID : 6182781680

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.4 �न�न�ल�खत म� से कौन-सी शॉट� कट कंुजी का उपयोग ‘Save As’ फ़ं�शन के �लए �कया जाता है?

Ans 1. F11

2. F12

3. F7

4. F9

Question Type : MCQ
Question ID : 6182781635

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.5 MS Word 2016 म� ��टं फ़ं�शन �कस मेन ूके तहत उपल�ध है?

Ans 1. Review

2. Layout

3. File

4. View

Question Type : MCQ
Question ID : 6182781647

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.6 अब हम �कस पीढ़� (generation) के कं�यटूर का उपयोग कर रहे ह�?
Ans 1. 5

2. 1

3. 2

4. 3

Question Type : MCQ
Question ID : 6182781634

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.7 मे�लगं म� ए�से �लॉक �न�न�ल�खत म� से �कससे �घरा होता है?

Ans 1. <<>> 

2. <> 

3. ‘ ‘

4. “ ”
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Question Type : MCQ
Question ID : 6182781648

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.8 �न�न�ल�खत म� से कौन-सा ॲि�लकेशन सॉ�टवेयर है?

Ans 1. लोडर

2. �स�टम य�ूट�लट�

3. ऑपरे�टगं �स�टम

4. इमेज ए�डटर

Question Type : MCQ
Question ID : 6182781627

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.9 MS Excel म� ‘FV’ �कस �कार का फ़ं�शन है?

Ans 1. टे��ट

2. लकुअप और रेफ़र�स

3. लॉिजकल

4. फ़ाइन��शयल

Question Type : MCQ
Question ID : 6182781665

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.10 ए�सेल �ा�प म� �दनांक �ा�त करने के �लए �कस फ़ं�शन का उपयोग वष�, माह और तार�ख क� आप�ूत� करके
�कया जाता है?

Ans 1. YEAR

2. DATEVALUE

3. DATE

4. EDATE

Question Type : MCQ
Question ID : 6182781667

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.11 �लाइड लेआउट म�, �न�न�ल�खत म� से कौन-सा से�शन (अनभुाग) नह�ं होता है?

Ans 1. ए�नमेश�स

2. �ल��स

3. चा��स

4. टाइट�स
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Question Type : MCQ
Question ID : 6182781674

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.12 डॉट म�ै��स और ब�ड ��टंस� �कस �कार के ��टंर ह�?
Ans 1. इंकजेट ��टंर

2. लेज़र ��टंर

3. थम�ल ��टंर

4. इ�प�ैट ��टंर

Question Type : MCQ
Question ID : 6182781623

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.13 MS Word म� �न�न�ल�खत म� से �कस कंुजी का उपयोग एक ता�लका म� ‘go to the previous cell’ के
�लए �कया जाता है?

Ans 1. Shift + Tab

2. Ctrl + Shift

3. Ctrl + Tab

4. Alt + Shift

Question Type : MCQ
Question ID : 6182781644

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.14 �न�न�ल�खत म� से �कसके �वारा एक पंि�त क� चय�नत सेल� को मज� करके एक बड़ी सेल के �प म� प�रव�त�त
�कया जाता है?

Ans 1. अनमज� से�स

2. मज� फॉमू�ला

3. रैप टे��ट

4. मज� एंड स�टर

Question Type : MCQ
Question ID : 6182781661

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.15 �कसी �लाइड म� य�द आप एक व�ृताकार �टाइल म� कुछ टे��ट साम�ी रखना चाहत ेह�, तो कौन सा �वक�प
चनु�गे?

Ans 1. ऑटो शपे

2. वड�आट�
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3. चाट�

4. �सपंल टे��ट बॉ�स

Question Type : MCQ
Question ID : 6182781670

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.16 �न�न�ल�खत म� से कौन सा �वक�प पंि�त क� ऊँचाई को साम�ी के अनसुार बदल देगा/ समायोिजत कर देगा?
Ans 1. कंडीशनल फ़ॉम��टगं

2. सेल �टाइल

3. �फ�टर

4. रैप टे��ट

Question Type : MCQ
Question ID : 6182781652

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.17 �न�न�ल�खत म� से कौन-सी वक� शीट (काय�प�क) म� एक �े� से फ़ॉम��टगं को कॉपी करके दसूरे �े� म� लागू
करने क� �व�ध है?

Ans 1. ए�सेल (Excel) म� फ़ॉम��टगं को कॉपी और अ�लाई करने का कोई तर�का नह�ं है, आपको इसे
मनैअुल� करना होगा।

2. Format Painter

3. Sort

4. Filter

Question Type : MCQ
Question ID : 6182781658

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.18 MS PowerPoint म� ��ड को �दखाने / �छपाने के �लए ______ कंुजी दबाएँ।
Ans 1. Shift + F11

2. Shift + F8

3. Shift + F10

4. Shift + F9

Question Type : MCQ
Question ID : 6182781675

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.19 एमएस पावरपॉइंट म� श�ुआत से �लाइड शो देखने के �लए ______ कंुजी दबाएं।
Ans 1. F5
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2. F12

3. F11

4. F8

Question Type : MCQ
Question ID : 6182781672

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.20 लेज़र ��टंर म�, छ�व को �कसके �वारा कागज़ पर अतं�रत �कया जाता है?

Ans 1. �म

2. रोलर

3. लेज़र

4. टोनर

Question Type : MCQ
Question ID : 6182781625

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.21 सेल �टाइल को एक वक� बकु से दसूरे म� कॉपी करने के �लए, मज� �टाइल �वक�प का उपयोग �कया जाता है,
जो ______ मेन ूम� होता है।

Ans 1. सेल �टाइ�स

2. टेबल फ़ॉम��टगं

3. कंडीशनल फ़ॉम��टगं

4. डटेा

Question Type : MCQ
Question ID : 6182781662

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.22 मेल मज� को परूा करने से पहले पवूा�वलोकन के �लए �न�न�ल�खत म� से �कस टैब का उपयोग �कया जाता है?

Ans 1. ���य ूयअुर लेटर

2. ���यू

3. ���य ूस�डर

4. ���य ूयअुर मेल

Question Type : MCQ
Question ID : 6182781649

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.23 �कसी वक� शीट म�, पहले कॉलम क� 5व� कॉलम के साथ तलुना करत ेसमय, स�ुवधा के �लए दसूरे से लेकर 4थे
कॉलम तक को �छपाने क� आव�यकता होती है। तलुना हो जाने के बाद, हम� इसे �फर से अनहाइड (�कट) करने
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क� आव�यकता होती है। अनहाइड (�कट) करने के �लए �कस टूल का उपयोग �कया जाता है?

Ans 1. Page Layout > Print Titles

2. Insert > Column Sparklines

3. View > Freeze Panes

4. Home > Format > Visibility > Hide & Unhide

Question Type : MCQ
Question ID : 6182781660

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.24 माउस पॉइंटर क� एक काल� ऊ�वा�धर (व�ट�कल) ि�लं�कंग लाइन को �कस नाम म� जाना जाता है?

Ans 1. �ड�लशन पॉइंट (�वलोपन �बदं)ु

2. इ�सश�न पॉइंट (सि�मलन �बदं)ु

3. र�ड पॉइंट (पठन �बदं)ु

4. सच� पॉइंट (खोज �बदं)ु

Question Type : MCQ
Question ID : 6182781637

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.25 �कसी ��त�ुत म� सभी �लाइड के �लए सं�मण �भाव सेट करत ेसमय उपयोग करने के �लए सबसे अ�छा
��य है।

Ans 1. �लाइड �यू

2. आउटलाइन �यू

3. �लाइड शॉट�र �यू

4. नोट पेज �यू

Question Type : MCQ
Question ID : 6182781673

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.26 एक ए�सेल ��ेडशीट (Excel spreadsheet) म� फ़ॉ�यू�ला म� आगु�म��स को अलग-अलग करने के �लए
�न�न�ल�खत म� से �कसका उपयोग �कया जाता है?

Ans 1. dollar (/)

2. slash (/)

3. Star (*)

4. Comma (,)

Question Type : MCQ
Question ID : 6182781651

Status : Answered
Chosen Option : 4

Marks : 1.00
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Q.27 �न�न�ल�खत म� से कौन-सा �वक�प उपयोगकता� �वारा उपयोग �कए जाने वाले फ़ो�डर� क� सचूी �द�श�त
करता है?

Ans 1. �रस�ट फ़ाइल

2. माय �प�चस�

3. डा�यमू�ट

4. ऑल �ो�ा�स

Question Type : MCQ
Question ID : 6182781631

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.28 �न�न�ल�खत म� से कौन-सा CPU क� अ�भग�यता ग�त को बढ़ाता है?

Ans 1. HDD

2. कैश मेमोर�

3. ALU

4. ROM

Question Type : MCQ
Question ID : 6182781621

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.29 �न�न�ल�खत म� से कौन-सा �वडंोज़ XP का एक ब�ुनयाद� घटक नह�ं है?

Ans 1. आइकॉन

2. ट�म�नल

3. मेनू

4. पॉइंटर

Question Type : MCQ
Question ID : 6182781630

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.30 �न�न�ल�खत म� से �कस शॉट�कट कंुजी का उपयोग �वषय व�त ु�चपकाने वाले (‘Paste content’) फ़ं�शन के
�लए �कया जाता है?

Ans 1. Ctrl + D

2. Ctrl + C

3. Ctrl + V

4. Ctrl + X

Question Type : MCQ
Question ID : 6182781640

Status : Answered
Chosen Option : 3
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Marks : 1.00

Q.31 �ोटे�ट क� हुई वक� शीट के संबंध म� �न�न�ल�खत म� से कौन-सा कथन स�य है?

Ans 1. य�द आप पासवड� भलू जात ेह�, तो ए�सेल पासवड� डाले �बना भी वक� शीट खोल देता है।

2. पासवड� हमेशा 5 अ�र का होता है।

3. एक �ोटे�ट क� हुई वक� शीट म�, कोई भी उपयोगकता� साम�ी संपा�दत कर सकता है।

4. आप काय�पिु�तका क� संरचना (structure) को �ोटे�ट कर सकत ेह�।

Question Type : MCQ
Question ID : 6182781664

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.32 एक प�रयोजना के �लए, य�द आप एक अ��य ह�ता�र जोड़कर वक� बकु क� अखंडता स�ुनि�चत करना चाहते
ह�, तो उपयोग करने के �लए �न�न�ल�खत मे से कौन-सा �वक�प बेहतर है?

Ans 1. द�तावेज क� जाँच करना

2. वत�मान शीट को सरु��त करना

3. संगतता क� जाँच करना

4. एक �डिजटल ह�ता�र जोड़ना

Question Type : MCQ
Question ID : 6182781657

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.33 �न�न�ल�खत म� से कौन-सा वक� बकु क� सरु�ा (Workbook Protection) से संबं�धत नह�ं है?

Ans 1. Workbook structure

2. Inspect document

3. Protect current sheet

4. Encrypt with password

Question Type : MCQ
Question ID : 6182781656

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.34 कौन-सा �डवाइस आपके लोकल नेटवक�  और इंटरनेट के बीच सेत ु(bridge) का काय� करता है?

Ans 1. ��टंर

2. �कैनर

3. PC

4. मॉडमे

Question Type : MCQ
Question ID : 6182781676

Status : Answered
Chosen Option : 4ANKAJ INFOTECH
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Marks : 1.00

Q.35 Ctrl + C का काय� �या है?

Ans 1. Cut

2. Copy

3. Commit

4. Call

Question Type : MCQ
Question ID : 6182781646

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.36

Ans 1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 6182781679

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.37 �न�न�ल�खत म� से �कसे कॉलम चाट� के �प म� भी जाना जाता है?

Ans 1. बार चाट�

2. हायराक� चाट�

3. लाइन चाट�

4. पाई चाट�

Question Type : MCQ
Question ID : 6182781668

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.38 वक� शीट को संशो�धत करने के संबंध म� �न�न�ल�खत म� से कौन-सा कथन गलत है?

Ans 1. फ़ॉम�ट प�टर से हम एक आइटम से दसूरे आइटम म� फ़ॉम��टगं को कॉपी कर सकत ेह�।

2. एक बार कॉलम�/पंि�तय� के मज� हो जाने पर हम उ�ह� �फर से अनमज� नह�ं कर सकत ेह�।

3. मिज�ग टूल से हम कई पंि�तय� / कॉलम� को मज� कर सकत ेह�।

4. रैप टे��ट पंि�त क� ऊँचाई को बदल नह�ं कर सकता है।

Question Type : MCQ
Question ID : 6182781653

Status : Answered
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Chosen Option : 4
Marks : 1.00

Q.39 �कसी वड� द�तावेज (डा�यमू�ट) के अतं म� एक �ै�तज रेखा को �कस नाम से जाना जाता है?

Ans 1. डा�यमू�ट क� समाि�त का �च�न

2. र�ड पॉइंट (पठन �बदं)ु

3. माउस पॉइंटर

4. इ�सश�न पॉइंट (सि�मलन �बदं)ु

Question Type : MCQ
Question ID : 6182781638

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.40 �न�न�ल�खत म� से कौन-सा एक ऐसा डटेाबेस है, िजसम� वह डटेा होता है, िजसे मेल मज� आउटपटु डा�यमू�ट म�
मज़� �कया जाना होता है?

Ans 1. आउटपटु डा�यमू�ट

2. ए�से डा�यमू�ट

3. मेन डा�यमू�ट

4. �र�सपीअ�ट �ल�ट (�ापक सचूी)

Question Type : MCQ
Question ID : 6182781645

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.41 �न�न�ल�खत म� से कौन-सा �स�टम से�टगं के �लए उपयोग �कया जाता है?

Ans 1. �डफ़ॉ�ट �ो�ा�स

2. �डवाइस एंड ��टंस�

3. हे�प एंड सपोट�

4. कं�ोल पनैल

Question Type : MCQ
Question ID : 6182781632

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.42 वड� ���न म� कई ______ शा�मल होत/ेहोती ह�।
Ans 1. ऑ�जे��स

2. वड� आट�

3. फो�डस�

4. शपे

Question Type : MCQ
Question ID : 6182781636
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Status : Answered
Chosen Option : 2

Marks : 0.00

Q.43 ए�सेल (Excel) म� �न�न�ल�खत म� से कौन-सा सेल आइड��ट�फ़केशन सह� है?

Ans 1. A1

2. 1A

3. oneA

4. Aone

Question Type : MCQ
Question ID : 6182781659

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.44 �ेज़�टेशन म� एक नई �लाइड जोड़ने के कई तर�के ह�। �न�न�ल�खत म� से �कस मेन ूम� ‘New Slide’ टैब होता
है?

Ans 1. होम

2. �यू

3. ऐ�नमेशन

4. �र�यू

Question Type : MCQ
Question ID : 6182781671

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.45 COBOL ल��वेज �कस वष� �डजाइन क� गई थी?
Ans 1. 1959 म�

2. 1955 म�

3. 1951 म�

4. 1950 म�

Question Type : MCQ
Question ID : 6182781628

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.46 �न�न�ल�खत म� से कौन-सा ॲि�लकेशन सॉ�टवेयर नह�ं है?

Ans 1. ऑपरे�टगं �स�टम

2. वड� �ोसेसर

3. डटेाबेस

4. इंटरनेट �ाउज़र

Question Type : MCQ
Question ID : 6182781626ANKAJ INFOTECH
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Status : Answered
Chosen Option : 2

Marks : 0.00

Q.47 �न�न�ल�खत म� से कौन-सा ��टंर काब�न फ़ॉम� का उपयोग करता है?

Ans 1. लेज़र ��टंर

2. थम�ल ��टंर

3. डज़ेी �ह�ल

4. �थ�बल ��टंर

Question Type : MCQ
Question ID : 6182781624

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.48 �न�न�ल�खत म� से �कस शॉट�कट कंुजी का उपयोग फॉ�ट डायलॉग बॉ�स के �लए �कया जाता है?

Ans 1. Ctrl + Shift + F

2. Ctrl + Shift + P

3. Ctrl + Shift + E

4. Ctrl + Shift + A

Question Type : MCQ
Question ID : 6182781643

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.49 �न�न�ल�खत म� से �कस इंटरनेट कने�शन म� �पीड सवा��धक होती है?

Ans 1. ऑि�टकल कै�रयर

2. बॉ�डडे T-1

3. �समे��क �डिजटल स�स�ाइबर लाइन (SDSL)

4. इंटरनेट ओवर सटेैलाइट (IoS)

Question Type : MCQ
Question ID : 6182781677

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.50 Microsoft Word 2016 म� �कसी द�तावेज़ (डा�यमू�ट) को सरु��त करने के �लए �कस मेन ूका उपयोग
�कया जाता है?

Ans 1. �ैक च�जेस

2. �रि��क ए�ड�टगं

3. �लॉक ऑथस�

4. �र�यु

Question Type : MCQ
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Question ID : 6182781639
Status : Answered

Chosen Option : 1
Marks : 0.00

Q.51 MS Word म� �न�न�ल�खत म� से �कस शॉट�कट कंुजी का उपयोग ‘Change Case’ फ़ं�शन के �लए �कया
जाता है?

Ans 1. Shift + F2

2. Shift + F4

3. Shift + F1

4. Shift + F3

Question Type : MCQ
Question ID : 6182781642

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.52 �कसी फ़ॉ�यू�ला को कॉपी करत ेसमय, �न�न�ल�खत म� से कौन सी �व�ध सह� है?

Ans 1. माउस को �गै करके फ़ॉ�यू�ला को कॉपी कर सकत ेहै।

2. आप शॉट� कट कंुजी CTRL +F का उपयोग करके और बाद के सेल� (से�स) पर माउस को ि�लक
करके फ़ॉ�यू�ला को कॉपी कर सकत ेह�।

3. आप शॉट� कट कंुजी CTRL + H का उपयोग करके और आगामी सेल� (से�स) पर माउस को ि�लक
करके फ़ॉ�यू�ला को कॉपी कर सकत ेह�।

4. फ़ॉ�यू�ला को बाद के सेल� (से�स) म� कॉपी करत ेसमय माउस को �गै करने का �वक�प काम नह�ं
करता है।

Question Type : MCQ
Question ID : 6182781666

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.53 �न�न�ल�खत म� से कौन-सी ��ेडशीट क� �वशषेता है?

Ans 1. ऑटोसम

2. ऑटो �डवीजन

3. ऑटो �डल�ट

4. ऑटो स��ै�ट

Question Type : MCQ
Question ID : 6182781650

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.54 �न�न�ल�खत म� से �कस ल��वेज (भाषा) के �लए एक इंटर�ेटर क� आव�यकता होती है?

Ans 1. COBOL

2. C++

3. C#
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4. Python (पाइथन)

Question Type : MCQ
Question ID : 6182781629

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.55 से�स को लॉक करने या फ़ॉ�यू�ला को हाइड करने का �भाव तब तक नह�ं पड़ता, जब तक आप:

Ans 1. वक� शीट क� सभी साम�ी को कॉपी न कर�

2. वक� शीट को अन�ोटे�ट न कर�

3. सेल (से�स) के �लए कंडीशनल फ़ॉम��टगं अ�लाए न कर�

4. वक� शीट को �ोटे�ट न कर�

Question Type : MCQ
Question ID : 6182781663

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.56 �न�न�ल�खत म� से कौन-सा �वक�प पत� के �लए नाम के समाधान के �लए मानक श�दावल� है, और इसका
उपयोग �यादातर डोमेन नाम� और IP पत� के बीच �पांतरण के �लए �कया जाता है?

Ans 1. डोमेन नेम �स�टम

2. टेलनेट

3. ईमेल

4. URL

Question Type : MCQ
Question ID : 6182781678

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.57 �न�न�ल�खत म� से कौन-सा �वक�प मेन मेमोर� क� �मता को बढ़ाता है?

Ans 1. ROM

2. वचु�अल मेमोर�

3. कैश मेमोर�

4. ALU

Question Type : MCQ
Question ID : 6182781622

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.58 �कसी फ़ाइल को �यवि�थत करने के �लए �न�न�ल�खत म� से �कसका उपयोग �कया जाता है?

Ans 1. फो�डर

2. र�सायकल �बन

3. टा�कबॉर
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4. मेनू

Question Type : MCQ
Question ID : 6182781633

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.59 य�द आप एक ह� बार म� दज़�न� या सकैड़� कॉलम और पंि�तय� को ऑटो�फट करना चाहत ेह�, तो आप �या
कर�गे?

Ans 1. �कसी भी पंि�त या कॉलम सीमा पर डबल-ि�लक कर�गे।

2. Ctrl + C दबाएँगे, �फर ��डैशीट म� ��येक पंि�त या कॉलम को ऑटो�फट करने के �लए �कसी भी
पंि�त या कॉलम सीमा पर डबल-ि�लक कर�गे।

3. अपनी संपणू� ��डैशीट का चयन करने के �लए Ctrl + A दबाएँगे, �फर ��डैशीट म� ��येक पंि�त या
कॉलम को ऑटो�फट करने के �लए �कसी भी पंि�त या कॉलम सीमा पर डबल-ि�लक कर�गे।

4. ��डैशीट म� ��येक पंि�त या कॉलम को ऑटो�फट करने के �लए शीष� पंि�त या पहले कॉलम क�
सीमा पर डबल-ि�लक कर�गे।

Question Type : MCQ
Question ID : 6182781655

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.60 �न�न�ल�खत म� से �कस शॉट�कट कंुजी का उपयोग ‘Redo’ फ़ं�शन के �लए �कया जाता है?

Ans 1. Ctrl + Z

2. Ctrl + Y

3. Ctrl + C

4. Ctrl + P

Question Type : MCQ
Question ID : 6182781641

Status : Answered
Chosen Option : 2

Marks : 1.00
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Q.1 वक�  शीट का नाम कैसे बदला जाता है?

Ans 1. वक�  शीट क� शीट टैब का चयन कर� > नया नाम टाइप कर� > एंटर दबाएं

2. वक�  शीट के शीट टैब पर �सगंल ि�लक कर� > नया नाम टाइप कर� > एंटर दबाएं

3. वक�  शीट के शीट टैब पर डबल ि�लक कर� > नया नाम टाइप कर� > एंटर दबाएं

4. वक�  शीट के शीट टैब पर ले�ट ि�लक कर� > नया नाम टाइप कर� > एंटर दबाएँ

Question Type : MCQ
Question ID : 6182781830

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.2 MS Word म�, टे��ट को अडंरलाइन करने के �लए शॉट�कट कंुजी �या है?

Ans 1. Ctrl + U

2. Ctrl + V

3. Ctrl + T

4. Ctrl + C

Question Type : MCQ
Question ID : 6182781828

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.3 Windows XP म�, MS Word �ो�ाम कैसे श�ु �कया जाता है?

Ans 1. Start > Microsoft office > MS Word

2. All program > Microsoft office > MS Word

3. Start > All program > Microsoft office > MS Word

4. Start > All program > MS Word

Participant ID 19387247
Participant Name BIHARI KUMAR
Test Center Name iON Digital Zone iDZ 2 Patliputra
Test Date 23/12/2019
Test Time 3:00 PM - 4:00 PM
Subject Data Entry Operator
Marks Obtained 24.00000

Section : MCQ for Data Entry Operator
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Question Type : MCQ
Question ID : 6182781815

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.4 दोन� �लर देखने के �लए आपको ______ म� होना चा�हए।
Ans 1. ��टं �ी�यू

2. पेज लेआउट �यू

3. वेब लेआउट

4. र��डगं �यू

Question Type : MCQ
Question ID : 6182781817

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.5 _____ सभी �लाइ�स के �लए एक �डज़ाइन लागू कर सकत ेह�।
Ans 1. �ांजीशन

2. मा�टर �लाइड

3. ��गर

4. ऐनीमेशन

Question Type : MCQ
Question ID : 6182781853

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.6 MS Excel 2016 म�, वक� शीट को पासवड� के साथ कैसे सरु��त �कया जाता है?

Ans 1. Review tab > Protect Sheet > Enter Password > Reenter Password > OK

2. View tab > Protect Sheet > Enter Password > Reenter Password > OK

3. Insert tab > Protect Sheet > Enter Password > Reenter Password > OK

4. Review tab > Protect Sheet > Enter Password > OK

Question Type : MCQ
Question ID : 6182781843

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.7 MS Excel म�, फ़ॉम��टगं बदले �बना फॉमू�ला को �कसी अ�य सेल म� कॉपी कैसे करत ेह�?
Ans 1. फॉमू�ला सेल चनु� �फर Ctrl + C > डिे�टनेशन सेल चनु� और ले�ट ि�लक कर� > Paste > OK पर

ि�लक कर�

2. फॉमू�ला सेल चनु� �फर Ctrl + C > डिे�टनेशन सेल चनु� और राइट ि�लक कर� > Paste > OK पर
ि�लक कर�

3. फॉमू�ला सेल चनु� �फर Ctrl + C > डिे�टनेशन सेल चनु� और डबल ि�लक कर� > Paste > OK पर
ि�लक कर�
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4. फॉमू�ला सेल चनु� �फर Ctrl + V > डिे�टनेशन सेल चनु� और राइट ि�लक कर� > Paste > OK पर
ि�लक कर�

Question Type : MCQ
Question ID : 6182781846

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.8 MS Excel म� कॉलम क� चौड़ाई का आकार कैसे बदला जाता है?

Ans 1. कॉलम पर ि�लक कर� > कॉलम पर तब तक ि�लक कर�, जब तक यह वां�छत आकार का न हो जाए

2. कॉलम क� ऊँचाई को सेले�ट कर� > कॉलम को तब तक �गै कर�, जब तक �क यह वां�छत आकार का
न हो जाए

3. कॉलम को सेले�ट कर� > कॉलम को तब तक �गै कर�, जब तक �क यह वां�छत आकार का न हो जाए

4. कॉलम को सेले�ट कर� > कॉलम क� ऊंचाई को तब तक �गै कर�, जब तक �क यह वां�छत आकार क�
न हो जाए

Question Type : MCQ
Question ID : 6182781834

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.9 एक से अ�धक असफल लॉ�गन के बाद वेब सव�र, �कसी उपयोगकता� या आईपी पत े(Address) को अव��
(Block) कर देता है, इसे �या कहा जाता है?

Ans 1. �डनायल ऑफ़ स�व�स (DoS) अटैक

2. �टू फ़ोस� अटैक

3. �फ�शगं अटैक

4. बे�सक फ़ोस� अटैक

Question Type : MCQ
Question ID : 6182781860

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.10 वॉन �यमूनै कं�यटूर �स�टम म� �ो�ाम ए�जी�यशून ______ �कया जाता है।
Ans 1. समांतर �प से (Parallelism)

2. या�ि�छक �प से (Randomly)

3. ��मक �प से (Sequentially)

4. साथ-साथ (Concurrently)

Question Type : MCQ
Question ID : 6182781801

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.11 MS Word 2016 म�, डॉ�यमू�ट (द�तावेज़) का नाम बदलने के �लए शॉट�कट कंुजी �या है?

Ans ANKAJ INFOTECH
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1. F2

2. F3

3. F12

4. F7

Question Type : MCQ
Question ID : 6182781826

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.12 MS Excel 2016 म�, से�स म� wrap text कैसे �कया जाता है?

Ans 1. वक� शीट खोल� > होम > एक सेल चनु� और राइट ि�लक कर� > फ़ॉ�ट, �टाइल, आकार चनु� > ओके
पर ि�लक कर�

2. वक� शीट खोल� > होम > एक सेल चनु� और राइट ि�लक कर� > फॉम�ट से�स > फॉ�ट, �टाइल, आकार
चनु� > ओके पर ि�लक कर�

3. वक� शीट खोल� > होम > एक सेल चनु� और राइट ि�लक कर� > फॉम�ट से�स > ओके पर ि�लक कर�

4. वक� शीट खोल� > एक सेल चनु� और राइट ि�लक कर� > फॉम�ट से�स > एलाइनम�ट > रैप टे��ट >

ओके पर ि�लक कर�

Question Type : MCQ
Question ID : 6182781838

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.13 इनपटु �डवाइस ______ उपयोग �कए जात ेह�।
Ans 1. �ोसे�सगं य�ूनट से डटेा �वीकार करने और आउटपटु य�ूनट को भेजने के �लए

2. डटेा �वीकार करने और इसे �ोसेस य�ूनट को भेजने के �लए

3. केवल डटेा को फ़ॉम�ट करने के �लए

4. एक �ोसे�सगं उपकरण के �प म�

Question Type : MCQ
Question ID : 6182781805

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.14 MS Excel म� �न�न�ल�खत म� से कौन सा मा�य सेल ए�से है?

Ans 1. A*

2. 1$

3. 1A

4. A1

Question Type : MCQ
Question ID : 6182781835

Status : Answered
Chosen Option : 4

Marks : 1.00
ANKAJ INFOTECH
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Q.15 फोर�ान भाषा �कसने �वक�सत क� थी?
Ans 1. जॉन बकैस के नेत�ृव म� ट�म �वारा

2. कॉ�मेरौएर, रसेल, और कोवल�क�

3. जॉन मकैाथ� 

4. ड�ेनस �रची और केन थॉ�पसन

Question Type : MCQ
Question ID : 6182781808

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.16 मेल मज� ���या म� शा�मल डॉ�यमू�ट कौन से ह�?
Ans 1. डटेा �ोत और मज� �कया गया डॉ�यमू�ट

2. म�ुय डॉ�यमू�ट और मज� �कया गया डॉ�यमू�ट

3. म�ुय डॉ�यमू�ट और डटेा �ोत

4. म�ुय डॉ�यमू�ट, डटेा �ोत और मज� �कया गया डॉ�यमू�ट

Question Type : MCQ
Question ID : 6182781829

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.17 MS Excel म�, Find and Replace डायलॉग बॉ�स खोलने के �लए �य�ुत शॉट�कट कंुजी �या है?

Ans 1. Ctrl + R

2. Ctrl + Alt + F

3. Ctrl + Shift + F

4. Ctrl + F

Question Type : MCQ
Question ID : 6182781833

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.18 मौजदूा MS Word डॉ�यमू�ट को सहेजने के �लए, �न�न�ल�खत म� से कौन से �वक�प का उपयोग �कया जाना
चा�हए?

Ans 1. CTRL + A दबाएं

2. CTRL + Z दबाएं

3. CTRL + S दबाएं

4. CTRL + V दबाएं

Question Type : MCQ
Question ID : 6182781819

Status : Answered
Chosen Option : 3

Marks : 1.00
ANKAJ INFOTECH
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Q.19 MS Excel म� �कसी वक� बकु �वडंो को एक आइकन के �प म� �म�नमाइज़ करने के �लए �य�ुत कंुजी संयोजन
�या है?

Ans 1. CTRL + F9

2. SHIFT + F9

3. CTRL + SHIFT

4. CTRL + ALT + F9

Question Type : MCQ
Question ID : 6182781832

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.20 ई-मेल संदेश भेजने के �लए ________ �ोटोकॉल का उपयोग करता है।
Ans 1. SOP

2. GOP

3. SMTP

4. FTP

Question Type : MCQ
Question ID : 6182781859

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.21 MOD(), MS Excel म� उपल�ध एक ग�णतीय फ़ं�शन है जो ______।
Ans 1. �कसी सं�या को एक गुणक �वारा गुणन करने के बाद �ा�त शषे �दान करता है

2. ऋणा�मक सं�याओ ंका मापांक देता है

3. प�रणाम के �प म� �कसी सं�या को एक भाजक �वारा �वभािजत करने के बाद �ा�त शषे �दान
करता है

4. उपरो�त सं�याओ ंका योग दशा�ता है

Question Type : MCQ
Question ID : 6182781847

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.22 MS Word 2016 म�, �कस टैब के तहत �रबन पर AutoShape उपल�ध है?

Ans 1. �य ूटैब

2. इ�सट� टैब

3. फ़ॉ�यू�ला टैब

4. होम टैब

Question Type : MCQ
Question ID : 6182781850

Status : Answered
Chosen Option : 3

ANKAJ INFOTECH
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Marks : 0.00

Q.23 MS Excel 2016 म�, �ेडडे कम�ट डालने (Insert a threaded comment) के �लए �य�ुत शॉट�कट कंुजी
�या है?

Ans 1. Ctrl + semi-colon (;)

2. Ctrl + Shift + Minus sign

3. Ctrl + Shift + Plus sign

4. Ctrl + Shift + F2

Question Type : MCQ
Question ID : 6182781831

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.24 एक पावर पॉइंट �लाइड, �न�न�ल�खत म� से �कस चरण� का उपयोग करके बनाई जा सकती है?

Ans 1. MS PowerPoint > Home > New > Create

2. MS PowerPoint > Insert > New > Create

3. MS PowerPoint > File > New > Blank presentation

4. MS PowerPoint > Create > New > Home

Question Type : MCQ
Question ID : 6182781851

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.25 MS Excel 2016 म�, पासवड� के साथ सरु��त वक� शीट को असरु��त कैसे कर�?
Ans 1. Review tab > Unprotect Sheet > Enter Password > OK

2. Review tab > Protect Sheet > Enter Password > Reenter Password > OK

3. Views tab > Unprotect Sheet > OK

4. View tab > Unprotect Sheet > Enter Password > Reenter Password > OK

Question Type : MCQ
Question ID : 6182781844

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.26 �डल�ट क� गई फ़ाइल, िजसे र�सायकल �बन म� सं�ह�त �कया जाता है, को ______ म� र��टोर �कया जाता है।
Ans 1. उपयोगकता� �वारा �न�द��ट �थान के आधार पर (Based on location specified by user)

2. अ�य �ाइव (Other drive)

3. इसक� मलू ि�थ�त (Original location)

4. मलू ि�थ�त के अलावा �कसी अ�य ि�थ�त (Different other than original location)

Question Type : MCQ
Question ID : 6182781812

Status : Answered
Chosen Option : 1

ANKAJ INFOTECH
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Marks : 0.00

Q.27 WWW �कस ्से स�बं�धत है ?

Ans 1. व�ड� वाइड वेब

2. वमु�स वेलफेयर

3. व�ड� �वज़ा��स

4. वाइ�ड लाइफ �ोटे�शन

Question Type : MCQ
Question ID : 6182781856

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.28 MS Excel 2016 म�, एक नई टेबल �टाइल कैसे बनात ेह�?
Ans 1. Home > New cell style > OK

2. Home > Cell Style > OK

3. Home > Cell Style > New cell style > OK

4. Home > Cell Style > New cell style

Question Type : MCQ
Question ID : 6182781842

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.29 MS Word 2016 म�, SmartArt, �रबन पर �कस टैब के अतंग�त उपल�ध होता है?

Ans 1. फ़ॉ�यू�ला टैब

2. �य ूटैब

3. होम टैब

4. इ�सट� टैब

Question Type : MCQ
Question ID : 6182781849

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.30 MS Word डॉ�यमू�ट क� वत�नी (spelling) और �याकरण जाँच के �लए उपयोग क� जाने वाल� फ़ं�शन कंुजी
कौन सी है?

Ans 1. F7

2. F2

3. F5

4. F1

Question Type : MCQ
Question ID : 6182781822

Status : Answered
Chosen Option : 1

ANKAJ INFOTECH
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Marks : 1.00

Q.31 MS PowerPoint 2016 म�, Display the context menu के �लए �य�ुत शॉट�कट कंुजी �या है?

Ans 1. Shift + F10

2. Ctrl + T

3. Shift + Tab

4. Ctrl + S

Question Type : MCQ
Question ID : 6182781852

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.32 MS Word 2016 म�, ऑ�जे��स को �ु�पगं करने का �वक�प ______ मेन ूम� मौजदू होता है।
Ans 1. इ�सट�

2. पेज लेआउट

3. �यू

4. लेआउट

Question Type : MCQ
Question ID : 6182781816

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.33 MS Word म�, परेू डॉ�यमू�ट को सेले�ट करने के �लए �य�ुत शॉट�कट कंुजी �या है?

Ans 1. CTRL + B

2. CTRL + A

3. CTRL + C

4. CTRL + M

Question Type : MCQ
Question ID : 6182781821

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.34 �कसी �व�श�ट काय� को करने के �लए �डज़ाइन �कया गया सॉ�टवेयर �या कहलाता है?

Ans 1. पकेैज सॉ�टवेयर

2. ए�ल�केशन सॉ�टवेयर

3. �स�टम सॉ�टवेयर

4. �स�ंोनस सॉ�टवेयर

Question Type : MCQ
Question ID : 6182781807

Status : Answered
Chosen Option : 3

Marks : 0.00
ANKAJ INFOTECH
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Q.35 कॉलम चाट� को ___ चाट� भी कहा जाता है।
Ans 1. बार

2. �कैटर

3. लाइन

4. पाई

Question Type : MCQ
Question ID : 6182781848

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.36 आप �कसी ��त�ुत के �लाइड म� ______ का उपयोग करके एक से दसूर� �लाइ�स पर जा सकत ेह�।
Ans 1. टैब कंुजी (Tab key)

2. �पेस बार (Space bar)

3. अप एंड डाउन एरो कंुजी (Up and down arrow key)

4. एंटर कंुजी (Enter key)

Question Type : MCQ
Question ID : 6182781855

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.37 जब आप माउस को टाइ�पगं ए�रया म� घमुात ेह�, तो माउस पॉइंटर एक पतले ______ के आकार का होता है।
Ans 1. तीर क� नोक (Arrow pointer)

2. ट�-बीम (T-beam)

3. आई-बीम (I-beam)

4. एल-बीम (L-beam)

Question Type : MCQ
Question ID : 6182781818

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.38 कं�यटूर का ALU से�शन, �टोरेज के �प म� ______ का उपयोग करता है।
Ans 1. ए�यमूलेुटर

2. रिज�टर

3. �ो�ाम काउंटर

4. एडर

Question Type : MCQ
Question ID : 6182781802

Status : Answered
Chosen Option : 2

Marks : 1.00

ANKAJ INFOTECH
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Q.39 MS Word म�, टे��ट इटै�लक बनाने के �लए शॉट�कट कंुजी �या है?

Ans 1. Ctrl + I

2. Ctrl + T

3. Ctrl + W

4. Ctrl + G

Question Type : MCQ
Question ID : 6182781836

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.40 Excel 2016 म�, मौजदूा वक� बकु �वडंो को कैसे �छपाया जाता है?

Ans 1. View tab > Window group > Hide

2. View tab > Workbook views group > Hide

3. Review tab > Window group > Hide

4. View tab > Show group > Hide

Question Type : MCQ
Question ID : 6182781837

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.41 डायल-अप कने�शन �कस �ोटोकॉल का उपयोग करता है?

Ans 1. सी�रयल लाइन इंटरनेट �ोटोकॉल (SLIP)

2. इंटरनेट �ोटोकॉल (IP)

3. �ांस�मशन क��ोल �ोटोकॉल (TCP)

4. उपयु��त म� से कोई नह�ं

Question Type : MCQ
Question ID : 6182781857

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.42 MS Excel म� "=now()" स�ू का आउटपटु �या है?

Ans 1. केवल वत�मान समय

2. यह स�ताह

3. केवल वत�मान �त�थ

4. वत�मान �दनांक और समय

Question Type : MCQ
Question ID : 6182781840

Status : Answered
Chosen Option : 4

Marks : 1.00

ANKAJ INFOTECH
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Q.43 Ms Excel 2016 म�, A1 से A10 से�स के मान जोड़ने का स�ू �या है?

Ans 1. "=Sum(A1 to A10)"

2. "=Sum(A1:A10)"

3. "=Sum(A1 - A10)"

4. "=Sum(A1 + A10)"

Question Type : MCQ
Question ID : 6182781839

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.44 MS Office म�, �कसी डॉ�यमू�ट म� टे��ट को कॉपी और �थानांत�रत कैसे �कया जाता है?

Ans 1. टे��ट को सेले�ट कर� > माउस पर ले�ट ि�लक कर� > कॉपी चनु�, �फर कस�र को �खसकाएँ > पे�ट
पर ि�लक कर�

2. टे��ट को सेले�ट कर� > माउस पर राइट ि�लक कर� > कॉपी चनु�, �फर कस�र को �खसकाएँ > माउस
पर राइट ि�लक कर� > पे�ट पर ि�लक कर�

3. माउस पर राइट ि�लक कर� > कॉपी चनु�, �फर कस�र को �खसकाएँ > माउस पर राइट ि�लक कर� >
पे�ट पर ि�लक कर�

4. टे��ट को सेले�ट कर� > माउस पर राइट ि�लक कर� > कॉपी चनु�, �फर कस�र को �खसकाएँ > माउस
पर ले�ट ि�लक कर� > पे�ट पर ि�लक कर�

Question Type : MCQ
Question ID : 6182781823

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.45 MS Office म�, टे��ट को पे�ट करने के �लए �य�ुत शॉट�कट कंुजी ______ है।
Ans 1. CTRL + X

2. CTRL + C

3. CTRL + V

4. CTRL + B

Question Type : MCQ
Question ID : 6182781813

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.46 कं�यटूर ड�ेकटॉप पर पाया जाने वाला आइकन नामक एक छोटा �तीक, एक ______ को �न��पत करता है।
Ans 1. ए�ल�केशन/फाइल/फो�डर

2. मेमोर�

3. वड� फ़ाइल ओ�ल�

4. हाड�वेयर

Question Type : MCQ
Question ID : 6182781810

Status : Answered
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Chosen Option : 1
Marks : 1.00

Q.47 MS Excel म� से�स के एक कॉलम को कैसे फ़ॉम�ट �कया जाता है?

Ans 1. एमएस ए�सेल > सेल/से�स के कॉलम का चयन कर� > राइट ि�लक कर� > फॉम�ट सेल

2. एमएस ए�सेल > सेल/से�स के कॉलम का चयन कर� > ले�ट ि�लक कर� > फॉम�ट सेल

3. एमएस ए�सेल > होम > सेल/से�स के कॉलम का चयन कर� > फॉम�ट सेल

4. एमएस ए�सेल > होम > सेल/से�स के कॉलम का चयन कर� > बायां ि�लक कर� > फॉम�ट सेल

Question Type : MCQ
Question ID : 6182781841

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.48 MS PowerPoint �लाइड म� प�रवत�न करने के बाद �डफ़ॉ�ट लेआउट को र��टोर कैसे �कया जाता है?

Ans 1. MS पावरपॉइंट > होम टैब > र�सेट बटन पर ि�लक कर�

2. होम टैब > �लाइड समहू > ि�लक कर�

3. एमएस पावरपॉइंट > �लाइ�स �ुप > र�सेट बटन पर ि�लक कर�

4. एमएस पावरपॉइंट > होम टैब > �लाइ�स �ुप > र�सेट बटन पर ि�लक कर�

Question Type : MCQ
Question ID : 6182781854

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.49 MS Word 2016 म�, एक मज� फ़��ड इ�सट� करने के �लए �य�ुत शॉट�कट कंुिजयाँ �या ह�?
Ans 1. Alt + Shift + K

2. Alt + Shift + M

3. Alt + Shift + F

4. Alt + Shift + N

Question Type : MCQ
Question ID : 6182781827

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.50 MS Word म� श�द� को मोटे अ�र� म� (बो�ड) करने के �लए �य�ुत शॉट�कट कंुजी �या है?

Ans 1. ESC + B

2. ALT + B

3. SHIFT + B

4. CTRL + B

Question Type : MCQ
Question ID : 6182781820

Status : Answered
Chosen Option : 4

ANKAJ INFOTECH



1/28/2020 https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S81D469/157710394463863…

https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S81D469/15771039446386387/193872… 14/16

Marks : 1.00

Q.51 इनम� से कौन सा परेू हाई लेवल ल��वेज सोस� कोड को मशीन कोड म� प�रव�त�त करता है?

Ans 1. इ�वट�र

2. इंटर�ेटर

3. कंपाइलर

4. कनवट�र

Question Type : MCQ
Question ID : 6182781809

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.52 MS Word 2016 डॉ�यमू�ट म� टेबल कैसे बनाएं?

Ans 1. Home > Row and Column क� सं�या का चयन कर� > Table

2. Insert > Table > Row and Column क� सं�या का चयन कर� > Click Add

3. Insert > Click on Table > Row and Column क� सं�या का चयन कर� > ADD

4. Insert > Table > Insert Table > Row and Column क� सं�या का चयन कर� > OK

Question Type : MCQ
Question ID : 6182781824

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.53 IoT का पणू� �प �या है?

Ans 1. इं�ट��यटू ऑफ़ टे�नॉलजी (Institute of Technology)

2. इंटरनेट ऑफ़ टे�नॉलजी (Internet of Technology)

3. इंटरनेशनल ऑफ़ टे�नॉलजी (International of Technology)

4. इंटरनेट ऑफ़ �थ�ंस (Internet of Things)

Question Type : MCQ
Question ID : 6182781858

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.54 �न�न�ल�खत म� से कौन सा एि�लकेशन सॉ�टवेयर का एक उदाहरण है?

Ans 1. �डबगर

2. वड� �ोसेसर

3. भाषा अनवुादक (ल��वेज �ांसलेटर)

4. ऑपरे�टगं �स�टम

Question Type : MCQ
Question ID : 6182781814

Status : Answered
Chosen Option : 4
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Marks : 0.00

Q.55 �प�ूलगं का पणू� �प �या है?

Ans 1. Simultaneous peripheral operation online (साइम�टै�नयस पेर�फ़ेरल ऑपरेशन ऑनलाइन)

2. Same peripheral operation online (सेम पेर�फ़ेरल ऑपरेशन ऑनलाइन)

3. Similar peripheral operation online (�स�मलर पेर�फ़ेरल ऑपरेशन ऑनलाइन)

4. Single peripheral operation online (�सगंल पेर�फ़ेरल ऑपरेशन ऑनलाइन)

Question Type : MCQ
Question ID : 6182781811

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.56 कॉ�से�ट क�बोड� का उपयोग ______ म� �कया जाता है।
Ans 1. फ़ा�ट फ़ूड रे��ां

2. टेल�फोन

3. एमट�एम मशीन

4. बे�सक मोबाइल ह�डसेट

Question Type : MCQ
Question ID : 6182781803

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.57 �पीच �सथेंसाइज़रस� ______ �पांत�रत करता है।
Ans 1. ऑ�डयो को टे��ट म�

2. इमेजेज को टे��ट म�

3. टे��ट को इमेज म�

4. टे��ट को ऑ�डयो म�

Question Type : MCQ
Question ID : 6182781804

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.58 MS Word म� �कसी सं�या क� पावर कैसे �दखात ेह�?
Ans 1. अडंरलाइन

2. सबि���ट

3. ��ाइक�ू

4. सपुरि���ट

Question Type : MCQ
Question ID : 6182781825

Status : Answered
Chosen Option : 1

ANKAJ INFOTECH



1/28/2020 https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S81D469/157710394463863…

https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S81D469/15771039446386387/193872… 16/16

Marks : 0.00

Q.59 �स�टम सॉ�टवेयर का उपयोग ______ को �नयं��त करने के �लए �कया जाता है।
Ans 1. सीपीय ूतापमान

2. एक उपयोगकता� �वारा आउटपटु

3. एक कं�यटूर के संचालन

4. एक उपयोगकता� �वारा इनपटु

Question Type : MCQ
Question ID : 6182781806

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.60 �कैटर चाट� को ______ भी कहा जाता है।
Ans 1. Y चाट�

2. 3D चाट�

3. X, Y चाट�

4. X चाट�

Question Type : MCQ
Question ID : 6182781845

Status : Answered
Chosen Option : 4

Marks : 0.00
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Q.1 वड� ���न लेआउट का �या उपयोग है?

Ans 1. केवल टे��ट क� फ़ॉम��टगं

2. डॉ�यमू�ट को ने�वगेट करना

3. डॉ�यमू�ट को �नजीकृत (Personalize) करना

4. डॉ�यमू�ट को ने�वगेट और �नजीकृत (Personalize) करना

Question Type : MCQ
Question ID : 6182781876

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.2 माइ�ो-ऑपरेशन ______ होत ेह�।
Ans 1. कं�यटूर के सीपीय ूरिज�टर� म� (the CPU registers of the computer)

2. कं�यटूर क� म�ुय मेमोर� म� (the Main memory of the computer)

3. सहायक मेमोर� म� (Auxiliary Memory)

4. कं�यटूर क� ��वतीयक मेमोर� म� (the Secondary memory of the computer)

Question Type : MCQ
Question ID : 6182781862

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.3 MS Word 2016 म�, �लस� का �या उपयोग है?

Ans 1. यह केवल �ै�तज (horizontal) पमैाने (scales) �द�श�त करता है, जो आपके टाइ�पगं �े� क�
चौड़ाई और ऊंचाई को दशा�ता है

2. यह �ै�तज (horizontal) और ऊ�वा�धर (vertical) पमैाने (scales) �द�श�त करता है जो आपके
टाइ�पगं �े� क� चौड़ाई और ऊंचाई को दशा�ता है

3. यह केवल ऊ�वा�धर (vertical) पमैाने (scales) �द�श�त करता है, जो आपके टाइ�पगं �े� क� चौड़ाई
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और ऊंचाई को दशा�ता है

4. यह �ै�तज (horizontal) और ऊ�वा�धर (vertical) पमैाने (scales) �द�श�त नह�ं करता है जो
आपके टाइ�पगं �े� क� चौड़ाई और ऊंचाई को दशा�ता है

Question Type : MCQ
Question ID : 6182781878

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.4 MS Word डॉ�यमू�ट ��टं कैसे �कया जाता है?

Ans 1. Tab + P

2. Ctrl + P

3. Shift + P

4. Alt + P

Question Type : MCQ
Question ID : 6182781879

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.5 �न�न�ल�खत म� से �कसे डटेा के DMA �ांसफ़र के दौरान "साइ�कल �ट��लगं" कहा जाता है?

Ans 1. जब DMA �ांसफ़र हो रहा हो, तब सीपीय ूबस को �नयं��त करता है, और बस को छोड़ने से पहले
एक वड� डटेा �ांसफ़र करता है

2. DMA कं�ोलर बस को �नयं��त करता है, और बस को छोड़ने से पहले डटेा �ांसफ़र को परूा करता है

3. DMA कं�ोलर बस को छोड़ने से पहले बस से एक वड� डटेा �ांसफ़र करने के �लए उसे �नयं��त करता
है

4. जब DMA �ांसफ़र हो रहा हो, तब सीपीय ूबस को �नयं��त करता है, और बस को छोड़ने से पहले
आव�यक डटेा �ांसफ़र करता है

Question Type : MCQ
Question ID : 6182781865

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.6 MS Excel 2016 म�, वक� शीट को सरु��त कैसे �कया जाता है?

Ans 1. Click on Review > enter password > click on ok

2. Click on View > Click on Review > Protect worksheet

3. Click on Review > enter password > Protect worksheet > Click on ok

4. Click on Review > Protect worksheet > enter password > click on ok

Question Type : MCQ
Question ID : 6182781903

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.7 य�ूट�लट� �ो�ाम और ऑपरे�टगं �स�टम के �च� ह�।
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Ans 1. �डवाइस �ाइवर

2. �स�टम सॉ�टवेयर

3. ए�ल�केशन सॉ�टवेयर

4. क�टमाइ�ड सॉ�टवेयर

Question Type : MCQ
Question ID : 6182781867

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.8 �न�न�ल�खत म� से कौन एक ए�ल�केशन सॉ�टवेयर नह�ं है?

Ans 1. Tally

2. MS Word

3. Unix

4. Photoshop

Question Type : MCQ
Question ID : 6182781866

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.9 वक�  शीट का नाम कैसे बदला जाता है?

Ans 1. वक�  शीट के शीट टैब पर �सगंल ि�लक कर�> नया नाम टाइप कर�> एंटर (Enter) दबाएं

2. वक�  शीट क� शीट टैब को सेले�ट कर�> नया नाम टाइप कर�> एंटर (Enter) दबाएं

3. वक�  शीट के शीट टैब पर डबल ि�लक कर�> नया नाम टाइप कर�> एंटर (Enter) दबाएं

4. वक�  शीट के शीट टैब पर ले�ट ि�लक कर�> नया नाम टाइप कर� > एंटर (Enter) दबाएँ

Question Type : MCQ
Question ID : 6182781890

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.10 य�द हम MS Excel म� Pi चाट� बनाने के �लए डटेा क� एका�धक �ृंखलाओ ं(Series) का चयन करत ेह�, तो
�या होगा?

Ans 1. यह एका�धक �ृंखलाओ ं(Series) को ले लेगा

2. यह पहल� �ृंखला (Series) को छोड़कर सभी क� उपे�ा (Ignore) करेगा

3. यह अ�ंतम �ृंखला (Series) को ले लेगा

4. यह दसूर� �ृंखला (Series) को ले लेगा

Question Type : MCQ
Question ID : 6182781908

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.11 SCSI का पणू� �प �या है? ANKAJ INFOTECH
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Ans 1. �मॉल क��यटूर �स�टम इंट��ेट (Small Computer System Integrate)

2. उपरो�त म� से कोई नह�ं (None of the above)

3. सेम कं�यटूर �स�टम इंटरफ़ेस (Same Computer System Interface)

4. �मॉल कं�यटूर �स�टम इंटरफ़ेस (Small Computer System Interface)

Question Type : MCQ
Question ID : 6182781874

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.12 MS Word 2016 म�, ‘Symbols’ �रबन पर �कस टैब के अतंग�त मौजदू होता है?

Ans 1. होम टैब

2. �य ूटैब

3. इ�सट� टैब

4. र��य ूटैब

Question Type : MCQ
Question ID : 6182781910

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.13 CIFS का पणू� �प �या है?

Ans 1. कॉप�रेट इंटरनेट फ़ाइल �स�टम

2. कलेि�टव इंटरनेट फाइल �स�टम

3. क�यनूल इंटरनेट फाइल �स�टम

4. कॉमन इंटरनेट फाइल �स�टम

Question Type : MCQ
Question ID : 6182781916

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.14 MS Word डॉ�यमू�ट म� टे��ट को कॉपी और मवू कैसे �कया जाता है?

Ans 1. Ctrl + F6 और Ctrl + F7 दबाकर

2. Ctrl + V और Ctrl + C

3. Ctrl + C और Ctrl + V

4. Ctrl + F7 और Ctrl + F6 दबाकर

Question Type : MCQ
Question ID : 6182781883

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.15 फ़ॉ�ट के केस (case) को बदलने के �लए शॉट�कट कंुजी �या है?
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Ans 1. Crtl + C

2. F2

3. Shift + F3

4. F7

Question Type : MCQ
Question ID : 6182781884

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.16 MS Excel म� से�स क� एक पंि�त को फ़ॉम�ट कैसे �कया जाता है?

Ans 1. MS Excel> Select row of cell(s)>Left Click>Format cell

2. MS Excel>Home>Select row of cell(s)> Format cell

3. MS Excel>Home>Select row of cell(s)>Right Click>Format cell

4. MS Excel> Select row of cell(s)>Right Click>Format cell

Question Type : MCQ
Question ID : 6182781901

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.17 MS Word 2016 म�, मे�लगं लेब�स कैसे बनाया जाता है?

Ans 1. Mailings Tab>Labels> New document

2. Design> Labels> New document >Mailings Tab

3. Home > Labels> Mailings Tab> New document

4. Mailings Tab > New document> Labels

Question Type : MCQ
Question ID : 6182781888

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.18 �ॉडब�ड कने�शन का अ�भ�ाय ______ से है।
Ans 1. vSAT

2. मोबाइल �स�नल

3. इ�टरनेट कने�शन

4. डायल अप

Question Type : MCQ
Question ID : 6182781918

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.19 In MS Word 2016, word count is found under ____ menu.
Ans 1. Review
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2. Design

3. File

4. View

Question Type : MCQ
Question ID : 6182781882

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.20 र�सायकल �बन एक कचरे का �थान (trash location) है, जहाँ �डल�ट क� गई फ़ाइल� सं�ह�त होती ह�, यह
�कस �कार होता है?

Ans 1. �वचा�लत �प से (Automatically)

2. यजूर को �डलेटेड फाइ�स मे�यअुल� र�सायकल �बन म� �टोर करना होगा (User has to store
deleted file in the recycle bin manually)

3. �नि�चत अव�ध के �लए (For fixed duration)

4. �वचा�लत �प से नह�ं (Not automatically)

Question Type : MCQ
Question ID : 6182781870

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.21 To store or hold the data temporarily that is being transmitted either between two
devices or between a device or an application is called:

Ans 1. Registering

2. Buffering

3. Spooling

4. Suffering

Question Type : MCQ
Question ID : 6182781872

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.22 MS Office 2016 म�, टे��ट को कट करने के �लए �य�ुत शॉट�कट कंुजी �या है?

Ans 1. CTRL+C

2. CTRL+V

3. CTRL+Z

4. CTRL+X

Question Type : MCQ
Question ID : 6182781873

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.23 How to merge cells in MS Excel?
Ans ANKAJ INFOTECH
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1. Open Worksheet>Home>Select a cell and right click> Format
cells>Alignment>Select merge cell>OK

2. Open Worksheet>Home>Select a cell and right click>Alignment>Select merge cell

3. Open Worksheet>Home>Select a cell and right click> Select merge cell>OK

4. Open Worksheet> Select a cell >Alignment>Select merge cell>OK

Question Type : MCQ
Question ID : 6182781899

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.24 MS Word म� Ctrl + A का काय� �या है?

Ans 1. छ�व Affix कर� (Affix image)

2. दोहराव से बच� (Avoid duplication)

3. सभी ऑ�जे�ट का चयन कर� (Select all objects)

4. ए�नोटेट (Annotate)

Question Type : MCQ
Question ID : 6182781889

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.25 In Ms Excel, "=NOW( )" function returns:
Ans 1. Current year

2. Current date and time

3. Current time only

4. Current month

Question Type : MCQ
Question ID : 6182781905

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.26 How to format a column of cells in MS Excel?
Ans 1. MS Excel> Select column of cell(s)>Right Click>Format cell

2. MS Excel>Home>Select column of cell(s)>Right Click>Format cell

3. MS Excel> Select column of cell(s)>Left Click>Format cell

4. MS Excel>Home>Select column of cell(s)> Format cell

Question Type : MCQ
Question ID : 6182781900

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.27 MS PowerPoint 2016 म� Date and Time फ़ं�शन कहाँ पाया गया है?

Ans 1. Insert
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2. View

3. review tab

4. File

Question Type : MCQ
Question ID : 6182781914

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.28 सेले�ट �कए गए कॉलम के बा� ओर एक कॉलम कैसे जोड़ा जाता है?

Ans 1. Double click on current cell>Insert>select on entire column>OK

2. Single click on current cell>Insert>select on entire column>OK

3. Right click on current cell> select on entire column>OK

4. Right click on current cell>Insert>select on entire column>OK

Question Type : MCQ
Question ID : 6182781891

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.29 MS Word म� मेल मज� क� कैटलॉग म� ______ शा�मल होती है।
Ans 1. �रकाड� क� सचूी (List of records)

2. स��य �वडंो क� सचूी (List of active windows)

3. लेबल� क� सचूी (List of labels)

4. डटेा �ोत क� सचूी (List of Data source)

Question Type : MCQ
Question ID : 6182781885

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.30 MS Excel म�, FLOOR () फ़ं�शन ___ है।
Ans 1. �व�तीय फ़ं�शन (Financial Functions)

2. टे��ट फ़ं�शन (Text function)

3. सांि�यक�य फ़ं�शन (Statistical function)

4. ग�णतीय फ़ं�शन (Mathematical function)

Question Type : MCQ
Question ID : 6182781907

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.31 MS Word म�, CTRL + F इनम� से �कसके �लए �य�ुत क�बोड� शॉट�कट है?

Ans 1. सच�
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2. र��लेस

3. सेव

4. हे�प

Question Type : MCQ
Question ID : 6182781880

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.32 मेल मज� म� डटेा �ोत म� जानकार� कैसे �यवि�थत क� जाती है?

Ans 1. परैा�ा�स

2. चाट�

3. म�ै��स

4. टेबल

Question Type : MCQ
Question ID : 6182781887

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.33 MS Excel म� पंि�त क� ऊंचाई का आकार कैसे बदला जाता है?

Ans 1. रो (Row) को सेले�ट कर�> रो (Row) को तब तक खींच�, जब तक �क यह वां�छत (desired) आकार
क� न हो जाए

2. रो �व�थ (Row width) को सेले�ट कर�> रो (Row) पर ि�लक कर�, जब तक �क यह वां�छत
(desired) आकार क� न हो जाए

3. रो �व�थ (Row width) को सेले�ट कर� > रो �व�थ (Row width) को तब तक खींच�, जब तक �क
यह वां�छत (desired) आकार क� न हो जाए

4. रो (Row) पर ि�लक कर�> रो (Row) पर ि�लक कर�, जब तक �क यह वां�छत (desired) आकार क�
न हो जाए

Question Type : MCQ
Question ID : 6182781894

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.34 MS Excel 2016 म� Fill �ॉप डाउन सचूी के अतंग�त �कतने �वक�प उपल�ध ह�?
Ans 1. 8

2. 20

3. 15

4. 1

Question Type : MCQ
Question ID : 6182781902

Status : Answered
Chosen Option : 1

Marks : 1.00
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Q.35 MS Excel 2016 म�, सरु�ा के �लए वक� बकु को कैसे �छपाया जाता है?

Ans 1. र��य ूटैब म�, ए�से�स�ब�लट� �ुप म�, हाइड या अनहाइड पर ि�लक कर�।

2. इ�सट� टैब म�, �फ़�टर �ुप म�, हाइड या अनहाइड पर ि�लक कर�।

3. �य ूटैब म�, �वडंो �ुप म�, हाइड या अनहाइड पर ि�लक कर�।

4. �डज़ाइन टैब म�, �वडंो �ुप म�, हाइड या अनहाइड पर ि�लक कर�।

Question Type : MCQ
Question ID : 6182781896

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.36 इंटरनेट म� सव�र को ______ के �प म� भी जाना जाता है।
Ans 1. गेटवे

2. ��ज

3. वेब सव�र

4. मॉडमे

Question Type : MCQ
Question ID : 6182781920

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.37 अस�बलर ______ �पांत�रत करता है।
Ans 1. मशीन कोड को हाई लेवल ल��वेज म�

2. अस�बल� लेवल ल��वेज को हाई लेवल ल��वेज म�

3. अस�बल� लेवल ल��वेज को मशीन कोड म�

4. हाई लेवल ल��वेज को अस�बल� लेवल ल��वेज म�

Question Type : MCQ
Question ID : 6182781869

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.38 कौन सी डटेा एं�� तकनीक यह पता लगाती है �क दज� �कया जाने वाला मान, MS Excel शीट म� दज� �कए गए
�पछले मान के समान है?

Ans 1. ऑटो �फ़ल

2. �पक �ॉम �ॉप डाउन �ल�ट

3. ऑटो कं�ल�ट

4. �फ़ल सीर�ज़

Question Type : MCQ
Question ID : 6182781895

Status : Answered
Chosen Option : 1

Marks : 0.00
ANKAJ INFOTECH



1/28/2020 https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S80D449/157710393828853…

https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S80D449/15771039382885394/194008… 11/16

Q.39 I/O य�ूनट इनम� से �कसका �नयं�ण करती है?

Ans 1. केवल ��टंर

2. केवल पेर�फ़ेरल

3. केवल �ोसेसर के संचार का

4. �ोसेसर के पेर�फ़ेरल के साथ संचार का

Question Type : MCQ
Question ID : 6182781863

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.40 मािज�न MS Excel 2016 म� ____ मेन ूके तहत उपल�ध ह�।
Ans 1. Home

2. Layout

3. File

4. Review

Question Type : MCQ
Question ID : 6182781892

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.41 PowerPoint �लाइड म� गाइड म� ______ होती ह�।
Ans 1. दो �ै�तज �बदंदुार रेखाएं (Two horizontal dotted lines)

2. एक �ै�तज और एक ऊ�वा�धर �बदंदुार रेखाएं (One horizontal and a vertical dotted lines)

3. एक �ै�तज और एक ऊ�वा�धर गहर� रेखाएं (One horizontal and a vertical deep lines)

4. दो ऊ�वा�धर �बदंदुार रेखाएं (Two vertical dotted lines)

Question Type : MCQ
Question ID : 6182781911

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.42 �न�न�ल�खत म� से कौन मेल मज� म� �डफ़ॉ�ट द�तावेज़ �कार नह�ं है?

Ans 1. letters

2. template

3. PowerPoint

4. Paint

Question Type : MCQ
Question ID : 6182781886

Status : Answered
Chosen Option : 2

Marks : 0.00
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Q.43 वह कंुजी-संयोजन �या है, जो सभी खलु� वक� ब�ुस म� मौजदू सभी वक� शीट क� गणना करता है, चाहे MS
Excel म� अ�ंतम गणना के बाद उनम� कोई प�रवत�न हुआ हो या नह�ं?

Ans 1. CTRL + F9

2. SHIFT + F9

3. CTRL + ALT + F9

4. ALT + F8

Question Type : MCQ
Question ID : 6182781893

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.44 �न�न�ल�खत म� से कौन सी पहल� हाई लेवल सामा�य-�योजन (general-purpose) �ो�ा�मगं भाषा है?

Ans 1. FORTRAN

2. PASCAL

3. C

4. BASIC

Question Type : MCQ
Question ID : 6182781868

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.45 Ms Excel 2016 म�, वक� बकु फ़ाइल को र�ड, राइट, मॉ�डफ़ाई या ए�जी�यटू करने के अनमु�त को सरु��त
कैसे �कया जाता है?

Ans 1. File > options > Protect Work book > Restrict Access

2. Home Tab > Info > Protect Work book > Restrict Access

3. View > Info > Protect Work book > Restrict Access

4. File Tab> Info > Protect Work book > Restrict Access

Question Type : MCQ
Question ID : 6182781897

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.46 Ctrl + Shift + = _______के �लए उपयोग �कया जाता है:

Ans 1. new slide

2. Subscript

3. superscript

4. sort

Question Type : MCQ
Question ID : 6182781912

Status : Answered
Chosen Option : 4

Marks : 0.00
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Q.47 MS Word 2016 म�, ‘Screenshot’ �रबन पर �कस टैब के अतंग�त मौजदू होता है?

Ans 1. होम टैब

2. इ�सट� टैब

3. �य ूटैब

4. र��य ूटैब

Question Type : MCQ
Question ID : 6182781909

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.48 Windows XP म� MS Word को �टाट� करने क� ���या �या है?

Ans 1. Start > MS Office > Programs >MS Word

2. Start >Programs > MS Word >MS Office

3. Start >All Programs >MS Office >MS Word

4. Start > MS Word> MS Office > Programs

Question Type : MCQ
Question ID : 6182781875

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.49 SMB का पणू� �प �या है?

Ans 1. सपुर मसेैज �लॉक

2. स�ट मसेैज �लॉक

3. सव�र मसेैज �लॉक

4. सव�र मेगा �लॉक

Question Type : MCQ
Question ID : 6182781917

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.50 �लाइड सॉट�र �य ू�या �द�श�त करता है?

Ans 1. केवल �वषम सं�या �मांक वाले �लाइड (Only slide with odd number)

2. �ै�तज �म म� आपके �ेज�टेशन के सभी �लाइड, थंबने�स (All the slides in your presentation
in horizontally sequenced, thumbnails)

3. आपके �ेज�टेशन म� से कोई �लाइड नह�ं (No one slide in your presentation)

4. �ै�तज �म म� आपके �ेज�टेशन म� से एक �लाइड, थंबने�स (One slides in your presentation
in horizontally sequenced, thumbnails)

Question Type : MCQ
Question ID : 6182781913

Status : Answered
Chosen Option : 1

Marks : 0.00
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Q.51 MS Excel 2016 म�, "Insert tab" के �लए �न�न म� से �कस शॉट�कट कंुजी का उपयोग �कया जाता है?

Ans 1. Alt+S

2. Alt+T

3. Shift+N

4. Alt+N

Question Type : MCQ
Question ID : 6182781906

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.52 Ms Excel 2016 म�, �दनांक को फॉम�ट कैसे �कया जाता है?

Ans 1. Open Worksheet>Home>Select a cell and right click>Number>Select date> OK

2. Open Worksheet>Home>Select a cell and right click> Select date>Type>OK

3. Open Worksheet>Home>Select a cell and right click> Format cells>Number>Select
date>Type>OK

4. Open Worksheet> Select a cell and right click>Number>Select date>Type>OK

Question Type : MCQ
Question ID : 6182781898

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.53 MS PowerPoint म�, �वचा�लत शो को रोकने या पनुः आरंभ करने के �लए ______ दबाएँ।
Ans 1. T

2. F3

3. S

4. F6

Question Type : MCQ
Question ID : 6182781915

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.54 �नद�श� को ______ म� सं�ह�त �कया जा सकता है।
Ans 1. i/o �डवाइसेस

2. अ�रथमे�टकल एंड लॉिजकल य�ूनट

3. मेमोर�

4. से��ल �ोसे�सगं य�ूनट

Question Type : MCQ
Question ID : 6182781861

Status : Answered
Chosen Option : 3

Marks : 1.00
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Q.55 ई-मेल ए�से म�, Bcc का पणू� �प �या है?

Ans 1. �बहाइंड काब�न कॉपी

2. �लकै काब�न कॉपी

3. �ल�क काब�न कॉपी

4. �लाइंड काब�न कॉपी

Question Type : MCQ
Question ID : 6182781919

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.56 MS Excel 2016 म�, वक� शीट को असरु��त कैसे �कया जाता है?

Ans 1. Click on Review > enter password > Click on ok

2. click on View > Click on Review > unprotect worksheet

3. Click on Review > unprotect worksheet > enter password > Click on ok

4. Click on Review > enter password > unprotect worksheet > Click on ok

Question Type : MCQ
Question ID : 6182781904

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.57 �वडंोज़ ऑपरे�टगं �स�टम म�, �ह��� म� ______ सचूीब� होत ेह�।
Ans 1. एकदम हाल ह� म� खोले गए �ो�ाम और फाइल� नह�ं

2. बहुत पहले खोले गए �ो�ाम और फाइल�

3. एकदम हाल ह� म� खोले गए �ो�ाम और फाइल�

4. केवल �पछले मह�ने क� फाइल�

Question Type : MCQ
Question ID : 6182781871

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.58 MS Word2016 म�, एक परैा�ाफ को ज�ट�फ़ाई कैसे करत ेह�?
Ans 1. MS Word डॉ�यमू�ट खोल�> होम (Home) टैब> डॉ�यमू��स क� साम�ी का चयन कर�> ज�ट�फ़ाई

(Justify) पर ि�लक कर�

2. मौजदूा MS Word डॉ�यमू�ट खोल�> इ�सर ्(Insert) टैब > ज�ट�फ़ाई (Justify) पर ि�लक कर�

3. मौजदूा MS Word डॉ�यमू�ट खोल� > �डज़ाइन (Design) टैब> डॉ�यमू��स क� साम�ी (Content)

का चयन कर�> परैा�ाफ़ डायलॉग बॉ�स लॉ�चर> ज�ट�फ़ाई (Justify) पर ि�लक कर�

4. �य ू(View) टैब > डॉ�यमू��स क� साम�ी (Content) का चयन कर�> परैा�ाफ़ डायलॉग बॉ�स
लॉ�चर > ज�ट�फ़ाई (Justify) पर ि�लक कर�

Question Type : MCQ
Question ID : 6182781877

Status : Answered
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Chosen Option : 2
Marks : 0.00

Q.59 ______ �य,ू MS Word डॉ�यमू�ट म� मािज�न, हेडर, फुटर, पेज �ेक और वाटर माक�  जसेै अवयव� को �द�श�त
करता है।

Ans 1. आउटलाइन �यू

2. �ा�ट

3. ��टं लेआउट �यू

4. वेब लेआउट �यू

Question Type : MCQ
Question ID : 6182781881

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.60 वह पेर�फ़ेरल उपकरण, िजसका उपयोग �कसी काग़ज़ पर �ा�फकल आउटपटु ��टं करने के �लए �कया जाता
है, ______ कहलाता है।

Ans 1. इनपटु �ोसे�सगं य�ूनट

2. �लॉटर

3. ��टंर

4. से��ल �ोसे�सगं य�ूनट

Question Type : MCQ
Question ID : 6182781864

Status : Answered
Chosen Option : 3

Marks : 0.00
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Q.1 आप अपनी वक� बकु को गलती से अपना फ़ॉम�ट और टे��ट या अ�य यज़ुस� �वारा ए�सेस करने से रोकने के
�लए ________ कर सकत ेह�।

Ans 1. हाइड

2. �ोटे�ट

3. ऐड

4. �ड�लट

Question Type : MCQ
Question ID : 6182782016

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.2 MS-Excel 2016 म� मज� एंड स�टर का �वक�प कहाँ पाया जाता है?

Ans 1. इ�सट� (Insert) टैब पर �ल�ंस �ुप म�

2. पेज लेआउट (Page layout) टैब पर एलाइनम�ट �ुप म�

3. होम (Home) टैब पर से�स �ुप म�

4. होम (Home) टैब पर एलाइनम�ट �ुप म�

Question Type : MCQ
Question ID : 6182782015

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.3 मॉडमे क� ग�त को ________ म� मापा जाता है।
Ans 1. �ब�स ��त सेकंड

2. बाइ�स ��त घंटा

3. मेगाबाइ�स

4. टे�ा बाइ�स

Participant ID 19450296
Participant Name SACHIN KUMAR SINGH
Test Center Name iON Digital Zone iDZ Jalalpur
Test Date 23/12/2019
Test Time 9:00 AM - 10:00 AM
Subject Data Entry Operator
Marks Obtained 32.00000

Section : MCQ for Data Entry Operator
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Question Type : MCQ
Question ID : 6182782038

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.4 MS-Word 2016 के एक टेबल म� असी�मत रोज और अ�धकतम ________ कॉल�स हो सकत ेह�।
Ans 1. 256

2. 100

3. 81

4. 63

Question Type : MCQ
Question ID : 6182782004

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.5 �व�भ�न सॉ�टवेयर �ो�ा�स म� अलग-अलग _________ होत ेह� जो उ�ह� �वज़अुल� (visually) पहचानने म�
मदद करत ेह�।

Ans 1. फ़ो�डर

2. आइकॉ�स

3. सॉ�टवेयर

4. डॉ�यमू�ट

Question Type : MCQ
Question ID : 6182781993

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.6 Watch Window फ़ं�शन MS Excel 2016 म� _____ मेन ूके तहत उपल�ध है।
Ans 1. Formula

2. Home

3. File

4. Review

Question Type : MCQ
Question ID : 6182782018

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.7 MS-Word म� �न�न�ल�खत ऑ�जे��स (व�तओु)ं म� से कौन सा टाइ�पगं �े� का एक �ह�सा है?

Ans 1. �लर

2. ��ोल बार

3. �टैटस बार

4. टाइटल बार
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Question Type : MCQ
Question ID : 6182781997

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.8 एक �स�टम के �ह�स� को देखा और �पश� �कया जा सकता है, उ�ह� �या कहा जाता है?

Ans 1. य�ूट�लट� सॉ�टवेयर

2. �स�टम सॉ�टवेयर

3. हाड�वेअर

4. ए�ल�केशन

Question Type : MCQ
Question ID : 6182781984

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.9 नई MS Word फ़ाइल खोलने के �लए शॉट� कट कंुजी �या है?

Ans 1. Ctrl + W

2. Ctrl + M

3. Ctrl + N

4. Ctrl + O

Question Type : MCQ
Question ID : 6182781998

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.10 The ________ option is used to stop the action of the Undo option.
Ans 1. Paste

2. Cut

3. Redo

4. do

Question Type : MCQ
Question ID : 6182782001

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.11 आप एक फ़ाइल म� अपना मेल मज� ____ कर सकत ेह�, ता�क सभी डा�यमू��स एक फ़ाइल म� ह�।
Ans 1. ��टं

2. �ड�लट

3. �रराइट

4. ऐ�से�ट
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Question Type : MCQ
Question ID : 6182782009

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.12 MS-Word 2016 म� �पे�लगं एंड �ामर चेक �वक�प �र�य ूटैब के _______ �ुप म� उपल�ध है।
Ans 1. च�जेस

2. ल��वेज

3. ��ूफंग

4. �ै�कंग

Question Type : MCQ
Question ID : 6182782003

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.13 MS-Excel म� य�द आप �कसी यज़ूस� को वक� शीट तक पहँुचने से सरु��त रखना चाहत ेह�, तो अपनी फ़ाइल को
_________ द�।

Ans 1. पासवड�

2. फ़ाइलनेम

3. नंबर

4. मेसेज

Question Type : MCQ
Question ID : 6182782023

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.14 श�ेस �ॉप-डाउन बटन MS-Excel 2016 म� इ�सट� टैब के ________ �ुप के अतंग�त उपल�ध है।
Ans 1. इल��ेश�स

2. चा��स

3. टेब�स

4. टे��ट

Question Type : MCQ
Question ID : 6182782029

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.15 A _______ is the address of a World Wide Web page.
Ans 1. Protocol

2. URL

3. HTTP

4. ISP
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Question Type : MCQ
Question ID : 6182782040

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.16 MS-Word म� ________ बार डॉ�यमू��स (द�तावेज़) का नाम और सॉ�टवेयर का नाम दशा�ता है।
Ans 1. ��ोल

2. �टैटस

3. ओपन

4. टाइटल

Question Type : MCQ
Question ID : 6182781996

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.17 _______ एक सॉ�टवेयर है, िजसका उपयोग प�, स�ूचयाँ, क�वताएँ आ�द जसेै डॉ�यमू��स (द�तावेज़) बनाने
के �लए �कया जाता है।

Ans 1. MS Paint

2. Windows Media Player

3. MS Word

4. Audacity

Question Type : MCQ
Question ID : 6182781995

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.18 MS Excel म� सीधे �कसी सेल पर जाने के �लए आप ________ म� उसका सेल ए�से टाइप कर सकत ेह�।
Ans 1. नेम बॉ�स

2. फ़ॉमू�ला बार

3. टाइटल बार

4. �टेटस बार

Question Type : MCQ
Question ID : 6182782013

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.19 WWW stands for:
Ans 1. World Wide Web

2. Water way web

3. Web wise world

4. World wise web
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Question Type : MCQ
Question ID : 6182782039

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.20 ________ म�, य�द आप पहल� बार डटेा सोस� (�ोत) बना रहे ह�, तो रे�डयो बटन चनु�।
Ans 1. टाइप अ �य ू�ल�ट (Type a new list)

2. एम एस ए�सेल (MS Excel)

3. ऑड�ेसट� (Audacity)

4. एम एस प�ट (MS Paint)

Question Type : MCQ
Question ID : 6182782007

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.21 MS-Excel 2010 म� पहल� और आ�खर� से�स के �लए सेल ए�से, �मशः _________ ह�।
Ans 1. B1 और XFD1048576

2. D1 और XFD1048578

3. A1 और XFD1048575

4. C1 और XFD1048577

Question Type : MCQ
Question ID : 6182782012

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.22 ______ का अ�र� , सं�याय� और वण� को टाइप करने के �लए उपयोग �कया जाता है।
Ans 1. �कैनर

2. क�बोड�

3. माउस

4. ��टंर

Question Type : MCQ
Question ID : 6182781983

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.23 MS-Excel 2016 म� रैप टे��ट (Wrap text) बटन Home टैब के ________ �ुप के अतंग�त उपल�ध होता
है।

Ans 1. नंबर

2. एलाइनम�ट

3. फ़ॉ�ट

4. ि�लपबोड�
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Question Type : MCQ
Question ID : 6182782014

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.24 An ________ is an example of system software.
Ans 1. MS Word

2. Paint

3. MS Excel

4. Linux

Question Type : MCQ
Question ID : 6182781986

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.25 Which of the following represents the extension to save PowerPoint presentations?
Ans 1. .ptx

2. .ppx

3. .px

4. .pptx

Question Type : MCQ
Question ID : 6182782032

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.26 Which of the following is not an input device?
Ans 1. mouse

2. joystick

3. keyboard

4. monitor

Question Type : MCQ
Question ID : 6182781985

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.27 A type of chart used to compare data using horizontal bar is called ________ chart.
Ans 1. Bar chart

2. Pie chart

3. Line chart

4. column chart

Question Type : MCQ
Question ID : 6182782028
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Status : Answered
Chosen Option : 4

Marks : 0.00

Q.28 MS Word के �कसी टे��ट पर कोई भी ए�शन जसेै कॉपी करना, �हलाना आ�द करने से पहले आपको टे��ट
______ करना होगा।

Ans 1. �सले�ट

2. ए�डट

3. �डल�ट

4. हाईलाइट �वथ कलर

Question Type : MCQ
Question ID : 6182782000

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.29 MS-Word म� मेल मज� का उपयोग �व�भ�न �ा�तकता�ओ ंको भेजे जाने वाले प� क� _________ ��तयाँ
बनाने के �लए �कया जाता है।

Ans 1. चौगुनी (�वा�पल)

2. �तहरा (��पल)

3. अनेक (म�ट�पल)

4. एकल (�सगंल)

Question Type : MCQ
Question ID : 6182782006

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.30 आप MS Excel 2016 म� �माट�आट� �ा�फ�स म� कलर वे�रएंश�स _______ टैब के तहत �माट�आट�
�टाइ�स से च�ज कलस� �ॉप-डाउन मे�य ूपर ि�लक करके लगा सकत ेह�।

Ans 1. �डज़ाइन

2. होम

3. इ�सट�

4. फ़ॉम�ट

Question Type : MCQ
Question ID : 6182782030

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.31 MS-Excel म� हम सेल का चयन करने के बाद _________ दबाकर सेल कंटे��स बदल सकत ेह�।
Ans 1. F2

2. F3

3. F4

4. F1
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Question Type : MCQ
Question ID : 6182782019

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.32 A ________ document is created in Mail Merge when one merges the main document
with the data source.

Ans 1. saved

2. merged

3. printed

4. edited

Question Type : MCQ
Question ID : 6182782005

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.33 MS-Excel म� कॉलम क� चौड़ाई बदलने के �लए हम माउस पॉइंटर को कॉलम हे�डगं क� लाइन पर ले जात ेह�,
जब तक �क यह _______ एरो के �प म� �दखाई न दे।

Ans 1. डबल

2. �सगंल

3. कस�र

4. �मॉल

Question Type : MCQ
Question ID : 6182782021

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.34 Which option of MS-PowerPoint helps display a series of slides on the full computer
screen?

Ans 1. Slide Show

2. Zoom Control

3. Slide Sorter

4. Placeholder

Question Type : MCQ
Question ID : 6182782033

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.35 In MS-PowerPoint, to move to the next slide, press the _______ arrow key from the
keyboard.

Ans 1. Esc

2. Shift

3. Down
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4. Up

Question Type : MCQ
Question ID : 6182782035

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.36 �न�न�ल�खत म� से कौन सा कं�यटूर का एक �कार है?

Ans 1. वायर �ेम

2. �ड�क �ेम

3. �ल ू�ेम

4. मनै �ेम

Question Type : MCQ
Question ID : 6182781982

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.37 MS-Excel म� �ोटे�ट वक� बकु �वक�प _________ टैब के अतंग�त उपल�ध होता है।
Ans 1. �र�यू

2. लेआउट

3. �यू

4. �डज़ाइन

Question Type : MCQ
Question ID : 6182782024

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.38 कं�यटूर पर फ़ाइ�स का पता लगाना आसान होता है, जब उ�ह� __________ म� �टोर �कया जाता है।
Ans 1. बॉ�स

2. कै�बनेट

3. फ़ाइल

4. फ़ो�डर

Question Type : MCQ
Question ID : 6182781992

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.39 _________ सॉ�टवेयर ऐसे �ो�ा�स है, जो यजूर को कुछ �कार के काय� करने म� मदद करने के �लए
�डज़ाइन �कया गया है।

Ans 1. मनेैजम�ट

2. य�ूट�लट�
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3. �स�टम

4. ए�ल�केशन

Question Type : MCQ
Question ID : 6182781987

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.40 वक� शीट म� कॉलम चनुने के �लए बटन के �कस संयोजन का उपयोग �कया जाता है?

Ans 1. Shift + Spacebar

2. Ctrl + Spacebar

3. Caps Lock + Spacebar

4. Alt + Spacebar

Question Type : MCQ
Question ID : 6182782011

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.41 ________ परेू �ो�ाम का एक बार म� अनवुाद करता है।
Ans 1. क�पाइलर

2. �ो�ाम

3. इंटर�ेटर

4. अस�बलर

Question Type : MCQ
Question ID : 6182781989

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.42 When you start MS PowerPoint 2016, it opens a new presentation with the title
___________.

Ans 1. Presentation@1

2. Presentation1

3. Presentation-1

4. Presentation_1

Question Type : MCQ
Question ID : 6182782031

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.43 By default, in a Word document, a spelling mistake is highlighted with a _______ wavy
line.

Ans 1. orange

2. red
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3. green

4. blue

Question Type : MCQ
Question ID : 6182782002

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.44 A workbook in ______ is assigned a default name as Book1.
Ans 1. MS Word

2. MS Excel

3. MS PowerPoint

4. MS Access

Question Type : MCQ
Question ID : 6182782010

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.45 MS Excel म� _________ तक� को �वीकार करता है और प�रणाम देता है।
Ans 1. फ़ं�शन

2. चाट�

3. �प�चर

4. हाइपर�लकं

Question Type : MCQ
Question ID : 6182782027

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.46 _________ पहल� बार कं�यटूर म� एक सॉ�टवेयर या हाड�वेयर डालने को संद�भ�त करता है।
Ans 1. जनरेशन

2. एि�टवेशन

3. इं�टालेशन

4. अ�वूल

Question Type : MCQ
Question ID : 6182781994

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.47 लंबाई, अ�र� का उपयोग या सं�या के संबंध म� पासवड� पर कोई ��तबंध नह�ं है; हालाँ�क, पासवड� MS-Excel
म� _________ ह�।

Ans 1. केस-स��स�टव

2. �फ��ड
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3. नॉट केस-स��स�टव

4. �ल�मटेड

Question Type : MCQ
Question ID : 6182782017

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.48 �कसी वक� शीट म� एक संपणू� कॉलम को हटाने के �लए �ड�लट सेल �ॉप-डाउन सचूी म� _________ �वक�प पर
ि�लक कर�।

Ans 1. �डल�ट शीट कॉल�स

2. �डल�ट शीट

3. �डल�ट शीट रोज

4. �डल�ट शीट से�स

Question Type : MCQ
Question ID : 6182782020

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.49 आप अ�य उपयोगकता�ओ ंको यह बताने के �लए �क फ़ाइल आपके �वारा बनाई गई है, ____ का उपयोग कर
सकत ेह�।

Ans 1. मज�

2. वॉटरमाक�

3. हाइपर�लकं

4. कॉपी

Question Type : MCQ
Question ID : 6182782026

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.50 कं�यटूर केवल __________ भाषा समझता है।
Ans 1. �डनर�

2. बायनर�

3. थड� जनरेशन

4. डसेीमल

Question Type : MCQ
Question ID : 6182781988

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.51 ________ नेटवक�  का एक पर�पर संबंध है।
Ans 1. राऊटर
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2. मॉडमे

3. ऐ�टेना

4. इंटरनेट

Question Type : MCQ
Question ID : 6182782036

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.52 _________ उन सभी व�तओु ंक� �यव�था है जो MS-PowerPoint के �ेज�टेशन म� �लाइड बनात ेह�।
Ans 1. �लाईड सॉट�र

2. �य ू�लाइड

3. �लाइड शो

4. �लाइड लेआउट

Question Type : MCQ
Question ID : 6182782034

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.53 कं�यटूर ______ का उपयोग करके �दनांक और समय दशा�ता है।
Ans 1. �टाट� बटन

2. फ़ाइल

3. फ़ो�डर

4. �स�टम �लॉक

Question Type : MCQ
Question ID : 6182781990

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.54 ________ आमतौर पर अध�चालक� (सेमीकंड�टस�) से बना होता है।
Ans 1. CD

2. हाड��ड�क

3. �लॉपी �ड�क

4. RAM

Question Type : MCQ
Question ID : 6182781981

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.55 ______ �कसी द�तावेज़ को ��टं करने के �लए से�ट�ंस चनुने का �वक�प �दान करता है।
Ans 1. Reading Layout
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2. Print Preview

3. Web Layout

4. Document Preview

Question Type : MCQ
Question ID : 6182781999

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.56 ________ उ�चतम ग�त (हाईए�ट �पीड) इंटरनेट ए�सेस �दान करता है।
Ans 1. ट� सी पी (TCP)

2. डायल-अप (Dial-up)

3. आय एस पी (ISP)

4. �ॉडब�ड (Broadband)

Question Type : MCQ
Question ID : 6182782037

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.57 मेल मज� म�, _________ एक �लेसहो�डर है जहाँ डटेा सोस� (�ोत) से वा�त�वक डटेा डाला जाएगा।
Ans 1. डटेा सोस�

2. टे�पलेट

3. मेन डॉ�यमू�ट

4. मज� फ़��ड

Question Type : MCQ
Question ID : 6182782008

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.58 कं�यटूर �स�टम म� ड�ेकटॉप के बकै�ाउंड म� होने वाले �च� को ड�ेकटॉप _________ कहा जाता है।
Ans 1. टे��ट

2. बकै�ाउंड

3. �प�चर

4. इमेज

Question Type : MCQ
Question ID : 6182781991

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.59 �कसी वक� शीट म� संपणू� पंि�त (row) का चयन करने के �लए शॉट� कट कंुजी �या है?

Ans 1. Ctrl + R
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2. Shift + Spacebar

3. Ctrl + A

4. Alt + R

Question Type : MCQ
Question ID : 6182782022

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.60 MS-Excel म� फ़ॉमू�ला म� �य�ुत _____ को सेल रेफर�स कहा जाता है।
Ans 1. सेल ए�से

2. कॉलम ए�से

3. रो ए�से

4. डटेा

Question Type : MCQ
Question ID : 6182782025

Status : Answered
Chosen Option : 1

Marks : 1.00
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Q.1 MS Excel म� चाट� �कसी डाटा का ______________ है।
Ans 1. �ा�फ़कल �न�पण (Graphical representation)

2. डटेा का योग (Summation of data)

3. ऑ�डयो �न�पण (Audio representation)

4. सं�या�मक �न�पण (Numerical representation)

Question Type : MCQ
Question ID : 6182782088

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.2 �न�न�ल�खत म� से �कस मेमोर� का उपयोग उस �ो�ाम डटेा को �टोर करने के �लए �कया जाता है, िजसे
वत�मान म� CPU म� ए�जी�यटू �कया जा रहा है?

Ans 1. सहायक मेमोर�

2. रैम

3. रोम

4. ��वतीयक �टोरेज

Question Type : MCQ
Question ID : 6182782043

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.3 MS Excel 2016 म�, सेले�ट क� गई से�स को �डल�ट करने हेत ु�डल�ट डायलॉग खोलने के �लए �य�ुत
शॉट�कट कंुजी �या है?

Ans 1. Ctrl+ (;)

2. Ctrl+Plus sign (+)

3. Ctrl+Minus sign (-)

Participant ID 19414268
Participant Name MANISH KUMAR CHOURASIYA
Test Center Name iON Digital Zone iDZ Jalalpur
Test Date 24/12/2019
Test Time 3:00 PM - 4:00 PM
Subject Data Entry Operator
Marks Obtained 19.00000

Section : MCQ for Data Entry Operator
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4. Ctrl+ (:)

Question Type : MCQ
Question ID : 6182782086

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.4 पावर �वाइंट 2016, �लाइड मा�टर को ______ मेन ूसे देखा जा सकता है।
Ans 1. View

2. Insert

3. Home

4. File

Question Type : MCQ
Question ID : 6182782094

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.5 एक वेबसाइट का डोमेन नाम �या दशा�ता है?

Ans 1. वेबसाइट क� आईपी

2. वेबसाइट क� �ोटोकॉल

3. वेबसाइट का नाम

4. वेबसाइट क� सरु�ा

Question Type : MCQ
Question ID : 6182782098

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.6 ____, एक कं�यटूर पर एक ऑपरे�टगं �स�टम इं�टाल करने को संद�भ�त करता है, िजसम� वत�मान म� कोई
ऑपरे�टगं �स�टम इं�टाल नह�ं है

Ans 1. अप�ेड इं�टालेशन

2. �सगंल exe इं�टालेशन

3. �ल�न इं�टालेशन

4. वेब बे�ड इं�टालेशन

Question Type : MCQ
Question ID : 6182782054

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.7 �कसी सेल क� साम�ी (content) को एक �थान नीचे �थानांत�रत कैसे �कया जाता है?

Ans 1. चय�नत सेल पर राइट-ि�लक कर� > Insert > Shift cell down > Ok

2. चय�नत सेल पर राइट-ि�लक कर�> Shift cell down > Ok

3. Insert >Shift cell down >Ok
ANKAJ INFOTECH



1/28/2020 https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S84D525/157719540782969…

https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S84D525/15771954078296951/1941426… 3/16

4. चय�नत सेल पर राइट-ि�लक कर� > Shift cell down > Done

Question Type : MCQ
Question ID : 6182782072

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.8 MS Excel 2016 म�, सेल म� wrap text कैसे �कया जाता है?

Ans 1. वक� शीट खोल�> Home > एक सेल सेले�ट कर� और उस पर राइट ि�लक कर� > Format cells>
Alignment > OK

2. वक� शीट खोल� > Home> Alignment > एक सेल सेले�ट कर� और उस पर राइट ि�लक कर� > font,

style, size चनु� > OK

3. वक� शीट खोल�> एक सेल सेले�ट कर� और उस पर राइट ि�लक कर�> Format cells>Alignment>

टे��ट कं�ोल के अतंग�त Wrap text म� �नशान लगाएं> OK

4. वक� शीट खोल�> Home> Alignment > एक सेल सेले�ट कर� और उस पर राइट ि�लक कर� >
Format cells > font, style, size चनु� > OK

Question Type : MCQ
Question ID : 6182782078

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.9 एमएस पॉवर पॉइंट म�, चय�नत आकार क� फॉम��टगं क� कॉपी करने का शॉट� �यटू कंुजी �या है?

Ans 1. Ctrl + Shift + V

2. Ctrl + C

3. Ctrl + Shift + F

4. Ctrl + Shift + C

Question Type : MCQ
Question ID : 6182782093

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.10 MS Excel 2016 म� कॉलम क� �यनूतम चौड़ाई ______ हो सकती है।
Ans 1. 10

2. 20

3. 50

4. 0

Question Type : MCQ
Question ID : 6182782075

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.11 �डल�ट क� गई फ़ाइल�, जो र�सायकल �बन म� सं�ह�त होती ह�, उ�ह� ________।
Ans 1. केवल आ�ंशक �प से र��टोड� �कया जा सकता है
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2. केवल 1 �दन के भीतर र��टोड� �कया जा सकता है

3. र��टोड� �कया जा सकता है

4. र��टोड� नह�ं �कया जा सकता है

Question Type : MCQ
Question ID : 6182782051

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.12 एमएस पावर �वाइंट 2016 म�, एक �ुप �कया �हअ ऑ�जे�ट को "अन�ुप" करने के �लए शॉट� कट कंुजी �या
है?

Ans 1. Ctrl + Shift + G

2. Alft + Shift + G

3. Ctrl + G

4. Alt + G

Question Type : MCQ
Question ID : 6182782092

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.13 मेल मज� ऑपरेशन म�, �न�न म� से कौन सा �वक�प मज� डॉ�यमू�ट से संबं�धत है?

Ans 1. म�ुय डॉ�यमू�ट, डटेा �ोत, और मज� �कया गया डॉ�यमू�ट।

2. �ाहक� के नाम और पत ेक� एक सचूी

3. लेब�स

4. एनवेलप

Question Type : MCQ
Question ID : 6182782066

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.14 MS Word 2016 म�, �कसी डॉ�यमू�ट म� पेज बॉड�र कैसे सेट �कया जाता है?

Ans 1. Design > Page borders

2. Views > Page borders

3. Insert > Page borders

4. Layout > Page borders

Question Type : MCQ
Question ID : 6182782058

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.15 MS Word डॉ�यमू�ट म� माउस का उपयोग करके �कसी टे��ट को कॉपी और आव�यक �थान पर पे�ट कैसे
�कया जाता है?
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Ans 1. MS Word फ़ाइल खोल� > माउस का उपयोग करके टे��ट सेले�ट कर� > टे��ट के चय�नत �े� म�
राइट ि�लक कर� > �ॉपडाउन सचूी म� कॉपी पर ि�लक कर� > माउस के पॉइंटर को नई ि�थ�त म� ले जाएं > पे�ट
पर ि�लक कर�

2. MS Word फ़ाइल खोल� > माउस का उपयोग करके टे��ट सेले�ट कर� > टे��ट के चय�नत �े� म�
राइट ि�लक कर� > �ॉपडाउन सचूी म� कॉपी पर ि�लक कर� > माउस के पॉइंटर को नई ि�थ�त म� ले जाएं > राइट
ि�लक कर�

3. MS Word फ़ाइल खोल� > माउस का उपयोग करके टे��ट सेले�ट कर� > टे��ट के चय�नत �े� म�
राइट ि�लक कर� > माउस के पॉइंटर को नई ि�थ�त म� ले जाएं > राइट ि�लक कर� > पे�ट पर ि�लक कर�

4. MS Word फ़ाइल खोल� > माउस का उपयोग करके टे��ट सेले�ट कर� > टे��ट के चय�नत �े� म�
राइट ि�लक कर� > �ॉपडाउन सचूी म� कॉपी पर ि�लक कर� > माउस के पॉइंटर को नई ि�थ�त म� ले जाएं > राइट
ि�लक कर� > पे�ट पर ि�लक कर�

Question Type : MCQ
Question ID : 6182782063

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.16 वॉन �यमूनै कं�यटूर �स�टम म� इनम� से �कसका उपयोग होता है?

Ans 1. डटेा �नद�श और �ो�ाम के �लए अलग अलग मेमोर� का

2. �नद�श डटेा और �ो�ाम डटेा के �लए एक ह� मेमोर� का

3. अलग डटेा मेमोर�, कोड मेमोर� और �टैक मेमोर� का

4. अलग कोड मेमोर�, और �टैक मेमोर� का

Question Type : MCQ
Question ID : 6182782041

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.17 MS Excel 2016 म� पंि�तय� के सभी से�स को �कस �कार फ़ॉम�ट �कया जा सकता है?

Ans 1. MS Excel > से�स क� पंि�त को सेले�ट कर� > ले�ट ि�लक कर� > फॉम�ट सेल �वक�प चनु�

2. MS Excel > होम > से�स क� पंि�त को सेले�ट कर� > राइट ि�लक कर� > फॉम�ट सेल �वक�प चनु�

3. MS Excel > से�स क� पंि�त को सेले�ट कर� > राइट ि�लक कर� > फॉम�ट सेल �वक�प चनु�

4. MS Excel > होम > से�स क� पंि�त को सेले�ट कर� > फॉम�ट सेल �वक�प चनु�

Question Type : MCQ
Question ID : 6182782080

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.18 ए�सेल वक� बकु को बंद करने के �लए �न�न�ल�खत म� से �कस शॉट�कट कंुजी का उपयोग �कया जाता है?

Ans 1. Ctrl+N

2. Ctrl+W

3. Ctrl+F3

4. Shift+F11

Question Type : MCQANKAJ INFOTECH
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Question ID : 6182782070
Status : Answered

Chosen Option : 4
Marks : 0.00

Q.19 वह सॉ�टवेयर, िजसका उपयोग हाई लेवल ल��वेज म� �लखे गए �ो�ाम को मशीन कोड म� �पांत�रत करने के
�लए �कया जाता है, �या कहलाता है?

Ans 1. वे�टर �ोसेसर

2. �केलर �ोसेसर

3. एरे �ोसेसर

4. ल��वेज �ांसलेटर

Question Type : MCQ
Question ID : 6182782049

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.20 MS Word म� Paste Special के �लए शॉट� कट क� �या है?

Ans 1. Shift + V

2. Ctrl + Shit + V

3. Ctrl + Alt + V

4. Ctrl + Shift + P

Question Type : MCQ
Question ID : 6182782064

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.21 MS Excel 2016 म�, सेल �टाइल कैसे लागू कर�?
Ans 1. MS Excel फ़ाइल > होम > सेल �टाइल > �कसी भी �टाइल पर ि�लक कर�

2. MS Excel फ़ाइल > होम > �कसी भी �टाइल पर ि�लक कर�

3. MS Excel फ़ाइल > होम > सेल �टाइल

4. MS Excel फ़ाइल > सेल �टाइल > �कसी भी �टाइल पर ि�लक कर�

Question Type : MCQ
Question ID : 6182782082

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.22 �ल�प मोड (sleep mode) �स�टम को ________ ि�थ�त म� ले जाता है।
Ans 1. काया��मक (Functional)

2. गैर-काया��मक (Non-functional)

3. अ�य�धक स��य (Most active)

4. स��य (Active)
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Question Type : MCQ
Question ID : 6182782050

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.23 �न�न म� से कौन सा फ़ं�शन �व�तीय फ़ं�शन से संबं�धत है?

Ans 1. =ACOSH( )

2. =FLOOR()

3. =ACCRINT( )

4. =AVEDEV( )

Question Type : MCQ
Question ID : 6182782087

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.24 = SQRT () एक ग�णतीय फ़ं�शन है, जो _________।
Ans 1. �कसी सं�या का घनमलू �दान करता है

2. �कसी सं�या का वग�मलू �दान करता है

3. �कसी सं�या का गुणन �दान करता है

4. �कसी सं�या का वग� �दान करता है

Question Type : MCQ
Question ID : 6182782085

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.25 Ms Excel 2016 म�, ज़मू इन कं�ोल सेल को ______% तक बड़ा बनाता है।
Ans 1. 100

2. 400

3. 200

4. 300

Question Type : MCQ
Question ID : 6182782073

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.26 कौन-सी कंुजी इ�सश�न पॉइंट के दा� ओर के वण� को �डल�ट करती है?

Ans 1. Delete

2. Tab

3. ESC

4. Backspace

Question Type : MCQ
ANKAJ INFOTECH



1/28/2020 https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S84D525/157719540782969…

https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S84D525/15771954078296951/1941426… 8/16

Question ID : 6182782060
Status : Answered

Chosen Option : 4
Marks : 0.00

Q.27 �न�न�ल�खत म� से कौन सा एक सॉ�टवेयर है?

Ans 1. पीडीएफ �यअूर (PDF viewer)

2. माउस

3. मॉ�नटर

4. क�बोड�

Question Type : MCQ
Question ID : 6182782047

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.28 �न�न�ल�खत म� से कौन इनपटु �डवाइस नह�ं है?

Ans 1. ��टंर

2. माउस

3. जॉयि�टक

4. क�बोड�

Question Type : MCQ
Question ID : 6182782042

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.29 MS WORD 2016 म� मे�लगं लेबल �न�न म� �कसके �वारा बनाया जा सकता है?

Ans 1. एक ख़ाल� Word document खोल� > Mailing tab > Label (Create group) पर ि�लक कर� >
सह� लेबल आकार चनु� > Address text box > लेबल के �लए टे��ट टाइप कर� > Print, या edit, save और
बाद म� print करने के �लए New Document चनु�।

2. नया Word document>Design tab > Label(Create group) पर ि�लक कर� > सह� लेबल
आकार चनु�> options पर ि�लक कर� > Address text box > लेबल के �लए टे��ट टाइप कर�

3. Mailing tab > Label (Create group) पर ि�लक कर� > सह� लेबल आकार चनु� > Address text

box > लेबल के �लए टे��ट टाइप कर�

4. एक ख़ाल� Word document खोल� > Mailing tab> Label (Create group) पर ि�लक कर� >
सह� लेबल आकार चनु� > options पर ले�ट ि�लक कर� > लेबल के �लए टे��ट टाइप कर�

Question Type : MCQ
Question ID : 6182782068

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.30 य�द आप MS Word म� Print Layout म� ह�, तो आप देख�गे:

Ans 1. केवल �ै�तज �लर (only horizontal ruler)

2. केवल ऊ�वा�धर �लर (only vertical ruler)
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3. न तो �ै�तज और न ह� ऊ�वा�धर �लर (Neither horizontal nor vertical ruler)

4. �ै�तज और ऊ�वा�धर �लर (horizontal and vertical ruler)

Question Type : MCQ
Question ID : 6182782057

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.31 Windows XPम�, MS Word �ो�ाम कैसे �टाट� करत ेह�?
Ans 1. Microsoft Word आइकन पर �सगंल ि�लक कर�

2. All program > Microsoft Office Shortcut Bar > Microsoft Word आइकन पर डबल ि�लक
कर�

3. All program > Microsoft office > MS word

4. Start > All program > Microsoft office > MS word

Question Type : MCQ
Question ID : 6182782055

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.32 �न�न�ल�खत म� से कौन सी कं�यटूर क� हाई लेवल �ो�ा�मगं ल��वेज है?

Ans 1. MATLAB

2. MS OFFICE

3. MS WORD

4. POWER POINT

Question Type : MCQ
Question ID : 6182782048

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.33  ________ पता, हो�ट या नेटवक�  इंटरफ़ेस पहचान और लोकेशन ए��ेसगं नामक दो म�ुय काय� करता है।
Ans 1. IP 

2. UDP

3. TCP

4. PPP

Question Type : MCQ
Question ID : 6182782099

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.34 �न�न�ल�खत म� से कौन सी ���या क� अव�था नह�ं है?

Ans 1. र�नगं

2. ट�म�ने�टगं
ANKAJ INFOTECH



1/28/2020 https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S84D525/157719540782969…

https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S84D525/15771954078296951/194142… 10/16

3. �ल��पगं

4. ए�जी�यशून

Question Type : MCQ
Question ID : 6182782046

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.35 MS Excel म� Paste Special के �लए शॉट� कट क� �या है?

Ans 1. Ctrl + Shit + V

2. Ctrl + Shift + P

3. Shift + V

4. Ctrl + Alt + V

Question Type : MCQ
Question ID : 6182782084

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.36 MS Word का उपयोग करके डटेा �ोत कैसे बनात ेह�?
Ans 1. Table > Insert Table > टेबल क� शीष� पंि�त पर डटेा फ़��ड नाम टाइप कर� और दसूर� पंि�त से

डटेा �रकॉड� �ारंभ कर�> Save

2. Insert > Table > Insert Table > टेबल क� शीष� पंि�त पर डटेा फ़��ड नाम टाइप कर� और दसूर�
पंि�त से डटेा �रकॉड� �ारंभ कर� > Save

3. Insert>Table > टेबल क� शीष� पंि�त पर डटेा फ़��ड नाम टाइप कर� और दसूर� पंि�त से डटेा �रकॉड�
�ारंभ कर� > Save

4. Insert>Table> Insert Table > दसूर� पंि�त से डटेा �रकॉड� �ारंभ कर� > Save

Question Type : MCQ
Question ID : 6182782067

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.37 �न�न�ल�खत म� से कौन सा वेब �ाउज़र नह�ं है?

Ans 1. गूगल �ोम

2. माइ�ोसॉ�ट ए�सेस

3. मोिज़ला फायरफा�स

4. इ�टरनेट ए�स�लोरर

Question Type : MCQ
Question ID : 6182782100

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.38 �वडंोज म� फ़ाइल �बंधन _______ के मा�यम से �कया जा सकता है।
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Ans 1. �वडंोज़ ए�स�लोरर

2. इ�टरनेट ए�स�लोरर

3. कं�ोल पनैल

4. र�सायकल �बन

Question Type : MCQ
Question ID : 6182782053

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.39 MS Excel म� से�स के �कसी के कॉलम को कैसे फ़ॉम�ट �कया जा सकता है?

Ans 1. MS Excel > होम> सेल/से�स के कॉलम को सेले�ट कर� > राइट ि�लक कर�> फॉम�ट सेल �वक�प
चनु�

2. MS Excel > होम > सेल/से�स के कॉलम को सेले�ट कर� > फॉम�ट सेल �वक�प चनु�

3. MS Excel > सेल/से�स के कॉलम को सेले�ट कर� > राइट ि�लक कर� > फॉम�ट सेल �वक�प चनु�

4. MS Excel > सेल/से�स के कॉलम को सेले�ट कर� > ले�ट ि�लक कर� > फॉम�ट सेल �वक�प चनु�

Question Type : MCQ
Question ID : 6182782081

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.40 एमएस पावर �वाइंट 2016 म�, "समहू" के �लए शॉट� कट क� कंुजी �या है िजसम� कई ऑ�जे�ट चनेु गए ह�?
Ans 1. Alt + G

2. Ctrl + G

3. Ctrl + O

4. Ctrl + shift + G

Question Type : MCQ
Question ID : 6182782091

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.41 मौजदूा MS Word डॉ�यमू�ट को कैसे सहेजा (save) जाता है?

Ans 1. CTRL + C दबाकर

2. CTRL + V दबाकर

3. CTRL + S दबाकर

4. CTRL + A दबाकर

Question Type : MCQ
Question ID : 6182782059

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.42 वेब सव�र "404 error" नामक टे��ट संदेश �द�श�त करता है / भेजता है, इसका �या अथ� है?
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Ans 1. वेब पेज नह�ं �मला

2. फ़ाइल का नाम बदल �दया गया है।

3. वेब पेज �मल गया है

4. वेब पेज ��तबं�धत है

Question Type : MCQ
Question ID : 6182782097

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.43 एमएस ए�सेल म� मा�य सेल ए�से �न�न�ल�खत म� से कौन सा है?

Ans 1. C1

2. 1D

3. 1A

4. 1B

Question Type : MCQ
Question ID : 6182782077

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.44 MS Word डॉ�यमू�ट क� वत�नी और �याकरण क� जाँच के �लए �कस फ़ं�शन कंुजी का उपयोग �कया जाता
है?

Ans 1. F7

2. F5

3. F1

4. F2

Question Type : MCQ
Question ID : 6182782062

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.45 क�-बोड� से संल�न कं�यटूर म� डटेा �ांसफ़र के �लए, कौन सी �था�तरण �व�ध को वर�यता (prefer mode) द�
जाएगी?

Ans 1. �ो�ा�ड I/O

2. सॉ�टवेयर-इंटेर�ट ��वेन I/O

3. डायरे�ट मेमोर� ए�सेस (DMA)

4. हाड�वेयर-इंटेर�ट ��वेन I/O

Question Type : MCQ
Question ID : 6182782045

Status : Answered
Chosen Option : 3

Marks : 0.00
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Q.46 �न�न�ल�खत म� से कौन सा एक ऑि�टकल इनपटु �डवाइस है?

Ans 1. डाक�  पेन

2. म�ैने�टक पेन

3. पेन �ाइव

4. लाइट पेन

Question Type : MCQ
Question ID : 6182782044

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.47 MS Excel 2016 म�, फ़ॉम�ट सेल डायलॉग खोलने के �लए �न�न�ल�खत म� से �कस शॉट� कट कंुजी का उपयोग
�कया जाता है?

Ans 1. Ctrl +2

2. Ctrl +3

3. Ctrl +1

4. Ctrl +4

Question Type : MCQ
Question ID : 6182782083

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.48 MS Excel 2016 वक� बकु फ़ाइल को सरु��त करने के �लए सह� चरण� का चयन कर�।
Ans 1.  File > Info. > Protect Sheet  बॉ�स चनु� और Encrypt with Password �वक�प चनु� >

Password  बॉ�स म� एक पासवड� डाल� > OK चनु� > Reenter Password बॉ�स म� पासवड� क� पिु�ट कर�
और �फर OK चनु�।

2.  View > Info > Protect Workbook बॉ�स चनु� और Encrypt with Password �वक�प चनु� >
Password  बॉ�स म� एक पासवड� डाल� > OK चनु� > Re-enter Password बॉ�स म� पासवड� क� पिु�ट कर�
और �फर OK चनु�।

3.  File > option. > Protect Workbook  बॉ�स चनु� और Encrypt with Password �वक�प चनु�
> Password  बॉ�स म� एक पासवड� डाल� > OK चनु� > Reenter Password बॉ�स म� पासवड� क� पिु�ट कर�
और �फर OK चनु�।

4.  File > Info. > Protect Workbook बॉ�स चनु� और Encrypt with Password �वक�प चनु� >
Password  बॉ�स म� एक पासवड� डाल� > OK चनु� > Reenter Password बॉ�स म� पासवड� क� पिु�ट कर�
और �फर OK चनु�।

Question Type : MCQ
Question ID : 6182782076

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.49 एमएस पावर �वाइंट 2016 म�, म�ैोज़ ____ मेन ूम� उपल�ध है?

Ans 1. Home

2. Insert

3. View
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4. File

Question Type : MCQ
Question ID : 6182782095

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.50 MS Excel म�, " Auto Shape / Shapes" _______ म� उपल�ध ह�।
Ans 1. इ�सट� टैब

2. �य ूटैब

3. होम टैब

4. पेज ले- आउट

Question Type : MCQ
Question ID : 6182782089

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.51 �न�न म� से कौन सी �वडंोज ऑपरे�टगं �स�टम म�, �ो�ाम को अनइं�टॉल करने/बदलने क� एक ���या है?

Ans 1. Program → Start menu → Control panel → Uninstall/change

2. Start menu → Program → Accessories → Control panel → Uninstall/change

3. Start menu → Control panel → Program → Uninstall/change

4. Start menu → All → Control panel → Uninstall/change

Question Type : MCQ
Question ID : 6182782052

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.52 आप MS Word 2016 डॉ�यमू�ट म� मौजदू व�तओु ंको �ुप कैसे कर सकत ेह�?
Ans 1. Selection Plane > �ुप �कए जाने वाले सभी ऑ�जे��स चनु� > arrange

2. Design > Selection Plane > �ुप �कए जाने वाले सभी ऑ�जे��स चनु� > Group

3. लेआउट > �ुप �कए जाने वाले सभी ऑ�जे��स चनु� > Group > Group

4. Page Layout > Paragraph Plane > Group

Question Type : MCQ
Question ID : 6182782056

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.53 वण� (letters) के बीच के �थान को �या कहा जाता है?

Ans 1. लाइन �पे�सगं

2. कैरे�टर �पे�सगं

3. परैा�ाफ़ �पे�सगं
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4. ि��ंग �पे�सगं

Question Type : MCQ
Question ID : 6182782061

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.54 डटेा को म�ुय डॉ�यमू�ट म� कैसे मज� �कया जाता है?

Ans 1. MS Word document > Start mail merge > Select recipient > Use Existing List > Write
letter > Insert merge field > Preview result > Finish & Merge

2. MS Word document > Mailing > Start mail merge > Select recipient > Write letter >
Insert merge field > Preview result > Finish & Merge

3. MS Word document > Mailing > Start mail merge > Select recipient > Use Existing
List > Write letter > Insert merge field > Preview result > Finish & Merge

4. MS Word document > Mailing > Start mail merge > Select recipient > Use Existing
List >Write letter > Preview result > Finish & Merge

Question Type : MCQ
Question ID : 6182782069

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.55 MS Excel 2016 म�, सेल बॉड�र को मोटा कैसे �कया जाता है?

Ans 1. MS Excel file > Select a cell > Borders > thick box border

2. MS Excel file > Home > Borders > thick box border

3. MS Excel file > Home > Select a cell > thick box border

4. MS Excel file > Home>Select a cell > Borders > thick box border

Question Type : MCQ
Question ID : 6182782079

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.56 मेल मज� ऑपरेशन म�, �न�न म� से कौन सा डटेा �ोत से संबं�धत है?

Ans 1. एक �ट�डड� लेटर (A standard letter)

2. डॉ�यमू�ट को मज� कर� (Merge document)

3. �य ूडॉ�यमू�ट (New document)

4. �ाहक� के नाम और पत ेक� एक सचूी (A list of names and addresses of the clients)

Question Type : MCQ
Question ID : 6182782065

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.57 MS Excel म�, करंट सेल के बा� ओर एक नया कॉलम कैसे जोड़ा जाता है?

Ans 1. करंट सेल पर �सगंल ि�लक कर� > Insert > select on entire column > OK
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2. करंट सेल पर राइट ि�लक कर� > select on entire column > OK

3. करंट सेल पर राइट ि�लक कर� > Insert > select on entire column > OK

4. करंट सेल पर डबल ि�लक कर� > Insert > select on entire column > OK

Question Type : MCQ
Question ID : 6182782071

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.58 MS Excel 2016 म� कॉलम क� चौड़ाई अ�धकतम ______ हो सकती है।
Ans 1. 800

2. 255 

3. 100

4. 200

Question Type : MCQ
Question ID : 6182782074

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.59 इनम� से कौन सा एक साधारण (common) वेबसाइट �वारा उपयोग �कया जाने वाला संचार �ोटोकॉल है?

Ans 1. YSP

2. TCP/IP

3. USP

4. FTP

Question Type : MCQ
Question ID : 6182782096

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.60 MS Excel म�, "Callouts" आकृ�तया ँ_____ म� उपल�ध होती ह�।
Ans 1. Insert tab>SmartArt

2. Insert tab>Shapes

3. Insert tab>Picture

4. Insert tab> ClipArt

Question Type : MCQ
Question ID : 6182782090

Status : Answered
Chosen Option : 4

Marks : 0.00
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Q.1 एक �लाइड से दसूर� �लाइड म� जाने के �लए इनम� से �कसका �योग �कया जा सकता है?

Ans 1. केवल Forward arrow

2. Backward arrow और Ctrl + Backward arrow

3. Forward arrow और Backward arrow

4. Forward arrow और Ctrl + Forward arrow

Question Type : MCQ
Question ID : 6182782155

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.2 MS Excel 2016 म�, सेल �टाइ�स का उपयोग करके फ़ॉम��टगं �टाइल कैसे जोड़त ेह�?
Ans 1. View → Cell Style → New Cell Style → Give a Style Name → ok

2. Review → Cell Style → New Cell Style → Give a Style Name → ok

3. Data → Cell Style → New Cell Style → Give a Style Name → ok

4. Home → Cell Style → New Cell Style → Give a Style Name → ok

Question Type : MCQ
Question ID : 6182782142

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.3 MS word 2016 म�, एक कॉलम म� दो �मागत सेल� के बीच एक सेल कैसे इ�सट� करत� ह�?
Ans 1. ऊपर� सेल को सेले�ट कर� → Right Click → Filter → Shift cell down → ok

2. �नचले सेल को सेले�ट कर� → Right Click → Insert → Shift cell down → ok

3. दोन� सेल को सेले�ट कर� → Right Click → Format → Shift cell down → ok

4. �कसी एक सेल को सेले�ट कर� → Left Click → Insert → Shift cell down → ok

Participant ID 19383510
Participant Name DEEPAK KUMAR
Test Center Name iON Digital Zone iDZ 2 Patliputra
Test Date 24/12/2019
Test Time 12:00 PM - 1:00 PM
Subject Data Entry Operator
Marks Obtained 18.00000

Section : MCQ for Data Entry Operator
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Question Type : MCQ
Question ID : 6182782133

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.4 �वडंोज़ ए�सपी म�, ड�ेकटॉप के �लए शॉट�कट कंुजी �या है?

Ans 1. Win +W

2. Win + D

3. Win + W7

4. Win + O

Question Type : MCQ
Question ID : 6182782113

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.5 MS-Excel 2016 म�, ‘SmartArt’ ___ टैब म� मौजदू होता है।
Ans 1. इ�सट�

2. पेज लेआउट

3. होम

4. �र�यु

Question Type : MCQ
Question ID : 6182782150

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.6 WWW (व�ड� वाइड वेब) का आ�व�कार �कसने �कया था?
Ans 1. ड�ेनस �रची और केन थॉ�पसन ने

2. �टम बन�स-ल� ने

3. जॉन बकैस के नेत�ृव वाल� एक ट�म ने

4. जॉन मकैाथ� ने

Question Type : MCQ
Question ID : 6182782158

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.7 वक� शीट पर मौजदू डटेा को कैसे ए�डट करत ेह�?
Ans 1. F3

2. F11

3. F2

4. F5

Question Type : MCQ
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Question ID : 6182782132
Status : Answered

Chosen Option : 2
Marks : 0.00

Q.8 URL का पणू� �प �या है?

Ans 1. य�ूनवस�ल �रसोस� लोकेटर (Universal Resource Locator)

2. य�ूनयन �रसोस� लोकेटर (Union Resource Locator)

3. यनूाइटेड �रसोस� लोकेटर (United Resource Locator)

4. य�ूनफ़ॉम� �रसोस� लोकेटर (Uniform Resource Locator)

Question Type : MCQ
Question ID : 6182782159

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.9 डटेा क� उस मा�ा, िजसे मेमोर� और �ोसेसर के बीच एक साथ �थानांत�रत �कया जा सकता है, को______
�वारा �द�श�त �कया जा सकता है।

Ans 1. �ोसेसर के आकार

2. बस के आकार

3. मेमोर� �चप के आकार

4. कं�यटूर के आकार

Question Type : MCQ
Question ID : 6182782101

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.10 �न�न�ल�खत म� से कौन सा बा�य उपकरण� और मेमोर� य�ूनट के बीच डटेा �ांसफर का �बंधन करता है?

Ans 1. �ो�ाम कं�ोलर

2. इनडायरे�ट मेमोर� ए�सेस कं�ोलर

3. इं���शन रिज�टर

4. डायरे�ट मेमोर� ए�सेस कं�ोलर

Question Type : MCQ
Question ID : 6182782102

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.11 MS Word म� "Save as" डायलॉग बॉ�स खोलने के �लए शॉट� कट क� �या है?

Ans 1. F11

2. F12

3. F3

4. F7

Question Type : MCQANKAJ INFOTECH
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Question ID : 6182782126
Status : Answered

Chosen Option : 4
Marks : 0.00

Q.12 इनम� से कौन सा चाट� असतत �े�णय� �वारा समहू�कृत डटेा क� तलुना करने के �लए सव��तम है?

Ans 1. लाइन चाट�

2. पाई चाट�

3. ए�रया चाट�

4. व�ट�कल बार चाट�

Question Type : MCQ
Question ID : 6182782148

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.13 MS Excel 2016 म�, �डफ़ॉ�ट �प से, आपके �वारा खोल� गई सभी वक� बकु ____ पर �द�श�त क� जाती ह�,
ले�कन आप उ�ह� आव�यकतानसुार टा�कबार पर �छपा या �दखा सकत ेह�।

Ans 1. ड�ेकटॉप

2. टा�क बार

3. मेन ूटैब

4. टाइटल बार

Question Type : MCQ
Question ID : 6182782137

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.14 MS-Excel 2016 म�, इल��ेशन (Illustrations) �ुप, �न�न म� से �कस टैब म� शा�मल होता है?

Ans 1. View

2. Review

3. Insert

4. Data

Question Type : MCQ
Question ID : 6182782149

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.15 �मागत सेल ्का योग �ात करने का स�ू �या है?

Ans 1. "=ADD(first cell address + last cell address)"

2. "=SUM(first cell address TO last cell address)"

3. "=SUM(first cell address + last cell address)"

4. "=SUM(first cell address : last cell address)"

Question Type : MCQANKAJ INFOTECH
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Question ID : 6182782138
Status : Answered

Chosen Option : 3
Marks : 0.00

Q.16 तीन द�तावेज़ ह� जो मेल मज� ���या म� शा�मल ह�, उ�ह� नीचे �दए �वक�प� म� से पहचान�।
Ans 1. म�ुय डॉ�यमू�ट, डटेा �ोत और मज� �कया गया डॉ�यमू�ट

2. सहायक डॉ�यमू�ट, डटेा �ोत और म�ुय डॉ�यमू�ट

3. डटेा �ोत, ए�सेल टेबल और म�ुय डॉ�यमू�ट।

4. सहायक डॉ�यमू�ट, डटेा �ोत और मज� �कया गया डॉ�यमू�ट

Question Type : MCQ
Question ID : 6182782125

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.17 MS Excel 2016 म�, सेल� के चयन को उसी कॉलम या पंि�त म� अ�ंतम भरे हुए सेल तक यानी स��य सेल
तक, या य�द अगल� सेल �र�त हो, तो अगले भरे हुए सेल तक बढ़ाने के �लए �न�न म� से �कस शॉट�कट कंुजी
का उपयोग �कया जाता है?

Ans 1. Shift + Spacebar

2. Ctrl + Enter

3. Ctrl + Shift + Arrow key

4. Ctrl + Shift + Spacebar

Question Type : MCQ
Question ID : 6182782136

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.18 �न�न�ल�खत म� से �कसे कं�यटूर के साथ �योग क� जाने वाल� एक �व�श�ट I/O बस कहा जा सकता है?

Ans 1. ए�स�ंोनस और �ोपराइटर�

2. �स�ंोनस और �ट�डड�

3. ए�स�ंोनस और �ट�डड�

4. �स�ंोनस और �ोपराइटर�

Question Type : MCQ
Question ID : 6182782105

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.19 ‘= ABS ()’ एक ग�णतीय फ़ं�शन है, जो _______ ।
Ans 1. �कसी सं�या का �नरपे� मान नह� ंलौटाता है, जो अपने �च�ह के �बना सं�या होती है।

2. �कसी सं�या का �नरपे� मान लौटाता है, जो अपने �च�ह वाल� सं�या होती है।

3. �कसी सं�या का �नरपे� मान लौटाता है, जो अपने �च�ह के �बना सं�या होती है।

4. केवल ऋणा�मक सं�या लौटाता है।
ANKAJ INFOTECH



1/28/2020 https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S83D509/157719542875249…

https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S83D509/15771954287524982/1938351… 6/16

Question Type : MCQ
Question ID : 6182782145

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.20 Ms Excel 2016 म�, एक साधारण गणना करने का फॉमू�ला, ___ टैब म� मौजदू होता है।
Ans 1. �र�यु

2. इ�सट�

3. �यू

4. फ़ॉमू�लास

Question Type : MCQ
Question ID : 6182782116

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.21 ISDN (इंट��ेटेड स�व�सेज़ �डिजटल नेटवक� ) एक ______ है।
Ans 1. इ�टरनेट कने�शन

2. �लाइट कने�शन

3. इलेि��कल लाइन कने�शन

4. पो�टल कने�शन

Question Type : MCQ
Question ID : 6182782157

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.22 C भाषा का �वकास �कसने �कया था?
Ans 1. कोलमेरौएर, रसेल और कोवल�क� ने

2. जॉन मकैाथ� ने

3. ड�ेनस �रची और केन थॉ�पसन ने

4. जॉन बकैस के नेत�ृव वाल� ट�म ने

Question Type : MCQ
Question ID : 6182782108

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.23 �लाइड का पनु: उपयोग करने का अथ� अपने �ेज�टेशन म� दसूरे �ेज�टेशन से एक या एक से अ�धक �लाइ�स
जोड़ने से है, यह कैसे �कया जाता है?

Ans 1. कॉपी क� गई �लाइड, �लाइड को इनहे�रट करती है

2. दसूर� फ़ाइल खोल� और इसे सहेज�

3. दसूर� फाइल को खोले �बना
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4. दसूर� फ़ाइल खोल� और उसे कॉपी कर�

Question Type : MCQ
Question ID : 6182782154

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.24 जब हम माउस को मे�य ूबार और टूलबार के पास ले जात ेह�, तो माउस पॉइंटर ______ का हो जाता है।
Ans 1. �ब�द ुके आकार

2. I-आकार

3. L-आकार

4. सचूक तीर (pointing arrow) के आकार

Question Type : MCQ
Question ID : 6182782118

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.25 वक�  शीट का नाम कैसे बदला जाता है?

Ans 1. वक�  शीट क� शीट टैब पर �सगंल ि�लक कर� → नया नाम �लख� → एंटर दबाए

2. वक�  शीट क� शीट टैब पर डबल ि�लक कर� → नया नाम �लख� → एंटर दबाए

3. वक�  शीट क� शीट टैब पर बायां ि�लक कर�t → नया नाम �लख� → एंटर दबाए

4. वक� शीट क� शीट टैब का चयन कर� → नया नाम �लख� → एंटर दबाए

Question Type : MCQ
Question ID : 6182782131

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.26 �न�न�ल�खत म� से �कसका उपयोग फॉमू�ला को कॉपी और पे�ट करने के �लए �कया जाता है, जो सेल फ़ॉम�ट
को नह�ं बदलता है?

Ans 1. Ctrl+C → Ctrl+Alt +V → Formulas

2. Ctrl+V → Ctrl+V

3. Ctrl+C → Ctrl+C

4. Ctrl+V → Ctrl+C

Question Type : MCQ
Question ID : 6182782146

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.27 "My Computer" खोलने के �लए शॉट� कट कंुजी �या है?

Ans 1. Win + F7

2. Win +W

3. Win + D
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4. Win + E

Question Type : MCQ
Question ID : 6182782115

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.28 एमएस ए�सेल म�, �न�न�ल�खत म� से कौन सा वधै सेल ए�से नह�ं है?

Ans 1. 11

2. A1

3. A@

4. 1A1

Question Type : MCQ
Question ID : 6182782134

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.29 श�द क� वत�नी (spelling) को कैसे बदलना है जो �पेल चेकर �वारा हाइलाइटेड है?

Ans 1. कस�र को श�द पर रख� → ctrl कंुजी दबाएं

2. कस�र को श�द पर रख� → राइट-ि�लक कर� → सझुाव से चनु�

3. कस�र को श�द पर रख� → F9 कंुजी दबाएं

4. कस�र को श�द पर रख� → ले�ट-ि�लक कर�

Question Type : MCQ
Question ID : 6182782123

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.30 �लाइड सॉट�र �य ू______ �द�श�त करता है।
Ans 1. आपके �ेज�टेशन के �ै�तिजक �म वाल� सभी �लाइड, थंबनेल

2. आपके �ेज�टेशन के �ै�तिजक �म वाल� एक �लाइड, थंबनेल

3. केवल �वषम �मांक वाल� �लाइड

4. आपके �ेज�टेशन वाल� कोई �लाइड नह�ं

Question Type : MCQ
Question ID : 6182782153

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.31 �कसी डॉ�यमू�ट म� टे��ट को दसूरे �थान पर कॉपी कैसे कर�?
Ans 1. ALT C दबाएं

2. टे��ट को सेले�ट कर� + Ctrl V दबाएं और �फर �चपकाने के �लए Ctrl C दबाएं

3. टे��ट को सेले�ट कर� + Ctrl C दबाएं और �फर �चपकाने के �लए Ctrl V दबाएं
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4. Ctrl + F7 दबाएं

Question Type : MCQ
Question ID : 6182782122

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.32 पॉवरपॉइंट �लाइड म� गाइड का उपयोग �कस�लए �कया जाता है?

Ans 1. �लाइड क� ऑ�जे��स को सह� ि�थ�त और �नपै (snap) म� रखने के �लए।

2. �लाइड ��डलाइ�स को सह� ढंग से सह� ि�थ�त म� रखने के �लए।

3. �लाइड टे��ट को सह� ि�थ�त और �नपै (snap) म� रखने के �लए।

4. �लाइड �लर को सह� ढंग से सह� ि�थ�त म� रखने के �लए।

Question Type : MCQ
Question ID : 6182782152

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.33 एमएस ए�सेल म� �न�न�ल�खत म� से कौन सा वधै सेल ए�से है?

Ans 1. A1

2. AB12

3. 11

4. AA11

Question Type : MCQ
Question ID : 6182782135

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.34 Ms Word 2016 म�, आपको Save as �वक�प कहां �मलेगा?
Ans 1. �यू

2. फाइल

3. �र�यु

4. डाटा

Question Type : MCQ
Question ID : 6182782124

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.35 एमएस ए�सेल म� कोई फ़ं�शन डालने के �लए शॉट� कट कंुजी �या है?

Ans 1. F1

2. F3

3. F5
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4. F2

Question Type : MCQ
Question ID : 6182782141

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.36 MS Excel 2016 म�, वक� बकु म� मौजदूा और अगल� शीट को सेले�ट करने के �लए �न�न म� से कौन सी
शॉट�कट कंुजी का उपयोग �कया जाता है?

Ans 1. Ctrl + Shift + Page Down

2. Ctrl + Shift + Page Up

3. Shift + Arrow key

4. Ctrl + Shift + Spacebar

Question Type : MCQ
Question ID : 6182782130

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.37 ____ एक कं�यटूर पर दो ऑपरे�टगं �स�टम इन�टॉल करने को संद�भ�त करता है।
Ans 1. �ल�न इं�टालेशन

2. �सगंल exe इं�टालेशन

3. �यलू बटू (dual boot)

4. वेब आधा�रत इं�टालेशन

Question Type : MCQ
Question ID : 6182782114

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.38 �न�न�ल�खत म� से �या कं�यटूर �णाल� के संचालन को �नयं��त करता है?

Ans 1. ऑपरे�टगं �स�टम

2. इंटरनेट

3. वड� �ोसेसर

4. डटेाबेस

Question Type : MCQ
Question ID : 6182782106

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.39 मेल सव�र से संदेश �ा�त करने के �लए �न�न म� से �कस �ोटोकॉल का उपयोग �कया जाता है?

Ans 1. SMTP

2. POP

3. TCP/IP
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4. UDP

Question Type : MCQ
Question ID : 6182782156

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.40 अन�धकृत उपयोगकता� से सरु��त करने के �लए सेल को कैसे �छपात े(hide) ह�?
Ans 1. Right click → Delete

2. Left click → Format cells → Protection → Hide → OK

3. Right click → Format Cells → Protection → Hide → OK

4. Right click → Protection → Hide → OK

Question Type : MCQ
Question ID : 6182782139

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.41 एक नए MS WORD डॉ�यमू�ट को सहेजने के �लए इनम� से कौन सा �वक�प सह� है?

Ans 1. File → Save as → एक फ़ाइल नाम द� → Save पर ि�लक कर�

2. CTRL + V दबाएं

3. CTRL + Z दबाएं

4. CTRL + A दबाएं

Question Type : MCQ
Question ID : 6182782119

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.42 MS Excel म� Underline के �लए शॉट� कट कंुजी �या है?

Ans 1. Alt + U

2. Ctrl + 4

3. Ctrl + O

4. Alt + 4

Question Type : MCQ
Question ID : 6182782144

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.43 PowerPoint �लाइड शो के दौरान, ���न को सफेद बनाने के �लए ___ कंुजी का उपयोग �कया जाता है।
Ans 1. S

2. P

3. M

4. W
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Question Type : MCQ
Question ID : 6182782151

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.44 MS Word म�, �न�न म� से �कस शॉट�कट कंुजी का उपयोग टे��ट �टाइल को हे�डगं 1 म� बदलने के �लए �कया
जाता है?

Ans 1. Ctrl + Alt + 1 

2. Ctrl + Alt + 2

3. Ctrl + Alt + 0

4. Ctrl + Alt + 3

Question Type : MCQ
Question ID : 6182782127

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.45 कं�यटूर के ड�ेकटॉप पर �टाट� बटन ______ म� मौजदू होता है।
Ans 1. टा�क बार

2. वक�  बार

3. ओपन बार

4. �लोज़ बार

Question Type : MCQ
Question ID : 6182782110

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.46 MS word 2016 म� एक बार म� कस�र को एक श�द के बा� ओर ले जाने के �लए �कस शॉट�कट कंुजी का
उपयोग �कया जाता है?

Ans 1. Ctrl + (End) 

2. Ctrl + (Spacebar) 

3. Ctrl + (home) 

4. Ctrl + (Left arrow) 

Question Type : MCQ
Question ID : 6182782121

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.47 इनम� से कौन सा हाई लेवल ल��वेज सोस� कोड को एक-एक लाइन करके मशीन कोड म� प�रव�त�त करता है?

Ans 1. कंपाइलर

2. इंटर�ेटर

3. क�वट�र
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4. इ�वट�र

Question Type : MCQ
Question ID : 6182782109

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.48 MS Word 2016 म�, Mailings टैब म� मेन ू�ुप 'Create' के अतंग�त डॉ�यमू�ट के �कतने �वक�प मौजदू होते
ह�?

Ans 1. 2

2. 4

3. 3

4. 5

Question Type : MCQ
Question ID : 6182782128

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.49 �न�न�ल�खत म� से �या कं�यटूर �स�टम म� भाषा अनवुादक नह�ं है?

Ans 1. जावा ल��वेज

2. क�पाइलर

3. इंटर�ेटर

4. असे�बलर

Question Type : MCQ
Question ID : 6182782107

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.50 �न�न�ल�खत म� से कौन सा फ़ं�शन सांि�यक�य फ़ं�शन से संबं�धत है?

Ans 1. "=TRUE"

2. "=FALSE"

3. "=FLOOR.MATH()"

4. "=DATE"

Question Type : MCQ
Question ID : 6182782147

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.51 �वडंोज़ XP म�, आपको कमांड �ॉ��ट कैसे �मलता है?

Ans 1. Program → Start menu → Control panel

2. Run → Command prompt

3. Start menu → Command prompt
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4. Start menu → Accessories → Command prompt

Question Type : MCQ
Question ID : 6182782112

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.52 �न�न�ल�खत म� से �कसे कं�यटूर का बा�य उपकरण माना जाता है?

Ans 1. ��टंर

2. हाड� �ड�क

3. CPU

4. ALU

Question Type : MCQ
Question ID : 6182782104

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.53 कं�ोल पनैल के बारे म� �न�न�ल�खत म� से कौन सा सह� है?

Ans 1. सभी फाइल� को �द�श�त करता है

2. सभी फ़ो�डर को �द�श�त करता है

3. सभी �नद�श� को �द�श�त करता है

4. सभी इन�टॉल �कये गए कं�यटूर �ो�ाम� (सॉ�टवेयर) को �द�श�त करता है

Question Type : MCQ
Question ID : 6182782111

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.54 कं�यटूर क� आउटपटु य�ूनट का �या काय� है?

Ans 1. यह बाहर� द�ुनया से डटेा और �नद�श पढ़ती है

2. यह कं�यटूर को आगे क� ���या के �लए �नद�श और डटेा �दान करती है

3. यह डटेा को उपयोगकता� के समझने यो�य �ा�प म� प�रव�त�त करती है

4. यह डटेा को कं�यटूर �वीकाय� �ा�प म� �पांत�रत करती है

Question Type : MCQ
Question ID : 6182782103

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.55 MS Excel म� Macro के �लए शॉट� कट कंुजी �या है?

Ans 1. Ctrl + F1

2. Alt + M

3. Alt + F8
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4. Ctrl + M

Question Type : MCQ
Question ID : 6182782143

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.56 MS word म�, टे��ट केस को बदलने के �लए �न�न�ल�खत म� से �कस शॉट�कट कंुजी का उपयोग �कया जाता
है?

Ans 1. Alt+ F3

2. Shift + F4

3. Ctrl + F5

4. Shift + F3

Question Type : MCQ
Question ID : 6182782129

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.57 कौन सी कंुजी इ�सश�न �बदं ुके बा� ओर वाले वण� (Character) को �डल�ट करती है?

Ans 1. ESC

2. �डल�ट

3. TAB

4. बकै�पेस

Question Type : MCQ
Question ID : 6182782120

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.58 MS Excel म� सेले�ट क� गयी सेल को कैसे फ़ॉम�ट �कया जाता है?

Ans 1. CTRL + Left Click → Format cell

2. Left Click → Format cell

3. Ctrl + F1

4. Right Click → Format cell

Question Type : MCQ
Question ID : 6182782140

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.59 MS word 2016 म�, �लर को ऑफ़ कैसे �कया जाता है?

Ans 1. Ruler → View

2. View → uncheck Ruler

3. View → Viewer
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4. Ruler → Insert

Question Type : MCQ
Question ID : 6182782117

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.60 �न�न�ल�खत म� से कौन सा ऑनलाइन सच� इंजन नह�ं है?

Ans 1. गूगल (Google)

2. ने�सस (Nexus)

3. �बगं (Bing)

4. याहू (Yahoo)

Question Type : MCQ
Question ID : 6182782160

Status : Answered
Chosen Option : 2

Marks : 1.00
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Q.1 ______ म�, क�बोड� के मा�यम से दज� �कया गया डटेा सीधे चुंबक�य टेप पर दज� �कया जाता है। ______ का
उपयोग होम �रकाड�र म� इ�तमेाल �कए जाने वाले टेप �रकाड�र या कैसेट के समान है।

Ans 1. क�-टू-टेप �स�टम, म�ैने�टक टेप

2. म�ैने�टक-इंक कैरे�टर र�डर, फेराइट- इ��े�नेटेड इंक

3. कैरे�टर र�डर, म�ैने�टक-इंक

4. ऑि�टकल माक�  र�डस�, ऑि�टकल कैरे�टर �रकि�नशन �डवाइस

Question Type : MCQ
Question ID : 6182782284

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.2 MS-Excel 2016 फ़ाइल को ______ कहा जाता है।
Ans 1. द�तावेज़ (Document)

2. काय� प�क (Worksheet)

3. काय� पिु�तका (Workbook)

4. डटेा प�क (Datasheet)

Question Type : MCQ
Question ID : 6182782307

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.3 MS-Excel म� COUNTIF फ़ं�शन का उपयोग करने के �लए, �न�न�ल�खत म� से कौन सा �सटें�स सह� है?

Ans 1. “=COUNTIF(“Cell Range”, “Criteria”)”

2. “&&COUNTIF(“Sheet”, “Criteria”)”

3. “++COUNTPLUSIF(“Cell Range”, “Criteria”)”

4. “=COUNTIFELSE(“NULL”, “Criteria”)”

Participant ID 19335009
Participant Name SAMIR KUMAR CHINTU
Test Center Name iON Digital Zone iDZ 2 Patliputra
Test Date 24/12/2019
Test Time 9:00 AM - 10:00 AM
Subject Data Entry Operator
Marks Obtained 25.00000

Section : MCQ for Data Entry Operator
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Question Type : MCQ
Question ID : 6182782325

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.4 �न�न�ल�खत म� से कौन सा MS-Excel का मा�य लॉिजकल फ़ं�शन नह�ं है?

Ans 1. OR

2. IF

3. AND

4. COUNT

Question Type : MCQ
Question ID : 6182782326

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.5 �न�न�ल�खत म� से कौन सा इंटरनेट ए�ल�केशन नह�ं है?

Ans 1. ऑनलाइन खर�दार�

2. www.practo.com के मा�यम से डॉ�टर के पास अपॉइंटम�ट बकु करना

3. www.irctc.co.in के मा�यम से �ेन �टकट बकु करना

4. 3D ���ंटग

Question Type : MCQ
Question ID : 6182782340

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.6 एमएस वड� (MS-Word) म� ि��लट �वडंो हटाने के �लए शॉट� कट कंुजी �या है?

Ans 1. Ctrl + S

2. Alt + S

3. Shift + S

4. Ctrl + Alt + S

Question Type : MCQ
Question ID : 6182782309

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.7 य�द हम� कुछ �ह�स� को छोड़कर द�तावेज� क� कई ��तय� जो समान ह� �ा�त करने क� आव�यकता हो, जसेै
�नमं�ण प�, तो हम MS-Word क� ______ स�ुवधा का उपयोग कर सकत ेह�।

Ans 1. क�पेयर (Compare)

2. मेल मज� (Mail Merge)

3. ऑ�जे�ट (Object)

4. टेब�स (Tables)
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Question Type : MCQ
Question ID : 6182782306

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.8 Windows XP का आ�धका�रक तौर पर कब लॉ�च �कया गया था?
Ans 1. 15 माच� 2002

2. 24 अग�त 2001

3. 19 जनू 2002

4. 22 जलुाई 2000

Question Type : MCQ
Question ID : 6182782289

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.9 ______ यह �नधा��रत करता है �क एक अन�ुछेद म� रेखाएं बाएँ और दाएँ हा�शए (मािज�न) के संबंध म� कैसी
�दखाई देती ह�।

Ans 1. लाइन �पे�सगं

2. परैा�ाफ़ एलाइनम�ट

3. ��ॉलबार

4. फ़ॉम�ट प�टर

Question Type : MCQ
Question ID : 6182782301

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.10 �न�न�ल�खत म� से कौन ए�ल�केशन सॉ�टवेयर से संबं�धत नह�ं है?

Ans 1. इंफॉम�शन �स�टम सॉ�टवेयर

2. �स�यलेूशन सॉ�टवेयर

3. �ड�क ऑपरे�टगं �स�टम (DOS)

4. कंटे�ट ए�सेस सॉ�टवेयर

Question Type : MCQ
Question ID : 6182782286

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.11 MS-Excel म� �कसी वक� बकु को सहेजने के �लए �न�न�ल�खत म� से �कस क�बोड� शॉट�कट का उपयोग �कया
जाता है?

Ans 1. Alt + B

2. Alt + A

3. Alt + S
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4. Ctrl + S

Question Type : MCQ
Question ID : 6182782313

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.12 जब MS-Excel 2016 श�ु होता है, तो यह �वचा�लत �प से ______ वक� शीट वाले ______ का �नमा�ण
करता है।

Ans 1. चाट�, 1

2. वक� बकु, 3

3. वक� बकु, 1

4. चाट�, 3

Question Type : MCQ
Question ID : 6182782311

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.13 Microsoft Windows ______ का एक उदाहरण है।
Ans 1. ऑपरे�टगं �स�टम

2. ए�ल�केशन �ो�ाम

3. डटेाबेस �ो�ाम

4. वड� �ोसे�सगं सॉ�टवेयर

Question Type : MCQ
Question ID : 6182782290

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.14 �कसी वक� शीट म� एक परू� पंि�त (row) का चयन करने के �लए ______ कंुजी दबाएँ।
Ans 1. Shift + Spacebar

2. Caps Lock + Spacebar

3. Alt + Spacebar

4. Ctrl + Spacebar

Question Type : MCQ
Question ID : 6182782305

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.15 य�द हम �कसी टे��ट क� ि�थ�त को बदलकर द�तावेज़ को पनुग��ठत करना चाहत ेह�, तो हम� मौजदूा �थान से
टे��ट को हटाने और नए �थान पर �फर से टाइप करने क� आव�यकता नह�ं है - बस इसे अपने वत�मान �थान
से वां�छत �थान पर �थानांत�रत (मवू) कर�। इस उ�े�य के �लए पहला आदेश है:

Ans 1. Ctrl + M
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2. Ctrl + X

3. Ctrl + C

4. Ctrl + V

Question Type : MCQ
Question ID : 6182782303

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.16 MS-Word द�तावेज़ के अतं म� �न�न�ल�खत म� से कौन सा आइटम होता है?

Ans 1. एंडनोट

2. टा�क बार

3. हेडर

4. मेन ूबार

Question Type : MCQ
Question ID : 6182782296

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.17 �न�न�ल�खत म� से �ेज�टेशन क� �लाइड बनाने के �लए कौन सबसे अ�धक उपय�ुत है?

Ans 1. ए�डट �लस

2. जावा

3. माइ�ोसॉ�ट अज़रू

4. माइ�ोसॉ�ट पॉवरपॉइंट

Question Type : MCQ
Question ID : 6182782331

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.18 ______ एक एकल इले��ॉन बीम का उपयोग करता है और काले बकै�ाउंड पर एक रंग, आम तौर पर हरा,
कह�वा (ए�बर) या सफेद रंग �द�श�त (�ड��ले) करता है। ���न का ______ रंग �नधा��रत करता है।

Ans 1. मॉ�नटर इंटरफेस, मॉ�नटर इंटरफेस बो��स

2. मॉ�नटर, �थकनेस

3. मोनो�ोम मॉ�नटर, फॉ�फोर क�पोिज़शन

4. टेल��वजन, �ब�ट इन मॉ�यलेूटर

Question Type : MCQ
Question ID : 6182782285

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.19 ______ से आपको यह जानने म� मदद �मलती है �क IP ऐ�से का कौन सा भाग नेटवक�  क� पहचान करता है
और कौन सा भाग नो�स क� पहचान करता है।
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Ans 1. सबने�टगं

2. ��टगं

3. म�ट��लेि�संग

4. नेटवक�  मा�क

Question Type : MCQ
Question ID : 6182782339

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.20 आप एक �र�त वक� शीट के सेल A1 ह�। आप Ctrl + डाउन एरो दबाएं। कस�र कहाँ होगा?
Ans 1. कॉलम 1 क� पहल� सेल

2. रो A क� आ�खर� सेल

3. कॉलम 1 क� अ�ंतम सेल

4. कॉलम A क� अ�ंतम सेल

Question Type : MCQ
Question ID : 6182782314

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.21 MS Excel म� �न�न�ल�खत म� से कौन सा सह� सेल ए�से है?

Ans 1. A!

2. AB45

3. 45AD

4. CD%

Question Type : MCQ
Question ID : 6182782317

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.22 �कसी फ़ाइल या फ़ो�डर क� खोज करने के �लए ______ दबाएं और �फर उस फ़ाइल या फ़ो�डर का नाम �लख�
िजसे आप टे��ट �े� (text field) म� खोजना चाहत ेह�।

Ans 1. F5

2. F3

3. F4

4. F6

Question Type : MCQ
Question ID : 6182782293

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.23 �न�न�ल�खत म� से कौन सा कथन गलत है?
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Ans 1. आप गैर आस�न (non-adjacent) से�स के समहू का चयन नह�ं कर सकत।े

2. आप टे��ट के अनसुार पंि�त (रो) क� ऊंचाई को सेट कर सकत ेह�।

3. आप �सगंल सेल म� दो या दो से अ�धक से�स को जोड़ सकत ेह�।

4. आप सभी �तंभ� (कॉलम) के �लए सामान चौड़ाई सेट कर सकत ेह�।

Question Type : MCQ
Question ID : 6182782315

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.24 एमएस ए�सेल म�, पणू� संदभ� (absolute reference) ______ �तीक �वारा �चि�नत ह�।
Ans 1. %

2. $

3. #

4. *

Question Type : MCQ
Question ID : 6182782322

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.25 MS-Excel 2016 म�, डटेा को �वज़अुल �प से �फ़�टर करने के �लए �लाइसर बटन, MS Excel के इ�सट� टैब
______ समहू म� उपल�ध है।

Ans 1. � पाक� लाइ� स

2. �लकं

3. �फ़�टस�

4. टेबल

Question Type : MCQ
Question ID : 6182782329

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.26 MS-Excel 2016 के �कस मेन ूटैब म�, �ोटे�ट वक� शीट (protect worksheet) या अन�ोटे�ट वक� शीट
(unprotect worksheet) �वक�प उपल�ध है?

Ans 1. फ़ॉमू�ला

2. �यू

3. डटेा

4. �र�यु

Question Type : MCQ
Question ID : 6182782323

Status : Answered
Chosen Option : 4

Marks : 1.00
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Q.27 ______ म�, ______ का उपयोग कं�यटूर �वारा क� जाने वाल� कार�वाइय� तथा वण� ि��ंग का ��त�न�ध�व
करने के �लए �कया जाता है जो कं�यटूर क� मेमोर� म� उन �थान� के पत� को दशा�त ेह�, जहाँ संकाय� (ऑपर�ड)
सं��हत होत ेह�।

Ans 1. उ�च-�तर�य भाषाएँ, �वशषे वण�

2. ���या�मक भाषाएँ, डटेा त�व (ए�लम��स)

3. अस�बल� भाषाएँ, नीमॉ�न�स (Mnemonics)

4. उ�च-�तर�य भाषाएँ, सं�या�मक अकं

Question Type : MCQ
Question ID : 6182782288

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.28 ______ क� सहायता से, हम मेमोर� ए�सेस टाइम को कम करत ेह�।
Ans 1. ह��स

2. ROM

3. कैश

4. SDRAM

Question Type : MCQ
Question ID : 6182782282

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.29 र�नगं एमएस वड� (MS Word) डॉ�यमू�ट को बंद करने के �लए शॉट� कट क� �या है?

Ans 1. Ctrl + Q

2. Ctrl + S

3. Ctrl + C

4. Ctrl + W

Question Type : MCQ
Question ID : 6182782295

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.30 जब आप इंटरनेट ए�स�लोरर, �वडंोज मी�डया �लेयर, �वडंोज ए�स�लोरर आ�द चलात ेह�, तो �ो�ाम बटन को
______ पर �पन �कया जाता है।

Ans 1. Taskbar

2. Desktop

3. My Computer

4. My Documents

Question Type : MCQ
Question ID : 6182782291

Status : Answered
Chosen Option : 2
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Marks : 0.00

Q.31 फ़ं�शन हमेशा ______ �च�ह के साथ श�ु होता है?

Ans 1. “/”

2. “=”

3. “*”

4. “#”

Question Type : MCQ
Question ID : 6182782324

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.32 ______ म� ऐसी जानकार� होती है जो हर द�तावेज़ म� बदल जाती है और उसे मज� �कए गए द�तावेज़� म�
जोड़ना होता है।

Ans 1. मज� �कए गए द�तावेज़ (Merged document)

2. म�ुय द�तावेज़ (Main document)

3. डटेा �ोत (Data source)

4. द�तावेज़ (Document)

Question Type : MCQ
Question ID : 6182782304

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.33 सी.आई.डी.आर. (CIDR) को ______ भी कहा जाता है।
Ans 1. IP ए��ेसगं

2. म�ट�टाि�कंग

3. अपलो�डगं

4. सपुरने�टगं

Question Type : MCQ
Question ID : 6182782338

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.34 आप सभी �लाइड� म� कोई एक छ�व लागू करने के �लए ______ �य ूका उपयोग कर सकत ेह�।
Ans 1. �लाइड शो

2. ज़मू कं�ोल

3. �लाइड मा�टर

4. �लेसहो�डर

Question Type : MCQ
Question ID : 6182782335

Status : Answered
Chosen Option : 1ANKAJ INFOTECH
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Marks : 0.00

Q.35 जब आप �कसी दसूरे नाम से या एक अलग फ़ो�डर (या �ड�क) म� वत�मान द�तावेज़ क� एक ��त सहेजना
चाहत ेह� तो ______ का उपयोग कर�।

Ans 1. फ़ॉम�ट प�टर (Format Painter)

2. सेव एज़ (Save As)

3. लोकेट (Locate)

4. रे�लस (Replace)

Question Type : MCQ
Question ID : 6182782297

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.36 MS-PowerPoint म�, अपने �ेज�टेशन हेत ु�टोर� बोड� बनाने के �लए ______ का उपयोग कर�। इसम� आपक�
�लाइड पर केवल टे��ट �दखता है, �च� या �ा�फ़क से जड़ु ेअ�य आइट�स नह�ं।

Ans 1. मा�टर �यू

2. पेज �यू

3. नाम�ल �यू

4. आउटलाइन �यू

Question Type : MCQ
Question ID : 6182782333

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.37 MS Word म�, �न�न�ल�खत म� से कौन सा �वक�प Comments का भाग नह�ं है?

Ans 1. New Comment

2. Show Comments

3. Delete

4. All comments

Question Type : MCQ
Question ID : 6182782319

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.38 एमएस-वड� (MS Word) 2016 म�, Compare फ़ं�शन ______ मेन ूके तहत पाया जाता है।
Ans 1. File

2. Review

3. Home

4. View

Question Type : MCQ
Question ID : 6182782299
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Status : Answered
Chosen Option : 2

Marks : 1.00

Q.39 IE11, Internet Explorer का �यारहवा ंऔर अ�ंतम सं�करण (version) है। इस सं�करण (version) का
�नमा�ण �कसने �कया?

Ans 1. इ�टेल

2. गूगल

3. माइ�ोसॉ�ट

4. ऐ�पल

Question Type : MCQ
Question ID : 6182782336

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.40 ______ कंुिजय� का उपयोग कस�र को तीर �वारा इं�गत �दशा (ऊपर, नीचे, बाएँ, दाएँ) म� ले जाने के �लए
�कया जाता है।

Ans 1. कस�र ग�त�व�ध (Cursor movement)

2. फ़ं�शन

3. �व�श�ट-फ़ं�शन कंुिजया ँ(Special-function Keys)

4. टैब (Tab)

Question Type : MCQ
Question ID : 6182782283

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.41 MS-Word क� ______ स�ुवधा का उपयोग संभा�वत गल�तय� क� जांच करने और �फर ��येक सधुार क�
पिु�ट करने के �लए �कया जा सकता है।

Ans 1. �पे�लगं एंड �ामर

2. �माट� लकुअप

3. �माट�आट�

4. �य ूकम�ट

Question Type : MCQ
Question ID : 6182782302

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.42 कं�यटूर के �ोसेसर म� �या होना चा�हए?

Ans 1. �ाइमर� �टोरेज और ROM

2. ALU, कं�ोल य�ूनट और हाड� �ड�क

3. ALU, कं�ोल य�ूनट और रिज�टस�

4. इनपटु/आउटपटु �डवाइस और ALU
ANKAJ INFOTECH
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Question Type : MCQ
Question ID : 6182782281

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.43 शीष�क और क�टे�ट लेआउट म� MS-PowerPoint के ______ शा�मल है।
Ans 1. �ा�फ�स

2. केवल म�ट�-पप�स क�टे�टवाले �लेसहो�डस�

3. �लाइड क� सचूी

4. �लाइड शीष�क और म�ट�पप�स क�टे�टवाला �लेसहो�डर

Question Type : MCQ
Question ID : 6182782334

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.44 �न�न�ल�खत म� से कौन सा MS-Excel का मा�य चाट� �कार नह�ं है?

Ans 1. लाइन चाट�

2. रडार चाट�

3. पाइवोट चाट�

4. मज� चाट�

Question Type : MCQ
Question ID : 6182782328

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.45 MS Excel म� पासवड� के बारे म� �न�न�ल�खत म� से कौन सा सह� है?

Ans 1. एक बार सेट होने के बाद, इसे र�सेट नह� ं�कया जा सकता है

2. यह केवल बड़ ेअ�र क� अनमु�त देता है

3. यह केस स��स�टव है

4. यह केवल 5 वण� क� अनमु�त देता है

Question Type : MCQ
Question ID : 6182782316

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.46 एमएस वड� (MS-Word) म� ि��लट �वडंो के �लए शॉट� कट कंुजी �या है?

Ans 1. Ctrl + S

2. Alt + S

3. Shift + S

4. Ctrl + Alt + S
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Question Type : MCQ
Question ID : 6182782308

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.47 MS-Excel म�, �न�न�ल�खत म� से कौन एक मा�य बॉड�र �टाइल नह�ं है?

Ans 1. बॉटम बॉड�र

2. मज� बॉ�स बॉड�र

3. टॉप बॉड�र

4. �थक बॉ�स बॉड�र

Question Type : MCQ
Question ID : 6182782321

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.48 �न�न�ल�खत म� से कौन-सा �वक�प सेल म� �छपे हुए टे��ट को कई रेखाओ ंम� �द�श�त करता है?

Ans 1. रैप टे��ट

2. मज� से�स

3. इंड�ट

4. ��कं टू �फ़ट

Question Type : MCQ
Question ID : 6182782312

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.49 MS Word म� �कसी कार�वाई को पवू�वत ्करने (Undo) के �लए शॉट� कट कंुजी �या है?

Ans 1. Ctrl + U + D

2. Ctrl + U

3. Ctrl + Z

4. Ctrl + D

Question Type : MCQ
Question ID : 6182782298

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.50 �न�न�ल�खत म� से कौन सा आउटपटु �डवाइस नह�ं है?

Ans 1. क�बोड�

2. ��टंर

3. �लॉटर

4. मॉ�नटर

Question Type : MCQANKAJ INFOTECH
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Question ID : 6182782294
Status : Answered

Chosen Option : 1
Marks : 1.00

Q.51 ______ वह जगह है जहा ंकॉपी या कट �कया टे��ट को अ�थायी �प से सं�ह�त �कया जा सकता है।
Ans 1. एंडनोट

2. �टेटस बार

3. ि�लपबोड�

4. परैा�ाफ़

Question Type : MCQ
Question ID : 6182782300

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.52 MS-Excel 2016 म�, से�स म� ______ फ़ॉम�ट को लागू करने के �लए, से�स क� वां�छत सीमा चनु�। होम टैब
पर, ______ समहू के अदंर, उस कॉ�बो बॉ�स पर ि�लक कर� िजसम� "जनरल” मान �दखता है और सचूी म�
"नंबर” चनु�।

Ans 1. नंबर, �टाइल

2. कर�सी, जनरल

3. परस�टेज, �टाइल

4. नंबर, नंबर

Question Type : MCQ
Question ID : 6182782320

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.53 आप MS-Excel म� Home मेन ूम� ______ समहू म� रैप टे��ट �वक�प पा सकत ेह�।
Ans 1. Styles

2. Font

3. Alignment

4. Number

Question Type : MCQ
Question ID : 6182782318

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.54 MS-Word म�, जब म�ुय द�तावेज़ को डटेा �ोत के साथ मज� �कया जाता है तो बनाया गया नया द�तावेज़
______ कहलाता है।

Ans 1. मेन डॉ�यमू�ट

2. मज� फ��ड

3. म�ड� डॉ�यमू�ट
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4. डटेा सोस�

Question Type : MCQ
Question ID : 6182782310

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.55 अन�ुयोग सॉ�टवेयर ______ है।
Ans 1. इसे �स�टम सॉ�टवेयर भी कहा जाता है

2. संगतता सम�या को कम करने के �लए उपयोग �कया जाता है

3. काय� उ�मखु (Task-oriented) होता है

4. हाड�वेयर क� एक �ेणी है

Question Type : MCQ
Question ID : 6182782287

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.56 MS-Excel 2016 के इ�सट� मेन ूके अदंर इल��ेशन समहू म� �कतने �वक�प उपल�ध ह�?
Ans 1. 7

2. 3

3. 5

4. 4

Question Type : MCQ
Question ID : 6182782327

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.57 एमएस ए�सेल म�, हाइपर�लकं जोड़ने के �लए शॉट� कट कंुजी �या है?

Ans 1. Shift + H

2. Alt + K

3. Ctrl + K

4. Ctrl + H

Question Type : MCQ
Question ID : 6182782330

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.58 Which of the following includes a number of administrative tools for better
administration of Windows in terms of user management, event viewer, etc.?

Ans 1. Desktop

2. Control Panel

3. Device driver
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4. “Start” button

Question Type : MCQ
Question ID : 6182782292

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.59 एमएस पॉवरपॉइंट म�, वत�मान �लाइड क� डुि�लकेट कॉपी बनाने के �लए शॉट� कट क� �या है?

Ans 1. Shift + D

2. Ctrl + D

3. Alt + C

4. Alt + D

Question Type : MCQ
Question ID : 6182782332

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.60 �न�न�ल�खत म� से कौन सा इंटरनेट कने�शन का एक �कार नह�ं है?

Ans 1. Broadband

2. LAN

3. vSAT

4. Dial-up

Question Type : MCQ
Question ID : 6182782337

Status : Answered
Chosen Option : 4

Marks : 0.00
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Q.1 वेब �ाउजर, इंटरनेट और वेब के संबंध म� �न�न�ल�खत म� से कौन सा कथन स�य नह�ं है?

Ans 1. वेब �ाउज़र एक सॉ�टवेयर �ो�ाम है।

2. इंटरनेट कने�शन एक लनै नेटवक�  पर �था�पत नह�ं �कया जा सकता है

3. वेबसाइट� को एक डोमेन नाम क� आव�यकता होती है

4. कुक�ज़ वे संदेश होत ेह�, जो वेब सव�र आपके वेब �ाउज़र पर उस समय भेजता है, जब आप इंटरनेट
साइट� पर जात ेह�। 

Question Type : MCQ
Question ID : 6182782220

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.2 इनम� से कौन सा अस�बलर �वारा �न�म�त मशीन कोड है?

Ans 1. �नमो�नक कोड

2. �सटें�स कोड

3. बाइनर� �रलोकेटेबल कोड

4. टे��ट कोड

Question Type : MCQ
Question ID : 6182782169

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.3 पॉवरपॉइंट का उपयोग करके एक �ेज�टेशन देत ेसमय, �पीकर अ�ंतम �लाइड पर जाना चाहता है। उसे क�बोड�
पर कौन सी कंुजी दबानी चा�हए?

Ans 1. F1

2. Down Arrow Key

3. End

Participant ID 19392686
Participant Name MANTU KUMAR SINGH
Test Center Name iON Digital Zone iDZ Jalalpur
Test Date 26/12/2019
Test Time 3:00 PM - 4:00 PM
Subject Data Entry Operator
Marks Obtained 13.00000

Section : MCQ for Data Entry Operator
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4. Ctrl + E

Question Type : MCQ
Question ID : 6182782215

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.4 इंटरनेट कनेि�ट�वट� का इनम� से कौन सा साधन उ�चतम �पीड �दान करेगा?
Ans 1. सटेैलाइट

2. फाइबर ऑि�टक

3. कॉपर

4. केबल ट�वी

Question Type : MCQ
Question ID : 6182782217

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.5 एमएस-वड� (MS-Word) म�, �कसी टे��ट को एक �थान से दसूरे �थान� पर ले जाने के �लए �य�ुत शॉट� कट
कमांड का सह� �म �या है?

Ans 1. Ctrl + X → Ctrl + P

2. Ctrl + X → Ctrl + V

3. Ctrl + C → Ctrl + P

4. Ctrl + C → Ctrl + V

Question Type : MCQ
Question ID : 6182782183

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.6 �न�न �वक�प� म� से कौन सा एमएस-ए�सेल (MS-Excel) म� फॉम��टगं टूलबार म� मौजदू नह� ंहोता है?

Ans 1. अडंरलाइन

2. आउटसाइड बॉड�र

3. वड�आट�

4. ऑ�रएंटेशन

Question Type : MCQ
Question ID : 6182782198

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.7 ए�सेल 2016 वक� बकु 2016 म� नई वक� शीट डालने के �लए "इंसट� शीट" �वक�प ______ नामक �रबन के
अतंग�त मौजदू होता है।

Ans 1. �डज़ाइन

2. लेआउट
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3. इ�सट�

4. होम

Question Type : MCQ
Question ID : 6182782190

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.8

Ans
1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 6182782180

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.9 एक ए�सेल वक� शीट क� पंि�त 3 क� सभी सेल� को Italics फ़ॉ�ट म� करने के �लए �या करना चा�हए?

Ans 1. पंि�त 3 क� �कसी भी सेल को सेले�ट कर� और �रबन के Font टैब म� Italics �वक�प चनु�।

2. पंि�त 3 को सेले�ट कर� और �रबन के Home टैब म� Italics �वक�प चनु�।

3. पंि�त 3 क� �कसी भी सेल को सेले�ट कर� और �रबन के View टैब म� Italics �वक�प चनु�।

4. पंि�त 3 को सेले�ट कर� और �रबन के Design टैब म� Italics �वक�प चनु�।

Question Type : MCQ
Question ID : 6182782200

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.10 मेल मज� म�, ______ वह फ़ाइल है, िजसम� नाम और पत ेया कोई अ�य जानकार� शा�मल होती है, जो मेल-
मज� डॉ�यमू�ट के ��येक सं�करण के साथ बदलती है।

Ans 1. लेब�स

2. डाटा �ोत

3. म�ुय डॉ�यमू�ट

4. मज़� �कए गए डॉ�यमू�ट

Question Type : MCQ
Question ID : 6182782185

Status : Answered
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Chosen Option : 3
Marks : 0.00

Q.11 �न�न�ल�खत म� से कौन एक ए�ल�केशन सॉ�टवेयर नह�ं है?

Ans 1. Adobe Flash

2. Linux

3. Photoshop

4. SAP

Question Type : MCQ
Question ID : 6182782164

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.12 ईमेल पर �ा�त एक ए�सेल फाइल म�, मझु ेकॉलम के नाम A, B, C, E, F, G….. �दखाई देत ेह�। कॉलम डी के
�दखाई नह�ं देने का �या कारण हो सकता है?

Ans 1. फ़ाइल म� वायरस है।

2. इसे हटा �दया गया है।

3. इसे �छपा �दया गया है।

4. �ेषक �वारा कॉलम नाम बदल �दए गए ह�।

Question Type : MCQ
Question ID : 6182782195

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.13 �न�न म� से कौन-सा एि�लकेशन सॉ�टवेयर नह�ं है?

Ans 1. वड� �ोसेसर

2. डटेाबेस सॉ�टवेयर

3. अस�बलर सॉ�टवेयर

4. वेब �ाउज़र

Question Type : MCQ
Question ID : 6182782166

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.14 एक एमएस-वड� (MS-Word) डॉ�यमू�ट म�, ______ सचूी का उपयोग तब �कया जाना चा�हए, जब कई
संबं�धत आइट�स ह�, और आइट�स का �म भी मायने रखता हो।

Ans 1. �मां�कत (Numbered)

2. ऊ�वा�धर (Vertical)

3. सामा�य (Normal)

4. बलेुटेड (Bulleted)

Question Type : MCQ
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Question ID : 6182782181
Status : Answered

Chosen Option : 3
Marks : 0.00

Q.15

Ans
1. 

2. कर�सी

3. 

4. 

Question Type : MCQ
Question ID : 6182782199

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.16 डॉ�यमू�ट बनाने, ए�डट करने, सहेजने और ��टं करने के �लए कं�यटूर का उपयोग करने के काय� को �या कहा
जाता है?

Ans 1. वड� �वज़ाड�

2. वड� �ोसे�सगं

3. वड� ल�ड�केप

4. वड� रै�पगं

Question Type : MCQ
Question ID : 6182782175

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.17 �वडंोज़ ए�सपी (Windows XP) म�, उन �ो�ाम� के आइकॉन, जो कं�यटूर के ऑन �कए जाने पर �वचा�लत
�प से �ारंभ हो जात ेह�, ______ म� �द�श�त �कए जात ेह�।

Ans 1. नोट��फ़केशन �े�

2. नोट�फ़ाई �े�

3. आइकन �े�

4. नो�टस �े�

Question Type : MCQ
Question ID : 6182782171

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.18
ANKAJ INFOTECH



1/28/2020 https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S90D582/157736624999326…

https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S90D582/15773662499932673/1939268… 6/17

एमएस-ए�सेल (MS-Excel) म� उपयोगकता� को केवल चय�नत सेल� को ए�डट करने क� अनमु�त देने के �लए,
�या करना चा�हए?

Ans 1. चय�नत सेल� को अनलॉक कर� और �फर वक� शीट को सरु��त कर�।

2. सेल� को सेले�ट कर� और �फर उ�ह� अन�ोटे�ट कर�।

3. सेले�ट क� गई सेल� को �ोटे�ट कर� और �फर वक� शीट को लॉक कर�।

4. उन सेल� को लॉक कर�, िज�ह� ए�डट नह�ं �कया जाना चा�हए और �फर वक� शीट को �ोटे�ट कर�।

Question Type : MCQ
Question ID : 6182782204

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.19 एमएस-ए�सेल (MS-Excel) म� एक बड़ी वक� शीट म�, आप हमेशा पहले कॉलम और शीष� पंि�त को हमेशा
�दखाना चाहत ेह�। आप कौन से कमांड का �वक�प चनु�गे?

Ans 1. View → Freeze Row and Column

2. Home → Freeze Panes

3. View → Freeze Top Row

4. View → Freeze Panes

Question Type : MCQ
Question ID : 6182782193

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.20 एक उपयोगकता� Show/Hide paragraph marks स��य करता है। द�तावेज़ को ��टं करत ेसमय �या
�भाव पड़गेा?

Ans 1. कोई �भाव नह�ं

2. परैा�ाफ माक�  छपे ह�गे

3. परैा�ाफ नह�ं छप�गे

4. केवल एक ह� परैा�ाफ म�ु�त �कया जाएगा

Question Type : MCQ
Question ID : 6182782179

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.21

Ans
1. 

2. 
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3. 

4. 

Question Type : MCQ
Question ID : 6182782202

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.22 कं�यटूर गे�मगं के �लए लोक��य �प से उपयोग क� जाने वाल� कं�ोल ि�टक को ______ कहा जाता है।
Ans 1. जॉयि�टक

2. �ैकबॉल

3. पेन �टाइलस

4. �ैकपॉइंट

Question Type : MCQ
Question ID : 6182782163

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.23 �न�न�ल�खत म� से कौन सी मेमोर�, CPU का �ह�सा नह�ं है?

Ans 1. रैम (RAM)

2. पेन �ाइव (Pen Drive)

3. कैश (Cache)

4. रिज�टर (Register)

Question Type : MCQ
Question ID : 6182782161

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.24 एमएस-ए�सेल (MS-Excel) म� ______, �झान� को �द�श�त करने म� �वशषे �प से �भावी है। इसम�
ऊ�वा�धर अ� (Y- अ�) हमेशा सं�या�मक मान �द�श�त करती है और �ै�तज अ� (X- अ�) समय या अ�य
�ेणी को �द�श�त करती है।

Ans 1. पाई चाट�

2. लाइन चाट�

3. डोनट चाट�

4. राडार चाट�

Question Type : MCQ
Question ID : 6182782208

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.25 ______ आपक� संपणू� हाड� �ाइव को �कैन करता है, अनाव�यक फाइ�स को हटाता है, जसेै �क इंटरनेट से
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आने वाल� अ�थाई फाइ�स और कुक�ज़, जो आपके वेबपेज� पर जाने के दौरान डाउनलोड होती ह�।
Ans 1. रिज��� �ल�नर

2. �ड�क �ल�नअप

3. �ड�क कं�ेशन

4. �ड�क डी�ैग़म�टर

Question Type : MCQ
Question ID : 6182782167

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.26 �वडंोज़ ए�सपी (Windows XP) म�, �छपी हुई फाइल� और फो�डर� को �दखाने के �लए, फ़ो�डर �ॉपट�ज के
______ टैब पर ि�लक कर�।

Ans 1. File Types

2. View

3. General

4. Offline Files

Question Type : MCQ
Question ID : 6182782172

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.27 �न�न�ल�खत म� से कौन सा मेल मज़� ऑपरेशन के �लए डटेा �ोत नह�ं हो सकता है?

Ans 1. आउटलकु संपक�  सचूी

2. CSV फ़ाइल

3. एमएस वननोट (MS OneNote)

4. एमएस-वड� (MS-Word) डॉ�यमू�ट म� एक टेबल

Question Type : MCQ
Question ID : 6182782186

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.28 ______ �वक�प का उपयोग अ�य उपयोगकता�ओ ंको डॉ�यमू�ट म� फेरबदल करने क� अनमु�त देने के �लए
�कया जाता है, ले�कन सभी प�रवत�न� को हाइलाइट �कया जाता है।

Ans 1. �ैक यज़ूस�

2. �ैक च�जेज

3. �ैक डॉ�यमू�ट

4. �ैक ए�ड�टगं

Question Type : MCQ
Question ID : 6182782177

Status : Answered
Chosen Option : 4

Marks : 0.00ANKAJ INFOTECH
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Q.29 �ले नरेैशंस �वक�प एमएस पॉवरपॉइंट 2016 म� _______ मेन ूके तहत पाया जाता है।
Ans 1. View

2. Transitions

3. Insert

4. Slide show

Question Type : MCQ
Question ID : 6182782214

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.30 �वडंोज ए�स�लोरर म� फ़ाइल "X1?" खोजने पर, प�रणाम म� कौन सी फ़ाइल� �दखाई द�गी?
Ans 1. िजनके फ़ाइल के नाम म� कह�ं भी X1 है

2. िजनके फ़ाइल का नाम X1 और कम से कम एक वण� से श�ु होत ेह�

3. िजनके फ़ाइल का नाम X1 और a? से श�ु होत ेह�

4. िजनके फ़ाइल का नाम X1 से श�ु होत ेह� और वण� क� सं�या �नधा��रत नह�ं है

Question Type : MCQ
Question ID : 6182782173

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.31 इनम� से कौन सी ऑ�जे�ट-ओ�रएंटेड ल��वेज नह�ं है?

Ans 1. BASIC

2. �मॉलटॉक

3. C++

4. पायथन (Python)

Question Type : MCQ
Question ID : 6182782168

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.32 �न�न�ल�खत म� से कौन सी सबसे धीमी मेमोर� है?

Ans 1. Register

2. pendrive

3. RAM

4. tape drive

Question Type : MCQ
Question ID : 6182782165

Status : Answered
Chosen Option : 4

Marks : 1.00
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Q.33 उस �ड����यटेूड डटेाबेस का नाम �या है, जो इंटरनेट पर कं�यटूर के नाम� और उनके संगत आईपी पत� का
�रकाड� रखता है?

Ans 1. यआूरएल (URL)

2. एसएमट�पी (SMTP)

3. ट�सीपी (TCP)

4. डीएनएस (DNS)

Question Type : MCQ
Question ID : 6182782218

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.34

Ans 1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 6182782206

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.35 "एडवांस �लाइड" �वक�प MS PowerPoint 2016 म� ___ मेन ूके तहत उपल�ध है।
Ans 1. इ�सट�

2. �ांिज़श�स

3. �यू

4. फाइ�स

Question Type : MCQ
Question ID : 6182782213

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.36 एमएस-ए�सेल (MS-Excel) म� वक� शीट के संबंध म� �न�न�ल�खत म� से कौन सा कथन सह� नह�ं है?

Ans
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1. �कसी वक� बकु म� वक� शी�स के �म को बदला जा सकता है।

2. एक या अ�धक वक� शीट �छपाई जा सकती ह�।

3. आप अनडू कमांड (Undo command) �वारा हटाए गए वक� शीट को र��टोर कर सकत ेह�।

4. वक� शीट का नाम बदला जा सकता है।

Question Type : MCQ
Question ID : 6182782191

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.37 Lines, Rectangles, Block Arrows और Callouts एमएस-ए�सेल (MS-Excel) म� �न�न�ल�खत म� से
�कसे �द�श�त करत ेह�?

Ans 1. चा��स

2. �माट�आट�

3. आइकॉ�स

4. श�ेस

Question Type : MCQ
Question ID : 6182782210

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.38 एमएस-ए�सेल (MS-Excel) म�, वकैि�पक पंि�तय� को शी�ता से अलग-अलग रंग� म� फ़ॉम�ट करने का सबसे
अ�छा तर�का �या है?

Ans 1. सेल �टाइ�स (Cell Styles)

2. फ़ॉम�ट एज़ टेबल (Format as Table)

3. कंडीशनल फ़ॉम��टगं (Conditional formatting)

4. थी�स (Themes)

Question Type : MCQ
Question ID : 6182782201

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.39 एमएस-वड� (MS-Word) 2016 डॉ�यमू�ट म� टे��ट को तीन कॉलम म� रखने के �लए, आपको कॉलम �वक�प,
�रबन क� �कस हे�डगं के अतंग�त �मलेगा?

Ans 1. होम

2. लेआउट

3. इ�सट�

4. �डज़ाइन

Question Type : MCQ
Question ID : 6182782184

Status : Answered
Chosen Option : 1

Marks : 0.00
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Q.40 "SmartArt" �वक�प एमएस-ए�सेल (MS-Excel) �रबन म� ______ टैब के अतंग�त उपल�ध होता है।
Ans 1. �ॉ

2. इ�सट�

3. होम

4. पेज लेआउट

Question Type : MCQ
Question ID : 6182782209

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.41

Ans
1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 6182782187

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.42 एमएस-ए�सेल (MS-Excel) क� वक� शीट म� एक कॉलम जोड़ने के �लए:

a) उस वक� शीट पर ि�लक कर� जहां कॉलम जोड़ा जाना है।
b) ______ टैब पर ि�लक कर�।
c) Cells �ुप म� ______ बटन पर तीर पर ि�लक कर�।
d) Insert Sheet Columns पर ि�लक कर�।

Ans 1. Insert, Add

2. Insert, Rows

3. Home, Add

4. Home, Insert

Question Type : MCQ
Question ID : 6182782192

Status : Answered
Chosen Option : 1

Marks : 0.00
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Q.43 मेल मज� करत ेसमय, डटेा �ोत के एमएस-वड� (MS-Word) डॉ�यमू�ट से जड़ुने के बाद, ______ जोड़ना,
डॉ�यमू�ट को डटेा �ोत से �ा�त जानकार� के साथ �नजीकृत करने का एक तर�का है।

Ans 1. मज� फ़���स

2. इ�सट� फ़���स

3. नेम फ़���स

4. डाटा फ़���स

Question Type : MCQ
Question ID : 6182782189

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.44 एमएस-ए�सेल (MS-Excel) वक� शीट म� एक कॉलम क� चौड़ाई बदलने के �लए, Home मेन ुम� �रबन पर
______ कमांड का उपयोग कर�।

Ans 1. कॉलम

2. टेबल

3. साइज़

4. फ़ॉम�ट

Question Type : MCQ
Question ID : 6182782194

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.45 �वडंोज़ ए�सपी (Windows XP) म�, �स�टम र��टोर �वक�प तक पहंुचने के �लए, �न�न म� �कस �वक�प म�
�दए गए तर�क़े का अनसुरण करना चा�हए?

Ans 1. Start > All Programs > System > System Tools > System Restore

2. Start > All Programs > System Information > System Tools > System Restore

3. Start > All Programs > System Tools > System Restore

4. Start > All Programs > Accessories > System Tools > System Restore

Question Type : MCQ
Question ID : 6182782170

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.46 वक� बकु संरचना को लॉक करना, अ�य उपयोगकता�ओ ंको वक� शीट म� कुछ जोड़ने, �थानांत�रत करने, हटाने,
�छपाने और नाम बदलने से रोकता है। यह ______ �कया जा सकता है।

Ans 1. वक� शीट लेवल �ोटे�शन का उपयोग करके

2. ए�सेल फ़ाइल के �लए Custom View सेट करके

3. वक� बकु लेवल �ोटे�शन का उपयोग करके

4. ए�सेल फ़ाइल के �लए Smart Look up का �योग करके

Question Type : MCQ
Question ID : 6182782197
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Status : Answered
Chosen Option : 1

Marks : 0.00

Q.47 �न�न�ल�खत म� से कौन सा इंटरनेट सेवा का एक �कार नह�ं है?

Ans 1. 4G

2. डीएसएल (DSL)

3. केबल (Cable)

4. यआूरएल (URL)

Question Type : MCQ
Question ID : 6182782216

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.48 एमएस-वड� (MS-Word) म�, डॉ�यमू�ट के �व�भ�न �यजू (views) को ��ततु करने के �लए �दए गए �यू
(view) बटन कौन से ह�?

Ans 1. ��टं लेआउट, फ़ुल ���न, वेब लेआउट, आउटलाइन लेआउट

2. ए�सेस लेआउट, �ा�ट �य,ू वेब लेआउट, आउटलाइन लेआउट

3. ��टं लेआउट, फुल ���न, वेब लेआउट, ए�सेस लेआउट

4. ए�सेस लेआउट, फुल ���न, वेब लेआउट, �ा�ट �यू

Question Type : MCQ
Question ID : 6182782176

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.49 MS-Word 2016 म� "वत�नी और �याकरण" जांच (“Spelling & Grammar” checking) �वक�प �रबन
के �कस �वक�प के अतंग�त मौजदू होता है?

Ans 1. �यू

2. रेफरे�सेस

3. र��यू

4. होम

Question Type : MCQ
Question ID : 6182782182

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.50 Protect Sheet �वक�प, एमएस-ए�सेल (MS-Excel) म� �रबन के �कस टैब के अतंग�त मौजदू होता है?

Ans 1. होम

2. पेज लेआउट

3. इ�सट�

4. र��यू
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Question Type : MCQ
Question ID : 6182782203

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.51 32 �बट सं�या के एक �लो�टगं पॉइंट �र�ज�टेशन म�, मं�टसा और घातांक (mantissa and exponent) का
आकार, �ब�स म� �कतना होता है?

Ans 1. मं�टसा - 16 घातांक - 15

2. मं�टसा - 15 घातांक - 16

3. मं�टसा - 8 घातांक - 23

4. मं�टसा - 23 घातांक - 8

Question Type : MCQ
Question ID : 6182782162

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.52 एमएस-पॉवरपॉइंट (MS-PowerPoint) म� New Slide �वक�प �रबन के ______ टैब के अतंग�त मौजदू है।
Ans 1. होम

2. �डज़ाइन

3. �लाइडशो

4. �ॉ

Question Type : MCQ
Question ID : 6182782211

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.53 फ़ं�शन ‘Effect’, �भावी वा�ष�क �याज दर �दान करता है, जब�क साधारण वा�ष�क �याज दर और ��त वष�
च�व�ृ� अव�धय� क� सं�या देता ह�। यह फ़ं�शन, एमएस-ए�सेल (MS-Excel) म� �न�न�ल�खत म� से �कस
�ेणी म� मौजदू होगा?

Ans 1. ग�णतीय और ��कोण�मतीय फ़ं�शन (Maths & Trigonometric functions)

2. ता�क� क फ़ं�शन (Logical functions)

3. �व�तीय फ़ं�शन (Financial functions)

4. डाटाबेस फ़ं�शन (Database functions)

Question Type : MCQ
Question ID : 6182782207

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.54 एक उपयोगकता� वड� डॉ�यमू�ट टे��ट फाइल को �रच फाइल फॉम�ट म� सेव करता है। इसके प�रणाम�व�प �या
होगा?

Ans 1. इससे अलग-अलग ऑपरे�टगं �स�टम म� �व�भ�न वड� �ोसेसर� के बीच टे��ट फाइल के आदान-

�दान क� अनमु�त �दान क� जाएगी।
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2. इससे �व�भ�न वड� �ोसेसर या ऑपरे�टगं �स�टम� के बीच टे��ट फ़ाइल के आदान-�दान क�
अनमु�त नह�ं द� जाएगी।

3. इससे अलग-अलग ऑपरे�टगं �स�टम� म� केवल समान वड� �ोसेसर के बीच टे��ट फाइल के
आदान-�दान क� अनमु�त �दान क� जाएगी।

4. इससे केवल समान ऑपरे�टगं �स�टम म� �व�भ�न वड� �ोसेसर� के बीच टे��ट फाइल के आदान-

�दान क� अनमु�त �दान क� जाएगी।

Question Type : MCQ
Question ID : 6182782178

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.55 स�ू "= TODAY()" का आउटपटु �या है?

Ans 1. ए�सेल शीट के �नमा�ण क� तार�ख

2. वत�मान समय

3. वत�मान तार�ख

4. फॉमू�ला दज� करने क� तार�ख

Question Type : MCQ
Question ID : 6182782196

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.56

Ans 1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 6182782205

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.57 सॉ�टवेयर इं�टॉलेशन के �लए, ऑि�टकल �ड�क क� परू� इमेज बनाने के �लए �कस अनकं�े�ड �ड�क इमेज
फ़ाइल फ़ॉम�ट का उपयोग �कया जाता है, और इसका उपयोग मलू मी�डया क� ��तयां बनाने के �लए �कया जा
सकता है?

Ans 1. .iso

2. .zip

3. .rar
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4. .bin

Question Type : MCQ
Question ID : 6182782174

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.58 एक ______ एक अ��वतीय पता है, जो इंटरनेट या लोकल नेटवक�  पर एक उपकरण क� पहचान करता है।
Ans 1. आईपी ए�से (IP Address)

2. यआूरएल (URL)

3. HTTPS

4. HTTP

Question Type : MCQ
Question ID : 6182782219

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.59 पॉवरपॉइंट �लाइड म�, बलेुटेड टे��ट क� छह लाइन� ह�। आप माउस को ि�लक �कए जाने पर, ��येक पंि�त को
एक-एक करके �द�श�त करना चाहत ेह�। �लाइड को �डज़ाइन करत ेसमय आप पावरपॉइंट क� �कस �वशषेता का
उपयोग कर�गे?

Ans 1. �डज़ाइन

2. ��गर

3. �ांिज़श�स

4. ए�नमेश�स

Question Type : MCQ
Question ID : 6182782212

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.60 मेल मज� का उपयोग करके लेबल ��टं करने के �लए, लेबल म� शा�मल �कए जाने वाले ��येक घटक के �लए
एक ______ बनाएं।

Ans 1. कॉलम

2. सेल

3. पंि�त

4. टेबल

Question Type : MCQ
Question ID : 6182782188

Status : Answered
Chosen Option : 3

Marks : 0.00
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Q.1 लेि�सकल एनालाइज़र, �सटैं�स एनालाइज़र, �सम��टक एनालाइज़र, _______ के कुछ चरण ह�।
Ans 1. अस�बलर

2. कंपाइलर

3. इंटरफेस

4. �लकंर

Question Type : MCQ
Question ID : 6182782349

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.2 �न�न �वक�प� म� से कौन सा MS Excel 2016 के फॉम��टगं टूलबार म� मौजदू नह�ं है?

Ans 1. रैप टे��ट (Wrap Text)

2. टे��ट बॉ�स (Text Box)

3. टे��ट हाइलाइट कलर (Text Highlight Colour)

4. बो�ड (Bold)

Question Type : MCQ
Question ID : 6182782378

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.3 While saving a Word document, you use _______ file format if you want to exchange
text file between different word processors in different operating systems.

Ans 1. Word 97-2003 document

2. Word Document

3. Word 97-2003 Template

4. Rich Text Format

Participant ID 19376264
Participant Name DHEERAJ KUMAR BAITHA
Test Center Name iON Digital Zone iDZ 2 Patliputra
Test Date 26/12/2019
Test Time 12:00 PM - 1:00 PM
Subject Data Entry Operator
Marks Obtained 23.00000

Section : MCQ for Data Entry Operator
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Question Type : MCQ
Question ID : 6182782358

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.4 Windows Explorer म� फाइल "X1*" क� खोज करत ेसमय, प�रणाम उन फाइ�स के फाइलनाम �द�श�त
कर�ग�, िजनके ______।

Ans 1. फ़ाइलनाम X1 और a * से श�ु होत ेह�

2. फ़ाइलनाम म� कह�ं भी X1 है

3. फ़ाइलनाम X1 से श�ु होत ेह� और नाम म� �कतने भी वण� हो सकत ेह�

4. फ़ाइलनाम X1 से श�ु होत ेह� और �यादातर एक वण� होता है

Question Type : MCQ
Question ID : 6182782353

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.5 ______ से �डल�ट क� गई आइटम र�सायकल �बन म� जात ेह�।
Ans 1. केवल हाड� �ड�क

2. हाड� �ड�क, सीडी और लनै

3. हाड� �ड�क और सीडी

4. �कसी भी �टोरेज उपकरण

Question Type : MCQ
Question ID : 6182782351

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.6 MS PowerPoint 2016 म� ______ टैब के अतंग�त “Reuse Slides” �वक�प उपल�ध है।
Ans 1. �र�यु

2. होम

3. �डज़ाइन

4. इ�सट�

Question Type : MCQ
Question ID : 6182782391

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.7 MS-Word 2016 म�, ���न पर �लर बार, ��ॉल बार और �टेटस बार क� �डफ़ॉ�ट ि�थ�तया ं�मशः
______ है।

Ans 1. ऊपर, दाएं, नीचे

2. ऊपर, नीचे, दाएं

3. दाएं, ऊपर, नीचे
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4. दाएं, नीचे, ऊपर

Question Type : MCQ
Question ID : 6182782356

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.8 Haptic input devices pertain to the sense of:
Ans 1. Hearing

2. Speaking

3. Touch

4. Seeing

Question Type : MCQ
Question ID : 6182782345

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.9 CPU म� �न�न�ल�खत म� से कौन सी मेमोर� सबसे तजे है?

Ans 1. रैम

2. कैश मेमोर�

3. रोम

4. रिज�टर

Question Type : MCQ
Question ID : 6182782341

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.10 MS excel वक� शीट म� एक पंि�त क� ऊंचाई (Row height) बदलने के �लए, ______ मेन ुके अतंग�त
Format कमांड का उपयोग कर�।

Ans 1. पेज ले-आउट (Page Layout)

2. �य ू(View)

3. �ा (Draw)

4. होम (Home)

Question Type : MCQ
Question ID : 6182782374

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.11 MS excel म� एक बड़ी वक� शीट म�, आप पहले कॉलम और शीष� पंि�त को हमेशा ��य रखना चाहत ेह�।
Freeze Panes कमांड का उपयोग करने से पहले �कस सेल को सेले�ट �कया जाना चा�हए?

Ans 1. A2

2. B1
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3. B2

4. A1

Question Type : MCQ
Question ID : 6182782373

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.12

Ans 1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 6182782375

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.13

Ans 1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 6182782386

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.14 In MS-Word, a password-protected document can be created by using:
Ans 1. Restrict access

2. Encrypt with password

3. Restrict editing
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4. Mark as final

Question Type : MCQ
Question ID : 6182782359

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.15 ______ searches for all pieces of every file on your hard drive and reassembles the
files into a specific location.

Ans 1. Registry Cleaner

2. Disk Defragmenter

3. Disk Compression

4. Disk Cleanup

Question Type : MCQ
Question ID : 6182782347

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.16 एक MS-Word डॉ�यमू�ट म�, ______ सचूी का उपयोग तब �कया जाना चा�हए, जब कई संबं�धत आइट�स
ह�, ले�कन िजस �म म� उ�ह� पढ़ा जाता है, वह र�डर के �लए �यादा मायने नह�ं रखता है।

Ans 1. ऊ�वा�धर (Vertical)

2. बलेुटेड (Bulleted)

3. म�ट�-लेवल (Multi-level)

4. नंबड� (Numbered)

Question Type : MCQ
Question ID : 6182782361

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.17

Ans 1. 

2. 

3. 

4. इफे��स

Question Type : MCQ
Question ID : 6182782382

Status : Answered
Chosen Option : 2

Marks : 0.00
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Q.18 इंटरनेट ए�सेेस nnn.nnn.nnn.nnn के �प म� होत ेह�, जहां nnn को _____ के बीच का नंबर होना चा�हए।
Ans 1. 0-256

2. 1-255

3. 1-256

4. 0-255

Question Type : MCQ
Question ID : 6182782399

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.19 �न�न�ल�खत म� से कौन सा MS-Word 2016 डॉ�यमू�ट म� से�शन �ेक के �लए एक वधै �वक�प नह�ं है?

Ans 1. �वषम प�ृठ (Odd Page)

2. वकैि�पक प�ृठ (Alternate Page)

3. सतत प�ृठ (Continuous Page)

4. अगला प�ृठ (Next Page)

Question Type : MCQ
Question ID : 6182782364

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.20 RAR फ़ाइल फ़ॉम�ट का उपयोग फ़ाइल आकार संकोचन के �लए �कया जाता है। RAR का पणू� �प �या है?

Ans 1. Roshan ARchive (रोशन आका�इव)

2. Rosate Archive (रोसेट आका�इव)

3. Roshal Archive (रोशल आका�इव)

4. Restrict Archive (रेि���ट आका�इव)

Question Type : MCQ
Question ID : 6182782354

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.21 कं�यटूर म� 2’s परूक (2’s complement) म� दशा�ई गई सं�याओ ंक� र�ज _____ के बीच होती है।
Ans 1. (-2n-1-1) to (2n) 

2. (-2n-1) to (2n-1 – 1)

3. (-2n-1 )to (2n-1 )

4. (-2n-1) to (2n-1) 

Question Type : MCQ
Question ID : 6182782342

Status : Answered
Chosen Option : 1

Marks : 0.00
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Q.22 �न�न�ल�खत म� से कौन सा एक �स�टम सॉ�टवेयर नह�ं है?

Ans 1. SAP

2. DOS

3. Unix

4. Ubuntu

Question Type : MCQ
Question ID : 6182782346

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.23 मेल मज� ऑपरेशन म�, �यि�तगत द�तावेज (जसेै, एक �ट�डड� लेटर, एनवेलप, या मे�लगं लेबल) को ______
के �प म� जाना जाता है।

Ans 1. म�ुय द�तावेज़

2. लेटर

3. डाटा �ोत

4. मज़� �कया गया डॉ�यमू�ट

Question Type : MCQ
Question ID : 6182782365

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.24 What is the short cut key to Underline the Text in MS Word?
Ans 1. Ctrl + U

2. Alt + U

3. Ctrl + P

4. Ctrl + O

Question Type : MCQ
Question ID : 6182782367

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.25 MS-Word म�, जब आप कई द�तावेज� पर काम कर रहे होत ेह�, तो ______ टैब म� �दए गए �वक�प� का
उपयोग करके उ�ह� �यवि�थत कर�।

Ans 1. लेआउट

2. र��यू

3. �यू

4. इ�सट�

Question Type : MCQ
Question ID : 6182782357

Status : Answered
Chosen Option : 1

Marks : 0.00
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Q.26 उ�तर प��का पर �लकै एंड �हाइट �च�न� को पढ़ने और इसे कं�यटूर पर भेजने के �लए �य�ुत उपकरण को
�या कहा जाता है?

Ans 1. OCR

2. OMR

3. MICR

4. �लॉटर

Question Type : MCQ
Question ID : 6182782343

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.27 "Shapes" �वक�प, MS Excel 2016 म� ______ टैब के अतंग�त मौजदू होता है।
Ans 1. पेज ले- आउट

2. होम

3. �ा

4. इ�सट�

Question Type : MCQ
Question ID : 6182782389

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.28 Which type of wire is used by a Digital Subscriber Line or DSL connection, for internet
access?

Ans 1. Fiber Optic

2. Cable TV

3. Copper

4. LAN cable

Question Type : MCQ
Question ID : 6182782397

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.29 घर� म� उपयोग क� जाने वाल� अ�धकांश इंटरनेट ए�सेस �व�धय� म� ______ नामक हाड�वेयर इकाई (unit)
शा�मल होती है। यह एक भौ�तक मा�यम से जड़ुती है, जो या तो फोन लाइन (DSL के �लए), केबल इंटरनेट
(CATV) लाइन, फाइबर ऑि�टक केबल, या वायरलेस एंट�ना (उप�ह और वायरलेस �ॉडब�ड सेवाओ ंके �लए)
का समथ�न करती है।

Ans 1. सव�र

2. मॉडमे

3. फ़ायरवॉल

4. ��ज

Question Type : MCQ
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Question ID : 6182782396
Status : Answered

Chosen Option : 2
Marks : 1.00

Q.30 World Wide Web (WWW), इंटरनेट पर सबसे अ�धक इ�तमेाल क� जाने वाल� सेवाओ ंम� से एक है। वेब
संबंधी काय� करने के �लए �य�ुत ए�ल�केशन �ोटोकॉल को �या कहा जाता है?

Ans 1. HTTP

2. VGP

3. USP

4. PGP

Question Type : MCQ
Question ID : 6182782398

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.31 "वत�नी और �याकरण क� जाँच (Spelling & Grammar checking)" MS-Word 2016 म� �रबन के �कस
�वक�प के अतंग�त ि�थत होता है?

Ans 1. �यू

2. र��यू

3. रेफ़र�स

4. होम

Question Type : MCQ
Question ID : 6182782362

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.32 �न�न�ल�खत म� से कौन सा एक पणू� सेल संदभ� (absolute cell reference) है?

Ans 1. $A$1

2. A1

3. A!

4. A1$

Question Type : MCQ
Question ID : 6182782376

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.33 �कसी ए�सेल वक� शीट के कॉलम B के सभी से�स म� फ़ॉ�ट को Bold करने के �लए �या करना चा�हए?

Ans 1. कॉलम B सेले�ट कर� और �रबन के Home टैब म� Bold �वक�प चनु�।

2. कॉलम B क� �कसी भी सेल को सेले�ट कर� और �रबन के Font टैब म� Bold �वक�प चनु�।

3. कॉलम B सेले�ट कर� और �रबन के Design टैब म� Bold �वक�प चनु�।

4. कॉलम B क� �कसी भी सेल को सेले�ट कर� और �रबन के View टैब म� Bold �वक�प चनु�।
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Question Type : MCQ
Question ID : 6182782380

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.34 MS Excel म� एक �ाफ बनाया गया है, िजसका उपयोग MS PowerPoint म� एक �लाइड म� �कया जाना है।
य�द ए�सेल ��ेडशीट म� अतं�न��हत डटेा म� कोई प�रवत�न होता है, तो पॉवरपॉइंट �लाइड म� मौजदू �ाफ़ म�
उसके संगत प�रवत�न �वचा�लत �प से नह�ं होने चा�हए। आप इसके �लए पॉवरपॉइंट क� �कस �वशषेता का
उपयोग कर�गे?

Ans 1. Format Painter

2. Paste

3. Paste Special > Picture (jpeg)

4. Insert

Question Type : MCQ
Question ID : 6182782392

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.35 MS PowerPoint 2016 म� _______ मेन ूके तहत �रहस�ल टाइ�मगं उपल�ध है।
Ans 1. Animation

2. Insert

3. File

4. Slide show

Question Type : MCQ
Question ID : 6182782393

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.36 ए�सेल वक� बकु म� वक� शीट का नाम बदलने के �लए, फ़ॉम�ट �वक�प ____ मेन ुके अतंग�त मौजदू होता है।
Ans 1. होम

2. इ�सट�

3. �डजाइन

4. लेआउट

Question Type : MCQ
Question ID : 6182782370

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.37 MS Excel म� से�स को अनलॉक करने के �लए, से�स को सेले�ट करने के बाद �न�न म� से कौन सा �वक�प
चनुना चा�हए?

Ans 1. Review → Protection → clear Locked

2. Home → Protection Tab → clear Locked
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3. Protect Sheet → Protection Tab → clear Locked

4. Format Cells → Protection → clear Locked

Question Type : MCQ
Question ID : 6182782383

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.38 वक� बकु के अदंर शीट टैब पर ि�लक करने पर, यह देखा जाता है �क वक� बकु संरचना को बदलने के �वक�प,
जसेै �क इ�सट�, �डल�ट, �रनेम, मवू, कॉपी, हाइड और अनहाइड शी�स अनपुल�ध ह�। इसका �या कारण हो
सकता है?

Ans 1. वक� बकु �ोटे�टेड है

2. वक� बकु को र�ड ओनल� मोड म� खोला गया है।

3. वक� बकु का Custom View स�म �कया गया है।

4. वक� शीट �ोटे�टेड है

Question Type : MCQ
Question ID : 6182782377

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.39 वेब �ाउज़स�, इंटरनेट और वेब के संबंध म� �न�न�ल�खत म� से कौन सा कथन स�य नह�ं है?

Ans 1. कुछ वेबसाइट उपयोगकता� के डटेा को 'सेव' करने के �लए कुक�ज़ का उपयोग करती ह�

2. �ाउज़र आपके कं�यटूर पर कोड रन करने क� अनमु�त देकर फ़ं�शन जोड़त ेह�

3. एक सरु��त वेबसाइट का यआूरएल "http://" से श�ु होना चा�हए 

4. सभी वेब �ाउज़र, उपकरण� के काफ� मानक सेट का उपयोग करत ेह�

Question Type : MCQ
Question ID : 6182782400

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.40 �न�न�ल�खत म� से कौन एक उ�च �तर�य भाषा नह� ंहै?

Ans 1. Assembly language

2. COBOL

3. Python

4. Java

Question Type : MCQ
Question ID : 6182782348

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.41 "Label Options" डायलॉग बॉ�स म�, �न�न म� से �कसे नह�ं चनुा जा सकता है?

Ans 1. उ�पाद सं�या (Product Number)
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2. डाटा �ोत (Data Source)

3. लेबल जानकार� (Label Information)

4. ��टंर जानकार� (Printer Information)

Question Type : MCQ
Question ID : 6182782368

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.42 पावरपॉइंट का उपयोग करत ेहुए एक �ेज�टेशन देत ेहुए, �पीकर पहल� �लाइड पर वापस जाना चाहता है। उसे
क�बोड� पर कौन सी कंुजी दबानी चा�हए?

Ans 1. Ctrl+B

2. Up Arrow Key

3. F1

4. Home

Question Type : MCQ
Question ID : 6182782395

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.43 �कसी फ़ाइल क� र�ड-ओ�ल�, �छपे हुए और आका�इव �वशषेताओ ंको फ़ाइल �ॉपट�ज के ______ टैब पर देखा
जा सकता है।

Ans 1. जनरल (General)

2. शये�रगं (Sharing)

3. �डटे�स (Details)

4. क�टमाइज (Customize)

Question Type : MCQ
Question ID : 6182782352

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.44

Ans 1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 6182782379

Status : AnsweredANKAJ INFOTECH
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Chosen Option : 1
Marks : 1.00

Q.45 MS Excel 2016 म�, ज�द� से वकैि�पक कॉल�स को अलग-अलग रंग� के साथ फ़ॉम�ट करने का सबसे अ�छा
तर�का �या है?

Ans 1. Format as Table → Themes → Design

2. Data → Format as Table

3. Home → Format as Table

4. Home → Conditional formatting

Question Type : MCQ
Question ID : 6182782381

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.46 a)  MS Excel 2016 क� �कसी वक� शीट म� एक पंि�त जोड़ने के �लए:
उस वक� शीट पर ि�लक कर�, जहाँ पंि�त जोड़ी जानी है।
______ टैब पर ि�लक कर�।
Cells �ुप म� ______ बटन पर मौजदू तीर (arrow) पर ि�लक कर�।
Insert Sheet Rows ि�लक कर�।

Ans 1. Insert, Add

2. Insert, Rows

3. Home, Add

4. Home, Insert

Question Type : MCQ
Question ID : 6182782372

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.47 मेल मज� करत ेसमय, एक बार डटेा �ोत के एमएस वड� डॉ�यमू�ट से जड़ुने के बाद, मज� फ���स जोड़ना, डटेा
�ोत से �ा�त जानकार� के साथ एक डॉ�यमू�ट को �नजीकृत करने का एक तर�का है। मज� फ���स डटेा �ोत म�
______ से आत ेह�।

Ans 1. कॉलम नंबस�

2. कॉलम हे�ड�ंस

3. रो लेब�स

4. सेल ए�सेेस

Question Type : MCQ
Question ID : 6182782369

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.48 जब आप MS-Word 2016 श�ु करत ेह�, तो ______ आमतौर पर उपयोग �कए जाने वाले आदेश� के �लए
आइकन �दान करता है जसेै - save और undo

Ans 1. टा�क बार
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2. ि�वक ए�सेस टूलबार

3. �रबन

4. �टेटस बार

Question Type : MCQ
Question ID : 6182782355

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.49

Ans 1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 6182782384

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.50 Windos XP म�, य�द कुछ गड़बड़ी होती है, तो अपने कं�यटूर को �पछल� ि�थ�त म� वापस लाने के �लए
______ �वक�प का उपयोग कर�।

Ans 1. रोल बकै

2. ऑपरे�टगं र��टोर

3. �टेट र��टोर

4. �स�टम र��टोर

Question Type : MCQ
Question ID : 6182782350

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.51 MS Excel म� एक वक� शीट �डल�ट क� जाती है और �फर वक� बकु को सेव कर �दया जाता है। �डल�ट क� गई
वक� शीट के संबंध म� इनम� से कौन सा कथन स�य है?

Ans 1. इसे �ैश �बन से �रकवर �कया जा सकता है।

2. यह �छप जाता है, और इसे पनुः �दखाया जा सकता है

3. इसे ि�लपबोड� पर कॉपी �कया जाता है।

4. इसे �रकवर नह�ं �कया जा सकता है।

Question Type : MCQ
Question ID : 6182782371

Status : Answered
Chosen Option : 1
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Marks : 0.00

Q.52

Ans 1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 6182782385

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.53 _________ पोट�, संगीत वा�य यं�� को कं�यटूर से जोड़ने क� अनमु�त �दान करता है।
Ans 1. MIPI

2. DIPI

3. DIMI

4. MIDI

Question Type : MCQ
Question ID : 6182782344

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.54 Which one of the following CANNOT be a Data Source for a Mail Merge operation?
Ans 1. MS-Smartsheet

2. CSV file

3. MS-Excel

4. An Open Database Connectivity (ODBC) database

Question Type : MCQ
Question ID : 6182782366

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.55 फ़ं�शन “TRUE”, ता�क� क मान TRUE देता है। जब आप �कसी शत� के आधार पर TRUE �ा�त करना चाहते
ह�, तो आप इस फ़ं�शन का उपयोग कर सकत ेह�।  यह फ़ं�शन MS Excel म� �न�न�ल�खत म� से �कस �ेणी
म� मौजदू होता है।

Ans 1. डटेाबेस फ़ं�शन

2. लॉिजकल फ़ं�शन

3. �व�तीय फ़ं�शन

4. ग�णतीय और ��कोण�मतीय फ़ं�शन
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Question Type : MCQ
Question ID : 6182782387

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.56 आप पावरपॉइंट �ेज�टेशन म� सभी �लाइ�स म� ऊपर� बाएं �कनारे पर कंपनी का लोगो लगाना चाहत ेह�। आप
�वक�प� म� से �कस �म का उपयोग करके ऐसा कर�गे?

Ans 1. View → Slide Master → Animation → Picture → < कंपनी लोगो य�ुत फ़ाइल चनु�>

2. View → Slide Master → Insert → Logo → < कंपनी लोगो य�ुत फ़ाइल चनु�>

3. View → Slide Master → Insert → Picture → < कंपनी लोगो य�ुत फ़ाइल चनु�>

4. View → Slide Master → Insert → Background Styles → < कंपनी लोगो य�ुत फ़ाइल चनु�>

Question Type : MCQ
Question ID : 6182782394

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.57 List, Process, Cycle, और Matrix, MS Excel म� �न�न�ल�खत म� से �कसे दशा�ता है?

Ans 1. �प�चस�

2. �माट�-आट�

3. श�ेस

4. चाट�

Question Type : MCQ
Question ID : 6182782390

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.58 �न�न�ल�खत म� से �कस टे��ट अलाइनम�ट अपने पाठ (text) को समान �प से मािज�न के बीच �वत�रत
करता है?

Ans 1. बाएं संरे�खत (Align to Left)

2. क� ��त टे��ट (Centre Text)

3. दाएं संरे�खत (Align to Right)

4. ज�ट�फ़ाई टे��ट (Justify Text)

Question Type : MCQ
Question ID : 6182782360

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.59 वक� शीट पर कॉल�स या पंि�तय� (rows) म� �यवि�थत डटेा को _______________ म� �लॉट �कया जा
सकता है। यह सामा�यतः �े�णय� को �ै�तज (�ेणी) अ� के साथ और ऊ�वा�धर (मान) अ� के साथ �द�श�त
करता है।

Ans 1. कॉलम चाट�

2. डोनट चाट�
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3. पाई चाट�

4. लाइन चाट�

Question Type : MCQ
Question ID : 6182782388

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.60 MS Word म�, एक टे��ट को एक �थान से दसूरे �थान पर कॉपी करने के �लए, �य�ुत शॉट� कट कमांड का
सह� �म �या ह�?

Ans 1. Ctrl+C → Ctrl+P

2. Ctrl+X → Ctrl+P

3. Ctrl+C → Ctrl+V

4. Ctrl+X → Ctrl+V

Question Type : MCQ
Question ID : 6182782363

Status : Answered
Chosen Option : 3

Marks : 1.00
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Q.1 By which of the following options, we can add an ‘Engineering’ function in MS-Excel
2016 worksheet?

Ans 1. Home Menu → Defined Names group

2. Home Menu → Calculation group

3. Home Menu → Function Library group

4. Home Menu → Formula Editing group

Question Type : MCQ
Question ID : 6182782266

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.2 In Windows, GUIDs are typically written in hexadecimal notation. What is the full form
of GUID?

Ans 1. General Unique Identity

2. Great Unique Identifier

3. Globally Universal Item

4. Globally Unique Identifier

Question Type : MCQ
Question ID : 6182782233

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.3 Which of the following is the slowest internet connection?
Ans 1. Wireless broadband

2. Dial-up

3. Wired broadband

4. Fiber connection

Participant ID 19405585
Participant Name MANISH KUMAR
Test Center Name iON Digital Zone iDZ Jalalpur
Test Date 26/12/2019
Test Time 9:00 AM - 10:00 AM
Subject Data Entry Operator
Marks Obtained 19.00000

Section : MCQ for Data Entry Operator
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Question Type : MCQ
Question ID : 6182782277

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.4 MS-Word 2016 म� �कस मे�य ूम� से ज़मू फं�शन का चयन �कया जा सकता है?

Ans 1. �डज़ाइन

2. �र�यू

3. �यू

4. फाइल

Question Type : MCQ
Question ID : 6182782250

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.5 By which method we view documents side by side in MS-Word 2016?
Ans 1. Split function from Zoom group in View menu

2. Split function from window group in View menu

3. View function from Immersive group in View menu

4. View function from Show group in View menu

Question Type : MCQ
Question ID : 6182782242

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.6 MS-Excel 2016 म� �कस मे�य ूसे ‘शयेर वक� बकु’ फं�शन का चयन �कया जा सकता है?

Ans 1. फॉमू�ला मे�यू

2. �र�य ूमे�यू

3. इ�सट� मे�यू

4. हे�प मे�यू

Question Type : MCQ
Question ID : 6182782256

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.7 Which of the following is a protocol related to electronic mail?
Ans 1. SMTP

2. FTP

3. UIDP

4. USP

Question Type : MCQ
Question ID : 6182782280ANKAJ INFOTECH
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Status : Answered
Chosen Option : 4

Marks : 0.00

Q.8 MS-Excel 2016 म� �न�न�ल�खत म� से कौन सा �वक�प, �ोटे�ट शीट फं�शन का वधै �वक�प नह�ं है?

Ans 1. फॉम�ट से�स

2. �य ूकम�ट

3. फॉम�ट कॉल�स

4. इ�सट� कॉल�स

Question Type : MCQ
Question ID : 6182782257

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.9 A small graphic symbol on screen that represents an action or a resource such as an
application, file, folder, menu or setting is known as?

Ans 1. Shortcut

2. Interpreter

3. Icon

4. Assembler

Question Type : MCQ
Question ID : 6182782231

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.10 AMOLED एक �डस�ले टे�नॉलॉजी है। AMOLED का पणू� नाम �या है?

Ans 1. एि�टव-मॉड�न ऑग��नक लाइट ए�सपट� डायोड

2. एि�टव-म�ै��स ऑग��नक लाइट-ए�म�टगं डायोड

3. एि�टव-मॉड�न ऑि�टकल लाइट ए�म�टगं �डवाइस

4. एि�टव-म�ै��स ऑि�टकल लाइट ए�म�टगं डायो�स

Question Type : MCQ
Question ID : 6182782225

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.11 MS-Office 2016 म� मेल मज� �वज़ाड� म� म�ुय डॉ�यमू�ट के �प म� प�रभा�षत �कया जा सकता है?

Ans 1. इसम� केवल �व�ेताओ ंके ई-मेल ए�से होत ेह�

2. इसम� �यि�तगत सचूना जसेै �ट�डड� लेटर, एनवेलप अथवा मे�लगं लेबल होत ेह�

3. इसम� �ेषक के ई-मेल ए�से होत ेह�

4. इसम� ए�सेल फाइल क� फॉम��टगं संबंधी अ�य से�टगं एवं थीम होत ेह�

Question Type : MCQ
Question ID : 6182782249
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Status : Answered
Chosen Option : 4

Marks : 0.00

Q.12 �वडंोज़ XP म� टा�कबार के बारे म� �न�न�ल�खत म� से कौन सा सह� है?

Ans 1. टा�कबार सॉ�टवेयर �ो�ाम के ऊपर ि�थत होता है

2. टा�कबार ���न के �नचले �कनारे म� रहता है

3. टा�कबार एक वड� फाइल खोलने हेत ु�डफॉ�ट �ो�ाम होता है

4. यह �वडंो के अदंर एक �वडंो होता है

Question Type : MCQ
Question ID : 6182782230

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.13 य�द हम MS-Office 2016 म� मेल मज� का �योग करत ेहुए मेल भेजना चाहत ेह�, तो �कस चरण म� पहले से
ह� र�चत टे��ले�स को डॉ�यमू�ट के �प म� �य�ुत �कया जा सकता है?

Ans 1. चरण 5

2. चरण 3

3. चरण 2

4. चरण 1

Question Type : MCQ
Question ID : 6182782246

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.14 �कस मे�य ूसे MS-Excel 2016 म� शीट को �छपाने क� �वशषेता का चयन �कया जा सकता है?

Ans 1. पेज लेआउट

2. इ�सट�

3. होम

4. फॉमू�ला

Question Type : MCQ
Question ID : 6182782261

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.15 ______ पत ेम� 128 �ब�स मौजदू ह�।
Ans 1. URL ID

2. MacID

3. IPv4

4. IPv6

Question Type : MCQ
Question ID : 6182782279ANKAJ INFOTECH
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Status : Answered
Chosen Option : 4

Marks : 1.00

Q.16 MS-Word 2016 म�, �कस मे�य ूसे ‘फाइंड फं�शन’ का चयन �कया जा सकता है?

Ans 1. �यू

2. इ�सट�

3. �र�यू

4. होम

Question Type : MCQ
Question ID : 6182782239

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.17 नई वक� शीट डालने के �लए शॉट�कट कंुजी �या है?

Ans 1. Shift + F11

2. Shift + F8

3. CTRL + Shift + F11

4. Shift + ALT + F11

Question Type : MCQ
Question ID : 6182782264

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.18 MS-Excel 2016 म� वक� बकु म� नया शीट ��व�ट करने हेत ु�यो�ता �वारा �न�न�ल�खत म� से �कस �वक�प
का चयन �कया जा सकता है?

Ans 1. Home → Styles group

2. Home → Alignment group

3. Home → Number group

4. Home → Cells group

Question Type : MCQ
Question ID : 6182782263

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.19 �न�न�ल�खत म� से कौन सा एक हाड�वेयर नह�ं है?

Ans 1. एम एस वड�

2. माउस

3. मॉ�नटर

4. क�बोड�

Question Type : MCQ
Question ID : 6182782222ANKAJ INFOTECH
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Status : Answered
Chosen Option : 1

Marks : 1.00

Q.20 �न�न�ल�खत म� से कौन सा एक वेब �ाउज़र नह�ं है?

Ans 1. Firefox

2. Safari

3. Google Chrome

4. Ubuntu

Question Type : MCQ
Question ID : 6182782278

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.21 �न�न�ल�खत म� से कौन सा �वक�प MS-Excel 2016 के होम मे�य ूम� �टाइ�स �ुप क� �वशषेता नह�ं है?

Ans 1. कं�डशनल फॉम��टगं

2. सेल �टाइ�स

3. फॉम�ट एज टेबल

4. रैप टे�सट

Question Type : MCQ
Question ID : 6182782260

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.22 �न�न�ल�खत म� से कौन सा �वक�प इंटरनेट क� सेवाओ ंका �योग करने हेत ुअ�नवाय� ज़�रत नह�ं है?

Ans 1. कं�यटूर

2. वेब �ाउज़र

3. इंटरनेट कने�शन

4. ��टंर

Question Type : MCQ
Question ID : 6182782276

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.23 �वडंोज म� कमांड �ॉ��ट �वारा मौजदूा (existing) सॉ�टवेयर क� �थापना र� करने (uninstalling) के �लए,
सह� कमांड �या होगा?

Ans 1. msiexed /x

2. msiexec /x

3. msiexcc /x

4. msiexee /x

Question Type : MCQ
Question ID : 6182782234ANKAJ INFOTECH
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Status : Answered
Chosen Option : 2

Marks : 1.00

Q.24 MS-Office 2016 क� MS-Excel वक� बकु म� एकल शीट को कैसे �डल�ट �कया जा सकता है?

Ans 1. फाइन मे�य ूसे इ�फो का चयन कर�

2. वक� शीट पर कह�ं भी दाया ंि�लक कर� और �डल�ट �वक�प का चयन कर�

3. �डज़ाइन मे�य ूसे कवर पेज का चयन कर�

4. वक� शीट नेम पर दाया ंि�लक कर� और �डल�ट �वक�प का चयन कर�

Question Type : MCQ
Question ID : 6182782251

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.25 MS-Word 2016 म� Navigation pane को �कस मे�य ूसे स��य/�नि��य �कया जा सकता है?

Ans 1. �डज़ाइन

2. लेआउट

3. �यू

4. �र�यू

Question Type : MCQ
Question ID : 6182782243

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.26 MS-Excel 2016 वक� शीट म� सेल �टाइ�स फं�शन से �कसी सेल को ‘नॉम�ल’ स�ूचत करने हेत ु�न�न�ल�खत
म� से कौन सा �वक�प �डफॉ�ट रंग शडे होता है?

Ans 1. कोई रंग नह�ं/पारदश�

2. हरा

3. काला

4. पीला

Question Type : MCQ
Question ID : 6182782262

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.27 MS-PowerPoint 2016 म� नया �लाइड़ जोड़ने के �लए �न�न�ल�खत म� से �कस शॉट�कट का �योग करना
चा�हए?

Ans 1. Ctrl+O

2. Ctrl+N

3. Ctrl+S

4. Ctrl+M
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Question Type : MCQ
Question ID : 6182782271

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.28 MS-Office 2016 म� मेल-मज� के संबंध म� �न�न�ल�खत म� से कौन सा कथन सह� है?

Ans 1. यह Gmail क� एक �वशषेता है जो �यो�ता को अनेक �यो�ताओ ंको एक समान प� भेजने म�
सहायक होती है

2. यह MS Office क� एक �वशषेता है जो �यो�ता को अनेक �ा�तकता�ओ ंको एक समान प� अथवा
डॉ�यमू�ट भेजने म� सहायक होती है

3. यह इंटरनेट पर अजनबी �यि�त से वाता�लाप करने हेत ुवेब �ाउज़ का एक फं�शन है

4. यह वड� �ोसेसर का एक फं�शन है िजससे टाइ�पगं परपज़ हेत ुक�टम टे��ले�स को डाउनलोड �कया
जा सकता है

Question Type : MCQ
Question ID : 6182782245

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.29 The ‘Reuse’ function can be selected from which group of Home menu in MS-
PowerPoint 365?

Ans 1. Home Menu → New Slide

2. Home Menu → Clipboard

3. Home Menu → Font

4. Home Menu → Editing

Question Type : MCQ
Question ID : 6182782272

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.30 By which option, we can insert a 3D Map in an MS-Excel 2016?
Ans 1. Sparklines group in Insert menu

2. Charts group in Insert menu

3. Links group in Insert menu

4. Tours group in Insert menu

Question Type : MCQ
Question ID : 6182782252

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.31 ‘IFNA’ function belongs to which category of functions in MS-Excel 2016?
Ans 1. Financial

2. Text

3. Math & trigonometry
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4. Logical

Question Type : MCQ
Question ID : 6182782265

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.32 .doc and .docx फाइल ए�सट�श�स के संबंध म� �न�न�ल�खत म� से कौन सा कथन सह� ह�?
Ans 1. .doc फाइल MS-Word का �व�तार होता है एव ं.docx फाइल MS-Excel का �व�तार होता है|

2. .doc एवं .docx दोन� ह� MS-Word के �व�तार होत ेह�|

3. .doc फाइल MS- Excel का �व�तार होता है एवं .docx फाइल MS-Word का �व�तार होता है|

4. .doc फाइल MS-ए�सेल का �व�तार होता है एव ं.docx फाइल MS-PowerPoint का �व�तार होता
है|

Question Type : MCQ
Question ID : 6182782235

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.33 MS-Office 2016 म� मेल मज� म� लेबल व�डस� को कैसे बदला जा सकता है?

Ans 1. Mailings menu → ‘Create’ group

2. Mailings Menu → ‘Start Mail Merge’ group

3. Mailings menu → ‘Preview Results’ group

4. Mailings menu → ‘Write & Insert Fields’ group

Question Type : MCQ
Question ID : 6182782248

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.34 An auditor is making a report of a company. In this report, he wants to show multiple
subheadings within a main heading and the font style of subheadings should be
according to his choice. Which of the following options of MS-Word 2016 can be
selected for the same?

Ans 1. Select object from text group in insert menu

2. Select multilevel list from paragraph group in home menu

3. Select Styles group in Home menu

4. Select sort from paragraph group in home menu

Question Type : MCQ
Question ID : 6182782241

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.35 �न�न�ल�खत म� से �कस �वक�प �वारा MS-Excel 2016 म� चय�नत से�स के बॉड�र को �मटाया जा सकता
है?

Ans 1. होम मे�य ूम� फॉ�ट �ुप
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2. होम मे�य ूम� एलाइ�म�ट �ुप

3. होम मे�य ूम� ए�ड�टगं �ुप

4. होम मे�य ूम� ि�लपबोड़� �ुप

Question Type : MCQ
Question ID : 6182782258

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.36 If a user is presenting a slide show in MS-powerPpoint 2016, the slides are changing
automatically, but now he wants to change that setting so that next slide will come
only after mouse click. Which of the following menus has this function/setting?

Ans 1. Review

2. View

3. Transitions

4. Design

Question Type : MCQ
Question ID : 6182782275

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.37 Which of the following is an Operating System?
Ans 1. Ubuntu

2. Safari

3. Netscape

4. Microsoft Word Processor

Question Type : MCQ
Question ID : 6182782226

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.38 For changing screen saver timeout in Windows XP, which option we should select?
Ans 1. Right Click on Desktop → Properties → Screen Saver

2. Double click on My Computer → C Drive → Program Files

3. Left click on My Computer → C Drive → Change Screen Saver

4. Right Click on My Network Places → Properties → IPV4

Question Type : MCQ
Question ID : 6182782232

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.39 MS-Word 2016 म�, चय�नत डटेा को वण�माला अथवा सं�या�मक �म म� �यवि�थत करने हेत ुहोम मे�य ूसे
�कस फं�शन का �योग �कया जा सकता है?

Ans
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1. म�ट�लेवल �ल�ट

2. फॉम�ट प�टर

3. नंब�रगं

4. सॉट�

Question Type : MCQ
Question ID : 6182782237

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.40 �न�न�ल�खत म� से कौन सा कथन सह� है?

Ans 1. क�पाइलर एक �ो�ाम है जो एस�बल� ल��वेज को मशीन कोड म� प�रव�त�त करता है|

2. क�पाइलर �वारा �न�म�त मशीन कोड को क��े�ड कोड कहा जाता है|

3. क�पाइलर सरु��त मशीन कोड �न�म�त करता है|

4. एस�बलर, अस�बल� ल��वेज कोड को इनपटु के �प म� �य�ुत करता है|

Question Type : MCQ
Question ID : 6182782229

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.41 MS-PowerPoint 2016 म�, �लाइड के क�टम आकार का चयन करने हेत ु�न�न�ल�खत म� से �कस �वक�प
का चयन �कया जाता है?

Ans 1. �डज़ाइन मे�य ू→ वे�रय��स �ुप

2. होम मे�य ू→ परैा�ाफ �ुप

3. �डज़ाइन मे�य ू→ �डज़ाइनर �ुप

4. �डज़ाइन मे�य ू→ क�टमाइज़ �ुप

Question Type : MCQ
Question ID : 6182782274

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.42 Which of the following functions of the SmartArt features in MS-Excel 2016 is used to
represent a series of interconnected ideas?

Ans 1. Vertical Bullet List

2. Basic Block List

3. Alternating Hexagon List

4. Vertical Box List

Question Type : MCQ
Question ID : 6182782270

Status : Answered
Chosen Option : 3

Marks : 1.00
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MS-PowerPoint 2016 म�, हम चय�नत �लाइ�स क� �ज�ट/शो (��त�ुत/�दश�न) कर सकत ेह�।
�न�न�ल�खत म� से �कस मे�य ूम� यह फं�शन है?

Ans 1. �डज़ाइन

2. �लाइड़ शो

3. ए�नमेश�स

4. फाइल

Question Type : MCQ
Question ID : 6182782273

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.44 MS-Excel 2016 म� �न�न�ल�खत म� से �कस �वक�प के ज़�रए रो क� ऊँचाई एवं कॉलम क� चौड़ाई को
�नधा��रत �कया जा सकता है?

Ans 1. होम मे�य ूम� �टाइ�स �ुप से कंडीशनल फॉम��टगं फं�शन का चयन कर�

2. होम मे�य ूम� से�स �ुप से इ�सट� फं�शन का चयन कर�

3. होम मे�य ूम� से�स �ुप से फॉम�ट फं�शन का चयन कर�

4. होम मे�य ूम� �टाइ�स �ुप से सेल �टाइ�स फं�शन का चयन कर�

Question Type : MCQ
Question ID : 6182782254

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.45 एमएस वड� 2016 म� चय�नत टे��ट अपरकेस बनाने के �लए शॉट� कट कंुजी �या है?

Ans 1. पहले ‘Alt+H’ �ेस कर�, �फर ‘FG’ �ेस कर� और �फर ‘S’ �ेस कर�

2. पहले ‘Alt+H’ �ेस कर�, �फर ‘7’ �ेस कर� और �फर ‘U’ �ेस कर�

3. पहले ‘Alt+H’ �ेस कर�, �फर ‘8’ �ेस कर� और �फर ‘S’ �ेस कर�

4. पहले ‘Alt+H’ �ेस कर�, �फर ‘FF’ �ेस कर� और �फर ‘S’ �ेस कर�

Question Type : MCQ
Question ID : 6182782240

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.46 आध�ुनक कं�यटूर म� �य�ुत �व�भ�न से�सस� �न�न�ल�खत म� से �कसका उदाहरण होत ेह�?
Ans 1. इनपटु �डवाइसेस

2. आउटपटु �डवाइसेस

3. मेमर� �डवाइसेस

4. ऑपरे�टगं �स�टम

Question Type : MCQ
Question ID : 6182782223

Status : Answered
Chosen Option : 4
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Marks : 0.00

Q.47 MS-Excel 2016 म� �न�न�ल�खत म� से कौन सा �वक�प फॉमू�ला मे�य ूम� ‘�दनांक और समय’ का फं�शन
है?

Ans 1. FIX

2. EOMONTH

3. EXACT

4. FIND

Question Type : MCQ
Question ID : 6182782267

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.48 वड� फ़ाइल म� हर परैा�ाफ़ से पहले �पेस लगाने के �लए, MS-Office 2016 म� �कस �वक�प का उपयोग �कया
जा सकता है?

Ans 1. लेआउट मेन ूम� परैा�ाफ़ �ुप से �पे�सगं फं�शन का चयन कर�|

2. �डज़ाइन मेन ूम� डॉ�यमू�ट फ़ॉम��टगं �ुप से इफे��स फं�शन का चयन कर�|

3. �डज़ाइन मेन ूम� डॉ�यमू�ट फ़ॉम��टगं �ुप से परैा�ाफ़ �पे�सगं फं�शन का चयन कर�|

4. लेआउट मेन ूम� परैा�ाफ़ �ुप से इंड�ट फं�शन का चयन कर�|

Question Type : MCQ
Question ID : 6182782236

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.49 एक ब�क �बंधक �कसी �व�श�ट मह�ने म� खोले गए खाताओ ंक� सं�या क� सचूी तयैार कर रहा है। शीट म� 25
रोज़ एवं 10 कॉल�स ह�। शीट परूा करने के बाद उसे पता चला �क पहला कॉलम जो खाताधारक� के नाम दशा�ता
है को �व�भ�न प�ृठभ�ूम रंग से �व�श�ट �दखाना चा�हए। ऐसा करने के �लए उसे �कस �वक�प का चयन करना
चा�हए?

Ans 1. होम मेन ूम� ि�लपबोड� �ुप

2. होम मेन ूम� परैा�ाफ़ �ुप

3. होम मेन ूम� फ़ॉ�ट �ुप

4. होम मेन ूम� एलाइनम�ट �ुप

Question Type : MCQ
Question ID : 6182782259

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.50 If a user enabled/show Paragraph marks and other hidden formatting symbols in MS-
Office 2016, then for hiding those symbols which menu has to be selected?

Ans 1. View

2. References

3. Home

4. Insert
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Question Type : MCQ
Question ID : 6182782238

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.51 MS-Word 2016 म� ���नशॉट ��व�ट करने हेत ु�न�न�ल�खत म� से से �कस �वक�प का चयन �कया जाता
है?

Ans 1. इ�सट� मे�य ूम� टेब�स �ुप से एक फं�शन

2. इ�सट� मे�य ूम� ए�ड़ इन �ुप से एक फं�शन

3. इ�सट� मे�य ूम� इल��ेश�स �ुप से एक फं�शन

4. इ�सट� मे�य ूम� पेजस �ुप से एक फं�शन

Question Type : MCQ
Question ID : 6182782244

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.52 �न�न�ल�खत म� से कौन सा �वक�प MS-Excel 2016 म� ‘श�ेस’ फं�शन का सद�य नह�ं है?

Ans 1. बार चाट�

2. �लॉक एरोज

3. कॉलआउ�स

4. लाइन

Question Type : MCQ
Question ID : 6182782269

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.53 �कस सं�थान/कंपनी �वारा .NET �ेमवक�  को �वक�सत �कया गया है?

Ans 1. याहू

2. ए�पल

3. माइ�ोसॉ�ट

4. गूगल

Question Type : MCQ
Question ID : 6182782228

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.54 एक �यो�ता अपने वा�ष�क �यय को ��तशत म� दशा�ने हेत ुMS-Excel 2016 म� एक चाट� तयैार करना चाहती
है। उसके �लए, �न�न�ल�खत म� से कौन से �कार का चाट� उपय�ुत होगा?

Ans 1. वॉटरफॉल चाट�

2. हायराक� चाट�

3. �कैटर चाट�
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4. पाई चाट�

Question Type : MCQ
Question ID : 6182782268

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.55 एक �यो�ता MS-Excel 2016 म� एक �रपोट� तयैार करता है। वह �रपोट� म� कुछ फॉ�म��टगं का �योग करता है,
परंत ुअब वह डटेा को �भा�वत �कए �बना सभी फॉम��टगं हटाना चाहता है। इसके �लए उसे �न�न�ल�खत म� से
�कस �वक�प का चयन करना चा�हए?

Ans 1. होम मे�य ूम� ए�ड�टगं �ुप से ि�लयर फं�शन म� ि�लयर फॉम��स का चयन कर�

2. होम मे�य ूम� से�स �ुप से �डल�ट फं�शन का चयन कर�

3. होम मे�य ूम� ए�ड�टगं �ुप से ि�लयर फं�शन म� ि�लयर क�ट��स का चयन कर�

4. होम मे�य ूम� �टाइ�स �ुप से कंडीशनल फॉम��टगं फं�शन का चयन कर�

Question Type : MCQ
Question ID : 6182782253

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.56 ए�ल�केशन सॉ�टवेयर के संबध म� �न�न�ल�खत म� से कौन सा कथन सह� है?

Ans 1. ए�ल�केशन सॉ�टवेयर के �बना �स�टम को चलाया नह�ं जा सकता है|

2. सामा�यतः ए�ल�केशन सॉ�टवेयर को एक लो-लेवल ल��वेज म� �लखा जाता है|

3. सामा�यतः ए�ल�केशन सॉ�टवेयर को एक हाई-लेवल ल��वेज म� �लखा जाता है|

4. ए�ल�केशन सॉ�टवेयर जनरल-परपज (�योजन सामा�य) है|

Question Type : MCQ
Question ID : 6182782227

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.57 By which option we can set width of a column to ‘AutoFit’ in MS-Excel 2016?
Ans 1. Select Conditional Formatting function from Styles group in Home menu.

2. Select target Column and press right click and select format cells

3. Select target Columns and click on Format function from Home menu

4. Select target Columns and press right click and select insert.

Question Type : MCQ
Question ID : 6182782255

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.58 मेमर� �डवाइस क� ग�त के संबंध म� �न�न�ल�खत म� से कौन से कथन सह� है?

Ans 1. Hard Disk > RAM > Register

2. RAM > Hard Disk > Register
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3. RAM = Hard Disk = Register

4. Register > RAM > Hard Disk

Question Type : MCQ
Question ID : 6182782221

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.59 MS-Office 2016 म� मेल मज� �वज़ाड़� का तीसरा चरण �या होता है?

Ans 1. डॉ�यमू�ट टाइप का चयन

2. �र�स�पएंटस का चयन

3. �टा�ट�ग डॉ�यमू�ट का चयन

4. राइट योर लेटर (अपना प� �लखना)

Question Type : MCQ
Question ID : 6182782247

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.60 Which of the following impact printers has fastest printing speed?
Ans 1. Line printer

2. Inkjet printer

3. Dot Matrix printer

4. Daisy Wheel printer

Question Type : MCQ
Question ID : 6182782224

Status : Answered
Chosen Option : 3

Marks : 0.00
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Q.1 MS Word 2016 म� �ैक च�ज �ॉपडाउन सचूी के तहत �कतने �वक�प ह�?
Ans 1. 1

2. 3

3. 2

4. 4

Question Type : MCQ
Question ID : 6182782489

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.2 Class C आईपी ए�से क� सीमा �या है?

Ans 1. 192.0.1.1 to 223.255.254.254

2. 190.0.1.1 to 223.255.254.284

3. 1.0.1.255 to 1.255.254.254

4. 192.0.1.1 to 285.255.254.254

Question Type : MCQ
Question ID : 6182782518

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.3 MS Office 2016 के वड� फाइल म� हर परैा�ाफ़ म� आव�यकता के अनसुार �पेस क�टमाइज करने के �लए
�कस �वक�प का उपयोग �कया जा सकता है?

Ans 1. �डज़ाइन मेन ूम� डॉ�यमू�ट फॉम��टगं �ुप से इफे��स ऑ�शन का चयन कर�

2. लेआउट मेन ूम� परैा�ाफ़ �ुप से इंड�ट ऑ�शन का चयन कर�

3. �डज़ाइन मेन ूम� डॉ�यमू�ट फॉम��टगं �ुप से परैा�ाफ़ �पे�सगं ऑ�शन का चयन कर�

4. लेआउट मेन ूम� परैा�ाफ़ �ुप से �पे�सगं ऑ�शन का चयन कर�

Participant ID 19410293
Participant Name MUKESH KUMAR
Test Center Name iON Digital Zone iDZ 2 Patliputra
Test Date 27/12/2019
Test Time 12:00 PM - 1:00 PM
Subject Data Entry Operator
Marks Obtained 15.00000

Section : MCQ for Data Entry Operator
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Question Type : MCQ
Question ID : 6182782476

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.4 MS Excel म�, यह जांचने का फॉमू�ला है �क �या दो टे��ट ि��ं�स समान ह�?
Ans 1. EQUAL

2. STRINGCOMP

3. CHECK

4. EXACT

Question Type : MCQ
Question ID : 6182782503

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.5 MS PowerPoint 2016 म�, आप कहां से थीम ढंूढ सकत ेह�?
Ans 1. View

2. Home

3. File

4. Design

Question Type : MCQ
Question ID : 6182782514

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.6 MS Word 2016 म�, Alt + HFDF ______ के समान है।
Ans 1. Ctrl + S

2. Alt + F

3. Shift + H

4. Ctrl + F

Question Type : MCQ
Question ID : 6182782481

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.7 MS Excel म�, फं�शन डालने के �लए शॉट� कट क� �या है?

Ans 1. F5

2. F3

3. F9

4. F12
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Question Type : MCQ
Question ID : 6182782494

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.8 MS PowerPoint 2016 म� ‘डुि�लकेट �सले�टेड �लाइ�स’ के फं�शन को इ�सट� मेन ूम� �कस �ुप से �सले�ट
कर सकत ेह�?

Ans 1. Home > Slides > New Slides

2. Home > Slides > Old Slides

3. Home > New Slides > Slides

4. View > Slides > New Slides

Question Type : MCQ
Question ID : 6182782511

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.9 MS Word 2016 म�, step-by-step Mail Merge �वज़ाड� ______ समहू के अतंग�त पाया जाता है।
Ans 1. Finish

2. Create

3. Start Mail Merge

4. Write & Insert Fields

Question Type : MCQ
Question ID : 6182782488

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.10 MS PowerPoint 2016 म�, �कस मेन ूसे �लाइ�स के मवूम�ट को �कसी �ेज़�टेशन के अदंर बदला जा सकता
है?

Ans 1. ए�नमेश�स

2. फाइल

3. �ांिज़श�स

4. �र�यू

Question Type : MCQ
Question ID : 6182782515

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.11 मेल मज� हे�पर के उपयोग से डटेा सोस� ��एट करने के दौरान MS Word 2016 म� डटेा फ���स का �ल�मट
�या था?

Ans 1. 26 फ���स

2. 63 फ���स

3. कोई �ल�मट नह�ं
ANKAJ INFOTECH



1/28/2020 https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S92D622/157743443825055…

https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S92D622/15774344382505592/1941029… 4/16

4. 100 फ���स

Question Type : MCQ
Question ID : 6182782487

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.12 मेल मज� डॉ�यमू�ट म� जब हम मेन डॉ�यमू�ट को डटेा सोस� के साथ मज� करत ेह� तो एक तीसरा डॉ�यमू�ट बनता
है, इस थड� डॉ�यमू�ट को �या कहा जाता है?

Ans 1. रे�स�पएंट �ल�ट

2. डटेा सोस�

3. एनवेल�स

4. मज� डॉ�यमू�ट

Question Type : MCQ
Question ID : 6182782486

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.13 हम MS Excel 2016 म�, रे�ट�गल शपे को �कस �वक�प से इ�सट� कर सकत ेह�?
Ans 1. इ�सट� मेन ूम� चा��स �ुप

2. इ�सट� मेन ूम� �ल�ंस �ुप

3. इ�सट� मेन ूम� टूस� �ुप

4. इ�सट� मेन ूम� इल��ेश�स �ुप

Question Type : MCQ
Question ID : 6182782492

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.14 MS PowerPoint 2016 म�, �न�न म� से �कस मेन ूम� �रकॉड� �लाइड शो �वशषेता है?

Ans 1. �लाइड शो

2. �ांिजश�स

3. फाइल

4. ए�नमेश�स

Question Type : MCQ
Question ID : 6182782513

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.15 MS-Office 2016 म�, �कस �टेप म� मेल मज� �वज़ाड� म� डॉ�यमू�ट के �कार को चय�नत कर सकत ेह�?
Ans 1. 4th �टेप (चौथा चरण)

2. 2nd �टेप (दसूरा चरण)
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3. 3rd �टेप (तीसरा चरण)

4. 1st �टेप (पहला चरण)

Question Type : MCQ
Question ID : 6182782485

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.16 ‘IF’ फ़ं�शन MS Excel 2016 म� �कस �ेणी से संबं�धत है?

Ans 1. मथै एंड ���नोमे��

2. फाइन��सयल

3. डटे एंड टाइम

4. लॉिजकल

Question Type : MCQ
Question ID : 6182782505

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.17 POP का उपयोग ईमेल सेवा �दाताओ ं�वारा �कया जाता है। POP का पणू� �प �या है?

Ans 1. Past Office Protocol

2. Post Orientated Protocol

3. Post Order Protocol

4. Post Office Protocol

Question Type : MCQ
Question ID : 6182782520

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.18 �न�न�ल�खत म� से कौन सा एक इनपटु �डवाइस है?

Ans 1. ��टंर

2. क�बोड�

3. CRT

4. �लॉटर

Question Type : MCQ
Question ID : 6182782463

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.19 हेमंत �कसी वायड� नेटवक�  से कने�ट होने क� को�शश कर रहा है और य�द वह म�ैयअुल �प से IP ए�से फ�ड
करना चाहता है, तो उसे Windows XP म� �न�न�ल�खत म� से �कस �वक�प का चयन करना चा�हए?

Ans 1. कं�ोल पनैल > नेटवक�  कने�श�स

2. माई कं�यटूर पर राइट ि�लक करके > �ॉपट�ज़
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3. माई नेटवक�  �लेसेस पर राइट ि�लक करके > �ॉपट�ज़

4. माई डॉ�यमू�ट पर राइट ि�लक करके > �ॉपट�ज़

Question Type : MCQ
Question ID : 6182782471

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.20 MS Excel 2016 म� Ctrl + - (माइनस) दबाने पर �या होता है?

Ans 1. Insert dialog box

2. Cell style box

3. Delete dialog box

4. Formatting dialog box

Question Type : MCQ
Question ID : 6182782491

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.21 MS Office 2016 म� ‘सेव एज़ (Save as)’ डायलॉग बॉ�स को खोलने के �लए �न�न�ल�खत म� से �कसका
उपयोग �कया जाता है?

Ans 1. Ctrl + Y

2. Alt + F12

3. Ctrl + A

4. F12

Question Type : MCQ
Question ID : 6182782475

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.22 �कसी GPT �ड�क म�, अ�धकतम �कतने एि�टव पा�ट�श�स संभव हो सकत ेह�?
Ans 1. 32

2. 4

3. 128

4. 64

Question Type : MCQ
Question ID : 6182782473

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.23 MS Excel म� Conditional Formatting म� Clear Rules के तहत �न�न�ल�खत म� से कोन सा एक
�वक�प वधै नह�ं है?

Ans 1. Clear Rules from Entire Workbook
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2. Clear Rules from Selected Cells

3. Clear Rules from This Table

4. Clear Rules from Entire Sheet

Question Type : MCQ
Question ID : 6182782498

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.24 Win + R शॉट�कट कंुजी Windows XP म� ______ डायलॉग बॉ�स को खोलता है।
Ans 1. Delete

2. Save As

3. Tools

4. Run

Question Type : MCQ
Question ID : 6182782474

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.25 MS Excel 2016 म�, ऑ�जे��स के संरेखण (alignment) को ______ मेन ूसे सेट �कया जा सकता है।
Ans 1. Design

2. Formula

3. Page Layout

4. Home

Question Type : MCQ
Question ID : 6182782508

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.26 �न�न�ल�खत म� से कौन सा �फगर MS Excel 2016 वक� शीट म� ‘श�ेस’ फं�शन का �ह�सा (part) नह�ं है?

Ans 1. लाइन

2. कॉलऑउ�स

3. �लॉक ऐरोज़

4. पाई चाट�

Question Type : MCQ
Question ID : 6182782509

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.27 MS Excel 2016 म� फॉमू�ला मेन ूम� ‘लकुअप एंड रेफर�स’ फं�शन �न�न�ल�खत म� से कौन सा है?

Ans 1. COLUMN

2. IF
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3. DATE

4. CHAR

Question Type : MCQ
Question ID : 6182782507

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.28 MS Word 2016 म� य�द कोई यज़ूर सारे ऑ�जे�ट टे��ट के साथ सेले�ट करना चाहता है, तो उसे
�न�न�ल�खत म� से कौन सा �वक�प चनुना चा�हए?

Ans 1. होम मेन ू> वॉयस �ुप > सेले�ट

2. होम मेन ू> ए�ड�टगं �ुप > सेले�ट

3. होम मेन ू> ि�लपबोड� �ुप > सेले�ट

4. होम मेन ू> परैा�ाफ़ �ुप > सेले�ट

Question Type : MCQ
Question ID : 6182782478

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.29 �न�न�ल�खत म� से कौन सा एक वधै आईपी ए�से नह�ं है?

Ans 1. 101.156.218.111

2. 678.120.1.1

3. 10.56.28.11

4. 1.156.218.111

Question Type : MCQ
Question ID : 6182782517

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.30 MS Excel म� Merge and Center के तहत �न�न�ल�खत म� से कोन सा एक �वक�प वधै नह�ं है?

Ans 1. Merge Column

2. Merge Cells

3. Merge and Center

4. Merge Across

Question Type : MCQ
Question ID : 6182782499

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.31 ______ फ़ं�शन एक टे��ट ि��ंग के दसूरे टे��ट ि��ंग के भीतर �ारं�भक ि�थ�त (starting position)
�दखाता है।

Ans 1. CLOSE
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2. END

3. FIND

4. START

Question Type : MCQ
Question ID : 6182782504

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.32 MS PowerPoint 2016 म� ‘Convert to SmartArt’ फं�शन कहां �मलता है?

Ans 1. Insert > Illustration

2. Insert > Paragraph

3. Home > Illustration

4. Home > Paragraph

Question Type : MCQ
Question ID : 6182782512

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.33 MS Excel म�, टे��ट ओ�रएंटेशन फं�शन कहां �मलता है?

Ans 1. View > Alignment

2. Home > Alignment

3. Design > Alignment

4. Home > Styles

Question Type : MCQ
Question ID : 6182782501

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.34 �न�न�ल�खत म� से कौन सा एक टे��ट फ़ं�शन है?

Ans 1. CODE

2. IF

3. SUM

4. DATE

Question Type : MCQ
Question ID : 6182782497

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.35 TFT एक ���न टे�नोलॉजी है। TFT का पणू� �प �या है?

Ans 1. �थन �फ�म �ांसपोट�र (Thin Film Transporter)

2. थम�ल �फ�म �ांिज़�टर (Thermal Film Transistor)
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3. �थन �फ�म �ांिज़�टर (Thin Film Transistor)

4. �थन �फ��ड �ांिज़�टर (Thin Fixed Transistor)

Question Type : MCQ
Question ID : 6182782465

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.36 �न�न म� से �कस �कार क� ROM म�, इसके एक �व�श�ट भाग को बदलने के �लए परू� �चप को परू� तरह से
�मटाना नह�ं पड़ता है?

Ans 1. EPROM

2. ROM

3. EEPROM

4. PROM

Question Type : MCQ
Question ID : 6182782462

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.37 �न�न�ल�खत म� से कौन सा एक ऑपरे�टगं �स�टम का �कार नह�ं है?

Ans 1. Android

2. Microsoft Edge

3. Unix

4. Linux Mint

Question Type : MCQ
Question ID : 6182782466

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.38 MS Excel 2016 म� �कस मेन ूसे ‘शो इंक’ फं�शन चय�नत �कया जा सकता है?

Ans 1. फाइल मेनू

2. फॉमू�ला मेनू

3. �र�य ूमेनू

4. हे�प मेनू

Question Type : MCQ
Question ID : 6182782496

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.39 हम �वडंोज़ XP (Windows XP) म� वॉलपेपर कैसे बदल सकत ेह�?
Ans 1. माई कं�यटूर पर राइट ि�लक और मनेैज का चयन करके

2. ड�ेकटॉप पर राइट ि�लक और �र�ेश का चयन करके
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3. C �ाइव पर राइट ि�लक और �ॉपट�ज़ का चयन करके

4. ड�ेकटॉप पर राइट ि�लक > �ॉपट�ज़ > ड�ेकटॉप

Question Type : MCQ
Question ID : 6182782470

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.40 MS Excel म�, होम मेन ूम� ‘एलाइनम�ट’ �ुप का फ�चर �न�न�ल�खत म� से कौन सा नह�ं है?

Ans 1. इन��ज़ इंड�ट

2. रैप टे��ट

3. कं�डशनल फॉम��टगं

4. मज� एंड स�टर

Question Type : MCQ
Question ID : 6182782500

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.41 �न�न�ल�खत म� से कौन सा ��टंर टोनर का उपयोग करता है?

Ans 1. इंकजेट ��टंर

2. डज़ेी �ह�ल ��टंर

3. लेजर ��टंर

4. थम�ल ��टंर

Question Type : MCQ
Question ID : 6182782464

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.42 जब आप Windows XP म� Win + M दबात ेह�, तो �या होता है?

Ans 1. माई डा�यमू��स खोलता है

2. �वडंोज �लोज़ करता ह�

3. सभी �वडंो को अ�धकतम (maximize) करता है

4. सभी �वडंो को छोटा (minimize) करता है

Question Type : MCQ
Question ID : 6182782472

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.43 MS Word म� सभी टे��ट को लोअर केस म� बदलने के �लए शॉट� कट क� �या है?

Ans 1. Alt + H7L

2. Alt + H9L
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3. Alt + C7L

4. Alt + U7S

Question Type : MCQ
Question ID : 6182782480

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.44 एक यज़ूर MS Excel 2016 म� एक �रपोट� बनाता है, वह उस �रपोट� म� कुछ कॉम��स इ�सट� करता है। ले�कन
अब वह डटेा और फॉम��टगं को �भा�वत �कए �बना सभी कॉम��स को �रमवू करना चाहता है। इसके �लए उसे
�कस �वक�प का उपयोग करना चा�हए?

Ans 1. होम मेन ूम� ए�ड�टगं �ुप से �ल�यर फं�शन म� �ल�यर कॉम��स को चय�नत करना।

2. होम मेन ूम� �टाइ�स �ुप से कं�डशनल फॉम��टगं फं�शन को चय�नत करना।

3. होम मेन ूम� से�स �ुप से �डल�ट फं�शन को चय�नत करना।

4. होम मेन ूम� ए�ड�टगं �ुप से �ल�यर फं�शन म� �ल�यर कॉ�ट�ट को चय�नत करना।

Question Type : MCQ
Question ID : 6182782493

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.45 MS Excel 2016 वक� शीट म�, से�स �टाइल फं�शन से सेल एज़ ‘गुड’ का संकेत दशा�ने के �लए �न�न�ल�खत
म� से कौन सा �डफॉ�ट कलर शडे है?

Ans 1. पीला

2. हरा

3. लाल

4. कोई कलर नह�ं/पारदश�

Question Type : MCQ
Question ID : 6182782502

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.46 �न�न�ल�खत म� से कौन सा मेमोर�, सेक� डर� मेमोर� का अगं है?

Ans 1. हाड� �ड�क

2. कैश मेमोर�

3. RAM

4. ROM

Question Type : MCQ
Question ID : 6182782461

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.47 �न�न�ल�खत म� से कौन सा नेटव�क� ग �डवाइस नह�ं है?
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Ans 1. क�बोड�

2. ि�वच

3. राउटर

4. हब

Question Type : MCQ
Question ID : 6182782516

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.48 MS Excel 2016 वक� शीट म� हम �कसी ‘वेब’ फं�शन को �कस �वक�प के मा�यम से जोड़ सकत ेह�?
Ans 1. Home > Defined Names group > More Functions

2. Formula > Function Library group > More Functions

3. Home > Formula Editing group > Web

4. Home > Calculation group Web

Question Type : MCQ
Question ID : 6182782506

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.49 MS Word 2016 म�, ‘�ड��ज इंड�ट’ फं�शन को होम मेन ूके �कस �ुप से चय�नत �कया जा सकता है?

Ans 1. फॉ�ट �ुप

2. वॉइस �ुप

3. परैा�ाफ़ �ुप

4. ए�ड�टगं �ुप

Question Type : MCQ
Question ID : 6182782477

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.50 �न�न�ल�खत म� से कौन सा एक �ो�ाम �यमून-र�डबेल फॉम�ट से मशीन-र�डबेल फॉम�ट म� प�रव�त�त करता
है?

Ans 1. मॉडमे

2. RAM

3. ROM

4. कंपाइलर

Question Type : MCQ
Question ID : 6182782469

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.51 �दए गए �वक�प� म� से तीन �कसी तरह से समान ह�। �वषम चनु�।
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Ans 1. Compiler

2. COBOL

3. FORTRAN

4. Java

Question Type : MCQ
Question ID : 6182782467

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.52 म�नता एक मह�ने के दौरान घर म� इ�तमेाल होने वाले �व�भ�न व�तओु ंसे संबं�धत एक टेबल को MS Excel
2016 म� बना रह� है। इसम� वह 1st रो म� �व�भ�न व�तओु ंके नाम �लखती है। ले�कन कुछ नाम बहुत लंबे ह�
और वह उस रो म� �फट नह�ं कर पाती है। कौन सा �वक�प उसे मदद करेगा ता�क नाम क� लंबाई के अनसुार रो
क� चौड़ाई को समायोिजत सहा�यक होगा?

Ans 1. टाग�ट रोज़ का चय�नत करे और राइट ि�लक दबाएं और फॉम�ट से�स को चय�नत करे

2. टेबल जसेै फॉम�ट पर टाग�ट रोज़ को चय�नत कर� और ि�लक कर�

3. होम मेन ूम� �टाइ�स �ुप से कं�डशनल फॉम��टगं फं�शन चय�नत कर�

4. होम मेन ूम� फॉम�ट फं�शन को ि�लक करने के बाद टाग�ट रोज़ चय�नत करे और ऑटो�फट रो
चय�नत करे

Question Type : MCQ
Question ID : 6182782495

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.53 ‘C’ ल��वेज को �कस वष� म� �वक�सत �कया गया था?
Ans 1. 1982-83

2. 1952-53

3. 1962-63

4. 1972-73

Question Type : MCQ
Question ID : 6182782468

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.54 MS Excel 2016 म�, आपको ��डलाइन को �य ूऔर ��टं स�म करने का �वक�प कहां �मलता है?

Ans 1. Review

2. View

3. Design

4. Page Layout

Question Type : MCQ
Question ID : 6182782510

Status : Answered
Chosen Option : 4
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Marks : 1.00

Q.55 ‘��डलाइ�स’ फं�शन को �कस मेन ूसे चय�नत �कया जा सकता है?

Ans 1. �र�यू

2. �यू

3. फ़ॉमू�लाज़

4. �डज़ाइन

Question Type : MCQ
Question ID : 6182782490

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.56 MS Word 2016 म� �कसी समीकरण को जोड़ने के �लए �न�न�ल�खत म� से �कस �वक�प का उपयोग �कया
जाता है?

Ans 1. इ�सट� मेन ूम� मी�डया �ुप

2. इ�सट� मेन ूम� �सबं�स �ुप

3. इ�सट� मेन ूम� इल��ेश�स �ुप

4. इ�सट� मेन ूम� एड-इ�स �ुप

Question Type : MCQ
Question ID : 6182782484

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.57 MS Word 2016 म�, संपणू� द�तावेज़ का चयन करने के �लए शॉट� कट कंुजी �या है?

Ans 1. Ctrl + A

2. Alt + A

3. Shift + D

4. Ctrl + D

Question Type : MCQ
Question ID : 6182782482

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.58 MS Office 2016 म�, Review मेन ूम� Display for Review के अतंग�त �कतने माक� अप �वक�प ह�?
Ans 1. 5

2. 4

3. 3

4. 2

Question Type : MCQ
Question ID : 6182782483

Status : Answered
Chosen Option : 1
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Marks : 0.00

Q.59 ______ ए�से म� 32 �ब�स मौजदू ह�।
Ans 1. IPv3

2. IPv1

3. IPv4

4. IPv2

Question Type : MCQ
Question ID : 6182782519

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.60 MS Word म�, �न�न�ल�खत म� से कौन सी शॉट�कट कंुजी का उपयोग एक समय म� एक अकं म� कमी या व�ृ�
के �लए �कया जाता है?

Ans 1. Ctrl + ( or )

2. Shift + ( or )

3. Ctrl + { or }

4. Ctrl + [ or ]

Question Type : MCQ
Question ID : 6182782479

Status : Answered
Chosen Option : 2

Marks : 0.00
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Q.1 MS Word 2016 म� ‘रैप टे��ट’ फं�शन कौन से मे�य ूम� होता है?

Ans 1. होम

2. �र�यू

3. �यू

4. फ़ाइल

Question Type : MCQ
Question ID : 6182782430

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.2 MS Word म� ि��लट �वडंो देखने के �लए शॉट� कट क� �या है?

Ans 1. Ctrl + S

2. Ctrl + Alt + S

3. Alt + s

4. Ctrl + Shift + S

Question Type : MCQ
Question ID : 6182782418

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.3 एक समी�क ने �ैक च�जेस (Track Changes) मोड म� MS Word 2016 द�तावेज़ म� बदलाव �कए ह�। इस
स�ुवधा को स��य करने के �लए उसने �कस मेन ूका उपयोग �कया?

Ans 1. लेआउट

2. �यु

3. �र�यु

4. रेफरे�सेस

Participant ID 19421928
Participant Name KRISHNANAND GUPTA
Test Center Name iON Digital Zone iDZ Jalalpur
Test Date 27/12/2019
Test Time 9:00 AM - 10:00 AM
Subject Data Entry Operator
Marks Obtained 24.00000

Section : MCQ for Data Entry Operator
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Question Type : MCQ
Question ID : 6182782421

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.4 MS Word 2016 म� होम मे�य ूम� ‘इन��ज़ इंड�ट’ फं�शन का चयन �कस �ुप म� से �कया जा सकता है?

Ans 1. ए�ड�टगं �ुप

2. फॉ�ट �ुप

3. परैा�ाफ �ुप

4. ि�लपबोड� �ुप

Question Type : MCQ
Question ID : 6182782417

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.5 MS Excel 2016 के फॉमू�ला मे�य ूम� �न�न�ल�खत म� से कौन सा एक ‘मथै एंड ���नोमे��’ फं�शन है?

Ans 1. XOR

2. ABS

3. CHAR

4. ADDRESS

Question Type : MCQ
Question ID : 6182782447

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.6 MS Excel 2016 म� फं�शन ‘CHAR’ कौन सी �ेणी से संबंध रखता है?

Ans 1. टे��ट

2. मथै एंड ���नोमे��

3. लॉिजकल

4. लकुअप एंड रेफरंस

Question Type : MCQ
Question ID : 6182782445

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.7 मंज ूMS PowerPoint 2016 म� एक �ेज�टेशन तयैार कर रह� है, �कस मेन ूसे वह �लाइड का आकार बदल
सकती है?

Ans 1. �डज़ाइन

2. �र�यू

3. ऐ�नमेशन

4. फ़ाइल
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Question Type : MCQ
Question ID : 6182782455

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.8 MS Excel 2016 म�, सेल A1 से A4 म� चार अलग-अलग ��वि�टयाँ ह�। य�द आप इन सेल ओ ंको मज� करते
ह�, तो �कस सेल क� कंट�ट को बरकरार रखा जाएगा?

Ans 1. A4

2. A1

3. A2

4. A3

Question Type : MCQ
Question ID : 6182782438

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.9 य�द एक यज़ूर MS Office 2016 म� वड� फ़ाइल के �कसी �व�श�ट कम�ट पर जाना चाहता है, तो ऐसा करने के
�लए उसे �न�न�ल�खत म� से कौन से मे�य ूपर जाना पड़गेा?

Ans 1. �र�य ुमे�यू

2. लेआउट मे�यू

3. होम मे�यू

4. �डज़ाइन मे�यू

Question Type : MCQ
Question ID : 6182782419

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.10 �न�न�ल�खत �डवाइसेस म� से कौन सा एक नेटव�क� ग �डवाइस है?

Ans 1. हब

2. �कैनर

3. �लॉ�र

4. ��टंर

Question Type : MCQ
Question ID : 6182782456

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.11 क��यटूर नेटव�स� म� ‘गॉफर (Gopher)‘ �या होता है?

Ans 1. यह एक सपुर क��यटूर का नाम है

2. यह ���ंटगं म� �य�ुत होने वाल� एक तकनीक है

3. यह नेटव�क� ग �डवाइस का एक �कार है
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4. यह एक इंटरनेट �ोटोकॉल है

Question Type : MCQ
Question ID : 6182782460

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.12 MS Office 2016 म� मेल मज� �वज़ड� म� चौथा �टेप �या होगा?
Ans 1. सेले�ट �र�स�पएंटस

2. राइट योर लेटर (Write Your Letter)

3. �टा�ट�ग डॉ�यमू�ट सेले�ट करना

4. डॉ�यमू�ट टाइप सेले�ट करना

Question Type : MCQ
Question ID : 6182782427

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.13 MS Excel म� "=" का उपयोग �या है?

Ans 1. डटेा क� श�ुता का संकेत देता है

2. एक छ�व इं�गत करता है

3. एक स�ू का संकेत देता है

4. अनमुोदन दशा�ता है

Question Type : MCQ
Question ID : 6182782444

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.14 �न�न�ल�खत म� से कौन MS Word 2016 म� �टाट� मेल मज� के तहत एक वधै �वक�प नह�ं है?

Ans 1. लेब�स

2. यज़ू एन एि�सि�टंग �ल�ट

3. डायरे�टर�

4. एनवेल�स

Question Type : MCQ
Question ID : 6182782426

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.15 यह माइ�ोसॉ�ट �वडंोज टा�कबार का एक से�शन है जो �कसी �यो�ता को उसके �ो�ाम को लॉचं करने म�
स�म करता है। इसे �या कहा जाता है?

Ans 1. इंटर�ेटर

2. आइकन
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3. अस�बलर

4. ि�वक लॉचं टूलबार

Question Type : MCQ
Question ID : 6182782411

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.16 MS Excel 2016 म� एक �यो�ता एक �रपोट� बनाता है, वह �रपोट� म� कुछ फॉम��टग का उपयोग करता है।
ले�कन अब वह, फॉम��टग और कम��स म� कुछ बदलाव �कए �बना संपणू� डटेा को हटाना चाहता है। ऐसा करने
के �लए उसे कौन सा �वक�प चनुना चा�हए?

Ans 1. होम मे�य ूम� ए�ड�टगं �ुप म� से ि�लयर �वक�प म� ि�लयर क�टे��स सेले�ट करके

2. होम मे�य ूम� ए�ड�टगं �ुप म� से ि�लयर �वक�प म� ि�लयर ऑल सेले�ट करके

3. होम मे�य ूम� �टाइ�स �ुप म� से ि�लयर फॉम��टग �वक�प सेले�ट करके

4. होम मे�य ूम� से�स �ुप म� से �डल�ट �वक�प सेले�ट करके

Question Type : MCQ
Question ID : 6182782433

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.17 MS Excel 2016 म�, �न�न�ल�खत म� होम मे�य ूम� ‘नंबर �ुप’ क� कौन सी �वशषेता नह�ं है?

Ans 1. फॉम�ट एज़ टेबल

2. अकाउं�टगं नंबर फॉम�ट

3. परस�ट �टाइल

4. इ���ज ड�ेसमल पॉइंट

Question Type : MCQ
Question ID : 6182782440

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.18 IPv4 के बारे म� �न�न�ल�खत म� से कौन सा कथन सह� है?

Ans 1. यह 128 �बट है

2. यह 32 �बट है

3. यह एक �कार का वेब �ाउजर है

4. यह 8 वग� (class) का है

Question Type : MCQ
Question ID : 6182782459

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.19 वेब �ाउज़र का काय� �या है?

Ans 1. यह वेबपेज� को देखने के �लए एक सॉ�टवेयर है
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2. यह LAN से कने�ट होने वाला एक हाड�वेयर है

3. यह एक �कार का इंटरनेट कने�शन है

4. यह एक �कार का मॉडमे है

Question Type : MCQ
Question ID : 6182782457

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.20 एक ब�क �बंधक एक �न�द��ट मह�ने म� ब�क म� खलेु खात� क� सं�या के �लए, MS Excel 2016 म�, एक शीट
बना रहा है। इस शीट म� 35 रोज (rows) और 8 कॉल�स (columns) ह�, शीट को परूा करने के बाद उसे पता
चलता है �क चौथा कॉलम, िजसम� खाता धारक के �पता का नाम �लखा हुआ है, उसे अलग बकै�ाउंड कलर से
हाइलाइट �कया जाना चा�हए। ऐसा करने के �लए उसे कौन सा �वक�प चनुना चा�हए?

Ans 1. होम मे�य ूम� परैा�ाफ �ुप म� फ�ल से�स �वक�प

2. होम मे�य ूम� फॉ�ट �ुप म� फ�ल कलर �वक�प

3. होम मे�य ूम� अलाइ�म�ट �ुप म� फ�ल फॉम�ट �वक�प

4. होम मे�य ूम� से�स �ुप म� फ�ल BG �वक�प

Question Type : MCQ
Question ID : 6182782439

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.21 MS Office 2016 म� �कस �वक�प �वारा हम 3D मॉडल इ�सट� कर सकत ेह�?
Ans 1. इ�सट� मे�य ूम� �ल�ंस �ुप

2. इ�सट� मे�य ूम� चा��स �ुप

3. इ�सट� मे�य ूम� �पाक� लाइ�स �ुप

4. इ�सट� मे�य ूम� इल��ेशंस �ुप

Question Type : MCQ
Question ID : 6182782432

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.22 एक �यो�ता अपने �वडंोज 7 पर चलने वाले क��यटूर पर एक नया हाड�वेयर इ��टॉल करता है, ले�कन हाड�वेर
ठ�क तरह से कि�फ़गर नह�ं हुआ। उसे �न�न�ल�खत म� से कौन से �वक�प का उपयोग करना चा�हए िजससे
वह यह जांच सके �क उस �न�द��ट हाड�वेर का �ाइवर ठ�क से इ��टॉल हुआ है या नह�ं?

Ans 1. कं�ोल पनैल > �ो�ा�स

2. कं�ोल पनैल > यजूर अकाउं�स

3. कं�ोल पनैल > �स�टम एंड �स�यो�रट�

4. कं�ोल पनैल > �डवाइस मनेैजर

Question Type : MCQ
Question ID : 6182782414

Status : Answered
Chosen Option : 1
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Marks : 0.00

Q.23 MS PowerPoint 2016 म� ‘Ctrl+M’ शॉट�कट का उपयोग �कस �लए �कया जाता है?

Ans 1. मौजदूा �लाइड को ओपन करने के �लए

2. वत�मान �लाइड �डल�ट करने के �लए

3. नई �लाइड इ�सट� करने के �लए

4. �ेज�टेशन को सेव (save) करने के �लए

Question Type : MCQ
Question ID : 6182782451

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.24 परेू MS Word डॉ�यमू�ट को चनुने के �लए शॉट� कट क� �या है?

Ans 1. Ctrl + A

2. Alt + E

3. Alt + A

4. Ctrl + E

Question Type : MCQ
Question ID : 6182782428

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.25 MS Excel 2016 वक� शीट म� �न�न�ल�खत म� से कौन सी आकृ�त ‘श�ेस’ फं�शन का �ह�सा है?

Ans 1. बार चाट�

2. �लॉक एरोज़

3. 3D म�ैस

4. �पवोट चाट�

Question Type : MCQ
Question ID : 6182782449

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.26 Windows XP म� आइकन �या होता है?

Ans 1. यह एक हाई लेवल कं�यटूर भाषा है

2. कमां�स क� एक सचूी जो उपल�ध होती है

3. ये एक �वडंो के अदंर एक �वडंो होती है

4. छोटे �च� जो कमां�स, फाइ�स या फो�डस� को दशा�त ेह�

Question Type : MCQ
Question ID : 6182782410

Status : Answered
Chosen Option : 4

Marks : 1.00ANKAJ INFOTECH
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Q.27 MS Office 2016 के मेल मज� फ�चर के बारे म� �न�न�ल�खत म� से कौन सा कथन सह� है?

Ans 1. अ�य लोग� के साथ संचा�रत करने के �लए यह सोशल नेटव�क� ग वेबसाइ�स का एक फ�चर है

2. यह वड� �ॉसेसर का एक फं�शन है िजसके �वारा हम टाइ�पगं उ�े�य के �लए क�टम टे�पले�स
डाउनलोड कर सकत ेह�

3. यह Gmail का एक ऐसा फ�चर है जो यज़ूर को एक ह� लेटर अनेक यजूस� को भेजने म� स�म करता
है

4. यह MS Office का एक ऐसा फ�चर है जो यजूस� को एक ह� लेटर या डॉ�यमू�ट अनेक �ा�तकता�ओं
के पास भेजने म� स�म करता है

Question Type : MCQ
Question ID : 6182782425

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.28 MS PowerPoint 2016 म� पवू�-�नधा��रत समय के बाद एनीमेशन श�ु करने के �लए आप �न�न�ल�खत म� से
�कस फ़ं�शन का उपयोग कर�गे?

Ans 1. Animations > Trigger > Delay

2. Animations > Timing > Animation Painter

3. Animations > Timing > Delay

4. Transition > Timing > Delay

Question Type : MCQ
Question ID : 6182782454

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.29 MS PowerPoint 2016 म� य�द कोई �यो�ता �कसी और �ेज�टेशन म� से कुछ �लाइडस इ�सट� करना चाहता
है, तो ऐसा करने के �लए �न�न�ल�खत म� से कौन से �वक�प का उपयोग �कया जाएगा?

Ans 1. Home > Editing > Reuse Slides

2. Review > Slides > Reuse Slides

3. Insert > > Reuse Slides

4. Home > New Slide > Reuse Slides

Question Type : MCQ
Question ID : 6182782452

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.30 �न�न�ल�खत म� से कौनसी मेमर� �डवाइस �ाइमर� मेमर� है?

Ans 1. पेन �ाइव

2. हाड� �ड�क

3. म�ैने�टक टेप

4. RAM (रैम)
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Question Type : MCQ
Question ID : 6182782401

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.31 MS Office 2016 म�, एक वड� फ़ाइल को बंद करने के �लए �न�न�ल�खत म� से �कसका उपयोग �कया जाता
है?

Ans 1. Ctrl + Z

2. Ctrl + W

3. Ctrl+ S

4. Ctrl + Y

Question Type : MCQ
Question ID : 6182782415

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.32 MS Excel 2016 म� �न�न�ल�खत म� से कौन सा एक logical function है?

Ans 1. DATE

2. NOT

3. CHAR

4. NOW

Question Type : MCQ
Question ID : 6182782446

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.33 आप �कसी MS Word द�तावेज़ म� एक �व�श�ट श�द खोजना चाहत ेह� और इसे दसूरे श�द से बदलना चाहते
ह�। आप �कस शॉट� कट कंुजी का उपयोग कर�गे?

Ans 1. Ctrl + H

2. Ctrl + Y

3. Ctrl + R

4. Ctrl + W

Question Type : MCQ
Question ID : 6182782422

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.34 �नमा�ता �वारा िजस �चप पर डटेा �लखा जाता है, उसे �या कहा जाता है?

Ans 1. मा�क रॉम (Mask ROM )

2. रैम (RAM )

3. कन�ल (Kernel)

4. �ोम (PROM)
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Question Type : MCQ
Question ID : 6182782402

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.35 ए�ल�केशन सॉ�टवेयर के बारे म� �न�न�ल�खत म� से कौन सा कथन सह� नह�ं है?

Ans 1. एक ऐसा सॉ�टवेर िजसे �यो�ता को �कसी �व�श�ट काय� म� मदद के �लए �वक�सत �कया गया है

2. ए�ल�केशन सॉ�टवेयर के �बना कोई �स�टम काम नह�ं कर सकता

3. यह समा�यतः एक �ो�ाम या �ो�ाम का सं�ह है िजसका उपयोग अ�ंतम �यो�ताओ ं(end users)

�वारा �कया जाता है

4. ए�ल�केशन सॉ�टवेयर, हाई लेवल ल��वेज म� �लखा जाता है

Question Type : MCQ
Question ID : 6182782407

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.36 �वडंोज म� �कसी फो�डर को छुपाने के �लए �न�न�ल�खत म� से �कसका उपयोग �कया जा सकता है?

Ans 1. माइ क��यटूर पर ले�ट ि�लक > सी �ाइव > हाइड �ाइव

2. माइ क��यटूर पर डबल ि�लक > सी �ाइव > �ो�ाम फाइ�स

3. ड�ेकटॉप पर राइट ि�लक > �ॉपट�ज़ > हाइड फो�डर

4. �वडंोज ए�स�लोरर खोल� और फो�डर को खोज� > फो�डर पर राइट ि�लक > �ॉपट�ज

Question Type : MCQ
Question ID : 6182782412

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.37 MS Office 2016 क� एक वड� फ़ाइल म� हर एक परैा�ाफ के �पे�सगं हटाने के �लए कौन से �वक�प का
उपयोग �कया जा सकता है?

Ans 1. लेआउट मे�य ूम� परैा�ाफ �ुप म� से �पे�सगं फं�शन का चयन कर�

2. लेआउट मे�य ूम� परैा�ाफ �ुप म� से इंड�ट फं�शन का चयन कर�

3. �डज़ाइन मे�य ूम� डॉ�यमू�ट फॉम��टगं �ुप म� से इफ़े��स फं�शन का चयन कर�

4. �र�य ुमे�य ूम� डॉ�यमू�ट फॉम��टगं �ुप म� से परैा�ाफ �पे�सगं फं�शन का चयन कर�

Question Type : MCQ
Question ID : 6182782416

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.38 MS Excel 2016 म� “अलाउ यजूस� टू ए�डट र�जेज़ (Allow Users to Edit Ranges)” फं�शन कौन से
मे�य ूम� से सेले�ट �कया जा सकता है?

Ans 1. होम मे�यू

2. हे�प मे�यू
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3. �र�य ूमे�यू

4. फॉमू�ला मे�यू

Question Type : MCQ
Question ID : 6182782436

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.39 MS Excel 2016 म�, �न�न�ल�खत म� से �ोटे�ट शीट फं�शन का कौन सा वधै �वक�प नह�ं है?

Ans 1. ए�डट ऑ�जे��स

2. फॉम�ट से�स

3. �डल�ट रौस

4. इ�सट� �य ूशीट

Question Type : MCQ
Question ID : 6182782437

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.40 MS Excel 2016 म� �कस �वक�प के �वारा हम कॉलम का �डफॉ�ट �व�थ सेट कर सकत ेह�?
Ans 1. होम मे�य ूम� �टाइ�स �ुप म� से कं�डशनल फाम��टग फं�शन सेले�ट करके

2. होम मे�य ूम� अलाइ�म�ट �ुप म� से मज� एंड स�टर सेले�ट करके

3. होम मे�य ूम� से�स �ुप म� से फॉम�ट फं�शन सेले�ट करके

4. होम मे�य ूम� �टाइ�स �ुप म� से सेल �टाइ�स फं�शन सेले�ट करके

Question Type : MCQ
Question ID : 6182782434

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.41 MS Excel 2016 म�, एक यज़ूर 40 छा�� क� एक क�ा के �लए एक वक� शीट बना रहा है। वह उन छा�� के नाम
हाइलाइट करना चाहता है िज�ह� 40 से कम अकं �मले ह�। ऐसा करने के �लए कौन सा �वक�प उसक� मदद
करेगा?

Ans 1. ‘होम’ मे�य ूम� ‘से�स’ �ुप म� से ‘�टाइ�स’ फं�शन सेले�ट करना

2. ‘होम’ मे�य ूम�, ‘से�स’ �ुप म� से ‘इ�सट�’ फं�शन सेले�ट करना

3. ‘होम’ मे�य ूम�, ‘ए�ड�टगं’ �ुप म� से ‘फाइंड एंड �र�लेस’ सेले�ट करना

4. ‘होम’ मे�य ूम�, ‘�टाइ�स’ �ुप म� से ‘कंडीशनल फॉम��टगं’ फं�शन सेले�ट करना

Question Type : MCQ
Question ID : 6182782441

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.42 �न�न�ल�खत म� से �कस मेन ूम� '�ै�कंग' समहू एमएस-वड� 2016 म� पाया जाता है?

Ans 1. �य ूमे�यू
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2. मे�ल�ंस मे�यू

3. �र�य ूमे�यू

4. �डज़ाइन मे�यू

Question Type : MCQ
Question ID : 6182782423

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.43 �दए गए �वक�प� म� से तीन �नि�चत तर�के से एक जसेै ह�, जब�क एक अलग है। �वषम चनु�।
Ans 1. इंटर�ेटर

2. क�पाइलर

3. असे�बलर

4. जावा

Question Type : MCQ
Question ID : 6182782409

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.44 इंकजेट और लेजर ��टंर म� �या अतंर है?

Ans 1. इंकजेट ��टंर उ�च वॉ�यमू ���ंटगं के �लए सबसे उपय�ुत ह� जब�क लेजर ��टंर कम वॉ�यमू
���ंटगं के �लए उपय�ुत ह�

2. इंकजेट ��टंर टोनर का उपयोग करत ेह� जब�क लेजर ��टंर �याह� का उपयोग करत ेह�

3. इंकजेट ��टंर �याह� का उपयोग करत ेह� जब�क लेजर ��टंर टोनर का उपयोग करत ेह�

4. इंकजेट ��टंर �लकै एंड वाइट म�ुण के �लए ह� जब�क लेजर ��टंर कलर म�ुण के �लए ह�

Question Type : MCQ
Question ID : 6182782405

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.45 जावा ल��वेज �कस सं�थान/कंपनी �वारा �वक�सत क� गई थी?
Ans 1. सन माइ�ो �स�ट�स

2. गूगल

3. याहू

4. माइ�ोसॉ�ट

Question Type : MCQ
Question ID : 6182782408

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.46 गीता एक �ोजे�ट पर काम कर रह� है और इस �ोजे�ट म� उसे एक कंपनी के कम�चा�रय� के �लए एक वक� बकु
बनानी है, वह MS Excel 2016 म� HR कम�चा�रय� क� एक वक� शीट बना रह� है और अब वह IT कम�चा�रय�
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क� एक नई शीट जोड़ना चाहती है, ऐसा करने के �लए उसे �न�न�ल�खत म� से कौन सा �वक�प चनुना चा�हए?

Ans 1. Alt + F11

2. Alt + Shift + F1

3. Ctrl + N

4. Ctrl + P

Question Type : MCQ
Question ID : 6182782443

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.47 एक �यो�ता को ए�सेल म� एक चाट� बनाना है, जो एक �नधा��रत समय का �चलन (trends) दशा�ता है। इसके
�लए कौन से �कार का चाट� सबसे अनकूुल होगा?

Ans 1. वॉटरफॉल चाट�

2. पाई चाट�

3. हायराक� चाट�

4. लाइन चाट�

Question Type : MCQ
Question ID : 6182782448

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.48 MS Excel 2016 म�, जब सेल को सेल �टाइल फ़ं�शन से “Bad” के �प म� लागू �कया जाता है, सेल का
बकै�ाउंड रंग ________ क� छाया (shade) बन जाता है।

Ans 1. पीला

2. कोई रंग नह�ं/ पारदश�

3. लाल

4. काला

Question Type : MCQ
Question ID : 6182782442

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.49 IP ए�से �कतने �कार (class) के होत ेह�?
Ans 1. 1

2. 9

3. 3

4. 5

Question Type : MCQ
Question ID : 6182782458

Status : Answered
Chosen Option : 3

Marks : 0.00
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Q.50 चय�नत टे��ट के केस (case) को टॉगल करने के �लए MS Word म� शॉट� कट कंुजी �या है?

Ans 1. Ctrl + C

2. F5

3. Alt + C

4. Shift + F3

Question Type : MCQ
Question ID : 6182782420

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.51 MS Office 2016 म�, ए�सेल वक� शीट म� हम ‘सेले�ट क� गई पंि�तय� को कैसे �डल�ट कर सकत ेह�?
Ans 1. �वडंो के �नचले बाएं कोने म� फ़ाइल नेम पर राइट ि�लक कर� और �डल�ट टैब सेले�ट कर�

2. होम मे�य ूम� से�स �ुप म� से �डल�ट फं�शन सेले�ट कर�

3. वत�मान वक� शीट के �नचले बाएं कोने म� शीट नेम पर राइट ि�लक कर� और �ोटे�ट शीट टैब सेले�ट
कर�

4. �डज़ाइन मे�य ूम� से कवर पेज सेले�ट कर�

Question Type : MCQ
Question ID : 6182782431

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.52 MS PowerPoint म� ��गर का उपयोग �या है?

Ans 1. यह एक �डफाइंड एनीमेशन श�ु कर सकता है

2. यह एक कंट�ट �र�य ूश�ु कर सकता है

3. इससे गोल� चल सकती है

4. यह �लाइड शो मोड श�ु करता है

Question Type : MCQ
Question ID : 6182782453

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.53 मा�नता MS ए�सेल 2016 म� एक मह�ने के दौरान उपयोग क� गई अनेक घरेल ूचीज़� क� एक ता�लका बना
रह� है। इस टेबल म� वह �व�भ�न चीज़� के नाम पहले कॉलम म� �लखती है, ले�कन कुछ नाम बहुत लब� ह� और
वह कॉलम म� �फट नह�ं होत ेह�। नाम� क� लंबाई के अनसुार उस कॉलम क� चौड़ाई को अनकूुल करने के �लए
उसे कौन सा �वक�प चनुना चा�हए?

Ans 1. Ctrl + A दबाएँ

2. टाग�ट कॉलम के �तंभ शीष�क (column heading) क� बा� सीमा पर डबल ि�लक कर�

3. F5 दबाएँ

4. टाग�ट कॉलम के �तंभ शीष�क (column heading) क� दा� सीमा पर डबल ि�लक कर�

Question Type : MCQ
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Question ID : 6182782435
Status : Answered

Chosen Option : 2
Marks : 0.00

Q.54 �न�न�ल�खत म� से कौन सा एक इनपटु �डवाइस है?

Ans 1. ��टंर

2. मॉ�नटर

3. क�बोड�

4. �ोजे�टर

Question Type : MCQ
Question ID : 6182782403

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.55 �न�न�ल�खत म� से कौन सा ��टंर, �ा�फ�स ��टं नह�ं कर सकता?
Ans 1. डज़ेी �ह�ल ��टंर

2. लेजर जेट ��टंर

3. इंकजेट ��टंर

4. डॉट म�ै��स ��टंर

Question Type : MCQ
Question ID : 6182782404

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.56 MBR के बारे म� �न�न�ल�खत म� से कौन सा कथन सह� नह�ं है?

Ans 1. MBR टेबल पा�ट�शन �क�म म� ए�सट�डडे पा�ट�शन हो सकता है

2. MBR का पणू� नाम ‘मा�टर बटू �रकॉड� (Master Boot Record)’ है

3. यह एक �वशषे �कार का बटू से�टर है जो पा�ट�शन वाले कं�यटूर क� श�ुआत म� है

4. MBR 5 से �यादा �ाइमर� पाट�श�स को सपोट� करता है

Question Type : MCQ
Question ID : 6182782413

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.57 ______ MS Excel म� एक " Lookup & Reference " �कार का फ़ं�शन है।
Ans 1. CLEAN

2. TRUE

3. CHAR

4. MATCH

Question Type : MCQ
Question ID : 6182782450ANKAJ INFOTECH
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Status : Answered
Chosen Option : 1

Marks : 0.00

Q.58 MS Word 2016 म� �न�न�ल�खत म� से �कस �वक�प म� ’ि�वक टेबल’ �वक�प पाया जाता है?

Ans 1. इ�सट� मे�य ूम� ऐड-इंस �ुप म�

2. इ�सट� मे�य ूम� इल��ेशन �ुप म�

3. इ�सट� मे�य ूम� टेबल �ुप म�

4. इ�सट� मे�य ूम� पेजेज �ुप म�

Question Type : MCQ
Question ID : 6182782424

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.59 �न�न�ल�खत म� से कौन सा ऑपरे�टगं �स�टम का एक �कार नह�ं है?

Ans 1. अ�मगाOS

2. सफार�

3. य�ून�स

4. सोलार�स

Question Type : MCQ
Question ID : 6182782406

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.60 MS Word 2016 म�, आप �थसॉरस म� एक चय�नत श�द का अथ� देखना चाहत ेह�। आप �न�न�ल�खत शॉट�
कट कंुजी का उपयोग कर�गे?

Ans 1. Alt + T

2. Ctrl + T

3. F7

4. Shift + F7

Question Type : MCQ
Question ID : 6182782429

Status : Answered
Chosen Option : 2

Marks : 0.00
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Q.1 MS-Excel 2016 काय�पिु�तका म�, 2 वक� शीट ह�। आप एक शीट को ए�डट से बचाना चाहत ेह� परंत ुदसूरे को
नह�ं। आप �न�न�ल�खत म� से �कस �वक�प का उपयोग कर�गे?

Ans 1. उपयोगकता�ओ ंको �े�णय� को संपा�दत करने क� अनमु�त द�

2. काय�पिु�तका को सरु��त रख� और साझा कर�

3. शीट को सरु��त रख�

4. काय�पिु�तका को सरु��त रख�

Question Type : MCQ
Question ID : 618278157

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.2 इनपटु/आउटपटु कं�ोलर �या है?

Ans 1. यह कं�यटूर हाड�वेयर और इनपटु/आउटपटु उपकरण� के बीच इंटरफेस के �प म� काम करता है

2. यह एक �कार का �स�टम सॉ�टवेयर है

3. यह एक �कार का अन�ुयोग (ए�ल�केशन) सॉ�टवेयर है

4. यह एक �कार का मॉ�नटर है

Question Type : MCQ
Question ID : 618278125

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.3 1000 पंि�तय� और पाँच कॉलम� क� एक म�ै��स म� 1000 छा�� के पत ेवाल� एक शीट है। वत�मान म�, कस�र
पहले छा� (A1) पर है और इसे पहले कॉलम क� सभी 1000 ��वि�टय� को केवल एक बार (A1 से A1000) म�
चनुने क� आव�यकता है। इसके �लए शॉट�कट �या है?

Ans 1. Ctrl + down arrow key

2. Ctrl + Shift + down arrow key
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Test Date 27/11/2019
Test Time 3:00 PM - 4:00 PM
Subject Data Entry Operator
Marks Obtained 14.00000

Section : MCQ for Data Entry Operator
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3. Ctrl + A

4. Ctrl + Shift + Tab

Question Type : MCQ
Question ID : 618278161

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.4 फाइल/फो�डर को अनहाइड करने के �लए कौन सा �वक�प चनुना चा�हए?

Ans 1. ले�ट ि�लक > कट > �छपी हुई फाइल� और �ाइव �दखाएं

2. राइट ि�लक > कट > अनहाइड

3. फ़ो�डर और खोज �वक�प बदल� > �य ू> छुपी हुई फ़ाइल� और �ाइव �दखाएं

4. बा� ओर ि�लक कर� > �य ू> �छपी हुई फ़ाइल� और �ाइव �दखाएं

Question Type : MCQ
Question ID : 618278133

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.5 मेल मज� को ख�म करने के �लए अ�ंतम चरण �या होगा?
Ans 1. समा�त और मज�

2. �र�य ुरे�स�पएंट

3. लेबल अपडटे

4. �ा�तकता� ए�डट

Question Type : MCQ
Question ID : 618278149

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.6 �कसी MS-Word द�तावेज़ म�, �न�न�ल�खत म� से कौन से काय� को '�ैक प�रवत�न' �वक�प का उपयोग करके
�ैक नह�ं �कया जा सकता है?

Ans 1. फ़ॉ�ट आकार को बदलना

2. चय�नत डटेा को बो�ड बनाना

3. फ़ॉ�ट रंग को बदलना

4. ता�लका �तंभ हटाना

Question Type : MCQ
Question ID : 618278143

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.7 MS-Excel 2016 के सलै म� बा� ओर डटेा संरे�खत करने के चरण� के अन�ुम को पहचान�।
Ans 1. प�ृठ लेआउट > संरे�खत कर� > बाएँ संरे�खत कर�
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2. होम > संरेखण > बाएं संरे�खत कर�

3. होम > फ़ॉ�ट > बाएं संरे�खत कर�

4. प�ृठ लेआउट > फ़ॉ�ट > बाएं संरे�खत कर�

Question Type : MCQ
Question ID : 618278154

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.8 कोई लेखक MS-Word म� जीत क� कहानी �लख रहा है और वह उस फ़ाइल म� जीत के काय��थल क� त�वीर
डालना चाहता है। वह जीत के काय��थल के बारे म� �च� को एक बड़ ेपरैा�ाफ के बीच म� इस तरह से रखना
चाहता है �क छ�व के चार� ओर टे��ट हो। लेखक को �न�न�ल�खत म� से कौन से फं�शन का उपयोग करना
चा�हए?

Ans 1. रैप टे��ट

2. पेज �ेक

3. ले�ट एलाइनम�ट

4. मज� और स�टर

Question Type : MCQ
Question ID : 618278140

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.9 कोई कंपनी �ाहक� को 6 अलग-अलग मद �दान करती है। �ब�� �बंधक, अपने पय�वे�क से, ��येक मद के
�लए, ��त�ुत के दौरान एक �लाइड तयैार कराता है। पय�वे�क सभी �लाइ�स को एक �वडंो म� रखना चाहता है
ता�क वह तलुना कर सके। �ब�� �बंधक �न�न�ल�खत फं�शन� म� से कौन सा फं�शन उपयोग करेगा?

Ans 1. �लाइड ज़मू

2. सारांश ज़मू

3. �लाइड साट�र

4. �लाइड का आकार

Question Type : MCQ
Question ID : 618278172

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.10 MS-Excel 2016 म� होम मेन ूके �कस उप मेन ूम� ‘रैप टे��ट’ पाया जाता ह�?
Ans 1. �टाइल

2. फ़ॉ�ट

3. ए�डट

4. संरेखण

Question Type : MCQ
Question ID : 618278160

Status : Answered
Chosen Option : 3
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Marks : 0.00

Q.11 ALU का पणू� �प �या है?

Ans 1. आ�ट��फशल लॉयल य�ूनट (Artificial Loyal Unit)

2. आ�ट��फशल लॉिजकल यजूर (Artificial Logical User)

3. अ�रदम�ैटक लॉिजक य�ूनट (Arithmetic Logic Unit )

4. अ�रदम�ैटक लॉयल य�ूनट (Arithmetic Loyal Unit)

Question Type : MCQ
Question ID : 618278121

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.12 MS-Excel म� पाठ क� प�ृठभ�ूम के रंग को बदलने के �लए �न�न�ल�खत म� से �कसका उपयोग �कया जाता
है?

Ans 1. बकै�ाउंड शडे

2. इ�सट� सेल कलर

3. फॉटं कलर

4. फ�ल कलर

Question Type : MCQ
Question ID : 618278162

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.13 �टै�टक RAM और डायना�मक RAM के बारे म�, �न�न�ल�खत म� से कौन सा �वक�प सह� है?

Ans 1. �टै�टक रैम, डायने�मक रैम से तजे है

2. डायने�मक रैम, �टै�टक रैम से महंगा है

3. डायने�मक रैम, �टै�टक रैम से तजे है

4. �टै�टक रैम क� तलुना म� डायने�मक रैम क� संरचना अ�धक ज�टल है

Question Type : MCQ
Question ID : 618278122

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.14 �न�न�ल�खत म� से कौन सा एक ऑपरे�टगं �स�टम है?

Ans 1. सफार�

2. नेट�केप

3. उब�ुटु �लन�स

4. गूगल �ोम

Question Type : MCQ
Question ID : 618278126

Status : Answered
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Chosen Option : 4
Marks : 0.00

Q.15 MS-PowerPoint 2016 के �य ूमेन ूम�, ‘नई �वडंो’ �वक�प का उ�े�य �या है?

Ans 1. दसूर� �वडंो म� दसूर� फाइल खोलना

2. नई खाल� ��त�ुत खोलना

3. उसी �वडंो म� एक और फ़ाइल खोलना

4. उसी ��त�ुत को दसूर� �वडंो म� खोलना

Question Type : MCQ
Question ID : 618278174

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.16 MS-Word म� ��टं कमांड का शॉट�कट �या है?

Ans 1. Alt + P

2. Ctrl + PrintScreen

3. Ctrl + P

4. Shift + P

Question Type : MCQ
Question ID : 618278139

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.17 �कसी कॉफ� शॉप का मा�लक, अपने �ाहक� के मेल मज� के �लए ए�से लेबल बनाना चाहता है। पता लेबल का
�न�न�ल�खत म� से कौन सा लाभ है?

Ans 1. वह �ाहक� के साथ �यि�तगत संबंध रख सकता है

2. वह �ाहक� के मोबाइल नंबर को �ैक कर सकता है

3. इससे बार-बार नाम और पत ेटाइप करने से बचा जा सकता है, इस�लए यह समय और पसैा बचाता
है।

4. वह �ाहक� को कॉल कर सकता है

Question Type : MCQ
Question ID : 618278148

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.18 नेटव�क� ग म� ‘DSL’ का पणू� �प �या है?

Ans 1. �डिजटल स���ाइबर लाइन (Digital Subscriber Line)

2. डमेो�ा�फक सबकॉि�टन�ट लाइन (Demographic subcontinent line)

3. �डिजटल स�स�ाइबर लाइट (Digital Subscriber Light)

4. �डिजटल सबकॉि�टन�ट लाइट (Digital Subcontinent Light)

Question Type : MCQ
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Question ID : 618278177
Status : Answered

Chosen Option : 2
Marks : 0.00

Q.19 MS-Excel म�, ‘मवू या कॉपी’ �वक�प के संबंध म� �न�न�ल�खत म� से कौन सा कथन गलत है?

Ans 1. इसका उपयोग काय�पिु�तका के अदंर शीट के अन�ुम को बदलने के �लए �कया जाता है

2. शीट को नई काय�पिु�तका म� ले जाया जा सकता है

3. शीट को �थानांत�रत करत ेसमय इसक� कॉपी को बनाए रखा जा सकता है

4. शीट को केवल खोल� गई फ़ाइल म� ले जाया जा सकता है और इसे नई काय�पिु�तका म� नह�ं ले जाया
जा सकता है

Question Type : MCQ
Question ID : 618278153

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.20 MS-Word म� justify फ़ं�शन का उ�े�य �या है?

Ans 1. बाएँ और दाएँ दोन� हा�शये (मािज�न) पर पाठ को संरे�खत करना

2. पाठ को क� � म� संरे�खत करना

3. परेू प�ृठ म� समान �प से पाठ को �वत�रत करना

4. संपणू� फ़ाइल म� समान �प से �वत�रत करना

Question Type : MCQ
Question ID : 618278138

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.21 �वडंोज़ XP म�, नया उपयोगकता� जोड़ने के �लए, �कस �वक�प का उपयोग �कया जा सकता है?

Ans 1. काय� �बंधक (टा�क मनेैजर)

2. कं�ोल पनैल

3. र�सायकल �बन

4. माई नेटवक�  �ले�सज़

Question Type : MCQ
Question ID : 618278132

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.22 �न�न�ल�खत म� से कौन सा कथन मेल मज� डटेाबेस के बारे म� सह� नह�ं है?

Ans 1. डटेा �ोत को �थानीय कं�यटूर म� सहेजा जाना चा�हए

2. HTTP �थान, मेल मज� �वारा सम�थ�त होती है

3. ए�सेल ��ेडशीट, डटेा �ोत के �प म� काम कर सकती है

4. मेल मज� के �लए ए�सेस डटेाबेस का भी उपयोग �कया जा सकता है
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Question Type : MCQ
Question ID : 618278147

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.23 �न�न�ल�खत म� से कौन सा �वक�प �लग एंड �ले के बारे म� सह� है?

Ans 1. यह एक ऐसी तकनीक है, जो ऑपरे�टगं �स�टम को वायरस के बारे म� उपयोगकता� को बताने क�
स�ुवधा देती है

2. यह एक �कार का �ाउज़र है

3. यह एक ऐसी तकनीक है, जो ऑपरे�टगं �स�टम को आतं�रक और बाहर� पे�रफेरेल का पता लगाने
और कॉि�फ़गर करने क� स�ुवधा देती है

4. यह MS-Word क� एक आतं�रक �वशषेता है।

Question Type : MCQ
Question ID : 618278134

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.24 �न�न�ल�खत म� से �कस �वक�प म�, मौजदूा फ़ाइल का नाम भी बदला जा सकता है?

Ans 1. फ़ाइल मेन ूम� "��टं" �वक�प

2. फ़ाइल मेन ूम� "इस �प म� सहेज�" �वक�प

3. फ़ाइल मेन ूम� "सहेज�" �वक�प

4. फ़ाइल मेन ूम� “नया” �वक�प

Question Type : MCQ
Question ID : 618278150

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.25 MS-Excel म� सलै� क� �ेणी के अकंग�णतीय मा�य क� गणना करने के �लए ______ फ़ं�शन का उपयोग
�कया जाता है।

Ans 1. AVERAGE

2. ADD

3. AM

4. SUM

Question Type : MCQ
Question ID : 618278165

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.26 MS-Excel 2016 क� काय�पिु�तका को �कस मेन/ू मेनज़ू से संर��त �कया जा सकता है?

Ans 1. फ़ाइल और �य ूमेन,ू दोन� से

2. केवल समी�ा मेन ूसे

3. केवल फ़ाइल मेन ूसे
ANKAJ INFOTECH



1/27/2020 https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S3D39/1574863703971478/1…

https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S3D39/1574863703971478/19464337_1… 8/16

4. फ़ाइल और समी�ा मेन,ू दोन� से

Question Type : MCQ
Question ID : 618278156

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.27 �न�न�ल�खत म� से कौन सा एक सच� इंजन नह�ं है?

Ans 1. याहू

2. �बगं

3. गूगल

4. फ़ायरफ़ॉ�स

Question Type : MCQ
Question ID : 618278178

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.28 मेल मज� करत ेसमय, MS-Word म� द�तावेज़ के �कार� क� सं�या होती है। �लफ़ाफ़े म�, इस पर दो पत े�लखे
होत ेह�। ये पत े�या ह�?

Ans 1. �डल�वर� का पता और �रटन� पता

2. �ेषक का पता और �रसीवर का पता

3. �ेषक का पता और �रटन� पता

4. �डल�वर� का पता और �रसीवर का पता

Question Type : MCQ
Question ID : 618278146

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.29 MS-Word द�तावेज़ म� 'पवू�वत (अन-डू)' फ़ं�शन का उपयोग करने के �लए शॉट�कट �या है?

Ans 1. Alt + Z

2. Ctrl + Z

3. Ctrl + R

4. Shift + Z

Question Type : MCQ
Question ID : 618278137

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.30 MS-Excel 2016 के होम मेन ूम� इ�सट� टैब का उपयोग करके कौन सा काय� नह�ं �कया जा सकता है?

Ans 1. सलै डाल�

2. शीट कॉलम डाल�

3. ता�लका डाल�
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4. शीट डाल�

Question Type : MCQ
Question ID : 618278152

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.31 �य ूमेन ूम� कौन सा फ़ं�शन �वडंो को अलग-अलग पनै म� �वभािजत करने क� अनमु�त देता है िजसे MS-
Excel 2016 म� अलग से ��ॉल �कया जा सकता है?

Ans 1. �प�लट

2. शीट �यवि�थत कर�

3. नयी �वडं�

4. सभी को �यवि�थत करे

Question Type : MCQ
Question ID : 618278155

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.32 �न�न�ल�खत म� से, �डफ़ॉ�ट �प से MS-Excel म� कौन सी द� गई आकृ�तय� (Shapes) क� �ेणी नह�ं है?

Ans 1. आइकॉन

2. पंि�तयां

3. �लॉक ऐरो

4. मलू आकृ�तयां

Question Type : MCQ
Question ID : 618278169

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.33 MS-Excel म� नई वक� शीट को जोड़ने का शॉट�कट �या है?

Ans 1. Shift + F9

2. Ctrl + F9

3. Ctrl + N

4. Shift + F11

Question Type : MCQ
Question ID : 618278151

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.34 MS-Word 2016 म� "लेआउट" मेन ूके उप मेन ू‘अर�ज' म� �न�न�ल�खत म� से कौन सा �वक�प नह�ं है?

Ans 1. पोजीशन

2. �ेक
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3. आगे लाना

4. रैप टे��ट

Question Type : MCQ
Question ID : 618278144

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.35 �वडंोज XP म� IP पता मनैअुल देने के �लए, हम� �न�न म� से �कस आइकन का चयन करना चा�हए?

Ans 1. र�सायकल �बन

2. माई कं�यटूर

3. माई नेटवक�  �थान

4. इंटरनेट ए���लोरर

Question Type : MCQ
Question ID : 618278130

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.36 MS-Excel के स�ू मेन ूम�, �न�न�ल�खत म� से कौन सा एक ता�क� क फं�शन है?

Ans 1. SUM

2. STDEV

3. IF

4. LOG

Question Type : MCQ
Question ID : 618278167

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.37 MS-Excel 2016 म� �कस मेन ूका उपयोग करके, स�ू-बार (फामू�ला बार) को अ��य बनाया जा सकता है?

Ans 1. होम > फाम�ट सलै

2. पेज लेआउट > स�ू बार

3. �य ू> स�ू बार

4. स�ू > स�ू बार

Question Type : MCQ
Question ID : 618278158

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.38 MS-Word म� �न�न�ल�खत म� से कौन सी मािज�न क� मानक शलै� नह�ं है?

Ans 1. हायफ़नेशन

2. सामा�य
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3. चौड़ा

4. ��त�ब�ंबत

Question Type : MCQ
Question ID : 618278136

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.39 MS- Word म� नई फ़ाइल खोलने का शॉट�कट �या है?

Ans 1. Ctrl + M

2. Ctrl + O

3. Ctrl + N

4. Ctrl + S

Question Type : MCQ
Question ID : 618278135

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.40 कं�यटूर माउस का आ�व�कार �कसने �कया था?
Ans 1. एलन के

2. एलन �य�ूरगं

3. डगलस एंजेलबाट�

4. चा�स� बेबेज

Question Type : MCQ
Question ID : 618278123

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.41 मेल मज� फ़ं�शन म� �न�न�ल�खत म� से कौन सा द�तावेज़ का एक �कार नह�ं है?

Ans 1. एनवेलप

2. डायरे�टर�

3. लेबल

4. �प�चस�

Question Type : MCQ
Question ID : 618278145

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.42 MS-Excel 2016 म� होम मेन ूके फाम�ट सलै �वक�प का �न�न�ल�खत म� से कौन सा काय� नह�ं है?

Ans 1. संरेखण

2. भरण
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3. अ�भ�व�यास

4. सरु�ा

Question Type : MCQ
Question ID : 618278159

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.43 असे�बल� भाषा के बारे म� �न�न�ल�खत म� से कौन-सी बात सह� है?

Ans 1. यह केवल सं�याओ ंका उपयोग करती है

2. यह �न�न-�तर�य भाषा है

3. यह GUI-आधा�रत भाषा है

4. यह उ�च-�तर�य भाषा है

Question Type : MCQ
Question ID : 618278128

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.44 पत ेके �ववरण के साथ 10 कम�चा�रय� क� एक सचूी है। वण�माला �म म� नाम� क� �यव�था करने क�
आव�यक है। MS-Word 2016 म� ऐसा करने के �लए �न�न�ल�खत म� से �कस �म का अनसुरण �कया
जाएगा?

Ans 1. �सले�ट डटेा > होम मेन ू> �र�य ु> सॉट�

2. �सले�ट डटेा > होम मेन ू> परैा�ाफ समहू > सॉट�

3. होम मेन ू> �सले�ट डटेा > रेफर�स > सॉट�

4. होम मेन ू> �सले�ट डटेा > श�ैलया ँ> सॉट�

Question Type : MCQ
Question ID : 618278141

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.45 एक चाट� तयैार करना होता है िजसम� X- अ� पर �लगं को �लया जाता है और Y- अ� पर �यि�तय� क� सं�या
को। �न�न�ल�खत म� से कौन सा डटेा ऐसे �े�णय� को �दखाने के �लए सबसे उपय�ुत है िजनम� �े�णया ंहोती
ह�?

Ans 1. बार चाट�

2. पंि�त चाट�

3. पाई चाट�

4. �टॉक चाट�

Question Type : MCQ
Question ID : 618278168

Status : Answered
Chosen Option : 1

Marks : 1.00
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MS-PowerPoint 2016 के होम टैब म� �न�न�ल�खत म� से कौन सा एक फ़ं�शन नह� ंहै?

Ans 1. �लाइड �डजाइन

2. खोज

3. से�शन

4. नई �लाइड

Question Type : MCQ
Question ID : 618278171

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.47 पा�स�ग क� ���या को �कस नाम से जाना जाता है?

Ans 1. �सटें�स एना�ल�सस

2. बचै �स�टम

3. �स�टम सॉ�टवेयर

4. इव�ट काउंटर

Question Type : MCQ
Question ID : 618278127

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.48 MS-Excel 2016 म� "�ोटे�ट शीट" �वक�प को �कस मेन ूसे चनुा जा सकता है?

Ans 1. पेज लेआउट

2. फ़ाइल

3. इंसट�

4. डटेा

Question Type : MCQ
Question ID : 618278163

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.49 वेब �ाउज़र, OSI मॉडल क� �कस परत पर काम करता है?

Ans 1. भौ�तक परत

2. अन�ुयोग परत

3. डटेा �लकं परत

4. नेटवक�  परत

Question Type : MCQ
Question ID : 618278180

Status : Answered
Chosen Option : 3

Marks : 0.00
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Q.50 MS-Word म� चय�नत डटेा को पे�ट करने का शॉट�कट �या है?

Ans 1. Ctrl + P + S

2. Ctrl + P

3. Alt + P

4. Ctrl + V

Question Type : MCQ
Question ID : 618278142

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.51 कं�यटूर के भौ�तक पत ेको ______ के �प म� भी जाना जाता है।
Ans 1. कं�यटूर का नाम

2. डोमेन नाम

3. IP पता

4. मकै पता

Question Type : MCQ
Question ID : 618278176

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.52 पांच छा�, पचास �यि�तय� के मा�सक खच� का डटेा एक� करने के �लए �कसी असाइनम�ट पर काम कर रहे ह�,
��येक छा�, 10 उ�तरदाताओ ंका डटेा एक� कर रहा है। उन छा�� म� से एक छा� चाहता है �क उसके �वारा
दज� �कए गए डटेा म� कोई भी बदलाव न कर सके। उसके �वारा �न�न�ल�खत म� से �कसका उपयोग �कया
जाएगा?

Ans 1. रैप टे��ट

2. नाम बदल� शीट

3. हाइड सलै

4. लॉक सलै

Question Type : MCQ
Question ID : 618278164

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.53 कंपाइलर� के बारे म�, �न�न�ल�खत म� से कौन सा �वक�प गलत है?

Ans 1. इसम� �डब�गगं आसान है �य��क इससे �ो�ाम का अनवुाद तब तक चलता रहता है जब तक �क ��ुट
पाई नह�ं जाती।

2. कंपाइलर परेू �ो�ाम को �कैन करने के बाद ह� ��ुट का संदेश देता है इस�लए �डब�गगं तलुना�मक
�प से क�ठन होती है �य��क ��ुट �ो�ाम म� कह�ं भी मौजदू हो सकती है।

3. कंपाइलर एक �ो�ाम है जो �ो�ा�मगं भाषा के परेू �ोत कोड को CPU के �लए �न�पादन यो�य
मशीन कोड म� प�रव�त�त करता है।

4. इसे भाषा संसाधक (�ोसेसर) भी कहा जाता है।
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Question Type : MCQ
Question ID : 618278129

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.54 IPV4 म�, �कतने वग� ह�?
Ans 1. 6

2. 4

3. 5

4. 7

Question Type : MCQ
Question ID : 618278179

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.55 �वडंो XP म� फ़ाइल साझा करने के �लए, चरण� का सह� �म �न�न�ल�खत म� से �या होना चा�हए?

Ans 1. मद पर डबल-ि�लक कर�- शये�रगं और �स�यो�रट� चनेु-नेटवक�  पर इस फो�डर को शयेर कर�

2. शये�रगं और �स�यो�रट� चनेु-नेटवक�  पर इस फो�डर को शयेर कर�

3. मद पर दाएं ि�लक कर�-शये�रगं और �स�यो�रट� चनेु-नेटवक�  पर इस फो�डर को शयेर कर�

4. मद पर बाएं ि�लक कर�-शये�रगं और �स�यो�रट� चनेु-नेटवक�  पर इस फो�डर को शयेर कर�

Question Type : MCQ
Question ID : 618278131

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.56 MS-Excel म� स�ू क� कॉपी करने का शॉट�कट �या है?

Ans 1. Ctrl + C

2. Alt + C

3. Ctrl + F + C

4. Ctrl + Shift + C

Question Type : MCQ
Question ID : 618278166

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.57 �न�न�ल�खत म� से कौन सा एक �माट� आट� �ा�फक है?

Ans 1. कॉल आउट

2. श�द कला (वड� आट�)

3. म�ै��स

4. �टार और बनैर

Question Type : MCQ
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Question ID : 618278170
Status : Answered

Chosen Option : 4
Marks : 0.00

Q.58 �लाइड सॉट�र �य ूम�, कौन सा काय� चय�नत �लाइड के साथ नह�ं �कया जा सकता?
Ans 1. प�ृठभ�ूम के फाम�ट म� बदलाव

2. नई �लाइड जोड़ना

3. खंड को जोड़ना

4. टेबल डालना

Question Type : MCQ
Question ID : 618278173

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.59 �न�न�ल�खत म� से कौन सा मेन,ू �लाइड के म�य ग�तशीलता का �वक�प देता है?

Ans 1. होम

2. सं�मण

3. �डज़ाइन

4. �यू

Question Type : MCQ
Question ID : 618278175

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.60 �न�न�ल�खत म� से कौन सी आउटपटु �डवाइस है?

Ans 1. OCR

2. हेडफो�स

3. माइ�ोफ़ोन

4. टचपडै

Question Type : MCQ
Question ID : 618278124

Status : Answered
Chosen Option : 3

Marks : 0.00
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Q.1 �न�न�ल�खत म� से कौन एक वेब �ाउज़र नह�ं है?

Ans 1. Firefox

2. Google Chrome

3. Safari

4. Microsoft Team

Question Type : MCQ
Question ID : 618278116

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.2 �न�न�ल�खत म� से कौन सा कथन मशीन भाषा के संबंध म� सह� है?

Ans 1. यह एक उ�च-�तर भाषा है।

2. उपयोगकता�/�ो�ामर के �लए इसे समझना आसान है।

3. यह एक �न�न-�तर भाषा है।

4. कं�यटूर, बाइनर� भाषा नह�ं समझ सकता है।

Question Type : MCQ
Question ID : 61827868

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.3 यह जाँचने के �लए �क �या हमारा कं�यटूर एक ऐसी ���या / काय� के कारण धीमी ग�त से काम कर रहा है जो
उ�च मा�ा म� RAM का उपयोग कर रहा है, और उस काय� को समा�त करने के �लए हम� ______ पर जाने क�
आव�यकता होती है।

Ans 1. My Files (माई फाइ�स)

2. My Computer (माई क��यटूर)

3. Task Bar (काय� प�ी)

Participant ID 19457772
Participant Name RAVI RANJAN KUMAR
Test Center Name iON Digital Zone iDZ Jalalpur
Test Date 27/11/2019
Test Time 12:00 PM - 1:00 PM
Subject Data Entry Operator
Marks Obtained 25.00000

Section : MCQ for Data Entry Operator
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4. Task Manager (काय� �बंधक)

Question Type : MCQ
Question ID : 61827872

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.4 MS-Excel 2016 म� �कसी �तंभ का आकार बढ़ाने या घटाने के �लए चरण� का सह� �म �या है?

Ans 1. Home टैब का चयन कर� > Cells > Format > Cell Size > �तंभ का चयन कर�

2. �तंभ का चयन कर� > Home टैब > Cells > Format > Cell Size > Column height

3. �तंभ का चयन कर� > Home टैब > Cells > Format > Cell Size > Column width

4. Cells> परूा डटेा चयन कर� > Home टैब > Format > Cell Size > Row height

Question Type : MCQ
Question ID : 61827894

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.5 MS-Word म� चय�नत पाठ के फ़ॉ�ट आकार को बढ़ाने का शॉट�-कट कमांड �या है?

Ans 1. Ctrl + ]

2. Ctrl + -

3. Ctrl + +

4. Alt + [

Question Type : MCQ
Question ID : 61827877

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.6 MS-Word म�, सपुरि���ट को स��य / �नि��य करने का शॉट�-कट __________ है।
Ans 1. Ctrl + Shift + -

2. Alt + Shift + +

3. Ctrl + Shift + =

4. Alt + Shift + =

Question Type : MCQ
Question ID : 61827878

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.7 �लाउड कं�य�ूटगं के बारे म� �न�न�ल�खत म� से कौन सा कथन सह� है?

Ans 1. यह इंटरनेट से जड़ुने क� आव�यकता को समा�त करता है।

2. इसम� मौसम पवूा�नमुान शा�मल है।

3. यह केवल फाइल� को हो�ट करने क� स�ुवधा देता है, �ो�ाम� को नह�ं।
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4. इसम� वेबसव�र पर हो�ट क� गई फ़ाइल�/�ो�ाम� के साथ काम करना शा�मल है।

Question Type : MCQ
Question ID : 618278120

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.8 MS-Word म� �न�न�ल�खत म� से कौन सा �वक�प प�ृठ �वराम का भाग नह�ं है?

Ans 1. �तंभ (कॉलम)

2. प�ृठ

3. टे��ट रै�पगं

4. सम प�ृठ (ईवन पेज)

Question Type : MCQ
Question ID : 61827880

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.9 MS-Excel 2016 म� “Formulas” मेन ूम� �न�न�ल�खत म� से कौन एक ता�क� क (लॉिजकल) फ़ं�शन नह�ं
है?

Ans 1. AND

2. NOT

3. DATE

4. IF

Question Type : MCQ
Question ID : 618278107

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.10 MS-Word 2016 म� E-postage का �वक�प ______ से चनुा जा सकता है।
Ans 1. File > Options > E-Postage

2. Review > Tracking > E-postage

3. Mailings > Labels > E-Postage

4. View > Outline > E-postage

Question Type : MCQ
Question ID : 61827888

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.11 MS-Excel के प�ृठ लेआउट टैब म� �न�न�ल�खत म� से कौन वधै प�ृठ आकार नह�ं है?

Ans 1. A4

2. Executive (ए�जी�य�ूटव)

3. Landscape (ल��सकेप)
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4. Legal (ल�गल)

Question Type : MCQ
Question ID : 61827898

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.12 �न�न�ल�खत म� कौन एक इनपटु उपकरण नह�ं है?

Ans 1. माइ�ोफ़ोन

2. जॉयि�टक

3. �कैनर

4. �पीकर

Question Type : MCQ
Question ID : 61827863

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.13 MS-PowerPoint 2016 के ��य मेन ूम� ‘New Window’ �वक�प का �या उ�े�य होता है?

Ans 1. �कसी अ�य �वडंो म� MS-Excel क� दसूर� फ़ाइल खोलना

2. उसी �वडंो म� एक और MS-Word क� फ़ाइल खोलना

3. उसी ��त�ुत को दसूर� �वडंो म� खोलना

4. परू� तरह से नई �र�त ��त�ुत खोलना

Question Type : MCQ
Question ID : 618278114

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.14 MS-Excel 2016 म�, ‘Lock cell’ �वक�प �कस मेन ू/ टैब म� होता है?

Ans 1. Data (डाटा)

2. Page layout (पेज लेआउट)

3. Home (होम)

4. File (फाइल)

Question Type : MCQ
Question ID : 61827896

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.15 कंपाइलर का �योग ______ प�रव�त�त करने के �लए �कया जाता है।
Ans 1. असे�बल� भाषा को मशीन भाषा म�

2. मशीन भाषा को असे�बल� भाषा म�

3. उ�च-�तर भाषा कोड को मशीन भाषा म�
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4. अन�ुयोग सॉ�टवेयर को �स�टम सॉ�टवेयर म�

Question Type : MCQ
Question ID : 61827869

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.16 MS-Word 2016 म� मेल मज� म� हम मेरे लेबल (my labels) म� �ा�फ़क या लोगो कैसे जोड़ सकत ेह�?
Ans 1. Mailings टैब म� Create समहू म� Labels पर ि�लक कर�।

2. Insert टैब के Illustrations group म� WordArt पर ि�लक कर�।

3. Page Layout टैप के page Background समहू म� Page color पर ि�लक कर�।

4. Insert टैब के Illustrations group म� Picture पर ि�लक कर�।

Question Type : MCQ
Question ID : 61827886

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.17 MS-Excel म� पाठ का रंग बदलने के �लए �न�न �वक�प� म� से �कसका उपयोग �कया जाता है?

Ans 1. Font color (फ़ॉ�ट कलर)

2. Bold Function (बो�ड फ़ं�शन)

3. Fill color (फ�ल कलर)

4. Insert cell color (इ�सट� सलै कलर)

Question Type : MCQ
Question ID : 618278102

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.18 �न�न म� से कौन एक सह� IP पता नह�ं है?

Ans 1. 3.3.3.3

2. 2189.12.30.45

3. 420.180.0.45

4. 392.148.11.12

Question Type : MCQ
Question ID : 618278119

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.19 MS-Word म� एक नई फ़ाइल बनाने के �लए �कस फ़ं�शन का उपयोग �कया जाता है?

Ans 1. Save as

2. Save

3. Open
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4. New

Question Type : MCQ
Question ID : 61827875

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.20 कं�यटूर का IP पता बदलने के �लए, हम� �न�न�ल�खत म� से �कस �वक�प पर राइट-ि�लक करना होगा?
Ans 1. My Network Places (माई नेटवक�  �लेस)

2. My Computer (माई क��यटूर)

3. Recycle Bin (र�सायकल बीन)

4. My Documents (माई डॉ�यमू�ट)

Question Type : MCQ
Question ID : 61827871

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.21 MS-Word 2016 द�तावेज़ म� �कस मेन ूसे हम ��ेडशीट जोड़ सकत ेह�?
Ans 1. Insert > Chart

2. Home > SmartArt

3. Insert > Table

4. Insert > Shapes

Question Type : MCQ
Question ID : 61827884

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.22 MS-Word म�, ��टं फ़ं�शन के �लए �न�न�ल�खत म� से कौन एक उपल�ध से�टगं नह�ं है?

Ans 1. हा�शये (मािज�न)

2. फ़ॉ�ट रंग बदल�

3. ��तय� क� सं�या

4. अ�भ�व�यास (ओ�रएंटेशन)

Question Type : MCQ
Question ID : 61827879

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.23 MS-Excel म�, �कस मेन ूसे WordArt �तीक� को जोड़ा जा सकता है?

Ans 1. Page layout (पेज लेआउट)

2. Insert (इ�सट�)

3. Add in (ऐड इन)
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4. Home (होम)

Question Type : MCQ
Question ID : 618278109

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.24 �दए गए �वक�प� म� से कौन, मेल मज� क� ���या म� शा�मल द�तावेज� को �दखा रहा है?

Ans 1. म�ुय द�तावेज़, डटेा �ोत, आ�ंशक द�तावेज़

2. मा�टर काड�, डटेा �ोत, मज� �कए गए द�तावेज़

3. मज� फ़ाइल, डटेा उपयोगकता�, मज� �कए गए द�तावेज़

4. म�ुय द�तावेज़, डटेा �ोत, मज� �कए गए द�तावेज़

Question Type : MCQ
Question ID : 61827889

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.25 एक समहू म� पाँच आइटम ह�, िजनम� से ��येक, समहू के कुल मान के �लए कुछ मान का योगदान करत ेह�।
��येक आइटम के योगदान को ��तशत म� �दखाने के �लए �कस �कार का चाट� सबसे उपय�ुत होगा?

Ans 1. पाई चाट�

2. दंड (बार) चाट�

3. पंि�त (लाइन) चाट�

4. �ह�टो�ाम

Question Type : MCQ
Question ID : 618278108

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.26 IBM 360 ______ का एक �कार है।
Ans 1. ऑपरे�टगं �स�टम

2. �ोसेसर

3. अन�ुयोग (ए�ल�केशन) सॉ�टवेयर

4. वेब �ाउज़र

Question Type : MCQ
Question ID : 61827867

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.27 A person is working on two MS-Excel workbooks simultaneously. He wants both
workbooks in single window to compare them. Which function is used to do so?

Ans 1. Arrange all in View tab

2. Insert sheet
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3. Zoom to selection option in View tab

4. Organise sheets in Home tab

Question Type : MCQ
Question ID : 61827895

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.28 पंजी (रिज�टर) �न�न�ल�खत म� से �कसका एक भाग है?

Ans 1. �ोसेसर

2. आउटपटु उपकरण

3. हाड� �ड�क

4. इनपटु उपकरण

Question Type : MCQ
Question ID : 61827862

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.29 MS-Word म�, एक ता�लका (टेबल) म� Cell margin को �कस मेन ूसे चनुा जा सकता है?

Ans 1. View (�य)ू

2. Design (�डज़ाइन)

3. Layout (लेआउट)

4. File (फाइल)

Question Type : MCQ
Question ID : 61827876

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.30 �लाइड सॉट�र ��य म�, �न�न�ल�खत काय� म� से कौन सा काय� चय�नत �लाइड के साथ नह�ं �कया जा सकता
है?

Ans 1. नई �लाइड जोड़ना

2. एक अनभुाग जोड़ना

3. ता�लका जोड़ना

4. �व�प प�ृठभ�ूम म� प�रवत�न

Question Type : MCQ
Question ID : 618278113

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.31 MS-Excel म� ‘MIN’ फ़ं�शन के �योग का �या उ�े�य होता है?

Ans 1. चय�नत डटेा म� �यनूतम मान क� गणना करना
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2. चय�नत मान� के मा�य क� गणना करना

3. समय �ा�प म� �मनट मान दज� करना

4. चय�नत मान� के योग क� गणना करना

Question Type : MCQ
Question ID : 618278105

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.32 पहल� पीढ़� के कं�यटूर म� �न�न�ल�खत म� से �कस इनपटु/आउटपटु उपकरण का उपयोग �कया गया था?
Ans 1. मॉ�नटर

2. �लॉटर

3. पंच काड�

4. क�बोड�

Question Type : MCQ
Question ID : 61827864

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.33 Windows म� सॉ�टवेयर क� �थापना �नद��शकाओ ंके �लए �डफ़ॉ�ट �थान ______ है।
Ans 1. E:\Program Files

2. C:\Program Files

3. Program Files:\new installation

4. D:\Program Files

Question Type : MCQ
Question ID : 61827874

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.34 वष� 2018 पर��ा के �लए 100 छा�� के अकं� का डटेा �दया है। समान अकं �ा�त करने वाले छा�� का चयन
करना है। Excel म� इसके �लए �कस फ़ं�शन का उपयोग �कया जाएगा?

Ans 1. Color scales

2. Home मेन ूम� Sort

3. Find & select

4. Highlight cells rule

Question Type : MCQ
Question ID : 61827893

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.35 Which of the following actions can be done using the “Format Cell” option of Home
tab to protect the worksheet in MS-Excel 2016?

Ans
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1. Protect sheet

2. Freeze Rows

3. Protect data

4. Encrypt cells

Question Type : MCQ
Question ID : 61827897

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.36 MS-Excel 2016 के Home मेन ूम� “Delete” टैब का उपयोग करके कौन सा काय� नह�ं �कया जा सकता है?

Ans 1. क� हटाना

2. प�क हटाना (�डल�ट करना)

3. फ़ाइल हटाना

4. प�क पंि�त हटाना

Question Type : MCQ
Question ID : 61827892

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.37 �थानीय (लोकल) �ाइव और सव�र �थान (�पेस) से बड़ी डटेा फ़ाइल के पर�पर �थानांतरण के �लए �न�न म� से
कौन सा सम�प�त (डडेीके�टड) �ोटोकॉल है?

Ans 1. HTTP

2. SMTP

3. FTP

4. HTTPS

Question Type : MCQ
Question ID : 618278118

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.38 MS-Excel 2016 म�, �कस फ़ं�शन �वारा हम पासवड� क� सहायता से काय�प�क म� नई पंि�तय� और �तंभ�
का जोड़ना रोक सकत ेह�?

Ans 1. View मेन ू> Window समहू > Switch window

2. Review मेन ू> Changes समहू > Protect Workbook

3. Review मेन ू> Changes समहू > Protect Sheet

4. Data मेन ू> Outline उपसमहू > Ungroup

Question Type : MCQ
Question ID : 618278104

Status : Answered
Chosen Option : 3

Marks : 1.00
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Q.39 जब हम Windows OS पर काम करत ेह�, तो ���न / ड�ेकटॉप के नीचे ि�थत प�ी (बार) को, जहाँ �स�टम
क� तार�ख और समय �दखाई देता है, �या कहा जाता है?

Ans 1. काय� प�ी (टा�क बार)

2. काय� फलक

3. मखु प�ृठ बटन

4. मेन ूबार

Question Type : MCQ
Question ID : 61827870

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.40 MS-PowerPoint 2016 म�, �न�न�ल�खत म� से कौन सा मेन ू�लाइड� के बीच ग�त�व�ध हेत ु�वक�प �दान
करता है?

Ans 1. Transition (�ांिज़शन)

2. View (�य)ू

3. Design (�डज़ाइन)

4. Home (होम)

Question Type : MCQ
Question ID : 618278115

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.41 MS-Excel म� “Wrap Text” कमांड का �या उ�े�य है?

Ans 1. क�� को एक क� म� �वलय (मज�) करना।

2. पाठ म� पंि�तय� क� सं�या �गनना।

3. पंि�तय� को �तंभ� म� बदलना।

4. अ�त�र�त-लंबे पाठ को कई पंि�तय� म� समायोिजत करना, िजससे आपको परूा पाठ �दख सके।

Question Type : MCQ
Question ID : 618278100

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.42 एक कंपनी �ाहक� को 6 अलग-अलग तरह क� व�तओु ंक� पेशकश करती है। �ब�� �बंधक अपने पय�वे�क के
सामने एक ��त�ुत के दौरान ��येक व�त ुके �लए एक �लाइड बनाकर �दखाता है। पय�वे�क तलुना करने के
�लए सभी �लाइड� को एक �वडंो म� देखना चाहता है। �ब�� �बंधक को �न�न�ल�खत म� से �कस फ़ं�शन का
�योग करना चा�हए?

Ans 1. Slide Zoom (�लाइड ज़मू)

2. Summary Zoom (स�मर� ज़मू)

3. Slide Sorter (�लाइड सॉट�र)

4. Slide Size (�लाइड साइज)

Question Type : MCQ
ANKAJ INFOTECH
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Question ID : 618278112
Status : Answered

Chosen Option : 4
Marks : 0.00

Q.43 कौन सा फ़ाइल सॉट�र ��य, हम� �कसी फ़ो�डर म� फ़ाइल नाम के साथ सभी फ़ाइल� का फ़ाइल आकार जानने म�
मदद करता है?

Ans 1. List (�ल�ट)

2. Large icons (लाज� आइकॉन �ल�ट टाइ�स)

3. Tiles (टाइ�स)

4. Details (�डटे�स)

Question Type : MCQ
Question ID : 61827873

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.44 फ़म�वेयर �न�न�ल�खत म� से �कसम� सं�ह�त होता है?

Ans 1. केवल पठनीय �म�ृत (ROM)

2. या�ि�छक अ�भगम �म�ृत (RAM)

3. हाड� �ड�क

4. कैश �म�ृत

Question Type : MCQ
Question ID : 61827861

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.45 MS-Excel 2016 काय�पिु�तका म� �कस टैब / मेन ूका उपयोग कर एक नए प�क (शीट) को जोड़ा जा सकता
है?

Ans 1. View (�य)ू

2. Home (होम)

3. Insert (इ�सट�)

4. Page layout (पेज लेआउट)

Question Type : MCQ
Question ID : 61827891

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.46 MS-Word म� ‘�फर से कर� (र�-डू)’ / ‘दोहराएँ (�रपीट)’ कार�वाई का शॉट�कट �या है?

Ans 1. Ctrl + X

2. Ctrl + Y

3. Ctrl + C

4. Ctrl + Z
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Question Type : MCQ
Question ID : 61827882

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.47 �न�न म� से कौन MS-Excel का एक सह� क� पता (सलै ए�से) नह�ं है?

Ans 1. AS2

2. B4

3. 4F

4. Z582

Question Type : MCQ
Question ID : 61827890

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.48 �न�न�ल�खत म� से कौन एक “smart art” �ा�फक नह� ंहै?

Ans 1. Pyramid (�परा�मड)

2. Matrix (म�ै��स)

3. Object (ऑ�जे�ट)

4. List (�ल�ट)

Question Type : MCQ
Question ID : 618278110

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.49 मेल मज� के संबंध म�, �या हम ई-मेल संदेश के �वषय बॉ�स (स�जे�ट बॉ�स) म� मज� फ़��ड का उपयोग कर
सकत ेह�?

Ans 1. नह�ं, हम ई-मेल संदेश के �वषय बॉ�स म� केवल पाठ टाइप कर सकत ेह�।

2. हा,ँ हम ई-मेल संदेश के �वषय बॉ�स म� केवल पाठ टाइप कर सकत ेह�।

3. हम ई-मेल संदेश के �वषय बॉ�स म� लेबल बना सकत ेह�।

4. हम �वषय बॉ�स म� �लफ़ाफ़े (ए�वेल�स) बना सकत ेह�।

Question Type : MCQ
Question ID : 61827885

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.50 MS-PowerPoint 2016 म�, �न�न�ल�खत म� से कौन होम टैब का एक फ़ं�शन नह�ं है?

Ans 1. Find (फाइंड)

2. New slide (�य ू�लाइड)

3. Section option (स��शन �वक�प)

4. Slide design (�लाइड �डज़ाइन)
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Question Type : MCQ
Question ID : 618278111

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.51 ब��कंग उ�योग �वारा द�तावेज़� क� मौ�लकता क� पिु�ट करने के �लए �न�न�ल�खत म� से �कस उपकरण का
�योग �कया जाता है?

Ans 1. OCR

2. MICR

3. चेक कोड र�डर

4. OMR

Question Type : MCQ
Question ID : 61827865

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.52 �न�न�ल�खत म� से कौन सा �वक�प अन�ुयोग (ए�ल�केशन) सॉ�टवेयर का एक उदाहरण है?

Ans 1. Unix

2. Microsoft Windows

3. Linux

4. VLC मी�डया �लेयर

Question Type : MCQ
Question ID : 61827866

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.53 If a formula is copied from one cell to another, then which symbol is used for absolute
cell referencing (location of specific cell) in MS-Excel?

Ans 1. @

2. $

3. :

4. =

Question Type : MCQ
Question ID : 618278106

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.54 MS-Excel म� 20 कंप�नय� का डटेा है जो कंपनी का नाम और उनके �वारा उ�पा�दत इकाइय� क� सं�या
�दखाता है। कंप�नय� को उ�पा�दत इकाइय� क� सं�या के अवरोह� �म म� �यवि�थत �कया गया है। कंपनी के
नाम से वण�माला �म म� डटेा को �यवि�थत करने के �लए �कस फ़ं�शन का उपयोग �कया जाएगा?

Ans 1. Sort largest to smallest (सॉट� लाज��ट टू �माले�ट)

2. Sort (सॉट�)
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3. Custom Filter (क�टम �फ़�टर)

4. Go to (गो टू)

Question Type : MCQ
Question ID : 618278101

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.55 MS-Word म�, बलेुट और सं�यांकन फ़ं�शन के बारे म� �न�न�ल�खत म� से कौन सा कथन गलत है?

Ans 1. सं�यांकन �वक�प का उपयोग करके, हम चय�नत डटेा को अ�र �न�द��ट नह�ं कर सकत ेह�।

2. सं�यांकन �वक�प का उपयोग करके हम चय�नत डटेा को अ�र भी �न�द��ट कर सकत ेह�।

3. बलेुट �वक�प का उपयोग करके हम चय�नत डटेा को अ�र �न�द��ट नह� ंकर सकत ेह�।

4. 'Bullet' और 'Numbering' दोन� �वक�प� को होम मेन ूसे चनुा जा सकता है।

Question Type : MCQ
Question ID : 61827881

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.56 MS-Word म� वत�नी और �याकरण क� गल�तय� क� जाँच के �लए, �न�न�ल�खत म� से �कस फ़ं�शन कंुजी का
उपयोग �कया जाता है?

Ans 1. F5

2. F6

3. F8

4. F7

Question Type : MCQ
Question ID : 61827883

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.57 MS-Word 2016 म� एक नई मेल मज� सचूी बनाने के �लए चरण� का सह� �म �या है?

Ans 1. Mailings > Select Recipients > Type New List

2. Mailings > Start Mail Merge > Labels

3. Review > Select Recipients > Type New List

4. Mailings > Start Mail Merge > Type New List

Question Type : MCQ
Question ID : 61827887

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.58 एक �बंधक अपनी कंपनी के कुछ डटेा को MS-Excel 2016 काय�पिु�तका म� दज� करता है और अपने
अधीन�थ� को काय�पिु�तका �दखाना चाहता है, ले�कन चाहता है �क वे उस काय�पिु�तका को केवल पढ़ सक� ,
उसम� कोई प�रवत�न न कर सक� । उ�ह� �न�न�ल�खत म� से �कस �वक�प का उपयोग करना चा�हए?
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1. Insert मेन ूके उप-मेन ूProtect workbook म� Hide का चयन कर�।

2. File मेन ूके उप-मेन ूProtect workbook म� Mark as Final का चयन कर�।

3. Data मेन ूम� Connection का चयन कर�।

4. Page Layout से Page Setup समहू म� Background का चयन कर�।

Question Type : MCQ
Question ID : 618278103

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.59 24 क�� (4 पंि�तय� और 6 �तंभ�) म� छा�� के अकं� का एक आ�यहू (म�ै��स) है। केवल 4 क�� (4 पंि�तयाँ
और 1 �तंभ) का एक नया आ�यहू बनाने के �लए सभी पंि�तय� के सभी 6 �तंभ� को �मलाना (मज� करना) है।
इसके �लए MS-Excel म� कौन सी कमांड उपल�ध है?

Ans 1. Unmerge cells (अनमज� सलै)

2. Merge cells (मज� सलै)

3. Merge and Center (मज� एंड स�टर)

4. Merge across (मज� अ�ॉस)

Question Type : MCQ
Question ID : 61827899

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.60 �न�न�ल�खत म� से कौन एक �कार का इंटरनेट कने�शन है जो इंटरनेट से जड़ुने के �लए �योग �कया जाता
है?

Ans 1. SMPT

2. POP

3. डायलअप

4. ZIP

Question Type : MCQ
Question ID : 618278117

Status : Answered
Chosen Option : 2

Marks : 0.00
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Q.1 �न�न�ल�खत म� से कौन एक �स�टम सॉ�टवेयर क� �वशषेता नह�ं है?

Ans 1. श�ेय�ूलगं

2. मेमोर� मनेैजम�ट (�बंधन)

3. फाइल �बंधन

4. �ब�लगं

Question Type : MCQ
Question ID : 6182787

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.2 �न�न�ल�खत म� से कौन एक वेब �ाउज़र नह�ं है?

Ans 1. माइ�ोसॉ�ट �बगं

2. इंटरनेट ए���लोरर

3. गूगल �ोम

4. नेट�केप

Question Type : MCQ
Question ID : 61827856

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.3 MS-Excel 2016 म� नई ��ेडशीट डालने के �लए उपय�ुत चरण� का सह� �म �या है?

Ans 1. Insert > Home > Insert Sheet

2. Home > Insert sheet > Insert

3. Home > Insert > Insert sheet

4. Insert Sheet > Home > Insert

Participant ID 19317001
Participant Name RAM AWATAR PRASAD
Test Center Name iON Digital Zone iDZ 1 Patliputra
Test Date 27/11/2019
Test Time 9:00 AM - 10:00 AM
Subject Data Entry Operator
Marks Obtained 18.00000

Section : MCQ for Data Entry Operator
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Question Type : MCQ
Question ID : 61827830

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.4 �न�न �ोटोकॉल म� से �कसका उपयोग बड़ी डटेा फ़ाइल� के ह�तांतरण के �लए �कया जाता है?

Ans 1. SMTP

2. HTTPS

3. HTTP

4. FTP

Question Type : MCQ
Question ID : 61827858

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.5 MS-Excel 2016 ��ेडशीट म� �कसी पंि�त क� ऊंचाई बढ़ाने या घटाने के उपय�ुत चरण� के अन�ुम को
पहचान�।

Ans 1. Row Height > Select the row > Home tab > Cells > Format > Cell Size

2. Select the row > Home tab > Cells > Format > Cell Size > Row Height

3. Cells > Select the row > Home tab > Format > Cell Size > Row Height

4. Select the row > Format > Home tab > Cells > Cell Size > Row Height

Question Type : MCQ
Question ID : 61827834

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.6 �न�न�ल�खत म� से कौन सा सह� IP पता नह�ं है?

Ans 1. 1986.12.30.45

2. 1.1.1.1

3. 120.160.0.15

4. 192.168.1.120

Question Type : MCQ
Question ID : 61827859

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.7 MS-Excel 2016 म� �न�न म� से �कस टैब से '��ज पनै' �वक�प चनुा जा सकता है?

Ans 1. डटेा

2. �यू

3. फामू�ला

4. इ�सट�
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Question Type : MCQ
Question ID : 61827835

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.8 MS-Excel 2016 क� '��ाइक�'ू स�ुवधा को ________ टैब के "फ़ॉ�ट" कमांड समहू से चनुा जा सकता है।
Ans 1. �डज़ाइन

2. फ़ाइल

3. होम

4. ि�वक ए�सेस टूलबार

Question Type : MCQ
Question ID : 61827838

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.9 MS-Excel 2016 ��ेडशीट म� �र�त स�ैस (क��) को सि�म�लत करने के उपय�ुत चरण� क� पहचान कर�।
Ans 1. चय�नत स�ैस पर ले�ट ि�लक कर� और शॉट�कट मेन ूपर इ�सट� पर ि�लक कर�।

2. होम टैब पर, सेल �ुप म�, इ�सट� के बाद एरो पर ि�लक कर� और तब इ�सट� स�ैस पर ि�लक कर�।

3. चय�नत स�ैस पर डबल ि�लक कर� और शॉट�कट मेन ूपर इ�सट� पर ि�लक कर�।

4. चय�नत स�ैस पर �सगंल-ि�लक कर� और शॉट�कट मेन ूपर इ�सट� पर ि�लक कर�।

Question Type : MCQ
Question ID : 61827833

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.10 MS-PowerPoint �ेज�टेशन म� अगल� �लाइड पर जाने के �लए समय अतंराल को ठ�क करने के �लए �न�न
म� से �कस मेन ूका उपयोग �कया जाता है?

Ans 1. �डज़ाइन

2. इ�सट�

3. �र�यु

4. �ांजीशन

Question Type : MCQ
Question ID : 61827855

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.11 MS-Excel सलै म� टे��ट के �ै�तज संरेखण के �लए �कतने �वक�प उपल�ध होत ेह�?
Ans 1. 7

2. 8

3. 5

4. 6
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Question Type : MCQ
Question ID : 61827839

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.12 �न�न�ल�खत म� से कौन एक इनपटु �डवाइस है?

Ans 1. �कैनर

2. मॉ�नटर

3. ��टंर (म�ुक)

4. �लॉटर

Question Type : MCQ
Question ID : 6182783

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.13 एि�लकेशन �वडंो के शीष� पर ि�थत वो बार जो एि�लकेशन �ो�ाम का नाम �दखाता है, उसे ______ कहा
जाता है।

Ans 1. नेम बार

2. टाइटल बार

3. �टेटस बार

4. टा�क बार

Question Type : MCQ
Question ID : 61827810

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.14 MS-Excel म� हम एक सलै से दसूरे सलै म� �कसी फॉमू�ले को कैसे कॉपी कर सकत ेह�?
Ans 1. �हाट-इफ एना�ल�सस का उपयोग करके

2. कॉपी और पे�ट फ़ं�शन का उपयोग करके

3. डटेा वे�लडशेन के �वारा

4. कंडीशनल फोमा��टगं का उपयोग करके

Question Type : MCQ
Question ID : 61827846

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.15 य�द MS-Excel म� �कसी एकल सलै म� 2 स�ैस के टे��ट को एक साथ रखने क� आव�यकता है, तो हम
�कसका उपयोग करत ेह�?

Ans 1. Italic (इटै�लक)

2. Wrap text ( रैप टे��ट)

3. Merge & Center (मज� ए�ड स�टर)
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4. Bold (बो�ड)

Question Type : MCQ
Question ID : 61827840

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.16 मेल मज� के �लए डटेा तयैार करने के संबंध म� �न�न�ल�खत म� से कौन सह� नह�ं है?

Ans 1. ��ेडशीट म� पो�टल कोड डटेा को सह� ढंग से �व��पत �कया गया है ता�क वड�, व�ैय ूको ठ�क से पढ़
सके

2. आपक� ��डैशीट म� कॉलम नाम फ़��ड के उन नाम� से मेल खात ेह� िज�ह� आप अपने लेबल म�
सि�म�लत करना चाहत ेह�।

3. मज� �कए जाने वाले सभी डटेा आपक� ��डैशीट क� अ�ंतम शीट म� मौजदू ह�।

4. मेल मज� म� उपयोग क� जाने वाल� ए�सेल ��ेडशीट आपके लोकल मशीन पर �टोर होती है

Question Type : MCQ
Question ID : 61827828

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.17 MS-PowerPoint 2016 के इ�सट� मेन ूसे �न�न�ल�खत म� से कौन सा �ा�त नह�ं जा सकता है?

Ans 1. �माट� आट�

2. चाट�

3. एनीमेशन

4. टे��ट बॉ�स

Question Type : MCQ
Question ID : 61827852

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.18 Microsoft Word 2016 सं�करण म� ‘लेआउट’ �वक�प ______ म� पाया जाता है।
Ans 1. मेन ूबार

2. टूल बार

3. टाइटल बार

4. टा�क बार

Question Type : MCQ
Question ID : 61827815

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.19 MS-Word 2016 सं�करण म� केस प�रवत�न के �कतने �वक�प उपल�ध ह�?
Ans 1. 4

2. 5
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3. 3

4. 6

Question Type : MCQ
Question ID : 61827820

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.20 �न�न�ल�खत म� से कौन �माट� आट� �ा�फक नह�ं है?

Ans 1. हायराक�

2. वड� आट�

3. साइ�कल

4. �रलेशन�शप

Question Type : MCQ
Question ID : 61827850

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.21 कमांड मोड से �कसी सॉ�टवेर को अन-इन�टॉल करने के �लए पहला कमांड �या होता है?

Ans 1. diskpart

2. wmic

3. ipconfig

4. get product name

Question Type : MCQ
Question ID : 61827814

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.22 �वडंोज ऑपरे�टगं �स�टम म�, 'एड ए �य ूहाड�वेयर' (‘Add a new hardware’) �वक�प कहाँ �मलता है?

Ans 1. मेन ूबार

2. टा�क बार

3. कं�ोल पनैल

4. मेन मेनू

Question Type : MCQ
Question ID : 61827811

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.23 MS-Excel म� �कस फ़ं�शन का उपयोग करके डुि�लकेट मान� को हाइलाइट �कया जा सकता है?

Ans 1. Find (फाइंड)

2. Merge & Center (मज� ए�ड स�टर)
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3. Format (फॉरमेट)

4. कंडीशनल फॉम��टगं

Question Type : MCQ
Question ID : 61827841

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.24 माइ�ोसॉ�ट वड� 2016 म� �डफ़ॉ�ट फ़ॉ�ट आकार �या है?

Ans 1. 11

2. 13

3. 12

4. 10

Question Type : MCQ
Question ID : 61827821

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.25 मेल मज� म� डटेा �ोत का ए�सट�शन �या है:

Ans 1. .exe

2. .mis

3. .services

4. .mdb

Question Type : MCQ
Question ID : 61827827

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.26 Windows XP म� एक फ़ाइल को हटाने के बाद हम इसे पनुः कहाँ से �ा�त कर सकत ेह�?
Ans 1. �डल�टेड आइटम फ़ो�डर से

2. भ�व�य के �लए से�ड फ़ो�डर से

3. �ैश फ़ो�डर से

4. र�सायकल �बन से

Question Type : MCQ
Question ID : 61827813

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.27 MS-PowerPoint म� एक बार म� सभी �लाइ�स देखने के �लए �न�न म� से �कसका उपयोग �कया जाता है?

Ans 1. र��डगं �यू

2. नो�स पेज �यू
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3. �लाइड शो �यू

4. �लाइड सॉट�र �यू

Question Type : MCQ
Question ID : 61827853

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.28 Microsoft-Word म� �कसी डॉ�यमू�ट को सेव करने का शॉट�कट ______ है।
Ans 1. Alt + R

2. Alt + S

3. Ctrl + R

4. Ctrl + S

Question Type : MCQ
Question ID : 61827817

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.29 MS-PowerPoint 2016 के �कस मेन ूम� "�य ू�लाइड" �वक�प उपल�ध होता है?

Ans 1. होम

2. �लाइड शो

3. �डज़ाइन

4. �यू

Question Type : MCQ
Question ID : 61827851

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.30 कं��लायर एक भाषा �ोसेसर है जो ______ है।
Ans 1. एक �कार का एि�लकेशन सॉ�टवेयर है

2. संपणू� �ोत कोड को �न�पादन यो�य मशीन कोड म� प�रव�त�त करता है

3. एक �कार का ऑपरे�टगं �स�टम है

4. एक �ोत काय��म पढ़ता है और जसेै ह� यह ��येक पंि�त के संपक�  म� आता है, उसका अनवुाद करने
के बाद उसे लाइनवार चलाता है

Question Type : MCQ
Question ID : 6182789

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.31 MS-Excel म� ��ेडशीट का नाम बदलने के �लए �न�न�ल�खत म� से �कस तर�के का उपयोग �कया जा सकता
है?

Ans 1. शीट टैब पर ले�ट-ि�लक कर�, �रनेम पर ि�लक कर� और एक नया नाम �लख�।
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2. शीट टैब पर राइट-ि�लक कर�, �रनेम पर ि�लक कर�, और एक नया नाम टाइप कर�।

3. शीट टैब पर राइट-ि�लक कर� और �डल�ट का चयन कर�।

4. तरंुत नाम बदलने के �लए शीट टैब पर शीट नेम पर �सगंल-ि�लक कर�।

Question Type : MCQ
Question ID : 61827831

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.32 �न�न�ल�खत म� से कौन ऑपरे�टगं �स�टम क� काया��मकता से सबसे अ�धक �नकटता से संबं�धत है?

Ans 1. फम�वेयर

2. हाड�वेयर

3. असे�बलर

4. कन�ल

Question Type : MCQ
Question ID : 6182781

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.33 MS-Word 2016 म� '�पे�लगं एंड �ामर' �वक�प खोलने के �लए ____________ टैब पर जाएं।
Ans 1. फ़ाइल

2. रेफेर�स

3. �र�यु

4. �यू

Question Type : MCQ
Question ID : 61827823

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.34 माइ�ोसॉ�ट वड� म� �कसी सेले�टेड आइटम को मॉ�डफाई (संशो�धत) करने के �लए हम _______ कंुिजय� का
उपयोग करत ेह�।

Ans 1. Ctrl + arrow

2. Shift + arrow

3. Alt + arrow

4. Tab + arrow

Question Type : MCQ
Question ID : 61827822

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.35 मेल मज� �कसी सचूी (�ल�ट) के साथ द�तावेज़ �डज़ाइन के संयोजन क� ���या है जो सचूी म� ��येक ��वि�ट
के �लए द�तावेज़ क� कई ��तया ंबनाने क� ���या है। इस सचूी को ______ कहा जाता है।
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Ans 1. डटेा सोस�

2. मज� फ़��ड

3. डटेाबेस

4. मचै फ़���स

Question Type : MCQ
Question ID : 61827829

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.36 ________ एक �वशषे काय� करने के �लए बनाया गया एक तक� संगत �वशषे-�योजन सॉ�टवेयर है।
Ans 1. एडवेयर

2. �स�टम सॉ�टवेयर

3. मलैवेयर

4. ए�ल�केशन सॉ�टवेर

Question Type : MCQ
Question ID : 6182786

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.37 हम �वडंोज कं�यटूर क� तार�ख और समय कहां से बदल सकत ेह�?
Ans 1. �वडंो के शीष� दा�हने कोने से

2. �वडंो के ऊपर� बाएँ कोने

3. टा�कबार के �नचले दा� ओर से

4. टा�कबार के नीचे बा� ओर से

Question Type : MCQ
Question ID : 61827812

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.38 मेल मज� म� डॉ�यमू�ट के �कतने �कार ह�?
Ans 1. 5

2. 6

3. 4

4. 7

Question Type : MCQ
Question ID : 61827826

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.39 ऑपरे�टगं �स�टम के कन�ल मोड को स��य करने के �लए "मोड �बट" को ______ पर सेट �कया जाता है।
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1. 2

2. 0

3. 1

4. 9

Question Type : MCQ
Question ID : 6182782

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.40 A और B दो कंप�नयां ह�। इनके से�स डटेा को हम� तलुना के �लए एक �लाइड म� ��ततु करना है। इस काय� के
�लए �न�न�ल�खत म� से �कस फं�शन का उपयोग �कया जा सकता है?

Ans 1. ि�वक �टाइल

2. लेआउट

3. र�सेट

4. से�शन

Question Type : MCQ
Question ID : 61827854

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.41 MS-Word 2016 क� ता�लका म� सेल� क� सीमाओ ंको देखने के �लए �य�ुत चरण� का सह� �म �या है?

Ans 1. Select table > Table tools > Design > Borders

2. Select table > Borders > Table tools > Design

3. Select table > Table tools > Borders > Design

4. Select table > Design > Table tools > Borders

Question Type : MCQ
Question ID : 61827824

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.42 �न�न�ल�खत म� से कौन सा MS-Excel 2016 म� एक �कार का चाट� नह�ं है?

Ans 1. लाइन चाट�

2. पाई चाट�

3. बार चाट�

4. टे��ट बॉ�स चाट�

Question Type : MCQ
Question ID : 61827848

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.43 MS-Word 2016 म� ‘��टं’ �वक�प �कस मेन ूम� पाया जाता है?
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Ans 1. �डज़ाइन

2. फ़ाइल

3. �यू

4. इ�सट�

Question Type : MCQ
Question ID : 61827819

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.44 पहल� पीढ़� के कं�यटूर म� �कस �कार क� भाषा का उपयोग होता है?

Ans 1. C++

2. उ�च �तर�य भाषा

3. मशीन भाषा

4. असे�बल� भाषा

Question Type : MCQ
Question ID : 6182788

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.45 �न�न�ल�खत म� से कौन एक �कार का इंटरनेट कने�शन नह�ं है?

Ans 1. DSL

2. VSAT

3. ईथरनेट

4. डायल अप

Question Type : MCQ
Question ID : 61827857

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.46 माइ�ोसॉ�ट 2016 के �कस मेन ू/ टैब म� मेल मज� पाया जा सकता है?

Ans 1. रेफेर�स

2. मे�लगं

3. �र�यु

4. इ�सट�

Question Type : MCQ
Question ID : 61827825

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.47 MS-Excel शीट म� �कसी भी फॉमू�ले से पहले कौन सा संकेत इ�सट� �कया जाता है?
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1. =

2. (

3. /

4. ?

Question Type : MCQ
Question ID : 61827845

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.48 MS-Excel 2016 म� �कस मेन ूसे टेबल शा�मल �कये सकत ेह�?
Ans 1. �र�यु

2. इ�सट�

3. फ़ाइल

4. पेज लेआउट

Question Type : MCQ
Question ID : 61827849

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.49 �बना पासवड� डाले, �न�न�ल�खत म� से कौन सी ��याओ ंको पासवड� से सरु��त MS-Excel फाइल म� �कया
जा सकता है?

Ans 1. फ़ाइल खोलना ले�कन कंट�ट को देखने म� स�म नह�ं होना

2. नए डटेा को डालना

3. फ़ाइल खोलना और कंट�ट को र�ड-ओनल� मोड म� देखना

4. फ़ाइल खोलना और डटेा का संपादन करना

Question Type : MCQ
Question ID : 61827837

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.50 �न�न�ल�खत म� से कौन एक इनपटु �डवाइस का उदाहरण है?

Ans 1. माउस

2. ��टंर

3. �पीकर

4. �लॉटर

Question Type : MCQ
Question ID : 6182784

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.51 �लाउड कं�य�ूटगं ______ है।
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Ans 1. इंटरनेट पर कं�य�ूटगं सेवाओ ंक� �डल�वर�

2. बादल� म� डटेा बचाने क� तकनीक

3. एक केब�ड नेटवक�  �वारा कं�य�ूटगं सेवाओ ंक� �डल�वर�

4. ईमेल �वारा सेवाएं �दान करने क� तकनीक

Question Type : MCQ
Question ID : 61827860

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.52 MS-Excel 2016 के �कस मेन ूम� '�ोटे�ट वक� बकु (काय�पिु�तका को सरु��त रख�)' �वक�प उपल�ध होता है?

Ans 1. फ़ाइल

2. �यू

3. डटेा

4. पेज लेआउट

Question Type : MCQ
Question ID : 61827836

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.53 �कस फ़ं�शन �वारा हम MS-Excel 2016 म� वक� शीट म� नई शीट डालने से रोक सकत ेह�?
Ans 1. र�नेम वक� बकु

2. माक�  एज़ फाइनल

3. शयेर वक� बकु

4. �ोटे�ट करंट शीट

Question Type : MCQ
Question ID : 61827844

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.54 MS-Excel 2016 म� �कस मेन ूसे पासवड� के साथ एक वक� शीट एि���ट क� जा सकती है?

Ans 1. फ़ाइल

2. होम

3. डटेा

4. �र�यु

Question Type : MCQ
Question ID : 61827843

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.55 ‘सलै �टाइल’ मेन ूको MS-Excel 2016 म� �कस मेन ूम� सेले�ट �कया जा सकता है?
ANKAJ INFOTECH



1/27/2020 https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S1D11/15748637072359341/…

https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S1D11/15748637072359341/19317001… 15/16

Ans 1. �र�यु

2. इ�सट�

3. फोमु�लास

4. होम

Question Type : MCQ
Question ID : 61827842

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.56 MS-Excel म� ��ेडशीट म� सेल को संशो�धत करने/पनुः �लखने के उपय�ुत चरण� क� पहचान कर�?
Ans 1. सेल का चयन कर� और �सफ�  सह� ��वि�ट को �फर से �लख�

2. सेल का चयन कर� और ��टं कमांड द�

3. शीट का चयन कर� और �सफ�  सह� ��वि�ट को �फर से �लख�

4. शीट का चयन कर� और फ़ाइल मेन ूपर जाएं

Question Type : MCQ
Question ID : 61827832

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.57 आमतौर पर कं�यटूर क�-बोड� म� �कतने फं�शन क�ज़ (keys) होत ेह�?
Ans 1. 10

2. 8

3. 24

4. 12

Question Type : MCQ
Question ID : 6182785

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.58 MS-Excel म� �न�न�ल�खत म� से कौन फामू�ला मेन ूम� फं�शन क� �ेणी नह�ं है?

Ans 1. डटेा और समय

2. लॉिजकल

3. �पवट टेबल

4. �व�तीय

Question Type : MCQ
Question ID : 61827847

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.59 माइ�ोसॉ�ट वड� म� सबि���ट स��य / �नि��य करने का शॉट�कट_____________ है।
Ans ANKAJ INFOTECH
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1. Ctrl + -

2. Alt + -

3. Ctrl + =

4. Shift + =

Question Type : MCQ
Question ID : 61827818

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.60 "रन (Run)" डायलाग बॉ�स का उपयोग करके MS-Word को श�ु करने के �लए �कस कमांड का उपयोग
�कया जा सकता है?

Ans 1. winword.exe

2. msword.exe

3. mswin.exe

4. mswinword.exe

Question Type : MCQ
Question ID : 61827816

Status : Answered
Chosen Option : 2

Marks : 0.00
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Q.1 एम.एस. वड� 2016 म� मेल मज� के दौरान �न�न�ल�खत म� से कौन मज� �ॉसेस का एक चरण नह�ं है?

Ans 1. मेन डॉ�यमू�ट को फॉम�ट कर� (म�ुय द�तावेज़ का �व�पण)

2. मज� �रज��स का ���य ू(मज� मज� प�रणाम� का पवूा�वलोकन)

3. मेन डॉ�यमू�ट को आइड��टफाई कर� (म�ुय द�तावेज़ क� पहचान)

4. डटेा सोस� को फॉम�ट कर� (डटेा �ोत �व�पण)

Question Type : MCQ
Question ID : 618278329

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.2 �य ूऑ�शन एम.एस. वड� म� �कस टैब मे�य ूम� होता है?

Ans 1. होम टैब

2. इंसट� टैब

3. �रबन

4. फ़ाइल टैब

Question Type : MCQ
Question ID : 618278318

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.3 �न�न�ल�खत म� से कौन सा इंटरनेट पर कं�यटूर या सव�र का एक नाम है?

Ans 1. हो�ट

2. य.ूआर.एल.

3. लोकल मशीन

4. एफ.ट�.पी.

Participant ID 19437056
Participant Name AMIT KUMAR
Test Center Name iON Digital Zone iDZ Jalalpur
Test Date 30/11/2019
Test Time 3:00 PM - 4:00 PM
Subject Data Entry Operator
Marks Obtained 27.00000

Section : MCQ for Data Entry Operator
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Question Type : MCQ
Question ID : 618278358

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.4 अस�बल� भाषा ______ कोड का �योग करती है।
Ans 1. �नमो�न�स (Mnemonic)

2. दशमलव

3. ��वआधार� (बाइनर�)

4. मशीन

Question Type : MCQ
Question ID : 618278309

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.5 ए�सेल फ़ाइल पर पासवड� एि���शन को हटाने का �या तर�का है?

Ans 1. वक� बकु को खोलने के �लए पासवड� डालना और �फर पर�मशन > एि���ट �वद पासवड� बॉ�स म� बने
पासवड� को �डल�ट करना

2. फ़ाइल क� कॉपी बनाना

3. वक� बकु को �बना पासवड� के र�ड ओनल� और उसे �र-से�वगं के �प म� खोलना

4. वक� बकु को �ोटे�टेड �य ूम� खोलना और �बना पासवड� के उसे �र-से�वगं करना

Question Type : MCQ
Question ID : 618278344

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.6 ______ �वक�प से�स के चय�नत र�ज से कंट��स, फॉम��टगं इफे��स और कम��स को हटाता है।
Ans 1. �ल�यर कम��स

2. �ल�यर कंट��स

3. �ल�यर ऑल

4. �ल�यर फॉम��स

Question Type : MCQ
Question ID : 618278339

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.7 कं�यटूर को चलाने वाले मा�टर कं�ोल �ो�ाम (�न�णात �नयं�ण काय��म) ______ है।
Ans 1. ऑपरे�टगं �स�टम

2. कंपाइलर

3. इंटर�ेटर

4. अस�बलर
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Question Type : MCQ
Question ID : 618278306

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.8 एम.एस. ए�सेल म� �माट�आट� �वक�प ______ टैब म� होता है।
Ans 1. �र�यू

2. �डज़ाइन

3. इंसट�

4. होम

Question Type : MCQ
Question ID : 618278350

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.9 एम.एस. ए�सेल 2016 वक� बकु काय�पिु�तका को �न�न म� से �कस मेन ूसे संर��त �कया जा सकता है?

Ans 1. फ़ाइल एंड लेआउट

2. �य ूएंड फॉमू�ला

3. डटेा एंड �र�यू

4. फ़ाइल एंड �र�यू

Question Type : MCQ
Question ID : 618278337

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.10 एम.एस. पॉवरपॉइंट म� �ज�टेशन को राइट (�लखने) और �डजाइन (अ�भकि�पत) करने के �लए �कस �यू
(अवलोकन) का उपयोग �कया जाता है?

Ans 1. नो�स

2. �लाइड सॉट�र

3. नॉम�ल

4. �लाइड शो

Question Type : MCQ
Question ID : 618278353

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.11 �स�टम क� डटे (तार�ख) और टाइम (समय) को ______ म� देखा जा सकता है।
Ans 1. टाइटल बार

2. नो�ट�फकेशन ए�रया (अ�धसचूना �े�)

3. लाइ�ेर�

4. �टाट� मे�यू
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Question Type : MCQ
Question ID : 618278312

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.12 ��टेंड (म�ु�त) आउटपटु को ______ कहा जाता है।
Ans 1. सॉ�ट कॉपी

2. कॉपी

3. हाड� कॉपी

4. �ड��ले

Question Type : MCQ
Question ID : 618278319

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.13 एम.एस. ए�सेल म� आप दो बार ______ �वारा कॉलम क� चौड़ाई ऑटो�फ़ट कर सकत ेह�।
Ans 1. सेल बॉड�र पर ि�लक

2. रो लोअर बॉड�र पर ि�लक

3. रो अपर बॉड�र पर ि�लक

4. कॉलम हैडर का राइट बॉड�र पर डबल ि�लक

Question Type : MCQ
Question ID : 618278341

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.14 माइ�ोसॉ�ट वड� 2016 अ�ल�केशन (अन�ुयोग) ______ �डफ़ॉ�ट नाम के साथ एक नया डॉ�यमू�ट
(द�तावेज़) खोलता है।

Ans 1. डॉ�यमेु�ट1

2. बकु 1

3. बकु

4. डॉक1

Question Type : MCQ
Question ID : 618278316

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.15 ______ परेू �ो�ाम के �यमून र�डबेल मानव (पठनीय �ोत) कोड को मशीन ल��वेज (भाषा) कोड म� बदल देता
है।

Ans 1. कंपाइलर

2. ऑपरे�टगं �स�टम

3. इंटर�ेटर
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4. ल��वेज (भाषा)

Question Type : MCQ
Question ID : 618278308

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.16 टे��ट �कटन को बदलने के �लए इनम� से �कस टूलबार म� बट�स होत ेह�?
Ans 1. �य ू(अवलकन)

2. अपीयर�स (�कटन)

3. �ट�डड� (मानक)

4. फ़ाम��टगं (�व�पण)

Question Type : MCQ
Question ID : 618278338

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.17 एम.एस. ए�सेल म� करंट सेल को �या नाम देत ेह� िजसके चार� ओर एक सेल बॉउं�ी होती है?

Ans 1. एि�टव सेल (स��य क�)

2. करंट सेल (वत�मान क�)

3. �य ूसेल (नया क�)

4. प�ैसव सेल (�नि��य क�)

Question Type : MCQ
Question ID : 618278333

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.18 �न�न�ल�खत म� से कौन सा बटन ए�ल�केशन (अन�ुयोग) �वडंो को बड़ा करता है?

Ans 1. �लोज

2. र��टोर

3. �मनीमाइज

4. मिै�समाइज़

Question Type : MCQ
Question ID : 618278314

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.19 �कसी डटेाशीट पर रोज या कॉल�स (पंि�तय� या �तंभ�) का एक सेट (सम�ुचय) उ�ह� अ��य बनाने के �लए
एक साथ ______ हो सकत ेह�।

Ans 1. �ु�ड (समहू�कृत)

2. ट��ड (मंडल�कृत)
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3. ��एटेड (�न�म�त)

4. जंब�ड (ग�ड-म�ड)

Question Type : MCQ
Question ID : 618278334

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.20 �कस �लाइड लेआउट म� केवल टाइटल फ��ड होता है?

Ans 1. टाइटल ओनल�

2. टाइटल �लाइड

3. टू कंट�ट �लाइड

4. �ल�क �लाइड

Question Type : MCQ
Question ID : 618278354

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.21 �न�न�ल�खत म� से कौन सा कं�यटूर क� एक �वशषेता नह�ं है?

Ans 1. �पीड

2. ज�बात

3. श�ुता

4. मेमोर�

Question Type : MCQ
Question ID : 618278301

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.22 एम.एस. ए�सेल म� �कस �वशषेता का उपयोग टे��ट को एक �न�द��ट कोण के मा�यम से घमुाने के �लए �कया
जाता है? यह फॉम�ट से�स �वक�प म� होता है।

Ans 1. टे��ट ओ�रएंटेशन

2. टे��ट फॉम��टगं

3. टे��ट इंड�ट

4. टे��ट अलाइनम�ट

Question Type : MCQ
Question ID : 618278342

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.23 समय के साथ प�रवत�न के प�रमाण को मह�व देने के �लए �कस �कार के चाट� का उपयोग �कया जाता है?

Ans 1. ए�रया
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2. �कैटर

3. पाई

4. बार

Question Type : MCQ
Question ID : 618278348

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.24 एक फ़ाइल/फ़ो�डर को एक �थान से दसूरे �थान पर ले जाने के �लए �कन कमांड के �कस कं�बनेशन (संयोजन)
का �योग �कया जाता है?

Ans 1. कट, पे�ट

2. मवू, पे�ट

3. कट, मवू

4. कॉपी, पे�ट

Question Type : MCQ
Question ID : 618278313

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.25 एम.एस. वड� 2016 म� मेल मज� म� �न�न�ल�खत म� से कौन एक सह� डॉ�यमू�ट टाइप (द�तावेज़ �कार) है?

Ans 1. पी.पी.ट�. �ज�टेशन

2. लेटर

3. ��ेडशीट

4. पि�लशर डॉ�यमू�ट

Question Type : MCQ
Question ID : 618278328

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.26 एम.एस. वड� म� फाइंड �वक�प �कस टैब पर होता है?

Ans 1. होम

2. �यू

3. मे�लगं

4. इंसट�

Question Type : MCQ
Question ID : 618278323

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.27 ______ एक �ा�फकल वेब �ाउज़र नह�ं है।
Ans
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1. सफार�

2. लाइ��स

3. गूगल �ोम

4. ओपेरा

Question Type : MCQ
Question ID : 618278360

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.28 सी.पी.य.ू क� ग�त का मापन ______ म� होता है।
Ans 1. TB

2. MB

3. CB

4. Hz

Question Type : MCQ
Question ID : 618278302

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.29 ______ एक संकेतन उपकरण (पॉइं�टगं �डवाइस) नह�ं है।
Ans 1. �ैकबॉल

2. लाइट पेन

3. क�बोड�

4. माउस

Question Type : MCQ
Question ID : 618278304

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.30 एम.एस. ए�सेल म�, आप ______ कमांड का उपयोग कर एक सेल से दसूरे सेल म� स�ू को कॉपी कर सकत ेह�।
Ans 1. Ctrl + B

2. Ctrl + C

3. Ctrl + D

4. Ctrl + A

Question Type : MCQ
Question ID : 618278346

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.31 कै�पर�क� �कस �कार का एि�लकेशन (अन�ुयोग) सॉ�टवेयर है?

Ans
ANKAJ INFOTECH
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1. वायरस �कैनर �ल�नर

2. �ड�क मनेैजम�ट

3. डी���शन (�वकोडन)

4. फ़ाइल फ़ो�डर मनेैजम�ट

Question Type : MCQ
Question ID : 618278307

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.32 �न�न�ल�खत म� से कौन सा सॉ�टवेयर आपको सं�या�मक डटेा को इंटर (दज�), कैलकुलेट (गणना) और
म�ैनपलेुट (कौशल साधन) क� स�ुवधा देता है?

Ans 1. एम.एस. पॉवरपॉइंट

2. एम.एस. प�ट

3. एम.एस. ए�सेल

4. एम.एस. वड�

Question Type : MCQ
Question ID : 618278330

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.33 एम.एस. वड� 2016 म� मेल मज� म� �न�न�ल�खत म� से कौन सा सह� डॉ�यमू�ट टाइप (द�तावेज़ �कार) नह�ं है?

Ans 1. ई-मेल मसेैज (संदेश)

2. ��ेडशीट

3. इनवेलप

4. लेटर

Question Type : MCQ
Question ID : 618278326

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.34 एम.एस. ए�सेल म�, आप वक� बकु क� सरु�ा के �लए ______ �नधा��रत कर सकत ेह�।
Ans 1. नंबर

2. यज़ूरनेम

3. पासवड�

4. टे��ट

Question Type : MCQ
Question ID : 618278343

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.35
ANKAJ INFOTECH
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�न�न�ल�खत म� से कौन सा य.ूआर.एल. का एक भाग नह�ं है?

Ans 1. Slash (/)

2. Colon (:)

3. Dot (.)

4. MAC ए�से

Question Type : MCQ
Question ID : 618278359

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.36 ______ एक �वशषेता है जो आपको �व�भ�न �कार के �ा�फ�स म� से चनुने क� स�ुवधा देती है।
Ans 1. चाट�

2. फॉमू�लाज

3. �माट�आट�

4. एलाइनम�ट

Question Type : MCQ
Question ID : 618278349

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.37 ______ म� मेल मज� डॉ�यमू�ट (द�तावेज़) म� डाल� जाने वाल� सट�क जानकार� होती है?

Ans 1. म�ुय �ोत

2. डटेा माइ�नगं

3. डटेा द�तावेज़

4. डटेा �ोत

Question Type : MCQ
Question ID : 618278325

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.38 ड�ेकटॉप पर �द�श�त छोटे �ा�फक �तीक� को ______ कहा जाता है।
Ans 1. फ़ो�डस�

2. डटेा

3. आइकॉ�स

4. फ़ाइ�स

Question Type : MCQ
Question ID : 618278311

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.39 ANKAJ INFOTECH
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�ज�टेशन बनाने के �लए इन�ब�ट �डजाइन (अतं�न��हत अ�भकि�पत) फ़ाइ�स को �या कहा जाता है?

Ans 1. �लाइड लेआउट

2. �लाइड �डज़ाइन

3. स�पल टै�पले�स

4. स�पल �डज़ाइन

Question Type : MCQ
Question ID : 618278352

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.40 एम.एस. वड� एक लोक��य ______ �ो�ाम है।
Ans 1. कैलकुलेशन (गणना)

2. वड� �ॉसे�सगं (श�द ��मण)

3. डटेाबेस

4. �ज�टेशन (��त�ुतकरण)

Question Type : MCQ
Question ID : 618278315

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.41 �रबन माइ�ोसॉ�ट ऑ�फस को �ड�पेले (�द�श�त) करने और �म�नमाइज (छोटा) करने के �लए �कस क�
कं�बनेशन (कंुजी संयोजन) का �योग �कया जाता है?

Ans 1. Ctrl + F

2. Ctrl + F1

3. Ctrl + F3

4. Ctrl + F2

Question Type : MCQ
Question ID : 618278317

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.42 �ल�खत टे��ट और कागज के �कनारे के बीच क� दरू� को �या कहत ेह�?
Ans 1. एलाइनम�ट

2. इंड�ट �टॉप

3. मािज�न

4. �लर लाइन

Question Type : MCQ
Question ID : 618278324

Status : Answered
Chosen Option : 4

Marks : 0.00
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Q.43 एम.एस ऑ�फस 2016 म� ए�सेल वक� बकु �डफ़ॉ�ट �प से �कतने वक� शी�स को �ड��ले करता है?

Ans 1. 2

2. 4

3. 3

4. 1

Question Type : MCQ
Question ID : 618278332

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.44 एम.एस. वड� म� �पे�लगं एंड �ामर �वक�प �कस टैब म� होता है?

Ans 1. �र�यू

2. पेज लेआउट

3. होम

4. मे�लगं

Question Type : MCQ
Question ID : 618278322

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.45 एम.एस. पॉवरपॉइंट म� �लाइड के ______ त�व म� �लाइड क� म�ुय साम�ी होती है।
Ans 1. टाइटल

2. बकै�ाउंड

3. फुटर

4. बॉडी टे��ट

Question Type : MCQ
Question ID : 618278355

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.46

Ans 1. एलाइन स�टर (क� �ामखु संरेखण)

2. एलाइन टे��ट ले�ट (बा� ओर संरेखण)

3. एलाइन टे��ट राइट (दा� ओर संरेखण)

4. जि�टफाई (समायोिजत)

Question Type : MCQ
Question ID : 618278320

Status : Answered
Chosen Option : 2

Marks : 0.00
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Q.47 �न�न�ल�खत म� से कौन सा पेर�फेरल उपकरण नह�ं है?

Ans 1. �कैनर

2. �लॉटर

3. सी.पी.य.ू

4. ��टंर

Question Type : MCQ
Question ID : 618278303

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.48 एम.एस. ए�सेल 2016 म� �कसी वक� बकु का �डफ़ॉ�ट नाम �या होता है?

Ans 1. डॉ�यमू�ट1

2. बकु1

3. शीट1

4. अनटाइ��ड1

Question Type : MCQ
Question ID : 618278331

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.49 एम.एस. ए�सेल 2016 म� �डल�ट �ॉपडाउन बटन के तहत ______ �वक�प का उपयोग चय�नत कॉलम को
हटाने के �लए �कया जाता है।

Ans 1. �डल�ट शीट कॉल�स

2. �डल�ट शीट रोज़

3. �डल�ट से�स

4. �डल�ट शीट

Question Type : MCQ
Question ID : 618278335

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.50 एक मानक सी.डी. का �यास ______ होता है।
Ans 1. 70 mm

2. 80 mm

3. 120 mm

4. 180 mm

Question Type : MCQ
Question ID : 618278305

Status : Answered
Chosen Option : 3

Marks : 1.00
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Q.51 एम.एस. ए�सेल म� एक र�ज म� इं�डगं सेल ए�से से �टा�ट�ग सेल ए�से को कौन सा �सबंल (�च�न) अलग करता
है?

Ans 1. हाइफ़न

2. एन डशै

3. ऐरो

4. कोलन

Question Type : MCQ
Question ID : 618278340

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.52 ‘�ोटे�ट वक� बकु’ फ़ं�शन �या काय� करता है?

Ans 1. यह वक� शीट तक पहंुचने के �लए एक पासवड� जोड़ता है

2. यह �कसी वक� बकु म� सभी वक� शी�स को �रफॉम��टगं (पनु: �व��पत) या इसम� कुछ टाइप �कए जाने
से संर��त करता है

3. यह एक वक� बकु को इस तरह से सहेजता है िजससे केवल कुछ च�ुनदंा लोग� का समहू ह� इसको
खोल सकता है

4. यह वक� शी�स को इंसट�ड (जोड़ने), �डल�टेड (हटाने) या मवू (�थानांत�रत) करने से रोकता है

Question Type : MCQ
Question ID : 618278336

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.53 �कसी डॉ�यमू�ट (द�तावेज़) म� टे��ट के सामा�य �यव�थापन और �कटन को ______ कहा जाता है।
Ans 1. मे�लगं (डाक-�ेषण)

2. फॉम��टगं (�व�पण)

3. ए�ड�टगं (संपादन)

4. अ�पय�रगं (उपि�थ�त)

Question Type : MCQ
Question ID : 618278321

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.54 एम.एस. वड� 2016 म� मेल मज�र म� �सले�ट �र�स�पएं�स के तहत �न�न�ल�खत म� से कौन सा उपल�ध नह�ं
होता है?

Ans 1. यजू �डफॉ�ट �ल�ट (�डफॉ�ट �ल�ट का �योग कर�)

2. चजू �ॉम आउटलकु कॉ�टे��स (आउटलकु कॉ�टे��स से चनु�)

3. टाइप अ �य ू�ल�ट (नई �ल�ट टाइप कर�)

4. यजू एन एि�जि�टंग �ल�ट (�व�यमान �ल�ट का �योग कर�)

Question Type : MCQ
Question ID : 618278327
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Status : Answered
Chosen Option : 3

Marks : 0.00

Q.55 ______ �ी�डफाइ�ड (पवू�-प�रभा�षत) स�ू ह� और ए�सेल म� पहले से ह� उपल�ध ह�।
Ans 1. सेल रेफर�सेज़

2. व�ैयू

3. फ़ं�श�स

4. ऑपरेटस�

Question Type : MCQ
Question ID : 618278347

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.56 ______ एक मानक फोन लाइन और मॉडमे का उपयोग करके कं�यटूर और आई.एस.पी के बीच �था�पत एक
अ�थाई और ऑन-�डमाड कने�शन है।

Ans 1. ल��ड लाइन

2. �ॉडब�ड

3. डायल-अप ए�सेस

4. वाई-फ़ाई

Question Type : MCQ
Question ID : 618278357

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.57 एम.एस. पॉवरपॉइंट म� �लाइ�स को �यवि�थत करने, �थानांत�रत करने या कॉपी करने के �लए �कस �े� का
उपयोग �कया जाता है?

Ans 1. �लाइ�स पनै

2. टाइटल बार

3. �रबन

4. नो�स पनै

Question Type : MCQ
Question ID : 618278351

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.58 म�ट�पल ओपन �वडंोज के �बंधन हेत ु�वडंोज के �कस जी.य.ूआई. कंपोन�ट (घटक) का उपयोग �कया जाता है?

Ans 1. टा�कबार

2. �टाट� बटन

3. आइकॉन

4. ड�ेकटॉप �वडंोज मनेैजर
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Question Type : MCQ
Question ID : 618278310

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.59 एम.एस. ए�सेल म� कौन सा �च�न स�ू के आरंभ का �तीक है?

Ans 1. *

2. /

3. =

4. +

Question Type : MCQ
Question ID : 618278345

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.60 ऑनलाइन होने के �लए �न�न�ल�खत म� से कौन सा एक मलूभतू �र�वायरम�ट (आव�यकता) नह�ं है?

Ans 1. �कैनर

2. मॉडमे

3. �ाउज़र या संबं�धत एि�लकेशन

4. ISP

Question Type : MCQ
Question ID : 618278356

Status : Answered
Chosen Option : 1

Marks : 1.00
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Q.1 ओ.एल.ई.डी. (OLED) का पणू� �व�ता�रत �प �या है?

Ans 1. ऑग��नक लाइट ए�सपट� डायो�स

2. आग��नक लाइट ए�म�टगं डायो�स

3. ऑि�टकल लाइट ए�म�टगं डायो�स

4. ऑि�टकल लाइट ए�म�टगं �डवाइस

Question Type : MCQ
Question ID : 618278245

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.2 ______ को ि�लक करने पर यह एक �ो�ाम/फ़ो�डर/फ़ाइल पर �रडायरे�ट करता है।
Ans 1. इंटर�ेटर

2. क�पाइलर

3. शॉट�कट

4. असे�बलर

Question Type : MCQ
Question ID : 618278251

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.3 What is the full form of EEPROM?
Ans 1. Electrically Erasable Programmable Read Only Memory

2. Effectively Erasable Programmable Read Only Memory

3. Electronically Erasable Portable Read Only Memory

4. Electronically Erasable Programmable Random Only Memory

Participant ID 19310373
Participant Name MD RAMEEZ RAJA
Test Center Name iON Digital Zone iDZ Sandalpur
Test Date 30/11/2019
Test Time 12:00 PM - 1:00 PM
Subject Data Entry Operator
Marks Obtained 36.00000
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Question Type : MCQ
Question ID : 618278241

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.4 MS-वड� 2016 के �कस मे�य ूसे �वतः पणू� काय� स��य/�नि��य �कया जा सकता है?

Ans 1. �रफरे�स

2. �यू

3. फ़ाइल

4. मे�लगं

Question Type : MCQ
Question ID : 618278263

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.5 Which of the followings is NOT related to internet services?
Ans 1. Switch

2. Gateway

3. Scanner

4. Router

Question Type : MCQ
Question ID : 618278298

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.6 Print layout option can be selected from which of the following menu in MS-Word
2016?

Ans 1. Insert

2. Review

3. Layout

4. View

Question Type : MCQ
Question ID : 618278259

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.7 MS-ए�सेल 2016 म� फामू�ला मे�य ूम� �न�न�ल�खत म� से कौन सा 'लकुअप & �रफरे�स' फ़ं�शन नह�ं है?

Ans 1. CHOOSE

2. ADDRESS

3. AREAS

4. REPLACE

Question Type : MCQ
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Question ID : 618278287
Status : Answered

Chosen Option : 2
Marks : 0.00

Q.8 MS-ए�सेल 2016 म� हम �कस मे�य ूसे रोज एंड कॉलम को हाइड/अनहाइड कर सकत ेह�?
Ans 1. होम

2. �यू

3. �र�यू

4. पेज लेआउट

Question Type : MCQ
Question ID : 618278276

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.9 What is the full form of OTT, and what is an example of the OTT service?
Ans 1. Over The Top, Voot

2. Over Top Traditional, Amazon Prime

3. Other Top Transmission, ALT Balaji

4. Over The Tree, Netflix

Question Type : MCQ
Question ID : 618278300

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.10 MS-ए�सेल 2016 शीट म� कंट�ट को बदले �बना बगल के सेल� के समान फॉम�ट को लागू करने क� ज�रत है।
से�स म� कस�र को �गै करने के बाद �कस ऑटो�फल �वक�प का उपयोग �कया जाना चा�हए?

Ans 1. �फल सीर�ज

2. �फल से�स

3. �फल फॉम��टगं ओनल�

4. कॉपी से�स

Question Type : MCQ
Question ID : 618278281

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.11 य�द हम कुछ त�व� के बीच �नरंतर प�रवत�न �दखाना चाहत ेह�, तो MS-ए�सेल 2016 म� �कस फ़ं�शन/सब-
मे�य ूका उपयोग �कया जाना चा�हए?

Ans 1. इ�सट� मे�य ूम� चाट� �ुप से बार का चयन करना

2. इ�सट� मे�य ूम� इल��ेशन �ुप से �सबंल �वक�प का चयन करना

3. इ�सट� मे�य ूम� इल��ेशन �ुप से ऑनलाइन �प�चर �वक�प का चयन करना

4. इ�सट� मे�य ूम� इल��ेशन �ुप से �माट�आट� �वक�प का चयन करना
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Question Type : MCQ
Question ID : 618278290

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.12 MS-पॉवरपॉइंट 2016 �ज�टेशन म� सभी �लाइ�स के �लए समान थीम और बकै�ाउंड का चयन करने के �लए
�न�न�ल�खत म� से �कस �वक�प का उपयोग कर सकत ेह�?

Ans 1. �य ूमे�य ूम� मा�टर �य ू�ुप से नो�स मा�टर का चयन

2. �य ूमेन ूम� मा�टर �य ू�ुप से ह�डआउट मा�टर का चयन

3. �य ूमेन ूम� म�ैोज़ �ुप से म�ैोज़ का चयन

4. �य ूमे�य ूम� मा�टर �य ू�ुप से �लाइड मा�टर का चयन

Question Type : MCQ
Question ID : 618278294

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.13 मेल मज� म� लेबल के �लए पेपर आकार का चयन करने के �लए चरण� का सह� �म �या होगा?
Ans 1. मे�ल�ंस > राइट एंड इ�सट� फ़���स > ��स > �फल इन

2. मे�ल�ंस > ��एट > लेब�स > ��टं > �डटे�स > पेज साइज़

3. मे�ल�ंस > ��एट > लेब�स > आ�श�स > सेले�ट �ोड�ट नंबर > �डटे�स > पेज साइज़

4. मे�ल�ंस > राइट एंड इ�सट� फ़���स > मचै फ़���स > य�ूनक आइड��टफायर

Question Type : MCQ
Question ID : 618278268

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.14 एक यजूर �कसी कंपनी क� �रपोट� बना रहा है, िजसम� वह म�ुय हेडलाइन के भीतर कई सब-हेडलाइंस को अपने
पसंद के फॉ�ट �टाइल म� �दखाना चाहता है। MS-वड� म� �न�न�ल�खत म� से कौन सा �वक�प उसके �लए सह�
हो सकता है?

Ans 1. होम मे�य ूम� परैा�ाफ �ुप से म�ट�लेवल �ल�ट का चयन करना

2. होम मे�य ूम� परैा�ाफ �ुप से सॉट� का चयन करना

3. इ�सट� मे�य ूम� टे��ट �ुप से ऑ�जे�ट का चयन करना

4. �डज़ाइन मे�य ूम� डॉ�यमू�ट फॉम��टगं से परैा�ाफ �पे�सगं का चयन करना

Question Type : MCQ
Question ID : 618278261

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.15 �ड�क डी�े�म�टेशन �या होता है?

Ans 1. यह हाड� �ाइव म� डटेा को सेव करने क� ���या है

2. यह एक �कार का मेमोर� �डवाइस है

3. यह यजूर क� हाड� �ाइव पर डी�े�म�टेड फ़ाइ�स को संग�ठत करने क� ���या है
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4. यह ��टंर क� इन�ब�ट �वशषेता है

Question Type : MCQ
Question ID : 618278247

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.16 हम MS-ए�सेल 2016 वक� शीट म� �कसी चय�नत सेल क� रो-हाइट कैसे सेट कर सकत ेह�?
Ans 1. होम मे�य ूसे सेल �टाइल पर ि�लक कर�

2. होम मे�य ूम� सेल �ुप से फोम��टगं फ़ं�शन म� सेल साइज़ म� रो हाइट का चयन कर�

3. राइट ि�लक कर� और फॉम�ट से�स चनु�

4. राइट ि�लक कर� और इंड�ट चनु�

Question Type : MCQ
Question ID : 618278275

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.17 हम ______ के बाद ह� MS-ए�सेल वक� शीट म� वां�छत से�स को लॉक कर सकत ेह�।
Ans 1. �ोटे�ट करंट शीट को स�म करने

2. हाइड स�ुवधा को स�म करने

3. �ोटे�ट वक� बकु ���चर को स�म करने

4. चय�नत सेल� पर फॉम��टगं लागू करने

Question Type : MCQ
Question ID : 618278277

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.18 Which of the followings is slowest internet connection?
Ans 1. Fiber connection

2. Dial-Up

3. Wired broadband

4. Wireless broadband

Question Type : MCQ
Question ID : 618278297

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.19 Which of the following is correctly matched?
Ans 1. .doc : OpenOffice Word

2. .docx : MS-Word

3. .xlsx : explorer

4. .ppt : pagemaker
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Question Type : MCQ
Question ID : 618278255

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.20 MS-ए�सेल 2016 फ़ाइल म� �कस मे�य ूसे एक नई शीट बढ़ाई जा सकती है?

Ans 1. होम मे�य ूम� इ�सट� टैब से

2. फ़ाइल मे�य ूम� ओपन टैब से

3. फ़ाइल मे�य ूम� सेव एज �वक�प से

4. फ़ाइल मे�य ूम� �य ूटैब से

Question Type : MCQ
Question ID : 618278272

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.21 MS-ए�सेल 2016 वक� शीट म� �कस फ़�चर �वारा हम पड़ोसी सेल से फॉमू�ला पे�ट कर सकत ेह�?
Ans 1. होम मे�य ूम� ए�ड�टगं �ुप से सेल �टाइ�स फ़ं�शन का चयन कर�

2. होम मे�य ूम� ए�ड�टगं �ुप से �फल फ़ं�शन का चयन कर�

3. होम मे�य ूम� सेल �ुप से इ�सट� फं�शन का चयन कर�

4. होम मे�य ूम� सेल �ुप से फॉम�ट फ़ं�शन का चयन कर�

Question Type : MCQ
Question ID : 618278286

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.22 Which of the followings is not a mandatory requirement for using the services of
internet?

Ans 1. Web browser or related app’s

2. Internet connection

3. Computing Device

4. Printer

Question Type : MCQ
Question ID : 618278296

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.23 एक कंपनी �बंधक ने आगामी वष� के �लए बजट का अनमुान लगाया और एक MS-ए�सेल 2016 शीट तयैार
कर फ�डबकै के �लए अपने अधीन�थ� को साझा �कया। उसने फाइल को पासवड� �वारा सरु��त रखता है और
यह स�ुनि�चत करना चाहता है �क शीट म� कोई भी रोज और कॉलम को हटा नह�ं सके। ऐसा करने के कौन सा
सह� अन�ुम है?

Ans 1. होम मेन ू> सेल सब�ुप > फॉम�ट > �ोटे�ट शीट > चेक इ�सट� रोज एंड कॉल�स

2. होम मेन>ू सेल सब�ुप > फॉम�ट > �ोटे�ट शीट > चेक �डल�ट रोज एंड कॉल�स
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3. होम मेन ू> सेल सब�ुप > फॉम�ट > �ोटे�ट शीट > अनचेक �डल�ट रोज एंड �डल�ट कॉल�स

4. होम मे�य ू> सेल सब�ुप > फॉम�ट > फॉम�ट से�स > �फल

Question Type : MCQ
Question ID : 618278284

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.24 ‘False’ function belongs to which category of functions in MS-Excel?
Ans 1. Logical

2. Financial

3. Text

4. Math & trigonometry

Question Type : MCQ
Question ID : 618278285

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.25 MS-पॉवरपॉइंट 2016 म� �रसेट फ़ं�शन का उपयोग �कस�लए �कया जाता है?

Ans 1. संपणू� �ेज�टेशन �नयम� को र�सेट करने के �लए

2. �लाइड साइज़ को कम करने के �लए

3. डॉ�यमू�ट को �ल�क डॉ�यमू�ट पे �रसेट करने के �लए

4. �लाइड �लेसहो�डर क� ि�थ�त, आकार और फॉम��टगं को उनक� �डफ़ॉ�ट से�ट�ंस पर �रसेट करने के
�लए

Question Type : MCQ
Question ID : 618278291

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.26 MS-वड� 2016 म� कॉपी-पे�ट �व�ध का उपयोग �कए �बना टे��ट को एक फ़ाइल से दसूर� फ़ाइल म�
�थानांत�रत �कया जा सकता है, इसके �लए �न�न�ल�खत म� से कौन सा �वक�प है?

Ans 1. �य ूमे�य ूम� �वडंो �ुप से �य ूि��लट को चनु� और टे��ट का चयन करने के बाद, माउस के दा�हने
बटन को दबाए रखकर गंत�य फ़ाइल म� �गै करके डाल�

2. फ़ाइल मे�य ूम� �वडंो �ुप से अर�ज आल का चयन कर� और टे��ट का चयन करने के बाद माउस के
दा�हने बटन को दबाए रखकर गंत�य फ़ाइल म� �गै करके डाले

3. होम मे�य ूम� �य ू�ुप से ि��लट का चयन कर� और टे��ट का चयन करने के बाद माउस के दा�हने
बटन को दबाए रखकर गंत�य फ़ाइल म� �गै करके डाल�

4. �य ूमे�य ूम� �वडंो �ुप से अर�ज आल का चयन कर� और टे��ट का चयन करने के बाद माउस के बाएं
बटन को दबाए रखकर गंत�य फ़ाइल म� �गै करके डाल�

Question Type : MCQ
Question ID : 618278262

Status : Answered
Chosen Option : 4

Marks : 1.00
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Q.27 एक छा� जनवर� 2018 म� अपने �श�क� �वारा पढ़ाई गई इकाइय� क� सं�या पर शीट तयैार कर रहा है। शीट
म� 20 रोज और 5 कॉल�स ह�। शीट परूा करने के बाद उसे पता चलता है �क �थम कॉलम, जो �श�क के नाम
का ��त�न�ध�व करता है, को अलग बकै�ाउंड रंग के साथ हाइलाइट �कया जाना चा�हए। इसके �लए MS-
ए�सेल 2016 का कौन सा �वक�प उसे मदद कर सकता है?

Ans 1. होम मे�य ूम� परैा�ाफ �ुप

2. होम मे�य ूम� ि�लपबोड� �ुप

3. होम मे�य ूम� पेज बकै�ाउंड �ुप

4. होम मे�य ूम� फ़ॉ�ट �ुप

Question Type : MCQ
Question ID : 618278279

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.28 The ______ devices work as an interface between user and computer.
Ans 1. Arithmetic Logic Unit

2. Control Unit

3. Input/Output Devices

4. Memory Unit

Question Type : MCQ
Question ID : 618278243

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.29 MS-ए�सेल 2016 वक� शीट म� सेल �टाइल के �य�ूल फ�चर का �डफ़ॉ�ट रंग �न�न�ल�खत म� से कौन सा है?

Ans 1. काल� (�लकै)

2. हरा (�ीन)

3. ह�का सनुहरा (लाइट गो�डन)

4. लाल (रेड)

Question Type : MCQ
Question ID : 618278282

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.30 �कसी MS-वड� 2016 फाइल म� सभी फॉम��टगं को साफ करने का काय� �कस मे�य ूम� होता है?

Ans 1. लेआउट

2. �यू

3. होम

4. फ़ाइल

Question Type : MCQ
Question ID : 618278257

Status : Answered
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Chosen Option : 3
Marks : 1.00

Q.31 Which of the following is an impact printer?
Ans 1. Deskjet

2. Inkjet

3. Laserjet

4. Drum printer

Question Type : MCQ
Question ID : 618278244

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.32 मेल मज� के म�ुय डॉ�यमू�ट म� ______ �न�हत होता है।
Ans 1. डटेाबेस िजसम� �यि�तगत जानकार� जसेै नाम, पता और फ़ोन नंबर होत ेह�

2. �ेषक� के ई-मेल पते

3. ए�सेल फ़ाइल क� थीम और अ�य फॉम��टगं से�ट�ंस

4. �नि�चत जानकार� और यह एक फॉम� लेटर, लेब�स, ईमेल या डाइरे�टर� हो सकती है

Question Type : MCQ
Question ID : 618278269

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.33 एक �बंधक �पछले 5 वष� का अपनी कंपनी के टन�ओवर क� �लाइड बना रहा है। वह 5 वष� के 5 अलग-अलग
खंड� को �मलाकर एकल MS-पॉवरपॉइंट 2016 �ज�टेशन बनाना चाहता है। इसके �लए वह �न�न�ल�खत म� से
कौन सा �वक�प चनु सकता है?

Ans 1. होम मे�य ूम� �लाइड �ुप से �य ू�लाइड फ़ं�शन का चयन करना

2. होम मे�य ूम� �लाइड �ुप से से�शन फ़ं�शन का चयन करना

3. होम मे�य ूम� ए�डट �ुप से �र�लेस फ़ं�शन का चयन करना

4. होम मे�य ूम� �लाइड �ुप से लेआउट फ़ं�शन का चयन करना

Question Type : MCQ
Question ID : 618278292

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.34 �यि�तगत संदेश वाले लोग� के �ुप को प� भेजना चाहत ेह�। �न�न�ल�खत म� से कौन सा �वक�प श�द के �लए
�योग �कया जाता है?

Ans 1. मेल मज� से लेटर को डॉ�यमू�ट टाइप के �प म� चयन कर�

2. मेल मज� से ई-मेल संदेश को डॉ�यमू�ट टाइप के �प म� चयन कर�

3. मेल मज� से ए�वेल�स को डॉ�यमू�ट टाइप के �प म� चयन कर�

4. मेल मज� से लेबल को डॉ�यमू�ट टाइप के �प म� चयन कर�

Question Type : MCQANKAJ INFOTECH
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Question ID : 618278266
Status : Answered

Chosen Option : 3
Marks : 0.00

Q.35 What is the length of IPv6 addresses?
Ans 1. 128 bits

2. 32 bits

3. 256 bits

4. 64 bits

Question Type : MCQ
Question ID : 618278299

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.36 MS-वड� 2016 म� �कसी टेबल/ता�लका म� चय�नत टे��ट क� �दशा बदलने के �लए �न�न�ल�खत म� से कौन सा
�वक�प सह� है?

Ans 1. �सले�ट टे��ट > राइट ि�लक > टे��ट डाइरे�शन

2. लेआउट > पेज सेटअप > हायफेनेशन

3. �य ू> �वडंो > �य ूसाइड बाई साइड

4. होम > फ�ट > च�ज केस

Question Type : MCQ
Question ID : 618278260

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.37 Which of the following is not a feature of editing group in Home menu of MS-Excel
2016?

Ans 1. Find and select

2. Sort and filter

3. Clear

4. Insert

Question Type : MCQ
Question ID : 618278280

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.38 Which of the following was the version of Windows before the Windows XP?
Ans 1. Windows 10

2. Windows Vista

3. Windows 7

4. Windows ME

Question Type : MCQ
ANKAJ INFOTECH
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Question ID : 618278250
Status : Answered

Chosen Option : 4
Marks : 1.00

Q.39 How can we rename an existing work sheet in an MS-Excel workbook?
Ans 1. Right click on sheet name in lower left corner of the current worksheet and select

rename option

2. Right click on file and select rename tab

3. Select Cover page from the Design menu

4. Select Info from the File menu

Question Type : MCQ
Question ID : 618278271

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.40 एक सॉ�टवेयर �ो�ाम जो �ो�ाम कोड से मशीन कोड क� �ोसे�सगं का काय� करने के �लए �डज़ाइन या उपयोग
�कया जाता है, उसे ______ के �प म� जाना जाता है।

Ans 1. ल��वेज �ोसेसर

2. वड� �ोसेसर

3. रैम ऑ�ट�माइज़र

4. हाड� �ड�क ऑ�ट�माइज़र

Question Type : MCQ
Question ID : 618278249

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.41 �वडंोज म� कमांड �ॉ��ट �वारा एक नया सॉ�टवेयर इन�टॉल करने के �लए उपय�ुत �थम कमांड �या होगा?
Ans 1. cd [file path] (सी.डी. [फाइल का पाथ])

2. cd [add extension] (सी.डी. [एड ए�सट�शन])

3. cd [software name] (सी.डी. [सा�टवेयर का नाम])

4. install [file path] (इं�टाल [फाइल पाथ])

Question Type : MCQ
Question ID : 618278254

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.42 Which of the following figures is not a part of auto shapes in MS-Excel worksheet?
Ans 1. Basic shapes

2. Flow chart

3. Block Arrows

4. Bar chart

Question Type : MCQANKAJ INFOTECH
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Question ID : 618278289
Status : Answered

Chosen Option : 3
Marks : 0.00

Q.43 MS-वड� 2016 फ़ाइल म� कैल�डर इ�सट� करने के �लए �न�न�ल�खत म� से �कस �वक�प का उपयोग �कया
जाता है?

Ans 1. इ�सट� मे�य ूम� टेब�स �ुप से ि�वक टेबल का चयन कर�

2. इ�सट� मे�य ूम� टे��ट �ुप से ऑ�जे�ट का चयन कर�

3. इ�सट� मे�य ूम� �लकं �ुप से �ॉस-�रफरे�स का चयन कर�

4. इ�सट� मे�य ूम� टेब�स �ुप से ए�सेल ��ेडशीट का चयन कर�

Question Type : MCQ
Question ID : 618278264

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.44 From which option we can change orientation of text in MS-Excel 2016?
Ans 1. Clipboard group in Home menu

2. Font group in Home menu

3. Alignment group in Home menu

4. Style group in Home menu

Question Type : MCQ
Question ID : 618278278

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.45 MS-वड� म� मेल मज� के बारे म� �न�न�ल�खत म� से कौन सा कथन सह� है?

Ans 1. हम केवल ई-मेल संदेश के �वषय बॉ�स म� मज� फ़��ड म� टाइप कर सकत ेह�

2. ई-मेल संदेश के �वषय बॉ�स म� न तो हम टाइप करत ेह� और न ह� मज� फ़��ड का उपयोग करत ेह�

3. हम ई-मेल संदेश के �वषय बॉ�स म� मज� फ़��ड का उपयोग कर सकत ेह�

4. हम ई-मेल संदेश के �वषय बॉ�स म� मज� फ़��ड म� टाइप नह�ं कर सकत ेह�

Question Type : MCQ
Question ID : 618278265

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.46 In MS-Excel 2016 sheet, a user wants to clear all formatting but there should be no
impact on content. Which option he should select?

Ans 1. Select Clear hyperlinks in Clear function from Editing group in Home menu.

2. Select Clear content in Clear function from Editing group in Home menu.

3. Select Clear all in Clear function from Editing group in Home menu.

4. Select Clear formats in Clear function from Editing group in Home menu.

Question Type : MCQANKAJ INFOTECH
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Question ID : 618278273
Status : Answered

Chosen Option : 3
Marks : 0.00

Q.47 In which step, can we create a new recipient list in mail merge?
Ans 1. 1st step: create recipient

2. 6th step: complete the merge

3. 3rd step: select recipients

4. 2nd step: select document type

Question Type : MCQ
Question ID : 618278267

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.48 The toggle button to make paragraphs marks and other hidden formatting symbols
visible/invisible is available in which menu in MS-Word 2016?

Ans 1. Insert

2. References

3. Home

4. View

Question Type : MCQ
Question ID : 618278258

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.49 For removing space between two paragraphs of same style, which function should be
selected in MS-Word 2016?

Ans 1. References > Smart Lookup

2. Insert > Cover Page > Austin

3. Layout > Paragraph > Line and page breaks > Don’t add space in same style
paragraphs

4. Layout > Paragraph > Indents and spacing > Don’t add space in same style
paragraphs

Question Type : MCQ
Question ID : 618278256

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.50 �वडंोज़ ए�स.पी. म� ���न सेवर �था�पत करने के �लए हम� �न�न�ल�खत म� से कौन सा �वक�प चनुना
चा�हए?

Ans 1. माई कं�यटूर पर ले�ट ि�लक > सी. �ाइव > च�ज ���न सेवर

2. माई नेटवक�  �लेस पर राइट ि�लक > �ॉपट�ज > आई.वी.पी.4

3. ड�ेकटॉप पर राइट ि�लक > �ॉपट�ज > ���न सेवर

4. माई कं�यटूर पर डबल ि�लक > सी. �ाइव > �ो�ाम फाइ�स
ANKAJ INFOTECH
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Question Type : MCQ
Question ID : 618278252

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.51 From which of the following options can we prevent users to format cells in MS-Excel
2016 worksheet?

Ans 1. Home >Alignment

2. Home > Format

3. Home > Delete

4. Home > Insert

Question Type : MCQ
Question ID : 618278283

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.52 Linux is a type of ______.
Ans 1. Operating System

2. Memory

3. Processor

4. Application Software

Question Type : MCQ
Question ID : 618278246

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.53 MS-पॉवरपॉइंट 2016 म� हम �लाइड शो ऑनलाइन ��ततु कर सकत ेह�। इसके �लए �न�न�ल�खत म� से �कस
�वक�प का उपयोग �कया जाता है?

Ans 1. इ�सट� मे�य ू> इल��ेशन �ुप

2. �ांजीशन मे�य ू> �ी�य ू�ुप

3. �र�य ुमे�य ू> ए�से�स�ब�लट� �ुप

4. �लाइड शो मे�य ू> �टाट� �लाइड शो �ुप

Question Type : MCQ
Question ID : 618278293

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.54 फ़ाइल मनेैजम�ट के संबंध म� जी.पी.ट�. का पणू� �व�ता�रत �प �या है?

Ans 1. �ेट पाट�शन टेबल

2. गाइडडे �ाइमर� टेबल

3. गाइडडे पाट�शन टेबल

ANKAJ INFOTECH
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4. जी.य.ूआई.डी. पाट�शन टेबल

Question Type : MCQ
Question ID : 618278253

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.55 Where will you find Autofit row height and Autofit column width in MS-Excel 2016?
Ans 1. Protection in format function from cells group in Home menu

2. Organize sheets in Format function from Cells group in Home menu

3. Visibility in Format function from Cells group in Home menu

4. Cell size in Format function from Cells group in Home menu

Question Type : MCQ
Question ID : 618278274

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.56 A women wants to make a chart in MS-Excel, which shows her monthly expenditures
in percentage. Which type of chart is best suitable for her?

Ans 1. Hierarchy chart

2. Doughnut

3. Pie chart

4. Bar chart

Question Type : MCQ
Question ID : 618278288

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.57 Which of the following is the fastest memory?
Ans 1. Magnetic Disk

2. Register

3. Magnetic Tape

4. Pen drive

Question Type : MCQ
Question ID : 618278242

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.58 Preview of slides in MS-PowerPoint 2016 can be seen from which Menu?
Ans 1. Design

2. Insert

3. Review

4. Transition

ANKAJ INFOTECH
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Question Type : MCQ
Question ID : 618278295

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.59 MS-ए�सेल 2016 म� �न�न�ल�खत म� से कौन �य ूमेन ूका �वक�प नह�ं है?

Ans 1. �माट� लकुअप

2. फॉमू�ला बार

3. ��डलाइन

4. �लर

Question Type : MCQ
Question ID : 618278270

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.60 COBOL is an acronym for ______.
Ans 1. Common Business Oriented Language

2. Common Band Oriented Layout

3. Common Build Oriented Language

4. Common Build Objects Language

Question Type : MCQ
Question ID : 618278248

Status : Answered
Chosen Option : 1

Marks : 1.00
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Q.1 MS-ए�सेल 2016 म� 'कं�डशनल फाम��टगं’ लागू करने का �वक�प �न�न�ल�खत म� से कौन सा नह�ं है?

Ans 1. हाइलाइट सेल ��स

2. डटेा बार

3. फॉटं कलर

4. टॉप/बॉटम ��स

Question Type : MCQ
Question ID : 618278222

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.2 य�द कोई मनेैजर ��ेडशीट पर पासवड� �ोटे�शन को स�म करना चाहता है ता�क कोई अधीन�थ अ�धकार�
MS-ए�सेल 2016 क� शीट से �कसी भी कॉलम/रो को हटा न सके तो वह कौन सा ऑ�शन चनु सकता है?

Ans 1. �र�य ूमे�य ूम� च�जेज �ुप से �ैक च�ज ऑ�शन का चयन कर�

2. �र�य ूमे�य ूम� थीसोरस �ुप से �ांसलेट ऑ�शन का चयन कर�

3. �र�य ूमे�य ूम� च�जेज �ुप से �ोटे�ट शीट ऑ�शन का चयन कर�

4. �र�य ूमे�य ूम� च�जेज �ुप से शयेर वक� बकु ऑ�शन का चयन कर�

Question Type : MCQ
Question ID : 618278217

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.3 य�द हम कुछ त�व� के बीच पदान�ु�मत संबंध �दखाना चाहत ेह� तो MS-ए�सेल 2016 म� �न�न�ल�खत म� से
�कस फ़ं�शन/सब-मे�य ूका उपयोग �कया जाना चा�हए?

Ans 1. इंसट� मे�य ूम� �च� समहू से �च� �वक�प चनु�

2. इंसट� मे�य ूम� �च� समहू से ि�लपआट� �वक�प चनु�

3. इ�सट� मे�य ूम� इल��ेशन समहू से �माट�आट� �वक�प चनु�

Participant ID 19362207
Participant Name AMIT KUMAR
Test Center Name iON Digital Zone iDZ Jalalpur
Test Date 30/11/2019
Test Time 9:00 AM - 10:00 AM
Subject Data Entry Operator
Marks Obtained 17.00000

Section : MCQ for Data Entry Operator
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4. इंसट� मे�य ूम� चाट� समहू से बार को चनु�

Question Type : MCQ
Question ID : 618278230

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.4 MS-ए�सेल 2016 के �कस मे�य ूम�, 'हाइड & अनहाइड' ऑ�शन उपल�ध है?

Ans 1. �य ू> पेज लेआउट

2. होम > �डल�ट

3. होम > फॉम�ट

4. डटेा > गेट डटेा

Question Type : MCQ
Question ID : 618278223

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.5 MS-पॉवर पॉइंट 2016 के होम टैब म� �न�न�ल�खत म� से कौन सा एक फ़ं�शन नह�ं है?

Ans 1. से�शन ऑ�शन

2. �य ू�लाइड

3. फाइंड

4. �लाइड �डजाइन

Question Type : MCQ
Question ID : 618278231

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.6 �न�न�ल�खत म� से �कस इनपटु/आउटपटु �डवाइस का उपयोग दसूर� पीढ़� (सेकंड जनरेशन) के कं�यटूर म�
�कया गया था?

Ans 1. जॉयि�टक

2. माउस

3. OCR

4. पंच काड�

Question Type : MCQ
Question ID : 618278184

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.7 एस�बलर के बारे म� �न�न�ल�खत म� से कौन सह� है?

Ans 1. यह एक �कार का एंट�वायरस है िजसका उपयोग कं�यटूर क� ग�त बढ़ाने के �लए �कया जाता है

2. यह हाड� कॉपी आउटपटु �डवाइस को सॉ�ट कॉपी आउटपटु �डवाइस म� प�रव�त�त करता है
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3. यह एस�बल� ल��वेज (भाषा) और कं�यटूर �ोसेसर म� �ल�खत �तीका�मक को�डत �नद�श� के बीच
सेत ुका काम करता है

4. यह यजूर और एि�लकेशन सॉ�टवेयर के बीच इंटरफेस का काम करता है

Question Type : MCQ
Question ID : 618278189

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.8 MS-ए�सेल 2016 के पेज लेआउट टैब म� �न�न�ल�खत म� से कौन सा पेजसाइज का �कार है?

Ans 1. A5

2. एि�ज�य�ूटव

3. लेटर

4. ल�गल

Question Type : MCQ
Question ID : 618278218

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.9 �वडंोज XP के थीम को बदलने के �लए हम� �कस �वक�प का चयन करना चा�हए?

Ans 1. माई कं�यटूर पर डबल ि�लक कर� > सी. �ाइव > �ो�ाम फाइल

2. माई नेटवक�  �थान पर दाएं ि�लक > �वशषेताएं > IPV4

3. माई कं�यटूर पर बाएं ि�लक कर� > सी. �ाइव > थीम बदल�

4. ड�ेकटॉप पर दाएं ि�लक > �ॉपट�ज > थीम

Question Type : MCQ
Question ID : 618278192

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.10 What is the full form of EPROM?
Ans 1. Electric Programmable Read Only Memory

2. Electric Programmable Random Organisation Memory

3. Erasable Programmable Read Only Memory

4. Erasable Portable Read Only Memory

Question Type : MCQ
Question ID : 618278181

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.11 MS-ए�सेल म� ‘�’ फं�शन �कस �ेणी के काय� से संबं�धत है?

Ans 1. फाइन��शयल

2. लॉिजकल
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3. डटे एंड टाइम

4. टे��ट

Question Type : MCQ
Question ID : 618278225

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.12 य�द हम अपने कं�यटूर को �वडंोज XP/�वडंोज 7 म� �पछले सं�करण म� पनु�था��पत करना चाहत ेह� तो हम�
�न�न�ल�खत म� से कौन सा �वक�प चनुना चा�हए?

Ans 1. �टाट� > आल �ो�ा�स > ए�सेसर�ज़ > आर.डी.सी.

2. कं�ोल पनैल > यजूर > पासवड�

3. माई कं�यटूर > सी �ाइव > यजूर

4. �टाट� > आल �ो�ा�स > ए�सेसर�ज़ > �स�टम टू�स

Question Type : MCQ
Question ID : 618278193

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.13 ��टगं �या है?

Ans 1. हाड� �ाइव म� डटेा को बचाने क� ���या

2. हाड�वेयर एस�ब�लगं क� ���या

3. RAM �ल�य�रगं क� ���या

4. नेटव�क� ग म� सोस� (�ोत) से डिे�टनेशन (गंत�य) तक डटेा का पकेैट �थानांत�रत करने क� ���या

Question Type : MCQ
Question ID : 618278238

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.14 MS-वड� 2016 म� '�ॉस-रेफर�स' फ़ं�शन को �न�न�ल�खत म� से �कस मे�य ूसे चनुा जा सकता है?

Ans 1. रेफरे�सेस

2. पेज लेआउट

3. �र�यू

4. इंसट�

Question Type : MCQ
Question ID : 618278204

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.15 �कसी कंपनी �ाहक� को 6 अलग-अलग मद �दान करती है। �ब�� �बंधक अपने पय�वे�क के सम� ��त�ुत
के दौरान ��येक मद के �लए एक �लाइड तयैार करता है। पय�वे�क सभी �लाइ�स को एक �वडंो म� रखना
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चाहता है ता�क वह तलुना कर सके। �न�न�ल�खत म� से कौन से फं�शन का �ब�� �बंधक �वारा उपयोग �कया
जाएगा?

Ans 1. �लाइड साइज़

2. समर� ज़मू

3. �लाइड साट�र

4. �लाइड ज़मू

Question Type : MCQ
Question ID : 618278232

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.16 डॉ�यमू�ट (द�तावेज़) �लखत ेसमय ‘Delhi’ को 6 – 7 �थान� पर ‘Dehli’ के �प म� �लखा जाता है।
�न�न�ल�खत म� से कौन से फ़ं�शन का उपयोग इस गलती को एक बार म� ठ�क करने के �लए �कया जा सकता
है?

Ans 1. Ctrl + Delhi

2. Alt + D

3. Ctrl + H

4. Shift + D

Question Type : MCQ
Question ID : 618278199

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.17 य�द कोई यजूर �वडंोज XP म� इंटरनेट ए�स�लोरर से कोई फ़ाइल डाउनलोड करता है तो डाउनलोड क� गई
फ़ाइल का �डफ़ॉ�ट �थान ______ होगा।

Ans 1. C �ाइव > माई डॉ�यमू��स

2. D �ाइव > यजूर

3. C �ाइव > ड�ेकटॉप

4. D �ाइव > ड�ेकटॉप

Question Type : MCQ
Question ID : 618278191

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.18 �न�न�ल�खत म� से कौन सा मे�य ू�लाइ�स के बीच आवागमन के �लए �वक�प �दान करता है?

Ans 1. �डज़ाइन

2. होम

3. �ांिजशन

4. �यू

Question Type : MCQ
Question ID : 618278235
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Status : Answered
Chosen Option : 1

Marks : 0.00

Q.19 य�द एक नया हाड�वेयर कं�यटूर के I/O पोट� से जोड़ा जाता है तो हम उस हाड�वेयर के �ाइवर क� ि�थ�त को
�कस �वक�प से देख सकत ेह�?

Ans 1. स�व�सेज

2. �डवाइस मनेैजर

3. �वडंोज �डफ� डर फ़ायरवॉल

4. �डफ़ॉ�ट �ो�ा�स

Question Type : MCQ
Question ID : 618278194

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.20 MS-वड� म� फाम��टगं म� 'ह��गगं' फ़ं�शन ______ के साथ जड़ुा हुआ है।
Ans 1. ओ�रएंटेशन

2. इंड�टेशन

3. पेज बॉड�र

4. फ़ॉ�ट �टाइल

Question Type : MCQ
Question ID : 618278200

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.21 MS-ए�सेल म� सेल के आकार को बदलने (�रसाइिजंग) के �लए �न�न�ल�खत म� से कौन सा �वक�प सह� है?

Ans 1. केवल कॉलम क� ऊँचाई को समायोिजत क� जा सकती है

2. केवल रो क� चौड़ाई को समायोिजत �कया जा सकता है

3. रो क� चौड़ाई और कालम क� ऊँचाई को समायोिजत �कया जा सकता है

4. रो क� ऊंचाई और कॉलम क� चौड़ाई को समायोिजत �कया जा सकता है

Question Type : MCQ
Question ID : 618278214

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.22 MS-ए�सेल 2016 के फ़ाइल मे�य ूका �वक�प �न�न�ल�खत म� से कौन है?

Ans 1. �लॉज

2. इंसट�

3. लेआउट

4. ऐड शीट

Question Type : MCQ
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Question ID : 618278210
Status : Answered

Chosen Option : 1
Marks : 1.00

Q.23 MS-ए�सेल 2016 कॉपी करत ेसमय और �फर पेि�टंग के समय कुछ फाम��टगं �वक�प �दान करता है। ये
�वक�प कहां पर पाए जात ेह�?

Ans 1. �य ू> फॉमू�ला बार

2. फॉमू�लाज > पे�ट �पेशल

3. होम > पे�ट �पेशल

4. इंनसट� > फॉमू�ला

Question Type : MCQ
Question ID : 618278226

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.24 ई-मेल का उपयोग पहल� बार ______ पर �कया गया था।
Ans 1. HTTPS

2. URL

3. ARPANET

4. OSI Model

Question Type : MCQ
Question ID : 618278240

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.25 फोर�ान के बारे म� �न�न�ल�खत म� से कौनसा सह� है?

Ans 1. यह कं�यटूर मेमोर� का एक �ह�सा है

2. यह �ोसेसर का एक �ह�सा है

3. यह एक �कार का ��टंर है

4. यह एक �ो�ा�मगं ल��वेज (भाषा) है

Question Type : MCQ
Question ID : 618278188

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.26 �ी अजीत �कसी वक� शीट म� काम कर रहे ह� और वह फाइल को pdf म� बदलना चाहत ेह�।

�न�न�ल�खत म� से कौन सा �वक�प उसे फ़ाइल �कार बदलने क� अनमु�त नह� ंदेता है?

Ans 1. सेव एज

2. फाम�ट

3. ��टं

4. ए�सपोट�
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Question Type : MCQ
Question ID : 618278211

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.27 MS-वड� 2016 म� "�र�य"ू मे�य ूका �ह�सा, �न�न�ल�खत म� से कौन सा नह�ं है?

Ans 1. �य ूकम�ट (नई �ट�पणी)

2. टेबल ऑफ़ कंट�ट (�वषय – सचूी)

3. वड� कॉउ�ट (श�द गणना)

4. कॉ�पेयर (तलुना)

Question Type : MCQ
Question ID : 618278203

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.28 MS-वड� म� एक परैा�ाफ और पेज मािज�न के बीच क� दरू� को ______ के �प म� जाना जाता है।
Ans 1. परैा �पे�सगं

2. लाइन �पे�सगं

3. इंड�ट

4. अडंरलाइन

Question Type : MCQ
Question ID : 618278197

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.29 MS-ए�सेल 2016 म� �कस मे�य/ूटैब म� संर��त वक� बकु (protected workbook) को शयेर करने का
ऑ�शन चनुा जा सकता है?

Ans 1. �र�यू

2. �यू

3. फॉमू�लाज

4. डटेा

Question Type : MCQ
Question ID : 618278216

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.30 कोई �बंधक �दसंबर 2018 म� �न�म�त इकाइय� क� सं�या को शीट पर तयैार कर रहा है। डटेा म� 10 रोज और 5
कॉल�स ह�। उसने अपनी कंपनी का नाम अथा�त ‘ABC म�ैयफैू�च�रगं �ाइवेट �ल�मटेड’ �लखने के �लए डटेा
के ऊपर C1’ सेल म� एक और पंि�त इनसट� (सि�म�लत) क� है। परंत ुउसके सामने एक सम�या है �य��क
कंपनी का परूा नाम एक सेल म� �फट नह�ं बठै रहा है, इसे �फट करने के �लए तीन सेल चा�हए। कौन सा �वक�प
इसम� उसक� मदद कर सकता है?

Ans
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1. ‘C1’, ‘D1’ और ‘E1’ से�स को मज� कर द�

2. ‘D1’ और ‘E1’ सेल को �डल�ट कर द� ता�क पया��त �थान बन जाए

3. कंपनी के नाम म� सभी �र�त �थान हटाना

4. ‘C1’ से ‘C3’ से�स को मज� कर द�

Question Type : MCQ
Question ID : 618278219

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.31 माइ�ोसो�ट �वारा �वडंोज XP �कस वष� म� लॉ�च �कया गया था?
Ans 1. 1999

2. 2000

3. 1998

4. 2001

Question Type : MCQ
Question ID : 618278190

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.32 �न�न�ल�खत म� से कौन सा मे�य ूएम.एस.-ए�सेल 2016 फ़ाइल का नाम बदलने (�रनेम) क� अनमु�त देगा?
Ans 1. फ़ाइल

2. �र�यू

3. रेफरे�सेस

4. होम

Question Type : MCQ
Question ID : 618278212

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.33 पॉवर पॉइंट के �य ूमे�य ूम� ‘�य ू�वडंो’ ऑ�शन का उ�े�य ______ है।
Ans 1. नई �र�त �ज�टेशन को खोलना

2. उसी �ज�टेशन को दसूर� �वडंो म� खोलना

3. उसी �वडंो म� एक अ�य फ़ाइल खोलना

4. दसूर� �वडंो म� दसूर� फाइल को खोलना

Question Type : MCQ
Question ID : 618278234

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.34 नए मेल मज� सेटअप �वज़ाड� म� फ़ाइल टाइप का चयन करने के बाद का �या �टेप है?
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1. फ़ाइल टाइप चनु�

2. एक �ारं�भक मेल चनु�

3. डॉ�यमू�ट �लख�/�यवि�थत कर�

4. �र�सप��स को चयन कर�

Question Type : MCQ
Question ID : 618278207

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.35 �न�न�ल�खत म� से कौन सा एक इनपटु/आउटपटु �डवाइस नह�ं है?

Ans 1. टचपडै

2. �ैकबॉल

3. RAM

4. माइ�ोफ़ोन

Question Type : MCQ
Question ID : 618278183

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.36 MS-ए�सेल 2016 म� होम टैब के �ा�प सब-मे�य ूम� ‘�ोटे�ट शीट’ का उ�े�य �या है?

Ans 1. दसूर� को फ़ाइल खोलने और उ�ह� अवां�छत फाम��टगं करने क� अनमु�त देना

2. �न�द��ट शीट म� दसूर� �वारा अवां�छत प�रवत�न करने से रोकना

3. दसूर� को फ़ाइल खोलने से रोकना

4. �व�श�ट शीट को वायरस से बचाना

Question Type : MCQ
Question ID : 618278224

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.37 MS-ए�सेल के फॉमू�ला मे�य ूम� ‘मथै एंड ��ग’ ’फ़ं�शन �न�न�ल�खत म� से कौन सा नह�ं है?

Ans 1. LOG

2. SWITCH

3. LCM

4. SUM

Question Type : MCQ
Question ID : 618278227

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.38 कोई कॉलेज �वेश के �लए फॉम� ��टं (म�ु�त) करना चाहता है। इस फाम� म� कॉलेज के लोग� को साम�ी के पीछे
पारदश� पाठ के �प म� रखने क� आव�यकता है। MS-Word म� �न�न�ल�खत म� से �कस फं�शन का उपयोग

ANKAJ INFOTECH



1/27/2020 https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S10D58/1575523181882621…

https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S10D58/15755231818826211/19362207… 11/16

�कया जा सकता है?

Ans 1. पेज बॉड�स� (प�ृठ सीमाएँ)

2. पेज कलर (प�ृठ रंग)

3. इफे��स (�भाव)

4. वाटर-माक�

Question Type : MCQ
Question ID : 618278196

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.39 वष� 2019 के �लए 78 कंप�नय� का �ब�� का डटेा है। उन कंप�नय� का चयन करना आव�यक है िजनक� वष� के
दौरान �ब�� 1000 इकाइय� से अ�धक है। इसके �लए MS-ए�सेल म� कौन से फ़ं�शन का उपयोग �कया
जाएगा?

Ans 1. सॉट�

2. फाइंड

3. ए�डट

4. गो टू

Question Type : MCQ
Question ID : 618278221

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.40 चय�नत टे��ट (पाठ) के म�य से काटने के �लए एक रेखा के काय� को ______ के �प म� जाना जाता है।
Ans 1. सपुरि���ट

2. ��ाइक�ू

3. च�ज केस

4. सबि���ट

Question Type : MCQ
Question ID : 618278198

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.41 मेल मज� म� �न�न�ल�खत म� से कौन सा मानक द�तावेज़ नह�ं है?

Ans 1. डाइरे�टर� (�नद��शका)

2. लेटर (प�)

3. इनवेलप (�लफाफ�)

4. म�ैरज काड� (शाद� काड�)

Question Type : MCQ
Question ID : 618278205

Status : Answered
Chosen Option : 4
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Marks : 1.00

Q.42 मेमोर� मनेैजम�ट (�बंधन) ______ क� एक �वशषेता/�ह�सा है।
Ans 1. अ�ल�केशन (अन�ुयोग) सॉ�टवेयर

2. �स�टम सॉ�टवेयर

3. �कैनर

4. मॉ�नटर

Question Type : MCQ
Question ID : 618278187

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.43 MS-वड� 2016 फ़ाइल का फाइल ए�सट�शन कौन सा है?

Ans 1. .docx

2. .pdf

3. .xlsx

4. .exe

Question Type : MCQ
Question ID : 618278195

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.44 MS-वड� फ़ाइल म� कोई छा� �डफ़ॉ�ट फ़ॉ�ट कलर (रंग) के साथ नो�स तयैार कर रहा है और वह पीले रंग क�
प�ृठभ�ूम म� कुछ �मखु �बदंओु ंको �चि�नत करना चाहता है। इस उ�े�य के �लए उसे �न�न�ल�खत म� से �कस
�वक�प का उपयोग करना चा�हए?

Ans 1. फॉ�ंट कलर

2. थी�स

3. फ़ॉ�ट �टाइल

4. टे�सट हाइलाइट कलर

Question Type : MCQ
Question ID : 618278201

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.45 डजेी �ह�ल ______ का एक �कार है।
Ans 1. �पीकर

2. ��टंर

3. �कैनर

4. मॉ�नटर

Question Type : MCQ
Question ID : 618278185
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Status : Answered
Chosen Option : 4

Marks : 0.00

Q.46 मेल मज� म� �कसी मौजदूा लेबल को संशो�धत करने के �लए चरण� का सह� �म �या है?

Ans 1. मे�ल�ंस > लेब�स > ऑ�शन > �ॉड�ट नंबर > �डटे�स

2. मे�ल�ंस > मचै फ���स

3. मे�ल�ंस > �र�सप��स चनु� > आउटलकु कॉ�टे��स से चनु�

4. इनसट� > �ॉस �रफर�स > ऑ�शन

Question Type : MCQ
Question ID : 618278208

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.47 कैश मेमोर� का उपयोग ______ के �लए �कया जाता है।
Ans 1. �ो�ाम �न�पादन के दौरान बार-बार उपयोग �कए जाने वाले �ो�ाम �नद�श� और डटेा को �टोर करने

2. इनपटु आउटपटु �डवाइस हेत ु�ाइवस� को �टोर करने

3. �थाई �प से डटेा �टोर करने

4. बाहर� �फ�म� और गान� को �टोर करने

Question Type : MCQ
Question ID : 618278182

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.48 MS- ए�सेल म� �न�न�ल�खत म� से कौन सा फॉम��टगं से�स का एक �ह�सा है?

Ans 1. ��टं ���य ूदेखना

2. टेबल इनसट� करना

3. अलाइनम�ट और इंड��स

4. कम�ट �लखना

Question Type : MCQ
Question ID : 618278220

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.49 MS-ए�सेल 2016 के फॉम�ट सेल ऑ�शन म� से�ट�ंस के संबंध म� �न�न�ल�खत म� से कौन सा कथन गलत है?

Ans 1. रैप (wrap) टे�सट और अ�य अलाइनम�ट ऑ�श�स 'फाम�ट सेल' म� उपल�ध ह�

2. रैप (wrap) टे�सट और अ�य अलाइनम�ट ऑ�श�स फॉम�ट सेल' म� उपल�ध नह�ं ह�

3. �फल कलर को बदला जा सकता है

4. �व�भ�न कैटगर�ज क� सं�या का फॉम�ट �नधा��रत �कया जा सकता है

Question Type : MCQ
Question ID : 618278215
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Status : Answered
Chosen Option : 3

Marks : 0.00

Q.50 �लाइड सॉट�र �य ूम� चय�नत (�सले�टेड) �लाइड के साथ �न�न�ल�खत म� से कौन से काय� को नह�ं �कया जा
सकता है?

Ans 1. टेबल इंसट� करना

2. नई �लाइड जोड़ना

3. से�शन को जोड़ना

4. फॉम�ट बकै�ाउंड (प�ृठभ�ूम) म� प�रवत�न

Question Type : MCQ
Question ID : 618278233

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.51 What is the full form of VSAT in network/internet?
Ans 1. Very Short Apply Terminal

2. Very Small Aperture Terminal

3. Very Small Android Test

4. Very Short Application Test

Question Type : MCQ
Question ID : 618278237

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.52 ईथरनेट एडा�टर/ नेटवक�  इंटरफेस काड� ओ.एस.आई. मॉडल क� �न�न�ल�खत म� से कौन सा लेयर पर काम
करता है?

Ans 1. डटेा �लकं लेयर

2. अ�ल�केशन लेयर

3. �ज�टेशन लेयर

4. �ांसपोट� लेयर

Question Type : MCQ
Question ID : 618278236

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.53 �कसी परुाने ए�से (पत)े को संपा�दत करने और नया ए�से (पता) जोड़ने के �लए, मेल मज� म� �कस �वक�प का
उपयोग �कया जा सकता है?

Ans 1. लेटस�

2. डाइरे�टर�

3. लेब�स

4. इनवेल�स
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Question Type : MCQ
Question ID : 618278206

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.54 What is the full form of APIPA?
Ans 1. Automatic Public Investment Procedure Assembly

2. Authorised Private Internet Protocol Addressing

3. Automatic Private Internet Protocol Addressing

4. Automatic Public Internet Protocol Addressing

Question Type : MCQ
Question ID : 618278239

Status : Answered
Chosen Option : 3

Marks : 1.00

Q.55 MS-वड� म� "फ़ॉ�ट" डायलॉग बॉ�स �ा�त करने के �लए शॉट�कट क� (कंुजी) �या है?

Ans 1. Ctrl + Shift + R

2. Ctrl + D

3. Ctrl + L

4. Ctrl + Shift + U

Question Type : MCQ
Question ID : 618278202

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.56 �न�न�ल�खत म� से �या MS-ए�सेल म� �डफ़ॉ�ट �प से द� गई आकृ�तय� क� �ेणी नह� ंहै?

Ans 1. �माट�आट�

2. रे�ट�ग�स

3. �लॉक ऐरोज

4. इ�वेश श�ेस

Question Type : MCQ
Question ID : 618278229

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.57 �स�टम सॉ�टवेयर म� सी.पी.य.ू का पणू� �प �या है?

Ans 1. कैरे�टर यजूर इंटरफ़ेस

2. कोड यजूर आइड��ट�फकेशन

3. कैरे�टर यजेूबल इंटरकने�शन

4. कोड यजूर इंटरफेस

Question Type : MCQ
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Question ID : 618278186
Status : Answered

Chosen Option : 3
Marks : 0.00

Q.58 �कसी MS-ए�सेल शीट म�, उपयोगी रोज और कॉल�स के बीच अ�य�ुत रोज और कॉल�स ह�। उन अ�य�ुत
रोज और कॉल�स को हटाना आव�यक है। इसके �लए �न�न�ल�खत म� से �या कदम उठाए जाएंगे?

Ans 1. सेल चनु� > होम > �डल�ट > �डल�ट शीट रोज या �डल�ट शीट कॉल�स

2. सेल चनु� > होम > �डल�ट से�स

3. सेल चनु� > �य ू> शो > ��डलाइ�स चेक बॉ�स

4. सेल चनु� > �य ू> जमू > ��डलाइ�स चेक बॉ�स

Question Type : MCQ
Question ID : 618278213

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.59 �कस �वक�प से हम देख सकत ेह� �क मेल मज� म� म�ु�त या भेजे जाने के बाद कैसे हमारे लेटर (प�), ई-मेल
मसेैज (संदेश), इनवेलप (�लफाफे), लेबल या डाइरे�टर� (�नद��शका) �दखाई द�गे?

Ans 1. डॉ�यमू��स �लख�/�यवि�थत कर�

2. मज� को परूा कर�

3. डॉ�यमू��स टाइप चनु�

4. अपने डॉ�यमू��स का पवूा�वलोकन कर�

Question Type : MCQ
Question ID : 618278209

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.60 कोई �नवेशक वष� 2018 क� अव�ध के �लए शयेर क� क�मत� म� �झान को जानना चाहता है। उसके �लए
�न�न�ल�खत म� से कौन सा �वक�प उपयोगी होगा?

Ans 1. पाई चाट�

2. डोनट

3. लाइन चाट�

4. कॉलम चाट�

Question Type : MCQ
Question ID : 618278228

Status : Answered
Chosen Option : 1

Marks : 0.00
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Q.1 एमएस वड� 365 म � �न�न�ल�खत म � से कौन सा क�बोड� शॉट�कट, लेआउट टैब के "पेज सेटअप" �ुप म� मा�ज �न
�वक�प को स��य करने के �लए उपयोग �कया जा सकता है?

Ans 1. एक साथ CTRL + M दबाए ँऔर �फर P दबाएँ

2. एक साथ ALT + M दबाए ँऔर �फर P दबाएँ

3. एक साथ ALT + P दबाए ँऔर �फर M दबाएँ

4. एक साथ CTRL + P दबाए ँऔर �फर M दबाएँ

Question Type : MCQ
Question ID : 558548143

Status : Answered
Chosen Option : 3

Marks : 1

Q.2 एमएस-वड� 365 म � �न�न�ल�खत म � से कौन सा �वक�प मे�ल �ग टैब का � ुप नह� है?

Ans 1. राइट एडं इंसट� फ�� (Write & Insert Fields)

2. �टाट� मेल मज� (Start Mail Merge)

3. पैरा�ाफ (Paragraph)

4. ��एट (Create)

Question Type : MCQ
Question ID : 558548161

Status : Answered
Chosen Option : 3

Marks : 1

Q.3 �न�न�ल�खत म � से कौन सी लो-लेवल ल ��वेज (low-level languages) है, �जसके �लए एक �ो�ामर को डेटा
�टोरेज और ऑपरेशन के कं�यूटर के सभी �व�श� फ�चस� को �� �प से �बं�धत करने क� आव�यकता होती
है?

 
Ans 1. मशीन और हाई लेवल ल ��वेज

2. अस �बली और मशीन ल ��वेज

3. मशीन और अस �बली ल ��वेज

4. मशीन और ऑ�जे�ट-ओ�रएटेंड ल ��वेज

Question Type : MCQ
Question ID : 558548121

Status : Answered
Chosen Option : 4

Marks : 0

Participant ID S220204404
Participant Name DHIRENDRA KUMAR
Test Center Name iON Digital Zone iDZ 1 Patliputra
Test Date 02/11/2022
Test Time 2:00 PM - 3:00 PM
Subject Stenographer
Marks Obtained 35

Section : Stenographer



Q.4 �स�टम सॉ�टवेयर के संदभ� म � �न�न�ल�खत म � से कौन सा कथन अस�य है?

Ans 1. एक उ� �तरीय कं�यूटर ल ��वेज म � �लखा जाना चा�हए, �जसे स ��ल �ोसे�स �ग यू�नट (CPU) और अ�य कं�यूटर
हाड�वेयर रीड कर सकते ह �।

2. सीधे उस हाड�वेयर से जुड़ता है जो कं�यूटर को चलने म � स�म बनाता है।

3. अ�सर एक �ो�ा�म �ग ल ��वेज के उपयोग क� आव�यकता होती है, �जसे अ�धक सहज यूजर इंटरफेस (UI) क�
तुलना म � उपयोग करना अ�धक क�ठन होता है।

4. कं�यूटर �स�टम म � उ� �तरीय सॉ�टवेयर के �लए एक �भावी �लेटफॉम� �दान करने के �लए �जतना संभव हो,
उतना कुशल होना चा�हए।

Question Type : MCQ
Question ID : 558548125

Status : Answered
Chosen Option : 1

Marks : 1

Q.5 �न�न�ल�खत म � से कौन सी, इंटरनेट क� 'संचार सेवा (क�यु�नकेशन स�व �स)' है?

Ans 1. वी�डयो कॉ��� �स �ग

2. फाइल �ांसफर

3. सूचना पुन�ा���त सेवाएँ

4. वेब सेवाएं

Question Type : MCQ
Question ID : 558548167

Status : Answered
Chosen Option : 3

Marks : 0

Q.6 �व �डोज ए�सपी (XP) कं�यूटर म � फाइल या फो�र खोजने के �लए चरण� के सही �म क� पहचान कर �।

Ans 1. �टाट� -> फॉर फाइल ऑर फो�र -> सच� (Start -> For Files or Folders ->Search)

2. �टाट� -> सच� -> फॉर फाइल ऑर फो�र (Start -> Search -> For Files or Folders)

3. �टेटस -> सच� -> फॉर फाइल ऑर फो�र (Status -> Search -> For Files or Folders)

4. फाइल -> सच� -> फॉर फाइल ऑर फो�र (File -> Search -> For Files or Folders)

Question Type : MCQ
Question ID : 558548129

Status : Answered
Chosen Option : 2

Marks : 1

Q.7 एमएस-पॉवरपॉइंट 365 म �, इंसट� टैब म � �न�न�ल�खत म � स े�कस �वक�प म � 'इ�वेशन' ऑ�जे�ट होता है?

Ans 1. इल��ेशन (Illustrations)

2. टे��ट (Text)

3. ऐड-इ�स (Add-ins)

4. �स �बल (Symbols)

Question Type : MCQ
Question ID : 558548180

Status : Answered
Chosen Option : 1

Marks : 0



Q.8 एमएस-ए�सेल 365 म � �दए गए फं�न का उपयोग करने पर सेल C2 का मान �या होगा?

C2=Round(A2,2), य�द सेल A2 म � मान 5.66666666666667 है।

Ans 1. 5.7

2. 5.67

3. 6.00

4. 5.68

Question Type : MCQ
Question ID : 558548150

Status : Answered
Chosen Option : 2

Marks : 1

Q.9 �न�न�ल�खत म � से कौन सा एक ऐसा नेटव�क �ग �डवाइस है �जसका उपयोग आमतौर पर एक वाइड ए�रया
नेटवक�  (WAN) बनाने हेतु लैन (LAN) को इंटरकने�ट करने के �लए �कया जाता है?

Ans 1. मॉडेम

2. हब

3. �रपीटर

4. राउटर

Question Type : MCQ
Question ID : 558548164

Status : Answered
Chosen Option : 1

Marks : 0

Q.10 एमएस-वड� 365 म �, लेआउट टैब के ‘पेज सेटअप’ � ुप म � �न�न�ल�खत म � से कौन सा �वक�प उपल� नह� होता
है?

Ans 1. इंड�ट (Indent)

2. मा�ज �न (Margins)

3. साइज (Size)

4. ओ�रएटेंशन (Orientation)

Question Type : MCQ
Question ID : 558548137

Status : Answered
Chosen Option : 1

Marks : 1

Q.11 इंसट� टैब के ‘टे��ट’ � ुप के भीतर �न�न�ल�खत म � स ेकौन सा �वक�प पूरी एमएस-ए�सेल वक� शीट को एमएस-
पॉवरपॉइंट 365 से �ल �क करने के �लए उपयोग �कया जाता है?

Ans 1. ऑ�जे�ट (Object)

2. हैडर एडं फूटर (Header & Footer)

3. वड� आट� (Word Art)

4. टे��ट बॉ�स (Text Box)

Question Type : MCQ
Question ID : 558548178

Status : Answered
Chosen Option : 1

Marks : 1



Q.12 �न�न�ल�खत म � से कौन �ो�ाम और ए��लकेशन का ��त�न�ध�व करने वाला �तीक है, और �व �डोज ए�सपी
(XP) म � �कसी आइटम, फ़ाइल या �ो�ाम के शॉट�कट के �प म � काय� करता है?

Ans 1. टा�क बार

2. �स�टम �े

3. �टाट� बटन

4. आइकन

Question Type : MCQ
Question ID : 558548127

Status : Answered
Chosen Option : 4

Marks : 1

Q.13 एमएस-वड� 365 म � संपूण� टेबल को सेले�ट करने के �लए �न�न�ल�खत म � से �कस �वक�प का उपयोग �कया
जाता है?

Ans 1. �जस टेबल को आप सेले�ट करना चाहत ेह �, उसके बाहर अपन ेमाउस पॉइंटर को ��लक कर � और �ैग कर�।

2. टेबल के बाहर ��लक कर �, और �फर टेबल मूव ह �डल (Table Move Handle) पर ऊपरी-बाए ँकोने म � ��लक
कर �।

3. टेबल म � ��लक कर �, और �फर टेबल मूव ह �डल पर �नचले-बाए ँकोने म � ��लक कर�।

4. टेबल म � ��लक कर �, और �फर टेबल मूव ह �डल पर ऊपरी-बाए ँकोने म � ��लक कर�।

Question Type : MCQ
Question ID : 558548148

Status : Answered
Chosen Option : 4

Marks : 1

Q.14 �न�न�ल�खत म � से कौन सा इंटरनेट कने�न, इंटरनेट से जुड़ने के �लए रे�डयो ���व �सी ब �ड का उपयोग करता है
और ब�त तेज ग�त �दान करता है?

Ans 1. आईएसडीएन (ISDN)

2. वायरलेस (Wireless)

3. डीएसएल (DSL)

4. केबल ट�वी (Cable TV)

Question Type : MCQ
Question ID : 558548168

Status : Answered
Chosen Option : 2

Marks : 1

Q.15 एमएस-वड� 365 म �, �न�न�ल�खत म � से कौन सा टैब, टेबल के �लए ��डलाइ�स और �ॉपट�ज स�हत �व�भ�
से�ट �ग �दान करता है?

Ans 1. �डज़ाईन (Design)

2. लेआउट (Layout)

3. � ू (View)

4. �र� ू (Review)

Question Type : MCQ
Question ID : 558548141

Status : Answered
Chosen Option : 2

Marks : 1



Q.16 �व �डोज ए�सपी (XP) म � मु�य फाइल �बंधन उपकरण �या होता है?

Ans 1. होम (Home)

2. माइ नेटवक�  �लेस (My Network Places)

3. कं�ोल पैनल (Control Panel)

4. माइ कं�यूटर (My Computer)

Question Type : MCQ
Question ID : 558548130

Status : Answered
Chosen Option : 1

Marks : 0

Q.17 �न�न�ल�खत म � से कौन सा सॉ�टवेयर �व�भ� �कार के काय� को पूरा करने म � उपयो�कता�� क� सहायता के
�लए �डजाइन �कया गया है, जो उ�पादकता, रचना�मकता या संचार से संबं�धत हो सकता है?

Ans 1. एटं� वायरस

2. यू�ट�लट�

3. ए�लीकेशन

4. �स�टम

Question Type : MCQ
Question ID : 558548124

Status : Answered
Chosen Option : 3

Marks : 1

Q.18 �व �डोज ए�सपी (XP) डे�कटॉप म � �न�न�ल�खत म � से कौन सा �वक�प डे�कटॉप के �नचले भाग म � छोट� नीली
बार (bar) है और इसम � �टाट� मे�यू और ��वक लॉ�च बार शा�मल होती है?

Ans 1. टा�क बार

2. �टाट� बार

3. टाइटल बार

4. मे�यू बार

Question Type : MCQ
Question ID : 558548128

Status : Answered
Chosen Option : 1

Marks : 1

Q.19 एमएस-वड� 365 म �, आप वड� डॉ�यूम �ट को _______ फाइल के �प म � सेव करके एक टे� पलेट बना सकते ह�।

Ans 1. .docx

2. .txt

3. .pdf

4. .dotx

Question Type : MCQ
Question ID : 558548136

Status : Answered
Chosen Option : 4

Marks : 1



Q.20 एमएस-वड� 365 म �, टेबल बनाने के �लए आव�यक पं��य� और �तंभ� क� �यूनतम सं�या �कतनी है?

Ans 1. दो पं�� और एक �तंभ

2. एक पं�� और एक �तंभ

3. दो पं�� और दो �तंभ

4. एक पं�� और तीन �तंभ

Question Type : MCQ
Question ID : 558548144

Status : Answered
Chosen Option : 1

Marks : 0

Q.21 एमएस-पॉवरपॉइंट 365 म � सेट अप �लाइड शो के �न�न�ल�खत म � से �कस �वक�प �लाइड शो को तब तक लूप
करने के �लए उपयोग �कया जाता है जब तक �क देखने वाल ेलोग Esc कंुजी (key) नह� दबाते ह�?

Ans 1. � ेज �टटेड बाइ ऐन इं�ड�वजुअल (फुल ���न)

2. �ाउ� बाइ ऐन इं�ड�वजुअल (�व �डो)

3. �ाउ� ऐट ए क�ओ�क (फुल ���न)

4. � ेज �टटेड बाइ ए �ीकर (फुल ���न)

Question Type : MCQ
Question ID : 558548177

Status : Answered
Chosen Option : 1

Marks : 0

Q.22 एमएस-पॉवरपॉइंट 365 म � � ेज �टेशन को टे� पलेट के �प म � सेव करने के �लए �न�न�ल�खत म � से �कस फाइल
फॉम �ट का उपयोग �कया जाता है?

Ans 1. .pdf

2. .pps

3. .pptx

4. .potx

Question Type : MCQ
Question ID : 558548173

Status : Answered
Chosen Option : 3

Marks : 0

Q.23 �न�न�ल�खत म � से कौन सा �वक�प संक�लत भाषा (compiled language) का उदाहरण है?

Ans 1. PHP (पीएचपी)

2. Ruby (�बी)

3. Python (पाइथन)

4. Java (जावा)

Question Type : MCQ
Question ID : 558548122

Status : Answered
Chosen Option : 2

Marks : 0



Q.24 एमएस-ए�सेल 365 म �, B1 से D13 तक क� सेल र �ज को _______ के �प म � �न��पत �कया जाता है।

Ans 1. B1::D13

2. B1..B13

3. B1:D13

4. B1-D13

Question Type : MCQ
Question ID : 558548151

Status : Answered
Chosen Option : 3

Marks : 1

Q.25 जब आप एमएस-वड� 365 डॉ�यूम �ट के �कसी भी श�द पर डबल ��लक कर�गे तो �या होगा?

Ans 1. श�द �डलीट हो जाएगा

2. श�द सेले�ट हो जाएगा

3. श�द वाला पूरा वा�य सेले�ट हो जाएगा

4. श�द वाला पूरा पैरा�ाफ सेले�ट हो जाएगा

Question Type : MCQ
Question ID : 558548142

Status : Answered
Chosen Option : 3

Marks : 0

Q.26 इंटरनेट ए�स�लोरर, _______ �ारा �वक�सत एक वेब �ाउ�ज �ग सॉ�टवेयर है।

Ans 1. गूगल

2. मो�जला

3. माइ�ोसॉ�ट

4. ओपेरा

Question Type : MCQ
Question ID : 558548170

Status : Answered
Chosen Option : 3

Marks : 1

Q.27 एमएस-वड� 365 म � �कसी डॉ�यूम �ट के �� �ट �ी� ू म � मा�ज �न को समायो�जत करते समय �न�न�ल�खत म � से कौन
सा �वक�प उपल� नह� होता है?

Ans 1. अन�मरड� (Unmirrored)

2. �मरड� (Mirrored)

3. वाइड (Wide)

4. मॉडरेट (Moderate)

Question Type : MCQ
Question ID : 558548138

Status : Answered
Chosen Option : 2

Marks : 0



Q.28

Ans

1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 558548154

Status : Answered
Chosen Option : 4

Marks : 1

Q.29 �न�न�ल�खत म � से कौन सा लोकल ए�रया नेटवक�  (LAN) का लाभ नह� है?

Ans 1. �डवाइस एक �सरे के साथ फाइल � शेयर करते ह �

2. �डवाइस� तक ए�सेस होती है और यहा ंतक �क इ�ह � एक-�सरे के �ारा �नयं��त भी �कया जा सकता है

3. �डवाइस एकल इंटरनेट कने�न का उपयोग नह� कर सकते ह �

4. �डवाइस शेयड� �� �टर पर �� �ट कर सकते ह �

Question Type : MCQ
Question ID : 558548163

Status : Answered
Chosen Option : 3

Marks : 1

Q.30 एमएस-ए�सेल 365 म � �दए गए फॉमू�ले का उपयोग करने पर सेल C2 का मान �या होगा?

C2=IF(AND(A2>=A4,A2<=A5),A6,A7)

जहाँ संबं�धत सेल� (cells) म � ये मान ह �: A2=200, A3=300, A4=400 A5=500, A6=600

Ans 1. 0

2. 600

3. 500

4. 200

Question Type : MCQ
Question ID : 558548149

Status : Answered
Chosen Option : 3

Marks : 0



Q.31 एमएस-पॉवरपॉइंट 365 म � � ेज �टेशन देते समय टॉ�क �ग पॉइंट्स, �जनका हम उ�लेख करना चाहते ह�, को �टोर
करने का �ान �न�न�ल�खत म � से कौन सा है?

Ans 1. नोट्स पैन (Notes pane)

2. �लाइड पैन (Slide pane)

3. टाइटल बार (Title bar)

4. �रबन (Ribbon)

Question Type : MCQ
Question ID : 558548172

Status : Answered
Chosen Option : 2

Marks : 0

Q.32 एमएस-पॉवरपॉइंट 365 म � टाइ�स म � � ू (view) टैब के भीतर �न�न�ल�खत म � से कौन सा �वक�प ���न पर एक
साथ �ो�ाम �व �डो को ओपन करता है?

Ans 1. अर �ज आल (Arrange all)

2. मूव ��लट (Move split)

3. �यू �व �डो (New window)

4. केसकेड (Cascade)

Question Type : MCQ
Question ID : 558548176

Status : Answered
Chosen Option : 1

Marks : 1

Q.33 एमएस-ए�सेल 365 म � �न�न�ल�खत म � से कौन सा चाट� एक डेटा � ृंखला म � आइटम� के योगफल के समानुपाती,
आइटम� के आकार को दशा�ता है?

Ans 1. पाई (Pie)

2. �कैटर (Scatter)

3. कॉलम (Column)

4. लाइन (Line)

Question Type : MCQ
Question ID : 558548157

Status : Answered
Chosen Option : 3

Marks : 0

Q.34 �न�न�ल�खत म � से कौन सा कथन एमएस-वड� 365 के बुलेट और नंब�र �ग �वक�प के संबंध म � अस�य है?

Ans 1. नंब�र �ग �वक�प का उपयोग करके हम ब��तरीय सू�चयाँ बना सकते ह �।

2. होम टैब से बुलेट और नंब�र �ग �वक�प� का चयन �कया जा सकता है।

3. बुलेट �वक�प का उपयोग करके हम सेले� ट �कए गए डेटा को अ�फाबेट असाइन नह� कर सकते ह �।

4. नंब�र �ग �वक�प का उपयोग करके हम सेले� ट �कए गए डेटा को अ�फाबेट असाइन नह� कर सकते ह�।

Question Type : MCQ
Question ID : 558548146

Status : Answered
Chosen Option : 3

Marks : 0



Q.35 एमएस-वड� 365 म �, �ॉप कैप के �लए _______ लाइन� क� �डफ़ॉ�ट सं�या और �ॉप करने के �लए _______
अ�धकतम सं�या है।

Ans 1. 2; 11

2. 4; 10

3. 3; 10

4. 3; 11

Question Type : MCQ
Question ID : 558548145

Status : Answered
Chosen Option : 3

Marks : 1

Q.36 एमएस-पॉवरपॉइंट 365 म �, जब हम �कसी � ेज �टेशन के दौरान एक �लाइड से �सरी �लाइड पर जाते ह � तो
�न�न�ल�खत म � से कौन सा �वक�प ए�नमेशन जैसा �भाव �दान करता है?

Ans 1. �लाइड �डजाइन

2. �लाइड �ां�जशन

3. क�टम एनीमेशन

4. �लाइड ओ�रएटेंशन

Question Type : MCQ
Question ID : 558548175

Status : Answered
Chosen Option : 2

Marks : 1

Q.37 एमएस-वड� 365 म � सब����ट ��एट करने के �लए �न�न�ल�खत म � से �कस क�बोड� शॉट�कट का उपयोग �कया
जाता है?

Ans 1. Alt + Shift + =

2. Ctrl + Shift + =

3. Ctrl + =

4. Alt + =

Question Type : MCQ
Question ID : 558548140

Status : Answered
Chosen Option : 3

Marks : 1

Q.38

Ans 1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 558548155

Status : Answered
Chosen Option : 3

Marks : 1



Q.39 एमएस-वड� 365 म � �न�न�ल�खत म � से कौन सा �वक�प एक टेबल का मा�य व�ट �कल सेल अलाइनम �ट �वक�प
नह� है?

Ans 1. स �टर (Center)

2. बॉटम (Bottom)

3. ए�ॉस (Across)

4. टॉप (Top)

Question Type : MCQ
Question ID : 558548147

Status : Answered
Chosen Option : 3

Marks : 1

Q.40 �न�न�ल�खत म � से कौन सा �वक�प व�� वाइड वेब के समान नह� है?

Ans 1. W3

2. इंटरनेट (Internet)

3. वेब (Web)

4. WWW

Question Type : MCQ
Question ID : 558548166

Status : Answered
Chosen Option : 1

Marks : 0

Q.41 मेल मज� के रे�स�पएटं आमतौर पर मौजूदा सूची म � नाम� और डेटा क� सूची से आते ह�, जैसे एमएस-ए�सेल
� ेडशीट, या आउटलुक कांटे�ट �ल�ट। एमएस-वड� 365 म � इस सूची (�ल�ट) या डेटाबेस को �या कहा जाता है?

Ans 1. डेटा ए�सेस (Data access)

2. ए�वलप (Envelopes)

3. लेबल (Labels)

4. डेटा सोस� (Data source)

Question Type : MCQ
Question ID : 558548159

Status : Answered
Chosen Option : 4

Marks : 1

Q.42 इंटरनेट हाइपरटे��ट डॉ�यूम �ट्स को _______ नामक एक �वशेष माक� अप ल ��वेज का उपयोग करके �न��पत
�कया जाता है।

Ans 1. पाइथन

2. C

3. C++

4. HTML

Question Type : MCQ
Question ID : 558548165

Status : Answered
Chosen Option : 4

Marks : 1



Q.43 �न�न�ल�खत म � से कौन सी नवीनतम �ो�ा�म �ग ल ��वेज सामा�य �प से आ�ट ��फ�शयल इंटे�लज �स आधा�रत
सम�या� के �लए उपयोग क� जाती है?

Ans 1. C

2. डाक� बे�सक

3. अस �बली

4. पाइथन

Question Type : MCQ
Question ID : 558548126

Status : Answered
Chosen Option : 1

Marks : 0

Q.44 एमएस-वड� 365 म � �न�न�ल�खत म � से कौन सा क�बोड� (keyboard) शॉट�कट, �रबन को सं���त या �व�ता�रत
करने के �लए उपयोग �कया जाता है?

Ans 1. Ctrl + F3

2. Ctrl + F2

3. Ctrl + F1

4. Ctrl + F4

Question Type : MCQ
Question ID : 558548133

Status : Answered
Chosen Option : 4

Marks : 0

Q.45 एमएस-वड� 365 म � टे��ट को असाइन �कया जा सकने वाला सबसे बड़ा फॉ�ट साइज़ �या है?

Ans 1. 1638

2. 256

3. 1683

4. 512

Question Type : MCQ
Question ID : 558548139

Status : Answered
Chosen Option : 1

Marks : 1

Q.46 �व �डोज ए�सपी (XP) कं�यूटर म � नया �� �टर इं�टाल करने के �लए कं�ोल पैनल के �न�न�ल�खत म � से कौन से
�वक�प का इ�तेमाल �कया जा सकता है?

Ans 1. डेट, टाइम, ल ��वेज एडं रीजनल ऑ�श�स

2. ऐड ऑर �रमूव �ो�ा�स

3. �� �टर एडं अदर हाड�वेयर

4. ए�से�स�ब�लट� ऑ�श�स

Question Type : MCQ
Question ID : 558548131

Status : Answered
Chosen Option : 2

Marks : 0



Q.47 �व �डोज 10 ऑपरे�ट �ग �स�टम म � �न�न�ल�खत म � से कौन सा �वक�प एमएस-वड� डॉ�यूम �ट ओपन करने का सही
तरीका नह� है?

Ans 1. कं�यूटर पर �कसी एमएस-वड� फाइल को डबल-��लक करके ओपन कर �। य�द आपको फाइल ओपन करने के
�लए �कसी ए��लकेशन को चुनने के �लए कहा जाता है, तो "माइ�ोसॉ�ट वड�" चुन �।

2. रन डायलॉग बॉ�स म � "Word.exe" टाइप कर �

3. रन डायलॉग बॉ�स म � "WinWord.exe" टाइप कर �

4. �टाट� -> ऑल �ो�ाम -> माइ�ोसॉ�ट ऑ�फस -> माइ�ोसॉ�ट वड�

Question Type : MCQ
Question ID : 558548132

Status : Answered
Chosen Option : 2

Marks : 1

Q.48 एमएस-ए�सेल 365 म � टे�लेट के �लए �न�न�ल�खत म � से कौन सा �डफ़ॉ�ट फाइल फॉम �ट होता है?

Ans 1. .xlsb

2. .xlsx

3. .xlsm

4. .xltx

Question Type : MCQ
Question ID : 558548156

Status : Answered
Chosen Option : 4

Marks : 1

Q.49 �न�न�ल�खत म � से कौन सा इनडायरे�ट इंटरनेट ए�सेस �व�ध का उदाहरण है?

Ans 1. ईथरनेट

2. 4G मोबाइल नेटवक�

3. 3G मोबाइल नेटवक�

4. प��लक वाई-फाई

Question Type : MCQ
Question ID : 558548169

Status : Answered
Chosen Option : 4

Marks : 0

Q.50 �न�न�ल�खत म � से कौन-सी क�बोड� पर �वशेष फ़ं�न कंुजी (function key) होती है?

Ans 1. Delete

2. Home

3. Esc

4. Caps Lock

Question Type : MCQ
Question ID : 558548123

Status : Answered
Chosen Option : 3

Marks : 0



Q.51 एमएस-वड� 365 म � मेल मज� सोस� से मज� फ�� इंसट� करने के �लए �न�न�ल�खत म � से �कस क�बोड� शॉट�कट का
उपयोग �कया जाता है?

Ans 1. Alt + Shift + D

2. Alt + Shift + F

3. Alt + Shift + E

4. Alt + Shift + M

Question Type : MCQ
Question ID : 558548162

Status : Answered
Chosen Option : 2

Marks : 1

Q.52 एमएस-वड� 365 के �न�न�ल�खत म � से �कस टैब म � 'पैरा�ाफ' � ुप मे�यू उपल� होता है?

Ans 1. इंसट� (Insert)

2. होम (Home)

3. �ा (Draw)

4. �डज़ाईन (Design)

Question Type : MCQ
Question ID : 558548134

Status : Answered
Chosen Option : 2

Marks : 1

Q.53 एमएस-वड� 365 म � मेल मज� म � लेबल ��एट करने के �लए चरण� का �न�न�ल�खत म � से कौन सा �म सही है?

Ans 1. �डजाइन -> लेबल (Design->Labels)

2. लेआउट -> लेबल (Layout->Labels)

3. होम -> लेबल (Home->Labels)

4. मे�ल �ग -> लेबल (Mailings->Labels)

Question Type : MCQ
Question ID : 558548160

Status : Answered
Chosen Option : 4

Marks : 1

Q.54 एमएस-वड� 365 म � �न�न�ल�खत म � से कौन सा मोड / ��य एक अनए�डटेबल मोड म � फाइल ओपन करता है जो
कुछ त�व� को ��तबं�धत करता है, जैसे �ल ��ड इमेज और �लाउड फॉ� ट, जो वायरस या मैलवेयर से सं��मत हो
सकते ह �?

Ans 1. राईट-ओनली मोड (Write-Only Mode)

2. आउटलाइन � ू (Outline view)

3. �ोटे�टेड � ू (Protected View)

4. �ा�ट � ू (Draft view)

Question Type : MCQ
Question ID : 558548135

Status : Answered
Chosen Option : 2

Marks : 0



Q.55 एमएस-पॉवरपॉइंट 365 म �, �न�न�ल�खत म � से कौन सा �वक�प �लाइड पर डॉटेड आयताकार बॉ�स को संद�भ �त
करता है, �जसका उपयोग टे��ट, �ा�फ�स या अ�य �लाइड ऑ�जे�ट को रखने के �लए �कया जाता है?

Ans 1. �लाइड शो (Slide Show)

2. �लाइड लेआउट (Slide Layout)

3. थीम (Theme)

4. �लेसहो�र (Placeholder)

Question Type : MCQ
Question ID : 558548174

Status : Answered
Chosen Option : 2

Marks : 0

Q.56 एमएस-ए�सेल 365 म �, मज� सेल �वक�प होम टैब के �कस समूह म � उपल� होता है?

Ans 1. एलाइनम �ट (Alignment)

2. फॉ�ट (Font)

3. से�स (Cells)

4. नंबर (Number)

Question Type : MCQ
Question ID : 558548153

Status : Answered
Chosen Option : 1

Marks : 1

Q.57 एमएस-वड� 365 म �, मेल मज� म � �कस �कार का डॉ�यूम �ट, डेटा �ोत म � ��येक आइटम के �लए सूचना के एक
बैच को सूचीब� करता है?

Ans 1. डायरे�टरी (Directory)

2. लेबल (Label)

3. ईमेल (Email)

4. ए�वेलप (Envelopes)

Question Type : MCQ
Question ID : 558548158

Status : Answered
Chosen Option : 4

Marks : 0

Q.58 गूगल �ोम �ाउजर म � �न�न�ल�खत म � से �कस से�ट �ग �वक�प का उपयोग थीम और फॉ�ट बदलने के �लए �कया
जाता है?

Ans 1. ऑटो�फल (Autofill)

2. डाउनलोड (Downloads)

3. अपीयर �स (Appearance)

4. �ाइवेसी एडं �स�यू�रट� (Privacy and Security)

Question Type : MCQ
Question ID : 558548171

Status : Answered
Chosen Option : 3

Marks : 1



Q.59 एमएस-ए�सेल 365 म � एक अलग चाट� शीट म � वत�मान र �ज म � डेटा का चाट� बनाने के �लए �न�न�ल�खत म � से
�कस फ़ं�न कंु�जय� का उपयोग �कया जाता है?

Ans 1. F2

2. F7

3. F9

4. F11

Question Type : MCQ
Question ID : 558548152

Status : Answered
Chosen Option : 4

Marks : 1

Q.60 �न�न�ल�खत म � से कौन सा �वक�प एमएस-पॉवरपॉइंट 365 के संदभ� म � �दए गए कथन� क� स�यता का सव��म
वण�न करता है?

(i) कई �लाइड्स को �डलीट करने के �लए, �श�ट (Shift) को दबाए रख � और अपनी मनचाही �लाइड्स को
सेले�ट कर �, �फर राइट-��लक कर � और �डलीट �लाइड को सेले�ट कर �।
(ii) �लाइड के अनु�म को �डलीट करने के �लए, कं�ोल (Ctrl) को दबाए रख � और �लाइड के अनु�म का चयन
कर �, �फर राइट-��लक कर � और �डलीट �लाइड को सेले�ट कर �।

Ans 1. (i)- अस�य, (i)- स�य

2. (i)- अस�य, (ii)- अस�य

3. (i)- स�य, (ii)- अस�य

4. (i)- स�य, (ii)- स�य

Question Type : MCQ
Question ID : 558548179

Status : Answered
Chosen Option : 3

Marks : 0
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    All About Computer Practice 
Q.1. buesa ls dkSu lh eSeksjh dh lcls cM+h ;qfuV gS \  
 Which of the following is the biggest unit of memory? 
 xhxkckbZV (Gigabytes) ckbZV (bytes) esxkckbZV (Megabytes) fdyksckbV (Kilobytes) 
Q.2. lk¶Vos;j dk çkFkfed mís'; MsVk dks fdlesa ifjofrZr djuk gS\ 
 The primery purpose of software is to turn data into. 
 osclkbV (Website) bUQ+kWesZ'ku (Infromation) çksxzkEl (Programs) vkCtsDVl (Objects) 
Q.3. th- ;w- vkbZ- fdldk laf{kIr :i gS \  

GUI Stands for 
 xzkfQ+dy ;wtj bUVjQ+sl (Graphical User Interface) 
 xzsVj ;wtj bUVjQsl  (Greater User Interface) 
 xzkfQ+dy ;wfu;u bUVjQsl (Graphical Union Interface) 
 xzkfQdy ;wtj bUVjsLV  (Graphical User Intereat) 
Q.4. dh cksMZ ds ftu cVuksa ij rhj dk fu'kku gksrk gS mls dgrs gS & 
 Key board keys that have arrows on them are called - 
 QaD'ku dht (Function Keys)  usohxs'ku dht (Navigation Keys) 
 VkbijkbZVj dht (Typewriter Keys) Lis'ky iiZl dht (Special purpose keys) 
Q.5. ASSCII, EBCDIC vkSj ;wuh&dksM+] ,fIyds'ku~ lk¶Vos;j ds mnkjg.k gSA 
 ASSCII, EBCDIC and Unicode are examples of Application Software's 
  lgh (True)    xyr (False) 
Q.6. foUMkst] vkWijsfVax flLVe fLØu ds fdl Hkkx ij igq¡pus dk lcls vklku lk/ku gS & 
      The easiest way to access any part of the screen in the windows operating system is using the. 
 dh cksM+Z (Key Board)  jSV (Rat) ekml (Mouse) tkW;fLVd (Joystick) 
Q.7. lk¶Vos;j dks ------------- Hkh dgrs gSaA 
 A software is also called as a 
 çfØ;k (Procedure)  MsVk (Data) çksxzkEl (Programs) bUQkWesZ'ku (Information) 
Q.8. cSdvi çksxzkEl Qkbyksa dh dkWih cuk ysrh gSaA tks fd ewy Qkbyksa ds [kks tkus ;k {kfrxzLr gksus ij 

mi;ksx esa vkrh gSA 
 Back programs make copies of the files to be used in case the original files are damaged or lost. 
  lgh (True)     xyr (False) 
Q.9. ekbØksçkslslj dks çk;% lh ih ;w Hkh dgrs gSaA 
 Microprocessor is often called as CPU 
  lgh (True)    xyr (False) 
Q.10. ------------ ;wfVfyfV gkMZfMLd dh vuko';d Qkbyksa dks igpkurh gS vkSj ;wtj }kjk funsZ'k nsus ij mudks  feVkrh gSA 

........... Utility identifies unnecessary files on the hard disk and erases them based on users command. 
 cSd vi (Backup)     Qkby dEçs'ku (File Compression) 
 vubULVky çksxzkEl (Uninstall Programs)  fMLd Dyhu vi (Disk Clean up) 
Q.11. bl rjg ds lkW¶Vos;j dh lajpuk vkids dke dks vf/kd lqfo/kktud cukus ds fy, dh xbZ gS] ftldk mi;ksx O;olk;ksa esa  
        foLrr :i ls fd;k tkrk gSA 

This type of software is designes to help you be more productive tasks, and is widely used 
in nearly every discilive and occupation. 

 dE;wfuds'ku lkW¶Vos;j   (Communication Software)  
 ;wfVfyVh lkW¶Vos;j   (Utility Software) 
 csfld ,Iyhds'ku lkW¶Vos;j  (Basic Application Software) 
 flLVe lkW¶Vos;j   (System Software) 
Q.12. feuh dEI;wVlZ dks fuEu uke ls Hkh tkuk tkrk gSA           

Minicomputers are also known as. 
 feM jsUt dEI;wVlZ (Mid Range Computers)  
 ilZuy fMftVy dEI;wVlZ (Personal Digital Computers) 
 esuÝse dEI;wVlZ (Mainframe Computers) ysiVkWi dEI;wVlZ (Laptop Computers) 
Q.13. buesa ls fdl fMokbl dk mi;ksx rst+ j¶rkj ds dEI;wVj xsEl [ksyus ds fy, gksrk gSA 
 Which of the following device is used to play fast games on a computers. 
 Vp ljQsl (Touch Sruface)   Vp LØhu (Touch Screen)  
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 VSd ckWy (Track Ball)    tkW;fLVd (Joystick) 
Q.14. buesa ls fdldks iksVsZcy dEI;wVj ugha ekuk tk ldrk \ 
 Which of the following would not be consodered as portable computer. 
 MsLdVkWi dEI;wVj (Desktop Computer) uksV cqd dEI;wVj (Note book computer) 
 ilZuy fMftVy vflLVsaV (Personal Digital Assistent) buesa ls dksbZ ugha (None of these) 
Q.15. gSMQksu ,d vkmViqV midj.k gSA Headphone is a typical output device. 
  lgh (True)      xyr (False) 
Q.16. vubULVky dEI;wVj gkMZfMLd esa baLVky vokafNr çksxzkEl dks gVkus esa enn djrk gSA 
 Uninstall programs helps us to remove unwanted programs installed in the computer. 
  lgh (True)      xyr (False) 
Q.17. LVksjst fMokbl dh {kerk dks lkekU;r% ckbVl esa ekik tkrk gSA 
 The capacity of a storage device is usually measured in terms of bytes. 
  lgh (True)      xyr (False) 
Q.18. LVksjst fMokbl dh {kerk dks lkekU;r% ehVj esa fxuk tkrk gSA 
 Capacity of the storage device is usually measured in terms of meter. 
  lgh (True)      xyr (False) 
Q.19. -------------- ,d IokWbfUVax fMokbl gSA  

............ is a pointing device. 
 ekml (Mouse) fçaVj (Printer)  LdSuj (Scanner) dh cksMZ (Keyboard) 
Q.20. dh cksMZ ds ftu cVuksa ij F1, F2 vkfn fy[kk gksrk gS mudks -------------- dgrs gSaA 
 The keyboards keys that are labeled F1, F2 and so on are called ............. 
 QaD'ku dht (Function Keys)   U;weSfjd dht (Numeric Keys) 
 VkbijkbZVj dht (Typewriter Keys)  Lis'ky iiZl dht (Special purpose keys)  
Q.21. dSIl ykWd tSls fdlh fQpj dks 'kq: ;k cUn djus okys cVu dks dgrs gS & 
 The keyboard keys like Caps lock that turn on features on or off are called. 
 QaD'ku dht (Function Keys)   dkfEcus'ku dht (Combination Keys) 
 VkWxy dht (Toggle Keys)   Lis'ky iiZl dht (Special Purpose Keys) 
Q.22. oMZ çkslsflax] bysDVªkWfud LçsM'khV] MkVkcsl vksj xzkfQDl çksxzkEl dks bl ,d 'kh"kZd ds vUrxZr j[kk x;k gSA 

Word processing, electronic spread sheets, database managers and graphics programs 
are all grouped under the title. 

 czkmftax çksxzkEl (Browsings Programs)  vksijsfVax flLVe (Operating System) 
 ,sfIyds'ku lk¶Vos;j (Application Software) MsVk ,aM bUÝkWesZ'ku (Data and Information) 
Q.23. dh cksMZ] ekml] ekWuhVj vksj flLVe ;wfuV dks ----------------- Hkh dgrs gSA 
 Keyboard, mouse, monitor, and system unit collectively also known as 
 lkWfyM os;j (Solidware) lkW¶Vos;j (Software) gkMZ os;j (Hardware) Q+eZ os;j (Firm ware) 
Q.24. ekWuhVj ij ut++j vkus okys vkÅViqV dks lk¶VdkWih dgrs gSA 
 Output of an image on the monitor screen is often called soft copy. 
  lgh (True)      xyr (False) 
Q.25. ckbujh uacfjax flLVe esa 0 ls 1 dks ,d fcV dgk tkrk gSA 
 Each 0 and 1 in the binary numbring system is called a bit. 
  lgh (True)      xyr (False) 
Q.26. jSe ls ckj ckj ,Dlsl dh tkus okyh lwpuk dks LVksj djus ds fy, dS'k eSeksjh dk bLrseky gksrk gSA 
 Catch memory is used to store most frequently accessed infromation from the RAM. 
  lgh (True)      xyr (False) 
Q.27. flLVe cksMZ dks esu cksMZ ;k enj cksMZ Hkh dgk tkrk gSA 
 The system board is also known as the main board or mother board. 
  lgh (True)      xyr (False) 
Q.28. ASSCII, EBCDIC vksj ;wfu dksM ckbujh dksM Ldhe gSaA 
 ASSCII, EBCDIC and Unicode are binary coding schemes. 
  lgh (True)      xyr (False) 
Q.29. dh cksMZ ds ftu cVuksa ij 0 o 9 fy[ks gksrs gSa] mudks -------------- dgrs gSaA 
 The keys labeled 0-9 on the keyboard are called. 
 QaD'ku dht (Function Keys)   U;weSfjd dht (Numeric Keys) 
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 VkbijkbZVj dht (Typewriter Keys)  Lis'ky iiZl dht (Special purpose keys)  
Q.30. lh- Mh- jkWe dk eryc dkWEiSDV~ fMLd jhM vksUyh eseksjh gSA 
 A CD ROM stands for Compact Disk Read Only Memory. 
  lgh (True)      xyr (False) 
Q.31. ------------- esa Øe okj funsZ'k fn;s gksrs gSa] tks dEI;wVj dks djus dk rjhdk crkrs gSaA 
 ............ consists of step-by-step introductions that tells the computer how to complete the 
  task. 
 çksxzkEl (Programs) gkMZos;j (Hardware) MsVk (Data) vkWCtsDVl (Objects) 
Q.32. lh- Mh- vkj- dk eryc lh- Mh- jhdksMsZcy gSA A CD-R stands for CD-Recordable. 
  lgh (True)      xyr (False) 
Q.33. ----,d cSdxzkmUM lk¶Vos;j gS] ftldh enn ls dEI;wVj vius vkarfjd lalk/kuksa dks O;ofLFkr djrk gSA 
 ......... is a background soft ware that helps the computer to manage it's internal resources. 
 flLVe lkW¶Vos;j (System Software)   lwpuk (Information)  
 vkWCtsDl (Objects)     buesa ls dksbZ ugha (None of these) 
Q.34. fçaVj ij vkus okys vkmViqV dks gkMZdkWih dgrs gSA 
 Output of an image obtained using a printer is called as hard copy. 
  lgh (True)      xyr (False) 
Q.35. fuEufyf[kr lHkh QkbZy dEçs'ku çksXkzkEl gSa] flok;%  
 Following are the file compression programms, EXCEPT 
 fouf>i (Win Zip) jSM (RAID) fou jkj (Win RAR) ih-ds- f>i (PK Zip) 
Q.36. fdlh fMLd ij vusd orkdkj NYys gksrs gSa ftudks VªSd dgrs gSaA bu ij pqEcdh; fof/k ls vkadMsa vafdr fd;s tkrs gSA 
 A track on a disk is one of the many circular ring areas where data is written magnetically. 
  lgh (True)      xyr (False) 
Q.37. ¶ykWih fMLd ,d fjewoscy LVksjst fMokbl gSA 
 Floppy disks are removable storage media. 
  lgh (True)      xyr (False) 
Q.38. dh cksMZ ds ftu cVuksa ij rhj dk fu'kku cuk gksrk gS mls dgrs gSA 
 The keyboard keys that have arrows on them are called. 
 QaD'ku dht (Function Keys)   dkfEcus'ku dht (Combination Keys) 

Uksfoxs'ku dht Navigation Keys   Lis'ky iiZl dht (Special Purpose Keys) 
Q.39. ekbØksçkslslj dks çk;% lh- ih- ;w- dgrs gSA 
 Microprocessor is often called as CPU. 
  lgh (True)      xyr (False) 
Q.40. vkB fcV~l feydj ,d ckbV gksrk gSA 
 Eight bits make up a bite. 
  lgh (True)      xyr (False) 
Q.41. ekWuhVj ij utj vkus okys vkmViqV dks gkMZdkWih dgrs gSA 
 Output of an image on the monitor screen is often called hard copy. 
  lgh (True)      xyr (False) 
Q.42. ........ xzkfQdy vkWCtsDVl gksrs gSa] ftudk bLrseky vDlj mi;ksx dh tkus okyh ,Iyhds'ku dks çnf'kZr djus vksj vksiu  
        djus ds fy, gksrk gSA 
 ......... are graphical objects used to represent and open commonly used applications. 
 th- ;w- vkbZ- (G.U.I.) çkbulZ (Priners) foaMksl ,u-Vh- (Windows NT) vk;dkWu (Icons) 
Q.43. lh-Mh- jke dk eryc lh- Mh- vkj- MCY;w- gSA A CD-ROM means CD-RW. 
  lgh (True)      xyr (False) 
Q.44. jSe esa LVksj fd;k gqvk MsVk  

Data stored in RAM is 
 ifjorZu jfgr gksrk gSA (Is non-volatile) 
 ikoj ds jgus rd gh jgrk gSA (Is only there while the power is on) 
 ikoj cUn djus ds dqN feuV rd gh jgrk gSA  
 (Remains only a few minutes after the power is turned off) 
 LFkk;h gksrk gS] vksj ikoj Qsy gksus ij gh tkrk gSA 
 (Is permanent and only lost in power failure) 
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Q.45. lh-Mh-vkj- dk eryc lh-Mh jhtuy gS & 
 A CD-R stands for CD-Regional. 
  lgh (True)      xyr (False) 
Q.46. ekWuhVj dk çkFkfed mi;ksx ;wtj dks lwpuk fn[kkuk gSA 
 Primary function of a monitor is to display information to the user. 
  lgh (True)      xyr (False) 
Q.47. jSUMe ,Dlsl eSeksjh ¼jSe½ ----------- çdkj dh eSeksjh gksrh gSA 
 Random Access Memory (RAM) is .......... type of memory. 
 LFkk;h (Permanent) vLFkk;h (Temporary) ¶yS'k (Flash) LekVZ (Smart) 
Q.48 The external memory of the computer is present on the motherboard in the form of slots. 
   (False)                 (True)  
Q.49 The internal memory of the computer is present on the motherboard in the form of chips 
   (True)                 (False) 
Q.50 cache memory is used to store most frequently accessed information from the ram. 
   (True)                          (False) 
 

Windows Vista 
Q.1. The "System Date" and "System Time" are the date and time as maintained by the  
 computer's internal clock. 

flLVe MsV o flLVe Vkbe og rkjh[k o le; gSA tks dEI;wVj dh vkarfjd ?kM+h }kjk lapkfyr gksrs gSA 

  True / lgh      False/ xyr 
Q.2. Disk cleanup is used to rearrange your files so that they are not broken up. 

fMLd Dyhu vi dk mi;ksx Qkbyksa dks iquZØec) djus ds fy, fd;k tkrk gSA ftlls os vyx&vyx u jgsA 
  True/ lgh       False / xyr 
Q.3. In Window Vista a folder system is also called a "Directory System." 

foaMkst foLVk esa QksYMj flLVe dks Mk;jsDVªh flLVe Hkh dgrs gSA 

  True / lgh      False/ xyr 
Q.4. "rtf" stands for "rich text fromat" 
 rft dk iwjk vFkZ ^fjp VsDlV QkWjesV* gSA 
  True  / lgh       False / xyr 
Q.5. You can click on .............. to learn how to use Windows Vista, obtain troubleshooting 
 information, receive support and more. 

foaMkst foLVk ds mi;ksx dks tkuus vksj dfBu lwpuk dks çkIr djus esa enn rFkk vU; dk;ksZ ds fy, ---------------  

ij fDyd djrs gSA 

 "Search"/ lpZ    "Windows"/ foaMkst 
  "Start"/ LVkVZ    "Help & Support"/ gsYi ,aM liksVZ   
Q.6. In MS paint to draw a curved line, we have to click the .................... icon. 

,e ,l iSaV ,Iyhds'ku esa oØh; js[kk dks Mªk djus ds fy,] ge ------------------------ vkbdu ij fDyd djrs gSA 
 "Curve"/ doZ "Line"/ ykbu  "Polygon"/ ikWfyaxu "Rectangle"/ jSDVSaxy  
Q.7. ............... refers to the height and width of the characters to be printed. 
 ----------------- fçaV fd;s tkus okys dSjsDVj dh ÅpkabZ vkSj pkSMkbZ dks çnf'kZr djrk gSA 
 "Font Size" / QkWUV lkbZt   "Border"/ ckMZj  
 "Cell"/ lSy     "Font Style"/ QkWUV LVkby   
Q.8. There are the buttons which are present on the "Title bar". EXCEPT 

;s cVu Vk;Vy ckj ij miyC/k gksrs gS] flok; 
 Minimize/ fefu ekbZt    Start/ LVkVZ 
 Maximise/ eSfDlekbt    Close/ Dykst      
Q.9. Disk Defrangementer is used to to remove unnecessary files on your hard disk to free up 
 space and your computer run faster. 

fMLd fMÝWXesaVj dk mi;ksx vius gkMZ fMLd ls vuqi;ksxh Qkby dks gVkus] fMLd Lisl dks [kkyh djus o  

dEI;wVj dks rst xfr ls dk;Z djus esa enn djrk gSA 
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  True / lgh       False/ xyr   
Q.10. To change the size of your picture, Select "Image J Attributes" from the menu. 

viuh rLohj ds vkdkj cnyus ds fy, esU;w ls ^^best** J ,VªhC;wV lsysDV djrs gSA  
  True/ lgh      False / xyr 
Q.11. To start the calculator application click "Start" and select "All Programs 

J Accessories J Calculator." 
  dsydqysVj dks LVkVZ djus ds fy, LVkVZ ij fDyd djds vky çksxzke J ,Dlsfljht J dsydqysVj lsysDV  

djrs gSaA 

  True / lgh      False/ xyr 
Q.12. ............... can be used to create and format large and complex text documents. 

-------------------- dk mi;ksx cMs o tfVy VSDlv MkD;wesaV dks rS;kj djus vkSj QkWjesV djus ds fy, fd;k tk  

ldrk gSA 

"Calculator/ dSydqysVj   "WordPad"/ oMZiSM  

"NotePad"/ uksViSM    "TextPad"/ VSDlV iSM     
Q.13. Notepad is a basic text editor that can be used to create simple documents. 

uksVisM ,d ewy VSDlV ,fMVj gS ftlds mi;ksx ls vki lk/kkj.k MkD;wesaV rS;kj dj ldrs gSA 
  True / lgh      False/ xyr    
Q.14. A folder system is also called a "................"  
 QksYMj flLVe dks --------------------- Hkh dgrs gSA 
 "Direction System"/ Mk;jsD'ku flLVe "Directory System"/ Mk;jsDVªh flLVe  

"Directroy list"/ Mk;jsDVªh fyLV     "Folder book"/ QksYMj cqd 
Q.15. A folder within a folder is known as a "Folder list." 

  QksYMj ds vanj QksYMj ^^QksYMj fyLV** ds uke ls tkuk tkrk gSA 
  True/ lgh      False/ xyr 
Q.16. What is the name of the new "glass-like" effect on Windows Vista that displays  semi-
 transparent effects on dialog boxes. 

foaMkst foLVk esa u, Xykl&ykbd bQsDV dk uke D;k gS tks Mk;ykWx ckDl ij lseh VªkLisjsaV bQsDV dks  

çnf'kZr dj ldrk gSA 

 AERO/ , bZ vkj vks    OREA/ vks vkj , bZ   
Transparancy/ Vªkalisjslh  None of these/ buesa ls dksbZ ugha     

Q.17. A ............... is like a container in which you can store files. 
 -------------------- ,d daaVsuj tSlk gS ftlesa vki Qkbyksa dks LVksj dj ldrs gSA 
 "Icon"/ vkbdu "document"/ MkD;wesaV  "folder"/ QksYMj "Sheet"/ 'khV   
Q.18. The operating system's job is ............. . ,d vkWijfsfVax fllVe dk dke gSA 
 to exeute many useful commands easily. dbZ lkjs mi;ksxh dekaM dks vklkuh ls laikfnr djuk 

 to make request for service through a defined application programme interface. 
,Iyhds'ku çksxzke baVjQsl ds o.kZu }kjk lsok ds fy, vuqjks/k djuk 

 to control the computer at the most fundamental level./ dEI;wVj ds ekSfyd Lrj dks daVªksy djuk 
 None of these./ buesa ls dksbZ ugha 
Q.19. The windows interface is based on .................... ./ foaMkst baVjQsl ----------------------------- ij vk/kkfjr gSA 

  "Graphical user Interface" or GUI/ xzkfQdy ;wtj baVjQsl ;k GUI 
 Application Programme Interface or (API)/ ,Iyhds'ku çksxzke baVjQsl (API) 
 "Clipboard"/ fDyicksMZ   None of these/  buesa ls dksbZ ugha 
Q.20. The name of a file consists of two parts, the File Name and the subfile name. 
 fdlh Qkby uke ds nks Hkkx gksrs gS Qkby uke vkSj lcQkby uke 
  True/ lgh      False/ xyr 
Q.21. To access the location of the particular file quickly, you create a shortcut icon for the file 

and palce it on the desktop. 
 fdlh Qkby ij rqjUr igqpus ds fy, vki MsLdVkWi ij mldh yksds'ku dk 'kkVZdV vkbdu rS;kj djrs gSA 
  True / lgh      False/ xyr    
Q.22. In Windows Vista windows sidebar contains mini-programs called gadgets. 
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  foaMkst lkbMckj esa feuh çksxzke gksrs gS ftudks xStsV~l dgrs gSaA 

  True / lgh      False/ xyr    

Q.23. A file created using Notepad is stored with the extension .................. . 
 uksVisM dk mi;ksx djds rS;kj fd;k x;k MkD;wesaV ----------------------- ,DlVsa'ku ds lkFk LVksj gksrk gSA 
 ".txt"  ".docx"  ".png"  ".jpg" 
Q.24. In windows vista two types of "searchers" are supported: Regular search Instant search. 

  foaMkst foLVk esa lpZ nks çdkj ds gksrs gS & jsxqyj lpZ] balVsV lpZ  
  True / lgh      False/ xyr 
Q.25. When your computer is booted and is ready to use, the screen you see is called 

the ............ . 
cwV gksus ds ckn tc vkidk dEI;wVj mi;ksx ds fy, rS;kj gksrk gS] rks ftl LØhu dks vki ns[krs gS og  

dgykrh gSA 

 "Table top"/ VscyVkWi    "Desktop"/ MsLdVkWi    
"Laptop"/ ySiVkWi    None of these/ buesa ls dksbZ ugha    

Q.26. "Computer" is an application which performs functions same as that of a handheld 
calculator. 

 dEI;wVj ,slh ,Iyhds'ku gS tks gSaMgsYM dEI;wVj ds leku dk;Z djrk gSA 
  True/ lgh      False/ xyr    
Q.27. ............... is designed to prevent and remove spy ware. 
 Likbos;j gVkus vksj mlls j{kk djus ds fy, fMtkbu fd;k x;k gSA 
 User Account Control/ ;wtj vdkmaV daVªksy   Windows Firewall/ foaMkst Qk;joky
 Windows Defender/ foaMkst fMQsaMj    Parental Controls/ iSjsaVy daVªksy 
Q.28. The clipboard is not available in Windows Vista Programs. 

  foaMkst foLVk esa fDyicksMZ ekStwn ugha gksrs gSA 

  True/ lgh      False/ xyr 
Q.29. What is "Windows Aero" ?/ ^^foaMkst ,sjks** D;k gS \ 
 It is the graphical user interface for Windows XP. 

 foaMkst ,Dl-ih- ds fy, xzkfQdy ;wtj baVjQsl gSA 
 It is the graphical user interface for Windows Vista. 
 foaMkst foLVk ds fy, xzkfQdy ;wtj baVjQsl gSA 
 Application Program/ ,Iyhds'ku çksxzke gSA   None of these/ bues ls dksbZ ugha  
Q.30. Which is the basic program of a computer?/ dEI;wVj dk lcls ewyHkwr dkSulk çksxzke gS\ 
 Operating System/ vkWijsfVax flLVe   Software Program/ lk¶Vos;j çksxzke
 Application Program/ ,Iyhds'ku çksxzke  None of these/ buesa ls dksbZ ugha   
Q.31. As you type, the text Automatically moves to the next line it reaches the right end of the 
  margin. This feature is called "Word Wrap." 

  Vkbi djrs le;] tc ekftZu ds nkfgus Nksj ij igqap tkrs gS rks VsDlV Lor% gh vxyh ykbu esa Vkbi gksus  

yxrk gSA bl fQpj dks oMZ jSi dgrs gSA 

  True / lgh      False/ xyr 
Q.32. "Log Off" is a power-saving state./ ikoj lsfoax voLFkk gSA 
  True/ lgh      False/ xyr 
Q.33. In windows vista, you can see multiple programs running simultaneously on different  

areas of your screen. 
  True       False 
Q.34. The ........... menu is used to enhance the apperance of the contained presented in a 

document. 
 "Insert"  "Edit"  "Fromat"  "File" 
Q.35. The "text" tool is used to add text to a paint object. 
 iSaV esa VSDlV Vwy dk mi;ksx VSDlV tksMus ds fy, fd;k tkrk gSA 
  True / lgh      False/ xyr 
Q.36. "............." helps in gurding your computer against malicious software. 

  -------------------- vkids dEI;wVj dks fofHkUu çdkj ds vokafNr lk¶Vos;j ls lqj{kk djus esa enn djrk gSA 
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"Windows Firewall"/ foaMkst Qk;joky  "Windows Defender"/ foaMkst fMQsaMj  
"Spy ware"/ Likbos;j     None of these./ buesa ls dksbZ ugha   

Q.37. .............. is a basic text editing programme and it is most comonly used to view or edit text 
files. 

  ----------------------- ,d csfld VsDlV ,fMfVax çksxzke gS vkSj lkekU; :i ls bldk mi;ksx VsDlV Qkby ns[kus  

vkSj ,fMV djus ds fy, gksrk gSA 

 "Calculator"/^dsydqysVj*   "Notepad"/^uksViSM*  
 "Address book"/^,Mªsl cqd*   "Paint"/^iSaV*   
Q.38. In a windows operating system screen saver is / foaMkst vkWijsfVax flLVe ds LØhu lsoj 
 helps in gurding your computer against many types of malicious software. 

fofHkUu çdkj ds vokafNr lk¶Vos;j ls dEI;wVj dh lqj{kk esa enn djrk gSA 

 is a long, vertical bar that is displayed on the side of your desktop. 
 ,d yEck ofVZdy ckj gksrk gS rks MsLdVkWi dh ,d vksj çnf'kZr gksrk gSA 

 is a programme that displays on image, animation, or just a blank screen on a 
computer after on input has been received for a certain length of time. 
,d çksxzke gS tks dEI;wVj ij best] ,fues'ku ;k dqN le; rd dksbZ buiqV u feyus ij CySd LØhu fn[kkrk gS  
    None of these./ buesa ls dksbZ ugha 

Q.39. Features in Windows Vista make it easier, safer and more entertaining to use your PC        
 virtually anytime and anywhere. 

  foaMkst foLVk ds fQpj ;wtj dks ihlh dks opZqvy :i ls dHkh Hkh mi;ksx djus ds fy, vklku] lqjf{kr  

euksjatd cukrh gSA 

  True / lgh      False/ xyr    

Q.40. The programmes on the .................. in Windows Vista remain there and are always 
availble for you to click to start them. 

  foaMkst foLVk esa -------------------- ds çksxzke mlh esa jgrs gSa vksj LVkVZ fDyd djus ij ges’kk dke ds fy, rS;kj jgrs gSA 

 the "Most frequently use programmes list."/ eksLV fÝDosUVyh ;wtLM çksxzke fyLV  
 "pinned items list"/ fiUM vkbVe fyLV  "Documents" / MkD;wesaVl  
  "Control Panel"/ daVªksy iSuy 
Q.41. In Windows Vista ............. is a power-saving state. 
 foaMkst foLVk esa ikoj lsfoax voLFkk gSA 
 Log off/ ykWx&vkWQ  Sleep/ Lyhi  Restart/ fjLVkVZ  Lock/ ykWd 
Q.42. AERO is an abbervation of ................... / AERO fdldk lf{kIr :i gSA 

Authentic, Energetic, Reflective and Open./ vkWFksufVd ,utksfVd fj¶ysfDVo vksj vksiu  Airthmetic, 
Essential, Reflective and Open./ vfjFkesfVd ,lsaf'k;y fj¶ysfDVo vksj vksiu 
Airthemtic, Essential, Reflective and Object./ vfjFkesfVd ,lsaf'k;y fj¶ysfDVo vksj vkWCtsfDVo  
Authentic, Essential, Reflective and Open./ vkWFksufVd ,lsaf'k;y fj¶ysfDVo vksj vksiu 

Q.43. At the bottom of the screen, you can see a long, thin bar which is called as .................. 
  LØhu ds uhps ,d yEck vkSj iryk ckj ns[krs gS ftls -------------------------- dgk tkrk gSA 

 "Task bar" / VkLdckj   "Title bar"/ Vk;Vy ckj  
 "Menubar"/ esU;wckj    "Spacebar"/ Lislckj  
Q.44. In Windows Vista a "Clipboard" is .................... / foaMkst foLVk esa fDyi cksMZ -------------------------- gSA 
 an application program./ ,d ,Iyhds'ku çksxzke  

a temporary storage area for information that you have copied or moved from one 
place and plan to use somewhere else. 
lwpukvksa ds fy, rkRdkfyd LVksjst {ks= ftls vki ,d LFkku ls dkWih ;k ewo dj ldrs gSa vkSj fdlh vU;  

txg mi;ksx dj ldrs gSA 

an operating system. / ,d vkWijsfVax flLVe   None of these./ buesa ls dksbZ ugha 
Q.45. .............. is a basic text editing programme and it is most comonly used to view or edit text files. 

  ------------------- ,d csfld VsDlV ,fMfVax çksxzke gS vksj lkekU; :i ls bldk mi;ksx VsDlV Qkby dks ns[kus  

o ,fMV djus ds fy, gksrk gSA 

 "Calculator"/ dSydqysVj    "Notepad" / uksVisM  
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"Address book"/ ,Mªsl cqd    "Paint" / iSaV  
Q.46. ............., is a drawing programme that can be used to create modify graphic images. 

  -------------------------- ,d Mªkbax çksxzke gS ftldk mi;ksx xzkfQd best dks rS;kj djus vksj eksfMQkb djus ds fy,  

fd;k tk ldrk gSA 

 "Brush"/ cz'k  "Paint"/ iSaV  "Notepad"/ uksViSM  "Wordpad"/ oMZiSM 
Q.47. The ............. menu is used to enhance the apperance of the content presented in a 

document. 
 "Insert"  "Edit"   "Format"  "File" 
Q.48. A ............. is a rectangular section on the screen that is used to display information and 

other programme. 
  LØhu ij ------------------------- ,d vk;rkdkj Hkkx gS ftl ij lwpuk vksj vU; çksxzke çnf'kZr fd;s tkrs gSaA 

 Icon / vkbdu  Desktop / MsLdVkWi Window / foaMks Panel / iSuy   

Q.49. The capability of an operating system to run multiple programmes at the same time is 
called "Multitasking." 
Mk;jsDVªh flLVe dh fo'ks"krk ftlesa ,d lkFk dbZ çksxzke ij dk;Z fd;k tk ldrk gSA og {kerk eYVhVkfLdax dgykrh gSA 

  True / lgh      False/ xyr 
Q.50. In Window vista, you can see multiple Programme running simultaneously on different 

areas of your screen 
 True       False 
Q.51. The name of a file consist of two parts/  Qkby ds uke ds nks Hkkx gksrs gSA 
 Folder Name/ QksYMj use   Extension/ ,DlVsa'ku  

File Name/ Qkby use   Sub folder Name/ lc QksYMj use   

Q.52. We can Navigate through text using 
 bldk mi;ksx djds ge VSDlV esa ewo dj ldrs gSaA 
 Cpu /.lh-ih-;w-  Mouse/ ekml  Key board/ dhcksMZ  Moniter/ eksfuVj 
Q.53. vkWijsfVax flLVe dk dk;Z gSA 

isfjQsfj;y fMokbl rd igqap dks daVªksy djuk   buesa ls dksbZ ugha 

eSeksjh dk çcU/ku djuk     ekSfyd Lrj ij dEI;wVj dks daVªksy djuk 

Word Processing 
Q.1. In MS Word 2007 when text is selected, a "............" is automatically displayed. 
 ,e-,l- oMZ 2007 esa VsDlV lsysDV djus ij -------------------- Lor% çnf'kZr gksrk gSA 
 Taskbar / VkLdckj   Main Toolbar / fefuVwyckj  

Mini Toolbar / esu Vwyckj  Menu bar / esU;wckj 
Q.2. You can make for a TOC using: TOC dk mi;ksx djdsvki cuk ldrs gSaA 
 Heading styles. ¼gsfMax LVkbyl½  Custom styles. ¼dLVe LVkbyl½   

Outline levels. ¼vkmVykbu ysoYl½  All of these. ¼mijksDr lHkh½ 
Q.3. ............... contains command for opening, saving, printing and closing a file. 
 ------------------------ esa Qkby dks [kksyus] lso djus ,oa can djus ds fy, dekaM gksrh gSA 

"Home"/ gkse  "Office Button"/ vkWfQl cVu "View"/ U;w "Insert"/ balVZ  
Q.4. ............... offers a wide variently of options to design documents. 
 MkD;wesaV dks fMtkbu djus ds fy, --------------------- fofHkUu çdkj ds fodYi çnku djrs gSaA 

 Microsoft Excel/ EkkbØkslkW¶V ,Dlsy   Microsoft PowerPoint/ EkkbØkslkW¶V ikojIokbaV
 Microsoft Word/ EkkbØkslkW¶V oMZ   Microsoft Access/ EkkbØkslkW¶V ,Dlsl 
Q.5. All of the following Ribben tabs are displayed in Word 2007, EXCEPT 
 fn, x, lkjs fjcu VSc] oMZ 2007 esa çnf'kZr gksrs gSa flok;] 
 Home/ gkse  Insert/ balVZ  Tools/ VwYl  Page Layout/ istysvkmV 
Q.6. When you use the mouse to move the insertion point, the shape of mouse pointer is like I-beam. 
 tc vki bat'kZu IokbaV dks ewo djus ds fy, ekml dk mi;ksx djrs gSa rks ekml IokbaVj I&che ds vkdkj  

dk gks tkrk gSA 

  True / lgh      False/ xyr 
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Q.7. Index shows you at a glance, the topics that are included in the document and make it 
easier to locate information. 
baMSDl ,d utj esa MkWD;wesaV esa 'kkfey fd;s x;s VkWfiDl dks fn[kkrk gS] ftlls lwpuk dks [kkstuk vklku gksrk  

gSA 

True / lgh      False/ xyr 
Q.8. You can click on the "Format" tab under "WordArt tools" to modify the WordArt as per  

your requirements.  
vko';drkuqlkj oMZvkVZ dks eksfMQkbZ djus ds fy,] ^^oMZvkVZ Vwy** esa ^^QkjesV** VSc ij fDyd djrs gSA 

True / lgh      False/ xyr 
Q.9. In Word, a file is called as a ............... . oMZ esa ,d Qkby ---------------------------- dgykrh gSA 
 "template"/^^VseiysV**     "form"/^^QkWeZ**   

"database"^^MsVkcsl**     "document"/^^MkD;wesaV** 
Q.10. The Mail Marge feature, combines a list of data, typically a file of names and addresses. 
 esy etZ QhplZ esa MkVk dh fyLV] Qkby use ,Mªsl dEckbZu gksrk gSA 

True / lgh      False/ xyr 
Q.11. Microsoft Word is the only word processor availbale in the market. 
 ekbØkslkW¶V oMZ cktkj esa ekStwn vdsyk oMZ çkslslj gSA 

  True/ lgh      False/ xyr 
Q.12. Hyperlink identifies a location in the documnet or a section of text that you name for 

feature reference. 
 gkbijfyad MkD;wesaV esa ,sls LFkku ;k VsDlV dks fpfUgr djrk gS] ftls Hkfo"; esa mi;ksx ds fy, uke nsrs gSA 

  True/ lgh      False/ xyr 
Q.13. A ............. is a reference from one part of a document to related information in same 

another part. 
 --------------------- ,d fjÝsal gS tks MkD;wesaV ds ,d Hkkx dh lwpuk dks nwljs Hkkx esa fn[kkrk gSA 

 Hyperlink/ gkbijfyad     Cross-referecne/ Økl&fjÝsal 
 Document/ MkD;wesaV     Linkage/ fyadst 
Q.14. For Indentation you may use the "Decrease Indent" and "Increase Indent" icons in the 

"Paragraph" group on the "............." tab for identing your text. 
 vius VSDlV dks baMsV nsus ds fy, vki ^^------------------------** VSc ij ^^iSjkxzkQ** xzqi esa ^^fMØht baMsaV** vksj ^^baØht baMsV** dk 

mi;ksx dj ldrs gSA 
 Insert/ batVZ Home/ gkse  Page Layout/ ist ysvkmV  Data/ MsVk  
Q.15. In MS Word 2007 the "References" tab contains spell check, the squares, and track 

changes. 
 ,e-,l- oMZ 2007 esa ^^fjÝsal VSc** esa Lisy pSd] fFklkWjl] vksj Vªsd psat gksrs gSA 

True/ lgh      False/ xyr 
Q.16. The "..............." is a dictionary of synonyms which you can use to find words that are 

synonyms with a term. 
 ------------------- lekukFkZd 'kCnksa dh 'kCndks"k gS ftldk mi;ksx lekukFkZd 'kCnksa dks [kkstus ds fy, dj ldrs gSA 

Translate/ VªkalysV Spelling/ Lisfyax Thesaurus/ fFklksjl  Research/ fjlpZ 
Q.17. A " ................ " is a listing of the topics that appear in a document with their associated 

page refences. 
 -------------------- ,d fo"k; lwph gS tks MkD;wesaV esa vius lEcfU/kr jsÝsal ist ds lkFk mifLFkr gksrk gSA 

 Index/ baMsDl     Table/ Vscy  
Clipboard/ fDyicksMZ    Table of contents/ Vscy vkWQ dUVsUV 

Q.18. You can format your document automatically applying styles, available in MS Word 
2007. 

 ,e-,l- oMZ esa ekStwn LVkby dk mi;ksx djds vki vius MkD;wesaV dks vkWVksesfVd :i ls QkWjesV dj ldrs gSA 

True / lgh      False/ xyr 
Q.19. A "............." is a connection to a location in the current document to another document 

or Web Site. 
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 ------------------------ ds tfj, vki orZeku MkD;wesaV dh fdlh yksds'ku dks nwljs MkD;wesaV ;k osclkbV ls tksMrs gSaA 

 Link/ fyad hyperlink/ gkbijfyad  hypolink/ gkbiksfyad  linkage/ fyadst 
Q.20. To view a document in the Print Preview Mode, click on the Office Button and select 

"Print  J Print Preview." 
 fçaV fçO;w eksM esa MkD;wesaV dks ns[kus ds fy, vkWfQl cVu ij fDyd djds ^^fçaV J fçaV fçO;w** lsysDV djrs gSaA 

True / lgh      False/ xyr 
Q.21. You may use the "The Auto Complete Feature" to automatically correct the grammatical 

and spelling mistakes in your document. 
 MkD;wesaV esa ekStwn xzkej] LiSfyax bR;kfn dh xyfr;ka Lor% Bhd gks tkus ds fy, ^^n vkWVks dEiyhV Qhpj**  

dk mi;ksx djrs gSA 

True/ lgh      False/ xyr 
Q.22. Using a word Processing application you can create, modify, store, retrieve and print a 

document. 
 oMZ izklsflax ,Iyhds'ku dk mi;ksx djds vki MkD;wesaV cuk ldrs gSa] cnyko dj ldrs gSa] fizaV fudky ldrs gSa lso dj 

ldrs gksA 
  True  ¼lgh½      False ¼xyr½ 
Q.23. "Mini Toolbar" provides easy way to access the most frequently used formatting 

commands. 
 feuh Vwyckj ds tfj;s T;knkrj mi;ksx gksus okys QkWjesfVax dek.M rd igqapus dk vklku rjhdk gksrk gSA 
  True / lgh      False/ xyr 
Q.24. To print only selected pages in your documnet, you may use either the "Current page" or 
 "Page" option under "Print Range." 
 MkWD;wesaV esa dsoy lsysDV fd, x, Hkkx dks fçaV djus ds fy,] vki ^^fçaV jSat** esa ;k rks ^^djsaV ist** ;k  

^^istst** fodYi dk mi;ksx dj ldrs gSA 

  True / lgh      False/ xyr 
Q.25. MS Word 2007 when we click on the Office Button the "Edit" menu is dispalyed. 
 ,e-,l- oMZ 2007 esa vkWfQl cVu dks fDyd djus ij ^^,fMV** esU;w çnf'kZr gksrk gSA 

True/ lgh      False/ xyr 
Q.26. A "................." is a pre-designed document useful for creating common purpose 

documents such as a fax, invoice or business letter. 
 QSDl] v/ofur ;k O;olkf;d ysVj tSls vke dk;ksZ ds fy, ------------------------------ ,d igys ls fMtkbu fd;k gqvk MkD;wesaV gSA 
 Template/ VSEiysV  File/ Qkby  Form/ QkWeZ  Database/ MsVkcsl 
Q.27. A multileve list shows the list items at different levels rather then single level. 
 eYVhysoy fyLV vkbVe dh lwpuk dks ,d Lrj ij u fn[kkdj fofHkUu Lrjksa ij fn[kkrh gSA 
  True / lgh      False/ xyr 
Q.28. A "............." is used to organize information into an eazy-to-read format of horizontal 

rows and vertical columns. 
 Cell   Sheet  Box   Table 
Q.29. To remove individual character at the left you may press "............". 
 ck;ha rjQ ls fdlh vdsys djsDVj dks feVkus ds fy, vki -------------------- Lisl çsl dj ldrs gSaA 

 Delete/ fMyhV  Backspace/ cdLisl  Enter/ ,UVj  Spacebar/ Lislckj 
Q.30. When you click on "Format Printer" icon on the "Home" tab, you can see that your 

mouse pointer changes to a "............." icon. 
 tc vki gkse VSc ij] QkWjesV isaVj vkbdu ij fDyd djrs gSa rks vkidk ekml IokbaVj --------------------------- ds vkdkj dk gks 

tkrk gSA 
 paintbrush/ isaVcz'k  I-beam/ I&che  Arrow/ ,sjks 4-Way arrow/ prq"dks.kh; ,sjks 
Q.31. You may create a new document using standard templates provided by Word by 

checking on a template name in the "New Documnet" window. 
 oMZ 2007 esa lEefyr LVS.MMZ VsEiysV~l dk mi;ksx djus ds fy, ^^U;w MkD;wesaV** foaMksa esa VªsEiysV~l use ij fDyd djds 

vki u;s MkD;wesaV dks rS;kj dj ldrs gSA 

  True / lgh      False/ xyr 
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Q.32. MS Word's Mail Merge feature facilitates you to mail your documnet about special offers 
to a large number of people. 

 vki oMZ ds esy etZ fQpj dk mi;ksx djds vusd yksxksa dks fo'ks"k çLrkoksa ds ckjs esa vius MkWD;wesaV dks esy  

etZ dj ldrs gSaaA 

  True / lgh      False/ xyr 
Q.33. When you move your mouse over a button, a ............ is displayed. That provides a 

detailed description of what the button does. 
 dksbZ cVu D;k dke djrk gS blds ckjs esa --------------------- foLrr o.kZu çnku djrk gSA 

 Super-tooltip/ lqijVwyfVi   Sub-tooltip/ lcVwyfVi   
Info/ bUQks     Key-tip/ dh&fVi 

Q.34. MS Word 2007 can quickly sort text, data or numbers ascending or descending order. 
,e-,l- oMZ 2007 VsDlV MsVk ;k uacj MsVk dks of.kZr fl)kUr ds vuqlkj vkjksgh ;k vojksgh Øe esa rsth ls lksVZ dj 
ldrs gSA 

  True / lgh      False/ xyr 
Q.35. ................ Applications help you to create different types of written documents such as 
 personal letters, from letters, brochures, faxes and even professional manuals. 
 ------------------------ ,Iyhds'ku vkidks ilZuy ysVj] QkWeZ ysVj] czkW'kj] QSDl vkSj O;olkf;d eSU;wvy tSls fofHkUu  

çdkj ds fyf[kr MkD;wesaV rS;kj djus esa enn djrk gSA 

 Word Processor/ oMZ çkslslj   Word Pad/ oMZ iSM 
 Note Pad/ uksV iSM     None of these/ buesa ls dksbZ ugha 
Q.36. The "Mailings" tab contains the items required for mail merge. 
 esfyax VSc esa esy etZ esa vko';d vkbVe 'kkfey gksrs gSA 
  True / lgh      False/ xyr 
Q.37. Word places footnotes at the end of each page and end notes at the end of documents. 
 oMZ esa QqVuksVl çR;sd ist ds var esa vksj ,.MuksVl MkD;wesaV ds var esa gksrs gSA 
  True / lgh      False/ xyr 
Q.38. To remove the hyperlink while retaining the text, right - click on it and select "Remove 
  Hyperlink." 
 gkbijfyad dks fjewo djus ds fy, VsDlV ds Åij jkbZV fDyd djds] fjewo gkbijfyad dj ldrs gSaA 
  True  ¼lgh½      False ¼xyr½ 
Q.39. MS Word indicates formating inconsistencies with a red wavy underline. 
 oMZ esa vuqfpr QkWjesfVax yky rjaxh; vaMjykbu ds lkFk fu:fir gksrh gSA 

True/ lgh      False/ xyr 
Q.40. To automatically correct the document, we use  
 MkD;wesaV dks Lor% lgh djus ds fy,] ge ---------------------- mi;ksx djrs gSaA 

 The auto correct feature/ vkWVks djsDV fQpj 
 The auto complete feature/ vkWVks dEiyhV Qhpj 
 Formating/ QksesZfVax     Building Blocks/ fcfYMax CykWDl   
Q.41. A "..............." is a common application for news paper columns. 
 U;wt isij dkWyEl ds fy, lkekU; ,Iyhds'ku gS & 
 News reading ¼U;wt fjfMax½    News letter ¼U;wt ysVj½  
 News ¼U;wt½      News editor ¼U;wt ,fMVj½ 
Q.42. Personal letters,  form letters, brochures, faxes and professional mannuals can be using 

word processors. 
 ilZuy ysVlZ] QkseZ ysVlZ] czkmtlZ] QSDl] izksQs'kuy eSU;wvyl dk mi;ksx oMZ izkslslj esa fd;k tkrk gSA 
  True  ¼lgh½      False ¼xyr½ 
Q.43. The set margins, select "Margins" from the "Page Setup" group on the "Page Layout" tab. 
 ektZUl lsV djus ds fy, ist lsV vi xzqi esa ist ysvkmV VSc ij fDyd djrs gSaA 
  True  ¼lgh½       False ¼xyr½ 
Q.44. Drop caps are the first characterls at the beginning of a paragraph that are enlarged, 

convering several lines. 
 MªkWi dSIl iSjkxzkQ dk çFke v{kj gksrk gS tks cgqr cMk gksrk gS vkSj dbZ ykbZuksa rd QSyk gksrk gSA 
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  True  ¼lgh½       False ¼xyr½ 
Q.45. A multilevel list shows the list items at different levels rather than single level. 
  True       False 
Q.46. The "Page Layout" tab contains margin, orientation, and spacing properties. 
 ist ysvkmV VSc esa ekftZu] vksfj;sUVs'ku vksj Lisflax çksiVhZt 'kkfey gksrs gSA 
  True  ¼lgh½       False ¼xyr½ 
Q.47. A "............." is used to mark a certain location in a document. 
 MkD;wesaV esa fpfUgr dh gqbZ fuf'pr yksds'ku ij igqapus ds fy, bldk mi;ksx gksrk gSA 
 Index ¼baMsDl½     Hyperlink ¼gkbijfyad½  
 Bookmark ¼cqdekdZ½   Table ¼Vscy½ 
Q.48. You may click on "Replace All" button to replace all occurrences of the search text by 

specified new text. 
 of.kZr u, VsDlV ds }kjk ik, x, lHkh lpZ VsDlV dks fjiysl djus ds fy, vki ^^fjiysl vkWy** cVu ij  

fDyd dj ldrs gSA 

 True  ¼lgh½       False ¼xyr½ 
Q.49. While working on a documnet in MS Word 2007 when we click on the picture, it is 

surrounded by eight boxes called "Sizing handles" which is used to to change the size of 
the graphic. 

 ,e-,l- oMZ 2007 esa dk;Z djrs gq, tc ge rLohj ij fDyd djrs gSa] rks xzkfQd ds vkdkj dks cnyus ds fy,] blds pkjks 
rjQ vkB gSaMy utj vkrs gSa ftldks lkbftax gS.My dgrs gSaA 
 True  ¼lgh½       False ¼xyr½ 

Q.50. While changing the level of an item in hierarchy you can increase the indent by using  
 gk;jvkdhZ esa vkbVe ds Lrj esa cnyko ds fy, vki bldk mi;ksx dj baMsaV dks c<+k ldrs gSA 

"Tab"/ VSc  "Backspace"/ cSdLisl  "Delete"/ fMyhV "Spacebar"/ Lislck 
Q.51. Footnotes or Endnotes are used to provide certain “…………………….”. 
 QqVuksVl o ,.MuksVl dk mi;ksx ------------------------- ds fy, fd;k tkrk gSA 

References/ fjÝsal Information/ lwpuk  Points/ IokWbaV  Lists/ fyLV   
Q.52. If you want the data to be automatically get updated in a document when the current 

data changes, check the “Update automatically” box. 
 ;fn vki pkgrs gSa fd MkD;wesaV esa rkjh[k vius vki viMsV gks tk, rks ^^viMsV vkWVksesfVdyh ckWDl dks pSd djsaA 

 True  ¼lgh½       False ¼xyr½ 
Q.53. ekbØkslkW¶V oMZ }kjk çnku fd, x, fdlh çekf.kd VsEiysV~l dk mi;ksx vki ---------------------- tSls MkD;wesaV ds  

fy, dj djrs gSaA       czk'kj fjT;we  fjiksVZ  çstsUVs'ku 

Q.54. MkWD;wesaV esa ekStwn xzkej] Lisfyax] bR;kfn dh xyfr;ka Lor% Bhd gks tkus ds fy, ^^n vkWVks dEiyhV Qhpj** dk mi;ksx dj 

ldrs gSaA  lgh       xyr 

Q.55. bldk mi;ksx djds ge VSDlV esa ewo dj ldrs gSaA         lhih;w dhcksMZ    eksuhVj     

 ekml 

Q.56. -------------- vkSj ------------ yksdfç; oMZ çkslslj gSaA  ¼uksViSM  ekbØkslkW¶V oMZ   oMZiSM  yhi½ 

Spread Sheet 
Q.1. In formulabar, an adjacent range is specified by giving the starting and editing cell 

addresses separated by a ................. 
 Qkjewys esa] 'kq: ls var ds lsy ,Mªsl ds }kjk ,MtlsaV jsat fufnZ"V gksrh gS vksj bls ----------------------- }kjk iFkd djrs gSA 

 Semicolon/ lsfedkWyu (;)    Comma/ dksek (,)  
 Full stop/ QqyLVkWi (.)     Colon/ dkWyu (:) 
Q.2. The cell address is displayed in the "Text Box". 
 VSDlV esa lsy ,Mªsl fn[kkbZ nsrk gSA 

True/ lgh      False/ xyr 
Q.3. A ............... is a visual representation of data and conveys the information in an easy to 
 understand and attractive manner. 
 MsVk vksj lwpukvksa dks le>us esa vklku o vkd"kZd rjhds esa fotqvy :i ls fjizstsaV djrk gSA 
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 chart/ pkVZ  table/ Vscy  picture/ fiDpj  graphic/ xzkfQd 
Q.4. In formulas, a non-adjacent range is specified by giving the cell addresses separated by a ....... 
 QkWjewyk esa] ---------------------- }kjk vyx fd;s x;s lsy ,Mªsl ds tfj;s ukWu ,DtslsaV jsat dk o.kZu djrk gSA 
 Semicolon/ lsfedksyu (;)    Comma/ dksek (,) 
 Full stop/ QqyLVkWi (.)     Colon/ dkWyu (:) 
Q.5. You can use the ............. to enter and edit data, instead of editing directly in your work sheet. 
 vxj vki viuh odZ'khV esa lh/ks ,fMfVax ugha djuk pkgrs gS rks MsVk dks ,fMV vksj ,aVj djus ds fy, vki ---------------------- 

dk mi;ksx Hkh dj ldrs gSA 

formula bar/ Qkjewyk ckj    title bar/ VkbVyckj 
menu bar/ esU;wckj     space bar/ Lislckj   

Q.6. Your Excel 2007 file is stored with the extension "............". 
 vkidh ,Dlsy 2007 Qkby ^^------------------** ,DlVsa'ku ds lkFk LVksj gksrh gSA 

 ".docx"  ".xlsx"  ".xltx"  ".zltx" 
Q.7. In an electronic spreadsheet or worksheet, data can be edited, new data can be added, 

and unwnated data can be deleted. 
 bySDVªkWfud LiSM'khV ;k odZ'khV esa MsVk dks ,fMV] u, MsVk dks 'kkfey vkSj vuqi;ksxh MsVk dks fMyhV fd;k tk ldrk gSA 

 True  ¼lgh½       False ¼xyr½ 
Q.8. The "Review" tab contains proofing tools like spell check & also has button that let you 

add comments to a worksheet and manage revisions. 
 ^^fjO;w** VSc esa Lisy pSd dh rjg çwfdax Vwy gksrk gS vksj blesa dbZ cVu gksrs gS tks odZ'khV vksj iquZjh{k.k ds fy, desaV 

dks tksMus dh lqfo/kk nsrs gSA 

  True  ¼lgh½       False ¼xyr½ 
Q.9. The "............" tab contains proofing tools like spell check. 
 bl VSc esa izqfQax VwYl gksrh gS] tSl 
 "Review" ¼fjO;w½ "Data" ¼MkVk½ "View" ¼O;w½  "Insert" ¼blaVZ½ 
Q.10. You can create and design our own work book templates. 
 vki viuk [kqn dk odZcqd VSEiySV rS;kj o fMtkbu dj ldrs gSA 
  True  ¼lgh½       False ¼xyr½ 
Q.11. In a spreadsheet programme as you move from one cell to another, the reference or 

address to the active cell appears in the "Name Box." 
 tSls gh vki ,d lsy ls nwljs lsy es ewo djrs gSa] rks ,fDVo lsy dk ,Mªsl ;k fjÝsal uke ckWDl esa mifLFkr gks tkrk gSA 

  True  ¼lgh½       False ¼xyr½ 
Q.12. To start the Microsoft Excel Application, click on the "Start" button and select "All 
  programmes J Micrsoft Office J Microsoft Office Excel 2007. 
 ekbØkslkW¶V ,Dlsy ,Iyhds'ku dks 'kq: djus ds fy,] LVkVZ cVu ij fDyd djds ^^vkWy çksxzke J ekbØkslkW¶V vkWfQl 

J ekbØkslkW¶V vkWfQl ,Dlsy 2007** lsysDV djrs gSA 

  True  ¼lgh½       False ¼xyr½ 
Q.13. The "Insert" tab lets you add special ingredients like tables, graphics, charts, and 

hyperlinks in a spreadsheets programme. 
 ^^balVZ** VSc esa vkidks Vscy] xzkfQDl vksj gkbijfyad tSls fo'ks"k ?kVdksa dks tksMus dh lqfo/kk feyrh gSA 
  True  ¼lgh½       False ¼xyr½ 
Q.14. The text that appears in the bottom margin of the page is called as the "Footer". 
 tks VsDlV ist ds ckWVe ektZu ij mifLFkr jgrk gS mls ^^QqVj** dgrs gSA 
  True  ¼lgh½       False ¼xyr½ 
Q.15. In Excel, a formula always begins with an equal sign (=) and uses airthmetic operators 

like +, -, *, /, %, and ^ to perform addition, subtration, multiplication, division, percent 
and exponentiation respectively. 

 ,Dlsy esa Qkjewyk ges'kk cjkcj ¼=½ ds fpUg ls 'kq: gksrk gS vksj ;g tksM] ?kVko] xq.kk] Hkkx] çfr'r vksj chtxf.krh; 

dk;Z ds fy, Øekuqlkj vfjFkesfVd lapkyd tSls +, -, *, /, %.vkSj ^ dk mi;ksx djrk gSA 

  True  ¼lgh½       False ¼xyr½ 
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Q.16. While working you may have to reference data from more than one sheet which is called 
  referencing multiple sheets. 
 tc vki ,d ls vf/kd fjÝsal MsVk'khV ij dke dj jgs gksrs gS rks ;g fjÝsafUlax eYVhiy 'khV~l dgykrh gSA 
  True  ¼lgh½       False ¼xyr½ 
Q.17. The defalut page orientation setting is "Landscape". 
 ^^ysMLdsi** fMQkWYV ist vksfj;sUVs'ku lsfVax gSA 

True/ lgh      False/ xyr 
Q.18. "............." is a method which aids you in forecasting values. 
 ^^------------------** ,slk fu;e gS tks oSY;w ds iwokZuqeku esa enn djrk gSA 
 "Find"/^^QkbaM** "Replace"/^^fjiysl** "Goal Seek"/^^xksy lhd** "Go to"/^^xks Vw** 
Q.19. In MS Excel 2007, below the "Ribbon", we can see Name Box on the left and the Formula 

Bar on the right. 
 ,e-,l- ,Dlsy 2007 esa fjcu ds uhps ck;ha vksj use ckWDl vksj nka;h vksj Qkjewyk ckj utj vkrk gSA 
  True  ¼lgh½       False ¼xyr½ 
Q.20. A "..............." is a prewritten formula the performs calculations automatically. 
 ------------------- iwoZfyf[kr QkewysZ gksrs gS] tks Lor% x.kuk dk dk;Z djrs gSaA 
 "Function"/ QaD'ku     "Equation"/ bDos'ku   

"Template"/ VseIysVl     "Reaction"/ fj,D'ku 
Q.21. MS Excel 2007 is used for different types of ................ varying from vary simple to complex. 
 ,e-,l- ,Dlsy 2007 dk mi;ksx fofHkUu çdkj ds ----------------------------- esa fd;k tkrk gS tks lkekU; ls ysdj tfVy dk;ksZ 

rd mi;ksxh gksrs gSA 

 calculations/ x.kuk    manipulations/ eSuqiqys'ku  
presentations/ çstsaVs'ku   expressions/,Dlçs'ku 

Q.22. Your excel file is stored with the extension ".xltx". 
 vkidh ,Dlsy Qkby ,DlVsa'ku ds lkFk LVksj gksrh gSA 

True/ lgh      False/ xyr 
Q.23. "Autocorrect" is a feature of Microsoft Excel 2007 that makes entering a series of 

heading easier by logically repeating and extending the series. 
 ^^vkWVksdjsDV** ekbØkslkW¶V ,Dlsy 2007 dk ,slk Qhpj gS tks Ja[kyk dks rkfdZd :i esa nksgjkus vksj c<kus dks vklku 

cukrk gSA 

True/ lgh      False/ xyr 
Q.24. "A relative reference" is a cell or range reference used in a formula whose location does not  

change when a formula is copied. 
^^fjysfVo fjÝsal** ,slh lsy ;k jsat fjÝsal gS ftldk mi;ksx QkWjewyk esa ml le; gksrk gS tc QkWjewyk dkWih djus ij 
LFkku esa ifjorZu ugha gksrk gSA 

True/ lgh      False/ xyr 
Q.25. While changing the level of an item in the hierarachy you can increase the indent by using. 
 gk;jvkdhZ esa vkbVe ds Lrj esa cnyko ds fy;s vki bldk mi;ksx djds baMsUV c<+k ldrs gSaA 
 "Tab" ¼VSc½  "Backspace" ¼cSdLisl½ "Delete" ¼fMyhV½ "Spacebar" ¼Lislckj½ 
Q.26. To set margins, select "Margins" from the "Page Setup" group on the "Page Layout" tab. 
  True       False 
Q.27. To remove individual character at the left you may press "..............". 
 ck;h rjQ ls vdsys v{kj dks feVkus ds fy;s vki Lisl izsl dj ldrs gSA 
 Delete ¼fMyhV½ Backspace  ¼cdLisl½ Enter ¼,UVj½ Spacebar ¼Lislckj½ 
Q.28. Drop caps are the first character/s at the beginning that are enlarged, convering several 

lines. 
 Mªki dSi iSjkxzkQ dk izFke v{kj gS] tks cgqr cMk gksrk gS] o dbZ ykbuksa rd QSyk gksrk gSA 
  True  ¼lgh½       False ¼xyr½ 
Q.29. The intersection of a row and a column is called a "................". 
 jkW vksj dkWye dk dVko ^^---------------------** dgykrk gSA 

Table/ Vscy  Cell/ lsy   Data/ MsVk  Sheet/ 'khV 
Q.30. A ............. is a file that is provided by the application in a "ready to use" format. 
 ------------------------- ,d ,slh Qkby gS] tks ^^jsfM Vw ;wt** :i esa ,Iyhds'ku }kjk çnku djrk gSA 

ANKAJ I
NFOTECH

cmc
Text Box



15 
Deep Training Institute Pvt. Ltd., Alwar 

Sheet/'khV  Template/ VsEiysV~l  Book/ cqd  Report/ fjiksVZ  
Q.31. A ............. is a visual representation of data and conveys the information in a easy to 

understand and attractive manner. 
 ---------------- MsVk dk nf"Vxr fjçstsaVs'ku gS vkSj lwpuk dks le>us ds fy, vklku vksj vkdf"kZr rjhds ls çfrikfnr djrk gSA 
 Chart/ pkVZ  Table/ Vscy  Picture/ fiDpj  Graphic/ xzkfQDl 
Q.32. To move among the worksheet in your workbook, you need to click on the "Workbook" tab. 
 viuh odZoqd esa fofHkUu odZ'khV~l ds chp ewo djus ds fy, ^^odZcqd** VSc ij fDyd djus dh vko';drk gksrh gSA 

True/ lgh      False/ xyr 
Q.33. A theme comprise of a color palette, font set, and effects. 
  True       False 
Q.34. You can view two areas of worksheet and lock rows or columns in one area by splitting or 

freezing panes. 
 LihfyafVax ;k Ýhftax isu ds }kjk vki odZ'khV ds nksa {ks=ksa dks ns[k ldrs gS vksj ,d {ks= esa jkW ;k dkWye dks ykWd dj 

ldrs gSA 
  True  ¼lgh½       False ¼xyr½ 
Q.35. "............" are individual designs that can be applied to different parts to the document. 
 ^^------------------------** Lora= fMtkbu gS ftldk mi;ksx MkD;wesaV ds fofHkUu Hkkxksa esa fd;k tk ldrk gSA 
 "Graphics"/^^xzkfQDl**   "Styles"/^^LVkby**  
 "Pictures"/^^fiDpj**    "Themes"/ ^^Fkhe** 
Q.36. "............" contains commands for opeining, saving, printing, and closing a file. 
 Qkby dks vksiu] lso] Dykst] ,oa fizaV djus dh dekaM blesa gksrh gSA 
 "View" tab/ O;w VSc   "Office Button"/ vkWfQl cVu   

"Insert" tab/ balVZ VSc  "Review" tab/ fjO;w VSc 
Q.37. When a formula containing an absolute cell reference is copied to another row or column 

in the worksheet, the cell reference does not change. 
 tc ,d QkewZyk] fdlh odZ'khV esa nwljh jks ;k dkWye ds lsy fjÝsal dkWih esa j[kk tkrk gSa rks ;g lsy fjÝsal cnyrk ugha 

gSA  True  ¼lgh½  False ¼xyr½ 
Q.38. The "header" is usually the title you give on the page. 
 gsMj lkekU; :i ls VkbfVy gksrh gS ftls vki ist ij ns ldrs gSA 
  True  ¼lgh½       False ¼xyr½ 
Q.39. The text that appears in the top margin of the page is called the ............... 
 ist ds Åijh ekftZu esa fLFkr VSDlV dks ---------------------- dgrs gSA 

Footer/ QqVj  Column/ dkWye Header/ gsMj  Paragraph/ iSjkxzkQ  
Q.40. In a spreadsheet programme a table is a selection of two or more cells. 
 LçSM'khV çksxzke esa] Vscy nks ;k nks ls vf/kd lsyks dk lsysD'ku gSA 
  True  ¼lgh½       False ¼xyr½ 
Q.41. The "title" is usually given as the footer. 
 VkbVy] QksYMj esa fn;k tkrk gSA  True/ lgh  False/ xyr 
Q.42. To stop the automatic relative cell references, i.e. to make the cell reference absolute, type 

a ............ character before the column and row number. 
 lsy fuf'pr djus ds fy, ;kfu lacaf/kr lsy ds Lor% jsÝsal dks jksdus ds fy,] dkWye vkSj jkW dh la[;k ds igys -------------------

---- Vkbi djrs gSA 

 # (hash)/ # ¼gS'k½    $ (dollar)/ $ ¼MkWyj½  
 % (percent)/ % ¼çfr'r½   * (star)/ * ¼LVkj½ 
Q.43. A theme comprise of a color peletle, font set, and effects. 
 ,d Fkhe esa dyj iSysV] QkWUV lsV vksj bQsDV 'kkfey gksrs gSA 
  True  ¼lgh½       False ¼xyr½ 
Q.44. To select a group or range of cells, click on the cell you want to begin, drag your cursor 

and release it when you have reached the end of the selection. 
 lsy ds ,d xzqi dks lsysDV djus ds fy,] ftl lsy ls vki 'kq: djuk pkgrs gS] ml lsy ij fDyd djrs gSA vius dlZj dks 

MªSx djrs gq, viuh bPNkuqlkj lsy ds vafre Nksj rd igqap dj bls NksM+ nsrs gSA 

  True  ¼lgh½       False ¼xyr½ 
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Q.45. If we require to add more data to be on one page, we change the page orientation to land
  scape. 
 ,d ist ij vf/kd MsVk dks fQV djus ds fy,] vki ist dk vksfj;sUVs'ku ysaMLdsi esa cnyrs gSA 

  True  ¼lgh½       False ¼xyr½ 
Q.46. Each worksheet can be used to organized different types of related information. 
 çR;sd odZ'khV dk mi;ksx fofHkUu çdkj dh lEcfU/kr lwpuk dks laxfBr djus ds fy, fd;k tk ldrk gSA 

  True  ¼lgh½       False ¼xyr½ 
Q.47. The "table" is a visual representation of data and convey the information in an easy to 

understand and attractive manner. 
 ^^Vscy** MsVk dks n'; ds :i esa çnf'kZr djrk gS rFkk lwpuk dks vkd"kZd vksj vklku rjhds ls çLrqr djrk gSA 

True/ lgh      False/ xyr 
Q.48. "Themes" provided with MS Excel 2007 are universal designs that unify all of the styles. 
 ,e-,l- ,Dlsy 2007 esa nh gqbZ] ^^Fkhe** ,d lkoZHkkSfed fMtkbu gS tks lHkh LVkby ds fy, fu;r gksrh gSA 
  True  ¼lgh½       False ¼xyr½ 
Q.49. In Microsoft Excel 2007, a single file or document is called a ".............". 
 ekbØkslkW¶V ,Dlsy 2007 esa] ,d vdsyh Qkby ;k MkD;wesaV --------------------------- dgykrk gSA 

Workbook/ odZcqd     Worksheet/ odZ'khV   
Sheet/'khV      Notebook/ uksVcqd  

Q.50. "Notebook" contains a collection of one or more worksheets and, optionally, chart sheets 
 containing graphic pictures of your worksheet data. 
 ^^uksVcqd** esa ,d ;k vf/kd odZ'khV dk laxzg gksrk gS] vkSj pkVZ'khV esa vkids odZ'khV MsVk dh xzkfQd rLohjsa gksrh gS\ 

True/ lgh      False/ xyr 
Q.51. With the ........... option, you can freeze either or both, rows and columns ie. regardless of 

where you are in the worksheet you can see the information in these rows and/or columns 
at all times. 
------------------ vkWi'ku ds lkFk jkW ;k dkWye ;k nksuksa dks fÝt dj ldrs gSa] vFkkZr~ odZ'khV jgrs gq, vki ges'kk ml jks ;k 
dkWye esa lwpuk dks ns[k ldrs gSA 
 "Split*/^^fLiyV**   "Arrange*/^^vjsat** 

  "Fitter*/^^fQYVj**   "Freeze Panes*/^^Ýht isUl** 
Q.52. You can create charts to represent data more effectival in an electronic sheet or worksheet. 
 bySDVªkWfud odZ'khV ;k LçSM'khV esa MsVk dks vf/kd vkd"kZd rjhds ls n'kkZus ds fy, vki pkVZ rS;kj djrs gSA 
  True  ¼lgh½       False ¼xyr½ 
Q.53. In a spreadsheet each cell has its own address called as "cell address". 
 LçSM'khV esa çR;sd lsy dk viuk ,MªSl gksrk gS ftls lsy ,Mªsl dgrs gSA 
  True  ¼lgh½       False ¼xyr½ 
Q.54. A template file in MS Excel 2007 has an extension “…………….”. 
 ,e-,l- ,Dlsy 2007 esa] VSEiysV Qkby dk ,DlVsa'ku -------------------------- gSA 
 “.docx”  “.yltx”   ”.xltx”   “.zltx” 
Q.55. A “………….” is like an accountant’s ledger consisting of rows and columns. 
 ------------------- vdkmaVsV ds cgh [kkrs ds leku gS] tks jkW vkSj dkWye esa j[kk x;k gSA 

 Table/ Vscy    Microsoft Excel 2007/,e-,l- ,Dlsy 2007   
Format/ QkjesV   Sheet/ 'khV  

Q.56. A “table” is a visual representation of data and conveys the information in an easy to 
understand and attractive manner. 

 ^^Vscy** MsVk dks n'; :i esa çLrqr djrk gS rFkk lwpuk dks vkd"kZd ,oa vklku rjhds ls çLrqr djrk gSA 

  True ¼Lkgh½     False ¼xyr½    

Q.58. Tkc vki ,d ls vf/kd fjÝsal MsVk'khV ij dke dj jgs gksrs gSa rks ;g fjÝsafUlax eYVhiy 'khV~l dgykrh gSA 

 lgh       xyr 

Q.59. ,e-,l- ,Dlsy 2007 dk mi;ksx fofHkUu çdkj ds ------------------- esa fd;k tkrk gS] tks lkekU; ls ysdj tfVy dk;Z rd 

mi;ksxh gksrs gSA 

,Dlçs'ku   x.kuk    eSuqiqys'ku   çstsaVs'ku 
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Presentation Graphic 
Q.1. The "Insert" tab contains the basic set of objects which you can insert into a slide. 
 ^^balVZ** VSc esa fdlh vkCtsDV ds csfld lsV gksrs gSa ftls vki LykbM esa balVZ dj ldrs gSaA 

True  ¼lgh½       False ¼xyr½ 
Q.2. Click "Replace All" to replace all occurrences of search text by the specified new text. 
 MkD;wesaV esa fdlh VsDlV dks çR;sd ckj u, VsDlV ls fjiysl djus ds fy, ^^fjiysl vky** fDyd djrs gSA 

True  ¼lgh½       False ¼xyr½ 
Q.3. A "................" graphic is a visual representation of your information and ideas. 
 ---------------------------- xzkfQd dh lwpuk vksj fopkj dk n'; çstsaVs'ku gSA     
 "WordArt"/^^oMZvkVZ**   "ClipArt"/^^fDyivkVZ**  "SmartArt"/^^LekVZvkVZ**
  "Autoshape"/^^vkVks'ksi** 
Q.4. To start a Microsoft PowerPoint Application, click on the "Start" button and select "All 
  progrmmes J Microsoft Office J Microsoft Office PowerPoint 2007". 
 ekbØkslkW¶V ikWojIokWbaV ,Iyhds'ku dks LVkVZ djus ds fy, ^^LVkVZ** cVu ij fDyd djds ^^vkWy çksxzke  
 J ekbØkslkW¶V vkWfQl J ekbØkslkW¶V vkWfQl ikWojIokWbaV 2007** dks lsysDV djrs gSaA 
  True  ¼lgh½       False ¼xyr½ 
Q.5. "..............." refer to a ready-to-use picture. 
 ^^--------------------------** mi;ksx ds fy, rS;kj fiDpj çnku djrk gSA 

"WordArt"/^^oMZ vkVZ**     "ClipArt"/^^fDyivkVZ**  
"SmartArt"/^^LekVZvkVZ**    "Autoshape"/^^vkWVks'ksi** 

Q.6. To open a recently used presentation you may click the office button and then click on 
the presentation name in the list displayed under "Recent Documents". 

 gky esa mi;ksx fd, x, çstsaVs'ku dks [kksyus ds fy,] vkWfQl cVu ij fDyd djds ^^fjlsaV MkD;wesaV** ds vUrxZr çnf'kZr  
lwph esa çstsaVs'ku uke ij fDyd djrs gSA 

True  ¼lgh½       False ¼xyr½ 
Q.7. SmartArt programs are designed to help you to create an effective presentation. 
 LekVZvkVZ çksxzkEl dks vkd"kZd çstsUVs'ku dks rS;kj djus esa enn ds fy, fMtkbu fd;k x;k gSA 

True/ lgh      False/ xyr 
Q.8. The "............." tab contains tools that controls how to slide show is presented. 
 LykbM 'kks dks dSls pykuk gS] bldks daVªksy djus okys Vwy ^^-------------------** VSc esa gksrs gSA 
 "Design"/^^fMtkbu** "Slide Show"/^^LykbM 'kks** "Review"/^^fjO;w** "View"/^^O;w** 
Q.9. Minature pictures of slides displayed in the slide sorter view. 
 LykbZM lkWVZj O;w esa LykbM dh NksVh rLohjs utj vkrh gSA 

True  ¼lgh½       False ¼xyr½ 
Q.10. ............. which displays icon that represent commonly used commands such as Save, 

Undo, and Redo. 
 ------------------------ ,d vkbdkWu çnf'kZr djrk gS ftlesa lkekU; :i ls mi;ksx gksus okys dekaM tSls lso] vaMw]  
 vksj fjMw jgrs gSaA 
 Home Button/ gkse cVu     The Ribbon/ fjcu  

The Quick Access Toolbar/ fDod ,Dlsl Vwyckj     The Office Button/ vkWfQl cVu 
Q.11. A "..........." is a connection to a location in the current documnet, another document or a 

website. 
 ------------------------ orZeku MkD;wesaV ds LFkku ls vU; MkD;wesaV ;k csoclkbV ds chp gksus okyk lEidZ gSA 
 Highlink/ gkbfyad   hipolink/ gkbiksfyad    

linkage/ fyadst    hyperlink/ gkbijfyad  
Q.12. ............ are used to create slide shows on the computer  
 Presentation graphics   Analytical development programs  
     Super Slide packages   Slide maker tools 
Q.13. To preview your presentation as web page, you need to add the "Web Page Preview" 

 command to Ribbon. 
 çstsaVs'ku dks osc ist ds :i esa fçO;w djus ds fy,] fjcu esa ^^osc ist fçO;w** dekaM dks tksMus dh vko';drk gksrh gSA 

True/ lgh      False/ xyr 
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Q.14. With "Slide Show View" you can see how your graphics timings, movies, animated 
elements and transition effects will look in the actulashow. 

  True       False 
Q.15. In graphic presentation, programmes each presentation is divided into ............ 
 xzkfQDl çstsaVs'ku çksxzkEl esa çR;sd çstsaVs'ku ------------------------------- esa foHkkftr gksrk gSA 
 charts/ pkV~lZ    slides/ LykbM~l   
 tables/ Vscy    pictures/ fiDpj  
Q.16. In PowerPoint "Match case": you may check this box for a case sensitive search. 
 ikWojIokWbaV ^^eSp dsl** laosnu'khy ¼dsl lsaflfVo½ lpZ ds fy, bl ckWDl dks pSd djrs gSA 

True  ¼lgh½       False ¼xyr½ 
Q.17. "Scale to fit paper": check this box to print the slides with an outer frame. 
 ^^Ldsy Vw fQV isij** LykbM dks vkmVj Ýse ds lkFk fçaV djus ds fy, bl ckWDl dks pSd djsaA 

True/ lgh      False/ xyr 
Q.18. In PowerPoint "build effects" are animations to slide contents.. 
 ikWojIokWbaV esa ^^fcYM bQsDV** LykbM ds dUVsUV dk ,uhes'ku gksrs gSaA 
  True  ¼lgh½       False ¼xyr½ 
Q.19. A "..............." is a pre-designed presentation designed for common purpose such as photo 
 album or a quiz show. 
 ------------------------- lkekU; mís'; tSls QksVks ,Yce ;k fDot 'kks ds fy, ,d iwoZof.kZr çstsaVs'ku gSA 

"Chart"/ pkVZ  "Table"/ Vscy  "Slide"/ LykbM "Template"/ VSEiysV  
Q.20. You may create a new presentation using a template provided by Powerpoint. 
 ikWojIokWbaV }kjk çnku fd;s x;s VsEiysVl dk mi;ksx djds vki u, çstsUVs'ku rS;kj dj ldrs gSaA 
  True  ¼lgh½       False ¼xyr½ 
Q.21. We can insert a video clip on a PowerPoint Slide. 
 ikWojIokWbaV çstsaVs'ku esa ge fQYeksa dh ,d NksVh fDyi dk lekos'k dj ldrs gSaA 

True  ¼lgh½       False ¼xyr½ 
Q.22. When you move your mouse over a sizing handle the pointer becomes a ".............". 
 Round Arrow  Two-headed Arrow Plus Sign Four-headed Arrow 
Q.23. PowerPoint Presentation is a component of following application software. 
 ikWojIokWbaV çstsaVs'ku fuEufyf[kr ,Iyhds'ku çksxzkEl dk ,d fgLlk gSA 
 Leap Office/ fyi vkWfQl   Start Office/ LVkj vkWfQl  
 Open Office/ vksiu vkWfQl   MS Office/,e-,l- vkWfQl 
Q.24. "Slide Show View" is an exclusive view of your slides in thumbnail form. 
 ^^LykbM 'kks O;w** Fkacusy ds :i esa lHkh LykbM~l dks çnf'kZr djrk gSA 

True/ lgh      False/ xyr 
Q.25. Headers and Footers are used to add information such as slide numbers, the time and 

date, a company logo or the presentation title to the top of a hand out or notes page in 
your presentation, or to bottom of a slide, handout or notes page. 

 çstsaaVs'ku esa gsMvkmV ;k uksVl ist ds Åij ;k uhps LykbM dh la[;k] le; vksj rkjh[k] daiuh dk yksxks ;k  
 çstsaVs'ku dk 'kh"kZd dks tksMus ds fy, gsMj vksj QqVj dk mi;ksx djrs gSaA 

True  ¼lgh½       False ¼xyr½ 
Q.26. To see a preview of your slide in a window on the screen, click on the Quick Access 

Toolbar and select "Print J Print Preview". 
 LØhu ij foaMksa esa vius LykbM dh fçO;w dks ns[kus ds fy,] fDod ,Dlsl Vwyckj ij fDyd djds ^^fç aV  
 J fçaV fçO;w** dks lsysDV djrs gSaA 

True/ lgh      False/ xyr 
Q.27. In Graphics Presentation Programs each presentation is divided into charts. 
 xzkfQDl çstsaVs'ku çksxzke esa çR;sd çstsaVs'ku nksa pkV~lZ esa foHkkftr gksrk gSA 

True/ lgh      False/ xyr 
Q.28. Using WordArt graphics, you can effectively communicate your message in a quick and 
 simple way. 
  True       False 
Q.29. You may change the presentation views by checking on the buttons displayed on the 

"..........." at the bottom of the screen. 

ANKAJ I
NFOTECH

cmc
Text Box



19 
Deep Training Institute Pvt. Ltd., Alwar 

 "Title bar"  "Menu bar"  "Tool bar"  "Status bar" 
Q.30. "Animations" refers to addition of special visual or sound effect to your slides. 
  True       False 
Q.31. Using powerpoint presentation graphics is simple and it is used for effective presentation 

on a topic. 
 ikWojIokWbaV çstsaVs'ku dk mi;ksx djuk cgqr vklku ,oa fdlh Hkh fo"k; oLrq dk çstsaVs'ku nsus ds fy, fd;k  
 tk ldrk gSA 

True  ¼lgh½       False ¼xyr½ 
Q.32. A "review" is a way to looking at a presentation. 
  True       False 
Q.33. In Presentation Graphics "..........." are used to add information such as slide numbers, 

the time and date, a company logo or the presentation title to the top of a handout or 
notes page in your presentation, or a bottom of a slide, handout or notes. 

 çstsaVs'ku xzkfQDl esa] --------------------------- dk mi;ksx çstsaVs'ku esa gSMvkmV ;k uksVl ist ds Åij ;k LykbM]  
 gSMvkmV ;k uksVl ist ds uhps dh vksj lwpuk,a] tSls LykbM la[;k] le; vksj rkjh[k] daiuh dk yksxks ;k  
 çstsaVs'ku VkbVy dks j[kus ds fy, djrs gSA 

Hyperlinks/ gkbijfyad    Tables / Vscy    
Header and Footers/ gsMlZ vksj QqVlZ  Charts/ pkVZl 

Q.34. The sizing handles at the slides are used to adjust only the height or the width. 
 fdukjs ij fLFkr lkbftax gSaMy dk mi;ksx dsoy ÅpkabZ vksj pkSMkbZ dks larqfyr djus ds fy, fd;k tkrk gSA 

True  ¼lgh½       False ¼xyr½ 
Q.35. "..............." takes up the full computer screen, like an actual slide show presentation. 
 ^^---------------------------** okLrfod LykbM 'kks çstsaVs'ku dh rjg lEiw.kZ dEI;wVj LØhu ij utj vkrk gSA 

Slide Sorter View/^^LykbM lkWVZj O;w**   Normal View /^^ukseZy O;w** 
 Slide Show View/^^LykbM 'kks O;w**   Notes Page/^^uksV~l ist** 
Q.36. The "Outline" tab shows your slide text in outline form. 
 ^^vkmVykbu** VSc vkids LykbM VsDlV dks vkmVykbu ds :i esa fn[kkrk gSA 

True  ¼lgh½       False ¼xyr½ 
Q.37. A slide layout refers to the arrangements of elements, such as text, pictures, tables, charts 

and movies, on a slide. 
 LykbM ysvkmV] ,d LykbM ij VsDlV] rLohjksa] Vsfcy] pkVZ vksj fQYe tSls ,fyesaVl dh O;oLFkk dks çnf'kZr  
 djrk gSA 

True  ¼lgh½       False ¼xyr½ 
Q.38. If you have a large number of slides in your presentation, you may find it more 

convenient to use the .............. to view all your slides and change their positions. 
 ;fn vkids çstsaVs'ku esa vusd LykbM gks] rks ----------------------------- dk mi;ksx djds vki vklkuh ls viuh lkjh  
 LykbM dks ns[k ldrs gSa vksj mlds LFkkuksa esa ifjorZu dj ldrs gSaA 
 Normal View/ ukeZy O;w   Slide Sorter View/ LykbM lkWVZj O;w   

Slide Show View/ LykbM 'kks C;w  Notes Page/ uksVl ist 
Q.39. You may use either the Normal View or the Slide Sorter View to delete a Slide. 
  True       False 
Q.40. In Microsoft PowerPoint your file is stored with the ............ extention. 
 ekbØkslkW¶V ikWojIokWbaV esa vkidh Qkby ^^---------------------------** ,DlVsa'ku ds lkFk LVksj gksrh gSA 
 *.psd*   *.rtf*   ".pptx*   4".docx* 
Q.41. When the pointer becomes a ............., you can drag placehadder to the location you wish. 
 Round arrow  Two-round arrow Plus sign  Four-headed arrow 
Q.42. A "Clip" may be a single media file, including art, sound, animation or movies.  
 ^^fDyi** ,d flaxy ehfM;k Qkby gks ldrh gS ftlesa vkVZ] lkmaM] ,uhes'ku ;k ewoht 'kkfey gks ldrh gSA 

True  ¼lgh½       False ¼xyr½ 
Q.43. "............" are details about a file that help identify it.  
 ^^---------------------** fdlh Qkby ds fooj.k gS tks mls igpkuus esa enn djrk gSA 
 Desktop Porperties/^^MsLdVkWi çksiVht**  Window Properties/^^foaMkst çksiVht** 
 Advanced Properties/^^,Mokal çksiVht**  Document Properties/^^Mkd;wesaV çksiVht** 
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Q.44. The "Sizing Handles" at the slides and corners of the selsection rectangle can be used to 
  adjust the size of the place holder. 
 lsysDV fd, x, vk;kr ds cxy esa vksj fdukjs dh vksj ^^lkbftax gSaMy** dk mi;ksx IyslgksYMj ds vkdkj dks  
 larqfyr djus ds fy, fd;k tkrk gSA 

True  ¼lgh½       False ¼xyr½ 
Q.45. To open a file that you have previously saved, click the Ribbon and select "Open". 
 igys lso dh xbZ Qkby dks [kksyus ds fy,] fjcu ij fDyd djds ^^vksiu** lsysDV djrs gSaA 

True/ lgh      False/ xyr 
Q.46. ".............." is the main editing view. 
 ---------------------- eq[; ,fMfVax O;w gSaA 
 Slide Sorter View/ LykbM lkWVZj O;w   Normal View/ ukseZy O;w  

Slide Show View/ LykbM 'kks O;w   Notes Page/ uksVl ist 
Q.47. We can insert a audio clip on a powerpoint slide. 
 ikWojIokWbaV çstsaVs'ku esa ge /ofu dk lekos'k dj ldrs gSaA 

True  ¼lgh½       False ¼xyr½ 
Q.48. In powerpoint the “Insert” tab contains tools to design your slides. 
  True       False 
Q.49. The “………..” tab contains the basic formatting tools. 
 ^^-----------------------------** VSc esa csfld QkjesfVax VwYl gksrs gSaA 

 “Design”/ fMtkbu    “View”/ O;w 
 “Insert”/ balVZ     ”Home”/ gkse 
Q.50. The “Slides” tab makes it easy to navigate through your presentation and to see the 

effects of changes and also rearrange, add or delete sliders. 
  True       False 
Q.51. The “Outline” tab shows you slides as your thumbnail sized images while you edit. 
 ,fMV ds nkSjku ^^vkmVykbu** VSc vkidh LykbMksa dks Fkacusy ds vkdkj dh rLohjksa ds :i esa fn[kkrk gSA 

True/ lgh      False/ xyr 
Q.52. In PowerPoint the “Insert” tab contains tools to design your slides. 
 ikWojIokWbaV esa ^^batVZ** VSc esa LykbM fMtkbu ds fy, VwYl gksrs gSaA 

True/ lgh      False/ xyr 
Q.53. Qkby dks [kksyus] lso djus] fçaV djus] vksj can djus ds funsZ'kksa dks çnf'kZr djus okyk vkWfQl cVuA 

 lgh        xyr 
Q.54. ------------------------------- ,d fo'ks"k LykbM gS] tks çstsaVs'ku dh lHkh LykbMksa ds fy, VkbfVy vksj VsDlV ds QkWjesV  
 o Lo:i dks fu;af=r djrh gSA 

LykbM    esu   ekLVj   mijksDr lHkh 
Q.55. tc vki ikWojIokWbaV dks LVkVZ djrs gS] rks vki ^^çstsaVs'ku 1** ds uke ls ukWeZy O;w esa Cysad çstsaVs'ku ns[krs  
 gSaA 

 lgh        xyr 
Q.56. bl O;q esa LykbM dh NksVh rLohjs utj vkrh gSA 

LykbM lkWVZj   ukWeZy   LykbM 'kks  vkmVykbu 

DBMS Practice 
Q.1. vki ,d Lisl ds lkFk fQYM ds uke dh 'kq:vkr dj ldrs gSaA 
 You can start the name of the field with a space. 
  lgh (True)      xyr (False) 
Q.2. ^^--------------** ,d MkVkcsl vkWCtsDVl gS ftldk mi;ksx eq[; LØhu ij fjdkWMZ fy[kus vksj çnf'kZr djus  rFkk ekStwn    
 fjdkWMZ esa ifjorZu djus ds fy, fd;k tkrk gSA 
 "............." is a database object that is mainly used to enter and display records and make 
  changes to existing records onscreens. 
 Doh (query)  Q+kWeZ (form)   fjiksVZ (report)  Vscy (table) 
Q.3. çkbejh uacj ,d fof'k"V vksj Øexr la[;k gksrh gS rks Vscy esa u;k fjdkWMZ tksMus ij Lor% c<+rh gSA 

Primary Number is a unique, sequential number that is automacically incremented by 
one whenever a new record is added to the table. 

  lgh (True)      xyr (False) 
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Q.4. çR;sd dkWye ,sls fjdkWMZ gksrs gS ftlesa fjdkWMZ ds ckjs esa lwpuk dh lcls NksVh bdkbZ dks jgrh gSA 
 Each column is a record which is the smallest unit of information about a record. 
  lgh (True)      xyr (False) 
Q.5. QkeZ fçaV fd;k tk ldus okyk vkmViqV gS ftldks Vscy vksj Dosjht ls rS;kj fd;k tkrk gSA 
 A form is a printed output generated from tables and quries. 
  lgh (True)      xyr (False) 
Q.6. fjcu esa VkLd&vksfj;sUVsM VSc] xzqi vksj daekM cVu gksrs gSaA 
 The ribbon has Task-oriented Tabs, Groups and command buttons. 
  lgh (True)      xyr (False) 
Q.7. ------------- ,d bySDVªkWfud MkVkcsl eSustesaV flLVe gS tks dbZ rjhdks ls lwpuk dks LVksj] laxfBr] 

,Dlsl] eSuqiqysV vksj çLrqr dj ldrk gSA 
 "............." is an electronic database management system which can store, organize, access, 
 manipulate, and present information in many different ways. 
 ,e ,l ,Dlsl 2007 (MS Access 2007)  ,e ,l oMZ (MS Word) 
   ,e ,l ,Dlsy (MS Excel)    ,e ,l ikojIokWbaV (MS PowerPoint)] 
Q.8. ,d O;olkf;d MsVkcsl dk vf/kdrj mi;ksx MsVkcsl LVªDpj esa gksrk gSA 
 A professional database is the most widely used database structure. 
  lgh (True)      xyr (False) 
Q.9. Vscy leku fQYM }kjk ,d nwljs ls lEcfU/kr jgrs gSaA 
 The tables are related or linked to one another by a common field. 
  lgh (True)      xyr (False) 
Q.10. tc vki MsVk Vkbi dks lsysDV djrs gSa] rks ^^fMLiys çksiVhZt** ds vUrxZr bldh fMQkWYV çksiVhZt çnf'kZr gksrh gSA 

When you select a data type, its default properties are displayed under "Display 
Properties." 

  lgh (True)      xyr (False) 
Q.11. ^^--------------** MsVk Vkbi dk mi;ksx dsoy la[;kvksa dks LVksj djus ds fy, fd;k tkrk gSA 
 "............." data type is used to store numbers only. 
 vkVksuacj (Auto Number) VsDlV (Text)    uacj (Number) MsV@Vkbe (Date/Time) 
 
Q.12. fMQkWYV oSY;w dk mi;ksx ml oSY;w dk o.kZu djus ds fy, fd;k tkrk gS] tks u;s fjdkWMZ ds tksM+s tkus ij fQYM esa Lor% 

gh ,aVj gks tkrk gSA 
A default value is used to specify a value that is automatically entered in a field when a 
new record is added. 

  lgh (True)      xyr (False) 
Q.13. ^^-------------** ,Dlsl 2007 esa lwpuk dks LVksj djrk gSA 
 "............" stores the information in Access 2007. 
 Vscy (Table)  Dosjht (Quries)  fjiksVZ (Reports)  QkWeZ (Forms) 
Q.14. QhYM çksiVhZ ,slh fo'ks"krk gS tks fQYM dk o.kZu djrh gSA 
 A field property is a characteristic that helps to define a field. 
  lgh (True)      xyr (False) 
Q.15. ^^------------** MsVk Vkbi dk mi;ksx best] MkWD;wesaV] xzkQ vkfn dks LVksj djus ds fy, fd;k tkrk gSA 
 ".........." data type is used to store images, documents, graphs etc. 
 gkbijfyad (Hyperlink) OEL vkWCtsDV (OEL Object) VsDlV (Text) fMlfØi'ku (Discription) 
Q.16. ^^-----------** QhYM esa ,aVj fd;s tkus okys dSjsDVj dh vf/kdre la[;k ds ckjs esa fu.kZ; djrk gSA 
 ".........." decides the maximum number of characters that can be entered in the field. 
 QkWjesV (Format)       buiqV ekLd (Input Mask)       dSI'ku (Caption)       fQYM lkbt (Field Size)                      
Q.17. MkVkcsl esa lwpuk ------------------- esa LVksj gksrh gSSA 
 The information in a database is stored in a ...................... 
 pkVZ (Chart)  ckWDl (Box)  QksYMj (Folder)   Vscy (Table) 
Q.18. ------------- ,d fMQkWYV MsVk Vkbi gS vksj bldk mi;ksx 'kCn] 'kCn vksj la[;k ds feJ.k vksj la[;k ftldh x.kuk ugha dh 

tkrh] ,sls VsDlV ,aVªh djus ds fy, fd;k tkrk gSA 
"............" is the default data type and is used to store text entries like words, 
combinations of words and numbers and numbers that are not used in calculations. 
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 VsDlV (Text)  la[;k (Number) eseks (Memo)  djsalh (Currency) 
Q.19. ,Dlsl esa vki MsVk dks vkjksgh ;k vojksgh Øe esa lksVZ dj ldrs gSaA 
 In Access, you can sort data in ascending or desending order. 
  lgh (True)      xyr (False) 
Q.20. MsVkcsl esa fdlh fo"k; ij dk;Z djus vksj çnf'kZr djus ds fy, ,Dlsl fofHkUu QkWjesV çnku djrk gS] ftUgsa ^^fyLVl** 
        dgrs gSA 

Access provides different window formats called "Lists" to display and work with the 
objects in a database. 

  lgh (True)      xyr (False) 
Q.21. ,Dlsl esa] çR;sd MsVkcsl vdsyh Qkby esa LVksj gksrk gS] ftldk ,DlVsa'ku gS & 
 In Access, every database is stored in a single file which has the extension. 
 ".docx"  ".rtf*   ".accdb"  ".txt" 
Q.22. MsVk Vkbi] fQYM esa j[ks x;s MsVk ds çdkj dk o.kZu djrk gSA 
 The data type defines the type of data the field will contain. 
  lgh (True)      xyr (False) 
Q.23. ----------- dk mi;ksx fQYM esa laxzfgr MsVk dks fpfUgr djus ds fy, fd;k tkrk gSA 
 A ............... is used to identify the data stored in a field. 
 Vscy (Table) fQYM use (Field Name) ckWDl (Box)  czSdsV (Bracket) 
Q.24. MsVkcsl lEcfU/kr lwpukvksa dk ,d laxfBr laxzg gSA 
 A database is an organized collection of related information. 
  lgh (True)      xyr (False) 
Q.25. ^^--------------** MsVk ,aVªh dks vklku cukrk gS vksj vko';drk ds vuqlkj MsVk çn'kZu dks fua;f=r djrk gSA 
 ".........." simplifies data entry and controls what data is required and how it is to be displayed. 
 QkWjesV (Format)     buiqV ekLd (Input Mask)       dSI'ku (Caption)         QhYM lkbt (Field Size)                      
Q.26. ,Dlsl Lor% çkbejh dh ds fy, dksM rS;kj djrk gS] tks Dosjht dks rS;kj djus vksj vU; dk;ksZ dks rst  djus esa enn   
 djrk gSA 

Access automatically creates a code for the primary key, which helps makes quries and 
other operations.  lgh (True)  xyr (False) 

Q.27. --------------- MsVk ds dbZ çdkj çnku djrk gSA  
............. provides a number of data types. 
oMZ 2007 (Word 2007)    ,sDlsl 2007 (Access 2007)   ,Dlsy 
2007 (Excel 2007)    ikoj IokbaV 2007 (PowerPoint 2007) 

Q.28. Vscy esa dksbZ fjdkWMZ tksMuk] fMyhV djuk ;k eksfMQkbZ djuk dkQh dfBu gksrk gSA 
 It is difficult to add, delete and modify records from a table. 
  lgh (True)      xyr (False) 
Q.29. ,Dlsl 2007 dk ^^QkWeZ fotkMZ** Qhpj QkWeZ dks fMtkbu djuk vklku cukrk gSA 
 The "Form Wizard" feature of Access 2007 makes it very easy to design forms. 
  lgh (True)      xyr (False) 
Q.30. tc vki MsVkcsl [kksyrs gS ;k ,d u;k MsVkcsl cukrs gS] rks Vscy] QkWeZ] vksj fjiksVZ tSls MsVkcsl vkWCtsDV dk uke 

usfoxs'ku osu esa ekStwn jgrk gSA 
When you open a database or create a new one, the names of your database objects such 
a tables. forms and reports appear in the Navigation Pane. 

  lgh (True)      xyr (False) 
Q.31. pkVZ yacor~ dkWye ¼ftUgsa QhYM dgrs gS½ vksj {kSfrt ls ¼ftUgsa fjdkWMZ dgrs gS½ ls cus gksrs gSA 
 Charts are made up of vertical columns (called fields) and horizontal rows (called records) 
  lgh (True)      xyr (False) 
Q.32. ,e- ,l- ,Dlsl ds dqN QhplZ dk mi;ksx djds vki tYnh fjiksV~lZ rS;kj dj ldrs gSaA 
 You can quickly produce reports using some MS Access features. 
  lgh (True)      xyr (False) 
Q.33. ^^------------** ,slh foaMksa gS ftls vki Vscy esa nh xbZ lwpuk dks vklkuh ls ns[kus ds fy, ;k lwpuk esa cnyko djus ds fy, 

rS;kj djrs gSa vksj Js.khc) djrs gSaA 
 "..........." are windows that you create and arrange in order to easily view or change the 
  information in a table. 
 Vscy (Table)  Dosjht (Quries)  fjiksVZ (Report)  QkWElZ (Forms) 
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Q.34. fuf'pr voLFkk ;k vko';drkvksa ls esy djus ds fy, ^^--------------** MsVk ,aVªh dks vojksf/kr djrk gSA 
 ".........." restricts, the data easy to meet certain conditions or requirements. 
 oSfyMs'ku VsDlV (Validation Text)   fMQkWYV oSY;w (Default Value) 

oSfyMs'ku :y (Validaton Rule)    QkWjesV (Format) 
Q.35. QkWeZ vkidks Vscy dh lkjh lwpukvksa ;k dqN dks fçaV djus esa enn djrk gSA 
 Forms help you print same or all of the information in a table. 
  lgh (True)      xyr (False) 
Q.36. ^^-------------** MsVk Vkbi dk mi;ksx mu yacs VsDlV dks LVksj djus esa fd;k tk ldrk gS ftudks VsDlV fQYM esa LVksj ugha  
 fd;k tk ldrkA 
 "..........." data type is used to store text that is too long to be stored in a text field. 
 VsDlV (Text)  uacj (Number) eseks (Memo)  djsalh (Currency) 
Q.37. ^^fMlfØi'ku** VsDlV ckWDl dk i;ksx QhYM ds o.kZu ds fy, fd;k tkrk gSA 
 The "Discription" text box is used to describe the field. 
  lgh (True)      xyr (False) 
Q.38. ^^-------------** ;wtj dks QhYM dSI'ku fu/kkZfjr djus ;k MsVk ,aVj djus ds fy, ladsr nsrk gSA 
 "............" specifies a field caption or a prompt for the user to enter data. 
 QkWjesV (Format)  buiqV ekLd (Input Mask)          dSI'ku (Caption)      QhYM lkbt (Field Size) 
Q.39. QkWeZ rS;kj djus ds fy, ^^QkWeZ fotkMZ** pj.kc) rjhds ls vkidk ekxZn'kZu djrk gSA 
 "Form Wizard" guides you through the steps required to create a form. 
  lgh (True)      xyr (False) 
Q.40. QhYM esa laxzfgr MsVk dks fpfUgr djus ds fy, QhYM uke dk mi;ksx fd;k tkrk gSA 
 A field name is to identify the data stored in a field. 
  lgh (True)      xyr (False) 
Q.41. fMQkWYV oSY;w ,slh vfHkO;fDr gS ftlesa Lohdkj djus ;ksX; oSY;w dk o.kZu gksrk gSA 
 A default value is an expression that defines acceptable values. 
  lgh (True)      xyr (False) 
Q.42. çR;sd jks ,slh QhYM gksrh gS ftlesa fdlh O;fDr] oLrq ;k LFkku ls lEcfU/kr lkjh lwpuk,a gksrh gSA 
 Each row is a field which contains all the information about a person, thing or place. 
  lgh (True)      xyr (False) 
Q.43. çkbejh dh dks ------------------ gksuk pkfg,A    

A primery key must be 
 ;wfud cV ijfeV uy (Unique But Permit Null)  ;wfud ,aM uksV uy (Unique And Not Null) 
 uu&;wfud ,aM uksV uy (Non-unique And Not Null) 
 uu&;wfud ,aM ijfeV uy (Non-unique And Permit Null) 
Q.44. fuEu esa ls dkSulh ,d Mhch, dh çfØ;k gS\ 
 Which of the following are functions performed by a DBA? 
 MsVkcsl fMtkbZu (Database Design)  flLVe flD;ksfjVh (System Security) 
 cSdvi ,oa fjdojh (Backup and Recovery) ;s lHkh All of the above) 
Q.45. ^^------------** ,d fjys'ku MsVkcsl eSustesaV ,Iyhds'ku gS ftldk mi;ksx MsVkcsl rS;kj djus vksj fo'kys"k.k djus ds fy, fd;k 

tkrk gSA 
"..........." is a relation database management application that is used to create and 
analyze a database. 
oMZ 2007 (Word 2007)   ,sDlsl 2007 (Access 2007)    flLVe 
flD;ksfjVh (System Security)  ikoj IokbaV 2007 (PowerPoint 2007) 

Q.46. fofHkUu çdkj dh lwpuk dks LVksj djus dh t:jr ds vuqlkj vki dbZ lkjs Vscy rS;kj dj ldrs gSA 
 You can create as many tables as you need to store different types of information. 
  lgh (True)      xyr (False) 
Q.47. ^^-----------** vkidh Vscy esa ,d QhYM ;k QhYMks dk lsV gS tks çR;sd fjdkWMZ ds fy, ,d fof'k"V ladsrd ds lkFk ,Dlsl 

çnku djrk gSA 
A "............" is a field or set of fields in your table that provied Access with a unique 
identifier for every record. 

 ikloMZ (Password)    Lis'ky dksM (Special Code)   
 çkbejh dh (Primary Key)   fof'k"V dksM (Unique Code) 
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Q.48. QksVks dks Qkby dh rjg batVZ fd;k tk ldrk gSA 
 The photo can be inserted as a file. 
  lgh (True)      xyr (False) 
Q.49. Vscy esa vki MsVk dk fo'ks"k.k dj ldrs gS vksj Vscy ds fofHkUu QhYM dh x.kuk dj ldrs gSA 
 You can analyze the data in a table and perform calculations on different fields of data. 
  lgh (True)      xyr (False) 
Q.50. MsVk QkWjesfVax dqN [kkl lwpuk dks rsth ls [kkstus esa enn djrk gSA 
 Formatting the data often helps in finding some particular information quickly. 
  lgh (True)      xyr (False) 
Q.51. MsVkcsl dks ifjHkkf"kr djus dk çFke pj.k D;k gS\ 
 What is the first step of defining a database. 
 MsVkcsl dks fMtkbu djuk (Designing the database) MsVk dk laxzg djuk (Collection of data) 
 MsVkcsl dh ;kstuk cukuk (Planning your database) MsVk dks fMftVkbV djuk (Digitizing your data) 
Q.52. tc vki fçaV fçO;w eksM esa Vscy ns[krs gSa rks ^^fçaV fçO;w** VSc mifLFkr jgrk gSA 
 The "Print Preview" tab appears when you view the table in the print preview mode. 
  lgh (True)      xyr (False) 
Q.53. lHkh çdkj ds MsVkcsl vkWCtsDV tSls Vscy] QkWeZ] Dosjht vksj fjiksVZ ds fMtkbu dks ns[kus vksj rS;kj djus ds fy, MsV'khV 

dk mi;ksx fd;k tk ldrk gSA 
Datasheet view can be used to create and view the design of all types of database objects 
such as tables, forms, queries, and reports. 

  lgh (True)      xyr (False) 
Q.54. Mh0ch0,e0,l0 dk rkRi;Z gSA DBMS means ................... 
 MsVkcsl eSustesaV flLVe (Database Management System)  
 Mksesu eSustesaV flLVe (Domain Management System) 
 MsVkcsl eSustesaV loZj (Domain Manangeemt Server) 
 Mksesu eSustesaV LVkbZy (Domain Management Style) 
Q.55. ,Dlsl ;g Hkh lqfuf'pr djrk gS fd çR;sd fjdkWMZ esa ukWu&CySd çkbejh fQYM dh vksj og lcls vyx gksA 
 Access also ensure that every record has a non-blank primary key field, and that it is 

always unique. 
  lgh (True)      xyr (False) 
Q.56. ^^osyhMs'ku #y** QhYM ds fy, fMQkWYV oSY;w dk o.kZu djrk gS] tks MsVk ,aVªh ds nkSjku Lor% rS;kj gksrh gSA 
 “Validation Rule” specifies a default value for a field to be automatically field n at the 

time of data entry. 
  lgh (True)      xyr (False) 
Q.57. MsVk dk Vscy] QkWeZ] Dosjht esa ns[kus ds fy, fMtkbu D;w jks vksj dkWye çnku djrk gSA 
 Design view provides a row and column view of the data in tables, forms, and queries. 
  lgh (True)      xyr (False) 
Q.58 You can enter up to charactess in a text field. 
 375  125  235  255  

Internet 
Q.1. usVLdsi usohxsVj ,d çdkj dk ------------------- gSA 
 Netsacpe Navigator is a type of ..................... 
 ;wfVfyVh çksxzke (Utility Program)  vksijsfVax flLVe (Operating System) 
 czkmtj (Browser)    osc vkWFkfjax çksxzke (Web Authoring Program) 
Q.2. tc vki dksbZ irk Vkbi djrs gSa] tSls "http://www.mkcl.org", rks ;gka .org dk rkRi;Z gS & 
 When you type an address such as "http://www.mkcl.org", in this .org indicates. 
 vksfjftuy osc lkbZV (Original Web Site)   

dkWef'kZ;y osc lkbZV (Commercial Web Site) 
 vkWxsZukbts'kut osc lkbZV (Organizational Web Site) 

,tqds'kuy osc lkbZV (Educational Web Site) 
Q.3. ---------- ,oa ------------ dk mi;ksx djds oYMZ okbM osc ij vki fdlh fo'ks"k fo"k; ij lpZ dj ldrs gSaA 
 You can search the World Wide Web for a specific topic by using ............ and ................ . 
 xksQlZ] fQMkst (Gophers, Fidos)   LdSulZ] lpZ baftu (Scanner, Search Engine) 
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 lpZ baftUl] bUMsDlst (Search Engines, Indexes) czkmtlZ] Y;wdlZ (Browsers, Lurkers) 
Q.4. ---------- fu;eksa ds vk/kkj ij baVjusV ij lwpuk ,oa lans'kksa dks Hkstk tkrk gSA 
 A(n) ............ is a set of rules for how information and messages are sent over the internet. 
 çksVksdkWy (Protocol)   vkbZ ,l ih (ISP)  ,isysV (Applet) 
 ,pVh,e,y] gkbij VsDlV ekdZvi ySaXost (HTML Hyper Text Markup Language) 
Q.5. baVjusV ij fdlh fo'ks"k fo"k; ij ppkZ djus dks dgrs gSa & 
 Discussion on the internet about specific topic is known as 
 U;wt (News)  U;wt xzqi (News group) osjsfudk (Verinica) VsyusV (Telnet) 
Q.6. buesa ls dkSulk ,d çdkj dk çksVksdkWy ugha gS\ 
 Which of the following is not a type of protocol? 
 ppp  TCI/IP   ASCII buesa ls dksbZ ugha (None of these) 
Q.7. buesa ls dkSulk ,d çdkj dk çksVksdkWy gS\ 
 Which of the following is a type of protocol? 
 ASCII   RAM    TCI/IP   DBA 
Q.8. bZ&esy lans'k ds rhu Hkkx gS & 
 The three parts of an e-mail message are 
 Vhlhih@vkbZih] Mksesu ,oa vkbZ,lih (TCP/IP, Domain and ISP) 
 MsfLVus'ku] fMokbl ,oa lsaMj (Destination, Device and Sender) 
 gsMj] lans'k ,oa flxuspj (Header, Message and Signature) 
 Vhlhih] vkbZih ,oa lans'k (TCP, IP and Message) 
Q.9. iwjs fo'o ds dEI;wVjksa dks vkil esa tksMus okyk usVodZ gS & 
 The network connecting several computers all over the world is? 
 baVªkusV (Intranet) baVjusV (Internet) vikZusV (Arpanet) usVodZ (Network) 
Q.10. buesa ls dkSu ,d czkmtj gSA 
 Which of the following is a browser. 
 osc lkbZV (Web site)     ekbØkslks¶V (Microsoft)   
 baVjusV ,DlIyksjj (Internet Explorer)  MCY;w MCY;w MCY;w- (www.) 
Q.11. Mh- ,u- ,l- dk rkRi;Z gSA 
 The terms DNS Stands for. 
 MsVk usfeax flLVe (Data Naming System) Mw use flLVe (Do Name System) 
 Mksesu use flLVe (Domain Name System) MqIyhdsV usfeax flLVe (Duplicate Name System) 
Q.12. baVjusV bZ&esy ,sMªsl lHkh ;wtlZ ds fy, -------------------- gksrs gSaA 
 Internet e-mail address is ..................... for every user. 
 fof'k"V (Unique) ,d gh (Same) ,d leku (Common) buesa ls dksbZ ugha (None of these) 
Q.13. fdlh osc lkbZV esa usfoxsV djus ds fy, ;wtj dks ----------------- esa tkuk vko';d gksrk gSA 
 For navigating any website, user has to enter  
 ;w vkj ,y (URL)      MCY;w MCY;w MCY;w (www) ih-ih-ih- (PPP) buesa ls dksbZ ugha (None of these) 
Q.14. bZ&dkselZ dk iwjk vFkZ D;k gS \ 
 What is the full form of E-Commerce ? 
 bafXy'k dkselZ (English Commerce)  bySDVªkWfud dkselZ (Electronic Commerce) 
 bySfDVªd dkselZ (Electric Commerce)  ,fyesaV dkselZ (Element Commerce) 
Q.15. fdlh dks esy Hkstus ds fy, vkidks t:jr gksrh gS ----------------- 
 To send e-mail to someone you need ............. 
 jslhMsaV ,sMªsl (Resident Address)  baVjusV dusfDVfoVh (Internet Connectivity) 
 QSDl ,sMªsl (Fax Address)   buesa ls dksbZ ugha (None of these) 
Q.16. -------------- dk mi;ksx osc ist ns[kus ds fy, fd;k tkrk gSA 
 ............. is used to see the web page. 
 buckWDl (Inbox)    fjlkbfdy fcu (Recycle bin)   
 baVjusV ,DlIyksjj (Internet Explorer) usVodZ uscjgqM (Network Neighborhood) 
Q.17. ;w vkj ,y dk iwjk uke D;k gS\ 
 Full form of URL 
 ;wfuolZy fjlkslZ yksdsVj (Universal Resource Locator)  
 ;wfuQkWeZ fjlklZ yksdsVj (Uniform Resource Locator) 
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 ;wfu fjlkslZ yksdsVj (Uni Resource Locator)  buesa ls dksbZ ugha (None of these) 
Q.18. eksMe MsVk dks lh-Mh- ls gkMZ fMLd esa dUoVZ djrk gSA 
 Modem convert data from a CD to a hard disk. 
  lgh (True)      xyr (False) 
Q.19. buesa ls dkSulk ,d lpZ baftu gS\ 
 Which of the following is a search engine. 
 xwxy (Google)  vYVk foLVk (Alta Vista) ;kgw (Yahoo) ;s lHkh (All of these) 
Q.20. bZ dkselZ dk D;k rkRi;Z gS\ 
 What is meant by E-Commerce? 

vkWu ykbZu Ø; foØ;] ,dkmUV lagkyuk] vkfn (Online selling, puchasing, account handling etc.) 
 dkselZ fo"k; dh i<+kbZ (Sunject commerce stream) 
 O;kikfjd leL;kvksa ls fuiVus ds fy, bysfDVªd midj.k  
 (Electronic equipment to deal with commercial problem) 
 ;s lHkh (All of the above) 
Q.21. .gov, .edu, .mil, vksj .net oxSjg ,DlVsa'kal dks dgrs gSaA 
 The extensions .gov, .edu, .mil, and .net are called. 
 Mh-,u-,l- (DNSs)     bZ&esy VkxsZV~l (E-mail targets)  
 Mksesu dksMl (Domain codes)    esy Vw ,Mªsl (Mail to address) 
Q.22. osc LikbZMlZ vksj ØkWylZ ------------------ ds mnkjg.k gksrs gSaA 
 Web spiders and crawlers are examples of 
 czkmtlZ (Browsers)      lpZ bfUtal (Search Engines)  
 ,pVh,e,y çksxzkEl (HTML Programs)   ¶ysEl (Flames) 
Q.23. ;w vkj ,y D;k gS \ 
 What is an URL ? 
 oYMZ okbM oSc essa ?kweus ds fy, bLrseky fd;k tkus okyk lk¶Vos;j iSdst 
 (A software package used to cruise the World Wide Web.) 
 oYMZ okbM oSc ij fjlkslZ dk ,d irk (The address of a resource on the World Wide Web) 
 fdlh baVjusV fotkMZ dks n'kkZus okyk 'kCn (The terms used to describe an internal wizard) 
 ykbo pSV çksxzke ¼vufyfeVsM fj;y Vkbe ySaxost½ (A live chat program [Unlimited real time language]) 
Q.24. baVjusV esa www. dk D;k rkRi;Z gS \ 
 What does the abbreviation "www." stands for. 
 oYMZ okbZt osc (World Wide Web)  okbM okbM osc (Wide Wide Web) 
 oYMZ foM~Fk osc (World Width Web)  oYMZ fon osc (World With Web) 
Q.25. dhoMlZ dh enn ls ;wtj dks MsVk [kkstus dh lqfo/kk çnku djus okyh osc lkbZV dgykrh gS & 
 Website that allow the user to search for data on keywords is: 
 pSV baftUl (Chat engines)   :VlZ (Routers)   
 osc loZj (Web Server)    lpZ baftUl (Search engines) 
Q.26. buesa ls iwjs fo'o esa bLrseky gksus okyk lpZ baftu dkSulk gS\ 
 Which of the following web search engine is used world wide? 
 Mksesu (Domain) xwxy (Google) Vkxy (Toggle) buesa ls dksbZ ugha (None of these) 
Q.27. fdlh fo"k; ij lpZ djrs le; ----------------- dk mi;ksx djrs le; tks lwpuk çkIr gksrh gSA og MsVkcsl  tSlh lajpuk esa  
 O;ofLFkr gksrh gSA 
 When you use a(n) ................. to search for a topic, the information you search through is 
 organized into a database like structure. 
 lpZ baftu (Search engin) baMsDl (Index)  LikbMj (Spider) ,IysV (Applet) 
Q.28. fuEu esa ls fdl çfØ;k ds tfj;s nks dEI;wVjksa ds chp bySDVªkWfud i= ;k lans'k Hksts tkrs gSa \ 
 Which of the following system electronic letter or message sent between individuals or computers. 
 bZ&esy (E-mail)     vkWu ykbZu lfoZl (Online Service)  
 'ks;lZ fjlkslZ (Share Resources)   ok;l esy eSlsftax (Voice mail messaging) 
Q.29. orZeku osc dks viuh QsofjVl dh lwph esa Mkyus ds fy, & 
 To add current web to the favourites list. 
 fDyd ^^QsofjVl & ,sM Vw QsofjV~l** (Click "Favourites - Add to Favourites") 
 fDyd ^^,sM & QsofjV~l (Click "Add - Favourites)  
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 fDyd ^^QkbZy & QsofjV~l (Click "File - Favourites)  ;s lHkh (All of these) 
Q.30. osc dh nqfu;k esa ,d lkbZV ls nwljh lkbZV ij tkus dh çfØ;k dks dgrs gS \ 
 Moving arround the web from one site to another is reffered to as ................ 
 fyafdax (Linking) usohxsfVax (Navigating) gkWfiax (Hopping) isftax (Paging) 
Q.31. çksVksdkWy nks ;k nks ls vf/kd dEI;wVjksa ds chp lwpuk çlkfjr djkus ds fu;eksaq dks ifjHkkf"kr djrk gSA 
 A protocol defines the rules for passing information between two or more computers. 
  lgh (True)      xyr (False) 
Q.32. baVjusV ij Hksth xbZ lwpuk NksVs&NksVs VqdMksa esa foHkkftr gksrh gS ftls dgrs gS & 
 Information sent over the Internet is divided into small pieces called. 
 iSdsVl (Packets) ihihiht+ (PPPs) bZ&esy ds çdkj (e-mail forms) eslStst (Messages) 
Q.33. ihihih vksj ,l ,y vkbZ ih tSls çksVksdkWYl dk rkRi;Z gSA 
 Protocols like PPP and SLIP are used for. 
 MsVk VªkalQj (Data Transfer) Mk;y vi baVjusV dusD'ku (Dialup internet connection)  
 Mksesu jftLVªs'ku (Domain Registration)  buesa ls dksbZ ugha (None of these) 
Q.34. -dkWe ----------- çdkj ds laxBu dh osclkbV dks n'kkZrk gSA 
 The .com indicates websites of .............. types of organization. 
 dkWef'kZ;y (Commercial) dkWEiysDl (Complex) dEiuh (Company)  dkxksZ (Cargo) 
Q.35. baVjusV ij fdlh nwljs ds esy ckWDl esa lans'k Hkstuk ----------------- dgykrk gSA 

Sending messages on the internet to another persons mailbox is  
 bZ&fctusl (E-Business)     bZ&ySVj (E-Letter)  
 bZ&esy (E-Mail)      lkbcj esy (Cyber Mali) 

PIMP 
Q.1. This is a type of personal information managers. 
 ;g ,d çdkj dk ilZuy bUQksesZ'ku eSustj gSA 
 MS Word 2007/,e-,l- oMZ 2007   MS Excel 2007/,e-,l- ,Dlsy 2007 
 MS PowerPoint 2007/,e-,l- ikoj IokbaV 2007 MS Outlook 2007/,e-,l- vkmVyqd 2007 
Q.2. You can attach all sorts of files to an e-mail including Spreadsheets, word processor docu
 ment database, even sound recordings and graphic images. 
  True       False 
Q.3. To create a mail, We click on "Mail in the navigation pane. 
  True       False 
Q.4. You use the "Send/Receive" button to Send and Receive mails. 
 lsaM o fjlho esy ds fy, ^^lsaM@fjlho** cVu dk mi;ksx dj ldrs gSA 

lgh (True)      xyr (False) 
Q.5. If you want to personalize your work environments wish to use a tool that organizes your 
  contacts. Schedules etc. You will use. 
 ;fn vki vius dk;Z{ks= dks O;fDrxr cukuk pkgrs gSa vksj vius dkWUVsDV~l] 'ksM;wYl] vkfn dks O;ofLFkr djus ds fy, VwYl 

dk mi;ksx djuk pkgrs gSa rks vki mi;ksx djsaxsA   
Microsoft Office Excel 2007 / EkkbØkslkW¶V vkWfQl ,Dlsy 2007   
Microsoft Office PowerPoint 2007/ EkkbØkslkW¶V vkWfQl ikoj IokbaV 2007 

 Microsoft Office Outlook 2007 EkkbØkslkW¶V vkWfQl vkmVyqd 2007   
Microsoft Office Word 2007/ EkkbØkslkW¶V vkWfQl oMZ 2007 

Q.6. Entry in MS Outlook 2007, that losts for more than 24 hours is called as 
,e-,l- vkmVyqd 2007 esa dh tkus okyh ,aVªh vxj 24 ?kaVs ;k mlls vf/kd dh gksrh gS rks og dgykrh gSA  

 Event/ bosaV  Exhibition/,Dlfgfc'ku  Mail/ esy  Calender/ dySaMj 
Q.7. Creating a Mail massage is also known as "Consolidating" a mail. 
 esy eSlst rS;kj djus dks ^^dalksfyMsfVax** ds uke ls Hkh tkurs gSA 

lgh (True)      xyr (False) 
Q.8. The most important feature of outlook 2007 is sending and receiving an e-mail. 
 ekbØkslkW¶V vkmVyqd 2007 dk lcls egRoiw.kZ Qhpj bZ&esy dks Hkstuk o çkIr djuk gSA 
  lgh (True)      xyr (False) 
Q.9. A ............. is a descriptive keyboard or phrase used in MS Outlook 2007 in which you can 

assign related items. 
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 Categary  Mail   Notes   Points 
Q.10. Sourting tasks is the process of rearranging items in ascending order.   
 lkWfVZax VkLd ,d fØ;k gS ftlds }kjk ge dk;kZs dks vojksgh ;k vkjksgh Øe esa tek djrs gSA 
  lgh (True)      xyr (False) 
Q.11. The "Notebook" is an electronic book. which includes detailed information of all the 

people with whom you communicate. 
 ^^uksVcqd** ,d bySDVªkWfud cqd gksrh gS] ftlesa mu lHkh yksxksa ds ckjs esa foLrr lwpuk gksrh gS] ftuds lkFk  

vki lapkj djrs gSA 
lgh (True)      xyr (False) 

Q.12. ................ are seprate external files that are along with you e-mail message. 
 ------------------- ,d vyx Qkby gS tks vkids bZ&esy eSlst ds lkFk tkrh gSA   
 Attachments/ vVSpesaV Options/ fodYi E-mails/ bZ&esy  Parcels/ iklZy 
Q.13. A task is a personal work related action item. 
 ,e-,l- vkmVyqd 2007 esa ^^VkLd** ,d ilZuy dk;Z lEcU/kh ^^,D'ku vkbVe** gSA 
  lgh (True)      xyr (False) 
Q.14. The "Instant Search" Feature helps you to quickly find items in Microsoft Office 
Outlook 2007. 
 ekbØkslkW¶V vkWfQl 2007 esa ^^baLVSaV lpZ** Qhpj vkidks rsth ls vkbVe dks [kkstus esa enn djrh gSA 
  lgh (True)      xyr (False) 
 
Q.15. In MS Outlook 2007 you can update the status of the tasks at any time and specify and 

percentage completed. 
 ,e-,l- vkmVyqd 2007 esa VkLd dk LVsVl iqu% fdlh Hkh le; LFkkfir dj ldrs gSa vkSj LVsVl o dk;Z dk  

çfr'kr çnf'kZr dj ldrs gSA 
  lgh (True)      xyr (False) 
Q.16. If you add a recipient's name using "BCC" the name is not Visible to other recipients of 

the message. 
 ;fn vki esy çkIr djus okyksa dk uke Bcc esa tksMrs gSa rks ;g uke nwljsa çkIr djus okyksa dks fn[kkbZ ugha  

iM+rk gSA 
lgh (True)      xyr (False) 

Q.17. When you start Microsoft Outlook 2007. All the mails that you receive gets deposited in 
your "Inbox" Folder as default. 

 tc vki ekbØkslkW¶V vkmVyqd 2007 dks LVkVZ djrs gSa] rks vkids }kjk çkIr lHkh esy] fMQkWYV :i esa  
^^buckWDl** QksYMj esa tek gksrh gSA 

lgh (True)      xyr (False) 
Q.18. Once We click on the flag symbol next to an important mail it gets added in the To Do Bar. 
 tc vki fdlh egRoiw.kZ esy ds cxy esa ^^¶ysx** ds fpUg ij fDyd djrs gSa rks og esy Lor% ^^Vw&Mw ckj**  

esa tqM+ tkrk gSA 
lgh (True)      xyr (False) 

Q.19. You may need to save your contacts to a file, so that are available for use in the future. 
This is called ................. 

 dkWUVsDV~l dks Hkfo"; esa mi;ksx ds fy, Qkby esa lso djus dh vko';drk gks ldrh gS ftls ----------------------  
dgrs gSA        

 "Saving"/ lsfoax    "Importing"/ baiksfVZax 
 "Exporting"/,DliksfVZax   "Extracting"/,DlVªsfDVax 
Q.20. A Mailing list is a collection of contacts. 
 esfyax lwph yksxks ds dkaVsDVl dk laxzg gksrh gSA 

lgh (True)      xyr (False) 
Q.21. To Forward that mail that you have received, click on the mail from the inbox and than 

click the "Forward" button. 
 ftl esy dks vki fjlho djrs gSa mls QkWjoMZ djus ds fy, ml esy ij fDyd djds ^^QkWjoMZ** cVu ij  

fDyd djrs gSA 
lgh (True)      xyr (False) 

Q.22. "Notes" are an electronic version of paper notes that you use to got down quick reminders. 
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  True       False 
Q.23. If you add a recipient's name using "Cc", the name is not visible to other recipients of the 
  message. 
 ;fn vki esy çkIr djus okyksa dk uke “Cc” esa tksMrs gSa] rks ;g uke nwljs çkIr djus okyksa dks fn[kkbZ ugha  

iM+rk gSA 
lgh (True)      xyr (False) 

Q.24. When you open Microsoft Outlook 2007, you will see a navigation pane on the left. Which 
contains catefories such as mail, calender and contacts etc. 

 tc vki ,e-,l- vkmVyqd 2007 'kq: djrs gSa rks ckbZ rjQ ,d ^^usfoxs'ku isu** gksrk gS ftlesa ^^esy**]  
^^dysaMj**] ^^dksaVsDV** bR;kfn foHkktu gksrs gSA 

lgh (True)      xyr (False) 
Q.25. In the Tasks Timeline view in MS Outlook 2007. The tasks are arranged according to 

their due dates. 
 ,e-,l- vkmVyqd 2007 esa ^^VkLd** ds Vkbe ykbu n'; esa lHkh VkLd muds iwjs gksus ds le;kuqlkj çnf'kZr  

gksrs gSA 
lgh (True)      xyr (False) 

Q.26. Sorting "Categories" is the process of rearranging items in ascending or descending 
order. 

 lkWfVax ^^dSVsxjht** esa fdlh vkbVe dks vkjksgh ;k vojksgh Øe esa iquxfBZr djus dh çfØ;k gSA 
lgh (True)      xyr (False) 

Q.27. In MS Outlook 2007 you may add contacts form different books into your mailing list. 
 ,e-,l- vkmVyqd 2007 esa vki ^^dksaVsDV* dks vyx&vyx ,Mªsl cqd ls esfyax fyLV esa tksM ldrs gSA 

lgh (True)      xyr (False) 
Q.28. When you went to convey the information that you have reveived to your friend or any 

other person you may ............. the mail that you have received. 
 tc vki çkIr dh xbZ lwpuk dks vius nksLrksa ;k vU; yksxksa dks Hkstuk pkgrs gSa] rks vki ml fjlho dh xbZ  

esy dks ------------------------ dj ldrs gSaA       
"Share"/^^'ks;j** "Give"/^^fxo**  "Send"/^^lSaM**  "Forward"/^^QkWjoMZ** 

Q.29. "Cc" stands for carbon copy and "Bcc" stands for blind carbon copy. 
 “Cc” dkcZu dkWih dk laf{kIr :i gS vksj “Bcc” CykbaM dkcZu dkWih dk laf{kIr :i gSA 

lgh (True)      xyr (False) 
Q.30. The ............... is an electronic book, which includes detailed information of all the people 
  with whom you communicate. 
 ------------------ ,d bySDVªkWfud cqd gS] ftlesa mu lHkh yksxksa ds ckjs esa foLrr lwpuk jgrh gSA ftuds lkFk  

vkius lapkj fd;k gksxkA    
 Addressbook/ ,Mªsl cqd Calendar/ dysaMj Task/ VkLd  Notebook/ uksVcqd
  
Q.31. You can use a flag to quickly create a follow-up item that can be tracked in the To-Do-

Bar, in  your Inbox, and even in he calendar. 
 'kh?kzrkiwoZd QkWyks&vi vkbVe dks rS;kj djus ds fy, ¶ySx dk mi;ksx dj ldrs gSa] ftls vius buckWDl esa  

vksj dysaMj esa Vw&Mw ckj esa Vªsd dj ldrs gSaA 
lgh (True)      xyr (False) 

Q.32. You can sort your tasks in MS Outlook 2007 according to subject by selecting "View 
J Arrange By J Subject". 

 vius dk;ksZ dks vkjksgh ;k vojksgh Øe esa tekus ds fy, ge ;g rjhdk viukrs gSa View J Arrange by 
J Subject. 

lgh (True)      xyr (False) 
Q.33. When you start Microsoft Outlook 2007, all the mails that you receive get deposited in 

your "Drafts" folder as default. 
 tc vki ekbØkslkW¶V vkmVyqd 2007 dks LVkVZ djrs gSa rks vkids }kjk çkIr lHkh esy] fMQkWYV :i ls]  

^^MªkW¶V** QksYMj esa tek gksrh gSA 
lgh (True)      xyr (False) 

Q.34. Hksth tkus okyh esy cukus ds fy,] usfoxs'ku isu esa ^^esy** ij fDyd djrs gSA 
 lgh       xyr 
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Q.35. tc vki ekbØkslkW¶V vkmVyqd 2007 dks LVkVZ djrs gSa] rks vkids }kjk çkIr lHkh esy] fMQkWYV :i esa  
^^MªkW¶V** QksYMj esa tek gksrh gSA 
 lgh       xyr 

Q.36. ;fn vki esy çkIr djus okyksa dk uke Cc esa tksMrs gSa rks ;g uke nwljsa çkIr djus okyksa dks fn[kkbZ ugha  
iM+rk gSA 
 lgh       xyr 

Internet Web and Electronic Commerce 
Q.1. tc ,d osc lkbV fodflr fd;k tkrk gS] rks fofHkUu baVj fyaDM Qkbyksa dks ,d lkFk j[kk tkrk gS bls dkSu lh lqfo/kk  
 djds çkIr fd;k tkrk gSA 
 When a web site is developed, the various interlinked files are grouped together. This is 
 achieved using which facility. 
 gkbij VsDlV (Hypertext)    gkbij fyaDl (Hyperlinks)   
 usVodZ (Network)     buesa ls dksbZ ugha (None of these) 
Q.2. baVjusV esa "www" ds laf{kIr :i dk eryc gSA 
 What does the abbroviation "www" in internet stands for: 
 oYMZ okbM osc (World Wide Web)   okbM okbM osc (Wide Wide Web) 
 oYMZ foM~Fk osc (World Width Web)   oYMZ fon osc (World With Web) 
Q.3. -------------- rsth ls c<+us okys ,d baVjusV ,fIyds'ku gSA 
 ............. is one of the fastest growing internte application. 
 bZ&esy (E-mail)  'kkWfiax (Shopping) bUosfLVax (Investing) okf.kT; (Commerce) 
Q.4. --------------- dEI;wVj dh ,d ubZ Hkk"kk] ftlls oYMZ okbZM osc ds fy, ,sfues'ku vksj xsEl [ksyrs gSaA 
 ............. is the new computer language used to write animation and games for the World 
  Wide Web. 
 tkok (Java)  lh (C)  lh$$ (C++)  ,pVh,e,y (HTML) 
Q.5. ---------------- esa esfyax lwfp;ka lekpkj] lewg vksj pSV lewg lEefyr jgrs gSA 
 .............. include mailing lists news groups and chat groups. 
 ppkZ ds lewg (Discussion Groups)  baVjusV lewg (Internet Groups) 
 vkbZ-ih- ds lewg (IP Groups)   buesa ls lHkh (All of these) 
Q.6. buesa ls dkSulk lpZ baftu gS \ 
 Which of the following is a search engine. 
 xwxy (Google)  vYVk foLVk (Alta Vista) ;kgw (Yahoo) ;s lHkh (All of these) 
Q.7. Mk;jsDVªh lpZ dks baMsDl lpZ Hkh dgk tkrk gSA 
 Directory Search is also known as Index Search. 
  lgh (True)      xyr (False) 
Q.8. vkbZ- vkj- lh- esa vkj dk eryc gSA 
 In IRC, R stands for: 
 fj;y (Real)  fjys (Relay)  fjdkWMZ (Record) jSUMse (Rendom) 
Q.9. ,siysV~l ,sls fo'ks"k çksxzkEl gS] ftudks -------------- Hkk"kk esa fy[kk x;k gSA 
 Applets are the special programs written in ............. language. 
 tkok (Java) ,pVh,e,y (HTML) ,pVhVhih (HTTP) buesa ls dksbZ ugha (None of these) 
Q.10. bZ&esy esa fuEufyf[kr lHkh cqfu;knh va'k gksrs gSa ---------------- ds flok; 
 E-mail includes all of the following basic elements except. 
 gsMj (Header)  QqVj (Footer) esflt (Message) gLrk{kj (Signature) 
Q.11. baLVsaV esflftax vkidks --------------- djus nsrk gSA 
 Instant messaging allows you 
 bZ esy esfltst Hkstuk (Send E-mail messages) MsVk dks ckaVuk (Sharing the data) 
 vkids esfltst dk rqjar tokc nsrh gSA (Instant reply of your messages) 
 okLrfod thou esa gksus ds tSls cgqr lkjks ds ,d lkFk ckrphr djus esa lapkj djuk 
 (To communicate with many at once in a conversation that occurs in real time) 
Q.12. tc vki ,d Vksfid ds fy, ---------------- dk ç;ksx djrs gS] rks mlds }kjk [kksth xbZ lwpuk ,d MsVkcsl ds tSls <k¡ps esa  
 laxfBr gks tkrh gSA 
 (When you use a(n) ............. to search for a topic the information you search through is 
  organized into a database - like structure. 
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 lpZ baftu (Search Engine) bUMsDl (Index)  LikbMj (Spider) ,sIysV (Applet) 
Q.13. .gov, .edu, .mil, vksj .net ds bDlVsU'kuksa dks ----------------- dgk tkrk gSA 
 The extensions .gov, .edu, .mil, and .net are called. 
 Mh-,u-,l- (DNSs)    bZ esy dh fu'kkfu;ka (E-mail targets)  
 Mksesu ds dksMl (Domain codes)  irkvksa dks esy djuk (Mail to addresses) 
Q.14. osc LikbMjksa  dks lpZ baftUl Hkh dgk tkrk gSA 
 (Web spider are also known as search engines.) 
  lgh (True)      xyr (False) 
Q.15. B2c, C2C vksj B2B --------------- ds çdkj gSA 
 B2c, C2C and B2B are types of ............... 
 bZ esy (E-mail)   bZ dkselZ (E-commerce)       bZ dS'k (E-cash)       buesa ls lHkh (All of these) 
Q.16. fdlh osc lkbV dks usfoxsV djus ds fy,] ;wtj dks -------------- esa ços'k djuk gksrk gSA 
 For navigating any website, user has to enter. 
 ;w vkj ,y (URL)     MCY;w MCY;w MCY;w (www) ih-ih-ih- (PPP)    buesa ls dksbZ ugha (None of these) 
Q.17. osc edfM;ka vksj ØkWylZ ds mnkjg.k gSA 
 Web spiders and Crawelers are examples of  
 czkmtlZ (Browsers)     lpZ baftUl (Search Engines)  
 ,p-Vh-,e-,y- çksxzkEl (HTML Programs)  QysEl (Flames) 
Q.18. dkWe ------------ çdkj dh O;oLFkk osc lkbV dks lwfpr djrk gSA 
 The .com indicates website of ............ type of organization. 
 okf.kT; (Commerce) tfVy (Complex) dEiuh (Company) dkxksZ (Cargo) 
Q.19. vkbZ ,l ih dk eryc gSA 
 ISP stands for. 
 baVuZy lfoZl Iyku (Internal Servicc Plan) baVjusV lfoZl Iyku (Internet Service Plan) 
 bafVxzy lfoZl Iyku (Intyergal Service Plan)       bUVjusV lfoZl çksokbMj (Internet Service Provider) 
Q.20. ------------ çksxzke gS] tks osc fjlkslsZl ds fy, ços'k ekxZ çnku djrs gSaA  
 ........... are programs that provide access to web resources. 
 czkmtlZ (Browsers)     lpZ baftUl (Search Engines)   çksxzkEl (Programs)  buesa ls lHkh (All of these) 
Q.21. fo'o Hkj esa dkSulk osc lpZ baftu ç;ksx fd;k tk ldrk gS \ 
 Which is a web search engine used World Wide ? 
 MksesUl (Domains) xwxy (Google) Vk¡xy (Toggle)         buesa ls lHkh (All of these) 
Q.22. baVjusV ij fdlh fof'k"V fo"k; ij ppkZ dks ------------- dgk tkrk gSA 
 Discussion on the internet about specific is known as  
 lekpkj (News)    lekpkj lewg (News Group)  

osjksfudk (Veronica)       Vsy~usV~ (Telnet) 
Q.23. ;w vkj ,y dk iw.kZ :i gSA 
 Full from of URL 
 ;wfuolZy fjlkslZ yksdsVj (Universal Resource Locator)  
 ;wfuQkWeZ fjlkslZ yksdsVj (Uniform Resource Locator)  
 ;wfu fjlkslZ yksdsVj (Uni Resource Locator)  buesa ls dksbZ ugha (None of these) 
Q.24. -------------- ,sls fo'ks"k çksxzke gSa ftudks tkok esa fy[kk x;k gSA 
 ............ are the special programs written in Java. 
 tkok çksxzkEl (Java Programs)   ,siysV~l (Applets)   
 çkstsDV~l (Projects)       buesa ls dksbZ ugha (None of these) 
Q.25. ,Q Vh ih dk eryc gSA 
 FTP stands for. 
 QhYM VªkalQj çkstsDV (Field Transfer Project) Qkby VªkalQj çkstsDV (File Transfer Project) 
 Qkby VªkalQj çksVksdkWy (File Transfer Protocol) buesa ls dksbZ ugha (None of these) 
Q.26. czkmtj ds va'k ds :i esa Iyx bu uked çksxzkeksa ds vkVksesfVd vkjEHk dj] ifjpkfyr fd;k tkrk gS 
 Plug-ins are programs that are automatically started and operate as a part of the browser. 
  lgh (True)      xyr (False) 
Q.27. dh&oMZ lpZ dks baMsDl lpZ Hkh dgk tkrk gSA 
 Keyword search is also known as Index search. 
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  lgh (True)      xyr (False) 
Q.28. ;fn vki "http://www. mkcl. org" tSls irs dks Vkbi djrs gSA rks mlesa .org lwfpr djrk gSA fd ;g ,d ---------

---- gSA 
 When you type an address such as "http://www.mkcl.org," in this. org indicates that it is a 
 vksfjftuy osc lkbV (Original Web Site) okf.kT; lEcU/kh osc lkbV (Commercial Web Site) 
 O;oLFkk lEcU/kh osc lkbV (Orgenizational Web Site)  fo|k lEcU/kh osc lkbV (Educational Web Site) 
Q.29. oYMZ okbM osc esa fdlh fof'k"B fo"k; dks <w¡<us ds fy, ---------------- vksj --------------- dk ç;ksx djrs gSaA 
 You can seach the World Wide Web for a specific topic by using ........... and .......... 
 xksilZ] fQMksl (Gophers, Fidos)   LdSulZ] lpZ baftu (Scanners, Search engine) 
 lpZ baftUl] bUMsDl (Search engine, Index)  czkmtlZ] Y;wdlZ (Browsers, Lukers) 
Q.30. lwfpr irs dks esfltst fHktkrs gq, esEcjksa dks lapkj djus dk ,d ekSdk fnykrs gSA esfyal lwfp;ka 
 Mailing lists allow members to communicate by sending messages to a list address. 
  lgh (True)      xyr (False) 
Q.31. ,d yksdfç; psfVax lsok dks ----------------- dgk tkrk gSA 
 A popular chat service is called - 
 baVjusV fjyht pSV (Internet Release Chat)  baVjusV vuqjks/k pSV (Internet Request Chat) 
 baVjusV lalk/ku pSV (Internet Resource Chat) baVjusV fjys pSV (Internet Relay Chat) 
Q.32. ,sIysV~l dks rS;kj djus ds fy, ç;qDr çksxzkfeax Hkk"kk dks tkok dgk tkrk gSA 
 A programming language used for creating applets is called java. 
  lgh (True)      xyr (False) 
Q.33. tc vki ,d VkWfid ds fy, -------------- dk ç;ksx djrs gS rks mlds }kjk [kksth xbZ lwpuk ,d MkVkcsl ds tSls <k¡ps esa 

laxfBr gks tkrh gSA 
 When you use a(n) .............. to search for a topic, the information you search through is 
  organized into a database - like structure. 
 lpZ baftu (Search Engine) baMsDl (Index)  LikbMj (Spider) ,sIysV (Applet) 
Q.34. Mksesu uke ds ihNs MkWV ¼-½ ds ckn vkus okys vk[kjh Hkkx dks -------------- dgk tkrk gSA 

The last part of the domain name following the dot (.) is called as .................. 
 Mksesu dksMl (Domain Codes)   bZ&esy VkxsZV~l (E-mail Targets) 
 Mh- ,u- ,l- (DNSs)     irs ds fy, esy (Mail to addresses) 
Q.35. osc ist fMtkbu djrs le; fuEufyf[kr LØhIV Hkk"kk dk ç;ksx fd;k tkrk gSA 
 Following is a script language used, while designing a web page. 
 ,p Vh ,e ,y ¼gkbij VsDlV ekdZvi ySaXost½ HTML (Hiper Text Markup Language) 
 ,p ,y ,e ,y ¼gkbij fyad ekdZvi ySaXost½ HLML (Hiper Link Markup Language) 
 ,p Vh MCY;w ,y ¼gkbij VsDlV osc ySaXost½ HTWL (Hiper Text Web Language) 
 buesa ls dqN ugha (None of these) 
Q.36. bZ&esy D;k gS \ 
 What is e-mail ? 
 baftfu;fjax esafyax (Engineering Mailing)   baVjusV esfyax (Internet Mailing) 
 bySDVªkWfud esfyax (Electronic Mailing)   mijksDr lHkh (All of the above) 
Q.37. vkbZ- ,e- dk eryc ------------------ 
 IM stands for ................... 
 baLVsV esfdax (Instant Making)    baVjuy esflftax (Internal Messaging) 
 baLVsV esflftax (Instant Messaging)    buesa ls dqN ugha (None of these) 
Q.38. ekbØkslks¶V ds baVjusV ,DlIyksjj O;kid :i ls ç;ksx djus okyk ,d czkmtj gSA 
 Microsoft's internet explorel is awidely used browser. 
  lgh (True)      xyr (False) 
Q.39. Mk;jsDVªh lpZ dks ------------------ Hkh dgk tkrk gSA 
 Directory search is also known as 
 Mk;jsDV lpZ (Direct Search)   ;wfud lpZ (Unique Search)   
 baMsDl lpZ (Index Search)   mijksDr lHkh (All of these) 
Q.40. ;w-vkj-,y- D;k gS \ 
 What is URL 
 lkW¶Vos;j dh ,d iSfdt ftlls oYMZ okbM oSc dk i;ZVu fd;k tkrk gSA 
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 (A software package used to cruise the World Wide Web) 
 oYMZ okbM oSc dk ,d lalk/ku dk irk (The address of resource on the World Wide Web) 
 baVjusV fotMZ dks o.kZu djus dk ,d 'kCn (The term used to describe an internet wizard) 
 ,d ykbo pSV çksxzke ¼vlhfer fj;y&Vkbe dh Hkk"kk½ 
 A live Chat Program (Unlimited Real time language) 
Q.41. usVLdsi usfoxsVj ,d çdkj dk ------------------ gSA 

Netscape Navigator is a type of ……………… 
 ;wfVfyfV çksxzke (Utility Program)  vksijsfVax flLVe (Operating System)  

czkmtj (Browser)    osc vk/kkfjr çksxzke (Web Authoring Program) 
System Software 

Q.1. ----------- çksxzke] vkids dEI;wVj flLVe dks ok;jl ;k brj gkfudkjd çksxzkeksa ls cpkrs gSA 
 .......... Programs that guard your computer system against viruses or other damaging  

programs. 
 cSd vi (Backup)    ,UVh ok;jl (Antivirus)  
 vu&baLVkWy (Uninstall)    buesa ls dksbZ ugha (None of these) 
Q.2. eYVhVkfLdax dk eryc vkWijsfVax flLVe ls ,d gh le; esa ,d ls vf/kd ,fIyds'kuksa dk pykus dh  
 {kerkA 
 Multitasking in the ability of the operating system to run more than one application at a time. 
  lgh (True)      xyr (False) 
Q.3. ----------- ,d ;wfVfyVh çksxzke gS] tks vuko';d QSXesaVksa dks <w¡<dj mUgsa gVkrk gS vksj vkWijs'kuksa dks lhfer djus ds fy, 

Qkbyksa vksj vuqI;wDr fMLd&Lisl dks fQj ls O;ofLFkr djrk gSA 
............. is a utility program that locates and eliminates unnecessary fragments and 
rearranges files and unused disk space to optimize operations. 

 cSd&vi (Backup)    fMLd Mh&QSXesaVksj (Disk Defragmenter) 
 vu baLVky (Uninstall)    buesa ls lHkh (All of these) 
Q.4. dEI;wVj ds gkMZ fMLd ij baLVkWy fd, x, vuko';d çksxzkeksa dks feVkus esa vu baLVkWy çksxzkEl ;ksxnku nsrs gSA 

Uninstall programs enable removing unneeded programs installed into the computer's 
hard disk. 

  lgh (True)      xyr (False) 
Q.5. cSd&vi çksxzkEl QSyksa dh çfr;ka cukrs gS] ftUgsa ewy QSyksa ds [kkstus ;k [kjkc gks tkus dh fLFkfr esa ç;ksx esa yk;s tkrs 

gSA 
Backup programs make copies of the files to be used in case the original files are 
damaged or lost. 

  lgh (True)      xyr (False) 
Q.6. ------------- dk eryc vkWijsfVax flLVe ls ,d gh le; esa ,d ls vf/kd ,fIyds'kuksa dks pykus dh {kerkA 
 ........... is the ability of the operating system to run more than one application at a time. 
 cwfVax (Booting)        dksfiax (Copping)        isfLVax (Pasting)        eYVh&VkfLdax (Multitaksing) 
Q.7. ------------ dks MsVk vksj çksxzkeksa dks LVksj djus esa ç;ksx fd;k tkrk gSA 
 ........... are used to store data and programs. 
 QksYMj (Folder) Qkby (File) jh&lkbfdy fcu (Recycle bin) buesa ls dksbZ ugha (None of these) 
Q.8. ------------ ,d ledsanzh oy; gSA 
 A ............ is a connetring ring. 
 VªSd (Track) lSDVlZ (Sectors) jkmaM (Round) buesa ls dksbZ ugha (None of these) 
Q.9. vkWijsfVax flLVe] ;wtj baVjQsl dk miyC/k djkrk gS] dEI;wVj lalk/kuks dk fua;=.k djrk gS vksj çksxzkeksa dks pykrk gSA 

The operating system provides the user interface, controls the computers resources, and 
runs programs. 

  lgh (True)      xyr (False) 
Q.10. gj ,d VªSd] ------------- uked dqN ost dh vkÑfr okys fgLlksa esa ck¡Vk x;k gSA 
 Each track is divided into wedge-shaped sections called .................. 
 VSªd (Track) lsDVlZ (Sectors) xksy (Round) buesa ls dqN ugha (None of these) 
Q.11. ------------ dks lfoZl çksxzke Hkh dgk tkrk gSA 
 ........... are also known as service programs. 
 vks- ,l- (OS)   fMokbl MªkbolZ (Device Drivers)    ;wfVfyfVl (Utilities) mijksDr lHkh (All of these) 
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Q.12. bl çdkj ds lkW¶Vos;j dks ,aM ;wtj lkW¶Vos;j ds uke ls tkuk tkrk gSA 
 Type of software that can be described as "end user" software. 
 MkWl (DOS)      flLVe lkW¶Vos;j (System Software)   
 ,Iyhds'ku lkW¶Vos;j (Application Software) vkWijs'ku lkW¶Vos;j (Operatin Software) 
Q.13. th- ;w- vkbZ- fdldk laf{kIr :i gS \  
 GUI Stands for 
 xzkfQ+dy ;wtj bUVjQ+sl  (Graphical User Interface) 
 xzsVj ;wtj bUVjQsl  (Greater User Interface) 
 xzkfQ+dy ;wfu;u bUVjQsl (Graphical Union Interface) 
 xzkfQdy ;wtj bUVjsLV  (Graphical User Intereat) 
Q.14. uhps fn;s x;s vkWijsfVax flLVe esa ls fdlesa xzkfQd ;wtj baVjQsl ugha gS \ 
 Which of these operating system does not have a graphical user interface ? 
 foaMkst 95 (Windows 95)  eSd OS (Mac OS) ySusDl (Linux)  ,e-,l- MkWl (MS DOS) 
Q.15. Hkk"kk vuqoknd çksxzkejksa }kjk fy[ks x;s çksxzkfeax funsZ'kksa dks fdlh Hkk"kk esa cnyrs gS] ftls dEI;wVlZ le>dj] mldk 

lalk/ku djrs gSA 
Language translators convert the programming instructions, written by programmers 
into a language that computer understand and process. 

  lgh (True)      xyr (False) 
Q.16. dbZ vyx VªCy'kwfVax ;wfVfyfV;ksa dk lekgkj gSA 
 ........... is a colloection of several separate troubleshooting utilities. 
 cSd vi (Backup)    ukWVZu ;wfVfyfV;ka (Norten Utilities)  
 vu baLVky (Uninstall)    mijksDr lHkh (All of the above) 
Q.17. ----------- ;wtj baVjQsl dks miyC/k djkrk gS] dEI;wVj lalk/kuksa dk fu;a=.k djrk gS vksj çksxzkeksa dks pykrk gSA 
 .......... provides the user interface, controls the computers resources, and runs programs. 
 MªkbolZ (Drivers)    vkWijsfVax flLVe (Operating System)  
 MsLdVkWi (Desktop)    buesa ls dksbZ ugha (None of these) 
Q.18. ------------ ;wfVfyfV] gkMZ fMLd ij vuko';d QSyks dks igpku dj] ;wtj mUgsa feVk nsrk gSA 

........... utility identifies non essential files on the hard disk and erases them only when 
user allows their erasure. 

 vu baLVky çksxzke (Uninstall Program)  cSd vi (Backup) 
 Qkby daçs'ku (File Compression)   fMLd Dyhu vi (Disk Clean up) 
Q.19. fuEufyf[kr esa ls dkSulk vkWijsfVax flLVe dk QaD'ku gSA 
 Which of the following is the function of operating system. 
 lalk/kuksa dk lapkyu (Managing Resources)  

,fIyds'kuksa dks pykuk (Running Applications)  
 ;wtj baVjQsl dk miyC/k djkuk (Providing User Interface) 
 mijksDr lHkh (All of the Above) 
Q.20. ---------- xzkfQdy vkWCtsDV~l gSa] tks lk/kkj.k :i ls ç;ksx fd;s tkus okys ,fIyds'ku dk çfrfuf/kRo djrs gSA 
 .......... are graphical objects used to represent commonly used applicatons. 
 th-;w-vkbZ- (GUI)  bolZ (Drivers)  foaMksl ,u-Vh- (Windows NT) vkbdkWUl (Icons) 
Q.21. dEI;wVj dh LVkfVZax ;k jh&LVkfVZax dks flLVe dh ---------------- dgk tkrk gSA 
 Starting or re-starting a computer is called .............. the system. 
 cwfVax (Booting) dksfiax (Copping) isfLVax (Pasting)    eYVh&VkfLdax (Multitasking) 
Q.22. ----------- fof'k"V çksxzke gS] tks fufnZ"V buiqV ;k vkmViqV midj.kksa dks ckdh ds dEI;wVj flLVe ls lapkj djus dh vuqefr 

nsrs gSA 
............. are specialized programs that allow particular input or output devices to 
communicate with the rest of the computer system. 

 fMokbl MªkbolZ (Device Drivers)  ;wfVfyfVl (Utilities)  
 vks-,l- (OS)      buesa ls dksbZ ugha (None of these) 
Q.23. fMLd Mh QSXesaVksj ,d ;wfVfyfV çksxzke gS tks vuko';d ÝSXesaVks dks <¡w<dj mUgsa gVkrk gS vksj vkWijs'kuksa dks lhfer djus ds 

fy, Qkbyksa vksj vuqIk;qDr fMLd Lisl dks fQj ls O;ofLFkr djrk gSA 
Disk Defrangmeter is a utility program, that locates and eliminates unnecessary 
fragments and rearranges files and unused disk space to opimize operations. 

ANKAJ I
NFOTECH

cmc
Text Box



35 
Deep Training Institute Pvt. Ltd., Alwar 

  lgh (True)      xyr (False) 
Q.24. ------------ dek.Mksa dk çn'kZu djrk gS] tks lwpuk ikus] gkMZos;j ls lsfoaxksa dks cnyus] lafpr lwpuk dks <w¡<dj] vkWu ykbu  
 enn ikus ;k dEI;wVj dks 'kV Mkmu djus dk ç;ksx dj ldrs gSA 

The ............. displays a list of commands that can be used to gain access to information, 
change hardware settings, find information stored in the, get online help and shut down 
the computer. 

 th- ;w- vkbZ (GUI) MsLdVkWi (Desktop) vkbZdkWu (Icon) LVkVZ cVu (Start Button) 
Q.25. fuEufyf[kr esa ls dkSulk usVodZ vkWijsfVax flLVe dk mnkjg.k gSA 
 Which of the following example of network operating systems ? 
 usVos;j (Netware)    foaMksl ,u- Vh- loZj (Windows N.T. Server) 
 foaMksl ,Dl- ih- loZj (Windows XP Server) mijksDr lHkh (All of the above) 
Q.26. ;wfVfyfVl dks lfoZl çksxzke Hkh dgk tkrk gSA 
 Utilities are also known as service programs 
  lgh (True)      xyr (False) 
Q.27. fMLd ij de txg Hkjus ds fy, ,sls dkSu ls çksxzkEl QSyks gS] tks muds ifj.kkeksa dks ?kVkrs gSA 
 Which programs reduce the size of the files so that they accupy lesser space on the disk. 
 cSd vi (Backup)    fMLd Dyhu vi (Disk Cleanup)  
 Qkby dEçs'ku (File Compression)  vu baLVky çksxzke (Uninstall Program) 
Q.28. gj ,d VªSd] lSDVlZ uked dqN ost dh vkÑfr okys fgLlksa esa ck¡Vk x;k gSA 
 Each track is divided into wedge-shaped called sectors. 
  lgh (True)      xyr (False) 
Q.29. dEI;wVj dh LVkfVZax ;k fj&LVkfVZax dks flLVe dh eYVhVkfLdax dgk tkrk gSA 
 Starting or Restarting a computer is called multitasking the system. 
  lgh (True)      xyr (False) 
Q.30. -------] çksxzkejksa }kjk fy[ks x;s çksxzkfeax funsZ'kksa dks fdlh Hkk"kk esa cnyrs gSa] ftls dEI;wVlZ le>dj mudk lalk/ku djrs gSA 

 ............ convert the programing instruction written by programmers into a language that 
  computers understand and process. 
 ;wfVfyfVl (Utilities)     fMokbl MªkbolZ (Device Drivers) 
 Hkk"kk vuqoknd (Language Translators)  buesa ls dksbZ ugha (None of these) 
 
Q.31. flLVe lkW¶Vos;j esa fuEu ds vykok lHkh 'kkfey gSA 
 System software includes all of the following except. 
 vkWijsfVax flLVe (Operating System)  fMokbl MªkbolZ (Device Drivers) 
 mi;ksfxrk,a (Utilities)    MsLdVkWi ifCyf'kax (Desktop Publishing) 
Q.32. ------------- cSdxzkmaM lk¶Vos;j gS tks fd dEI;wVj dks mlds vkarfjd lzksrks ds mi;ksx esa lgk;rk djrk gSA 
 ............ is background software that helps the computer manage it's own internal resources. 
 flLVe lkW¶Vos;j (System Software)   lwpuk (Information) 
 mís'; (Objects)      buesa ls dksbZ ugha (None of these) 
Q.33. vkWijsfVax flLVEl] çksxzke gSa tks lalk/kuksa dk lapkyu djrs gS ;wtj baVjQsl dks miyC/k djkrs gSa vksj  
 ,fIyds'kuksa dks pykrs gSaA 
 Operating systems are programs that manage resource, provide user interface and run 
  applicatons. 
  lgh (True)      xyr (False) 
Q.34. dEI;wVj dh LVkZfVax ;k jh&LVkZfVax dks cwfVax dgk tkrk gSA 

Starting or Re-starting a computer is called booting the system. 
  lgh (True)      xyr (False) 
Q.35. ,UVh ok;jl çksxzke dEI;wVj dks ok;jl ;qDr çksxzkeksa ds geys ls cpkus ds fy, gksrs gSA 
 Anti virus programs are meant to guard a computer from invasion of the virus programs. 
  lgh (True)      xyr (False) 
Q.36. dEI;wVj ds gkMZ fMLd ij baLVky fd;s x;s vuko';d çksxzkeksa dks feVkus esa vubaLVky çksxzkEl ;ksxnku nsrs gSaA 
 Uninstall programs enable removing unneeded programs on started into  
  lgh (True)      xyr (False) 
Q.37. VªCy'kwfVax çksxzke gkMZos;j vksj lkW¶Vos;j nksuksa dh leL;kvksa dks igpku dj tgka rd gks lds mudks lq/kkjus dh dksf'k'k  
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djrk gSA 
Trouble shooting programs recognize both hardware and software problems and try to 
correct them as far as possible. 

  lgh (True)      xyr (False) 
Q.38. fMokbl MªkbolZ fof'k"V çksxzke gS] tks fufnZ"V buiqV ;k vkmViqV midj.kksa dh ckdh ds dEI;wVj flLVe ls lapkj djus dh 

vuqefr nsrs gSA 
 Device Drivers are specialized programs that allow particular input or output devices to 
  communicate with the rest computer system. 
  lgh (True)      xyr (False) 
Q.39. ,sUVhok;jl çksxzke dEI;wVj dks ok;jl ;qDr çksxzkeksa ds geys ls cpkus ds fy, gksrs gSA 
 Antivirus programs are meant to guard a computer from invasion of the virus programs. 
  lgh (True)      xyr (False) 

System Unit 
Q.1. ekbØks&çkslslj esa nksa ekSfyd ?kVd gksrs gSA 
 Microprocessor has two basic components. 
 daVªksy ;wfuV (Control Unit)   vFkZesfVd ykWftd ;wfuV (Airthmatic Logic Unit)  
 ;s lHkh (All of these)   buesa ls dksbZ ugha (None of these) 
Q.2. fuEufyf[kr esa ls dkSulk MsVk lalk/ku bdkbZ gS \ 
 Which of the following is a data processing unit 
 lhih;w (CPU)  jSe (RAM)  gkMZ fMLd (Hard Disk)  ¶ykWih (Floppy) 
Q.3. Qk;j&ok;j ds iksVZ dks gkMZ ijQkWesZUl lhfj;y cl ¼,p-ih-,l-ch-½ iksVZ Hkh dgk tkrk gSA 
 Fire-Wire port is also called as High Performance Serial Bus (HPSB) port. 
  lgh (True)      xyr (False) 
Q.4. dS'k eSeksjh dks jSe esa vDlj ç;ksx dh tkus okyh lwpuk dks laxzg djus esa ç;ksx fd;k tkrk gSA 
 Cashe memory is used to store most frequently accessed information from the RAM. 
  lgh (True)      xyr (False) 
Q.5. vkj-vkbZ-,l-lh- dk eryc gSA 
 RISC stands for. 
 jsM;wtM baLVªD'ku lsV dEI;wVj (Redused Instruction Set Computer) 
 jhM baLVªD'ku lsV dEI;wVj (Read Instruction Set Computer) 
 jsM;wtM baLVªD'ku lkW¶Vos;j dEI;wVj (Reduce Instruction Software Computer) 
 buesa ls dksbZ ugha (None of these) 
Q.6. ------------- flLVe ds lHkh ?kVdksa dks tksMrk gS vksj buiqV rFkk vkmViqV ds midj.kksa ds flLVe ds bdkbZ ls lapkj djus nsrk 

gSA 
The ........... connects all system computers and allows input and output device to 
communicate with the system unit. 

 flLVe cksMZ (System Board)    ekWuhVj (Monitor)  
 ekml (Mouse)      buesa ls dksbZ ugha (None of these) 
Q.7. ekbØks çkslslj fpIl ds çdkj gS & 
 The types of microprocessor chips are 
 lh-vkbZ-,l-lh- fpIl (CISC Chips)   vkj-vkbZ-,l-lh- fpIl (RISC Chips) 
 ;s lHkh (All of these)    buesa ls dksbZ ugha (None of these) 
Q.8. lhfj;y iksVZ ls MsVk dk VªkalQj] lekukUrj iksVZ ls Hkh rsth ls gksrk gSA 
 Data transfer through a serial port is faster than that of a parallel port. 
  lgh (True)      xyr (False) 
Q.9. fuEu esa ls dkSulh çkbejh eSeksjh gS \ 
 Which of following is a primery memory ? 
 jSe (RAM)  lhMh (CD)  ¶ykWih (Floppy)  gkMZ fMLd (Hard Disk) 
Q.10. jSUMe ,Dlsl eSeksjh ¼jSe½] ------------- çdkj dh gksrh gSA 
 Random Access Memory (RAM) is ............ type of memory. 
 LFkk;h (Permanent) vLFkkbZ (Temporary) ¶yS'k (Flash)  LekVZ (Smart) 
Q.11. ASCII, EBCDIC vksj ;wfu dksM] ,fIyds'ku lkW¶Vos;j ds mnkjg.k gSA 
 ASCII, EBCDIC and Unicode are examples of Application Software. 
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  lgh (True)      xyr (False) 
Q.12. vkB fcV~l feydj ,d ckbV gksrk gSA 
 Eight bits makes up a bite. 
  lgh (True)      xyr (False) 
Q.13. ekbØks dEI;wVj esa dsfUnz; lalk/ku bdkbZ ¼lh-ih-;w-½ ;k lalk/kd] ekbØks&çkslslj uked flaxy fpi ij 'kkfey gksrs gSaA 

In a microprocessor system, the Central Processing Unit (C.P.U.) or a processor is 
contained on a single chip called the microprocessor. 

  lgh (True)      xyr (False) 
Q.14. lh- vkbZ- ,l- lh- dk eryc gSA 
 CISC stands for. 
 dEI;wVj baLVªD'ku lsV dEI;wVj (Computer Instruction Set Computer) 
 dkWEiysDl baLVªD'ku lsV dEI;wVj (Complex Instruction Set Computer) 
 dkWEiysDl baMsDl lsV dEI;wVj (Complex Index Set Computer) 
 buesa ls dksbZ ugha (None of these) 
Q.15. ASCII, EBCDIC vksj ;wfu dksM&ckbujh dksfMax Ldhe gSaA 
 ASCII, EBCDIC and Unicode are binery coding schemes. 
  lgh (True)      xyr (False) 
Q.16. uksV cqd ds flLVe ;wfuVksa dks vDlj --------------- dgk tkrk gSA 
 Note book system units are often called as ................. 
 ih-Mh-,- (PDA)    ySiVkWi (Laptop) MsLdVkWi (Desktop) buesa ls dksbZ ugha (None of these) 
Q.17. ----------- dks flLVe dsfcusV ;k pSfll Hkh dgk tkrk gSA 
 ............. is also known as the system cabinet or chassis. 
 flLVe ;wfuV (System Unit)    ekWuhVj (Monitor) 
 dh cksMZ (Key board)     buesa ls dksbZ ugha (None of these) 
Q.18. ¶yS'k jSe esa laxzg dh xbZ MsVk] dEI;wVj ds fy, ikoj fLop vkWQ djus ij Hkh feV ugha tkrh gSA 

Data stored in Flash RAM does not get erased even when power to the computer is 
switched off. 

  lgh (True)       xyr (False) 
Q.19. flLVe cksMZ dks esu cksMZ ;k enj cksMZ Hkh dgk tkrk gSA 
 The system board is also known as the main board or mother board. 
  lgh (True)       xyr (False) 
Q.20. LVksjst midj.k dh {kerk dks lk/kkj.k :i ls ckbVksa esa ukik tkrk gSA 
 Capacity of a storage device is usually measured in terms of bytes. 
  lgh (True)       xyr (False) 
Q.21. fuEufyf[kr esa ls dkSu ls ?kVd dks MsVk laxzg esa ç;ksx fd;k tkrk gSA 
 Which of the following component is used to store data? 
 lhih;w (CPU) eseksjh (Memory)  buiqV midj.k (Input Device) vkmViqV fMokbl (Output Device) 
Q.22. ekbØksçkslslj dks vDlj lhih;w dgk tkrk gSA 
 Microprocessor is often called a CPU. 
  lgh (True)       xyr (False) 
Q.23. ekbØksçkslslj ds flLVe esa dsfUnz; lalk/ku bdkbZ ¼lh-ih-;w-½ ;k lalk/kd] ------------- uked flaxy fpi ij  'kkfey jgrs gSA 

In a microprocessor system, the control processing unit (C.P.U.) or processor is contained 
on a single chip called the ............ 

 LykWV (Slot) iksVZ (Port) ekbØksçkslslj (Microprocessor)  buesa ls dksbZ ugha (None of these) 
Q.24. ----------- ,d 16 fcV okyk dksM+ gS] ftls phuh ;k tkikuh; tSlh vUrjkZ"Vªh; Hkk"kkvksa dh iqf"V ds fy, rS;kj fd;k x;k gSA 
 ............ is a 16-bit code desingend to support international language like Chinese and 
  Japanese. 
 ;wfu dksM+ (Unicode) ASSCII EBCDIC  buesa ls dksbZ ugha (None of these) 
Q.25. ------------ dkQh iksVsZcy rjg ds midj.k gS] tks deS.Mksa ;k MsVk dks buiqV djus ds fy, LVSyl ;k dye ds ç;ksx dk leFkZu 

djrs gSA 
 ih-Mh-,- (PDA) ySiVkWi (Laptop) MsLdVkWi (Desktop) VSCysV~ ih-lh- (Tablet P.C.s) 
Q.26. fuEufyf[kr esa ls dkSulk dEI;wVj ds eSeksjh dh bdkbZ gS \ 
 Which of the following is the unit of computer memory. 
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 fdyksxzke (Kilogram) fdyksckbVl (Kilobytes) ehVj (Meter) lsfYlvl (Celsius) 
Q.27. fçUVjksa dks flLVe ;wfuV ds lkFk tksMus esa vf/kdrj lekukUrj iksVksZ dk ç;ksx fd;k tkrk gSA 
 Parallel ports are mostly used to connect printers to the system unit. 
  lgh (True)      xyr (False) 
Q.28. bySDVªkWfud i)fr esa MsVk vksj funsZ'kksa dks ckbujh ;k Vw&LVsV uacfjax flLVe ds Li esa of.kZr fd;k x;k gSA 

Data and instructions are represented electronically with a binary, or two-state 
numbering system. 

  lgh (True)      xyr (False) 
Q.29. fuEufyf[kr esa ls dkSulh eSeksjh dh vf/kdre bdkbZ gS \ 
 Which of the following is the heighest unit of memory ? 
 xhxkckbZV (Gigabyte) ckbZV (bytes) esxkckbZV (Megabytes) fdyksckbV (Kilobytes) 
Q.30. flLVe cksMZ] flLVe ds lHkh ?kVdksa dks tksMrk gS vksj buiqV rFkk vkmViqV ds midj.kksa dks flLVe ds bdkbZ ls lapkj djus  
 nsrk gSA 
 The system board connects all system components and allow input and output device to 
  communicate with the system unit. 
  lgh (True)      xyr (False) 
Q.31. lekukUrj iksVZ esa MsVk dks ,d ckbV ls nwljs ckbV esa çlkfjr fd;k tkrk gSA 
 In parallel port data is transmitted one byte after another. 
  lgh (True)      xyr (False) 
Q.32. fuEu esa ls dkSulh çkbejh eSeksjh gS \ 
 Which of the following is a primery memory ? 
 jSe (RAM)  lh-Mh- (CD)  ¶ykWih (Floppy)  gkMZfMLd (Hard Disk) 
Q.33. lkWdsV~l LykWVl vksj cl ykbUl] flLVe cksMZ ds ?kVd gSA 
 Socates, slots and bus lines are components of the system board. 
  lgh (True)       xyr (False) 
Q.34. ckbujh uacfjax flLVe esa gj ,d 0 vksj 1 dks ,d fcV dgk tkrk gSA 
 Each 0 and 1 in the binery numbering system is called a bit. 
  lgh (True)      xyr (False) 

Input and Output 
Q.1. ekWuhVj LØhu ds fcac ds vkmViqV dks vdlj gkMZdkih dgk tkrk gSA 
 Output of an image on the monitor screen is often called hard copy. 
  lgh (True)      xyr (False)  
Q.2. cSad esa pSdl ls MsVk dks i<+us esa ,e- vkbZ- lh- vkj- dk ç;ksx fd;k tk ldrk gSA 
 MIRC can be used to read data from checks in a bank. 
  lgh (True)      xyr (False) 
Q.3. 800 x 600 fjtksY;w'ku okys ekWuhVj gkfjtkWUVy 800 fiDlsy vksj ofVZdy 600 fiDlsy gksrs gSA 
 A monitor with resolution of 800 x 600 has 800 pixels horizontally and 600 pixels vertically. 
  lgh (True)      xyr (False) 
Q.4. dh cksMZ ij 0&9 rd fufnZ"V dqqaft;ksa dks -------------------- dgk tkrk gSA 
 The keys labeled 0 -9 on the keyboard are called. 
 QaD'ku dht (Function Keys)   VkbijkbZVlZ dht (Typewriters Keys) 
 U;wefjd dht (Numeric Keys)  fo'ks"k ç;kstu dht (Special purpose Keys) 
Q.5. ekml vksj VªSd & ckWy ds dk;Z vyx & vyx gSA 
 The functions of a mouse and a track ball are different. 
  lgh (True)      xyr (False) 
Q.6. ------------ midj.k] turk ds le>us ds tSls dEI;wVjksa }kjk lalk/ku djus yk;d :iksa esa ifjorZu djrs gSA 
 .......... devices translate what people understand into a form that computers can process. 
 buiqV (Input) vkmViqV (Output)   ;s lHkh (All of these)    buesa ls dksbZ ugha (None of these) 
Q.7. dh cksMZ esa F1, F2, vkfn uke dh dqaft;ksa dks ------------------ dgk tkrk gSA 
 The keyboards keys that are labeled F1, F2 and so on are called ................ 
 QaD'ku dht (Function Keys)   U;wesfjd dht (Numeric Keys)  
 Vkbi jkbVlZ dht (Typewriter Keys)  fo'ks"k ç;kstu dht (SpecialPurpose Key) 
Q.8. fuEufyf[kr esa ls dkSulk midj.k iksbaV djus okyk midj.k ugha gS \ 
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 Which of the following device is not from pointing type of device ? 
 ekml (Mouse) Vp LØhu (Touch screen) dh cksMZ (Key board) tk; LVhd (Joystick) 
Q.9. fuEufyf[kr esa ls dkSulk midj.k buiqV midj.k ugha gS \ 
 Which of these is not a input device ? 
 ekWuhVj (Monitor) ekml (Mouse)  dh cksMZ (Key board) tk; LVhd (Joystick) 
Q.10. eqfnzr ikB dks e'khu jhMscy dksM esa cnyus esa vks- lh- vkj- dk ç;ksx fd;k tk ldrk gSA 
 OCR is used to translate printed text to machine readable code. 
  lgh (True)      xyr (False) 
Q.11. vkWifVdy djsDVj dks igpkuus dk midj.k vksj vkWifVdy ekdZ dks igpkuus dk midj.k nksuksa ,d gh midj.k ds nksa uke 

gSA 
Optical character recognition decice and optical mark recognition device are two names 
of the same device. 

  lgh (True)      xyr (False) 
Q.12. gkWfjtUVy fiDlsy dh la[;k vksj ofVZdy fiDlsy dh la[;k dk vuqikr] ekWuhVj dk ,sLisDV jsf'k;ks gSA 
 Aspect ratio of a monitor is the ratio of number of horizontal pixels to number of vertical pixels. 
  lgh (True)      xyr (False) 
Q.13. ekWuhVj LØhu ds fcac ds vkmViqV dks vDlj gkMZdkWih dgk tkrk gSA 
 Output of an image on the monitor screen is often called a hardcopy. 
  lgh (True)      xyr (False) 
Q.14. fdlh fQpj dks vkWu ;k vkWQ djus okys dSi ykWd ds tSls dh cksMZ dh dqaft;ksa dks --------------- dgk tkrk gSA 
 The keyboard keys like caps lock that turn a feature on or off are called. 
 QaD'ku dht (Function Keys)   dkWfEcus'ku dht (Combination Keys) 
 Vkaxy dht (Toggle Keys)   fo'ks"k ç;kstu dht (Special Purpose Keys) 
Q.15. ;wtj dks lwpuk çnf'kZr djuk gh ekWuhVj dk ewyHkwr dk;Z gSA 
 Primary function of a monitor is to display information to the user. 
  lgh (True)      xyr (False) 
Q.16. gsMQksu] vkmViqV midj.k dk çfrfuf/kd :i gSA 
 Headphone is a typical output device. 
  lgh (True)      xyr (False) 
Q.17. MsLdVkWi ij ns[ks tkus okys ekml ikWbaVj dks -------------- Hkh dgk tkrk gSA 
 The mouse pointer seen on the desktop is also called as ............... 
 ,sjks ikWbaVj (Arrow Pointer)    dh ikWbaVj (Key Pointer) 
 fMLiys ikWbaVj (Display Pointer)   buesa ls dksbZ ugha (None of these) 
Q.18. fo'ks"k ç;kstu okys xzkfQdksa dks rS;kj djus esa IykWVlZ dk ç;ksx fd;k tk ldrk gSA 
 Plotters are used to produce special purpose graphics. 
  lgh (True)      xyr (False) 
Q.19. buiqV midj.k] turk ds le>us ds tSls dEI;wVjksa }kjk lalk/ku djus yk;d :iksa esa ifjorZu djrs gSA 
 Input device translate what people understand into a form that computers can process. 
  lgh (True)      xyr (False) 
Q.20. fi;kuks ds tSls laxhr dks ctkuk gh dEI;wVj esa dkWeu dh cksMZ dk ewyHkwr dk;Z gSA 
 Primary function of a common keyboard in a computer is to play music like a piano. 
  lgh (True)      xyr (False) 
Q.21. foaMksl vkWijsfVax flLVe esa LØhu ds fdlh Hkh fgLls rd vklkuh ls igqapus esa -------------- dk ç;ksx gksrk gSA 
 The eassiest way to access any part of the screen in the windows operating system is using 
the 
 dh cksMZ (Key board)  pwgk (Rat) ekml (Mouse) tkW;LVhd (Joystick) 
Q.22. MkWV eSfVªDl fçaVj fpMfpMkus okys vkokt mRiUu djrs gSA 
 Dot matrix printers make irritating noise. 
  lgh (True)      xyr (False) 
Q.23. rsth ls [ksyus okys xsEl~ ds fy, tkW; LVhd dkQh ykHknk;d gSA 
 Joystick is very useful in playing speed games. 
  lgh (True)      xyr (False) 
Q.24. dkxt ij vkmViqV ikus ds fy, fçaVjksa dks dEI;wVj ds lkFk tksM ldrs gSA 
 Printers can be connected to a computer for producing output on a paper. 
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  lgh (True)      xyr (False) 
Q.25. 'kkVZdV rS;kj djus ds fy, QaD'ku dht ds vykok fdu dqaft;ksa dk ç;ksx fd;k tkrk gSA 
 Instead of function keys which are use to create a shortcut. 
 Vkaxy dht (Toggle Keys)    Lis'ky dht (Special Keys) 
 dkWfEcus'ku dht (Combination Keys)  U;wesfjd dht (Numeric Keys) 
Q.26. ¶ySV cSM LdSuj ds dke djus dh i)fr dkQh gn rd QksVks dkWfibax e'khu ds tSls gh gSA 
 Method of working of a flatbed scanner is mostly similar to a photocopying machine. 
  lgh (True)      xyr (False) 
Q.27. ekWuhVj LØhu ds fcac ds vkmViqV dks vDlj lkW¶V dkWih dgk tkrk gSA 
 Output of an image on the monitor screen is often called soft copy. 
  lgh (True)      xyr (False) 
Q.28. dkSu lk fçaVj] dkxt ds Åij L;kgh ls NksVs&NksVs fcanqvksa dks vR;ar rsth ls fNM+ddj MsVk ;k fcacksa dks  fçaV djrk gSA 
 Which printer print data or image by spraying small dropts of ink at high speed into the 
  surface of the paper ? 
 bad tsV fçaVj (Ink Jet Printer)    ystj fçaVj (Laser Printer) 
 MkWV esfVªDl fçaVj (Dot Matrix Printer)   Mªe fçaVj (Drum Printer) 
Q.29. fuEufyf[kr esa ls dkSulh dqath Vkaxy dh ugha gS \ 
 Which of the following key is not a toggle key ? 
 dSIl ykWd (Caps Lock)  ue ykWd (Num Lock)  LØksy ykWd (Scroll Lock)  daVªksy (Control) 
Q.30. dh cksMZ ds dqaft;ksa esa ,sjks okys dqaft;ksa dks -------------------- dgk tkrk gSA 
 The keyboard keys that have arrows on them are called. 
 QaD'ku dht (Function Keys)   usfoxs'ku dht (Navigation Keys) 
 VkbijkbZVlZ dht (Typewriters Keys)  fo'ks"k ç;kstu dht (Special Purpose Keys) 
Q.31. --------------- ,d ykbV laflfVo dye ds tSlk midj.k gSA 
 A .............. is a light sensitive pen like device. 
 ykbV isu (Light Pen)    tkW; LVhd (Joy Stick)  
 Vp LØhu (Touch Screen)   buesa ls dksbZ ugha (None of these) 
Q.32. fçaVj esa vkmViqV gksus okys fcac dks vDlj gkMZ dkWih dgk tkrk gSA 
 Output of an image through a printer is often called hard copy. 
  lgh (True)      xyr (False) 
Q.33. fuEufyf[kr midj.kksa esa ls dksulk midj.k rsth ls dEI;wVj xsEl dks [ksyus esa iz;ksx fd;k tkrk gS 
 Which of the following device is used to play fast computer games? 
  tkW;LVhd (Joystick)    Vp lQsZ'k  (Touch Surface)  
  Vp LØhu (Touch Screen)  VªSd ckWy  (Track Ball) 

Secondary Storage 
Q.1. fMLd ij fLFkr cgqr lkjs xksykdkj {ks=ksa esa ls ,d gS] tgka MsVk dks eSXusfVdy rkSj ij fy[kk tkrk gSA 
 A track on a disk is the one of the many circular ring shaped areas where data is written 
  magnetically. 
  lgh (True)      xyr (False)  
Q.2. fuEufyf[kr esa ls dkSulk Qkby dEçs'ku çksxzke ugha gS \ 
 Which of these is not a file compressin program ? 
        fou f>i (Win Zip)   ih-ds- fti~ (PK Zip)    fou vkj-,-vkj- (Win RAR)   vkj-,-vkbZ-Mh-(RAID) 
Q.3. ikajifjd ¶ykWih fMLd] 1-44 ,ech 3-5 bap dk fMLd gksrk gSA 
 The traditional floppy disk is the 1.44 MB 3.5 inch disk. 
  lgh (True)      xyr (False) 
Q.4. 200 ,ech ;k 720 ,ech dh {kerk okys fMLdksa dk mRiknu lksuh dkWiksZjs'ku }kjk fd;k tkrk gS ---------- 
 ............ disk from the Sony Corporation have a capacity of 200 MB or 720 MB. 
 lqij fMLd (Super Disk)    gkbZ ,Q Mh fMLd (HiFD Disk)  
 fti~ fMLd (Zip Disk)    buesa ls dksbZ ugha (None of these) 
Q.5. mPp {kerk okys fMLdksa dks Hkh ¶ykWih fMLd dkVZjsftl ds uke ls tkuk tkrk gS tks ikjaifjd ¶ykWih fMLd dh txg ys jgk 

gSA 
High capacity disks also known as floppy disk cartriodges are rapidly replacing the 
traditional floppy disk. 
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  lgh (True)       xyr (False) 
Q.6. --------------- MsVk vko';drkvksa dk vuqeku djrs gq, gkMZ fMLd ds fu"iknu esa lq/kkj djrk gSA 
 ............. improves hard-disk performance by anticipating data needs. 
 fMLd dSfpax (Disk Catching)    fMLd fMQSXesaV (Disk Defragment) 
 fMLd jkbZfVax (Disk Writing)    buesa ls dksbZ ugha (None of these) 
Q.7. 3-5 ¶ykWih fMLd dh {kerk ------------------- 
 3.5 floppy disk capacity is ................. 
 1-44 ,e ch (1.44 MB)    1 ,ech (1 MB)   
 1-66 ,ech (1.66 MB)     1-55 ,ech (1.55 MB) 
Q.8. 120 ,ech ;k 240 ,ech {kerk okys lqij fMLdksa dk mRiknu bes'ku }kjk fd;k tkrk gSA 
 Super disks are produced by Imation and have a 120 MB or 240 MB capacity. 
  lgh (True)      xyr (False) 
Q.9. lh-Mh- jkse dk eryc gSA 
 A CD-ROM stands for. 
 dkWEiSDV fMLd jhM vksUyh eseksjh (Compact Disk Read Only Memory) 
 dkWEiSDV fMLd jhM oUl eseksjh (Compact Disk Read Once Memory) 
 lh- Mh- vkj- MCY;w (CD-RW)  buesa ls dksbZ ugha (None of these) 
Q.10. -------------- çksxzke] vkids dEI;wVj flLVe dks ok;jl ;k brj gkfudkjd çksxzkeksa ls cpkrs gSA 
 .......... Programs that guard your computer system against viruses or other damaging pro
   grams. 
 cSd vi (Backup)    ,sUVh ok;jl (Anti Virus)  

vu baLVky (Uninstall)    buesa ls dksbZ ugha (None of these) 
Q.11. xksykdkj fgLls dk uke D;k gS] ftl ij laxzg.k ek/;e ij MsVk dks fy[kk tkrk gS \ 
 What is the name given to a part of circle on which data is written in a storage media ? 
 VªSd (Track) lSDVj (Sector)  flfyaMj (Cylinder)  Likbjy (Spiral) 
Q.12. lh-Mh-vkj-MCY;w- fMLd dk eryc gSA 
 A CD-RW Disk means. 
 lh-Mh-jh-jkbVscy (CD-Rewriteable)   lh-Mh-fjdkWMsZcy (CD-Recordable) 
 lh-Mh- jkWe (CD-ROM)     buesa ls dksbZ ugha (None of these) 
Q.13. -------------- dk mRiknu yksesxk }kjk fd;k tkrk gS o mldh {kerk 100 ,ech o 250 ,ech ;k 750 ,ech gS tks fd vkt 

dh ekud ¶ykWih fMLd dh rqyuk esa 500 xquk gSA  
............. are produced by lomega and topically have a 100 MB, 250 MB or 750 MB 
capacity over 500 times as much as today's standard floppy disk. 

 lqij fMLd (Super Disk)    gkbZ ,QMh fMLd (HiFD Disk)  
 fti fMLd (Zip Disk)     buesa ls dksbZ ugha (None of these) 
Q.14. ewyHkwr laxzg.k OgksysVkbZy gSA 
 Primary storage is a volatile. lgh (True)  xyr (False) 
Q.15. 200 ,ech ;k 720 ,ech dh {kerk okys gkbZ ,Q Mh fMLdks dk mRiknu lksuh dkWiksZjs'ku }kjk fd;k tkrk gSA 
 HiFD Disks from the Sony Corporation have a capacity of 200 MB or 720 MB. 
  lgh (True)      xyr (False) 
Q.16. 120 ,ech ;k 240 ,ech {kerk okys lqij fMLdks dk mRiknu bes'ku }kjk fd;k tkrk gSA 
 .......... are produced by Imation and have a 120 MB or 240 MB capacity. 
 lqij fMLd (Super Disk)    gkbZ ,QMh fMLd (HiFD Disk) 
   fti~ fMLd (Zip Disk)     buesa ls dksbZ ugha (None of these) 
Q.17. ----------- ,d cnyus ;ksX; LVksjst midj.k gS ftlesa cMh ek=k esa tkudkjh LVksj dh tkrh gSA 
 ........... are removable storage devices used to store massive amounts of information. 
 gkMZ fMLd iSd (Hard Disk Packs)   lh-Mh- (C.D.) 
 ¶ykWih fMLd (Floppy Disk)    buesa ls dksbZ ugha (None of these) 
Q.18. gj ,d VªSd] lSDVlZ uked dqN ost dh vkÑfr esa ck¡Vk x;k gSA 
 Each track is divided into wedge-shaped sections called sectors. 
  lgh (True)      xyr (False) 
Q.19. laxzg.k midj.k ,sls gkMZos;j gS] tks MsVk vksj çksxzkeksa dks laxzg.k ek/;e ls i<rk gSA 
 Storage device are hardware that reads data and programs from stroage media. 
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  lgh (True)      xyr (False)  
Q.20. fMLd ds yscy ij 2 ,pMh dk erycA 
 The 2 HD on a disk label means. 

 nks rjQ] de ?kuRo (Two side, Low Density)     nks rjQ] vf/kd ?kuRo (Two Side High Density) 
 ,d rjQ] vf/kd ?kuRo (One Side High Density) buesa ls dksbZ ugha (None of these) 
Q.21. ----------- fMLdks esa 120 ,ech dh laxzg.k {kerk gksrh gS vksj ,d ekud 3-5** ds ¶ykWih fMLdl~ ij MªkbOl MsVk dks jhM dj] 

mls LVksj dj ldrs gSA 
........... disks have a 120 MB storage capacity and the drivers are also able to read and 
store data on a standard 3.5" floppy disk. 

 lqij fMLdl (Super Disks)     gkbZ ,Q Mh fMLdl (HiFD Disks) 
 fti fMLdl (Zip Disks)     buesa ls dksbZ ugha (None of these) 
Q.22. fti fMLdks dk mRiknu yksesxk }kjk fd;k tkrk gS o mldh {kerk 100 ,ech] 250 ,ech ;k 750 ,ech gS tks vkt ds 

ekud ¶ykWih fMLd dh rqyuk esa 500 xquk gSA 
 Zip disks are produced by lomega and typically have a 100 MB, 250 MB or 750 MB 

 capacity over 500 times such as much as today's standard floppy disks. 
  lgh (True)      xyr (False) 
Q.23. lh- Mh- vkj- dk eryc gSA 
 A CD-R stands for. 
 lh-Mh- fjdkWMsZcy (CD-Recordable)    lh-Mh- jUuj~ (CD-Runner) 
 lh-Mh- fjlhoj (CD-Receiver)    buesa ls dksbZ ugha (None of these) 
Q.24. gj ,d VªSd ------------------ uked dqN ost dh vkÑfr okys fgLlksa esa ck¡Vk x;k gSA 
 Each track is divided into wadge-shaped sections called. 
 VªSd (Track) lSDVlZ (Sectors) xksy (Round) buesa ls dksbZ ugha (None of these) 
Q.25. gkMZ fMLd iSd cnyus ;ksX; LVksjst midj.k gS ftlesa cMh ek=k esa tkudkjh LVksj dh tkrh gSA 
 Hard disk packs are removable storage devices used to massive amounts of information. 
  lgh (True)      xyr (False) 
Q.26. f}rh;d laxzg.k ukWu&OgksysVkbZy gSA 
 Secondary Storage is nonvolatile.   lgh (True)  xyr (False) 
Q.27. ¶ykWih fMLd cnys tkus okys LVksjst ehfM;k gksrs gSA 
 Floppy disks are removable storage media. 
  lgh (True)      xyr (False) 
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Functions

● LEN

इस Function का उपयोग Text String में character की संख्या जानने के लए जाता ह।ै
This function is used to know the number of characters in the text string.

Exp. :-  = LEN (Bhavishya)
= 9 character



Date & Time

● Today 

इस Function का उपयोग Cell में Current date insert करने के लए कया जाता ह।ै
This function is used to insert the current date in the cell.

Exp. :- = Today()
= 05/1/2019



● Now 

इस Function का उपयोग Cell में Current date & Time insert करने के लए कया 
जाता ह।ै
This function is used to insert the current date & time in the cell.

Exp. :- = Now()
= 05/1/2019 01:30 PM



● Date 

इस Function का उपयोग date को date के default format में लखने के लए कया 
जाता ह।ै
This function is used to write the date in the default format of the date.

Exp. :- = Date (2018, 03, 22 )
= 22/03/18



● Year 

इस Function का उपयोग दी गई date में Year नकालने के लए कया जाता ह।ै
This function is used to find the year in the given date.

Exp. :- = YEAR (03/02/2018)
= 2018



Mathematical & Trig no Function

● = abs(-a) 

इस Function का उपयोग Absolute value return करने के लए कया जाता ह।ै 
This function is used to return the absolute value.
यह Negative number को Positive value में convert कर देता ह।ै 
It converts the negative number into a positive value.
परन्तु Positive value का कोई effect नहीं डालता।
But positive value does not have any effect.

Exp. :- =ABS (-9)
=9



● = product (3,5) 

इस Function का उपयोग cell में लखी गई value को Multiply करने के लए कया ह।ै 
This function is used to multiply the value written in the cell.

Exp. :- = Product (5,4)
= 20



● = Power (2,5) 

इस Function का उपयोग दी गई संख्या की Power को बढ़ाने के लए कया जाता ह।ै इस 
Function का Output नम्न प्रकार ह।ै
This function is used to increase the power of a given number. The output of 
this function is as follows.

Exp. :- = Power (2,5)
= 32

(जैसे 2 को पांच बार गुणा करेगा = 2x2x2×2×2 = 32) 



● = SQRT (144) 

इस function का use दी गई संख्या का वगर्वामूल (Square Root ) नकालने के लए कया 
जाता ह।ै
This function is used to find the square root of a given number.

Exp. :- =SQRT (144)
= 12



= ODD (10) 

इस function का उपयोग दये गये नंबर के नकटतम वषम पूणार्वाक use करने के लए 
करते हैं।
This function is used to find the nearest odd integer to the given number.

Exp :- = ODD (10)
= 11



● = EVEN (11) 

इस function का उपयोग दये गये नंबर के नकटतम सम पूणार्वाक लेने के लए करते हैं ।
This function is used to find the nearest even integer of the given number.

Exp. :- = EVEN(11)
= 12



Statically Function

● AVERAGE 

इस function का उपयोग दी गई संख्या का औसत नकालने के लए कया जाता ह ै। 
This function is used to find the average of a given number.

Exp. :- 
= AVERAGE (20, 40, 30) = 30



● MAX 

इस function का उपयोग दी गई संख्याओ ंमें से सबसे बडी संख्या ज्ञात करने के लए कया 
जाता ह।ै
This function is used to find the largest number among the given numbers.

Exp. :- 
= MAX (20, 40, 30 ) = 40



● MIN 

इस function का उपयोग दी गई संख्याओ ंमें से सबसे छोटी संख्या ज्ञात करने के लए कया 
जाता ह।ै
This function is used to find the smallest number among the given numbers.

Exp. :- 
= MIN(20, 40, 30, 0, -1) = -1



● COUNT

इस function का उपयोग दी गई Cell range में कुल संख्या जानने के लए कया जाता ह।ै 
यह Function Text की गनती नहीं करता ।
This function is used to find the total number of cells in a given cell range. 
This function does not count the text.

Exp. :- 
= COUNT(20, 40, 30, 40, 55 ) = 5



Data Tab

यह टबे कम् प् यूटर स् क्रीन पर नम् न चत्रानुसार दखाई देता ह।ै इस टबे में छ: ग्रुप ह ैजो क नम् न ह-ै 
This tab appears on the computer screen as shown below. There are six groups 
in this tab which are as follows-



1. Get External data

● From Access :- इसका उपयोग MS-Access की File से data को Access करने के 
लए कया जाता ह।ै
From Access: - It is used to access data from the file of MS-Access.

● From web :- इसका उपयोग Web File से data को Access करने के लए कया 
जाता ह।ै
From web :- It is used to access data from web file.



● From text file :- इसका उपयोग कसी Text File के data को Access करने के 
लए कया जाता ह।ै 
From text file: - It is used to access the data of a text file.

● From other Source : इसका उपयोग कसी अन्य प्रकार से कसी data को Access 
करने के लए कया जाता ह ैजैसे- SQL
From other Source : It is used to access any data in any other way like- 
SQL



2. Data Tools

What-If Analysis

● Goal seeks :-

○ Output के According input में change करने के लए goal seek का उपयोग 
कया जाता।
To change the input according to the output, goal seek is used.



○ Value के पूवार्वानुमान के लए goal seek का उपयोग कया जाता ह।ै
Goal seek is used to predict the value.

○ यह Sheet के केवल दो cell पर work करता ह।ै
It works on only two cells of the sheet.
■ Set cell
■ By changing cell



● Scenario Manager

○ Scenario Manager Multiple sheet पर work कर सकते हैं।
Scenario Manager can work on multiple sheets.

○ MS Excel में कसी Product के MRP के लए इसका use कया जा सकता ह।ै
It can be used for MRP of a product in MS Excel.

○ Scenario Manager के द्वारा एक Auto Summary भी तैयार की जाती ह।ै
An Auto Summary is also prepared by Scenario Manager.



Q.1- MS Excel 2003 में Last Column का Label होता ह?ै
What is the Label of Last Column in MS Excel 2003?

(1) V4

(2) VI6

(3) IV

(4) None of the above



Q.2- MS Excel 2016 में Last Column का Label होता ह-ै
The Label of Last Column in MS Excel 2016 is-

(1) XVFD

(2) XAAD

(3) XFD

(4) None of these



Q.3- नम् नलखत में से कौन-सा उनके आकार के अवरोही क्रम में सही व् यवस् था ह?ै
Which of the following is the correct arrangement of their sizes in 
descending order?

(1) Worksheet, Workbook,  Range, Cell

(2) Workbook, Worksheet, Range, Cell

(3) Workbook, Range, Cell, Worksheet

(4) Cell, Range, Worksheet, Workbook



Q.4- MS Excel 2010 में Column की संख् या होती ह?ै
The number of columns in MS Excel 2010 is?

(1) 16834

(2) 16384

(3) 1048576

(4) None of these



Q.5- MS Excel 2019 में Last Row Number होता ह-ै 
Last Row Number in MS Excel 2019 is-

(1) 1057876

(2) 1087546

(3) 1048576

(4) None of these



Q.6- MS Excel 2013 में First Cell का address होता ह-ै
The address of the first cell in MS Excel 2013 is-

(1) A:1

(2) A1

(3) AA

(4) None of the above



Q.7- “Excel” Formula cell के एडे्रस $A$4 का प्रतनधत् व करता ह-ै 
“Excel” represents the address $A$4 of the Formula cell-

(1) Relative cell reference

(2) Mixed cell reference

(3) Absolute cell reference

(4) All of the above



Q.8- MS Excel 2000 में First Cell Address होता ह?ै
What is the first cell address in MS Excel 2000?

(1) A

(2) AA

(3) 1A

(4) None of the above



Q.9- MS Excel 2019 में Last Row Number होता ह-ै 
Last Row Number in MS Excel 2019 is-

(1) 1048577

(2) 1048576

(3) 1048756

(4) None of these



Q.10- MS Excel में प्रदशर्शित होने वाली Vertical & Horizontal Lines को क् या कहा 
जाता ह?ै
What are the Vertical & Horizontal Lines displayed in MS Excel called?

(1) Lining

(2) Gridlines

(3) Printing Line

(4) None of these
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